What is Motion?

Motion is a behavior-driven motion graphics application used to create stunning imaging effects in real time for a wide variety of broadcast, video, and film projects.

In Motion, you can:

- Create sophisticated animations on the fly using any of more than 200 built-in motion and simulation *behaviors*, such as Spin, Throw, or Orbit, which allow you to add dynamic motion to your projects in real time, with no preview rendering time necessary.
- Build complex visual effects using one or more of nearly 300 Motion basics
- Build complex visual effects using one or more of nearly 300 filters such as Glow, Strobe, or Bleach Bypass.
- Animate the traditional way, using keyframes and modifiable curves, to create precise timing effects.
- Create polished text effects, from the simple (lower-thirds and credit rolls) to the complex (3D titles, animated effects, sequencing text).
- Create custom effect, transition, title, and generator templates for automatic export to Final Cut Pro X. You can also modify the effects, transitions, titles, and generators that ship with Final Cut Pro.
- Use rigging to map multiple parameters to a single control (for example, a slider that simultaneously manipulates size, color, and rotation of text) in Motion compositions or in templates exported to Final Cut Pro X.
- Build compositions by selecting from royalty-free content, such as vector artwork, animated design elements, and high-resolution images.
- Retime footage to create high-quality slow-motion or fast-motion effects.
- Stabilize camera shake or create complex motion-tracking effects such as match moves and corner-pinning.
- Perform advanced compositing and green screen effects.
- Build fluid 3D motion graphics for show intros, bumpers, commercials, or title sequences.
- Create sophisticated particle systems involving large numbers of automatically animated objects in 2D or 3D space.
- Build complex patterns of repeating elements using the
- Build complex patterns of repeating elements using the powerful replicator tool, then animate the resulting collages in 2D or 3D space.
- Publish your projects directly to websites such as YouTube and Facebook, or send your motion graphics to iTunes for syncing with Apple devices such as iPad, iPhone, and Apple TV.

Motion workflow

The basic process of working in Motion is described below. You don’t have to do every step, and you might do other tasks that aren’t listed here.

Create a project

You can create a blank project, open a preset composition, or create a template for use in Final Cut Pro X.

Add media

Typically, you import media to create a composition. You can, however, create entire projects using the built-in content that comes with Motion, such as preset particle emitters, text, or generators. Each media item added to your project becomes a layer in your composite.

Add or create effects
Now the fun really begins. Whether you’re building simple animated backgrounds, creating green screen composites or 3D composites, or assembling complex motion-graphics animations, the effect possibilities are nearly limitless.

Share your composition
When your project is finished, you can publish your movie right from Motion to the web, or send it to iTunes, iPad, iPhone, iPod, or Apple TV. You can also burn a disc to give to others.

Motion interface at a glance
The Motion interface is divided into several functional areas.

Project Browser
When you open Motion, the Project Browser appears. Use this window to create new projects or open existing projects.
Main workspace

After you open a project via the Project Browser, the main workspace appears. Use this window to build, modify, and preview your motion graphics projects. The main workspace is divided into several functional areas, described in detail below.

For more information, see Create a new project.
File Browser

The File Browser, located on the left side of the main workspace, displays all files on your computer and networked disks. Navigating the File Browser is similar to navigating a window in the Finder.

When you select a file in the File Browser, a visual preview appears in the top-left corner of the Motion workspace, along with the file’s metadata.
Library

The Library, located on the left side of the main workspace, contains effects, content, presets, behaviors, filters, and other

File Browser: Access media files stored on your computer or storage device.

- Preview and metadata: Select a file and see a preview image and metadata about the file before importing.

- Computer folders: Select the folder that contains the media you want to import.

- Media files: Select the media files that you want to import here.
elements available in Motion. You can expand the Library content by adding fonts, music, or photos, or by saving content and effects that you create in Motion.

When you select an item in the Library, a visual preview appears in the top-left corner of the Motion workspace. The preview area also contains text information for the selected item, such as a description of the behavior, filter, or generator.
Inspector

When you select an object in your Motion project—an image, video clip, or effect—its parameter controls become available in
There are four Inspector categories, each of which displays parameter controls for the selected object:

- **Properties Inspector**: Contains controls for setting basic...
- **Properties Inspector**: Contains controls for setting basic attributes of the selected object, such as position, scale, and blending.

- **Behaviors Inspector**: Contains controls for adjusting attributes of behaviors—animation and simulation effects that you can apply to objects in your project.

- **Filters Inspector**: Contains controls for adjusting attributes of filters—visual treatments that you can apply to objects in your project.

- **Object Inspector**: Contains controls that vary depending on the type of object selected. The name of this Inspector is also context-sensitive, changing depending on the type of object selected, such as Camera, Text, or Shape.

---

**Heads-up display (HUD)**

The most commonly used Inspector controls are also available in the heads-up display (HUD), a floating window that you can show or hide. For more information, see [Transform layers in the HUD](#).

![HUD](image)

**HUD**: Provides convenient access to the most common Inspector controls for adjusting items in your project.

---

**Project pane**

The Project pane (located between the File Browser, Library, or Inspector and the Canvas) contains three lists, each of which
provides access to a different aspect of your project:

- **Layers list**: Displays the hierarchy of objects (groups, layers, cameras, lights, behaviors, filters, and so on) in your project.
- **Media list**: Shows the files imported into your project.
- **Audio list**: Provides access to, and control of, audio files in your project.

More than simple lists of items in a project, these panes let you organize key attributes of a motion graphics composition, including the stacking order of image layers, audio settings, and source media settings.

**Project pane**: Organize stacking order of objects, view media, and adjust audio used in your project.
The Canvas is the visual workspace where you modify and arrange objects in your composition. Adding layers and effects to your project is as simple as dragging them from the Library or File Browser to the Canvas. The composition in the Canvas is what will be output when you share a project.

The buttons centered at the bottom of the Canvas are *transport controls*. Use them to play your project and see how it looks over time.

**Toolbar**

You can access tools for editing and creating objects in the toolbar, located in the center of the Motion workspace. There are tools that transform objects in 2D or 3D space; tools that create text, shapes, and masks; buttons that add cameras, lights,
generators, particle systems, and replicators; and pop-up menus that apply filters and behaviors to objects.

**Timing pane**

The Timing pane, located at the bottom of the Motion workspace, lets you view and modify the time component of a project’s contents. There are three panes that control a different timing aspect of a project:

- **Video Timeline**: Provides an overview of objects in the project and how they’re laid out over time.
- **Audio Timeline**: Provides an overview of audio components in the project and how they are laid out over time.
- **Keyframe Editor**: Displays the animation curves for animated parameters and effects.
Basic components of Motion

The composition you build in Motion, then save and share, is called a *project*. The basic components of your project—images, video clips, applied special effects, and so on—are represented in the interface as *objects* that you can select, drag, and manipulate in various ways. There are several categories of objects that you’ll use in every project:

- **Groups**: The basic containers used in a project to organize imported media and Motion content and effects. A group can contain one or more objects, as well as other, nested groups.

- **Layers**: A specific kind of object that you can see in the Canvas, including:
  - *Images or video clips*: Still pictures and movies that you import into Motion. See [Add and manage content overview](#).
  - *Shapes*: Rectangles, circles, lines, and more complex
- **Shapes**: Rectangles, circles, lines, and more complex shapes that you create in Motion using the shape tools. See *Shapes, masks, and paint strokes overview*.

- **Masks**: A special type of shape used to create regions of transparency in layers. See *Shapes, masks, and paint strokes overview*.

- **Paint strokes**: Freehand shapes drawn in a single, continuous movement. See *Shapes, masks, and paint strokes overview*.

- **Text**: Type that you can add and animate in a project. See *Basic text overview*.

- **Particle systems**: Sophisticated animation effects composed of swarming small particles. You can create your own particle systems or apply the pre-built particle systems that come with Motion. See *Particles overview*.

- **Replicators**: Patterns of repeating visual elements you can create or apply to build cascading arrays of kaleidoscopic imagery. See *Replicator overview*.

- **Generators**: Graphical images that come with Motion, including colors, bars, stripes, and gradients that you can add to your project. See *Generators overview*.

- **Effects objects**: Special effects that you apply to visual layers. Effects objects are not visible in the Canvas on their own; rather, they modify the visual layers you see in the Canvas. Motion includes the following effects objects:
  - **Cameras**: An angle of view that you can adjust or animate to create the illusion of panning, dollying, or zooming through your composition. See *Add a camera*.
  - **Lights**: Simulated illumination sources that you can direct.
- **Lights**: Simulated illumination sources that you can direct at any visible layer in the canvas. See Add lights.

- **Behaviors**: Sophisticated animation and simulation effects that you can apply to the visual layers in your project. For example, you can use the Spin behavior to make a shape rotate over time at a rate you specify. See Behaviors overview.

- **Filters**: Special visual effects used to modify the appearance of visual layers in Motion. For example, you can use a blur filter to make an image or shape appear to be out of focus. You can also animate filters. See Filters overview.

In Motion Help, the term *object* is often used to describe the superset of all elements (groups, layers, and effects objects) that comprise and act upon a composition. *Layer*, however, always refers to the image-based elements acted upon—the visual media you see in the Canvas.

### About mice, keys, and multi-touch devices

If you have a two- or three-button mouse connected to your computer, you can right-click to access the same controls specified by the Control-click commands in this documentation.

Some keyboard shortcuts require you to use the Function key (Fn—next to the Control key) in conjunction with the keys specified in the user documentation. For more information about keyboard shortcuts in Motion, see Keyboard shortcuts overview.
If you have a multi-touch device, such as a Magic Mouse or trackpad, you can use various gestures for interface navigation, scrolling, frame-scrubbing, and zooming. You can also use gestures to change the size of icons in the File Browser and Library. These gestures are discussed in their relative sections of the documentation.
Create and manage projects

Create and manage projects overview

Creating a project is the first step in the Motion workflow. The easiest way to create a new project (or to open an existing project) is to use the Project Browser window. When you open Motion, the Project Browser appears.

Use the options in the browser to specify the type of project you want to open:
A new standard ("blank") Motion project
A previously opened Motion project
A predesigned composition template that you can customize
A new blank project based on one of the supplied Final Cut Pro templates (effects that you build in Motion for use in Final Cut Pro X)

Before opening the new project, you can also use the Project Browser to modify your project properties—resolution (width and height), frame rate, and duration. For example, you might want to choose properties that will match your planned output format.

Regardless of the project properties you choose, after you create a project, Motion lets you import nearly any kind of media file supported by QuickTime. Further, you can mix media files with different properties in the same project. For example, you can combine video clips of different frame sizes with graphics files. In the end, the file you output uses the frame size and frame rate specified by the project properties.

After you create a project, you can or save or revert it, play it back, or modify its properties.

Create a new project

You can create a Motion project from scratch, using the standard project settings in the preview area of the Project Browser. If none of the presets meets your needs, you can create a project with custom properties. You can also create projects prepopulated with selected media. Additionally, you can create projects based
on predesigned motion graphics templates or on special templates for use as effects in Final Cut Pro X.

Create a basic project

1. Open Motion or, if it’s already open, Choose File > New (or press Command-N).

2. In the Project Browser, select the Blank category in the sidebar, then click the Motion Project icon.

3. Choose a resolution from the Preset pop-up menu and a frame rate from the Frame Rate pop-up menu in the right column, then click Open.

   **Important:** Frame rates cannot be changed for existing projects.

A new, untitled Motion project opens. The project is not saved to your storage device until you choose a save command from the File menu. For more information on saving project files, see Save, autosave, and revert projects.

Create a project with custom properties

1. Open Motion or, if it’s already open, Choose File > New (or press Command-N).

2. In the Project Browser, select the Blank category in the sidebar, then click the Motion Project icon.
3. Click the Preset pop-up menu on the right side of the browser, then choose Custom.

Additional properties controls appear.

4. Set the resolution (width and height), field order, aspect ratio, frame rate, and default duration for your custom project.

5. Click Open.

A new, untitled Motion project opens using the custom properties you specified.

Create a project prepopulated with specific
1. Do one of the following:
   - Choose File > Import as Project or press Shift-Command-I.
   - Open the Project Browser, then click Create Project From File.

The Import Files as Project dialog appears.

2. Navigate to and select the one or more media files, Shift-clicking to select contiguous items or Command-clicking to select noncontiguous items.

As you select files, format settings at the bottom of the dialog become available. Settings inherent to the selected files remain dimmed, but propagate to the new project. For
example, because movie files have an inherent frame rate, aspect ratio, and field order, those settings are dimmed in the Import Files as Project dialog.

3. If needed, set the frame rate, aspect ratio, field order, and audio mix settings.

Except for the Frame Rate parameter, these settings can be modified after the project is created, in the Properties Inspector. For more information, see Project properties overview.

**Note:** If you selected an item from an image sequence, select the Image Sequence checkbox to have Motion use each image as a frame in a movie clip. For more information, see About image sequences.

4. Click Import as Project.

A new project populated with the media you selected opens.

---

**SEE ALSO**

Use templates overview
Final Cut Pro templates overview

---

**Open an existing project**

There are many ways to open an existing Motion project. You can open projects and templates via the Project Browser, the Motion
Open a project from the Project Browser

1. In the Project Browser (press Command-N), then select a category in the sidebar to limit which items are displayed in middle of the browser.

2. Select an item from the middle of the browser.

   A video preview, if available, plays in the preview area on the right.

3. If necessary, modify the resolution, frame rate, and default duration using the pop-up menus above the preview area.
4. Click Open.

The Project Browser closes and the project you selected opens in the Motion workspace.

Open a project file from within Motion using the Open command

1. With Motion open, choose File > Open (or press Command-O).

   The Open dialog appears.

2. In the Open dialog, navigate to the project file you want, then click Open.

Open an existing Motion project file that does not appear in the Project Browser

Using the buttons at the bottom of the Project Browser, you can also open a specific project that doesn’t appear in the Project Browser, but is accessible through the Finder.

1. In the Project Browser, click Open Other (or press Command-O).

   The Open dialog appears.

2. In the Open dialog, navigate to a Motion project file, select it, then click Open.
Open a recent project

Do either of the following:

- In Motion, choose File > Open Recent, then choose a project from the submenu.
- From the Project Browser, click Recent in the sidebar, select a project from the center of the browser, then click Open.

Open a project file from the Finder

From the Finder, do one of the following:

- Double-click a Motion project file.
- Select a Motion project file, then drag it onto the Motion application icon in the Applications folder or in the Dock (if you’ve placed a Motion application icon in the Dock).
- Select a Motion project file, then choose File > Open (or press Command-O).
- Control-click a Motion project file, then choose Open from the shortcut menu.

The project you selected opens in Motion workspace.

**Tip:** You can search for Motion projects via Spotlight in the Finder. For more information, see Search for projects using the Finder.
**Close a project**

- Click the close button in the top-left corner of the project window (or press Command-W).

**Search for projects using the Finder**

Spotlight indexes the following properties of Motion projects, allowing you to perform advanced searches. Use Spotlight in the Finder (the magnifying glass icon in the OS X menu bar) to take advantage of this feature.

<table>
<thead>
<tr>
<th>Project property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer name</td>
<td>The name of a layer in a project</td>
</tr>
<tr>
<td>Media name</td>
<td>The name of a media object in a project</td>
</tr>
<tr>
<td>Pathname</td>
<td>The path to a media object in a project</td>
</tr>
<tr>
<td>Text</td>
<td>The content of a text</td>
</tr>
<tr>
<td>Description</td>
<td>Text in the Project Description field in the Properties Inspector</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Marker name</td>
<td>The name of a marker in the Timeline of a project</td>
</tr>
<tr>
<td>Marker comment</td>
<td>Text of a marker comment in a project</td>
</tr>
</tbody>
</table>

**Bypass the Project Browser**

If you consistently create projects with a specific preset, template, or other starting project, you can bypass the Project Browser. This way, when you create a project, it’s opened in the Motion workspace with the settings you established.

1. Choose Motion > Preferences (or press Command-Comma).
   The Motion Preferences window appears.
2. Click Project.
3. In the For New Documents area, click Use Project.

**Note:** If you haven’t assigned a preset project, the setting reads: Use Project: Nothing Selected. When you choose a project, the text updates to reflect the name of the selected project.

4. Click Choose.

A window opens containing the contents of the Project Browser.

5. Select a category in the sidebar and a project type from the center area, then choose a preset (if available) from the right column.

6. Click Open.

The selected project is assigned to the Use Project option in the Project pane of the Preferences window. From now on, the Project Browser does not appear when you choose File > New (or press Command-N). Instead, a new project opens in the format set in Motion Preferences.

---

**Create, edit, and delete project presets**

If you commonly create projects using properties that don’t match any available preset, you can create a custom preset for future use. Presets are created, modified, and deleted in the Presets
Create a custom preset

1. Choose Motion > Preferences (or press Command-Comma).
2. Click Presets.
3. Click the Add button (+) beneath the presets list.

The Project Preset Editor appears.
4. In the Project Preset Editor, enter the following information:

   a. **Name**: Type a name for the preset.

   b. **Description**: Type a brief description of what that preset is for, including significant characteristics such as frame size and frame rate.

   c. **Width and Height**: Enter a frame size.

   d. **Pixel Aspect Ratio, Field Order, and Frame Rate**: Choose settings from the corresponding pop-up menus.

5. Click OK.

   The new preset appears in the Presets pane and in the Preset pop-up menu in the Project Browser.

6. If you’re done creating project presets, close Motion Preferences.

**Note**: For more information on industry-standard frame sizes,
Duplicate and edit an existing preset

The project presets that come with Motion cannot be modified. However, you can duplicate an existing preset and then modify it.

1. In Motion Preferences, select a preset in the Presets pane.
2. Click Duplicate.
   
The duplicated preset appears underneath the original preset with “copy” appended to its title.
3. Select the duplicated preset, then click Edit.
   
If you select a built-in preset (designated by a lock icon), an alert dialog appears asking if you want to duplicate the preset.
4. When the Project Preset Editor appears, make your changes, then click OK.

Note: You cannot edit or delete locked project presets.

Delete a custom preset

1. In Motion Preferences, select a preset in the Presets pane.
2. Click the Delete button (–) underneath the presets list.
Save, autosave, and revert projects

It’s wise to save early and often as you work on your project. In addition to preserving your work for future use, Motion’s save commands can be used in other ways to manage the development of your project. For example, if you want to keep your current composition but create a variant version, use the Save As command to save a duplicate of the current project. If you want to gather all media used in a Motion project into a single folder, use the Collect Media option when you save. There are also commands that let you revert to a previously saved version of your project.

Save a project


   If the project has not been saved, the Save As dialog appears.
Note: If the project has been saved, the project file is updated without opening a dialog.

2. Enter a name into the Save As field, choose a save location on your storage device, then click Save.

Save a duplicate of a project

1. Choose File > Save As (or press Shift-Command-S).

   The Save As dialog appears.

2. Enter a name into the Save As field, choose a save location on your storage device, then click Save.

Save a project and collect all project media into a folder

When saving a project, you can have Motion copy the all media files used in the project into a single folder, making portability and backup easier.
1. Choose File > Save As (or press Shift-Command-S).

The Save As dialog appears.

2. Click the Collect Media pop-up menu, then choose Copy to Folder.

If you want to collect all media files in your project, including those not used in the current composition, select Include Unused Media.

3. Enter a new name for the file in Save As field, choose a save location on your storage device, then click Save.

Motion creates a folder with the name specified in the Save As field and places two items in the folder:

- A project file with the same name as the folder
- A folder named “Media” containing all media files used in the project

**Important:** When using the Save As command, use a name that’s different from the name of any previously saved versions of the same project. Otherwise, you run the risk of
overwriting a version of the project that you want to keep.

Revert a project to the last saved version

The Revert to Saved command discards all changes you’ve made to a project since the last time you saved it.

**Note:** You can also use the application’s unlimited undo feature to achieve the same purpose in incremental steps. For more information on the Undo command, see Edit menu.

- Choose File > Revert to Saved.

  **Important:** This command cannot be undone.

Autosave projects to a specific storage location

By default, Motion automatically saves backups of your project at set intervals. In the Cache pane of Motion Preferences, you can specify how frequently projects are autosaved, as well as the storage location of the autosaved project files. Autosaved project files are time- and date-stamped.

1. Choose Motion > Preferences (or press Command-Comma).

2. Click Cache.

3. In the Autosave area, select Use Autosave Vault (if it’s not already selected).
By default, the Autosave Vault folder is located in your /Users/username/Movies/Motion Projects/ folder.

4. If you want to set a different location for the Autosave Vault folder, click Choose, select a new location, then click Choose.

---

**Revert to an autosaved project**

If you’ve been using the autosave feature to back up your project, you can revert your project to an earlier autosaved version.

   
   The Restore Project dialog appears.

2. Click the pop-up menu, then choose a saved project.

   The autosaved project opens in a new project window.

---

**Use templates**

**Use templates overview**

There are two kinds of templates in Motion: *composition templates* and *Final Cut Pro templates*. This section discusses composition templates. For information on Final Cut Pro templates, see [Final Cut Pro templates overview](#).

Composition templates are premade, royalty-free projects that you can customize. They’re intended to simplify the process of
creating professional-looking titles and graphics, especially for recurring projects such as television series. Using composition templates, you can:

- Create placeholder layers (called drop zones) for easy placement of custom video or graphics.
- Customize placeholder text without overriding effects or keyframes already applied to the template text.
- Modify animation already applied to a template to suit your own timing needs.

SEE ALSO
Open a template
Template guidelines
Drop zones overview
Organize templates in the Project Browser

Open a template

Motion templates—shown in the Compositions category in the Project Browser sidebar—are premade, royalty-free projects that you can customize. Each template contains graphics, text objects, and backgrounds.

You can also create custom templates for commonly used shots that you regularly create. For example, if you make titles for a news program, you can create templates for the opening title, interstitial graphics, bumpers, and other repetitious shots.
Create a project from a composition template

You can open a composition template from the Project Browser.

1. Open Motion, or if it’s already open, Choose File > New (or press Command-N).

2. In the Project Browser, select a category from the Compositions section in the sidebar.

   The compositions for that category appear in the middle of the browser.

3. Click a composition to see its basic properties (resolution, duration, and frame rate) and an animated preview on the right.
4. To create a project from the selected composition, click Open a Copy.

A new project opens in the Motion workspace. You can customize the project by editing the text or exchanging the graphic elements with your own. The changes you make to projects created using compositions do not overwrite the source template files.

Create a composition template from scratch

You can also build a custom template from scratch. Custom templates are standard Motion projects saved in a special way.

1. With a standard Motion project open, Choose File > Publish Template.

   A save dialog appears.

2. Enter a name for the template and choose a category from the Category pop-up menu.

   To create a custom category, choose New Category from the Category pop-up menu, enter a descriptive name, then click Create.

3. Choose New Theme from the Theme pop-up menu, enter a descriptive name, then click Create.

4. If you want the template project to retain media in the Media list that isn’t present in the composition, select “Include unused media.”
5. If you want a preview of the template to appear in the Project Browser, select Save Preview Movie.

**Note:** If you want to add the template to a Final Cut Pro project, select the “Publish as Final Cut Generator” checkbox. For more information, see Final Cut Pro templates overview.

6. Click Publish.

The template is now available in the Project Browser, in the Compositions category you chose in step 2.

---

Replace template media using drop zones

*Drop zones overview*

Drop zones are placeholder graphics where template users can drag images or video to customize the project. When you modify one of the built-in composition templates that come with Motion, or create a composition template from scratch, you can add drop zone layers. A drop zone layer appears (in the Canvas and in the Layers list) as a rectangle with a downward arrow in its center. In the Canvas, the drop zone’s layer name appears in the center of the graphic. Any media item (image or footage) dragged into the region defined by the drop zone replaces the drop zone placeholder graphic.
Note: If there are multiple overlapping drop zones in the Canvas, the topmost one has priority when you drag an item over the zone. You can force all drop zones to appear by using the expose feature. For more information, see Control and expose drop zones.

Adding a drop zone to a Final Cut Pro X template in Motion enables Final Cut Pro users to easily assign media to an editing project. For more information about creating templates for use in Final Cut Pro, see Final Cut Pro templates overview.

SEE ALSO
Create drop zones
Modify drop zone images
Drop zone controls
Control and expose drop zones

Create drop zones
You create drop zones in either of two ways: by adding an empty drop zone object or by converting an existing layer into a drop zone. Any still image or video clip can be converted into a drop zone via the Image Inspector.
Add an empty drop zone

1. Choose Object > New Drop Zone or press Shift-Command-D.
   
   A drop zone layer is added to the project.

2. Position and scale the drop zone layer.

3. If needed, rename the drop zone layer in the Layers list.

4. Open the Inspector and click Image to modify the drop zone parameters.

For more information about using these parameters, see Drop zone controls.

Resize a drop zone

1. In the Layers list or Canvas, select a drop zone.

2. In the toolbar, click the Select/Transform tool.
3. In the Canvas, drag a transform handle to resize the drop zone.

**Tip:** Press Shift while dragging to resize the drop zone proportionally.

---

**Convert an image layer to a drop zone**

1. Add a video clip or still image to your project.

2. Position or resize the image or clip where you want the drop zone to appear.

   For information about positioning and scaling images, see [Transform layers in the Canvas overview](#).

3. Open the Image Inspector and click the Drop Zone checkbox. The drop zone parameters appear.
4. To replace the original image with a drop zone graphic, click the Clear button.

An active drop zone replaces the original image. For more information about using remaining Drop Zone parameters, see Drop zone controls.

Modify drop zone images

After you add a source image to the drop zone, you can pan or resize the image within the boundary of the drop zone. You can add a solid color to the drop zone to fill empty areas that are the byproduct of panning or resizing the image.

Add an image to a drop zone

Do one of the following:

- Drag an image from the File Browser or Library to the Drop Zone in the Layers list. When the pointer changes to a curved arrow, release the mouse button.

- Drag an image from the File Browser, Library, or Media list (in the Project pane) to the Drop Zone in the Canvas. When the pointer changes to a curved arrow and the drop zone is highlighted in yellow in the Canvas, release the mouse button.

- Drag an image from the Media list to the Source Media well in the Image Inspector.
In the Image Inspector, click To and select a media item in the project from the pop-up menu.

---

**Scale a drop zone image in the Canvas**

1. Select the drop zone.

2. Do one of the following:
   - In the Canvas, double-click the drop zone.
     The Adjust Item tool is automatically selected.
   - In the toolbar, select the Adjust Item tool.

   The drop zone bounding box appears as a dotted line.

3. Drag the scale handles in the Canvas to resize the image.

   The image’s bounding box appears as a solid line and scales uniformly. Portions of the image that extend beyond the edges
of the drop zone appear semitransparent.

Scale a drop zone image in the Inspector

1. Select the drop zone.

2. In the Image Inspector, drag the Scale slider. To adjust the horizontal or vertical scale independently, click the Scale disclosure triangle to reveal the X and Y subparameters.

Pan a drop zone image in the Canvas

1. Select the drop zone.

2. In the toolbar, select the Adjust Item tool.

   The drop zone bounding box appears as a dotted line.

3. Place the pointer over the drop zone image, and, when the Pan tool appears, drag within the drop zone to pan the image.

   The image’s bounding box appears as a solid line. The dotted line represents the edges of the drop zone. Portions of the image that extend beyond the edges of the drop zone appear semitransparent.

Pan a drop zone image via the Inspector

1. Select the drop zone.
2. In the Image Inspector, adjust the Pan parameter X and Y settings.

**Assign a background color to a drop zone**

1. Select the drop zone.

2. In the Image Inspector, select the Fill Opaque checkbox.
   Any empty portion of the drop zone is filled with black.

3. Use the Fill Color controls to choose a custom drop zone fill color.

**SEE ALSO**

Transform layers in the Canvas overview
Transform layers in the Properties Inspector

**Drop zone controls**

You can add any media object to any drop zone, but the object might not have the same dimensions as the drop zone. Motion provides controls to help ensure that the image placed in the drop zone is handled as you want—scaling, stretching, and positioning the object correctly.

The Image Inspector contains the following drop zone controls:

- *Drop Zone*: A checkbox (available in the Image Inspector of
any image layers in your project) that, when selected, converts an image layer into a drop zone.

- **Source Media:** An image well that appears after an image is converted into a drop zone. Drag a media item to the well from the Media list to change the current drop zone image.

- **To:** A pop-up menu providing an alternative method of assigning media to the drop zone. The menu contains a list of media items in your project. Select an item to assign it to the drop zone.

- **Pan:** Value sliders to pan the media within the drop zone. Adjust the X value slider to move the media horizontally and the Y value slider to move the media vertically.

- **Scale:** A slider to uniformly scale the media in the drop zone. To resize the media horizontally or vertically, click the Scale disclosure triangle and adjust the X or Y parameter.

- **Fill Opaque:** A checkbox that, when selected, fills the drop zone background with a color when the drop zone is scaled down or panned. If the Fill Opaque checkbox is not selected, the empty drop zone area remains transparent.

- **Fill Color:** A color control to set a color when the Fill Opaque checkbox is selected.

- **Use Display Aspect Ratio:** A checkbox that, when selected, resizes the drop zone according to selected Display Aspect Ratio Snapshot (in the Snapshots pane of the Project Inspector). For more information about display aspect ratios, see [Add multiple display aspect ratios to a template](#).

- **Clear:** A button to remove media from the drop zone, replacing it with a downward-arrow graphic.
Control and expose drop zones

When constructing your template, you can disable drop zones so you don’t accidentally apply media. Later, when using the template, you can turn drop zones back on.

You can also use the expose feature in Motion to reveal obscured drop zones in the Canvas. The expose command shows an exploded view of valid drop zones in the Canvas.

---

**Turn drop zones on and off**

- Choose View > Use Drop Zones.

A checkmark appears next to the menu item when drop zones are enabled (which means they accept objects dragged to them). When no checkmark appears next to the menu item, drop zones are disabled (which means they ignore objects dragged to them).

---

**Expose all drop zones in a project**

1. Use the Library or File Browser to locate an item to import into the project.

2. While holding down the Command key, drag the item onto the Canvas.
Objects in the Canvas shrink and separate in an exploded view so you can see them all. Moving the pointer over an object reveals its Layers list name.

**Note:** You cannot Command-drag non-image objects (shapes, Motion projects, particles, and so on) to the Canvas.

3. Drop the object onto its target.

   The object replaces its target, and the Canvas view returns to normal.

---

**Template guidelines**

When you work with templates, consider the following guidelines:

- *Use descriptive group and layer names:* Group and layer names in a template should describe each object’s function.
For example, text objects in a titling template might be named “Main Title,” “Starring,” “Guest Star,” and so on. If you use visual elements in the template’s composition, their layer names should describe their function—“Background Texture,” “Divider,” and “Main Title Background,” for example. Descriptive layer names are especially important if others use the template.

- **Create alternate versions of a template for each resolution you need:** If you regularly create projects for a variety of output formats, you can build different display aspect ratios into a single template. For example, when you create a template with a 16:9 aspect ratio, you can add an alternate version customized for 3:2 displays. For more information about creating alternate display versions in a single template, see **Add multiple display aspect ratios to a template**.

- **Place all media files used in a template in a central folder:** To avoid problems with offline or missing media, move all media files for the template into a central folder on your computer before you begin the working on the project. Although customized templates are saved in the /Users/username/Movies/ folder on your computer, media added to the template remains in its original location on disk. A central location for all media resources ensures that files are not lost. Alternatively, you can use the File > Save As command, and use the Collect Media option. For more information, see **Save, autosave, and revert projects**.

Organize templates in the Project Browser
You can organize and access custom templates in the Project Browser. All templates are organized into categories. You can add, delete, and rename categories in the Project Browser.

Add a category in the Project Browser

1. Choose File > New From Project Browser.
   
   The Project Browser appears.

2. Select a template type (Compositions, Final Cut Effects, Final Cut Generators, Final Cut Transitions, Final Cut Titles) from the sidebar (on the left).

3. Click the Add button (+) at the bottom of the sidebar.

4. Enter a name for the category in the dialog that appears.

5. Click Create.
   
   The new category appears in the column at the left under the template type you selected.

Delete a category in the Project Browser

1. Choose File > New From Project Browser.
   
   The Project Browser appears.

2. Select a category in the sidebar.
3. Press Delete or click the Delete button (−).

   An alert dialog prompts you to confirm the deletion.

The directory on your disk corresponding to that category is placed in the Trash, but is not deleted. Template files in that category’s directory are also placed in the Trash.

---

**Delete individual templates from the Project Browser**

1. Choose File > New From Project Browser.

   The Project Browser appears.

2. Select a category from the sidebar, then select the template to delete.

3. Press Delete.

   An alert dialog prompts you to confirm the deletion.

4. Click the Delete button (−).

---

**Modify project properties**

**Project properties overview**

When you create a project, you specify a set of project properties
Resolution, Frame Rate, Duration, and so on. You can change most of these properties at any time, even after you add objects to the project.

The Properties Inspector lets you define the most essential attributes of a project. By choosing different parameters, you can accommodate nearly any video or film format you need to output to. These properties are the default settings used when you export your project.

Project background color, as well as how the background color is rendered, is also modified in the Properties Inspector.

**SEE ALSO**

Edit project properties
Properties Inspector controls
About project frame size

**Edit project properties**

The Project object in the Layers list must be selected for the project’s Properties Inspector to be displayed. If another object is selected, that object’s properties are displayed in the Properties Inspector.
Edit the properties of an existing project

1. Do one of the following:
   - Choose Edit > Project Properties (or press Command-J).
   - Select the Project object at the top of the Layers list, then open the Inspector and click Properties (if that pane is not showing already).
   - Control-click an empty area of the Canvas (in the gray area outside the project) and choose Project Properties from the shortcut menu.

   The Properties Inspector opens.

2. In the Properties Inspector, change any necessary parameters.

   **Important:** Project Frame Rate cannot be changed after a project is created.

   The Properties Inspector for the project contains settings for
video file format, timecode display, motion blur, and other project attributes.

**Change the project background color**

1. Do one of the following:
   - Choose Edit > Project Properties (or press Command-J).
   - Select the Project object at the top of the Layers list, then open the Inspector and click Properties.

   The Properties Inspector opens. Two parameters in a project’s Properties Inspector affect the background color of a project and affect how a composition appears when exported out of Motion.

2. Set your project background properties:
   - *Background Color*: Use this color well to set the color appearing in the Canvas when no other object obscures the background.

   **Note**: To export a project with a premultiplied alpha channel, Motion always renders against black.

   - *Background*: Use this pop-up menu to set whether the background color is rendered as part of the alpha channel. If set to Solid, the background color creates a solid alpha channel. If set to Transparent, the background color does not render as part of the alpha channel. In either case, the background color is visible in the Canvas.

For more information about transparency, see [About alpha](#)
Properties Inspector controls

When the Project object is selected in the Layers list, the Properties Inspector is divided into several control groups: General, Motion Blur, Reflections, and Description.
General controls

Use the controls in the General group to set or modify your project’s basic attributes.

- **Preset**: A pop-up menu to choose a common video format to base your preset on. After choosing a preset, you can adjust
the other parameters in the Properties Inspector to customize your format settings. For more information about managing Motion project presets, see Create, edit, and delete project presets.

- **Width and Height:** A value slider to define the size of the Canvas and the default output resolution of your project. Drag left or right over the values to decrease or increase them. Frame size is usually defined by the video format you plan on outputting to. For example, NTSC DV format video is 720 x 480, whereas PAL DV format video has a frame size of 720 x 576.

- **Pixel Aspect Ratio:** A pop-up menu to set whether the project is created using square or nonsquare pixels. Computer displays, film, and high-definition video use square pixels, while standard-definition video uses nonsquare pixels. Choose Square for projects intended for the web, high-definition projects, and film, or choose a nonsquare pixel ratio corresponding to each international standard-definition broadcast format. A value slider to the right of this pop-up menu displays the numerical aspect ratio, in case you need to change the dimensions manually.

- **Field Order:** A pop-up menu to set field order if the project uses interlaced video. Project field order should match the field order of the device being used to output the resulting QuickTime file to video. When working with progressive-scan video or film, choose None.

- **Frame Rate:** A display field to see the project frame rate (in frames per second). Frame rate should match that of the format you output to. For example, film is 24 fps, PAL video is 25 fps, and NTSC video is 29.97 fps.
Important: Frame rates cannot be changed for existing projects.

- **Duration**: A value field to modify the project’s Timeline duration. Use the adjacent pop-up menu to define the duration units (Frames, Timecode, or Seconds).

- **Override FCP**: A checkbox (available only in Final Cut Transition projects) that, when selected, overrides the default transition duration (as defined in the Editing pane of Final Cut Pro Preferences). For more information, see Final Cut Pro templates overview.

- **Start Timecode**: A value field to set the starting timecode displayed in the project.

- **Theme**: A pop-up menu to assign a theme to the project.

- **Designed for 4K**: A checkbox available only in Final Cut Effect, Transition, Generator, or Title template projects. For more information, see Set template resolution.

- **Background Color**: A color control to set the background color of the Canvas.

- **Background**: A pop-up menu to define whether the Background Color is rendered as part of the alpha channel. Regardless of the selection, the Background Color is visible in the Canvas. Choose from these three options:
  - **Transparent**: The background color does not render as part of the alpha channel.
  - **Solid**: The background color creates a solid alpha channel.
  - **Environment**: The background color creates a solid alpha channel and interacts with 3D projects, including blend
modes and reflections. In the following images of the Canvas, Reflection is turned on for the elliptical shape (in the shape’s Properties Inspector). In the left image, the elliptical shape retains its original white color because Background is set to Solid. In the right image, the pink background is reflected in the elliptical shape because Background is set to Environment.

![Image showing reflection and no reflection](image)

**Motion Blur and Reflections controls**

Below the General section of the Properties Inspector are two groups of controls that can affect how your project looks when exported: Motion Blur and Reflections.

The Motion Blur controls simulate the effect a camera’s mechanical shutter has on a frame of film or video when the camera or its subject is moving. In Motion, motion blur affects objects in your project that are animated using behaviors or keyframes, creating more natural-looking motion in your project, even though the animation is artificial. As with a camera, faster objects have more blur; slower objects have less blur.
The Motion Blur section of the Properties Inspector has two settings:

- **Samples**: A slider to set the number of subframes rendered per frame, where one frame represents 360 degrees. Higher Samples values result in a higher-quality motion-blur effect, but are more processor-intensive. The default Samples value is 8. The maximum possible value is 256.

- **Shutter Angle**: A slider to define the size of the motion blur that appears for animated objects. Increasing the shutter angle increases the number of frames over which the shutter is open.

The following image shows a shape keyframed to move quickly across the Canvas horizontally.

In the next image, Motion Blur is enabled and Samples is set to the default value of 8.
**Note:** When using larger Shutter Angle values, it may be necessary to increase the Samples value to eliminate unwanted artifacts.

In the above image, the Shutter Angle is set to the default of 360 degrees, which represents 1 frame. In the following image, Shutter Angle is set to 600 degrees.

The Reflections section of the Properties Inspector has one parameter:

- **Maximum Bounces:** A slider to limit the number of recursive reflections that can occur when two or more shiny objects reflect one another. This parameter is intended to prevent an endless repetition of reflective bounces.

For more information about reflections, see [Cast a reflection](#).
**Description field**

At the bottom of the Properties Inspector is a field where you can enter a brief description of the project, including significant characteristics of the project preset, such as frame size and frame rate.

**About project frame size**

When you change the frame size of a project (via the Width and Height parameters in the Properties Inspector), you effectively change the size of the Canvas, increasing or reducing layout space for objects in the project.

Changing the size of the Canvas does not change the size or position of objects in the Canvas. Further, because the coordinate system in Motion uses 0, 0 as the center of the frame, all objects remain arranged in their current positions relative to the center of the frame as the edge of the frame shrinks toward the center. This can result in objects being cut off as the frame shrinks past their edges.

In the following example, a project with a frame size of 1280 x 720 is reduced to 320 x 240. The 720 x 480 video clip is smaller than the original frame size but bigger than the reduced frame size.
Note: Because Motion is resolution-independent, it’s not usually necessary to change your project’s frame size. You can output a project at any size, regardless of the current frame size, by changing the settings in Motion’s Share windows. For example, if you build a project with a frame size for standard-definition broadcast, you can still export a half-resolution version of the project to post on the web by exporting to the necessary size.
Add and manage content overview

After you create a project, you add media—video clips, still images, special effects, and so on—to create a composition. Motion provides two easy ways to add this content to your project:

- **File Browser:** Locate external video clips, still images, and audio files on your computer or on networked storage devices, then import this media into your Motion project. See [File Browser overview](#).

- **Library:** Search for high-quality content that comes with Motion (text styles, animated graphics, special effects, and so on), then add this content to your Motion project. See [Library overview](#).

The File Browser and Library, located on the left side of the Motion workspace, display all of your available content in hierarchical, searchable lists. Here you can also preview selected content before you add it to your Motion project.

Media files imported from your computer or networked devices become *source media*. Source media can be scaled (resolution), cropped, exchanged or replaced, duplicated, revealed in the Finder, and so on. See [Source media overview](#).
Import media files

File Browser overview

The easiest way to import external media files (video, audio, and
still images on your computer or a connected storage device) into Motion is via the File Browser. When you open a Motion project, the File Browser is displayed on the left side of the workspace. The File Browser shows a hierarchal list of all files on your computer and networked storage devices. Navigating the File Browser is similar to navigating a window in the Finder.

The File Browser is divided into several areas:
- **Preview area**: At the top of the File Browser, a thumbnail image displays a video preview of any file selected in the navigation areas of the browser, along with information about the selected file, including filename, media type, file size, and frame rate.

- **Navigation pane**: Just below the Preview area is a list of folders and files.
Navigation pane: Just below the Preview area is a list of servers, storage devices, and folders available on your computer. Navigation arrows and a pop-up menu let you step forward or back through recently viewed folders and devices.

- **File stack:** When you select a server, device, or folder from the navigation pane, the contents of the selected item are shown in the lower area of the File Browser.

---

**View the File Browser**

If the File Browser is not visible in the Motion workspace, you can easily show it.

Do one of the following:

- Click File Browser in the top-left corner of the Motion workspace.

- Choose Window > File Browser (or press Command-1).

---

**Collapse or expand the pane containing the File Browser, Library, and Inspector**

- Click the “i” button in the lower-left corner of the Motion workspace.

---

If it’s your first import
By default, Motion places imported media files in your project at the location of the playhead (the current frame in the Timeline). You can change that setting to have imported media always placed at the start of your project (frame 1).

**Set the start point of imported media**

1. Choose Motion > Preferences (or press Command-Comma).

2. In the Project pane, set “Create Layers At” to one of the following:
   - *Current frame*: New media layers are added at the current playhead position.
   - *Start of project*: New media layers are added at the first frame of the project.

**Import standard media files**

You can import media files (video clips, audio clips, and still images) into a Motion project one at a time or severally.

**Note:** Although you can import iTunes and photo files via the File Browser, it’s better to add them via the iTunes and Photo categories in the Motion Library. When you add iTunes and photo files via the Library, you can browse for files using the playlist or photo album features. For more information, see Add iTunes and photo files from the Library.
Import media files into a Motion project

1. Navigate through the File Browser to locate media files to import.

   To open a folder in the File Browser, click a folder in the upper navigation pane, then double-click a folder in the lower pane; to return to a previously viewed folder, click the left arrow button beneath the preview area, or choose a folder from the pop-up menu beneath the preview area, or press Command-Up Arrow.

2. Select one or more files to import.

   In list view, Shift-click to select multiple contiguous files; Command-click to select multiple noncontiguous files.

3. To stop preview playback, move the pointer over the preview area and click the Pause button; to mute preview audio, click the Play/Mute button to the right of preview thumbnail.

4. Do any of the following:
   - Drag the file or files from the file stack to a location in the Canvas.
   - Click the Import button at the top of the File Browser to add the file or files to the center of the Canvas.
   - Drag the file or files into the empty lower area of the Layers list.
   - Drag the file or files into the empty lower area of the Timeline.
The media files appear in the Canvas and in the Layers list (as layers inside a new group at the top of the list).

![Image of Layers List]

**Import media files into an existing group in the Layers list**

You can also import media clips and images into an existing group in the Layers list.

1. Navigate through the File Browser and select one or more media files.

2. To nest the media files in an existing group in the Layers list, do one of the following:
   - Drag the files on top of a group in the Layers list. The imported files appear as new layers in that group, placed above existing layers in the group.
   - Drag the files between any layers in a group. A position indicator shows where the layers will be placed when you
release the mouse button.

- Drag the files into the Timeline, placing them between any layers nested in an existing group.

**Note:** For more information on adding objects to the Timeline, see *Timeline overview*.

---

## Import media files without using them in the composition

You can also add media files to your project without having them appear in the composition. You do this by dragging a file into the Media list, thereby storing media objects you might want to use in the future. When you import this way, the imported media does not appear in the Canvas or in the Layers list. However, the media remains available in the Media list.

1. In the Project pane, click Media to open the Media list.

2. Do one of the following:
   - Drag media files from the File Browser into the Media list.
   - Click the Add button (+) in the lower-left corner of the Project pane; then, in the Import Files dialog, select a file to add and click Import.
   - With the Media list active, choose File > Import (or press Command-I); then, in the Import Files dialog, select a file to add, and click Import.
   - Control-click in the Media list, choose Import Media from the shortcut menu, then add a file via the Import Files
To import an image sequence in the Import Files dialog, select the Image Sequence checkbox. If this checkbox is deselected, only files selected in the Import dialog are imported.

The resulting media objects are added to the Media list but don’t appear in the Canvas, Layers list, or Timeline.

**Import media files using the Import command**

You can also import media files without using the File Browser. To do so, use the Import command.

1. Do any of the following:
   - Choose File > Import (or press Command-I).
   - Control-click an empty area of the Canvas (in the gray area outside the project), then choose Import from the shortcut menu.

   The Import Files dialog appears.

2. Navigate to and select one or more media files, Shift-clicking to select contiguous items or Command-clicking to select noncontiguous items.

   If you’re selecting items from an image sequence, select the Image Sequence checkbox to have Motion use each image as a frame in a movie clip.
3. Click Import.

The media files appear in the Canvas, and as layers inside new groups at the top of the Layers list.

**Note:** When you import multiple files using the Import command, each media file is placed in a separate new group in your Motion project. However, when you import multiple files via the File Browser, the files are placed in a single new group in your Motion project.

---

**Import media files and create a new Motion project at the same time**

You can also create a new project for files at the time of import. To do so, use the Import as Project command.

1. Choose File > Import as Project or press Shift-Command-I.

The Import Files as Project dialog appears.

2. Navigate to and select the one or more media files, Shift-clicking to select contiguous items or Command-clicking to select noncontiguous items.

3. If needed, set the frame rate, aspect ratio, field order, and audio mix settings.

If you’re selecting items from an image sequence, select the Image Sequence checkbox to have Motion use each image as a frame in a movie clip.
4. Click Import as Project.

The media files appear in a new Motion project.

---

**Import layered Photoshop files**

You can also import layered Photoshop files. Many motion graphics professionals create layouts in Photoshop, then import the resulting multilayered file into Motion, where the layers are animated and combined with other imported and Motion-generated objects.

There are several ways to import layered Photoshop files:

- With all Photoshop layers merged together as a single Motion layer
- With each Photoshop layer preserved as a separate Motion layer, nested in a new group
- By choosing a single Photoshop layer

When you import all Photoshop layers as individual Motion layers, Motion places them in a new group in the Layers list and Timeline. Each layer retains the position, opacity, and blend mode of its corresponding original Photoshop layer.

Although you can import Photoshop text layers, the text appears in Motion as noneditable bitmap graphics.

The following Photoshop effects are not imported into Motion:

- Layer effects
Import a layered Photoshop file using the drop menu

1. Drag a layered Photoshop file from the File Browser into the Canvas, Layers list, or Timeline.

2. Before releasing the mouse button, pause until the Canvas drop menu appears and the pointer becomes curved. This menu presents commands for importing the layered file.

3. Continuing to hold down the mouse button, choose a command from the drop menu, then release the mouse button:
   - **Import Merged Layers**: All layers of the Photoshop file are collapsed into a single Motion layer.
   - **Import All Layers**: A group is created, and each layer of the Photoshop file is preserved as a separate Motion layer in this new group.
   - **[Individual layers]**: Each layer in the Photoshop file appears as a separate item in the drop menu. Selecting a layer adds only that layer to the project, where it appears as a
single Motion layer.

**Note:** When a Photoshop file contains more layers than can be displayed in the drop menu, the Choose Layer option appears in the drop menu. After you click the Choose Layer option, the Pick Layer to Import dialog appears.

---

### Add a layered Photoshop file using the Import command

1. Choose File > Import.

2. Select the layered Photoshop file to import, then click Import. The Pick Layer to Import dialog appears.

3. Choose a command from the Layer Name pop-up menu:
   - *Merged Layers:* All layers of the Photoshop file are collapsed into a single Motion layer.
   - *All Layers:* A group is created, and each layer of the Photoshop file is preserved as a separate Motion layer in this group.
   - *Individual layers:* Each layer in the Photoshop file appears as a separate item in the drop menu. Selecting a layer adds only that layer to the project, where it appears as a single Motion layer.

If you don’t like the layer you chose, you can pick a different one from the Photoshop file without deleting or importing again. You do so by selecting the recently imported
Photoshop layer, then choosing a different Photoshop layer from the Layer pop-up menu in the Properties Inspector.

Import image sequences

Sometimes, animated sequences are delivered as a series of sequentially numbered still images. Motion lets you import these sequences as a single object, with each image used as a sequential frame in a movie.

Import a series of numbered still images as a single object

1. Click the “Show image sequences as collapsed” button in the lower-right corner of the File Browser.

   ![](image)

   The File Browser displays multiple items collapsed into a single object.

2. Drag the object from the File Browser to the Canvas, Layers list, Timeline, or Media list.

   **Note:** Images from digital cameras are often numbered sequentially but are not part of an animation sequence. To import a single still image from a digital camera, deselected the
“Show image sequences as collapsed button.”

For more information, see About image sequences.

Sort and search in the File Browser

You can display and sort files in the File Browser in any of several ways. In the File Browser, you can also search for files located on your computer or on connected storage devices.

View the File Browser in list view

- Click the List View button in the lower-right corner of the File Browser.
View the File Browser in icon view

- Click the Icon View button in the lower-right corner of the File Browser.

Change the size of the icons while in icon view

Do one of the following:

- Click the Scale button in the lower-left corner of the File Browser, then drag the slider to the right to make the icons larger, or to the left to make them smaller.

- On a Multi-Touch trackpad, pinch open to make the icons larger or pinch closed to make the icons smaller.

Sort the File Browser list
When the File Browser is in list view, you can sort the list by any column. This can be helpful if you are looking for a specific file and know the approximate size or modification date.

- At the top of the file stack, click the header of the column to sort.

  The column header is highlighted and the contents of the window are sorted by that column.

### Search for a file

- Click the Search button at the bottom of the File Browser, then enter text in the Search field.

  The contents of the file stack are filtered to include only files whose names contain the entered text.

  **Note:** The Search field is not available unless the Search button is selected.

### Clear a file search

- Click the Clear button at the right side of the Search field.
Manage folders and files in the File Browser

In the File Browser, you can rename, move, or delete files. You can also change how files are displayed.

**WARNING:** Renaming, moving, or deleting folders or files via the File Browser affects those items on your computer or networked storage device. This can cause other Motion projects to list the affected media as missing. To relocate missing media, see [Reconnect offline media files](#).

---

Rename a folder or file

Do one of the following:

- Control-click the file or folder, and choose Rename from the shortcut menu; then, when the text field becomes active, enter the new name, and press Return.

- In the file stack, click the name of the folder or file once to select it, then click it again to activate the text field, enter the new name, and press Return.

---

Delete a folder or file

Do one of the following:

- In the file stack, Control-click the file, then choose Move to
Trash from the shortcut menu.

- Drag the file from the file stack to the Trash icon in the OS X Dock.

Create a folder

- Click the Add button (+) in the lower-left corner of the File Browser.

A new folder with the name “untitled folder” is added to your computer or networked storage device (in the location selected in the file stack of the File Browser).

Move a file into a folder

- In the file stack, drag the file onto a folder icon.

The file is moved inside that folder.

**Note:** Changes you make to your file structure in the Motion File Browser are reflected in the Finder.

Display the location of a file in the Finder
Preview a media file in a separate window

Do any of the following:

- **Open a file in a viewer window**: Control-click a file in the file stack, then choose Open in Viewer from the shortcut menu.
- **Open a file in QuickTime Player**: Control-click a file in the file stack, then choose Open in QuickTime Player from the shortcut menu.

About media file types

Supported media formats

You can import the following video, still image, and audio formats:

**QuickTime video codecs**

- Animation
- DV - PAL
- DV/DVCPro - NTSC
- DVCPro - PAL
- DVCPro HD 1080i50, 1080i60, 1080p25, 1080p30, and
720p50, 720p60
- DVCPRO50 - NTSC
- DVCPRO50 - PAL
- Uncompressed 8- and 10-bit 4:2:2
- HDV 1080i50, 1080i60, 1080p24, 1080p25, and 720p24, 720p25, 720p30
- Motion JPEG
- MPEG IMX 525/60 (30Mb/s, 40 Mb/s, 50 Mb/s)
- MPEG IMX 625/50 (30Mb/s, 40 Mb/s, 50 Mb/s)
- Photo - JPEG
- Apple ProRes 4444 XQ
- Apple ProRes 4444
- Apple ProRes 422 HQ
- Apple ProRes 422
- Apple ProRes 422 LT
- Apple ProRes 422 Proxy
- XDCAM HD 1080i50, 1080i60, 1080p24, 1080p25, 1080p30 (35 Mb/s VBR)
- H.263
- H.264

Other codecs
- MXF
Still image formats

- Photoshop
- BMP
- GIF
- JPEG
- PNG
- TIFF
- TGA
- OpenEXR

Other image formats

- Layered Photoshop files
- PDF files

Audio formats

You can import audio files with sample rates up to 192 kHz and with bit depths up to 32 bits. Mono and stereo files are supported. Multichannel audio files are also supported. Motion supports the following audio file types:

- AAC (listed in the Finder with the .m4p file extension)
- AIFF
Important: You cannot import rights-managed AAC files, such as non-iTunes Plus tracks purchased from the iTunes Store.

For more information about the file formats supported by Motion, go to the Motion website at http://www.apple.com/finalcutpro/motion.

About QuickTime movies

Motion supports QuickTime movies using any file format (codec) installed on your computer.

Although you can import movies in nearly any codec, avoid using highly compressed clips in projects. Excessively compressed clips can display undesirable visual artifacts. Fortunately, QuickTime provides many codecs ideal for moving uncompressed or minimally compressed video files between applications, including Apple ProRes 4444 XQ, Apple ProRes 4444, Apple ProRes 422 HQ, Apple ProRes 422, Uncompressed 8- and 10-bit 4:2:2, Pixlet, None, Animation, Apple M-JPEG A and B, DVCPRO-50, and DV/DVCPRO.

Some codecs support alpha channels, which define areas of transparency in the clip. If a QuickTime clip has an alpha channel, Motion uses the alpha channel in your project.

You can combine clips that are compressed with different codecs in the same project. You can also combine clips that have
different frame sizes, pixel aspect ratios, and interlacing.

About high-resolution still image files
You can import still image files using most popular still image formats, including SGI, Photoshop, BMP, JPEG, TIFF, TGA, and JPEG-2. As with video clips, you can mix still image files with differing frame sizes and pixel aspect ratios. For a full list of eligible file types, see Supported media formats.

A common and effective use of still images in motion graphics work is the animation of high-resolution files. The dots per inch (DPI) qualification as defined in programs like Photoshop does not apply to video. If the dimensions of an imported image are larger than the frame size of the Motion project, the image extends beyond the borders of the Canvas.

You can reduce the scale of the image to fit the project’s frame size. You can also animate the image’s Scale parameter (in the Properties Inspector) to zoom into or out of the image, or animate its Position parameter to pan the image.

Because Motion is graphics-card dependent, file-size import limitations vary from computer to computer. When you import an image that is too large, an alert dialog appears, stating: “This media is too large to render at full resolution, and will be shown at a lower quality.” Click OK to import the image at a lower quality. For more information on recommended graphics cards, visit the Motion website at http://www.apple.com/finalcutpro/motion.

For guidelines about working with high-resolution graphics, see About high-resolution graphics.
When you import a still image, the image assumes a duration equal to the current duration of the project. Increasing the duration of the project does not increase the duration of an image that’s imported. Still images have infinite duration in Motion, so you can stretch them in the Timeline to be as long as necessary. For more information about modifying objects in the Timeline, see Timeline overview.

Set the import size of large still images

You can set an option in the Preferences window to import large still images at their original size or scaled to fit the Canvas size.

1. Choose Motion > Preferences (or press Command-Comma).

2. In the Still Images & Layers area of the Project pane, click the Large Stills pop-up menu and choose a setting.
There are two options:

- **Do Nothing**: Imports the image at its original size.

  In the following example, a 2311 x 1525 image is imported into a Broadcast HD 1080 project (1920 x 1080) with Do Nothing selected in Preferences. The image is larger than the Canvas.

- **Scale to Canvas Size**: Imports and scales the image to fit the project size while maintaining the image’s native aspect ratio.

  In the following example, the same image is imported with Scale to Canvas Size selected in Preferences.
The image is scaled—the equivalent of using the Select/Transform tool to scale down the image in the Canvas while pressing Shift.

To confirm that the image is merely transformed and has not changed resolution, you can select the image file in the Media list, then open the Media Inspector.

The Fixed Width and Fixed Height parameters display the resolution of the original file.
About image sequences

Numbered image sequences store video clips as individual still image files. Each image file has a number in the filename that indicates where it fits into the sequence. In a film clip that’s been digitally scanned, each file represents a single frame. In a video clip that’s been converted to an image sequence, each file contains both fields of a single video frame, with the upper and lower lines of the image saved together.

Image sequences use the same variety of file formats as still image files. Some of the most popular formats for saving image sequences include SGI, BMP, JPEG, TIFF, and TGA. Like still image formats, many of these image sequence formats support alpha channels, which are used by Motion.

Because image sequences have been around for so long, they remain the lowest-common-denominator file format for exchanging video across editing and compositing applications. Although QuickTime is increasingly used to exchange video clips between platforms, image sequences are still used, especially in film compositing.

As with QuickTime video clips, you can mix image sequences of
different formats, using different frame sizes, pixel aspect ratios, frame rates, and interlacing.

**Important:** Any imported image sequence must contain three or more digits of padding—for example, “imagemame.0001.tif.”

### Collapse image sequences

The “Show image sequences as collapsed” button at the bottom of the File Browser lets you display image sequences as a single object, rather than as the collection of files on your disk.

![Click to collapse or expand image sequences.](image)

**Note:** You can turn this feature off for numbered image files that aren’t used as an image sequence. For example, pictures taken with digital cameras often have numbered filenames that can be mistaken for an image sequence.

### About PDF files

The PDF file format is a PostScript-based document format that accommodates PostScript-based graphics and text, as well as bitmap graphics. Areas of transparency in a PDF file are also transparent in Motion.

PDF files are capable of storing PostScript-based illustrations. Unlike graphics file formats such as TIFF and JPEG, which save images as a collection of pixels at a given resolution divided into
red, green, and blue channels, PostScript-based illustrations are saved as mathematical descriptions of how the artwork is drawn. As a result, PDF files using PostScript-based artwork and text have infinite resolution.

The practical difference between bitmap files and PostScript-based files is that scaling a bitmap beyond 100 percent results in the image progressively softening the more you increase its size. PostScript-based illustrations remain sharp and clear no matter how large or how small you scale them.

When importing a PDF file, its size is relative to the original page size of the file. As a result, even small graphics can have a large frame size, with empty space surrounding the graphic. When exporting a graphic as a PDF file for use in Motion, you may want to scale the graphic to fit the page dimensions, or reduce the page size in the source application’s page preferences to fit the graphic’s dimensions.

**Fixing the resolution of a PDF object**

Although PDF files have unlimited resolution, large PDF objects can consume a lot of video memory, which can hinder performance in Motion. To avoid this problem, limit the resolution of each PDF image to save video memory. By using fixed-resolution parameters, the files are rendered once, ensuring better performance.

The fixed-resolution parameters for PDF objects are adjusted in the Media Inspector. Select the PDF source media in the Media list to activate the Media pane of the Inspector. Adjust the following controls to modify the PDF’s fixed-resolution parameters:
• **Pixel Aspect Ratio**: A pop-up menu to assign a nonsquare pixel aspect ratio to the file. In most cases, the “From file” menu option is the best choice because it assigns the PDF source file’s native aspect ratio. Choose a different menu item only if you want to override that native setting.

• **Fixed Resolution**: A checkbox that, when selected, fixes the resolution of PDF source media to the size specified in the Fixed Width and Fixed Height sliders.

• **Fixed Width**: A slider to set the maximum horizontal resolution to which a PDF object can be smoothly scaled.

• **Fixed Height**: A slider to set the maximum vertical resolution to which a PDF object can be smoothly scaled.

• **Use Background Color**: A checkbox that, when selected, substitutes a custom background color for transparent portions of the PDF. Choose the background color in Background Color controls (described below).

• **Background Color**: Color controls (available when Use Background Color is selected) to set the background color for transparent portions of the PDF.

• **Crop**: Sliders (Left, Right, Bottom, and Top) to crop the edges of the PDF image, if necessary. These controls crop the PDF source media (and all layers linked to that source media). To crop an individual layer, use the Crop parameters in the layer’s Properties Inspector.

---

**Mixed content in PDF files**

Although PDF files can contain a mix of PostScript-based art,
PostScript text, and bitmapped graphics, each format has different scaling properties. PostScript-based art and text scale smoothly, but bitmapped graphics embedded in a PDF file are subject to the same scaling issues as other bitmapped graphics formats. As a result, bitmapped graphics can soften if scaled larger than their original size.

**Note:** Form objects, buttons, and JavaScript objects that are present in an imported PDF file do not appear in Motion.

### Multipage PDF files

You can import multipage PDF files. When you do, a parameter called Page Number appears in the Properties Inspector when the PDF object is selected. Drag the slider to set which page is displayed in the Canvas. Animate this parameter to display different pages over time.

**Important:** Multilayered PDF files are not supported. To import a multilayered illustration, export each layer as a separate PDF file and import these as a nested group of objects in Motion.

### About alpha channels

Ordinary video clips and image files have three channels of color information: red, green, and blue. Many video and image file formats also support an additional alpha channel, which contains information defining areas of transparency. An alpha channel is a grayscale channel where white represents areas of 100 percent opacity (solid), gray regions represent translucent areas, and black represents 0 percent opacity (transparent).
When you import a QuickTime movie or an image file into a project, its alpha channel is immediately recognized by Motion. The alpha channel is then used to composite that object against other objects behind it in the Canvas.

There are two ways to embed alpha channel information into files. Motion attempts to determine which of these methods a media file uses:

- **Straight**: Straight alpha channels are kept separate from the red, green, and blue channels of an image. Media files using straight alpha channels appear fine when used in a composition, but they can look odd when viewed in another application. Translucent effects such as volumetric lighting or lens flares in a computer-generated image can appear distorted until the clip is used in a composition.

- **Premultiplied**: The transparency information is stored in the alpha channel as well as in the visible red, green, and blue channels, which are multiplied with a background color (generally black or white).

The only time it really matters which kind of alpha channel an object has is when Motion doesn’t correctly identify it. If a media item’s alpha channel is set to Straight in the Media list when it’s really premultiplied, the image can appear fringed with the premultiplied color around its edges. If this happens, select the problematic item in the Media list, then change its Alpha Type parameter in the Media Inspector.

**About audio files**

You can import many audio file formats into your project, including
WAV, AIFF, .cdda, MP3, and AAC. Although Motion is not a full-featured audio editing and mixing environment like GarageBand or Logic Pro, you can import music clips, dialogue, and sound effects. If you import a QuickTime file with mono or stereo tracks of audio, the audio appears in the Audio Timeline.

You can import audio clips with various sample rates and bit depths. When you do, Motion resamples audio tracks to the sample rate and bit depth used by your computer. The default is 16-bit, 44.1 kHz float for the built-in audio interface. If you use a third-party audio interface, audio is remixed to the sample rate and bit depth used by that device.

You can import audio files with sample rates up to 192 kHz and with bit depths up to 32 bits. Mono and stereo files are supported. Multichannel audio files are also supported.

For more information about file formats Motion supports, see Supported media formats. For more information on using audio in Motion, see Audio overview.

A seamless way to browse for and import music from your iTunes library is to use the Music category in the Motion Library. For more information, see Add iTunes and photo files from the Library.

Note: You cannot import rights-managed AAC files, such as non-iTunes Plus tracks purchased from the iTunes Store.

About text files
Motion can read and work with a variety of text files, both as media elements and as text data to incorporate in generators,
particle systems, and replicator effects. For more information, see Add text.

Add Library content

Library overview

Motion ships with a collection of built-in art content and effects (text styles and fonts, animated graphics, filter effects, and so on) that you can use in your projects. This content is available in the Library, which is displayed on the left side of the Motion workspace (next to the File Browser). Navigating the Library is similar to navigating the File Browser.

The Library is divided into several areas:

- **Preview area:** At the top of the Library, a thumbnail image displays a video preview of content selected in navigation areas of the Library (special effects, text styles, graphical art, and so on).

- **Navigation pane:** Just below the preview area is a two-column pane displaying the categories and subcategories of content and effects available in Motion. Navigation arrows let you step forward and back through recently viewed categories of content. A pop-up menu lets you filter content by theme (Abstract, Sci-Fi, Urban, and so on).

- **Library stack:** When you select a category and subcategory in the navigation pane, the contents of the subcategory are shown in the lower area of the Library.
View the Library

If the Library is not visible in the Motion workspace, you can easily
Click Library in the top-left corner of the Motion workspace.

Choose Window > Library (or press Command-2).

Collapse or expand the pane containing the File Browser, Library, and Inspector

Click the “i” button in the lower-left corner of the Motion workspace.

Categories of Library content

The Library contains the following categories of content that you can add to your project:

- **Behaviors**: Sophisticated animation and simulation effects (Spin, Grow, Gravity, and so on) that you can apply to objects
and images in your project. Some behaviors can only be applied to specific objects. For example, Text Animation and Text Sequence behaviors can only be applied to text objects. For more information, see Apply behaviors overview.

- **Filters**: Special effects used to modify the appearance of images, objects, and video clips in your project. You can apply filters to create artistic effects (blurs, glows, stylized looks), to perform image corrections (color balancing, sharpening), or to create complex compositing effects (green screen keying). Third-party FxPlug filters appear in the category to which they belong. Most filters can be applied to any layer (text, images, shapes, video footage, particles, and so on) in your project. For more information, see Filters overview.

- **Generators**: Computer-generated art such as checkerboards, noise patterns, color rays, and animated text objects that you can add to your projects. For more information, see Generators overview.

- **Particle Emitters**: Animated swarms of small particles that let you add effects ranging from simulations of smoke, fire, and explosives to animated abstract textures. All premade particle systems can be customized after you add them to your project. For more information, see Particles overview.

- **Replicators**: Patterns of repeating elements used to create kaleidoscopic effects (static or animated) in your compositions. All premade replicators can be customized after you add them to your project. For more information, see Replicator overview.

- **Shapes**: Premade geometrical forms that you can use as visual elements or as image masks in your project. Each
shape is a Bezier shape and can be customized using Motion’s shape-editing tools. For more information, see Shapes, masks, and paint strokes overview.

- **Gradients**: A selection of premade color spreads that can be applied to shapes, text, particles, and replicators in your project. For more information, see Gradient editor controls.

- **Fonts**: A browser containing all the fonts available on your computer, organized into subcategories based on the categories defined in the Font Book application. Simply select a font, then apply it to text in your project. For more information about Font Book, see Mac Help (in the Finder, choose Help > Mac Help). For more information about using fonts in Motion, see Preview and apply fonts.

- **Text Styles**: Thematic type styles (Antique, Fantasy, Grunge, and so on) that let you modify the look of 2D text and 3D text in your project. For more information, see Use preset text styles.

- **Shape Styles**: Preset shape styles that add artistic line strokes (Abstract, Flora, and Liquid, for example) to shapes in your project. For example, dragging a shape style onto a shape instantly applies that style. For more information, see Shapes, masks, and paint strokes overview.

- **Materials**: Preset 3D text materials that give 3D text a natural and realistic appearance, as they respond to lighting, exhibit reflectiveness, and so on. All premade materials can be customized after you add them to your project. See Materials overview.

- **iTunes**: A browser for locating and importing files from your iTunes library. The subcategories include the library and
playlists created in iTunes. The contents of each playlist appear in the Library stack. See Add iTunes and photo files from the Library.

- **Photos:** A browser for locating and importing image files from your selected photo library. The contents of each photo album or photo library appear in the Library stack. The photo application that is available in the Photos category of the Motion Library is set in the General pane of Motion Preferences. See Add iTunes and photo files from the Library.

- **Content:** Graphical elements used in the templates and presets that ship with Motion. Use these images, text elements, patterns, and animations to create custom design elements, such as particles and replicators, which can be saved to the Library for later use.

- **Favorites:** A place to save objects—built-in or custom-made in Motion—for future use, including cameras, layers, or groups. You can also place frequently used media files (such as PDF or TIFF files) into the Favorites category. Objects you place in the Favorites category are available to every project you create in Motion.

- **Favorites Menu:** Objects you place in the Favorites Menu folder appear in the Favorites menu, for even faster access. When you choose an item from the Favorites menu, that item is placed into the selected layer and is positioned at the center of the Canvas. Objects you put in the Favorites Menu are available to every project in Motion.

Add Library content to a project
You can add Library content (special effects and premade graphical elements) to a project in several different ways.

## Add Library content to a project

1. Navigate through the Library, selecting a category and subcategory in the navigation pane and an item in the Library stack.

   For example, select the Filters category, select a filter subcategory, then select a filter in the Library stack.

   A preview of the selected Library item appears in the preview area.

2. Do either of the following:
   - Click the Apply button to the right of the preview area.
   - Drag the item from the Library stack to a location in the Canvas, or into the empty lower area of the Layers list or Timeline.

   The item is placed inside a new group at the top of the Layers list and Timeline, and the content appears in the Canvas or under the selected layer in your project.

**Note:** Some categories of Library content are designed to modify specific types of layers. For example, items in the Text Styles category of the Library can only be applied to text layers in your project. If nothing happens when you try to add a Library item, make sure you’ve applied it to a suitable group.
Add Library content to a specific group or layer in a project

1. Navigate through the Library, selecting a category and subcategory in the navigation pane and an item in the Library stack.

   For example, click the Filters category, click a filter subcategory, then click a filter in the Library stack.

   A preview of the selected Library item appears in the preview area.

2. Do either of the following:
   - Select a specific group or layer in the Layers list or Timeline, then click Apply in the preview area.
   - Drag the item from the Library stack to a specific group or layer in the Layers list or Timeline.

   The item is placed in the group or applied to the layer.

**Note:** Some categories of Library content are designed to modify specific types of layers. For example, items in the Text Styles category of the Library can only be applied to text layers in your project. If nothing happens when you try to add a Library item, make sure you’ve applied it to a suitable group or layer.
There’s an additional way to add generators, behaviors, and filters—using the pop-up menus in the toolbar. For more information, see Add a generator, Apply and remove filters, and Add, remove, and disable standard behaviors.

Add iTunes and photo files from the Library

You can add files from your iTunes library and photo application libraries to a project via the Motion Library. The iTunes and photo content appear in two Library categories, iTunes and Photos. (However, you cannot import rights-protected video content from iTunes into a Motion project.)

Note: Although a connected iPod appears in the File Browser as a hard disk, you can only browse for and import iPod files that are stored as data. Music transferred to the iPod via iTunes cannot be imported into Motion.

Add a file from iTunes

1. In the Library, select the iTunes category.

   The iTunes library content appears in the adjacent navigation pane. By default, All is selected (the iTunes library).

2. Select a subcategory, such as Music or Podcasts, then select a file from the stack.
3. Do one of the following:
   - Click the Apply button to the right of the preview area.
   - Drag the file to the Canvas, Layers list, Timeline, or Audio Timeline (if the file is an audio track or is a video that contains audio).

**Note:** Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes non-iTunes Plus music purchased from the iTunes Store.

For more information on working with audio files, see [Audio overview](#).

---

### Add a file from a photo application

1. In the Library, select the Photos category.

   The albums (or libraries) appear in the adjacent navigation pane. By default, All is selected.

   **Note:** The photo application that is available in the Photos category of the Motion Library is set in the General pane of Motion Preferences. Only one application may be selected at a time. For more information, see [General preferences](#).

2. Select an album, then select a file from the stack.

3. Do one of the following:
   - Click the Apply button to the right of the preview area.
   - Drag the file to the Canvas, Layers list, or Timeline.
Note: When importing large-scale images into Motion, you can import the files at their native resolution or at the resolution of the Motion Canvas. For more information, see Set the import size of large still images.

Sort and search in the Library
You can display and sort content in the Library in any of several ways. You can also search for library content.

View the Library in list view

- Click the List View button in the lower-right corner of the Library.

View the Library in icon view

- Click the Icon View button in the lower-right corner of the Library.
Change the size of the icons while in icon view

- Click the Icon Scale button in the lower-left corner of the Library, then drag the slider to the right to make the icons larger, or to the left to make them smaller.

- On a Multi-Touch trackpad, pinch open to make the icons larger or pinch closed to make the icons smaller.

Sort using the Theme pop-up menu

The Theme pop-up menu under the preview area lets you sort Library content by thematic categories such as Abstract, Nature, Sci-Fi, and so on.

Do one of the following:

- Select a category in the Library sidebar or stack, then click the Theme pop-up menu and choose a theme.

- To sort using the default themes, select the Content category, then click the Theme pop-up menu choose an item.

Search for Library content
Click the Search button at the bottom of the Library, then enter text in the Search field.

**Note:** The Search field is not available unless the Search button is selected.

---

**Clear a file search**

- Click the Clear button at the right side of the Search field.

---

**Manage Library folders and files**

Although you can’t modify the effects, elements, and folders built into Motion, you can organize custom effects, elements, and folders in the Library the same way you manipulate files in the Finder. You can create folders and delete certain files or folders.

You can also easily create, save, and organize files and themes in the Library.

---

**Create a new folder in the Library**

You can create new folders in the subcategory column (the
second column) or in the stack (the area under the category and subcategory columns) to better organize your custom Library content.

Do any of the following:

- **Create a new folder in the subcategory column**: Select a category, select the All folder in the subcategory column, then click the New Folder button (+) in the lower-left corner of the Library.

  A new, untitled folder appears in the subcategory column.

- **Create a new folder in the stack**: Select a category, select the subcategory to contain the new folder, then click the New Folder button (+) in the lower-left corner of the Library.

  A new, untitled folder appears in the stack.

For more information on saving custom Library content, see [Save custom objects to the Library](#).

---

**Rename a custom folder or file**

Do one of the following:

- **Rename a subcategory folder**: In the subcategory column, click the name of a custom folder once to select it, click it
again to activate the text field, enter a new name, then press Return.

 Rename a file or folder in the stack: In the stack, Control-click a custom file or folder, choose Rename from the shortcut menu, enter a new name, then press Return.

**WARNING:** Renaming a custom folder or file in the Library renames the item on your computer or networked storage device. If projects use files from the originally named folder, Motion may list the item as missing.

---

**Remove custom objects or folders from the Library**

 Select a custom folder in the subcategory column or stack (or a custom object in the stack), then do one of the following:

- Choose Edit > Delete.
- Press Command-Delete.

**WARNING:** Deleting a custom folder or file in the stack removes that item from your computer or networked storage device and places the item in your Trash.

---

**Delete a folder or file**

 Select a custom file in the Library stack, Control-click the custom file, then choose Move to Trash from the shortcut menu.
Move a file into a folder

In the Library stack, drag the file onto the folder icon.

The file is moved inside that folder.

When Library media becomes unavailable

As with any other object used in a Motion project, Library media must be present and installed on your computer for that media to appear correctly in Motion. If someone gives you a project file and you don’t have the same filters or fonts used in the file, a warning appears when you open the project, listing the items that are unavailable.

You can close the project and install the necessary files on your computer, or you can open the file. When you open a file with missing media, the following occurs:

- **Missing Content:** Missing content is treated like any other missing media item. For more information about reconnecting media, see Reconnect offline media files.

- **Missing Filters:** When a filter is missing, a placeholder object appears in the Layers list and Timeline. When you reinstall the missing filter, the filter object replaces the placeholder, and the effect is applied properly.

- **Missing Fonts:** When fonts are missing, the text objects that use those fonts default to Helvetica as a temporary substitute.
Work with Library themes

Library themes help you organize projects that may share objects by allowing you to label specific objects with a default theme, such as Abstract, Nature, or Sci-Fi, or to assign objects to a custom theme. By default, some preset Library objects are assigned to a theme. For example, the *Hypnotic* particle emitter preset is in the Sci-Fi category.

**Note:** Library themes are different from the themes in the Themes pop-up menu of the Project Browser. Project Browser themes are applied to entire Motion projects and shared between Motion and Final Cut Pro X when creating templates. For more information on creating templates for Final Cut Pro, see Final Cut Pro templates overview.

Sort using the Theme pop-up menu

- Select a category or subcategory in the Library sidebar, then choose a theme from the Theme pop-up menu.

  Items belonging to the chosen theme appear in the stack.

Create a new custom theme
1. In the Library, below the preview area, choose New Theme from the Theme pop-up menu.

2. In the Create New Theme dialog, type a theme name, then click OK.

A new theme is added to the Library. New themes appear in the Theme pop-up menu.

Custom themes are saved in the “themes” document in your/Users/username/Library/Application Support/Motion/Library/folder.

---

### Assign a theme to custom content

- Control-click a custom item in the Library stack (such as a shape saved to the Favorites folder), choose Theme from the shortcut menu, then choose a theme from the submenu.

An item must be saved in the Library before you can assign a theme. For more information, see Save custom objects to the Library.

Items that can be assigned a theme include the following:

- Replicators
- Emitters
- Shapes
- Gradients
- Text styles
- Shape styles
• Shape styles
• Layers or groups

Note: You cannot assign a theme to behaviors, filters, fonts, images, image sequences, or movies.

Remove a custom theme

1. Choose the theme to remove from the Theme pop-up menu.

   The Remove Theme item becomes available in the Theme pop-up menu.

2. Choose Remove Theme from the Theme pop-up menu.

   The theme is removed from the list.

Note: You can only remove custom themes.

Save custom objects to the Library

You can save nearly any object in Motion to the Library, including animated cameras and lights, customized behaviors, filters, particle systems or replicators, shapes and text, as well as layers and groups. After an object is placed in the Library, it can be added to a project like any other element in the Library.

You can save multiple objects to the Library as one file or multiple files. For example, if you create an effect using multiple filters and you want to save the cumulative effect of those filters to apply to
other objects, you can save the filters as one item in the Library.

Although you can save custom objects into their namesake folders, it is better to save customized objects that you use frequently to the Favorites category. Because some Motion Library categories contain numerous items, placing custom items in the Favorites or Favorites Menu categories can save you search time. In the Favorites category, you can create additional folders to better organize custom items.

**Note:** You can create folders in the built-in categories, such as the Color Correction filters subcategory; however, those folders only appear in the Library stack and not the sidebar. Folders added to the Favorites category appear in the Library sidebar.

---

## Save a custom object to the Library

1. Open the Library and select the Favorites or Favorites Menu category, or another category.

   **Note:** To save a custom object to a category other than the Favorites or Favorites Menu category, the object type must match the category. For example, you can save custom filters to the Filters category, but not to the Behaviors category or Generators category.

2. Drag a customized object from the Layers list, Timeline, or Inspector into the stack at the bottom of the Library.

   The item is saved to the Library in the category you selected, and appears with a custom icon.
When you save a customized item, it’s placed in the /Users/username/Library/Application Support/Motion/Library/ folder.

Save multiple custom objects to the Library

1. Open the Library and select the Favorites or Favorites Menu category, or another category.

   **Note:** To save a custom object to a category other than the Favorites or Favorites Menu category, the object type must match the category. For example, you can save custom filters to the Filters category, but not to the Behaviors category or Generators category.

2. In the Layers list, select all objects to save and drag them to the stack, holding down the mouse button until a drop menu appears.

3. Choose “All in one file” or “Multiple files” from the drop menu, then release the mouse button.

   “All in one file” saves objects together, as one item in the Library. “Multiple files” saves them as individual objects in the Library.

   **Note:** When saving objects of different types, it’s best to save them to the Favorites or Favorites menu category (or a folder you specifically create) for organizational purposes. If multiple objects of different types are saved, such as a shape with an applied behavior and text, the objects are added to the Content folder as “Untitled.”
Create a custom note for a saved Library object

- Control-click the icon in the Library stack, choose Edit Description from the shortcut menu, enter notes in the dialog that appears, then click OK.

For information about renaming and organizing custom Library content, Manage Library folders and files.

Manage source media

Source media overview

When you import an external media file into a Motion project, two things occur:

- An instance of that media (an image or video clip) is placed in your project, and is visible in the Layers list, Canvas, and Timeline.

- A link to the external source media file on your computer or other connected device is shown as an item in the Media list in the Project pane.
Media used in Motion must remain connected to the source media files on your computer or networked device. If you move, delete, or rename external media files that correspond to media used in a Motion project, the source media link (in the Media list) and any layers in your project using that source media go “offline.” It’s easy to reconnect offline media in your project (as long as the external files are still available on your computer or networked device). For more information, see Reconnect offline media files.

Because Motion is a nondestructive effects application, changes you make to media layers in your project are not applied to the external media on your computer or connected device. Rather, any changes you make to a media layer are applied to the instance of the media in Motion.

You can view information about source media in two places in the Motion workspace:

- **Media list**: The second list in the project pane, itemizes all source media files (audio, image, image sequence, and QuickTime movie files) in your project. The items in this list are links to source media files that remain on your computer or networked device. Applied effects (such as filters or behaviors) and graphics content created in Motion (such as masks, shapes, or text) do not appear in the Media list. Columns in the Media list display information about each source file, including format, duration, frame rate, and so on. For more information, see Media list overview.

- **Media Inspector**: Available when you select a media item the Media list, displays information about the selected source media file (format, duration, frame rate, and so on). The Media Inspector also contains adjustable media controls for
modifying instances of the source media file used in your project. For more information, see Display the Media Inspector.

View source media information

Media list overview

The Media list (the second list in the Project pane) itemizes all media files (audio, image, image sequence, and QuickTime movie files) in the project. Items in this list are links to source media files that remain on your computer or networked storage device. Applied effects (such as filters or behaviors) and graphics content created in Motion (such as masks, shapes, or text) do not appear in the Media list.

The columns in the Media list contain information about each media item, in the following categories:

- **Preview**: Displays a thumbnail of the media object.
- **Name**: Lists the filename of the source media on disk where the object is linked. If you change the name of corresponding linked objects in the Layers list, this name doesn’t change.
- **Kind**: Lists the type of file—still image, QuickTime movie, image sequence, or audio file.
- **In Use**: Indicates that the media is in use in the project.
- **Duration**: Displays the total duration of the object, in frames or timecode, depending on what is displayed in the Timeline.
- **Frame Size**: Displays the frame size of the object, in pixels.
- **Format**: For QuickTime movies, displays the codec used. For other media files, this column is empty.
- **Format**: For QuickTime movies, displays the codec used. For still images, displays the method of compression that is applied based on the file type.

- **Depth**: Specifies the color depth of the image.

- **Vid Rate**: Displays the video frame rate of the object, in frames per second.

- **Aud Rate**: For audio files and QuickTime movies, displays the sample rate of the audio.

- **Aud Bit Depth**: For audio files and QuickTime movies, specifies the bit depth of the audio.

- **File Size**: Shows the size of the source media file on disk.

- **File Created**: Shows the file creation date of the source media file on disk.

- **File Modified**: Shows the file modification date of the source media file on disk. This is a useful parameter for file management.

**SEE ALSO**

Display, sort, and search the Media list
Source media controls in the Media Inspector

Display, sort, and search the Media list
Customize your view of the Media list to see the information most important to you.
Display the Media list

Do one of the following:

- If the Project pane is visible, click Media at the top of the pane.
- Choose Window > Media (or press Command-5).

The Media list opens.

Display and adjust columns in the Media list

Do any of the following:

- To display all visible columns in the Media list, drag the scroller at the bottom of the Media list.

- To show or hide a column, Control-click a column header, then choose the item to show or hide from the shortcut menu.
Items in the list with a checkmark are displayed in the Media list. Items with no checkmark are hidden.

- To reorder the columns, drag a column header left or right to a new position.

- To adjust column width, drag a column border to resize the width in the header row.

- To adjust row height, do one of the following:
  - Position the pointer over a horizontal line and drag up or down to decrease or increase the height of all rows. Icons and thumbnails resize themselves as you make the adjustment.
  - Click the Scale button at the bottom of the Media list, then drag the slider left to decrease row height or right to increase row height.
Sort Media list items in a column by file type

- Click the column header.

The layers are sorted in the column and a small arrow in the column header indicates the direction of the sort. To reverse the direction of the sort, click the column header.

Search for specific items in the Media list

- Click the Search button at the bottom of the Media list, then enter the name of items to view in the Search field.

As you type in the Search field, the Media list is filtered to show items containing the text you type.

To stop filtering and return to the complete list, click the Clear
Reveal source media

Occasionally, you may need to find source media used in your project, to access additional information about an imported media file, or to locate the external file on your computer or networked storage device.

Show a layer’s source media link in the Media list

Do one of the following:

- Control-click a layer in the Canvas, Layers list, or Timeline, then choose Reveal Source Media from the shortcut menu.
- Select a layer, then choose Object > Reveal Source Media (or press Shift-F).

The Media list opens, with the source media selected. The Media Inspector also opens, displaying information about the source media.

Find external source media used in your project
Open the Media list, Control-click a media item, then choose Reveal in Finder from the shortcut menu.

A Finder window appears, and the external source media file used in your project is highlighted.

Adjust source media parameters

Display the Media Inspector

The Media Inspector displays adjustable parameters that define how an image or movie clip is displayed and composited in the project. These parameters define the source media’s essential properties, including frame rate, pixel aspect ratio, interlacing, and alpha channel parameters. There are also parameters that allow you to define source media’s end condition, reversal, cropping, and timing.

Open the Media Inspector

Open the Media list (the second list in the Project pane), select a media item, open the Inspector, then click the Media tab.

The Media Inspector shows adjustable parameters for and information about the selected item in the Media list. For information about adjusting source media parameters, see Source media controls in the Media Inspector.
Source media controls in the Media Inspector

Motion attempts to interpret the correct parameter settings for each source media item you add to a project. However, additional manual adjustment is sometimes necessary. Because Motion is a nondestructive application, changes made to these parameters are not applied to the source media files on disk. Parameter changes affect how objects are drawn in Motion.
The following controls let you modify source media in the Media list. Modifying source media modifies all layers in a project linked to that source media.

**Note:** The parameters described below do not apply to Photoshop files imported as separate layers. And PDF files with transparent backgrounds do not have the Alpha Type or Invert Alpha options.
Alpha parameters.

- **Alpha Type:** A pop-up menu to set how Motion deals with alpha channels in the media item. An alpha channel contains information about areas of transparency in the image or movie. When you import an image file or QuickTime movie that has an alpha channel, its alpha channel is immediately recognized by Motion. There are several different ways to embed alpha channel information into files, which correspond to the options in this menu. Motion assigns an option based on an analysis of the object when it’s imported, but you can override the default if necessary, by choosing any of the following:

  - **None/Ignore:** The default setting for objects with no alpha channel. This option also allows you to ignore an object’s alpha channel, so the entire object appears solid.

  - **Straight:** These alpha channels are kept separate from the red, green, and blue channels of an image. Media files using straight alpha channels appear fine when used in a composition, but they may look odd when viewed in another application. Translucent effects such as volumetric lighting or lens flares in a computer-generated image can appear distorted until the clip is used in a composition. If Straight is chosen but you see a black, white, or colored fringe around the object, this parameter is incorrectly set and should be changed to a Premultiplied option, depending on the color of the fringe.

  - **Premultiplied–Black:** This type of alpha channel is multiplied with the clip’s red, green, and blue channels. As a result, objects with premultiplied alpha channels look correct, even with translucent lighting effects, because the
entire image is precomposited against a solid color. This option interprets alpha channels that are precomposited against black.

- **Premultiplied–White**: This option interprets alpha channels that are precomposited against white.

- **Guess Alpha Type**: This option forces Motion to analyze the file in an attempt to figure out what kind of alpha channel is used. If you’re unsure, use this setting.

- **Invert Alpha**: A checkbox that, when selected, inverts an alpha channel that is incorrectly generated in reverse. Ordinarily, an alpha channel is a grayscale channel, where white represents areas of 100 percent opacity (solid), gray regions represent translucent areas, and black represents 0 percent opacity (transparent).

- **Pixel Aspect Ratio**: A pop-up menu to set the type of pixel relevant to the project, square or nonsquare. In general, objects created for computer display, film, and high-definition video use square pixels, while objects created for some video formats (such as DV, HDV, DVCPRO HD, and others) use nonsquare pixels. A value field to the right of this pop-up menu displays the numeric aspect ratio, in case you need a custom ratio. By correctly identifying each object you add to your project, you can mix and match both kinds of media.

- **Field Order**: A pop-up menu to choose a field order that matches the field order of the device used to capture an interlaced clip. There are two choices: Upper (Odd) or Lower (Even). If you choose incorrectly, you’ll notice that the video stutters during playback. When this happens, choose the opposite field order. Clips shot on film or with a progressive scan video camera have no interlacing; therefore Field Order
should be set to None. By correctly identifying each object in your project, you can mix and match clips with a different field order. For more information, see Field order.

- **Frame Rate:** A pop-up menu to choose a frame rate in frames per second (fps) that matches a clip’s native rate. For example, film is 24 fps, PAL video is 25 fps, and NTSC video is 29.97 fps. Additional frame rates are available for other video formats. If the frame rate you require is not listed, enter a number in the text field to the right of the pop-up menu. If you modify a QuickTime file’s frame rate but need to change it back to the file’s original rate, choose “From file” at the bottom of the Frame Rate pop-up menu.

Although you can mix clips using different frame rates, clips playing at a frame rate different from that of the project might not play smoothly.

**Note:** Project frame rates are determined by the project preset. To edit a preset or to create a preset, choose Motion > Preferences and use the options in the Presets pane.

- **Fixed Width and Fixed Height:** Sliders (available for still images) to change the resolution of source media. When the Large Stills control (in Motion Preferences) is set to Scale to Canvas Size, these values display the resolution of the original file. For more information, see Set the import size of large still images.

When a PDF is selected in the Media list, these controls set the maximum resolution to which a PDF object can be smoothly scaled. For more information, see About PDF files.

- **Crop:** Four sliders, visible when you click the disclosure triangle, that define the number of pixels to be cropped from
each of the source media’s four sides, relative to the outer edge of the bounding box that surrounds that source media. Cropping an item in the Media list also crops all instances of that item in layers of the project. A similar Crop parameter appears in the Properties Inspector when you select a layer in the Layers list. For more information, see Properties Inspector controls.

- **Timing:** Three value sliders to set the start, end, and duration of the source media:
  - **Start:** Sets the In point of the source media, in constant and variable speed modes. Adjusting this parameter moves the In point to the specified frame without affecting the duration of the media.
  - **End:** Sets the Out point of the source media, in constant and variable speed modes. Adjusting this parameter moves the Out point to the specified frame without affecting the duration of the media.
  - **Duration:** Sets the total duration of the source media. If Time Remap is set to Constant Speed, adjusting Duration also affects the Speed and Out point. If Time Remap is set to Variable Speed (in the Timing controls of the Properties Inspector), adjusting Duration does not affect variable speed playback.

- **Linked Objects:** A list of all objects in the Layers list that are linked to the selected source media in the Media list. The first column shows the name of the group containing an instance of the source media; the second column shows the layer name. Changing the layer name in the Layers list updates the name appearing in this list.

- **Replace Media File:** A button to relink media in your project to...
Replace Media File: A button to relink media in your project to a source file on disk. This feature is primarily useful for relinking offline media, but can also be used to change source media (changing all layers that are linked to that source media).

- Metadata: An information pane displaying properties of the external media file on your computer or networked device that’s linked to the item selected in the Media list.

About duplicating and deleting media files

When you delete a layer in the Layer’s list, by default Motion deletes the corresponding media item in the Media list (but does not delete the source media on your computer or connected storage device). If you want to delete a layer, but retain its source media item in the Media list for future use, open Motion Preferences and, in the General pane, deselect the “Automatically manage unused media” checkbox. For more information, see General preferences.

When you duplicate a layer in the Layers list, a new instance of the source media is created in the Layers list—however, no new source item is created in the Media list. In a project with duplicated layers, you can adjust the attributes of all duplicates simultaneously by adjusting the source media’s parameters in the Media Inspector (see Display the Media Inspector).

If you’ve duplicated layers and want to delete them all at the same time, delete the corresponding media item in the Media list.
Exchange media in a project

You can overwrite an image layer with media from a different file in the File Browser or Library. This process, called *exchanging media*, replaces the layer’s original *source media link* with a new source media link. When you exchange a layer’s source media, the layer retains its Property Inspector parameter values (including Position, Scale, and Opacity, and Blend Mode), as well as applied filters, behaviors, masks, or keyframes.

The exchange operation lets you replace layers in your project even after you’ve modified and animated them. If you’re unhappy with an element of your composition, exchange it with a new one.

**Important:** You can only exchange layers that are linked to source media files on your computer or networked device. You cannot exchange Motion-generated objects such as particle systems, generators, shapes, or text objects.

---

**Exchange media in a layer**

1. Drag a media file from the File Browser onto a layer in the Layers list.

2. When a curved pointer appears, release the mouse button.
The layer’s original source media is replaced by the new source media.

---

**Exchange source media via the Media Inspector**

1. In the Media list, select the object to replace.

2. Open the Media Inspector or HUD (heads-up display).

   **Note:** For information about opening the Media Inspector, see Display the Media Inspector. To open the HUD, press F7.

3. Click Replace Media File.

4. In the dialog that appears, navigate to the file that will replace the current source media.

5. Click Open.
The original source media is replaced by new source media in the Media list and in any layers in the project linked to the source media.

Reconnect offline media

Reconnect offline media files

Adding a media file to a Motion project creates a link between the resulting image layer in Motion and its corresponding source media file on your computer or connected storage device. If you move, delete, or rename media files on your computer or connected device, the linked layers in Motion go “offline.” Media can also go offline if you give someone a project file without also providing the source media it uses.

Offline layers appear as checkered rectangles that occupy the entire bounding box of the missing image.

When a layer goes offline, a question mark icon appears beside the empty preview thumbnail in the Layers list.
In the Media list, a question mark icon replaces the missing preview thumbnail.

When you open a project file with offline media, a dialog appears listing all files that can’t be found. If the media files were moved to another folder or disk instead of being deleted, you might be able to locate them on your computer using the offline media Search feature. If you know the location of the missing media files, you can display a manual reconnection dialog and navigate to the files without searching. If the file was renamed, you must locate it manually.
Manually reconnect an offline media file

1. In the alert dialog, click Reconnect.

   In the manual reconnection dialog that appears, navigate to the location of the missing file.

2. Select the file, then click Open.

The file is reconnected. If more than one missing media file appears in the same folder, all files are reconnected.

Search for and reconnect offline media files

If you can’t find the file manually, use the offline media Search feature.

1. In the alert dialog, click Search.

   Motion attempts to find the first missing file in the list. If the search is successful, a dialog shows the missing media file.

2. Select the file, then click Open to reconnect it.
If the search is unsuccessful, use the manual reconnection dialog to navigate to the file. When you locate it, select the file, then click Open.

**Cancel an active search for offline media**

1. Click Cancel.
   
   The manual reconnection dialog appears.

2. In the dialog, navigate to the file’s location, select the file, then click Open.

The file is reconnected.

**Reconnect offline media via the Media Inspector**

If you do not immediately reconnect an offline layer, you can still save changes to the project and even close it again, then reconnect the offline layers later, via the Reconnect Media File button in the Media Inspector.

1. Open the Media list.

2. Select the offline layer to reconnect.

3. Open the Media Inspector, then click the Reconnect Media File button under the Linked Objects list.

   Motion attempts to find the first missing file in the list. If the
search is successful, a file browser dialog appears with the missing media file selected. If the search is unsuccessful, you must navigate manually to file’s location, then select the file.

4. Click Open to reconnect the file.

**Note:** You can also use the File > Reconnect Media command.

If more than one missing media file appears in the same folder, clicking Open reconnects all files.

---

**About networked devices and removable media**

Be careful when adding media files from a remote server to your project. Although the File Browser can access the contents of other computers on your network, dragging remote media to your project does not copy the source file to your computer. The media source file remains on the remote device. As a result, when that remote device becomes unavailable, the corresponding item in your project goes offline. Further, depending on the speed of your network, you may experience performance issues when using media files on other computers.

Ideally, copy all media files used in your project onto a device that’s physically connected to your computer. If you must use media from a networked storage device, ensure that the device is always mounted on your system and that you have a high-performance network.
This is especially true for media from removable devices, such as flash drives, DVDs, and removable hard disks that are frequently disconnected from your computer. Always copy media files from such media to your local computer.
Project playback overview

After you create a project, Motion provides easy ways to control and optimize playback. You can:

- **Play back** a project using simple transport controls
- **Adjust project timing**
- **Define a play range**

For information about graphics cards and performance, see About project playback performance.

View and play back a project

View and play back a project overview

The easiest way to play a project and see your animated sequence in real time is to **use the transport controls** under the Canvas. In addition to starting and stopping your project’s playback, you can use the transport controls to jump to the beginning or end of your project, advance your project frame by frame, and so on.

To customize playback, you can also:

- Optimize playback performance by manually rendering a
- Optimize playback performance by manually rendering a portion or your entire project to random access memory (RAM)

- Play your project in full-screen player mode

- View the Canvas (or Timing pane) on a second display

Play back a project

After you add content to your project, use the transport controls at the bottom of the Canvas to play your sequence back in real time, to jump to the beginning or end of your project, to advance your project frame by frame, and more.

![Transport controls diagram]

**Note:** Most of the transport controls have a keyboard shortcut.

The transport controls contain the following buttons:

- **Go to start of project:** Returns the playhead to the beginning of the project. (Keyboard shortcut: Home)

- **Go to end of project:** Moves the playhead to the end of the project. (Keyboard shortcut: End)

- **Play from start (of a play range):** Plays from the In point to the Out point of the play range.

- **Play/Pause:** Plays or pauses the project.

- **Go to previous frame:** Moves the playhead to the previous frame.

- **Go to next frame:** Moves the playhead to the next frame.
Play from start (of a play range): Plays from the In point to the Out point of the play range. To learn how to set a play range, see Define the play range.

- **Play/Pause:** Starts and stops playback. (Keyboard shortcut: Space bar)

- **Record:** Turns on and turns off animation recording. When recording is turned on, the values for animatable parameters appear red in the Inspector, indicating that any change you make to a parameter (such as moving an object in the Canvas or adjusting a slider) creates a keyframe. (Keyboard shortcut: A)

- **Go to previous frame:** Moves the playhead backward by one frame. (Keyboard shortcut: Left Arrow or Page Up)

- **Go to next frame:** Advances the playhead by one frame. (Keyboard shortcut: Right Arrow or Page Down)

There are two buttons to the right of the transport controls that also affect playback:

- **Player Mode:** Hides or shows the File Browser, Library, Inspector, Project pane, and Timing pane to maximize Canvas space. For more information, see Expand the Canvas to full-screen player mode.

- **Loop playback:** Controls whether playback loops indefinitely, or whether playback stops when the end of the play range is reached. For more information, see Define the play range. (Keyboard shortcut: Shift-L)
And to the left of the playback controls is another button that also can affect playback:

- **Play/Mute audio**: Turns audio playback on or off. Turning audio off can improve playback performance.

---

Optimize playback using RAM Preview

Each time you play a project in the Canvas, Motion performs complex rendering calculations to represent the objects and effects that appear in each frame. The project plays back as quickly as possible up to the frame rate specified in the Properties Inspector. However, with a very complex project, playback quality can be hampered by the limitations of your computer hardware.

To improve real-time playback, you can manually render parts of your project and store the frames in your computer’s random access memory using **RAM Preview**. With RAM Preview, you can render the play range, a selection, or the entire project.

---

**RAM Preview your entire project**

- Choose Mark > RAM Preview > All.
The RAM Preview dialog appears, displaying a progress bar that shows which frame is being rendered, how many more frames remain, and an approximation of the time remaining. When RAM Preview is completed, the dialog closes.

![RAM Preview dialog](image)

**Note:** Because some sections of a project may be more complex than others, the “Time remaining” value may be somewhat inaccurate.

---

**Interrupt the RAM Preview**

- Click the Stop button in the RAM Preview dialog.

The section that has been rendered is stored in RAM. When a section of your project is stored in RAM, a green glow appears along the bottom of the Timeline ruler and the mini-Timeline.
Clear RAM Preview

You can manually delete RAM Preview to make room for a new RAM Preview or to free up RAM for other operations.

- Choose Mark > RAM Preview > Clear RAM Preview.

RAM Preview the play range

You can restrict which frames are rendered by choosing to preview the play range or a selection. Using RAM Preview on a selection renders all visible layers in the project from the first frame of the selection until the last.

1. Set a play range in your project.
   For more information, see Define the play range.

2. Choose Mark > RAM Preview > Play Range.
   The RAM Preview dialog appears and displays a progress bar.
When RAM Preview is completed, the dialog closes.

---

**RAM Preview a selection**

1. Holding down the Command and Option keys, drag In the Timeline to select a region to preview.

   A highlight appears over the selected frames.

   ![Timeline with selected region](image)

   For more information on regions, see Make changes to a region (range of frames).

2. Choose Mark > RAM Preview > Selection.

   The RAM Preview dialog appears. When RAM Preview is completed, the dialog closes.

---

**Expand the Canvas to full-screen player mode**
When you click the Player Mode button below the Canvas, the Canvas expands to fill the Motion workspace. This is helpful for watching project playback without the distraction of the software interface. In this mode, the menus, toolbar, and timing display remain active. The Show/Hide Timeline, Show/Hide Audio Timeline, and Show/Hide Keyframe Editor buttons at the lower-right corner of the workspace also remain available, as does the Show/Hide File Browser/Library/Inspector button at the lower-left corner of the workspace.

**Switch to full-screen player mode**

Do one of the following:

- Choose Window > Player Mode.
- Click the Player Mode button above the toolbar.
- Press F8.

**Return to normal view**

Do one of the following:

- Choose Window > Player Mode again.
Click the Player Mode button again.

Press F8 again.

View the Canvas or Timing pane on a second display

If you have two displays connected to your computer, you can show the Canvas or Timing pane on the second display.

**Note:** You can also drag Motion project windows to the second display, allowing you to view more than one project at a time.

Show the Canvas on a second display

- Choose Window > Show Canvas on Second Display.

  The Canvas and Project pane (Layers, Media, and Audio lists) appear on the second display. Drag the right edge of the Project pane left or right to resize the Canvas and Project pane.

Show the Canvas in the main window

Do one of the following:

- Choose Window > Show Canvas in the Main Window.
Show the Timing pane on a second display

Choose Window > Show Timing Pane on Second Display.

The Timing pane (Timeline, Audio Timeline, and Keyframe Editor) appears on the second display. Drag the right edge of the Timeline layers list left or right to resize the Timing pane and layers list.

Note: Click the Show/Hide Timeline button, Show/Hide Audio Timeline button, and Show/Hide Keyframe Editor button in the lower-right corner of the Timing pane to show or hide the Timing pane interface elements.

Show the Timing pane in the main window

Do one of the following:

Choose Window > Show Timing Pane in the Main Window.

Choose Window > Revert to Original Layout.

View and adjust project timing

Timing display overview
The timing display, located in the center of the toolbar, lets you view the current frame (or timecode number) of the playhead, or the total duration of the project. In the timing display, you can also modify the duration of the project, navigate to a specific frame, move forward or backward in small or large increments, and scrub frames.

For details, see:
- View or change timing information
- Navigate a project
- Change the duration of a project

View project timing information
You can set the timing display to show either the current playhead position or the total project duration. You can also set the timing display show this information in different units—frames or timecode.

Switch between display of playhead position and project duration

Do one of the following:
- Click the clock icon on the left side of the timing display.
When set to project duration, the clock icon looks like this:

![Clock Icon](image)

When set to playhead position (known as current time), the clock icon looks like this:

![Clock Icon](image)

Click the downward arrow on the right side of the timing display, then choose Show Project Duration or Show Current Time.

When set to show project duration, the timing display shows the running time or number of frames in your project (depending on the unit of measure you choose to display). When set to show the current time, the timing display shows the frame number or timecode number of the current playhead position (depending on the unit of measure you choose to display).

---

**Switch between display of frame numbers and timecode**

The timing display offers two ways of measuring time in your project: frames or timecode. Frames are incremental still images starting at 1 or 0 and continuing for the duration of your project. Timecode is the standard eight-digit numeric system used in video production. Timecode runs like a clock from 00:00:00:00 to 23:59:59:29. The first two digits represent hours; the second two digits represent minutes; the third two digits represent seconds;
and the final two digits represent frames, as in HH:MM:SS:FF.

- Click the downward arrow on the right side of the timing display, then choose Show Frames or Show Timecode from the pop-up menu.

Frames and timecode counters have specific advantages, depending on the video format in which you’re originating and finishing. For example, if you’re designing a title sequence for a 35mm film that must be exactly 720 frames, set the timing display to show frames. If you’re building a television spot for broadcast (which uses the timecode standard), set the timing display to show timecode.

Navigate a project using the timing display
You can also use the timing display to move the Timeline playhead.

Move the playhead to a specific frame or time
Do one of the following:

- With the timing display pop-up menu set to Show Frames and Show Current Time, double-click the number display, type the desired frame number, then press Return.

- With the timing display pop-up menu set to Show Timecode and Show Current Time, double-click the number display, type the desired timecode (in HH:MM:SS:FF format), then press Return.

**Increase or decrease the current time one frame at a time**

- With the timing display pop-up menu set to Show Current Time, press the Left Arrow key (or Page Up key) to move the playhead backward or the Right Arrow key (or Page Down key) to move the playhead forward.

**Move ahead or back in seconds, minutes, or hours**

1. Ensure that the timing display pop-up menu is set to Show Current Time.

2. Double-click the timing display, then do one of the following:
   - To move forward in seconds, enter a plus sign (+), enter the number of seconds to move forward, enter a period, then press Return. For example, to move 2 seconds
ahead, enter “+2.” (with a period after the numeral 2), then press Return. To move ahead in minutes, enter two periods after the numeral, then press Return. To move ahead in hours, enter three periods after the numeral, then press Return.

- To move backward in seconds, enter a minus sign (–), then enter the number of seconds to move backward, enter a period, then press Return. For example, to move 2 seconds backward, enter “–2.” (with a period after the numeral 2), then press Return. To move backward in minutes, enter two periods after the numeral, then press Return. To move backward in hours, enter three periods after the numeral, then press Return.

**Move forward or backward a specific number of frames**

- With the timing display pop-up menu set to Show Current Time, enter a plus sign (+) followed by the number of frames to move forward, then press Return.

- With the timing display pop-up menu set to Show Current Time, enter a minus sign (–) followed by the number of frames to move backward, then press Return.

**Change the duration of a project**

By default, a new Motion project has a duration of ten seconds.
You can change this duration to match the needs of your project.

The project duration is displayed at the bottom of the Motion window. You can also display the duration in the timing display in the toolbar.

### Display project duration in the timing display

Do one of the following:

- In the timing display, click the downward arrow, then choose Show Project Duration from the pop-up menu.
- In the timing display, click the clock icon to switch between project duration display and current time display.

### Change the project duration

Do one of the following:

- With the timing display set to Show Project Duration, double-click the number, type a duration value, then press Return.

  When the timing display is set to Show Timecode, you can type a precise timecode value in the HH:MM:SS:FF format (hours:minutes:seconds:frames).

- With the timing display set to Show Project Duration, drag left or right over the number to decrease or increase the duration.
Choose Edit > Project Properties (or press Command-J), then change the value of the Duration field in the Properties Inspector.

Note: Click the downward arrow to the right of the numbers in the timing display and choose Show Frames or Show Timecode to switch between viewing the project duration in frames or timecode.

### Change the default project duration

Choose Motion > Preferences (or press Command-Comma), then enter a project length in the Project Duration field.

Note: The duration of any open project is not changed. This setting only takes effect in projects created after the preferences are set and Motion is quit and reopened.

### Change the duration in seconds, minutes, or hours

1. Click the downward arrow in the timing display, and make sure that the pop-up menu is set to Show Timecode and Show Project Duration.

2. Double-click the timing display, then do any of the following:
   - Set the duration to an exact timecode value: Enter a specific timecode value in the HH:MM:SS:FF format (hours:minutes:seconds:frames), including a colon between
each double-digit number.

- **Set the duration in total seconds**: Enter the number of seconds followed by a period, then press Return.

- **Set a duration in total minutes**: Enter the number of minutes followed by two periods, then press Return.

- **Set a duration in total hours**: Enter the number of hours followed by three periods, then press Return.

### Define the play range

Ordinarily, clicking the Play button plays your project from the first frame until the last. However, you can change the play range of your project by modifying the In and Out points in the Timeline ruler or by using Menu commands. You might do this to focus on a specific section as you fine-tune your project or make other changes to it. When you finish, reset the In and Out points to the beginning and end of your project.

### Customize the playback In point

Do one of the following:

- In the ruler, drag the In point marker from the left edge of the ruler to the frame where you want to set the In point. As you drag, the playhead moves with your pointer. When you release
the mouse button, the playhead snaps back to its previous position.

- In the ruler, move the playhead to the frame where you want to set the In point, then choose Mark > Mark Play Range In.

- In the ruler, move the playhead to the frame where you want to set the In point, then press Option-Command-I.

### Customize the playback Out point

Do one of the following:

- In the ruler, drag the Out point marker from the right edge of the ruler to the frame where you want to set the Out point.

- In the ruler, move the playhead to the frame where you want to set the Out point, then choose Mark > Mark Play Range Out.

- In the ruler, move the playhead to the frame where you want to set the Out point, then press Option-Command-O.

### Reset playback In and Out points

Do one of the following:

- Choose Mark > Reset Play Range.

- Press Option-X.
The In and Out points reset themselves to the beginning and end of the project.

**Navigate to playback In and Out points**

Do any of the following:

- *Navigate to an In point:* Choose Mark > Go to > Play Range Start (or press Shift-Home).
- *Navigate to an Out point:* Choose Mark > Go to > Play Range End (or press Shift-End).

**About project playback performance**

When you play back a project, Motion attempts to display your sequence in real time. However, if your computer has an older graphics card, or if have more than one monitor connected to your graphics card, playback performance may be negatively affected.

Your graphics card also determines the maximum file size you can import into Motion. For most recommended cards, the image size limit is 4K or 8K. For the best results, resize very large images to the largest size required in the project, but no larger. Computers with graphics cards containing minimum amounts of video RAM (VRAM) may experience poor performance (or other
issues) when creating 4K projects. For more information, visit the Motion website at http://www.apple.com/finalcutpro/motion.

**Note:** Because of hardware limitations and differences, the appearance of projects shared between computers with different installed graphics cards may vary.
Basic compositing overview

After you create a project and add content, you can begin to edit and arrange the image layers in your composition. This process is known as *compositing*, the art of combining at least two images to produce an integrated final result. Motion graphics artists use various compositing techniques to create animated visual effects—transforming the physical properties of image layers (such as scale), adjusting opacity, applying filters, creating text and shapes, and so on. Compositing also includes special effects techniques such as keying, masking, color correction, and the creation of animated particle systems.

Most basic compositing tasks are performed in four areas of the Motion workspace:
Layers list: Select image layers and effects objects in this hierarchical list. You can also rearrange the stacking order of image layers so that certain images appear above other images in the Canvas. See Layers list overview.

Canvas: View and manipulate image layers in this visual workspace. Select onscreen editing tools in the toolbar below the Canvas to perform basic layout tasks in the Canvas—selecting, moving, rotating, scaling, distorting, and so on. The onscreen tools let you adjust all of these properties by dragging in the Canvas. See Transform layers in the Canvas overview.

Tip: Although you can select layers in the Canvas, when multiple layers are stacked one atop another, it’s often easier to select specific layers in the Layers list.

Properties Inspector: You can also adjust layer properties using numeric controls—sliders, dials, value fields, and so on.
These controls in the Properties Inspector let you make the same adjustments afforded by the onscreen editing tools, but with more precision. Adjustments made in the Canvas are simultaneously updated in the Inspector, and vice versa. For example, if you change a layer’s scale by dragging its corner handles in the Canvas, the layer’s Scale parameter is updated in the Properties Inspector. See Transform layers in the Properties Inspector.

- **HUD**: Many of the numeric controls in the Properties Inspector are also available in the HUD (heads-up display), a floating window that you can show or hide. See Transform layers in the HUD.

**Select and organize layers**

**Layers list overview**

When you add media content, the resulting element is represented in your Motion project as a *layer*. Think of layers as a series of visual overlays stacked on top of each other. These image layers combine to create the composition displayed in the Canvas. Motion provides a graphical representation of this layer hierarchy in the Layers list of the Project pane. In a 2D project, the stacking order of layers in the Layers list determines which layers appear in front of others in the Canvas.

You can modify layers by applying effects objects to them. Effects objects also appear in the Layer’s list, under the group or layer to which they are applied.

The Layers list contains the following objects:
- **Layers**: The basic image objects—movie clips, still images, shapes, text, particle systems, and so on—in your project that combine to create a composition.

- **Effects objects**: Nonimage objects that modify image layers or groups. Effects objects include filters, behaviors, lights, cameras, and rigs. Effects objects appear in the Layers list indented under the layer or group that they modify.

- **Groups**: Containers that enclose layers and effects objects. When you create a layer, it’s placed inside a group. All image layers and effects objects—except for cameras, lights, rigs, and the Project object—must reside in groups. Masks, behaviors, and effects can be applied to groups or to layers. A group can also contain other groups nested inside it. In this way, you can construct complex hierarchies of nested groups, with each nested group subordinate to the group that contains it.

- **Project object**: An icon at the top of the Layers list that, when selected, makes the Project Inspector available. The Project Inspector displays parameters that are set to be published in a template for use in Final Cut Pro X. For more information, see Publish parameter controls to Final Cut Pro and Add multiple display aspect ratios to a template.
Additional icons and controls in each row of the Layers list provide information about the status of applied effects, allow you to lock layers, and let you turn applied effects on or off. For more information, see Layers list controls.

**Note:** In Motion, any element that appears stacked in the Layers list is considered an *object*. That includes image layers, which are a special class of object defined as any image-based element—a movie clip, a still image, a shape, text, a particle system, a replicator, and so on—that is visible in the Canvas. For example, a rotating a triangle shape is a layer, but the behavior object that animates it is not; a sepia-tone video clip is a layer, but the Sepia filter that makes it so warmly old-timey is not. In Motion help, the term *object* is often used to describe the superset of all elements (layers, groups, and effects objects) that act upon and form a composition. *Layer*, however, always refers to the image-based elements acted upon.
To reorganize layers and groups in a project, you must select objects to move or modify. You can select layers and groups in the Layers list or Canvas.

**Note:** You can also select, organize, and manipulate layers in the Timeline layers list. Changes made in the Timeline layers list are mirrored in the Layers list, and vice versa. See [Timeline overview](#).

---

**Select layers or groups in the Layers list**

Do any of the following:

- **Select a single layer or group:** Click a layer or group in the Layers list or Canvas. All other selected objects are deselected.

  **Note:** Selecting a group does not select the layers nested underneath it. However, operations performed on a selected group also affect layers nested in the group.

- **Select multiple contiguous layers or groups:** Click the first layer or group, hold down the Shift key, then click the last layer or group in the contiguous list.

- **Select multiple noncontiguous layers or groups:** Hold down the Command key while clicking multiple layers in the Layers list.

---

**Select layers in the Canvas**

Do any of the following:
Select a single layer: Click the Select/Transform tool in the toolbar (if it’s not already selected), then click an image in the Canvas.

Select multiple layers: Click the Select/Transform tool in the toolbar (if it’s not already selected), then drag a selection rectangle around multiple images in the Canvas, or hold down the Shift key while clicking multiple images.

Add or remove selections when there are multiple selected layers

Do any of the following:

- **Add to selected groups or layers:** Command-click any unselected layer or group in the Layers list, or Shift-click any unselected layer in the Canvas.

- **Deselect a layer from multiple selected layers:** Command-click any selected layer in the Layers list, or Shift-click any selected layer in the Canvas.

Select all layers and groups

Do one of the following:
Choose Edit > Select All (or press Command-A).

Click the first group or layer in the Layers list then Shift-click the last group or layer in the list.

**Deselect all layers or groups**

Choose Edit > Deselect All (or press Shift-Command-A).

**SEE ALSO**

Show and hide the Layers list

The Layers list is located in the Project pane, to the right of the Canvas. You can show, hide, or resize the Project pane and Layers list to customize your workspace.

**Collapse or expand the Project pane**

Do one of the following:

- Choose Window > Show/Hide Project Pane (or press F5).
- Click the Show/Hide Project Pane button in the bottom of the Canvas.
Display the Layers list

Do one of the following:

- If the Project pane is visible, click Layers at the top of the pane.
- Choose Window > Layers (or press Command-4).

Resize the Project pane

Do any of the following:

- **Resize horizontally:** Drag the right edge of the pane left or right.
- **Resize vertically:** Drag the top edge of the Timing pane up or down.

**Note:** You can also choose Window > Hide Timing Pane. The Timing pane is hidden and the Project pane is expanded vertically.

Expose layers in the Canvas
Motion’s expose commands provide a way of viewing multiple layers at once, exploding and rescaling them. The expose commands allow you to access all layers in a project in the Canvas without having to drill down into the Layers list. Expose commands also let you select inactive layers at the playhead’s current position or jump to a selected layer’s In point.

---

**Expose layers that are active at the playhead position**

1. Click anywhere in the Canvas.

2. Press X.

   Layers active at the current position of the playhead temporarily scale down and spread out over the Canvas. Each active layer is represented by a white frame in the Canvas. Moving the pointer over a frame reveals the layer’s name.

3. Select the layer to work on.

   The elements move and rescale back to their original positions; the element is selected in the Canvas; and the playhead moves to the first frame of the selected layer.

---

**Expose all layers in your project**

1. Click anywhere in the Canvas.
2. Press Shift-X.

Layers in the project temporarily scale down and spread out over the Canvas. Each layer in the project is represented by a white frame in the Canvas. Moving the pointer over a frame shows the layer’s name.

3. Select the layer to work on.

The layers move and rescale back to their original positions; the element is selected in the Canvas; and the playhead moves to the middle frame of the selected layer.

**Add and remove layers and groups**

You can add and remove layers or groups in the Layers list. You can also add or remove layers (but not groups) in the Canvas.

**Add a layer to your project**

Do one of the following:
Drag an item from the File Browser or Library to a group in the Layers list.

Drag an item from the File Browser or Library to the Canvas.

For more information about adding content from the File Browser or Library, see Add and manage content overview.

Create a group in the Layers list

Do one of the following:

- Click the Add button (+) in the lower-left corner of the Project pane.

- Control-click an empty area of the Canvas (in the gray area outside the composition) and choose New Group from the shortcut menu.

  An empty group is added above the existing groups in the Layers list.

- Choose Object > New Group (or press Shift-Command-N).

  An empty group is added above the currently selected object. (If no object is selected, the empty group is added at the top of the Layers list).

Note: You can also create groups when dragging files to the Layers list from the File Browser or Library. For more information, see Add and manage content overview.
Duplicate a layer

Do one of the following:

- Option-drag the layer to the position you want in the Layers list, or Option drag a layer in the Canvas.

**Note:** You can also Option-drag layers between different open Motion projects (to the Canvas or Layers list).

- Control-click a layer in the Layers list or Canvas, then choose Duplicate from the shortcut menu.

Clone a layer

When you duplicate a layer, subsequent changes made to the original (source) layer are not inherited by the duplicated layers. However, when you use the Make Clone Layer command, changes made to filters and masks in the source layer propagate to the clones. Creating clone layers improves project playback and rendering performance.

**Important:** Behaviors don’t propagate to clone layers unless the behavior affects a filter or mask in the source layer.

Do one of the following:

- Select the layer to clone, then choose Object > Make Clone Layer (or press K).

- Control-click a layer in the Layers list, then choose Make
Clone Layer from the shortcut menu.

A clone layer is created and appears in the Canvas on top of the original layer. In the Layers list, the clone layer appears with the default name “Clone Layer.” A clone layer icon appears next to the name.

![Layers panel with Clone Layer selected](image)

**Note:** You can modify clone layers independently of their source layer. However, you cannot modify the Frame Blending parameter of a clone layer created from a retimed source layer.

### Remove a layer or group

Do one of the following:

- Control-click a layer or group in the Layers list, then choose Cut or Delete from the shortcut menu.

- Select a layer or group in the Layers list, then choose Edit > Delete (or press Delete) or Edit > Cut.
The layer or group is removed. This action removes the object from the Canvas as well.

**Note:** If you delete a media file (an imported image, image sequence, audio file, or QuickTime movie) from the project, the file is also removed from the Media list unless the “Automatically manage unused media” checkbox is deselected in the General pane of Motion Preferences. When this setting is deselected, media files are deleted from the Layers list (and Canvas) but remain in the project in the Media list. Drag an item from the Media list into the Canvas to add it back to the Layers list. For more information, see Display, sort, and search the Media list.

---

**Reorganize layers and groups**

The order in which layers and groups appear in the Layers list determines which layers appear in front of other layers in the Canvas. You can change the ordering of layers in the Layers list or in the Canvas. However, it’s easiest to select layers and change their stacking order in the Layers list.

Additionally, you can change layer order using commands in the Object menu. These commands can be used with layers, effects objects, groups, or groups nested in another group. Reordering a group reorders all objects nested in that group.

**Note:** When using 3D groups, you can rearrange the *depth order* in 3D space to override the layer order in the Layers list. For more information about depth and layer hierarchy in 3D groups, see Create 3D intersection.
Move a layer or group forward or backward in your composition

Do one of the following:

- Drag a layer or group up or down in the Layers list.

  A position indicator shows the new position the selection occupies when you release the mouse button.

- Select a layer or group in the Layers list (or select a layer in the Canvas), click the Object menu, then choose Bring to Front, Send to Back, Bring Forward, or Send Backward.

  **Note:** You cannot use the Object menu reorder commands to move image layers out of the group they’re nested in.

  The selected layer or group is reordered in the Layers list and Canvas.

  **Note:** Using the Bring and Send commands in the Object menu to move layers up and down in the nested hierarchy in any group is especially useful when working with selected objects in the Canvas. For more information, see [Object menu](#).

Move multiple layers or groups forward or backward in the composition

Do one of the following
In the Layers list, Shift-click to select multiple contiguous layers or groups or Command-click to select multiple noncontiguous layers or groups, then drag the items up or down in the Layers list.

A position indicator shows the new position the items occupy when you release the mouse button.

In the Layers list, Shift-click to select multiple contiguous layers or groups or Command-click to select multiple noncontiguous layers or groups, click the Object menu, then choose Bring to Front, Send to Back, Bring Forward, or Send Backward.

**Note:** When you apply the Bring Forward or Send Backward arrangement command to noncontiguous selected layers, the layers move up or down the object hierarchy together, and any space between the layers remains.

Move a layer from one group to another
When you have more than one group, you can move layers back and forth between groups, changing their nested relationship in your project.

1. Select one or more layers.

2. Do one of the following:
   - Drag the selected layers to a position underneath another group. A position indicator appears, showing where the layer is placed when you release the mouse button.
   - Choose Edit > Cut (or press Command-X), then select the group to paste into, and choose Edit > Paste (or press Command-V).

**Copy a layer from one group to another**

Do one of the following:

- Option-drag selected layers from one group to another.

- Select layers, choose Edit > Copy (or press Command-C), then select the group to paste into, and choose Edit > Paste (or press Command-V).

- Select layers, choose Edit > Copy (or press Command-C), select the group to paste into, then Control-click an empty area of the Canvas (in the gray area outside your composition) and choose Paste from the shortcut menu.

**Copy a layer or group from one project to**
When you have more than one project open, you can copy layers or groups back and forth between projects.

1. Select one or more layers in the active project window.

2. Do one of the following:
   - Drag the selected object to a position in the target project’s Layers list. A position indicator appears to show where the object is placed when you release the mouse button.
   - Choose Edit > Copy (or press Command-C), select a group in the target project, then choose Edit > Paste (or press Command-V).
   - Option-drag a layer in the Canvas to the Canvas or Layers list of the target project.

---

Rename a layer or group

Renaming groups and layers in the Layers list helps organize your project. When you rename a layer, the original name of the source media file on disk remains unchanged. Likewise, renaming a layer in the Layers list does not change the name of the layer’s corresponding source media in the Media list. For more information, see Source media overview or Display, sort, and search the Media list.

1. In the Layers list, double-click the name of a group or layer,
then enter a new name.

2. To confirm the name, press Return, or click in another layer or group.

Show, hide, solo, or lock layers and groups

In the Layers list, you can disable layers and groups to make them invisible in the Canvas without removing them from your composition. For example, if a large image layer obstructs other layers you want to adjust in the Canvas, you can temporarily disable the offending layer. Similarly, you can disable effects objects—filters, behaviors, masks, and so on—to temporarily remove their effect on layers and groups.

If you disable a group, you also hide all layers and groups nested in it. Hidden layers and groups are not included when your project is exported.

In the Layers list, you can also solo or lock groups or layers to prevent accidental modification.

Enable or disable objects

When you disable an image layer or group, it becomes invisible in the Canvas. When you disable an effects object (such as a behavior or filter), its effect is disabled.
Do one of the following:

- Deselect the activation checkbox to the left of an object in the Layers list.

- Select an object, then choose Object > Active (or press Control-T).

- Control-click an object, then choose Active from the shortcut menu.

When disabled, objects are dimmed in the Layers list. Disabled layers are hidden in the Canvas; disabled effects objects no longer modify the group or layer they’re applied to.

**Note:** If you disable layers in a group, the enclosing group’s checkbox displays a dash instead of a checkmark, indicating that some layers are not visible.

---

**Solo a layer or group**
You can “solo” a layer or group to hide all other layers and groups in the project. This technique can be useful to isolate a single layer or group in the Canvas to animate or manipulate it without interfering with other objects in your composition.

1. In the Layers list, select layers or groups to solo.

2. Choose Object > Solo (or press Control-S).

   **Note:** You can also Control-click an object in the Layers list, then choose Solo from the shortcut menu.

   All other layers or groups are deactivated, and only the soloed object is visible in the Canvas. When the selected item is soloed, the solo menu item displays a checkmark.

---

## Lock an object

Locked objects cannot be modified or moved, and their parameters cannot be altered or animated. However, animation and behaviors previously applied to a layer or group still play. Locking a group also locks all layers and groups nested in it.

**Note:** You cannot lock objects that contain published parameters (for use in Final Cut Pro X). Such objects display a dimmed lock control. For more information about publishing parameters, see [Add parameter controls overview](#).

Do one of the following:

- Click the lock icon to the right of the object in the Layers list.
In the Layers list, select a layer, group, or effects object, then choose Object > Lock (or press Control-L).

In the Canvas, the bounding box of a disabled layer (or a disabled group of layers) turns white to indicate the item is locked.

Nest layers and groups

Nest layers and groups overview

Groups and layers in the Layers list appear in a hierarchy that shows which layers are nested inside which groups. Nested layers and groups appear underneath and indented to the right of their parent group.

It’s a good idea to group layers that work together as a unit. By nesting related layers you want to animate inside a group, you can save time by animating the enclosing group, instead of animating each layer. For example, when you select a group that has three layers nested in it, the entire group is selected as a single unit.
Transforming the selected group in the Canvas moves all three layers simultaneously.

Regardless of how they’re nested, layers can always be modified independently. Subordinate groups can also be modified independently. In the following example, a filter is applied to a layer in a group containing three fish layers. All other layers in the group remain unaffected.
However, if you apply the same filter to the group, all layers in that group are affected by the filter, as if they were a single layer.

Many filters produce different results when applied to a group, rather than individual layers in a group, as shown in the images.
You can also nest groups inside other groups. You might do this if you’re creating a layer hierarchy to control the relationship of one group of layers to another, or if you’re grouping layers to which you want to apply a single set of behaviors and filters.

Note: You cannot group groups that appear at different hierarchical levels in the Layers list.

Collapse and expand group hierarchies

To make the Layers list easier to manage, you can collapse layers nested in a group. Collapsed groups appear as a single row in the Layers list, and can be moved or nested like any other layer. Each group’s thumbnail displays a preview of its composite, making it easy to see what’s nested inside when the group is collapsed.

Open or collapse a single group

Do one of the following:

■ In the Layers list, click the disclosure triangle to the left of a
Group, ungroup, and nest layers

Nesting layers and groups in the Layers list helps you apply animation and other effects to specific elements of your composition. For more information, see Nest layers and groups overview.

Nest selected layers into a new group

1. Select all layers or groups you want to group together.

2. Choose Object > Group (or press Shift-Command-G).

The selected layers or groups are nested in a new group.

Ungroup nested layers

You can also delete a containing group and move and “unnest” its contents.

1. In the Layers list, select a group containing the nested layers or groups.
2. Choose Object > Ungroup (or press Option-Command-G).

The layers or groups are moved up in the Layers list hierarchy.

Note: You cannot ungroup groups that are at the root (project level) of the Layers list hierarchy.

Move a group inside another group

1. In the Layers list, select one or more groups.

2. Do one of the following:
   - Drag the groups onto another group.
   - Drag the groups to a position at the bottom of another group.
   - Choose Edit > Cut (or press Command-X) to cut the groups, then select another group and choose Edit > Paste (or press Command-V).

Constrain group size

By default, the size of a group is determined by the layers in that group. Because animated objects often grow in size, the active height and width of a group (its resolution) can become large. You can constrain the resolution of a group to a specific width and height.

The project in the following image contains a particle system. The animated particles, although not visible when they move off the
Canvas, make the group containing them large.

If a project contains growing objects that move or expand beyond the edges of the Canvas, use the Fixed Resolution checkbox to decrease your computer processing time.

**Note:** The Group pane of the Inspector (which contains the Fixed Resolution parameter) is only accessible when a group is selected in the project.

---

**Fix the resolution of a group**

1. In the Layers list, select a group.

2. In the Group Inspector, select the Fixed Resolution checkbox.
By default, the group’s resolution is set to the project size; objects in the group but outside the Canvas are cropped. An “R” indicator appears to the right of the Fixed Resolution checkbox, informing you that the group is rasterized. For more information on rasterization, see Groups and rasterization.

3. To set a resolution other than that of the project, adjust the Fixed Width and Fixed Height sliders.

If the group’s anchor point is offset, the cropping might not occur around the edges of the Canvas, and objects may be cut off.

**Note:** When you select a layer in a fixed-resolution group, the bounding box around the layer appears at its original size, unaffected by the containing group’s resolution.
Layers list controls

In each row of the Layers list, icons offer additional information about groups, layers, and effects objects. Clicking these icons modifies or turns effects, visibility, and locking on or off.

The Layers list contains the following controls:

- **Activation checkbox:** Turns the visibility of the group, layer, or effects object on or off. When an object’s visibility is off, you can still modify the object’s parameters and manipulate its onscreen controls (in the Canvas).

- **Preview:** Displays a thumbnail of a layer or group. The group thumbnail represents the cumulative result of the composite up to that point in the project. (You can turn the display of the preview on or off in the Layers Columns section of the View menu.)

- **Name field:** Identifies the object by name. To edit the name, double-click the text area of a selected object, enter a new name, then press Return. In projects containing a camera, the
Isolate button appears in the Name column.

- **Isolate button**: Appears for a selected layer, group, or camera object in a project that contains a camera. (For information about cameras, see Add a camera.) The Isolate button has an active and inactive state. Clicking the Isolate button for a layer or group sets that object to its original face-forward orientation (so you can apply a mask, for example). Clicking the button again returns to the previous view. Clicking the Isolate button for a camera takes you to that camera’s view.

**Note**: When a group or layer is isolated, the name of the item replaces the current camera listing in the Camera menu (in the upper-left corner of the Canvas).

- **Link icon**: Appears when the layer has a corresponding audio element, such as a multichannel QuickTime file. To unlink the video and audio (to edit them separately), click the link icon. When they are unlinked, a red slash appears through the icon.

- **2D/3D icon**: Switches a group between 2D or 3D mode. The same icon appears at the left of the group name and indicates the 2D/3D status of the group. Layers cannot be 2D or 3D—they are always 2D elements in a 2D or 3D group.

- **Lock icon**: Locks an object to prevent changes from affecting that object. Locking a group prevents changes to layers and effects in that group. When the lock is disabled, its icon appears open.

- **Mask, behavior, and filter icons**: Appear when a mask, behavior, or filter is applied to the layer or group. To turn off the effect of the mask, behavior, or filter, click the icon so that it’s marked with a red slash.
- **Opacity slider**: Displays the opacity (transparency) of the group or layer. You can adjust the slider to change the item’s opacity. This slider is not displayed by default. To display the Opacity slider in the Layers list, choose View > Layers Columns > Opacity.

- **Blend Mode pop-up menu**: Displays the blend mode of the layer or group. Click the pop-up menu to choose a blend mode. This pop-up menu is not displayed by default. To display the Blend Mode pop-up menu in the Layers list, choose View > Layers Columns > Blend Modes. For more information on blend modes, see *How do blend modes work?*.

### Layers list shortcut menu

The Layers list shortcut menu gives you access to additional commands to help organize and manipulate layers. Control-click a layer in the Layers list, then choose a command from the shortcut menu. The command is applied to the layer you Control-clicked. The menu contains the following commands:

- **Cut**: Removes the layer and places it on the Clipboard.
- **Copy**: Copies the layer to the Clipboard.
- **Paste**: Places the contents of the Clipboard in the selected
location.

- **Duplicate**: Creates a layer identical to the selection.
- **Delete**: Removes the selected layer.
- **Group**: Places the selected layer or layers into a new group. (For more information, see Nest layers and groups overview.)
- **Ungroup**: Deletes a containing group, and moves its contents up one level in the Layers list hierarchy.
- **Active**: Enables or disables a layer, group, or effects object—the equivalent to clicking an object’s activation checkbox.
- **Solo**: Hides other layers and groups in the project (so that they are not visible in the Canvas). When a layer or group is soloed, activation checkboxes for other layers and groups are dimmed. You can solo multiple layers and groups at a time.
- **Isolate**: Hides all other groups and layers, and restores the selected layer or group to a face-forward orientation for easier adjustment (such as the application of a mask, for example). This command becomes available only after you add a camera to your project. Choosing Isolate for a camera object activates that camera’s view.
- **3D Group**: Switches the group from 2D mode to 3D mode. For more information about 3D groups, see Create 3D intersection.
- **Blend Mode**: Sets the blend mode for the selected layer. This is equivalent to setting a value using the Blend Mode pop-up menu (when activated in View > Layers Columns).
- **Add Image Mask**: Adds an image mask to the selected layer. An image mask creates transparency by deriving an alpha
channel from another layer, such as a shape, text, movie, or still image. For more information, see Image masks overview.

- **Make Clone Layer**: Clones the selected layer. Like the Duplicate command, Make Clone Layer lets you make copies of a selected layer. However, copies created by the Make Clone Layer command are automatically modified to match changes made to the original layer. For more information, see Add and remove layers and groups.

- **Reveal Source Media**: Opens the Media list and highlights the media file associated with the selected clip.

When no items are selected in the Layers list, the shortcut menu provides this set of commands:

- **New Group**: Adds a group to the project above existing groups in the Layers list.

- **Import**: Opens the Import Files dialog, used to import files from the Finder.

- **Paste**: Pastes any item copied to the Clipboard into the topmost group in the Layers list.

- **Project Properties**: Opens the Properties Inspector for the project, where you can modify the project’s background color, aspect ratio, field rendering, motion blur, reflections, and so on. For more information, see Project properties overview.

**Customize the Layers list**

You can modify the display of the Layers list to suit your needs.
Adjust row height

Do one of the following:

- Position the pointer over a horizontal line and drag up or down to decrease or increase the height of all rows.
  
  Icons and thumbnails resize themselves as you make the adjustment.

- Click the Scale button at the bottom of the Layers list, then drag the slider left to decrease row height or right to increase row height.

Filter the Layers list

- Click the Search button, then enter the name of the objects to view in the Search field.

When you begin typing in the Search field, the Layers list hides objects that do not contain the text you type. Hidden objects continue to appear in the Canvas.
Stop filtering and return to the complete Layers list

- Click the Clear button at the right of the Search field.

  The Search field is cleared, and the Layers list returns to the unfiltered view.

Show or hide mask, behavior, or filter objects

You can hide effects objects in the Layers list to simplify your view of layers and groups in your project.

- Click the Show/Hide Masks, Show/Hide Behaviors, or Show/Hide Filters button in the lower-left corner of the Layers list.

  When a button is dimmed, the effects object is hidden from view in the Layers list. However, the effect remains active in the Canvas.

Transform layers
Transform layers overview

The Motion interface provides three areas where you can transform the basic spatial properties of layers and groups—resizing, repositioning, rotating, cropping, and distorting them:

- **In the Canvas**, where you can drag onscreen transform handles
- **In the Properties Inspector**, where you can adjust numeric controls (sliders, dials, value fields, and so on)
- **In the HUD**, where you can adjust a subset of the controls found in the Properties Inspector

When you transform a layer in any of these areas, the layer’s parameters are also updated in the other two sections of the Motion workspace.

Transform layers in the Canvas

Transform layers in the Canvas overview

You can transform image layers in the Canvas using onscreen controls (transform handles) to drag, resize, rotate, and more. Although you can perform the same modifications with more precision by adjusting parameter controls in the Properties Inspector, onscreen controls give you a more hands-on method of working.

Before transforming layers, you must make a selection in the Layers list or Canvas. After you select a layer, a bounding box with transform handles appears in the Canvas.
You can move selected layers anywhere in the frame shown in the Canvas, and you can also drag layers past the edge of the frame. By default, when you move a layer past the edge of the frame, it becomes invisible; however, you can still manipulate the layer using its bounding box.

You can perform different adjustments in the Canvas by choosing different 2D transform tools in the toolbar. The default tool—Select/Transform—lets you reposition, resize, and rotate a selected layer or group. Other 2D transform tools let you distort or crop objects, create drop shadows, and more.

SEE ALSO

Transform layer properties in the Canvas
2D transform tools
Align layers in the Canvas

Transform layer properties in the Canvas

After you select a layer in the Layers list or Canvas, you can choose a 2D transform tool (from the pop-up menu in the toolbar)
to activate transform handles in the Canvas. Drag the handles to transform basic image properties such as position, rotation, scale, and so on. For a list of transform tools and their functions, see 2D transform tools.

**Activate the Select/Transform tool**

The Select/Transform tool (the arrow) is the default 2D transform tool. Use it to resize, reposition, or rotate layers in the Canvas.

- Click the Select/Transform tool in the toolbar, or press the S key.

**Note:** If a different 2D transform tool is showing in the toolbar, click and hold down the tool to open a pop-up menu, then choose the Select/Transform tool (the arrow).

The Select/Transform tool is selected in the toolbar, and transform handles appear in the Canvas for each selected layer or group.

**Choose a different 2D transform tool**

When you choose a 2D transform tool from the pop-up menu in the toolbar, transform handles appear in the Canvas for each
selected layer or group.

Do any of the following:

- **In the toolbar**: Click and hold down the Select/Transform tool, then choose a different tool from the pop-up menu. For a list of transform tools and their functions, see 2D transform tools.

![Transformation tools](image)

- **In the Canvas**: Click the Select/Transform tool in the toolbar, then Control-click any layer in the Canvas and choose a tool from the shortcut menu.
The options in the shortcut menu vary depending on the type of layer selected. For example, a shape layer contains shape-specific options such as Stroke, Edit Gradient, and Edit Points.

- **With the Tab key:** In the Layers list or Canvas, select a layer, then press Tab. Pressing Tab repeatedly cycles through the 2D transform tools in order. Pressing Shift-Tab cycles through the tools in reverse.

**Note:** When pressing Tab, the 3D Transform tool is activated between the 2D Select/Transform tool and the Anchor Point tool. For more information about 3D transforms, see Transform layers in 3D space.

---

**Transform layers**

1. Select one or more layers in the Layers list or Canvas.
2. Choose a 2D transform tool from the pop-up menu in the toolbar, as described in the previous task.

3. Drag a transform handle in the Canvas.

If you selected a single layer, only that layer is modified:

Before

After scaling

If you selected multiple layers, each is transformed. Each transform occurs around each layer’s own anchor point, so the effect is the same as if you applied the transform to each layer’s handle, one at a time:

Before

After scaling
If you select and then transform an entire group, all layers and groups nested in it are treated as a single layer.

1. Select a group in the Layers list.

   In the Canvas, a single set of transform handles appears on a bounding box that encompasses all layers in the group.

2. Choose a 2D transform tool from the pop-up menu in the toolbar, as described above.

3. Drag a transform handle in the Canvas.

All layer transforms occur around a single anchor point belonging to the group:

If you select a layer and its parent group (but not the other layers in the group), the following occurs:

- The scale handles of the parent group remain available, and the scale handles of the individual layers within the group are dimmed. Dragging the group’s scale handles scales the group, not its nested objects.
The rotation handles of the individual layers remain available. Dragging an object’s rotation handle rotates that object independently of the other objects in the group.

SEE ALSO

Select layers and groups
2D transform tools

2D transform tools

Use the 2D transform tools to adjust and manipulate objects in the Canvas. To select a tool, click the 2D transform tools control in the toolbar and, holding down the mouse button, choose a different tool from the pop-up menu.

![2D transform tool menu](image)

When you choose a 2D transform tool and then select a layer or group, handles appear in the Canvas. Drag the handles to move
or transform an object in the Canvas.

**Tip:** Press S to select the Select/Transform tool. To quickly cycle through tools, press Tab. Press Shift-Tab to cycle through the tools in reverse.

Some of the tools are activated automatically when specific layers are selected. For example, the Edit Points tool is selected after you create a complex shape or mask layer, so you can immediately adjust the Bezier or B-Spline control points.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Arrow Icon" /></td>
<td>Select/Transform tool (arrow)</td>
<td>Activates selection and transform controls in the Canvas for the selected object. Scale objects by dragging a corner point; rotate objects by dragging the center point. This is the default tool in the 2D transform tools pop-up menu. See</td>
</tr>
<tr>
<td>Tool</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Anchor Point tool</td>
<td>Activates an anchor point control (the point around which an object scales or rotates) in the Canvas for the selected object. Modify the anchor point by dragging it to a new position. See Move a layer’s anchor point.</td>
<td></td>
</tr>
<tr>
<td>Drop Shadow tool</td>
<td>Activates a drop shadow control in the Canvas for the selected object. Drag a corner handle to change a layer’s position, scale, or rotation.</td>
<td></td>
</tr>
</tbody>
</table>
change the direction and offset of an object’s drop shadow. (This control doesn’t move the object.) See Add a drop shadow to a layer.

Distort tool

Activates shear and distortion handles in the Canvas for the selected object. Drag a midpoint handle to shear two adjacent corners at the same time, leaving the other two corners locked into place; drag a corner handle to distort a corner, leaving the other
three corners locked into place. See Distort or shear a layer.

Crop tool

Activates crop handles in the Canvas for the selected object. Drag the edge or corner of the object to crop (hide) a portion of the object. See Crop a layer.

Edit Points tool

Activates points and Bezier handles in the Canvas for complex masks, shapes, and motion paths. See Modify the control points of
<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit Shape tool</strong></td>
<td>Activates points and curvature handles in the Canvas for simple shapes. See <a href="#">Draw simple shapes</a>.</td>
</tr>
<tr>
<td><strong>Transform Glyph tool</strong></td>
<td>Activates handles in the Canvas for selected text characters (glyphs). See <a href="#">Transform text glyphs and other object attributes</a>.</td>
</tr>
<tr>
<td><strong>Adjust Item tool</strong></td>
<td>Activates handles in the Canvas that modify specific parameters such as a shape or mask.</td>
</tr>
</tbody>
</table>
as the amount or angle of a Directional Blur, the shape of a particle emitter, or the start and end points of a gradient. See Transform text glyphs and other object attributes.

Change a layer’s position, scale, or rotation

The Select/Transform tool is the default tool in Motion.

Clicking the Select/Transform tool activates Canvas controls to adjust a layer’s position, scale, and rotation.
Change a layer’s position in the Canvas

1. Select a layer in the Layers list or Canvas.

   A bounding box appears around the selected layer in the Canvas.

2. Click the Select/Transform tool in the toolbar (if it’s not already selected).

   By default, the Select/Transform tool is the active tool. If you have another tool selected, such as a Mask or Shape tool, pressing the S key returns you to the 2D transform tools.

3. Drag anywhere inside the selected layer’s bounding box in the Canvas.

   The image is moved to a new position in the Canvas, and the
values are updated in the Position parameter of the Properties Inspector.

## Resize a layer in the Canvas

1. Select a layer in the Layers list or Canvas.

   A bounding box appears around the selected layer in the Canvas.

2. Click the Select/Transform tool in the toolbar (if it’s not already selected).

   By default, the Select/Transform tool is the active tool. If you have another tool selected, such as a Mask or Shape tool, pressing the S key returns you to the 2D transform tools.

3. Do any of the following:
   - *Resize width and height at the same time:* Drag a corner handle in the Canvas.

     The width and height are resized independently, which may change the aspect ratio (ratio of width to height) of the image.
- *Resize width and height proportionally:* Hold down the Shift key while dragging a corner handle in the Canvas. The aspect ratio (ratio of width to height) of the image remains the same.

- *Resize either width or height:* Drag the top or bottom
Resize either width or height: Drag the top or bottom handle to modify height; drag the left or right handle to modify width.

The width or height is resized independently of the other.

- **Resize around the anchor point:** Hold down the Option key while dragging any scale handle in the Canvas.

  The layer rescales, but the anchor point of the layer remains pinned to its position in the Canvas.

As you drag the scale handles, the new width and height percentages appear in the status bar above the Canvas and are updated in the Scale parameter of the Properties Inspector.
Note: Scaling the width or height of a layer by a negative value reverses the image, flipping its direction.

Rotate a layer in the Canvas

The Select/Transform tool also activates a handle used to rotate the image around its anchor point. For animation purposes, Motion keeps track of the number of times you’ve rotated the layer and stores this value in that layer’s Rotation parameter in the Properties Inspector.

1. Select a layer in the Layers list or Canvas.

   A bounding box appears around the selected layer in the Canvas.

2. Click the Select/Transform tool in the toolbar (if it’s not already...
By default, the Select/Transform tool is the active tool. If you have another tool selected, such as a Mask or Shape tool, pressing the S key returns you to the 2D transform tools.

3. Do one of the following:
   
   - Drag the rotation handle to rotate the layer.
   
   - Press Shift while you drag the rotation handle to constrain the angle of the selected layer to 45-degree increments.

As you drag the rotation handle, the original angle of the layer is indicated by a small circle that appears on a larger circle surrounding the layer’s anchor point. Additionally, the status bar shows you the new angle of rotation, and the value of the Rotation parameter is updated in the Properties Inspector.
Move a layer’s anchor point

Selecting the Anchor Point tool activates Canvas controls to adjust the point in a layer around which geometric transforms are performed.

Layers rotate around the anchor point, but the anchor point also affects resizing operations. For example, the default anchor point for any layer is the center of the bounding box that defines the layer’s edges. If you rotate a layer, it spins around this central anchor point.

If you offset the anchor point, however, the layer no longer rotates around its own center, but instead rotates around the new anchor point.
Change the anchor point of a layer in the Canvas

1. Select a layer in the Layers list or Canvas.
   A bounding box appears around the selected layer in the Canvas.

2. Click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Anchor Point tool.
In the Canvas, the selected layer’s anchor point appears as a round target surrounded with three colored arrows representing the X, Y, and Z coordinate axes. For more information on coordinate axes, see Transform layers in 3D space.

3. Do one of the following:
   - Drag the white circle to move the anchor point vertically or horizontally.
   - Drag an arrow to move the anchor point along the corresponding axis.

As you drag the anchor point, a line stretches from the
default position of the anchor point to its new position. Additionally, the status bar shows you the anchor point’s new coordinates and the delta (amount of change) between the anchor point’s new and old positions, and the Anchor Point parameter is updated in the Properties Inspector.

**Note:** If the anchor point is close to the center or edges of the layer, and both Snapping and Dynamic Guides are turned on, the anchor point snaps to that location.

---

**Add a drop shadow to a layer**

Selecting the Drop Shadow tool enables Canvas controls to create a drop shadow and modify its blur, angle, and distance from a layer.

A drop shadow, by default, is a dark, translucent, offset shape that falls behind a layer, as if a light were shining on the layer. Drop shadows are the same size as the layer to which they’re applied, although blurring a drop shadow might enlarge it somewhat. Drop shadows create the illusion of depth, so the foreground layer seems to pop out at the viewer. For this reason, drop shadows are frequently used to create the impression of space between two overlapping layers.
Add a drop shadow to a layer in the Canvas

1. Select a layer in the Layers list or Canvas.

   A bounding box appears around the selected layer in the Canvas.

2. Click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Drop Shadow tool.
In the Canvas, a drop shadow bounding box appears around the selected layer. By default, the drop shadow is hidden behind the layer.

3. Drag inside the bounding box to set the distance and angle of the shadow.

A shadow appears behind the layer, and the Drop Shadow parameters are updated in the Properties Inspector.

Alternatively, you can add a drop shadow by selecting a layer, then selecting the Drop Shadow activation checkbox in the Properties Inspector. For more information, see Properties Inspector controls.

---

**Adjust the blur of a drop shadow in the Canvas**

1. Select a layer in the Layers list or Canvas.
A bounding box appears around the selected layer in the Canvas.

2. Click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Drop Shadow tool.

In the Canvas, a drop shadow bounding box appears around the selected layer.

3. Drag a corner handle on the bounding box to adjust the blur of the drop shadow.

The Drop Shadow parameters are updated in the Properties Inspector.

Distort or shear a layer
Selecting the Distort tool activates Canvas controls to reposition a
layer’s corner points independently, and to shear (slant) its midsection points horizontally or vertically.

Distort a layer in the Canvas

1. Select a layer in the Layers list or Canvas.

   A bounding box appears around the selected layer in the Canvas.

2. Click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Distort tool.

   In the Canvas, a bounding box with eight handles appears around the selected layer.
3. In the Canvas, drag any of the four corner handles to stretch the layer into an irregular shape.

The Four Corner parameters are updated in the Properties Inspector.

After you distort a layer, you can revert to the layer’s original shape by deselecting the layer’s Four Corner checkbox in the Properties Inspector. Doing so resets the shape of the layer without resetting the shape you defined by dragging in the Canvas.

Shear a layer in the Canvas

1. Select a layer in the Layers list or Canvas.

   A bounding box appears around the selected layer in the Canvas.
2. Click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Distort tool.

In the Canvas, a bounding box with eight handles appears around the selected layer.

3. Drag any of the side handles or top and bottom handles to shear (slant) the layer. The top and bottom handles shear the layer horizontally. The left and right handles shear the layer vertically.
The Four Corner parameters are updated in the Properties Inspector.

**Note:** Shearing a layer using the Distort tool does not affect the Shear parameter in the Transform area of the Properties Inspector. Instead, the Distort tool modifies the Four Corner parameters to simulate a Shear effect. You can still modify the Shear parameter, effectively shearing the shear simulation for interesting results.

---

**Crop a layer**

Selecting the Crop tool activates Canvas controls to resize the borders of a layer.
Cropping lets you chop off any of the four edges of a layer to eliminate parts you don’t want to see in your composition. Common examples of layers you’d want to crop are video clips with a black line or unwanted vignetting around the edges. The crop operation can remove these undesirable artifacts. A layer might also be cropped to isolate a single element of the image.

When you crop an imported image using the Crop tool (which yields the same result as using the Crop controls in the layer’s Properties Inspector), only the instance of that file is cropped. The source image in the Media list is not cropped. To crop the source image, you must select the layer in the Media list, then use the Crop tools in the Media Inspector. For more information, see Source media controls in the Media Inspector.

**Note:** If you must isolate a more irregularly shaped layer, or you want to create a border of a specific shape, see Shapes, masks, and paint strokes overview.
Crop a layer in the Canvas

1. Select a layer in the Layers list or Canvas.

   A bounding box appears around the selected layer in the Canvas.

2. Click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Crop tool.

   In the Canvas, a bounding box with eight crop handles appears around the selected layer.

3. Do any of the following:

   - **Crop one edge**: Drag the top, left, right, or bottom handle.
   - **Crop two adjacent edges**: Drag a corner handle.
   - **Maintain the same aspect ratio while cropping**: Hold down the Shift key and drag a handle.
The ratio between the layer’s width and height is preserved.

**Note:** If a layer is modified with the Distort tool, the Crop tool and its onscreen controls become disabled. However, you can still crop a distorted layer by adjusting its Crop parameter settings in the Properties Inspector.

The Crop parameters are updated in the Properties Inspector.

---

**Move the crop area while keeping the underlying image in place**

- Drag inside the crop area.

  The crop area moves, allowing you to adjust the crop to a new location without changing its size or shape.

---

**Move the image while keeping the crop area in place**

- Hold down the Command key while dragging inside the crop area.

  The crop area remains static, but the image underneath it moves, allowing you to change the visible area of the layer.
Modify the control points of a shape or mask

Selecting the Edit Shape tool activates Canvas controls for adjusting simple shapes and masks.

Selecting the Edit Points tool activates control points in the Canvas for adjusting complex shapes and masks.

Modify a simple shape in the Canvas

1. After you create the simple shape or mask, click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Edit Rectangle or Edit Ellipse tool.
The shape or mask layer’s onscreen control points become active.

2. In the Canvas, drag the control points to modify the shape of the layer.

For information on creating and adjusting simple masks and shapes, see Draw simple shapes and Draw simple masks.

Modify a complex shape’s control points in the Canvas

1. After you create the complex shape or mask, click the 2D transform tools pop-up menu in the toolbar and, holding down the mouse button, choose the Edit Points tool.

Note: You can also double-click the shape or Control-click the layer, then choose Edit Points from the shortcut menu.
The layer’s control points become active.

2. In the Canvas, drag the control points (or the tangent handles attached to each control point) to modify the shape.

For information on creating complex shapes, see Complex shapes and masks overview. For information on adjusting complex shapes, see Edit control points overview.

Transform text glyphs and other object attributes

Selecting the Transform Glyph tool activates Canvas controls (available only when a text layer is selected) to modify the position and X, Y, or Z rotation for individual characters (glyphs) in a text layer.

For information on using the Transform Glyph tool, see Text glyphs overview.

Selecting the Adjust Item tool enables Canvas controls that allow you to manipulate filters, replicators, generators, and other objects.

For example, you can use the Adjust Item tool to adjust the center point of a blur filter, the shape of a particle emitter, or the settings of a gradient. For examples, see Use onscreen gradient controls.
Align layers in the Canvas

The Alignment submenu in the Object menu contains commands that let you reposition any number of simultaneously selected layers to align with one another in various ways. These commands make it easy to organize a jumble of layers into an even layout.

In each operation, the left, right, top, and bottom of the selected layers are defined by the bounding box that surrounds each layer. The position of the anchor point is ignored.

Align layers in the Canvas with the Object menu

- Select the layers or groups you want to align, choose Object > Alignment, then choose any of the following:
  - **Align Left Edges**: Layers are moved horizontally so their left edges line up with the leftmost layer in the selection.
  - **Align Right Edges**: Layers are moved horizontally so their
Align Right Edges: Layers are moved horizontally so their right edges line up with the rightmost layer in the selection.

Align Top Edges: Layers are moved vertically so their tops line up with the topmost layer in the selection.

Align Bottom Edges: Layers are moved vertically so their bottoms line up with the bottommost layer in the selection.

Align Far Edges: Layers are moved in Z space so their far edges line up with the farthest layer in the selection.

Align Near Edges: Layers are moved in Z space so their near edges line up with the closest layer in the selection.

Align Horizontal Centers: Layers are moved horizontally so their centers line up along the center point between the leftmost and rightmost layers in the selection.

Align Vertical Centers: Layers are moved vertically so their centers line up along the center point between the topmost and bottommost layers in the selection.

Align Depth Centers: Layers are moved in Z space so their centers line up along the center point between the farthest and nearest layers in the selection.

Distribute Lefts: Layers are moved horizontally so the left sides of all layers are evenly distributed, from right to left, between the leftmost and rightmost layers in the selection.

Distribute Rights: Layers are moved horizontally so the right sides of all layers are evenly distributed, from right to left, between the leftmost and rightmost layers in the selection.

Distribute Tops: Layers are moved vertically so the tops of all layers are evenly distributed, from top to bottom,
between the topmost and bottommost layers in the selection.

- **Distribute Bottoms:** Layers are moved vertically so the bottoms of all layers are evenly distributed, from top to bottom, between the topmost and bottommost layers in the selection.

- **Distribute Far:** Layers are moved in Z space so the far edges of all layers are evenly distributed along the Z axis, from closest to farthest, between the closest and farthest layers in the selection.

- **Distribute Near:** Layers are moved in Z space so the near edges of all layers are evenly distributed along the Z axis, from closest to farthest, between the closest and farthest layers in the selection.

- **Distribute Horizontal Centers:** Layers are moved horizontally so the centers of all layers are evenly distributed, from left to right, between the leftmost and rightmost layers in the selection.

- **Distribute Vertical Centers:** Layers are moved vertically so the centers of all layers are evenly distributed, from top to bottom, between the topmost and bottommost layers in the selection.

- **Distribute Depth Centers:** Layers are moved in Z space so the centers of all layers are evenly distributed, from closest to farthest, between the closest and farthest layers in the selection.

Each of the above commands affects the Position parameter of each layer.
Transform layers in the Inspector

Transform layers in the Properties Inspector

You can adjust layer properties using numeric controls in the Properties Inspector. These controls let you make the same adjustments afforded by the 2D transform tools, but with more precision. Adjustments made in the Canvas are simultaneously updated in the Inspector, and vice versa. The available controls vary depending on the type of layer you select in the Layers list or Canvas.

When the Project object (located at the top of the Layers list) is selected, controls become available in the Properties Inspector that allow you to modify the project’s background color, aspect
ratio, field rendering, motion blur, reflections, and other global settings. For more information on project properties, see Project properties overview.

---

### Open the Properties Inspector

Do one of the following:

- Click Inspector in the top-left corner of the Motion workspace, then click Properties.

- Choose Window > Inspector (or press F1), then click Properties.

The Inspector opens. The preview area contains a visual preview of the object and can show the multiple frames of moving footage. The Inspector preview area is similar to the File Browser and Library preview areas, but it has no Apply or Import button.

---

### Collapse or expand the pane containing the Properties Inspector
Do one of the following:

- Choose Window > Inspector (or press F1).
- Click the “i” button in the lower-left corner of the Motion workspace.

### Show or hide a group of controls in the Properties Inspector

Do one of the following:

- Position the pointer over a row that contains a section name (Transform or Blending, for example), then click Show or Hide.
- Double-click the empty space in a row that contains a section name.

![Properties Inspector](image)

Double-click to show or hide the group of controls.

### Modify layer values in the Properties Inspector
Do any of the following:

1. In the Layers list or Canvas, select a layer.

2. In the Properties Inspector, drag a slider or dial, choose an item from a pop-up menu, select a checkbox, or enter a new number in a value field.

---

**Reset a layer value to its default state**

In the Properties Inspector, do one of the following:

- Click the Reset button beside a parameter category.

- Click the Animation menu in a parameter row (the downward arrow that appears when you move the pointer over the right side of the row), then choose Reset Parameter.
For more information on how to use the parameter controls, see User color and gradient controls overview. For a description of the controls in the Properties Inspector, see Properties Inspector controls.

Properties Inspector controls
The Properties Inspector displays the following adjustable parameters for most layers and groups:

Transform parameters

- **Position**: Value sliders that define the X (horizontal), Y (vertical), and Z (depth) positions of each layer.

  Click the disclosure triangle next to the Position parameter to reveal dials that adjust position around all three axes (X, Y, and Z).

The coordinate system used by Motion specifies the center of the Canvas as 0, 0, 0 regardless of the frame size of the project. Moving a layer to the left subtracts from the X value, while moving it to the right adds to the X value. Moving a layer up adds to the Y value, and moving a layer down subtracts from the Y value. Moving a layer closer adds to the Z value, while moving a layer farther away subtracts from the Z value.
Each layer’s position is centered on its anchor point. Offsetting the anchor point also offsets the position of the layer relative to the X, Y, and Z position values you’ve set.

- **Rotation**: A dial that controls a one-dimensional value representing the number of degrees of rotation around the Z axis. A positive value rotates the layer counterclockwise. A negative value rotates the layer clockwise. Rotating a layer beyond 360 degrees results in multiple rotations when the Rotation parameter is animated.

Click the disclosure triangle next to the Rotation parameter to reveal dials that adjust rotation around all three axes (X, Y, and Z), as well as the Animate pop-up menu.

- **Animate**: A pop-up menu that sets the interpolation for animated 3D rotation channels to one of two options:
  - **Use Rotation**: The default interpolation method. Layer rotates from its start angle to its final angle. Depending on the animation, the layer might twist before reaching its final orientation (the last keyframed value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, the layer rotates on all axes before reaching its final orientation.
  - **Use Orientation**: This alternate interpolation method
Use Orientation. This alternate interpolation method provides smoother interpolation but does not allow multiple revolutions. Use Orientation interpolates between the layer’s start orientation (first keyframe) to its end orientation (second keyframe).

**Note:** The Rotation parameter must be keyframed for its Animate parameter options to have any effect. For information about keyframing, see [Keyframing overview](#). For information about 3D rotation, see [Transform layers in 3D space](#).

- **Scale:** A slider that controls the layer’s scale, relative to its original size. By default, the horizontal and vertical scale of a layer is locked to the layer’s original aspect ratio—represented by a single percentage. Click the disclosure triangle to display independent percentages for the X, Y, and Z scales of the layer.

  **Note:** Setting a layer’s scale to a negative value flips the layer.

- **Shear:** Value sliders that define the X and Y shear of the layer. A layer with no shear has X and Y shear values of 0. Positive values shear in one direction, while negative values shear in the other.

- **Anchor Point:** Value sliders that define the X and Y position of the anchor point relative to the center of the layer. Coordinates of 0, 0 center the anchor point in the bounding box defining the outer edge of the layer. Click the disclosure triangle to expose an additional value slider defining the Z position.
Blending parameters

- **Opacity**: A slider that sets the transparency of the layer. For more information, see Modify layer opacity.

- **Blend Mode**: A pop-up menu that sets the Blend Mode of the layer. For more information, see Layer blending overview.

- **Preserve Opacity**: A checkbox that, when selected, renders the layer visible only where another layer is visible behind it in the composite. The front layer uses the opacity value of the layer behind it. For more information, see Modify layer opacity.

- **Casts Reflections**: A pop-up menu that determines whether a layer casts a reflection. Choose from three options:
  - **Yes**: The layer is seen reflected in nearby reflective layers.
  - **No**: The layer is ignored by reflective surfaces.
  - **Reflection Only**: The layer becomes invisible, but appears in reflective surfaces around it.

**Note**: Reflections are only visible when layers are in a 3D group. For more information on 3D groups, see About 2D and 3D group properties.

Drop Shadow parameters

An activation checkbox to turn the drop shadow of a layer on and off. When selected, additional controls become available:

- **Color**: Color controls that set the drop shadow’s color. The default color is black.

- **Opacity**: A slider that sets the drop shadow’s transparency.

- **Blur**: A slider that specifies the drop shadow’s softness.
• **Distance:** A slider that sets how close or far a layer’s drop shadow is to the layer. The farther away a drop shadow is, the more distance there appears to be between the layer and anything behind it in the composition.

• **Angle:** A dial that lets you change the direction of the drop shadow. Changing the Angle of the drop shadow changes the apparent direction of the light casting the shadow.

• **Fixed Source:** A checkbox that, when selected, renders the drop shadow as if cast by a fixed light source, regardless of camera or text movement.

### Four Corner parameters

An activation checkbox to turn distorting on and off. If a layer is distorted and this checkbox is deselected, the layer resumes its original shape, although the distorted coordinates are maintained. Reselecting the checkbox reenables the distort effect specified by the Four Corner coordinate parameters.

When the Four Corner checkbox is selected, value sliders to modify the X and Y coordinates of the layer’s four corner points (Bottom Left, Bottom Right, Top Right, and Top Left) become available. You can also control these parameters visually in the Canvas using the Distort tool. For more information, see [2D transform tools](#).

### Crop parameters

An activation checkbox to turn cropping on and off. If a layer is
cropped and this checkbox is deselected, the layer resumes its original size, although the cropping values are maintained. Reselecting the checkbox reenables the cropping effect specified by the crop parameters.

### Timing parameters
Value sliders to control all aspects of clip retiming. For more information, see [Retime media overview](#).

### Lighting parameters
The Lighting parameter controls appear only when the parent group is set to 3D.

- **Shading**: A pop-up menu that sets how a layer responds to lights in the scene. There are three options:
  - *Inherited*: The layer uses the shading value of its parent.
  - *On*: The layer can be lit.
  - *Off*: The layer ignores lights.
- **Highlights**: A checkbox that, when selected, causes lit layers to show highlights. This parameter has no effect if Shading is set to Off. Click the disclosure triangle to reveal an additional Shininess parameter.
- **Shininess**: A slider that sets the strength of a layer’s highlights. Higher values create a glossier appearance. This parameter is disabled when the Highlights checkbox is deselected.

For more information, see [Add lights](#).
Shadows parameters

The Shadows parameter controls appear only when the parent group is set to 3D.

- **Cast Shadows**: A checkbox that sets whether a shadow is cast when a layer lies between a light source and another layer.

  **Note**: This parameter does not affect drop shadows.

- **Receive Shadows**: A checkbox that controls whether neighboring layers’ shadows affect the current layer. When this checkbox is deselected, light affects the layer as if the shadow-casting layer did not exist.

- **Shadows Only**: A checkbox that, when selected, specifies that a layer blocks light and casts a shadow, while the layer itself does not appear in the scene.

For more information, see [Shadows overview](#).

Reflection parameters

The Reflection parameter controls appear only when the parent group is set to 3D. The Reflection parameter controls are not available for 3D particle emitters, 3D replicators, or normal text layers. However, the Reflection parameters are available for flattened text, which is activated by the Flatten checkbox in the Layout pane of the Text Inspector.

- **Reflectivity**: A slider that controls the shininess of the layer’s surface. When set to 0%, there’s no reflectivity. When set to 100%, the layer is totally reflective, like a mirror.
- **Blur Amount**: A slider that controls how blurry the reflection appears, creating the appearance of soft focus due to the surface quality of the reflecting layer.

- **Falloff**: A checkbox that controls whether the reflection fades with distance from the layer, producing a more realistic result. Click the disclosure triangle to show additional controls that adjust the falloff effect: Begin Distance, End Distance, and Exponent. The Exponent slider adjusts how quickly the reflection becomes fainter as reflected layers move away from the reflecting layer.

- **Blend Mode**: A pop-up menu that determines the blend mode used for the reflection.

For more information, see [Reflection controls](#).

## Media parameters

The Media parameters (available when an image layer is selected) contain a thumbnail of the current layer and the “To” pop-up menu.

- **To**: A pop-up menu that lets you choose another image layer in your project to replace the current layer. The replaced media remains in your project in the Media pane.

## Timing parameters

Use the Timing controls to set the selected object’s In and Out points, as well as the duration of the object.
Transform layers in the HUD

Like the Inspector, the HUD (heads-up display) is contextual and changes its controls based on the selected object. For example, when you select an image layer, its HUD contains opacity, blend mode, and drop shadow controls.

When you select a shape layer, its HUD contains additional controls for adjusting fill, outline, width, feathering, and so on. When you apply an effects object to a layer or group (a filter, behavior, particle emitter, and so on), HUDs for effects also become available. For more information, see the chapters in Motion help covering those subjects.

Display a HUD

Do one of the following:

- Select a layer or group, then choose Window > Show HUD (or press F7).
- Select a layer or group, then click the Show/Hide HUD button.
in the toolbar (to the right of the timing display).

- Press D.

**Switch between HUDs of a selected layer**

Do one of the following:

- Click the downward arrow in the HUD title bar to list all possible HUDs that can be displayed for the selected object, then choose the HUD to view from the pop-up menu.

- Press D to cycle through all HUDs for the selected object. To cycle the HUDs in reverse, press Shift-D.

The HUDs are cycled in the order in which the effects were applied.

When you select multiple objects of the same type, a combined HUD appears (with “Multiple Selection” displayed in its title bar).
Jump to the Inspector from the HUD

Most of the time, the HUD displays a subset of the parameters visible in the Inspector for the selected object. If you’re working in the HUD, you can jump to the Inspector to access the remainder of the controls for that object.

- Click the Inspector icon (the “i”) in the upper-right corner of the HUD.

  The Inspector corresponding to the HUD appears.

Edit multiple objects at the same time in the HUD

For simultaneous adjustment to work, the objects must be the same (such as two Throw behaviors or two shapes).

1. In the Layers list or Canvas, select the objects (of the same type) to modify.

2. In the HUD titled “Multiple Selected,” adjust the parameters.

Adjust opacity and blending

Modify layer opacity
The opacity and blending controls for each layer appear in the Properties Inspector and in the default HUD for any selected layer.

By stacking layers with varying opacities, you can merge images together in ways not otherwise possible. For example, if you have two full-screen background images you want to use together, you can set the opacity of the layer in front to 50%, allowing the layer in back to show through.

![Images: Image in front, Image in back, Front image at 50% opacity]

You can overlap as many layers as you want, and by varying their opacities, selectively reveal layers in the back.

---

**Change a layer’s opacity**

Do one of the following:

1. In the Layers list or Canvas, select a layer.

2. Do one of the following:
   - In the Properties Inspector, adjust the Opacity slider (in the Blending section).
   - In the HUD, adjust the Opacity slider.
Note: Some layers, such as text and shapes, have additional opacity parameters in their respective panes in the Inspector. For example, setting a shape’s Opacity value in the Properties Inspector and setting its Opacity value in the Style Inspector require separate controls that have multiplicative effects. In other words, if Opacity is set to 50% in the Properties Inspector, then set to 50% in the Style pane of the Shape Inspector, the resulting opacity for the text is 25%.

Limit the visibility of overlapping layers

The Preserve Opacity checkbox in the Properties Inspector lets you limit a layer’s visibility to areas of the Canvas where the layer overlaps nontransparent regions of other layers.

- With a layer (the dolphin image in this example) selected in the Canvas or Layers list, select the Preserve Opacity checkbox in the Properties Inspector.

The only area of the layer visible is the area that overlaps the layer behind it.
At first, this might not appear to be very exciting, but the Preserve Opacity checkbox can be used in combination with the Opacity and Blend Mode controls to create some very interesting effects.

**Note:** The layer with the enabled Preserve Opacity parameter takes the opacity value of the layer beneath it in the composite stack.

Preserve Opacity is an easy way to selectively reveal part of a layer. In this example, by setting the blend mode of the top color wash layer to Exclusion, you get the resulting image:

By selecting the Preserve Opacity checkbox for the color wash layer on top, only the overlapping parts are displayed, and the superimposed image only affects the Dolphin layer.
Layer blending

Layer blending overview

While the Opacity parameter defines a uniform level of transparency for a layer, the blend modes allow you many more creative options to control how the overlapping images interact, based on the colors in each layer. By default, each layer’s blend mode is set to Normal, so changes to a layer’s opacity uniformly affect every part of the image equally.

Blend modes can create transparency in a layer regardless of the setting of its Opacity parameter. This is because the pixels of an image with a selected blend mode are combined with the pixels of any layers lying immediately below in the Canvas. For example, if you overlap two layers, then set the blend mode of the top one to Screen, the darker areas of the screened image become transparent, while the lighter areas remain more solid, resulting in the following image:
Important: The transparency created by most of the available blend modes only affects how a layer combines with overlapping layers underneath. These blend modes do nothing to affect a layer’s alpha channel. For information about blend modes that do affect a layer’s alpha channel, see Blend modes that manipulate alpha channels.

Each blend mode combines layers in different ways. For example, setting the top layer’s blend mode to Multiply yields a result opposite to that of the Screen blend mode, as the darker areas of the image remain solid, and the lighter areas become transparent.

Blend modes only affect the combination of a layer with the layers below it. Any layers appearing above have no effect on this interaction, even if the layer is transparent. In the following example, the text layers on the top level have no effect on the
For overlapping layers with different blend modes, the bottommost pair of layers is combined first, and that combination then interacts with the next layer up, and so on until all overlapping layers are combined for the final image. In this case, each layer with a specified blend mode only interacts with the image below it, whether that image is a single layer or a pair of layers blended together.

Each of Motion’s blend modes works in conjunction with the Opacity parameter to alter the interaction between the foreground and background layers. Adjusting a layer’s opacity lessens the blending effect assigned to it, even as it reduces that layer’s visibility, allowing you to customize any blend mode to better suit your needs.

Blend modes only affect overlapping layers, and have no interaction with your project’s background color (unless the background is set to Environment). If you specify a blend mode for a layer that doesn’t overlap anything, that layer remains as it was before.

SEE ALSO
Change a layer’s blend mode
You can change a layer’s blend mode in several ways.

Modify a layer’s blend mode

With a layer selected, do one of the following:

- In the HUD, click the Blend Mode pop-up menu, then choose a different mode.

- In the Properties Inspector, click the Blend Mode pop-up menu, then choose a different mode.

- Choose Object > Blend Mode, then choose a different mode from the submenu.

- Control-click a layer in the Canvas, Layers list or Timeline, then choose Blend Mode and a different mode from the shortcut menu.

- In the Layers list, display the Blend Mode column (choose View > Layers Columns > Blend Mode), then click a layer’s Blend Mode pop-up menu and choose a different mode.
How do blend modes work?

Each blend mode presents a different method of combining (compositing) two or more images. Blend modes work in addition to a layer’s alpha channel and opacity parameter.

To understand the descriptions of each blend mode in this chapter, it’s important to understand that blend modes mix colors from overlapping images based on the brightness values in each color channel in an image. Every image consists of a red, green, and blue channel, and sometimes an additional alpha channel. Each channel contains a range of brightness values that define the intensity of each pixel in the image that uses some of the channel’s color.

The effect that each blend mode has on overlapping layers depends on the range of color values in each layer. The red, green, and blue channels in each overlapping pixel are mathematically combined to yield the final image.

These value ranges can be described as blacks, midrange values, or whites. These regions are loosely illustrated by the chart below.

For example, the Multiply blend mode renders white color values in an image transparent, while black values are left alone. All midrange color values become translucent, with colors in the lighter end of the scale becoming more transparent than the
colors in the darker end of the scale.

How do blend modes affect groups? Blend modes work differently depending on whether they’re used with groups or layers. One blend mode—Pass Through—is available only for groups.

Pass Through
When a group is set to Pass Through (the default blend mode for groups), each layer in the group is blended with all layers and groups that appear underneath it in the Layers list—including layers in other groups. In the following example, the Swirls layer is set to Stencil Luma, and the Fishes layer is set to Add.

With the enclosing group set to Pass Through, the Swirls layer stencils all other layers underneath it, including the Gradient layer in the bottom group. The result is that all layers are stenciled against the background color. The Fishes layer is likewise added
Normal

When a group is set to Normal, the layers nested in that group are blended with layers underneath them in the same Group. Layers nested in the group do not blend with layers in other groups beneath them in the Layers list. In the following example, the Fishes and Swirls layers in the topmost group are blended only with themselves when the topmost group is set to Normal.

The Gradient layer in the bottom group is left unaffected, although
the transparency in the top group caused by the combination of the Add and Stencil Luma blend modes reveals the gradient in the background.

![Image of underwater scene with fish]

**Other blend modes**

When you set a group to any other available blend mode, the following happens:

- The layers in that group are blended according to their own blend modes.
- The resulting composite of all layers in that group is then blended with other groups lower in the Layers list, according to the selected blend mode for the original group.

In the example cited above, when the topmost group is set to Multiply, the composite of the Added Fishes and the Stenciled Swirls layers is multiplied with the Gradient layer in the bottommost group.
Types of blend modes

The following section describes how blend modes cause layers to combine to create different results. The blend modes are presented in the order in which they appear in the Blend Mode pop-up menu, arranged into groups of modes that create similar results.

Most of the examples in this section are created by combining the following two reference images:

The resulting image illustrates how differently the color values from each image interact under each blend mode. When examining the results, pay attention to the white and black areas of the colored squares, as well as to the highlights and shadows in the chimpanzee image. These show you how each blend mode treats
the whites and blacks in an image. The other brighter and darker colors serve to illustrate each blend mode’s handling of overlapping midrange color values. The yellow, red, pink, and blue squares, in particular, all have very different color and luminance values that contrast sharply from example to example.

**Important:** Depending on the blend mode, layer and group ordering may or may not be important. Some blend modes behave differently depending on which image is on top.

**Normal blend mode**

The default blend mode for layers. In a layer set to Normal, any transparency is caused by the Opacity parameter or by an alpha channel.

**Darkening blend modes**

The following blend modes tend to create a result darker than either of the original images:

- **Subtract:** Darkens all overlapping colors. Whites in the foreground image go black, while whites in the background image invert overlapping color values in the foreground image, creating a negative effect. Blacks in the foreground image become transparent, while blacks in the background image are preserved. Overlapping midrange color values are darkened based on the color of the background image. In areas where the background is lighter than the foreground, the background image is darkened. In areas where the background is darker than the foreground, the colors are
inverted. The order of two layers affected by the Subtract blend mode is important.

- **Darken**: Emphasizes the darkest parts of each overlapping image. Whites in either image allow the overlapping image to show through completely. Lighter midrange color values become increasingly translucent in favor of the overlapping image, while darker midrange color values below that threshold remain solid, retaining more detail. The order of two layers affected by the Darken blend mode does not matter.

The Darken blend mode is useful for using one image to texturize another selectively, based on its darker areas. You can also use Screen, Color Burn, and Linear Burn for variations on this effect.
- **Multiply**: Like Darken, Multiply emphasizes the darkest parts of each overlapping image, except that midrange color values from both images are mixed together more evenly. Progressively lighter regions of overlapping images become increasingly translucent, allowing whichever image is darker to show through. Whites in either image allow the overlapping image to show through completely. Blacks from both images are preserved in the resulting image. The order of layers affected by the Multiply blend mode does not matter.

The Multiply blend mode is useful in situations where you want to knock out the white areas of a foreground image and blend the rest of the image with the colors in the background. For example, if you superimpose a scanned sheet of handwritten text over a background image using the Multiply blend mode, the resulting image becomes textured with the darker parts of the foreground.
Color Burn: Intensifies the dark areas in each image. Whites in the background image replace the foreground image, while whites in the foreground image become transparent. Midrange color values in the background image allow midrange color values in the foreground image to show through. Lighter midrange color values in the background image allow more of the foreground image to show through. Darker midrange values in all visible overlapping areas are then mixed together, resulting in intensified color effects. The order of two layers affected by the Color Burn blend mode is important.

Linear Burn: Similar to Multiply, except that darker overlapping midrange color values are intensified, as with Color Burn. Progressively lighter color values in overlapping images become increasingly translucent, allowing darker colors to show through. Whites in either image allow the overlapping image to show through completely. The order of two layers affected by the Linear Burn blend mode does not matter.
Lightening blend modes

The following blend modes tend to create a lighter result than either of the original images.

- **Add**: Emphasizes the whites in each overlapping image and lightens all other overlapping colors. The color values in every overlapping pixel are added together. The result is that all overlapping midrange color values are lightened. Blacks from either image are transparent, while whites in either image are preserved. The order of two layers affected by the Add blend mode does not matter.

The Add blend mode is useful for using one image to selectively texturize another, based on its lighter areas such as highlights. You can also use Lighten, Screen, Color Dodge, and Linear Dodge to create variations of this effect.
- **Lighten**: Emphasizes the lightest parts of each overlapping image. Every pixel in each image is compared, and the lightest pixel from either image is preserved, so the final image consists of a dithered combination of the lightest pixels from each image. Whites in both images show through in the resulting image. The order of two layers affected by the Lighten blend mode does not matter.

- **Screen**: Like Lighten, Screen emphasizes the lightest parts of each overlapping image, except that the midrange color values of both images are mixed together more evenly. Blacks in either image allow the overlapping image to show through completely. Darker midrange values underneath a specific threshold allow more of the overlapping image to show. Whites from both images show through in the resulting image. The order of two layers affected by the Screen blend mode does not matter.
The Screen blend mode is useful for knocking out the blacks behind a foreground subject, instead of using a Luma Key. It’s mainly useful when you want the rest of the foreground subject to be mixed with the background image, based on its brightness. It’s good for glow and lighting effects and for simulating reflections. You can also use the Add, Lighten, and Color Dodge blend modes to create variations of this effect.

**Color Dodge:** Preserves whites in either the foreground or background image. Blacks in the background image replace the foreground image, while blacks in the foreground image become transparent. Midrange color values in the background image allow midrange color values in the foreground image to show through. Darker values in the background image allow more of the foreground image to show through. All overlapping midrange color values are mixed together, resulting in interesting color mixes. Reversing the two overlapping images results in subtle differences in how the overlapping midrange color values are mixed together.
**Linear Dodge:** Similar to Screen, except that lighter midrange color values in overlapping regions become intensified. Blacks in either image allow the overlapping image to show through completely. Whites from both images show through in the resulting image. The order of two layers affected by the Linear Dodge blend mode does not matter.

**Complex blend modes**

The following blend modes create results by applying a combination of effects, based on the original images. Each mode can create a variety of results depending on the specific values of the images being mixed together. Some of these modes are designed to simulate the effect of shining a light through the top layer, effectively projecting upon the layers beneath it.

- **Overlay:** Causes whites and blacks in the foreground image to become translucent and interact with the color values of the
background image, causing intensified contrast. Whites and blacks in the background image replace the foreground image. Overlapping midrange values are mixed together differently depending on the brightness of the background color values. Lighter background midrange values are mixed by screening. Darker background midrange values are mixed by multiplying. The visible result is that darker color values in the background image intensify the foreground image, while lighter color values in the background image wash out overlapping areas in the foreground image. The order of two layers affected by the Overlay blend mode is important.

The Overlay blend mode is useful for combining areas of vivid color in two images.

- **Soft Light:** Similar to the Overlay blend mode, makes whites and blacks in the foreground image translucent. However, the translucent whites and blacks continue to interact with the color values of the background image. Whites and blacks in the background image replace the foreground image. All
overlapping midrange color values are mixed together, creating a more even tinting effect than the Overlay blend mode. The order of two layers affected by the Soft Light blend mode is important.

The Soft Light blend mode is useful for softly tinting a background image by mixing it with the colors in a foreground image.

- **Hard Light:** Causes whites and blacks in the foreground image to block the background image. Whites and blacks in the background image interact with overlapping midrange color values in the foreground image. Overlapping midrange color values are mixed together differently depending on the brightness of the background color values. Lighter background midrange values are mixed by screening. Darker background midrange values are mixed together by multiplying. The visible result is that darker color values in the background image intensify the foreground image, while lighter color values in the background image wash out overlapping
areas in the foreground image. The order of two layers affected by the Hard Light blend mode is important.

- **Vivid Light**: Similar to the Hard Light blend mode, with two exceptions: Vivid Light mixes midrange color values together more intensely, and preserves whites and blacks from either overlapping image in the end result. (Dithering can cause overlapping areas of solid white and solid black.) Overlapping midrange color values are mixed together differently depending on the brightness of the background color values. Lighter midrange values become washed out, while the contrast of darker midrange color values is increased. The overall effect is more pronounced than with the Hard Light blend mode. Reversing the two overlapping images results in subtle differences in how the overlapping midrange color values are mixed together.

- **Linear Light**: Similar to the Hard Light blend mode, except that
overlapping midrange color values are mixed together with higher contrast. Whites and blacks in the foreground image block the background image. Whites and blacks in the background image interact with overlapping midrange color values in the foreground image. Overlapping midrange color values are mixed together. Lighter background colors brighten the foreground image, while darker colors darken it. The order of two layers affected by the Linear Light blend mode is important.

Pin Light: Similar to the Hard Light blend mode, except that overlapping midrange color values are mixed together differently based on their color value. Whites and blacks in the foreground image block the background image. Whites and blacks in the background image interact with overlapping midrange color values in the foreground image. The methods used by the Pin Light blend mode to mix two images are somewhat complex. Overlapping midrange color values are treated differently depending on which of the four regions of the luminance chart they fall into:

- Lighter and darker areas of the foreground image falling close to the whites and blacks are preserved.
- Areas of the foreground image falling near the center of the midrange are tinted by the background color.
Darker areas of the foreground image between the blacks and center of the midrange are lightened.

Lighter areas of the foreground image between the whites and the center of the midrange are darkened.

The result might appear alternately tinted or solarized, depending on the lightness or darkness of the overlapping values. This blend mode lends itself to more abstract effects. The order of two layers affected by the Pin Light blend mode is important.

**Hard Mix:** Similar to the Hard Light blend mode, except that the saturation of overlapping midrange color values is intensified, resulting in extremely high-contrast images. Whites and blacks are preserved. Although the order of two layers doesn’t affect the overall look of two images blended using the Hard Mix blend mode, there might be subtle differences.
Inversion blend modes

The following two blend modes create results that often appear to resemble aspects of a photographic negative of the selected layer.

- **Difference**: Similar to the Subtract blend mode (in the Darkening category), except that areas of the image that would be severely darkened by the Subtract blend mode are colorized differently. The order of two layers affected by the Difference blend mode does not matter.

- **Exclusion**: Similar to the Difference blend mode, except that the resulting image is lighter overall. Overlapping areas with lighter color values are lightened, while darker overlapping color values become transparent. The order of two layers affected by the Exclusion blend mode does not matter.
The Stencil and Silhouette blend modes let you use a single layer’s alpha channel or luma values to isolate regions of background layers and groups. (Similar effects can be accomplished using shape and image masks. In addition, masks might provide you with a greater degree of control, depending on your needs. For more information, see Shapes, masks, and paint strokes overview.)

Stencil modes crop out all non-overlapping parts of layers underneath the layer used as the stencil. Silhouette modes do the opposite, punching holes in overlapping layers underneath in the shape of the layer used as the silhouette.

When working in a 3D group, changes in depth order affect the Stencil and Silhouette blend modes differently. For example, if you have two layers in a 3D group and the upper layer is set to Stencil Alpha or Stencil Luma, the blend mode remains in effect when the upper layer is moved behind the lower layer in Z space. If you have two layers in a 3D group and the upper layer is set to Silhouette Alpha or Silhouette Luma, the blend mode does not remain in effect when the upper layer is moved behind the lower layer in Z space.

When you use the Stencil or Silhouette blend modes in a group set to the Pass Through blend mode, the resulting effect carries down through every layer in every group that lies underneath it in the Layers list, unless the group that contains it is rasterized. This is a powerful, but not always desired effect, because it prevents you from placing a background group to fill the transparent area. You can limit the Stencil or Silhouette blend mode to affect only those layers in the same enclosing group by setting the group’s blend mode to anything other than Pass Through. For example, if you set the enclosing group of the two layers in the Silhouette Shapes, masks, and paint strokes overview.
Alpha example to Normal, then add a group underneath containing additional layers, those layers show through the transparent areas created by the silhouetted group.

The following blend modes modify the alpha channel of the layer to which the blend mode is applied:

- **Stencil Alpha**: Uses the alpha channel of the affected layer to crop out all non-overlapping parts of layers and groups underneath it in the Layers list.

  ![Object used for stencil](image1) ![Object underneath](image2) ![Result](image3)

- **Stencil Luma**: Does the same thing as the Stencil Alpha blend mode, but uses the affected layer’s luma value to define transparency. Stencil Luma is useful if the layer you want to use for cropping has no alpha channel of its own.

- **Silhouette Alpha**: The reverse of the Stencil Alpha blend mode, useful for cutting holes in underlying layers.
- **Silhouette Luma:** The reverse of Stencil Luma.
- **Behind:** Forces the layer to appear behind all other layers and groups, regardless of its position in the Layers list and Timeline. If multiple layers or groups are set to Behind, they appear behind all other groups not set to Behind, in the order in which they appear in the Layers list.
- **Alpha Add:** Works similarly to the Add blend mode, but instead of adding the color channels of overlapping layers, it adds their alpha channels together. Try using this blend mode instead of Motion’s default method of alpha channel compositing for a different treatment of overlapping areas of translucency.
- **Light Wrap:** Takes bright areas from the background layer at the edge of the matte and blurs them into the foreground layer. This is intended to create a more organic, seamless composite, where light from the background appears to bleed onto the foreground layer as would occur in a natural, noncomposited image. To adjust the parameters that affect the Light Wrap, such as Amount, Intensity, Opacity, and Mode, apply the Keyer filter and make those adjustments in the Filters Inspector. For more information, see Keyer filter controls.

**Note:** Motion applies the Light Wrap effect at the end of the rendering process. When you add other filters to the layer,
such as color correction effects, they are rendered before the Light Wrap.

View and navigate in the Canvas

Zoom or pan the Canvas

You can zoom in on the Canvas to allow precision alignment and placement of objects, and you can zoom out to get a sense of the big picture or to see the path of a moving object. You can also pan the Canvas to modify your view of a composition. Zooming and panning does not change the size or layout of the images in your project. It only changes your working view of the entire composition.

Zoom using the Zoom tool

1. In the toolbar, click the view tools pop-up menu, then choose the Zoom tool.

   ![Zoom mode](image)

   Zoom mode is activated in the Canvas.

2. Do one of the following:
• Click in the Canvas to zoom in.
• Press Option and click in the Canvas to zoom out.
• Drag right or left in the Canvas to smoothly zoom in or out.

## Zoom using other methods

Do any of the following:

- Click the Zoom Level pop-up menu at the top-right side of the Canvas, then choose a zoom percentage.

![Zoom Level pop-up menu](image)

- Holding down the Space bar and Command key (in that order), drag the pointer horizontally in the Canvas. The zoom occurs around the spot clicked in the Canvas.

- On a Multi-touch device, Pinch closed to zoom out or pinch open to zoom in. After you zoom in, use a two-finger swipe in any direction to scroll around.

## Zoom a specific area of the Canvas
Zoom in: Holding down the Space bar and Command key (in that order), drag the pointer over an area in the Canvas; while still holding down the keys, click in the Canvas to zoom in 50 percent increments of the current zoom level.

Zoom out: Holding down the Space bar, Command key, and Option key (in that order), click in the Canvas to zoom out in 50 percent increments of the current zoom level.

Note: To pan the Canvas without selecting the Pan tool, hold down the Space bar and drag in the Canvas.

Zoom to make the project fill the Canvas

Click the Zoom Level pop-up menu, then choose Fit.

Pan using the Pan tool

1. In the toolbar, click the view tools pop-up menu, then choose the Pan tool.
Pan mode is activated in the Canvas.

2. Drag in the Canvas to move your composition in different directions.

**Pan using a keyboard shortcut**

- Holding down the Space bar, drag the pointer in the Canvas.

**Reset the Canvas Zoom level or Pan**

Do one of the following:

- Click the Zoom Level pop-up menu at the top-right side of the Canvas, then choose 100%.
In the toolbar, double-click the Zoom tool.

**Note:** Double-clicking the Pan tool resets pan, but not zoom.

---

**View dynamic Canvas feedback**

The status bar at the top-left side of the Canvas shows information about layer transforms, color, coordinates, and playback frame rate—dynamically, as you modify layers.

---

**Turn display of the status bar on or off**

1. Type Command-Comma to open Motion Preferences.

2. In the Appearance pane of Motion Preferences, select or deselect the Dynamic Tool Info checkbox.

   When you select Dynamic Tool Info, the status bar appears above the Canvas whenever you adjust a layer by dragging in the Canvas. For example, when you scale an object in the Canvas, the width and height values are displayed in the status bar.

---

**Display pixel color**
Some motion graphics projects require you to match or align colors in your project. The status bar can provide visual and numeric information about the color of the pixel under the pointer, as well as the value of the alpha channel. No clicking is necessary—as you move the pointer over the Canvas, the status bar updates.

1. In the Appearance pane of Motion Preferences, select the Color checkbox.

2. Choose a color format from the Display Color As pop-up menu:
   - **RGB**: The red, green, blue, and alpha components of the color are represented in values from 0–1. Super-white values can exceed the 0–1 value range.
   - **RGB (percent)**: The red, green, blue, and alpha components of the color are represented in values from 1–100.
   - **HSV**: The hue is represented in values from 1–360, and the saturation and value (luminance) are represented in values from 1–100.

3. Move the pointer over the Canvas.

   The color information displayed in the status bar updates as you move the pointer.

---

**Display the current pointer position**

For precise placement of objects in the Canvas, it can be helpful
to know the exact pixel position of the pointer. The status bar can display this information in an X and Y coordinate system (Cartesian). The center point of the Canvas is 0, 0.

- In the Appearance pane of Motion Preferences, select the Coordinates checkbox.

  When you move the pointer in the Canvas, the coordinate information updates in the status bar.

### Display playback frame rate

Part of the way Motion plays back a project in real time is by lowering the frame rate when a sequence is too complex to render at full speed. You can monitor the current frame rate—in frames per second (fps)—in the status bar.

**Note:** The frame rate appears in the status bar only while a project is playing.

![FPS: 60]

- In the Appearance pane of Motion Preferences, select the “Frame rate (only during playback)” checkbox.

  When you play the project, the frame rate appears in the upper-left corner of the status bar.

### Custom Canvas view options
The pop-up menus in the top-right side of the Canvas let you customize various view settings, including zoom level, color channels, rendering options, overlay options, and 3D view layouts.

### Zoom Level pop-up menu

Choose any of several default zoom levels. Zooming the Canvas changes the current view of the window, not the size of the images in your project. For more information, see Zoom or pan the Canvas.

### Channels pop-up menu

Choose which color channels are displayed in the Canvas:

- **Color:** Shows the image as it would appear on a video monitor. Visible layers appear in natural color and transparent areas reveal the background color as set in the Properties Inspector for the project. The background color is black by default. To change it, press Command-J, then choose a color from the Background Color control in the Properties Inspector.

**Note:** The Background pop-up menu in the Properties Inspector must be set to Solid to export the background color with the project. This option creates a solid alpha channel on export (when exporting using a codec that supports alpha channels). When the Background pop-up menu is set to Transparent, the color is visible in the Canvas, but does not
- **Render** as part of the alpha channel.

- **Transparent**: Shows the background area of the Canvas as transparent. A checkerboard pattern appears by default where no images block the background.

- **Alpha Overlay**: Displays the image in normal color, but adds a red highlight over transparent areas of the image.

- **RGB Only**: Displays the normal mix of red, green, and blue channels but displays transparent areas (including semitransparent areas) as opaque.

- **Red**: Displays only the red channel as a range of black to white.

- **Green**: Displays only the green channel as a range of black to white.

- **Blue**: Displays only the blue channel as a range of black to white.

- **Alpha**: Displays the alpha (transparency) channel of the layers in the Canvas.

- **Inverted Alpha**: Displays an inverted view of the alpha (transparency) channel.

- **Overexposure**: Displays the overexposed areas of the composition. Luminosity values above 1.0 (out of gamut) are indicated by a red-and-white crosshatch pattern. Values above 2.0 appear solid red. You can use the **Broadcast Safe filter** to limit the range of luminance or chrominance in an image to the broadcast legal limit.
Choose the render quality and resolution of the Canvas display, and enable or disable features that can impact playback performance. When an option is active, a checkmark appears beside the menu item. If a complex project is causing your computer to play at a very low frame rate, you can make changes in this menu to reduce the strain on the processor. This frees you from waiting for the image to be rendered at full resolution each time you make an adjustment, allowing you to watch complex projects at high frame rates while you work.

The Render pop-up menu displays the following items:

- **Dynamic**: Reduces the quality of the image displayed in the Canvas during playback or scrubbing in the Timeline or mini-Timeline, allowing for faster feedback. Also reduces the quality of an image as it is modified in the Canvas. When playback or scrubbing is stopped, or the modification is completed in the Canvas, the image quality is restored (based on the Quality and Resolution settings for the project).
- **Full**: Displays the Canvas at full resolution (Shift-Q).
- **Half**: Displays the Canvas at half resolution.
- **Quarter**: Displays the Canvas at one-quarter resolution.
- **Draft**: Renders objects in the Canvas at a lower quality to allow optimal project interactivity. There’s no anti-aliasing.
- **Normal**: Renders objects in the Canvas at a medium quality. Shapes are anti-aliased, but 3D intersections are not. Floating-point (32-bit) footage is truncated to 16-bit. This is the default setting.
- **Best**: Renders objects in the Canvas at best quality, which
includes higher-quality image resampling, anti-aliased intersections, anti-aliased particle edges, and sharper text.

- **Custom**: Allows you to set additional controls to customize rendering quality. Choosing Custom opens the Advanced Quality Options dialog. For more information, see Advanced Quality settings.

- **Lighting**: Turns the effect of lights in a project on or off. This setting does not turn off lights in the Layers list (or light scene icons), but it disables light shading effects in the Canvas.

- **Shadows**: Turns the effect of shadows in a project on or off.

- **Reflections**: Turns the effect of reflections in a project on or off.

- **Depth of Field**: Turns the effect of depth of field in a project on or off.

- **Motion Blur**: Enables/disables the preview of motion blur in the Canvas. Disabling motion blur may improve performance.

**Note**: When creating an effect, title, transition, or generator template for use in Final Cut Pro X, the Motion Blur item in the View pop-up menu controls whether motion blur is turned on when the project is applied in Final Cut Pro. For more information, see Final Cut Pro templates overview.

- **Field Rendering**: Enables/disables field rendering. Field rendering is required for smooth motion playback on many TV monitors. Field rendering nearly doubles rendering time, so disabling this item may improve performance.

**Note**: When creating an effect, title, transition, or generator template for use in Final Cut Pro, the Field Rendering setting in the View pop-up menu does not control whether field
rendering is applied in Final Cut Pro. Rather, field rendering is controlled in the Properties Inspector for the project. (Press Command-J to open the Properties Inspector.) When Field Order is set to anything other than None, field rendering is used in Final Cut Pro, regardless of the Field Rendering status in the View pop-up menu.

- **Frame Blending:** Enables/disables frame blending in the Canvas. Frame blending can smooth the appearance of video frames by interpolating the pixels between adjacent frames to create a smoother transition.

### View and Overlay pop-up menu

Choose layout guides and controls that can be viewed in the Canvas. When an option is active, a checkmark appears beside the menu item. (Many of these menu options are also available in the View menu in the menu bar.)

The View and Overlay pop-up menu displays the following items:

- **Show Overlays:** Enables or disables the display of rulers, grids, guides, and other layout overlays in the Canvas. This setting must be on to view any other overlay items. To turn the camera overlays on or off, use Show 3D Overlays.

  **Note:** You can also press Command-Slash (/).

- **Rulers:** Turns display of the rulers along the edge of the Canvas on or off. You can specify where the rulers appear in the Canvas pane (Alignment section) of Motion Preferences. For more information, see Manage layout with rulers and guides.

  **Note:** You can also press Shift-Command-R.
- **Grid:** Turns a grid display on and off over the Canvas. You can set the spacing and color of the grid in the Canvas pane (Alignment section) of Motion Preferences.

  **Note:** You can also press Command-Apostrophe (‘).

- **Guides:** Turns display of manually created guides on and off. Guides can only be created if rulers are displayed. You can change the color of the guides in the Canvas pane (Alignment section) of Motion Preferences.

  **Note:** You can also press Command-Semicolon (;).

- **Dynamic Guides:** Turns display of automatic dynamic guides on and off. These guides appear when dragging a layer past edges of other layers when snapping is enabled (choose View > Snap). You can change the color of dynamic guides in the Canvas pane (Alignment section) of Motion Preferences.

  **Note:** You can also press Shift-Command-Colon (:).

- **Safe Zones:** Turns display of the title safe and action safe guides on and off. By default, these guides are set at 80% and 90%. You can change these settings and the color of the guides in the Canvas pane (Zones section) of Motion Preferences.

  **Note:** You can also press the Apostrophe key (‘).

- **Film Zone:** Turns display of film aspect ratio guides on and off. This can be helpful if you are creating a project for videotape to be transferred to film. You can change the size of the guides as well as their color in the Canvas pane (Zones section) of Motion Preferences.

  **Note:** You can also press Shift-Quotation Mark (”).
Handles: Turns display of object handles in the Canvas on and off. Some onscreen transformations, such as resizing, require visible object handles. Handles appear only on selected objects.

Lines: Turns display of lines that outline an object on and off. Lines appear only on selected objects.

Animation Path: Turns animation paths on and off. These editable paths indicate the route along which animated objects travel. If the selected object is not positionally animated, this command does not appear to have any effect. If handles are not displayed, the path curves cannot be adjusted in the Canvas. Except for the Motion Path behavior, animation paths created by behaviors are for display only and are not editable.

Show 3D Overlays: Turns 3D overlays in the Canvas on and off, including Camera overlays, 3D view tools, 3D compass, inset view, 3D grid, and 3D scene icons. (3D overlays appear in projects that contain 3D groups. See View 3D overlays.)

Note: You can also press Option-Command-Slash (/).

3D View Tools: Turns the Camera menu and 3D view tools in the Canvas on and off. See 3D view tools.

Compass: Turns the 3D compass in the Canvas on and off. Using red, green, and blue axes, the compass shows your current orientation in 3D space. The red axis is X (horizontal), the green axis is Y (vertical), and the blue axis is Z (depth). See About cameras and views.

Inset View: Turns the inset view in the Canvas on and off. When enabled, a temporary window appears in the lower-right corner of the Canvas displaying an active camera or
Perspective view of the project, helping you stay oriented as you move objects in 3D space. In the 3D pane of Motion Preferences, you can change the size of the inset view, as well as control whether the inset view appears on transform changes, on all changes, or manually. See **Inset view**.

- **3D Grid**: Turns the grid in the Canvas on and off. The 3D grid helps you stay oriented and can be used to guide the placement of objects in your project. The 3D grid appears when you are in a 3D workspace. See **3D grid**.

- **3D Scene Icons**: Turns the display of cameras and lights in the Canvas on or off. Scene icons appear in the Canvas as wireframe icons. Lights appear with red (X), green (Y), and blue (Z) adjust 3D handles that let you transform and rotate them. The handles are still displayed when the 3D scene icons command is turned off. See **3D scene icons**.

- **Correct for Aspect Ratio**: Applies an artificial distortion of the Canvas in projects with nonsquare pixels. When the setting is on, the computer monitor simulates what a TV monitor displays. When the setting is off, projects with nonsquare pixels appear stretched. This is because computer monitors have square pixels. This setting does not modify the output of the project.

- **Show Full View Area**: When enabled, this setting lets you see the portion of a layer that extends beyond the edge of the Canvas. This setting is disabled by default, because it slows your project’s interactivity.
• **Use Drop Zones**: Turns drop zones on and off. When Use Drop Zones is enabled, a checkmark appears next to the menu item, and drop zones accept objects dragged to them. When this command is turned off, drop zones ignore objects dropped onto them. For more information, see [Drop zones overview](#).

• **Save View Defaults**: Saves the current state of all settings in this menu as the default state for new projects.

---

**View Layouts pop-up menu**

Choose a preferred view your project in the Canvas. You can view the Canvas as a single workspace or choose from available window arrangements in the menu. (Although the workspace views are available for 2D projects, they are most useful when working in 3D space.)

The View Layouts pop-up menu displays the following items:
• **Single**: The default value, displays a single window in the Canvas.

• **Two-up, side by side**: Displays two windows in the Canvas, one next to the other.

• **Two-up, top and bottom**: Displays two windows in the Canvas, one on top of the other.

• **Three-up, large window below**: Displays three windows, two next to each other on top and a larger window below.

• **Three-up, large window right**: Displays three windows, two stacked on the left side and a larger window spanning the right side.

• **Four-up, large window right**: Displays four windows, three stacked on the left side and one larger window on the right side.

• **Four-up**: Displays four windows, all the same size.

### Advanced Quality settings

When you choose Custom in the Quality section of the Render pop-up menu (or in the View > Quality menu), the Advanced Quality Options dialog appears.
The Advanced Quality Options dialog provides additional controls to fine-tune rendering performance and quality. It contains the following items:

- **Quality**: A pop-up menu that sets rendering quality. These settings are identical to the Quality settings in the Render pop-up menu. (For more information on the Render popup menu, see Custom Canvas view options.)

Choose one of four settings from this pop-up menu (each setting activates different options in the dialog):

- **Draft**: None of the quality options are selected, and the Text Quality parameter is set to Low. This option allows optimal project interactivity.

- **Normal**: “Shape anti-aliasing” is selected, and the Text Quality parameter is set to Medium. This option allows project interactivity that is slower than Draft, but much faster than Best.

- **Best**: “High-quality resampling,” “Shape anti-aliasing,” and “Anti-alias 3D intersections” are selected. Text render quality is set to High. This option slows down project interactivity.

- **Custom**: Lets you set your own combination of render settings.

- **High Quality Resampling**: Turns on high-quality resampling (increasing or reducing the number of pixels in an image).

- **Text Quality**: A pop-up menu that sets text-rendering quality to Low, Medium, or High. When High is selected, project interactivity may slow.

- **Shape anti-aliasing**: Renders shapes at a higher resolution
- **Shape anti-aliasing**: Renders shapes at a higher resolution, then scales objects back to regular resolution to ensure smooth edges.

- **Anti-alias 3D intersections**: Renders objects intersecting in 3D space at a higher resolution, then scales objects back to regular resolution to ensure smooth edges.

## Manage layout with rulers and guides

Using rulers and guides (line overlays) in the Canvas can help you compose or align elements of your project, as well as snap objects to rulers.

## Turn on rulers

- Click the View pop-up menu at the top-right side of the Canvas, then choose Rulers (or press Shift-Command-R).

  When Canvas rulers are enabled, a checkmark appears next to the item in the pop-up menu.

  By default, rulers appear along the left and top sides of the Canvas.

## Change the location of the rulers

1. Choose Motion > Preferences.

2. In the Canvas pane, click Alignment, then choose a ruler
Add a horizontal or vertical guide to the Canvas

1. Click in the gray area of the horizontal or vertical ruler, then drag into the Canvas.

As you drag, the position of the guide is displayed in the Canvas.

**Note:** Guides must be enabled in the View pop-up menu (or by pressing Command-Semicolon).

The ruler units are in pixels, with the 0, 0 point in the center of the Canvas.
When the guide is in the location you want, release the mouse button.

**Simultaneously add a horizontal and vertical guide to the Canvas**

1. Drag from the corner where the rulers meet into the Canvas.
2. When the guides are in the location you want, release the mouse button.

**Remove a guide from the Canvas**

- Drag the guide off the Canvas.

To delete the guide, drag into the Project pane or Timing pane areas of the Motion workspace, then release the mouse button.

**Change the color of the guides**

1. Choose Motion > Preferences.
2. In the Canvas pane, click Alignment, click or Control-click the Guide Color well, then select a color.
3D compositing overview

Motion includes a robust set of tools for creating three-dimensional layers that intersect and interact with one another.

The 3D features in Motion are powerful, yet flexible, allowing you to combine 2D elements and 3D elements to create different effects. You can:

- Rotate or reposition 2D layers in 3D space
- Create intersecting 3D layers
- Add a 3D camera and convert your entire project to 3D to take advantage of advanced 3D features such as:
Tip: Before you begin creating 3D environments, learn the basics of the 3D coordinate system in Motion. See 3D coordinates overview.

You can also create 3D text in Motion. For more information see 3D text overview.

About 3D coordinates

3D coordinates overview

In a standard 2D Motion project, coordinates are measured in two dimensions, along two axes: X (side to side) and Y (up and down). A 3D Motion project contains an additional dimension (depth), which is measured along the Z axis (front to back). All three axes (X, Y, and Z) meet in the center of the Canvas, at a point called the origin, where X=0, Y=0, and Z=0. Moving an object to the left subtracts from the X value, while moving it to the right adds to the X value. Moving an object up adds to the Y value, while moving it down subtracts from the Y value. Moving an object “closer” adds to the Z value, while moving it farther away subtracts from the Z value.

In a 2D project, the X and Y axes remain static: X always runs horizontally, and Y always runs vertically. However, in a 3D
project, you can change your point of view, which reorients (from your perspective) the direction of the 3 axes. As a result, moving an object up (from your perspective) doesn’t always mean increasing its Y position value.

![3D coordinate system](image)

**Note:** In a new project, the Canvas is oriented with the Z axis pointing straight at you. This orientation preserves the traditional two-dimensional orientation of the X and Y axes.

Motion uses the following conventions for 3D coordinates:

- Object movement is *along* an axis.
- Object rotation is *around* an axis.
- Each axis is color-coded: X is red; Y is green; and Z is blue.
- *Positive* rotation is counterclockwise around an axis.
- The coordinates of an object (as shown in the Inspector) are relative to the coordinates of the group in which the object resides. For more information, see About relative coordinates.

### About relative coordinates

In Motion, the coordinates of an object are *relative* to the
coordinates of the group that the object resides in. For example, if you position an empty group at X, Y, and Z coordinates of 100, 100, 100, then add a layer (a porcupine image in the example shown below) to the group, the layer’s coordinates are shown in the Properties Inspector as 0, 0, 0. However, in the Canvas the image layer appears offset (100 pixels right of center, 100 pixels above center, and 100 pixels “closer” to you). The layer’s absolute coordinates in the Canvas may be the same as those of its parent group (100, 100, 100), but the Properties Inspector displays the layer’s *relative coordinates* (0, 0, 0—the center of the layer’s parent group).
Rotation values are also relative to an object’s parent. For example, rotating the group 45° also rotates the porcupine layer 45° in the Canvas; however, in the porcupine layer’s Properties Inspector, the Rotation value remains 0°—the rotation value of the porcupine relative to its parent group.

Transform layers in 3D space

In Motion, 2D layers and groups can exist in the same project as 3D layers and groups. You can manipulate any 2D layer in 3D space by using the 3D transform tool.

Move a layer in 3D space

1. Select the 3D Transform tool in the toolbar (or press Q).
2. Select a layer or group in the Layers list or Canvas.

3D handles appear on the selected object in the Canvas.

3. Do any of the following:

- *Move the object horizontally*: Drag the red arrow to move the object along its X axis.

- *Move the object vertically*: Drag the green arrow to move the object along its Y axis.

- *Move the object forward or backward*: Drag the blue handle to move the object along its Z axis.

  **Tip**: If the blue handle is facing forward, drag left or right to move the object forward or backward.

As you drag, the active arrow turns yellow, and the status bar
above the Canvas displays the current coordinates of the object as well as the distance the object has moved (delta). Coordinates are given in the form of X, Y, and Z.

Rotate a layer in 3D space

1. Select the 3D Transform tool in the toolbar (or press Q).

2. Select a layer or group in the Layers list or Canvas.

3D handles appear on the selected object in the Canvas.
3. Move the pointer over one of the rotation handles (small circles surrounding the arrows) until a colored rotation ring appears, then drag the ring.

- The red ring rotates the object around its X axis.
- The green ring rotates the object around its Y axis.
- The blue ring rotates the object around its Z axis.

As you drag, the status bar above the Canvas displays the absolute rotation values as well as the amount of rotation change (delta).
Rotate a layer around all axes simultaneously

1. Select the 3D Transform tool in the toolbar (or press Q).

2. Select a layer or group in the Layers list or Canvas.

   3D handles appear on the selected object in the Canvas.
3. Holding down the Command key, move the pointer over one of the rotation handles (small circles surrounding the arrows) until all three rotation rings appear, then drag over the object (but not over the rotation handle).

The object rotates around all three axes simultaneously, and the status bar above the Canvas displays the absolute rotation values as well as the amount of rotation change (delta).

**Display a subset of the 3D transform handles**

Do any of the following:

- *Display the axis arrows only:* Press the Comma key (,).
- *Display the rotation handles only:* Press the Period key (.)
- *Display the scale handles only:* Press the Slash key (/).

When you press any key a second time, the display switches
back to the default, with all three of the onscreen controls visible.

Transform a layer in 3D space using the HUD

As an alternative to dragging in the Canvas, you can transform layers and groups in 3D space using graphic controls in the HUD.

1. Select the 3D Transform tool in the toolbar (or press Q).

2. Select a layer or group in the Layers list or Canvas.

3. Choose Window > Show HUD or press D.

4. In the HUD, do any of the following:
   - *Move a layer*: Drag in any of the three Move squares to reposition the object along its Z axis, X and Y axes, or X and Z axes. Hold down the Command key while dragging to simultaneously scale the object as it’s moved, preserving its size relative to the camera.
• **Rotate a layer:** Drag in the Rotate square to rotate the object around the X and Y axes. To rotate around the Z axis, hold down the Command key while dragging.

• **Resize a layer:** Drag in the Scale square to uniformly resize the selected object in the Canvas. To constrain scaling to the axis corresponding to the initial direction of the drag, hold down the Command key while dragging.

• **Choose an axis type:** Click the Adjust Around pop-up menu, then choose an item. Local Axis (the default) orients 3D transforms to the object’s local coordinates. World Axis orients 3D transforms to the coordinates of the 3D grid in the Canvas. View Axis orients 3D transforms to the *view space* of the current view, with the Z axis aligned along the view’s line of sight. For more information on views, see About cameras and views.

---

3D intersection
Create 3D intersection

By default in Motion, the order of layers in the Layers list determines the stacking order of layers in the Canvas. In other words, layers higher up in the Layers list appear in the Canvas on top of layers that are lower in the Layers list. This hierarchy of layer organization is called layer order. Even when you move a layer forward in Z space using 3D transform handles, that layer does not pass through or move in front of layers that are higher in the Layers list. Layer order prevents intersection and interaction of layers.

**Important:** 3D text objects only intersect with other 3D text objects. Additionally, 3D text uses only layer order: For 3D text to appear above other non-3D text layers, the 3D text must be positioned above the other layers in the Layers list; the text’s Z position in the Canvas has no effect. For more information, see About 3D text intersection and layer order.

In the image below, groups Red A and Blue B are positioned at the same point in 3D space. But because they are layer-ordered, Red A does not intersect with Blue B.

To have objects intersect in the Canvas, you must convert groups
in your project to *depth order*. You do this by converting 2D groups to 3D groups.

In the image below, because the parent group has been converted to 3D, groups Red A and Blue B now intersect.

![Layers and Depth Order Example](image)

To summarize:

- Groups and layers nested in 2D groups are composited in layer order.
- Groups and layers nested in 3D groups are composited in depth order.

A Motion project can contain both 2D and 3D groups, and both groups can be parents or nested children of one another. And you can convert a group from 2D to 3D, and vice versa, at any time.

---

**Convert a group from 2D to 3D to enable intersection**

- In the Layers list, select a 2D group, then do one of the
- Click the 2D icon to the right of the group in the Layers list.

![Layers list with 2D and 3D group icons](image)

- Choose Object > 3D Group (or press Control-D).

- In the Group Inspector, click the Type pop-up menu, then choose 3D.

![Group Inspector showing Type option](image)

The 2D group icon is replaced by a 3D group icon, and layers and groups nested in the parent group are converted to depth order, allowing intersection with other depth-ordered layers and groups. To change a group from 3D to 2D, use the same method described above.
Important: Some operations, as well as the application of some filters or a mask, cause a group to be rasterized. When a group is rasterized, it’s converted into a bitmap image. Rasterization affects 2D and 3D groups in different ways, sometimes preventing 3D intersection. For more information, see Groups and rasterization.

About 2D and 3D group properties

2D groups and 3D groups behave in different ways. And in the Group Inspector, 2D groups and 3D groups have different parameters.

The Group Inspector for 3D groups contains Flatten and Layer Order parameters. Selecting the Flatten checkbox places layers and groups inside the 3D group into a two-dimensional plane. Selecting the Layer Order checkbox composites layers and groups inside the 3D group according to their position in the Layers list rather than by depth order (position in the Canvas along the Z axis). For more information, see Create 3D intersection.

The Group Inspector for 2D groups contains the Fixed Resolution parameter. Selecting the Fixed Resolution checkbox lets you manually set the size of a group, using sliders. By default, Fixed Resolution is disabled and the size of the group is determined by...
the layers in that group. For more information, see Constrain group size.

### 2D group properties

- Nested layers and groups are composited in the Canvas in layer order (hierarchical order in the Layers list). However, adjacent 3D groups that are not nested in 2D groups can intersect based on depth order.

In the example above, the two gray balls in the 2D Foreground group are composited on top of the rest of the scene. Group A and Group B intersect because they are 3D groups, but neither of them can intersect with the 2D root-level groups.

- A 2D group can be nested in a 3D group.
- A 2D group not nested in a 3D group is locked to the camera, even if the camera is animated. (For more information about cameras, see About cameras and views.
- Filters are applied to a 2D group in local space—that is, flat to the image.
When lights are used, the group is lit as a single object; nested layers and groups are not lit individually.

**Note:** 2D groups not nested inside 3D groups are not affected by lights.

- Because it is flat, a 2D group has Drop Shadow, Four Corner, and Crop parameters in the Properties Inspector.
- 2D groups can have a fixed resolution.

### 3D group properties

- Nested layers and groups are composited in depth order (according to their position along the Z axis).
- When a 3D group is nested in a 2D group, the 3D group is flattened. This means that the nested 3D group acts like a flat card and ignores the camera. In addition, the flattened group does not intersect with layers of the 2D group or other groups in the project.
- Filters are applied to a 3D group in view space. In other words, the filter affects the group as if it were applied to the lens of the camera viewing the group.
When lights are used on a 3D group, its nested layers and groups are lit individually.

Only a 3D group with the Flatten parameter enabled has Crop, Drop Shadow, and Four Corner parameters in the Properties Inspector.

Add cameras to create 3D environments

3D cameras overview

By default, newly created Motion projects are 2D, planar environments. When you add a scene camera and convert your project to a 3D environment, the following occurs:

- A third dimension (depth) is activated in the Canvas, represented by the Z axis.

- A camera object is added to the Layers list and to the Canvas (as a wireframe icon that you can drag like any other object in Motion). Like a real-world camera, a Motion scene camera lets you frame a custom point of view during your sequence. And like a real camera, a Motion scene camera can be static or set into motion to create elaborate tracking shots.
• Controls become available in the Inspector for adjusting your camera’s angle of view and other properties. See Controls in the Camera Inspector.

• 3D overlays become available in the Canvas to help you view and arrange your 3D elements. See View 3D overlays.

• Additional reference views (called reference cameras) become available so that you can see your 3D project from various angles (from the front, back, sides, and so on). See About cameras and views.

• A group of camera behaviors becomes available, allowing you to apply sophisticated animated camera moves. See Add Camera behaviors.

SEE ALSO
Add a camera
About cameras and views

Add a camera

In 3D mode, anything you see in the Canvas represents the viewpoint of a camera, either a default reference camera or a scene camera that you create. You can create cameras to look at your scene from different points of view. You can place cameras, animate them, and apply behaviors to them. Creating multiple cameras lets you make different cameras active at different times, allowing you to “cut to” different views over the course of the project.

Note: When building a 3D project, it can be useful to position cameras to examine your project’s layout from different
viewpoints. Rather than repeatedly moving the Perspective camera, you can add scene cameras to use as spatial bookmarks. You won’t want to use these cameras during export, so be sure to disable them before rendering.

The scene cameras you create are used for rendering output. Scene cameras appear in the Canvas as wireframe camera icons and as objects in the Layers list.

---

**Add a scene camera to a Motion project**

1. Click the New Camera button in the toolbar, or choose Object > New Camera.

   ![New Camera button](image)

   If your project contains no existing 3D groups, the following dialog appears:

   ![Dialog](image)

   If your project is empty or already contains at least one 3D group, go to step 3.

2. Do one of the following:
   - To add a camera without converting 2D groups in your project.
   - To add a camera while converting 2D groups to 3D.

   ![Options](image)
- To add a camera without converting 2D groups in your project to 3D groups, click Keep as 2D.
- To add a camera and convert 2D groups in your project to 3D groups, click Switch to 3D.

The following happens:

- A camera object is added to the Layers list and Canvas (represented there by a wireframe icon).
- The 3D Transform tool in the toolbar is selected.
- The Camera HUD becomes available (if it isn’t visible, press F7).
- The Camera Inspector becomes available.
- The Camera pop-up menu (set to Active Camera) becomes available in the upper-left corner of the Canvas.

3. Click the Camera pop-up menu in the upper-left corner of the Canvas, then choose a camera view.
About cameras and views

In a 3D workspace, everything is seen from the viewpoint of a camera. If you want to export your project specifically from a camera view, you must add a *scene camera*. When you add a scene camera to a project, additional *reference cameras* become available to help you see your composition from various angles, such as top, bottom, left, and right. Scene cameras are used for rendering output when you export your project; what you see through the scene camera represents your final render. Reference cameras are not used for rendering.

Scene cameras

There are two types of scene cameras to choose from in the Camera Inspector:

- **Framing**: Sets the camera origin (or anchor point) at the focal plane (a plane perpendicular to the camera’s local Z axis—in other words, perpendicular to your line of sight as you look at the Canvas). The position of a Framing camera’s origin makes it useful for orbiting moves—rotating the camera causes it to orbit.
• **Viewpoint**: Sets the camera origin (or anchor point) at the center of projection, “inside” the virtual camera. Rotating a Viewpoint camera causes it to pivot—also known as *panning* (horizontal) or *tilting* (vertical).

For more information, see Controls in the Camera Inspector.

You set the scene camera type (Framing or Viewpoint) in the Camera Inspector. Scene cameras appear in the Layers list and Canvas (as wireframe objects that you can move and rotate to change your point of view).

---

**Reference cameras**

There are two types of views provided by the reference cameras:

• **Orthogonal**: Views the scene by looking straight down one of the world axes: X, Y, or Z. The Front and Back cameras look straight down the Z axis. The Top and Bottom cameras look straight down the Y axis. The Left and Right cameras look straight down the X axis. Orthogonal views do not show perspective.
• **Perspective:** Views the scene with perspective distortion, the way a real-world camera would. (Scene cameras also view the scene in perspective.)

Reference camera views are selected in the Canvas, via the Camera pop-up menu or the 3D compass.

Reference cameras do not appear as objects in the Layers list or Canvas, nor can they be manipulated like a scene camera.

**SEE ALSO**
Add a camera
View 3D overlays
Scale, position, and animate cameras
Controls in the Camera Inspector

**Work with camera views and overlays**

**View 3D overlays**
After you add a camera to your project, there are six 3D overlays available in the Canvas to help you view and arrange your 3D elements:

- Camera pop-up menu: Sets the camera view
- 3D compass: Rotates the camera view
- Orthogonal camera view: A: Object rotated in orthogonal camera view
- Object rotated in perspective camera view

Orthogonal camera view with no rotation
Object rotated in orthogonal camera view
Object rotated in perspective camera view
- **Camera pop-up menu**: Sets the camera view.
- **3D view tools**: Control reference and scene cameras.
- **Inset view**: Displays the scene from a different camera’s perspective.
- **3D grid**: Shows the ground plane of the 3D world.
- **3D compass**: Changes the Canvas view in 3D space.
- **3D scene icons**: Display onscreen representations of cameras, lights, and edge-on lines.

Show or hide 3D overlays

Do one of the following:
Choose View > 3D Overlays, then choose an overlay type.

Click the View pop-up menu above the Canvas, then choose an overlay type.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is enabled in the Canvas.

Camera pop-up menu

The Camera pop-up menu, located in the upper-left corner of the Canvas, lists the active camera view. Choose from a list of scene cameras and reference cameras. This menu also contains several view-related commands.

The Camera pop-up menu is divided into three sections:

- The top section lets you select the active scene camera as well as any other scene cameras you’ve added to your project. For more information on scene cameras, see Add a
Active Camera/Camera: When you choose Active Camera from the pop-up menu, the topmost camera in the Layers list at the current playhead position (in the Timeline) becomes the active camera. The active camera is the camera through which you view your project in the Canvas. It’s also the camera view that’s rendered when you export your project. If a project contains only one scene camera (as shown above), two items appear at the top of this pop-up menu: Active Camera and Camera, which represent the same camera.

If a project contains more than one scene camera (as shown below), all scene cameras appear at the top of the Camera pop-up menu, under the Active Camera item. To make a different scene camera the active camera, choose a different camera from the top section of the pop-up menu. (Scene cameras listed in this section of the Camera pop-up menu appear in the same order as they do in the Layers list.)
For more information, see Work with multiple cameras.

- The middle section of the Camera pop-up menu lets you choose a reference camera to help you see your composition from various angles. Choose any of the following to activate a reference camera view:
  - **Perspective:** Like a real-world camera, views the scene with perspective distortion. For example, layers farther away from the camera appear smaller than layers closer to the camera. The perspective view defaults to a view from the front center.
  - **Front:** This orthogonal camera looks straight down the Z axis and shows a perpendicular view from the front of the scene.
  - **Back:** This orthogonal camera looks straight down the Z axis and shows a perpendicular view from the back of the scene.
  - **Left:** This orthogonal camera looks straight down the X axis
and shows a perpendicular view from the left of the scene.

- **Right**: This orthogonal camera looks straight down the X axis and shows a perpendicular view from the right of the scene.

- **Top**: This orthogonal camera looks straight down the Y axis and shows a perpendicular view from the top of the scene.

- **Bottom**: This orthogonal camera looks straight down the Y axis and shows a perpendicular view from the bottom of the scene.

**Note**: The orthogonal camera views (Front, Back, Left, Right, Top, and Bottom) ignore perspective.

The reference camera views cannot be exported. However, you can still animate a scene camera when a reference camera view is selected.

**Note**: Because project objects are 2D (flat), they may not be visible in the Canvas when you choose an orthogonal camera view (Front, Back, Left, Right, Top, and Bottom). This is because orthogonal views are at right angles (perpendicular) to 2D elements in your project. When you select an object that’s invisible to an orthogonal references camera, a thin white line represents the object in the Canvas. For more information, see 3D scene icons.

- The bottom section of the Camera pop-up menu allows access to five frequently used commands:
  - **Reset View**: Resets the camera view to its default orientation. (Control-R)
  - **Select Active Camera**: Selects the active camera in the project—the topmost camera in the Layers list that is
visible at the current frame (when there are multiple cameras existing at the same frame in time). (Control-Option-C)

- **Fit Objects Into View:** Reframes the current camera to fit the selected objects into the Canvas. (F)

- **Frame Object:** Frames the selected objects in the active view. If no objects are selected, Frame Object resets the reference camera to view all objects in the scene. (Shift-Command-F)

- **Focus On Object:** Used when a camera has depth of field turned on. Adjusts the camera’s Focus Offset to the selected object. (Control-F)

After you choose a camera view (scene camera or reference camera), use the **3D view tools** to pan, orbit, or dolly the camera.

### 3D view tools

The 3D view tools in the upper-right corner of the Canvas become available after you add a camera to your project. Use these tools to modify the position and orientation of reference and scene cameras, thereby changing your view of objects in 3D space.

A scene camera indicator (a gray camera icon) appears at the left of the 3D view tools when a scene camera is the active camera. This icon is a reminder (not a button or control) that when you use the 3D view tools, you are moving the scene camera, which affects your project’s output.
Pan, orbit, or dolly using the 3D view tools

Do one of the following:

- **Pan**: Drag over the leftmost control to move the camera along the X and Y axes relative to the current view.

- **Orbit**: Drag over the middle control to orbit the camera around the selected scene object. If nothing is selected, the camera orbits around its focal plane. For more information on the camera focal plane, see Controls in the Camera Inspector. Orbit can affect X, Y, and Z Position values, as well as X and Y Rotation values.

  **Note:** If you use the orbit control to change an orthogonal reference camera, an asterisk appears next to the view’s name in the Camera pop-up menu, indicating that the view is no longer a true orthogonal view.

- **Dolly**: Drag over the rightmost control to dolly the camera, moving it along the Z axis relative to the current view.

  **Tip:** Double-clicking a 3D view tool resets all parameters that can be affected by the tool.

Pan, orbit, or dolly in small or large
Do one of the following:

- Hold down the Shift key while dragging in the Pan, Orbit, or Dolly controls to adjust the camera in increments of 10.
- Hold down the Option key while dragging in the Pan, Orbit, or Dolly controls to adjust the camera in increments of .01.

Pan, orbit, or dolly using keyboard commands and a two-button or three-button mouse

Do one of the following:

- **Pan**: Drag in the Canvas while holding down the Option key and the right mouse button.
- **Orbit**: Drag in the Canvas while holding down the Command key and the right mouse button.
- **Dolly**: Drag in the Canvas while holding down the Command key, the Option key, and the right mouse button.

Reset your camera

Do one of the following:

- Double-click the Pan, Orbit, or Dolly tool.
Click the pop-up Camera pop-up menu (in the upper-left corner of the Canvas), then choose Reset View.

In the Properties Inspector for the camera, click the reset button for the Transform parameters.

![Reset button](image)

### 3D compass

Located in the lower-left corner of the Canvas, the 3D compass acts as an orientation and shortcut device. It has active and passive states, depending on whether the pointer is positioned over it. In its passive state, it displays the orientation of the three world axes (X, Y, and Z). In its active state, the compass presents color-coded shortcuts to activate the reference (orthogonal and perspective) cameras.

[3D Compass in passive state](image)  [3D Compass in active state](image)
Show or hide the 3D compass

- Click the View pop-up menu above the Canvas, then choose Show 3D Overlays and 3D Compass.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is enabled in the Canvas.

Select a reference camera view using the 3D compass

1. Position the pointer over the compass.

   The compass changes to its active state, displaying a labeled icon for each reference camera view.

2. Click the icon representing the camera to activate.

   The view in the Canvas updates to the selected reference camera view.

Select a camera view using the 3D compass

1. Position the pointer over the 3D compass.

   The compass changes to its active state.

2. Control-click the 3D compass, then choose a scene camera or reference camera view from the shortcut menu.
The view in the Canvas changes to the selected camera view.

Inset view

When you move an object (a layer, group, camera, or light) in a 3D project, an inset view appears in the lower-right corner of the Canvas, showing the scene from a different camera’s point of view. If you’re viewing the scene through the active camera, the inset view shows the Perspective camera’s point of view. If you’re viewing the scene through any other camera, the inset view shows the active camera. Use the inset view to see the results of changes that you make in orthogonal views.

![Camera](image)

Show the inset view

- Click the View pop-up menu above the Canvas, then choose Show 3D Overlays and Inset View.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is enabled in the Canvas.
You can set the inset view’s size and when it appears in the Canvas by opening Motion Preferences (press Command-Comma), then adjusting the settings in the 3D pane.

3D grid

The 3D grid shows the *ground plane* of the 3D world. The ground plane is, as the name states, a plane attached to the ground of the scene, where Y equals 0. The ground plane represents the dividing line between up and down, that is, between positive Y values and negative Y values. It is centered on 0, 0, 0.

Show the 3D grid

- Click the View pop-up menu above the Canvas, then choose Show 3D Overlays and 3D Grid.
A checkmark next to an overlay type in the pop-up menu indicates that the overlay is enabled in the Canvas.

### 3D scene icons

3D scene icons are onscreen wireframe representations of cameras and lights in your project. (When a scene camera is active, its 3D scene icon is not visible because you’re viewing the scene through that camera. To see the camera’s scene icon, click the Camera pop-up menu and choose a different camera view.)

When you rotate a flat layer (a shape or image) so that its plane is perpendicular to the screen, another type of 3D scene icon becomes visible: an edge-on line that lets you see and manipulate an object that would otherwise be invisible.

**Note:** No 3D scene icons appear in exported images or movie clips.

**Tip:** Double-click a camera scene icon to select it and change the current view to that camera.
Show the 3D scene icons

- Click the View pop-up menu above the Canvas, then choose Show 3D Overlays and 3D Scene Icons.

  A checkmark next to an overlay type in the pop-up menu indicates that the overlay is enabled in the Canvas.

Viewport layouts

Viewports are window divisions in the Canvas that display multiple camera views at the same time. Viewports can help you animate and position objects in 3D space. The default viewport is a single camera view. You can add more viewports by clicking the gray box in the top-right corner of the Canvas, then choosing an arrangement:

- *Single*: The default value, displays a single viewport window in
the Canvas.

- **Two-up, side by side**: Displays two viewport windows in the Canvas, one next to the other.

- **Two-up, top and bottom**: Displays two viewport windows in the Canvas, one on top of the other.

- **Three-up, large window below**: Displays three viewport windows, two next to each other on top and a larger window below.

- **Three-up, large window right**: Displays three viewport windows, two stacked on the left side and a larger window spanning the right side.

- **Four-up, large window right**: Displays four viewport windows, three stacked on the left side and one larger window on the right side.

- **Four-up**: Displays four viewport windows, all the same size.

When working with multiple viewports, the most recent view clicked in is the active view. The active viewport is highlighted with a yellow border. Only the active viewport displays transform handles.
Note: The active viewport in the Canvas is not the same as the active camera. For more information, see About cameras and views.

Work with multiple cameras

If a scene contains more than one camera, you can set the topmost camera in the Layers list and Timeline to be the active camera at the current frame. Although the active camera is the default camera used for export, you can select any scene camera to export. (The active camera is not the same as the active view. The active view is the last viewport you clicked in when working with multiple viewports.)
Note: Dragging and dropping an object onto the Canvas adds the object to the scene at the focal plane of the current camera. Dragging an object into the Layers list or clicking the Apply button in the preview area of the File Browser positions the object at 0, 0, 0 in the Canvas.

Make a camera active based on its layer order

- In the Canvas, click the Camera pop-up menu, then choose Active Camera.
The topmost camera in the Layers list at the current frame becomes the active camera (Camera 2 in the example above).

**Make a specific camera the active camera**

- In the Canvas, click the Camera pop-up menu, then choose a scene camera.
Scale, position, and animate cameras

Motion gives you various ways to scale, position, “walk,” and animate cameras. After you position cameras in a project, you can select a single camera view using the Isolate command. For more information, see Isolate an object in the Canvas.

Scale a camera

Use the Scale parameter in the Properties pane of the Inspector to scale what a scene camera sees. For example, when the
camera “shrinks,” the scene it views seems to become larger.

1. Select a camera in the Canvas, Layers list, or Timeline.

2. In the Properties Inspector, drag the Scale slider.

**Note:** Changing the Scale value does not affect a camera’s Angle of View parameter. Additionally, changing the Scale value only affects framing cameras. For more information about framing cameras, see About cameras and views and Controls in the Camera Inspector.

---

**Position a camera in the Canvas**

Do one of the following:

- Drag a camera or its onscreen controls in the Canvas.
  
  For more information, see Transform layers in 3D space.

- Select a camera in Canvas, Layers list, or Timeline, then adjust the Position or Rotation controls in the Properties Inspector.

- Select a camera in Canvas, Layers list, or Timeline, then adjust the 3D transform controls in the HUD.

  For more information, see Transform layers in 3D space.

- Select a camera in Canvas, Layers list, or Timeline, then adjust the 3D view tools in the upper-right corner of the Canvas.
Position a camera using the Walk 3D View tool

The Walk 3D View tool lets you position a camera in 3D space as you would in a computer game, using a keyboard-and-mouse navigation method.

1. Select a camera, then click the view tools control in the toolbar and, holding down the mouse button, choose the Walk 3D View tool.

The pointer changes to indicate that the Walk 3D View tool is active.

2. Use the Up Arrow, Down Arrow, Right Arrow, and Left Arrow keys to move the camera in 3D space; hold down the Option key while using the arrow keys to move the camera more slowly.

You can also drag in the Canvas to orient the camera.

If you’re using a scene camera, you can also record the 3D view tools...
movement you create using the Walk 3D View tool, by creating keyframes. For more information on keyframing, see Add keyframes.

Note: The Walk 3D View tool is available only when Active Camera, Camera, or Perspective is selected from the Camera pop-up menu. For more information on the Camera pop-up menu, see Camera pop-up menu.

Animate a camera

Do one of the following:

- Add keyframes to a camera parameter in the Camera Inspector or Properties Inspector.

  For more information on animating with keyframes, see Keyframing overview.

- Apply a basic behavior or a Camera behavior to a camera.

  For more information on Camera behaviors, see Add Camera behaviors.

- Apply a Parameter behavior to camera parameter in the Camera Inspector or Properties Inspector.

  For more information on Parameter behaviors, see Add, remove, and disable a Parameter behavior.
Isolate an object in the Canvas

The Isolate command (and Isolate button) temporarily aligns the current view with the selected object and hides all other objects in the scene, facilitating access to distant or obscured objects.

The Isolate command is not intended for creating a camera view to be rendered or exported, but rather to temporarily restrict your view to a single object so you can modify or manipulate that object more effectively.

Isolate an object

1. Select the object to isolate in the Canvas, Layers list, or Timeline.

2. Do one of the following:
   - Choose Object > Isolate (or press Control-I).
   - In the Layers list or Timeline, click the Isolate button.

   The current view changes to align itself with the selected object, and all other objects in the scene are hidden.
When an object is isolated, a temporary camera is created and listed in the Camera pop-up menu. The camera shares its name with that of the isolated object.

**Exit the isolated view**

Do one of the following:

- Choose Object > Isolate (or press Control-I).
- In the Layers list or Timeline, click the Isolate button.
- Choose a different camera from the Camera pop-up menu.

**Note:** You can isolate as many objects as you have viewports. It’s a common workflow to edit an object in an isolated view while looking at the results through a scene camera in another viewport. After an object is isolated in a view, you can activate another viewport and isolate a different object. For more information, see Viewport layouts.
Controls in the Camera Inspector

You can modify a scene camera’s properties in the Camera Inspector (and in the Camera HUD).

To open the Camera Inspector, select a camera in the Canvas, Layers list, or Timeline, then click Camera in the Inspector.

The Camera Inspector contains the following parameter controls:

- **Camera Type**: A pop-up menu to set the type of camera used. There are two options:
  - **Framing**: Sets the camera origin at the focal plane. The focal plane of a camera is a plane located at a distance equal to the camera’s focal distance along its local Z axis (or line of sight) and oriented perpendicular to the camera’s local Z axis.
  - **Viewpoint**: Sets the camera origin at the center of projection, “inside” the virtual camera.

- **Angle of View**: A slider to set the number of degrees in which
the camera sees. Values range from 0 to 180 degrees.

**Note:** When you animate the Angle of View parameter on a Framing camera, the result is an *opposing dolly* effect. An opposing dolly zooms in the opposite direction that the camera moves. When you animate the Angle of View parameter on a Viewpoint camera, the result is a regular camera zoom.

- **Near Plane:** A slider to set the distance where the camera begins to see objects. Objects closer to the camera than this distance are not rendered from this camera’s point of view.

- **Far Plane:** A slider to set the distance where the camera ceases to see objects. Objects farther from the camera than this distance are not rendered from this camera’s point of view.

- **Near Fade:** A slider to set the softness factor for the near plane. The softness factor sets a boundary range over which near objects fade in.

- **Far Fade:** A slider to set the softness factor for the far plane. The softness factor sets a boundary range over which far objects fade out.
The Camera HUD contains the Camera Type, Angle of View, Focal Length, and DOF Blur Amount parameters, which are also available in the Inspector. The Camera HUD also contains 3D transform controls. For more information, see Transform layers in 3D space.

Depth of field

Depth of field overview

In the real world, cameras have a limited range of focus. Objects within that range appear sharp, and the farther outside that range an object is, the blurrier it appears. This effect is used by camera operators to help limit which part of a scene the viewer pays attention to. Motion lets you simulate that phenomenon, thereby increasing the sense of depth in a 3D scene.

Every camera in Motion has a focus offset that determines the precise location of perfect focus. Stretching away from that point in either direction are near and far focus points, which determine
the range of the depth of field.

**Note:** Some complex objects, such as local 3D text and paint strokes with enabled Dynamics, are not affected by depth-of-field settings.

**Render depth of field effects**

When depth of field is employed, playback performance may be significantly impacted. To alleviate this issue, you can disable the effects of depth of field settings while working on other aspects of your project.

**Enable or disable depth of field effects**
Click the Render pop-up menu in the upper-right corner of the Canvas, then choose Depth of Field (or press Control-Option-D).

When a check mark is visible next to the menu item, the effects are rendered. When no check mark is visible, all objects remain in focus.

**Turn off depth of field in the Inspector**

- Select a camera in the Layers list or Timeline, then, in the Camera Inspector, set the DOF Blur Amount value (in the Depth of Field section) to 0.

**Depth of Field controls in the Camera Inspector**

You can modify a camera’s depth of field parameters in the Camera Inspector:

- **DOF Blur Amount**: A slider to control the maximum amount of blur applied to out-of-focus objects.
- **Focus Offset**: A slider to set the distance from the camera where objects are in perfect focus.
- **Near Focus**: A slider to set the nearest point of focus, measured in pixels as an offset from the focal distance.
- **Far Focus**: A slider to set the farthest point of focus, measured in pixels as an offset from the focal distance.
• **Infinite Focus:** A checkbox that sets the far focus to infinity, overriding the setting chosen in the Far Focus slider.

• **Filter:** A pop-up menu to set the type of blur algorithm used to render the out-of-focus areas. Choices include Gaussian or Defocus. The Defocus setting renders a more realistic effect, but may impact performance.

  **Tip:** For best results, use Gaussian when setting up a scene, and Defocus for final output.

• **Filter Shape:** When the Filter pop-up menu is set to Defocus, this pop-up menu lets you choose between a disk-shaped, or polygon-shaped render kernel. Different shapes produce subtly different blur patterns simulating different types of camera lenses.

• **Sides:** When the Filter Shape pop-up menu is set to Polygon, this slider sets the number of sides in the polygon.

• **Depth:** A pop-up menu to set the depth to Radial or Planar. Although Radial typically exhibits more realistic results, there are some cases where it may look artificial. These include cases where the camera is set to a high DOF Blur Amount, or if the image layer is close to the edge of the frame, is very large, is rotated, and so on. In these cases, switching to Planar may improve results.

---

**Camera behaviors**

**Add Camera behaviors**

Although most types of behaviors in Motion can be applied to cameras, there is an additional set of behaviors specifically
designed to be applied to cameras in a 3D project. These Camera behaviors create common camera moves such as dollying, panning, and zooming without keyframing.

There are six camera-specific behaviors: Dolly, Focus, Framing, Sweep, Zoom In/Out, and Zoom Layer.

### Add a Camera behavior

1. Select a scene camera in the Layers list, Canvas, or Timeline.

2. In the toolbar, click the Add Behavior pop-up menu, choose Camera, then choose an item from the submenu.

   ![Add Behavior toolbar](image)

   The behavior is applied to the camera object and appears under it in the Layers list and Timeline.

---

**SEE ALSO**

Behaviors overview

**Dolly**

The Dolly behavior moves the camera a specified distance along the camera’s Z axis.
After you apply this behavior, the Dolly section of the Behaviors Inspector contains the following parameter controls:

- *Distance:* A slider to set the distance of the dolly movement.
- *Speed:* A pop-up menu to set the type of interpolation used for the movement. The value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

The HUD contains the same controls as the Inspector.

Focus

The Focus behavior animates the camera’s Focus Offset parameter to focus on a target object. For more information on camera focus settings, see Depth of field overview.

**Tip:** Use this behavior to perform a rack-focus effect during a scene.

After you apply this behavior, the Focus section of the Behaviors Inspector contains the following parameter controls:

- *Target:* An image well to specify the object upon which the camera will focus. Drag an object from the Layers list into the well.
- *Transition:* A slider to set how long it takes for the camera to reach the focus position, measured as a percentage of the behavior’s duration.
- *Speed:* A pop-up menu to set the type of interpolation used for the movement. Values include Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.
The HUD contains the same controls as the Inspector.

**Framing**

The Framing behavior animates the camera along a path to position it in front of a selected layer. You can control how the layer fits into the frame at the ending position, and you can control the shape of the path to affect the amount of bend or curvature, as well as the apex of such a curved path. Other parameters allow you to customize the camera’s orientation along the path, the speed at which it travels, and at what point it begins orienting towards the target object.

The Framing behavior has handles to allow you to manipulate the path and ending position in the Canvas. For more information on using the Framing behavior’s handles, see Use Framing behavior onscreen controls.

**Tip:** Multiple framing behaviors can be arranged consecutively to move a camera from one object to another over the course of a scene.

**WARNING:** Applying a Framing behavior before or after a Basic Motion behavior, such as Motion Path or Throw, can create unexpected results. These behaviors can continue to affect the object even after the behavior ends. For example, if a Framing behavior is applied after a Motion Path behavior is applied, the residual effect of the Motion Path is combined with the path generated by the Framing behavior, resulting in the target object being framed improperly.

After you apply this behavior, the Framing section of the
Behaviors Inspector contains the following parameter controls:

- **Target**: An image well to specify the object upon which the camera is framed. Drag an object from the Layers list into the well.

- **Target Face**: A pop-up menu to specify which side (face) of the target layer the camera points to at the end of the framing behavior. For example, when you choose “Bottom (-y),” the camera swoops in from its original position to frame the bottom of the object, pointing up along the Y axis.

- **Up Vector**: A pop-up menu that provides a constraint for the camera to keep it the right way up. By default, the camera is upright along the Y axis. When you choose “Target +X,” the camera moves from its original position and rotates so that it’s perpendicular to the X axis of the target object, making its upright axis +X (the right side of the X axis, based on the 0, 0, 0 coordinate system). When you choose “World +X,” the camera moves from its original position and rotates so that it is perpendicular to the +X axis of the 3D space (rather than the axis of the target layer). When you choose “Auto,” Motion tries to guess the upright axis.
For more information on coordinates, see 3D compositing overview.

- **Framing**: A pop-up menu to specify how the target should be framed. The menu choices include the following:
  
  - **Fit Horizontally**: Positions the camera so the full width of the target fits in the width of the frame.
  
  - **Fit Vertically**: Positions the camera so the full height of the target fits in the height of the frame.
  
  - **Fit Both**: Positions the camera so both width and height of the target fit in the frame.
  
  - **Simple Fit**: Positions the camera so both width and height of the project fit in the frame. If the target object is larger or smaller than the project dimensions, it may not properly fill the frame.
  
  - **Custom Fit**: This option appears when you modify the Framing Offset parameter (described below).

- **Framing Offset**: Three value sliders (X, Y, and, when expanded, Z) to offset (in pixels) the point on the target that is centered, relative to the camera. By adjusting Framing Offset, you can target a point other than the center of the object. The Z slider moves the camera nearer to or farther from the target.

- **Offset Path Apex**: A slider to set the position along the path
Offset Path Apex: A slider to set the position along the path (from the original position to the framing position) where the bend (if any) occurs if the user chooses to offset the path. Offset Path Apex is expressed as a value between 0 and 1 (0 being at the start of the path, 1 being the end, and 0.5 being halfway along the path).

Path Offset: Three value sliders (X, Y, and, when expanded, Z) to offset the camera’s position from the path, measured in pixels.

Orientation: A pop-up menu to set whether the camera is oriented towards the target at every frame (Orient to Current) or oriented towards the target at its final position (Orient to Final).

Position Transition Time: A slider to set how long it takes the camera to reach the framing position, measured as a percentage of the behavior’s duration.

Rotation Transition Time: A slider to set how long it takes the camera to reach the framing orientation, measured as a percentage of the behavior’s duration.

Transition: A pop-up menu to set the speed of the transition. Choices include Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

Ease Out Time: A slider to set the percentage of the behavior’s duration when the ease-out effect starts. The ease out ramps down the behavior’s effect until the end of the behavior.

Ease Out Curve: A slider that sets the rate of the ease-out effect.
The HUD contains a subset of the controls in the Inspector.

**Use Framing behavior onscreen controls**

When you select a Framing behavior in the Layers list, onscreen controls become available in the Canvas, allowing you to create a custom framing size and shape, and to visually adjust the Framing Offset and Offset Path Apex parameters.

**Note:** To use the Framing behavior onscreen controls, you must first assign a layer to the Target image well in the Behaviors Inspector.

---

**Target a point other than the center of the layer**

By default, the Framing behavior targets the center of the layer. You can instruct the camera to frame another area of the target layer using the Framing Offset parameter’s onscreen controls.

1. Click the Camera pop-up menu in the upper-left corner of the Canvas, then choose Perspective.

2. Select a framing behavior in the Layers list or Timeline.

   In the Canvas, a white rectangle with four corner handles appears. This rectangle is the Framing Offset parameter onscreen control.

3. Do one of the following:
• Drag any of the four corner handles to adjust the Z value.

**Note:** Because the onscreen controls may be imprecise, use the value sliders in the Behavior Inspector to limit value changes to the Z axis alone.

• Drag inside the white rectangle to adjust the X or Y values.

---

**Set the location of the camera motion path apex**

If the Framing behavior settings create a curved camera motion path, you can adjust the vertex (the highest point of the curve) using the Offset Path Apex parameter’s onscreen control.

1. Click the Camera pop-up menu in the upper-left corner of the Canvas, then choose Perspective.

2. With the Framing behavior selected, drag the Offset Path Apex (the small white box) along the white line that connects the red curved motion path to reposition the apex.

**Tip:** If you don’t see the small white box, drag over the dolly tool (in the top-left corner of the Canvas) to zoom out a bit.
Offset the camera motion path

You can offset the camera’s motion path that is created by the Framing behavior using the Path Offset parameter’s onscreen controls.

1. Click the Camera pop-up menu in the upper-left corner of the Canvas, then choose Perspective.

2. With the Framing behavior selected, do one of the following:
   - Drag the green arrow to adjust the path along the Y axis.
   - Drag the red arrow to adjust the path along the X axis.
   - Drag the blue arrow to adjust the path along the Z axis.
   - Drag inside the white circle (where the colored circles meet) to adjust the path along all three axes simultaneously.

   **Note:** If the transform controls (colored arrows) appear within the framing onscreen controls in the Canvas, the framing is adjusted rather than the camera motion path. If this occurs, orbit the camera view so that the transform controls are offset from the framing control.
For more information on the 3D transform controls, see Transform layers in 3D space

Sweep
The Sweep behavior pivots the camera across a specified arc.

After you apply this behavior, the Sweep section of the Behaviors Inspector contains the following parameter controls:

- **Start**: A dial to set the camera’s starting angle relative to its current orientation. A nonzero value causes the camera to jump to this value at the start of the behavior.

- **End**: A dial to set the camera’s final angle relative to its Start parameter value.

- **Speed**: A pop-up menu to set the type of interpolation used for the rotation. The value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

- **Axis**: A pop-up menu to set the axis around which the sweep occurs. Value can be set to Tilt X, Swivel Y, or Roll Z.

The HUD contains the same controls as the Inspector.

Zoom In/Out
The Zoom In/Out behavior animates the camera’s Angle of View
After you apply this behavior, the Zoom In/Out section of the Behaviors Inspector contains the following parameter controls:

- **Zoom**: A slider to set a proportional value to modify the camera’s Angle of View parameter. For more information about the Angle of View parameter, see Controls in the Camera Inspector.

- **Speed**: A pop-up menu to set the type of interpolation for the movement. The value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

The HUD contains the same controls as the Inspector.

**Zoom Layer**

The Zoom Layer behavior moves a camera to the position of a target object’s anchor point. When the camera reaches the object’s anchor point, the angle of view changes while offsetting the camera’s position based on the Zoom parameter. (This parameter is set to 0 by default so no animation of the Angle of View occurs.)

This behavior also lets you animate the camera’s Angle of View during the camera’s movement, based on the behavior’s Transition value. For more information about the Angle of View parameter, see Controls in the Camera Inspector.

After you apply this behavior, the Zoom Layer section of the Behaviors Inspector contains the following parameter controls:

- **Object**: An image well to set the target of the camera’s
movement. Drag an object from the Layers list into the well.

- **Transition**: A slider to specify how far into the behavior the camera stops moving and the camera’s Angle of View parameter begins to animate instead.

  If Transition is set to 50% in a Zoom Layer behavior that has a length of 300 frames, the camera move takes 150 frames to arrive at the position of the target object and then stops moving for the duration of the behavior, and the camera’s Angle of View parameter animates over the rest of the duration. If Transition is set to 100%, the camera move takes the full 300 frames to arrive at the position of the target object, and the camera’s angle of view does not animate. If the Zoom Layer behavior’s duration is 100 frames and Transition is set to 50%, the camera move takes 50 frames to arrive at the position of the target object.

- **Speed**: A pop-up menu to set the type of interpolation used for the rotation. The value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

- **Zoom**: A slider to set a proportional value to modify the camera’s Angle of View parameter. A nonzero value determines how much the angle of view (and thus perspective) changes relative to the camera’s initial angle of view. A zero value for Zoom leaves the Angle of View parameter unchanged.

The HUD contains the same controls as the Inspector.

**Lighting**
Lighting overview

You can apply lighting to a motion graphics project to enhance the depth and scope of compositions, and to help create realistic environments for composites. Although light sources are not visible, you can simulate a visible light source by combining a point light with an image or shape, as shown in the example below.

![Simulated visible light source created by combining a light with a shape](image)

**Tip:** Use the Match Move behavior to move a simulated light source with a light in a movie clip. For more information on the Match Move behavior, see [Match move an object](match_move).

Motion’s lighting system works only on 3D groups (and the layers and groups nested within them). When you add lights to a scene, two groups of properties contribute to the appearance of lights:

- **Light properties:** You can adjust the quality of a light itself by selecting a light object in your project, then modifying its parameters in the Light Inspector.

- **Object lighting properties:** You can adjust how an image layer in your project (a still image, movie clip, shape, and so on) receives light cast by light objects by selecting the layer, then
adjusting Lighting parameters in the Properties Inspector.

You can manipulate any of the following light properties: type of light, intensity, and color. A light bulb, the sun, and lighting in a dance club have different appearances. You can use lighting properties to simulate these differences. You can use multiple lights to mix color. If one red and one blue spot light are pointed at a white object, they mix to make magenta. Each type of light has its own attributes. It may take a combination of light types to achieve a specific effect. For example, you might want to combine a dim ambient light with a spot light to add depth or prevent total darkness where the spot light’s effect drops off.

SEE ALSO

Add lights
Light Inspector controls
Lighting controls in the Properties Inspector

Add lights

You can add a lights to your project one at a time, or you can add sets of lights that have been predesigned to create specific lighting styles.

Add a light to a project

1. Click the New Light button in the toolbar, or choose Object > New Light.
If your project contains no existing 3D groups, the following dialog appears:

If your project already contains at least one 3D group, go to step 3.

If you select Keep as 2D, a light will have no effect until you create at least one 3D group at the root level (not nested in a 2D group).

2. Click Switch to 3D.

A light object is added to the Layers list, Canvas (represented there by a wireframe icon), and Timeline; the 3D Transform tool in the toolbar becomes active; and the Light Inspector opens.

3. Make adjustments to the light in the Light Inspector.

Add a preset lighting style

You can add a group of lights all at once by selecting one of Motion’s preset lighting styles.
1. Choose Object > New Light Setup and choose one of the preset lighting styles.

2. If a dialog appears stating that you have no 3D groups in the project, click Switch to 3D.

A new group containing lights is added to the project. The number and types of lights varies depending on the preset style you chose.

3. Make any adjustments to the newly added lights to customize them for your scene.

**Note:** Choosing a new light setup does not remove or replace any lights that are already in the project.

**Tip:** If you’re using 3D text, turn off any lighting effects before adding scene lights to avoid unexpected or conflicting results. See *Adjust 3D text lighting*.

---

### Disable rendering of lighting

Lighting effects can significantly impact playback performance. You can temporarily disable lighting to improve playback speed while working on other aspects of your project.

- Click the Render pop-up menu in the top-right corner of the Canvas, then choose Lighting (or press Option-L).
When you create a light, or select a light object in the Layers list, the Light Inspector opens. In the Light Inspector, you can adjust the following parameters:

- **Light Type:** A pop-up menu to specify any of four light types:
  - **Ambient:** Emits light in all directions, illuminating all objects in the scene from all directions equally. This type of light has no position and no representation in the Canvas. The most common use for ambient lights is to add an overall fill effect or color cast.
  
  **Note:** There’s no global ambience property in Motion, so you may have to add an ambient light to prevent total blackness.

  - **Directional:** Emits parallel rays of light in a specified direction from a source located at an infinite distance. Rotate the directional light icon (a wireframe cylinder with one end removed) in the Canvas to change the direction in which the light is cast. The circle represents the back of the light, and the lines indicate the direction the light is traveling.

- **Point:** Emits light outward from a single point in 3D space
in all directions. Optionally, you can add falloff based on an object’s proximity to the light. This is the default light in Motion, and it produces results similar to that of an incandescent light bulb.

- **Spot**: Emits light from a conical light source and casts an elliptical pattern on objects hit by the light. Using a spot light allows for a high degree of accuracy when you need to limit the area affected by the light.

- **Color**: A standard set of controls to select the color of the light.

- **Intensity**: A slider that acts as a dimmer switch for lighting. If you use a Directional light at 100% intensity pointed straight at
a red object, the object looks red. If you lower the intensity, the object and scene get darker. However, if you increase the intensity above 100% you may begin to overexpose your scene, eventually causing the object to appear white. The Intensity value slider ranges from 0 and 400, but there’s no upper limit for Intensity (use the adjacent value slider to set a value above 400).

**Note:** Multiple lights interacting with an object combine to increase the object’s apparent brightness as they would in the real world. If you have two spot lights overlapping in space and pointing in the same direction with Intensity set to 100%, you see the same result as having a single spot light with its Intensity set to 200%.

- **Falloff Start:** A slider to adjust where the falloff point of a light begins. In the real world, light falls off—or has less of an effect—as the distance from the light source increases. Usually falloff starts at the center of the light object. Setting Falloff Start adds additional control to your lighting. This parameter applies to light types that use a Position parameter (Point and Spot).

In the example below, a light is positioned slightly above the origin of the scene. There are three rings of cards at a distance of 200, 500, and 1000 units from the light. (In this example, a visible light source—the bulb at the center of the rings of cards—is simulated for illustrative purposes.) The light’s Intensity is set to 100% and Falloff is set to 10%. When Falloff Start is set to 0 (left, below), the light begins to fall off by the time it hits the innermost ring. When Falloff Start is set to 200 (right, below), the inner ring is lit at 100% intensity and the outer rings are slightly brighter than before.
When Falloff Start is increased to 500 (left, below), the inner and middle rings are lit at 100% intensity, and the outer ring is brighter than before. Finally, when Falloff Start is set to 1000 (right, below), all rings are lit at 100% intensity.

In the next example, the image on the left contains a light with Intensity set to 100%, while the image on the right has a light Intensity of 500%. In the image on the right, the outer rings are slightly brighter, but the innermost ring is overexposed. If the Falloff Start of the light in the image on the right is increased to 1000, the rings are overexposed.
- **Falloff**: A slider to control the rate of falloff for a point or spot light based on the Falloff Start setting. At low values, light falls off over a long distance from the light source; therefore, the light travels farther in the image. At high values, the falloff occurs more rapidly.

- **Cone Angle**: A dial that becomes available only when Light Type is set to Spot. The Cone Angle is measured from the center of the light outward and can be set to a value between 0 and 90 degrees. The distance of the light from its target affects the result of this parameter. If the light is close, a wider spot cone angle may be needed to light more of the object. If the light is farther away, a lower Cone Angle may be needed to isolate objects.

- **Soft Edge**: A dial that becomes available only when Light Type is set to Spot. Like Cone Angle, this parameter can be set to a value between 0 and 90 degrees. Its starting point begins at the outer edge of the Cone Angle. If set to 0, spot lights have a hard edge. Low values produce a slight softening effect to the boundary of the lit area. Higher values produce a wide, more natural fade. Adding softness expands the area of your light, so you might need to adjust the angle to achieve a specific effect.

Note: Point lights, directional lights, and spot lights also
Note: Point lights, directional lights, and spot lights also contain a set of parameters to control how they cast shadows. For more information on these parameters, see Shadows overview.

The Light HUD contains the Light Type, Color, Intensity, Falloff Start, and Falloff parameters, which are also available in the Inspector. The Light HUD also contains 3D transform controls. For more information, see Transform layers in 3D space.

Lighting controls in the Properties Inspector

Layers and groups have properties that control how they react to lights in a scene. When layer or group is selected, you can adjust these parameters in the Lighting section of the Properties Inspector. Groups have a single Shading parameter. Layers have Shading, Highlights, Shininess, and Diameter parameters.

- **Shading**: A pop-up menu to set how an object responds to lights in the scene. If set to On, the object can be lit. If set to Off, the object ignores scene lights. If set to Inherited (the default), the object uses the Shading value of its parent.
  
  Note: When a layer or group is nested in one or more parent groups, setting its Shading parameter to On overrides any Shading parameter settings applied to the parent groups.

- **Highlights**: A checkbox to control whether lit objects show highlights. This parameter has no effect if Shading is set to Off. Click the disclosure triangle to reveal an additional Shininess parameter.

- **Shininess**: A slider to set how strong an object’s highlights are. For more information, see Shininess overview.
- **Shininess**: A slider to set how strong an object’s highlights appear. Higher values create a glossier appearance. This Shininess parameter is disabled when the Highlights parameter is deselected.

- **Diameter**: A slider that becomes available when Light Type is set to Directional, Point, or Spot. Diameter affects how lights are reflected as highlights in 3D Text objects.

---

# Shadows

## Shadows overview

Motion projects that include point lights or spot lights can create more natural, realistic effects by casting shadows. Shadows are created when an opaque or semi-opaque object (a layer or group) blocks light from hitting another object. To see a shadow in Motion, you need at least three things: A shadow-casting light source, an object to cast a shadow, and another object upon which the shadow is cast. Multiple lights cast multiple shadows that may or may not be visible depending on the relative positions and settings of the objects in the scene.

**Note**: Ambient lights do not cast shadows.

In Motion, you can control whether a light source creates shadows and whether each object in the scene receives shadows or casts shadows (or both). You can even have an invisible object cast a shadow. The strength, sharpness, shape, and position of the shadow depends on the type and positions of the lights and relative position of all three objects.
WARNING: Some changes you make to 3D objects cause shadows to disappear. This occurs when the change causes rasterization of the 3D object—adjusting the opacity of a group or turning on the glow attributes for a text layer, for example. Flattening the 3D group allows it to cast shadows again. For more information about disappearing shadows, see Shadows and rasterization.

Cast shadows versus drop shadows

There are two common types of shadow effects used in motion graphics work: drop shadows and cast shadows. Motion can create both effects, but because they have different purposes and applications, it may be helpful to consider the differences between them.

Cast and drop shadows simulate the effect of light blocked by an opaque object. But a cast shadow is a 3D effect requiring a light source and an object for the shadow to fall upon, whereas a drop shadow is a 2D effect simulating a cast shadow without a light source and therefore is limited to a very small range of settings.

Drop shadows are commonly used to simulate depth and
separate foreground objects from the background in 2D projects. The classic drop shadow effect is used on light-colored titles so the text is legible against dark and light backgrounds. In a drop shadow effect, the imaginary light source does not create any shading effect on the surface of the object, and the shadow’s position is set at a fixed direction. A drop shadow is rendered as a part of the foreground object, so it doesn’t interact with background objects. However, because it is an effect, its appearance can be customized. The softness, opacity, position, and color can be adjusted and animated without having to manipulate a light source.

Cast shadows are true 3D effects, and their appearance is determined by the light source and the other objects in the scene. Multiple cast shadows interact with each other and take their shapes based on the surfaces and positions of the objects upon which they are cast.

This section addresses cast shadow effects. For information on drop shadows, see Add a drop shadow to a layer.

SEE ALSO
Cast a shadow
Shadow controls in the Inspector
About shadows and complex 3D layers
Shadows without lights

Cast a shadow

Shadows are controlled in the Light Inspector. To improve performance, you can temporarily turn off the rendering of
shadows in the Canvas.

## Cast a shadow

- In the Layers list or Canvas, select the light, then select the Shadows activation checkbox in the Light Inspector.

**Note:** To cast a shadow, the light must be offset from the object casting the shadow, and the object casting the shadow needs to be offset from the layer receiving its shadow.

## Disable rendering of shadows

Rendering shadows can significantly impact playback performance. You can temporarily disable shadows to improve playback speed while working on other aspects of your project.

- Click the Render pop-up menu above the Canvas, then choose Shadows (or press Control-Option-S).

## Shadow controls in the Inspector

Shadows are controlled by adjusting settings in two places:

- **Shadows section in the Light Inspector:** Use these parameter controls to set the shadow properties of point lights and spot lights.

- **Shadows section in the Properties Inspector:** Use these...
Shadows section in the Properties Inspector: Use these parameter controls to set the casting and receiving properties of layers.

Note: 2D groups at the root level of the project (not nested in other groups) do not have lighting or shadow controls. To enable shadows on such a group, convert it to 3D or embed it in another 3D group.

Shadows controls in the Light Inspector

- **Shadows:** A checkbox to turn on Shadows controls. (When activated, the checkbox is blue.) The Shadows checkbox lets you set some lights to cast shadows, and others not to cast shadows.

  Selecting this checkbox causes the light to cast shadows on objects in front of it if the objects also have shadow controls enabled. Deselecting it prevents the light from generating shadows, regardless of settings of individual objects.

- **Opacity:** A slider to control the apparent opacity of the shadow.

- **Softness:** A slider to specify how blurry a shadow will appear.

  Note: The appearance of a shadow depends on the
Note: The appearance of a shadow depends on the rendering quality of the object casting it. Because a shadow may be larger than the original object, you may see some jagged edges or aliasing on the shadow. If you see such artifacts, check how your image looks when the project is set to Best quality, rather than Draft or Normal. For more information about Canvas display quality, see Custom Canvas view options.

- **Uniform Softness:** A checkbox to constrain the results of the softness slider to a uniform amount of blur on the shadow regardless of distance between the light, the object casting the shadow, and the object receiving the shadow.

By deselecting the checkbox, you enable nonuniform softness, so that when objects are farther from each other, more blur is applied.

Note: Enabling nonuniform softness can impact playback performance.

![Uniform softness](image1.png)  ![Nonuniform softness](image2.png)

Note: Intersecting objects reveal an unnatural effect of using uniform softness. Because an equal amount of blur is applied to the entire shadow, the blur appears to spill out in front of the intersecting object, creating a strange appearance. This effect can be eliminated in two ways: by deselecting the
Uniform Softness checkbox or by setting the object to not receive shadows (by deselecting the Receive Shadows checkbox in the Properties Inspector).

- **Color**: Standard color controls to set the color of the shadow. Although semitransparent objects cast lighter shadows than opaque objects, you cannot create light transmission effects wherein a semitransparent object projects some of its own color onto another object, as stained glass does. For more information on using the color controls, see Basic color controls.

**Note**: When Shadows are enabled for point lights, spot lights, and directional lights, Motion uses the multiply compositing mode to blend shadows with the objects upon which they’re cast. This means that the result is a darkening effect, regardless of the color of the shadow. If you select a shadow color lighter than the background upon which it is cast, the
shadow may not be visible. So, for example, when Shadows are enabled for a light, it’s not possible to cast a white shadow on a dark surface. To override this effect, you must disable the Shadows parameter for the light. For more details, see Shadows without lights.

Shadows controls in the Properties Inspector

Every layer in a 3D group has Shadows controls in its Properties Inspector. This includes shapes, video clips, particles, and so on. Lights, Cameras, and 2D groups at the root level of the project (not nested in another group) do not have Shadows controls.

- **Cast Shadows:** A checkbox to set whether a layer casts a shadow if it lies between a light source and another layer.

- **Receive Shadows:** A checkbox to control whether other layers cast shadows on the currently selected layer. The following image depicts an object (the white ring) with the Receive Shadow checkbox selected and the Casts Shadow checkbox deselected.
• **Shadows Only:** A checkbox that allows an object to block light and cast a shadow, while the object itself does not appear in the scene.

You can select both Receive Shadows and Shadows Only, which makes the object invisible except for the regions where a shadow is cast upon it.

**About shadows and complex 3D layers**
When using shadows with layers such as particle systems, text objects, or replicators that are set to 3D, shadows are cast from one part of the object onto another part. This is called *self-shadowing*.

Modifying the object in a way that causes rasterization prevents shadows from displaying.

In some cases you may be able to find another way to perform the effect that does not require rasterization. For example, in the following images, rather than modifying the opacity of the particle emitter, which causes rasterization, you can modify the opacity of the particle cells and maintain the shadows.
In the second figure above, rasterization interferes with the depth order of the particle system, and particles appear in front of the letter A. In the third figure, no rasterization occurs, and particles appear in their proper depth order, in front of and behind the letter A. For more information about how rasterization affects shadows, see **Shadows and rasterization**.

**SEE ALSO**

Particles overview
Replicator overview
Basic text overview

### Shadows without lights

Lighting and shadows can each be disabled independently. You can keep shadows visible, even when lighting is disabled, allowing you to keep the original unshaded look of the scene. Turning off lighting also changes the way shadows are rendered.

When shading (the visible effect of lighting) is disabled, shadows behave differently. Rather than being multiplied with the object upon which they are cast, the shadow’s color and opacity are controlled only by the Shadows settings in the Light Inspector.
This allows you to create shadows of any color or opacity, from traditional dark shadows to brightly colored or even white shadows.

You can disable shading globally in the View pulldown menu (choose View > Render Options > Lighting to remove the checkmark from the menu item) or in the Render pop-up menu above the Canvas (choose Lighting to remove the checkmark from the menu item). You can also disable shading for a specific layer by setting the Shading parameter in the Properties Inspector to Off.
With spot lights, enabling Shadows but disabling shading can create a seemingly strange result where the shadow is suddenly cut off because it has exceeded the scope of the light cone. Because the shading effect of the light cone is turned off, the shadow edge looks unnatural.

To correct such an occurrence, increase the Cone Angle in the Light Inspector.

**Reflections**

**Cast a reflection**

In the real world, all objects exhibit some degree of reflectivity based on surface shine, brightness, angle of view, and proximity.
Motion simulates this natural effect, equipping every object with a set of parameters to create and control realistic-looking reflections. When reflections are enabled for a layer, all other layers in the project are reflected but may only be visible from specific angles and distances.

In Motion, reflections are controlled in the Properties Inspector. To improve performance, you can temporarily turn off the rendering of reflections in the Canvas.

**Cast a reflection**

- Select the layer to receive the reflection, then select the Reflection activation checkbox in the Properties Inspector.

  **Note:** To cast reflections, layers must be offset from each other (for example, X rotation or Z position).

**Disable rendering of reflections**

Rendering reflections can significantly impact playback performance. You can temporarily disable reflections to improve
playback speed while working on other aspects of your project.

- Click the Render pop-up menu above the Canvas, then choose Reflections (or press Control-Option-R).

SEE ALSO

Reflection controls
About reflections and groups
Limit recursive reflections

Reflection controls

Reflections are controlled by adjusting settings in the Reflection section and Blending sections of Properties Inspector:
Reflection section controls

- **Reflection**: An activation checkbox that enables reflections based on the settings of the parameters in the object (a layer or group). (When selected, the checkbox is highlighted blue.)

- **Reflectivity**: A slider that controls how shiny the object’s surface appears. 0% indicates no reflectivity, while 100% is perfectly reflective, like a mirror.

- **Blur Amount**: A slider that controls whether real reflections appear in sharp focus or quite blurry, depending on the surface quality of the reflecting object.

- **Falloff**: A checkbox that determines whether the reflection fades with distance from the object, producing a more realistic result.

When the Falloff checkbox is selected, additional controls become available. Click the disclosure triangle beside the Falloff checkbox to reveal these controls:

- **Begin Distance**: A slider that determines the distance (inside the reflection) where the falloff begins. When the slider is set to 0, falloff starts at the reflection plane.

- **End Distance**: A slider that determines the distance where
the falloff ends, beyond which the reflection isn’t visible. Adjusting this slider moves the falloff point closer to the reflection plane, which causes less of the reflected image to appear.

- **Exponent**: A slider that controls how quickly a reflection gets fainter as the reflected object gets farther from the reflective surface.

- **Blend Mode**: A pop-up menu that sets the blend mode used for the reflection. Blend modes other than Add are useful for achieving different looks, even if they aren’t physically intuitive. For more information about blend modes, see [Layer blending overview](#).
Blending section controls

- **Casts Reflection**: The Properties Inspector of every layer or group also contains a Casts Reflection pop-up menu (in the Blending section) that controls whether an object is reflective. There are three options:
  - **Yes**: The object is reflected in nearby reflective objects.
  - **No**: The object is ignored by reflective surfaces.
  - **Reflection Only**: The object becomes invisible, but appears in reflective surfaces around it.
About reflections and groups

In addition to choosing reflection settings for individual layers, you can adjust settings for an entire group. Reflection settings (in the Properties Inspector) for a group override the settings of individual layers in the group. For example, if a layer in a group is not set to receive reflections, turning that setting on for the whole group forces the individual layer to receive them. Turning off the setting for the group allows the layer’s settings to act as expected.

Cast Reflection settings (in the Properties Inspector) work differently. If the group is set to cast reflections, individual objects’ reflections can still be turned off (or set to Reflection Only). However, if the group is set to not cast reflections at all, individual objects never cast a reflection, regardless of their setting.

For more information about the Reflection settings and Cast Reflection settings in the Properties Inspector, see Reflection controls.

Limit recursive reflections

When a reflective object (layer or group) is reflected in another
object, the first object can be seen in the reflection, potentially causing an endless repetition of reflections. Motion limits the number of reflective bounces that can occur in a scene, preserving performance and preventing the viewer from getting lost in infinity. The number of allowed reflections is set per project.

**Limit the number of recursive reflections in a project**

   
   The Properties Inspector for the project opens.

2. In the Reflections section, adjust the Maximum Bounces slider.
Timeline overview

The *Timeline* is where you control all timing aspects of a project. You can set the frames where objects begin and end, align multiple effects so they occur simultaneously, control object duration, and even perform common trim operations to edit the objects as you would in a nonlinear video editing application. The Timeline is located under the toolbar, in the *Timing pane*.

The Timeline consists of three areas:

- **Timeline layers list**: On the left side of the Timing pane, this area displays a hierarchical list of objects (layers, groups, effects objects) in your project, mirroring the contents of the Layers list in the Project pane. As you can in the Layers list, you can add media to your project by dragging it into the Timeline layers list.

- **Timeline track area**: On the right side of the Timing pane, this area displays colored bars (*timebars*) that correspond to the objects in the Timeline layers list; the length of each timebar represents the duration of each object over the course of your project. You can adjust timing and synchronization by edit by moving, trimming, or slipping timebars in the track area.

- **Timeline ruler**: Above the track area, this numbered strip measures the timing of objects in frames. Here, you can drag the playhead to navigate through your project as well as perform various timing tasks.
In addition to the Timeline, the Timing pane contains two related partitions that can be shown or hidden: the Audio Timeline and the Keyframe Editor.

Display of the Timing pane is controlled by three buttons in the lower-right corner of the Motion project window:

- Show Audio Timeline button
- Show Keyframe Editor button
- Show Timeline button

An abbreviated mini-Timeline, located at the bottom of the Canvas, provides controls to perform quick edits such as moving, trimming, and slipping without opening the Timing pane. For more information, see Edit in the mini-Timeline.

Tip: You can show the Timeline on a second display, providing a larger workspace for manipulating the timing of objects. For more
information, see View the Canvas or Timing pane on a second display.

SEE ALSO
Show, hide, or resize the Timing pane
Add objects to the Timeline overview
Manage Timeline layers and tracks overview
Display and modify keyframes in the Timeline
Retime media overview

Show, hide, or resize the Timing pane

Show or hide the Timing pane

Do one of the following:

- Choose Window > Video Timeline (or press Command-7).
- Click the Show/Hide Timeline button in the lower-right corner of the Motion project window.

Note: To collapse the entire Timing pane (Timeline, Audio
Timeline, and Keyframe Editor), make sure that all three buttons in the lower-right corner of the Motion project window are dimmed.

**Resize the Timing pane**

Do one of the following:

- Drag the toolbar up or down.
- Drag the boundary (the gray line) between the File Browser, Library, or Inspector and the Timing pane to the left or right.
- Deselect the “i” button in the lower-left corner of the Motion Project window to widen the Timing pane (and hide the File Browser, Library, and Inspector).

**Add objects to the Timeline**

**Add objects to the Timeline overview**

Just as you can drag objects (media and effects) to the Layers list or Canvas, you can drag objects to the Timeline. There are two ways to do this:

- **Add media to the Timeline layers list.** This method is identical to the workflow for dragging media to the Layers list in Project pane.
• Add media and effects objects to the Timeline track area. With this method, you can control how media is added to the project—inserted, exchanged with existing media, and so on—with a series of drop menu commands.

Additionally, you can set drag-and-drop preferences to customize how and where objects are placed the Timeline.

Add layers to the Timeline layers list
Just as you can add media to the Layers list, you can drag media into the Timeline layers list. When you do so, a layer is added to the Timeline layers list (and also to the Layers list, and Canvas), and a corresponding timebar appears in the track area.

Library effects (behaviors, filters, and so on) can also be dragged into the Timeline layers list. However, because effects objects are applied to media layers (images, video, audio, and so on), they cannot be grouped by themselves.

Note: You can also drag images and clips to the Timeline track area. See Add layers to the Timeline track area.

Add a layer to a group

1. Drag an item from the File Browser, Library, or Media list, then position the pointer over the Timeline layers list.

2. Do any of the following:
   • Add the item as the topmost layer in a group: Position the
Add the item as the topmost layer in a group:

- **Add the item between two existing layers**: Position the pointer over a group, and when a white border appears, release the mouse button.

- **Replace an existing image layer**: Position the pointer over an existing layer, and when the pointer becomes a curved arrow, release the mouse button.

The new layer is added to the Timeline layers list, Layers list and Canvas.

**Note**: If the media item is a clip with multiple audio tracks, a drop menu will appear, allowing you to choose between mixing down the multiple tracks to stereo or importing audio tracks individually. For more information, see [Add audio files](#).

---

### Add a layer to a new group between existing groups

1. Drag an item from the File Browser, Library, or Media list into the Timeline layers list between two existing groups.

2. When the position indicator appears, release the mouse button.

A new group containing the new layer is created between the existing groups.

---

### Create a group above existing groups
1. Drag an item from the File Browser, Library, or Media list into the Timeline layers list, below the lower edge of the bottom layer.

2. Release the mouse button.

A new group is created above the other existing groups in the hierarchy of groups and layers.

SEE ALSO
Import standard media files
Add Library content to a project
Display, sort, and search the Media list

Add layers to the Timeline track area
When you drag a media item from the File Browser, Library, or Media list into the Timeline track area, a drop menu appears with options for how the new layer should be incorporated. Depending on where in the track area you drop the item, the menu displays different options: Composite, Insert, Overwrite, or Exchange.
You can also drag library effects objects (behaviors, filters, and so on) into the Timeline track area. However, because effects objects are applied to media layers (images, video clips, audio clips, and so on), they can’t be added as standalone objects.

**Note:** If you release the mouse button before the drop menu appears, the item is added as a *composite edit*—above the other tracks in the Timeline and on top of other layers in the Canvas.

---

**Add a layer to a new Timeline track**

To add a layer to a new Timeline track without modifying any other layer in your project, use the Composite edit. The Composite edit places the layer in the track above the one you drag to.
1. Drag an item from the File Browser, Library, or Media list into the Timeline track area.

   As you drag, a tooltip appears at the pointer, indicating the current frame number.

2. When you reach the frame where you want the new layer to start, position the pointer over the layer you want as a background, holding down the mouse button until the drop menu appears.

3. Choose Composite from the drop menu.

   The new layer is composited into the project above the layer you dragged to.

---

Insert a layer, splitting an existing layer
To insert a layer into a new Timeline track and split an existing layer at the insertion point, moving it forward in time to make room for the new layer, use the Insert command. For example, if you insert a 100-frame movie into a group containing an existing layer, the new movie is added to the Timeline at the frame where you drop it, pushing the remaining frames of the original movie out 100 frames.

If you insert a new item midway through an existing layer, the existing layer is split into two layers, each on its own track.

1. Drag an item from the File Browser, Library, or Media list over an existing bar in the Timeline track area.

   As you drag, a tooltip appears at the pointer, indicating the current frame number.

2. Drag to the frame where you want the new layer to start,
holding down the mouse button until the drop menu appears.

3. Choose Insert from the drop menu.

The new layer is inserted into the track, breaking the original bar into two, and pushing the frames after the insertion farther out in time.

**Replace an existing layer with a new layer**

To replace an existing layer with a new layer in the Timeline, use the Overwrite command.

If the new layer is shorter than the one currently in the group, the Overwrite option splits the duration of the existing layer and deletes only the frames where the new layer appears.
1. Drag an item from the File Browser, Library, or Media list onto a bar in the Timeline track area.

   As you drag, a tooltip appears, indicating the frame number where you are located.

2. Drag to the frame where you want the new layer to start, holding down the mouse button until the drop menu appears.

3. Choose Overwrite from the drop menu.

   The frames of the new layer replace the frames of the original layer. If the original layer contained more frames than the new one, the old layer is split into two layers and the additional frames remain.

![Image](After Overwrite edit with shorter clip)

**Replace an existing layer with a layer of the same duration**

To replace an existing layer with a layer of the same duration, use the Exchange command. The Exchange command is a variant of the Overwrite option, but instead of dropping the entire duration of the new layer into the project, the duration of the existing layer is
used. For example, if you drag a 30-second clip over a 5-second clip, choosing Exchange swaps the existing 5 seconds with the first 5 seconds of the longer clip. If you exchange a longer clip with a shorter one—for example, swapping a 10-second clip with one that lasts only 5 seconds—the first 5 seconds are replaced, and the final 5 seconds of the original remain.

The exchange edit transfers any filters, behaviors, and keyframes from the original layer onto the new layer.

**Note:** You cannot use the Exchange command with audio files.

1. Drag an item from the File Browser, Library, or Media list onto a bar in the Timeline track area.

   As you drag, a tooltip appears, indicating the frame number where you are located.

2. Drag to the frame where you want the new layer to start, holding down the mouse button until the drop menu appears.

3. Choose Exchange from the drop menu.

   The old layer is replaced by the new layer.

---

**Add multiple layers**

When you drag more than one item to the Timeline, the new layers appear in their own tracks above any existing layers. This is equivalent to performing a composite edit with a single object. A drop menu lets you choose whether the additional layers should be stacked up as a composite, or whether they should appear
one after another (sequentially).

1. Shift-click or Command-click to select multiple items in the File Browser, Library, or Media list, then drag them to the Timeline track area.

2. Drag to the frame where you want the new layers to start, holding down the mouse button until the drop menu appears.
3. Do any of the following:

- **Stack the layers at the same start point:** Choose Composite from the drop menu.

  Multiple layers are added to the project at the same point in time, each new layer on its own track.

- **Stack the layers in sequential order:** Choose Sequential from the drop menu.

  Multiple layers are added into the project, each in its own track, one after another in the Timeline.

If you release the mouse button in the Timeline track area before the drop menu appears, a composite edit is applied by default. Alternatively, you can drop the multiple layers into the Timeline layers list. Doing so results in a composite edit.

---

**SEE ALSO**

Import standard media files
Add Library content to a project
Display, sort, and search the Media list

**Set Timeline drag-and-drop preferences**

You can set preferences that specify where an item is dropped when you add it to the Timeline Layers list: at the start of the project or at the current playhead position. You can also set the delay time before a drop menu appears when you drag a media item to the Timeline track area.
Specify where new objects appear in the Timeline layers list

1. Choose Motion > Preferences (or press Command-Comma).
2. Click the Project icon.
3. In the Still Images & Layers section, click the appropriate button to create layers at “Current frame” or “Start of project.”

Note: The Create Layers At preference applies only when you drag items to the Timeline layers list, the Layers list, or Canvas. Clips dropped on a specific frame in the Timeline track area appear at that exact location.

Set the drop menu delay preference for items added to the Timeline track area

You can modify the time it takes for the drop menu to open when you drag items into the Timeline track area.

1. Choose Motion > Preferences (or press Command-Comma). The Preferences window appears.
2. Click the General.
3. In the Interface section, adjust the Drop Menu Delay slider to set the delay pause for drop menus in Motion.
Manage Timeline layers and tracks

Overview

The Timeline layers list (on the left side of the Timing pane) mirrors the Layers list in the Project pane and displays your project objects (groups, layers, filters, behaviors, masks, and so on) and their stacking order. When you reorder in the Timeline Layers list, the change is immediately reflected in the Layers list in the Project pane. The Timeline layers list contains many of the same controls as the Layers list in the Project pane. For more information, see Layers list controls.

The Timeline track area (on the right side of the Timing pane) displays each object in a project as a colored bar (known as a *timebar*). Different colors represent different types of objects.
The Timeline track area can contain the following timebars and other icons:

- **Group**: A double blue bar. For groups with multiple layers, the lower bar displays three lines and a value indicating the number of objects in the group.

  ![Group Icon](image)
  ```text
  Group
  Un...  3 Objects
  ```

- **Objects (video clips, stills, shapes, text, particles, replicators, cameras, lights)**: A blue bar

  ![Object Icon](image)
  ```text
  Underwater world
  ```

- **Masks**: A gray bar

  ![Mask Icon](image)
  ```text
  Freehand Mask
  ```

- **Behaviors and Filters**: A thin purple bar
Behaviors and Filters: A thin purple bar

- **Keyframes**: Red diamonds beneath the keyframed object. Selected keyframes appear white.

- **Audio**: A green bar displaying the audio waveform. Audio tracks are not displayed by default. For more information on displaying audio tracks see Adjust audio tracks.

---

**Select and organize Timeline layers**

The Timeline layers list, on the left side of the Timing pane, mirrors the Layers list in the Project pane. You can select, reorganize, show, hide, and lock layers in the Timeline layers list the same way you do in the Layers list. Changes made to one list are reflected in the other. For more information, see the following topics:

- Select layers and groups
- Add or remove layers and groups
- Reorganize layers and groups
- Show, hide, solo, or lock objects
- Nest layers and groups
- Layers list controls
Unlink video and audio tracks

Ordinarily, objects that contain both audio and video are linked so they remain in sync. This link is represented by an icon in the Timeline layers list.

![Link icon]

Note: To display the Audio Timeline, click the Show/Hide Audio Timeline button, located in the lower-right corner of the Motion project window.

Objects that are linked are always edited together in the Timeline. Operations such as cut, copy, paste, and split affect both audio and video. However, if you ever want to break that relationship so you can move or edit the audio or video without the other tagging along, you can disable that link and move either object freely. Beware that this might result in your audio and video playing out of sync.

Manipulate audio and video elements

- Layers list controls
- Layers list shortcut menu
1. In the Timeline layers list, click the link icon to the right of the object name for the video or audio element.

A red slash appears over the link icon in all previously linked layers.

![Image showing Timeline layers list with red slash over link icon]

2. Move, trim, or slip the audio bar or video bar.

![Image showing Before and After of audio bar modifications]

The link icon also appears in the Layers list and the Audio list of the Project pane.

**SEE ALSO**

- Edit in the Timeline track area
- Adjust audio tracks

**Customize the Timeline**

You can customize the display of the Timeline layers list and track area to suit your needs.
Show or hide mask, filter, or behavior objects

You can hide effects objects in the Timeline Layers list and track area to simplify your view of layers in your project.

- Click the Show/Hide Masks, Show/Hide Filters, or Show/Hide Behaviors button at the top of the Timeline layers list.

When a button is dimmed, the effects object and its corresponding bar are hidden from view in the Timeline layers list and track area. However, the effect remains active in the Canvas.

Modify the track display

You can display your timebars in the Timeline track area in any of several different ways to suit your preferred working style.

1. Choose Motion > Preferences (or press Command-Comma), then click Appearance.

2. In the Timeline section of the Appearance pane, choose an item from the Timebar Display pop-up menu:
   - Name: Displays the name of the object on the timebar.
   - Name Plus Thumbnail: Displays the name of the object and
a single thumbnail on the timebar.

- **Filmstrip**: Displays frames of the object on the timebar.

Regardless of the Timebar Display setting, timebars for cameras, lights, behaviors, and filters are labeled with names only. When Timebar Display is set to Filmstrip, computer processing time is increased.

---

**Adjust Timeline track height**

You can adjust the height of tracks displayed in the track area. Audio and object tracks can be resized separately. However, some tracks, including filters and behaviors, cannot be resized.

Do one of the following:

- Drag a row separator between two layers in the Timeline layers list up or down to modify the vertical size of the tracks.

- Click the Timeline pop-up menu at the bottom of the Timeline layers list, then choose a new size. Options include Mini, Small, Medium, and Large.
Scroll the track area

You can scroll horizontally in the track area to see portions of your timebars that extend beyond the immediate workspace.

- Drag the scroller under the track area left or right.

Zoom the track area

Do one of the following:

- Drag the handle at either end of the scroller, inward to zoom in, or outward to zoom out.

To zoom from the center of the visible area, hold down the Shift key while you drag a handle.

- Drag the zoom slider left to zoom out or right to zoom in at the position of the playhead.
Press Option–Command–Equal Sign (=) to zoom in.

**Note:** If your whole desktop zooms, open OS X System Preferences, click Accessibility, click Zoom, then deselect the “Use keyboard shortcuts to zoom” checkbox.

Press Option–Command–Minus Sign (−) to zoom out.

**Note:** If your whole desktop zooms, open OS X System Preferences, click Accessibility, click Zoom, then deselect the “Use keyboard shortcuts to zoom” checkbox.

On a Multi-Touch trackpad, pinch open to zoom in and pinch closed to zoom out.

---

**Zoom the track area to fit the entire project or play range**

Do one of the following:

- Click the Zoom Time View button in the upper-right corner of the Timeline.

- With the Timeline active, press Shift-Z or Option-Command-0.
Choose View > Zoom Time View > To Project or View > Zoom Time View > To Play Range.

Edit objects in the Timeline

Edit in the Timeline track area

As you design your project, you arrange layers spatially in the Canvas and temporally in the Timeline. When you select a layer, group, or effects object in the Layers list or Timeline layers list, its timebar is selected in the Timeline track area. Drag a bar forward or backward in time, or trim it to correspond with the timing of other bars.

Motion uses the terms move, trim, slip, and split to describe the different ways of editing timebars:

- **Move:** Changes the location of an object in the Timeline without affecting its content or duration. See Move objects in the Timeline track area.

- **Trim:** Changes the duration of an object in the Timeline without affecting its location or content. See Trim objects in the Timeline track area.

- **Slip:** Changes the content of an object in the Timeline without affecting its location or duration. See Slip video layers in the Timeline track area.

- **Split:** Divides an object into multiple objects that you can manipulate in separate tracks. See Split objects in the Timeline track area.
As you can with objects in the Layers list, you can delete objects in the Timeline, as well as cut, copy, or paste them.

You can also modify all timebars in a group by editing the group timebar.

**Move objects in the Timeline track area**
Move an object when you want it to begin and end at a different point in the Timeline.

**Move an object in the Timeline**
- In the Timeline track area, drag a bar left or right to move it in time.

A tooltip appears, identifying the new In and Out points as you drag the bar. A delta symbol (triangle) indicates the amount of change in frames or timecode.

**Move an object and snap it to neighboring objects**
Do one of the following:

- Click to select the Snapping button in the upper-right corner of the Timeline, then drag a bar in the track area.

- Press Shift as you drag the item in the Timeline.

Vertical lines appear in the track, corresponding to the In and Out points of other timebars. The active bar snaps to these lines as you drag.

---

**Move an object to the playhead position**

You can move a timebar to a new location in its track by using the Move Selected In Point or Move Selected Out Point command. This command shifts the position of the selected object to the current playhead position. You can also use this command to move and align multiple objects in one operation.

1. Select the object to move.

   Shift-click to select multiple objects, if desired.

2. Place the playhead at the point in the Timeline where you want to move the object.

3. Choose Mark > Move Selected In Point (or press Shift-Left Bracket) to align the object’s beginning to the playhead, or choose Mark > Move Selected Out Point (or press Shift-Right Bracket) to align the object’s end to the playhead.
Bracket) to align the end of the object to the playhead position.

## Move an object to a specific frame

1. In the Timeline, select the object (or objects) to move, then type the number of the frame (or timecode) where you want to move the object.

   A value field appears, displaying the number you typed.

2. Press Return.

   The object’s In point moves to the specified frame number. If you selected more than one object, they all move to the specified frame number.

## Move an object a specific number of frames

Do one of the following:

- To move an object forward a specific number of frames,
select the object, type a plus sign (+) followed by the number of the frames you want to move, then press Return.

To move an object backward a specific number of frames, select the object, type a minus sign (–) followed by the number of the frames you want to move, then press Return.

Trim objects in the Timeline track area

Trim an object’s timebar when you want to shorten or lengthen its duration in the Timeline. You can trim the beginning or end of the object by dragging from the left or right edge of the bar (the In and Out points). You can also trim an object by using menu commands and corresponding keyboard shortcuts. You can trim multiple objects simultaneously, and you can trim on the fly while your project is playing back.

Note: Video and audio objects cannot be trimmed to be longer than the duration of their source media. To extend a video or audio object beyond the duration of its source media, you must change the object’s End Condition to Loop, Ping Pong, or Hold in the object’s Properties Inspector. This limitation does not apply to other objects, such as still images, cameras, text, and shapes, all of which you can extend without restriction. You can also change the effective duration of a clip without adding or removing frames, by changing the clip’s playback speed. For more information on the Timing controls, see Retime media overview.
When you trim a video object in the track area, Motion provides a visual representation of how much additional footage is available in the object’s source clip: a dimmed extension on either end of the bar indicating that unused frames exist in the source video clip. If you see no dimmed extensions when you trim a bar, there are no unused frames in the source clip. Consequently, you cannot lengthen the object (unless you change the object’s End Condition in the Properties Inspector for the clip).

Trim an object in the timeline

1. In the Timeline track area, move the pointer to one end of the bar you want to trim.

The pointer changes to a trim pointer.

2. Drag the end of the bar until it reaches the frame where you want the object to start or end.

As you drag, a tooltip indicates the new In or Out point, and the new duration of the object.
Trim an object and snap its In or Out point to neighboring objects

- Press Shift as you drag the edge of a bar in the track area.

  Vertical lines appear in the track, corresponding to the In and Out points of other bars. The active bar snaps to these lines as you drag.

---

Trim one or more objects via the Mark menu

1. Select one or more objects to trim.

2. Place the playhead at the frame where you want the new In or Out point.

3. Choose Mark > Mark In (or press I) or Mark > Mark Out (or press O) to set a new In point or Out point.

   All selected objects are trimmed to the new point.

---

Trim an image or video layer without trimming its applied effects objects
You can trim a layer without affecting the duration of its applied effects objects (masks, filters, and so on).

- Hold down the Command key while you drag the edge of the image or video clip.

The object is trimmed independently of its applied effects objects.

---

**Slip video layers in the Timeline track area**

Slip a video layer when you want to use a different section of your source clip without changing the layer’s duration or where it appears in the Timeline.

**Important:** Slipping is only possible *after* you’ve trimmed a video layer’s timebar.

For example, if you have a shot of a door opening that is three seconds long and you want to trim it by one second, you can use the Slip function to select which one-second section to use: the first second as the door leaves the jamb, the next second where the door swings open, or the last second where it bangs against the wall.
As with trimming, when you slip a video layer in the track area, Motion provides a visual representation of how much additional footage is available in the object’s source clip: a dimmed extension on either end of the bar indicates that unused frames exist in the source video clip. You can only slip a bar as far as the existing unused frames in the source media.

---

**Slip a video layer in the Timeline**

1. With the pointer over the video layer’s timebar, press and hold down the Option key.

   The pointer turns into the slip pointer.

2. Still holding down the Option key, drag the middle part of the bar left or right.

   Dragging to the left replaces the frames with a section from later in the source material; dragging to the right uses frames from earlier in the clip.
Split objects in the Timeline track area

You can divide a single object into multiple objects, each in its own Timeline track. Splitting lets you turn one object into multiple pieces and then manipulate each segment of the object on its own track. For example, you can split an object into multiple tracks over time if you want to apply an effect to the object over a specific, finite segment of time. Or you might split an object into multiple tracks to create the illusion that the object is moving in 3D space, passing in front of other objects. When working in 3D, you can even split camera tracks.

Split an object in the Timeline
1. Select the object to split.

2. Drag the playhead to the frame where you want the split to occur.

3. Choose Edit > Split.

The object is broken into two pieces, each positioned on its own track.

---

Delete objects in the Timeline track area

Motion provides three ways to remove an object from the Timeline track area:

- **Delete**: Removes the object, leaving a gap in the track.
- **Ripple Delete**: Removes the object and closes up the gap left behind.
- **Cut:** Deletes the object, leaving a gap in the Timeline, and copies the object to the Clipboard for later pasting.

---

## Delete an object

1. Select the object to delete.
2. Choose Edit > Delete (or press Delete).

You can also Control-click the object, then choose Delete from the shortcut menu.

---

## Ripple delete an object
1. Select the object to delete.

2. Choose Edit > Ripple Delete (or press Shift-Delete).

---

**Cut an object**

1. Select an object to delete.

2. Choose Edit > Cut (or press Command-X).

You can also Control-click the object, then choose Cut from the shortcut menu.

---

**Copy and paste objects in the Timeline**

As in other applications, in Motion you can copy and paste objects. Copying leaves an object in place and copies it to the Clipboard for later pasting.

When you paste an object, it’s placed at either the position of the playhead or at the beginning of the project (see If it’s your first import). For the purposes of simplicity, the remainder of this section assumes pasted objects are placed at the playhead position.

Objects with applied filters, behaviors, keyframes, and other effects retain those effects when cut, copied, and pasted. You can also copy or cut filter and behavior objects from one media layer and then paste them into another media layer, effectively transferring the effect to a different media item.
In addition to ordinary pasting, Motion lets you paste as an insert, overwrite, or exchange edit. These three commands appear in the Paste Special dialog:

- **Insert into time region**: Pastes the Clipboard contents into the project, pushing existing objects farther down in time.
- **Overwrite into time region**: Pastes the Clipboard contents into the project, deleting any existing objects at the same point in time.
- **Exchange media with existing object**: Replaces the selected object in the project with the Clipboard contents.

**Note**: Paste Special can also be used with selected regions in the Timeline to perform a special type of paste. For more information, see Make changes to a region (range of frames).

---

**Copy an object to the Clipboard**

1. In the Timeline, select an object to copy.
2. Choose Edit > Copy (or press Command-C).

---

**Paste an object into the Timeline**

1. In the Timeline, select a group to paste into.
2. Position the playhead at the desired time position.
The pasted object is placed in a new track at the top of the other layers in the active group. If no group is selected, the object is pasted into the group it was copied from. If it was copied from outside the current project, a new group is created. Pasting multiple objects retains the relative object and layer order of the Clipboard contents.

### Paste an object, pushing other objects farther ahead in the Timeline

1. In the Timeline, select a group to paste into.
2. Position the playhead at the desired time position.
3. Choose Edit > Paste Special (or press Option-Command-V).
   - The Paste Special dialog appears.
4. Select “Insert into time region.”
5. Click OK to confirm your edit.

The object is inserted at the selected position, splitting other objects in the same time region and pushing them to the right in the Timeline.

### Paste an object, deleting other objects in the same time region

1. In the Timeline, select a group to paste into.
2. Position the playhead at the desired time position.

3. Choose Edit > Paste Special (or press Option-Command-V).
   The Paste Special dialog appears.

4. Select “Overwrite into time region.”

5. Click OK to confirm your edit.

The object is pasted at the selected position, overwriting other objects in the same time region.

---

**Paste an object, replacing another object**

1. In the File Browser, select an item, then choose Edit > Copy (or press Command-C).
   
   **Note:** This task works only for items copied from the File Browser.

2. In the Timeline, select an object to replace.

3. Position the playhead at the desired time position.

   The Paste Special dialog appears.

5. Select “Exchange media with existing object.”

6. Click OK to confirm your edit.
The object is pasted at the selected position, replacing the other object.

About group tracks

You can edit in the group track, even if the group is collapsed and its nested objects are not visible in the Timeline track area.

Group tracks contain two colored bars. The narrow, dark-blue upper bar edits all objects in the group as a single unit. It’s labeled with the name of the group ("Group" by default). The lower group bar—taller and a lighter shade of blue—edits individual objects in the group. The lower group bar displays information about the names of individual objects in the group, as well as the number of objects that overlap in composited areas of the Timeline.

Motion lets you move objects in the Timeline via the group track. Depending on where you drag in the group track, you can move all objects, individual objects, or just those objects that overlap in time (composited objects).
Trimming the edges of the upper group bar trims the edges of the objects in the group. If there’s only one object, trimming the upper group bar trims that object. If there’s more than one object lined up with the edge of the group, trimming the group trims all those objects.

You cannot trim overlapping objects via the group track.

You can modify the upper group bar to be longer or shorter than the contents of the group (the lower group bar). For example, you might shorten the upper group bar to hide a section of the objects in it. Objects that extend beyond the ends of the upper group bar are not displayed in the Canvas.
In addition to moving and trimming, you can slip video layers in the group track. Any portion of the lower group bar that contains only one video layer can be slipped in this manner. Areas where more than one layer overlap can be slipped by Control-clicking the group bar and choosing a video layer from the shortcut menu. For more information, see Edit in the group track.

Edit in the group track

There are a variety of editing tasks you can perform directly in the group track. This is equivalent to making similar edits to the various tracks contained within the group, but it’s sometimes more efficient to make such changes in the group track instead.

Move all objects in a group at once

- Drag the upper group bar left or right.
  
  All objects in the group move in time.

Move a single object in a group

1. Click an area of the lower group bar where a single object is visible.
That object is highlighted in the group track.

2. Drag the section left or right to move the object in the group forward or backward in time.

The selected object moves in time.

Move overlapping (composited) objects in a group

- Drag an area of the lower group bar where multiple objects overlap.

The composited objects move in time.

Trim objects in a group

- Drag an end of the upper group bar right or left in the track area.

Objects in the group that share the same In and Out point with the group are trimmed along with the group.

Change the duration of the group
independently of the objects in it

- Holding down the Command key, drag either end of the upper group bar left or right.

  Only the group is trimmed.

**Note:** After you manually change the length of the upper group bar, it's no longer updated when you add or modify the objects to the group. To restore automatic updating, realign the edges of the upper group bar with the edges of the first and last clips in the group.

---

**Slip a video layer via the group track**

- Holding down the Option key, drag an area in the lower group bar where the video layer is located.

  If there are overlapping (composited) layers, before performing this operation Control-click the overlapping region, then choose the desired video layer from the shortcut menu.

**Note:** You can only slip a layer if it has been trimmed first. For more information on slipping, see [Slip video layers in the Timeline track area](#).

Dragging right slips the video clip to an earlier portion of the source media. Dragging left slips the video clip to a later portion of the source media. Either way, the position of the clip in the Timeline and its duration are unchanged.
Navigate in the Timeline

Motion provides many controls for navigating the Timeline. You can drag the playhead to “scrub” through your project as quickly or slowly as you want, or immediately jump to a specific frame. Additionally, you can jump to object boundaries, markers, and other important indicators in the Timeline.

Many navigation tasks are also accessible via the timing display in the toolbar.

Note: The timing display can be set to show frames or timecode. To set the timing display duration to frames, choose Show Frames from the pop-up menu on the right side of the timing display (the downward arrow).

In addition to moving to new positions in time, you can navigate directly to objects in the Timeline, such as objects, markers, and keyframes.

Play back your project

Do one of the following:

- Click the Play button in the transport controls (under the Canvas).
- Press the Space bar.
Move the playhead to a new point in time

Do one of the following:

- Double-click the current frame number in the timing display, enter a new frame number, then press Return.

- Drag left or right over the current frame number in the timing display to rewind or advance.

- Drag the playhead in the Timeline ruler to the frame you want.

- Click the Timeline ruler at the frame number where you want to move the playhead.

- With the Canvas or Project pane active, type a new frame number, then press Return to jump to that frame.

- With the Timeline active (and no objects selected), type a new frame number, then press Return to jump to that frame.

Navigate by frame

To make it easier to find specific frames in your project, you can step through the Timeline frame by frame, rather than skimming it.

Do any of the following:

- To move forward a specific number of frames: Type a plus sign (+), then type the number of frames to move forward.
To move backward a specific number of frames: Type a minus sign (–), then type the number of frames to move backward.

To move forward or backward one frame at a time: Click the “Go to next frame” or “Go to previous frame” button in the transport controls (to the right of the Play button), or press the Left Arrow key to move backward or the Right Arrow key to move forward.

You can also choose Mark > Go to > Previous Frame or Mark > Go to > Next Frame.

To move forward or backward ten frames at a time: Choose Mark > Go to > 10 Frames Back or Mark > Go to > 10 Frames Forward.

---

Move ahead or back in seconds, minutes, or hours

1. Make sure the timing display is set to show timecode.
   If the timing display is showing frames, click the downward arrow, then choose Show Timecode from the pop-up menu.

2. Double-click in the timing display.

3. Do any of the following:
   • Move forward in seconds: Enter a plus sign (+), enter the number of seconds to move forward, then enter a period. For example, to move 2 seconds ahead, enter “+2.” (with a period after the number), then press Return.
- **Move forward in minutes:** Enter a plus sign (+), enter the number of seconds to move forward, then enter two periods after the number. (To move ahead in hours, enter three periods after the number.)

- **Move backward in seconds:** Enter a minus sign (–), enter the number of seconds to move backward, then enter a period. For example, to move 2 seconds backward, enter “–2.” (with a period after the number), then press Return.

- **To move backward in minutes:** Enter a minus sign (–), enter the number of seconds to move backward, then enter two periods after the number. (To move backward in hours, enter three periods after the number.)

---

**Navigate by jumping**

To move the playhead quickly from point to point in the Timeline, do one of the following:

- **To jump to the beginning of the project:** Click the “Go to start of project” button in the transport controls (under the Canvas), or choose Mark > Go to > Project Start, or press Home.

- **To jump to the end of the project:** Click the “Go to end of project” button in the transport controls, or choose Mark > Go to > Project End, or press End.

- **To jump to the next keyframe:** With an animated object selected, choose Mark > Go to > Next Keyframe, or press Shift-K.

- **To jump to the previous keyframe:** With the animated object
Jump to the beginning or end of an object in the Timeline

1. Select the object to navigate to.

2. Do one of the following:
   - Choose Mark > Go to > Selection In Point or Mark > Go to > Selection Out Point.
   - Press Shift-I (for the In point) or Shift-O (for the Out point).

SEE ALSO
Work with markers overview
Display and modify keyframes in the Timeline

Display and modify keyframes in the Timeline

You can move or delete keyframes that are displayed in the Timeline. You can also display the animation curve for a selected keyframe, using the Keyframe Editor.

For more information on the Keyframe Editor, see Keyframing overview.
Display keyframes in the Timeline track area

- In the upper-right corner of the Timeline, click the Show/Hide Keyframes button.

When the Show/Hide Keyframes button is highlighted blue, keyframes appear below the objects in the track area.

Note: Don’t confuse the Show/Hide Keyframes button with the Show/Hide Keyframe Editor button, located in the bottom-right corner of the Motion project window. The former turns the display of keyframes in the Timeline track area on and off; the latter expands and collapses the Keyframe Editor in the Timing pane.

Move a keyframe’s position in time

Moving a keyframe in the Timeline modifies the keyframe’s position in time (but not its value).

- Drag the keyframe to the left or right.
When selected, the keyframe appears white.

**Change a keyframe’s value**

To change a keyframe’s value (as opposed to its position in time), do one of the following:

- Control-click the keyframe, choose the parameter to adjust from the shortcut menu, enter a new value, then press Return.

- Use the Keyframe Editor, which lets you change both the value and interpolation of the keyframe.

**Copy and paste keyframes**

1. In the Timeline, select the object that contains the keyframes you want to copy.

2. In the Timeline track area, select or Shift-select keyframes, then choose Edit > Copy (or press Command-C).

3. In the Timeline track area, select the target object for the copied keyframes, then choose Edit > Paste (or press Command-V).

**Delete a keyframe or group of selected keyframes**

- In the Timeline track area, select the keyframe or keyframes to delete.
delete, then do one of the following:

- Press Delete.
- Control-click a selected keyframe, then choose Delete Keyframes from the shortcut menu.

Delete all keyframes

- In the Timeline track area, Control-click a keyframe, then choose Delete All Keyframes from the shortcut menu.

Display an animation curve in the Keyframe Editor

- Control-click a keyframe on a track, then choose Show in Keyframe Editor from the shortcut menu.

The Keyframe Editor appears underneath the Timeline, showing the animation curve and a new, untitled curve set.

SEE ALSO

Keyframing overview
Display the Keyframe Editor

Work in the ruler
Work in the ruler overview

You can perform several timing tasks in the ruler above the Timeline track area:

- Drag the playhead to a specific frame to view the project at a specific time.

- Drag the In and Out points of your project so playback occurs only within the specified frames. See Define the play range.

- Select a range of frames, so you can delete, cut, or paste into them. See Make changes to a region (range of frames).

- Add or edit project markers, which can be added to your project to identify an important frame or range of frames. See Work with markers overview.

Make changes to a region (range of frames)

You can make changes to a range of frames, known as a region. Selecting a region allows you to make changes to multiple objects in a specific range of time in the Timeline. For example, you can cut or copy a section of time to remove it from your project completely, or just move it to a new position in Timeline. Regions need not align with object edges in the Timeline—you can create a region that begins midway through an object.
Note: Pasting a region does not paste it at the current playhead location. To move a pasted region to the playhead location, press the Shift key while you drag the pasted object. As you approach the current playhead location, the object snaps into place.

You can also paste objects into a defined region using the Paste Special command, which lets you insert, overwrite, or exchange objects in the Timeline. Additionally, you select a region and insert blank frames, creating an empty placeholder for a clip you don’t yet have.

Select a region (a range of frames)

- Holding down the Command and Option keys, drag in the Timeline ruler.

A light highlighted band appears over the selected frames.

Move a region
Position the pointer over the region, then drag to move the region.

**Note:** This operation does not move objects within the region.

**Deselect tracks from a region**

- Command-click a track in a region to deselect the track.
**Paste into a region**

1. Select an object.

2. Press Command-C to copy or Command-X to cut your selection.

3. Holding down the Command and Option keys, drag in the ruler to select a region.


   The Paste Special dialog appears.

5. Select “Insert into time region” or “Overwrite into time region,” then click OK.

   The Clipboard contents are pasted into the region using the method you specified. For more information on the different editing types, see Add layers to the Timeline track area.

---

**Insert time into a project**

1. Holding down the Command and Option keys, drag in the ruler to select a region.

   Drag as wide an area as you want to insert.

2. Choose Edit > Insert Time.

   The number of frames in the region is added to the project, beginning at the end of the selected region, pushing any
existing objects farther forward in time.

If time is inserted in a region that contains a video clip, the clip is split onto two tracks, and objects beyond the split point are placed in a new group.

### Work with markers

#### Work with markers overview

A *marker* is a visual reference point in the Timeline that identifies a specific frame. You can add as many markers as you want in the Timeline ruler while playing the project, or when the playhead is stopped.
Use markers to:

- Add a visual reference to an object at a specific point in time. See Add, move, and delete markers.
- Quickly navigate to specific points in a sequence. See Navigate with markers.
- Align other objects or keyframes to an important point in time.
- Add notes about a specific area in your project. See Edit marker information.
- Customize effects templates for use in Final Cut Pro X. For more information about template markers, see What are template markers?

You can assign different colors to different types or markers and create marker groups.

There are two types of markers: project markers and object markers. Project markers are fixed to a specific frame or timecode value in the ruler. Object markers are attached to an object and move around as you move the object in the Timeline.
Add, move, and delete markers
You can add, delete, or move Timeline markers.

Add a project marker

1. Place the playhead at the frame where you want the marker.

2. Ensure that no objects are selected, then do any of the following:
   - *Add a project marker at the playhead:* Choose Mark > Markers > Add Marker, or press M.
   - *Add a project marker a specific frame:* Shift-click at the desired point in the Timeline ruler, or Control-click at the desired point in the Timeline ruler, then choose Add Marker from the shortcut menu.

   A green marker is added to the Timeline ruler.

**Note:** You can also press Shift-M to add a project marker at the playhead position, even if an object is selected.

Add an object marker

1. Place the playhead at the frame where you want the marker.

2. Select the object to add the marker to, then do one of the following:
   - Choose Mark > Markers > Add Marker.
   - Press M.
Press M.

A red marker is added to the bar for the selected object.

In this way, you can add object markers at specific frames while you play back your project.

### Move a marker

- Drag the marker left or right to a new location.

### Delete a marker

Do one of the following:

- Drag the marker vertically out of the area where it resides, then release the mouse button.
  
  The marker disappears with a “poof” animation.

- Double-click the marker, then click Delete Marker in the Edit Marker dialog.

- For project markers, position the playhead over the marker, then choose Mark > Markers > Delete Marker.

- For object markers, position the playhead over the marker, select the group or object, then choose Mark > Markers > Delete Marker.

- Control-click the marker, then choose Delete Marker from the shortcut menu.
Delete all project markers

In addition to deleting a single marker, you can delete all markers from your project in one step.

1. Make sure no objects are selected in your project (choose Edit > Deselect All (or press Shift-Command-A)).

2. Choose Mark > Markers > Delete All Markers.

Delete all markers in a specific object

Do one of the following:

- Select the object containing the markers you want to delete, then choose Mark > Markers > Delete All Markers.

Edit marker information

You can edit the information for a marker, including its name, starting frame, duration, and color. You can also add comments to the marker. Comments appear in a tooltip when the pointer is placed over the marker.
1. Open the Edit Marker dialog by doing one of the following:
   - Double-click a marker.
   - Control-click a Marker, then choose Edit Marker from the shortcut menu.
   - Move the playhead to a marker, then choose Mark > Markers > Edit Marker (or press Option-Command-M).

![Edit Marker dialog](image)

2. Enter a name in the Name field.

   Text added to the Name and Comment fields for project markers appears in a small window when you place the pointer over the marker.

![Marker with text](image)

3. Enter text in the Comment field.
This comment appears as a tooltip when you place the pointer over project markers.

4. Enter a Start value or drag in the Start field.

   The marker moves to the frame number you enter (or timecode number, if the timing display is set to show timecode).

5. Enter a Duration value or drag in the Duration field to specify the range of frames (or timecode) for the marker.

6. Click a Color button to set the marker color.

7. Click OK to accept your changes.

---

Navigate with markers

You can jump from your current playhead position to a nearby project marker forward or backward.

---

Jump to the next marker

- Control-click the Timeline ruler, then choose Next Marker from the shortcut menu.

  The playhead jumps to the starting position of the next project marker.

Alternatively, you can choose Mark > Go To > Next Marker or
Jump to the previous marker

- Control-click the Timeline ruler, then choose Previous Marker from the shortcut menu.

  The playhead jumps to the starting position of the previous project marker.

Alternatively, you can choose Mark > Go To > Previous Marker or press Option–Command–Left Arrow.

Jump to the next or previous marker using the Edit Marker dialog

You can also navigate to adjacent markers via the Edit Marker dialog.

- Double-click a marker, then use the arrow buttons in the Edit Marker dialog.

The dialog remains open and the contents are replaced with the information for the next marker.
Edit in the mini-Timeline

The mini-Timeline lies just above the transport controls and below the Canvas, providing an at-a-glance look at where selected objects fit into your overall project.

The mini-Timeline also has a playhead to indicate which frame you are viewing as well as In point and Out point markers to identify the play range. The length of the mini-Timeline represents the duration of the entire project.

You can drag the playhead through the mini-Timeline to scrub your project, or to jump to a specific point in time. In the mini-
Timeline, you can also change the play range of the entire project as well as move, trim, or slip a selected object.

You can also perform many nonlinear editing functions in the mini-Timeline. You can drag clips or images from the File Browser, or objects from the Library (such as replicators or shapes), to the mini-Timeline. You can also move, trim, and slip objects to change which portion of the object appears at which point in time. For more information on editing functions such as Move, Trim, and Slip, see Edit in the Timeline track area.

Add an object to the mini-Timeline

1. Drag an item from the File Browser to the mini-Timeline.
   
   As you drag, a tooltip appears to indicate the frame where the item will be placed.

2. When you reach the desired frame, release the mouse button.
   
   The object is added to the project beginning at that frame.

Add multiple objects to the mini-Timeline

You can add multiple objects to the mini-Timeline at once. You can choose to add the objects sequentially (one after another) or as a composite (all at the same point in time).

1. Shift-click to select multiple items in the File Browser, then drag them onto the mini-Timeline.
As you drag, a tooltip appears to indicate the frame where the items will be placed.

2. Continuing to hold down the mouse button, drag to the desired frame.

A drop menu appears.

3. Choose an edit type from the drop menu, then release the mouse button.

Depending on the item dragged to the Timeline, up to four drop options are available. For more information on the Timeline drop menu, see Add layers to the Timeline track area.

Move an object in time

1. In the Layers list, Timeline layers list, or Canvas, select the object you want to move.

The object appears in the mini-Timeline.

2. In the mini-Timeline, drag the object left or right to reposition it in time.

A tooltip appears, indicating the new In and Out point of the object, as well as the amount of change from the previous
3. When you reach the position you want, release the mouse button.

**Shorten or lengthen (trim) an object**

1. Select the object to display it in the mini-Timeline.

2. Position the pointer over the beginning or ending edge of the blue bar in the mini-Timeline.

   The pointer changes to a trim pointer.

3. Drag the edge of the bar to change its duration.

   A tooltip appears, indicating the new In or Out point and the amount of change that your edit is causing.

You cannot trim a layer to be longer than the amount of frames available in the corresponding media file unless its End Condition is set to Hold, Loop, or Ping Pong in the **Timing controls in the Properties Inspector**.

**Slip a video clip (or other multiframe object)**
1. Select the multiframe object you want to modify.

2. Position the pointer over the body of the clip in the mini-Timeline and hold down the Option key.

   The pointer changes to a slip pointer.

3. Continuing to hold down the Option key, drag left or right in the mini-Timeline to use a later or earlier part of the clip.

   A tooltip appears, indicating the new In and Out points.

Note: You cannot slip a clip if it has not been trimmed first. For more information, see Slip video layers in the Timeline track area.

Snap the playhead to a project marker in the mini-Timeline

- Press Shift and drag the playhead in the mini-Timeline.

   The playhead snaps to the frame that contains a project marker.
Retime media

Retime media overview
Your motion graphics projects may require you to perform special timing tricks on media: speeding up a clip, slowing it down, or playing it back at different speeds. There are several ways to apply retiming to a clip:

• Manipulate clip timing in the Timeline with the help of modifier keys. Indicators in the Timeline help you visualize loops and other retiming conditions. For more information, see Retime in the Timeline.

• Adjust the Timing controls in the Properties Inspector to modify speed and playback attributes of media clips. For more information, see Timing controls in the Properties Inspector.

• Apply a Retiming behavior designed for commonly applied retiming tasks, including hold frames, strobing, looping, and so on. Take some time to look over the Retiming behaviors in the Library before spending a lot of time in the Inspector creating your own custom retiming from scratch. For more information, see Retiming behaviors overview.

Retime in the Timeline
You can modify the duration and playback speed of video tracks in the Timeline using the retime pointer or loop pointer.

Speed and duration are interdependent; that is, if you increase a
clip’s playback speed, its duration decreases, and vice versa. For example, a 60-frame video clip played back at 30 frames per second takes two seconds to display its 60 frames. If its In point is frame 1, its Out point is frame 60. Playing back the same clip at 15 frames per second would take twice as long; the clip’s In point remains the same, but its Out point becomes 120.

---

**Shorten the video clip’s duration and speed up its playback speed**

1. With the pointer positioned over the end of a video clip (the Out point), press and hold down the Option key.

   The pointer turns into the retime pointer.

2. Drag the Out point of the clip’s bar to the left.

   As you drag, the tooltip displays the clip’s speed and duration.

**Note:** The retime pointer is available only when the Time Remap pop-up menu is set to Constant Speed in the Timing controls in the Properties Inspector. When Time Remap is set to Variable Speed, the retime pointer has no effect. You cannot retime images, effects, and other nonvideo objects.
Lengthen a video object’s duration and slow down its playback speed

1. With the pointer positioned over the end of a video clip (the Out point), press and hold down the Option key. The pointer turns into the retime pointer.

2. Drag the Out point of the clip’s bar to the right. As you drag, the tooltip displays the clip’s speed and duration.

Loop a clip

Another way to extend a video clip’s duration is to loop it. When a looped clip reaches its last frame, it starts playing again from its first frame. You can easily loop a clip by adjusting it in the Timeline.

1. With the pointer positioned over the end of a video clip (the Out point), press and hold down the Option and Shift keys. The pointer turns into the loop pointer.

2. Continuing to hold down the Option and Shift keys, drag the Out point of the bar to the right.
As you drag, the tooltip displays the clip’s Out point, total Duration, and Loop Duration.

A looped object displays barriers to indicate where loops begin and end in the Timeline.

**Change the loop point of a clip**

Moving the first loop barrier in a layer’s bar changes the point where the clip loops.

- Drag the first loop barrier left or right.

  The end point of the clip’s loop moves as you drag.

**Timing controls in the Properties Inspector**

Media layers (movie clips and still images) have timing parameters in the Properties Inspector. Click Show on the right side of the Timing category to reveal the timing controls for a selected object. When multiple objects of the same type are selected, parameters with common values are editable. When different types of objects
are selected, such as a clip and text, the Timing controls are not available.

**Note:** Still images and other layers without an inherent time dimension have a reduced set of Timing controls (In point, Out point, and Duration).

The Properties Inspector contains the following timing controls:

- **Time Remap:** A pop-up menu that sets how time is remapped in the clip. There are two menu choices:
  - **Constant Speed:** Retimes the entire clip using the same value.
  - **Variable Speed:** Animates the speed of the clip over time.

- **Speed:** A value slider that sets the speed of the clip as a percentage. The default is 100%. Values lower than 100 play back the clip more slowly than its original speed and also extend the duration of the clip. Values higher than 100 play back the clip faster than its original speed and shorten the duration of the clip.

  This parameter appears only when Time Remap is set to Constant Speed.

- **Retime Value:** A value slider used to adjust the time value of the clip at a given frame. When you set Time Remap to Variable Speed, two keyframes are generated at the first and last frame of the clip. The two default keyframes represent 100% constant speed. Adding keyframes to this parameter and assigning them different Retime Values makes the speed of the clip ramp from one speed to another.

  This parameter appears only when Time Remap is set to
Variable Speed.

- **In**: A value slider that sets the In point of the layer, in both constant and variable speed modes. Adjusting this parameter moves the layer In point to the specified frame without affecting the duration of the layer.

- **Out**: A value slider that sets the Out point of the layer, in both constant and variable speed modes. Adjusting this parameter moves the layer Out point to the specified frame without affecting the duration of the layer.

- **Duration**: A value slider that sets the total duration of the layer. If Time Remap is set to Constant Speed, adjusting Duration will also affect the Speed and the Out point. If Time Remap is set to Variable Speed, adjusting Duration does not affect variable speed playback.

- **Reverse**: A checkbox that controls whether the clip is played back in reverse.

- **Frame Blending**: A pop-up menu that sets the method used to determine how the image is blended during each frame of playback. The Frame Blending pop-up menu contains the following items:
  - **None**: Displays the frame from the original clip nearest the source frame.
  - **Blending**: The default setting. Displays a blend of the individual pixels of adjacent frames.
  - **Motion-Blur Blending**: Applies a motion blur algorithm to the blended frames.
  - **Optical Flow**: Uses an optical flow algorithm to blend the two frames surrounding the desired frame. Using this
method affects playback performance most significantly. To display frames properly, Motion analyzes the clip to determine the directional movement of pixels. Only the portion of the clip used in the project (the clip between the In and Out points) is analyzed. When you choose Optical Flow, an analysis indicator appears in the lower-left corner of the Canvas.

If you play back the project before the analysis is complete, the clip will appear as if Frame Blending is set to None. When the analysis is complete, the indicator disappears, and the clip will play back properly. You can perform optical flow analysis on multiple clips simultaneously. The clips are processed in the order—the first clip you apply optical flow to is processed first, and so on.

Note: The more motion contained in a clip, the longer the analysis takes.

For information on pausing, reordering, or stopping a clip analysis, see Manage retiming analysis.

Important: When importing interlaced footage and using the Optical Flow method for frame blending, be sure the Field Order parameter (in the Media Inspector) is assigned to the correct value. Otherwise, artifacts may appear in the retimed layer.
End Condition: A pop-up menu to set how playback continues when the end of the clip is reached. There are four options:

- **None**: The default setting. The layer’s duration in your project is equal to the duration of its source media file.

- **Loop**: When the last frame of the clip is reached, the clip loops back to the first frame and plays again. This can cause a jump in the clip’s apparent playback unless the clip was designed to loop seamlessly.

- **Ping-Pong**: When the last frame of the clip is reached, the next iteration of clip playback is reversed. If you set a clip of a ball rolling on the floor to loop with the Ping-Pong option, it would appear to roll forward, then backward, then forward again for the duration of the layer. The Ping-Pong option lets you extend the duration of some video clips more smoothly than the Loop option.

- **Hold**: This option freezes the last frame of the clip for the amount set in the End Duration slider.

**Note**: When using the Hold option with interlaced footage, ensure that field order is properly set in the Media Inspector. To modify a clip’s field order, select the clip in the Media list, then choose an option from the Field Order pop-up menu in the Media Inspector.

- **End Duration**: A slider to set the number of frames by which the clip is extended at the end of its duration. This value can be adjusted only if End Condition is set to a value other than None.
You can display processing information and modify analysis when retiming a clip.

Display more information about ongoing clip analysis

Do one of the following:

- Choose Window > Show Task List (or press F9).
- Click the analysis indicator (in the lower-left corner of the Canvas, beside the Play/Mute audio button).

The Background Task List window appears.

The Background Task List shows all processes Motion is working on in the background. Each task is labeled, has a progress bar, and displays text describing how far along the task is. You can interrupt current and pending operations by
pressing the pause button next to the progress bar.

### Pause clip analysis

- In the Background Task List window, click the Pause button.

A message appears detailing how many frames have been processed.

**Note:** When analysis is paused, projects play back at a much improved speed.

### Restart clip analysis

- In the Background Task List window, click the Restart button.

![Background Task List](image)

**Click to restart analysis.**

### Reorder clip analysis

- In the Background Task List window, drag the clip to analyze to the top of the list.
Analysis begins on the repositioned clip, and the clip previously being processed is paused.

Close the Background Task List window when analysis is complete

- In the Background Task List dialog, select the “Close when tasks are complete” checkbox.
Behaviors overview

*Behaviors* are animation and simulation effects that you can apply to image layers, cameras, and lights to build sophisticated motion effects without keyframes. Some behaviors even adjust individual parameters of objects in your project, allowing you to customize animated effects with extreme precision.

Behaviors are designed to be flexible and can be combined with one another to create all kinds of effects.

There are 11 kinds of behaviors in Motion:

- **Audio behaviors**: Create simple audio effects, such as fade-ins and fade-outs, pans, and fly-bys. See [Audio behaviors overview](#).

- **Basic Motion behaviors**: Create common animation effects such as rotation, scaling, motion paths, fade-ins, fade-outs, and more. See [Basic Motion behaviors overview](#).

- **Camera behaviors**: Animate points of view by creating basic camera moves such as dollies, pans, and zooms. See [Add Camera behaviors](#).

- **Motion Tracking behaviors**: Analyze the motion present in video clips to stabilize camera shake or pin moving objects to one another (*match move*). See [Motion tracking overview](#).

- **Parameter behaviors**: Animate a specific parameter of any...
Parameter behaviors: Animate a specific parameter of any object, including filters, behaviors, cameras, and lights. For example, you can apply the Oscillate behavior to text opacity to make letters fade in and out. See Parameter behaviors overview.

- **Particles behaviors**: Animate individual particles in a particle system. See Apply behaviors to particle systems.

- **Replicator behaviors**: Animate replicator patterns to build stunning kaleidoscopic effects. See Apply the Sequence Replicator behavior.

- **Retiming behaviors**: Change the playback speed of footage to create slow-motion and fast-motion effects, freeze frames, reverse playback, or strobe and stutter frames. See Retiming behaviors overview.

- **Shape behaviors**: Animate the vertices of shapes or masks to create morphing polygons and other effects. See Shape behaviors overview.

- **Simulation behaviors**: Apply real-world simulation animations, such as gravity, orbital attraction, repelling force, and edge collision to create sophisticated interactions among multiple objects in your project. See Simulation behaviors overview.

- **Text behaviors**: Set your text in motion to create advanced titling effects. See Animated text overview and Apply the Sequence Text behavior.

For an introduction to using and applying behaviors, see Apply behaviors overview. For information about adjusting applied behaviors, see Adjust behaviors overview.

Note: Audio, Camera, Motion Tracking, Particles, Replicator,
Shape, and Text behaviors are discussed in their respective chapters.

**Behaviors versus keyframes**

When you apply a behavior to an object (or to a specific object parameter) in your project, no keyframes are added. Rather, behaviors automatically generate a range of values that are then applied to an object’s parameters, creating animation over the duration of the behavior. Changing the parameters of a behavior alters the animation.

Traditional keyframes, on the other hand, apply specific values to a parameter. When you apply two or more keyframes with different values to a parameter, you animate that parameter from the first keyframed value to the last.

By design, behaviors are most useful for creating generalized, ongoing motion effects. They’re also extremely useful for creating animated effects that might be too complex or time-consuming to keyframe manually. Keyframing, in turn, might be more useful for creating specific animated effects where the parameter you’re adjusting is required to hit a specific value at a specific time. For more information about using keyframes in Motion, see [Keyframing overview](#).

The animation created by behaviors can be converted into keyframes. See [Convert behaviors to keyframes](#).

**Browse and apply behaviors**
Browse for behaviors

All available behaviors appear in the Library and in the Add Behavior pop-up menu in the toolbar.

Select the Behaviors category in the left pane of the Library to reveal the behavior subcategories in the right pane. Selecting a subcategory reveals all behaviors of that type in the Library stack (below the category and subcategory panes).
When you select a behavior in the Library stack, a short description and preview of the behavior appear in the preview area.

The animated previews help you understand how each behavior works. Although most previews are self-explanatory, the Parameter category previews show before/after examples of the behavior’s effect on an animated object, with the gear graphic turning red to show the object after the behavior takes effect. For Simulation behaviors, the red gear graphic identifies the object to which the selected behavior is applied.

You can apply behaviors from the Library or from the Add Behavior pop-up menu in the toolbar. See Apply behaviors overview.

Apply behaviors

Apply behaviors overview

Most behaviors are applied to objects in the Canvas, Layers list, or Timeline. However, the Parameter category of behaviors are
applied in the Inspector to a specific parameter you want to animate.

**Important:** Text, Particles, Replicator, Audio, Shape, and Camera behaviors should only be applied to their namesake objects.

When you apply a behavior to an object, the object parameters affected by that behavior are animated based on the behavior’s default settings. For example, if you apply the Gravity behavior to an object in the Canvas, that object’s position is animated and it moves down, according to the Gravity behavior’s default setting. In most cases, a behavior’s duration is the Timeline duration of the object to which it is applied (the length of the bar in the Timeline track area). For example, if you apply a Spin behavior to an object that begins at frame 20 and ends at frame 300, the Spin behavior’s duration is also frame 20 to frame 300.

Not all behaviors automatically apply motion to an object. Some behaviors, such as Throw, require you to set the throw velocity before the object is “thrown.” Other behaviors, such as Orbit Around, require a source object to act as the central object for other objects to move around.

In addition to applying behaviors to objects, you can apply behaviors to groups in the Layers list or Timeline. Depending on the applied behavior, all objects nested in that group are affected in one of two ways: as if they were a single object or as individual elements.

**SEE ALSO**

Add, remove, and disable standard behaviors
Add, remove, and disable standard behaviors

Applying a behavior to an object instantly animates specific parameters of that object. Because behaviors don’t add keyframes, removing a behavior instantly eliminates the animated effect. All types of behaviors are removed in the same way.

Apply a behavior to an object

Do one of the following:

- Drag a behavior from the Library stack to an appropriate object in the Canvas, Layers list, or Timeline.

  An advantage to applying behaviors from the Library is the ability to preview the animation created by the behavior in the Library preview area.

  **Note:** When applying a behavior to a camera or light, it’s usually easier to drag the behavior to a camera or light in the Layers list or Timeline than to its wireframe object in the Canvas.

- Select an object in the Canvas, Layers list, or Timeline, then select a behavior from the Library stack and click Apply in the preview area.
Select an object in the Canvas, Layers list, or Timeline, click the Add Behavior pop-up menu in the toolbar, then choose a behavior from the menu.

Apply a behavior to multiple objects

1. Select all objects to apply the behavior to.

   In the Layers list, Canvas, or Timeline, Shift-click to select a contiguous set of objects, or Command-click to select noncontiguous objects.

2. Do one of the following:

   - In the toolbar, click the Add Behavior pop-up menu, then choose a behavior.
   - Select a behavior in the Library stack, then click Apply in the preview area.

Remove a behavior from an object
1. Select a behavior in the Layers list, Timeline, Behaviors Inspector, or pop-up menu in the title bar of the HUD.

2. Do one of the following:
   - Choose Edit > Delete.
   - Press Delete.

   **Note:** You can also Control-click a behavior in the Layers list or Timeline, then choose Delete from the shortcut menu.

**SEE ALSO**

Where applied behaviors appear

When you apply a behavior to a layer or group, it appears nested underneath that layer or group in the Layers list and in the Timeline.
A behavior icon (a gear) also appears to the right of the object (layer or group) name in the Layers list and Timeline. Clicking this icon enables and disables all behaviors applied to that object. The actual parameters that let you adjust the attributes of a behavior appear in the Behaviors Inspector.

New behaviors you apply to an object appear above behaviors applied previously.

When you apply a behavior to an object (or parameter) in your project, a behavior icon (a gear) appears in the row of the affected parameter in the Properties, Behaviors, or Filters Inspector. This icon shows you that a behavior is influencing that parameter. When you apply a behavior to a parameter that has been animated with keyframes, a behavior icon (a gear) appears within a keyframe (diamond) icon.

Animation paths

When some behaviors are applied to an object, an animation path appears in the Canvas displaying the projected path of the object over time. Consider this path a “preview” of the animation created by the behavior. Unlike animation paths created using keyframes or the path created by the Motion Path behavior, animation paths
for behaviors cannot be edited. To show or hide all types of paths, click the View pop-up menu above the Canvas, then choose Animation Path (when the checkmark beside the menu command disappears, animation paths are hidden in the Canvas).

Behavior effects in the keyframe editor

If you open the Keyframe Editor and look at a parameter affected by a behavior, you see a noneditable curve that represents the behavior’s effect on that parameter. The noneditable curve (in this example, opacity channel animation that corresponds to the Fade In/Fade Out behavior) appears in addition to that parameter’s editable curve, which can be used in combination to keyframe that parameter. For more information about the Keyframe Editor, see Display the Keyframe Editor.

Note: Use the pop-up menu above the Keyframe Editor to select which parameters are displayed and to create curve sets. For more information on curve sets, see Create a custom curve view.
Add, remove, and disable a Parameter behavior

A standard behavior is applied to an object and typically affects multiple parameters of that object. However, the special class of behavior known as the *Parameter behavior* is applied to a specific parameter of your choosing. In this way, you can modify a single parameter belonging to a filter, particle system, shape, text, or any other object in your project. You can even apply a Parameter behavior to a parameter of another behavior.

A Parameter behavior’s effect on an object depends on the parameter to which it is applied. For example, if you apply the Randomize parameter behavior to a particle emitter’s Position parameter, the emitter drifts randomly around the screen when the project plays. Applying the Randomize parameter behavior to a shape’s Scale parameter makes the shape randomly grow and shrink.

**Important:** Although you can apply a Parameter behavior to an object, the applied behavior does not affect the object until you select a specific parameter to apply the Parameter behavior to. A more direct way to apply a Parameter behavior is by using the shortcut menu in the Inspector.

### Apply a Parameter behavior to a specific parameter of an object

1. Select the object to apply the Parameter behavior to.
2. Do one of the following:

- Control-click a parameter’s name in the Inspector, choose Add Parameter Behavior, then choose an item from the submenu.

- Click the parameter’s Animation menu (the downward arrow that appears when you move the pointer over the right side of a parameter row), choose Add Parameter Behavior, then choose an item from the submenu.
Control-click a parameter in the HUD, choose Add Parameter Behavior from the shortcut menu, then choose an item from the submenu.

Control-click a parameter in the Keyframe Editor parameter list, then choose a Parameter behavior from the shortcut menu.

Use the pop-up menu above the Keyframe Editor to choose the parameters you want displayed in the Keyframe Editor. For more information, see Choose a curve view.

When you apply a Parameter behavior, the Behaviors Inspector opens.

Apply a Parameter behavior to an object
1. Do one of the following:

- Drag a Parameter behavior from the Library stack to an appropriate object in the Canvas, Layers list, or Timeline.

  **Note:** When applying a behavior to a camera or light, it’s usually easier to drag the behavior to a camera or light in the Layers list or Timeline than to the wireframe object in the Canvas.

- Select an object in the Canvas, Layers list, or Timeline, click the Add Behavior pop-up menu in the toolbar, then choose an item from the Parameter submenu.

The behavior is applied to the object, but no parameter is assigned to the behavior.

2. To assign a specific parameter to the Parameter behavior, do one of the following:

- Select the Parameter behavior in the Layers list, click the Apply To pop-up menu in the HUD, then choose a parameter from the submenu.

- Select the Parameter behavior in the Layers list, click the Apply To pop-up menu in the Behaviors Inspector, then choose a Parameter behavior from the submenu.

  The parameter you chose appears in the Apply To text field.

---

**Apply a Parameter behavior to a parameter of another behavior**
Parameter behaviors can be applied to the parameters of other behaviors. For example, you can apply the Oscillate parameter behavior to the Drag parameter of the Orbit Around behavior. As a result, the orbital drag fluctuates, causing the object to fall toward the center of its orbit.

1. Select a behavior that you’ve already applied to an object.

2. Do one of the following:
   - Control-click a parameter’s name in the Inspector, choose Add Parameter Behavior, then choose an item from the submenu.
Click the parameter’s Animation menu in the Inspector (the downward arrow that appears when you move the pointer over the right side of a parameter row), choose Add Parameter Behavior from the shortcut menu, then choose an item from the submenu.
Control-click a parameter in the HUD, choose Add Parameter Behavior from the shortcut menu, then choose an item from the submenu.

Control-click a parameter in the Keyframe Editor parameter list, then choose a Parameter behavior from the shortcut menu.

Use the pop-up menu above the Keyframe Editor to choose the parameters you want displayed in the Keyframe Editor. For more information, see Choose a curve view.

Remove a Parameter behavior

1. Select a Parameter behavior in the Layers list, Timeline, Behaviors Inspector, or pop-up menu in the title bar of the HUD.

2. Do one of the following:
Choose Edit > Delete.

Press Delete.

**Note:** You can also Control-click the behavior in the Layers list or Timeline, then choose Delete from the shortcut menu.

**Note:** If you save a Parameter behavior as a favorite, the parameter assignment is saved with the rest of that behavior’s settings. As a result, the saved behavior will affect the same parameters of any object it’s applied to.

**SEE ALSO**

Reassign a Parameter behavior to another parameter
Where applied Parameter behaviors appear

Reassign a Parameter behavior to another parameter

After you apply a Parameter behavior, it remains assigned to that parameter unless you reassign it via the Apply To pop-up menu.

The Apply To pop-up menu displays all parameters available for the object to which the behavior is applied. If an object has other behaviors or filters applied to it, those parameters also appear in submenus of the Apply To pop-up menu.

1. In the Layers list, Timeline, or Behaviors Inspector, select the
Parameter behavior to reassign.

2. In the Behaviors Inspector or HUD, choose a new parameter from the Apply To pop-up menu.

The Parameter behavior is applied to the newly chosen parameter and the Apply To field is updated to reflect the new assignment. In the Inspector, a behavior icon (a gear) appears next to the new parameter.

Where applied Parameter behaviors appear

Like other behaviors, Parameter behaviors appear nested underneath the objects they’re applied to in the Layers list and Timeline, along with any other behaviors applied to that object.

**Note:** Although Parameter behaviors appear nested under objects in the Layers list, each Parameter behavior is applied to a *single parameter* of an object, and not to the object itself.

Whereas standard behaviors display a simple gear icon in the Layers list, Parameter behavior icons contain a funnel-shaped image at the center of the gear. The funnel represents the “channeling” of individual parameters.
The same icon appears in the Timeline.

Control-clicking a parameter’s name in the Inspector, or clicking the downward arrow at the right of a parameter (visible when you move the pointer over it) opens the Animation menu, which displays the names of behaviors applied to that parameter.

Choosing a behavior opens the Behaviors Inspector.

As with all other behaviors, when a Parameter behavior is applied to an object in your project, a behavior icon (a gear) appears over the Keyframe button of the affected parameter in the Properties, Behaviors, or Filters Inspector where it is applied.
Manage behaviors and behavior timing

Disable, lock, hide, and rename behaviors

When you apply a behavior to an object, the behavior appears in three places: the Layers list, the Timeline, and the Behaviors Inspector.

The Behaviors Inspector contains all editable parameters for a behavior that’s been applied to an object. The Layers list and Timeline have several controls for each behavior:

Note: In the Layers list and Timeline, Control-clicking an object’s behavior icon (the small gear) opens a shortcut menu that displays
behaviors applied to that object. Choose a behavior from this menu to display its parameter controls in the Inspector.

---

**Disable the effect of a single behavior**

- Deselect the behavior’s activation checkbox in the Layers list, Timeline, or Behaviors Inspector.

  Behaviors that are disabled have no effect on the object to which they’re applied.

---

**Disable the effect of all behaviors applied to an object or layer**

- Click the behavior icon that appears to the right of the object name in the Layers list and Timeline.

  A red slash appears through a disabled behavior’s icon, the behavior names are dimmed, and their effect disabled.

---

**Lock a behavior**

- Click the lock icon in the Layers list or Timeline.

  You cannot modify the parameters of a locked behavior.
Show or hide all behaviors

- Click the Show/Hide Behaviors button at the bottom of the Layers list (or at the top of the Timeline layers list).

![Show/Hide Behaviors button]

This button neither enables nor disables behaviors applied to objects in your project; it merely controls their visibility as objects in the Layers list and Timeline.

Rename a behavior

- In the Layers list or Timeline, double-click a behavior name, enter a new name, then press Return.

Copy, paste, move, and reorder behaviors

After you add behaviors to an object, there are a number of ways to copy and move them among the other items in the Timeline or Layers list. Behaviors can be cut, copied, pasted, or duplicated like any other item in Motion. When you cut or copy a behavior in the Timeline or Layers list, you also copy the current states of that behavior’s parameters.
When you duplicate an object, you duplicate all behaviors applied to it. This way, if you’re creating a project with a number of objects that use the same behavior, you can apply that behavior to the first instance of that object, and then duplicate that object as many times as necessary.

Cut or copy a behavior

1. Select a behavior in the Layers list or Timeline.

2. Do one of the following:
   - Choose Edit > Cut (or press Command-X) to remove the behavior and place it on the Clipboard.
   - Choose Edit > Copy (or press Command-C) to copy the behavior to the Clipboard.

Paste a behavior

1. Select an object in the Layers list or Timeline.

2. Choose Edit > Paste (or press Command-V).

   The cut or copied behavior is applied to the selected object, with all its parameter settings intact.

Transfer a behavior from one object to
You can also move a behavior from one object to another in the Layers list or Timeline by dragging it to a new position.

- In the Layers list or Timeline, drag a behavior from one object and drop it on top of another.

Note: If you move a Parameter behavior to another object, it is applied to the same parameter it affected in the previous object—as long as the corresponding parameter exists. If the parameter does not exist, the parameter assignment (Apply To field) is set to None.

Duplicate a behavior

You can also duplicate a behavior in place.

1. Select a behavior in the Layers list or Timeline.

2. Do one of the following:
   - Choose Edit > Duplicate (or press Command-D)
Choose Edit > Duplicate (or press Command-D).

Control-click the behavior to duplicate, then choose Duplicate from the shortcut menu.

**Note:** You can also use the Cut, Copy, and Paste commands from the shortcut menu to duplicate a behavior.

---

**Drag a duplicate of a behavior to another object**

You can also duplicate a behavior and apply the duplicate to another object in the Layers list or Timeline.

- In the Layers list or Timeline, Option-drag a behavior to another object.

  The behavior is duplicated and applied to the second object, and the original behavior is left in its original location.

---

**Reorder behaviors**

1. In the Layers list or Timeline, drag the behavior up or down in the list of nested behaviors applied to the same object.

   A position indicator appears.
2. When the position indicator is in the correct row, release the mouse button.

All behaviors combine according to a predetermined order of operations (see About behavior order of operations) regardless of their order in the Layers list. Therefore, reordering the behaviors has no effect on the resulting animations, with a few exceptions:

- The Stop behavior suspends the activity of all behaviors beneath it in the Layers list that affect the same parameter. The Stop behavior has no effect on behaviors above it in the Layers list.

- Parameter behaviors are applied in the order that they are added, from the bottom to the top in the Layers list, so you need to think about how you are building the operation. For example, imagine a circle shape with an X Position of 50 in the Canvas. If you apply a Rate Parameter behavior with a positive Rate value to the X Position of the circle, the circle will move to the right from its starting X Position of 50. If you then apply a Negate Parameter behavior to the circle’s X Position, the circle will start at –50 in the Canvas and move to the left. The effect you see in the Canvas is the result of each behavior acting upon the previously applied behavior: an X Position value of 50 is modified by the Rate behavior (in a positive direction), which is in turn modified
by the Negate behavior, changing the X Position and rate to negative values.

If you swap the order of Rate and Negate in the Layers list, Negate is processed first. The circle’s X Position value of 50 is turned into –50. This is then passed as the input to Rate, which moves the circle in a positive direction. Now the circle begins at the –50 X Position in the Canvas and moves to the right.

Modify behavior timing

Behavior timing overview

You can change a behavior’s timing to control when it starts, how long it lasts, and when it stops. There are several ways to do this:

- **Use the Stop parameter behavior** to suspend a behavior’s effect on a single parameter.
- **Trim the length of a behavior’s bar** in the Timeline.
- **Drag a behavior’s bar** left or right in the Timeline.
- **Change the Start Offset or End Offset parameter** to stop a behavior before the end of its bar’s duration in the Timeline.

Stop a behavior

The easiest way to control behavior timing is to use the Stop behavior (in the Parameter category). The Stop behavior halts the animation occurring in a single parameter, whether the animation is based on keyframes in the Keyframe Editor or behaviors
Stop a parameter from animating

1. Move the playhead to the frame where you want animation to stop.

2. Select the affected object, then open the Properties Inspector.

3. Control-click the parameter to stop, choose Add Parameter Behavior from the shortcut menu, then choose Stop.

   If the behavior was applied to one dimension of a multidimensional parameter, open that parameter’s disclosure triangle and Control-click the dimensional parameter to access the same shortcut menu, then choose Stop.

   The parameter is animated until the frame where the Stop behavior begins.

   **Note:** When applied in this manner, the Stop behavior takes effect at the current frame (regardless of the Create Layers At setting in Motion Preferences).

4. To assign the Stop behavior to a different parameter, choose a new parameter from the Apply To pop-up menu in the Stop section of the Behaviors Inspector.

   The Stop behavior halts the animation of all behaviors that affect
the selected parameter of that object. For example, if the Gravity, Edge Collision, and Rotate behaviors are applied to a shape and you apply the Stop parameter to the shape layer’s Position parameter, the shape stops moving but continues rotating.

To control when animation affecting that parameter is stopped, trim the Stop behavior in the Timeline. For more information on trimming behaviors, see Trim behaviors.

Trim behaviors

When you apply a behavior to an object, the duration of the behavior in the Timeline defaults to the duration of the object to which it’s applied. However, a behavior can be modified to limit the duration of its effect. For example, if you apply the Spin behavior to a replicator layer, by default that replicator spins for its entire duration. If you trim the Out point of the Spin behavior, the spinning stops at the new position of the Out point.

As you trim the behavior bar in the Timeline, a tooltip appears, indicating the new location of the Out point as well as the new duration of the behavior.

**Important:** The motion of a Simulation behavior cannot be stopped or changed by trimming its duration in the Timeline. For more information, see About controlling Simulation behaviors.
Change the duration of a behavior in the Timeline

1. Move the pointer to the In or Out point of any behavior bar in the Timeline.

2. When the pointer changes to the trim pointer, do one of the following:
   - Drag the In point to the right to delay the beginning of the behavior’s effect.
   - Drag the Out point to the left to end the behavior’s effect before the end of the object it’s modifying.

Trimming the Out point of a behavior often sets the object to its original state beyond the Out point behavior. For many behaviors, using the Stop behavior to pause the object’s animation is a more efficient method than trimming its Out point. Another way to stop a behavior’s effect and leave the affected object in the transformed state is to adjust a behavior’s Start and End Offset parameters.
About controlling Simulation behaviors

The ideal use for behaviors (with the exception of Motion Tracking behaviors) is creating fluid motion graphics that do not require specific timing. This is especially true with the Simulation behaviors, which let you create sophisticated interactions among multiple objects in your project with minimal editing.

Unlike Basic Motion behaviors, you cannot stop or change the motion of a Simulation behavior in the Timeline. However, you can affect the rate of a Simulation behavior by modifying its duration in the Timeline. You can also change the starting frame of the behavior.

Because the Simulation behaviors mimic natural effects, such as Gravity, the laws of inertia apply: an external force sets the object in motion, and that object stays in motion even after the active force is no longer present. Changing the duration of a Timeline bar for a Simulation behavior does stop the “active” force on the object but does not stop the motion of the object. You can, of course, control Simulation behaviors by modifying their parameters.

In the following image, the Orbit Around behavior is applied to the small blue circle. The large orange circle is assigned as the object that the blue circle moves around. The red animation path represents the motion of the small blue circle over its duration. The Orbit Around behavior is the same duration (240 frames) as the large circle to which it is applied.
In the next image, the Orbit Around behavior is trimmed in the Timeline to a shorter duration (140 frames) than the object to which it is applied. Notice the change in the shape of the animation path: At frame 140, where the Orbit Around behavior ends, the object (the small blue circle) stops moving around its target and continues moving off the Canvas. The Orbit Around behavior—the active force—is no longer present, but the motion of the blue circle does not stop.

Move behaviors in time

In addition to changing a behavior’s duration, you can also move its position in the Timeline relative to the object it’s applied to. This lets you set the frame where that behavior begins to take effect.

Move a behavior in the Timeline
1. Click anywhere in the middle of a behavior’s bar in the Timeline.

2. Drag the behavior to the left or right to move it to another position in the Timeline.

As you move the bar, a tooltip displays the new In and Out points for the behavior. The tooltip also displays the delta value, which shows the number of frames you’ve moved the bar.

![Timeline with behavior bar and tooltip](image)

---

**Change the start or end offset of Parameter behaviors**

Many Parameter behaviors have two additional parameters, Start Offset and End Offset, used to change the frame where a Parameter behavior’s effect begins and ends.

Use the Start Offset slider to delay the beginning of the behavior’s effect, relative to the first frame of its position in the Timeline. Adjust this parameter to make the Parameter behavior start later.

Use the End Offset slider to extend the behavior’s effect relative...
to the last frame of its position in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior bar in the Timeline, lets you freeze the behavior’s effect on the object for its remaining duration.

The following example shows how to use the Start Offset and End Offset parameter with the Ramp behavior (applied to the Scale parameter of a shape).

Use the Start Offset and End Offset parameters

1. In the Layers list, Timeline, or Canvas, select an image layer, such as a shape.

2. In the Properties Inspector, Control-click the Scale parameter, then choose Add Parameter Behavior > Ramp from the shortcut menu.

   The Ramp behavior is applied to the Scale parameter of the layer, and the Behaviors Inspector opens. The Ramp behavior lets you create a gradual transition in any animatable parameter.

3. Set the Start Value to 0 and the End Value to 200, then play the project.

   The layer scales from its original size to twice its original size over the duration of the layer.

4. Set the Start Offset to 90 and the End Offset to 90.
The layer does not begin scaling until frame 90, and stops scaling 90 frames from its last frame in the Timeline.

About behavior order of operations

There’s no limit to the number of behaviors you can add to an object. When multiple behaviors are applied to a single object, they work together to create a final animated effect.

In general, each behavior applies a value to a specific parameter. The values generated by all behaviors that affect the same parameters are combined to create the end result. For example, if you apply the Throw, Spin, and Gravity behaviors to a single object, the Throw and Gravity behaviors combine to affect the position of the object. The Spin behavior affects the rotation of the object.

When combining different behavior types (such as Parameter and Simulation behaviors), or combining behaviors and keyframes, it’s important to understand the behaviors’ order of operations. Motion evaluates behaviors and keyframes in the following order:

Keyframes > Simulation behaviors > all other behaviors

Parameter behaviors are applied in the order in which they are added, from the bottom of the Layers list up (like the order of filters and the compositing order of image layers). For more information, see Copy, paste, move, and reorder behaviors.

Important: The order of operations is always in effect—regardless of the order in which the behaviors are applied or the
Use the following guidelines for animating objects with multiple applied behaviors or keyframes:

- When you animate an object with keyframes and then apply a behavior, the effect of the keyframes is evaluated first.

  For example, if you animate the Rotation parameter of an object using keyframes and then apply a Rotational Drag (Simulation) behavior to the object, Motion evaluates the keyframed rotation, and then applies the drag (from the Simulation behavior) to the keyframed animation.

- When you animate an object with any behavior and then add keyframes, the effect of the keyframes is evaluated first.

  For example, if you animate an object so it rotates in a clockwise direction using the Spin behavior and then keyframe the Rotation parameter so the object rotates in a counterclockwise direction, the object rotates in the counterclockwise direction. Motion always evaluates keyframes first.

- When you animate an object with a behavior and then apply a Simulation behavior, the Simulation behavior is evaluated before the first behavior (and therefore may have no effect).

  For example, if you animate the Rotation parameter of an object using the Oscillate (Parameter) behavior and then apply a Rotational Drag (Simulation) behavior to the object, the object oscillates, but is not slowed by the Rotational Drag behavior. Motion evaluates the Simulation behavior (Rotational Drag) before the Parameter behavior (Oscillate), applying the drag to a 0 value. There is no data for the Simulation behavior.
to affect.

**Note:** Although the Spin behavior appears in the Basic Motion category, Spin is treated as a Simulation behavior in the order of operations.

For information on combining keyframes with behaviors, see About combining behaviors with keyframes.

**Behaviors and keyframes**

**About combining behaviors with keyframes**

Any object can have behaviors and keyframes applied to it simultaneously. When this happens, the values generated by the behavior and the keyframed values applied to the parameter are combined to yield the final value for that parameter. This lets you combine the automatic convenience of behaviors with the direct control of keyframing to achieve your final result.

**Note:** Motion has a specific order of operations for keyframes and behaviors. For more information, see About behavior order of operations.

For example, if you create an animation path using keyframes, you can create a completely predictable and smooth movement.
However, if you apply the Randomize parameter behavior to the same object, its effect combines with the keyframed motion path you created. As a result, the animation path follows the general direction you want, with random variation in it to make it interesting.

Although this example shows how you can combine behaviors and keyframes to create animation paths, you can combine behaviors and keyframes for any parameter.

SEE ALSO
About behaviors and keyframes in the Keyframe Editor
About keyframing specific parameters in behaviors
Convert behaviors to keyframes
About behaviors and keyframes in the Keyframe Editor

When you keyframe a parameter that’s already affected by a behavior, the keyframes add to or subtract from the effect of the behavior. This effect is shown in the Keyframe Editor, which displays two curves for each parameter modified by both a behavior and one or more keyframes:

- A bold, editable curve displaying the effect of keyframes on the parameter
- An lighter, noneditable curve displaying the combined effect of the behavior and keyframes on the parameter at each frame.

Dragging a keyframe on the bold curve also modifies the lighter curve, because the keyframe is modifying the values generated by the behavior.

**Important:** The value displayed in the Inspector for the affected parameter reflects the combined result of keyframes and behaviors applied to that parameter. Editing a parameter’s values in the Inspector only results in changes made to the underlying parameter value, whether keyframed or not. This parameter value is then combined with the behavior’s effect, yielding a final value.
that might differ from the value you entered.

When you combine keyframes with multiple behaviors, the results can appear to be unpredictable, depending on the combination of behaviors applied.

**SEE ALSO**

Keyframing overview
Convert behaviors to keyframes

---

### About keyframing specific parameters in behaviors

You can also apply keyframes to specific parameters of behaviors in your project. Doing so gives you more control when animating a behavior’s parameters. For example, you can keyframe the Speed parameter of the Oscillate parameter behavior to increase the rate of oscillation over time, creating a more complex animation path.

![Default Oscillate Parameter behavior](image1)

![Oscillate Parameter behavior with keyframed Speed parameter](image2)

For more information about keyframing the parameters of behaviors, see **Apply keyframes to behaviors**.
Convert behaviors to keyframes

Behaviors are best suited for fluid effects in which precise timing is not necessary. However, there might be projects in which you want finite control over the animated effects created with behaviors. If necessary, several of the behaviors can be *baked* into keyframes. This means that the animation curves created by the behaviors (which have no keyframes) can be converted into keyframed animation curves. You can then modify the keyframes in the Keyframe Editor to meet more precise timing requirements.

Because many (though not all) behaviors affect shared object parameters, when you convert a behavior to keyframes, all other behaviors applied to the same object are also converted into keyframes. The keyframes are applied to the individual parameters that the behaviors originally affected. Additionally, when behaviors applied to other objects affect the object being converted (for example, the Attractor or Repel behavior), their effect is baked into the object’s resulting keyframes value. The original behaviors remain applied to the other objects, but the resulting effect is not doubled as a result of the keyframes combining with the behavior.

**Convert behaviors to keyframes**

1. Do one of the following:
   - Select an object that has behaviors to convert.
   - In the Inspector, select a behavior to convert.

2. Choose Object > Convert to Keyframes (or press Command-
A dialog prompts you to confirm the conversion to keyframes.

3. Click Convert.

All behaviors are converted into keyframes, even if some of the behaviors fall outside of the object’s time range.

Converting a behavior to keyframes can result in a very large amount of keyframes. You can simplify your keyframes using the Reduce Keyframes command. For more information, see Simplify a keyframe-heavy curve.

**Note:** You cannot selectively convert individual behaviors. The Convert to Keyframes command converts all behaviors applied to an object.

You cannot convert many of the Simulation, Replicator, Particle, or Text behaviors into keyframes. Simulation behaviors such as Vortex can affect the parameters of all objects in a project, and baking such a behavior would create an overwhelming amount of keyframes. Such behaviors are designed to create very complex motion that would be too time-consuming to keyframe manually.

If a behavior (or an object with applied behaviors) can be baked, the Convert to Keyframes command appears in the Object menu when the behavior or object is selected. If the Convert to Keyframes command is dimmed, keyframes cannot be generated from the behavior.
Adjust behaviors overview

You edit behavior parameters in the Behaviors Inspector or in the HUD. All behavior parameters appear in the Behaviors Inspector. Each behavior has a subset (or sometimes a complete set) of parameters that appear in the HUD. The HUD and the Behaviors Inspector reference the same parameters, so changing a parameter in one changes the same parameter in the other.

In general, the parameters that appear in the HUD are the most essential for modifying that behavior’s effect. Frequently, the controls available in a behavior’s HUD are more descriptive and easier to use than those in the Behaviors Inspector.

For example, the Fade In/Fade Out behavior HUD contains a graphical control for adjusting a layer’s fade time.

The Fade In/Fade Out behavior Inspector contains standard sliders for adjusting a layer’s fade time.
Display the HUD for a behavior

- Do one of the following:
  - Select the behavior to modify in the Layers list, Timeline, or Behaviors Inspector.
  - Control-click an object in the Canvas, then choose a behavior from the Behaviors submenu in the shortcut menu.

  **Note:** If the HUD doesn’t appear, choose Window > Show HUD (or press F7 or D).

Display the Behaviors Inspector

1. Select an object with an applied behavior.

2. Do one of the following:
   - In the Inspector, click Behaviors (if that pane is not already showing).
   - Click the “i” in the upper-right corner of the behavior’s HUD.
   - If the File Browser or Library are displayed, press Command-3.

Edit multiple behaviors at the same time

If you’ve applied the same behavior to multiple objects, you can
modify all instances of that behavior at the same time.

1. In the Layers list or the Behaviors Inspector, Command-click to select multiple behaviors of the same type.

   For example, you might select all Throw behaviors applied to different objects in your project.

2. Do one of the following:
   - In the HUD titled “Multiple Selected,” adjust the parameter controls.
   - In the Behaviors Inspector, adjust the parameter controls.

   Only behaviors that apply are available. When you adjust the parameters, all selected behaviors are modified.

For detailed information about the adjustable parameter controls in each type of behavior, see the following:

Basic Motion behaviors overview

Parameter behaviors overview

Retiming behaviors overview

Simulation behaviors overview

Additional behaviors

Basic Motion behaviors
Basic Motion behaviors overview

Basic Motion behaviors animate specific parameters of the object to which they’re applied. Some affect position, while others affect scale, rotation, or opacity.

**WARNING:** Building consecutive Basic Motion behaviors or placing such a behavior before or after the Camera Framing behavior can create unexpected results. These behaviors can continue to affect the object even after the behavior ends, thus influencing the subsequent behavior’s animation path. For example, if a Framing behavior is applied after a Motion Path behavior, the residual effect of the Motion Path behavior is combined with the animation path generated by the Framing behavior. Consequently, the target object might be framed improperly. For information about Camera behaviors, see Add Camera behaviors.

There are eight Basic Motion behaviors:

- **Fade In/Fade Out** makes an object dissolve into view or fade away.
- **Grow/Shrink** makes an object enlarge or reduce its size over time.
- **Motion Path** creates a spline path for an object to move along.
- **Move** pulls an object to a target point in the Canvas.
- **Point At** causes an object to turn toward a target point.
- **Snap Alignment to Motion** points an object in the direction its moving along an animation path.
- **Spin** rotates an object around a single axis.
Fade In/Fade Out

The Fade In/Fade Out behavior lets you dissolve into and out of any object by ramping the opacity of the object from 0 percent to 100 percent at the start, and then back to 0 percent at the end. You can eliminate the fade-in or fade-out effect by setting the duration of the Fade In Time or Fade Out Time to 0 frames.

**Note:** This behavior is multiplicative. This means that the Fade In and Fade Out parameters are multiplied by the object’s current opacity to produce the resulting level of transparency.

The Fade In/Fade Out behavior is useful for introducing and removing animated elements. For example, you can apply the Fade In/Fade Out behavior to text that moves across the screen to make it fade into existence, and then fade away at the end of its duration.

**Note:** The Fade In/Fade Out behavior cannot be applied to a camera or light.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Fade In Time:** A slider defining the duration, in frames, over which the object fades in from 0 to 100 percent opacity from the first frame of the object. A duration of 0 frames results in a straight cut into the object, making it appear instantly.
- **Fade Out Time:** A slider defining the duration, in frames, over which the object fades out from 100 to 0 percent opacity at the last frame of the object. A duration of 0 frames results in a
straight cut-away from the object, making it disappear instantly.

- **Start Offset:** A slider that lets you delay the beginning of the behavior’s effect relative to its first frame in the Timeline. Adjust this parameter to make the behavior start later. This parameter value is measured in frames.

- **End Offset:** A slider that lets you offset the end of the behavior’s effect relative to its last frame in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline.

The HUD lets you set the Fade In and Fade Out durations with a graphical control. Drag anywhere in the shaded area of the Fade In or the Fade Out ramp to adjust the duration of the effect.

**Note:** Continue dragging beyond the limits of the graphical HUD control to extend the durations of the Fade In or Fade Out.

---

![Fade In/Fade Out screenshot](image)

**Grow/Shrink**

The Grow/Shrink behavior lets you animate the scale of an object, enlarging or reducing its size over time. At the first frame of the behavior, the object appears at its original size; the settings of the
behavior determine whether the object grows or shrinks over the duration of the effect. The vertical and horizontal growth rates can be set to independent values, for asymmetrical effects.

**Note:** The Grow/Shrink behavior cannot be applied to cameras or lights.

You can use the Grow/Shrink behavior with high-resolution graphics to zoom into an image, such as a map or photograph. You can combine this behavior with the Throw or Wind behavior to pan across the image while zooming into it. The Grow/Shrink behavior can also be used to emphasize or de-emphasize images in your project. For example, you can enlarge an object to make it the center of attention, or shrink the object while introducing another object to move the viewer’s eye to the new element.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Increment:** A pop-up menu that sets how the behavior’s effect progresses over its duration in the Timeline. There are three options:
  - **Continuous Rate:** Uses the Scale Rate parameter to grow or shrink the object by a steady number of pixels per second.
  - **Ramp to Final Value:** Grows or shrinks the object from its original size to the specified percentage plus the original scale in the Scale To parameter. If the behavior is shortened in the Timeline, the Grow/Shrink effect occurs faster.
  - **Natural Scale:** Uses an exponential curve so that the animation progresses slowly when the scale values are small, and speeds up when the values are large, creating
the illusion of scaling at a constant speed. This is the default option.

- **Scale Rate/Scale To:** A slider that sets the speed and magnitude of the effect (depending on the command chosen in the Increment pop-up menu). Click the disclosure triangle to reveal X and Y sliders that adjust horizontal or vertical scale independently.

- **Curvature:** A slider that adjusts the acceleration from the original to the final size. Higher Curvature values ease into and out of the effect. Because Curvature is defined by the length of the behavior in the Timeline, minus the End Offset, this setting does not affect the overall duration of the effect.

  **Note:** The Curvature parameter is not available when the Increment parameter is set to Natural Scale.

- **End Offset:** A slider that offsets the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline.

The HUD consists of two rectangular regions. The first, a rectangle with a dotted line, represents the original size of the object. The second, a solid rectangle, represents the relative growth rate. Drag a border of the solid rectangle to grow or shrink the object. Drag the slider to adjust the scale of the HUD controls, increasing or decreasing their effect.
Motion Path

The Motion Path behavior lets you create a 2D or 3D motion path for an object to follow. When you apply this behavior, the motion path defaults to an open spline: a straight line defined by two points at the beginning and end of the path. You can also choose from preset path shapes, such as a closed spline, loop, rectangle, or wave, or use a shape to define a path. A shape used as the source for a motion path can be animated.

For more information on customizing the Motion Path behavior, see Work with the Motion Path behavior.

The first point on the path is the position of the object in the Canvas at the first frame of the behavior. Option-click anywhere on the path to add Bezier points, which allow you to reshape the motion path by creating curves.
When you play the project, the object moves along the assigned path. (To show or hide the motion path, choose Show Overlays from the View pop-up menu above the Canvas.) The speed at which the target object travels is defined by the duration of the behavior. Speed is also affected by the Speed parameter, which lets you modify the object’s velocity—adding acceleration and deceleration at the beginning and end of the behavior, for example. You can also create a custom preset defining how the object travels along the path.

**Note:** When you switch between the Path Shape options, the Inspector and the HUD display parameters specific to the selected option.

The Motion Path behavior is an easy way to create predictable motion without using the Keyframe Editor. It’s also a great way to create reusable motion paths that you can save in the Library for future use.

When the Motion Path behavior is added to an object, the Adjust Item tool is selected, allowing you to modify the default path in the Canvas by adding points and using the Bezier (or B-Spline) controls attached to each point to adjust each curve. You can also move and resize preset motion path shapes, such as a rectangle or wave, in the Canvas.
Adjust this behavior using the controls in the Behaviors Inspector:

- **Path Shape**: A pop-up menu that defines the shape of the path on which the object travels. Choose one of the following path shapes:
  - **Open Spline**: The default shape, a straight path defined by two points at the beginning and end of the path. You can choose to work with Bezier or B-Spline control points. Option-click (or double-click) anywhere on the path to add points.

  **Note**: You cannot add points to a motion path when Circle or Rectangle are selected from the Path Shape pop-up menu. To change the shape of a path when Geometry is selected from the Path Shape pop-up menu, edit the source shape.

  - **Closed Spline**: A closed path with the last point in the same location as the first point. You can choose to work with Bezier or B-Spline control points. Option-click (or double-click) anywhere on the path to add points.

  - **Circle**: A simplified version of Closed Spline, in which the X radius or Y radius can be adjusted to create a circle or an ellipse. Use the outer control points to resize the circle (or rectangle) motion path’s shape.
- **Rectangle**: A closed path in which the width and the height can be adjusted to create a square or a rectangle.

- **Wave**: A wavy path (a sine wave) defined by two points, one at the beginning and one at the end of the path, and controlled by the End Point, Amplitude, Frequency, Phase, and Damping parameters.

- **Geometry**: A path based on a shape or mask. The object travels along the edge of the shape or mask. In the following figure, the outline of the shape on the left is used as the motion path in the composition shown on the right.

![Shape and Geometry Example](image)

**Note**: The Path Shape parameters work similarly to text on a path. For more information about working with text on a path, see Create and modify text on a path.

- **Shape Type**: A pop-up menu (available when Path Shape is set to Open Spline or Closed Spline) that sets how the path is manipulated, via Bezier or B-Spline control points.

- **Bezier**: Lets you manipulate the path manually by dragging Bezier handles.

  **Note**: For more information about creating and adjusting Bezier curves, see Edit Bezier control points.

- **B-Spline**: Lets you manipulate the path by dragging B-
Spline control points. The points themselves do not lie on the surface of the shape. Instead, each B-Spline control point is offset from the shape’s surface, “magnetically” pulling that section of the shape toward itself to create a curve. B-Splines are extremely smooth—by default, there are no sharp angles in B-Spline shapes, although you can create sharper curves, if necessary.

**Note:** For more information about working with B-Spline curves, see [Edit B-Spline control points](#).

- **Radius:** A slider (available when Circle is the defined path shape) that sets the size of the circular path. Click the disclosure triangle to adjust the X radius and Y radius independently.

**Note:** When the Motion Path behavior is selected, you can also drag the onscreen control points to resize the circle. Press Shift while dragging to resize the X and Y radii uniformly.

- **Size:** A slider (available when Rectangle is the defined path shape) that modifies the size of the rectangular path. Click the disclosure triangle to adjust the X scale and Y scale independently.

**Note:** When the Motion Path behavior is selected, you can also drag the onscreen control points to resize the rectangle. Press Shift while dragging to resize the X and Y scales uniformly.

- **Offset:** A slider (available when Circle, Rectangle, or Geometry is the defined path shape) that sets where the object starts moving on the path.

**End Points:** Value sliders (available when Wave is the defined path shape) that control loop or break-out options, depending on your needs.
- **End Point**: Value sliders (available when Wave is the defined path shape) that sets the location of two default points on the wave’s path. The end points can also be adjusted using the wave’s onscreen controls (active by default when the Motion Path behavior is selected). Moving the left end point moves the entire path; moving the right end point lengthens, shortens, or angles the path.

- **Amplitude**: A slider (available when Wave is the defined path shape) that defines half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.

- **Frequency**: A slider (available when Wave is the defined path shape) that sets the number of waves. Higher values result in more waves.

- **Phase**: A dial (available when Wave is the defined path shape) that defines the degree of the offset of waves from the start and end points of the path. When Phase is set to 0 degrees (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When Phase is set to 90 degrees, the wave begins and ends at the highest point in the wave. When set to –90 degrees, the wave begins at the lowest point in the wave. When set to 180 degrees, the waves are the same as 0 degrees, but inverted.

- **Damping**: A slider (available when Wave is the defined path shape) that progressively diminishes the oscillation of the wave. Positive values diminish the wave forward (from left to right); negative values diminish the wave backward (from right to left). The following illustration shows positive damping applied to the wave motion path.
• **Attach to Shape**: A checkbox (available when Geometry is the defined path shape) that, when selected, forces the motion path to follow the source shape at its original location. When disabled, the motion path can exist in a location other than its source shape.

**Note**: When Attach to Shape is selected, you cannot move the object to another location.

**Tip**: To align the rotation of an object to match all changes made to its position along an animation path, apply the Snap Alignment to Motion behavior. For more information, see Snap Alignment to Motion.

• **Shape Source**: An object well (available when Geometry is the defined path shape) that specifies the object (a shape or mask) used as the motion path source. Choose an available shape from the adjacent To pop-up menu, or drag a shape from the Layers list into the object well.

• **Direction**: A pop-up menu that defines the object’s direction along the path. There are two options:
  - **Forward**: The object moves in a forward direction along the path (from the start point to the end point, depending upon the Offset parameter).
  - **Reverse**: The object moves in a backward direction along the path.
The object moves in a backward direction along the path (from the end point to the start point, depending upon the Offset parameter).

**Note:** The Offset parameter is available when Path Shape is set to Circle or Rectangle.

- **Speed:** A pop-up menu that defines the object’s velocity from the first to the last point in the motion path. There are eight choices:
  - **Constant:** The object moves at a steady speed from the first to the last point on the motion path.
  - **Ease In:** The object starts at a slow speed, then reaches and maintains a steady speed through the last point on the motion path.
  - **Ease Out:** The object starts at a steady speed, then gradually decelerates to a stop at the last point of the motion path.
  - **Ease Both:** The object slowly accelerates from the first point on the motion path, then gradually decelerates to a stop at the last point of the motion path.
  - **Accelerate:** The object moves along the path with increasing speed.
  - **Decelerate:** The object moves along the path with decreasing speed.
  - **Natural:** The speed at which the object moves over the path is determined by the shape of the path. For example, if the path is a U-shape curve, the object moves faster as it moves toward the low point of the U and slower as it moves up the edges.
  - **Custom:** Object speed is defined by keyframes for the path. Object speed is defined by keyframes for the path.
- **Custom**: Object speed is defined by keyframes for the object’s speed from 0 to 100 percent. In other words, you determine the position of the object along the path in time.

- **Custom Speed**: A slider (available when Speed is set to Custom) that modifies the Custom Speed velocity curve in the Keyframe Editor. For example, you can keyframe custom values to make an object travel forward to a specific percentage of the path, then backward, then forward, and so on before reaching the end of the animation.

- **Apply Speed**: A pop-up menu that determines how the Speed parameter (velocity) is applied over the duration of the behavior. (Loops must be set to a value greater than 1 for the Apply Speed parameter to have any effect.) There are two choices:
  - **Once Per Loop**: The velocity, as defined by the Speed parameter, is applied to each cycle. For example, if Loops is set to 3 and Speed is set to Accelerate, the object accelerates each time it travels over the path. The speed is applied to the entire duration, ignoring the Loops setting.
  - **Over Entire Duration**: The velocity, as defined by the Speed parameter, is applied one time over the duration of the behavior. For example, if Loops is set to 3 and Speed is set to Accelerate, the object accelerates the first time it travels over the path, but not the second and third time.

- **Loops**: A slider that sets the number of times the object travels the motion path over the duration of the behavior. For an object to travel its path more than once, or to “ping-pong,” Loops must be set to a value greater than 1.

- **End Condition**: A pop-up menu that defines the behavior of the object after it reaches the end of its motion path. There
are two options:

- **Repeat**: The object travels the motion path the number of times defined by the Loop parameter.

- **Ping-Pong**: The object moves along the path until it reaches the last point on the path, then moves backward to the first point on the path. The number of “ping-pongs” is defined by the Loops parameter.

- **Control Points**: Value sliders (available when the path shape is Open Spline or Closed Spline) that set the X, Y, and Z coordinates of the motion path control points. (Click the disclosure triangle to display the X, Y, and Z value sliders.)

**Note**: You cannot apply Parameter behaviors to the control points.

**SEE ALSO**

Work with the Motion Path behavior

**Work with the Motion Path behavior**

The following tasks demonstrate how to customize the Motion Path behavior.

**Change the shape of the motion path**

With an applied Motion Path behavior selected in the Layers list, Timeline, or Behaviors Inspector, do any of the following:

- In the Behaviors Inspector, click the Path Shape pop-up
You can use a shape animated with behaviors or keyframes as the source for a motion path. This includes animated transforms (a shape changing its location in the Canvas) and animated control points (a shape changing its shape due to keyframed control points).

1. Import (or draw) the shape to use as the path source.

2. With an applied Motion Path behavior selected, open the Behaviors Inspector, then choose Geometry from the Path Shape pop-up menu.

   The Shape Source well appears in the Inspector and HUD.

3. From the Layers list, drag the shape you created in step 1 into the Shape Source well.

4. When the pointer becomes a curved arrow, release the mouse button.

   A thumbnail of the shape appears in the well and the shape is used as the source shape for the motion path.

**Note:** You can disable the source shape in the Layers list (by deselecting its activation checkbox) so that the source shape
is not visible in your project.

Select another geometry source for a motion path shape

- With an applied Motion Path behavior selected, open the Behaviors Inspector, click the To pop-up menu (located next to the Shape Source object well), then choose the object to use as the motion path’s shape source.

**Note:** To align the rotation of the object to the shape of its motion path, you can apply the Snap Alignment to Motion behavior (in the Basic Motion behaviors subcategory).

Move the object and its motion path

- In the Layers list or Canvas, select the object (not the Motion Path behavior), then drag the object in the Canvas.

  **Note:** To move the object and its motion path when Path Shape is set to Geometry, select the source object, then move the object in the Canvas.

Distance the object from the path

By default, the object is locked to the motion path by its anchor point.
Select the Anchor Point tool from the toolbar, then drag the anchor point in the Canvas.

For more information on using the Anchor Point tool, see Move a layer’s anchor point.

**Note:** A separate Offset parameter lets you offset the starting location of the object on the motion path (but does not offset the object from the path).

---

**Use the Custom Speed parameter**

1. In the Layers list, select an applied Motion Path behavior.

2. In the Behaviors Inspector or HUD, click the Speed pop-up menu, then choose Custom.

The Custom Speed parameter control becomes available. By default, a keyframe is set at the first and last points of the behavior to create an animation of 0 percent to 100 percent, where at 0 the object is at the beginning of the path, and at 100 the object is at the end of the path. This is the same velocity used with the Constant preset.
3. Press A to enable keyframe recording.

**Note:** When keyframe recording is enabled, all keyframeable parameter value sliders are tinted red, to remind you that any value change entered creates a keyframe.

4. Move the playhead to the position where you want to create a keyframe, then enter a percentage value in the Custom Speed field.

   For example, a value of 90 moves the object 90 percent of the way through the motion path.

5. Continue moving the playhead and adding keyframes to obtain the result you want.

   **Note:** If you change the Speed parameter to a preset (such as Constant) after creating a custom speed, the custom velocity channel is ignored but remains intact.

---

**Adjust a motion path in 3D space**

The easiest way to modify a motion path in 3D space is to add a camera to your project and manipulate the path in a modified camera view.

1. If there’s no camera in your project, add a camera by doing one of the following:
   - Click the New Camera button in the toolbar.
   - Choose Object > New Camera (or press Option-Command-C).
Note: If none of your project groups are set to 3D, a dialog appears asking if you want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera to affect the groups.

2. Do one of the following:

- Click the Camera pop-up menu in the upper-left corner of the Canvas (the default option is Active Camera), then choose a camera view. This example uses the Top view.

- With the Active Camera (or other) view selected, use the Orbit tool (the center tool in 3D view tools in the upper-right corner of the Canvas) to rotate the camera.

Note: If you use the 3D view tools with any camera selected, you are moving the camera, not just changing the camera view.

Depending on the camera view, the object on the path might not be visible. For example, if the object has not been rotated in X or Y space and you are working in Top view, the camera is looking down perpendicularly (on the Y axis) on the object. The motion path and its points are still visible (as long as the Motion Path behavior is selected).

In the following image, the motion path appears flat when viewed from above—the affected object only moves in X and Y space.
3. Drag a control point up or down to adjust the object in Z space.

In the following image, the path is no longer flat—the affected object moves in X, Y, and Z space.
To enter specific values for the control point locations, click the Control Points disclosure triangle in the Motion Path behavior parameters. The first value field is X, the second value field is Y, and the third value field is Z.

4. To reset the camera view, do one of the following:
   - Double-click the 3D view tool that you previously adjusted. For example, if you dragged the Orbit tool to rotate the current camera, double-click the Orbit tool to reset the camera.
   - If you chose (or modified) a default camera view (such as Top, Right, Left, and so on), choose Active Camera from the Camera menu, or choose View > 3D View > Active Camera.
   - With the camera selected, click the reset button in the Properties Inspector.

For more information about working with cameras in a 3D project, see 3D cameras overview.

SEE ALSO
Motion Path

Move
The Move behavior places a point in the Canvas that creates a specific location for an object or group to move toward or away from in a straight line. When used with other behaviors, Move can
create complex motions. For example, in the following illustration, an Orbit Around behavior is applied to the airplane shape.

In the next illustration, a Move behavior is added to the airplane shape. The destination point of the Move path is positioned in the center of the circle. While the airplane circles around (obeying the Orbit Around behavior), it is also drawn to the center of the target (obeying the Move behavior), creating a spiraling motion path.

Tip: The Move behavior is useful in 3D mode because it lets you simulate camera movements without using a camera. For example, when you apply the Move behavior to a group that contains objects offset in Z space, you can create a dolly-like move.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Position**: Value sliders to define the X, Y, and Z position of the
target point. The target (the end of the Move path) is placed at the center of the Canvas by default.

**Note:** You can also drag the target point in the Canvas using the Adjust Item tool.

- **Strength:** A slider defining the speed at which the object moves toward the target. With a value of 0, the object doesn’t move at all. The higher the value, the faster the object moves.

- **Direction:** A pop-up menu that sets whether the object moves toward the target point or away from the point.

- **Speed:** A pop-up menu that defines the object’s velocity from its position in the Canvas to the position of the target. There are six choices:
  - **Constant:** The object moves at a steady speed from its position toward the target.
  - **Ease In:** The object starts at a slow speed, then reaches and maintains a steady speed toward the target.
  - **Ease Out:** The object starts at a steady speed, then gradually decelerates to a stop when it reaches the target.
  - **Ease Both:** The object slowly accelerates, then decelerates to a stop when it reaches the target.
  - **Accelerate:** The object moves toward the target with increasing speed.
  - **Decelerate:** The object moves toward the target with decreasing speed.

**Note:** To move the object more slowly toward its target, extend the duration of the Move To behavior in the Timeline or mini-Timeline. To move the object faster,
shorten the duration of the behavior.

Point At

The Point At behavior causes an object or group to turn toward a target point. Use the Point At behavior with the Move To behavior to create animated objects that not only move toward a point (or each other), but that turn in the direction of the target.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Object**: An object well that defines the target object. To set the target object, drag an object from the Layers list to this object well. You can also drag the target object from the Layers list onto the Point At behavior.

- **Transition**: A slider that determines how long it takes the object to go from its starting orientation to pointing at the center of the target object. This parameter is useful when the object is pointing at a moving target object.

If Transition is set to 50% in a 300-frame project, and the target object is not moving, the point-at object takes 150 frames to point at (or orient to) the center of the target object and then stops moving for the duration of the behavior. If Transition is set to 100%, the point-at object takes the full 300 frames to point at the target object. If the Point At behavior’s duration is 100 frames, and Transition is set to 50%, the point-at object takes 50 frames to orient to the target object.

If Transition is set to 50% in a 300-frame project, and the target object is animated, the point-at object takes 150 frames to point at (or orient to) the center of the target object and then continues following the animated target object for the duration...
of the behavior. If Transition is set to 100%, the point-at object takes the full 300 frames to point at the target object.

- **Speed**: A pop-up menu that defines the object’s velocity from its position in the Canvas to the position of the target. There are six choices:
  - **Constant**: The object moves at a steady speed from its position toward the target.
  - **Ease In**: The object starts at a slow speed, then reaches and maintains a steady speed toward the target.
  - **Ease Out**: The object starts at a steady speed, then gradually decelerates to a stop when it reaches the target.
  - **Ease Both**: The object slowly accelerates, then gradually decelerates to a stop when it reaches the target.
  - **Accelerate**: The object moves toward the target with increasing speed.
  - **Decelerate**: The object moves toward the target with decreasing speed.

- **Axis**: A pop-up menu that lets you align the rotation of the object to the X, Y, or Z axis. The default axis is Z. This parameter specifies which axis points at the target after the movement is complete.

- **Invert Axis**: A checkbox that flips the object so it faces the proper direction. Select the checkbox if the object is aligning on the correct axis, but appears backwards.

**Snap Alignment to Motion**
This behavior aligns the rotation of an object to match all changes made to its position along an animation path. Snap Alignment to Motion is meant to be combined with behaviors that animate the position of an object, or with a keyframed animation path you create yourself.

In the following example, a graphic of an airplane is shown traveling a spiral motion path. On its own, the orientation of the graphic doesn’t change, because only the Position parameter is affected.

If you add the Snap Alignment to Motion behavior to the airplane graphic, the Rotation parameter is affected so the graphic points in the direction of motion, without the need for additional keyframing.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Rotation Axis**: A pop-up menu to rotate the object around the axis of rotation.
• **Rotation Axis:** A pop-up menu to rotate the object around the X, Y, or Z axis. You can also choose All to rotate the object around all three axes. The default rotation axis is Z. All uses the acceleration direction as “up,” like a roller coaster.

• **Axis:** A pop-up menu to specify whether the object aligns to its horizontal or vertical axis.

• **Invert Axis:** A checkbox that, when selected, flips the object so it faces the proper direction. Select this checkbox if the object is aligning on the correct axis, but appears backwards.

• **End Offset:** A slider that offsets the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. For example, if End Offset is set to 60, the object actively snaps to the direction of the path until 60 frames before the end of behavior in the Timeline.

**SEE ALSO**

*Align to Motion*

**Spin**

The Spin behavior animates the rotation of an object, spinning it around a single axis. Using the Custom axis controls, the rotation does not have to occur on a principle axis (X, Y, or Z). If you trim the end of the Spin behavior to be shorter than the duration of the object it’s applied to, it remains at the angle of the last frame of the behavior, as long as there are no other behaviors or keyframes affecting that object’s Rotation parameter.

Uses for Spin are fairly obvious, but another way to use the Spin behavior is with objects that have an off-center anchor point.
Because objects rotate around the anchor point, if you change an object’s anchor point before you apply a Spin behavior to it, you can change the look of the motion you create. For more information on changing an object’s anchor point, see Move a layer’s anchor point.

**Note:** Although the Spin behavior appears in the Basic Motion category, Spin is treated as a Simulation behavior in the Motion application’s order of operations. For more information, see About behavior order of operations.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects:** A checkbox (available when Spin is applied to an object that contains multiple objects—such as a group, particle emitter, or text) that, when selected, causes each object in the layer or group to rotate as an individual object. When this checkbox is deselected, the entire layer or group spins uniformly.

- **Increment:** A pop-up menu that sets how the behavior’s effect progresses over its duration in the Timeline. There are two choices:
  - **Continuous Rate:** Uses the Spin Rate parameter to spin the object by a steady number of degrees per second.
  - **Ramp to Final Value:** Spins the object for the number of degrees specified in the Spin To parameter over the behavior’s duration in the Timeline.

- **Spin Rate/Spin To:** A dial to set the speed at which the object spins. When Increment is set to Continuous Rate, Spin Rate defines a continuous rate of spin in degrees per second. When Increment is set to Ramp to Final Value, Spin To defines
a number of degrees to spin over that object’s duration. Negative values result in clockwise motion; positive values result in counterclockwise motion.

- **Axis**: A pop-up menu that sets whether the object spins about the X, Y, or Z axis. You can also choose Custom, which yields additional Longitude and Latitude parameters. The following illustration shows the Spin behavior’s HUD control set to the Z axis.

![Spin behavior’s HUD control set to the Z axis](image)

When Axis is set to Custom, additional Latitude and Longitude controls become available. These controls allow the object to spin at an angle (not locked to the X, Y, or Z axes).

![Additional Latitude and Longitude controls](image)
The following image shows how longitude and latitude relate to the Spin HUD control.

- **Latitude/Longitude**: A dial (available when Axis is set to Custom) that specifies the axis of rotation.

The HUD controls include an outer ring and an inner control. Drag along the edge of the outer ring to manipulate an arrow that indicates the direction and speed the object spins. Adjust the length of the arrow to change the speed at which the spinning occurs—drag around multiple times to increase the rate of the spin.

The inner arrow controls the axis about which the object or group spins. When you drag the inner controls, a globe control becomes available to adjust the object’s spin in degrees longitude and latitude.

**Note**: You can spin the arrow around the ring multiple times to rotate the object more quickly.
The Throw behavior is the simplest way to set an object in motion. Controls let you adjust the speed and direction of a single force that’s exerted on the object at the first frame of the behavior. After this initial force is applied, the object continues drifting in a straight line at the same speed, for the duration of the Throw behavior.

A simple example of using the Throw behavior is to send a series of offscreen objects moving across the screen. When used in conjunction with other behaviors such as Grow/Shrink and Fade In/Fade Out, you can create sophisticated moving elements without keyframing a single parameter.

The Throw behavior is also useful when you’re moving an object through a simulation. For example, you might move the object past other objects that have Attractor or Repel behaviors applied to them. Because the Throw behavior only applies a single force to move the target object at the initial frame of the behavior, any other behaviors that interact with the target object have potentially greater influence over its motion.
**Important:** The Throw behavior does not apply a continuous force, nor can you create changes in direction or speed, because Throw cannot be keyframed. To create keyframed changes in direction or speed, use the Wind behavior. To create a more complex animation path, use the Motion Path behavior.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects:** A checkbox, available when this behavior is applied to an object that contains multiple child objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Increment:** A pop-up menu that sets how the behavior’s effect progresses over its duration in the Timeline. There are two choices:
  - **Continuous Rate:** Sets the speed of the object at a steady number of pixels per second, specified in the Throw Velocity parameter.
  - **Ramp to Final Value:** Moves the object from its original position to the specified distance (in pixels) in the Throw Distance parameter.

**Note:** When the Canvas displays a nonsquare pixel image, the vertical rate is in pixels per second, and the horizontal rate is the perceptual equivalent.

- **Throw Velocity/Throw Distance:** A slider that sets either velocity or distance, depending on the setting in the Increment pop-up menu. When Increment is set to Continuous Rate, the
Throw Velocity slider sets a continuous speed for the object to move in X, Y, or Z space. When Increment is set to Ramp to Final Value, the Throw Distance slider sets a total distance (in pixels) for the object to travel in X, Y, and Z space over its duration. The standard slider is limited to 100 pixels. Use the value slider to enter values greater than 100.

The 2D HUD lets you specify the direction and speed of the Throw behavior by dragging an arrow in a circular region. The direction of the arrow defines the direction of movement in X and Y space, and the length of the arrow defines speed (velocity). A slider adjusts the scale of the HUD control, increasing or decreasing the effect of the direction/speed control.

When you click the 3D button, additional 3D controls become available. The center arrow now defines the direction the object is thrown in 3D space (X, Y, and Z axes). The Speed slider lets you increase or decrease the velocity of the thrown object.
In the 2D and 3D Throw HUDs, press the Shift key while dragging the arrow to constrain it to 45-degree angles. In the 2D HUD, press the Command key to change the arrow’s direction without affecting its length.

Note: The maximum speed you can define with the HUD is not the maximum possible speed. Higher values can be entered into the Throw Velocity/Throw Distance parameter in the Behaviors Inspector.

Parameter behaviors

Parameter behaviors overview

A Parameter behavior is applied to a specific object parameter, and the effect is limited to just that parameter. You can apply the same Parameter behavior to different parameters, resulting in different effects. For example, you can apply the Oscillate behavior to the opacity of an object to make the object fade in and out, or you can apply the Oscillate behavior to the rotation of
an object to make the object rock back and forth. You can also apply Parameter behaviors to filter parameters, generator parameters, the parameters of particle systems, or even the parameters of other behaviors.

There are 18 Parameter behaviors:

- **Audio** links any parameter to the dynamic sound properties of an audio file.
- **Average** smooths animation transitions.
- **Clamp** restricts an animated parameter to a minimum and maximum value.
- **Custom** lets you make your own behaviors.
- **Exponential** modifies the speed of animations to create more organic effects.
- **Link** synchronizes the value of one parameter to that of another parameter.
- **Logarithmic** modifies the speed of an animation to create more organic effects.
- **MIDI** lets you edit and animate parameters using a MIDI controller.
- **Negate** inverts a parameter value to its opposite.
- **Oscillate** animates a parameter by cycling it between two values.
- **Quantize** modifies an animation to make parameter values change in incremental steps.
- **Ramp** creates gradual changes in animations.
- **Randomize** creates jittery animations by applying a continuous
- **Audio** links any parameter to the dynamic sound properties of an audio file.
- **Average** smooths animation transitions.
- **Clamp** restricts an animated parameter to a minimum and maximum value.
- **Custom** lets you make your own behaviors.
- **Exponential** modifies the speed of animations to create more organic effects.
- **Link** synchronizes the value of one parameter to that of another parameter.
- **Logarithmic** modifies the speed of an animation to create more organic effects.
- **MIDI** lets you edit and animate parameters using a MIDI controller.
- **Negate** inverts a parameter value to its opposite.
- **Oscillate** animates a parameter by cycling it between two values.
- **Quantize** modifies an animation to make parameter values change in incremental steps.
- **Ramp** creates gradual changes in animations.
- **Randomize** creates jittery animations by applying a continuous
- **Randomize** creates jittery animations by applying a continuous sequence of randomly increasing and decreasing values.
- **Rate** increases a parameter over time.
- **Reverse** reverses the direction of an animated parameter.
- **Stop** abruptly suspends the animation of a parameter.
- **Track** applies motion-tracking data to a parameter of an effect (a filter, for example).
- **Wriggle** creates jittery animations, but with a slower effect than that of the Randomize behavior.

**Audio**

The Audio behavior lets you animate nearly any parameter based on properties of an audio file, such as bass frequency. For example, the Audio parameter behavior can be applied to the Scale parameter of an object, causing the object to scale up and down based on the amplitude of the bass. For more information, see **Apply the Audio parameter behavior**.

**Average**

The Average behavior smooths the transition from one value to another in animations that are keyframed and in behaviors that are applied to a parameter. Use the Average behavior to smooth out animated effects. Averaged motion moves more fluidly, while averaged changes to parameters such as Opacity and to filter parameters appear to happen more gradually. Use the Window Size parameter to adjust the amount of smoothing applied to the
Tip: The Average behavior can be used to smooth out the sequence of values generated by a Randomize behavior.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Window Size**: A slider that adjusts the amount of smoothing applied to the affected parameter, by specifying the number of adjacent frames to average together. Higher values apply more smoothing by averaging a wider range of values, resulting in more fluid animation. Lower values average a narrower range of values, resulting in less smoothing, with values closer to the original.

- **Apply To**: A pop-up menu that displays the parameter affected. You can also use this control to reassign the behavior to a different parameter.

**Clamp**

The Clamp behavior sets a minimum and maximum value for an animated parameter. In the following illustration, the center star has an applied Vortex behavior set to affect the two airplane shapes. As a result, the airplanes circle around the center star, as indicated by the red animation paths.
In the following illustration, a Clamp behavior is applied to the X Position parameter of the outer airplane shape. The Max value is set to 230 and the Min value is set to 0. As a result, the animation path is “clamped”—the image can travel 230 pixels to the right but cannot move left past the 0 point, creating a half-circle animation.

The circle motion path is essentially cut in half. If a negative value is entered in the Min value slider, the image moves past the 0 point.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Clamp At**: A pop-up menu that sets whether the behavior restricts clamping to a minimum value, a maximum value, or both minimum and maximum values.
- **Min**: A value slider that lets you define the minimum amount of
change for an animated parameter.

- **Max**: A value slider that lets you define the maximum amount of change for an animated parameter.

  The value is represented as a percentage, in pixels, or in degrees, depending on the parameter assignment. For example, if Clamp is applied to the Rotation parameter, the Min and Max values are degrees. If Clamp is applied to the X Position parameter, the values are in pixels.

- **Apply To**: A pop-up menu that shows the parameter affected, and that can be used to reassign the behavior to another parameter.

### Custom

The Custom behavior lets you make your own behaviors by creating a set of parameters, then keyframing them to create the type of animation you want to apply to an object. By saving custom behaviors you create in the Library, you can build your own collection of behaviors to suit your needs.

The Custom behavior is not applied like the other Parameter behaviors described in this section. Rather, you apply the Custom behavior like any other non-Parameter behavior in Motion: by dragging it from the Library onto an object in the Canvas or Layers list, or by selecting an object in the Canvas or Layers list, then choosing Custom from the Add Behavior pop-up menu.

**Note**: Although the Custom behavior is a Parameter behavior, it does not appear in the shortcut menu when you Control-click a parameter.
Unlike other behaviors, the Custom behavior doesn’t apply default parameters in the Behaviors Inspector. Instead, a pair of pop-up menus lets you add and remove any parameters you want to use.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Add Parameter**: A pop-up menu used to add parameters you want to keyframe to create custom animation. Choose a parameter from this menu to add it to the Custom parameter list for keyframing.

- **Remove Parameter**: A pop-up menu listing parameters you’ve added to the current Custom behavior. Choose a parameter from this menu to remove it from the Custom parameter list, along with any keyframes applied to that parameter.

SEE ALSO

**Add a Custom behavior**

Add a Custom behavior

Before adding custom parameters to a Custom behavior, you must apply the Custom behavior to an object in your project.

### Add a Custom behavior to an object

1. Do one of the following:
- Select the object you want to add a Custom behavior to, click the Add Behavior pop-up menu in the toolbar, then choose Parameter > Custom.

- In the Library, select the Behaviors category, select the Parameter subcategory, then drag the Custom icon to the object in the Canvas, Layers list, or Timeline.

The Custom behavior is applied to the object. The behavior has no effect until you add a parameter to the behavior.

2. In the Custom area of the Behaviors Inspector, click the Add Parameter pop-up menu, then choose a parameter to add.

This menu contains every animatable parameter.

The parameter you chose appears near the top of the Custom area in the Behaviors Inspector.

After you add the parameters to animate in your Custom behavior, you can keyframe them in the Keyframe Editor to create whatever animated effect you require. For more information on keyframing parameters to create animation, see Apply keyframes to behaviors.
After you animate the parameters you added, you can save the Custom behavior into the Library for future use. For more information about saving Custom behaviors to the Library, see Save custom behaviors.

Remove a parameter from the Custom parameter list

- Click the Remove Parameter pop-up menu, then choose a parameter to remove.

That parameter no longer appears in the Custom parameter pop-up menu. Any keyframes applied to that parameter are deleted.

SEE ALSO

Custom

Exponential

The Exponential behavior creates more natural animations when scaling objects, especially when using high values. For example, when an object scales from very small to very large, our eyes
erroneously perceive the animation to slow down as the object reaches its upper scale values. The Exponential parameter behavior allows such an animation to speed up the scaling as the values increase to compensate for that illusion, and create a more uniform-looking scale effect.

**Tip:** When applied to parameters other than Scale, the Exponential parameter behavior creates more organic animations than other interpolation modes.

You can also change the interpolation modes of keyframes to Exponential. For more information, see [Set curve interpolation](#).

Adjust this behavior using the controls in the Behaviors Inspector:

- **Start Value**: A slider to set the value that’s added to the parameter at the first frame of the Exponential behavior.
- **End Value**: A slider to set the value the Exponential behavior reaches at the last frame of the behavior. Over the life of the behavior, the parameter the Exponential behavior is applied to makes a transition from the Start Value to the End Value, plus the original value.
- **Start Offset**: A slider to delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior start later.
- **End Offset**: A slider to offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the
behavior bar resets the object to its original parameter.

- **Apply To**: A pop-up menu that shows the parameter affected, and that can be used to reassign the behavior to another parameter.

**Link**

The Link behavior forces the value of one parameter to match that of another “linked” parameter. The source parameter can be attached to the same object or to another object. The linked parameters must contain numerical data. Parameters controlled by checkboxes, menus, and other non-numeric values cannot be linked. The linked parameters also must contain the same number of attributes. You cannot link a compound parameter such as Scale X-Y-Z to a parameter such as Opacity, which has only one slider. You can however, link a compound parameter such as Scale X-Y-Z to Position X-Y-Z.
The values of the source parameter can be scaled to more accurately apply to the destination parameter. For example, a source parameter with a range of 1–100 can be scaled when applied to a parameter with a range of 0–1. The values can also be offset from the source, and the effect can be mixed with the destination value to create different effects.

The Link behavior can be applied to a parameter animated with behaviors or keyframes; however, the Link behavior does not affect the parameter when the Start Values or End Values are zero.

When using the Link behavior to control an object’s position parameter, the linked coordinates are based on the center point of the current group. So when an object is linked to another object in the same group, it shares an identical position. However, if the source object is in a different group, the coordinates might appear offset in space.

If your goal is to match an identical position across groups with different center points, you can create an invisible dummy object in the group containing the source, link it to the source object, then use the Match Move behavior to copy the dummy object’s position to that of the intended target. Match Move compensates for inter-group position offsets and provides the option to attach one object to another or to mimic the source object’s transformations. For more information about the Match Move behavior, see Match moving overview.

You can also link to the group’s coordinates instead of the object’s, and use the Offset parameters in the Link behavior to obtain the position you want. However, if that group is subsequently added to another group, the linked object might not
move as expected.

**Note:** When a link behavior is added, it’s not enabled by default. To activate the behavior, click the activation checkbox beside the behavior name in the Behaviors Inspector.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Source Object:** An object well that defines the source object in which the source parameter resides. Click the To pop-up menu to select a source object in the current project.

- **Source Parameter:** A pop-up menu showing the parameter that serves as the source for the Link behavior. Use this menu to select a new source parameter. Only parameters with the same value type and number of attributes as the parameter selected in the Apply To (Target Parameters) pop-up menu appear here.

**Note:** When possible, Source Parameter defaults to the parameter chosen in the Apply To row (described below).

**Important:** Changing the Apply To (Target Parameters) setting changes which parameters appear in the Source Parameter pop-up menu. If you cannot find the parameter you’re looking for, you might need to choose a Target Parameter to which you can link.

- **Apply To:** A pop-up menu showing the parameter affected. Use this menu to reassign the behavior to another parameter.

- **Apply Mode:** A pop-up menu that sets how the values from the source parameter affect the target parameter. The choices include:
  - **Add to source:** Adds the source parameter value to the
• **Multiply by source:** Multiplies the source parameter value with the existing value of the target parameter.

• **Replace with source:** Replaces the existing value of the target parameter with that of the source parameter.

• **Mix Over Time:** A pop-up menu that sets how rapidly the source parameter values begin to affect the target parameter. Options include: Ease In, Ease Out, Ease In/Out, Accelerate, Decelerate, Accelerate/Decelerate, and Custom Mix.

• **Mix Time Range:** A slider (available when the Mix Over Time pop-up menu is set to an Ease or Acceleration option) that controls the number of frames over which the ease or acceleration occurs.

**Tip:** Ease In and Accelerate begin at the In point of the Link behavior; Ease Out and Decelerate end at the Out point of the Link behavior. Therefore, you can trim the Link behavior in the Timeline to specify where the ease or acceleration begins or ends.

• **Custom Mix:** A slider (available when the Mix Over Time parameter is set to Custom Mix) that can be animated to create a user-determined mix between the source and target parameter values.

• **Scale:** A slider that specifies a value to be multiplied with the Source Parameter before it is applied to the target.

• **Apply Link When:** A pop-up menu that limits when values from the source are applied to the target. There are five choices:

  • **Any source value:** No limits are placed on the source parameter values. An offset slider for each setting
associated with the source parameter appears at the bottom of the Behaviors Inspector. If the source parameter has a single slider, such as Opacity, a single offset slider appears. If the source parameter has multiple sliders, such as Position X-Y-Z, offset sliders for each of those settings appear.

- **Source value above minimum:** The link applies only when the source value exceeds a defined minimum value. If the source value falls below the defined minimum, the link behavior stops. When selected, the Clamp Source Values Within Range checkbox as well as offset and minimum sliders for each setting associated with the source parameter appear at the bottom of the Behaviors Inspector. If the source parameter has a single slider, such as drop shadow Blur, an offset and a minimum slider appear for that setting. If the source parameter has multiple sliders, such as Scale X-Y-Z, offset and minimum sliders appear for each of those settings.

- **Source value below maximum:** The link applies only when the source value stays below a defined maximum value. If the source value exceeds the defined maximum, the link behavior stops. When selected, the Clamp Source Values Within Range checkbox as well as offset and maximum sliders for each setting associated with the source parameter appear at the bottom of the Behaviors Inspector. If the source parameter has a single slider, such as shape Roundness, an offset and a maximum slider appear for that setting. If the source parameter has multiple sliders, such as Rotation X-Y-Z, offset and maximum sliders appear for each of those settings.

- **Source value between min and max:** The link applies only when the source value stays within the defined minimum and maximum values. When selected, the Clamp Source Values Within Range checkbox as well as offset and range sliders for each setting associated with the source parameter appear at the bottom of the Behaviors Inspector. If the source parameter has a single slider, such as stroke color, an offset and a range slider appear for that setting. If the source parameter has multiple sliders, such as scale X-Y-Z, offset and range sliders appear for each of those settings.
• **Source value between min and max:** The link applies only when the source value stays within a defined range. If the source value falls below the defined minimum, or exceeds the defined maximum, the link behavior stops. When selected, the Clamp Source Values Within Range checkbox as well as offset, minimum, and maximum sliders for each setting associated with the source parameter appear at the bottom of the Behaviors Inspector. If the source parameter has a single slider, such as shape Feather, one set of three sliders (offset, minimum, and maximum) appears for that setting. If the source parameter has multiple sliders, such as Fill Color (red, green, blue), sets of three sliders appear for each of those settings.

• **Source value outside min and max:** The link applies only when the source value stays outside of a defined range. If the source value falls above the defined minimum, or below the defined maximum, the link behavior stops. When selected, the Clamp Source Values Within Range checkbox as well as offset, minimum, and maximum sliders for each setting associated with the source parameter appears at the bottom of the Behaviors Inspector. If the source parameter has a single slider, such as outline Width, one set of three sliders (offset, minimum, and maximum) appears for that setting. If the source parameter has multiple sliders, such as Shear X-Y, sets of three sliders appear for each of those settings.

• **Clamp Source Value Within Range:** A checkbox that becomes available when the Apply Link pop-up menu is set to a choice requiring a minimum or maximum value. When selected, values that exceed the defined range are pinned to the highest or lowest allowable setting.
- **(Parameter) offset**: A slider that lets you create a constant offset between the source parameter value and the value applied to the target parameter.

- **(Parameter) min**: One or more sliders that become available when the Apply Link When pop-up menu is set to “Source value above minimum,” “Source value between min and max,” or “Source value outside min and max.” A “min” slider appears for each component of the source parameter. Adjusting this slider defines a minimum value to limit when the link behavior is active.

- **(Parameter) max**: One or more sliders that become available when the Apply Link When pop-up menu is set to “Source value below maximum,” “Source value between min and max,” or “Source value outside min and max.” A “max” slider appears for each component of the source parameter. Adjusting this slider defines a maximum value to limit when the link behavior is active.

---

**Logarithmic**

The Logarithmic behavior is the inverse of the Exponential behavior. Like the Exponential behavior, it creates more natural animations when scaling objects, especially when using high values. The Logarithmic parameter behavior applies a mathematical function to create a logarithmic curve (rather than linear) between the two values—the effect ramps up quickly, and then the effect slows down. This allows the animation to progress slowly when the scale values are small and speed up when the scale values are large. When applied to parameters other than Scale, the Logarithmic parameter behavior creates more organic...
animations than other interpolation modes.

The Logarithmic behavior can be applied to parameters animated with behaviors or keyframes; however, Logarithmic does not affect the parameter unless the Start Values or End Values are nonzero.

**Note:** You can also change the interpolation modes of keyframes to Logarithmic. For more information, see Set curve interpolation.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Start Value:** A slider that sets the value added to the parameter at the first frame of the Logarithmic behavior.
- **End Value:** A slider that sets the value of the Logarithmic behavior at the last frame. Over the life of the behavior, the parameter that the Logarithmic behavior is applied to makes a transition from the Start Value to the End Value, plus the original value.
- **Start Offset:** A slider that delays the beginning of the behavior’s effect relative to the first frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior start later.
- **End Offset:** A slider that offsets the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior bar resets the object to its original parameter.
- **Apply To:** A pop-up menu that shows the parameter affected.
MIDI

The MIDI behavior lets you edit and animate object parameters using standard MIDI devices, such as a synthesizer. For the true motion graphics mixmaster.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Control Type**: A pop-up menu that sets the mode of the MIDI controller. There are three modes:
  - **Note**: Use this mode when the control is a keyboard key on the MIDI device.
  - **Controller**: Use this mode when the control is a knob, dial, key, slider, or foot pedal on the MIDI device.
  - **Learning**: Use this mode to “teach” Motion which control (such as a knob, dial, or key) you want to use on the MIDI device to manipulate the parameter to which the MIDI behavior is applied. When in Learning mode, the first knob, dial, or key that you adjust on the MIDI device is set as the control.

  **Note**: When the MIDI behavior is first applied, Learning is the default control type.

- **ID**: A slider that displays the identification number of the MIDI control (such as a knob, dial, or key) that you are manipulating.

- **Value**: A slider that displays the standard MIDI value between
- **Value**: A slider that displays the standard MIDI value between 0 and 1 when you’re manipulating the MIDI control.

- **Scale**: A slider that multiplies the Value parameter in the MIDI behavior. This means that when Scale is increased, the MIDI control has a larger range of value and a greater effect on the parameter it’s controlling. For example, when you use a knob to adjust an object’s rotation, the default rotation value range (when Scale is set to 1) for a full turn of the knob might only be 30 percent. When the Scale value is increased to 13, the rotation value of a full turn of the knob is increased to 370 degrees.

- **Apply To**: A pop-up menu (parameter assignment control) that shows the parameter affected, and that can be used to reassign the behavior to another parameter.

**SEE ALSO**

*Add a MIDI behavior*

---

**Add a MIDI behavior**

You apply the MIDI behavior in the same way as all other Parameter behaviors. In the following examples, the MIDI behavior is used to adjust an object’s opacity and rotation.

**Note**: This behavior can only be used if you have a MIDI device correctly connected to your computer.

---

**Use the MIDI behavior to adjust an object’s opacity**
1. Select an object, then locate the Opacity parameter in the Properties Inspector.

2. Control-click the parameter, then choose Add Parameter Behavior > MIDI from the shortcut menu.

   The MIDI parameters are displayed in the Behaviors Inspector. By default, Control Type is set to Learning.

   ![MIDI Behaviors Inspector](image.png)

   Like all other Parameter behaviors, the Apply To field displays the parameter to which the behavior is applied.

3. On your MIDI device, tweak the control (such as the knob, dial, or key) you want to use as the controller for the Opacity parameter.

   The identification number of the MIDI control is displayed in the ID field. The value range of the control is 0 to 127, the default MIDI control value.

   Because an object’s opacity can only fall between 0 (completely transparent) to 100 (completely opaque), the default MIDI values are sufficient to adjust the parameter.

   **Note:** When in Learning mode, the first control adjusted on the MIDI device is set as the control. To reset the selected controller,
choose Learning from the Control Type pop-up menu, then adjust another control on the MIDI device.

Use the MIDI behavior to adjust an object’s rotation

1. Select an object, then locate the Rotation parameter in the Properties Inspector.

2. Control-click the parameter, then choose Add Parameter Behavior > MIDI from the shortcut menu.

3. On your MIDI device, tweak the control (knob, dial, key, and so on) you want to use as the controller for the Rotation parameter.

   As mentioned above, the default Value range is 0 to 1. Because the Rotation value of an object can be much larger, you can use the Scale parameter to multiply the Value range.

4. To give the control more sensitivity, increase the Scale value.

SEE ALSO

MIDI

Negate

The Negate behavior inverts the value of each keyframe and
behavior effect in the parameter to which it’s applied by multiplying the parameter by \(-1\). The Negate behavior basically flips each parameter value to its opposite. Animation paths are flipped, rotation is reversed, and any effect’s parameter is changed to its opposite.

For example, applying the Negate behavior to the Position parameter of an object with an animation path results in the animation path moving to the opposite quadrant of the Canvas.

![Animation path before and after Negate behavior](image)

**Note:** If you want to reverse the motion taking place on an animation path, rather than flipping the shape of the animation path itself, use the Reverse parameter behavior.

Adjust this behavior using the control in the Behaviors Inspector:

- **Apply To:** A pop-up menu that shows the parameter affected, and that can be used to reassign the behavior to another parameter.

---

**Oscillate**

The Oscillate behavior animates a parameter by cycling it between two values. You can customize how wide apart the high
and low values are as well as the number of oscillations per minute. The Oscillate behavior can create all kinds of cyclical effects. For example, if you apply the Oscillate behavior to the rotation property of an object, it will rock back and forth. This happens because the rotation property cycles back and forth between the original rotation value plus and minus the Amplitude value that’s set in the Oscillate behavior.

Applying the Oscillate behavior to the X value of the Scale parameter instead causes the width of the object to cycle, and it repeatedly stretches and compresses for the duration of the behavior.

The Oscillate behavior is additive, meaning that the value generated by this behavior is added to the original value of the parameter to which it’s applied.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Wave Shape**: A pop-up menu that sets the shape of the oscillation’s wave. There are four shapes:
  - **Sine**: The default wave shape, creates a smooth animation between values. For example, if Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to Sine, the object gracefully fades in and out.
  - **Square**: Creates abrupt changes in values. For example, when Oscillate is applied to an object’s Opacity parameter,
and the Wave Shape is set to Square, the object flashes on and off (like turning a light switch on and off).

- Sawtooth: Ramps upward over time and then drops sharply. For example, when Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to Sawtooth, the object fades in slowly and fades out abruptly (like using a light dimmer to fade up a light, and then flicking the power switch off).

- Triangle: Similar to the sine wave, creates a smooth animation between values but with sharper changes at the transitions. For example, when Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to Triangle, the object fades in and out more acutely than it does with the Sine Wave setting.
• **Phase:** A slider that sets the point of the specified oscillation where the behavior starts. This parameter lets you put multiple objects with identical Oscillate behaviors out of phase with one another so they don’t all look the same.

• **Amplitude:** A slider that sets the maximum values between which the parameter oscillates. The parameter swings between the amplitude value and the negative of the amplitude value. Higher values result in more extreme swings from the beginning to the ending of each oscillation.

• **Speed:** A slider that sets the speed at which the oscillation occurs, in oscillations per minute. Higher values result in faster oscillations.

• **Half Range:** A checkbox that, when selected, cuts the sine wave (or other wave shape) in half and prevents it from crossing the value of 0. For example, when Amplitude is set to 100, the parameter oscillates between 100 and –100. When Half Range is selected, however, the parameter oscillates between 100 and 0. When Amplitude is set to –100, the parameter oscillates between –100 and 0.

**Tip:** When you’re oscillating position parameters, set Wave Shape to Sine and enable Half Range to create a bouncing effect.

• **Start Offset:** A slider that delays the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start
later. The units of this parameter are in frames.

- *End Offset*: A slider that offsets the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior bar resets the object to its original parameters.

- *Apply To*: A pop-up menu that shows the parameter affected, and that can be used to reassign the behavior to another parameter.

SEE ALSO

Create a decaying oscillation

Create a decaying oscillation

When you apply the Oscillate behavior to an object’s rotation or position, a common effect is to “decay” or “dampen” the animation over time. This means that the animation gradually slows or comes to a stop. You can achieve this effect using keyframes to slow the amplitude of the oscillation.

Decay an oscillating rotation using keyframes

1. Go to the frame where you want the animation to begin, then
press A to enable keyframe recording.

2. In the Oscillate section of the Behaviors Inspector, set the Amplitude to the maximum value you want to use in your project.

**Note:** When keyframe recording is enabled, any value change to a parameter using the Inspector, HUD, or Canvas creates a keyframe.

3. Go to the frame where you want the animation to come to a stop and set the Amplitude value to 0.

When the object is selected, you can see the dampening of the animation—caused by the keyframed Amplitude parameter—in the Keyframe Editor (when Animated is chosen from the pop-up menu above the Keyframe Editor). The following illustration shows the keyframed Amplitude parameter of the Oscillate behavior superimposed over the resulting change to the Oscillate curve itself. For more information, see **Display the Keyframe Editor** and **Keyframe Editor controls**.

**Note:** The Oscillate behavior must be selected for its curve to be
Quantize

The Quantize behavior creates an incremental animation in any keyframed or behavior-influenced parameter. For example, if opacity is animated so an object gradually fades in over time, you can add the Quantize behavior to make the object become opaque in steps.

**Note:** The Quantize behavior only works with animated parameters.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Step Size:** A value slider that defines the size of the steps, based on the units of the parameter to which it’s applied. For example, when Quantize is applied to rotation, the steps are in degrees (even though this parameter is not a dial control). When applied to position, the steps are in pixels.

The left image below shows the projected path (the red line) of a layer with an applied Throw behavior. The right image displays the same animation path after the Quantize behavior is added. In this example, the Step value is set to 90.
• **Offset**: A slider that offsets the steps. For example, when Quantize is applied to a Position parameter and Step Size is set to 100, an object “steps” in increments restricted to 100 pixels; thus, the step offset is 100, 200, 300, and so on. If Offset is set to 50, the step offset is restricted to 50, 150, 250, and so on.

• **Apply To**: A pop-up menu that shows the parameter affected, and that can be used to reassign the behavior to another parameter.

---

**Ramp**

The Ramp behavior creates a gradual transition in any parameter that can be animated, from the Start Value to the End Value. The speed of the transition is defined by the length of the Ramp behavior in the Timeline, and by the behavior’s end value. Additional parameters allow you to define how the transition occurs; whether it’s at a single, continuous speed; or whether it accelerates over time.

Ramp is a versatile behavior. If you apply it to the Scale property, it works like the Grow/Shrink behavior. If you apply it to the Opacity property, you can fade an object in or out in different
ways. Although you can use the Ramp behavior to mimic other Motion behaviors, it can be applied to any parameter. It’s an additive behavior, meaning that the value it generates is added to the original value of the parameter to which it’s applied.

For example, to animate different segments of a bar graph so each segment grows to a specific length, apply the Ramp behavior to the each bar’s Crop parameter. After you arrange the different bars with their starting Crop values, the Ramp behaviors move the Top Crop parameter up, giving the illusion that each bar is growing. Set the End Value parameter of each Ramp behavior to the length you want each bar to reach, and you’re done!

Adjust this behavior using the controls in the Behaviors Inspector:

- **Start Value**: A slider to set the value that’s added to the parameter at the first frame of the Ramp behavior.
- **End Value**: A slider that sets the value the Ramp behavior reaches at the last frame of the behavior. Over the life of the behavior, the parameter that the Ramp behavior is applied to transitions from the Start Value to the End Value, plus the original value.
- **Curvature**: A slider that eases the acceleration at which the
Ramp behavior transitions from the Start Value to the End Value. Higher Curvature values result in an ease in/ease out effect, where the transition begins slowly, gradually speeds up as the behavior continues, then gradually slows to a stop as it reaches the end. Because Curvature is defined by the length of the behavior in the Timeline, this parameter does not affect the overall duration of the effect.

- **Start Offset:** A slider that delays the beginning of the behavior’s effect relative to the first frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior start later.

- **End Offset:** A slider that offsets the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior bar resets the object to its original parameter.

- **Apply To:** A pop-up menu that shows the parameter affected, and that can be used to reassign the behavior to another parameter.

### Randomize

The Randomize behavior creates a continuous sequence of randomly increasing and decreasing values, based on the parameters defining the range and type of values generated. Use Randomize to create jittery effects, such as twitchy rotation, flickering opacity, and other effects requiring rapid and varied
changes over time that would be time-consuming to keyframe.

Although the values created with this behavior appear to be random, they’re predetermined by the parameter settings you’ve chosen. As long as you don’t change the parameters, the frame-by-frame values created by this behavior remain the same. If you don’t like the randomly generated values, click the Generate button in the Behaviors Inspector to pick a new random seed number. This number is used to generate a new sequence of values.

The Apply Mode parameter determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Randomize behavior to modify a parameter’s preexisting values.

The Randomize behavior can be modified with other behaviors, such as Average and Negate, to exercise further control over the values generated.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Amount**: A slider (available when the Apply Mode—described below—is set to Add, Subtract, or Add and Subtract) that defines the maximum value the Randomize behavior will generate.

- **Multiplier**: A slider (available when the Apply Mode—described below—is set to Multiply) that defines the maximum value the Randomize behavior will generate.

- **Apply Mode**: A pop-up menu that determines how values generated by this behavior are combined with other behaviors
and keyframes that affect the same parameter. Choose Add, Subtract, Multiply, or Add and Subtract.

- **Frequency**: A slider that sets the amount of random variation per second. Higher values generate faster variations; lower values generate slower variations.

- **Noisiness**: A slider that adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected parameter.

- **Link**: A checkbox, available when you apply Randomize to a two-dimensional parameter (such as Scale) or to a three-dimensional parameter (such as Position) that consists of X, Y, and/or Z values. Select this checkbox to keep the behavior’s effect on each value proportional.

- **Affect Subobjects**: A checkbox (available when you apply Randomize to a parameter of the Sequence Replicator behavior) that, when selected, gives each replicated cell in the Canvas a different random behavior. When Affect Subobjects is deselected, each object undergoes the same animation.

- **Random Seed**: A button that picks a new random seed number. This number is used to generate new sequences of values, based on the other parameters of this behavior.

- **Start Offset**: A slider that delays the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. The units of this parameter are in frames.

- **End Offset**: A slider that offsets the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline. Using this
slider to stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior bar resets the parameter to its original value.

- **Apply To**: A pop-up menu shows the parameter affected, and that can be used to reassign the behavior to another parameter.

## Rate

The Rate behavior increases a parameter’s value over time, with the rate of increase determined by the Rate slider. Unlike the Ramp behavior, this behavior has no end value, but continues to increase or decrease the parameter it’s applied to until the end of the parameter.

**Note**: To decrease a parameter over time, enter a negative value into the Rate parameter.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Rate**: A slider that sets a rate of increase over time for the affected parameter, measured in percentage increase per second.

- **Curvature**: A slider that eases the acceleration at which the Rate behavior transitions from the Start Value to the End Value. Higher Curvature values result in an ease in/ease out effect, beginning slowly, gradually speeding up as the behavior continues, then gradually slowing to a stop as it reaches the end. Because Curvature is defined by the length...
of the behavior in the Timeline, this parameter does not affect
the overall duration of the effect.

- **End Offset:** A slider that offsets the end of the behavior’s
effect relative to the last frame of its position in the Timeline, in
frames. Adjust this parameter to make the behavior stop
before the end of the behavior bar in the Timeline. Using this
slider to stop the effect, instead of trimming the end of the
behavior bar in the Timeline, freezes the last random value
generated by this behavior for the remaining duration of the
object. Trimming the end of the behavior bar resets the
parameter to its original value.

- **Apply To:** A pop-up menu that shows the parameter affected,
and that can be used to reassign the behavior to another
parameter.

### Reverse

Unlike the Negate behavior, which inverts the value of the
parameter to which it’s applied, the Reverse behavior reverses
the direction of any animation that affects a parameter, whether
it’s caused by behaviors or keyframes. For example, when you
apply the Reverse behavior to path animation that begins at the
left and moves to the right, the animation path won’t move, but
the object instead begins at the right and moves to the left. The
Reverse behavior basically switches the beginning and ending
points of animated objects.

Adjust this behavior using the control in the Behaviors Inspector:

- **Apply To:** A pop-up menu that shows the parameter affected,
and that can be used to reassign the behavior to another
Stop

The Stop behavior suspends parameter animation (created by keyframes or applied behaviors) of an object. For example, if you assign the Stop parameter behavior to the Position parameter of an object moving across the screen and rotating, the object ceases to move across the screen but continues to rotate.

Each behavior’s effect on the object is frozen at the first frame of the Stop behavior in the Timeline. Keyframes applied to that parameter cease to have any effect for the duration of the Stop behavior in the Timeline. If the Stop behavior is shorter than the object to which it’s applied, all keyframes and behaviors affecting that channel immediately take effect after the last frame of the Stop behavior. For more information, see Stop a behavior.

Adjust this behavior using the control in the Behaviors Inspector:

- **Apply To:** A pop-up menu that shows the parameter being stopped, and that can be used to reassign the Stop behavior to another parameter.

Track

The Track behavior applies tracking data to a parameter of an effect, such as the center point of the Light Rays filter. For more information on using the Track behavior, see Track a filter’s position parameter.
Wriggle

The Wriggle behavior works similarly to the Randomize behavior, but with a slower effect.

Tip: A Wriggle behavior applied to an Opacity parameter set to 100% does not have much effect. This is because there isn’t much room to “wriggle.” For a better result, set the Opacity to 0, or change the Apply Mode to Subtract.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Amount/Multiplier**: A slider that defines the maximum value that the Wriggle behavior generates. The Amount slider is available when the Apply Mode is set to Add, Subtract, or Add and Subtract. The Multiplier is available when the Apply Mode is set to Multiply.

- **Apply Mode**: A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Wriggle behavior to modify a parameter’s preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

- **Frequency**: A slider that sets the amount of random variation per second. Higher values generate faster variations, whereas lower values generate slower variations.

- **Wriggle Offset**: A slider that offsets the sequence of random values when you want to apply the same Wriggle behavior to multiple objects. By offsetting each object’s version of the Wriggle behavior, you can prevent objects from moving in sync.

- **Noisiness**: A slider that adds an additional overlay of random
Noisiness: A slider that adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected parameter.

Link: A checkbox, available when you apply the Wriggle behavior to a two-dimensional parameter (such as Scale) or three-dimensional parameter (such as Position) that consists of X, Y, and/or Z values. Select this checkbox to keep the behavior’s effect on each value proportional.

Affect Subobjects: A checkbox, available when the Wriggle behavior is applied to a parameter of the Sequence Replicator behavior. When Affect Subobjects is selected, each object has a different wriggle behavior. When Affect Subobjects is deselected, each object undergoes the same animation.

Random Seed: A button that picks a new random seed number. This number is used to generate new sequences of values, based on the other parameters of this behavior.

Start Offset: A slider that delays the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is measured in frames.

End Offset: A slider that offsets the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the end of the behavior bar in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior bar resets the parameter to its original value.

Apply To: A pop-up menu that shows the parameter affected,
Retiming behaviors

Retiming behaviors overview

When you select a clip, a group of Timing parameters appears in the Properties Inspector. These controls adjust some of the same effects as the Retiming behaviors, such as slowing down or speeding up, looping, or reversing a clip. However, the Timing controls affect the entire clip. The Retiming behaviors, on the other hand, let you define which portion of the clip is modified by a timing change. Any timing changes made to a clip using the Inspector’s Timing controls are respected by the Retiming behaviors. For example, if you changed the speed of the clip to 50% in the Properties Inspector, a Retiming behavior uses that half-speed clip as its source. For more information on Timing controls in the Properties Inspector, see Retime media overview.

There are 11 Retiming behaviors:

- **Flash Frame** inserts a range of random frames into the playback of a clip.
- **Hold Frame** freezes the frame at the behavior’s In point.
- **Loop** replays a segment of a clip.
- **Ping Pong** replays a segment of a clip backward and then forward.
- **Replay** triggers playback of a clip segment that begins at a
different frame in your project.

- **Reverse** plays a clip or image sequence backwards.
- **Reverse Loop** replays a segment of a clip in reverse.
- **Scrub** moves a virtual playhead around a clip.
- **Set Speed** changes the playback rate of a clip.
- **Strobe** simulates the look of a strobe light or lower-frame-rate video.
- **Stutter** randomly inserts hold frames, of random durations, into the playback of a clip.

## Flash Frame

The Flash Frame behavior inserts a user-defined range of random frames (adjacent to the current frame) into the playback of a clip.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Random Frames**: A slider that sets the probability that a frame within the duration of the behavior is replaced with a random frame. When this value is set to 0, no random frames are inserted. When set to 100, every frame is random. The default value is 10%.

- **Frame Range**: A slider that defines the range from which the random frames are chosen, based around the current frame. The default value is 10 frames.

- **Duration**: A slider that sets the duration of the sequence of random frames. The default value is 1, which means one random frame is inserted at a time. When Duration is set to
30, for example, 30-frame sequences (chosen from the Frame Range) are randomly inserted. The Duration value overrides the Random Frame count (so a new random frame does not interrupt the sequence).

- **Random Seed**: A button that picks a new random seed number. This number is used to generate new values, based on the other parameters of this behavior.

## Hold Frame

The Hold Frame behavior holds the frame at the behavior’s In point for the duration of the behavior. The clip continues playing normally after the behavior’s Out point. For example, if the Hold Frame behavior begins at frame 60 and ends at frame 300, the clip plays normally until frame 59, frame 60 is held for 240 frames, and then normal playback resumes—frame 61 of the clip—at frame 301.

The Hold behavior is applied at the current frame, rather than at the start of the object.

Adjust this behavior using the control in the Behaviors Inspector:

- **Offset**: A slider that sets the offset for the hold frame. When set to 0 (the default), the frame at the start of the behavior is the hold frame. When set to 60, however, the frame at the start of the behavior (the hold frame) is the start frame plus 60 frames. This parameter is measured in frames.

**Tip**: Flickering may occur if the Hold Frame behavior is applied to interlaced footage. To avoid this, ensure that Field Order is properly set in the Inspector. To change field order,
select the footage in the Media list, open the Media pane in the Inspector, then choose a field order option from the Field Order pop-up menu. See Source media controls in the Media Inspector.

Loop

The Loop behavior loops a segment of the clip within the duration of the behavior. The loop’s starting frame is derived from the start frame of the behavior. For example, if the behavior is applied at the start of a clip, and Loop Duration is set to 30, the first 30 frames of the clip loop repeatedly until the end of the behavior. At the end of the behavior, normal playback resumes from the frame at the end of the loop duration.

Adjust this behavior using the control in the Behaviors Inspector:

- **Loop Duration**: A slider that sets the duration of the looped frames. The default value is 30 frames.

Ping Pong

The Ping Pong behavior “ping-pons” playback of a segment of the clip within the duration of the behavior. The ping-pong effect’s starting frame is derived from the start frame of the behavior. For example, if the behavior is applied at the start of a clip, and Duration is set to 30, the first 30 frames of the clip play forward, then play in reverse, then forward, and so on until the end of the behavior. At the end of the behavior, normal playback resumes.

Adjust this behavior using the control in the Behaviors Inspector:

- **Duration**: A slider that sets the duration of the ping-pong.
• **Duration**: A slider that sets the duration of the ping-pong frames. The default value is 30 frames.

---

# Replay

The Replay behavior resets the playhead at the beginning of the behavior to a specific frame, then plays the clip normally from that frame. The clip plays back normally after the end of the behavior. Use this behavior to trigger playback of the clip at different times, without making multiple copies of the movie object.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Start From**: A pop-up menu that determines whether the replay starts from an absolute frame number or an offset from the frame at the start of the behavior. There are two menu items:
  - **Absolute Frame**: Sets the replay to start at the frame specified in the Start Time parameter. For example, if the behavior starts at frame 60 of the clip and Start Frame is set to 30, when playback reaches frame 60, the clip starts playback over from frame 30.
  - **Offset Frame**: Offsets the start frame of the replay. For example, if the behavior starts at frame 60 of the clip, and Start Frame is set to 30, when playback reaches frame 60, the clip starts playback at frame 90. If Start Frame is set to –30, the clip starts playback over from frame 30.
- **Start Time**: A slider that sets the start frame where the replay begins. The default is frame 1.
Reverse
The Reverse behavior plays the clip or image sequence backwards.

There are no parameters for this behavior.

Reverse Loop
The Reverse Loop behavior loops a segment of the clip in reverse within the duration of the behavior. If Loop Duration is set to 30 and the behavior begins at frame 1, frames 1–30 are played in reverse, then frames 31–60 are played in reverse, frames 61–90 are played in reverse, and so on.

Tip: To achieve a nice stutter effect, set Loop Duration to 2.

Adjust this behavior using the control in the Behaviors Inspector:
- *Loop Duration*: A slider that sets the duration of the looped frames to be played in reverse. The default value is 30 frames.

Scrub
Like the Scrub filter, the Scrub behavior moves a virtual playhead around a clip, allowing you to change the timing of the clip without moving it in the Timeline. Additionally, the Scrub behavior lets you animate the offset parameter using keyframes or Parameter behaviors, often with interesting results. Try applying the Oscillate behavior to the Frame offset, with the Offset From parameter set to Current Frame. Scrub does not affect clip audio.
Note: You can also apply Parameter behaviors to the Retime Value parameter in the Timing controls for the clip object. The Timing controls are located in the Properties Inspector. Time Remap must be set to Variable Speed to access the Retime Value parameter.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Frame Offset**: A slider that sets the offset of the virtual playhead.
- **Offset From**: A pop-up menu that sets the position where the virtual playhead is offset. There are two menu items: First Frame or Current Frame.

### Set Speed

The Set Speed behavior lets you change the speed (playback rate) of a clip. The speed specified in the behavior begins at the behavior’s In point and exists for the duration of the behavior. The clip continues playing at its default speed after the behavior’s Out point. For example, if the Set Speed behavior begins at frame 60 and ends at frame 300, the clip plays normally until frame 59, plays back at the rate specified in the behavior from frame 60 to frame 300, then resumes its default playback speed at frame 301. You can apply an ease-in or ease-out effect to the speed change.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Speed**: A slider that sets the speed of the clip as a percentage. The default is 100% (the clip’s normal speed). A Speed setting of 50% plays the clip at half speed.

Note: The Speed parameter can be keyframed to create
Note: The Speed parameter can be keyframed to create variable playback rate changes.

- **Ease In Time**: A slider that sets the number of frames over which the ease-in speed change occurs (from the start of the behavior). The default value is 20 frames.

- **Ease In Curve**: A slider that defines the curvature of the ramp when easing into the speed change. A value of 0 creates a sharp transition to the new speed; a value of 100 creates the smoothest ease in to the new speed. The default is 50%.

- **Ease Out Time**: A slider that sets the number of frames over which the ease-out speed change occurs (from the end of the behavior). The default value is 20 frames.

- **Ease Out Curve**: A slider that defines the curvature of the ramp when easing out of the speed change. A value of 0 creates a sharp transition from the new speed to the original speed; a value of 100 creates the smoothest ease out. The default is 50%.

### Strobe

The Strobe behavior simulates the look of a strobe light or lower-frame-rate video by holding a number of frames as defined by the Strobe Duration parameter over the playback of the clip. For example, when Strobe Duration is set to 10, frame 1 is held for 10 frames, frame 11 for 10 frames, frame 21 for 10 frames, and so on. The frames in between (2–10, 12–20, 22–30, and so on) do not appear.

Adjust this behavior using the control in the Behaviors Inspector:

- **Strobe Duration**: A slider that sets the number of frames to hold.
- **Strobe Duration**: A slider that sets the number of frames to hold. A value of 1 plays the clip at normal speed. The default value is 5 frames.

## Stutter

The Stutter behavior randomly inserts hold frames, of random durations, into the playback of a clip. The effect is similar to a tape that sticks during play in a videocassette recorder.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Stutter Amount**: A slider that sets the probability that a hold frame is generated at the given frame. When set to 0%, no hold frames are created; when set to 100%, every frame is a hold frame. Values between 0 and 100 indicate the probability of frames (within the duration of the behavior) that are replaced by hold frames. The default value is 10%.

- **Duration Range**: A slider that sets the maximum duration of hold frames. A value of 1 inserts single-frame hold frames at a frequency determined by the Stutter Amount parameter. Increasing the Duration Range increases the range of hold frames. For example, a value of 30 creates random hold frames with a minimum of 1 frame and a maximum of 30 frames. The default value is 3 frames.

- **Random Seed**: A button that picks a new random seed number. This number is used to generate new values, based on the other parameters of this behavior.
Simulation behaviors overview

Simulation behaviors perform one of two tasks. Some Simulation behaviors, such as Gravity, animate the parameters of an object in a way that simulates a real-world phenomenon. Other Simulation behaviors, such as Attractor and Repel, affect the parameters of objects surrounding the object to which they’re applied. These behaviors allow you to create sophisticated interactions among multiple objects in your project with minimal adjustments. Like the Basic Motion behaviors, Simulation behaviors also affect specific object parameters. Examples include Attractor, Gravity, and Repel.

**Important:** Several Simulation behavior parameters contain object wells into which you drag target objects used as attractors, repellers, orbiters, and so on. Dragging an object to a well can be tricky—be sure to drag the object name (or thumbnail) from the Layers list to the object well in the Inspector (without releasing the mouse button). If you click the object in the Layers list and release the mouse button, that behavior object is deselected its parameters are no longer displayed in the Inspector. This applies to all wells, including mask source wells and image wells.

There are 16 Simulation behaviors:

- **Align to Motion** changes the orientation of an object to match its direction along an animation path.
- **Attracted To** pulls an affected object toward a designated target.
- **Attractor** pulls objects toward the affected object.
- **Drag** simulates the force of friction on a moving object.
- **Drag** simulates the force of friction on a moving object, slowing it down over time.
- **Drift Attracted To** pulls an affected object toward a designated target, then makes the object come to rest, rather than overshooting the target and bouncing around.
- **Drift Attractor** pulls other objects toward the affected object, then makes those objects come to rest, rather than overshooting the affected object and bouncing around.
- **Edge Collision** causes an object to collide with and bounce off the edges of the Canvas frame.
- **Gravity** causes an object to fall over time.
- **Orbit Around** causes the affected object to circle around a designated target.
- **Random Motion** animates an object along a random path.
- **Repel** pushes objects away from the affected object.
- **Repel From** pushes the affected object away from a designated target.
- **Rotational Drag** simulates the force of friction on spinning objects.
- **Spring** causes the affected object to move back and forth around a designated target.
- **Vortex** causes objects to circle around the affected object.
- **Wind** “blows” an object in a specified direction.

**Align to Motion**
The Align to Motion behavior changes the rotation of an object to match changes made to its direction along an animation path. This behavior is meant to be combined with Simulation behaviors that animate the position of an object or with a keyframed animation path you create yourself.

**Note:** The Align to Motion behavior does not work on objects animated using the Motion Path behavior. Instead, use the Snap Alignment to Motion behavior (in the Basic Motion subcategory).

Unlike the Snap Alignment to Motion behavior, which produces absolute changes in rotation that precisely match changes in direction, Align to Motion has a springy reaction and creates a more lively effect.

In the above example, the airplane travels along the keyframed animation path, but the plane isn’t aligned to the animation path (notice the rotation handle). Using the Align to Motion behavior, the airplane’s angle of rotation moves so it points in the direction of the animation path. By adjusting the Drag parameter, you can make the object careen wildly about its anchor point as it goes around curves in the animation path.

Adjust this behavior using the controls in the Behaviors Inspector:
- **Affect Subobjects**: A checkbox, available when this behavior is applied to an object that contains multiple child objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Rotation Axis**: A pop-up menu that rotates the object around the X, Y, or Z axis. You can also select All to rotate the object around all three axes. The default rotation axis is Z.

- **Axis**: A pop-up menu that sets whether the object aligns to its horizontal or vertical axis.

- **Invert Axis**: A checkbox that flips the orientation with which the object aligns to the motion.

- **Spring Tension**: A slider that adjusts how quickly the object’s rotation changes to match a change in the object’s direction. Lower values create a delay between a change to an object’s position and its subsequent change in rotation. Higher values create more responsive changes in rotation.

- **Drag**: A slider that adjusts whether the change in rotation made by this behavior overshoots the new direction of the object. Low drag values result in springy changes in rotation, where the object rotates back and forth as it overshoots changes in direction. High drag values dampen this effect, making the object’s rotation stick more closely to the changes made in rotation. Higher values also cause the object’s rotation to lag behind the object’s change in position.

**SEE ALSO**
Attracted To

An object with the Attracted To behavior applied moves toward a single specified target, the object of attraction. Additional parameters allow you to adjust the area of influence that defines how close an object must be to move toward the object of attraction, and how strongly it is attracted.

The Drag parameter lets you define whether attracted objects overshoot and bounce about the attracting object, or whether they eventually slow down and stop at the position of the target object.

You can apply two or more Attracted To behaviors to a single object, each with a different object of attraction, to create tug-of-war situations where the object bounces among all objects it’s attracted to.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox, available when this behavior is applied to an object that contains multiple child objects, such as a group, a particle emitter, a replicator, or a text
Object: An object well that defines the object of attraction. To set the defined target object, drag the object from the Layers list to the Object well in the Attracted To HUD or Inspector. In the Layers list, you can also drag the target object onto the Attracted To behavior.

Strength: A slider defining the speed at which the object moves toward the object of attraction. With a value of 0, the object doesn’t move at all. The higher the value, the faster the object moves.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. There are two menu items:

- Linear: Object attraction falls off in proportion to the object’s distance.
- Exponential: The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

Falloff Rate: A slider that sets how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of attraction.
• **Influence**: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects outside the area of influence remain in place.

• **Drag**: A slider that reduces the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

• **Include X, Y, and Z**: Buttons that specify the axes on which the affected object (or objects) moves around the object to which it is attracted. When Z is enabled, the object moves about its attractor object in Z space.

---

**Attractor**

The Attractor behavior, when applied to an object, causes other objects that lie within the area of influence move toward it. You can manipulate the strength with which other objects are attracted, as well as the distance required for attraction to begin.

By default, objects overshoot the object of attraction and bounce
around, never coming to rest. The Drag parameter lets you adjust this behavior, changing whether attracted objects overshoot and bounce around, or whether they eventually slow down and stop at the position of the target object.

The Attractor behavior can affect all objects in the Canvas that fall within the area of attraction, or you can limit its effect to a specific list of objects by using the Affect parameter.

The Attractor behavior can also be applied to objects in motion. If you animate the position of the target object to which you’ve applied the Attractor behavior, all other objects in the Canvas continue to be attracted to its new position.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect**: A pop-up menu that limits which objects in your project are affected by the Attractor behavior. There are three options:
  - **All Objects**: All objects in the Canvas are affected by the Attractor behavior.
  - **Related Objects**: The default setting. Only other objects in the same group as the object of attraction are affected.
  - **Specific Objects**: Only objects appearing in the Affected Objects list are affected by the Attractor behavior.

- **Affected Objects**: A list that appears when Specific Objects is chosen in the Affect pop-up menu. Drag objects from the Layers list into this list to have the objects affected by this behavior. To remove an item from the list, select the item and click Remove. The Affected Objects list contains the following columns:
- **Layer**: This column lists the name of the layer containing the object.

- **Name**: This column lists the name of the object.

- **Strength**: A slider that sets the speed at which attracted objects move toward the target object. With a value of 0, attracted objects don’t move at all. The higher the value, the faster attracted objects move.

- **Falloff Type**: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. There are two menu items:
  - **Linear**: Object attraction falls off in proportion to the object’s distance.
  - **Exponential**: The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

- **Falloff Rate**: A slider that sets how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

- **Influence**: A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects outside the area of influence remain in place.

- **Drag**: A slider that reduces the distance attracted objects overshoot the object of attraction. Lower Drag values result in
the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

- Include X, Y, and Z: Buttons that specify the space in which the object (or objects) moves toward the target object. For example, when X and Y are enabled, the object moves in the XY plane; when Y and Z are enabled, the object moves in the YZ plane.

Drag

The Drag behavior simulates the force of friction on a moving object, slowing it down over time. Applying the Drag behavior is an easy way to decelerate objects with multiple behaviors that create complex motion.

Adjust this behavior using the controls in the Behaviors Inspector:

- Affect Subobjects: A checkbox, available when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- Amount: Sliders that slow down an object over time, causing it to eventually come to a stop. Higher Drag values result in the object coming to rest sooner. Click the Amount disclosure triangle to adjust the drag applied to the X, Y, and Z values separately. An example of this is to create a situation where
an object's vertical speed slows down faster than its horizontal speed.

- **Include X, Y, and Z**: Buttons that specify the space that Drag affects. For example, when X and Y are enabled, the object drags in the XY plane; when Y and Z are enabled, the object drags in the YZ plane.

**Drift Attracted To**

The Drift Attracted To behavior is similar to the Attracted To behavior, but by default an object moves toward the object of attraction and comes to rest, rather than overshooting the object of attraction and bouncing around.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox, available when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Object**: An object well that defines the object of attraction. To set the defined target object, drag the object from the Layers list to the Object well in the Drift Attracted To HUD or Inspector. In the Layers list, you can also drag the target object onto the Drift Attracted To behavior.

- **Strength**: A slider that sets the speed at which the object moves toward the object of attraction. With a value of 0, the object doesn’t move at all. The higher the value, the faster the
object moves.

- **Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. There are two menu items:
  
  - **Linear:** Object attraction falls off in proportion to the object’s distance.
  
  - **Exponential:** The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

- **Falloff Rate:** A slider that sets how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

- **Influence:** A slider that sets the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects outside the area of influence remain in place.

- **Drag:** A slider that reduces the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

- **Include X, Y, and Z:** Buttons that specify the space in which the affected object (or objects) drifts toward the object to which it is attracted. For example, when X and Y are enabled,
the object drifts in the XY plane; when Y and Z are enabled, the object drifts in the YZ plane.

Drift Attractor

The Drift Attractor behavior is similar to the Attractor behavior, but by default objects within the area of influence move toward the object of attraction and come to rest, rather than overshooting the object of attraction and bouncing around.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect**: A pop-up menu that limits which objects in your project are affected by the Drift Attractor behavior. There are three options:
  - **All Objects**: All objects in the Canvas are affected by the Drift Attractor behavior.
  - **Related Objects**: The default setting. Only other objects in the same group as the object of attraction are affected.
  - **Specific Objects**: Only objects appearing in the Affected Objects list are affected by the Drift Attractor behavior.

- **Affected Objects**: A list that appears when Specific Objects is chosen in the Affect pop-up menu. Drag objects from the Layers list into this list to have those objects affected by the behavior. To remove an item from the list, select the item and click Remove. There are two menu items:
  - **Layer**: This column lists the name of the layer containing the object.
  - **Name**: This column lists the name of the object.
• **Strength**: A slider that sets the speed at which attracted objects move toward the target object. With a value of 0, attracted objects don’t move at all. The higher the value, the faster attracted objects move.

• **Falloff Type**: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. There are two options:
  • **Linear**: Object attraction falls off in proportion to the object’s distance.
  • **Exponential**: The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

• **Falloff Rate**: A slider that determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When Falloff Type is set to Exponential, the attraction falls off more quickly than when set to Linear.

• **Influence**: A slider that sets the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects outside the area of influence remain in place.

• **Drag**: A slider that reduces the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.
Include X, Y, and Z: Buttons that specify the space in which the object (or objects) drift toward the target object. For example, when X and Y are enabled, the object drifts in the XY plane; when Y and Z are enabled, the object drifts in the YZ plane.

**Edge Collision**

The Edge Collision behavior is ideal for setting up complex motion simulations with objects that do not exit the Canvas. Objects with the Edge Collision behavior applied come to a stop or bounce off after colliding with the edge of the Canvas frame. For example, if you apply the Throw behavior to an object and set the velocity to send the object toward the edge of the frame, then apply Edge Collision, the object will bounce off the edge of the frame according to the Bounce Strength parameter. Edge Collision has no effect on objects larger than the Canvas.

The angle at which the object bounces depends on the angle at which it hits the edge of the frame; the speed it travels after bouncing is set by the Bounce Strength parameter.

**Important:** By default, the Edge Collision behavior uses the size of the project and the bounding box to determine how the object collides with the edge of the Canvas. For example, in an NTSC Broadcast SD project (720 x 486 pixels), an object bounces off the right and left edges of the project at its bounding box. With groups (particles, text, and objects), only the object’s center is used. You can make the object travel farther off the Canvas before it bounces by adjusting the Width and Height parameters. If you’re using this behavior with an object that has an alpha channel that’s smaller than its bounding box, adjust the Crop...
parameter in the object’s Properties Inspector to fit the bounding box as closely as possible to the edge of the image.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox, available when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Bounce Strength**: A slider that sets the speed at which objects travel after colliding with an edge. A value of 0 causes objects to come to a complete stop when colliding with an edge that’s perpendicular to the direction of motion. Higher values cause an object to move faster after bouncing. This parameter only slows the object in the direction perpendicular to the bounced edge.

- **Active Edges**: Six checkboxes that define which collision box edges are detected by the Edge Collision behavior. You can turn edges on and off in any combination.
  - **Left Face**: Defines the left edge for the collision.
  - **Right Face**: Defines the right edge for the collision.
  - **Top Face**: Defines the top edge for the collision.
  - **Bottom Face**: Defines the bottom edge for the collision.
  - **Back Face**: Defines the back edge (in Z space) for the collision.
  - **Front Face**: Defines the front edge (in Z space) for the collision.
- **Width**: A slider that sets a width (the right and left edges of the Canvas) other than the size of project. By default, Width is set to the project size.

- **Height**: A slider that sets a height (the top and bottom edges) other than the size of project. By default, Height is set to the project size.

- **Depth**: A slider that sets a depth (the back and front faces, in Z space) for the edge collision. By default, Depth is set to 100 pixels.

---

**Gravity**

The Gravity behavior causes an object, or the objects in a group (when Affect Subobjects is selected), to fall over time. The gravitational acceleration can be increased or decreased, resulting in a change to the rate of fall. Objects affected by the Gravity behavior continue to fall past the bottom edge of the Canvas (unless the Edge Collision behavior has been applied).

The following illustration shows an object affected by the Throw, Snap Alignment to Motion, and Gravity behaviors all at once.
As you can see, the Gravity behavior can be used in conjunction with other behaviors that animate the position of objects to create natural-looking arcs and animation paths that simulate thrown objects falling to the ground. For example, apply the Throw behavior to an object to send it flying through the air, and then apply the Gravity behavior to it to make the object arc up and then fall down past the bottom of the Canvas.

You can also set the Acceleration parameter to a negative value, effectively applying “antigravity” to the object and making it fly up.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox, available when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Acceleration**: A slider that sets the strength of gravity affecting the target object. The higher this value, the faster the target object falls.

**Orbit Around**

Similar to the Attracted To behavior, the Orbit Around behavior’s default parameter settings give the object sufficient initial velocity to orbit around another object in a perfect circle.
Note: Behaviors such as Attractor and Repel applied to nearby objects might disrupt an object with the Orbit Around behavior applied to it.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox, available when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Object**: An object well that defines the object to orbit around. To set the defined target object, drag the object from the Layers list to the Object well in the Orbit Around HUD or Inspector. In the Layers list, you can also drag the target object onto the Orbit Around behavior.

- **Strength**: A slider that sets the speed of the object.

- **Falloff Type**: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. The default is Linear.
  
  - **Linear**: Object attraction falls off in proportion to the
- *Exponential:* The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

- **Falloff Rate:** A slider that sets how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

- **Influence:** A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects outside the area of influence remain in place.

- **Drag:** A slider that causes the orbit to decay. The default value for Orbit Around is 0, which results in a stable orbit. Any other value causes the orbit to decay and the object to spiral into the object of attraction.

- **Include X, Y, and Z:** Buttons that specify the space in which the orbit occurs. For example, when X and Y are enabled, the object orbits in the XY plane. In the illustration below, X and Y are selected in the Include parameter. The red motion paths represent the motion of the white airplanes around the target object (the circle). The light gray box represents the boundary of the group.
In the illustration below, Y and Z are turned on in the Include parameter. The white airplanes move around the target object in the YZ plane.

- **Pole Axis**: A pop-up menu that becomes available when the X, Y, and Z axes are enabled in the Include parameter. Because
all points are at a fixed distance from the target or attractor object (the Pole Axis), the object can be visualized on a sphere of all possible orbits, with the target object at the center of the sphere. The Pole Axis defines the two points on the sphere that the orbit must pass through. There are four menu items:

- **X**: Aligns the Pole Axis set to the X plane.
- **Y**: Aligns the Pole Axis to the Y plane.
- **Z**: Aligns the Pole Axis to the Z plane.
- **Random**: When Random is selected, the axes shift to a different random position.

- **Direction**: A pop-up menu that sets whether objects move around in a clockwise or counterclockwise direction.

Random Motion

The Random Motion behavior animates the position of an object and makes that object move around the Canvas along a random path. The Random Motion behavior is useful for creating varied animation paths for large numbers of objects you want to move at the same time. For example, you can create an arrangement of ten objects in the Canvas and apply the Random Motion behavior to them all.

Although the motion created with this behavior appears to be random, it is predetermined by the group of parameters you’ve chosen. As long as you don’t change the parameters, the animation path created by this behavior remains the same. If you don’t like the path that was randomly generated, click the
Generate button in the HUD or the Behaviors Inspector to pick a new random seed number. This number is used to generate a new path.

You can also use the Random Motion behavior to add variation to the animation paths created by other behaviors that affect an object’s position. In the following example, adding Random Motion to an object with the Orbit Around behavior results in a more erratic animation path from orbit to orbit, although it still moves around the center as before.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox that appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Amount**: A slider that determines the speed the object moves by changing the length of the animation path. Higher values result in faster motion and longer animation paths.

- **Frequency**: A slider that determines the number of twists and
turns in the animation path, which can be seen by the crookedness of the resulting animation path. Higher values create more turns in the animation path. Lower values result in straighter animation paths.

- **Noisiness**: A slider that determines an additional level of jaggedness along the animation path shape defined by the Amount parameter. Higher values result in a more jagged-looking animation path.

- **Drag**: A slider that controls the speed the object moves along the animation path. While the Amount parameter controls the length of the animation path, the Drag parameter shrinks or enlarges the animation path as a whole.

- **Include X, Y, and Z**: Buttons that specify the space in which random motion is in effect. For example, when X and Y are enabled, the motion occurs in the XY plane; when Y and Z are enabled, the motion occurs in the YZ plane.

- **Random Seed**: A button that picks a new random seed number. This number is used to generate new animation paths, based on the values you’ve picked in the other parameters of this behavior.

**Repel**

If you apply the Repel behavior to an object, that object pushes away all other objects within the area of influence in the Canvas. The strength with which objects are pushed away can be increased or decreased, as can the distance repelled objects travel.
You can also specify which objects are affected by this behavior, creating an effect where only specific objects are moved, while others remain still.

The Repel behavior is the opposite of the Attractor behavior, and is part of a group of simulation behaviors that create complex animated relationships between two or more objects.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect**: A pop-up menu that limits which objects in your project are affected by the Repel behavior. There are three options:
  - **All Objects**: All objects in the Canvas are affected by the Repel behavior.
  - **Related Objects**: The default setting. Only other objects in the same group as the repelling object are affected.
  - **Specific Objects**: Only objects appearing in the Affected Objects list are affected by the Repel behavior.

- **Affected Objects**: A list that appears when Specific Objects is chosen in the Affect pop-up menu. Drag objects from the Layers list into this list to be affected by the Attractor behavior when the Specific Objects option is selected in the Affect pop-
up menu. To remove an item from the list, select the item and click Remove. The Affected Objects list contains the following columns:

- **Layer**: This column lists the name of the layer containing the object.
- **Name**: This column lists the name of the object.
- **Strength**: A slider that defines the speed at which repelled objects move away from the object. With a value of 0, repelled objects don’t move at all. The higher the value, the faster repelled objects move.
- **Falloff Type**: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.
  - **Linear**: Repulsion between objects falls off in proportion to the object’s distance.
  - **Exponential**: The closer an object is within the area of influence, the more strongly it is repelled, and the faster it moves away from the object doing the repelling.
- **Falloff Rate**: A slider that sets how quickly the force of repulsion between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move away from the object of repulsion. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.
- **Influence**: A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move away from the object of repulsion. Objects outside the
area of influence remain in place.

- **Drag**: A slider that reduces the distance repelled objects travel away from the repelling object.

- **Include X, Y, and Z**: Buttons that specify the space in which the objects move away from the object with the applied Repel behavior. For example, when X and Y are enabled, the object moves away in the XY plane; when Y and Z are enabled, the object moves away in the YZ plane.

---

**Repel From**

Whereas the Repel behavior pushes other objects away, the Repel From behavior has the converse effect, making the object it’s applied to move away from a selected object in the Canvas.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox that appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Object**: An object well that defines the object to be repelled from.

- **Strength**: A slider that sets the speed at which the object is repelled. With a value of 0, the object is not repelled at all. The higher the value, the faster the object is repelled.

- **Falloff Type**: A pop-up menu that determines whether the
distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear**: Repulsion between objects falls off in proportion to the object’s distance.

- **Exponential**: The closer an object is within the area of influence, the more strongly it is repelled, and the faster it moves away from the object doing the repelling.

- **Falloff Rate**: A slider that sets how quickly the force of repulsion between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move away from the object of repulsion. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

- **Influence**: A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move away from the object of repulsion. Objects outside the area of influence remain in place.

- **Drag**: A slider used to reduce the distance the object or objects travel away from the repelling object.

- **Include X, Y, and Z**: Buttons that specify the space in which the object moves away from the selected object. For example, when X and Y are enabled, the object moves in the XY plane; when Y and Z are enabled, the object moves in the YZ plane.

---

**Rotational Drag**

Rotational Drag is similar to the Drag behavior, except that it
affects Rotation instead of position. Rotational Drag simulates friction affecting objects that are spinning due to keyframed or behavior-driven changes to the Rotation parameter. By setting higher Drag values, you can slow rotational changes to an eventual stop.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox that appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Amount**: A slider used to slow down an object’s rotation over time, causing it to eventually come to a stop. Higher Amount values result in the rotation ending sooner.

### Spring

The Spring behavior creates a relationship between two objects, so that an object with the Spring behavior applied to it moves back and forth around a second object. The Attract To parameter defines the object that serves as the target and center of the Spring behavior. Additional parameters let you adjust the speed of the behavior (Spring Tension) and the acceleration of the object at each change in direction (Relaxed Length).

If the Attract To object is at rest, the resulting motion is fairly simple and the springing object moves back and forth in a straight line. If the Attract To object is in motion, the springing object’s
motion is much more complex, changing direction according to the velocity of the Attract To object.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects**: A checkbox that appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Attract To**: An object well that defines the object of attraction. To set the defined target object, drag the object from the Layers list to the Attract To well in the Spring HUD or Inspector. In the Layers list, you can also drag the target object onto the Spring behavior.

- **Spring Tension**: A slider that determines how fast the object is pulled toward the object of attraction.

- **Relaxed Length**: A slider that sets the distance from the target object where object attraction diminishes to zero. As the springing object’s distance increases past this point, the force of attraction increases proportionally, to bring it back toward the target object.

- **Repel**: A checkbox that, when selected, pushes objects apart as the target object gets closer to the object of attraction than the Relaxed Length value. When this checkbox is deselected, no repelling force is applied.

- **Include X, Y, and Z**: Buttons that specify the space in which the affected object moves back and forth around the assigned
object. For example, when X and Y are enabled, the object moves back and forth in the XY plane; when Y and Z are enabled, the object moves back and forth in the YZ plane.

**Vortex**

The opposite of the Orbit Around behavior, the Vortex behavior exerts a force on all objects surrounding the object to which the Vortex behavior is applied.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect:** A pop-up menu that limits which objects in your project are affected by the Vortex behavior. There are three options:
  - **All Objects:** All objects in the Canvas are affected by the Vortex behavior.
  - **Related Objects:** The default setting. Only other objects in the same group as the object of attraction are affected.
  - **Specific Objects:** Only objects appearing in the Affected Objects list are affected by the Vortex behavior.

- **Affected Objects:** A list that appears when Specific Objects is chosen in the Affect pop-up menu. Objects you drag from the Layers list into this list are affected by the Attractor behavior when the Specific Objects option is selected in the Affect pop-up menu. To remove an item from the list, select the item and click Remove. The Affected Objects list contains the following columns:
  - **Layer:** This column lists the name of the layer containing the object.
  - **Name:** This column lists the name of the object.
- **Name:** This column lists the name of the object.

- **Strength:** A slider that sets the speed at which the affected objects move about the object of attraction.

- **Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. The default is Linear.
  - **Linear:** Object attraction falls off in proportion to the object’s distance.
  - **Exponential:** The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

- **Falloff Rate:** A slider that sets how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

- **Influence:** A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects outside the area of influence remain in place.

- **Drag:** A slider that causes the vortex to decay. The default value for Vortex is 0, which results in a stable vortex. Any other value causes the vortex to decay and the object to spiral into the object of attraction.

- **Include X, Y, and Z:** Buttons that specify the space in which the objects vortex around the target object. For example, when X and Y are enabled, the object circles around in the XY
plane; when Y and Z are enabled, the object circles around in the YZ plane.

- **Pole Axis:** A pop-up menu that becomes available when the X, Y, and Z axes are enabled in the Include parameter. Because all points are at a fixed distance from the target or attractor object (the Pole Axis), the object can be visualized on a sphere of all possible orbits, with the target object at the center of the sphere. The Pole Axis defines the two points on the sphere that the orbit must pass through. For more information, see this parameter’s discussion in Orbit Around.

- **Direction:** A pop-up menu that sets whether objects move around in a clockwise or counterclockwise direction.

**Wind**

Apply the Wind behavior to an object to animate its position and move it in a specified direction. Unlike the Throw behavior, the velocity specified by the Wind behavior is a continuous force, and its parameters can be keyframed to achieve gradual changes in speed and direction.

The Wind behavior is better than the Throw behavior when you want to vary the speed of the affected object. You can apply another behavior (such as Randomize or Ramp) or keyframe the Velocity parameter of the Wind behavior to vary the speed and direction of the object. You cannot make gradual changes in speed or direction with the Throw behavior.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Affect Subobjects:** A checkbox that appears when this
behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is selected, all objects enclosed in the parent object are affected individually. When this checkbox is deselected, all objects enclosed in the parent object are affected by the behavior together.

- **Air Thickness**: A slider and value slider that adjust how fast the object accelerates on the X, Y, or Z axis when the speed is changed. Lower values (simulating thinner air) have less effect when pushing the object, so it takes longer to get up to speed. Higher values (thicker air) have more effect and push the object up to speed more quickly.

- **Velocity**: A slider and value slider that adjust the speed on the X, Y, or Z axis where the simulated air is blowing the object. Higher values result in faster motion.

The HUD lets you specify the direction and speed of the Wind behavior by dragging an arrow in a circular region. The direction of the arrow defines the direction of movement in X and Y space, and the length of the arrow defines speed (velocity). A slider lets you adjust the scale of the HUD control, increasing or decreasing the effect the control has over the object.
Press the Shift key while dragging the arrow to constrain it to 45-degree angles. Press the Command key to change the arrow’s direction without affecting its length.

When you click the 3D button, a center arrow control defines the direction the object is “blown” by the wind in 3D. The Speed slider increases or decreases the velocity of the blown object.

**Note:** The maximum speed you can define with the HUD is not the maximum speed possible. Higher values can be entered into the Velocity parameter in the Behaviors Inspector.
Additional behaviors

Audio, Camera, Motion Tracking, Particles, Replicator, Shape, and Text behaviors are designed specifically to be applied to their respective objects: Audio files, cameras, particle emitters or cells, replicators or replicator cells, shapes, and text.

SEE ALSO

Audio behaviors overview
Add Camera behaviors
Apply behaviors to particle systems
Apply the Sequence Replicator behavior
Shape behaviors overview
Motion tracking overview
Animated text overview

Save and share custom behaviors

Save custom behaviors

You can save customized behaviors to the Library in any of several organizational categories for future use. Behaviors saved in the Library appear with a custom icon. You can also save multiple behaviors to the Library as a single file or as multiple files. For example, if you create an animation that uses multiple behaviors and you want to save the cumulative effect of those behaviors, you can save them all as one item in the Library.

Alternatively, you can create new folders in existing categories.
You can create a folder in the Favorites or Behaviors category. Folders created in the Behaviors category appear in the Library sidebar. Folders created in the subcategories, such as the Basic Motion subcategory, appear in the Library stack and not the sidebar.

Save a behavior to the Library

1. Open the Library and select the Favorites, Favorites Menu, or Behaviors category.

   For organizational purposes, it’s best to save custom behaviors to the Favorites or Favorites menu category.

2. Drag the customized behavior to save from the Layers list, Timeline, or Inspector into the stack at the bottom of the Library.

   **Note:** If a custom behavior is dragged to another subcategory, such as the Glow (Filters) subcategory, it is placed in the Behaviors category and the Behaviors category becomes active.

Save multiple behaviors to the Library

1. Open the Library and select the Favorites, Favorites Menu, or Behaviors category.

2. In the Layers list, select all behaviors to save and drag them to the stack, holding down the mouse button until a drop menu appears.
3. Choose “All in one file” or “Multiple files” from the drop menu, then release the mouse button.

“All in one file” saves behaviors together. They are listed as one item in the Library. “Multiple files” saves the behaviors as individual objects in the Library.

For information on naming items saved to the Library, saving multiple items of different types to the Library, as well as creating and organizing folders in the Library, see Save custom objects to the Library.

Delete custom behaviors
You can delete custom behaviors from the Library, if necessary.

Delete a custom behavior

- In the Library stack, Control-click the custom behavior, then choose Move to Trash from the shortcut menu.

Delete a custom folder from a subcategory in the Library stack

- Control-click the folder in the Library stack, then choose Move to Trash from the shortcut menu.
You can also delete the folder from the OS X Finder. The folder is stored in the /Users/username/Library/Application Support/Motion/Library/ folder. If the Library folder is hidden in the OS X Finder, hold down the Option key, then choose Go > Library.

**Important:** Deleting a custom object or folder cannot be undone.

---

**Move behaviors to another computer**

Each customized behavior you drag into the Motion Library is saved as a separate file in the /Users/username/Library/Application Support/Motion/Library/ folder on your computer. For example, a saved custom behavior named My Motion Path in the Favorites folder of the Library appears in the /Users/username/Library/Application Support/Motion/Library/Favorites/ folder. Items saved to the Library appear in the OS X Finder with a .molo extension ("Motion Library object"). These items cannot be opened from the Finder.

You can move saved behaviors to other computers that have Motion installed.

---

**Copy a custom behavior to another computer**

- Copy Motion custom behaviors from your computer’s /Users/username/Library/Application Support/Motion/Library/
folder to the same folder on another computer that has Motion installed.
Keyframing overview

*Keyframing* is the process of assigning different parameter values to an object at specific points in time to animate some aspect of the object. Although behaviors are ideal for quickly adding complex motion or effects to an object, keyframes provide additional precision, ensuring that a specific event happens at the exact frame you choose. For example, if you want to time a movement or effect to match a musical beat or a word in the soundtrack, a keyframe is the best tool for the job.

![Keyframe examples](image)

When you set more than one keyframe for a parameter, Motion *interpolates* the in-between frames, generating a smooth change over time. For example, if you want a title to change from green to blue over time, you can set two keyframes at two points in time. The first keyframe defines the text’s color as green, and the second keyframe sets the color to blue. Motion makes the frames between those points change smoothly from green to blue.

Motion lets you keyframe color values, position, rotation, opacity, and almost every other parameter in the application—for both
image layers and effects objects (cameras, lights, behaviors, filters, and so on). For example, keyframes allow you to animate static filters and modify behaviors, resulting in complex, precisely timed animations.

There are two basic ways to **add keyframes** to your project. And you can edit keyframes in several areas of the Motion workspace: in the **Inspector**, **HUD**, **Timeline track area**, and **Keyframe Editor**.

**SEE ALSO**
Behaviors overview

### Add keyframes

Motion provides two basic ways to apply keyframes to animate your project:

- **Record button method:** Turn on the Record button to create a new keyframe whenever you adjust any parameter. This method is useful when you want to create keyframes for multiple parameters in your project.
**Initial-keyframe method**: Manually add a keyframe to a parameter to have any further adjustment of that parameter create additional keyframes at the current playhead position. This method is useful when you want to create keyframes for a single parameter of a specific object in your project.

---

**Add keyframes to one or more parameters using the Record button**

1. Do one of one following:
   - Click the Record button in the transport controls under the Canvas.
   - Press A.
   - Choose Mark > Record Animation.
The Record button is highlighted.

2. Select an object in the Canvas, Layers list, or Timeline.

3. Drag the playhead to a new position in time.

4. Modify one or more parameters by doing any of the following:
   - Use the onscreen controls to move, scale, or manipulate objects.
   - Use the controls in the Inspector or HUD to move, scale or manipulate objects.

   Keyframes are added at the current playhead position for any parameters you modified.

5. Repeat steps 3 and 4 to add additional keyframes.

As long as the Record button is enabled, any parameter modifications you make in your project are recorded as new keyframes. In the Inspector, all modifiable parameters are highlighted red to remind you that parameter changes are being recorded as keyframes.

---

**Turn off the Record button**

If keyframe recording is enabled, you can turn it off the same way you turned it on.

Do one of the following:

- Click the Record button in the transport controls under the Canvas.
Add keyframes to a single parameter using the initial-keyframe method

1. Select an object in the Canvas, Layers list, or Timeline.

2. Modify a parameter by doing any of the following:
   - Use the onscreen controls to move, scale, or manipulate the object.
   - Use the controls in the Inspector or HUD to move, scale or manipulate the object.

3. Create an initial keyframe by doing one of the following:
   - Press Control-K.
     Pressing Control-K adds a keyframe to the last parameter you modified (in step 2 above). For example, if you scale a layer using its onscreen handles and then press Control-K, a keyframe is added to the Scale parameter.
   - In the Transform section of the Properties Inspector, click the Add/Delete Keyframe button for the parameter you want to keyframe.

Note: The Add/Delete Keyframe button (a plus sign in a gray diamond) is hidden until you position the pointer over the far-right side of the parameter row you want to add a keyframe to.
In the Transform section of the Properties Inspector, click the Animation menu on the far right side of a parameter, then choose Add.

**Note:** The Animation menu (a downward arrow) is hidden until you position the pointer over the far-right side of the parameter row you want to add a keyframe to.

In the Inspector, Control-click a parameter’s name, then choose Add from the shortcut menu.

A keyframe for the parameter you modified is added at the current frame, and the parameter you modified appears red in the Inspector, indicating that keyframing is now turned on for that parameter.
4. Move the playhead to a new time position.

5. Modify the same parameter again, as described in step 2.

Another keyframe is added at the current frame.

**Note:** When you animate parameters using the initial-keyframe method, you cannot turn off or suspend keyframe recording.

---

**Animate in the Canvas**

**Add an animation path in the Canvas**

The easiest way to apply keyframes is to manipulate objects directly in the Canvas while the Record button is enabled. Using this method, you can animate changes to basic parameters such as scale, rotation, position, distort, and so on.

When the Record button is enabled and you move the playhead to a new frame, any change you make to any object generates new keyframes. When animating an object’s position, an *animation path* is created—a red line in the Canvas showing the direction of motion (a small white arrow at the beginning of the path) and the location of keyframe points (small white diamonds along that path).
**Note:** To view the animation paths of keyframed objects, ensure that Animation Path is selected in the View pop-up menu (in the upper-right corner of the Canvas).

If the playhead is positioned on a previously set keyframe, changes you make modify that keyframe rather than the curve, regardless of whether the Record button is on or off.

---

**Move an object across the screen**

1. Click the Record button (or press A) to turn on keyframe recording.

2. Place the playhead at the starting frame.

3. Place the object in a starting position.
4. Move the playhead forward.

5. Drag the object to the ending position.

6. Click the Record button (or press A) to turn off keyframe recording.

A red animation path shows the route the object will take when you play back your project, flying from position one to position two over the interval you set.

**Note:** If you can’t see the animation path, click the View pop-up menu above the Canvas, then choose Animation Path. When this setting is active, a checkmark appears next to it in the View pop-up menu.
See also

Manipulate animation paths

Manipulate animation paths
You can modify an animation path by adding keyframes to or deleting keyframes from the path, by dragging keyframes on the path, or by dragging a path segment between two adjacent keyframes.

Additionally, you can set the keyframe type to curved or angled, changing the shape of the path.

When you drag a keyframe in the Canvas, the frame number corresponding to that keyframe and its X, Y, and Z position values are displayed in the status bar (above the Canvas).

Add keyframe points to an animation path
Double-click or Option-click the animation path.

A new keyframe point is added. By default, keyframe points are curved Bezier points.

Reposition a keyframe point

After you add keyframe to an animation path, you can change its location in Canvas, thereby changing the shape of the path.

- Drag a keyframe point to a new position in the Canvas.

  The shape of the animation path changes, based on the new position of the keyframe point.

Reposition a segment of the animation path

- Drag the path segment between the two selected keyframe points.

  **Note:** You can also Shift-select the keyframe points that bound the path segment or segments you want to move, then drag one of the selected keyframe points (or the segment between two adjacent keyframe points).

Reposition the entire animation path

Do one of the following:
Holding down the Option and Command keys, drag a keyframe point on the animation path.

Holding down the Option and Command keys, drag a portion of the animation path between two keyframe points.

Holding down the Option and Command keys, drag the object’s center onscreen control.

The animation path and the object are moved to a new position in the Canvas, and no new keyframes are created.

Reposition an object on an animation path

When you move an object on an animation path to a new position in the Canvas, a portion of the animation path is repositioned along with the object.

Do any of the following:

- **Reposition an object without adding a new keyframe**: Drag the center onscreen control of the object.

  If the object is on a keyframe point, the object and the keyframe point are moved to a new position in the Canvas. If the object is between two keyframe points, the object and the two adjacent keyframe points are moved to a new position in the Canvas.

- **Reposition an object and add a new keyframe**: Make sure the object is positioned on the animation path between two keyframe points, then drag the object (but not its center...
The object is moved to a new position in the Canvas, and a new keyframe point is created at that position.

**Note:** If the object is on a keyframe point, dragging the object does not create a new keyframe; rather, the current keyframe point is moved along with the object to a new position in the Canvas.

### Change the angle of a keyframe point

By default, keyframe points on an animation path use Bezier curves. You can modify the curve angle by dragging tangent handles or by converting Bezier keyframe points to linear points.

Do any of the following:

- **Change the angle of a Bezier keyframe point:** Select a Bezier keyframe point in the Canvas, then drag its tangent handles.

- **Convert a smooth Bezier keyframe point to a sharp linear point:** Control-click a keyframe point in the Canvas, then choose Linear from the shortcut menu.

The tangent handles of the keyframe point disappear, leaving a sharply angled linear keyframe. To quickly convert the keyframe point back to a curved Bezier point with tangent handles, Command-drag the keyframe.

- **Convert a sharp linear keyframe point to a smooth Bezier point:** Control-click the keyframe point and choose Smooth from the
Tangent handles appear on the Smooth keyframe point, and the animation path becomes curved. To quickly convert a curved Bezier point back to a sharply angled linear point, Command-click the keyframe.

**Note:** The Very Smooth option is not available for animation paths and remains dimmed in the shortcut menu.

For more information on manipulating Bezier points, see [Complex shapes and masks overview](#).

### Delete, disable, or lock a keyframe point

Deleting a keyframe point modifies the shape of the animation path; disabling a keyframe point temporarily removes it from the path; locking a keyframe point prevents editing.

Do any of the following:

- **Delete a keyframe point:** Control-click a keyframe point in the Canvas, then choose Delete Point from the shortcut menu (or select the keyframe point, then press Delete).

  The keyframe is removed, changing the shape of the animation path.

- **Disable a keyframe point:** Control-click a keyframe point in the Canvas, then choose Disable Point from the shortcut menu.

  The keyframe is disabled and no longer influences the shape
of the animation path. To re-enable the keyframe, Control-click the disabled keyframe, then choose Enable Point from the shortcut menu.

- Lock a keyframe point: Control-click a keyframe point in the Canvas, then choose Lock Point from the shortcut menu.

The keyframe is locked and can no longer be edited. To unlock the keyframe, Control-click the locked keyframe point, then choose Unlock Point from the shortcut menu.

Animate via the Inspector

Animate parameters in the Inspector

Although you can animate basic object properties by dragging onscreen controls in the Canvas, many other parameters are accessible only in the Inspector. Each section of the Inspector contains keyframeable parameters. For example, you can animate the position and shape of a mask, the color and styles of a text object, or the options in a generator. The parameters that are keyframeable depend on which object is selected and which effects are applied to that object.

Animate parameters in the Inspector using the Record button

1. In the Canvas, select the object to keyframe.
2. Click the Record button (or press A) to turn on keyframe recording.

3. Drag the playhead to the frame where you want the effect to begin.

4. Open the Inspector containing the parameter you want to modify (the Filters Inspector, in this example).

   **Note:** When the Record button is turned on, animatable parameter values appear red. When the Record button is off, parameter values that have no keyframes remain a light shade of gray.

5. Set the parameter to the beginning value.

6. Move the playhead to a new position.

7. In the Inspector, change the parameter to a new value.

8. Click the Record button (or press A) again to disable record.
The parameter now changes over time.

Animate parameters in the Inspector by setting an initial keyframe (Record button is off)

1. In the Canvas, select the object to keyframe.

2. Place the playhead on the frame where you want the effect to begin.

3. Open the Inspector containing to the parameter you want to modify.

4. Set the parameter to the beginning value, then do one of the following:
   - Press Control-K.
   - In the Inspector, click the parameter’s Animation menu, then choose Add.
Note: The Animation menu (a downward arrow) is hidden until you position the pointer over the far-right side of the parameter row you want to add a keyframe to.

- In the Inspector, Control-click the parameter name, then choose Add from the shortcut menu.

- In the Properties Inspector, click the parameter’s Add/Delete Keyframe button.

Note: The Add/Delete Keyframe button (a plus sign in a gray diamond) is hidden until you position the pointer over the far-right side of the parameter row you want to add a keyframe to.

A keyframe is added at the current frame, and the parameter appears red in the Inspector.
5. Move the playhead to a new position.

6. In the Inspector, change the parameter to a new value.

   The parameter now changes over time.

---

**Animation menu**

The Animation menu in the Inspector provides access to additional keyframing options.

Every keyframeable parameter in the Inspector has an Animation menu, available by Control-clicking a parameter’s name to reveal a shortcut menu, or by moving the pointer to the right side of a parameter row in the Inspector, then clicking the downward arrow that appears.
Note: If the Animation menu corresponds to a parameter that cannot be animated, the Enable Animation and Keyframe menu items are dimmed.

The Animation menu contains the following items:

- **Reset Parameter:** Removes keyframes and settings for this parameter, resetting the parameter to its default value.

- **Show in Keyframe Editor:** Opens the Keyframe Editor and displays the parameter’s keyframes and curves. For more information, see Display the Keyframe Editor.

- **Add:** Adds a keyframe at the current frame in the project. If the playhead is positioned on a frame where a keyframe has been added, this menu command is dimmed. To add a keyframe without accessing the Animation menu in the Inspector, press Control-K; a keyframe is added to the last modified parameter of the object (regardless of the status of the Record button) at the current frame.

- **Delete:** Deletes the keyframe. The Delete option is available only if the playhead is positioned on a frame where a keyframe exists.

- **Previous:** Moves the playhead to the previous keyframe for this parameter. The Previous command is available only if a keyframe exists earlier in the project.

- **Next:** Moves the playhead to the next keyframe for this parameter. The Next command is available only if a keyframe exists later in the project.

Note: You can also choose Mark > Go To > Previous Keyframe (or press Option-K) or Mark > Go To > Next Keyframe (or press Shift-K) to move from keyframe to
- **Enable/Disable Animation**: Activates or deactivates keyframes for the parameter. Choosing Disable Animation hides the keyframes already set, restoring the parameter to its default value. However, the keyframes are not thrown away. (A dash appears in the parameter row to indicate that the animation is disabled.) Choosing Enable Animation returns the parameter to its last keyframed state.

- **Add Parameter Behavior**: Opens a submenu listing all available Parameter behaviors you can use to animate the parameter. For more information, see Add, remove, and disable a Parameter behavior.

- **Add To Rig**: Lets you add a parameter to an existing rig, or to a new rig. Rigs are useful when you create templates for Final Cut Pro X. For more information, see Rigging overview and Final Cut Pro templates overview.

- **Publish**: Sends the parameter control to Final Cut Pro X when you create and save a template for the editing application. The Publish command also lets you send rig controls (widgets) to Final Cut Pro. For more information on the Publish command, see Publish parameter controls to Final Cut Pro. For more information on rigging, see Rigging overview.

### Manage keyframes with the Animation menu

You can use the Animation menu in the Inspector to manage common keyframing tasks.
Note: The Animation menu (a downward arrow) is hidden until you position the pointer over the far-right side of the parameter row you want to add a keyframe to.

Set keyframes using the Animation menu

1. In the Inspector, change the value of the parameter you want to keyframe.

2. Click the Animation menu for the affected parameter, then choose Add.

   A keyframe is added at the frame and the affected parameter appears red in the Inspector, indicating that any further changes at other playhead locations will add keyframes to this parameter.

3. To set another keyframe for the same parameter, move the playhead to the next location, then change the value of the parameter.

Delete a keyframe

1. Move the playhead to a frame where there’s a keyframe.

2. In the Inspector, click the Animation menu for the parameter you want to change, then choose Delete.

   Note: To delete all keyframes for a parameter, choose Reset Parameter from the Animation menu.
Reset all keyframes for a parameter

- In the Inspector, click the Animation menu for the parameter you want to reset, then choose Reset Parameter.

  All keyframes are removed for that parameter.

Keyframe controls in the Inspector

In the Inspector, basic keyframe controls are available on the right side of animatable parameter rows. These controls allow you to determine the status of a parameter at a glance, to add or delete keyframes at the current playhead, and to navigate to next and previous keyframes in the Timeline.

Moving the pointer over an animatable parameter reveals the Add/Delete Keyframe button (a plus sign enclosed in a gray diamond). Click the button to place a keyframe for that parameter at the current frame. If a parameter is keyframed at the current frame, as well as before and after the current frame, additional navigation controls appear:
• **Previous Keyframe:** A left angle bracket that appears when there’s a keyframe in the Timeline to the left of the playhead position. Click this control to move to a previous keyframe in the Timeline.

• **Add/Delete Keyframe:** A diamond-shaped button with several states. A gray diamond indicates that there’s no keyframe at the current frame. Click this button to add a keyframe at the playhead position. When you add a keyframe, the diamond turns orange, indicating that there’s a keyframe at the current frame. Clicking the orange diamond deletes the keyframe. When the playhead advances to a frame that’s not keyframed, the diamond turns gray.

• **Next Keyframe:** A right angle bracket that appears when there’s a keyframe to the right of the playhead position. Click this control to move to the next keyframe in the Timeline.

• **Reset button:** A curved arrow button at the top of each parameter section in the Inspector. Click this button to remove all keyframes applied to all parameters in this section of the Inspector and restore those parameters to their default state.
Animate via the HUD

Parameters that appear in the HUD can be keyframed using the Record button or by setting an initial keyframe. Using this technique, you can animate basic object properties such as opacity or position, or create advanced effects such as setting static filters into motion. In this example, the HUD is used to animate an object’s opacity.

Animate a parameter via the HUD

1. Place the playhead where you want to begin to animate.

2. Do one of the following:
   - Click the Record button (or press A) to turn on keyframe recording, then click a slider handle in the HUD.

   Even if you don’t change the slider’s value, clicking it sets a keyframe at that point. This way, the parameter remains at its previous value from the beginning of the clip until that keyframe, then begins the interpolation toward the next keyframe.
With the Record button off, click a slider handle in the HUD, then press Control-K.

A keyframe for that parameter is added at the playhead position.

3. Move the playhead forward to a new time.

4. Change the same parameter slider.

5. Move the playhead forward again.

6. Change the same parameter slider again.

7. If keyframe recording is on, click the Record button (or press A) to turn off keyframe recording.

Use keyframes to modify behaviors

Apply keyframes to behaviors
You can also use keyframes to animate behaviors. Combining behaviors and keyframes is a powerful way to enhance behaviors’ usefulness.

For example, you might want to apply a Gravity behavior, but delay the object’s fall until five seconds into the clip. Keyframes allow you to manipulate the parameters of each behavior.

Certain parameters cannot be animated, such as the Throw Velocity parameter of the Throw behavior and the Spin Rate parameter of the Spin behavior. If a parameter can be animated, the following occurs:

- When keyframe recording is turned on (via the Record button), the parameter value appears red in the Inspector.
- Moving the pointer over the parameter row in the Inspector reveals the Add/Delete Keyframe button (a plus sign in a gray diamond).
- When you add keyframes to a parameter that has been animated with a behavior, a behavior icon (a gear) appears within a keyframe icon (a diamond).

Note: In Motion, you can convert all behaviors applied to an object into keyframes using the Convert to Keyframes command in the Object menu. See Convert behaviors to keyframes.
Keyframe a behavior’s parameters using the Record button

1. Select an object in the Canvas.

2. Apply a behavior.

   For more information about applying behaviors, see Apply behaviors overview.

3. Click the Record button (or press A) to turn on keyframe recording.

4. Place the playhead at the frame where you want the effect to begin changing.

5. In the Inspector or HUD, adjust the behavior’s parameter settings.

   For more information, see Animate parameters in the Inspector and Animate via the HUD.

6. Move the playhead to a new time position.

7. Adjust the behavior settings again.

8. Click the Record button (or press A) to turn off keyframe recording.

About combining keyframes and...
About combining keyframes and behaviors

When you combine keyframes with behaviors, Motion adds the two sets of instructions together. For example, if you apply a Throw behavior toward the upper left of the Canvas, and at the same time add keyframes that instruct the object to move to the right, the behavior-driven object moves less leftward because the keyframes are pushing it in an opposite direction. The larger the Throw velocity rate, the more the behavior overpowers the keyframes, and vice versa.

You can use this method to enhance and control the effects of behaviors. For example, you can apply a Gravity behavior that causes an object to fall toward the bottom of the Canvas, and then keyframe the object’s position to move across the Canvas from left to right. As a result, the object falls as it moves rightward.

Likewise, you can apply a Fade In/Fade Out behavior, but use keyframes on the object’s Opacity parameter to limit the maximum opacity to 80 percent. The resulting clip fades in, but not completely.

Additionally, you can convert behaviors to keyframes. See Convert behaviors to keyframes.

Work with keyframes in the Timeline

View keyframes in the Timeline
When keyframing, it’s often helpful to view your keyframes in the Timeline. This lets you move keyframes to line them up with other important timing elements in your project such as edit points, sound cues, markers, and other keyframes. In the Timeline, keyframes appear in the track area as small red (or white, when selected) diamonds beneath the object they animate. You can also view keyframe values in the Timeline, and delete keyframes you don’t need.

View keyframes in the Timeline

- Click the Show Keyframes button in the upper-right corner of the Timeline so that it’s highlighted blue.

Any applied keyframes appear in the track area as small red (or white, when selected) diamonds beneath the object they animate.
Identify a keyframe’s value

- Control-click (or double-click) a keyframe in the Timeline and view its value in the shortcut menu.

**Note:** Multiple keyframes on the same frame are listed in the menu.

Display a keyframe with its associated animation curve in the Keyframe Editor

- Control-click the keyframe in the Timeline, then choose Show in Keyframe Editor from the shortcut menu.

The Keyframe Editor appears below the Timeline. For information on working in the Keyframe Editor, see Display the Keyframe Editor.

Modify keyframes in the Timeline

When keyframes are visible in the Timeline, you can change their positions in time. Moving a keyframe in time does not modify the keyframe’s parameter value. Rather, it changes the position in time when the keyframe occurs. This can have a significant effect on the nature of the animation. For example, if you have two keyframes that animate an object from the top of the screen to the bottom over a duration of five seconds, dragging one of the keyframes farther from the other forces the animation to occur...
more slowly.

The value of a keyframe can also be modified in the Timeline.

When multiple keyframe values are set in the same frame, only one keyframe marker appears in the Timeline. However, you can choose to edit any of its values.

Move a keyframe in the Timeline

- Drag the keyframe left or right to adjust its position in time.

Edit a keyframe value in the Timeline

1. Control-click (or double-click) the keyframe.

   A shortcut menu appears displaying all of the parameters keyframed at the current frame.

2. Choose the keyframe parameter to edit.
3. Enter a value into the value field, then press Return.

**Note:** To exit an active value field without making changes, press Esc.

---

**Copy and paste keyframes in the Timeline**

1. In the Timeline track area, select one or more keyframes.

   Shift-click to select multiple contiguous keyframes; Command-click to select multiple noncontiguous keyframes.

2. Choose Edit > Copy (or press Command-C).

3. Move the playhead to the frame where you want to paste the keyframes.

4. In the Timeline layers list, select the target object (or objects) for the copied keyframes, then choose Edit > Paste (or press Command-V).

**Note:** You can copy and paste keyframes from multiple objects to single or multiple objects. The objects must share
the same parameters for the keyframes to apply.

## Delete a keyframe in the Timeline

- Control-click the keyframe to delete, then choose Delete Keyframes from the shortcut menu.

If there are multiple keyframes applied at the playhead position, they’re all deleted.

## Delete all of an object’s keyframes in the Timeline

- Control-click any keyframe, then choose Delete All Keyframes from the shortcut menu.

For more control of effects using keyframes, you can use the Keyframe Editor.

**Note:** Although you can delete keyframes in the Timeline, there is no way to add keyframes from the Timeline.

## Align a keyframe to a marker in the Timeline

In the Timeline, you can align a keyframe with other important timed events. For example, you might want to align a filter keyframe applied to one object with the In or Out point of another object, or to a marker, or to a keyframe in another track.
1. Turn on the Show Keyframes button at the top of the Timeline.

2. Turn on the Snapping button at the top of the Timeline.

When the Snapping button is on, it’s highlighted blue.

3. Holding down the Shift key, drag a keyframe in the Timeline until it snaps to a marker, another keyframe, or In or Out point of another object.

In the following image, the keyframe snaps to the purple marker in the Timeline ruler.

About keyframes and effect duration

When you change the duration of an effect such as a filter or behavior in the Timeline track area, the timing of all keyframes applied to that effect is scaled proportionally. This means that
keyframed changes to an effect speed up or slow down when the effect is shortened or lengthened. This happens whether you change the duration of the effect bar, or change the duration of the image bar an effect is applied to.

Object parameters such as Position, Rotation, Scale, Opacity, and so on are not affected.

**Tip:** To change the duration of a timebar without altering the timing of keyframes, hold down the Command key while dragging one end of the bar left or right.
Work in the Keyframe Editor

Display the Keyframe Editor

The Keyframe Editor provides a visualization of changing keyframe values in the form of *animation curves*. Animation curves plot keyframes on a line over time; changing keyframe values modify the shape of the curve. In the Keyframe Editor, you can view and modify these curves to fine-tune animation in your project.

On the left side of the Keyframe Editor, a parameter list shows parameters that have keyframes. And on the right side, a graph area displays animation curves for those keyframed parameters. The Keyframe Editor makes it easy to add and delete keyframes, as well as move them in two-dimensional space to modify their values (up-down) and their positions in time (left-right). You can manipulate curves and define a variety of interpolation methods, creating dramatically different types of effects.

For a complete list of Keyframe Editor features, see Keyframe Editor controls.

Show the Keyframe Editor

Do one of the following:
Click the Show Keyframe Editor button in the bottom-right corner of the Motion workspace.

Choose Window > Keyframe Editor.

Press Command-8.

The Keyframe Editor appears in the Timing pane (under the Timeline if the Timeline is displayed).

Keyframe Editor controls

The Keyframe Editor comprises a list of parameters on the left, a multifunctional graph on the right where keyframes and curves for each parameter are displayed, and tools for modifying keyframes and curves. These elements are described below:
- **Show Curve Set pop-up menu**: Choose an item from the menu to filter the parameters shown in the Keyframe Editor. For more information, see *Choose a curve view*.

- **Keyframe editing tools**: Select any of three tools for editing keyframes and curves in the graph:
  - **Edit Keyframes tool**: Select and edit keyframes the same way you edit Bezier curves.
  - **Sketch Keyframes tool**: Manually draw curves that generate keyframes conforming to the shape drawn.
  - **Transform Keyframes tool**: Drag a selection box to enclose and manipulate a group of keyframes simultaneously.

For more information about using these tools, see *Modify keyframes*.

- **Parameter list**: View keyframeable parameters of selected
objects, including image layers, filters, and behaviors. When you select multiple objects in the Layers list or Timeline, you can compare their parameters here. The parameter list contains the following items:

- **Activation checkbox**: Checkboxes in the left column set which parameters are displayed in the graph. Deselect a checkbox to hide a parameter’s keyframes and curves from the graph on the right.

- **Parameter name**: Object and parameter names appear in the second column of the parameter list. Control-click a parameter name to apply a Parameter behavior from the shortcut menu.

- **Value**: Parameter values at the playhead position appear in the third column. Modify a parameter value by dragging left or right over the number in this field. Or double-click the field, then enter a value. The value displayed and editing options depend on several factors: If the playhead is on a keyframe, this field shows the value for that keyframe, and adjusting the value alters the keyframe. If the playhead is not on a keyframe, this field shows the value of that parameter at the current frame. If the parameter has keyframes, adjusting the value creates a new keyframe at that frame. (For more information on changing the values of keyframes, see Modify keyframes.)

- **Keyframe and keyframe navigation buttons**: Keyframe controls appear in the fourth column. These controls are identical to those found in the Inspector: the Previous Keyframe button, Add/Delete Keyframe button, and Next Keyframe button. See Animate parameters in the Inspector.
Animation menu: The Animation menu appears in the fifth column for each parameter in the list. To open this menu, position the pointer over this column (in the row of the parameter you want to animate), then click the downward arrow that appears. The Animation menu in the Keyframe Editor contains all commands found in the Inspector’s Animation menu, plus several additional commands:

- **Reset Parameter**: Removes keyframes and settings for the parameter, restoring the default value.
- **Add**: Adds a keyframe at the current frame in the Keyframe Editor. If the playhead is positioned on a frame where a keyframe has been added, this command is unavailable. (Alternatively, you can use a keyboard shortcut—Control-K—to add a keyframe.)
- **Delete**: Deletes the current keyframe. This command is available if the playhead is positioned on a frame where a keyframe exists.
- **Previous**: Moves the playhead to the previous keyframe for this parameter. This command is available if a keyframe exists earlier in the project.
- **Next**: Moves the playhead to the next keyframe for this parameter.
• **Next:** Moves the playhead to the next keyframe for this parameter. This command is available if a keyframe exists later in the project.

• **Enable/Disable Animation:** Activates or deactivates the keyframed value. Choosing Disable Animation hides the keyframes you set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation returns the parameter to its last keyframed state.

• **Interpolation:** Sets the type of curve for the parameter. See Curve interpolation methods for examples of the different interpolation methods. Choose Constant, Linear, Bezier, Continuous, Exponential, or Logarithmic.

• **Before First Keyframe:** Defines what happens between the first keyframe and the beginning of the clip. See Set curve extrapolation for examples of extrapolation methods. Choose Constant, Linear, Ping Pong, Repeat, or Progressive. You can also turn the extrapolation into keyframes by choosing Generate Keyframes.

• **After Last Keyframe:** Defines what happens between the last keyframe and the end of the clip. See Set curve extrapolation for examples of extrapolation methods. Choose Constant, Linear, Ping Pong, Repeat, or Progressive. You can also turn the extrapolation into keyframes by choosing Generate Keyframes.

• **Lock/Unlock Parameter:** Locks the parameter from changes. When a parameter is locked, neither keyframes nor curves are adjustable.

• **Reduce Keyframes:** Opens the Reduce Keyframes dialog, which lets you apply a thinning algorithm to the
keyframes for the parameter. This reduces the number of keyframes in a parameter while preserving the shape of the curve. The thinning algorithm can be adjusted in two ways: Increasing the Maximum Error Tolerance results in fewer keyframes; increasing the Smoothing Factor makes smoother curves between keyframe values.

- **Set to Curve Snapshot:** Reverts keyframe changes made in the selected curve to the most recent snapshot. This command is available when Take/Show Curve Snapshot is turned on (the camera button in the upper-right corner of the Keyframe Editor). For more information, see [Compare a modified curve to its previous state](#).

- **Graph area:** Shows the keyframes and curves of active parameters (those in the parameters list). Each curve is a different color, although some colors are duplicated. Areas before the first keyframe and after the last keyframe are represented by dotted lines. Selected parameters and keyframes appear white.

A time ruler shows the locations of keyframes, project markers, playback In and Out points, and the playhead. Zoom controls at the bottom of the graph let you focus on specific regions of the sequence. For more information on using the zoom/scroll controls, see [Customize the Timeline](#).

- **Audio Waveform pop-up menu:** Turns on the display of audio waveforms for the selected item in the background of the graph. This lets you line up an effect to take place at the same time as an event that occurs in the audio. If there are multiple audio tracks in the project, you can use this menu to view the
waveform of any individual audio track in the project, or the master track.

- **Clear Curve List button**: Deletes all items in the parameter list from a custom set.

- **Fit Visible Curves in Window button**: Scales the graph area vertically and horizontally so that the curve is entirely visible. This button does not change the value of your keyframes.

- **Take/Show Curve Snapshot button**: Turns on and turns off the state of all curves in the Keyframe Editor. With a snapshot turned on, the original unaltered curve is represented by a lighter color—visible in the background behind the curves you’re adjusting—and can be used as a reference showing the curve’s original values. As long as you remain in the Keyframe Editor editing the current set of curves, the snapshot curve remains available. Clicking this button again causes the current snapshot to disappear. For more
information about curve snapshots, see Compare a modified curve to its previous state.

- **Snapping button**: Enables snapping. When this control is enabled, keyframes snap to markers, other keyframes, and other snappable items.

- **Auto-Scale Vertically to Fit Curves button**: Rescales the graph vertically so that the curve is entirely visible. This does not change the value of your keyframes.

**Tip**: You can show the Keyframe Editor on a second display, providing a larger workspace for modifying keyframes and curves. For more information, see View the Canvas or Timing pane on a second display.

### Modify keyframes and curves

#### Add or delete keyframes

To add or delete keyframes in the Keyframe Editor, select the Edit Keyframes tool (above the parameter list), then perform the
following tasks:

Add a keyframe

- In the parameter list (on the left side of the Keyframe Editor), click the Animation menu for any parameter, then choose Add.

**Note:** The Animation menu (a downward arrow) is hidden until you place the pointer over the right side of the parameter’s row in the list.

A keyframe is added at the position of the playhead.

Add a keyframe to an existing animation curve

- In the Keyframe Editor, double-click or Option-click the animation curve in the graph area.

A keyframe is added to the curve at the pointer position. The new keyframe is set to the interpolation method used by the rest of that curve. For example, Position parameters use Bezier curves by default, so new keyframes are added as Bezier keyframes. For more information on interpolation methods, see Set curve interpolation.
Add a keyframe to an animation curve and adjust its value

- In the Keyframe Editor, Option-drag a curve segment.

  A keyframe is added to the segment at the pointer position, and its value is displayed as you drag the keyframe.

Delete a keyframe

Do one of the following:

- Select the keyframe in the Keyframe Editor, then press Delete.

  Note: You can drag a selection box around multiple keyframes.

- Control-click the keyframe, then choose Delete from the shortcut menu.

- Navigate to the keyframe, then click the Animation menu for the keyframed parameter and choose Delete.

  The Animation menu is hidden until you place the pointer over the right side of a parameter row.

Delete all of a parameter’s keyframes

- In the parameter list in the Keyframe Editor, click the
Animation menu for a parameter, then choose Reset Parameter.

The Animation menu is hidden until you place the pointer over the right side of a parameter row.

**Note:** You can also use the corresponding Animation menu in the Inspector.

---

**Modify keyframes**

To modify keyframe values in the Keyframe Editor, select the Edit Keyframes tool (above the parameter list), then perform the following tasks:

- **Change the value of a keyframe**
  
  Do one of the following:
  
  - In the graph area of the Keyframe Editor, drag the keyframe along the Y axis (up-down) to change its parameter value. To change its position in time, drag along the X axis (left-right).
  
  Press the Shift key while dragging to constrain movement to one axis. (To constrain keyframes to the Y axis, select “Lock keyframes in time in Keyframe Editor” in the Time pane of the
Motion Preferences window.

When dragging a keyframe in the graph, numbers appear indicating the position and value of the keyframe. The first number is the frame number (or timecode number) and the second number is the parameter value.

When you drag two keyframes closer along the X axis, the transformation between those values happens more quickly. When you drag keyframes farther apart from each other, the change happens more slowly.

- Double-click the keyframe to modify, enter a value in the value field, then press Return.
This changes the value of the keyframe along the Y axis (up-down).

**Note:** To dismiss an active value field without making changes, press Esc.

- In the parameter list, drag a value slider:
  - Drag right to increase the keyframe value.
  - Drag left to decrease the keyframe value.
  - Hold down the Shift key while dragging to change the value in increments of 10.
  - Hold down the Option key while dragging to change the value in increments of .01.
**Move a keyframe in time by a specific number of frames**

1. Select a keyframe in the Keyframe Editor.

2. Do any of the following:
   - *Move the selected keyframe to a specific frame*: Enter a number, then press Return.
   - *Move the selected keyframe forward by a specific number of frames*: Enter a plus sign (+) and the number of frames, then press Return.
   - *Move the selected keyframe back by a specific number of frames*: Enter a minus sign (−) and the number of frames, then press Return.

**Change keyframe values by moving an entire curve**

You can select and move animation curves in the graph area of the Keyframe Editor.

Do one of the following:

- Holding down the Option and Command keys, drag a keyframe on the curve up or down.
- Holding down the Option and Command keys, drag a curve segment between two keyframes up or down.
Change keyframe values by moving a segment of the curve

In the Keyframe Editor, Shift-select the keyframes that bound the path segment or segments you want to move, then drag one of the selected keyframes up or down.

The path segment moves up or down, changing the shape of the curve.

Reverse, lock, and disable keyframes

With the Edit Keyframes tool (above the parameter list) selected, you can also perform advanced keyframe modifications. You can reverse keyframes to invert the corresponding animated effect without re-animating it, lock keyframes (individually or in groups) to prevent accidental adjustment, or disable an entire curve to suspend animation for that parameter.

Reverse keyframes

1. In the graph area Keyframe Editor, drag a selection rectangle in the graph to select the keyframes to reverse.
2. Control-click a selected keyframe, then choose Reverse Keyframes from the shortcut menu.

The keyframes are reversed.

**Lock keyframes**

- In the Keyframe Editor, select the keyframes to lock, then control-click one of the keyframes in the graph and choose Lock from the shortcut menu.

Locking prevents further modification the keyframes. (You can also lock all keyframes in the Keyframe Editor by selecting “Lock keyframes in time in Keyframe Editor” in the Time pane of Motion Preferences.)

**Disable a curve**

- In the Keyframe Editor, select the keyframes to disable, then Control-click a keyframe in the graph and choose Disable from the shortcut menu.

Disabled keyframes are ignored and have no effect on the object’s animation. If you disable a keyframe, the curve readjusts itself as if that keyframe didn’t exist, even though the keyframe is present in the Keyframe Editor, in a dimmed state.

**Copy and paste keyframes and curves**
With the Edit Keyframes tool (above the parameter list) selected, you can copy and paste keyframes and animation curves. This technique is useful for copying a keyframed effect from one object to another, for moving a keyframe segment earlier or later in the same parameter, or for creating keyframes in one parameter and applying them to another.

Copy and paste keyframes

Use this technique to copy and paste a segment of an animation curve from one parameter to another, or from one object to another.

1. Select keyframes by doing one of the following:
   - In the graph area of the Keyframe Editor, drag a selection rectangle around the keyframes.
   - In the graph area, Shift-click the keyframes you want to select.

   Note: If the curve appears white but the keyframes do not, the keyframes are not selected.

2. Copy or cut the selected keyframes by doing one of the following:
   - Choose Edit > Copy (or press Command-C).
   - Choose Edit > Cut (or press Command-X).
3. To paste the keyframes to a different parameter, do the following:
   
   a. Select the destination parameter in the parameter list (on the left side of the Keyframe Editor).
   
   b. Place the playhead at the point where you want the keyframes to begin.
   
   c. Choose Edit > Paste (or press Command-V).

   The keyframes are added to the new parameter.

   Note: Pasted keyframes might not make a curve identical to the original if the parameter scales are different.

---

### Copy and paste an animation curve

Use this technique to copy and paste an entire animation curve from one parameter to another, or from one object to another.

1. Select an animation curve by doing one of the following:
   
   • Select a row in the parameter list of the Keyframe Editor.
   
   • Shift-click or Control-click in the parameter list of the Keyframe Editor to select multiple rows.

2. Choose Edit > Copy (or press Command-C) to copy the selected curve.

   Note: You cannot use the Cut command on a complete
3. To paste the curve to a different parameter, do the following:

a. In the parameter list of the Keyframe Editor, select the destination parameter.

b. Choose Edit > Paste (or press Command-V).

The curve is added to the new parameter.

**Note:** Pasted animation curves might not make a curve identical to the original if the parameter scales are different.

---

**Manually draw an animation curve**

The Sketch Keyframes tool (next to the Edit Keyframes tool) lets you sketch animation curves in the Keyframe Editor graph area, creating keyframes as you go. To sketch a curve, the parameter to animate must first appear in the parameter list. See Create a custom curve view for methods of displaying curves.

---

**Sketch an animation curve**

1. In the parameter list in the Keyframe Editor, select the
2. Select the Sketch Keyframes tool (the pencil icon above the parameter list).

3. Drag in the graph area to sketch an animation curve.

Drawing new keyframes overwrites existing keyframes at the frames where you draw.
Add an individual keyframe using the Sketch Keyframes tool

1. In the parameter list of the Keyframe Editor, select the parameter to modify.

2. Select the Sketch Keyframes tool (the pencil icon above the parameter list).

3. Click in the graph area to add a keyframe.

   Additional clicks create additional individual keyframes.

Transform multiple curve segments simultaneously

Use the Transform Keyframes tool to drag a selection box around multiple keyframes and then manipulate their positions by dragging the box or adjusting its handles. Dragging the selection box moves the selected keyframes in whatever direction you move. As a result, you can affect where the keyframes are positioned in time or you can affect their parameter values, or you can do both at the same time. Adjusting a selection box handle scales the keyframes, changing their timing and parameter values.
Draw a selection box using the Transform Keyframes tool

1. Select the Transform Keyframes tool (above the parameter list in the Keyframe Editor).

2. In the graph area, drag to create a selection box enclosing the keyframes you want to manipulate.

A box with eight handles appears in the graph area.

Important: When transforming keyframes using the Transform Keyframes tool, by default keyframes are adjusted in whole-frame increments. You can adjust keyframe in sub-frame increments if the “Allow sub-frame keyframing” checkbox is turned on in the Time pane of Motion Preferences. Sub-frame adjustments allow greater precision, but use the Next/Previous Keyframe controls (or keyboard shortcuts) to move the playhead to keyframes that are between frames. If you move a sub-frame-adjusted keyframe using the pointer, the frame snaps to the nearest whole frame.
Drag the selection box to change keyframe timing and parameter values

- Drag inside the selection box to move the box and the enclosed keyframes.

Moving left and right repositions the keyframes in time, and moving up and down increases and decreases the parameter values of the keyframes.

**Note:** No matter where you drag the box, only the keyframes selected by the original box are manipulated, even if the repositioned box overlaps keyframes outside the original selection. To manipulate additional keyframes, redraw the selection box in the graph area.

Scale the selection box relative to the handle opposite the one you’re dragging

- Drag any handle to resize the selection box.

The selection box changes shape relative to the handle on the opposite side or corner of the box, which remains locked in place.

Scale the selection box about its center
Hold down the Option key and drag a handle of the selection box.

Both sides of the box scale up or down around its center as you drag along the axes.

**Deform the selection box asymmetrically**

Hold down the Command key and drag a corner handle of the selection box.

Each corner handle moves independently of the other three corner handles of the selection box.

**Deselect the selection box**

Do one of the following:

- In the Keyframe Editor, click once anywhere outside the selection box.
- Choose the Edit Keyframes tool.

The selection box disappears.

**Tip**: You can also draw a new selection box outside of the old one to surround a different group of keyframes.

Apply a Parameter behavior to a curve
Parameter behaviors can also be applied to curves via the Keyframe Editor.

### Apply a Parameter behavior to an animation curve

- In the Keyframe Editor parameter list, Control-click a curve name and choose a Parameter behavior from the shortcut menu.

### SEE ALSO

- About behaviors and keyframes in the Keyframe Editor
- Add, remove, and disable a Parameter behavior

### Compare a modified curve to its previous state

When modifying keyframes, it’s helpful to have a frame of reference for your curves. A saved reference of curves lets you compare modified curves to the original curves. Additionally, a saved reference—known as a *curve snapshot*—acts as a safety net if you need to restore a curve’s original state.

### Take a curve snapshot

- Click the Take/Show Curve Snapshot button in the upper-right
With Take/Show Curve Snapshot enabled, as you move keyframes in the Keyframe Editor, the original curve—as it appeared when you took the snapshot—retains its color. As long as you remain in the Keyframe Editor editing the current set of curves with the Take/Show Curve Snapshot button enabled, the snapshot curve remains available.

Revert a curve to its most recent snapshot

If, after editing a curve, you want to revert to the snapshot, you can do so from the Animation menu in the Keyframe Editor.

- In the Keyframe Editor, click the Animation menu for the parameter you want to revert, then choose Set to Curve Snapshot.

The Animation menu (a downward arrow) is hidden until you
move the pointer over the right side of the parameter row.

The curve reverts to the state of its most recent snapshot.

**Important:** If you leave the Keyframe Editor, or load a different set of curves into the Keyframe Editor, curve snapshots are taken again, replacing the previous curve snapshots.

Set curve interpolation and extrapolation

Set curve interpolation

Although you can manually create nearly any curve shape to build the animation you want, the Keyframe Editor provides tools to control the automatic interpolation of curves—that is, the computed values between keyframes. Depending on the interpolation method you choose, you can dramatically alter the shape of animation curves, and therefore the impact of your effects.

To set the interpolation for a curve, you select the keyframe you want to modify, then choose a distribution algorithm. For more information about the preset algorithms, see [Curve interpolation methods](#).

Set an interpolation method for a keyframe
Do one of the following:

- Control-click a keyframe in the Keyframe Editor, choose Interpolation from the shortcut menu, then choose a method from the submenu.

- Select multiple keyframes, Control-click one of them, choose Interpolation from the shortcut menu, then choose a method from the submenu.

The interpolation method chosen is applied to the entire selection.

---

**Set an interpolation method for a curve segment**

- Control-click a segment between two keyframes in the Keyframe Editor, choose Interpolation from the shortcut menu, then choose a method from the submenu.

Only the segment between the surrounding two keyframes is affected by the interpolation method you choose. You can set different interpolation methods for other segments of the same curve.
When different interpolation methods are applied to segments of an animation curve, the methods used in the curve appear with a dash next to their name in the Interpolation submenu (in the Keyframe Editor parameter list).

**Change the interpolation method for an entire parameter**

- Click in the fifth column of the Keyframe Editor parameter list to open the Animation menu for the parameter, then choose a method from the Interpolation submenu.
The selected interpolation method is applied to that parameter’s curve.

### Change the interpolation method for multiple parameters

1. In the parameter list of the Keyframe Editor, Shift-click to select multiple parameters.

2. Click in the fifth column of the Keyframe Editor parameter list to open the Animation menu, then choose a method from the Interpolation submenu.

   The selected interpolation method is applied to all selected curves.

**SEE ALSO**

Curve interpolation methods
Curve interpolation methods

The Interpolation submenu of the Animation menu contains the following methods that set the shape of curves between keyframes:

- **Constant:** When applied to a keyframe or curve segment, this method holds the keyframe at its current value and then abruptly changes to the new value at the next keyframe.

- **Linear:** When applied to a keyframe, this method creates a uniform distribution of values through the keyframe from its two adjacent keyframes. When applied to a segment, this method creates uniform distribution of values between points.

- **Bezier:** This method lets you manipulate the keyframe curve manually by dragging the tangent handles. If multiple Bezier keyframes are selected, or Bezier interpolation is applied to the curve segment, the handles of all selected keyframes are modified.

- **Continuous:** This method behaves like Bezier interpolation, but
- **Continuous**: This method behaves like Bezier interpolation, but without access to the tangent handles (which are calculated automatically). The parameter begins to change gradually, reaching its maximum rate of acceleration at the midpoint, then tapers off slightly as it approaches the second keyframe. When applied to a keyframe, the segments before and after the keyframe are affected. When applied to a curve segment, the segment between the keyframes is affected.

![Continuous](image)

- **Exponential**: This method creates an exponential curve between the current keyframe and the next, changing the value slowly at first, then reaching its maximum rate of acceleration as it approaches the next keyframe.

![Exponential](image)

- **Logarithmic**: This method creates a logarithmic curve between the current keyframe and the next, changing the value rapidly at first, then slowing drastically as it approaches the next keyframe.

![Logarithmic](image)

- **Ease In**: This method has a reverse-inertia effect, so a value change slows coming into a keyframe. When applied to a
curve segment, the value change eases into the segment. This option is available only when you Control-click a keyframe; it is not available in the Animation pop-up menu.

- **Ease Out**: This method creates a typical inertia-like lag, so a value change begins more slowly coming out of a keyframe. When applied to a curve segment, the value change eases out of the segment. This option is available only when you Control-click a keyframe; it is not available in the Animation pop-up menu.

- **Ease Both**: This method combines Ease In with Ease Out, applying both at once. This option is available only when you Control-click a keyframe; it is not available in the Animation pop-up menu.

SEE ALSO

Set curve interpolation
Convert to Bezier interpolation

Bezier interpolation—the default keyframe type—is the most flexible method of curve generation because it allows manual modification of the curve. If you’ve converted Bezier keyframes to another linear keyframes, Motion lets you convert them back to Bezier keyframes.

Convert a linear keyframe into a Bezier keyframe

While holding down the Command key, drag the keyframe in the keyframe graph.

Tangent handles appear and your mouse movement controls one of the handles.

Note: Command-clicking a Bezier point resets it to Linear interpolation.

To simultaneously modify the tangent handles of more than one keyframe point, Shift-click to select multiple points, then adjust the
Adjust tangents of a keyframe point

Each Bezier keyframe point has two tangent handles that adjust the angle of curve at the keyframe. By default, these handles are locked together (moving one moves the other, creating a uniform curve at the keyframe point). However, you can break the handle to create separate curve segments on each side of a keyframe point. Doing so lets you create irregular curves.

Do any of the following:

- "Break" tangent handles to adjust one independently of the other: Hold down the Option key and drag a tangent’s handle, or Control click a tangent handle, then choose Break Handle from the shortcut menu.

- Relink broken tangent handles: Hold down the Option key while dragging a tangent, or Control-click a tangent handle and choose Link and Align Handles.
Constrain a tangent handle’s angle to 45-degree increments

- While holding down the Shift key, drag the handle.

Set curve extrapolation

When you begin adding keyframes, you instruct Motion to modify the in-between frames to *interpolate* the effect. But what values are used for the frames before the first keyframe and after the last one?

By default, when you add your first keyframe, that same value is extended forward and backward to the beginning and end of the clip (as if you hadn’t added a keyframe). In other words, the frames before that first keyframe remain at the value of that first keyframe. Similarly, the frames after the last keyframe hold at that last defined value.

You can override this default behavior to create loops and other
patterns. This is known as *extrapolation*. When you apply an extrapolation method to a parameter, animation is added beyond your first or last keyframes. Extrapolation is useful when you need to extend the duration of an effect such as a moving background. Several extrapolation algorithms are available in the Before First Keyframe and After First Keyframe submenus of the Animation menu. For descriptions of the preset algorithms, see *Curve extrapolation methods*.

### Apply an extrapolation method to a parameter before the first keyframe

- In the Keyframe Editor, click in the fifth column of the parameter list to open the Animation menu for the parameter to change, then choose an item from the Before First Keyframe submenu.
Apply an extrapolation method to a parameter after the last keyframe

- In the Keyframe Editor, click in the fifth column of the parameter list to open the Animation shortcut menu for the parameter to change, then choose an item from After Last Keyframe submenu.

SEE ALSO

Curve extrapolation methods

Curve extrapolation methods

The following extrapolation options are available in the Before First Keyframe and After Last Keyframe submenus. (In each of the illustrated examples below, the extrapolation setting is applied after the last keyframe.)

- **Constant**: This method, the default, holds the beginning or ending segments of the curve to the same value as the first or last keyframe.
- **Linear**: This method extends the curve beyond the first or last keyframes uniformly, along the existing trajectory of the first or last keyframe.

- **Ping Pong**: This method copies the curve and repeats it, alternating forward and backward.
• *Repeat:* This method duplicates the curve, applying it again and again.

• *Progressive:* This method extends the curve by repeating the existing shape of the curve, but rather than returning to the exact values, repeats from the existing end value.
SEE ALSO
Set curve extrapolation

Convert extrapolation data into keyframes

By default, keyframe extrapolation occurs without creating keyframes. This lets you experiment with various methods. However, you can convert an extrapolation method into keyframes to further manipulate them, using the Generate Keyframes command. You can choose how many extrapolation cycles you want converted into keyframes. Cycles after the number chosen remain in the extrapolated state.
Convert extrapolation data into keyframes

1. In the Keyframe Editor, click the Animation menu for the parameter you want to modify, then choose Generate Keyframes from the Before First Keyframe or After Last Keyframe submenu.

The Animation menu remains hidden until you position the pointer over the fifth column in the parameter list.
The Generate Keyframes dialog appears.

2. Choose the number of cycles to be keyframed.

3. Click OK to confirm your selection.

SEE ALSO
- Choose which curves are displayed in the Keyframe Editor
- Choose a curve view

Choose which curves are displayed in the Keyframe Editor

Choose a curve view

Displaying too many parameters in the Keyframe Editor can make the graph area difficult to read. You can limit the list of parameters displayed in the graph area by choosing a view option from the Show Curve Set pop-up menu.

Located at the top of the parameter list, the Show Curve Set pop-up menu lets you display built-in parameter curve sets as well as custom sets you build yourself. (For information about creating a custom curve set, see Create a custom curve view.) The Curve
Set pop-up menu displays the name of the selected curve set (Animated, All, or Modified, for example).

**View all parameters for all selected objects**

- Click the Show Curve Set pop-up menu, then choose All.

By default, only animated parameters display curves in the graph. Nonanimated parameters appear as dotted lines. Deselect a parameter’s activation checkbox to hide it in the graph. You can display or hide all parameters associated with a group or object by selecting or deselecting its checkbox.

**View only animated (keyframed or behavior-influenced) parameters**
Click the Show Curve Set pop-up menu, then choose Animated.

Parameters with more than one keyframe are displayed.

**View keyframes for a specific parameter of an object**

- In the Inspector, click the Animation menu for the parameter, then choose Show in Keyframe Editor.

  **Note:** The Animation menu is hidden until you place the pointer over the right side of a parameter row.

  The keyframes appear in the Keyframe Editor and an untitled curve set is selected in the Show Curve Set pop-up menu.

**View parameters changed from their default values**

- Click the Show Curve Set pop-up menu, then choose Modified.

  This option shows the parameters that have been modified from their default values, or are currently being modified (in the Canvas, Inspector, or HUD).

**View only active parameters**
Click the Show Curve Set pop-up menu, then choose Active.

This option shows only parameters being modified in real time. For example, with Active selected, dragging an object in the Canvas displays its X, Y, and Z Position parameters in the Keyframe Editor.

**View keyframes corresponding to a specific parameter**

- Click the Show Curve Set pop-up menu, then choose a parameter type (such as Rotation, Opacity, or Retiming).

  Only parameters of the chosen type are displayed.

**View keyframes corresponding to a specific parameter for multiple objects**

1. In the Layers list, Canvas, or Timeline layers list, Shift-select the objects that contain keyframes you want to view.

2. In the Keyframe Editor, click the Show Curve Set pop-up menu, then choose a parameter type (such as Scale).

  Only parameters of the chosen type are displayed for the selected objects.

**SEE ALSO**
Create a custom curve view

Create a custom curve view

In addition to using the built-in curve set views, you can make and manage your own view using the last two options in the Show Curve Set pop-up menu: New Curve Set and Manage Curve Sets. As you create and store custom parameter sets, they appear in the Show Curve Set pop-up menu (at the top of the parameter list in the Keyframe Editor), allowing you to switch between them. Deleting, duplicating, and modifying custom sets is done in the Manage Curve Sets dialog (accessible from the Show Curve Set pop-up menu).

Create a custom curve set

1. Click the Show Curve Set pop-up menu, then choose New Curve Set.

   A dialog appears.

2. Enter a name for the set, then click OK.

   After you create a curve set, you can choose it from the Show Curve Set pop-up menu.
Add parameters to a custom curve set

Do one of the following:

- After you create a custom curve set, drag a parameter name from any pane in the Inspector into the Keyframe Editor parameter list.

In the Inspector, click the Animation menu for the parameter, then choose Show in Keyframe Editor.

The Animation menu (a downward arrow) remains hidden until you position the pointer over the far-right side of the parameter row you want to modify.

The parameter is added to the custom curve set.

Delete a parameter from a custom curve set
Delete a parameter from a custom curve set

- In the Keyframe Editor, drag the parameter out of the list.

Delete all parameters from a custom curve set

- Click the Clear Curve List button in the top-right corner of the Keyframe Editor.

Delete a custom curve set

1. In the Keyframe Editor, click the Show Curve Set pop-up menu, then choose Manage Curve Sets.

The Manage Curve Sets dialog appears.
2. Select the name of the set to delete.

3. Click the Delete button (−) at the top of the dialog.

   The set is deleted.

4. Click Done to close the dialog.

---

**Duplicate a custom curve set**

1. In the Keyframe Editor, click the Show Curve Set pop-up menu, then choose Manage Curve Sets.

   The Manage Curve Sets dialog appears.

2. Select the name of the set to duplicate.

3. Click the Duplicate button at the top of the dialog.

   The set is duplicated.

4. Double-click the set name in the list, then enter a name for the set.

5. Click Done to close the dialog.

   The new set now appears in the Show Curve Set pop-up menu. These sets are saved with the project, so each time you reopen the project, they are available. You can store as many parameter sets as you like. After you store a set, you can change or delete that set as needed.
Switch between custom curve sets

Use the Manage Curve Sets dialog to switch back and forth between custom curve sets that contain common animated parameters. For example, if you created a custom curve set for an object’s Position and Rotation parameters, and your project also contains another object with animated Position and Rotation parameters, you can switch back and forth between their curve sets.

1. In the Keyframe Editor, click the Show Curve Set pop-up menu, then choose Manage Curve Sets.

2. Select the Relative checkbox in the left column of the Manage Curve Sets dialog.

The curve set is displayed for the currently selected object.

SEE ALSO
Choose a curve view

Save an animation curve

After you apply keyframed animation to an object, you can save its curve to the Library and then apply your custom animation to an object in any project. Animation curves saved in the Library appear with a custom icon.
**Note:** Items saved to the Library appear in the Finder with a `.molo` extension (“Motion Library object”). These items cannot be opened from the Finder.

If you create animation that uses multiple curves and you want to save the cumulative effect of the animation, you can save all curves as one item in the Library.

Although you can save animation curves into the Content category of the Library, it’s generally recommended that you save items you use frequently in the Favorites category—some Motion Library categories contain so many items that using the Favorites or Favorites Menu categories can save you search time. In the Favorites category, you can create additional folders to organize custom items.

You can also create folders in existing categories, including Favorites, Favorites Menu, or Content. Folders created in the Content category appear in the Library sidebar. Folders created in subcategories, such as Basic Motion, appear in the Library stack and not the sidebar. For more information on creating folders in the Library, see [Save custom behaviors](#). 

Animation curves saved to the Favorites Menu category can be applied to objects using the Favorites menu.

---

**Save an animation curve to the Library**

1. Open the Library and select the Favorites or Favorites Menu category.
2. Drag the name of the parameter animation curve to save from the parameter list in the Keyframe Editor into the stack at the bottom of the Library.

The saved animation curve is placed in the
/Users/username/Library/Application Support/Motion/Library/Favorites folder or the
/Users/username/Library/Application Support/Motion/Library/Favorites Menu folder.

Note: If you drag an animation curve to another subcategory, such as the Glow (Filters) subcategory, the curve is placed in the Content category, which becomes active.

Save multiple animation curves to the Library

1. Open the Library and select the Content, Favorites, or Favorites Menu category.

2. In the parameter list of the Keyframe Editor, select the animation curves you want to save and drag them to the stack, holding down the mouse button.

3. When the drop menu appears, choose “All in one file” or “Multiple files.”

“All in one file” saves the animation curves together, listed as one item in the Library. “Multiple files” saves the curves as individual items in the Library.
**Note:** When you Control-click an animation curve icon in the Library stack, the Edit Description shortcut menu item becomes available. This is a handy tool for entering custom notes about an item saved in the Library. After you choose Edit Description, enter your notes in the text field, then click OK.

For information on naming items saved to the Library, saving multiple items of different types to the Library, as well as creating and organizing folders in the Library, see [Save custom objects to the Library](#).

---

**Work in the mini-curve editor**

Mini-curve editors provide a way to animate parameters outside the Keyframe Editor’s interface using keyframes in a graph. Animations created in a mini-curve editor don’t appear in the Keyframe Editor.

Two Particle behaviors—Scale Over Life and Spin Over Life—have mini-curve editors in the Inspector (when the Increment Type parameter is set to Custom). Mini-curve editors are also present for paint objects, in the Stroke pane of the Shape Inspector.

By default, the mini-curve editor is collapsed and shows a scaled-down representation of the parameter curve.
Expand a mini-curve editor

- Click the disclosure triangle next to the collapsed mini-curve editor in the Inspector.

The expanded mini-curve editor appears.

When expanded, the mini-curve editor shows a representation of the relevant animation curve. In the example above, the Over Life parameter is mapped to the X axis and the Custom Spin parameter is mapped to the Y axis.

Add keyframes in the mini-curve editor

The procedure for adding keyframes in a mini-curve editor is slightly different than adding them in the full-sized Keyframe Editor.
Do one of the following:

- Double-click the curve.
- Option-click the curve.
- Control-click the curve, then choose Add Keyframe from the shortcut menu.

**Modify a keyframe value in the mini-curve editor**

1. Double-click the keyframe in the mini-curve editor in the Inspector.
   
   Its value field is activated.

2. Enter a value in the value field, then press Return.

   **Note:** To dismiss an active value field without making changes, press Esc.

**Rescale the mini-curve editor so the entire curve is visible**

- Select the Auto Fit checkbox (located beneath the lower-right corner of the mini-curve editor).

  The animation curve is scaled to fit within the confines of the mini-curve editor.
The mini-curve editor provides the Edit Keyframes, Sketch Keyframes, and Transform Keyframes tools, and each functions in the same manner as in the Keyframe Editor. For more information on using the Edit Keyframes tool, see Modify keyframes. For more information on using the Sketch Keyframes tool, see Manually draw an animation curve. For more information on using the Transform Keyframes tool, see Transform multiple curve segments simultaneously.

Animate on the fly

Motion lets you create animations while your project is playing back. This is similar to how audio engineers adjust sliders for each audio channel while listening to the mix. The next time the project is played back, all changes are incorporated.

Because so many of Motion’s effects are displayed in real time, you can perform a sort of “visual mix” and modify the parameters of your effects while the project is playing back. Make adjustments to any slider or parameter, interactively manipulate objects in the Canvas, and then, if you don’t like the results, rewind and do it again. Each time you alter a parameter, you replace the keyframes previously assigned.

Animate a parameter on the fly via the Inspector or HUD
1. Click the Record button, press A, or choose Mark > Record Animation to turn on keyframe recording.

2. Click the Play button or press the Space bar to begin playback.

3. As your project plays, adjust a parameter slider in the Inspector or HUD.

4. Click the Record button again to disable Record. The changes you made during playback are recorded as keyframes for that parameter. You can view them in the Keyframe Editor.

   **Note:** You can also animate on the fly using the initial keyframe method. For more information on the initial keyframe method, see [Add keyframes](#).

---

### Delete keyframes recorded on the fly

If you don’t like the animation you made, you can delete the keyframes and try again.

Do one of the following:

- Choose Edit > Undo (or press Command-Z) to revert to the state before you began recording your animation.

- Select one or more keyframes, then press Delete.

- Control-click a keyframe, then choose Delete from the
shortcut menu.

- Select a keyframe, then choose Delete from the Animation menu for that parameter.

**Note:** To delete all keyframes for a parameter, click the Animation menu in the Keyframe Editor parameter list or Inspector, then choose Reset Parameter.

---

Create a handmade animation path in the Canvas

A common use for animating on the fly is to create hand-drawn animation paths. Although you can choose various curve types, it is very difficult to simulate semi-random movement except by sketching with a mouse or tablet pen.

1. Enable Record (press A).
2. Click the Play button to begin playback.
3. Select the object to manipulate and drag it in the pattern of your choice.

The position and speed of your movement are recorded and applied to the position keyframes for that object.
You can further manipulate the path by dragging individual keyframes, or re-recording a new animation path for that object.

Simplify a keyframe-heavy curve

When a parameter contains at least one keyframe, or when the Record button is enabled, a keyframe is added every time you modify a parameter at a new playhead position. If you animate while the project is playing, you create a keyframe at every frame. Additionally, when you convert a behavior to keyframes, you often end up with an unwieldy amount of keyframes.

In many cases, the curve created by your animation can be represented using fewer keyframes. Often, this provides a smoother rate of change and lets you take advantage of interpolation methods such as Bezier or Continuous.

You can streamline your keyframe curves in two ways: by
simplifying an existing animation curve using the Reduce Keyframes command in the Animation menu for that parameter or by adjusting keyframe thinning options before recording keyframes.

Reduce keyframes in an existing animation curve

1. Click the Animation menu for the parameter you want to modify (in the fifth column in the Keyframe Editor parameter list), then choose Reduce Keyframes.

   The Reduce Keyframes dialog appears.

   ![Reduce Keyframes Dialog]

2. Adjust the Error Tolerance and Smoothing parameters to obtain the curve you want.
Adjust keyframe thinning before animating on the fly

Use the Recording Options dialog to adjust the Keyframe Thinning setting or to disable recording during playback. (This setting has no effect on ordinary keyframing.)

1. Do one of the following:
   - Choose Mark > Recording Options (or press Option-A).
   - Double-click the Record button (under the Canvas).
   The Recording Options dialog appears.

2. Select a Keyframe Thinning option:
• **Off:** No thinning is applied. Keyframes are added at every frame where the parameter is changed.

• **Reduced:** Motion eliminates keyframes that can easily be replaced with a simple curve.

• **Peaks Only:** Only keyframes with dramatic value changes are recorded.

• **Don’t record keyframes during playback:** Select this checkbox if you don’t want keyframes to be recorded while the project is playing back.

3. Click OK.

---

### Disable animation recording during playback

If the Record button is enabled or a parameter contains at least one keyframe, keyframes are added when you make parameter adjustments. To prevent creating accidental animation, you can restrict automatic keyframing so it happens only when the project is not playing.

1. Choose Mark > Recording Options.

   The Recording Options dialog appears.

2. Select “Don’t Record keyframes during playback.”

3. Click OK.
Final Cut Pro X ships with numerous effects, titles, transitions, and generators, nearly all of which were created in Motion. You can modify these default effects or create your own using the Final Cut Pro templates that come with Motion. If you’re a content creator, you can build and distribute custom Final Cut Pro effects to other artists and editors or to clients.

When you save a Final Cut Pro template in Motion, the resulting effect, title, transition, or generator becomes available in one of the Final Cut Pro media browsers. For example, a transition template saved in Motion appears as a new transition in the Transitions Browser in Final Cut Pro, ready to be applied to an editing project. What’s more, in Motion, you can choose which parameters to publish, allowing the Final Cut Pro user complete, some, or no control over modifying the effect.

**Note:** Audio files saved in a Motion template will not be available in Final Cut Pro.

There are four types of Final Cut Pro templates:

- *Final Cut Effect:* Create a custom stylized effect that can be applied to clips in the Final Cut Pro Timeline. A sepia-tone color correction might make an audience think of days gone
by, while a radiant glow might suggest an otherworldly setting. See *Create an effect template*.

- **Final Cut Transition**: Create a custom transition that can be applied to clips in the Final Cut Pro Timeline. A transition artfully connects the edit point between two clips. One scene might dissolve into the next in a cloud of smoke, or one setting might displace another through a kaleidoscope. See *Create a transition template*.

- **Final Cut Title**: Create a custom text animation that can be added to a Final Cut Pro sequence. Text might flare in or out in a fiery glow, or fall into place from offscreen. See *Create a title template*.

- **Final Cut Generator**: Create generalized graphical content that can be added to a Final Cut Pro project. A Final Cut Generator is nearly identical to any other Motion project—it can include text, shapes, replicators, camera moves and lighting, generators, and so on. It can be static or animated. See *Create a generator template*.

**Important**: Because you cannot change template types after you open a project, determine what kind of template you want to build before creating a Motion project. A standard Motion project, however, can always be published as a Final Cut Generator.

**SEE ALSO**

Template workflow
Guidelines for better template creation

How do templates work?
How do templates work?

Template workflow

Creating templates for Final Cut Pro X in Motion involves several simple steps:

**Stage 1: Select a template type**

In the Motion Project Browser, create a new project by selecting one of four template types—Final Cut Effect, Final Cut Transition, Final Cut Title, or Final Cut Generator—then click Open.

**Stage 2: Add Motion effects to the template placeholders**

The new Motion template project that opens contains graphical placeholders—target layers (a downward arrow graphic in the Canvas) where you drag Motion behaviors, filters, and other special effects. You can include temporary images to preview the effect you are building. Ultimately, these effects will be applied to footage in Final Cut Pro. For more information, see **Placeholders versus drop zones**.

**Stage 3: Add additional layers and effects (if necessary)**

If your effect requires additional graphics, add new layers to the template (shapes, paint strokes, particles, and so on) and modify them with effects (lighting, camera moves, or filters, for example).
**Note:** These new graphics will ultimately be composited over Final Cut Pro clips and cannot be separated from the effect.

### Stage 4: Add user interface controls to make the template adjustable in Final Cut Pro

To allow Final Cut Pro users to modify specific parameters, you can “publish” sliders, checkboxes, or dials, making them available in the Final Cut Pro Inspector.

### Stage 5: Save the template project

When you save a template in Motion, the effect, transition, title, or generator is exported to the relevant Final Cut Pro media browser (the Effects Browser, Titles Browser, Transitions Browser, or Generators Browser). In Final Cut Pro, when the template is added to the Timeline or applied to a clip in the Timeline, an activation checkbox and published parameter controls appear in the Final Cut Pro Inspector.

The duration of the effect is determined by the length of the Final Cut Pro clip it is applied to. Special markers allow you to control the template’s timing in Final Cut Pro. See [What are template markers?](#)

### Placeholders versus drop zones

Most of the Final Cut Pro templates in Motion contain *placeholder*
layers, which appear in the Canvas as downward arrow graphics.

In Motion, you drag effects objects (behaviors, filters, and so on) into these placeholder layers. The result is a custom effect that you can later apply to clips in Final Cut Pro. When you do so, two things happen:

- The target clip in the Final Cut Pro Timeline populates the placeholder.
- The effects embedded in the placeholder are applied to the target clip.

Placeholder layers are not intended to hold source media (images or movie clips) that you apply in Motion. Although you can drag an image or clip into a placeholder in Motion to test what the effect will look like, those images are not used in Final Cut Pro.

If you want users to be able to add additional source media to an applied template in Final Cut Pro, you can add one or more drop zones to the template in Motion. Drop zones remain empty until users assign source media to them in Final Cut Pro.

Placeholders and drop zones can be scaled or transformed in templates to create certain looks and movements. For example, you can create a picture-in-picture effect by adding a drop zone
to a template, scaling the drop zone down, then positioning it in a corner of the Canvas. When a user applies the template to a clip in Final Cut Pro, that clip populates the effect, and an empty drop zone appears in the corner of the Viewer; the user can then assign a different clip to the picture-in-picture drop zone.

Placeholders and drop zones share many of the same parameters, such as Pan, Scale, and Fill Color. If you modify placeholder parameters in Motion (via the placeholder’s Image Inspector), those adjustments do not affect the clip in Final Cut Pro to which the effect template is applied. For drop zones, however, parameter modifications made in Motion do affect the media assigned to the drop zone in Final Cut Pro. For more information on drop zone (and placeholder) parameters, see Drop zone controls.

**Note:** Drop zones can also be used when creating Motion-specific templates (not for use in Final Cut Pro). For more information, see Drop zones overview.

### Work with effect templates

#### Create an effect template

Use the Final Cut Effect template to create a custom stylized effect that can be applied to clips in the Final Cut Pro X Timeline.

#### Create a new effect template
1. In Motion, choose File > New From Project Browser (or press Option-Command-N).

2. In the Project Browser, click Final Cut Effect, then click the Preset pop-up menu and choose a project size.

Important: Be sure to create the template at the highest resolution you will use in your Final Cut Pro project. If you are creating 4K-specific templates, you can enable a setting that allows the Final Cut Pro media browsers to display only templates designed for use in 4K projects. For more information, see Set template resolution.

3. Click Open (or press Return).

If the correct preset is already chosen, you can double-click Final Cut Effect in the Project Browser.

A new, untitled Motion project opens, with the Effect Source placeholder layer selected.
Note: You cannot delete the Effect Source placeholder from an effect template. Nor can you create additional Effect Source placeholders.

4. To add a reference image to the Effects Source placeholder to preview your work, do one of the following:

- From the File Browser or Library, drag a still image onto the placeholder arrow in the Canvas.
- From the File Browser or Library, drag a still image to the Effect Source layer in the Layers list.

Be sure to release the mouse button when the pointer is over the placeholder (the downward arrow in the Canvas or Effect Source layer in the Layers list). If you miss the target, you create a new layer, which cannot be dragged to the placeholder layer.

The image is added to the Effect Source layer, replacing the arrow graphic in the Canvas. This image is temporary media used to preview the result of the effect you are building. It is not used in the Final Cut Pro effect.
5. Add filters or behaviors to the Effect Source layer to create a custom effect.

The filter and behavior parameters can be modified and animated. For more information on working with filters, see Filters overview. For more information on behaviors, see Behaviors overview.

6. To allow Final Cut Pro users to modify specific parameters, choose Publish from the Animation pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or dial) available in the Final Cut Pro Inspector when the custom effect is applied to a clip. Published parameters can be adjusted and keyframed in Final Cut Pro. For more information, see Add parameter controls overview.

7. Optional: When you’re satisfied with the custom effect you’ve built, you can remove the preview image from the template by selecting the Effect Source layer, then clicking the Clear button in the Image Inspector.

8. Choose File > Save, then do the following:

   a. In the save dialog, enter a name for the template.

      If you don’t specify a name, the template appears in the Final Cut Pro Effects Browser as “New Template.”

   b. Choose a category from the Category pop-up menu.

      You can also create a custom category. Categories
represent how the effects are organized in the Motion Project Browser and in the Final Cut Pro Effects Browser. Custom categories also appear in the browsers.

c. If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in the Final Cut Pro Themes Browser. A theme is a metadata tag that assists in categorizing different templates as being part of a single family. For example, you may have different template types that are related to the same project, such as a transition, an effect, and a group of titles. By tagging the templates with the same theme, all templates, regardless of their template type, appear in the Final Cut Pro Themes Browser.

Themed templates also appear in other effects browsers. For example, a themed Final Cut Effect template appears in the Final Cut Pro Themes Browser as well as in the Effects Browser.

d. To retain unused media in the project (media or audio in the Media list that’s not used in the template but which you want to save for later inclusion), select “Include unused media.”

For information on where template-related files are saved, see About template files and media save locations.

e. If you want a preview movie to appear in the Motion Project Browser, select Save Preview Movie.

9. Click Publish.
The template and remaining media are saved and exported to the Final Cut Pro Effects Browser. If you did not remove the reference image, it appears in the template’s thumbnail in the Final Cut Pro Effects Browser.

**Apply the effect in Final Cut Pro**

- Locate the effect in the Final Cut Pro Effects Browser, then apply the effect to a clip in the Timeline.

  Images or clips used in the Motion placeholder layer appear in the Effects Browser icon, but are not applied to the clip in the Final Cut Pro Timeline.

For information about applying and editing effects in Final Cut Pro, see Final Cut Pro X Help.

**Modify a Final Cut Pro effect**

Many of the presets in the Final Cut Pro X Effects Browser were created in Motion. You can modify them in Motion, then save them as custom effects in Final Cut Pro.

For a step-through example of modifying a preset Final Cut Effect, see Example: Modify a preset Final Cut Pro effect in Motion.

1. In Final Cut Pro, click the Effects Browser button in the
The Effects Browser appears.

2. Locate the effect to edit.

To preview the effect, move the pointer over the effect’s thumbnail.

3. Control-click the effect, then do one of the following:
   - If the effect is a Final Cut Pro preset, choose “Open a copy in Motion” from the shortcut menu.
     A copy of the project opens in Motion, and the duplicated file appears in the Final Cut Pro Effects Browser.
   - If the effect is a template created in Motion, choose “Open in Motion” from the shortcut menu.
     The original project opens in Motion.

4. Modify the project in Motion, then do one of the following:
   - **Save a copy of a Final Cut Pro preset with the default name:** Choose File > Save.
   - **Save a copy of a Final Cut Pro preset with a new name:** Choose File > Save As, complete the save dialog information, then click Publish.
   - **Save the updated Motion-created template and overwrite the original version:** Choose File > Save.
   - **Save the updated Motion-created template as a copy:** Choose File > Save As, complete the save dialog information, then click Publish.
**Note:** When a preset Final Cut Pro effect is applied to the Final Cut Pro Timeline and then modified in Motion, the saved changes do not affect instances of the default preset in the Final Cut Pro Timeline. However, if the version of a preset in the Final Cut Pro Timeline has already been modified in Motion, any subsequent changes made to the template in Motion affect instances of the effect in the Final Cut Pro Timeline.

The template is saved and appears in the Effects Browser in Final Cut Pro.

---

**Example: Modify a preset Final Cut Pro effect in Motion**

In Final Cut Pro X, the Bokeh Random effect adds moving, blurred particles to a clip. This example describes how to modify that effect in Motion by adding and removing parameter controls.

**Note:** *Bokeh* comes from the Japanese term “boke,” meaning blur or haze. Bokeh is a term used in photography to describe the aesthetic quality of a blurred image.

---

**Use Motion to add a control to the Bokeh Random effect**

1. In Final Cut Pro, select a clip in the Timeline, then click the Effects Browser button in the toolbar.
2. In the Effects Browser, select the Light category, Control-click the Bokeh Random effect, then choose “Open a copy in Motion” from the shortcut menu.

A copy of the template opens in Motion, and the duplicated file appears in the Final Cut Pro Effects Browser.

3. In the Layers list in Motion, click disclosure triangles to open the Light Layer 02 group, the Bokeh group, and then the Circles group.

Note that the effect is composed of behaviors, a Gaussian Blur filter, and rigged particle parameters. For detailed information on rigging parameters, see Rigging overview.

4. In the Circles group, select the Bokeh 4 particle emitter.

5. In the Emitter Inspector, click the Color Mode pop-up menu, then choose Colorize.
6. Select a new color from the Color controls (just under the Color Mode pop-up menu).

In the Canvas, the circular particles change to the new color.

7. Do one of the following:
   - Click the Color parameter’s Animation menu (the downward arrow that appears when you place the pointer over the right side of the parameter row), then choose Publish.
Control-click the Color parameter’s name, then choose Publish from the shortcut menu.

8. In the Layers list, click the Project object, and then in the Project Inspector, click Publishing.

The controls that are published in the preset Bokeh Random effect are listed: Type, Blend Mode, Size, Number, Pattern, Speed, Blur Amount, Opacity, and Color. After you save this template in Motion (as described below), the modified effect will be added to the Effects inspector in Final Cut Pro, making the Color parameter available to Final Cut Pro users.
Use Motion to remove a control from the Bokeh Random effect

- In the Publishing pane of the Project Inspector, do one of the following:
  - Click the Type parameter’s Animation menu (the downward arrow that appears when you place the pointer over the right side of the parameter row), then choose Unpublish.
  - Control-click the Type parameter’s name, then choose Unpublish from the shortcut menu.

  The Type control is removed from the list and will not be available in Final Cut Pro.

Save the modified Bokeh Random effect

- Choose File > Save (or press Command-S).
Note: To save the effect with a different name or to a different category in the Effects Browser, choose File > Save As. The initially created file (Bokeh Random Copy) remains in the Final Cut Pro Effects Browser and Motion Project Browser, but can be deleted in the OS X Finder, in the folder in /Users/username/Movies/Motion Templates.

The effect is now ready for use in Final Cut Pro. Unlike the original preset, Bokeh Random Copy includes a control to change the color of the particles, and no longer includes a control to change the shape of the particles.

Work with transition templates

Create a transition template

Use the Final Cut Transition template to create a custom transition that can be applied to clips in the Final Cut Pro X Timeline.

Create a new transition template

1. In Motion, choose File > New From Project Browser (or press Option-Command-N).

2. In the Project Browser, click Final Cut Transition, then choose a project size from the Preset pop-up menu.
Important:  Be sure to create the template at the highest resolution you will use in your Final Cut Pro project. If you’re creating 4K-specific templates, you can enable a setting that allows the Final Cut Pro media browsers to display only templates designed for use in 4K projects. For more information, see Set template resolution.

3. Click Open (or press Return).

If the correct preset is already chosen, you can double-click Final Cut Transition in the Project Browser.

A new, untitled Motion project opens containing two placeholder layers: Transition A and Transition B.

Note:  You cannot delete the Transition A and Transition B placeholders from a transition template. Nor can you create
4. To add a reference image to the placeholders to preview your work, do the following:

a. From the File Browser or Library, drag a still image onto the Transition A layer in the Layers list (or onto the Transition A arrow in the Canvas).

b. From the File Browser or Library, drag a second still image onto the Transition B layer in the Layers list.

Be sure to release the mouse button when the pointer is over a placeholder (the downward arrow in the Canvas or Transition layer in the Layers list). If you miss the target, you create a new layer, which cannot be dragged to the placeholder layer.

The images are added to the Transition A and B placeholder layers, replacing the downward arrow graphics in the Canvas. The images serve as temporary media to preview the result of the transition you are building. They are not used in the Final Cut Pro X transition.

5. Modify Transition A and Transition B so they flow into each other midway through the transition, using filters, behaviors, or other combinations of effects.

For example, animate a lens flare filter that moves across the screen as Transition A fades into Transition B.

When designing the template, think about how best to line up the end of incoming clip A with the beginning of the transition,
and the end of the transition with incoming clip B. For example, a transition that begins on a full-screen Placeholder A and ends on a full-screen Placeholder B avoids jarring jumps. Because the default behavior between the transition placeholders is a simple cut, to smooth out the transition, you may need to adjust the placeholder timebars to overlap in the Timeline, then animate their opacity using keyframes or a behavior.

For more information on working with filters, see Filters overview. For more information on behaviors, see Behaviors overview.

6. To allow Final Cut Pro users to modify parameters, choose Publish from the Animation pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or dial) available in the Final Cut Pro Inspector when the custom effect is applied to a clip. Published parameters can be adjusted and keyframed in Final Cut Pro. For more information, see Add parameter controls overview.

7. *Optional:* When you’re satisfied with the transition you’ve built, you can remove the preview images from the template by selecting each Transition layer, then clicking the Clear button in the Image Inspector.

The temporary image is removed.

8. Choose File > Save, then do the following:
a. In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Transitions Browser as “New Template.”

b. Choose a category from the Category pop-up menu.

You can also create a custom category. Categories represent how the effects are organized in the Motion Project Browser and in the Final Cut Pro Transitions Browser. Custom categories also appear in the browsers.

c. If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in the Final Cut Pro Themes Browser. A theme is a metadata tag that assists in categorizing different templates as being part of a single family. For example, you may have different template types that are related to the same project, such as a transition, an effect, and a group of titles. By tagging the templates with the same theme, all templates, regardless of their template type, appear in the Final Cut Pro Themes Browser.

Themed templates also appear in other effects browsers. For example, a themed Final Cut Transition template appears in the Final Cut Pro Themes Browser as well as in the Transitions Browser.

d. To retain unused media in the project (media or audio in the Media list that is not used in the template but which you may want to include in the template later), select “Include unused media.”
For information on where template-related files are saved, see About template files and media save locations.

e. If you want a preview movie to appear in the Motion Project Browser, select Save Preview Movie.

9. Click Publish.

The template and remaining media are saved and exported to the Final Cut Pro Transitions Browser. If you did not remove the reference image, it appears in the template’s thumbnail in the Final Cut Pro Transitions Browser.

Override the default transition length set in Final Cut Pro

The duration of transition template is determined by the Final Cut Pro project settings. However, you can override that default duration in Motion.

- In Motion, select the Project object in the Layers list, then select the Override FCP checkbox in the Properties Inspector.

The transition also has adjustable In and Out points in the Final Cut Pro project.

Apply the transition in Final Cut Pro

- Locate the transition in the Final Cut Pro Transitions Browser, then apply the transition to an edit point in the Timeline.
Images or clips in the Motion placeholder layer appear in the Transitions Browser icon, but are not applied to the clip in the Final Cut Pro Timeline.

For information on applying and editing transitions in Final Cut Pro, see Final Cut Pro X Help.

Example: Create a Prism Blur transition

This example demonstrates how to create an original, simple Final Cut Pro X transition in Motion. Clip A dissolves into clip B with a prism blur effect.


2. In the Project Browser, select Final Cut Transition, choose the project preset required for your Final Cut project, set the Duration to 200 frames, then click Open.

   **Note:** This example uses the Broadcast HD 720 preset.

   The project opens and contains a single group with two placeholder layers: Transition A and Transition B.

3. Optional: To preview what the effect will look like, drag a still image from the File Browser to Transition A in the Layers list and then drag a different still image to Transition B, releasing the mouse button when the pointer changes to a curved arrow.
These images are for preview purposes only, and will not be saved to Final Cut Pro.

**Note:** This example does not use any images.

When you play the project (press the Space bar), no transition is present by default. Transition A ends, and transition B begins abruptly.

4. In the Timeline, position the pointer over the end of the Transition A bar, then trim the bar by dragging its end edge to the end of the project.

5. Trim the Transition B bar by dragging its beginning edge to frame 80.

6. Animate the opacity of Transition A by doing the following:
   a. Click the Record button (press A) and select Transition A.
   b. Drag the playhead to frame 1, then set Opacity to 100 in
Because the default Opacity value is 100, move the Opacity value slider back and forth, or enter 100 in the adjacent value slider to be sure a keyframe is created.

**Tip:** To see keyframes in the Timeline, click the Show/Hide Keyframes button in the upper-right corner of the Timeline.

c. Drag the playhead to frame 80, then set Opacity to 100 in the Properties Inspector.

Again, adjust the Opacity value to be sure a keyframe is created. This prevents any dipping to black as transition A fades into transition B.

d. Drag the playhead to frame 130, then set Opacity to 0 in the Properties Inspector.

When you play the project, Transition A fades into Transition B.

7. In the Layers list, select the Group.

8. In the toolbar, click the Add Filter pop-up menu, then choose Blur > Prism.
9. Animate the blur amount of the Prism filter by doing the following:

   a. Drag the playhead to frame 1, then open the Filters Inspector and set Amount to 0.

   b. Drag the playhead to frame 105, then in the Filters Inspector, set Amount to 50.

   c. Drag the playhead to frame 200, then in the Filters Inspector, set Amount to 0.

     When you play the project, Transition A fades into Transition B with a prism blur that moves right, then left.

10. Choose File > Save, then do the following:

     a. In the save dialog, enter a name for the template.

        If you don’t specify a name, the template appears in the
Final Cut Pro Transitions Browser as “New Template.”

b. Choose a category from the Category pop-up menu.

You can also create a custom category. Categories appear in the Motion Project Browser and the Final Cut Pro Transitions Browser.

c. If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and the Final Cut Pro Themes Browser. A theme is a metadata tag that helps categorize templates.

d. To retain unused media in the project (media or audio in the Media list that’s not used in the template that you may decide to include in the template later), select “Include unused media.”

For information on where template-related files are saved, see About template files and media save locations.

e. If you want a preview movie to appear in the Motion Project Browser, select Save Preview Movie.

After the prism blur transition is applied to the Final Cut Pro X Timeline, its duration can be easily modified. For more information transition duration, see Create a transition template.
You might want a custom transition to include a background image or clip. For example, if your Transition A and Transition B clips are animated to scale down, you can apply a background image to cover the black areas of the exposed frame. You can create a background by adding a drop zone to the transition template. After you apply the transition to a clip in the Final Cut Pro X Timeline, you can assign source media to the drop zone.

Drop zones in templates allow Final Cut Pro users to place media into designated regions of the applied effect. You can add filters, behaviors, animations, and other effects to drop zones in Motion to affect clips later added to those drop zones in Final Cut Pro. For more information, see Placeholders versus drop zones and Drop zones overview.

1. In the Final Cut Transition project, choose Object > New Drop Zone.

A drop zone layer (titled “Drop Zone”) appears in the layers list and Canvas.

2. Select the drop zone layer, then do one of the following in the Image Inspector:
   - Use a clip as the drop zone’s source media in Final Cut Pro: Click the Type pop-up menu, then choose Media Source.
When the transition is added to a Final Cut Pro project, a Drop Zone image well appears in the Final Cut Pro inspector. Using this image well, an editor can add a source clip that appears as a background during the custom transition. Using the drop zone’s onscreen controls (accessed by double-clicking the drop zone in the Final Cut Pro Viewer), an editor can pan or scale the source clip within the drop zone. For more information, refer to the Final Cut Pro X Help.

- **Use a still image as the drop zone’s media source in Final Cut Pro:** Click the Type pop-up menu, then choose Timeline Pin.

When the transition is added to a Final Cut Pro project, you can select a single frame of a clip as the source frame in the drop zone by dragging a numbered handle along the Timeline. For more information, see Final Cut Pro X Help.

**Note:** You can set a drop zone background color that’s apparent when the drop zone’s source media is panned or scaled. For more information, see Drop zones overview.
Modify a Final Cut Pro transition

Many presets in the Final Cut Pro X Transitions Browser were created in Motion. You can modify them in Motion, then save them as custom transitions in Final Cut Pro.

1. In Final Cut Pro, click the Transitions Browser button in the toolbar.

   The Transitions Browser appears.

2. Locate the transition to edit.

   To preview of the effect, move the pointer over the transition’s thumbnail.

3. Control-click the transition and do one of the following:
   - If the transition is a Final Cut Pro preset, choose “Open a copy in Motion” from the shortcut menu.

     A copy of the project opens in Motion, and the duplicated file appears in the Final Cut Pro Transitions Browser.

     **Note:** The “Open a copy in Motion” command is not available for FxPlug transitions.

   - If the transition is a template created in Motion, choose “Open in Motion” from the shortcut menu.

     The original project opens in Motion.

4. Modify the project in Motion, then do any of the following:

   - Save a copy of the Final Cut Pro preset with the default
• **Save a copy of the Final Cut Pro preset with the default name:** Choose File > Save.

• **Save a copy of the Final Cut Pro preset with a new name:** Choose File > Save As, complete the save dialog information, then click Publish.

• **Save the updated Motion-created template and overwrite the original version:** Choose File > Save.

• **Save the updated Motion-created template as a copy:** Choose File > Save As, complete the save dialog information, then click Publish.

**Note:** If the preset Final Cut Pro transition was applied to the Final Cut Pro Timeline before being modified in Motion, the saved changes do not affect instances of the transition in the Final Cut Pro Timeline. However, after the modified transition is applied to the Final Cut Pro Timeline, any subsequent changes made in Motion to the template affect instances of the transition in the Final Cut Pro Timeline.

The template is saved and appears in Transitions Browser in Final Cut Pro.

---

**Work with title templates**

**Create a title template**

Use the Final Cut Title template to create a custom title that can be applied to clips in the Final Cut Pro X Timeline.
Create a new title template

1. In Motion, choose File > New From Project Browser (or press Option-Command-N).

2. In the Project Browser, click Final Cut Title, then click the Preset pop-up menu and choose a project size.

   Important: Be sure to create the template at the highest resolution you will use in your Final Cut Pro project. If you’re creating 4K-specific templates, you can enable a setting that allows the Final Cut Pro media browsers to display only templates designed for use in 4K projects. For more information, see Set template resolution.

3. Click Open (or press Return).

   If the correct preset is already chosen, you can double-click Final Cut Title in the Project Browser.

   A new, untitled Motion project opens containing two layers: a text layer (Type Text Here) and a placeholder layer (Title Background).
4. To add a reference image to the Title Background placeholder to preview your work, do one of the following:

- From the File Browser or Library, drag a still image onto the placeholder arrow in the Canvas.
- From the File Browser or Library, drag a still image to the Title Background layer in the Layers list.

Be sure to release the mouse button when the pointer is over a placeholder (the arrow in the Canvas or Transition layer in the Layers list). If you miss the target, you create a new layer, which cannot be dragged to the placeholder layer.

The image is added to the Title Background layer, replacing the downward arrow graphic in the Canvas. This image is temporary media used to preview the effect you are building. It is not used in the Final Cut Pro X title.

**Note:** If you don’t want to use a reference image or do not want to modify the clip in Final Cut Pro, you can delete the Title Background placeholder.
5. Modify the text as needed and add animation, filters, text behaviors, and other effects to create custom titles.

Because users can change the text in Final Cut Pro, it’s not necessary to modify the default text (“Type Text Here”) in Motion. You can adjust and animate parameters in the Text Inspector, Filters Inspector, Behaviors Inspector, and Properties Inspector to create a memorable title sequence. For more information about using text, see Basic text overview and Animated text overview.

6. To allow Final Cut Pro users to modify specific parameters, choose Publish from the Animation pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or dial) available in the Final Cut Pro Inspector when the custom title is added to a clip. Published parameters can be adjusted and keyframed in Final Cut Pro. For more information, see Add parameter controls overview. For information specific to publishing text parameters, see About publishing text parameter controls.

7. Optional: When you’re satisfied with the custom title you’ve built, you can remove the preview image from the template by selecting the Effect Source layer, then clicking the Clear button in the Image Inspector.

The temporary image is removed and not saved to the template’s Media folder. For more information, see About template files and media save locations.

8. Choose File > Save, then do the following:
a. In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Titles Browser as “New Template.”

b. Choose a category from the Category pop-up menu.

You can also create a custom category. Categories represent how the effects are organized in the Motion Project Browser and in the Final Cut Pro Titles Browser. Custom categories also appear in the browsers.

c. If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in the Final Cut Pro Themes Browser. A theme is a metadata tag that assists in categorizing different templates as being part of a single family. For example, you may have different template types that are related to the same project, such as a transition, an effect, and a group of titles. By tagging the templates with the same theme, all templates, regardless of their template type, appear in the Final Cut Pro Themes Browser.

Themed templates also appear in other effects browsers. For example, a themed Final Cut Title template appears in the Final Cut Pro Themes Browser as well as in the Titles Browser.

d. To retain unused media in the project (media or audio in the Media list that is not used in the template but which you may want to include in the template later), select “Include unused media.”
For information on where template-related files are saved, see About template files and media save locations.

e. If you want a preview movie to appear in the Motion Project Browser, select Save Preview Movie.

9. Click Publish.

The template and remaining media are saved and exported to the Final Cut Pro Titles Browser. If you did not remove the reference image, it appears in the template’s thumbnail in the Final Cut Pro Titles Browser.

### Apply the title in Final Cut Pro

From the Final Cut Pro Titles Browser, do one of the following:

- Drag the title into the Timeline, above the clip you want to composite it over.

  When you release the mouse button, the title is anchored to the clip, and the clip is used as the background. The title can span multiple clips in the Timeline. The clips populate the Title Background placeholder, inheriting any transforms, filters, or other effects applied to the placeholder in Motion.

- Drag the title to the main Timeline as a clip.

  When you release the mouse button, the title is added to the main Timeline. If the title effect contains a Title Background placeholder, the placeholder is ignored, and a background clip cannot be specified. Drag the In and Out points to increase or decrease the duration of the title.
For information on working with titles in Final Cut Pro, see Final Cut Pro X Help.

Create a title background

In a title template, the Title Background placeholder is not intended to hold source media (images or movie clips) added in Motion. Although you can drag an image or clip onto the Title Background placeholder in Motion to preview how the titles will look composited over media, those images are never used in Final Cut Pro X. If you want to give Final Cut Pro users the option of adding their own source media a title, add a drop zone to the title template in Motion.

Drop zones can be any size and can be placed in any region of the frame. You can add filters, behaviors, and animations to drop zones in Motion so those effects influence clips later added in Final Cut Pro. For more information on drop zones, see Drop zones overview. To better understand the difference between placeholders and drop zones, see Placeholders versus drop zones.

Create a background for a title template

- In a Final Cut Title project in Motion, choose Object > New Drop Zone.

A drop zone layer (titled “Drop Zone”) appears in the layers list
When the template is saved in Motion, the title is added to the Final Cut Pro Titles Browser. When a Final Cut Pro editor add the title to their Timeline, a Drop Zone image well appears in the Final Cut Pro inspector. Using this image well, an editor can add a source clip that appears beneath the titles. Using the drop zone’s onscreen controls (accessed by double-clicking the drop zone in the Viewer), an editor can pan or scale the source clip within the drop zone. For more information, refer to Final Cut Pro X Help.

**Tip:** From Motion, you can publish a rigged checkbox that turns the drop zone on or off in the main Final Cut Pro Timeline. Alternatively, you can create two versions of the title template, one that uses a standard drop zone as a background and one that doesn’t. For more information on rigging, see Rigging overview. For more information on publishing, see Add parameter controls overview.

---

**Modify a Final Cut Pro X title**

The presets in the Final Cut Pro X Titles Browser were created in Motion. You can modify these presets in Motion, then save them as new title effects in Final Cut Pro.

1. In Final Cut Pro, click the Titles Browser button in the toolbar.
2. In the Titles Browser, locate the title to edit.
To preview the title effect, move the pointer over title’s thumbnail.

3. Control-click the title and do one of the following:
   - If the title is a Final Cut Pro preset, choose “Open a copy in Motion” from the shortcut menu.
     A copy of the project opens in Motion, and the duplicated file appears in the Final Cut Pro Titles Browser.
   - If the title is a template created in Motion, choose “Open in Motion” from the shortcut menu.
     The original project opens in Motion.

4. Modify the project in Motion, then do one of the following:
   - **Save a copy of the Final Cut Pro preset with the default name:** Choose File > Save.
   - **Save a copy of the Final Cut Pro preset with a new name:** Choose File > Save As, complete the save dialog information, then click Publish.
   - **Save the updated Motion-created template and overwrite the original version:** Choose File > Save.
   - **Save the updated Motion-created template as a copy:** Choose File > Save As, complete the save dialog information, then click Publish.

**Note:** If the preset Final Cut Pro title was applied to the Final Cut Pro Timeline before being modified in Motion, the saved changes do not affect instances of the title in the Final Cut Pro Timeline. However, after the modified title is applied to the Final Cut Pro Timeline, any subsequent
changes made in Motion to the template affect instances of the title in the Final Cut Pro Timeline.

The template is saved and appears in Titles Browser in Final Cut Pro.

Work with generator templates

Create a generator template

Use the Final Cut Generator template to create a custom generator that can be applied to clips in the Final Cut Pro X Timeline. A generator template is similar to a standard Motion project. However, when saved, it’s exported to the Generators Browser in Final Cut Pro.

Like any content added to a Final Cut Pro project, a generator template can be composited over a clip in the Final Cut Pro Timeline, or added to the main Timeline. The duration of the generator in Final Cut Pro is determined by its duration when created and saved in Motion.

Create a new generator template

1. In Motion, choose File > New From Project Browser (or press Option-Command-N).

2. In the Project Browser, click Final Cut Generator, then choose
a project size from the Preset pop-up menu.

**Important:** Be sure to create the template at the highest resolution you will use in your Final Cut Pro project. If you’re creating 4K-specific templates, you can enable a setting that allows the Final Cut Pro media browsers to display only templates designed for use in 4K projects. For more information, see Set template resolution.

3. Click Open (or press Return).

   If the correct preset is already chosen, you can double-click Final Cut Generator in the Project Browser.

   A new, untitled project opens. The project contains no placeholders.
4. Build the project as you would any other Motion project, using shapes, text, behaviors, camera animation, and so on.

**Note:** You can also add drop zones to create additional effects, such as a picture-in-picture effect. Drop zones allow Final Cut Pro users to place media into designated regions of the applied effect. For more information, see [Drop zones overview](#) and [Placeholders versus drop zones](#).

5. To allow Final Cut Pro users to modify specific parameters, choose Publish from the Animation pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or dial) available in the Final Cut Pro Inspector when the custom effect is applied to a clip. Published parameters can be adjusted and keyframed in Final Cut Pro. For more information, see [Add parameter controls overview](#).

**Note:** If you have many parameters that you want to adjust with a single control, you can *rig* the parameters to a slider, pop-up menu, or checkbox. When the rig controls are published with a template, the slider, pop-up menu, or checkbox becomes available in the Final Cut Pro X project. For more information, see [Rigging overview](#).

6. Choose File > Save, then do the following:

   a. In the save dialog, enter a name for the template.

      If you don’t specify a name, the template appears in the Final Cut Pro Generators Browser as “New Template.”
b. Choose a category from the Category pop-up menu.

You can also create a custom category. Categories represent how the effects are organized in the Motion Project Browser and in the Final Cut Pro Generators Browser. Custom categories also appear in the browsers.

c. If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in the Final Cut Pro Themes Browser. A theme is a metadata tag that assists in categorizing different templates as being part of a single family. For example, you may have different template types that are related to the same project, such as a transition, a generator, and a group of titles. By tagging the templates with the same theme, all templates, regardless of their template type, appear in the Final Cut Pro Themes Browser.

Themed templates also appear in other effects browsers. For example, a themed Final Cut Generator template appears in the Final Cut Pro Themes Browser as well as in the Generators Browser.

d. To retain unused media in the project (media or audio in the Media list that’s not used in the template but which you may want to include in the template later), select “Include unused media.”

For information on where template-related files are saved, see About template files and media save locations.
e. If you want a preview movie to appear in the Motion Project Browser, select Save Preview Movie.

7. Click Publish.

The template is saved and exported to the Final Cut Pro Generators Browser.

**Apply the generator in Final Cut Pro**

From the Generators Browser in Final Cut Pro, do one of the following:

- Drag the generator into the Timeline, above the clip you want to composite it over.

  The generator can span multiple clips in the Timeline.

- Add the generator to the main Timeline as a clip.

  When you release the mouse button, the generator is added to the main Timeline. Drag the generator’s In and Out points in the Timeline to change the duration.

For information on working with generators in Final Cut Pro X, see Final Cut Pro X Help.

**Modify a Final Cut Pro X generator**

Many presets in the Final Cut Pro X Generators Browser were
created in Motion. You can modify these presets in Motion, then save them as generators in Final Cut Pro.

1. In Final Cut Pro X, click the Generators Browser button in the toolbar.

The Generators Browser appears.

2. Locate the generator to edit.

To preview the generator, move the pointer over the generator’s thumbnail.

3. Control-click the generator and do one of the following:

   - If the generator is a Final Cut Pro preset, choose “Open a copy in Motion” from the shortcut menu.

     A copy of the project opens in Motion.

   - If the generator is a template created in Motion, choose “Open in Motion” from the shortcut menu.

     The original project opens in Motion.

4. Modify the project in Motion, then do any of the following:

   - **Save a copy of the Final Cut Pro preset with the default name**: Choose File > Save.

   - **Save a copy of the Final Cut Pro preset with a new name**: Choose File > Save As, complete the save dialog information, then click Publish.

   - **Save the updated Motion-created template and overwrite**
the original version: Choose File > Save.

- **Save the updated Motion-created template as a copy:** Choose File > Save As, complete the save dialog information, then click Publish.

**Note:** If the preset Final Cut Pro generator was applied to the Final Cut Pro Timeline before being modified in Motion, the saved changes do not affect instances of the title in the Final Cut Pro Timeline. However, after the modified title is applied to the Final Cut Pro Timeline, any subsequent changes made in Motion to the template affect instances of the title in the Final Cut Pro Timeline.

The template is saved and appears in Generators Browser in Final Cut Pro.

---

**Publish a standard Motion project as a Final Cut Pro X generator**

When possible, use the Final Cut Effect, Title, Transition, and Generator templates to create effects content for Final Cut Pro X. However, if necessary, you can convert a standard Motion project for use in Final Cut Pro. There are two ways to do this:

- **Publish the Motion project as a Final Cut Generator,** which exports the template to the Final Cut Pro Generators Browser, where it can be applied to the Timeline and edited like any other generator.

- **Save the Motion project as a QuickTime file,** then import the QuickTime movie into the Final Cut Pro project like any other
footage.

Although you cannot add an Effect Source, Transition A, Transition B, or Title Background placeholder to a Motion project, you can add standard drop zones, which let Final Cut Pro users insert customized content into the generator.

Like template projects, standard Motion projects let you publish specific parameters to the Final Cut Pro inspector. For more information on publishing parameters, see Add parameter controls overview.

---

Publish a standard Motion project as a generator in Final Cut Pro

1. When you save your Motion project, choose File > Publish Template.

2. In the save dialog, enter a name for the template, complete the other options, then select Publish as Final Cut Generator.

   For more information about save dialog options for templates, see Create a generator template.

3. Click Publish.

   The template is saved and appears in Generators Browser in Final Cut Pro.
Add, replace, or remove placeholder images

When creating a template for Final Cut Pro X, you can add an image to a placeholder layer, replacing the downward arrow graphic in the Canvas. This allows you to:

- Preview the effect you are building in Motion
- Create a thumbnail image for the effect in Final Cut Pro

However, this image is not used when the effect is applied to a clip in Final Cut Pro.

**Important:** When adding preview media to a placeholder, use a still image rather than a video clip, which can introduce timing conflicts in Final Cut Pro.

Add a placeholder image to a template

Do one of the following:

- From the File Browser or Library, drag an image onto the placeholder arrow in the Canvas; when the pointer becomes a curved arrow, release the mouse button.

- From the File Browser or Library, drag an image to the Effect Source layer in the Layers list; when the pointer becomes a curved arrow, release the mouse button.
When you publish the template, the image is saved with the template and is used as the thumbnail for the effect in Final Cut Pro browser. You can change the image used for the thumbnail in the Final Cut Pro browser by replacing the placeholder image.

Replace an image in a template placeholder

1. To replace a reference placeholder image, do one of the following:
   - From the File Browser or Library, drag a still image onto the downward placeholder arrow in the Canvas, and when the pointer becomes a curved arrow, release the mouse button.
   - From the File Browser or Library, drag a still image to the Effect Source layer in the Layers list, and when the pointer becomes a curved arrow, release the mouse button.

2. Choose File > Save (or press Command-S).

   The “Media exists outside the document. Do you wish to copy it?” dialog appears.

3. Do one of the following:
   - To save the new image with the template in the /Users/username/Movies/ folder in the OS X Finder, click Copy.

   When you save the template, the new image is saved with the template and is used as the thumbnail for the effect in
Final Cut Pro browser.

- To save the template without the new image, click Don’t Copy.

## Clear media from a template placeholder

When you save a template containing a placeholder image, that image is stored on your computer in the same folder as the template (`/Users/username/Movies/Motion Templates/`), potentially creating multiple instances of media files and taking up storage space. To save storage space, you can clear placeholder images from templates before saving.

1. In the template project, select an Effect Source, Title Background, Transition A, or Transition B placeholder.

2. In the Image Inspector, click the Clear button in the Final Cut Placeholder controls.
The preview media is removed from the template, and the placeholder arrow reappears in the affected layer.

**Note:** When you clear a placeholder image, its source media is not loaded into Motion the next time you modify the template (by choosing the “Open a copy in Motion” command in the Final Cut Pro media browsers). And if you previously added a placeholder image to create a thumbnail for a Final Cut Pro effect, clearing the placeholder image from the template in Motion deletes the thumbnail from Final Cut Pro.

---

**Manually remove media saved with a template**

1. In the OS X Finder, go to the /Users/username/Movies/Motion Templates/ folder.

2. In the appropriate Effects, Titles, or Transitions folder, open the theme folder that contains your template, then open the Media folder.

3. Drag the media to the Trash.

---

**Add parameter controls**

**Add parameter controls overview**

When you use a template in Motion to create an effect, transition, title, or generator for Final Cut Pro X, you can “publish” nearly any
Publish parameter controls to Final Cut Pro

The following tasks describe how to publish parameters, compound parameters, rig controls, and other template elements. Published parameters appear in the Final Cut Pro X inspector.

Publish a parameter control

1. In the effect, transition, title, or generator template, select the
2. In the selected item’s Inspector, do one of the following:
   - Click the parameter’s Animation menu (the downward arrow that appears when you place the pointer over the right side of the parameter row), then choose Publish.
   - Control-click the parameter’s name, then choose Publish from the shortcut menu.

3. Save the template.

When you apply the modified effect, transition, title, or generator to a clip in the Final Cut Pro Timeline, the parameter control you published appears in the Final Cut Pro inspector, ready for adjustment.

Publish compound parameter controls (a parameter with nested subparameters)
1. In the template project, select the image layer or effects object containing the compound parameter to publish.

2. Open the selected item’s Inspector.

   To publish a compound parameter to Final Cut Pro in a collapsed state (its subparameters hidden by a disclosure triangle), make sure the parameter’s disclosure triangle is closed.

   To publish a compound parameter in an expanded state (disclosure triangle open and its subparameters exposed), make sure the parameter’s disclosure triangle is open.

3. Do one of the following:
   - Control-click the parameter’s name, then choose Publish from the shortcut menu.
   - Click the parameter’s Animation menu (the downward arrow that appears when you place the pointer over the right side of the parameter row), then choose Publish.

4. Save the template.

   The parameter and its subparameter controls are published. When the modified effect is applied to a clip in Final Cut Pro, the compound parameter retains its state (collapsed or expanded) at the time of publishing. If the result is not what you expected, click the disclosure triangle in the Final Cut Pro inspector to expand or collapse the subparameters manually.
Note: Examples of parameters with subparameters include Scale (with X, Y, and Z values) and Shear (with X and Y values).

Publish subparameter controls of a compound parameter

You can also publish specific subparameters of a compound parameter. This is a good way to limit an editor’s control over effects parameters in a Final Cut Pro project.

1. In the template project, select the image layer or effect object containing the subparameter to publish.

2. In the item’s Inspector, click the compound parameter’s disclosure triangle to show its subparameters.

3. For each parameter to publish, do one of the following:
   - Click the parameter’s Animation menu (the downward arrow that appears when you place the pointer over the right side of the parameter row), then choose Publish.
   - Control-click the parameter’s name, then choose Publish from the shortcut menu.
4. Save the template.

The subparameter control is published. When you apply the modified effect to a clip in Final Cut Pro, the subparameter appears in the Final Cut Pro inspector.

**Publish an activation checkbox for a filter or behavior**

Publishing a filter or behavior activation checkbox lets Final Cut Pro users quickly turn an effect on or off.

1. In the template project, select the filter or behavior whose activation checkbox you want to publish.

2. In the Behaviors or Filters Inspector, do one of the following:

   - In the header row of the behavior or filter, click the Animation menu (the downward arrow that appears when you place the pointer over the right side of the row), then choose Publish.

   - Control-click the behavior or filter name, then choose Publish from the shortcut menu.

   **Note:** If you publish only the blue activation checkbox and no other parameters in the behavior or filter’s group of controls, only the checkbox is published.

3. Save the template.

When you apply the modified effect to a clip in Final Cut Pro, a checkbox with the name of the published filter or behavior
appears in the Final Cut Pro inspector. Deselecting the checkbox disables the effect of that filter or behavior (including its constituent parameters).

### Publish a rig control (widget)

1. Add a rig to the template, assigning specific parameters to the rig’s widget controls.

For more information about building rigs, creating widgets, and assigning parameters, see [Rigging overview](#).

2. Select the rig, then do one of the following in the Rig Inspector:

   - In the Checkbox, Pop-up, or Slider widgets, click the Animation menu (the downward arrow that appears when you place the pointer over the right side of the widget’s parameter row), then choose Publish from the shortcut menu.

   - Control-click the Checkbox, Pop-up, or Slider parameter name, then choose Publish from the shortcut menu.

3. Save the template.

   When you apply the modified effect, transition, title, or generator to a clip in the Final Cut Pro Timeline, the rig control you published appears in the Final Cut Pro inspector.

### Publish a gradient editor control
1. In the template project, select the image layer or effect object that contains the gradient editor to publish.

2. In the item’s Inspector, Control-click the Gradient parameter, then choose Publish from the shortcut menu.

3. Save the template.

When you apply the modified effect, transition, title, or generator to a clip in the Final Cut Pro Timeline, the gradient editor control appears in the Final Cut Pro inspector.

---

**Publish a filter’s onscreen controls**

You can publish a filter’s onscreen controls so that Final Cut Pro users can make filter adjustments by dragging handles in the Final Cut Pro Viewer.

1. In the template project, select the filter object.

2. In the Filters Inspector, select the Publish OSC checkbox.
3. Save the template.

When you apply the modified effect, transition, title, or generator to a clip in the Final Cut Pro Timeline, the onscreen controls for the filter appear in the Final Cut Pro Viewer.

**Note:** When you publish onscreen controls, their corresponding numeric controls in the Inspector are not published. You must publish Inspector parameter controls separately. See “Publish a parameter control” above.

For more information about filter onscreen controls, see Adjust filters using onscreen controls and Publish filter parameters for use in Final Cut Pro X.

---

**Manage parameter controls**

The following tasks describe how to review, reorder, and unpublish parameters, as well as how to customize a published parameter name.

---

**Review parameter controls to be published**

1. In the Layers list of the template project, click Project.

2. In the Project Inspector, click Publishing.

   Parameters (for all object types) set to be published appear in the list.
Reorder parameter controls in the Publishing pane

1. In the Layers list of the template project, click Project.
2. In the Project Inspector, click Publishing.
3. Drag a parameter up or down in the Published Parameters list.

Rename a published parameter control

1. In the Layers list of the template project, click Project.
2. In the Project Inspector, click Publishing.
3. In the Published Parameters list, double-click the name of a parameter, enter a name, then press Return.

Note: To navigate to the originally published parameter (before the name change), Control-click the parameter and choose Reveal Original Parameter.

Unpublish a parameter control via the Inspector

- Select a layer or effect object in the Layers list, then in the Inspector, do one of the following:
  - Click the published parameter’s Animation menu (the

Click the published parameter’s Animation menu (the downward arrow that appears when you place the pointer over the right side of the parameter row), then choose Unpublish.

- Control-click the published parameter’s name, then choose Unpublish from the shortcut menu.

### Unpublish a parameter control via the Publishing pane

1. In the Layers list of the template project, click Project.

2. In the Project Inspector, click Publishing, then do one of the following:
   - Click the Animation menu (the downward arrow that appears when you place the pointer over the right side of the parameter row), then choose Unpublish from the shortcut menu.
   - Control-click the parameter name, then choose Unpublish from the shortcut menu.

### About publishing text parameter controls

When you apply a title or generator containing text to a clip in Final Cut Pro X, the Title inspector becomes available. This inspector contains many of the same basic controls as the Motion Text Inspector (Font, Size, Alignment, and so on).
However, if the applied title or generator contains published text parameters, those parameters appear in a separate pane in Final Cut Pro: the Title inspector.

**Note:** When you publish a text parameter already in the Final Cut Pro Text inspector, the parameter appears in both the Title inspector and the Text inspector. Changes made to the parameters in the Title inspector affect the same parameters in the Text inspector, and vice versa.

The Text inspector in the Final Cut Pro includes many of the same controls available in the Motion Text Inspector. If you want to control a parameter not included in the Final Cut Pro Text inspector, publish that parameter in the title or generator template in Motion.

For more information on working with text in Final Cut Pro, see Final Cut Pro X Help. For more information on Motion’s text parameters, see Text Inspector overview.

**What cannot be published in a Final Cut Pro template?**

The following Motion items cannot be published in templates for Final Cut Pro X:

- Audio of any kind, including Source Audio wells in the Audio Parameter behavior
- Image wells (except for drop zone Source Media wells)
- Mini-curve editors
- Timing controls in the Image Inspector or Media Inspector
- Retiming behaviors (such as Ping Pong, Loop, and Stutter)
- The Range Minimum/Range Maximum slider rig widget
- Placeholder Pan and Scale controls in template placeholders
- Project properties (such as Pixel Aspect Ratio, Frame Rate, and Background Color in the Properties Inspector)
- Some Keyer filter and Luma Keyer filter controls
- Noncompound groups of controls, such as the Lighting parameter in the Properties Inspector
- Onscreen path for the Motion Path behavior

**Note:** Although you can publish a Motion Path behavior to Final Cut Pro, the path does not appear in the Final Cut Pro Viewer.

In general, Motion lets you publish most controls in the application. However, some publishable controls are not supported in Final Cut Pro. The following items have components that are not accessible after a template is added to a Final Cut Pro project:

- Parameters related to text path onscreen controls
- Mask or shape control points
- Parameters with deselected activation checkboxes
- The Histogram in the Levels color correction filter
- Audio behavior parameter controls

**Note:** Audio files saved in a Motion template are not available
Control template timing and animation

What are template markers?
Markers are visual reference points you add to the Timeline to identify specific frames. There are several types of markers. The first, known as Standard, is designed for use in Motion and has no effect if saved in a Final Cut template. The remaining marker types, known as template markers, are designed to control the timing of templates in Final Cut Pro X.

For basic information on using markers in the Timeline, see Work with markers overview.

When building a template in Motion, you typically don’t know the duration of the clips it will be applied to in Final Cut Pro. By default, the duration of a Motion template is determined by the length of the Final Cut Pro clip it’s applied to. Template markers let you control the timing of template after it’s applied in Final Cut Pro, by designating regions in the Timeline to be played, ignored, or looped. You can also use a template marker to designate a specific frame to be used as the template’s thumbnail in the Final Cut Pro Effects, Transitions, or Titles Browser.

Template markers fall into five categories:

- **Build In**: Designates the end point of an intro section of a template, and instructs Final Cut Pro to play that section at the
same speed as the original template (as created in Motion), regardless of the duration of the clip in the Final Cut Pro Timeline. For example, if a Build In marker is present at the 30-second mark, the first 30 seconds retain the original timing (as created in Motion). Beyond the 30-second mark, the template is time-stretched (or time-shrunk) to the duration of the Final Cut Pro clip.

- **Build Out**: Designates the start of an outro section of a template, and instructs Final Cut Pro to play that section at the same speed as the original template (as created in Motion), regardless of the duration of the clip in the Final Cut Pro Timeline. For example, if a Build Out marker is present 30 seconds from the end of the Final Cut Pro clip, the last 30 seconds retain the original timing (as created in Motion). Prior to the Build Out marker, the template is time-stretched (or time-shrunk) to the duration of the Final Cut Pro clip.

If no Build In or Build Out markers are present, the entire template is time-stretched to correspond to the duration of the clip in Final Cut Pro. For example, if you apply a template that is three minutes long to a six minute long clip in Final Cut Pro, the effect stretches over the six-minute duration of the Final Cut Pro clip.

**Note**: Transition templates assume a default duration in Final Cut Pro (determined in Final Cut Pro Preferences). This duration can conflict with the effects of these marker types. For example, you might specify that the intro animation of a transition lasts for 45 frames, while the default duration in Final Cut Pro is set to 30 frames for the entire transition. For information on how to override the Final Cut Pro default duration, see [Create a transition template](#).
• **Loop**: Loop markers indicate where the template should begin looping playback.

• **Poster Frame**: Poster Frame markers determine the frame of a template to be used as the thumbnail for the template in the Final Cut Pro Effects Browser, Transitions Browser, or Titles Browser.

• **Text Edit**: Text Edit markers identify ideal edit points in your title templates.

### Add template markers

To create a Build In, Build Out, Project Loop End or Poster Frame marker, you must first add a project marker to a Motion project, then change its type in the Edit Marker dialog. To create a Text Edit marker, you must first add an object marker, then change its type in the Edit Marker dialog.

### Mark the last frame of a template’s intro section

When you add a “Build In – Mandatory” marker or “Build In – Optional” marker to a template, frames between the beginning of the project and the Build In marker play (in Final Cut Pro) at the same speed as in the original Motion template. The “Build In – Optional” marker publishes a checkbox that disables playback of the intro section when deselected.

1. Position the playhead on the frame where you want the
marker to appear, then press Shift-M.

A green project marker appears in the Timeline ruler, and a (subtle) green vertical line appears in the mini-Timeline.

2. Do one of the following:
   - Position the playhead over the marker, then choose Mark > Markers > Edit Marker.
   - Double-click the marker.
   - Control-click the marker, then choose Edit Marker from the shortcut menu.

3. In the Edit Marker dialog, choose one of the following from the Type pop-up menu:
   - **Build In – Mandatory**: Choose this marker type to play the frames between the beginning of the project and the “Build In – Mandatory” marker at the same speed as in the original Motion template. Beyond the marker, the effect is time-stretched (or shrunk) to match the duration of the Final Cut Pro clip.
     
     This intro is always played, regardless of where the template is placed in the Final Cut Pro Timeline.
   - **Build In – Optional**: Choose this marker type to play the frames between the beginning of the project and the “Build In – Optional” marker at the same speed as in the original Motion template and to include a checkbox to disable the intro’s playback.
     
     The project marker becomes a Build In marker, and the Timeline ruler displays a gold glow over the affected
When a “Build In – Optional” marker is added to a template, a Build In checkbox is published (added to the Published Parameters list in the Publishing pane of the Project Inspector). After the template is added to a Final Cut Pro project, the Build In checkbox appears in the Final Cut Pro inspector. When the checkbox is deselected, frames before the marker are not played.

Mark the last frame of a template’s outro section

When you add a “Build Out – Mandatory” marker or a “Build Out – Optional” marker to a template, frames between the Build Out marker and the end of the project play (in Final Cut Pro) at the same speed as in the original Motion template. The “Build Out – Optional” marker publishes a checkbox that disables
playback of the outro section when deselected.

1. Position the playhead on the frame where you want the marker to appear, then press Shift-M.

   A green project marker appears in the Timeline ruler, and a (subtle) green vertical line appears in the mini-Timeline.

2. Do one of the following:
   - Position the playhead over the marker, then choose Mark > Markers > Edit Marker.
   - Double-click the marker.
   - Control-click the marker, then choose Edit Marker from the shortcut menu.

3. In the Edit Marker dialog, choose one of the following from the Type pop-up menu:
   - **Build Out – Mandatory:** Choose this marker type to play the frames between the “Build Out – Mandatory” marker and the end of the project at the same speed as in the original Motion template. Prior to the marker, the effect is time-stretched (or shrunk) to match the duration of the Final Cut Pro clip.
     
     This outro is always played, regardless of where the template is placed in the Final Cut Pro Timeline.
   
   - **Build Out – Optional:** Choose this marker type to play the frames between the beginning of the project and the “Build In – Optional” marker at the same speed as in the original Motion template and to include a checkbox to disable the intro’s playback in the template.
The project marker becomes a Build Out marker, and the Timeline ruler displays a gold glow over the affected region.

When a “Build Out – Optional” marker is added to a template, a Build Out checkbox is published (added to the Published Parameters list in the Publishing pane of the Project Inspector). After the template is added to a Final Cut Pro project, the Build In checkbox appears in the Final Cut Pro inspector. When the checkbox is deselected, frames before the marker are time-stretched and frames after the marker are not played.

Specify the frame where the template begins looping playback

You can add a Project Loop End marker to instruct Final Cut Pro
to begin looping playback at a specific frame. When playback reaches this frame, the project plays from the beginning of the project or from the Build In marker, if present. Frames beyond the Project Loop End marker are never played.

1. Position the playhead on the frame where you want the marker to appear, then press Shift-M.

A green project marker appears in the Timeline ruler, and a (subtle) green vertical line appears in the mini-Timeline.

2. Do one of the following:
   - Position the playhead over the marker, then choose Mark > Markers > Edit Marker.
   - Double-click the marker.
   - Control-click the marker, then choose Edit Marker from the shortcut menu.

3. In the Edit Marker dialog, choose Project Loop End from the Type pop-up menu.

The project marker becomes a Project Loop End marker, and the Timeline ruler displays a gold glow over the affected region.
Setting a marker type to Project Loop End changes any marker set to a Build Out type back to Standard. Similarly, if a Project Loop End marker exists, adding a Build Out marker resets the loop marker back to Standard.

**Tip:** Adding a loop marker to the second frame in a template signals that the effect is time-invariant—the first frame of the project loops forever. This can be useful for generators that do not contain animation, such as a solid color generator, or for filters that are not animated by default, such as a color correction filter.

**Note:** Templates with applied Time filters (Echo, Scrub, Strobe, Trails, or WideTime) should not use Loop markers, because unexpected timing results can occur.

**Set the frame to be used as the template’s thumbnail in the Final Cut Pro browser**

You can add a Poster Frame marker to instruct Final Cut Pro to
use a specific frame of a template as the thumbnail for the template in the Final Cut Pro Effects Browser, Transitions Browser, or Titles Browser.

1. Position the playhead on the frame you want to use as the poster frame, then press Shift-M.

   A green project marker appears in the Timeline ruler, and a (subtle) green vertical line appears in the mini-Timeline.

2. Do one of the following:
   - Position the playhead over the marker, then choose Mark > Markers > Edit Marker.
   - Double-click the marker.
   - Control-click the marker, then choose Edit Marker from the shortcut menu.

3. In the Edit Marker dialog, choose Poster Frame from the Type pop-up menu.

   Although the project marker appearance does not change, it becomes a Poster Frame marker (a tooltip appears if you move the pointer over the marker).

   If a Poster Frame marker exists, adding a new Poster Frame marker resets the first marker to Standard.

---

**Specify a frame as an ideal text edit point in a title template**
You can add Text Edit markers to specify the optimal edit points for text in a title template. For example, if your title animates offscreen, you can add a Text Edit marker to quickly navigate to a frame where the text is visible in the Final Cut Pro Viewer.

1. Place the playhead at the frame where you want the marker.

2. Select the text to add the marker to, then do one of the following:
   - Choose Mark > Markers > Add Marker.
   - Press M.
     A red object marker is added to the timebar of the selected object.

3. Do one of the following:
   - Position the playhead over the marker, then choose Mark > Markers > Edit Marker.
   - Double-click the marker.
   - Control-click the marker, then choose Edit Marker from the shortcut menu.

4. In the Edit Marker dialog, choose Text Edit from the Type pop-up menu.

   Although the object marker appearance does not change, it becomes a Text Edit marker.

   You can add multiple Text Edit markers to a template.

In the Final Cut Pro Timeline, double-click the title to enter text-
edit mode. In the Viewer, use the Next Text Layer and Previous Text Layer buttons to navigate between Text Edit markers. For more information about working with titles in Final Cut Pro, see Final Cut Pro X Help.

Move a marker

- Drag the marker to a new position in the Timeline ruler.

  When you drag the marker, the current frame is displayed above the pointer.

Change the marker type

1. Do one of the following:
   - Position the playhead over the marker, then choose Mark > Markers > Edit Marker.
   - Double-click the marker.
   - Control-click the marker, then choose Edit Marker from the shortcut menu.

2. In the Edit Marker dialog, click the Type pop-up menu, then choose a marker type.

   The Build In and Build Out markers appear as small green arrows in the Timeline ruler. The Project Loop Out marker appears as a small orange arrow. At the top of the ruler, the area specified as the intro, outro, or loop section displays a gold glow.
Animation guidelines

Effect, title, transition, and generator templates can include animation like a standard Motion project. When the template is added to a clip in Final Cut Pro X, animation in the placeholder is applied to the clip, whether created by behaviors or keyframes.

Animation in the template that is longer than the duration of the clip to which it’s applied in Final Cut Pro is scaled to fit.

**Important:** If you don’t want your template animation scaled to fit the duration of a clip in Final Cut Pro, you can use markers to designate segments where the animation is locked. Additionally, you can use markers to designate sections where animation loops indefinitely in the Final Cut Pro project. For more information, see *What are template markers?*.

When publishing parameters in your templates, consider the following guidelines:

- When possible, avoid publishing keyframed parameters. Published keyframes can cause unexpected results when you edit or when you animate the parameters in the Final Cut Pro inspector.

- Do not publish a parameter that’s controlled by a behavior. For example, if you publish an Opacity parameter that’s controlled by a Fade In/Fade Out behavior, you cannot adjust the opacity parameter after the template is added to the
Final Cut Pro project.

- Because the duration of templates often conflicts with the duration of the Final Cut Pro clips they’re applied to, try to publish nonanimated parameters in the template, then keyframe those parameters in Final Cut Pro.

- Use behaviors instead of keyframes in templates when possible. Behaviors can be a more flexible animation tool for templates. Behaviors don’t rely on specific timing or use keyframes to create an animation. Publish behavior parameters that you want to control in Final Cut Pro.

**SEE ALSO**

- Keyframing overview
- Behaviors overview

**Timing guidelines**

Depending on the template type, different timing rules apply when you apply the template to a clip in the Final Cut Pro Timeline. When publishing parameters and applying templates, consider the following guidelines:

- *Final Cut Effect:* When you apply an effect template in Final Cut Pro, the effect is integrated into the clip. For example, when a color-correction effect template that’s 300 frames in Motion is saved and applied to a 2,300-frame clip in Final Cut Pro, the resulting effect is 2,300 frames. Animated effect templates are also scaled according to the duration of the clip they’re applied to in Final Cut Pro. For example, if a template in Motion is 300 frames long, and the
placeholder layer is animated to rotate 360 degrees (one complete rotation) from frames 0 to 300, when the template is applied to a 900-frame clip in Final Cut Pro, the complete rotation is stretched to 900 frames.

You can override the timing adjustment in Final Cut Pro by applying markers to the template in Motion. For example, to control frame-counting effects, such as Timecode generators, apply special markers to instruct Final Cut Pro when to play specific ranges of the template. For more information, see Add template markers.

- **Final Cut Transition**: In Final Cut Pro, the default transition duration is set in the Editing pane of Final Cut Pro Preferences. When you apply a transition template to an edit point in the Final Cut Pro timeline, the duration of the transition effect is modified to the default transition duration. For example, in a Final Cut Pro Broadcast HD 1080 project (29.97 fps) with a default transition duration of two seconds, an applied 300-frame transition template is compressed to 60 frames (2 seconds at 29.97 fps).

To override the transition duration setting in Final Cut Pro Preferences, select the Override FCP checkbox in the Properties Inspector in Motion. If this checkbox is selected when the transition is saved, the transition retains its original duration when added to the Final Cut Pro project.

Whether the transition duration uses the Final Cut Pro default or is overridden, you can adjust the In and Out points of the transition in the Final Cut Pro Timeline.

- **Final Cut Title**: When added to a Final Cut Pro project, a title template is anchored to the clip it’s applied to. Its duration is based on the duration of the template in Motion. After the title
is applied, you can adjust its duration in the Final Cut Pro Timeline.

- **Final Cut Generator:** When added to a Final Cut Pro project, a generator template uses its default duration (its duration when the template was created and saved in Motion). After the generator is applied, you can adjust its duration in the Final Cut Pro Timeline.

## Set template resolution

Before you create a template, decide what resolution your project requires. Although the template scales to fit the resolution of the Final Cut Pro X project it’s applied to, you should create the template at the highest resolution you will use.

Additionally, you can save a template in multiple display aspect ratio settings, for delivery to different-sized screens. For more information, see [Add multiple display aspect ratios to a template](#).

**Note:** An image added to a placeholder is fit based on the template project settings in Motion. Because the image in the placeholder is not used when the template is applied to a Final Cut Pro project, stretching or scaling of the media does not affect the Final Cut Pro clip the template is applied to.

When you create templates with 4K resolution, you can add a metadata flag so that Final Cut Pro users can quickly find 4K templates (and filter out all non-4K templates).
Flag a template as having 4K resolution

- In the Layers list in Motion, select the Project object and then select the Designed for 4K checkbox in the Properties Inspector.

After the template is published to Final Cut Pro, select the “4K-ready content only” checkbox in the Final Cut Pro media browsers to display only templates designed for use in 4K projects. (The “4K-ready content only” checkbox appears only in Final Cut Pro projects using one of the 4K or 5K formats.)

Add multiple display aspect ratios to a template

When creating a template for Final Cut Pro X, you can build alternate versions that have different display aspect ratios—all within a single template. For example, when you create a template with a 16:9 aspect ratio, you can add an alternate version customized for 4:3 displays. When the template is applied to a clip Final Cut Pro, the editing application chooses the version that matches its display aspect ratio. These alternate display versions of a single template are called snapshots. Snapshots eliminate the need to create multiple versions of the same template for multiple display ratios.

If you expect a template to be applied to differently sized clips in Final Cut Pro, perform the workflow described in this section
Add a display aspect ratio to a template

1. In the Layers list in Motion, select the Project object.

2. In the Project Inspector, click Snapshots.

   The Display Aspect Ratio Snapshots list appears, showing the project’s current default aspect ratio.

3. Click the Add button (+) and choose a different aspect ratio from the shortcut menu.

   If you chose Custom, the Custom Display Aspect Ratio calculator appears.

   The new aspect ratio appears in the list, and the project adjusts.

   **Note:** You cannot add a snapshot that matches an existing Display Aspect Ratio snapshot.
4. To reposition your objects to better fit the new aspect ratio, click Edit Snapshot.

A small floating window appears, indicating that you are in aspect ratio-edit mode.

5. Position and scale the layers in your project to fit the new display aspect ratio, then click the Stop Rig Edit Mode button in the floating window.

Click the items in the list to view the results in the Canvas.

Note: When working with an alternate snapshot, the resolution listed in the Properties pane of the Inspector (when Project is selected in the Layers list) may seem strange. This is because the Display Aspect Ratio is shown, rather than the Pixel Aspect Ratio.

6. Choose File > Save or File > Save As, then do the following:

a. In the save dialog, enter a name for your template.

b. Choose a category from the Category pop-up menu.

c. If needed, choose a theme from the Theme pop-up menu.

d. To retain unused media in the project (media or audio in the Media list not used in the project), select “Include unused media.”

When the template is applied to the Final Cut Pro Timeline, the template aspect ratio that matches the Final Cut Pro project is used.
Create a custom display aspect ratio (DAR) snapshot

Pixel Aspect Ratio (PAR) is the ratio of the width of a pixel to its height. For example, NTSC pixels are slightly taller than they are wide. They have a pixel aspect ratio of 10/11 (approximately 0.9091). Display Aspect Ratio (DAR) is a ratio of the final displayed image’s width to its height. For example, the iPad display aspect ratio is 1.3333 (also written as 4:3), but broadcast NTSC has a display ratio of 1.3636. To calculate the display aspect ratio of an image from its dimensions and pixel aspect ratio, multiply the pixel aspect ratio by the width and divide by the height. The most common aspect ratios are 4:3 (also referred to as standard, 4x3, or 1.33:1) and 16:9 (widescreen, 16x9, or 1.78:1). Older monitors and televisions are generally 4:3, so the screen is 33 percent wider than it is high. Newer HD monitors and televisions are 78 percent wider than they are high.

1. In the Layers list, select the Project object.

2. In the Project Inspector, click Snapshots.

3. Click the Add button (+) and choose Custom from the shortcut menu.

4. Click the Pixel Aspect Ratio pop-up menu, then choose an option, such as NTSC D1/DV.

   The pixel aspect ratio (PAR) appears in the field to the right of the pop-up menu.

5. Enter the width and height in the fields to the right of the PAR
value, such as 720 x 480.

The new custom DAR is listed in the Display Aspect Ratio Snapshots list.

About template files and media save locations

When you save a template, the project and all associated files are saved in your /Users/username/Movies/Motion Templates/ folder on your computer, organized by template type. For example, a Final Cut Effect template is saved to /Users/username/Movies/Motion Templates/Effects/; a Final Cut Transition is saved to /Users/username/Movies/Motion Templates/Transitions/, and so on. The template types include Compositions (templates created in Motion for use in Motion), Effects, Generators, Titles, and Transitions.

When you save a template in Motion, you assign a category and have the option to assign a theme.

In the OS X Finder, templates are stored according to the following folder hierarchy: template type/category/theme. For example, if you save a Final Cut Effect template to the “Blur” category with an optional “News” theme, it is stored in the Finder in the /Users/username/Movies/Motion Templates/Effects/Blur/News/yourtemplatename folder.

Note: You can also sort by theme in the Motion Project Browser using the Theme pop-up menu.
Contents of the template folder

Each template folder contains the following items:

- **large.png**: This file is used for the preview in the Motion Project Browser and as a preview in the Final Cut Pro browser when the project loads in the background.

- **small.png**: This file is used for the thumbnail preview of the template in the Final Cut Pro browser. The current frame when the template is saved in Motion is used for the preview frame.

- **yourtemplatename.mov**: This file is used for the movie preview of the template that plays when the template is selected in the Motion Project Browser. This file is created when you select the “Save Preview Movie” checkbox before saving.

- **yourtemplatename.moef, -.motn, -.moti, or -.motr**: This is the Motion template’s project document.
  - .moef is the Final Cut Effect template extension.
  - .motn is the Final Cut Generator template extension.
  - .moti is the Final Cut Title template extension.
  - .motr is the Final Cut Transition template extension.

- **Media folder**: This folder contains all media in the project—media used in the placeholder and other clips and images used in the project, including content such as particle cell sources. If you clear the media in the template placeholder before saving the template, that media is not saved in the Media folder.

**Note:** If you select “Include unused media” in the save dialog.
Sharing templates

To share templates and associated media files between users and computers, place the associated template files in the same folder structure on another user’s computer in the /Users/username/Movies/Motion Templates/ folder.

About using masks in templates

You can use shapes and masks in any Final Cut Pro template type. For the best template results, use the following guidelines:

- Limit the use of shapes to generator templates. Shapes are ideal generator template elements because they can be scaled in Final Cut Pro X without degradation. (However, too many shapes in a template can adversely impact performance in Final Cut Pro.)
- A shape added to a placeholder layer is converted to a mask. When a template with a masked placeholder is applied to a clip in Final Cut Pro, the mask is applied to the clip. Objects in the template outside the placeholder are not affected.
- Mask parameters (Roundness, Feather, and Mask Blend Mode, and so on) can be published so they are editable in Final Cut Pro. However, the onscreen mask controls in Motion are not available in Final Cut Pro. To reposition a template mask in Final Cut Pro, publish the mask’s transform.
parameters (located in the mask’s Properties Inspector). For more information on publishing, see Add parameter controls overview.

For more information on working with shapes and masks, see Shapes, masks, and paint strokes overview.

Guidelines for better template creation

To get the best results when creating custom templates, consider the following suggestions:

- Although you can drag a video clip into a placeholder layer for preview purposes, the clip’s duration can interfere with timing built into the template. For that reason, it’s better to use still images in templates when you need to preview an effect.

- Complex Motion layer effects such as particle emitters and replicators are not recommended for use in any template types, because they might negatively affect Final Cut Pro X performance.

- The first time you save a template that’s a work in progress, deselect the Save Preview Movie checkbox in the save dialog. Doing so prevents Motion from creating a movie preview each time you save the draft template. (The preview movie appears in the Motion Project Browser.) When you’re ready to save the final version of the template, select the Save Preview Movie checkbox to create the preview movie.

- When creating complex templates that involve multiple drop...
When creating complex templates that involve multiple drop zones, use a Final Cut Generator or Final Cut Title template.

- As with any project in Motion, too many effects (such as filters, text objects, and so on) adversely impact performance in Final Cut Pro.

- Create animation using behaviors rather than keyframes. Behaviors are easier to modify when the template is applied in Final Cut Pro.

- Avoid publishing parameters animated with behaviors or keyframes. Published parameters allow template customization in Final Cut Pro.

- Shapes are nice graphic elements to add to a template project (outside of the placeholder), as they can be scaled without degradation. (Shapes added to a placeholder become masks). However, too many shapes in a template will adversely impact performance in Final Cut Pro.

- Ensure that “Create Layers At” in the Project pane of Motion Preferences (click Command-Comma to open Preferences) is set to “Start of project.”

- In the Motion Timeline, ensure that all filter and behavior bars extend to the end of the project.

- Before saving a template, decide whether you want to save or clear preview media, based on the following considerations:
  - Media not cleared is saved with the template, creating longer render times and consuming storage space.
  - Media saved with the template is available when the template is reopened in Motion (via the “Open in Motion” command in the Final Cut Pro media browsers), allowing
you to pick up where you left off in the previous template-building session.

- When keying green screen or blue screen footage, using a keying template is not recommended. Footage should be keyed directly in its own project in Final Cut Pro or Motion. This is because the Keyer filter analyzes the footage it is initially applied to. You can render a keyed clip with its alpha channel and add the clip to a Final Cut Pro project. For more information, see Keying overview.

- Do not use image sequences when creating templates.

- If an object in a template has an applied Link Parameter behavior, do not move the object to another group. Doing so breaks the links.

- If you publish parameters for an object and then delete that object, all parameters set to be published are also deleted.

- Do not use deprecated filters (older filters that are no longer supported in Motion 5) in a template. Although the filter may render correctly in Motion, it may not render correctly after the template is applied to a Final Cut Pro clip.

- If using a third-party filter, ensure that your template contains a Project Loop End marker (or that the project’s duration is set to one frame). If the template does not contain a Project Loop End marker, the effect is re-rendered in Final Cut Pro following certain editing actions, such as blading or trimming.

- Template placeholder layers cannot be duplicated. If a group that contains a placeholder is duplicated, other objects in the group are duplicated, but not the placeholder.

- If you plan to loop template animation, or need to match the
template and a Final Cut Pro project frame for frame, create the template with the same frame rate as the Final Cut Pro project. For more information on looping template animation, see Add template markers.
Rigging overview

Even a relatively basic Motion project contains numerous parameter controls. You can customize and even combine multiple controls using *rigging*.

Rigging lets you map one or more parameters at preset values to a single control. For example, you can rig a single slider to change the size, color, and tracking of a text object to a specific range of preset values. Or you can rig a single a checkbox to activate shadows and reflections for all objects in a project.

The customized master controls (checkboxes, pop-up menus, and sliders) in a rig are called *widgets*. You can create widgets to adjust nearly any parameter of any object in your project, including behaviors, filters, particle systems, replicators, text, shapes, video clips, images, cameras, lights, and so on. Widgets can even control other widgets. There’s no limit to the number of parameters each widget affects. You can use multiple widgets in a rig to create a customized control panel where a few controls modify a wide range of parameters in the project.

Rigging is especially useful in *Final Cut Pro X templates*, allowing users to modify a complex group of parameters with a small set of controls, or limiting user control to ensure that junior compositors, editors, and others in the production pipeline adhere to established specs and client needs. But rigs are also useful in
Motion, allowing you to simplify the control set of a complex project. Instead of making changes by manipulating individual parameters, you can modify the Motion project using just a few widgets in a rig. For examples showing how rigs can simplify a Motion project, see How to use a single rig and How to use multiple rigs.

The following image shows a Rig in the Inspector with a single checkbox widget controlling the color of multiple objects. The name of the checkbox has been customized ("Dark colors").

![Rig in the Inspector](image)

**SEE ALSO**

- How does rigging work?
- Build a simple rig
- Work with widgets
- Publish rigs to Final Cut Pro

**How does rigging work?**

When you create a rig and add a widget control, you assign sets of **snapshots** to the widget. A snapshot is a record of parameter states for one or more objects in your project. Widgets let you
switch between stored snapshots. For example, you can use a checkbox widget to record a snapshot of a shape’s Scale and Color parameters at one set of values (large and red) and then record another snapshot at a different set of values (small and green). In this example, when you select and deselect the checkbox widget (in the Widget Inspector), the shape snaps from large and red to small and green, and vice versa. See Snapshots overview.

There are three types of widgets, each offering a different level of control over snapshots:

- **Checkbox**: The most basic widget, toggles between two snapshots. For more information, see Checkbox widget.
- **Pop-up menu**: A slightly more complex widget, lets you choose from among multiple snapshots. For more information, see Pop-up menu widget.
- **Slider**: The most complex widget, lets you apply gradual changes between multiple snapshots. For more information, see Slider widget.

There are several ways to record snapshots. The most basic method is to use the Rig Edit Mode button in the Widget Inspector. In rig edit mode, any changes you make to the parameters of any object update the active snapshot in that widget. For more information, see Build a simple rig. For additional ways to assign snapshots, see Snapshots overview.

There are several factors to consider when using rigs:
- Each parameter in a project can be assigned to only one widget at a time. However, you can store many values for that parameter as different snapshots that can be accessed using
Because a parameter cannot be controlled simultaneously by two widgets, you cannot duplicate (or cut/copy and paste) a rig or widget. Similarly, if you duplicate or copy and paste an object with rigged parameters, the new object’s parameters are not rigged.

If a parameter is assigned to a widget, that parameter cannot be modified while you are actively recording a different widget’s snapshot. For example, if you have a slider widget controlling a shape object’s color, and you begin recording a snapshot for a different widget, the shape’s color is not modifiable.

Some parameter types cannot be rigged. Some parameters that use the mini-curve editor to affect an object over a range (such as the various “over stroke” parameters in the Shape inspector) cannot be added to a rig or modified while recording a snapshot. If you modify a parameter that cannot be rigged in edit mode, the change is applied globally—affecting all snapshots containing that object.

Build a simple rig

The following task describes how to add a basic rig to a project, add a widget to the rig, then assign parameters and snapshots (parameter states) to the widget.

1. Choose Object > New Rig (or press Control-Command-R).
A new rig is added to the project (shown in the Layers list and Timeline layers list).

2. In the Rig Inspector, click one of the three buttons:
   - **Add Slider**: Adds a slider widget to the rig, enabling users to apply gradual changes between multiple parameter states
   - **Add Pop-up**: Adds a pop-up menu widget to the rig, enabling users to choose from among multiple parameter states
   - **Add Checkbox**: Adds a checkbox widget to the rig, enabling users to toggle between two parameter states

The new widget (in this example, a pop-up menu widget) appears in the Layers list under its parent rig:
And the Widget Inspector opens:

By default, the widget contains empty placeholders for snapshots (parameter states). In this example, the pop-up menu widget contains three options: Snapshot 1, Snapshot 2, and Snapshot 3. You can rename them using the Rename button. See Create and manage snapshots.

3. To assign parameters and snapshots (specific parameter states) to the widget, do the following:

   a. In the Rig inspector or the Widget inspector, click the Edit Mode Start button.

      A window appears containing the Stop Rig Edit Mode button. The appearance of this window indicates that you...
are in rig edit mode: Any changes you make to parameters of any object in your project will be recorded as a snapshot.

b. Record a snapshot by making changes to objects in your project in the Canvas, the HUD, or the Inspector.

In this example, any changes you make are applied to the Snapshot 1 pop-up menu item.

c. When you finish making changes to parameters, click Stop Rig Edit Mode.

The snapshot is stored and the parameters you modified are added to the Widget Inspector, alongside a joystick icon indicating that the parameter is rigged.

d. To set additional snapshots, choose an unassigned snapshot in the widget (in this example, choose Snapshot 2 from the pop-up menu), then repeat steps a, b, and c.
After you add snapshots to a widget, adjusting the widget control (the checkbox, pop-up menu, or slider) loads a snapshot, changing the state of affected parameters in your project.

For information about other methods to create snapshots, see Snapshots overview and Control rigs from parameter Animation menus.

Work with widgets

A rig has no effect until it contains a widget with assigned snapshots (parameter states). Widgets are special controls used to drive parameters in the project.

Widgets are represented in four places in the Motion workspace:

- In the Layers list, under the parent rig.
- In the Rig Inspector. If the rig has multiple widgets, they all appear here.
- In the HUD.
- In the Widget Inspector.

Widgets can be reordered and renamed. Renaming widgets can be important if you have multiple widgets of the same type. Otherwise you see a list of controls that have identical, generic names.
When viewing the Widget Inspector, the controls for the selected widget are displayed. When viewing the Rig Inspector, controls for all widgets in the rig are displayed. The Widget Inspector and Rig Inspector both display the parameter controls used to modify the widget (an Edit Mode button and the parameters you’ve assigned to it). However, the HUD displays only the assigned widget control (the checkbox, pop-up menu, or slider that toggles or adjusts the widget), not the parameters used to modify the widget.

When a rig is selected, the HUD shows all widget controls assigned to that rig.

**Add a widget and assign a parameter in a single step**

As an alternative to creating a widget using the buttons in the Rig Inspector, you can create a rig and a widget and then apply a parameter to the widget in a single step.

Do one of the following:
In the Inspector, click a parameter’s animation menu (the downward arrow that appears when you position the pointer over the right side of a parameter row), choose Add To Rig, choose a rig, then choose a widget type from the submenu.

Drag a parameter row from any Inspector pane to a rig object in the Layers list.

Dropping the parameter row immediately on the rig object creates a slider widget. Pausing briefly causes a drop menu to appear, allowing you to select the widget type you want to create.

A new widget appears in the Layers list, under its parent rig. In the Widget Inspector, the parameter you chose appears under the Edit Mode button, ready for snapshot assignment. For more information, see Create and manage snapshots and Control rigs from parameter Animation menus.

---

**Reorder widgets in a rig**

In the Layers list, drag the widgets into the order you want them to appear.
By default, each widget is named according to its type (“Checkbox,” for example). However, you can assign a custom name to identify the settings the widget will affect.

- Double-click the widget name in the Layers list, enter a new name, then press Return.

Widget names cannot be changed in the Inspector.

**Note:** If the widget has been published, the name change does not carry through to the published parameter. To synchronize names, rename the widget manually in the Publishing pane of the Project Inspector, or unpublish and republish the newly named widget.

---

**Move a widget to another rig**

If there are multiple rigs in a project, widgets can be moved easily between the different rigs.
In the Layers list, drag the widget you want move onto another rig.

**Delete a widget from a rig**

Select the widget, then do one of the following:

- Press Delete.
- Choose Edit > Delete.
- Control-click the widget, then choose Delete from the shortcut menu.

**SEE ALSO**

Checkbox widget
Pop-up menu widget
Slider widget

**Widget types**

**Checkbox widget**

Checkbox widgets allow you to switch between two snapshots—that is, between two sets of parameter states. Typically, checkbox widgets are used to create an on/off type of effect, although you can store any parameter states in either snapshot, creating more of a toggle effect.
The activation checkboxes in the Rig Inspector (highlighted blue when selected) and in the Layers list (beside the checkbox widget) have no effect on the constituent parameters of the checkbox.

Checkbox widgets contain the following controls in the Rig Inspector and Widget Inspector:

- **Checkbox**: Use this widget control to switch between two snapshots (parameter states).
- **Edit Mode**: Click the Start button to enable snapshot recording. For more information about recording snapshots, see Snapshots overview.

**Note**: When you record a snapshot (using the Edit Mode button or the methods described in Snapshots overview), the affected parameters (those you modify in the Inspector or via onscreen controls in the Canvas) are added to the widget. When you finish recording a snapshot, new controls for the modified parameters appear in the Widget Inspector. These parameters are duplicates of the same parameters that occur in other Inspector panes. Parameters controlled by a rig display a special icon (a joystick) on the right side of the parameter row in the Inspector.

### Pop-up menu widget

Pop-up menu widgets are similar to checkbox widgets but allow you to save more than two parameter states (snapshots). Each
item in a pop-up menu widget represents a snapshot. When you choose an item in the pop-up menu, the affected parameters in your project toggle to a different saved state.

The activation checkboxes in the Rig Inspector (highlighted blue when selected) and in the Layers list (beside the pop-up menu widget) have no effect on the constituent parameters of the pop-up menu.

Pop-up menu widgets contain the following controls in the Rig Inspector and Widget Inspector:

- **Pop-up**: Use this widget control to switch between multiple saved snapshots.
- **Rename**: Use this button to enter a custom name for the item in the pop-up menu.
- **Add/Delete**: Click the Add button (+) to add an item to the pop-up menu; click the Delete button (−) to remove an item. Each item represents a new snapshot.
- **Edit Mode**: Click the Start button to enable snapshot recording. For more information about recording snapshots, see Snapshots overview.

**Note**: When you record a snapshot (using the Edit Mode button or the methods described in Snapshots overview), the
affected parameters (those you modify in the Inspector or via onscreen controls in the Canvas) are added to the widget. When you finish recording a snapshot, new controls for the modified parameters appear in the Widget Inspector. These parameters are duplicates of the same parameters that occur in other Inspector panes. Parameters controlled by a rig display a special icon (a joystick) on the right side of the parameter row in the Inspector.

- **Initial Value**: Use this control (in the Options section) to set the initial value for the pop-up menu widget when it’s published and used as a template in Final Cut Pro X. There are three options:

  - **Last Saved**: When the template is used in Final Cut Pro, the pop-up menu value defaults to the menu item assigned when the project was last saved. This option ensures a consistent pop-up menu state, while still permitting users to choose alternate states manually. This is the default setting.

  - **Sequential**: Each time the template is used (in a single project) in Final Cut Pro, the setting of this pop-up menu changes, rotating through the available menu items. The first time the template is used, this pop-up menu defaults to the first menu item. The next time the template is used, the pop-up menu is set to the second menu item, and so on. For example, in a wipe transition template with a pop-up menu widget assigned to control the shape of the wipe, the first time you add the template to the Final Cut Pro timeline, the wipe is a star; the next time you apply the template to the Final Cut Pro timeline, the wipe is a circle, and so on.
Random: Each time the template is used in Final Cut Pro, another menu item from this pop-up menu is assigned by default. For example, in a title template with a pop-up menu widget assigned to control the title’s font, each successive time the title is used in a project, a font is randomly selected from the font list.

Slider widget

Slider widgets let you select values interpolated between snapshots. When you drag the slider, the affected parameters change gradually, ramping between the values of adjacent snapshots. Each snapshot assigned to a slider is represented by a separate snapshot tag—a small shaded circle underneath the slider widget.

For information on adding snapshot tags, see the tasks in Create and manage snapshots.

Clicking a snapshot tag sets the value of the slider to the tag’s value and enables the tag’s snapshot for editing. Setting the slider to values between tags causes the rigged parameter values to be interpolated between the surrounding snapshot values.
The activation checkboxes in the Rig Inspector (highlighted blue when selected) and in the Layers list (beside the slider widget) have no effect on the constituent parameters of the slider.

Slider widgets contain the following controls in the Rig Inspector and Widget Inspector:

- **Slider**: Use this widget control to move between snapshots. The snapshot tags beneath the slider indicate the saved snapshots.

- **Snapshot tags**: The small (unlabeled) shaded circles underneath the slider indicate saved snapshots. Double-click below the slider to add snapshot tags. Add as many snapshot tags as you want. Snapshot tags work similarly to tags that represent individual colors in a gradient. To learn how tags are used when creating gradients, see Gradient editor controls.

- **Edit Mode**: Click the Start button to enable snapshot recording. For more information about recording snapshots, see Snapshots overview.

**Note**: When you record a snapshot (using the Edit Mode
button or the methods described in Snapshots overview), the affected parameters (those you modify in the Inspector or via onscreen controls in the Canvas) are added to the widget. When you finish recording a snapshot, new controls for the modified parameters appear in the Widget Inspector. These parameters are duplicates of the same parameters that occur in other Inspector panes. Parameters controlled by a rig display a special icon (a joystick) on the right side of the parameter row in the Inspector.

- **Range Minimum**: Use this parameter (in the Options section) to set the low end of the numeric range displayed next to the slider widget. For example, if you want the slider widget to range from 0 to 11, set Range Minimum to 0.

- **Range Maximum**: Use this parameter (in the Options section) to set the high end of the numeric range displayed next to the slider widget. For example, if you want the slider widget to range from 0 to 11, set Range Maximum to 11. If you want the slider widget to range from 0 to 100, set Range Maximum to 100.

**Note**: Range Minimum and Range Maximum have no effect on the actual parameter values that the slider widget controls. Range Minimum and Range Maximum merely designate an arbitrary numeric range that’s displayed next to the slider widget.

- **Interpolation**: Use this pop-up menu (in the Options section) to set how values on the slider are interpolated. The interpolation applies to the segment of the slider between the current snapshot tag and the next one. You can set interpolation methods for each segment of the slider. By default, all segments are set to Linear. There are three menu options:
- **Constant**: Holds the value of the first snapshot until the slider reaches the next snapshot, at which point the parameter changes. (This is similar to changing states using a pop-up menu widget.)

- **Linear**: Creates a simple interpolation between states.

- **Ease**: Creates a smooth interpolation, where the effect is weighted towards the nearer snapshot tag.

## Manage parameter snapshots

### Snapshots overview

When you click the Edit Mode Start button in the Widget Inspector or Rig Inspector, Motion begins recording parameter changes you make (including parameters you animate). Also, a window appears containing a Stop Rig Edit Mode button.

The parameter changes you make while in rig edit mode are stored in the current snapshot (the item selected in the widget checkbox, pop-up menu, or slider). Other snapshots in the rig are unaffected. After you stop rig edit mode, any parameter you modified (in the Canvas, or in the HUD or Inspector) is added to the Widget Inspector, and its state is saved in the snapshot.

Only one snapshot can be modified per edit mode session. To edit more than one snapshot, end the editing session, select
another snapshot (by clicking another snapshot tag for a slider, by choosing a new menu item for a pop-up menu, or by changing the state of a checkbox), then start a new edit mode session.

Parameters affected by a rig display a joystick icon on the right side of the parameter row.

Any parameter controlled by a rig is added to the Widget Inspector, below the Edit Mode Start button and above the Options parameters.

**Note:** Each parameter can be controlled by only one widget. After a parameter is assigned to a widget, you cannot assign that parameter to additional widgets.

You can add parameters to a widget after a snapshot is created.
by clicking the Start Rig Edit Mode button again and making changes to new parameters (see Create and manage snapshots) or by manually adding parameters to the widget (see Control rigs from parameter Animation menus).

**Important:** After a parameter is added to a widget, changes made to that parameter modify the selected snapshot even if Rig Edit Mode is stopped, and even if the Widget Inspector is not visible.

**How snapshots are saved**

Snapshots are saved in the widget. Any parameter affected by a snapshot is persistently displayed in the widget (even if that parameter is unmodified by the current snapshot setting). Parameter controls in widgets are duplicates of the parameter controls they’re linked to.

- For checkbox widgets, there are two snapshots: one for the selected state and one for the deselected state. Making changes to the linked parameters affects the snapshot for the current state of the checkbox.

- For pop-up menu widgets, there are as many snapshots as there are menu items. Add menu items by clicking the Add button (+) to the right of the pop-up menu in the Widget Inspector. Making changes to the parameters affects the selected pop-up menu item.

- For slider widgets, you must select a snapshot tag before enabling Edit Rig Mode.
After parameters are added to the widget, they can be modified only when a specific snapshot tag is selected. If a slider widget is set between two tags, you cannot modify parameters.

Create and manage snapshots
You can record and modify snapshots using the controls in the Rig Inspector or Widget Inspector.

Record a snapshot
1. Select a rig or widget in the Layers list.
   
   For information about creating rigs and widgets, see Build a simple rig.

2. In the Rig Inspector or Widget Inspector, choose a snapshot
state from the widget control you want to record to:

- **Checkbox widget**: To record to the selected state, select the checkbox. To record to the deselected state, deselect the checkbox.

- **Pop-up menu widget**: Click the pop-up menu, then choose an item (Snapshot 1, Snapshot 2, or Snapshot 3) to record to.

- **Slider widget**: Select a snapshot tag (one of the gray shaded circles under the slider) to record to. To create a new snapshot tag, double-click an empty area below the slider. When selected, the snapshot tag is highlighted blue.

3. Click the Edit Mode Start button under the widget control you prepared in step 2.

A window appears containing a Stop Rig Edit Mode button. The appearance of this window indicates that changes you make to parameters will be recorded.

4. Make changes to one or more parameters of one or more objects in your project using the onscreen controls in the Canvas or the numeric controls in the HUD or Inspector.

Each adjustment you make is recorded to the snapshot setting selected in the widget (the checkbox, pop-up menu item, or slider position).
5. After you set the parameters to the desired snapshot state, click the Stop Rig Edit Mode button. Recording is stopped, and the snapshot is stored to the widget. Modified parameters are added to the Widget Inspector (under the Edit Mode Start button) alongside a joystick icon indicating that the parameter is rigged.

6. To set additional snapshots, repeat steps 2 through 5.

Rename a snapshot in a pop-up menu widget

By default the snapshot settings in a pop-up menu widget are named Snapshot 1, Snapshot 2, and Snapshot 3. You can give them more descriptive names using the Rename button.

1. Select a rig or widget in the Layers list.

For information about creating rigs and widgets, see Build a simple rig.
2. In the Rig Inspector or Widget Inspector, choose an item from the pop-up menu (Snapshot 1, Snapshot 2, or Snapshot 3), then click the Rename button.

3. Enter a new name in the highlighted field, then press Return. The menu item updates to the new name.

4. Repeat steps 2 and 3 to rename additional pop-up menu items.

Add snapshot items to a pop-up menu widget

By default, the pop-up menu widget contains three menu items (Snapshot 1, Snapshot 2, and Snapshot 3). You can add or remove menu items using the Add or Delete button.

1. Select a rig or widget in the Layers list.

   For information about creating rigs and widgets, see Build a simple rig.

2. In the Rig Inspector or Widget Inspector, choose an item from the pop-up menu, then do one of the following:
Add a menu item: Click the Add button (+) to the right of the pop-up menu, enter a name for the new item in the highlighted field, then press Return.

Remove a menu item: Click the Delete button (−) to the right of the pop-up menu.

Add a snapshot tag to a slider widget

By default there are two recordable snapshot settings in a slider widget, represented by snapshot tags: shaded gray circles under the slider, and at either end. When you record snapshots to these two tags, values along the slider between the two tags are interpolated; in other words, when you drag the slider, the affected parameters change gradually, ramping between the values of adjacent snapshots.
You can add additional snapshot tags to the slider widget to create more complex ranges of parameter change.

1. Select a rig or widget in the Layers list.

   For information about creating rigs and widgets, see Build a simple rig.

2. In the Rig Inspector or Widget Inspector, double-click an empty area below a slider widget.

   A new snapshot tag appears under the slider. Parameters at this position inherit their values based on the interpolation point between the two snapshot tags adjacent to the new snapshot tags. You can reorder snapshot tags by dragging them left or right under the slider.

   To record new or additional parameter values for a snapshot tag, see “Record a snapshot” above.

Delete a snapshot tag from a slider widget

- Drag the tag away from the area under the slider.
Control rigs from parameter Animation menus

Using the Animation menu, you can create or modify a rig while you’re modifying specific parameters in your project.

Add a parameter to a rig

- In the Inspector, click the Animation menu for the parameter (the downward arrow that appears when you place the pointer over the right side of a parameter row), choose Add to Rig > Rig, then choose a rig and a specific widget from the submenus.

The parameter is added to the selected widget in the rig.

Note: You can also create a rig via this submenu.
Remove a parameter from a widget

- In the Inspector, click the Animation menu (the downward arrow that appears when you place the pointer over the right side of a parameter row) of the parameter to remove, then choose Remove from Widget [name of widget].

The parameter is removed from the widget.

**Note:** Parameters can be removed from a widget in the parameter list in the Widget Inspector or in the Inspector containing the original parameter.

Reveal the widget driving a parameter

- In the Inspector, click the Animation menu (the downward arrow that appears when you place the pointer over the right side of a parameter row) for the parameter, then choose Reveal Widget [name of widget].

The Inspector displays the Widget pane.

Reveal the original parameter used in a widget

- In the Widget inspector (not the Rig Inspector), click the Animation menu (the downward arrow that appears when you place the pointer over the right side of a parameter row) for the parameter, then choose Reveal Target Parameter.
The Inspector containing the original parameter is opened and the parameter name briefly blinks yellow.

Note: The Reveal Target Parameter command can be especially helpful when a widget is driving multiple similarly named parameters from different objects. This command allows you to identify the parent object.

How to use rigs

How to use a single rig

Although rigs are often used to build master controls for use in Final Cut Pro X projects, they’re also useful in Motion, to simplify the control set of a complex project. Instead of making changes by manipulating individual parameters in various Inspectors, you can modify the Motion project using just a few widgets in a single rig.

You can make changes to a Motion project by adjusting widgets in the Rig Inspector, in the Widget Inspector, or in the Rig HUD. However, it may be easiest to adjust widgets in the Rig HUD, which displays only the widgets you’ve created (and none of the additional controls used to create and customize widget settings).
A rig is especially helpful when you need to share a complex project with multiple users or when the project is designed to be updated each time it’s used. For example, you can create a basic project for an animated lower-third title that incorporates two text objects, a background replicator, and a lens flare generator that moves across the text.

![Image of a project with layers and controls]

Each time the project is used, the size and position of the background generator must change to match the length of the text. Also, the lens flare must only appear on top of the letters. By adding a rig to the project, you can create a small set of controls that modify only the parameters such changes require.
As an alternative to adjusting widgets in the Rig HUD, you can publish the widgets, then adjust them in the Project Inspector. (Open the Project Inspector by selecting the Project object at the top of the Layers list). For more information about publishing, see Publish rigs to Final Cut Pro.

You can even apply keyframes to a slider widget to create dynamic animated effects based on saved snapshots in the slider. (Pop-up menu and checkbox widgets cannot be keyframed, nor can they accept behaviors. For more information, see About widget animation.)
How to use multiple rigs

You can create multiple rigs in a single project to better organize related widgets. Likewise, you can group each rig in the Layers list with the object or objects it affects. That way you can quickly navigate to the relevant rig to control the specific, related parameters.

You can also use one widget to control another. Treat the widget as you would another parameter control when manipulating a snapshot for a widget.

**Note:** You cannot create recursively controlled widgets. That is, you cannot use one widget to drive a second widget that’s already driving the first.
About widget animation

When a Motion project contains a rig with a slider widget, you can use keyframes to animate the parameters modified by the slider (using the same keyframing method you use for unrigged parameters). Keyframing a slider widget lets you create powerful and complex effects where multiple parameters driven by a single widget are animated simultaneously. In rig edit mode, you can also apply Parameter behaviors to a rigged object.

**Note:** Pop-up menu widgets and checkbox widgets cannot be keyframed, nor can they accept behaviors.

For more information about animating with keyframes, see Keyframing overview.

Publish rigs to Final Cut Pro

Rigging is especially useful in Final Cut Pro X templates, allowing users to modify a complex group of parameters with a small set of controls, or limiting user control to ensure that junior compositors, editors, and others in the production pipeline adhere to established specs and client needs. After you add widgets ( checkboxes, pop-up menus, and sliders) to a rig in a Final Cut Pro template in Motion, you must choose which widgets you want to publish. When you save the template, its published widgets become available in Final Cut Pro.

Publish a widget to Final Cut Pro
In the Rig or Widget Inspector, Control-click the name of the parameter to publish, then choose Publish from the shortcut menu.

**Note:** The template must be saved for its published parameter controls to be available in Final Cut Pro.

### View published parameters in Motion

You can review the parameters set to be published in your template by opening the Project Inspector.

1. Click the Project object at the top of the Layers list.

2. In the Project Inspector, open the Publishing pane.

   The Publishing pane displays all published parameters, including widgets. When saved in a template, published parameters also appear in the inspector in Final Cut Pro. For more information about publishing, see Add parameter controls overview.
Create particles

Particles overview

Particle systems let you create sophisticated effects involving large numbers of automatically animated objects.

You can add a premade particle system to your composition from the Library, or you can create your own custom particle effects using nearly any image layer or group in your project, including still images, shapes, text, and movies.

Particle systems consist of two basic elements:

- *Particle emitter*: A special type of effect applied to a layer, causing the layer to multiply and animate according to the parameters you set in the Inspector.
- *Particle cell*: The image layer that’s multiplied and animated by the particle emitter.

The emitter and cells have separate sets of parameters that
control the particle system’s behavior. If you imagine that a garden hose is a particle system, the nozzle acts as the emitter, while the water represents the flow of particles. Changing the parameters of the emitter changes the shape from which the particles are emitted as well as their direction. Changing the cell’s parameters affects each particle.

Each particle created in the Canvas is essentially a duplicate of the cell, and is animated according to the parameters of that particle system over its lifetime.

The layer you use as a particle system’s cell determines the appearance of that particle system. Particle systems can contain multiple cells (image layers), resulting in the release of several types of particles from a single emitter. Many of the most sophisticated particle presets in the Particle Emitters library are constructed in this way.
SEE ALSO
Add preset particles or create custom particles
What happens when you create a particle emitter?

Add a particle system to a project
Add preset particles or create custom particles
There are two basic ways to add a particle system to a project:

- Choose a preset from the Particle Emitters category of the Library.
- Create a custom particle system using your own image, video clip, shape, or text. You can also use multiple images as source cells for a single particle system.

Add a preset particle system from the
Library

The easiest way to add a particle system to your project is to use a preset in the Particle Emitters category of the Library. There are many types of particle effects to choose from. If you find one close to what you need, you can easily customize its parameters after you add it to your project. Particle systems are added to a project exactly like any other object in Motion.

1. In the Library, select the Particle Emitters category, then select a subcategory, such as Nature, Pyro, SciFi, and so on.
2. In the Library stack under the categories and subcategories, select a particle preset.

An animated preview of the selected particle emitter plays in the Library preview area.

3. Do one of the following:

- Click Apply in the preview area to add the selected particle system to the center of the Canvas.

  **Note:** If Create Layers At is set to “Start of project” in the Project pane of Motion Preferences, the particle system is added at the first frame. See If it’s your first import.

- Drag the particle system from the Library stack into the Canvas to the position where you want it to appear.

- Drag the particle system from the Library stack into a group in the Layers list or Timeline.

- Drag the particle system from the Library stack to the track area of the Timeline or mini-Timeline; when you reach the frame where you want the new particles to start, release the mouse button.

The new particle emitter layer appears in the Layers list and in the Canvas, composited against any other layers you’ve already added.

When you add a particle system from the Library, the system acts as it did in the preview area. If necessary, modify the particle system parameters in the HUD or Inspector. See Emitter adjustment overview. You can modify a particle system only after it’s added to a project.
Note: Some emitters look best when motion blur is enabled. Preset Library emitters that benefit from motion blur include Jelly Bands, Light Transit, Rain Streaks, and Silly String. To enable motion blur, choose Motion Blur from the Render pop-up menu (above the Canvas), or choose View > Render Options > Motion Blur (or press Option-M).

---

Create a custom particle system

To create a custom particle system, you must select a layer in your project to use as the source for a cell in a new particle emitter. You can use any layer in your project as a cell source, including still images, video clips, text, or shapes created in Motion. The layer you select when you create an emitter becomes the first cell in that particle system. The cell specifies the look of the actual particles generated in the Canvas.

Note: You can also use a group as the source for an emitter cell, but your computer’s processing performance may slow drastically.

1. Create an image layer to serve as the cell source for the particles that your emitter will generate.
   
   This example uses an image of a simple white circular gradient, such as the “basic blur” image located in the Library (in the Particle Images subcategory of the Content category).
2. Move the object in the Canvas to the location where you want the center of your particle system to be.

3. Select the object, then do one of the following:
   - In the toolbar, click the Make Particles button.
   - Press E.

   The new custom particle emitter layer appears in the Layers list and in the Canvas, composited against any other layers you’ve already added. If necessary, modify the particle system parameters in the HUD or Inspector. See Emitter adjustment overview.

---

Create complex particles using multiple source layers

You can add as many cells as you want in a single emitter, creating complex compositions with different overlapping
1. Add one or more image layers to your project.

2. In the Layers list, select the layers to use as the particle cells, then do one of the following:
   - In the toolbar, click the Make Particles button.
   - Press E.

   A new particle emitter layer appears in the Layers list and in the Canvas. The emitter’s cells (the image layers you selected in the previous step) appear in Layers list under the emitter object.

3. To create additional cells for the emitter, drag layers in the Layers list onto an existing emitter.

   **Note:** Layers dragged from the File Browser or Library directly are not added to an emitter, but as a layer in a new group.

The layers you drag are copied to the particle system, appearing as new source cells in the Layers list (under the emitter object) and in the Canvas as part of the complex particle system. The original layers remain as standalone items in the project. You can deselect their activation checkboxes in the Layers list to hide them in the Canvas. (However, if you delete the original layers, their source cells are deleted from
When you play the project, each source cell generates particles simultaneously, according to each source cell’s parameters. When selected in the Layers list, each cell displays its own Particle Cell Inspector.

**Note:** When multiple sources are used to create a particle system, the resulting emitter is positioned in the Canvas at the average of the sources’ positions.

---

**Optimize particle system resolution to improve playback performance**

Particle systems often create particles that grow or move off the Canvas before they “die.” This can make the size of a layer or group much larger than the dimensions of the Canvas. Although the particles are not visible after they move off the Canvas (unless Show Full View Area is enabled in the View menu), they’re still present in the project and are processed. You can improve playback performance by constraining the resolution (height and width) of the group containing the particle emitter.

**Note:** Using a movie with applied filters as a particle cell source adversely impacts your computer’s processing performance. For better performance, export your sequence with the filter applied, then import it back into Motion and use the movie as the cell source.

1. In the Layers list, select a group that contains a particle emitter.
2. In the Group Inspector, select the Fixed Resolution checkbox.

For more information, see Constrain group size.

What happens when you create a particle emitter?
After you add a particle emitter to a project, the following occurs:

- An emitter appears in the Layers list and is selected.
- A cell containing the image or images to be “particle-ized” appears as a sublayer underneath the emitter (click the disclosure triangle beside the emitter layer to hide or reveal its cells).
- The original source layer (the cell source) is disabled.

Note: Changes made to the original source layer, such as opacity or shearing, are also applied to the particles even after the emitter is created.

- In the Canvas, a bounding box with transform handles appears around the selected particle system.

Note: For projects with a frame rate greater than 30 frames
For projects with a frame rate greater than 30 frames per second (fps), you may see only the bounding box (not the first particle) at the first frame of your project. Because Motion generates particles at a default rate of 30 per second, there’s no guarantee that a particle will appear on every frame.

- The first particle appears in the Canvas in the same location as the original (now-disabled) source layer.
- The Emitter HUD appears. If you’ve hidden the HUD, press F7 to show it.
- The Emitter Inspector becomes available.

By default, the first frame of a new particle system (with a single cell) has one particle. If you play your project (press the Space bar), additional particles are generated and emerge from the center of the emitter.

By default, new cells emit one particle per frame in all directions (for 30-fps projects), and each particle moves 100 pixels per second away from the emitter over a lifetime of 5 seconds (150 frames in a 30-fps project).
Note: Use the Initial Number control in the Particle Cell Inspector to change the default behavior so a particle system begins with a burst of particles at the first frame. For more information, see Emitter controls.

Adjust a particle system

Emitter adjustment overview

You can adjust particle systems (emitters and cells) in your project in a number of ways:

- Modify the general appearance of the emitter by changing the source image, adjusting cell opacity, changing an emitter’s position in the Canvas, or deleting cells or the entire emitter.
- Adjust basic parameter controls in the HUD.
- Adjust all parameter controls in the Inspector.

Modify basic particle system attributes

You can make basic adjustments to a particle system by
replacing its source image, adjusting cell opacity, removing unwanted cells, changing the emitter’s size or position in the Canvas, or removing the entire emitter.

---

### Replace a preset emitter’s cell source image

After you add a preset emitter to your project, you can customize it by replacing its source image.

1. In the File Browser or Library, select the file you want to use as the replacement graphic for the preset, then add it to the project.

2. In the Layers list, drag the layer to the emitter cell source you want to replace.

   **Note:** If the cell layer is not visible, click the disclosure triangle next to the emitter.

3. When the pointer becomes a curved arrow, release the mouse button.

   The original cell source image is replaced with the new layer.

4. Optional: Hide the new cell source layer by deselecting its activation checkbox in the Layers list.

   The cells based on this layer remain in your particle system, but the static cell source layer is hidden in the Canvas.

---

### Adjust an emitter’s cell opacity
Adjust an emitter’s cell opacity

Adjust the opacity of individual cells in a particle system by modifying the cell parameters in the Particle Cell Inspector or by modifying the cell source layer’s opacity in the Properties Inspector.

Do one of the following:

- Select a cell in the Layers list, then adjust the Opacity tag in the gradient editor in the Particle Cell Inspector (or change Color Mode to Colorize and adjust the Opacity parameter in the Color controls). For information about adjusting opacity and color, see Change a gradient’s color and opacity.

- Select the original, deselected cell source layer—not the cell in the emitter—and change its opacity in the HUD or Properties Inspector.

Adjust an emitter’s size or position using onscreen controls

You can modify the size and position of particle emitters in the Canvas using onscreen transform controls.

1. In the Layers list, select the particle emitter to adjust.

2. In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Adjust Item tool.
When the Adjust Item tool is selected, the emitter onscreen controls appear in the Canvas. The onscreen controls vary depending upon the shape of the emitter (chosen from the Shape pop-up menu in the Emitter Inspector).

3. Resize the emitter in the Canvas by dragging the emitter shape’s outline, or one of its corner points, or (for a Line emitter shape) one of the plus signs (+) on either end of the line.

4. Reposition the emitter in the Canvas by dragging inside the emitter shape (but not directly on the outline).

Remove a cell from an emitter

You can remove a cell from an emitter that contains multiple cells.

- In the Layers list or Timeline, select the cell to remove, then press Delete.
The original source layers remain in the project (in the Layers list).

Remove an emitter from a project

You can remove a particle system from the Layers list or Timeline.

- Select the particle emitter, then press Delete.

  The emitter and its cells are removed from the project, but the original source layers remain in the project.

Modify particle system parameters in the HUD

Adjust a particle system in the Emitter HUD

When you create an emitter, the particle system begins working according to the default parameters in its Emitter Inspector and Particle Cell Inspector. You can modify the most important of these parameters in the Emitter HUD.

Display an Emitter HUD

- Select the emitter in the Layers list, Timeline, or Canvas.

  The Emitter HUD appears. (If it does not appear, press F7.)
Adjust parameters for a 2D emitter in the HUD

Do any of the following:

- Drag a slider:
  - *Birth Rate*: Sets how many particles are created every second.
  - *Life*: Sets how long each particle remains onscreen (in seconds) before disappearing from existence.
  - *Scale*: Sets the size of each particle, relative to the original size of the cell.
  - *Emission Range*: Sets the angle at which particles are emitted.

- Drag in the graphical emission control to modify several parameters simultaneously: Emission Range, Emission Angle, and Emission Speed. For more information, see Emitter HUD controls.
Adjust parameters for a 3D emitter in the HUD

When the 3D checkbox in the Emitter Inspector is selected, the Emitter HUD offers additional 3D controls for manipulating the emitter in 3D space.

Do any of the following:

- Drag any of the following sliders:
  - *Birth Rate*: Sets how many particles are created every second.
  - *Life*: Sets how long each particle remains onscreen (in seconds) before disappearing from existence.
  - *Scale*: Sets the size of each particle, relative to the original size of the cell.
  - *Emission Range*: Sets the angle at which particles are emitted.

- Drag in the graphical emission control to modify the Emission Latitude and Emission Longitude parameters. For more information, see [Emitter HUD controls](#).
Transform an emitter in 3D space via the HUD

When you select a particle emitter in the Layers list and then select the 3D Transform tool (in the toolbar), the Emitter HUD expands to display additional controls that allow you to transform the emitter in X, Y, and Z space:

1. With an emitter selected in the Layers list, click the 3D transform tool in the toolbar.

2. In the Emitter HUD, drag in any of the control squares to move, rotate, or scale the emitter in 3D space.

These controls are available in both 2D emitters and 3D emitters.
For more information on using the 3D transform controls in the HUD, see Transform layers in 3D space.

For particle systems containing multiple cells, the Emitter HUD parameters simultaneously modify the effect of each cell’s parameters relative to one another. This means that for a particle system consisting of two cells with different scale values, changing the scale in the HUD resizes both cells simultaneously. For example, increasing the scale in the HUD by 200% does not change the scale of both cells to 200%, but resizes the cells relative to their original scale values.
For this reason, in emitters with multiple cells, the HUD parameters are displayed as percentages. When you modify the parameters of a single cell, the cell parameters are adjusted directly.

**SEE ALSO**
Emerber HUD controls

**Emitter HUD controls**

Adjust an emitter using the controls in the Emitter HUD:

- **Birth Rate**: A slider that defines how many particles are created every second.
- **Life**: A slider that defines how long each particle remains onscreen (in seconds) before disappearing from existence.
- **Scale**: A slider that defines the size of each particle, relative to the original size of the cell.
- **Emission Range**: A slider that defines the angle at which particles are emitted.
- **Emission control (not labeled)**: A circular graphical control that
Emission control (not labeled). A circular graphical control that lets you modify several parameters simultaneously, described below:

- **Emission Range (2D only):** Drag the two points on the outer ring of the graphical emission control to define the range of degrees at which particles are generated. In other words, the Emission Range parameter defines the size of the “slice” of the pie graph that the particles fill when generated. This graphical control adjusts the same parameter as the Emission Range slider.

- **Emission Angle (2D only):** Drag the blue arrows clockwise or counterclockwise to change the direction in which particles are emitted (within the angle defined by the Emission Range control).

- **Emission Speed (2D only):** Drag the blue arrows outward or inward to define how quickly particles move away from the emitter.

Use the following modifier keys to more precisely manipulate the graphical emission control in the HUD:

- **Shift (while adjusting Emission Angle):** Restricts angles to 45-degree increments.

- **Shift (while adjusting Emission Range):** When working with a 2D emitter, restricts to 22.5-degree increments.

- **Command:** When working with a 2D emitter, adjusts Emission Angle only.

- **Option:** When working with a 2D emitter, adjusts Emission Speed only.

- **Emission Latitude/Emission Longitude control (not labeled, 3D**
When using a 3D particle emitter (when the 3D checkbox is selected in the Emitter Inspector), the spherical emission control of the HUD lets you modify the Emission Latitude and Emission Longitude parameters.

Drag the sphere in the center of the circle to modify the emission direction (in degrees latitude and longitude) of the particles. You can also enter specific values in the Emitter Inspector.

Drag the Emission Range slider (above the sphere) to define the range of degrees at which particles are generated. In other words, this control defines the size of the cone that the particles fill when generated in 3D space.
SEE ALSO

Adjust a particle system in the Emitter HUD

Modify particle system parameters in the Inspector

Adjust a particle system in the Inspector

Particle emitter parameters and particle cell parameters, though closely related, serve different purposes:

- Particle emitter parameters control the overall shape and direction of the animated mass of particles. Other emitter parameters simultaneously modify the parameters of all cells inside that emitter. You can adjust emitter parameters in the Emitter Inspector.

- Particle cell parameters control the behavior of particles after they’re generated by the emitter. You can adjust cell parameters in the Particle Cell Inspector.

Adjust a particle emitter in the Emitter Inspector

1. Select an emitter object in the Layers list or Timeline.

2. In the Inspector, click Emitter.

3. Adjust the Emitter Controls.
The controls of the Emitter Inspector are *dynamic*—different parameters appear depending on the number of cells in the particle system, the emitter shape that’s used, and whether the 3D checkbox is selected or deselected.

For a complete list of these controls, see **Emitter controls**.

---

**Adjust a particle cell in the Particle Cell Inspector**

1. Select any cell in an emitter in the Layers list or Timeline.

2. In the Inspector, click Particle Cell (if the pane is not already displayed).

3. Adjust the Cell Controls.

   For a complete list of these controls, see **Particle cell controls**

---

**SEE ALSO**

*Single-cell versus multi-cell emitter controls*

*Emitter controls*

*Particle cell controls*

---

**Single-cell versus multi-cell emitter controls**

If a particle system has only one cell, the Emitter Inspector displays both the emitter controls and the cell controls. In this...
In this case, you can control every aspect of the particle system from this single Inspector, which saves you from going back and forth between the Emitter and Particle Cell Inspectors.

If a particle system has two or more cells, the Emitter Inspector looks much different. The list of controls is much shorter, and the majority of the cell controls are replaced with a smaller group of master controls (hidden by default).
Changes made using the master controls modify the effect of each cell’s parameters relative to the other cells in the system. For example, in a particle system with three cells that have different Scale values, increasing the Scale parameter in the Emitter Inspector multiplies the Scale value of all three cells by the same percentage. This has the result of increasing or reducing the size of every particle in the system, while keeping the size of each particle relative to one another the same. For this reason, the master control values of multi-cell particle systems appear as percentages.

**Emitter controls**

The parameters in the Emitter Controls section of the Emitter Inspector determine how particles are distributed and rendered in
Several of these parameter controls are identical to those found in
the Emitter HUD, with one difference: Although the emission
control in the Emitter HUD lets you manipulate the Range, Angle,
Latitude (3D), Longitude (3D), and Speed parameters using a
single graphical control, the Emitter Inspector uses individual
numeric controls for each parameter.

Note: The settings for emitters in the Properties Inspector and
Emitter Inspector can be keyframed to change values over time.
However, there’s no way to control the animation of individual
particles.

Some parameters in the Emitter Inspector depend on the settings
of other parameters. All combinations of parameters are
described below:

- **Shape**: A pop-up menu to set the overall shape of the emitter.
Different shapes significantly alter the distribution of generated
particles. When you choose an emitter shape, different Emitter
Inspector parameters appear that are unique to that shape.
For example, when Rectangle is the selected shape, Outline,
Tile Fill, and Random Fill become available in the Arrangement

---

Note: The settings for emitters in the Properties Inspector and
Emitter Inspector can be keyframed to change values over time.
However, there’s no way to control the animation of individual
particles.

Some parameters in the Emitter Inspector depend on the settings
of other parameters. All combinations of parameters are
described below:

- **Shape**: A pop-up menu to set the overall shape of the emitter.
Different shapes significantly alter the distribution of generated
particles. When you choose an emitter shape, different Emitter
Inspector parameters appear that are unique to that shape.
For example, when Rectangle is the selected shape, Outline,
Tile Fill, and Random Fill become available in the Arrangement

The Shape pop-up menu contains the following items:

- **Point**: The default shape for new emitters, specifies a single point of emission for a particle system.

- **Line**: Particles emerge from a line. Using the onscreen controls (with the Adjust Item tool selected in the toolbar) or controls in the Properties Inspector, you can specify the length and location of the line. In the Inspector, you can set a specific number of points where particles emerge. This emitter shape is useful for creating sheets of particles that cascade over a wide area.

- **Rectangle**: Particles emerge from a rectangle along its edge, or in a tile-fill or random-fill pattern. Using the onscreen controls (with the Adjust Item tool selected in the
toolbar), you can specify the size and location of the rectangle: Drag the corners to adjust width and height; drag edges to adjust width or height independently. You can choose different rectangle patterns via the Arrangement parameter (described below). In the following image, the Arrangement parameter is set to Outline.

![Rectangle with particles](image)

Use modifier keys to more precisely manipulate the corners of the Rectangle onscreen controls (with the Adjust Item tool selected in the toolbar):

- **Option**: Adjustments to size are scaled uniformly, with the anchor point remaining fixed.

- **Shift**: Adjustments to size are made proportionally.

- **Circle**: Particles emerge from a circle-shaped emitter. Depending on the setting you choose in the Arrangement parameter (described below) particles emerge in an outline, tile-fill, or random-fill pattern. This emitter shape is useful for surrounding an element in a composition with particles that emerge from its edge. Using the onscreen controls (with the Adjust Item tool selected in the toolbar), you can specify the size and location of the circle. In the following image, the shape’s Arrangement parameter is set to Outline.
• **Burst:** Particles emerge from a burst pattern. Using the onscreen controls (with the Adjust Item tool selected in the toolbar), you can specify the size and location of the burst.

• **Spiral:** Particles emerge from a spiral pattern. Using the onscreen controls (with the Adjust Item tool selected in the toolbar), you can specify the size and location of the spiral.
- **Wave:** Particles emerge from a waveform. Using the onscreen controls (with the Adjust Item tool selected in the toolbar) or the Start Point and End Point controls in the Emitter Inspector, you can specify the length and location of the wave.

![Wave Image](image1.png)

- **Geometry:** Particles emerge from the edge of a shape, defined by a spline object used as the shape source. The following image on the right shows the shape used as the emitter source. The image on the left shows particles emerging from the edge of the shape source.

![Geometry Image](image2.png)

To apply a shape as the geometry shape source for a particle emitter, drag the shape to the Shape Source well in the Emitter Inspector (when the Shape pop-up menu is set to Geometry).
- **Image**: Particles emerge from within an area defined by an image or from only the edges of the image. The image may or may not have an alpha channel. If it does, the shape of the alpha channel can also be used to define the emitter shape. The following image on the right shows the image used as the emitter image source. The image on the left shows the particles emerging from within the image.

![Image example](image1.png)  ![Image source example](image2.png)

To apply an image as the image source for a particle emitter, drag the image to the Image Source well in the Emitter Inspector (when the Shape pop-up menu is set to Image).

- **Box**: This option is available when the 3D checkbox (described below) is selected in the Emitter Inspector. Particles are emitted from a three-dimensional cube along its surface (Outline), or in a tile-fill or random-fill pattern (set in the Arrangement pop-up menu, described below). Using the onscreen controls (with the Adjust Item tool selected in the toolbar), you can specify the size and location of the rectangle. Drag the front horizontal edge to adjust height;
drag the front vertical edge to adjust width; drag a back edge to adjust depth; drag a front corner to simultaneously adjust the width and height. To reposition the emitter, drag in the shape (but not on an edge or corner point). The following image shows a Box shape with Arrangement set to Tile Fill.

![Box shape with Arrangement set to Tile Fill.](image)

- **Sphere**: This option is available when the 3D checkbox (described below) is selected in the Emitter Inspector. Particles are emitted from a three-dimensional sphere along its surface (Outline), or in a tile-fill or random-fill pattern (set in the Arrangement pop-up menu, described below). Using the onscreen controls (with the Adjust Item tool selected in the toolbar), you can specify the radius and location of the sphere. Drag the outline of the sphere to adjust its radius; drag in the sphere to reposition it in the Canvas.

- **Arrangement**: A pop-up menu (available when the Shape pop-up menu is set to Rectangle, Circle, Image, Box, or Sphere) to specify the pattern used to generate particles. There are three menu options:
- **Outline**: Emits particles along the edge of the shape in 2D emitters and along the surface of the shape in 3D emitters.

- **Tile Fill**: Emits particles from a tiled pattern of rows, columns, and ranks (for 3D emitters) in the circle, rectangle, image, box, or sphere. You can specify the number of columns, rows, and ranks, as well as the Tile Offset.

- **Random Fill**: Emits particles randomly from within the circle, rectangle, image, box, or sphere.

- **Size/Radius**: A slider (available when the Shape pop-up menu is set to Rectangle or Box) to set the size of the rectangle or cube from which particles are emitted. When Rectangle is the selected shape, the Width and Height controls become available. When Box is the selected shape, an additional Depth control becomes available. When Circle is the selected shape, this parameter becomes Radius.

**Note**: Height is measured in project pixels, and Width is measured in square pixels, to ensure that a numerically square shape will look square when Correct for Aspect Ratio is enabled in the View pop-up menu in the top-right corner of the Canvas. For more information about square pixels, see [Pixel aspect ratio overview](#).

- **Columns**: A slider available when Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Tile Fill. Sets the number of horizontal emitter points on a grid over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid points that fall outside of the shape are ignored.

- **Rows**: A slider available when Shape is set to Rectangle,
Circle, Image, Box, or Sphere, and Arrangement is set to Tile Fill. Sets the number of vertical emitter points on a grid over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid points that fall outside of the shape are ignored.

- **Ranks:** A slider (available when Shape is set to Box or Sphere, and Arrangement is set to Tile Fill) to set the number of points in Z space on a grid over the selected shape from which particles are emitted.

- **Tile Offset:** A slider available when Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Tile Fill. Values from 0 to 100% offset the rows toward the right, and values from 0 to –100% offset the rows toward the left. A value of 50 or –50% creates a “brickwork” pattern.

- **Image Source:** An image well (available when Shape is set to Image) to specify the object used to define the shape of the emitter.

- **Shape Source:** An image well (available when Shape is set to Geometry) to specify a spline object used to define the shape of the emitter.

- **Emission Alpha Cutoff:** A slider available when Shape is set to Image. When the Image Source object contains an alpha channel, this slider defines the minimum opacity value necessary to create particles at that point on the source image. For example, when Emission Alpha Cutoff is set to 25%, particles appear only where the alpha value of the image is equal to or greater than 25% opacity. The lower the Emission Alpha Cutoff value, the more particles appear. For this parameter to be effective, the alpha channel must have areas of varying transparency.
- **Start Point:** Value sliders (available when the Shape pop-up menu is set to Line or Wave) to define, in X and Y coordinates, the first point of the line used as the emitter shape. Click the disclosure triangle to modify the Z position of the start point. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool selected in the toolbar).

- **End Point:** Value sliders (available when Shape is set to Line or Wave) to define, in X and Y coordinates, the second point of the line used as the emitter shape. Click the disclosure triangle to modify the Z position of the start point. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool in the toolbar selected).

- **Emit At Points:** A checkbox available when Shape is set to Line, Rectangle (with Arrangement set to Outline or Random), or Circle (with Arrangement set to Outline or Random), Burst, Spiral, Wave, Geometry, Box (with Arrangement set to Outline), or Sphere (with Arrangement set to Outline). When the Emit At Points checkbox is selected, particles emerge from a limited number of points (as defined in the Points parameter, described below). When the checkbox is deselected, particles may emerge from anywhere on the line or edge. When the Adjust Item tool is selected in the toolbar, the points become visible in the Canvas.

- **Points/Points Per Arm:** A slider available when the Emit At Points checkbox is selected and Shape is set to any of the following: Line, Rectangle, Image, or Circle (with Arrangement set to Outline or Random Fill); or Burst, Spiral, Wave, or Geometry. Defines the number of points where particles are emitted. For Rectangle or Circle shapes, the particles are emitted from evenly distributed points along the edge of the shape when Arrangement is set to Outline. When the Adjust
Item tool is selected in the toolbar, the points are visible in the Canvas.

Using a large number of points slows your computer’s processing performance.

- **Radius**: A slider (available when Shape is set to Circle, Burst, Spiral, or Sphere) to define the size of the shape from which particles are emitted.
- **Twists**: A slider (available when Shape is set to Spiral) to set the number of turns in the spiral. The default value is 0.25.
- **Number of Arms**: A slider (available when Shape is set to Burst or Spiral) to set the number of branches from which particles are emitted. The default value is 3.

![Spiral emitter shape set to default Number of Arms and Twists](image1)

![Spiral emitter shape with Number of Arms set to 3 and Twists set to .70](image2)

- **Amplitude**: A slider (available when Shape is set to Wave) to define half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.
- **Frequency**: A slider (available when Shape is set to Wave) to set the number of waves. Higher values result in more waves.
- **Phase**: A dial (available when Shape is set to Wave) to set the degree of the offset of the waves from the start and end
points of the path. When set to 0 degrees (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When set to 90 degrees, the wave begins and ends at the highest point in the wave. When set to 90 degrees, the wave begins at the lowest point in the wave. When set to 180 degrees, the waves are the same as they are at 0 degrees, but inverted.

- **Damping:** A slider (available when Shape is set to Wave) to set the direction of progressive diminishment of the oscillation of the wave. Positive damping values diminish the wave forward (from left to right); negative values diminish the wave backward (from right to left).

- **Offset:** A slider available when Shape is set to Line, Rectangle (with Arrangement set to Outline), Circle (with Arrangement set to Outline), Burst, Spiral, Wave, Geometry, or Image. Offsets the emitter itself or the particles generated on the shape. For example, when the emitter Shape is a Line, changing the Offset value moves the emitter’s position in the Canvas. When the emitter Shape is a Rectangle and Arrangement is set to Outline, changing the Offset value moves the particles along the edge of the shape.

- **3D:** A checkbox that, when selected, enables the Box and Sphere options in the Shape pop-up menu. Further, because all emitter shapes can be manipulated in 3D space, additional 3D parameters are available for all emitter shapes when the 3D checkbox is selected: Render Particles, Emission Latitude, and Emission Longitude. These additional parameters appear in the Emitter Inspector and HUD.

These parameters are available for all shapes, regardless of the Arrangement setting.
Note: When the 3D checkbox is selected, particles cannot receive reflections, and the Reflections parameter (in the Properties Inspector) is no longer available for the emitter. Additionally, when the 3D checkbox is selected, In Global 3D (Better) must be selected from the Render Particles pop-up menu for particles to cast shadows and to be affected by lights.

For more information on the additional 3D controls in the HUD, see Adjust a particle system in the Emitter HUD.

- **Emission Angle**: A dial (available when the Shape pop-up menu is set to a 2D shape) to set the direction in which particles travel. This control works in conjunction with the Emission Range control (described below). It’s equivalent to one of the functions of the graphical emission control in the Emitter HUD.

Note: When using an emitter shape other than a Point, such as a Line, Circle, Rectangle, Spiral, Burst, or Wave, and with Arrangement set to Outline, setting the Emission Angle parameter to 180 degrees and the Emission Range parameter to 0 degrees restricts the emission of particles to the inside of the shape. Setting the Emission Angle parameter to 0 degrees and the Emission Range parameter to 0 degrees restricts the emission of the particles to outside of the shape.

- **Emission Range**: A dial to restrict the area around the center of each emission point where particles are generated, in the direction of the Emission Angle. It’s equivalent to one of the functions of the graphical emission control in the Emitter HUD.

Note: When using a Line, Circle, Rectangle, Spiral, Burst, or Wave (but not Geometry) shape, setting Emission Range to 0 degrees keeps particles perpendicular to the emitter when
they emerge.

- **Render Particles:** A pop-up menu (available when the 3D checkbox is selected) to select between two rendering methods for the particles:
  - **In Local 3D (Faster):** The default setting, renders particles faster but does not allow for intersections with layers in the emitter group or with layers in other groups. Nor does it allow particles to cast shadows.
  - **In Global 3D (Better):** Allows the particles to intersect with layers in the emitter group and with layers in other groups. When turned on, your project’s playback performance is slowed.

  **Important:** For the 3D particles to cast shadows, and be affected by lights and depth-of-field settings, you must select the 3D checkbox and choose In Global 3D (Better) from the Render Particles pop-up menu.

- **Emission Latitude:** A dial (available when the 3D checkbox is selected) to set the emission direction (in degrees latitude) of the particles.

- **Emission Longitude:** A dial (available when the 3D checkbox is selected) to set the axis of rotation (in degrees longitude) from which the particles are emitted.

- **Depth Ordered:** A checkbox (available when the 3D checkbox is selected) that, when deselected, causes particle distribution to be completely random, regardless of size. Consequently, particle arrangements may appear to violate the rules of perspective.
When selected, this checkbox draws the particles in the particle system according to each particle’s actual 3D position in the project. In other words, particles closer to the camera appear closer; particles farther from the camera appear more distant.

- **Render Order**: A pop-up menu to set whether new particles are drawn on top of or underneath particles that have already been generated. There are two options:
  - **Oldest First**: New particles appear on top of older
- **Oldest Last**: New particles appear underneath older particles.

- **Interleave Particles**: A checkbox that, when selected, mixes particles generated from multiple cells together. Deselecting this checkbox layers particles in the same order as the cells that generate them.

**Note**: This option has no effect with particle systems containing only one cell. Leaving this option off speeds rendering with multiple cells.

- **Face Camera**: A checkbox (available when 3D is enabled) that forces the particle system to face the active scene camera. For more information on cameras, see [Add a camera](#).

**SEE ALSO**

- Adjust a particle system in the Inspector
- Single-cell versus multi-cell emitter controls
- Particle cell controls

### Particle cell controls

Think of the particle cell as the “mold” for the particles generated in the Canvas by the emitter. The parameters in the Cell Controls group determine how particles behave after they are released from the emitter. Cell controls appear at the bottom of the Emitter Inspector when a particle system is selected, and in the Particle Cell Inspector when a particle cell is selected.
Adjust an emitter’s cells using the Cell Controls:

- **Birth Rate**: A slider that defines the birth rate of the cell—that is, how many particles of this cell emerge from the emitter every second. Higher values create denser particle effects.
• **Birth Rate Randomness:** A slider that defines an amount of variance in the Birth Rate of generated particles. A value of 0 results in no variance (particles emerge from the emitter at the same rate). A value greater than 0 introduces a variance defined by the Birth Rate slider, plus or minus a random value falling within the Birth Rate Randomness setting.

• **Initial Number:** A slider that defines the initial number of particles. This control determines how many particles of this cell appear at the first frame of a particle effect. The result is an initial burst of particles that eventually evens out according to the Birth Rate setting.

• **Life:** A slider that defines the duration of every particle, in seconds—that is, how long each particle lasts before vanishing from existence. This effect is similar to how sparks
disappear after flying away from a sparkler. Unless the Color Over Life setting or Opacity Over Life setting (both described below) is used to fade each particle out over its life, particles immediately vanish at the end of their lifetimes.

- **Life Randomness**: A slider that defines an amount of variance in the life of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same lifetime. A value greater than 0 introduces a variance defined by the Life slider, plus or minus a random value falling within the Life Randomness setting.

- **Speed**: A slider that defines initial speed—that is, how quickly each particle flies away from the emitter. This, in conjunction with the Life and Birth Rate settings, determines how many particles appear in the Canvas at a given frame. This parameter is equivalent to one of the functions of the graphical emission control in the HUD.

- **Speed Randomness**: A slider that defines an amount of variance in the speed of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same speed. A value greater than 0 introduces a variance defined by the Speed slider, plus or minus a predetermined random value falling within the Speed
Randomness setting.

- **Align Angle**: When this checkbox is selected, particles rotate to match the shape on which they are positioned. This parameter is available in all cases but the following: when the Shape setting (in the Emitter Inspector) is Rectangle, Circle, Image, Box, and Sphere and the Arrangement setting is Tile Fill or Random Fill; or when the Shape setting is Point.

- **Angle**: A dial that sets the angle of rotation, in degrees, at which new particles are created.

- **Angle Randomness**: A dial that sets an amount of variance in the angle of generated particles.

- **Spin**: A dial that animates particles in a system by initially spinning each particle around its center. Adjustments to this control are in degrees per second.

- **Spin Randomness**: A dial that sets an amount of variance in the spin of generated particles. A value of 0 results in no variance—all particles from the selected cell spin at the same rate. A value greater than 0 introduces a variance defined by the Spin parameter, plus or minus a random value falling within the Spin Randomness setting.

- **Additive Blend**: By default, particles are composited together using the Normal blend mode. Select this checkbox to composite all overlapping generated particles together using the Additive blending mode. The result is that the brightness of overlapping objects is intensified. This blending occurs in addition to the compositing method set in the Blend Mode parameter of the Properties Inspector.
• **Color Mode**: A pop-up menu that sets how particles are tinted. There are five options:

  • **Original**: Particles are generated using the original colors from the source layer. When this setting is selected, the Opacity Over Life gradient editor becomes available (described below).

  ![Additive Blend off](image1) ![Additive Blend on](image2)

• **Colorize**: Particles are tinted using the color specified in the Color parameter. When this setting is selected, additional Color and Opacity Over Life controls appear (described below).
• **Over Life:** Particles are tinted based on their age, with the range of possible colors defined by the Color Over Life gradient editor (described below).

• **Pick From Color Range:** Particles are tinted at random, with the range of possible colors defined by the Color Range gradient editor (described below). A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used.

• **Take Image Color:** Each new particle’s color is based on the color of the image at the position where the particle
was generated. This menu item is available only when the Shape pop-up menu in the Emitter Inspector is set to Image.

- **Opacity Over Life:** A gradient editor (available when the Color Mode is set to Original or Colorize) that animates changes to the opacity of particles over their lifetime. For more information on using gradient controls, see *Change a gradient’s color and opacity*.

- **Color:** Color controls (available when the Color Mode pop-up menu is set to Colorize) to set the color of particles. You can also modify the alpha channel of each particle, altering its opacity. This parameter is unique to the cell object. You can click the color well to choose a color, use the eye dropper, or open the disclosure triangle and adjust the Red, Green, Blue, and Opacity channel sliders. For more information on using color controls, see *Basic color controls*.

- **Color Over Life:** A gradient editor (available when the Color Mode is set to Over Life) that sets the range of color that each particle assumes as it ages, beginning with the leftmost color in the gradient, and progressing through the range of colors until finally reaching the rightmost color at the end of its life. For more information on using gradient controls, see *Change a gradient’s color and opacity*.

- **Color Repetitions:** A slider (available when Color Mode is set to Over Life) that sets the number of times the gradient color pattern is repeated over the life of the particle.

- **Color Range:** A gradient editor (available when Color Mode is set to Pick From Color Range) that sets a range of colors used to randomly tint new particles. The direction of the gradient colors is not relevant. Color Range has the same controls as...
the Color Over Life gradient editor.

- **Scale**: A slider that defines the scale of every particle of a cell. Click the disclosure triangle next to the Scale parameter to reveal separate X, Y, and Z scaling subparameters. Use X and Y to resize the width and height of generated particles; use Z to change the depth of 3D text particles. This control affects the initial scale of the particle (compared to the Scale Over Life behavior in the Particles behavior category).

![Scale set to 200%](image1)
![Scale set to 50%](image2)

**Note**: When you use an image as a particle cell source and set a low Scale value, set the render quality in the Render pop-up menu (above the Canvas) or the View menu to Best (choose View > Quality > Best).

- **Scale Randomness**: A slider that defines an amount of variance in the scale of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same size. A value greater than 0 introduces a variance defined by the Scale parameter, plus or minus a random value falling within the Scale Randomness setting. Click the disclosure triangle next to the Scale parameter to reveal separate X, Y, and Z scaling subparameters. Use X and Y to vary the width and height of generated particles; use Z to
vary the depth of 3D text particles.

- **Attach To Emitter:** A slider that sets how closely particles follow the position of a moving emitter. If set to zero, particles follow their own path after being emitted, resulting in particles that trail along the motion path the emitter is following. If this parameter is set to 100, in the absence of other behaviors, all generated particles follow the emitter, surrounding it in a moving cloud of particles.

- **Play Frames:** A checkbox (available if the particle system was created from a QuickTime movie) that controls playback. If selected, playback of the animation or movie clip used to generate each particle loops. If deselected, particles are generated using the still frame specified by the Random Start Frame parameter or the Source Start Frame parameter (both described below).

- **Random Start Frame:** A checkbox (available if the particle system was created from a QuickTime movie) that introduces variation into animated particles generated from QuickTime objects. If selected, each newly generated particle begins at a different frame of the animation. Stills are chosen randomly if Random Start Frame is deselected.

- **Source Start Frame:** A slider available if the particle system was created from a QuickTime movie, allowing for the selection of the starting frame for particle generation.
Source Start Frame: A slider available if the particle system was created from a QuickTime movie and Random Start Frame is deselected. Use this control to set the start frame of the animation (if the Play Frames checkbox is selected) or the still frame to display (if the Play Frames checkbox is deselected).

- **Hold Frames**: A slider (available if the particle system was created from a QuickTime movie) that sets the number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

- **Hold Frames Randomness**: A slider (available if the particle system was created from a QuickTime movie) that varies the number of frames to “hold.”

- **Show Particles As**: A pop-up menu that sets whether particles are displayed in a preview mode or as they actually appear. By default, this parameter is set to Image, which displays each particle as it is supposed to appear. However, the nonimage preview modes play more efficiently when viewing a complex particle system and also provide other ways of analyzing particle motion. There are four menu items:

  - **Points**: Displays each particle as a single point. This is the fastest preview mode, useful for displaying the type and speed of particle motion in a system.
• *Lines*: Displays each particle as a line. This is a good preview mode to use to analyze the vector of each particle’s motion. The length of each line is determined by that particle’s speed, and the angle of each line equals each particle’s direction.

• *Wireframe*: Displays each particle as a bounding box. Because the bounding boxes are good indicators of each particle’s orientation in the system, this preview mode is useful for evaluating the movements of individual particles. For example, it’s easy to see the angle of rotation for particles spinning or following a complex motion path.
• **Image:** The default setting, displays the full particle system effect.

![Image](image_url)

**Note:** The option chosen in the Show Particles As pop-up menu appears in your final render. Used deliberately, this can result in some interesting effects.

• **Point Size:** A slider (available when Show Particles As is set to Points) that sets the largeness of the points.

• **Random Seed:** Although particle systems seem random, they’re deterministic. This means that the variation in each particle system is created based on the number shown in the Random Seed field. Unless this seed number is changed, a particle system with the same Random Seed value always plays back with the same motion. If you don’t like the current random motion or distribution of the particle system, you can
change the seed value by typing a new number or clicking Generate. This changes the random calculations performed for that system for all randomness parameters.

- **Particle Source**: In particle systems with more than one cell, an image well representing each cell appears at the bottom of the Emitter Inspector. Each Particle Source well has a checkbox you can use to enable or disable that cell.

**SEE ALSO**

Adjust a particle system in the Inspector  
Single-cell versus multi-cell emitter controls  
Emitter controls

### Adjust a particle emitter in the Properties Inspector

You can modify an emitter’s position, scale, blend mode, drop shadow, and other attributes in the Properties Inspector. These properties are separate from the emitter parameters in the Emitter and Particle Cell Inspectors.

1. Select an emitter object in the Layers list, Timeline, or Canvas.
2. In the Inspector, click Properties.
3. Adjust the controls.
For detailed information on all Properties Inspector parameters, see Properties Inspector controls.

**Note:** When you select a particle cell and open the Properties Inspector, only one parameter group is available: the Timing controls, which adjust the In and Out points of the particle cell. For more information, see About particle system timing.

### Animate emitters and cells

#### Animate emitters and cells overview

By adding behaviors to a particle system’s emitter, or to the cells themselves, you can create sophisticated, organic animation that would be impossible to accomplish any other way. You can animate an emitter using behaviors designed specifically for particles, or by using Basic Motion, Parameter, or Simulation behaviors. You can also animate emitter parameters and cell parameters with keyframes.

Consider the following guidelines when animating a particle system:

- Apply the Particles behaviors ([Scale Over Life](https://www.example.com) and [Spin Over Life](https://www.example.com)) to modify and animate the rotation and size of the particles over their lifetime. For details, see

- Apply behaviors to particle cells or to the emitter to create even more varied effects (simulation behaviors can be especially effective). Any behavior that you apply to a cell is in turn applied to each particle the cell generates.

- Apply a Simulation behavior to an emitter or another object in
Apply a Simulation behavior to an emitter or another object in your project (an object that is not part of the particle system) to make particles interact with other objects in the project. For example, applying the Repel behavior to an object will cause particles to weave around that object.

- Keyframe the Emitter Inspector parameters to modify the particle system’s overall characteristics over time, such as increasing or decreasing the size, speed, or lifetime of newly generated particles.

- Keyframe the emitter’s Position parameter (in the Properties Inspector) to alter the position and geometric distribution of a particle system over time, such as creating a path of bubbles that follows an object onscreen. For more information on keyframing, see Animate parameters in the Inspector.

- Use Motion Tracking behaviors to track an emitter to a moving object in a clip, or to apply existing tracking data in your project to an emitter. For more information about Motion Tracking behaviors, see Motion tracking overview.

SEE ALSO

Apply behaviors to particle systems
View animated emitter curves in the Keyframe Editor
Apply behaviors to particle systems

Applying behaviors to particle systems is a quick and easy way to move emitters in your project and to create nearly limitless animations.

With all Basic Motion behaviors, after individual particles emerge, they’re unaffected by changes to the position of the emitter. This means that moving the emitter around the screen using behaviors results in the creation of a trail of particles that behave according to their particle cell parameters.

There are two ways to apply behaviors to a particle system:

- **To the emitter**: Behaviors applied to emitters affect the emitter itself, not its individual particles. For example, using the Throw behavior to send an emitter flying across the Canvas creates a trail of particles.

- **To the emitter cell**: Behaviors applied to cells are in turn applied to each particle generated from that cell. This can result in some extremely complex animations as dozens of particles move according to the behaviors you’ve defined. Behaviors applied to cells have no effect on the position of the emitter.

Apply a behavior to an emitter

Do one of the following:

- Drag a behavior from the Library onto an emitter in the Canvas, Layers list, or Timeline.
Select the emitter, click the Add Behavior pop-up menu in the toolbar, then choose a behavior.

Select an object in the Canvas, Layers list, or Timeline, then select a behavior from the Library stack and click Apply in the preview area.

In the Canvas, the emitter begins to move according to the parameters of the applied behavior.

**Note:** Not all behaviors instantly activate an object when applied. For example, you must adjust the Throw Velocity parameter of a Throw behavior to cause an object to move.

---

**Apply a behavior to a cell**

Behaviors applied to cells are in turn applied to each particle generated from that cell.

Do one of the following:

- Drag a behavior from the Library onto a cell in the Layers list.
Select a cell in the Layers list, click the Add Behavior pop-up menu in the toolbar, then choose a behavior.

Select a cell in the Layers list, then select a behavior from the Library stack and click Apply in the preview area.

The emitter begins to move according to the parameters of the applied behavior.

**Note:** Not all behaviors instantly activate an object when applied. For example, you must adjust the Throw Velocity parameter of a Throw behavior to cause an object to move.

**Tip:** If you do not see the expected result when applying behaviors to particle cells, try selecting or deselecting the Affect Subobjects checkbox (in the Behaviors Inspector) or selecting a different option from the Affect pop-up menu in the HUD or Behaviors Inspector. These parameters determine whether the entire object (such as the particle emitter) or its components (such as the particle cells) are affected by the behavior and how an object interacts with surrounding objects, respectively. (The Affect Subobjects checkbox appears in the Behaviors Inspector only when the Throw and...
Spin behaviors are applied to a group containing multiple objects, such as a group, particle emitter, or text.)

In the Canvas, the emitter begins to move according to the parameters of the applied behavior.

**Note:** Not all behaviors instantly activate an object when applied. For example, you must adjust the Throw Velocity parameter of a Throw behavior to cause an object to move.

**Tip:** If you do not see the expected result when applying behaviors to particle cells, try selecting or deselecting the Affect Subobjects checkbox (in the Behaviors Inspector) or selecting a different option from the Affect pop-up menu in the HUD or Behaviors Inspector. These parameters determine whether the entire object (such as the particle emitter) or its components (such as the particle cells) are affected by the behavior and how an object interacts with surrounding objects, respectively. (The Affect Subobjects checkbox appears in the Behaviors Inspector only when the Throw and Spin behaviors are applied to a group containing multiple objects, such as a group, particle emitter, or text.)

---

**Apply a Parameter behavior to an emitter or cell parameter**

You can apply Parameter behaviors to parameters in the Emitter or Particle Cell Inspector. A Parameter behavior is a special kind of behavior that animates a single parameter of an object.

Do one of the following:
Drag a behavior from the Parameter category of behaviors in the Library onto an emitter or cell in the Layers list or Timeline, then, in the Behaviors Inspector, click the To pop-up menu and choose a parameter from the submenus.

Select an emitter or cell in the Layers list or Timeline, click the Add Behavior pop-up menu in the toolbar, and choose a Parameter behavior; then, in the Behaviors Inspector, click the To pop-up menu and choose a Parameter from the submenus.

In the Emitter or Particle Cell Inspector, Control-click a parameter, then choose a Parameter behavior from the shortcut menu.

The Parameter behavior is applied to the parameter you chose. Play back your project to see the result.

For more information, see Parameter behaviors overview.

Apply a Particles behavior to an emitter or cell

The Particles category of behaviors in the Library contains two behaviors specifically for use with the cells or emitter in a particle system:

- **Scale Over Life**: This behavior lets you grow or shrink the particles in a system over the duration of each particle’s life.
- **Spin Over Life**: This behavior lets you spin the particles in a system over the duration of each particle’s life.
Do one of the following:

- Drag a behavior from the Particles category of behaviors in the Library onto an emitter or cell in the Layers list or Timeline.
- Select an emitter or cell in the Layers list or Timeline, click the Add Behavior pop-up menu in the toolbar, then choose a Particles behavior.

For a description of each Particles behavior parameter, see Scale Over Life and Spin Over Life.

Particles behavior controls

Scale Over Life

The Scale Over Life behavior has one main parameter control and three optional parameter controls that vary, depending on the selected Increment Type:

- *Increment Type*: A pop-up menu that sets which method is used to resize particles over their lifetime. There are four options:
  - *Natural Scale*: Specifies starting and ending scale percentages used to animate each particle’s size over its lifetime. Natural Scale uses an exponential curve to allow the animation to progress slowly when the scale values are small, and speed up when the values are large. This creates the illusion that the scaling is occurring at a constant speed.
  - *Rate*: Specifies a steady rate at which particles change scale over their lifetime.
- *Birth and Death Values*: Specifies starting and ending scale percentages used to animate each particle’s size over its lifetime. The scale amount generated by this option for a specific particle at a specific time is multiplied by the preexisting particle Scale (defined in the Cell Controls section of the Emitter Inspector).

- *Custom*: Lets you customize the scale of the particles over their lifetime via a mini-curve editor (described below).

  **Scale At Birth**: A slider (available when Increment Type is set to Natural Scale or Birth and Death Values) that defines the initial size of particles when they’re created. Click the disclosure triangle next to the Scale At Birth parameter to reveal separate X, Y, and Z subparameters. Use X and Y to change the width and height of generated particles; use Z to change the depth of 3D text particles.

  **Scale At Death**: A slider (available when Increment Type is set to Natural Scale or Birth and Death Values) that defines the size of each particle at the end of its lifetime. Click the disclosure triangle next to the Scale At Death parameter to reveal separate X, Y, and Z subparameters. Use X and Y to change the width and height of generated particles; use Z to change the depth of 3D text particles.

  **Scale Rate**: A slider (available when Increment Type is set to Rate) that defines how quickly each particle changes size. Positive values grow particles over time, while negative values shrink particles over time. Click the disclosure triangle next to the Scale Rate parameter to reveal separate X, Y, and Z subparameters. Use X and Y to change the width and height of generated particles; use Z to change the depth of 3D text particles.
- **Custom Scale controls:** A group of controls (a mini-curve editor and two sliders, described below) appears when Increment Type is set to Custom. Use the mini-curve editor for more precise control over the Scale of particles in your particle system.

  - **Mini-curve editor (unlabeled):** A graph with the curves and control points you can drag to adjust the scale of particles in your particle system. For more information on using mini-curve editors, see [Work in the mini-curve editor](#).

  - **Custom Scale:** A slider to adjust the value of the selected keyframe in the mini-curve editor.

  - **Over Life:** A slider to adjust the position of the selected keyframe in the life of the particle.

## Spin Over Life

The Spin Over Life behavior has one main parameter control and three optional parameter controls that vary, depending on the selected Increment Type:

- **Increment Type:** A pop-up menu that sets which method is used to spin particles over their lifetime. There are three options:

  - **Rate:** Specifies a steady rate and direction in which particles spin over their lifetime.

  - **Birth and Death Values:** Specifies starting and ending spin degrees used to animate each particle’s rotation over its lifetime. The spin amount generated by this option for a
specific particle at a specific time is added to the preexisting particle spin (defined in the Cell Controls section of the Emitter Inspector).

- **Custom:** Lets you customize the spin of the particles over their lifetime via a mini-curve editor (described below).

- **Spin Rate:** A slider (available when Increment Type is set to Rate) that determines how quickly each particle spins and the direction of the spin. Positive values spin particles faster over time and in a counterclockwise direction; negative values spin particles slower over time and in a clockwise direction.

- **Spin At Birth:** A slider (available when Increment Type is set to Birth and Death Values) that determines the initial spin of the particles when they’re created.

- **Spin At Death:** A slider (available when Increment Type is set to Birth and Death Values) that determines the spin of the particles at the end of their lifetime.

- **Custom Spin controls:** A group of controls (a mini-curve editor and several other controls, described below) available when Increment Type is set to Custom. Use the mini-curve editor for more precise control over the Spin of particles in your particle system.
  - Mini-curve editor (unlabeled): A graph with the curves and control points you can drag to adjust the spin of particles in your particle system. For more information on using mini-curve editors, see [Work in the mini-curve editor](#).
  - **Custom Spin:** A dial to adjust the value of the selected keyframe in the mini-curve editor.
  - **Over Life:** A slider to adjust the position of the selected
keyframe in the life of the particle.

View animated emitter curves in the Keyframe Editor

You can also animate emitter or cell parameters using keyframes. When you do so, a curve describing that animation is available in the Keyframe Editor. The selected object determines which curves appear in the Keyframe Editor (when Animated is selected from the pop-up menu in the top-left corner of the Keyframe Editor). For more information about animating with keyframes, see Keyframing overview.

Display keyframed emitter or cell curves

- **Display keyframed emitter curves**: With the Keyframe Editor open (press Command-8 if it’s not already open), select an emitter in the Layers list to display animated emitter parameters such as Position and Rotation (in the Properties Inspector) or Emission Angle and Range.

- **Display keyframed cell curves**: With the Keyframe Editor open (press Command-8 if it’s not already open), select a cell in the Layers list to display animated parameters such as Birth Rate or Angle.

**Note**: To manually send an animated parameter to the Keyframe Editor, click an animated parameter’s Animation menu (the downward arrow that appears when you place the
pointer over the right side of a parameter row in the Inspector), then choose Show In Keyframe Editor.

The parameter is displayed in the Keyframe Editor in a new, untitled curve set.

For more information about keyframe curves, see Display the Keyframe Editor.

Create 3D particles

Two emitter pattern styles in the Shape pop-up menu have 3D options: Box and Sphere. The Box and Sphere shape options are available only when the 3D checkbox is selected in the Emitter Inspector.
Although the Rectangle, Circle, Line, Wave, Image, and Geometry emitter shapes have no inherent 3D parameters, they can be moved and rotated in 3D space. Additionally, the Line and Wave emitter shapes have quasi-3D properties: Their start and end points can be moved into Z space (depth).
And when you nest an emitter in a 3D group, you can use Simulation behaviors to pull particles out of their X and Y planes, into Z space.

---

**Turn an existing 2D particle system into 3D particles**

1. After adding an emitter to a project, select the 3D checkbox in the Emitter Inspector.

   For information about adding an emitter, see Add preset particles or create custom particles.

2. If your project does not contain a camera, click the New Camera button in the toolbar.

   If your project is a 2D project, a dialog appears asking if you want to switch your 2D groups to 3D.

3. Click Switch to 3D.

   A camera is added to the project, and your layers are turned into 3D layers.

4. In the 3D view tools (in the upper-right corner of the Canvas), drag in the Orbit tool (the center tool).
As the camera rotates, you can see that the particles are emitted in X, Y, and Z space (all three dimensions).

Tip: Use Simulation behaviors to create animated particles in 3D space that interact with other objects in the project. For example, use Orbit Around to create particles that circle around a target object. For more information, see Simulation behaviors overview.

5. Optional: If you want the particles to face the camera as it rotates around the emitter, select the Face Camera checkbox in the Emitter Inspector.

Create a 3D box or sphere particle emitter

1. After adding an emitter to a project, select the 3D checkbox in the Emitter Inspector.

For information, see Emitter controls.
2. In the Emitter Inspector, click the Shape pop-up menu, then choose Box or Sphere.

Particles emanate from a box or sphere pattern, in 3D space.

**Make particles intersect with other layers**

Particles can intersect with other rotated layers in 3D space.

- In the Emitter Inspector, click the Render Particles pop-up menu, then choose In Global 3D (Better).

In the following image on the left, with Global 3D selected, particles intersect with other objects in the project that are transformed in 3D space. In the image on the right, with Local 3D selected, particles do not intersect with other objects.

About particle system timing

When you create a particle system, its duration can be as long or short as necessary, regardless of the duration of the original
source layers used to create the particle system. The duration of a particle system is defined by the duration of the emitter object. Changing the In or Out point of an emitter in the Properties Inspector, Timeline, or mini-Timeline changes the duration of the entire particle system.

By default, particles are generated by every cell in a system for the duration of the emitter. The duration of each generated particle is defined by the Life parameter of the cell that generated it, and not by the duration of the cell itself.

The duration of the cell governs the time span over which new particles are generated. You can change a cell’s duration by dragging its position or its In and Out points in the Timeline. In this way, you can adjust the timing that defines when each cell’s particles emerge.

For example, you can create a particle system that simulates an explosion by offsetting the appearance of three types of particles. First, dense white sparks emerge from the center. Half a second later, more diffuse orange blast particles appear around a larger area. One second after that, hot smoke emerges from underneath both of these layers as they fade away.
You can offset a cell in the Timeline or mini-Timeline so that the cell starts before the emitter. This creates a “pre-roll” in which the particle simulation begins before the particles are drawn.

For more information on adjusting the timing of layers in the Timeline, see Timeline overview.

Guidelines for using graphics in particle systems

Creating a particle system from scratch begins with designing the particles you want it to emit. You can use any image, shape, text, or movie supported by Motion as a source for a cell.

Still images

Particle systems that use still images as their cell sources render in real time much faster than systems that use video or animation clips. A still image is often all you need to create a compelling particle system.

Use the following guidelines when creating graphics for use as particles:
• **Graphics size:** If you’re not sure what size you want your particles to be, it’s a good idea to make your graphics larger rather than smaller. Increasing the size of particles beyond the size of the original graphic can introduce unwanted artifacts. One caveat, however, is that the larger the cell source size, the slower your playback performance.

• **Particle edges:** The quality of the edges of your graphics can be extremely important for creating convincing particles. Soft, translucent edges might look better than hard, over-defined ones.

• **Object color:** By default, particles are created using the original colors of the source image used as the cell. If necessary, you can tint the emitted particles using the Color Mode controls in the Emitter and Particle Cell Inspectors. Choose between tinting all particles with a single color or creating a gradient tint that changes color over time. You can also choose to apply a gradient preset to the particles (see *Use the gradient preset pop-up menu*). Tinting particles applies the tint color uniformly over the entire particle system.

• **Alpha channels:** Always create graphics that you want to use as cells with predefined alpha channels. For more information on importing files with alpha channels, see *About alpha channels*.

---

**QuickTime movies**

You can also use QuickTime movies as the image source of a particle cell. For example, you can create an animation in Motion, render it as a QuickTime movie, then import it into another Motion project to use as image source for a cell. In general, the same
recommendations for creating still graphics apply to the creation of animation or video clips you intend to use as cells, but there are additional considerations.

Use the following guidelines when creating animations for use as particles:

- **Playback performance**: Using a movie clip as the image source of a particle cell may impact your project’s playback performance.

- **Retimed clips**: If you retime a movie clip (in the Properties Inspector or with a Retiming behavior) used as the image source for a particle cell, the effect of the retiming is carried through to the particle system.

- **Looping clips**: Particles created from QuickTime clips loop over and over for the duration of each particle’s life. If the clip you use doesn’t loop well, there will be a jump cut at every loop point. Another option is to use very short movies to introduce randomness into the appearance of the particle system.

- **Minimal compression**: Ideally, QuickTime clips to be used as particles should be saved using a high-quality codec, such as Animation, Uncompressed 8- and 10-bit 4:2:2, or ProRes 4444. Other codecs can be used, but they might introduce unwanted artifacts depending on the level of compression used.

About using filters and masks with particles
You can apply filters or masks to an emitter. (However, you cannot apply filters or masks to the cells in an emitter.)

**Filters**

When you apply a filter to an emitter, the entire particle system is transformed, including every element in the onscreen pattern.

![Light Valve particle system default](image1.png) ![Light Valve with Bulge filter applied](image2.png)

**Note:** Although you cannot apply a filter to an individual cell, you can apply a filter to the image source of a cell (the disabled layer in Layers list used to create the particle cell).

For more information on applying filters to layers in your project, see [Filters overview](#).

**Masks**

You can apply masks to the image source of a particle cell. The effect of the mask on the cell source is carried through to the emitted particles.
You can also apply masks to the emitter object itself.

For more information on working with masks, see Masks and transparency overview.

Save custom particle effects to the Library

After you create a particle system, you can save it as a particle preset in the Particle Emitters, Favorites, or Favorites Menu folder in the Library, for future use. When you place particle systems in the Library, they become particle presets that can be used like any other particle preset.
Tip: For organizational purposes, create a folder of your own in the Favorites or Favorites Menu category to store custom particle systems.

Save a particle system to the Library

1. Open the Library and select the Particle Emitters, Favorites, or Favorites Menu category.

2. Drag the emitter you want to save from the Layers list into the stack at the bottom of the Library.

The customized emitter is saved in the `/Users/username/Library/Application Support/Motion/Library/` folder (in the Particle Emitters, Favorites, or Favorites Menu subfolder). Any custom layers created in Motion (such as a shape layer) that you used to create that particle system are included in the file.

SEE ALSO
Save custom objects to the Library
Move Motion projects, objects, or presets to another computer
Replicator overview

The Motion *replicator* builds complex patterns of repeating elements—from a simple line of animated shapes to flowing kaleidoscopic imagery—without manual duplication or tedious keyframing.

You can add a preset replicator to your project from the Library, or you can create your own custom replicator using nearly any image layer in your project, including video, still images, shapes, and text. For example, with very few clicks of your mouse you can create spinning loops based on a simple shape.

![Replicator source shape](image1.png) ![Replicator result](image2.png)

Replicators consist of two basic elements:

- *Replicator*: A special type of effect that generates multiple duplicates of an image layer, then arrays the copies in the Canvas, creating a complex pattern. You specify the shape
and arrangement of the pattern, such as a spiral, circle, or box.

- **Cell**: The image layer that’s duplicated and assembled as a pattern in the Canvas.

The replicator and its cells have separate sets of parameters that control the look of the mosaic pattern you see in the Canvas. Changing the *replicator parameters* modifies the overall onscreen pattern, allowing you to create rectangular, circular, spiral, and other geometric layouts. Changing the *cell parameters* affects each element in the onscreen pattern, allowing you to modify attributes such as the angle, color, and scale of the pattern pieces.

You can also modify elements in the pattern by making changes to the source layer used to create a cell. For example, if you use a rotated rectangle shape as the replicator source layer, the replicated elements in the Canvas appear rotated. If the source layer has applied filters, the effects of the filters are retained in the elements of the replicator pattern.

Unlike particle systems, replicator patterns are static by default. However, many of the preset replicators available in the Library are already animated, and you can always manually keyframe parameters of custom replicators, or apply behaviors. For example, by keyframing a replicator’s Offset parameter, you can create a wave of dots that slither across the screen.
You can add behaviors to the replicator or its cells to create even more varied effects (simulation behaviors can be especially effective). Behaviors applied to a replicator or a replicator cell can be applied to each element of the pattern. This lets you achieve almost limitless variation and complexity that would take hours to animate using keyframes. You can also apply a behavior such as Vortex to another object in your project (an object that is not part of the replicator pattern), and have the pattern elements circumnavigate that object.

A special behavior called Sequence Replicator choreographs the parameters of your onscreen elements (their position, scale, and opacity, for example) in a sequential animation. For more information, see Apply the Sequence Replicator behavior.

Replicators take advantage of the Motion app’s 3D capabilities. Some replicator shapes are inherently 3D, and others can have points that exist in 3D space. Additionally, behaviors applied to a replicator in 3D space can pull pattern elements out of a plane. For more information, see Work with 3D replicators.

**Note:** Although you can replicate any image layer in your project, you cannot replicate replicators themselves, or particle emitters, lights, cameras, or rigs.

**SEE ALSO**
How are replicators and particle systems different?
How are replicators and particle systems different?

Although the replicator and particle systems share many parameters, they’re very different tools. Both use layers (shapes, text, images, and so on) as cell sources and both generate onscreen elements from those sources. However, each produces a unique effect from those raw materials. A particle system generates dynamic (animated) elements that change over time: Particles are born, emerging from an onscreen “emitter”; they move across the Canvas; and they die, according to the “laws of nature” you specify in the parameters of the system.

A replicator, however, is not a dynamic simulation. Its elements are not emitted like particles, and thus have no birth rate, life, or speed parameters. The replicator builds a pattern of static copies of a source layer in an arrangement that you specify. Although the replicated elements you see onscreen are static by default, you can animate a replicator’s parameters. For example, you can designate a simple star shape as the source of your onscreen pattern and then replicate the star multiple times along the outline of a circle. By keyframing a few parameters of your new replicator object, you can launch the stars into animated orbit around the center of the circle, making them change color as they whirl.

SEE ALSO

Replicator overview
Add a replicator to a project

Add a preset replicator or create a custom replicator

There are two basic ways to add a replicator to a project:

- Choose a preset from the Replicators category of the Library.
- Create a custom replicator using your own image, shape, or video clip as a cell source. You can increase replicator complexity by using multiple cell sources.

Add a preset replicator from the Library

The easiest way to add a replicator system to your project is to use a preset in the Replicators category of the Library.

1. In the Library, select the Replicators category, then select a subcategory, such as Mattes, Transitional, Backgrounds, and so on.

2. In the Library stack under the categories and subcategories, select a replicator object.

A preview of the selected replicator appears in the Library preview area.
3. Do one of the following:

- Click Apply in the preview area to add the replicator to the center of the Canvas.

  **Note:** If Create Layers At is set to “Start of project” in the Project pane of Motion Preferences, the replicator is added at the first frame. See If it’s your first import.

- Drag the replicator from the Library stack into the Canvas at the position where you want it to appear.

- Drag the replicator from the Library stack to a group in the Layers list or Timeline layers list.

- Drag the replicator to the track area of the Timeline or mini-Timeline. When you reach the frame where you want the new replicator to start, release the mouse button.

  The replicator preset appears in the project, composited above objects below it in the Layers list.

If necessary, modify the replicator parameters in the HUD or in the Replicator Inspector. You can also replace the preset image source with one of your own images, clips, shapes, or text layers. For more information, see Adjust a replicator overview. You can modify a replicator only after it’s added to a project.

Create a simple custom replicator
You can create a custom replicator pattern by designating an image layer in your project as a source for the cell. Applying a replicator to that layer creates a nonanimated, filled rectangular pattern. You can then modify the replicator parameters to suit your project needs.

1. Create a layer to serve as the cell source for a custom replicator.

   This example uses a bird graphic from the Content folder in the Library.

2. Select the layer in the Layers list or Canvas, then do one of the following:
   - In the toolbar, click the Replicate button.
   - Choose Object > Replicate (or press L).

The new custom replicator layer appears in the Layers list and
in the Canvas, composited against any other layers you’ve already added.

If necessary, modify the replicator parameters in the HUD or in the Replicator Inspector. For more information, see Adjust a replicator overview.

Create a complex replicator using multiple source layers

You can create a more complex pattern containing multiple elements by adding multiple image sources to a single replicator. Each source becomes a cell in the replicator, and each cell has its own set of parameters.

1. In the Layers list or Timeline, select the layers to replicate.

   This example uses two graphics from the Content folder in the Library.
Note: Shift-click to select contiguous layers; Command-click to select noncontiguous layers.

2. Do one of the following:
   - In the toolbar, click the Replicate button.
   - Choose Object > Replicate (or press L).

The cells of the default rectangle replicator pattern are created from the source layers (which are deselected so they do not appear in the composition).

When multiple cells create a replicator pattern, the elements appear at the same points on the pattern. The replicator is positioned at the average of the source’s positions.
Add additional cells to an existing replicator

In the Layers list, drag an existing image layer onto the replicator.

**Note:** If you drag a media item from the File Browser or Library onto a replicator in the Layers list, the item is not added to the replicator; rather, it’s added to your project as a new layer in a new group.

![Layers panel](image)

The layer is duplicated as a new cell in the replicator.

**Note:** If the layer you drag to a replicator is a shape or mask, a drop menu appears, giving you the option to add the spline object as a replicator cell or as a mask. For more information,
What happens when you create a replicator?

After you add a replicator to a project, the following occurs:

- A replicator appears in the Layers list and is selected.
- One or more cells containing the image or images to be replicated appear as sublayers underneath the parent replicator (click the disclosure triangle beside the replicator layer to hide or reveal its cells).
- The original source layer (the cell source) is disabled.

**Note:** Changes made to the original source layer, such as opacity or shearing, are also applied to the pattern even after the replicator is created.

- In the Canvas, a bounding box and with transform handles appears around the selected replicator.
- For custom replicators, the Adjust Item tool is selected in the About using filters and masks with replicators.
toolbar so you can immediately begin dragging the replicator’s onscreen handles.

With the Adjust Item tool selected, dragging the bounding box outline or corner points in the Canvas resizes the replicator. Dragging inside the bounding box (but not the outline) repositions the replicator object as a whole.

- The Replicator HUD appears. If you’ve hidden the HUD, press F7.
- The Replicator Inspector becomes available.

The replicator and its cell (or cells) have separate parameters that control the look of the mosaic pattern you see in the Canvas. Changing the replicator parameters modifies the overall onscreen pattern, allowing you to create rectangular, circular, spiral, and other geometric layouts. Changing the cell parameters affects each element in the onscreen pattern, allowing you to modify attributes such as the angle, color, and scale of the pattern pieces.

After replicators are modified, you can save them in the Library for later use. See Save custom replicators to the Library.
You can adjust replicators in your project in a number of ways:

- **Modify basic replicator properties**, including a source image, cell opacity, and the pattern’s size and position in the Canvas.
- **Delete a replicator cell or an entire replicator**.
- **Adjust basic parameter controls in the HUD**.
- **Adjust advanced parameter controls** in the Replicator Inspector or Replicator Cell Inspector.

**(Modify the basic appearance of a replicator)**

After adding a preset replicator or creating a custom replicator, you modify it further by replacing its source image, adjusting cell opacity, or changing the replicator pattern’s size or position in the Canvas.

---

**(Replace a preset replicator’s source image)**

After adding a preset replicator to your project, you can replace its source image to better suit your needs.

1. In the File Browser or Library, select the file you want to use as the replacement graphic for the replicator preset, then add it to the project.

2. In the Layers list, drag the object to the replicator cell you want to replace.
Note: If the cell layer is not visible, click the disclosure triangle next to the replicator layer.

3. When the pointer becomes a curved arrow, release the mouse button.

The original source object is replaced with the new object.

4. Optional: Hide the new source layer by deselecting its activation checkbox in the Layers list.

The cells based on this layer remain in your replicator pattern, but the source layer itself is hidden in the Canvas.

**Adjust replicator element opacity**

You can adjust the opacity of individual elements in a replicator by modifying the cell parameters in the Replicator Cell Inspector or by modifying the source layer’s opacity in the Properties Inspector.

Do one of the following:

- Select the cell in the Layers list, then adjust the Opacity tag in the gradient editor in the Replicator Cell Inspector (or change Color Mode to Colorize and adjust the Opacity parameter in the Color controls).

- Select the original source layer—not the replicator cell—and change its opacity in the HUD or Properties Inspector.

**Change the stacking order of elements**
Change the stacking order of elements

The elements in the pattern are stacked according to their order in the Layers list and Timeline. In a replicator with multiple cells, changing cell stacking order changes the appearance of the pattern in the Canvas.

- In the Layers list, drag a cell to a new position above or below other cells in the replicator.

Adjust a replicator’s size or position using onscreen controls

1. In the Layers list, select the replicator to adjust.

2. In the toolbar, click the 2D transform tools pop-up menu, then choose the Adjust Item tool.

When the Adjust Item tool is selected, the replicator onscreen
controls appear in the Canvas. The onscreen controls vary depending upon the shape of the replicator (chosen from the Shape pop-up menu in the Replicator Inspector).

3. To resize the replicator, drag the replicator shape’s outline in the Canvas.

4. To reposition the replicator, drag inside the shape (but not directly on the outline) in the Canvas.

The size or position of the replicator shape is adjusted. For example, if the shape is a spiral or circle, dragging the shape outline changes the Radius parameter value. Dragging inside the shape (but not directly on the outline) repositions the replicator in the Canvas.

If the replicator shape is a rectangle, dragging a corner or edge of its bounding box changes the Size parameter value. Depending on which handle you drag, you can constrain the transform to width, height, or depth (in a box-shaped replicator). Or you can drag a corner handle to scale the replicator in multiple dimensions simultaneously.
Remove a replicator or a replicator cell

In a replicator that contains multiple cells, you can remove cells to change the appearance of the onscreen pattern. You can also remove a replicator (and its cells) entirely.
Remove a cell from a replicator

- In the Layers list or Timeline, select the cell to remove, then press Delete.

  The cell is removed from the Layers List, and the replicator pattern in the Canvas is modified.

Remove a replicator and its cells from a project

- Select a replicator in the Layers list or Timeline, then press Delete.

  The original source layer or layers remain in the project.

Modify a replicator in the HUD

When you create a replicator from a source layer, the onscreen pattern is built using the default parameters in the Replicator Inspector and Replicator Cell Inspector. You can modify the most important of these parameters in Replicator HUD and the Replicator Cell HUD. The HUD also provides quick access to the Opacity and Blend Mode parameters, located in the Properties Inspector.
Adjust a replicator in the Replicator HUD

1. In the Layers list or Timeline, select a replicator.
   The HUD appears. (If it does not appear, press F7.)

2. Modify any of the controls in the HUD: Opacity, Blend Mode, Shape, Arrangement, Columns, Rows, or Origin.
   These controls are a subset of the controls in the Replicator Inspector and in the Properties Inspector. For more information, see Replicator controls and Adjust a replicator in the Properties Inspector.

Adjust a cell in the Replicator Cell HUD

1. In the Layers list or Timeline, select a replicator cell.
   The HUD appears. (If it does not appear, press F7.)

2. Modify any of the controls in the HUD: Angle, Angle End, Angle Randomness, Scale, Scale End, or Scale Randomness.
   These controls are a subset of the controls in the Replicator Cell Inspector. For more information, see Replicator cell controls.

Modify a replicator in the Inspector
Adjust a replicator in the Inspector

Replicator and replicator cell parameters, though closely related, serve different purposes:

- Replicator parameters control the overall shape, arrangement, offset, stacking order, build order, and number of elements in the replicator pattern.
- Replicator cell parameters control the behavior and appearance of the elements in the replicator pattern.

For a replicator with only one cell (one source image), the replicator and replicator cell controls appear in the same Replicator Inspector. In this case, you can control every aspect of the replicator using these controls. However, in replicators with multiple cells, each cell has its own Replicator Cell Inspector containing all parameters for that cell.

Replicator parameters are dynamic—different controls appear depending on what is selected from the Shape pop-up menu and the Arrangement pop-up menu (which is itself dynamic, invoking additional parameters). For example, with Rectangle as the selected pattern shape, additional parameters appear in the Inspector that allow you to modify the size of the rectangle, the number of rows and columns, and other attributes. And with Spiral as the selected shape, parameter appear that allow you to adjust the radius of the spiral, the number of twists and arms, the number of points per arm (the locations on the shape where the elements sit), and other attributes.
Further, different parameters are also available depending on the selected arrangement for the shape. You can achieve very different looks by changing only a few parameters.

**Adjust a replicator in the Replicator Inspector**

1. Select a replicator in the Layers list or Timeline.

2. In the Inspector, click Replicator.
3. Adjust the Replicator Controls and Cell Controls.

The contents of the Replicator Inspector are dynamic: different parameters appear depending on the option you choose in the Shape pop-up menu. Also, different parameters appear depending on the option you choose in the Arrangement pop-up menu.

For a complete list of these controls, see Replicator controls.
1. Select a replicator cell in the Layers list or Timeline.

2. In the Inspector, click Replicator Cell.

3. Adjust the Cell Controls.

   For a complete list of these controls, see Replicator cell controls.
Replicator controls

The parameters in the Replicator Inspector give you complete control over every aspect of the pattern created by the selected replicator. This includes the shape upon which the pattern is built and the shape’s related parameters, such as the size of the pattern, how the elements are arranged in the pattern, and so on.

Some parameters in the Replicator Inspector depend on the settings of other parameters. All combinations of parameters are described below:

- **Shape**: A pop-up menu to set the overall shape of the onscreen replicator pattern. The default setting is Rectangle. Choose any of up to ten shape styles from the menu to alter the distribution of the pattern elements.

The Shape pop-up menu contains the following items:

- **Line**: Elements are positioned on a line. In the Inspector, you can set a specific number of points on the line—one element is positioned at every point (including the end points of the line).
- **Rectangle**:: Elements are positioned in a rectangle along the replicator outline, or in a tile or random fill pattern. When Rectangle is selected, the Arrangement parameter becomes available (described below).

  ![Rectangle shape with Arrangement set to Outline](image1)
  ![Rectangle shape with Arrangement set to Tile Fill](image2)
  ![Rectangle shape with Arrangement set to Random Fill](image3)

- **Circle**:: Elements are positioned in a circle along the replicator outline, or in a tile or random fill pattern. When Circle is selected, the Arrangement parameter becomes available. In the following image, the circle’s Arrangement is set to Outline.
• *Burst:* Elements are positioned in a flare pattern.

• *Spiral:* Elements are positioned in a spiral pattern.

• *Wave:* Elements are positioned on a waveform.
• **Geometry:** Elements are positioned along the edge of a shape, defined by a spline object used as the shape source. For more information, see *Create a custom replicator shape*.

For information on using geometry (a shape) as a replicator shape, see *Replicator cell controls*.

• **Image:** Elements appear within an area defined by an image or along its border, depending on the Arrangement setting. The image may have an alpha channel. If so, the shape of the alpha channel can also be used to define the pattern. For more information, see *Create a custom replicator shape*.

• **Box:** This option is available when the 3D checkbox...
Elements are positioned in a three-dimensional cube along the replicator outline, or on its surface in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool selected in the toolbar), you can specify the size and location of the rectangle. Drag the front horizontal outline edge to adjust height; drag the front vertical edge to adjust width; drag a back edge to adjust depth; drag a front corner to simultaneously adjust the width and height. To reposition the replicator, drag in the replicator (but not on an edge or corner point). In the following image, the box’s Arrangement is set to Tile.

![Replicator with box Arrangement set to Tile](image)

- **Sphere**: This option is available when the 3D checkbox (described below) is selected in the Replicator Inspector. Elements are positioned in a three-dimensional sphere along the replicator outline, or on its surface in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool selected in the toolbar), you can specify the radius and location of the circle. Drag the outline of the sphere to adjust its radius; drag in the sphere to reposition it in the Canvas.

- **Arrangement**: A pop-up menu (available when the Shape pop-up menu is set to Rectangle, Circle, Image, Box, or Sphere) to
specify the layout of the elements in the selected shape. There are three menu options:

- **Outline**: Elements are positioned along the edge of the shape.

- **Tile Fill**: Elements are positioned in a tiled pattern of rows and columns in the circle, rectangle, image, box, or sphere pattern. You can specify the number of columns and rows, as well as the Tile Offset. This is the default setting.

- **Random Fill**: Elements are positioned randomly within the circle, sphere, rectangle, or box pattern.

- **Size/Radius**: A slider (available when Shape is set to Rectangle or Box) to set the size of the rectangle or cube shape. Click the disclosure triangle to display separate Width, Height, and Depth (for the Box shape) parameters. When Circle is the selected shape, this parameter becomes Radius.

**Note**: For projects using the default camera settings and a default Z position for the replicator, Height is measured in pixels, and Width is measured in square pixels, to ensure that a numerically square will look square when “Correct for Aspect Ratio” is selected in the View pop-up menu in the top-right corner of the Canvas. For more information about square pixels, see [Pixel aspect ratio overview](#).
- **Shape Source:** An image well (available only when Shape is set to Geometry) to specify a shape object as the source for the replicator pattern. To set the shape source for the replicator, drag a shape from the Layers list or Timeline into the Shape Source well.

- **Image Source:** An image well (available when the Shape parameter is set to Image) to specify an image object as the source for the replicator shape. To set the image source, drag an image from the Layers list or Timeline into the Image Source well.

- **Emission Alpha Cutoff:** A slider (available when the Image Source object contains an alpha channel) to set the minimum opacity value necessary to create an element at that point on the source image. For example, when set to 25%, elements appear only at points where the alpha value of the image is equal to or greater than 25% opacity. The lower the Emission Alpha Cutoff value, the more cells appear. For this parameter to be effective, the alpha channel must have areas of varying transparency.

- **Start Point:** Value sliders (available when Shape is set to Line or Wave) to define, in X and Y coordinates, the first point of the line or wave on which the elements are positioned. Click the disclosure triangle to modify the Z position (depth) of the start point. You can adjust these values in the Canvas using...
End Point: Value sliders (available when Shape is set to Line or Wave) to define, in X and Y coordinates, the end point of the line or wave on which the elements are positioned. Click the disclosure triangle to modify the Z position (depth) of the end point. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool selected in the toolbar).

Amplitude: A slider (available only when Shape is set to Wave) to define half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.

Frequency: A slider (available only when Shape is set to Wave) to define the number of waves. The default is value is 1.

Phase: A dial (available only when Shape is set to Wave) to define the degree of offset of the waves from the start and end points of the path. When set to 0 degrees (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When set to 90 degrees, the wave begins and ends at the highest point in the wave. When set to –90 degrees, the wave begins at the lowest point...
in the wave. When set to 180 degrees, the waves are the same as at 0 degrees, but are inverted.

- **Damping:** A slider (available only when Shape is set to Wave) to set the diminishing oscillation of the wave. Positive damping values diminish the wave forward (from left to right); negative values diminish the wave backward (from right to left).

![Wave Image]

- **Points:** A slider that does the following:
  - When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Outline or Random Fill, specifies the number of evenly distributed element points along the edge of the shape.
  - When Shape is set to Line or Wave, specifies the number of evenly distributed element points on the line or wave.
  - When Shape is set to Geometry, specifies the number of evenly distributed element points around the shape.
When the Adjust Item tool is selected in the toolbar, these points are visible in the Canvas.

- **Offset**: A slider that does the following:
  - When Shape is set to Line or Wave, moves the elements along the line or wave.
  - When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Outline, moves the elements along the edge of the shape.
  - When Shape is set to Geometry, moves the position of the elements along the edge of the shape.

- **Build Style**: A pop-up menu and related controls to specify how elements are built over the replicator shape. When Shape is set to Rectangle, Circle, or Image, and Arrangement is set to Outline; or when Shape is set to Geometry, the pop-up menu contains the following options:
  - **Clockwise**: Places the elements along the shape in a clockwise direction.
  - **Counter Clockwise**: Places the elements along the shape in a counterclockwise direction.
When Shape is set to Rectangle or Image, and Arrangement is set to Tile Fill, and Origin set to Upper Left, Upper Right, Lower Left, or Lower Right, the Build Style pop-up menu contains the following options:

- **Across**: Builds the elements across the pattern in the direction implied by the Origin parameter.
- **By Row**: Builds the elements over the pattern by row.
- **By Column**: Builds the elements over the pattern by column.

When Shape is set to Box, and Arrangement is set to Tile Fill, and Origin is set to Front Upper Left, Front Upper Right, Front Lower Left, Front Lower Right, Back Upper Left, Back Upper Right, Back Lower Left, or Back Lower Right, the Build Style pop-up menu contains the following options:

- **Across**: Builds the elements across the pattern in the direction implied by the Origin parameter.
- **By Row, Column, Rank**: Builds the elements over the pattern by row, column, then rank starting from the Origin.
- **By Column, Row, Rank:** Builds the elements over the pattern by column, row, then rank starting from the Origin.

- **By Row, Rank, Column:** Builds the elements over the pattern by row, rank, then column starting from the Origin.

- **By Column, Rank, Row:** Builds the elements over the pattern by column, rank, then row starting from the Origin.

- **By Rank, Row, Column:** Builds the elements over the pattern by rank, row, then column starting from the Origin.

- **By Rank, Column, Row:** Builds the elements over the pattern by rank, column, then row starting from the Origin.

- **Radius:** A slider (available when Shape is set to Burst, Spiral, Circle, or Sphere) to set the size of the selected shape.

- **Twists:** A slider (available only when Shape is set to Spiral) to set the number of turns in a spiral. The default value is 0.25. When Number of Arms is set to one, a single spiral is created.
• **Number of Arms**: A slider (available only when Shape is set to Burst or Spiral) to set the number of branches on which the elements are positioned. The default value is 3.

• **Points Per Arm**: A slider (available only when Shape is set to Burst or Spiral) to set the number of element points on each branch of the burst or spiral. When the Adjust Item tool is selected in the toolbar, the points are visible in the Canvas.

• **Columns**: A slider (available when Shape is set to Rectangle, Circle, or Image, and Arrangement is set to Tile Fill; or when Shape is set to Box or Sphere and Arrangement is set to Outline or Tile Fill) to specify the number of vertical columns (or horizontal element points) on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside the shape are ignored.

• **Rows**: A slider (available when Arrangement is set to Tile Fill) to set the number of horizontal rows (or vertical element points) on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside the shape are ignored. This control is also available for Box and Sphere when Arrangement is set to Outline or Tile Fill.

• **Ranks**: A slider (available when Shape is set to Box and
Arrangement is set to Tile Fill or Outline; or when Shape is set to Sphere and Arrangement is set to Tile Fill) to specify the number of points in Z space (depth) on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside the shape are ignored.

- **Tile Offset:** A slider (available when Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Tile Fill) to specify the amount (in percentage points) that the elements are offset from the pattern. Values from 0 to 100% offset the rows toward the right, and values from 0 to −100% offset the rows toward the left. A value of 50 or −50% creates a brickwork pattern.

- **Origin:** A pop-up menu to specify how the elements traverse across the pattern from a point of origin. For example, when set to Left, the elements sweep across the pattern from left to right. When set to Upper Right, the elements traverse from the upper-right corner point of the shape to the lower-right corner.
When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Tile Fill or Random Fill the Origin pop-up menu contains the following options:

- **Upper Left**: Elements originate in the upper-left corner of the pattern and end in the lower-right corner.
- **Upper Right**: Elements originate in the upper-right corner of the pattern and end in the lower-left corner.
- **Lower Left**: Elements originate in the lower-left corner of the pattern and end in the upper-right corner.
- **Lower Right**: Elements originate in the lower-right corner of the pattern and end in the upper-left corner.
- **Center**: Elements originate in the center of the pattern and move outward. This is the default Origin option.
- **Left**: Elements originate at the left side of the pattern and end at the right side.
- **Right**: Elements originate at the right side of the pattern and end at the left side.
- **Top**: Elements originate at the top of the pattern and end at the bottom.
- **Bottom**: Elements originate at the bottom of the pattern and end at the top.
• **Bottom**: Elements originate at the bottom of the pattern and end at the top.

When Shape is set to Circle or Sphere, **and** Arrangement is set to Tile Fill or Random Fill, the Origin pop-up menu contains the following options:

• **Center**: Elements originate in the center of the pattern and build outward. This is the default Origin option.

• **Edge**: Elements originate along the edge of the pattern and build inward.

When Shape is set to Box, **and** Arrangement is set to Tile Fill or Random Fill, the Origin pop-up menu contains the following options:

• **Front Upper Left**: Elements originate in the front upper-left corner of the pattern and end in the back lower right.

• **Front Upper Right**: Elements originate in the front upper-right corner of the pattern and end in the back lower left.

• **Front Lower Left**: Elements originate in the front lower-left corner of the pattern and end in the back upper right.

• **Front Lower Right**: Elements originate in the front lower-right corner of the pattern and end in the back upper left.

• **Back Upper Left**: Elements originate in the back upper-left corner of the pattern and end in the front lower right.

• **Back Upper Right**: Elements originate in the back upper-right corner of the pattern and end in the front lower left.
- **Back Lower Left:** Elements originate in the back lower-left corner of the pattern and end in the front upper-right.

- **Back Lower Right:** Elements originate in the back lower-right corner of the pattern and end in the front upper-left.

- **Left:** Elements originate at the left side of the pattern and end at the right side. The pattern is identical on each row.

- **Right:** Elements originate at the right side of the pattern and end at the left side. The pattern is identical on each row.

- **Top:** Elements originate at the top of the pattern and end at the bottom. The pattern is identical on each rank.

- **Bottom:** Elements originate at the bottom of the pattern and end at the top. The pattern is identical on each rank.

- **Front:** Elements originate at the front of the pattern and
- Front: Elements originate at the front of the pattern and end at the back. The pattern is identical on each column.

- Back: Elements originate at the back of the pattern and end at the front. The pattern is identical on each column.

- Center: Elements originate in the center of the pattern and move outward. This is the default Origin option.

- X Axis: Elements originate along the X axis of the pattern and move outward.

- Y Axis: Elements originate along the Y axis of the pattern and move outward.

- Z Axis: Elements originate along the Z axis of the pattern and move outward.

Note: The origin pop-up menu also determines where the Sequence Replicator behavior starts its animation. For more information on the Sequence Replicator behavior, see Apply the Sequence Replicator behavior.

- Shuffle Order: A checkbox that, when selected, rearranges the order in which the elements appear.
Replicate Seed: A random seed generator button and field (available when Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Random Fill) to modify the Random Fill pattern. Click the Generate button to set a new random seed number.

Although the result of the Random Fill option from the Arrangement pop-up menu seems random, it’s deterministic. This means that the random variation in the pattern is created based on the number shown. Unless this seed number is changed, a replicator with the same parameter settings and source object always appears the same. If you don’t like the current random fill, you can change the seed number by typing a new number or clicking Generate. This changes the random calculations performed for that pattern. This parameter is also used to randomize the Shuffle Order parameter.

3D: A checkbox that, when selected, enables the Box and Sphere options in the Shape pop-up menu.

Reverse Stacking: A checkbox that, when selected, inverts the order in which elements are stacked. To see the effect of this parameter, elements must be overlapping.
Face Camera: A checkbox (available when the 3D checkbox is selected) that, when selected, forces pattern elements to face the camera when the camera or the replicator is rotated. When Face Camera is deselected, the elements face forward in the replicator pattern and appear flat (unless the source layer or pattern elements are rotated in 3D space). Because Motion does not support 3D objects (other than 3D text), this option is key to giving 2D layers the appearance of 3D as the camera is animated.

Note: Because replicator pattern elements are 2D (flat) objects (unless 3D text is used as the replicator source), the pattern elements are not visible when you use the orthogonal reference camera views, such as Left, Right, and Top (unless the source layer or pattern elements are rotated in 3D space). This is because orthogonal views are at right angles (perpendicular) to the elements. For more information on using cameras, see 3D cameras overview.
Create a custom replicator shape

Two settings in Shape pop-up menu (in the Replicator Inspector) let you set a custom layout pattern for elements in the replicator:

- **Geometry**: Elements in the replicator pattern are arrayed along the outline of a custom geometry shape (a circle or Bezier shape, for example) that you designate.

- **Image**: Elements in the replicator pattern are arrayed along the outline of, or as a fill within, an image or movie clip that you designate.

When you choose Geometry or Image from the Shape pop-up menu, a source well becomes available. When used as geometry sources, images (such as stills or clips) and geometry (shape) layers can be used to specify the shape of the replicator pattern. The following tasks describe how to use image and geometry layers as cell sources and shape sources.

Use a geometry object as the shape source
of the replicator pattern

1. Import (or draw) the shape to use as the pattern shape in an existing replicator.

   The shape is added as a layer to your project.

2. In the Layers list, select the replicator, then, in the Replicator Inspector, click the Shape pop-up menu and choose Geometry.

   The Shape Source well appears in the Inspector and HUD.

3. From the Layers list, drag the shape to the Shape Source well.

4. When the pointer becomes a curved arrow, release the mouse button.

   A thumbnail of the shape appears in the well and is used as the source for the shape of the replicator. To hide the original shape you created in step 1, deselect its checkbox in the Layers list.

Note: Image objects cannot be used as a shape source when
the Shape pop-up menu is set to Geometry.

Use an image as the shape source of the replicator pattern

1. Import an image to use as the pattern shape in an existing replicator.

The image is added as a layer to your project.

2. In the Layers list, select the replicator, then, in the Replicator Inspector, click the Shape pop-up menu and choose Image.

The Image Source well appears in the Inspector and HUD.

3. From the Layers list, drag the image into the Image Source well, and when the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the image appears in the well and is used as
the source for the shape of the replicator pattern. To hide the original shape you created in step 1, deselect its checkbox in the Layers list.

4. To set the type of pattern, click the Arrangement pop-up menu, then choose an option:

- **Outline**: Pattern elements are placed along the rectangular outline of the image source.

- **Tile Fill**: Pattern elements are flanked in rows and columns inside the borders of the image source.

- **Random**: Pattern elements are distributed in random fashion inside the borders of the image source.

---

**Replicator cell controls**

Adjust replicator cells using the controls at the bottom of the Replicator Inspector (for replicators with a single cell) or in the Replicator Cell Inspector (for replicators with multiple cells):

- **Align Angle**: A checkbox (available when Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Tile Fill or Random Fill) that forces replicator elements to rotate to match the shape on which they’re positioned.
• **Angle**: A dial to set (in degrees) the rotation of the replicator elements. When the 3D checkbox is selected in the Replicator Inspector, the default dial modifies the Z angle. To modify the rotation of the pattern elements on all three axes (X, Y, and Z), click the disclosure triangle and adjust the X, Y, and Z dials. When the 3D checkbox is selected, this parameter group also displays the Animate pop-up menu (described below).

• **Animate**: A pop-up menu (available as a subparameter of the Angle parameter when the 3D checkbox is selected) that sets the angle interpolation for keyframed animation of the Angle parameter. There are two menu choices:
  - **Use Rotation**: The default interpolation method. When the Angle parameter is keyframed, pattern elements rotate from their start rotation to their final rotation. Depending on the animation, the elements may twist before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, the elements rotate on all axes before reaching their final orientation.
  - **Use Orientation**: This alternate interpolation method provides smoother animation but does not allow multiple revolutions. It interpolates between the pattern elements’
• **Angle End:** A dial to set (in degrees) the rotation of the replicator elements at the end of the pattern. The angle value of the elements at the end of the pattern equals the Angle value (start) plus the Angle End value. For example, if Angle is set to 0 degrees and Angle End set to 90 degrees, the elements are not rotated at all at their origin, and are rotated by 90 degrees at the end of the pattern.

In a 3D project, using the default dial modifies the Z angle. To modify the rotation of the pattern elements on all three axes (X, Y, and Z), click the disclosure triangle and adjust the individual X, Y, and Z dials. When the 3D checkbox is selected, this parameter group also displays the Animate pop-up menu (described below).

• **Animate:** A pop-up menu (available as a subparameter of the Angle End parameter when the 3D checkbox is selected) that sets the angle interpolation for keyframed animation of the Angle parameter. There are two menu choices:
  - **Use Rotation:** This is the default interpolation method.
- **Use Rotation:** This is the default interpolation method. When the Angle End parameter is keyframed, pattern elements rotate from their start rotation to their final rotation. Depending on the animation, the elements may twist before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, the elements rotate on all axes before reaching their final orientation.

- **Use Orientation:** This alternate interpolation method provides smoother animation but does not allow multiple revolutions. It interpolates between the pattern elements’ start orientation (first keyframe) and their end orientation (second keyframe).

- **Angle Randomness:** A dial that defines an amount of variance in the rotation of replicator elements. A value of 0 results in no variance—all elements have the same rotational value. A value greater than 0 introduces a variance. The angle for an element is defined by the Angle and Angle End parameter, plus or minus a random value falling within the Angle Randomness.

In a 3D project, using the default dial or value slider (when the disclosure triangle is closed), modifies the Z angle. To modify the rotation of the pattern elements on all three axes (X, Y, and Z), click the disclosure triangle and adjust the X, Y, and Z dials. When the 3D checkbox is selected, this parameter group also displays the Animate pop-up menu (described below).

- **Animate:** A pop-up menu (available as a subparameter of the Angle Randomness parameter when the 3D checkbox is selected) that sets the angle interpolation for keyframed animation of the Angle Randomness parameter. There are
two menu choices:

- **Use Rotation**: This is the default interpolation method. When the Angle Randomness parameter is keyframed, pattern elements rotate from their start rotation to their final rotation. Depending on the animation, the elements may twist before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, the elements rotate on all axes before reaching their final orientation.

- **Use Orientation**: This alternate interpolation method provides smoother animation but does not allow multiple revolutions. It interpolates between the pattern elements’ start orientation (first keyframe) and their end orientation (second keyframe).

- **Additive Blend**: By default, replicator elements are composited together using the Normal blend mode. Select this checkbox to composite all overlapping elements using the Additive blend mode. The result is that the brightness of overlapping objects is intensified. This blending occurs in addition to the compositing method set in the Blend Mode parameter in Properties Inspector.

- **Color Mode**: A pop-up menu to specify how replicator elements are tinted. There are five menu options:
  
  - **Original**: Elements are created using the original colors from the source layer. When this setting is chosen, the Opacity Gradient editor becomes available (described below).
- **Colorize:** Elements are tinted using the color specified in the Color parameter. When this setting is chosen additional Color and Opacity Gradient controls become available (described below).

- **Over Pattern:** Elements are tinted based on how they are ordered in the pattern. When Over Pattern is chosen, the Color Gradient editor becomes available (described below).

- **Pick From Color Range:** Elements are tinted at random, with the range of possible colors and transparency defined by the Color Range gradient editor (described below). A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used.

  For more information on using the gradient controls, see **Change a gradient’s color and opacity**.

- **Take Image Color:** Each element’s color is based on the color of the image at the position of the element point. This mode is only available when an image in used as the replicator shape.
• **Color:** This color well becomes available when the Color Mode is set to Colorize. Use it to specify a color to tint replicator elements. You can also alter each element’s opacity. This parameter is unique to the cell object. You can click the color well to choose a color, or open the disclosure triangle and use the Red, Green, Blue, and Opacity channel sliders or value sliders.

• **Opacity Gradient:** A gradient editor (available when Color Mode is set to Original or Colorize) to change the opacity of replicator elements over the pattern. This gradient control is limited to grayscale values, which are used to represent varying levels of transparency. White represents solid elements; progressively darker levels of gray represent decreasing opacity; and black represents complete transparency. A simple white to black gradient represents a pattern that is solid at its origin, but which fades out gradually. For more information on using gradient and opacity gradient controls, see Change a gradient’s color and opacity.
- **Color Gradient**: A gradient editor (available when Color Mode is set to Over Pattern) to specify the range of color and transparency of the pattern, beginning with the leftmost color in the gradient, then progressing through the range of colors to the rightmost color at the end of the pattern.

Gradual color changes do not appear in each element, but only across the pattern as a whole.

An Opacity control is available at the top of the gradient editor. For more information on using gradient controls, see Change a
- **Color Range**: A gradient editor (available when Color Mode is set to Pick From Color Range) to specify the range of colors and transparency used to randomly tint the pattern.

- **Color Repetitions**: A slider (available when Color Mode is set to Over Pattern) to set the number of times the gradient is repeated over the pattern.

- **Scale**: A slider to set the scale of replicator elements. By default, Scale is set to 100%—the size of the replicator elements is equal to the size of the source layer. Click the disclosure triangle next to the Scale parameter to reveal separate X, Y, and Z scaling subparameters. Use X and Y to resize the width and height of elements separately; use Z to change the depth of 3D text elements.

- **Scale End**: A slider to set the scale of the replicator elements at the end of the pattern, relative to the Scale value. For example, if Scale is set to 100% and Scale End set to 50%, the elements are 100% at their origin and half their size at the end of the pattern. Click the disclosure triangle next to the Scale End parameter to reveal separate X, Y, and Z scaling subparameters. Use X and Y to resize the width and height of elements separately; use Z to change the depth of 3D text elements.

- **Scale Randomness**: A slider to set an amount of variance in the scale of replicator elements. A value of 0 results in no variance—all elements in the pattern are the same size. A value greater than 0 introduces a variance. The scale for an element is defined by the Scale parameter, plus or minus a random value falling within the Scale and the Scale End. Click the disclosure triangle next to the Scale Randomness parameter to reveal separate X, Y, and Z scaling subparameters. Use X and Y to resize the width and height of elements separately; use Z to change the depth of 3D text elements.
parameter to reveal separate X, Y, and Z scaling subparameters. Use X and Y to resize the width and height of elements separately; use Z to change the depth of 3D text elements.

- **Play Frames**: A checkbox (available if the replicator is using a QuickTime object as the source for a cell) that, when selected, loops playback of the animation or movie clip used for each element. If this checkbox is deselected, the animation or clip is frozen at the still frame specified by the Random Start Frame parameter or the Source Start Frame parameter (described below).

- **Random Start Frame**: A checkbox (available if the replicator is using a QuickTime object as the source for a cell) that, when selected, introduces variation so that each element in the pattern begins at a different frame of the clip. If the Play Frames checkbox is deselected, still frames are chosen randomly.

- **Source Start Frame**: A slider (available if the replicator is using a QuickTime object as the source for a cell, and if Random Start Frame is deselected) that designates the start frame of the clip (when the Play Frames checkbox is selected) or the
still frame to display (when Play Frames is deselected).

- **Source Frame Offset**: A slider (available if the replicator is using a QuickTime object as the source for a cell, and Random Start Frame is deselected) to offset the start frame chosen in the Source Start Frame slider. At their origin, the elements play the animation from the frame specified in the Source Start Frame slider. Each adjacent pattern element in the Canvas advances the start frame by the offset amount.

![Rectangle replicator shape with Origin set to Top and Source Frame Offset set to 0](image1)

![With Source Frame Offset set to 20, each adjacent pattern element begins 20 frames later.](image2)

- **Hold Frames**: A slider (available if the replicator is using a QuickTime object as the source for a cell) to set the number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

- **Hold Frames Randomness**: A slider (available if the replicator is using a QuickTime object as the source for a cell) to vary the number of frames to hold.

- **Show Objects As**: A pop-up menu that sets whether replicator elements are displayed in a preview mode or as they actually appear. The nonimage modes play back more efficiently when viewing a complex replicator pattern. By default, this pop-up
menu is set to Image, which displays each element as it is supposed to appear. Choose one of the following four options:

- **Points**: Displays each element as a single point. This is the fastest preview mode. When you choose Points, the Point Size slider appears, allowing you to increase the size of the points for easier viewing. In the following image, the Point Size is set to 8.

- **Lines**: Displays each element as a line. This option is effective only when elements of the replicator are animated using Simulation behaviors or the Throw (Basic Motion) behavior. The movement of each pattern element is represented by a line; use this view to analyze motion vectors of elements. The length of each line is determined by that element’s speed, and the angle of each line equals each element’s direction. In the following image, the replicator elements are animated using the Vortex behavior.
**Note:** Element movement created by the Sequence Replicator behavior or by keyframing the replicator parameters is not displayed.

- *Wireframe:* Displays each element as a bounding box. Because the bounding boxes are good indicators of each element’s orientation in the pattern, this preview mode is useful for evaluating the movements of individual elements. For example, it’s easy to see the angle of rotation for elements that are spinning or following a complex motion path.

- *Image:* Displays elements as they will appear in your final render. This is the default setting.
Note: The option chosen in the Show Objects As pop-up menu appears in your final render.

- **Random Seed:** Although the result of adjusting the Angle Randomness, Scale Randomness, Pick From Color Range, Random Start Frame, or Hold Frame Randomness parameters seems random, it’s deterministic. This means that the random variation in the pattern is created based on the number shown in the Random Seed field. Unless this seed number is changed, a replicator with the same parameter settings appears the same. If you don’t like the current random scale or angle, change the seed number by typing a new number in the field or by clicking Generate.

- **Object Source:** An image well displaying a thumbnail of the replicator cell. To swap out a cell, drag a new source layer from the Layers list to the Object Source well.

In a replicator with multiple cells, each cell appears in a separate image well listed at the bottom of the Replicator Inspector. A checkbox lets you enable or disable that cell.
You can modify a replicator’s position, scale, blend mode, drop shadow, and other attributes in the Properties Inspector. These properties are separate from the replicator parameters in the Replicator and Replicator Cell Inspectors, which control the shape and size of the replicator, as well as all aspects of its pattern and cells.

1. Select a replicator in the Layers list, Timeline, or Canvas.
2. In the Inspector, click Properties.
3. Adjust the controls.

For detailed information about the Properties Inspector, see Properties Inspector controls.

**Note:** When you select a replicator cell (as opposed to the replicator, itself) and open the Properties Inspector, only one group of parameters is available: the Timing controls, which adjust the In and Out points of the replicator cell.

**Animate replicators**

**Animate replicators overview**

By adding behaviors or keyframes to a replicator or its cells, you can quickly animate the pattern of replicated images in complex, dramatic ways:
Apply Basic Motion or Simulation behaviors to a replicator object to animate an entire replicator pattern as a whole, or to replicator cells to animate each element in the pattern symmetrically. To make replicator elements interact with other objects in your project, apply a Simulation behavior to the replicator or another object (an object that’s not part of the replicator). For example, applying the Orbit Around behavior to an object will cause replicator elements to circle around that object.

Use the Sequence Replicator behavior—a special behavior designed for replicators—to animate individual pattern elements in turn over time, without creating keyframes.

Use Parameter behaviors to animate individual parameters in the Replicator Inspector or Replicator Cell Inspector.

Use keyframes to animate individual parameters in the Replicator Inspector or Replicator Cell Inspector. Or use keyframes in the Properties Inspector to animate a replicator’s position, rotation, or opacity over time.

Apply behaviors to replicators and replicator cells

You can apply Basic Motion, Parameter, and Simulation behaviors to a replicator. Some behaviors can be applied directly to replicator cells, such as Throw and Spin (from the Basic Motion
Do one of the following:

- Drag a behavior from the Library onto a replicator or replicator cell in Layers list or Timeline.

- Select a replicator or replicator cell in the Layers list or Timeline, then choose an item from the Add Behavior pop-up menu.

The behavior is applied to the replicator or cell, which begins to move according to the parameters of the behavior.

Not all behaviors instantly activate a layer (including a Replicator layer) when applied. For example, when you apply the Throw behavior to a layer, you must adjust the Throw Velocity parameter to make the layer move.

For more information, see Behaviors overview.

As previously noted, the replicator also has a special behavior called Sequence Replicator, which animates individual cells in sequence over time. For more information, see Apply the Sequence Replicator behavior.

SEE ALSO
Special behavior considerations
Special behavior considerations

When you apply one of the Simulation behaviors, or the Spin or Throw behavior, to a replicator that already has keyframed animation, some animation created by the keyframes is ignored. For example, if the Angle parameter in the Cell Controls of the Replicator Inspector is keyframed to make the pattern elements rotate over time, and you apply a Spin behavior—with the Affect Subobjects checkbox selected—the elements ignore the replicator’s Angle keyframes and rotate according to the rate set in the Spin behavior parameters. To rotate the entire replicator layer and enable the Angle keyframe animation, deselect Affect Subobjects in the Spin parameters.

Apply the Sequence Replicator behavior

The Sequence Replicator behavior animates elements of a replicator in sequence over time. This is the only way to animate elements individually—keyframing the cell parameters or applying other behaviors affects all elements in the pattern uniformly.
Using the Sequence Replicator behavior, you can select and apply replicator cell parameters such as Position, Color, Scale, Rotation, or Opacity, then animate those parameters in a cascading sequence that passes through each element in a replicator pattern.

The starting point for the sequence animation is based on the replicator’s origin or build style. For example, if a spiral replicator’s Origin parameter is set to Center, the sequence animation begins at the center of the spiral and moves outward; if the Origin of a rectangle replicator with a tile fill is set to Upper Left, and the Build Style is set to Across, the sequence begins with the elements in the upper-left corner of the pattern, then moves toward the lower-right corner.

You can apply the Sequence Replicator behavior to a replicator or to its cells. Either application creates the same animation.

After you create a Sequence Replicator behavior, you can save it to the Library as a custom behavior.

Apply the Sequence Replicator behavior

Do one of the following:
In the Layers list or Timeline, select a replicator or replicator cell, click the Add Behavior pop-up menu in the toolbar, then choose Replicator > Sequence Replicator.

In the Library, select the Behaviors category, select the Replicator subcategory, then drag the Sequence Replicator from the stack to a replicator or replicator cell in the Layers list, Timeline, or Canvas.

The Sequence Replicator controls appear in the Behaviors Inspector. For the behavior to have any effect on the replicator, you must add parameters using the Parameter pop-up menu at the top of the Sequence Replicator controls. For details, see the next task.
Add and animate parameters in the Behaviors Inspector

After you apply the Sequence Replicator behavior to a replicator, you must assign one or more parameters for the behavior to modify. In the following example, the Rotation, Opacity, and Scale parameters are assigned to the Sequence Replicator behavior in the Behaviors Inspector.

1. In the Layers list or Timeline, select the Sequence Replicator behavior.

2. In the Parameter row of the Behaviors Inspector, do the following:
   a. Click the Add pop-up menu, then choose Rotation.
   b. Click the Add pop-up menu, then choose Opacity.
   c. Click the Add pop-up menu, then choose Scale.

   The added parameters appear above the Add and Remove pop-up menus. No animation occurs until you set a value for the parameters.

3. Ensure that keyframe recording is turned off (the Record button in the transport controls under the Canvas is not highlighted).

4. In the Behaviors Inspector, drag the Rotation dial to set a spin value.

   In this example, Rotation is set to 160 degrees, so that each
element rotates from 0 degrees to 160 degrees over the pattern for the duration of the Sequence Replicator behavior.

**Note:** If the elements are already rotated (in the Cell Controls), the elements are rotated 160 degrees from their original rotation value.

Play your project (press the Space bar). Each element rotates 160 degrees in sequence, popping into place before the next element begins rotating.

5. To ease the transition between each element’s animation, drag the Spread value slider to the right.

In this example, Spread is set to 12. In addition to creating a more graceful animation, changing the Spread value can also dramatically change the appearance of the pattern.
6. In the Behaviors Inspector, drag the Opacity slider to the lowest value you want the elements to fade to during the animation.

In this example, Opacity is set to 0. Each element fades from 100% opacity to 0% opacity over the duration of the Sequence Replicator behavior.

**Note:** If the elements already contain some transparency, they fade from their original opacity value to 0%.

7. In the Behaviors Inspector, drag the Scale slider to the right to increase the size of each element over time.

In this example, Scale is set to 190%.
Play your project. The animation begins at the original value for any added parameter, then transforms to the value you specify in the Sequence Replicator parameters. The animation begins at the origin of the pattern (set in the Origin or Build Style parameter of the Replicator Inspector or HUD) and moves to through the elements to the end of the pattern.

**Change the way the sequence moves through the pattern**

After you apply parameters to the Sequence Replicator behavior, you can use Sequence Controls parameters to change the way the sequence moves through the replicator pattern. The following task continues with the project used in the previous example.

1. With the Sequence Replicator behavior selected, play the project (press the Space bar) to see the effects of the sequencing.

   By default, the Sequencing parameter (in the Behaviors Inspector) is set to “To,” which specifies that the animation begins at the original value of the cells and moves to the value set in the Sequence Replicator behavior for that parameter.
The starting point for the sequence animation is based on the build or origin of the pattern (as defined in the Origin or Build Style parameters in the Replicator Inspector). In the current example, the elements begin completely opaque, at 100% scale, and with 0 degrees of rotation at the origin of the pattern. As the sequence moves toward the end of the pattern, the elements become completely transparent, are scaled to 190%, and are rotated 160 degrees.

2. In the Behaviors Inspector, click the Sequencing pop-up menu, then choose From.

Play your project. The animation now moves from the value set in the Sequence Replicator behavior to the original value of the cells. This is the opposite of the To Sequencing option.

3. In the Behaviors Inspector, click the Sequencing pop-up menu, then choose Through.

Play your project. The sequence goes through a full animation cycle starting at the original value of the cells, moving to the
value set in the Sequence Replicator, then returning to the original value of the cells. This is similar to combining the To and From Sequencing options.

4. In the Behaviors Inspector, click the Unit Size pop-up menu, then choose All.

Play your project. The sequence animation affects all replicator elements simultaneously. The default Unit Size setting is Object, which applies the sequence animation to the elements of the replicator based on the origin of the pattern.

5. In the Behaviors Inspector, drag the Loops slider to the right to set a value of 3.

Play your project. The sequence now loops three times. The value of the Loops parameter defines the number of times the animation repeats over the duration of the replicator object.
6. In the Behaviors Inspector, click the End Condition pop-up menu, then choose Ping Pong.

By default, the End Condition parameter is set to Hold, which completes a sequence animation cycle, then starts the cycle again from the beginning. When set to Ping Pong, the animation cycles forward one time, then cycles backward, then forward, and so on.

**Note:** The End Condition parameter has no effect for Loop values less than or equal to 1.

---

**SEE ALSO**

**Sequence Replicator controls**

Use the following controls in the Behaviors Inspector to modify the sequence animation:

- **Parameter:** Two pop-up menus (Add and Remove) that designate pattern elements to animate in sequence. When you choose an item from the Add pop-up menu, additional controls appear at the top of the Behaviors Inspector. You can adjust these controls (or keyframe them) to modify the sequence animation, which is based on the change in value between these parameters and the original values of the cells. The Add pop-up menu items include the following options:
  - **Rotation:** Adds a rotation dial and value slider that enables you to Specify (in degrees) the rotation of replicator
- **Color:** Adds a row of color controls that let you specify a tint for replicator elements. You can click the color well to choose a color or open the disclosure triangle and use the Red, Green, and Blue sliders. For more information about using color controls, see **Basic color controls**.

- **Opacity:** Adds an opacity slider, allowing you to define the transparency of the pattern elements.

- **Scale:** Adds a scale slider that lets you define the size of replicator elements. Click the disclosure triangle next to the Scale slider to reveal separate X and Y subparameters to adjust the width and height of the cells separately. By default, Scale is set to 100%—the size of the replicator cells is equal to the original size defined in the cell parameters. Click the disclosure triangle next to the Scale parameter to reveal separate X, Y, and Z scaling subparameters. Use X and Y to resize the width and height of elements separately; use Z to change the depth of 3D text elements.

- **Position:** Adds two value fields that define the offset of elements from their original position in X and Y space. Click the disclosure triangle next to the parameter name to reveal separate X, Y, and Z position subparameters. For example, to create an animation in which elements move upward along the Y axis over the replicator pattern, enter a positive value in the Y Position field. In the following images, Y Position is set to 300.
• **Sequencing:** A pop-up menu to set how the sequence animation moves through the elements of the pattern, based on the change from the original parameter value to the value set in the Sequence Replicator parameters. The starting point for the sequence animation is based on the selected Origin or Build Style parameters (in the Replicator Inspector). For example, if a line replicator’s Origin parameter is set to End Point, the sequence animation begins at the end of the line and moves toward the start of the line by default. To change the starting point for the sequence animation, change the Origin or Build Style of the pattern in the Replicator Inspector or HUD. The Sequencing pop-up menu contains the following options:

• **To:** Animation begins at the original value of the cells and moves to the value set in the Sequence Replicator behavior for that parameter. For example, if the original opacity value of a cell is 100%, and opacity is set to 0% in the Sequence Replicator parameters, onscreen elements begin completely opaque and become completely transparent.

• **From:** Animation moves from the value set in the Sequence Replicator behavior to the original value of the cells. For example, if the original opacity value of a cell is 100% and opacity is set to 0% in the Sequence Replicator parameters, onscreen elements begin completely transparent and become completely opaque. This is the
opposite of the To option in the Sequencing pop-up menu.

- **Through**: The sequence goes through a full animation cycle starting at the original value of the cells, moves to the value set in the Sequence Replicator, and then returns to the original value of the cells. For example, if the original opacity value of a cell is 100% and opacity is set to 0% in the Sequence Replicator parameters, onscreen elements begin completely opaque, become transparent, and then become completely opaque again.

- **Through Inverted**: The sequence goes through an inverted animation cycle starting from the value set in the Sequence Replicator, moves to the original value of the cells, and then returns to the value set in the Sequence Replicator. For example, if the original opacity value of a cell is 100% and opacity is set to 0% in the Sequence Replicator parameters, the onscreen elements begin completely transparent, become opaque, and then become completely transparent. This is the opposite of the Through Sequencing option.

- **From Keyframes**: Lets you use animation originally created in the source layer’s parameters (except alpha parameters). Additionally, you can keyframe how the animation moves through the values set in the Sequence Replicator parameters.
• **Source**: A pop-up menu (available when the Sequencing pop-up menu is set to From Keyframes) to enable animation created by keyframes in a replicated source layer (the layer that is disabled when the replicator is created). There are two options: Use Source Animation and Ignore Source Animation.

• **Unit Size**: A pop-up menu to specify whether the sequence animation is applied to the replicator pattern as a whole, to its elements, or to a keyframed range. There are three options:
  - **Object**: The default setting, applies the animation to each element in sequence over the duration of the behavior
  - **All**: Applies the sequence animation to all replicator elements simultaneously.
**Custom:** Lets you specify the percentage of elements in the pattern affected by the sequence animation simultaneously. Although you can create keyframes for the Custom option, it’s not required to affect the sequence. As shown in the following images, the Object and All options allow you to sequence the animation through the origin or build style of the pattern, or through all pattern elements simultaneously.

However, custom lets you define an area of elements—based on percentage—that are affected by the sequence.
When you choose Custom from the Unit Size pop-up menu, the Start and End parameters (described below) become available.

- **Start**: A slider (available when the Unit Size pop-up menu is set to Custom) to specify the offset of the start of the range of elements affected by the sequence animation as it moves over the replicator pattern. In the above image, Start is set to 10%.

- **End**: A slider (available when the Unit Size pop-up menu is set to Custom) to specify the end of the range of elements affected by the sequence animation as it moves over the replicator pattern. By default, End is set to 10%. In the above image, End is set to 30%.

**Note**: If the Sequencing pop-up menu is set to From Keyframes, the Custom option in the Unit Size parameter has no effect.

- **Spread**: A slider to control the amount of falloff of the animation. To create a softer transition between each element, increase the Spread value.

- **Traversal**: A pop-up menu to set the action of the sequence
behavior to one of the following:

- **Constant Speed**: The sequence animation moves from the origin of the replicator pattern through the end of the pattern at a constant speed. The sequence moves in the direction specified in the Replicator Inspector (such as Origin or Build Style).

- **Ease In**: The sequence animation begins slowly and increases to normal speed as it moves through the replicator pattern.

- **Ease Out**: The sequence animation begins at normal speed and slows toward the end of the replicator pattern.

- **Ease In/Out**: The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the duration of the replicator pattern, then slows as it reaches the end of the replicator pattern.

- **Accelerate**: The sequence animation increases in speed.

- **Decelerate**: The sequence animation decreases in speed.

- **Custom**: This option lets you keyframe how the animation moves through the replicator pattern. When the Traversal pop-up menu is set to Custom, the Location parameter replaces the Loops parameter.

- **Location**: A slider (available when Traversal is set to Custom) to define where on the pattern the animation is in effect.

For more information on using the Custom Traversal option, see Control sequence timing with keyframes.

- **Loops**: A slider to set the number of times the animation
sequences through the replicator pattern over its duration.

**Note:** Loops is not available when the Traversal parameter is set to Custom.

- **End Condition:** A pop-up menu that sets how the sequence animation is repeated over the duration of the replicator object. This parameter has no effect for Loop values less than or equal to 1. There are three End Condition options:
  - **Hold:** Completes the sequence animation cycle one time, then starts it again from the beginning (after the last element in the sequence completes its animation).
  - **Wrap:** Treats the sequence animation as a continuous loop so the spread wraps from the last element in the sequence to the first element.
  - **Ping Pong:** Completes the sequence animation cycle forward, then completes the animation backward, then forward, and so on.

**Control sequence timing with keyframes**

When the Traversal parameter in the Sequence Replicator behavior is set to Custom, you can create location keyframes to specify where on the pattern the animation is in effect. Use the Traversal parameter to create a sequence animation that travels through a replicator pattern in a unique way. The following example shows how to use the Custom Traversal option to scale the elements around a circle replicator shape by creating keyframes.
Use keyframes to create custom sequence timing

1. **Add a Sequence Replicator behavior to a replicator**, then, in the Behaviors Inspector, add parameters and set their values. In this example, the Scale parameter is added and the Scale value set to 200%.

![Sequence behavior applied to replicator with Scale parameter set to 200%, Sequencing set to Through, and Spread set to 4](image)

2. Click the Traversal pop-up menu, then choose Custom.

3. Press A to enable keyframe recording, then move the playhead to the frame where you want to begin the animation.

4. In the Behaviors Inspector, drag the Location slider (or use the adjacent value slider) to set where the sequence begins.

As you drag the slider, the sequence moves through the pattern elements. Location values specify (in percentage points) where in the pattern animation is occurring, with 0% representing the origin of the pattern, and 100% representing
the end of the pattern.

A keyframe is added to the Location parameter.

5. Go to the next frame where you want to set a keyframe, the adjust the Location slider.

Another keyframe is added to the Location parameter.

6. Repeat step 5 until you create all your keyframes.

7. Press A again to turn off keyframe recording.

8. Play the project (press the Space bar).

The animation moves through the replicator pattern based on its keyframed locations. In this case, the scale moves erratically back and forth around the circle, rather than in a constant direction.

Use Parameter behaviors with the Sequence Replicator behavior

You can add Parameter behaviors to Sequence Replicator parameters to create even more varied, complex effects without
keyframing. (Parameter behaviors are a special kind of behavior applied to a specific parameter of an object. For more information, see Parameter behaviors overview.)

Apply a Parameter behavior to a Sequence Replicator behavior

1. **Add a Sequence Replicator behavior to a replicator.**

2. In the Layers list or Timeline, select the Sequence Replicator behavior.

3. In the Behaviors Inspector, Control-click the parameter you want to add a Parameter behavior to, then choose a behavior from the Add Parameter Behavior submenu.

   **Note:** You can add a Parameter behavior only to a parameter that has an Animation menu (which appears as a downward arrow when you place the pointer over the right side of a parameter row in the Inspector).

   The Parameter behavior is added and appears above the Sequence Replicator behavior in the Behaviors Inspector. A behavior icon appears in the Animation menu of the Sequence Replicator parameter.
Note: When the Wriggle or Randomize parameter behavior is added to a Sequence Replicator parameter, the Affect Subobjects checkbox becomes available. Select the checkbox if you want each element in the pattern to display a different random behavior.

For more information about applying and adjusting Parameter behaviors, see Add, remove, and disable a Parameter behavior.

Display replicator animation curves in the Keyframe Editor
When you keyframe parameters in the Properties Inspector,
Replicator Inspector, and Replicator Cell Inspector, you can view the resulting keyframe curves in the Keyframe Editor.

Different parameters (and their keyframe curves) appear in the Keyframe Editor depending on which layer you select in the Layers list:

- Select the replicator layer to display animated parameters of the Replicator Inspector, such as Position and Rotation in the Properties Inspector, or Size or Tile Offset (available when the shape is a rectangle).

- Select the cell layer to display animated parameters of the Replicator Cell Inspector, such as Angle or Scale.

For more information, see Keyframing overview.

1. Click the Show Keyframe Editor button in the bottom-right corner of the Motion workspace.

The Keyframe Editor opens in the Timing pane. Make sure the pop-up menu in the top-left corner of the Keyframe Editor is set to Animated.

2. Do one of the following:

   - To display animation curves representing keyframed replicator parameters in the Properties Inspector and Replicator Inspector (Position, Rotation, Size, Tile Offset,
and so on), select a replicator object in the Layers list or Timeline.

- To display animation curves representing keyframed replicator parameters in the Replicator Cell Inspector (Angle, Angle Randomness, and so on), select a replicator cell object in the Layers list or Timeline.

For more information about keyframe curves, see Choose a curve view.

## Work with 3D replicators

Two replicator pattern styles in the Shapes pop-up menu have 3D properties: Box and Sphere. The Box and Sphere shape options are available only when the 3D checkbox is selected in the Replicator Inspector. Box and Sphere replicators build a pattern of elements in 3D space. The 2D Rectangle and Circle replicator shapes have columns (in the Y plane) and rows (in the X plane), but Box and Sphere have an additional Ranks parameter, which adds depth (in Z space) to the replicator.
Although the Rectangle, Circle, Line, Wave, Image, and Geometry replicators have no inherent 3D parameters, as with any other Layer in Motion, they can be moved and rotated in 3D space. Additionally, Line and Wave replicator shapes have quasi-3D properties: Their start and end points can be moved into Z space. In the following image, the Z Start Point and Z End Point have been adjusted to give the replicator depth.

Create a 3D replicator

Box and Sphere replicators build a pattern of elements in 3D space. The 2D Rectangle and Circle replicator shapes have
columns (in the Y plane) and rows (in the X plane), but Box and Sphere have an additional Ranks parameter, which adds depth (in Z space) to the replicator.

1. After adding a replicator to a project, select the 3D checkbox in the Replicator Inspector.

For more information on adding a replicator to a project, see Add a preset replicator or create a custom replicator.

2. In the Replicator Inspector, click the Shape pop-up menu, then choose Box or Sphere.

If your project is not yet 3D, the replicator pattern appears flat.

3. If your project does not contain a camera, click the New Camera button in the toolbar, then click Switch to 3D.

A camera is added to the project, and your layers are converted to 3D layers.

4. In the 3D view tools (in the upper-right corner of the Canvas), drag in the Orbit tool (the center tool).

As the camera rotates, you can see that the replicator cells are aligned in Z space

Tip: Use Simulation behaviors to create animated replicators in 3D space that interact with other objects in the project. For
example, use Orbit Around to make replicator elements circle around a target object. For more information, see Simulation behaviors overview.

Make replicators interact with other objects

When a replicator is a member of a 3D group, certain behaviors can be applied to pull replicator pattern elements out of their X and Y planes.

1. After adding a replicator to a project, select the 3D checkbox in the Replicator Inspector.

   This example uses a burst replicator shape. For more information on adding a replicator to a project, see Add a preset replicator or create a custom replicator.

2. If your project does not contain a camera, click the New Camera button in the toolbar, then click Switch to 3D.

   A camera is added to the project, and your layers are turned into 3D layers.

3. In the Layers list, select an object (a white circle shape in this example), and in the Properties Inspector, click the Position disclosure triangle, then drag in the Z value slider.

   In this example, the white circle’s Z Position is set to 225.

4. In the Layers list, select the replicator, click the Add behavior pop-up menu in the toolbar, then choose Simulations > Attracted To.
No animation occurs until an object is assigned to the Attracted To behavior.

5. With the Attracted To behavior selected in the Layers list, drag the target object (in this example, the white circle) to the Object well in the Behaviors Inspector.

With the default Attracted To settings, the entire replicator moves as one toward the target object.

6. In the Behaviors Inspector, select the Affect Subobjects checkbox.

7. To play the project, press the Space bar.

As the project plays, each replicator element is affected individually, moving forward in Z space toward the attractor. Under the behavior’s influence, the replicator elements move past their attractor element, and return to their original position.

For more information about working in 3D, see 3D compositing overview.
About replicator timing

After you create a replicator, its duration can be as long or short as necessary, regardless of the duration of the original source layers used for the pattern cells. The duration of a replicator is defined by the duration of the replicator timebar in the Timeline track area. Changing the In or Out points of a replicator in the Properties Inspector, Timeline, or mini-Timeline changes the duration of its timebar.

Although the duration of source layers has no affect on the replicator, the duration of each cell affects how long the elements created from that cell are visible in the project. You can change a cell’s duration by dragging its In and Out points in the Timeline. In this way, you can adjust the timing that defines when each cell type appears. For example, to create a pattern in which three types of elements appear at different times in the animation, you can offset the cells in the Timeline. In the following image, the “crosshair” cells appear first. One second later, the “drop” cells appear. One second after that, the “soft circle” cells appear.

Tip: You can animate the opacity of each cell to create a fade-in effect; you do this by keyframing the Opacity parameter in the Replicator or the Replicator Cell Inspector.

For more information on adjusting the timing of layers in the Timeline, see Timeline overview.
About using filters and masks with replicators

You can apply filters or masks to a replicator or to the image sources used to create replicator cells. (However, you cannot apply filters or masks to the replicator cells themselves.)

Filters

When applied to the replicator, a filter affects every element of the replicator pattern. When applied to an image source layer, the effect of a filter is retained when the layer is replicated.

For more information on applying filters to layers in your project, see Filters overview.

Masks

When you apply a mask to an replicator source layer, the effect of the mask is retained when the layer is replicated.
You can also apply a mask to the replicator object itself.

**Note:** Although you cannot apply masks to a 3D replicator, you can apply them to the image source layer used to create a cell in a 3D replicator.

For more information on working with masks, see [Masks and transparency overview](#).

**Save custom replicators to the Library**

After you create a replicator you like, you can save it as a replicator preset in the Replicator or Favorites category of the
Save a custom replicator to the Library

1. Open the Library and select the Replicators, Favorites, or Favorites Menu category.

   **Note:** For organizational purposes, you may find it useful to create a folder of your own in the Favorites or Favorites Menu category to store replicators.

2. From the Layers list or Timeline, drag the replicator to save into the stack at the bottom of the Library.

   The customized replicator is saved as a file on your computer in the `/Users/username/Library/Application Support/Motion/Library/` folder (in the Replicators, Favorites, or Favorites Menu subfolder). Any custom layers created in Motion (such as a shape layer) used to create that replicator are included in the file.

SEE ALSO

Save custom objects to the Library
Move Motion projects, objects, or presets to another computer
Basic text overview

Although trends in type design change, a balanced use of type and graphics remains key to achieving the right effect in commercials, documentaries, title sequences, broadcast logos, corporate presentations, and personal video projects. No matter what style your project requires, Motion provides unique tools for creating dynamic text effects.

It’s easy to add text to a Motion project. Simply select the Text tool in the toolbar, click in the Canvas, and start typing. A new text layer is created (shown in the Canvas, and represented in the Layers list and Timeline), and you can apply various treatments to
Further, you can modify text as a single object or as separate glyphs (characters), applying different effects character by character.

This chapter covers the basics of text creation and modification, including how to:

- Add text
- Select and modify text in the Canvas
- Preview and apply fonts
- Use preset text styles
- Edit text in the Inspector
- Modify text glyphs, adjusting text character by character)

After you add text and format it to your liking, you can begin to create dynamic animation effects (see Animated text overview). You can also create and animate sophisticated 3D text (see 3D text overview).

Add text to a project

Set preferences before you add text

You can set Motion to create text at either the current frame (the frame where the playhead is positioned when you add the text) or at the start of the project. You can also specify a default duration
Set layer creation and duration preferences

1. Choose Motion > Preferences (or press Command-Comma), then click the Project icon.

2. In the Still Images & Layers section of the Project pane, select a Default Layer Duration preference:
   - *Use project duration:* New text layers (and any other new layers you add) run the length of the project. This means that if you’re working in a 300-frame project and you create text, the duration of the text (in the Timeline) is 300 frames.
   - *Use custom duration:* New text layers (and any other new layers you add) run for the duration you enter in the adjacent text field (measured in seconds or frames, depending on the option you choose in the pop-up menu).

3. Select a Create Layers At preference:
   - *Current frame:* New text layers (and any other new layers you add) are created at the current location of the playhead.
   - *Start of project:* New text layers (and any other new layers you add) are created at the beginning of the project, regardless of the playhead location.
Add text
You can add text to a Motion project in a number of ways.

Add basic text in the Canvas

1. In the Layers list, select the group to add a text layer to.

   Note: If no group is selected, the text is added to the last selected group (the underscored group in the Layers list).

2. In the toolbar, click the Text tool (or press T).

3. Click in the Canvas.

   The insertion point flashes in the Canvas. Before you enter text, an empty text layer is added to the project and the Text HUD appears.

   Note: If the HUD does not appear, press F7 or click the Show HUD button in the toolbar.
4. Optional: Choose font formatting options in the Format pane of the Text Inspector or in the HUD.

You can choose a font type, size, alignment, and more.

5. Enter text.

As you type, the following occurs:

- The text appears in the Canvas.
- The mini-Timeline and the text layer in the Layers list are labeled using the characters you type.
- The same text appears in the track bars of the group and layer in the Timeline.
Note: By default, the text layout method (adjustable in the Layout pane of the Text Inspector) is set to Type. The Type layout option creates no right margin. Therefore, if you enter a long string of text, the characters extend on a single line beyond the edge of the Canvas until you create a manual line break (by pressing Return). The Type layout mode is useful when you’re working with short strings of text and also when animating horizontal scrolling effects in the Canvas. For information on changing text layout and setting margins, see “Add paragraph-style text with margins that wrap,” below.

6. When you finish typing, do one of the following:

   - Press Esc.
   - Press Command-Return.
   - Click the Select/Transform tool in the toolbar.

   The text is selected and appears with a bounding box in the Canvas; and the Select/Transform tool is selected.

Important: After you finish typing, press Esc or select another tool on the toolbar—do not use a keyboard shortcut. When the Text tool is selected, typing a keyboard shortcut (other than Esc) adds text to the Canvas.
Add paragraph-style text with margins that wrap

When the Text tool is selected, clicking in the Canvas prompts basic text entry; dragging in the Canvas activates paragraph-style text entry. Paragraph-style text is contained within margins that cause the text you type to wrap to the next line. You can adjust the margins of the paragraph to create a column of text as narrow or as wide as you like.

1. In the toolbar, click the Text tool (or press T).

2. Drag in the Canvas.

When you release the mouse button, a custom paragraph-style text entry field appears in the Canvas. The field enclosed within a bounding box representing margins. A ruler appears above the bounding box. In the Layout pane of the Text Inspector, the Layout Method pop-up menu is set to Paragraph.
3. Begin typing at the flashing insertion point.

Text automatically wraps to the next line when you reach the right margin (the right side of the bounding box).

**Note:** You can also type paragraph text in the Text editor field of the Format pane (in the Text Inspector).

4. When you finish typing, press Esc or Command-Return.

5. To adjust the margins, drag a handle on the bounding box.

When text extends beyond the upper and lower edges of the text-entry field, a scroll control appears on the right side of the text-entry field.

For more information about text margins, see Create and
Add text from the Inspector

After you add a blank text object to your project (by selecting the Text tool and clicking in the Canvas), you can enter and edit text in the Text editor of the Inspector, rather than in the Canvas. The Text editor, located at the bottom of the Text Inspector’s Format pane, is useful when working with large amounts of text.

1. Click the Text tool (or press T), then click or drag in the Canvas to create a blank text object.
   - If you click in the Canvas, you activate the default layout method (Type), which requires that you insert manual line breaks (by pressing Return) to make text wrap to a new line.
   - If you drag in the Canvas, you activate the Paragraph layout method, which wraps text into a column.

2. In the Text Inspector, click Format to open the Format pane.

3. Optional: Choose font formatting options in the Format pane.
   You can choose a font type, size, alignment, and more.

4. Click in the Text editor at the bottom of the Format pane, then begin typing.
Note: To resize the Text editor, drag the three small gray circles along the bottom edge of the text field.

Import a text file

You can add plain text (TXT) or Rich Text Format (RTF) to a Motion
project. After you add a text file, you can edit its content the same way you edit Motion-created text. The appearance (font, size, layout, and so on) of the text imported from an RTF file is preserved (although some formatting options available in RTF files, such as text wrapping, are not supported in Motion); the text appearance in a TXT file is based on the settings in the Motion Text Inspector.

For more information about importing text files, see About TXT and RTF files.

1. In the File Browser, select the TXT or RTF file you want to use.

2. Do one of the following:
   - Drag the file to the Canvas, Layers list, or Timeline.
   - Click the Import button in the preview area of the File Browser.

The text is added to the project and can be modified.

**Note:** Alternatively, you can import a text file using the File > Import command.

---

**Copy and paste text from another application**

You can copy text from another document or browser and paste the text into a Motion project.

1. Open the text document (an RTF, TXT, Pages, or other text file) in a text-editing application.
2. Select and copy the text.

3. In the Motion toolbar, select the Text tool, click in the Canvas, then do one of the following:
   - Choose Edit > Paste (or press Command-V).
   - In the Format pane of the Text Inspector, click in the Text editor, then choose Edit > Paste (or press Command-V).

Consider the following guidelines when pasting text from another application into Motion:

- Pasted RTF text retains the original font attributes, including family and typeface, size, color, outline, and drop shadow.
- When pasted, pure black text is converted to white text.
- White text copied from Motion is pasted to the clipboard as black text.
- Text pasted into an empty text-entry field in the Canvas or into the Text editor (in the Format pane of the Text Inspector) retains its original paragraph format, including alignment, justification, and tabs.
- Text pasted into existing text in the Canvas or in the Text editor does not retain its original paragraph format.
- If an image is copied with the text, the image is not included when the text is pasted in Motion.
- Dynamically numbered lists are not supported. Lists become standard text when pasted.
About TXT and RTF files

When you add a TXT file to a project, the following occurs:

- The text is formatted based on the settings in the Text Inspector.
- The Layout Method (in the Layout pane of the Text Inspector) is set to Paragraph.

**Note:** To change the layout of the text, choose another option from the Layout Method pop-up menu. The ruler and scroll controls become available in the Paragraph and Scroll layouts. The scroll control becomes available in the Crawl layout.
- The paragraph margins are set to the Safe Zones of the project. (Press the Apostrophe key to turn Safe Zones on and off.)

When you add an RTF file to a project, the following occurs:

- The formatting of the text (font, style, line spacing, outline, and other styles set in the text editing application) is preserved in the project.
- The Layout Method (in the Layout pane of the Text Inspector) is set to Paragraph.
- Margins in the original text file are preserved in the Canvas.
- When you double click the imported text in the Canvas, a paragraph-style text-entry field becomes active, displaying the following in the Canvas:
  - An adjustable bounding box representing the margins of the text
  - A ruler at the top of the bounding box
Select and modify text in the Canvas

After you add text to Motion, you can select and edit text directly in the Canvas. To select text characters for modification, use the Text tool.

To select text as an object, use the Select/Transform tool.
Select text characters

Do one of the following:

- Select the Text tool in the toolbar, then drag within the text object in the Canvas.

  If you don’t begin the drag within a text object, a new text object is created.

- Select the Text tool in the toolbar, lick between two text characters in the Canvas, hold down the Shift key, then press the Right Arrow key or the Left Arrow key to select characters.

- Click the Select/Transform tool in the toolbar, then double-click text in the Canvas.

- In the Layer’s list, select a text layer, then in the Text editor (at the bottom of the Text Inspector’s Format pane), drag within or double-click text.

Move the text insertion point

With the Text tool selected, click text in the Canvas, then do any of the following:

- **Move the text insertion point**: Press the Right Arrow or Left Arrow key.

- **Jump to the beginning of a text line**: Press Command–Left Arrow.
- **Jump to the end of a text line**: Press Command–Right Arrow.

- **Jump to the beginning of the word**: Press Option–Left Arrow.

- **Jump to the end of the word**: Press Option–Right Arrow.

- **Move the insertion point through multiple lines of text (for a single text object)**: Press the Up Arrow key or the Down Arrow key.

---

**Replace or modify text**

- Select text in the Canvas, then begin typing.

  The selected text is replaced by the new text.

---

**Delete a word**

In the Canvas, do one of the following:

- Double-click a word, then press Delete.

- Click at the end of a word, then press Option-Delete.

---

**Preview and apply fonts**

You can choose a font before you enter text, or just start typing text and then modify the font later. You can preview available
fonts in the Library. You can apply fonts from the Library, from the Format pane of the Text Inspector, or from the HUD.

Motion uses supported fonts (OpenType, Type 1 or PostScript, and TrueType) located in the following folders on your computer:

- `/Library/Fonts/
- `/Users/username/Library/Fonts/

For information on installing fonts, see Mac Help (in the Finder, choose Help > Mac Help).

---

**Find a font in the Library**

You can find specific fonts in the Library.

Do one of the following:

- Select any font name or thumbnail in the font stack of the Library, then quickly type the first two letters of font name you want.

  The font you seek is highlighted in the stack.

- Click the magnifying glass icon at the bottom of the Library, then type the name of the font in the Search field.

  Only fonts containing the search term appear in the stack.

---

**Preview fonts in the Library**
1. In the Library, click the Fonts category.

2. Click the font subcategory to preview available fonts.

   **Note:** The first subcategory, All Fonts, contains all fonts from the other subcategories.

   If you’re in list view, the font list appears in the stack. If you’re in icon view, font thumbnails appear in the stack, as shown in the image below.

3. In the stack, click a font thumbnail or name.

   The font is displayed in the preview area, with the font name and type.

---

**Preview and apply fonts in the Canvas**

If you’ve already added text to your project, you can preview different fonts in the Canvas.

1. Select text in the Canvas, Layers list, or Timeline.

2. In the Format pane of the Text Inspector, click the Font pop-
up menu.

The menu of available fonts opens.

3. Drag the pointer up or down in the menu to preview fonts.

   As you drag through the menu, the text changes in the Canvas.

4. After you choose a font, release the mouse button.

   **Note:** You can also use the wheel of a three-button mouse or a two-finger swipe on a Multi-Touch trackpad to move up and down the menu.

For more information about controls in the Format pane, see [Format controls in the Text Inspector](#)

---

**Preview and apply fonts in the HUD**

1. Select text in the Canvas, Layers list, or Timeline.

2. In the HUD (press F7 if it’s not already open), click the Font pop-up menu.
The menu of available fonts opens.

3. Drag the pointer up or down in the menu to preview fonts.
   As you drag through the menu, the text changes in the Canvas.

4. After you choose a font, release the mouse button.

   **Note:** You can also use the wheel of a three-button mouse or a two-finger swipe on a Multi-Touch trackpad to move up and down the menu.

---

**Change the font of text in your project by dragging a font type to the Canvas**

1. In the Library, click the Fonts category, then click a font subcategory.

2. Drag a font from the Library stack onto the existing text in the Canvas.
As you drag the font over the text, a transparent thumbnail of the font appears and the pointer becomes a green add pointer (+). When you release the mouse button, the text is changed to the selected font.

Change the font of text in your project using the Apply button

1. In the Canvas, Layers list, or Timeline, select a text layer to modify.

2. In the Library, click the Fonts category, then click a font subcategory.
3. In the stack, click a font.

4. In the preview area, click Apply.

The text is changed to the selected font.

Use preset text styles

The Motion Library contains preset 2D and 3D text styles that you can apply to text. A text style is a group of Appearance parameters that are modified and saved in the Library. For example, the Neon text style applies a rounded font style and includes a gradient outline simulating the bright glow of an electrified glass tube filled with neon gas. You can apply these presets from the Library or from the Text Inspector.

You can also customize and save your own text style or format (or both) in the Library. See Save a custom text style.
Apply a preset text style from the Library

1. In the Library, select the Text Styles category.

2. Select the 2D Styles or 3D Styles category, then select a style from the stack.
3. Do one of the following:
   - Select the text in the Canvas, then click the Apply button in the preview area.
   - Drag the style from the stack to text in the Canvas, Layers list, or Timeline.

   The text style is applied to the text. If you applied a 3D style, the text is extruded and becomes 3D text (the 3D Text checkbox is selected in the Appearance pane of the Text Inspector). For more information, see 3D text overview.

Apply a preset text style from the Text Inspector

1. Select text in the Canvas, Layers list, or Timeline.

2. In the Appearance pane or Format pane of the Text Inspector, click the preset pop-up menu and choose an item from the 2D Styles or 3D Styles categories.
The text style is applied to the text. If you applied a 3D text style, the text is extruded and becomes 3D text (the 3D Text checkbox is selected in the Appearance pane of the Text Inspector). For more information, see 3D text overview.

Apply a preset text style from the HUD

1. Select text in the Canvas, Layers list, or Timeline.

2. In the HUD (press F7 if it’s not already open), click the preset pop-up menu (below the Blend Mode pop-up menu) and choose an item from the 2D Styles or 3D Styles categories.
The text style is applied to the text. If you applied a 3D text style, the text is extruded and becomes 3D text (the 3D Text checkbox is selected in the Appearance pane of the Text Inspector). For more information, see 3D text overview.

Edit text in the Inspector

Text Inspector overview

You can perform advanced text editing tasks in the Text Inspector.

The Text Inspector is divided into three subpanes:

- **Format**: Contains controls for adjusting basic text parameters such as font, size, alignment, line spacing, tracking, and kerning. See Display the Format pane of the Text Inspector.

- **Appearance**: Contains controls for adjusting visual text styles, including opacity, blur, color, outline, glow, and drop shadows. See Display the Appearance pane of the Text Inspector.

- **Layout**: Contains controls for adjusting text arrangement settings such as margins, tabs, scrolling, word wrapping, and text on a path. Display the Layout pane of the Text Inspector.

Many of the controls in the Text Inspector are also available in the HUD.

If a text parameter can be animated, moving the pointer over the right side of the parameter’s row in the Inspector displays the Add Keyframe button and the Animation menu. Click either to access
keyframe and animation controls. For more information, see Keyframe controls in the Inspector and Animation menu.

To reset a parameter to its default settings (including removing keyframes), choose Reset Parameter from the parameter’s Animation menu. To reset a group of parameters, such as the text Face controls or the Sequence controls of a text behavior, click the reset button in the Inspector.

Note: For parameters with no default setting (including most parameters in the Format and Layout panes), there is no reset button.
Display the Text Inspector or Text HUD

Open the Text Inspector to access advanced parameter controls that adjust text format, appearance, and layout. Some of these controls are also available in the Text HUD.

Display the Text Inspector

1. Select text in the Canvas, Layers list, or Timeline.

2. Do one of the following:
   - Click Inspector (in the upper-left corner of the Motion workspace), then click Text.
   - Choose Window > Inspector.
   - Click the “i” button on the HUD.
   - Press Command-3.

Display the Text HUD

1. Select text in the Canvas, Layers list, or Timeline.

2. Press F7 or D.

Edit text format

Display the Format pane of the Text...
The Format pane of the Text Inspector contains controls for adjusting basic text attributes such as font, typeface, size, kerning, and character rotation. Many Format parameters can be animated (keyframed). For information about common formatting tasks, see Format text. For a list of all Format pane controls, see Format controls in the Text Inspector.

Show the Format pane

- In the Text Inspector, click Format.
The following tasks are useful when editing text format, including changing fonts, moving the text insertion point, and adjusting kerning. For a complete list of available controls, see Format text controls in the Text Inspector.
Resize text

Do any of the following:

- **Change font size**: Drag the Size slider in the Basic Formatting controls.

- **Scale the text**: Drag the Scale slider in the Advanced Formatting controls.

Click the disclosure triangle to reveal separate X and Y Scale controls.

**Note**: To scale the text as a layer, select text, then drag a scale handle in the Canvas.

Rotate or shear text

In the Advanced Formatting controls, do any of the following:

- **Rotate text characters**: Adjust the Rotation dial.

  Click the disclosure triangle to expose separate X, Y, and Z Rotation controls.

- **Shear text characters**: Drag the Slant slider.

Kern text characters
1. In the toolbar, click the Text tool (or press T).

2. In the Canvas, position the insertion point (click the mouse button) between the characters to kern, then do one of the following:
   - In the Format pane of the Text Inspector, drag the Kerning slider or adjacent value slider to set a kerning value.
   - Press Option–Command–Right Bracket (]) to increase the space between characters by one-pixel increments.
   - Press Option–Command–Left Bracket ([) to reduce the space between characters by one-pixel increments.

Format controls in the Text Inspector
The parameter controls in the Format pane of the Text Inspector
allow for common text adjustments.

**Basic Formatting controls**

- *Preset*: An unlabeled pop-up menu at the top of the Format pane, used to apply preset text styles from the Library to text in your project. You can also use this pop-up menu to save format settings (and appearance settings from the Appearance pane) of text in your project. The default menu item is Normal.

For more information on applying and saving text styles, see Use preset text styles.

- *Collection*: A pop-up menu to filter the font categories available in the Font pop-up menu. When set to All Fonts, every font installed on your OS X system appears in the Font pop-up menu.

- *Font*: A pop-up menu to choose a font for selected text.

- *Typeface*: An unlabeled pop-up menu (to the right of the Font pop-up menu) to choose a type style, such as Regular, Bold, Condensed, and so on. The available typefaces are specific to the font family selected in the Font pop-up menu.

- *Size*: A slider to set the point size of the text. The slider is constrained to a maximum of 288 points. To create larger text, drag to the right over the numeric value, or click the value, type a new number, then press Return.
Note: You can also scale text in the Canvas using onscreen controls, but doing so scales text as an object independently of type point size.

- **Alignment**: Buttons to set the alignment and justification of text.
- **Vertical Alignment**: Buttons to set the vertical alignment of text.
- **Line Spacing**: A slider to set the distance between each line of text (leading) in point-size increments.

**Tip**: To modify the spacing for individual lines of text when hard returns are present, select text with the Text tool, then adjust the Line Spacing slider. Spacing is modified on the line that includes the selected text.

- **Tracking**: A slider to set the spacing between text characters, applying a uniform value between each character.
- **Kerning**: A slider to adjust spacing between text characters.
- **Baseline**: A slider to adjust the baseline of text characters (an invisible horizontal line defining the bottom alignment of characters).

**Advanced Formatting controls**

- **Scale**: A slider to resize text characters proportionally. To drag up or right to increase value beyond default maximum, or click and type a number.
- **Scale**: A slider to resize text characters proportionally. To scale in only X or Y space, click the disclosure triangle to set separate X and Y scale values.

- **Affects Layout**: A checkbox (available when the Scale parameter is disclosed) to set how scaling affects text on a path. (For information about text paths, see [Create and modify text on a path](#).) For example, when Affects Layout is deselected and text is on an open spline path (and Wrap Around is deselected in the Layout pane), increasing the Scale parameter causes text characters to bunch up along the length of the path. When Affects Layout is selected, increasing scale extends text characters beyond the path; decreasing scale bunches up characters toward their set alignment (left, right, or center).

- **Offset**: Value sliders to offset text from its original position (anchor point). Click the disclosure triangle to access separate X, Y, and Z position values.

- **Rotation**: A dial to rotate text characters in Z space. Click the
disclosure triangle to access separate X, Y, and Z rotation controls and also the Animate pop-up menu.

- **Animate**: A pop-up menu (available when the Rotation parameter is disclosed) to change the interpolation for animated 3D rotation channels. There are two menu options:
  
  - **Use Rotation**: The default interpolation method, whereby text characters rotate from their start rotation to their final rotation. Depending on the animation, the characters may twist before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Rotation parameters are animated from 0 degrees to 180 degrees in a project, the text characters rotate on all axes before reaching their final orientation.
  
  - **Use Orientation**: This method provides smoother interpolation but does not allow multiple revolutions; interpolates between the text characters’ start orientation (first keyframe) and their end orientation (second keyframe).

For more information about the Animate parameter, see Properties Inspector controls.

**Note**: You must keyframe the Rotation parameter for the Animate parameter options have an effect.

- **Slant**: A slider to simulate italics by adding a slant value to text characters.

- **Monospace**: A checkbox that, when selected, applies a fixed amount of space between each text character.

- **All Caps**: A checkbox to make text characters uppercase.
• *All Caps Size:* A slider (available when the All Caps checkbox is selected) to set the size of uppercase characters based on a percentage of the font point size.

• *Editable in FCP:* A checkbox that, when selected, allows editing of text strings, text size, and text tracking in templates published to Final Cut Pro X.

For more information on publishing to Final Cut Pro, see Final Cut Pro templates overview.

Text editor

• *Text:* A text field (the darker shaded area) to add and edit text in your project from the Inspector. For more information, see Add text.

Edit text appearance

Display the Appearance pane of the Text Inspector

The Appearance pane of the Text Inspector contains controls for adjusting visual text styles, including color, outlines, glow effects, and drop shadows. You can animate most of these parameters.

In the Appearance pane, you can also apply preset text styles from the Library to text in your project—modified Appearance parameters that create a specific look for text, such as a red glow and gradient face. You can also create custom text styles and save them to the Library. For more information, see Use preset
There are several groups of controls in the Appearance pane:

- **Face controls**
- **Outline controls**
- **Glow controls**
- **Drop shadow controls**

When you select 3D text, two additional groups of controls become available in the Appearance pane:

- **3D Text controls** (For more information, see [3D Text controls](#).)
- **Lighting controls** (For more information see [Lighting and environment controls](#).)

You can enable or disable a group of style controls by selecting or deselecting the activation checkbox to the left of the group header. (When selected, the checkbox turns blue.) By default, Outline, Glow, and Drop Shadow are deselected.
Show the Appearance pane

- In the Text Inspector, click Appearance.

Modify text color

In the Appearance pane of the Text Inspector or in the HUD, you can change the color of text using standard color controls.
Note: To adjust individual color channels, you must use the Appearance pane of the Text Inspector.

You can also apply a gradient to text, from the Appearance pane or from the Library.

Set text color in the Inspector

1. Select text in the Layers list, Canvas, or Timeline.

2. In the Appearance pane of the Text Inspector, make sure that the “Fill with” pop-up menu is set to Color.

3. Do one of the following:
   - Click the color well, then use the Colors window to set the text color.
   - Click the downward arrow to the right of the color well (or Control-click the color well), then click in the pop-up color palette to select a color. Drag in the lower palette to set the color to a grayscale color.
Click the eyedropper tool to the right of the Color well, then click a color in the Canvas.

In the Inspector, click the Color disclosure triangle to show the color channel parameters, then use the sliders or value sliders to adjust each color channel.

Set text color in the HUD

1. Select text in the Canvas, Layers list, or Timeline.

2. In the HUD (if it’s not displayed, press F7 or D) click the color well, then choose a text color in the Colors window.
The text is dynamically updated as you select a color.

**Note:** To select a color from the Canvas (or anything on the desktop), click the color picker in the Colors window, position the picker over the color you want to select, then click again.

---

**Apply a text gradient**

In the Inspector, you can apply a gradient fill to text, then customize or animate the gradient in the Gradient editor. For general information about working with gradients, see [Gradient editor controls](#).
Like preset text styles from the Library, preset gradients can be applied to text. Gradient presets are located in the Gradients category of the Library. A custom gradient that you apply to text can also be saved in the Library for use in future projects.

1. Select text in the Canvas, Layers list, or Timeline.

2. In the Appearance pane of the Text Inspector, click the “Fill with” pop-up menu, then choose Gradient.

   In the Inspector, the Color controls are replaced with the Gradient editor. The default gradient is white and blue (Atlantic Blue).

   ![Gradient Editor](image)

   In the Canvas, the default gradient is applied to the text.

---

**Apply a preset text gradient**
1. Select the text and make sure the “Fill with” pop-up menu is set to Gradient in the Appearance pane of the Text Inspector.

2. Click the Gradient preset pop-up menu (on the right side of the Gradient row), then choose a preset gradient.

The selected gradient is applied to the text.

Apply a preset gradient from the Library

1. In the Library, click the Gradients category.

2. In the stack, select a gradient.

   A preview of the selected gradient appears in the preview area.
3. Do one of the following:

- Drag the gradient to text in the Canvas, Layers list, or Timeline.

- Make sure text is selected in the Canvas, Layers list, or Timeline, then click Apply in the preview area.

The gradient is applied to the text.
Modify text opacity

There are several ways to change the opacity of text:

- To change the overall opacity of a text object, use the Opacity slider in the Properties Inspector or HUD.

- To change the opacity of an appearance parameter such as Face, Glow, Drop Shadow, or Outline, use the respective Opacity controls in the Appearance pane of the Text Inspector.

**Note:** The Opacity parameter in the Properties Inspector and the Opacity parameter in the Appearance pane of the Text Inspector are separate controls. When you adjust both for a text object, the effect is multiplicative. In other words, if Opacity is set to 50% in the Properties Inspector and then set to 50% in the Appearance pane, the resulting opacity for the text is 25%.

Set text opacity in the Properties Inspector

1. Select text in the Canvas, Layers list, or Timeline.
2. Open the Properties Inspector.
3. In the Blending controls, drag the Opacity slider or enter an opacity value in the field.
Set text opacity in the Appearance pane of the Text Inspector

1. Select text in the Canvas, Layers list, or Timeline.
2. Open the Appearance pane of the Text Inspector.
3. In the Face controls, drag the Opacity slider or enter an opacity value in the field.

Set text opacity in the HUD

1. Select the text in the Canvas, Layers list, or Timeline.
2. Press F7 or D to display the HUD.
3. Drag the Opacity slider.
   
   Text opacity is updated as you drag the slider.
The Opacity parameter in the Properties Inspector (not in the Text Appearance pane) is also updated.

Modify text softness
Use the Blur parameter in the Appearance pane of the Text Inspector to adjust the softness of text.

Adjust text softness in the Inspector

1. Select text in the Canvas, Layers list, or Timeline.
2. Open the Appearance pane of the Text Inspector.
3. In the Face controls, drag the Blur slider, or enter a blur
amount in the value slider.

The text softness is updated as you drag the slider.

Use an image as a texture fill for text

Use the Texture image well to apply, replace, and remove textures.

Apply a texture fill to text

1. Select the text.

2. In the Text Inspector, click Appearance to open the Appearance pane.

3. Choose Texture from the “Fill with” pop-up menu.

   The Color (or Gradient) controls are replaced with the Texture controls.
By default, no texture is applied to the text.

4. Drag an image from the Layers list or Media list into the Image well.

**Important:** When dragging an image to the well, be sure to click and drag in one movement. If you click the image and release the mouse button, the image is selected and its Inspector appears.

The image appears in the well and is applied to the text.

**Tip:** When text is filled with an image, the texture is applied to each text character. To learn how to make the texture continuous through all text characters, see Image masks overview.

---

**Replace a texture fill**

1. Select the text.

2. Drag an image from the Layers list or Media list into the Image well.
well in the Appearance pane of the Text Inspector.

The new image appears in the well and is applied to the text.

**Note:** When an image (or a movie clip) is replaced in the Layers list or Media list and that image is used as a texture source, the texture for the text is replaced with the new image.

---

**Remove a texture fill**

In the Appearance pane of the Text Inspector, do one of the following:

- Click the Texture parameter reset button.

- Drag the image out of the well, then release the mouse button.

The image disappears.

---

**Change the position of a texture fill**
In the Texture controls group in the Appearance pane of the Text Inspector, do one of the following:

- Press Command, then drag in the Image well.
  
The image moves in the well and is offset in the text in the Canvas.

- Adjust the Offset value sliders.
  
The left value slider represents X position values; the right value slider represents Y position values.

**Note:** You can adjust the position of a texture for a single glyph by selecting the glyph with the Text tool or by using the Transform Glyph tool. For more information on working with glyphs, see [Text glyphs overview](#).

---

**Animate a texture fill using keyframe recording**

You can set keyframes for the offset values of the texture source to create a moving element within text. In the following example, an image of a leopard lying in the grass is used as the texture source for the text “leopard.”
1. Apply a texture to the text.

   For instructions on how to apply a texture to text, see “Apply a texture to text,” above.

2. Move the playhead to the frame where you want the texture animation to begin.

3. To enable keyframe recording, click the Record button in the transport controls under the Canvas, or press A.

   **Note:** When keyframe recording is enabled, a keyframe is created for any change you make to an object in your project.

4. To position the texture, do one of the following in the Texture controls in the Appearance pane of the Text Inspector:
   - Holding down the Command key, drag in the Image well.
   - Adjust the Offset value sliders.

   The image within the text moves, and a keyframe is
5. Move the playhead to the next frame where you want to set a keyframe.

6. Repeat step 4 to move the texture to a new position.

7. Press A or click the Record button to turn off keyframe recording.

8. Move the playhead to frame 1 (or the start frame of the animation) and press the Space bar to play back the clip.

The texture offset is animated.
Animate a texture fill by manually adding a keyframe

1. Apply a texture to the text.

   For instructions on how to apply a texture to text, see “Apply a texture to text,” above.

2. Move the playhead to the frame where you want the texture animation to begin.

3. In the Appearance pane of the Text Inspector, click the Animation menu for the Offset parameter (the downward arrow appears when you move the pointer over the end of the parameter row), then choose Add Keyframe.

4. To position the texture, do one of the following:
   - Press Command, then drag in the Image well.
   - Use the Offset value sliders to enter an offset value.
     The image within the text moves, and a keyframe is created in the Offset parameters.

5. Move the playhead to the next frame where you want to set a keyframe.

6. Repeat step 4 to move the texture to a new position.

   A keyframe is added.

Note: After a parameter contains a keyframe, any further
adjustment to that parameter adds a keyframe at the current playhead position, regardless of the Record button state.

7. Move the playhead to frame 1 (or the start frame of the animation) and play the clip.

The texture offset is animated.

**Note:** When you use an object with applied filters or behaviors as a texture source for text, the effect of filters is inherited by the texture. However, behaviors are ignored.

---

Add a text outline, glow, or drop shadow

Use the parameter controls in the Outline, Glow, and Drop Shadow areas of the Appearance pane of the Text Inspector to add a text outline, glow, or drop shadow effect to text.

---

Create an outline for text

1. Select text in the Canvas, Layers list, or Timeline.

2. In the Text Inspector, click Appearance to open the Appearance pane.

3. In the Outline controls, select the Outline checkbox.

When selected, the Outline checkbox turns blue and the
Outline controls become available. A red default outline with a width of one point is added to the selected text in the Canvas.

Tip: Deselect the Face checkbox in the Appearance pane to display a text outline with no fill.

Create a glow for text

1. Select the text in the Canvas, Layers list, or Timeline.

2. In the Text Inspector, click Appearance to open the Appearance pane.

3. In the Glow controls, select the Glow activation checkbox.

When selected, the Glow checkbox turns blue and the Glow controls become available. A default yellow glow (with Scale and Opacity set to 100%, and Radius set to 0) is applied to the selected text in the Canvas.
Tip: Deselect the Face parameter activation checkbox (and other active parameters) to display only the text glow.

Add a drop shadow

1. Select text in the Canvas, Layers list, or Timeline.

2. In the Text Inspector, click Appearance to open the Appearance pane.

3. In the Drop Shadow controls, select the Drop Shadow checkbox.

When selected, the Drop Shadow checkbox turns blue, and the Glow controls become available. A default black drop shadow is applied to the text.
Appearance controls in the Text Inspector

3D Text controls in the Appearance pane

When you select 2D text in your project, the 3D Text controls in the Appearance pane remain dimmed. To activate the 3D Text controls and convert selected text to extruded 3D text, click activation checkbox in the header row of this section. (When selected the activation checkbox turns blue.)

For more information about creating and editing 3D text, see 3D text overview. For a detailed description of 3D Text controls in the Appearance pane, see 3D Text controls.

![3D Text controls in the Appearance pane](image)

Face controls in the Appearance pane

Use the Face controls in the Appearance pane of the Text Inspector to specify whether text is a solid color, a color gradient, or a texture.

The Face controls are not available for 3D text.
**Note:** You can distort the Face parameters of text independently of other Appearance parameters. For more information, see *Spatially distort a glyph using onscreen controls*.

- **Preset:** An unlabeled pop-up menu at the top of the Appearance pane (above the 3D Text controls) to save the format, style, or format and style of the text to the Library, or to apply a preset text style from the Library to the text. The default menu item is Normal.

  For more information on applying and saving text styles, see *Use preset text styles*.

- **Face:** An activation checkbox to enable or disable all Face parameters (Fill, Color, Opacity, Blur, and Four Corner). This checkbox is selected by default (highlighted blue).

- **Fill with:** A pop-up menu to set text fill to Color, Gradient, or Texture.

- **Color/Gradient/Texture:** Color controls to set the text fill color, gradient, or texture. These controls vary depending on the “Fill with” setting (described above). Click the disclosure triangle to reveal additional controls. For more information about the color and gradient controls, see *Modify text color*.

When the “Fill with” pop-up menu is set to Texture, the following controls become available:
- **Image**: An image well to set a texture source (an image, movie clip, or other object). See Use an image as a texture fill for text.

- **Frame**: A slider (available when the Image well contains a movie or image sequence) to specify a start frame for the texture.

- **Hold Frame**: A checkbox (available when the Image well contains a movie or image sequence) that, when selected, uses the frame specified by the Frame slider (described above). The selected frame is used as the texture for the text object’s total duration.

- **Offset**: Value sliders to specify the X and Y values of the position of the source texture (relative to the text object). If the object applied to the image well is visible in your project, adjusting the Offset parameter does not reposition the object.

- **Wrap Mode**: A pop-up menu to specify how the edge of a texture is treated when the texture is offset and appears cut off in the text, or when it’s too small to fill the text it’s
applied to. There are three options:

- **None**: The texture remains transparent beyond the edge of the source image.

- **Repeat**: The texture source is repeated beyond the edge of the source image.

- **Mirror**: Beyond the edge of the source image, the texture source is reflected, as in a mirror—duplicated, tiled, and reversed to encompass the full width and height of the text.

- **Opacity**: A slider to set text opacity, regardless of the fill option (Color, Gradient, or Texture).

For more information, see Modify text opacity.

- **Blur**: A slider to set the softness of the text, regardless of the fill option.

- **Four Corner**: Value sliders to control the position of the face attribute and distort the text characters. In the following illustration, the Four Corner parameter in the Face controls has been modified (but the Four Corner parameter for the red outline has not been modified).

Click the disclosure triangle to reveal the following value sliders:
- **Bottom Left**: Offsets the text fill from the lower left of its original position.

- **Bottom Right**: Offsets the text fill from the lower right of its original position.

- **Top Right**: Offsets the text fill from the upper right of its original position.

- **Top Left**: Offsets the text fill from the upper left of its original position.

**Note**: You can also adjust the Four Corner parameters using onscreen controls. See [Transform glyph controls in the Text HUD](#).

---

### Outline controls in the Appearance pane

Use the Outline controls in the Appearance pane of the Text Inspector to create text outlines. You can change the fill of the outline, as well as its opacity, softness, width, and layer order.

The Outline controls are not available for 3D text.

**Note**: You can distort text outlines independently of other Appearance parameters. For more information, see [Spatially distort a glyph using onscreen controls](#).
Outline: An activation checkbox to enable or disable all Outline parameters. This checkbox is deselected by default.

Fill with: A pop-up menu to set the fill for the outline. As with the Face controls, you can set the outline fill to Color, Gradient, or Texture.

The Outline fill controls—Color, Gradient, and Texture—are equivalent to the Face controls. For information on using these controls, see Face controls in the Appearance pane.

Color/Gradient/Texture: Color controls to set the color, gradient, or texture of the text outline, depending on which item is selected in the “Fill with” pop-up menu. Click the disclosure triangle to adjust additional parameters.

Opacity: A slider to set the opacity of the text outline.

Blur: A slider to set the softness of the text outline.

Width: A slider to set the thickness of the text outline.

Layer Order: A pop-up menu to set whether the outline is drawn over or under the text face.

Four Corner: Value sliders to control the position of the outline attribute, allowing for outline distorting effects. Click the disclosure triangle to reveal the value sliders:

- Bottom Left: Offsets the text outline from the lower left of
its original position.

- **Bottom Right:** Offsets the text outline from the lower right of its original position.

- **Top Right:** Offsets the text outline from the upper right of its original position.

- **Top Left:** Offsets the text outline from the upper left of its original position.

**Note:** You can also adjust the Four Corner parameters using onscreen controls. See [Transform glyph controls in the Text HUD](#).

## Glow controls in the Appearance pane

Use the Glow controls in the Appearance pane of the Text Inspector to create a glow in front of or behind text. Except for Layer Order, all Glow parameters can be animated.

**Note:** You can distort the glow of text independently of other Appearance parameters. For more information, see [Spatially distort a glyph using onscreen controls](#).

- **Glow:** An activation checkbox to enable or disable glow
parameters in this group. This checkbox is deselected by default.

**Note:** When the Glow activation checkbox is selected, the text is rasterized. For more information, see Groups and rasterization.

- **Fill with:** A pop-up menu to set the fill for the glow. As with the Face and Outline controls, you can set the glow fill to Color, Gradient, or Texture.

The Glow “Fill with” options—Color, Gradient, and Texture—are equivalent to the Face controls. For information on using these controls, see Face controls in the Appearance pane.

- **Color/Gradient/Texture:** Color controls to set the color, gradient, or texture of the glow effect. Click the disclosure triangle to adjust additional parameters.

- **Opacity:** A slider to set the opacity of the text glow.

- **Blur:** A slider to set the softness of the text glow. To ensure that the glow is visible, set the Blur value above 0.

- **Radius:** A slider to set the circumference of the glow.

- **Scale:** A slider to set the size of the glow.

- **Offset:** Value sliders to offset the glow in the X or Y position.

- **Layer Order:** A pop-up menu to specify whether the glow is drawn over or under the text face.

- **Four Corner:** Value sliders to control the position of the glow attribute, allowing for glow distorting effects. Click the disclosure triangle to reveal the value sliders:
  - **Bottom Left:** Offsets the text glow from the lower left of its
original position.

- **Bottom Right:** Offsets the text glow from the lower right of its original position.

- **Top Right:** Offsets the text glow from the upper right of its original position.

- **Top Left:** Offsets the text glow from the upper left of its original position.

**Note:** You can also adjust the Four Corner parameters using onscreen controls. See Transform glyph controls in the Text HUD.

Drop Shadow controls in the Appearance pane

Use the Drop Shadow controls to create a shadow behind text, and to adjust the shadow color, opacity, offset from the text object, softness, and angle. All Drop Shadow parameters can be animated.

- **Drop Shadow:** An activation checkbox to enable or disable the drop shadow effect. This checkbox is deselected by default.

**Note:** When the Flatten checkbox is selected in the Layout
pane of the Text Inspector, additional Drop Shadow controls appear in the Properties Inspector. Drop Shadow controls in the Properties Inspector are independent of the controls in the Text Inspector. Enabling Drop Shadow in both locations adds to the existing shadow.

- **Fill with:** A pop-up menu to set the fill for the shadow. As with the Face, Outline, and Glow controls, you can set the shadow fill to Color, Gradient, or Texture.

The Shadow “Fill with” options are equivalent to the Face controls. For information on using these controls, see Face controls in the Appearance pane.

- **Color/Gradient/Texture:** Color controls to set the color, gradient, or texture of the shadow. Click the disclosure triangle to adjust additional parameters.

- **Opacity:** A slider to set the opacity of the text shadow.

- **Blur:** A slider to set the softness of the text shadow.

- **Scale:** A slider to set the size of the shadow.

- **Distance:** A slider to specify the offset of the text shadow.

- **Angle:** A dial to set the angle (or direction) of the drop shadow.

- **Fixed Source:** A checkbox that, when selected, makes the drop shadow behave as if cast by a fixed light source, regardless of camera or text movement.

- **Four Corner:** Value sliders to control the position of the drop shadow attribute, allowing for outline distorting effects. Click the disclosure triangle to reveal the value sliders:
  - **Bottom Left:** Offsets the text drop shadow from the lower left of its original position.
- **Bottom Right:** Offsets the text drop shadow from the lower right of its original position.
- **Top Right:** Offsets the text drop shadow from the upper right of its original position.
- **Top Left:** Offsets the text drop shadow from the upper left of its original position.

**Note:** You can also adjust the Four Corner parameters using onscreen controls. See [Transform glyph controls in the Text HUD](#).

### Save a custom text style

After you modify parameters in the Appearance pane (such as Gradient or Glow) or Format pane (such as Tracking or Slant), you can save the style you create to the Text Styles category in the Library. These custom styles can then be used and applied like preset styles.

**Note:** Custom presets saved to the Library are stored in the `/Users/username/Library/Application Support/Motion/Library/Text Styles/` folder.

### Save a modified text style to the Library

1. Select the text with the modified parameters you want to save as a style.
2. In the Appearance pane or Format pane of the Text Inspector,
open the Preset pop-up menu (at the top of the pane) and choose any of the following:

- **Save Format Attributes**: Saves only Format pane parameters.
- **Save Appearance Attributes**: Saves only the Appearance pane parameters.
- **Save All Format and Appearance Attributes**: Saves parameters from both the Appearance and Format panes.

3. In the Save Preset To Library dialog, enter the name for the preset.

![Save Preset To Library dialog]

4. Click Save.

The custom preset is saved to the Text Styles category in the Library. Custom presets can be identified in the Library by the small user badge that appears in the lower-right corner of the text style icon.

---

**Edit text layout**

**Display the Layout pane of the Text Inspector**
Use the Layout pane of the Text Inspector to create text on a path, to set direction and rendering options, to add a typewriter effect, and more.

There are seven groups of controls in the Layout pane:

- Layout controls
- Text Rendering controls
- Behavior controls
- Type On controls
- Path Options controls
- Margins controls
- Tabs controls

**Show the Text Layout pane**

- In the Text Inspector, click Layout.
Create text on a path

Create and modify text on a path

The Path layout method lets you place text on a baseline path that you can warp to create curving or angular trails of text. After you create text on a path, you can modify or extend the path, add or remove control points, or animate text on the path. See Animate text on a path.
You can always edit text on a path, changing text characters or fonts, tracking, and kerning, as well as Appearance pane settings.

**Note:** The Text tool must be selected to view and edit the text path.

---

**Create text on a path**

1. Select the text in the Canvas, Layers list, or Timeline.

2. In the Layout pane of the Text Inspector, click the Layout Method pop-up menu, then choose Path.

   The Path Options controls become available, near the bottom of the Layout pane.

3. Select the Text tool in the toolbar (or press T) and click the text in the Canvas.

   Step 3 is important—the Text tool must be selected to view or edit the text path.

   The path appears below the text. The default path shape is a straight line (an open spline) and contains three control points.
Adjust the text path in the Canvas

- With the Text tool selected, drag a path control point to change the shape of the path.

Extend a text path in the Canvas

When you add additional text characters to text on a path, you may need to extend the default path, by dragging it in the Canvas.
With the Text tool selected, drag the last control point of the text path toward the end of the text.

Tip: When dragging, press Shift to constrain the path to a straight line.

After you extend a path, you can add control points to further manipulate the shape of the path, as described in the next task.

Add, modify, or remove control points from a text path in the Canvas

Do any of the following:
Add a control point: Option-click or double-click the text path.

**Note:** If nothing happens, make sure the Path Shape pop-up menu (in the Path Options group of controls in the Layout pane) is set to Open Spline or Closed Spline.

Remove a control point: Select a point on the text path, then press Delete.

You can also Control-click the point, then choose Delete Point from the shortcut menu.

Create a linear point: Control-click a point on the text path, then choose Linear from the shortcut menu.

Create a smooth (Bezier) point: Control-click a point on the text path, then choose Smooth from the shortcut menu.

When Path Type is set to B-Spline (in the Path Options group of controls in the Layout pane), the Very Smooth option becomes available in the shortcut menu.

Lock a point: Control-click a point on the text path, then choose Lock Point from the shortcut menu.

A locked point cannot be edited.

Unlock a point: Control-click a point on the text path, then choose Unlock Point from the shortcut menu.

Text paths are modified in the same way as shape control points. For complete information, see *Shapes, masks, and paint strokes overview*. 
Note: Clicking any path control point and holding down the mouse button displays the point number (based on the order the points are drawn on the path) and X, Y, and Z coordinates in the status bar (above the Canvas). Path control points are also listed by number in the Path Options group of controls in the Layout pane of the Text Inspector.

SEE ALSO
Path Options controls in the Layout pane

Modify a text path in 3D space
You can manipulate a spline text path to make text extend through 3D space.

Adjust the text path in 3D space

1. If there’s no scene camera in the project, add a camera by doing one of the following:
   - Click the Add Camera button in the toolbar.
   - Choose Object > New Camera (or press Option-Command-C).

Note: If any of your scene objects are using 3D visuals,
**Note:** If none of your project groups is set to 3D, a dialog appears asking you if you want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera to affect the groups.

2. To change the default camera view to Top, do one of the following:
   - Click “Active Camera” in the upper-left corner of the Canvas to open the Camera pop-up menu, then choose Top.
   - Choose View > 3D View > Top.

   The text is no longer visible because the camera is now looking down perpendicularly (along the Y axis) at the text on a path. The text path and its points are still visible. (The yellow wireframe camera icon in the Canvas represents the scene camera you added in step 1.)

   The text path onscreen controls are available for all camera views. This example uses the Top view.

3. With the Text tool and text layer selected, drag a control point to adjust the text path in X, Y, or Z space.

   Manipulating text on a path in 3D space only works when Path Shape is set to Open Spline or Closed Spline (in the Path Options controls in the Layout pane).
If the path selection disappears, reselect the text layer in the Layers list. To enter values for the control point locations for Open Spline or Closed Spline, click the Control Points disclosure triangle in the Path Options group of the Layout pane. The first value slider is X, the second value slider is Y, and the third value slider is Z.

4. To change the camera view, choose another camera view from the Camera pop-up menu in the upper-left corner of the Canvas.

5. To reset the camera view, do one of the following:
   - Click the Camera pop-up menu, then choose Active
Camera.

- Choose View > 3D View > Active.

**Tip:** When working with text in a 3D project (especially text that moves close to the camera), before exporting, set the Render Quality to Best (choose View > Quality > Best). Best mode dramatically slows project performance and interactivity, so you might want to set the Render Quality to Normal while working. You can also set the Render Quality on export using the pop-up menus in the Render pane of the Export window.

---

Isolate a group or layer to modify text on a 3D path

When working with text on a 3D path, type may become difficult to read depending on its orientation and distance from the camera. To edit the text, you can snap the text object to its original face-forward orientation using the Isolate button in the Layers list (or Timeline) or the Isolate command in the Object menu.

**Note:** The Isolate command is available only for selected objects.

Do one of the following:

- In the Layers list (or Timeline), click the Isolate button.
Control-click the layer or group, then choose Isolate from the shortcut menu.

Choose Object > Isolate.

Click the Isolate button again to return to your previous view.

**Note:** Clicking a camera’s Isolate button activates that camera’s view.

SEE ALSO

Path Options controls in the Layout pane

Use a geometry shape for a path source
The following section describes how to use a shape as the source for a text path.

Use geometry for a text path source

1. Import (or draw) the shape you want to use as the path
2. In the Layout pane of the Text Inspector, set the text Layout Method to path, then choose Geometry from the Path Shape pop-up menu. The Shape Source well appears in the Inspector.

3. From the Layers list, drag the shape to the Shape Source well.

4. When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and the shape is used as the source shape for the text path.
**Note:** You might want to disable the source shape in the Layers list so it’s not visible in your project.

---

**Select another geometry source for a text path shape**

- In the Layout pane of the Text Inspector, click the To pop-up menu (located next to the Shape Source image well) and choose an object to use as the text path’s shape source. All shapes or masks in the project appear in the pop-up menu.

---

**SEE ALSO**

Path Options controls in the Layout pane

---

Animate text on a path

You can animate text so that it moves across the text path.
**Animate text on a path**

1. Create the path for the text to travel along.

   See *Create and modify text on a path*.

2. Move the playhead to the frame where you want to begin the animation, then press A to enable keyframe recording.

3. In the Layout pane of the Text Inspector, adjust the Path Offset slider (or the adjacent value slider) to the amount you want to move the text on the path.

   A keyframe is added to the Path Offset parameter.

   A positive value moves the text toward the right, and a negative value moves the text toward the left. You can enter values greater than 100% or less than 0% in the value slider.
A value greater than 100% moves the text completely off the path to the right; a value less than 0% moves the text off the path to the left. In the following image, the Path Offset is set to 105%, so the text is completely off the right end of the text path.

4. Go to the frame where you want to place the next keyframe.

5. Adjust the Path Offset slider or value slider to reposition the text on the path.

6. Play the project to see the text travel along the text path.

7. Press A again to disable keyframe recording.

SEE ALSO

Path Options controls in the Layout pane

Work with margins and tabs

Create and adjust text margins

You can create a custom margin using the Margins controls in the
For information on creating text with margins in the Canvas, see Add text.

Create text margins in the Inspector

1. Select the Text tool in the toolbar, click in the Canvas, then enter some text.

   When the Text tool is selected, clicking in the Canvas (without dragging) creates a blank text layer with the Layout Method set to Type.

2. In the Layout pane of the Text Inspector, set Layout Method to Paragraph.

3. In the Margins section of the Layout pane, adjust the sliders to set the left, right, top, and bottom margins.

4. Press Esc or click the Select/Transform tool to exit text-editing mode.

Adjust text margins without scaling the text

When you add paragraph-style text with adjustable margins (or import a text file from another application) you can resize the margins of the text-entry field in the Canvas without affecting the scale of the text. (For information about adding paragraph-style
With the Text tool selected, Layout Method set to Paragraph in the Layout pane, and a text layer selected, do one of the following:

- In the Canvas, drag a text-entry field’s onscreen scale handle.

**Note:** Do not use the Select/Transform tool to resize text margins. When you exit text-entry mode (by pressing Esc or selecting a tool from the toolbar), a standard object bounding box appears around the text. If you resize standard a text bounding box (by dragging one of its scale handles), the text is resized, not just the width of the bounding box.

- In the Layout pane of the Text Inspector, adjust the Margins controls.
Note: When text is deleted from a paragraph, the paragraph margins remain in their original locations.

SEE ALSO
Layout controls in the Layout pane
Add, remove, and modify tabs

Motion allows paragraph-formatted text to contain an unlimited number of tabs to control word spacing in text. By default, text created in Motion has no tabs. Adding, moving, and removing tabs is done in the Canvas—but you can also move tabs by modifying their values in the Inspector. When you import a Rich Text Format (RTF) file, tabs in the RTF file are retained in the Motion project and appear in the Tabs section of the Layout pane.

There are four types of tabs:

- **Left tab:** Aligns the left edge of the text with the tab.
- **Right tab:** Aligns the right edge of the text with the tab.
- **Center tab:** Aligns the center of the text with the tab.
- **Decimal tab:** Aligns decimal points in numbers on multiple lines.

---

Add a tab

1. In the Layout pane of the Text Inspector, make sure Paragraph (or Scroll) is selected in the Layout Method pop-up menu.

2. Double-click the text in the Canvas to display the paragraph onscreen controls.
3. In the ruler above the text-entry field in the Canvas, do one of the following:

- Click to add a left tab.
- Double-click to add a center tab.
- Control-click and choose a tab type from the shortcut menu.

When you add a tab, its black icon appears in the ruler.

![Diagram of ruler with tabs]

Change a tab type in the Canvas

- Double-click a tab icon in the ruler.

  The tabs cycle through the right, center, left, and decimal types.

Change a tab type in the Inspector

- In the Tabs section of the Layout pane of the Text Inspector, click the Tab type pop-up menu, then choose an option.

  The tabs icon is updated in the ruler in the Canvas.
Move the tabs

1. Double-click the text in the Canvas to display the paragraph onscreen controls.

   **Note:** The Text tool must be selected for the ruler and tabs to appear in the Canvas.

2. Do one of the following:
   - In the Canvas, drag a tab (the small black icon) in the ruler.
   - In the Layout pane of the Text Inspector, use the Tabs controls to adjust the position and layout of the tabs.
     The affected text is repositioned to the tab.

Remove a tab

1. Double-click the text in the Canvas to display the paragraph onscreen controls.

   **Note:** The Text tool must be selected for the ruler and tabs to appear in the Canvas.

2. Drag the tab (the small black icon) away from the ruler and release the mouse button.

   The tab is removed from the ruler in the Tabs controls in the Layout pane of the Text Inspector.
Layout controls in the Text Inspector

Use the Layout controls to set basic layout options for a text object:

- **Layout Method**: A pop-up menu to set any of five kinds of text layouts:
  - **Type**: The default method, creates a single line of text. As text is added, the string of text continues off the Canvas. (If you need text to wrap to multiple lines, use the Paragraph layout method instead, described below.)
  - **Paragraph**: Creates text with margins and line wrapping. When Layout Method is set to Paragraph, Margins controls become available in the lower area of the Layout pane. Double-click the text in the Canvas when Layout Method is set to Paragraph to display a ruler and scroll control around the text-entry field. When you delete text from a paragraph text-entry field, paragraph margins do not scale. For information on modifying or creating a paragraph, see Add text.
  - **Path**: Creates text on a path and makes the Path Options controls available. The path can be an open or closed spline, a circle, a rectangle, a wave, or based on a geometry shape. See Create and modify text on a path.
  - **Scroll**: Positions the margins of the text-entry field to match...
the project’s safe zones in preparation for a scrolling animation. Double-click the text in the Canvas to display a ruler and an enhanced scroll control showing a preview of the text. Drag in the scroll bar to navigate through large amounts of text. Scroll does not animate the text—text is only positioned and formatted in preparation for you to create scrolling animation using keyframes or behaviors. For more information on animating text, see Animated text overview. When Layout Method is set to Scroll, the following occurs: The Transform Glyph tool is not available; the Offset, Rotation, and Affects Layout controls in the Format pane are not available; and the text is flattened, so the Flatten, Render Text, and Face Camera controls are not available. (For more information, see the Flatten checkbox description in Text Rendering controls in the Layout pane.)

- **Crawl:** Positions the text in a single string (within project safe zones) along the bottom of the project in preparation for a crawl or ticker-type animation. Double-click the text in the Canvas to display a scroll control below the text-entry field. Crawl does not animate the text—text is only positioned and formatted in preparation for you to create an animation using keyframes or behaviors. For more information on animating text, see Animated text overview. When Layout Method is set to Crawl, the following occurs: Tabs are not available; the Transform Glyph tool is not available; the Offset, Rotation, and Affects Layout controls in the Format pane are not available; and the text is flattened. As a result, the Flatten, Render Text, and Face Camera controls are not available. (For more information, see the Flatten checkbox description in Text Rendering controls in the Layout pane.)
• **Direction:** A pop-up menu to set the direction for the flow of letters. Choose Horizontal or Vertical.

• **Auto-Shrink:** A pop-up menu (available when Layout Method is set to Paragraph, Scroll, or Crawl) to change the vertical or horizontal scale of selected letters to ensure that text fits within the margins of the text object. Choose one of the following options:
  
  • **Off:** No scaling occurs. Text exceeding the width or height of the text object extends beyond the visible edges of the screen for scrolling or crawling text, or wraps to the next line for paragraph text.
  
  • **Left And Right:** Scaling occurs at the left and right margins of the text object. This setting is primarily used with scrolling text, to ensure that no characters are cut off. However, it can be applied to other text objects.
  
  • **Top And Bottom:** Scaling occurs at the top and bottom margins of the text object. This setting is primarily used for crawling text, to ensure that no characters are cut off. However, it can be applied to other text objects.
  
  • **To All Margins:** Scaling occurs at the left, right, top, and bottom margins of the text object.

• **Crop At Margins:** A checkbox that, when selected, crops text that extends past the margins of the text object. This control is disabled when Auto-Shrink (described above) is enabled.

**Note:** For Crop At Margins to be active, Layout Method must be set to Paragraph, and the text object must be flattened. For more information about flattening text, see [Text Rendering controls in the Layout pane](#).
Text Rendering controls in the Layout pane

Use the Text Rendering controls to set how text objects are displayed in 3D layers:

- **Flatten**: A checkbox that, when selected, forces text characters to remain in a 2D plane. In 3D groups, text characters on a path may be influenced by behaviors in ways that interfere with linear alignment. For instance, a simulation behavior might pull nearby text characters out of their plane. When Flatten is selected, the text can still interact with other objects in 3D space, but only as a flattened image, like a card.

![Unflattened text on a 3D path can weave through other elements in a project.](image)

After you select Flatten, the text characters no longer move in 3D space.
Make sure to select the Flatten checkbox when you want:

- Text to receive reflections. If the Flatten checkbox is not selected, the Reflections parameter does not appear in the Properties Inspector. For more information on using reflections, see Cast a reflection.

- To use the 2D transform tools in the toolbar (Select/Transform, Anchor Point, Distort, Drop Shadow, Four Corner, and Crop).

- To apply a mask to text. The mask tools in the toolbar are not available when Flatten is deselected.

**Note:** When a text object rotated in Z space is flattened, text that is farther from the camera (farther away in Z space) appears smaller. For more information, see About 2D and 3D group properties.

- **Render Text:** A pop-up menu to choose a text-rendering method. This control is not available when the Flatten checkbox is selected, or when Scroll or Crawl is selected from the Layout Method pop-up menu. There are two menu items:
  - *In Global 3D (Better)*: Allows text to intersect with objects in the text group and with objects in other groups. When
working with a camera, allows text in 3D space to be affected by the camera’s Depth of Field settings (text outside the camera range of focus is blurred). When this option is enabled, project performance and interactivity may slow.

For text to cast shadows and to be affected by depth of field settings, In Global 3D (Better) must be enabled. For more information on using shadows, see Shadows overview. For more information on using depth of field, see Depth of field overview.

- **In Local 3D (Faster):** Renders text more quickly, but does not allow for intersections with objects in the text group or with objects in other groups, nor does it allow text to cast shadows.

- **Face Camera:** A checkbox that, when selected, forces text characters to face the camera, even when the camera is rotated or the text is rotated. This checkbox is not available when the Flatten checkbox is selected (because text cannot face the camera and flatten to the text plane at the same time). Additionally, this setting is not available when Scroll or Crawl is selected from the Layout Method pop-up menu (because those layout methods cause text to flatten).

**Note:** Because basic text characters are 2D (flat) objects, text may not be visible when you use orthogonal reference camera views, such as Left, Right, and Top (unless the text object or characters are rotated in 3D space). This is because orthogonal views are at right angles (perpendicular) to objects in the Canvas. For more information on using cameras, see Add a camera.
Behavior controls in the Layout pane

Use the Behavior controls to adjust how a text object is treated when behaviors are applied, based on the position of the text object’s anchor points:

- **Anchor Point:** A pop-up menu to specify how anchor points are assigned: by character, word, line, or as a single object. For example, when you rotate text using the Format pane of the Text Inspector or by applying a text sequence behavior, the effect varies depending on the type of anchor point you’ve assigned. When Anchor Point is set to All, the text rotates as a single object; when Anchor Point is set to Character, each glyph rotates independently. To see a visual representation of the anchor point, select the text with the Transform Glyph tool. For more information on the Transform Glyph tool, see Text glyphs overview.

Note: The anchor point specified in the Layout pane is not the same as the anchor point for the object. Object anchor point controls are available in the Properties Inspector and via the...
Anchor Point tool in the toolbar. For more information on adjusting the anchor point of an object, see Move a layer’s anchor point.

The Anchor Point pop-up menu has four options:

- **Character**: Rotates each character as if each glyph has its own anchor point.
- **Word**: Rotates each word as if each word has its own anchor point.
- **Line**: Rotates each line as if individual lines had their own anchor points.
- **All**: Rotates all text as a single object.

- **Anchor Position**: A pop-up menu to specify the per-glyph anchor point position. To see a visual representation of the anchor point, select the text with the Transform Glyph tool. For more information on the Transform Glyph tool, see Text glyphs overview.

The Anchor Position pop-up menu has five options:

- **Baseline**: Positions the anchor point at the baseline (default).
- **Center**: Positions the anchor point at the depth center and vertical center of the character, word, or line of text.
- **Typographic Center**: Positions the anchor point at the depth center and typographic center (the midpoint between ascender and descender heights).
- **Top Center**: Positions the anchor point at the depth center and the top of the character, word, or line of text.
- **Left Center**: Positions the anchor point on the Y axis at the...
- Left Center: Positions the anchor point on the Y axis at the depth center and the left of the character, word, or line of text.

- Right Center: Positions the anchor point on the Y axis at the depth center and the right of the character, word, or line of text.

- Position: Value sliders to define the position of the anchor point specified in the Anchor Point pop-up menu. Click the disclosure triangle to display individual X, Y, and Z value sliders. To see a visual representation of the anchor point, select the text with the Transform Glyph tool. For more information on the Transform Glyph tool, see Text glyphs overview.

Type On controls in the Layout pane

Use the Type On controls to create a type-on effect, similar to a typewriter-style animation. You can keyframe the type-on effect to occur forward or backward, or to move in both directions.

**Note:** There’s also a Text Animation behavior called Type On that creates a forward type-on effect without setting keyframes. For more information on using that behavior, see Use the Type On behavior.

- **Start:** A slider to set the start point of the type-on effect (from the left side of the text). When set to the default 0%, the text is fully “typed on.” When set to 100%, the text is fully “typed off.” If the value animates from 0 to 100 over time, the text types off from left to right. If the value animates from 100 to 0, the text types on from right to left.

- **End:** A slider to set the end point of the type-on effect (from
End:
The slider to set the end point of the type-on effect (from the right side) of the text. When set to the default 100%, the text is fully “typed on.” When set to 0%, the text is fully “typed off.” If the value animates from 100 to 0 over time, the text types off from right to left. If the value animates from 0 to 100, the text types on from left to right.

- **Fade In:** A checkbox that, when selected, causes text characters to fade on or off. When Fade In is deselected, the text characters pop on as they appear.

Path Options controls in the Layout pane

Use the Path Options controls to specify the initial shape of a text path, and to modify the path and text on that path. This group is only active when the Layout Method pop-up menu at the top of the Layout pane is set to Path. For more information about creating a text path, see [Create and modify text on a path](#).

The Transform Glyph tool can be used with text on a path. For more information, see [Text glyphs overview](#).

- **Path Shape:** A pop-up menu to set the shape of the path. Choosing different shapes will cause different controls to appear (described below). There are six menu options:
  - **Open Spline:** The default shape, a straight path defined by one point at the beginning and one point at the end of the path. You can work with Bezier or B-Spline control points. Option-click (or double-click) on the path to add points.
  - **Closed Spline:** A closed path where the last point is in the same location as the first point. You can use Bezier or B-Spline control points. Option-click (or double-click) on the path to add points.
• Circle: A simplified version of Closed Spline, in which the X radius or Y radius can be adjusted to create a circle or an ellipse.

• Rectangle: A closed path where the width and the height can be adjusted to create a square or a rectangle.

• Wave: A wavy path (a sine wave) defined by one point at the beginning and one point at the end, and controlled by the End Point, Amplitude, Frequency, Phase, and Damping parameters.

• Geometry: A shape path where the object travels along the edge of a shape or mask. An animated shape can be used as the text path source—for example, a circle shape with an applied Oscillate Shape behavior.

• Path Type: A pop-up menu (available when Path Shape is set to Open Spline or Closed Spline) to choose how to manipulate the shape of the path. There are two menu choices:

  • Bezier: Lets you manipulate the keyframe curve by dragging Bezier tangent handles. For more information about creating and adjusting Bezier curves, see Edit Bezier control points.

  • B-Spline: Lets you manipulate the keyframe curve by dragging B-Spline points. B-Splines are manipulated using points—there are no tangent handles. The points themselves do not lie on the surface of the shape. Instead, each B-Spline control point is offset from the shape’s surface, “magnetically” pulling that section of the shape toward itself to create a curve. B-Splines are extremely smooth: By default, there are no sharp angles in B-Spline shapes, although you can create sharper curves, if
necessary. For more information about working with B-Spline curves, see Edit B-Spline control points.

- **Radius:** A slider (available when Path Shape is set to Circle) to change the size of the circular path. Click the disclosure triangle to adjust the X radius and Y radius.

  **Note:** When the Text tool is selected, you can also use onscreen control points to resize the circle. Press Shift to resize the X and Y radii uniformly.

- **Size:** A slider (available when Path Shape is set to Rectangle) to change the size of the rectangular path. Click the disclosure triangle to adjust the X scale and Y scale.

  **Note:** When the Text tool is selected, you can also use onscreen control points to resize the rectangle. Press Shift to resize the X and Y scales uniformly.

- **Start Point:** Value sliders (available when Path Shape is set to Wave) to set the location of the start point on the wave’s path. The left value slider sets the X coordinate of the start point. The right value slider sets the Y coordinate of the start point. The start point can also be adjusted using the wave’s onscreen controls (active by default when the Text tool is selected).

- **End Point:** Value sliders (available when Path Shape is set to Wave) to set the location of the end point on the path. The left value slider sets the X coordinate of the end point. The right value slider sets the Y coordinate of the end point. The end point can also be adjusted using the wave’s onscreen controls (active by default when the Text tool is selected).

- **Amplitude:** A slider (available when Path Shape is set to Wave) to define half the distance from the highest point to the lowest
point in the wave. Higher values result in more extreme waves.

- **Frequency**: A slider (available when Path Shape is set to Wave) to set the number of waves. Higher values result in more waves.

- **Phase**: A dial (available when Path Shape is set to Wave) to define the percentage of the offset of the waves from the start and end points of the path. When set to 0% (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When set to 90%, the wave begins and ends at the highest point in the wave. When set to –90%, the wave begins at the lowest point in the wave. When set to 180%, the waves are the same as 0%, but inverted.

- **Damping**: A value slider (available when Path Shape is set to Wave) to progressively diminish the oscillation of the wave. Positive damping values diminish the wave forward (from left to right). Negative values diminish the wave backward (from right to left).

- **Shape Source**: An image well (available when Path Shape is set to Geometry) to define the object (shape or mask) used as the motion path source.

- **To**: A pop-up menu (available when Path Shape is set to Geometry) to choose an object in the project to be used as a shape source for the motion path.

- **Attach to Shape**: A checkbox (available when Path Shape is set to Geometry) that, when selected, forces the motion path to follow the source shape at the shape’s original location. When Attach to Shape is deselected, the motion path can be offset from its source shape (by dragging the shape object to
a new location in the Canvas). To learn how to use spline objects as a text path source shape, see Use a geometry shape for a path source.

**Note:** When Attach to Shape is selected, you cannot drag the shape object to another location.

- **Path Offset:** A slider to set where text begins on the path. Animate this value to move text along a path. At 0%, the first text character is at the left end of the path; at 100%, the first character is at the right end of the path.

- **Wrap Around:** A checkbox (available when Path Shape is set to Open Spline or Wave) that, when selected, wraps text from the end of the path to the first point of the path. Wrap Around is selected by default.

- **Inside Path:** A checkbox that, when selected, shifts the baseline of text on a loop path so the text appears inside the loop.

- **Align to Path:** A checkbox that, when selected, aligns the text to the shape of the path. When the checkbox is deselected, text characters align vertically, regardless of the shape of the path.

- **Control Points:** Value sliders (available when Path Shape is set to Open Spline or Closed Spline) to adjust the X, Y, and Z coordinates of the control points.

**SEE ALSO**

Create and modify text on a path

Margins controls in the Layout pane
Margins controls in the Layout pane

Use the Margins controls—available when the Layout Method is set to Paragraph, Scroll, or Crawl—to set the size and location of text margins.

When a text file is imported into Motion, its margin and tab information is retained in the Motion project. The Layout Method (in the Layout pane of the Text Inspector) for the imported text is set to Paragraph. By default, text created in Motion is set to Type, creating one string of text until you enter a line break. To create columns with tabs or to use margins with text created in Motion, you must set the Layout Method (in the Layout pane of the Text Inspector) to Paragraph or Scroll.

There are several ways to create and adjust text margins, including using onscreen controls and controls in the Layout pane in the Text Inspector. You can set a margin for text before you create it.
• **Left Margin, Right Margin, Top Margin, and Bottom Margin:** Sliders (available when Layout Method is set to Paragraph, Scroll, or Crawl) to define the text margins in the Canvas.

**SEE ALSO**

Create and adjust text margins
Add, remove, and modify tabs

**Tabs controls in the Layout pane**

Motion allows paragraph-formatted text to contain an unlimited number of tabs to control word spacing in text. By default, text created in Motion has no tabs, so there are no controls in the
Tabs section of the Layout pane. Adding, moving, and removing tabs is done in the Canvas. You can also move tabs by modifying their values in the Inspector. When you import a Rich Text Format (RTF) file, tabs in the RTF file are retained in the Motion project and appear in the Tabs section of the Layout pane.

- **Tab 0, 1, 2, and so on**: A list of tabs in the selected paragraph, including their type and positions.

- **Tab type pop-up menu**: An unlabeled pop-up menu (the up-and-down arrows) to set the tab to Left, Center, Right, or Decimal (aligns decimal points in numbers on multiple
• **Tab value slider:** An unlabeled value slider (the numeric value) to adjust the position of the tab.

You can add, move, and remove tabs in the Canvas. For more information, see Add, remove, and modify tabs.

### Work with text glyphs

#### Text glyphs overview

**Glyphs** are the individual characters in a text layer—the letters, numbers, or symbols. In Motion, you can select and then modify or animate individual glyphs independently of the word, line, or paragraph of which they are a member. Using glyph transform handles, you can drag in the Canvas to spatially transform several glyph attributes, including position, rotation, scale, face (fill), outline, glow, or drop shadow. And using controls in the Inspector, you can modify many other text attributes, including fill color, outline color, font, font size, slant, and so on.

You modify glyphs by selecting the Transform Glyph tool (in the toolbar), selecting the glyphs you want to transform in the Canvas, and then either adjusting controls in the Inspector or dragging handles in the Canvas.

To animate glyphs, see Animate individual text glyphs.

### Select characters with the Transform
Glyph tool

Before you can transform a glyph, you must select it using the Transform Glyph tool in the toolbar. You can select a single glyph or multiple glyphs in a text layer. When more than one glyph is selected, the last Shift-selected glyph is enclosed in a bounding box with transform handles. This is known as the *focused glyph*. Each of the other glyphs in the selection are enclosed in a bounding box without transform handles. Any selected glyph (focused or not) is affected by transforms applied to the focused glyph.

**Note:** If you use the Transform Glyph tool to distort an appearance attribute of a glyph (Face, Outline, Glow, Drop Shadow), only one glyph can be selected at a time.

---

Select a single glyph

1. Select a text layer.

2. Click and hold the 2D transform tools in the toolbar, then choose the Transform Glyph tool.
A bounding box with transform handles appears around the first glyph in the text. (Or, if a different glyph was previously selected, the bounding box surrounds that glyph).

3. If you want to select a different glyph in the text layer, click another glyph in the Canvas.

Select all glyphs in a text layer

1. Select a text layer.

2. Click and hold the 2D transform tools in the toolbar, then choose the Transform Glyph tool.
Ensure that the Attribute pop-up menu in the HUD is set to Transform Glyph (because the other settings in the menu allow only one glyph selection at a time).

A glyph is selected in the Canvas.

3. Choose Edit > Select All (or press Command-A).

   All glyphs are selected.

---

**Select multiple glyphs in a text layer**

1. Select a text layer.

2. Click the 2D transform tools in the toolbar, then choose the Transform Glyph tool from the pop-up menu.
Ensure that the Attribute pop-up menu in the HUD is set to Transform Glyph (because the other settings in the menu allow only one glyph selection at a time).

A glyph is selected in the Canvas

3. Do one of the following:

- **Select contiguous glyphs**: Holding down the Shift key, click in the Canvas to select additional adjacent glyphs; or drag in the Canvas to select adjacent glyphs.

- **Select noncontiguous glyphs**: Holding down the Command key, click to select nonadjacent glyphs.
Although the onscreen controls appear only around the focused (last selected) glyph, any glyph surrounded by a box is affected when you adjust the onscreen controls.

**Deselect a group of selected glyphs**

- Choose Edit > Deselect All (or press Shift-Command-A).

  Any previously selected glyphs are deselected.

**Select a glyph in another text layer**

- With an active Transform Glyph tool selection, click a different text layer in the Layers list or Timeline.

  The selection shifts to the second text layer.

**Modify a glyph in the Inspector or HUD**

You can modify nearly any attribute of a selected glyph by adjusting controls in the Text Inspector or Text HUD.

1. Select a text layer.

2. Click and hold the 2D transform tools in the toolbar, then choose the Transform Glyph tool from the pop-up menu.
A glyph is selected in the Canvas. To select a different glyph, click another glyph in the Canvas. For information about selecting multiple glyphs, see Select characters with the Transform Glyph tool.

3. In the Text Inspector or Text HUD, adjust any available parameter control.

**Note:** If the Text HUD is not visible, choose Window > Show HUD (or press F7).

---

Spatially distort a glyph using onscreen controls

When you select the Transform Glyph tool, you can spatially adjust glyphs in the Canvas by choosing between two types of onscreen transform controls:

- Handles that adjust scale, position or rotation (identical to 3D...
Handles that adjust scale, position or rotation (Section 4.5 onscreen controls)

- Handles that spatially distort face (fill color), outline, glow, or drop shadow—stretching or shearing one of those attributes

You choose a handle type from the Attribute pop-up menu in the Text HUD.

---

Transform a glyph’s scale, position, or rotation

1. Select a text layer.

2. Click and hold the 2D transform tools in the toolbar, then choose the Transform Glyph tool from the pop-up menu.

A glyph is selected in the Canvas. To select a different glyph, click another glyph in the Canvas. For information about
selecting multiple glyphs, see Select characters with the Transform Glyph tool.

3. In the Text HUD, ensure that the Attribute pop-up menu is set to Transform Glyph.

This setting activates scale, position, and rotation handles in the Canvas.

**Note:** If the HUD is not visible, choose Window > Show HUD (or press F7).

4. Drag a transform handle in the Canvas.

The glyph is modified in the Canvas.

In the Format pane of the Text Inspector, the Scale, Offset, or Rotation parameter is modified simultaneously. (Offset represents a glyph’s position in the Canvas.)

---

**Spatially distort a glyph’s face (fill color), outline, glow, or drop shadow**

1. Select a text layer.

2. Click and hold the 2D transform tools in the toolbar, then choose the Transform Glyph tool from the pop-up menu.
A glyph is selected in the Canvas. To select a different glyph, click another glyph in the Canvas. For information about selecting multiple glyphs, see Select characters with the Transform Glyph tool.

3. In the Text HUD, click the Attribute pop-up menu, then choose one of the following: Face, Outline, Glow, or Drop Shadow.

**Note:** If the HUD is not visible, choose Window > Show HUD (or press F7).

The selected glyph (or the focused glyph, if multiple glyphs are selected) is enclosed by a bounding box with eight handles: four corner handles for distorting, and four middle handles for shearing.
4. Do any of the following:

- **Shear the style attribute**: Drag a middle handle.
- **Distort the style attribute**: Drag a corner handle.

The glyph’s face, outline, glow, or drop shadow is sheared or distorted in the Canvas.

In the Appearance pane of the Text Inspector, the activation checkbox for the attribute you adjusted is selected (highlighted blue) and those controls become available for further adjustment.

---

**Reset glyphs to their original settings**

If you’ve modified a glyph in the Inspector or in the Canvas using transform handles, you can restore the glyph to its original parameters.
Reset a glyph that’s been modified in the Inspector

You can reset transformed glyphs to their original state via the Animation menu.

1. In the Canvas, select a glyph or glyphs that you’ve modified.

   For more information, see Select characters with the Transform Glyph tool.

2. In the Text Inspector, find the parameter that you modified, click its Animation menu (the downward arrow that appears when you move the pointer to the right side of the parameter row), then choose Reset Parameter.

Reset a scaled, offset, or rotated glyph

When you scale, move, or rotate a glyph, the changes are reflected in the Format pane of the Text Inspector, in the Scale, Offset, and Rotation parameter rows. You can reset transformed glyphs to their original state via the Animation menu in those rows.

1. Select a glyph or glyphs that you’ve already scaled, moved, or rotated.

   For more information, see Select characters with the Transform Glyph tool.
2. In the Format pane of the Text Inspector, do any of the following:

- **Restore a glyph to its default scale**: In the Scale parameter row, click the Animation menu (the downward arrow that appears when you move the pointer to the right side of the row), then choose Reset Parameter.

- **Restore a glyph to its default position**: In the Offset parameter row, click the Animation menu (the downward arrow that appears when you move the pointer to the right side of the row), then choose Reset Parameter.

- **Restore a glyph to its default rotation**: In the Rotation parameter row, click the Animation menu (the downward arrow that appears when you move the pointer to the right side of the row), then choose Reset Parameter.

---

**Reset distorted appearance attributes (Face, Outline, Glow, or Drop Shadow)**

When you spatially distort a glyph’s Face, Outline, Glow, or Drop Shadow attribute using onscreen controls, the changes are reflected in the Appearance pane of the Text Inspector, in the Four Corner parameter for that attribute. You can reset distorted
glyphs to their original state using the Four Corner reset button for affected attribute.

1. In the Canvas, select a glyph or glyphs with an appearance attribute that you’ve distorted or sheared.

For more information, see Select characters with the Transform Glyph tool.

2. In the Appearance pane of the Text Inspector, click the reset button (a curved arrow) in the Four Corner parameter for the affected attribute (Face, Outline, Glow, or Drop Shadow).

Transform glyph controls in the Text HUD

When you select the Transform Glyph tool, additional controls become available in the Text HUD.

Note: In addition to text parameters, the Text HUD contains the 3D transform tools, the Adjust Around pop-up menu (see Transform layers in 3D space), and the Attribute pop-up menu (described below).
- **Attribute**: A pop-up menu to specify the glyph attribute to be modified by onscreen transform handles. There are five menu options:
  - **Transform Glyph**: Displays onscreen controls that allow you to scale, move, or rotate the glyph.
  - **Face**: Displays onscreen controls that allow you to spatially distort the face (color fill) of the glyph.
  - **Outline**: Displays onscreen controls that allow you to spatially distort the outline of the glyph.
  - **Glow**: Displays onscreen controls that allow you to spatially distort the glow of the glyph.
  - **Drop Shadow**: Displays onscreen controls that allow you to spatially distort the drop shadow of the glyph.

SEE ALSO
Convert standard text into 3D text

You can convert standard 2D text to 3D text, and vice versa.

In the Appearance pane of the Text Inspector, select the 3D Text activation checkbox (to the left of the 3D Text group header).

When you select the 3D Text checkbox, parameters specific to 3D text become available, and the Face and Outline controls are replaced with the Lighting, Materials, and Options groups of controls. The Glow and Drop Shadow controls remain available.

To convert from 3D text back to 2D text, deselect the 3D Text activation checkbox.

To learn how to create and work with 3D text, see 3D text
You can check the spelling of a text layer in your project via the Text editor.

In the Format pane of the Text Inspector, do one of the following:

- Click in the Text editor, then choose Edit > Spelling and Grammar and choose an option from the submenu.
- Control-click in the Text editor, then choose an item from the shortcut menu.

When a spelling error is found, the text is highlighted in the Text editor. If the Text tool is active when the spelling is checked, the text is also selected in the Canvas.

Find and replace text in your project
The Find and Replace window lets you locate and change a word (or a set of characters) in a Motion project. You can search in a selected text object, or in all text objects. This tool is useful for changes to long-form text objects, such as credit rolls.

1. Choose Edit > Find and Replace (or press Command-F).
   The Find and Replace window appears.

2. In the Find field, enter the text to search for; in the Replace field enter the replacement text.

3. Select an option from the “Search in” pop-up menu:
   - *All Text Objects in Project*: Search all text in your project.
   - *Selected Text Object*: Search text you’ve already selected in your project.

4. Do any of the following:
   - Press Return or click Next to find the text you entered in the Find field:
     **Note**: Select the “Loop search” checkbox to continue searching from the beginning of your project after reaching the end of the text.
   - Click Previous to find the previous occurrence of the text you entered in the Find field.
     Found text is selected in the Canvas.

5. To replace the selected text, do one of the following:
- Click Replace to replace the current selection.
- Click Replace All to replace all occurrences of the Find text.

To replace the current selection and immediately find the next occurrence of the Find text, click Replace & Find.

- Click Replace & Find to replace the current selection and immediately find the next occurrence of the Find text.

**Note:** To undo an operation performed in the Find and Replace window, click in the Canvas to make it active, then choose Edit > Undo Text Replace (or press Command-Z).

---

**About using filters with text**

Filters are applied to text in the same manner as they are to other objects in Motion. This section provides a quick guide to applying filters to text.

When a filter is applied to text, the text is flattened. In the Layout pane of the Text Inspector, the Flatten checkbox is selected and the parameter is disabled. When text is flattened, filters are applied to the text in local space—that is, “flat” to the text.
To deselect the Flatten checkbox when a filter is applied, deselect (or delete) the filter in the Layers list, select the text, then deselect the Flatten checkbox (in the Layout pane of the Text Inspector). If you turn the filter back on (by selecting it), the text is flattened again.

For more information, see Filters overview.

**Note:** Certain operations, such as the application of some filters or selecting the Crop checkbox in the Properties Inspector, can cause a group to be rasterized. For more information, see Text and rasterization.
3D text overview

In addition to basic 2D text, Motion lets you create text objects that appear to have depth, complete with sides, edges, and backs. 3D text in Motion exhibits the same characteristics as real three-dimensional objects, simulating natural lighting and shading effects, and displaying textures.

To get started with 3D text and learn about its powerful features, see 3D text workflow.

For information about creating basic 2D text, see Basic text overview.
For information about animating 2D text and 3D text, Animated text overview.

3D text workflow

Although 3D text can be customized in unlimited ways, you can create impressive-looking 3D text in just a few simple steps.

Stage 1: Create a 3D text object

You can create a new 3D text object from scratch or convert an existing 2D text object into 3D text. Both approaches result in basic 3D text: white characters with a smooth plastic texture that are gently extruded in Z space (depth).
Stage 2: Apply a preset style

To give basic 3D text a more dynamic appearance, you can apply one of the ready-made 3D text styles that come with Motion.
The text style is applied to the selected text.
The preset 3D text styles artfully combine font, depth, and texture settings.

**Stage 3: Adjust text settings**

You can further modify your 3D text by adjusting basic text settings (including font, size, tracking, line spacing, and capitalization) or adjusting 3D-specific text attributes (such as depth, text weight, edge style, and corner style) in the Text Inspector or HUD.
To get a good look at all sides of your 3D text, you can move and rotate it in 3D space.

Stage 4: Modify the materials
If you want to, you can customize the texture of your 3D text by applying different textures and finishes available in the Materials category of the Motion Library. Materials include substances (such as metal or plastic), paint layers, distress layers, and more. Each layer has many attributes, allowing you to create limitless variations. You can even apply different materials to different facets of 3D text (front, back, side, and edges).

Stage 5: Add a lighting style

Another way to customize the appearance of your 3D text is to add a lighting style.
You can customize lighting in a variety of different ways, but these presets are a great way to create a unique and realistic look very quickly.
Stage 6: Integrate the text with your composition

Finally, combine your 3D text with backgrounds, shadows, and other elements to create an organic, integrated scene.
Add 3D text to a project

Add 3D text

You can add 3D text to your project using the 3D Text tool.

1. Do one of the following:
   - In the toolbar, click and hold the Text tool, then choose the 3D Text tool from the pop-up menu.
   - Press the T key twice (pressing T once activates the basic text tool, pressing it again activates the 3D Text tool).
2. Click anywhere in the Canvas to create an insertion point, then begin typing.

**Tip:** You can also choose the 3D Text tool, then drag in the Canvas to create a paragraph-style text-entry field with adjustable margins. For more information, see “Add paragraph-style text with margins that wrap” in Add text.

The 3D text appears in the Canvas. By default, newly created 3D text objects are given a smooth, white plastic appearance. To give basic 3D text a more dynamic look, you can quickly apply one of the ready-made 3D text styles that come with Motion. These preset text styles artfully combine font, depth, and texture settings. Or, if you want to create a custom look, you can apply textures and finishes available in the Motion Library.

SEE ALSO

Convert 2D text to 3D

**Convert 2D text to 3D**

You can easily convert a 2D text object in your project to 3D text. This process, called *extruding*, replaces the Face and Outline text settings with depth, weight, edge, lighting, and material settings designed to simulate realistic three-dimensional objects. You can also convert a 3D text object back to 2D text.
Convert a text object from 2D to 3D

1. In the Layers list, Timeline, or Canvas, select a 2D text object.

2. In the Appearance pane or Format pane of the Text Inspector, select the 3D Text activation checkbox.

The selected text is converted to basic 3D text, and given a smooth, white plastic texture. The Face and Outline controls in the Appearance pane are hidden, and the 3D Text, Lighting, and Material controls are enabled.

To give basic 3D text a more dynamic look, you can quickly apply one of the ready-made 3D text styles that come with Motion. These preset text styles artfully combine font, depth, and texture settings. Or, if you want to create a custom look, you can apply textures and finishes available in the Motion Library.

Convert a text object from 2D to a preset 3D
You can also convert 2D text to any of the preset 3D text styles available in Motion. In addition to converting 2D text to 3D, preset 3D text styles apply a specific font, color, and 3D material to create a particular text treatment.

1. In the Layers list, Timeline, or Canvas, select a 2D text object.

2. In the Text Inspector, click the pop-up menu at the top of the Appearance pane or Format pane, choose 3D Styles, then choose a preset style from the submenu.
The text is converted to 3D text in the style you chose. The Face and Outline controls in the Appearance pane are hidden, and the 3D Text, Lighting, and Material controls are enabled.

**Convert a text object from 3D to 2D**

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, deselect the 3D Text checkbox.

The text is converted to 2D text. The Lighting and Material controls in the Appearance pane are replaced by the Face and Outline sections, and the 3D Text section is dimmed.

The icon in the Layers list indicates whether a text object is 2D or 3D.
Apply a preset 3D text style

The easiest way to give basic 3D text a dynamic appearance is to apply one of the ready-made 3D text styles that come with Motion. These preset styles combine font, depth, and texture settings to create an “instant” 3D graphical treatment.

1. In the Layers list, Canvas, or Timeline, select a 3D text object.

2. In the Text Inspector, click the preset pop-up menu at the top of the Format pane or Appearance pane, then choose 3D Styles.
3. Choose a 3D text style from the submenu that appears.

The 3D text style is applied to the selected text.
Alternatively, you can create your own custom 3D text styles and looks by applying several of the numerous 3D textures and finishes (*materials*) available in the Motion Library. You can also create your own materials using images imported into Motion. For more information, see Materials overview.

**Move and rotate 3D text**

3D text has multiple *facets*—front, extruded sides, edges (bevels), and back. When you add 3D text to your project, you’ll see the front facet, but depending on the angle of the text, you may not be able to see the other facets.
You can view these other facets by moving or rotating the 3D text object.
Move or rotate 3D text using onscreen handles

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the toolbar, click the 3D Transform tool.

3. Do any of the following:
   - *To move the text object horizontally along its X axis*: Drag the red arrow.
   - *To move the text object vertically along its Y axis*: Drag the green arrow.
   - *To move the text object forward or backward along its Z axis*: Drag the blue arrow.
To rotate the text object around its X axis: Move the pointer over the rotation handles until a red rotation ring appears, then drag the red ring.

To rotate the text object around its Y axis: Move the pointer over the rotation handles until a green rotation ring appears, then drag the green ring.

To rotate the text object around its Z axis: Move the pointer over the rotation handles until a blue rotation ring appears, then drag the blue ring.

For more information, see Transform layers in 3D space.
Move or rotate 3D text using HUD controls

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the toolbar, click the 3D Transform tool.

3. Press F7 to open the HUD (if it’s not already open).

4. In the HUD, drag in the Move or Rotate squares.

For more information, see Transform layers in 3D space.

Move or rotate individual glyphs

You can also move or rotate individual characters (glyphs) of a 3D
1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Transform Glyph tool.

3. In the Canvas, select the glyph you want to move or rotate.

   A 3D bounding box with position handles and rotation handles appears around the selected glyph.

4. Do any of the following:
   - In the Canvas, drag a position handle (a colored arrow) to move the selected glyph along its X, Y, or Z (depth) axis.
   - In the Canvas, drag a rotation handle (a small white circle) to rotate the selected glyph around its X, Y, or Z axis.

   As you drag, three colored rotation rings appear, each corresponding to an axis. The ring for the currently active
axis is highlighted.

Rotating a 3D text glyph around its Y axis

For more information about transforming glyphs, see Text glyphs overview.

**Tip:** You can also view 3D text from different perspectives by adding a camera and converting your project to 3D. For more information, see Add a camera.

**SEE ALSO**

Apply materials to different facets

Modify basic 3D text attributes
Modify basic format and layout

In many ways, 3D text is just like 2D text, and you can modify basic text attributes (including font, size, tracking, line spacing, and capitalization) the same way you modify those attributes for 2D text: by adjusting controls in the Format pane and Layout pane in the Text Inspector.

**Note:** To modify the depth, texture, and lighting attributes of 3D text, use the controls in the Appearance pane of the Text Inspector. For more information, see [Modify depth, weight, edges, and corners](#), [Materials overview](#), and [Lighting overview](#).

---

Change text format settings

- In the Layers list, Timeline, or Canvas, select a 3D text object, then open the Format pane of the Text Inspector and adjust font, size, alignment, line spacing, tracking and other basic attributes.
Change text layout settings

- In the Layers list, Timeline, or Canvas, select a 3D text object, then open the Layout pane of the Text Inspector and adjust the layout method, direction, and other standard text layout attributes.

For more information about specific layout settings, see Layout controls in the Layout pane.

Modify depth, weight, edges, and corners

One of the most obvious differences between 2D text and 3D text is that 3D text has depth.
You can adjust text depth, as well as a number of other 3D text attributes (such as text weight, edge style, and corner style) in the Appearance pane of the Text Inspector.

Adjust 3D text depth

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. Do one of the following:
   - In the 3D Text section of the Text Inspector’s Appearance pane, drag the Depth slider left or right.
In the HUD (press D if it’s not visible), drag the Depth slider left or right.

Change the direction of 3D text depth

You can set 3D text depth to extrude in different directions: forwards, backwards, or centered on the original text plane.

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the 3D Text section of the Text Inspector’s Appearance pane, click the Depth Direction pop-up menu, then choose any of the following:
   - Backward: The text object is extruded backwards from the plane where the text was initially added.
Forward: The text object is extruded forwards from the plane where the text was initially added.

Centered: The text object is extruded equally both forward and backward from the plane where the text was initially added.

To see the resulting effect, drag the Depth slider in the Appearance pane or HUD.

Tip: Setting an extrusion direction and then keyframing the Depth parameter lets you animate text so that it appears to extrude forward or backward or in both directions over time.

Adjust 3D text weight

You can adjust 3D text to appear thicker or thinner. Whereas increasing the Size value in the Format pane makes text larger by substituting a larger version of the font, increasing the Weight
value uniformly thickens all the lines and serifs that comprise the letters in the text object.

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the 3D Text section of the Text Inspector’s Appearance pane, drag the Weight slider to the left to make the text appear thinner, or to the right to make it appear thicker.

Set the style of 3D text edges

The places where the different facets of a 3D text meet are called edges. You can add bevels, ridges, rings, and other shapes to customize the appearance of these edges.

By default, the back edge of 3D text (between the back facet and the sides) is identical to the front edge (between the front facet and the sides). However, you can set the front and back edges to
different edge shapes.

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the 3D Text section of the Text Inspector’s Appearance pane, click the Front Edge pop-up menu, then choose an edge style.

   ![Image of 3D Text Inspector with Front Edge options]

3. Click the Back Edge pop-up menu, then choose an edge style.

   If you choose Same As Front, the style you chose in step 2 is applied to the back edge of the 3D text object.

Adjust the size of 3D text edges
After you change the style of the front edge or back edge of a 3D text object to anything other than square, you can also adjust the size of that edge. If the back edge is set to something other than Same As Front (or Square), you can adjust the size of the back edge independently from that of the front.

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the 3D Text section of the Text Inspector’s Appearance pane, click the Front Edge pop-up menu, then choose a setting other than Square.

   The Front Edge Size slider appears.

3. Drag the Front Edge Size slider to the left to make the edge smaller, or to the right to make the edge larger.

You can also modify the width and depth of the edges.
independently.

To modify the width and depth of the edges independently, click the disclosure triangle to the left of the Front Edge Size slider, then drag the Width or Depth slider.

4. Click the Back Edge pop-up menu, then choose a setting other than Same As Front or Square.

![3D Text settings](image)

The Back Edge Size slider appears.

5. Drag the Back Edge Size slider to the left to make the edge smaller, or to the right to make the edge larger.

**Note:** You can’t see the back edge of the object unless you rotate the object or add a camera that’s pointed at the back of the object. See Move and rotate 3D text.

---

**Set the style of 3D text inside corners**

When the front edge or back edge of a text object is set to anything other than Square, you can customize the inside edge corners (such as the angles in a letter $E$).
1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the 3D Text section of the Text Inspector’s Appearance pane, click the Inside Corners pop-up menu, then choose an option:
   - **Straight**: Sets all edge corners to sharp angles.
   - **Round**: Softens the sharpness of edge corners by adding a round curve to each sharp angle.
   - **Miter**: Smooths the sharpness of edge corners in a more subtle way, by adding an additional angle, known as a miter.

Adjust the depth, weight, or edge size of individual glyphs
You can also create different depths, weights, or edge sizes for different characters (glyphs) in a 3D text object.

1. In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Transform Glyph tool.

2. In the Canvas, click the glyph you want to adjust.

   A 3D bounding box appears around the character.

3. Do one of the following:
   - In the 3D Text section of the Text Inspector’s Appearance pane, drag the Depth, Weight, or Front Edge Size slider left or right.
In the HUD (press F7 or D if it’s not visible), drag the Depth, Weight, or Front Edge Size slider left or right.

For more information about transforming glyphs, see Text glyphs overview.

For a complete list of depth, weight, and edge controls, see 3D Text controls.

3D Text controls

Adjust depth, weight and edge attributes using the 3D Text controls in the Appearance pane of the Text Inspector:

- 3D Text: An activation checkbox that, when selected, applies 3D attributes to selected text in your project and enables 3D controls in the Appearance pane. Deselecting this checkbox
converts selected 3D text to flat 2D text and disables 3D controls in the Appearance pane.

When this checkbox is selected, the following controls become available for adjustment:

- **Depth**: A slider that sets the thickness of selected 3D text.
- **Depth Direction**: A pop-up menu that sets whether selected 3D text is extruded backward, forward, or equally from front to back.
- **Weight**: A slider that makes selected 3D text appear heavier or lighter.
- **Front Edge**: A pop-up menu that sets the style of the front edge of selected 3D text.
- **Front Edge Size**: A slider that adjusts the width and depth of the chosen edge style. Click the disclosure triangle to reveal separate Width and Depth sliders.
- **Back Edge**: A pop-up menu that sets the style of the back edge of selected 3D text.
- **Inside Corners**: A pop-up menu that sets the style of the
inner corners of the front and back edges (such as angles in the letter E) in selected 3D text. The Front Edge or Back Edge of a text object must be set to an option other than Square to see the affect of this parameter.

For information on using these controls, see Modify depth, weight, edges, and corners.

SEE ALSO
Material controls overview
Lighting and environment controls

Modify surface appearance

Materials overview

3D text objects in Motion have properties designed to give them a natural and realistic appearance. They respond to lighting conditions and exhibit shading, reflectivity, and other attributes of real-world objects.
Attributes that define a 3D text object’s surface appearance are called *materials*.

After you create a 3D text object, you can apply a preset material or create a custom material by combining a collection of one or more material layers—image overlays that combine to create a naturalistic 3D texture.

Think of material layers as the building blocks for creating an object in real life. For example, you might begin creating an object by deciding what substance it should be made of—wood, plastic, metal, and so on. Depending on that basic substance, the object will have some fundamental properties, including color, texture, reflectivity, and so on. Next, you apply paint or another finish to the object to modify its color, sheen, and reflectivity. Motion even allows you to apply a “distress” layer to add a bit of texture, aging, or other elements to make the object feel more organic and realistic.
Each material layer type has a variety of controls and settings to customize the specific look and feel of the material.

You can apply multiple material layers of differing types to compound their effects, and you can rearrange the order in which material layers are applied to create varied results. You can also apply different materials to specific facets of a 3D text object.

Apply materials to 3D text

Apply a preset material

A quick way to give your 3D text a naturalistic texture is to apply one of the preset materials built into Motion.

Examples of some of the many preset 3D materials available in Motion include:
Apply a preset material from the Library

Do one of the following:

- In the Library, select Materials in the left column, select a category from the right column, then drag a material from the stack to a 3D text object in the Layers list, Timeline, or Canvas.

Before you drag the material into your project, a rotating preview appears at the top of the Library.
In the Layers list, Timeline, or Canvas, select a 3D text object, then in the Library, select Materials, select a category, select a material from the stack, then click Apply.

Before you apply the material, a rotating preview appears at the top of the Library.

The preset 3D material is applied to the text object.
You can modify any of the preset materials or add new material layers to create custom textures. See Modify material layers and Add, remove, or rearrange material layers.

Apply a preset material from the Text Inspector

1. In the Layers list, Timeline, or Canvas, select a 3D object, then in the Text Inspector’s Appearance pane, click the preview thumbnail in the Material area.

![Click the preview thumbnail.](image)

A pop-up menu showing the material presets categories appears.

2. Choose a category from the pop-up menu, then choose a material preset from the submenu that appears.
The preset 3D material is applied to the text object.

You can modify any of the preset materials or add new material layers to create custom textures. See Modify material layers and Add, remove, or rearrange material layers.

**Note:** The preset 3D materials are not same as the preset 3D text styles. Whereas *preset materials* apply a ready-made texture to 3D text, *preset text styles* apply a complete “look,” including a specific font, depth, texture, and other attributes. For more information, see Apply a preset 3D text style.

**Apply a custom material**

You can use your own image or clip to create a custom 3D text material layer. As with the preset materials, you can add paint layers, finish layers, distress layers, and emit layers to your custom material layer.
Apply a custom image or video clip as a material

1. From the File Browser or Library, **import** the image or clip you want to use as your 3D text material into your project.

2. In the Layers list, Timeline, or Canvas, select a 3D object, then in the Text Inspector’s Appearance pane, click the Substance pop-up menu and choose Generic.

3. Click the Surface pop-up menu, then choose Image.
An image well becomes available in the Image Options controls.

4. Drag the image or clip you imported in step 1 from the Layers list to the image well.

**Note:** Click and drag the image from the Layers list in one continuous movement. If you click the image and release the mouse button, the 3D text is deselected and the image well is
no longer available.

The image is mapped onto the 3D text object and the preview thumbnail in the Appearance pane is updated.

5. Adjust how the mapped image appears on the 3D text object using the Image Options controls.

For example, you may want to adjust the scale of the image or apply the image individually to each text character rather than have it mapped across all text characters.
In this example, the Scale parameter is set to 20 percent so the image more clearly appears on the front surface of the 3D text.

For a description of the Image Options parameters, see “When Substance is set to Generic” in Sub
cstance controls. For a description of the Placement parameters, see Placement controls.
Modify material layers

When you create a new 3D text object, it appears in the Canvas with a default 3D material preset applied: a smooth, white plastic texture (Basic). Most of the other preset materials in Motion Library are more complex, composed of multiple material layers—combinations of substance, paint, finish, and distress overlays that combine to create a naturalistic 3D texture. For example, the “Motion” preset consists of a colorful image used as a substance layer combined with an Enamel finish layer and a Reflective paint layer.

The GolfBall preset consists of a Plastic substance layer combined with a Polish finish layer, a Dirt distress layer, and a Bumps distress layer (set to –500% to create a dimple effect).

You can adjust each of these material layers in the Text Inspector.
(in the Material section of the Appearance pane). As you modify these settings, your 3D text is updated instantly in the Canvas, allowing you to fine-tune the look you want to achieve.

**Note:** Material layers (which appear stacked in the Appearance pane of the Text Inspector when you select a 3D text object) are not to be confused with the image layers that comprise a Motion project (which are represented in the Layers list, Timeline, and Canvas).

---

**Modify material layers used in a 3D texture**

Adjust the material layers in a 3D texture using the controls in the Appearance pane of the Text Inspector. This example shows how to modify the Substance layer of a simple 3D texture.

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

   A preview thumbnail of the preset currently applied to the text appears in the Text Inspector, in the Material section of the Appearance pane.
The material layers comprising the preset are shown under the preview thumbnail. For example, the Basic material preset has a single material layer: Substance, which is set to Plastic. Additional Substance settings specify the type of plastic (Shiny) as well as the color (White).

2. Click the Substance pop-up menu and choose a substance category.
Depending on the option you select, additional controls may appear in the Appearance pane.

3. **Click the Type pop-up menu (under the Substance pop-up menu) and select a specific substance belonging to the category you selected above.**

Depending on the option you select, additional controls may appear in the Appearance pane.

4. **Adjust other available Substance settings, such as Color, Brightness, Roughness, and so on.**

As you make adjustments, the preview thumbnail is updated in the Material section of the Appearance pane, and the 3D text is updated in the Canvas.

For a description of all material layer controls, see [Material controls overview](#).
Rename a modified material

When you modify material layers, the preview thumbnail in the Material section of the Appearance pane is updated to show the new texture. However, the preset name under the thumbnail remains the same ("Basic" for text added with the 3D Text tool). You can rename the material to better describe the modified material.

In the Material section of the Text Inspector’s Appearance pane, double-click the name of the material (beneath the preview thumbnail), then type a new name and press Return.

The material is renamed for the selected 3D text object. The original preset remains unchanged.

Restore a material’s preset settings

If you’re not satisfied with the results of your modifications to a preset material, you can revert the material back to its original settings, or to the settings of any preset.

In the Appearance pane of the Text Inspector, click the preview thumbnail in the Material area, then choose a preset from the pop-up menu.
The settings of the chosen preset are applied to 3D text object, and are shown in the updated preview thumbnail. Other customized instances of the preset are not affected.

Add, remove, or rearrange material layers

You can add multiple material layers to create more complicated textures for 3D text. For example, if you combine an Aluminum substance layer with a Grey Granite substance layer, your 3D text takes on a metallic ore finish that may or may not exist in nature. Likewise, you can add paint layers, finish layers, distress layers, and emit layers to create highly realistic (or highly fanciful) textures that show signs of aging, dirtiness, radiance, and other real-world qualities.

The order in which material layers are applied affects the appearance of the object. For example, you might add a wood surface layer, a paint layer, and various distress layers to create a
material that looks like it’s made of painted wood that has been aged and worn. Each layer affects the layers stacked beneath it in the Appearance pane, and rearranging the layers creates different results.

You can also remove, rearrange, or temporarily disable material layers.

---

**Add a material layer to a 3D texture**

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, click Add Layer (in the Options section), then choose a new material layer option (Substance, Paint, Finish, Distress, or Emit) and subtype from the pop-up menu.

![Material Options](image)

Click to open the Add Layer pop-up menu and select an additional material layer.

The new material layer and its adjustable controls are added in the Appearance pane.
3. To add another material layer, repeat step 2.

4. Adjust material layer controls in the Appearance pane to achieve the look you want.

For a description of all material layer controls, see Material controls overview.

---

Enable or disable a material layer

You can temporarily turn off or turn on any material layer to see how it’s affecting the overall texture.

- In the Appearance pane of the Text Inspector, click the activation checkbox to the left of the material layer name (Substance, Paint, Distress, and so on).
When the checkbox is highlighted blue, the material layer effect is visible in the Canvas. When the checkbox is dimmed, the effect is turned off.

Rearrange the stacking order of material layers

The stacking order of material layers in the Appearance pane affects a 3D texture’s appearance in the Canvas. You can rearrange the stacking order to create different looks.
In the Appearance pane of the Text Inspector, drag a material layer name (Substance, Paint, Distress, and so on), to a new position in the stack.

Remove a material layer

In the Appearance pane of the Text Inspector, click a material layer name (Substance, Paint, Distress, and so on), then press Delete.

**Tip:** To select and modify multiple material layers at once, Shift-click or Command-click the layers. This is especially useful if you want to delete or rearrange all the layers at once.

Add light-emitting material layers
The Emit material layer causes the selected 3D text layer to appear to be self-illuminating rather than just reflecting other light. The light emitted using this method does not act like other light sources in a 3D project: it doesn’t illuminate other objects or cause shadows to be cast.

In fact, the Emit layer is texture with a single color, gradient, or image, which is superimposed over 3D text object using an *Add blend mode* to make the text appear brighter.

1. In the Appearance pane of the Text inspector, click the Add Layer pop-up menu, then choose Emit.

   An Emit material layer is added in the Options section of the Appearance pane.

2. Click the Fill pop-up menu and choose a fill type (Color, Gradient, or Texture).
Depending on the Fill option you choose, additional parameter controls appear in the Emit material layer. For a full description of all Emit parameter controls, see Emit controls.

Apply materials to different facets

By default, applying a material to a 3D text object causes all facets of the text to display the same material. But a 3D text object can also display different materials on its different facets. For example, you can apply a shiny wood finish to the front facet, and a brushed metal appearance to the side facet. You can even apply a different material to the edges (the border between the face and the sides or the back and the sides).

If the same material is applied to more than one facet, you can modify the multiple facets’ settings simultaneously to ensure the settings remain consistent. You can also link facets together so
Apply a material to a specific facet of 3D text

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, click the Material pop-up menu, then choose Multiple.

   Five preview thumbnails appear, representing the five facets of 3D text: Front, Front Edge, Side, Back Edge, and Back.
3. Do any of the following:

- **Apply a preset material to a facet**: Click a preview thumbnail for any facet, then choose a new preset material from the pop-up menu.

- **Apply a custom material to a facet**: Click the name of a facet to display its material layers in the Appearance pane, then adjust those material layers or add new ones.

   For more information, see Modify material layers.

   The facet is updated to display the new material—in your 3D text object in the Canvas and in the Material preview thumbnail in the Appearance pane.

---

**Apply a material to multiple facets simultaneously**

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, click the Material pop-up menu, then choose Multiple.

   Five preview thumbnails appear, representing the five facets
of 3D text: Front, Front Edge, Side, Back Edge, and Back.

3. Shift-click the names of the facets you want to modify.

![Material pop-up menu]

The selected facets are highlighted blue.

4. Click the preview thumbnail of any of the highlighted facets, then choose a new preset material from the pop-up menu.

The selected facets are updated to display the new material—in your 3D text object in the Canvas and in the highlighted Material preview thumbnails in the Appearance pane. The facets are also automatically linked together so further changes to any of them will affect all of them.

---

**Link facets together**

You can link two or more facets together so that any changes made to one of them automatically updates the others.

1. With a 3D text object selected in your project and the Material pop-up menu in the Appearance pane set to Multiple, Shift-click the names of two or more facets you want to link.

2. Click the broken link icon on one of the selected facets.
All selected facets are linked and display blue active link icons.

3. To add another facet to the selected group, click its broken link icon.

The additional facet is linked to the group. Now, when you select any facet in the linked group, all linked facets are highlighted. Changes made to any of the highlighted facets are automatically made to all other facets in the linked group.

Unlink facets

- To remove a facet from a linked group, click any member of the group to select the group, then click the link icon for the facet you want to unlink.

  The facet is deselected and removed from the group.

Revert multiple facets back to a single facet

- In the Appearance pane of the Text Inspector, click the Material pop-up menu, then choose Single.
The five thumbnail previews are replaced by a single thumbnail preview, and all facets revert to the material that was applied to the selected facet. Any modifications you made to materials on other facets are permanently discarded.

SEE ALSO

Move and rotate 3D text

Save a modified material

After you create your own materials, you can save those textures as custom presets for reuse or for sharing with colleagues, clients, or customers. Saving a modified material as a custom preset includes all material layers shown in the Material section of the Appearance pane at the time of saving (including disabled material layers).

By default, custom preset materials are saved to the root level of the Materials category in the Library. If you want your custom preset materials grouped into a folder, you can manually organize them in the Library.

Save the currently selected material as a preset

1. In the Appearance pane of the Text Inspector, click the preview thumbnail in the Material section, then choose Save
Material from the pop-up menu.

The Save Preset to Library dialog appears.

2. Type a descriptive name for the preset, then click Save.

The currently selected material is saved as a preset, in the Material category in the Library. You can apply the preset as you would any other material in the Library. See Apply a preset material.

---

Organize saved custom preset materials
1. In the Motion Library, select Materials in the left column. The preset materials for that category appear in the stack area below.

2. Click the New Folder button (+) in the lower-left corner of the Library.
A new, untitled folder appears in the right column, above the stack.

**Note:** If you select a category of materials (Concrete or Fabric, for example) before you add the folder, the folder will be added within that category and will appear in the stack instead of in the category column.

3. Double-click the name of the untitled folder, then type a new name and press Return.

4. Drag the custom preset materials into the new folder.

The presets will now appear in the category you created, in both the Library and in the Material section of the Text Inspector’s Appearance pane (when the preview thumbnail is clicked).
Material controls

Material controls overview

The preset or custom materials you apply to 3D text are made up of one or more material layers—Substance, Paint, Finish, Distress, and so on—that combine to create a complex texture. When you select a 3D text object, its material layers appear in the Appearance pane of the Text Inspector, stacked under the Material preview thumbnail.

![Material preview thumbnail and pop-up menu]

You can adjust the parameter controls in each of these material layers to modify the texture applied to your 3D text. For a complete list of controls in each type of material layer, see the following:

- **Substance controls**
- **Paint controls**
- **Finish controls**
- **Distress controls**
Substance controls

Use the Substance controls in the Appearance pane of the Text Inspector to modify the basic surface texture of 3D text. Depending on the option you choose in the Substance pop-up menu (at the top of the Substance section of the Appearance pane), different parameter controls become available.

- **Substance**: A pop-up menu to set a substance type: Concrete, Fabric, Metal, Plastic, Stone, Wood, Flat, or Generic.

When Substance is set to Concrete
• **Type:** A pop-up menu to choose a style of concrete (Aged, Colored, Smooth, and so on).

• **Depth:** A slider to adjust the depth of surface irregularities in the concrete substance.

• **Placement:** A group of controls (available when you click the disclosure triangle) to set how the concrete pattern is applied to the text object. For details, see Placement controls.

### When Substance is set to Fabric

• **Type:** A pop-up menu to choose a style of fabric (Denim, Tweed, Wool, and so on).

• **Roughness:** A slider to adjust how raised and uneven the fabric pattern appears.

• **Placement:** A group of controls (available when you click the disclosure triangle) to set how the fabric pattern is applied to the text object. For details, see Placement controls.
When Substance is set to Metal

- **Type**: A pop-up menu to choose a style of metal (brass, aluminum, steel, and so on). There’s also a Custom option to modify the gradient for the metal’s reflection. See Example: Customize a metal gradient.

- **Shininess**: A slider to adjust how reflective the surface appears.

- **Thickness**: A slider to adjust the apparent thickness of the metal surface when it’s applied on top of another substance layer. Control this parameter more precisely by clicking the disclosure triangle, then adjusting individual Base and Highlight sliders.

When Substance is set to Plastic

- **Type**: A pop-up menu to choose any of three plastic styles: Shiny, Matte, or Textured.

- **Color Type**: A pop-up menu to choose whether you want the
plastic surface to be a solid color or a gradient. For information on using gradients, see Gradient editor overview.

- **Color**: A color control (available when Color Type is set to Color) to set the color of the plastic.

- **Gradient Controls**: A gradient control (available when Color Type is set to Gradient) to set a preset gradient or create a custom gradient, and to determine how the gradient is applied to the text object.

- **Texture Depth**: A slider (available when Type is set to Textured) to adjust how visible the texture appears on the object.

- **Placement**: A group of controls (available when Color Type is set to Textured) to determine how the texture is applied to the text object. For details, see Placement controls.

---

**When Substance is set to Stone**

- **Type**: A pop-up menu to choose a style of stone (Limestone, Dark Granite, Slate, and so on).

- **Depth**: A slider to adjust the depth of surface irregularities in the stone substance.

- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the stone pattern is applied to
When Substance is set to Wood

- **Type**: A pop-up menu to choose a style of wood (Ash, Walnut, Bamboo, and so on).

- **Grain Depth**: A slider to adjust the depth of grain in the wood substance.

- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the wood pattern is applied to the text object. For details, see [Placement controls](#).

When Substance is set to Flat

Use the Flat substance type to create an object that has depth, but which is unaffected by light or shadows. Flat creates a “2.5-dimensional” look popular in graffiti and pop-art styles.
Surface: A pop-up menu to choose whether the surface should display a color, a gradient, or an image. For information on using gradients, see Gradient editor overview.

Color: A color control (available when Surface is set to Color) to set the color of the text.

Gradient: A gradient control (available when Surface is set to Gradient) to set a preset gradient or create a custom gradient.

Image: An image well (available when Surface is set to Image). Drag an image layer from the Layers list, Media list, Library, or File Browser into the image well to use as the surface material of the 3D text object.

Wrap Mode: A pop-up menu (available when Surface is set to Image) that determines how the selected image is applied to the 3D text object if the image is smaller or larger than the text object. Choose any of the following options:

- None: The image is applied once to the text, and areas of the text object that exceed the scope of the image are not covered.
- Repeat: The image is applied and reapplied to the text object as often as necessary, creating a pattern to fill in the area beyond the scope of the original image.
- Mirror: The image is applied to the text object, then applied again in an inverted, reversed orientation to cover the area
Placement controls

- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the image pattern is applied to the text object. For details, see Placement controls.

- **Intensity**: A slider to adjust the vibrancy of the chosen Surface option (Color, Gradient, Image).

- **Opacity**: A slider to adjust the transparency of the chosen Surface option (Color, Gradient, Image). Drag to the left to make the surface appear more transparent; drag to the right to make the surface appear more opaque.

- **Enable Edge**: A group of controls (available when you click the disclosure triangle) that creates a dynamic effect for how edges are rendered depending on the relative position of the camera. As the text changes position (relative to the camera) the shading changes.

You can enable or disable these controls by selecting or deselecting the activation checkbox to the left of the Enable Edge row.

- **Edge Amount**: A slider to adjust how visible the edges of the selected substance layer appear.

- **Invert**: A checkbox that, when selected, inverts the visible area of the edges for the selected substance layer.

- **Blend Mode**: A pop-up menu to control how flat substance layers interact with layers beneath them. Choose any of the following methods:
  - **Normal**: The visible areas of the topmost substance layer obscures the edges of the layers beneath it.
  - **Multiply**: The visible areas of the substance layers are

  beyond the scope of the original image.
Multiply: The visible areas of the substance layers are multiplied together so the darker areas of each layer appear on the edges of the text object.

Add: The visible areas of the layers are added together so the lighter areas of each layer appear on the edges of the text object.

When Substance is set to Generic

The generic substance type (often called “diffuse” in other 3D applications) is used in several of the preset materials available in the Library. When Substance is set to Generic, a neutral surface is generated, onto which a solid color, gradient, or image can be applied. This substance type is usually used in conjunction with the Custom Specular or Custom Bump finish layers to create unique looks.

- **Surface**: A pop-up menu to choose whether the surface should display a color, a gradient, or an image.

- **Color**: A color control (available when Surface is set to Color) to set the color of the paint.

- **Gradient**: A gradient control (available when Surface is set to Gradient) to set a preset gradient or create a custom gradient. For information on using gradients, see Gradient editor overview.
• **Image**: An image well (available when Surface is set to Image). Drag an image layer from the Layers list, Media list, Library, or File Browser into the image well to use as the surface material of the 3D text object. See [Apply a custom material](#).

• **Placement**: A group of controls (available when Surface is set to Image) to determine how the image is applied to the text object. For details, see [Placement controls](#).

• **Wrap Mode**: A pop-up menu (available when Surface is set to Image) to choose how the selected image is applied to the 3D text object if the image is smaller or larger than the 3D text object. Choose any of the following options:

  • **None**: The image is applied once, and areas of the text object that exceed the scope of the image are not covered.

  • **Repeat**: The image is applied and reapplied as often as necessary, creating a pattern to fill the area beyond the scope of the original image.

  • **Mirror**: The image is applied to the text object, then applied again in an inverted, reversed orientation to cover the area beyond the scope of the original image.

• **Brightness**: A slider to adjust how much light is reflected by the surface of the text object. Control this effect with more precision by clicking the disclosure triangle and separately adjusting the following subcontrols:

  • **Lights**: A slider to adjust the amount of light reflected in the object’s surface, based on the light type chosen in the Lighting Style pop-up menu (in the [Lighting group of controls](#)).

  • **Environment**: A slider to adjust the amount of light reflected...
- **Environment**: A slider to adjust the amount of light reflected in the object’s surface, based on the environment type chosen in the Environment Type pop-up menu (in the **Lighting group of controls**).

- **Opacity**: A slider to adjust the visibility of the substance layer. Drag to the left to make the substance more transparent, or drag to the right to make it more opaque.

---

**Paint controls**

Use the Paint controls in the Appearance pane of the Text Inspector to create the effect of a coat of paint on the 3D text object. Depending on the option you choose in the Paint pop-up menu (at the top of the Paint section of the Appearance pane), different parameter controls become available.

- **Paint**: A pop-up menu to set a paint type: Smooth Paint, Textured Paint, Watercolor, or Reflective Paint.

---

When Paint is set to Smooth Paint
- **Color Type**: A pop-up menu to choose whether the paint is a solid color or a gradient. For information on using gradients, see Gradient editor overview.

- **Paint Color**: A color control (available when Color Type is set to Color) to set the color of the paint.

- **Paint Gradient**: A gradient control (available when Color Type is set to Gradient) to set a preset gradient or create a custom gradient.

- **Sheen**: A slider to adjust the apparent shininess of the paint surface.

- **Opacity**: A slider to adjust the visibility of the paint. Drag to the left to make the paint more transparent; drag to the right to make it more opaque.

**When Paint is set to Textured Paint**

- **Color Type**: A pop-up menu to choose whether the paint is a
solid color or a gradient. For information on using gradients, see Gradient editor overview.

- **Paint Color**: A color control (available when Color Type is set to Color) to set the color of the paint.
- **Paint Gradient**: A gradient control (available when Color Type is set to Gradient) to set a preset gradient or create a custom gradient.
- **Sheen**: A slider to adjust the apparent shininess of the paint surface.
- **Surface Texture**: A pop-up menu to apply a texture.
- **Texture Depth**: A slider to adjust the visibility of the texture on the surface of the 3D text object.
- **Opacity**: A slider to adjust the visibility of the paint. Drag to the left to make the paint more transparent; drag to the right to make it more opaque.

When Paint is set to Watercolor

- **Color Type**: A pop-up menu to choose whether the paint is a solid color or a gradient. For information on using gradients, see Gradient editor overview.
- **Paint Color**: A color control (available when Color Type is set to
Paint Color:
- A color control (available when Color Type is set to Color) to set the color of the paint.

Sheen:
- A slider to adjust the apparent shininess of the paint surface.

Opacity:
- A slider to adjust the visibility of the paint. Drag to the left to make the paint more transparent, or drag to the right to make it more opaque.

Placement:
- A group of controls (available when you click the disclosure triangle) to set how the watercolor pattern is applied to the text object. For details, see Placement controls.

When Paint is set to Reflective Paint

- **Paint Job:** A pop-up menu to select the type of reflective paint (Velvet, Pearl, Electric, and so on)
- **Paint Color:** A color control to set the color of the reflective paint.
- **Second Color:** Some Paint Job types use a second color. Use this color control to set that second color.
- **Sheen:** A slider to adjust the apparent shininess of the paint surface.
- **Diffuse Brightness:** A slider (available when Paint Job is set to
Custom) to set the amount of color reflected by the text object.

- **Specular Brightness:** A slider (available when Paint Job is set to Custom) to set the amount of light reflected by the text object.

- **Shininess:** A slider (available when Paint Job is set to Custom) to set how mirror-like the surface appears.

- **Face Opacity:** A slider (available when Paint Job is set to Custom) to set how transparent the paint effect is on surfaces that are more perpendicular to the camera.

- **Edge Opacity:** A slider (available when Paint Job is set to Custom) to set how transparent the paint effect appears on surfaces that are more parallel to the camera.

- **Opacity:** A slider to adjust the visibility of the paint. Drag to the left to make the paint more transparent; drag to the right to make it more opaque.

- **Fresnel:** A slider (available when Paint Job is set to Custom) to set the amount that a change in viewing angle impacts the reflectiveness of the object. A high Fresnel value means that there’s a strong change in reflectivity as the viewing angle changes; a low Fresnel value means that the reflectivity remains relatively consistent regardless of viewing angle.

### Finish controls

Use the Finish controls in the Appearance pane of the Text Inspector to create the effect of a reflective *finish* (such as polish, enamel, and so on) on the surface of the 3D text object. Depending on the option you choose in the Finish pop-up menu
(at the top of the Finish section of the Appearance pane), different parameter controls become available.

- **Finish**: A pop-up menu to set a finish type: Polish, Enamel, Brushed, Textured, or Custom Specular.

![Image of a pop-up menu with options for Finish: Polish, Enamel, Brushed, Textured, Custom Specular, with sliders for Reflectivity and Glossiness.]

### When Finish is set to Polish

- **Reflectivity**: A slider to adjust the brightness of reflections that appear on the surface of the object. Similarly to *light intensity*, Reflectivity can be set above 100% to create a high dynamic range (HDR)-type effect.

- **Glossiness**: A slider to adjust how dull or sharp reflections are. A setting of 0 creates a blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.

### When Finish is set to Enamel

- **Reflectivity**: A slider to adjust the brightness of reflections that appear in the surface of the object. Similarly to *light intensity*, Reflectivity can be set above 100% to create a high dynamic range (HDR)-type effect.

- **Glossiness**: A slider to adjust how dull or sharp reflections are. A setting of 0 creates a blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.
creates a sharp, mirror-like reflection.

- **Highlight Color:** A color control to set a color to tint the highlights that appear in reflections on the text object’s surface.

**Note:** The enamel setting effectively negates any bumpiness on layers beneath it (just like the effect of adding enamel to a rough surface in the real world). For example if you place this layer over a wood layer, the grain depth of the wood will be ignored no matter high you set that parameter.

**When Finish is set to Brushed**

- **Reflectivity:** A slider to adjust the brightness of reflections that appear in the surface of the object. Similarly to *light intensity*, Reflectivity can be set above 100% to create a high dynamic range (HDR)-type effect.

- **Glossiness:** A slider to adjust how dull or sharp reflections are. A setting of 0 creates a blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.

- **Depth:** A slider to adjust the apparent depth of the brush pattern.

- **Reverse Depth:** A checkbox that, when selected, inverts the brush pattern, making dark areas appear raised and light areas appear sunken into the surface.

- **Placement:** A group of controls (available when you click the disclosure triangle) to set how the brush pattern is applied to the text object. For details, see Placement controls.
When Finish is set to Textured

- **Type:** A pop-up menu to choose a texture: Combed, Cracked, Eggshell, and so on.

- **Reflectivity:** A slider to adjust the brightness of reflections that appear in the surface of the object. Similarly to *light intensity*, Reflectivity can be set above 100% to create a high dynamic range (HDR)-type effect.

- **Glossiness:** A slider to adjust how dull or sharp reflections are. A setting of 0 creates a blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.

- **Depth:** A slider to adjust the apparent depth of the texture pattern.

- **Reverse Depth:** A checkbox that, when selected, inverts the texture pattern, making dark areas appear raised and light areas appear sunken into the surface.

- **Placement:** A group of controls (available when you click the disclosure triangle) to set how the texture is applied to the text object. For details, see *Placement controls*.

When Finish is set to Custom Specular

- **Intensity:** A slider to adjust the amount of light reflected in the text object’s surface.

You can control the intensity of lights and environmental light separately by clicking the disclosure triangle and exposing the following two sliders:

- **Lights:** A slider to adjust the amount of light reflected in the object’s surface, based on the kind of light chosen in the
Lighting Style pop-up menu (in the Lighting group of controls).

- **Environment:** A slider to adjust the amount of light reflected in the object’s surface, based on the type of environment chosen in the Environment Type pop-up menu (in the Lighting group of controls).

  For more information about these lighting options, see Lighting overview.

- **Intensity Image:** A checkbox that, when selected, activates a set of controls for adding a custom image as an “intensity map.” An intensity map makes brighter areas of the image reflect more light, and darker areas limit the reflection. Use an intensity map to create the effect of a pattern or smudge on the object’s surface that dynamically modifies or limits the reflectiveness of the object. Click the disclosure triangle to reveal the following controls:

  - **Image:** An image well to assign an image used as the intensity map. Drag an image from the Layers list or Media list into this well.
  
  - **White Level:** A slider that sets the brightness point above which areas of the intensity map allow reflections to pass and be visible. Lowering the White Level makes the intensity map more transparent, reducing reflectivity.
  
  - **Black Level:** A slider that sets the brightness point below which areas of the intensity map prevent reflections from passing. Raising the Black Level means more of the image will appear opaque.
  
  - **Wrap Mode:** A pop-up menu that sets what happens if the image is smaller than the text object. Choose one of the
The following options:

- **None**: The image is applied once, and areas of the text object that exceed the scope of the image are not covered.

- **Repeat**: The image is applied and reapplied as often as necessary, creating a pattern to fill the area beyond the scope of the original image.

- **Mirror**: The image is applied to the text object, then applied again in an inverted, reversed orientation to cover the area beyond the scope of the original image.

- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the intensity map is applied to the text object. For details, see Placement controls.

- **Shininess**: A slider to adjust how mirror-like the object appears. Control this effect more precisely by clicking the disclosure triangle and adjusting two additional sliders:
  - **Lights**: A slider to adjust how sharply lights are reflected in the surface of the object. A higher setting makes reflections more sharply defined, and a lower setting creates a blurrier reflection.
  - **Environment**: A slider to adjust how sharply the environment image is reflected in the surface of the object. A higher setting makes the environment more clearly visible, and a lower setting creates a blurrier reflection.

For more about lighting options, see Adjust 3D text lighting.

- **Shininess Image**: A checkbox that, when selected, activates a set of controls for adding a custom image as an “shininess
map.” A shininess map controls the sharpness (or mirror-likeness) of the object. Click the disclosure triangle to reveal the following controls:

- **Image**: An image well to assign an image used as the shininess map. Drag an image from the Layers list or Media list into this well. Areas of the image that are white allow the reflection to appear sharp and mirror-like. Areas that are black make the reflection appear dull and blurry.

- **White Level**: A slider that sets the brightness point above which areas of the shininess map enable a clear, mirror-like reflection in the surface. Lowering the White Level means more of the reflection will appear clear and mirror-like.

- **Black Level**: A slider that sets the brightness point below which areas of the Shininess Image create a dulling or blurring effect on the object’s reflections. Raising the Black Level means more of the reflection will appear blurry.

- **Wrap Mode**: A pop-up menu that sets what happens if the image is smaller than the text object. Choose one of the following options:
  
  - **None**: The image is applied once, and areas of the text object that exceed the scope of the image are not covered.
  
  - **Repeat**: The image is applied and reapplied as often as necessary, creating a pattern to fill the area beyond the scope of the original image.
  
  - **Mirror**: The image is applied to the text object, then applied again in an inverted, reversed orientation to cover the area beyond the scope of the original image.
• **Placement:** A group of controls (available when you click the disclosure triangle) to set how the shininess map is applied to the text object. For details, see Placement controls.

• **Specular Color:** A pop-up menu to choose whether the specular color is based on the current surface, a solid color, or an image. Use this control to add a hue (or pattern) that colors the reflection as if the material were made of that color or pattern. For example, adding an orange specular color causes reflections to have an orange hue, as if the 3D text object were made of copper.

• **Surface Blend:** A slider (available when Specular Color is set to From Surface) to adjust the amount of the underlying color blended into the highlights.

• **Color:** A color control (available when Specular Color is set to Solid Color) to set the Specular color.

• **Anisotropic:** A checkbox that, when selected, activates a set of controls that limit the custom specular effect to a particular pattern or direction (as opposed to the default method, which disperses the specular effect in many directions at once). This allows you to distort the highlights created by lighting styles and scene lights. Click the disclosure triangle to reveal the following controls:
  
  • **Geometry:** A pop-up menu to choose whether the anisotropic effect is linear, cylindrical, or based on a custom image.
  
  • **Placement:** A group of controls (available when you click the disclosure triangle) to set how the anisotropic specular effect is applied to the text object. For details, see Placement controls.
- **Place On**: A pop-up menu to choose whether the anisotropic effect is applied per glyph or per object. For details, see Placement controls.

- **Orientation**: Three dials (X, Y, and Z), available when Geometry is set to Linear, to set the direction of the linear anisotropic specular effect.

- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the anisotropic specular effect is applied to the text object. For details, see Placement controls.

- **Position**: Value sliders (available when Geometry is set to Cylindrical) to set the position where the cylindrical anisotropic specular effect is centered.

- **Anisotropic Angle Image**: An image well (available when Geometry is set to Image). Drag an image from the Layers list or Media list into this well to use as a map that determines the appearance of the anisotropic specular effect.

- **Wrap Mode**: A pop-up menu (available when Geometry is set to Image) to choose how the intensity map is applied to the 3D text object if the image is smaller or larger than the 3D text object. Choose any of the following options:
  - **None**: The image is applied once, and areas of the text object that exceed the scope of the image are not covered.
  - **Repeat**: The image is applied and reapplied as often as necessary, creating a pattern to fill the area beyond the
- **Mirror:** The image is applied to the text object, then applied again in an inverted, reversed orientation to cover the area beyond the scope of the original image.

- **Highlight Sharpness:** A slider to adjust the shape of the reflected highlight, making it narrow or wide.

### Distress controls

Use the Distress controls in the Appearance pane of the Text Inspector to create the effect of adding wear or degradation to the surface of the 3D text object. Depending on the option you choose in the Distress pop-up menu (at the top of the Distress section of the Appearance pane), different parameter controls become available.

- **Distress:** A pop-up menu to set a distress type: Scratches, Stains, Dirt, Dents, Wavy, Bumps, Perforated, Wrinkles, or Custom Bumps.
When Distress is set to Scratches

- **Type**: A pop-up menu to choose a scratch pattern.
- **Depth**: A slider to adjust the apparent depth of the scratches.
- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the scratch pattern is applied to the text object. For details, see [Placement controls](#).

When Distress is set to Stains

- **Type**: A pop-up menu to choose a stain pattern.
- **Opacity**: A slider to adjust the visibility of the stain pattern.
- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the stain pattern is applied to the text object. For details, see [Placement controls](#).

When Distress is set to Dirt

- **Type**: A pop-up menu to choose a dirt pattern.
- **Opacity**: A slider to adjust the visibility of the dirt pattern.
- Sparsity: A slider to adjust the visibility of the dirt pattern.

- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the dirt pattern is applied to the text object. For details, see **Placement controls**.

### When Distress is set to Dents

- **Type**: A pop-up menu to choose a dents pattern.
- **Depth**: A slider to adjust the apparent depth of the dents in the 3D text object.
- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the dent pattern is applied to the text object. For details, see **Placement controls**.

### When Distress is set to Wavy

- **Depth**: A slider to adjust the apparent depth of the wave pattern.
- **Placement**: A group of controls (available when you click the disclosure triangle) to set how the wave pattern is applied to the text object. For details, see **Placement controls**.

### When Distress is set to Bumps

- **Type**: A pop-up menu to choose a bump pattern.
- **Depth**: A slider to adjust the apparent depth of the bump pattern.
- **Placement**: A group of controls (available when you click the
When Distress is set to Perforated

- **Type:** A pop-up menu to choose a perforation pattern.
- **Depth:** A slider to adjust the apparent depth of the perforation pattern.
- **Placement:** A group of controls (available when you click the disclosure triangle) to set how the perforation pattern is applied to the text object. For details, see Placement controls.

When Distress is set to Wrinkles

- **Type:** A pop-up menu to choose a wrinkle pattern.
- **Depth:** A slider to adjust the apparent depth of the wrinkles.
- **Placement:** A group of controls (available when you click the disclosure triangle) to set how the wrinkle pattern is applied to the text object. For details, see Placement controls.

When Distress is set to Custom Bumps

Source image for Custom Bumps distress layer  3D text prior to Custom Bumps distress layer  3D text after Custom Bumps distress layer
This option lets you select an image to serve as the texture map for the selected object.

- **Bump map gain**: A slider to increase or decrease the contrast of the selected image, giving the effect of larger or smaller bumps.

- **Image**: An image well to assign a custom image to use as the bump map. Drag an image from the Layers list or Media list into this well.

- **Bump Map Type**: A pop-up menu to set whether the bump map is interpreted as **Height**, which uses the luminance of an image to define the bump pattern, or as Normal, which uses an RGB map image to define the bump pattern.

- **Invert**: A checkbox that, when selected, swaps the light and dark elements of the image, effectively inverting the apparent height of the bumps.

- **Wrap Mode**: A pop-up menu to set what happens if the image is smaller than the text object. Choose from one of the following options:
  - **None**: The image is applied once, and areas of the text object that exceed the scope of the image are not covered.
  - **Repeat**: The image is applied and reapplied as often as necessary, creating a pattern to fill the area beyond the scope of the original image.
  - **Mirror**: The image is applied to the text object, then applied again in an inverted, reversed orientation to cover the area beyond the scope of the original image.

- **Placement**: A group of controls (available when you click the
Placement: A group of controls (available when you click the disclosure triangle) to set how the texture is applied to the text object. For details, see Placement controls.

- Blend Mode: A pop-up menu to set how multiple bump layers interact with each other. Choose one of two options:
  - Add: Uses a mathematical add operation, allowing the lighter areas of each layer to shine through.
  - Replace: Causes the top-most layer to appear wherever it overlaps with layers that occur below it in the Inspector.

Emit controls

Use the Emit controls in the Appearance pane of the Text Inspector to add a radiance effect to 3D text, as if the text were emitting its own light.

- Fill: A pop-up menu to set whether the light emitted is based on a solid color, a gradient, or a texture. For information on using gradients, see Gradient editor overview.
- Color: A color control (available when Fill is set to Color) to select the color to be emitted.
- **Gradient**: A gradient control (available when Fill is set to Gradient) to set a preset gradient or create a custom gradient for the colors to be emitted.

- **Image**: An image well (available when Fill is set to Texture) to assign a custom image to use as the texture emitted. Drag an image from the Layers list or Media list into this well.

- **Wrap Mode**: A pop-up menu (available when Fill is set to Texture) to set what happens if the image is smaller than the text object. Choose from one of the following options:
  - **None**: The image is applied once, and areas of the text object that exceed the scope of the image are not covered.
• **Repeat:** The image is applied and reapplied as often as necessary, creating a pattern to fill the area beyond the scope of the original image.

• **Mirror:** The image is applied to the text object, then applied again in an inverted, reversed orientation to cover the area beyond the scope of the original image.

• **Placement:** A group of controls (available when you click the disclosure triangle) to set how the texture is applied to the text object. For details, see Placement controls.

• **Intensity:** A slider to adjust how visible the emitted light appears on the object.

• **Coverage:** A slider to adjust how much the emit layer is visible based on the opacity of the layer. A value of 100% (the default) causes the emit layer to display, regardless of the opacity of the layers beneath it. A value of 0% means that the emit layer shines only where the material is opaque.

### Placement controls

Many material layers use graphic images with fixed dimensions that are “mapped” to the 3D text object—for example, the pattern of a fabric substance or the scratches of a distress layer. When a material layer uses a mapped image, Placement controls become available at the bottom of that layer’s section in the Appearance pane of the Text Inspector. You can use these controls to set how the image is mapped onto the text object.
If you have multiple material layers—each using a different mapped image—you can adjust each layer’s Placement controls independently. For example, for a material made of a wood substance and a scratched distress layer, you can rotate the orientation of the wood grain one way, and then rotate the orientation of scratches the other way.

You can also adjust the orientation of multiple material layers at once using a shared set of Placement controls. For example, you can rotate the wood grain and the scratches as a group, in the same direction. The Shared Placement controls, located in the Options section of the Appearance pane (above the material layers controls), become available when you designate the placement for one or more material layers as Shared.

The Options section of the Appearance pane also has a set of Global Placement controls you can use to randomize the placement of any textures applied in any material layer.

**Independent Placement controls**

These controls appear at the bottom of each material layer in the Appearance pane that uses a texture or image. To see all the controls, click the disclosure triangle.
• **Placement:** A pop-up menu to set whether the image or texture is mapped to the 3D text object independently of other material layers or in combination with other material layers. There are two options:

  • *Independent:* Activates controls (described below) for adjusting the position, scale, and rotation of this material layer’s image or texture.

  • *Shared:* Disables the Placement controls for this material layer, and enables Shared Placement controls in the Options section of the Appearance pane. Use the Shared Placement controls (described in the next section below) to adjust the position, scale, and rotation of this material layer’s image or texture, as well as those of any other material layers set to Shared.
- **Place On**: A pop-up menu to choose whether to apply the image or texture once to the entire text object, or to apply it individually to each glyph (character).

- **Side Placement**: A pop-up menu to set how the mapped image or texture is applied to the sides of the text object. Choose one of the following options:
  - **Normal**: The image or texture is mapped to the front of the text object as well as to the side.
  - **Turn 90°**: The image or texture is mapped to the front of the text object; the same image is mapped to side the of text object, but is rotated by 90 degrees.
- **Stretch From Side:** The image or texture is mapped to the front of the text object, and to the side, and the pixels on the edge are repeated, so that the pattern appears to be stretched over the sides of the text object.

- **Position:** Value sliders to offset the location where the image or texture is mapped to the object.

- **Scale:** A slider to adjust the image or texture being mapped. Click the disclosure triangle to reveal separate X and Y scale sliders and the Scale With Font Size checkbox (described below).

- **Scale With Font Size:** A checkbox (visible when you click the Scale disclosure triangle) that, when selected, causes the size of the applied image or texture to change proportionally whenever you modify the font size of the text object.

- **Rotation:** A dial to rotate the mapped image or texture around the Z axis. Click the disclosure triangle to reveal separate dials for rotating around the X, Y, and Z axes.

**Shared Placement controls**

These controls appear in the Options section of the Inspector when one or more material layers are set to Shared placement. These controls are identical to the controls described in the Independent Placement controls above. Adjusting these controls adjusts the placement (position, scale, rotation, and so on) of all material layers set to Shared placement.
Global Placement controls

These settings modify all images that are affected by placement controls, independent or shared.

- **Randomize**: A pop-up menu to apply randomly generated variations of the pattern placement on the different facets of the 3D text object. Choose an option from the pop-up menu to limit the randomness to just the sides, just the front and back, or to all facets.

- **Random Seed**: A control to choose a different random number to change the random pattern placement. Click the Generate button to have Motion select a random number, or enter your own number directly into the text field.

Example: Customize a metal gradient

Each of metal materials in the Motion Library has a default reflection gradient governing how colors reflect off the surface of metallic 3D text. You can customize the preset metal materials to create unique effects. This example shows how to add colorful iridescence to a default metal reflection gradient.
1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Text Inspector’s Appearance pane, click the preview thumbnail in the Material area, choose Metal from the pop-up menu, then choose a metal type from the submenu.

3. Do one of the following:
   - If you chose Aluminum Foil, Brushed Metal, Chrome, Copper, Gold, or Nickel: In the Substance controls, click the Type pop-up menu, then choose Custom (at the
• If you chose Brushed Circular, Distressed Metal, Grunge Metal, Iron, Old Steel, or Rust: Click the Substance pop-up menu, and choose Metal; then click the Type pop-up menu, and choose Custom.

The Reflection Gradient control for the selected metal appears.
4. Modify the gradient using the gradient editor.

For more information about using gradient controls, see Gradient editor overview.

In the final text treatment, the colors that you set on the left side of the gradient editor (the fuchsia and light blue colors, in this example) are more visible when 3D text surfaces are perpendicular to the screen. The colors that you set on the right side of the gradient (violet and gray, in this example) are more visible in the final text treatment when 3D surfaces are parallel to the screen. And when the 3D text is rotated (or the camera is animated in a 3D project), the text reflects the different gradient colors, shimmering as it moves.
For more information on using the gradient editor, see Gradient editor overview. For information on the metal material controls, see Substance controls.

Modify lighting style

Lighting overview

3D text in Motion is designed to simulate the shading and reflectivity of a three-dimensional object in the real world reacting to local lighting conditions and the surrounding environment.
Although you can manually add light objects to your project to achieve precise lighting effects, it’s not a requirement when working with 3D text. The built-in lighting and environment controls in Motion greatly simplify the process of creating natural-looking 3D text objects.

Also, because reflectivity is a fundamental aspect of what makes three-dimensional objects appear realistic, Motion allows you to control what’s reflected in 3D text objects. You can choose from a range of preset environments, or you can create your own custom environment.

SEE ALSO
Adjust 3D text lighting
Modify the lighting environment
Lighting and environment controls
Adjust 3D text lighting

All 3D text objects in Motion have a set of built-in options that simulate basic lighting conditions. This enables you to quickly and easily create natural-looking scenes quickly and easily.

Additionally, you can add light objects to your project if you need to illuminate your 3D text objects in more complex or specific ways.

Modify the lighting style

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, click the Lighting Style pop-up menu and choose one of the lighting options.
3. Drag the Intensity slider to increase or decrease the amount of illumination.

Click to choose a lighting style.
Your 3D text object is illuminated in style you chose.

For a detailed list of all 3D text lighting controls, see Lighting and environment controls.

Control how 3D text objects cast self-shadows

In the real world, complex objects often cast shadows on parts of themselves. You can simulate this effect in Motion by having 3D text cast “self-shadows.”
Note: The self-shadow effect does not cast shadows on other objects in your project. To make 3D text cast shadows on other objects, you must add light objects (described in “Use external lights to illuminate a 3D text object,” below).

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, click the Self Shadows checkbox (in the Lighting section).

Note: The Self Shadows checkbox is hidden when Lighting Style is set to Off.

With self-shadows enabled, one part of a 3D text object will cast a shadow on another part of the same object (depending
on the light source position). Although this effect can add realism to a text object, in some cases it may add unwanted or distracting shadows.

3. Click the disclosure triangle next to the Self Shadows checkbox to reveal additional controls.

4. Drag the Opacity slider to the left to decrease the visibility of self-shadows.

5. Drag the Softness slider to the right to soften the edges of self-shadows, making them more subtle.

For a more information about self-shadow controls, see Lighting and environment controls.

---

**Use external lights to illuminate a 3D text object**

To create more precise or complex lighting and shadow effects, you can add light objects to your project. This technique is useful if you want to illuminate multiple objects in a consistent and naturalistic way, if you want to use very specific types of lights, or if you want to use colored lights.

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text inspector, click the Lighting Style pop-up menu and choose Off, then deselect the Environment checkbox (if it’s not already deselected).
Note: This step is optional, but turning off 3D text’s built-in lighting effects before you manually add light objects prevents conflicting lighting results.

3. Choose Object > New Light (or press Shift-Command-L) to add a new light object to the scene.

If your 3D text is currently in a 2D group, a dialog appears asking if you want to switch your 2D groups to 3D.

4. Click Switch to 3D.
A light object is added to your project.

5. In the Canvas, drag the light object’s onscreen handles to illuminate your objects.

For more information about moving and orienting lights, see Add lights.

6. In the Light Inspector, choose a light type and adjust other settings as needed.

7. If necessary, drag or rotate the light object in the Canvas using its onscreen controls.

For detailed information about using lights and shadows in 3D projects, see Add lights and Shadows overview.
Use external lights to cast shadows from a 3D text object

In addition to self-shadowing, 3D text can cast shadows on other objects in the project.

1. Follow steps 1–7 in “Use external lights to illuminate a 3D text object,” above.

2. Select a light object in the Canvas, Layers list, or Timeline.

   **Note:** The Shadows controls are not available when the Light Type pop-up menu is set to Ambient.

   For more information about using the shadow controls, see and **Shadow controls in the Inspector**.

3. In the Light Inspector, select the Shadows activation checkbox.
When selected, the checkbox is highlighted blue.

4. Double-click the Shadows heading to expose the shadow controls, then adjust them to your liking.

5. Select the layer you want your 3D text to cast the shadow on, open the Properties Inspector, double-click Shadows heading to expose the shadow controls, then select the Receive Shadows checkbox.

**Note:** The layer receiving the shadow needs to be offset from the object casting the shadow.

---

**Modify the lighting environment**

Reflective objects such as 3D text need something to reflect. In Motion, you can choose what’s reflected in the surface of 3D text objects by enabling environment lighting.

Environment lighting projects an image onto the 3D text object to simulate a reflected world.

![Spark](image1.png) ![Spark](image2.png)

*Environment set to Colorful  Environment set to Squares*

Because environment lighting emulates the reflective properties of real-world objects, its effects are more noticeable on 3D text with
shiny surfaces.

Set the image to be reflected by a 3D text object

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text inspector, click the disclosure triangle to expand the Environment section of controls.

3. Click the Type pop-up menu and choose an environment.
Choose one of the preset images (such as Roof Top, Light Box, and so on) or choose Gradient and choose a preset gradient or create a custom gradient to act as the source of the reflection. For information on using gradients, see Gradient editor overview.

Tip: You may need to rotate the 3D text object around its X or Y axis to see different parts of the reflected environment. For more about rotating a text object, see Move and rotate 3D text.
Modify the appearance of a reflected environment

In the Appearance pane of the Text inspector (in the Environment section), do any of the following:

- Drag the Intensity slider to the left to make the reflected image appear dimmer, or drag the slider to the right to make the reflected image appear brighter.

- Drag the Rotation dial to change the angle at which the environment image appears reflected in the 3D text object.

![Lighting Interface]

**Tip:** By default, environments rotate around the Y axis (unlike other rotation controls in Motion which default to rotating around the Z axis). If you want to rotate around a different axis than the default, click the disclosure triangle next to the Rotation dial to reveal separate X, Y, and Z axis rotation dials.

- Drag the Contrast slider to the right to make the reflected image to create a sharper difference between the light and dark areas.

- Drag the Saturation slider to the left to reduce the amount of
Because the environment control effectively adds a light source to your 3D text object (even when Lighting Style is set to Off), you may want to turn off the Environment entirely—for example if you add scene lights to create a custom lighting environment.

- Deselect the activation checkbox to the left of the Environment controls.

Tip: If your project has more than one 3D text object, for more realistic results make sure that all text objects use same reflection environment.

For a list of Environment controls, see Lighting and environment controls.

Lighting and environment controls

Adjust the controls in the Lighting section of the Text Inspector’s Appearance pane to modify 3D text lighting:
Lighting controls

- *Lighting Style*: A pop-up menu to select a preset lighting style for the selected 3D text object. Choose any of the following:
• **Off**: Disables the 3D text lighting controls. Choose this option if you want to manually add your own lights to the project.

**Note**: You may also want to disable environmental lighting. See [Modify the lighting environment](#).

• **Standard**: Illuminates the text object from the front, from the left, and from the right.

• **Medium Center**: Creates a soft, flat light illuminating the text object from the center.

• **Medium Left**: Creates a soft, flat light illuminating the text object from the left.

• **Medium Right**: Creates a soft, flat light illuminating the text object from the right.
object from the right.

- **Above**: Illuminates the text object from above.
- **Backlit**: Illuminates the text object from behind.

**Note**: By default, environmental light causes additional illumination to fall on the front surface of the text object. To create a backlighting effect where the front of the text object appears entirely unlit, deselect the activation checkbox for the Environment controls to disable environmental lighting. For more information, see *Modify the lighting environment*.

- **Below**: Illuminates the text object from the bottom.
- **Diagonal Left**: Illuminates the text object from the upper-left corner.
- **Diagonal Right**: Illuminates the text object from the upper-right corner.
- **Drama Top Left**: Illuminates the text object from the top and left sides, with no illumination at all on the right or bottom.
- **Drama Top Right**: Illuminates the text object from the top and right sides, with no illumination at all on the left or bottom.

- **Intensity**: A slider to adjust the strength of the lights cast on the 3D text object.
- **Self Shadows**: A group of controls (available when you click the disclosure triangle) to set if and how the lighting causes text glyphs (individual characters) to cast shadows upon the other glyphs in the text object.
When Self Shadows is enabled, two additional controls become available:

- **Opacity**: A slider to adjust how visible the shadows are. This can be set above 100% to override the effect of the default light shading (based on the lighting model and setup).

- **Softness**: A slider to adjust how blurred the shadows appear.

### Environment controls

- **Environment**: An activation checkbox that, when selected, causes 3D text to appear to reflect lighting from a surrounding “environment.” Click the disclosure triangle to reveal additional adjustment controls:
  
  - **Type**: A pop-up menu to choose the image, gradient, or pattern that’s reflected. For information on using gradients, see [Gradient editor overview](#).
  
  - **Intensity**: A slider to adjust the strength of the environment light.
  
  - **Rotation**: A dial that controls the angle at which the environment image is mapped onto the object.
  
  - **Contrast**: A slider that increases or decreases the contrast of the environment image. More contrast creates weaker midtones, brighter highlights, and darker shadows; lower contrast creates stronger midtones, muted highlights, and muted shadows.
  
  - **Saturation**: A slider to adjust the visibility of the colors
within the environment image. More saturation creates more visible color; less saturation creates a more monochromatic image.

Add glow or drop shadow effects to 3D text

You can apply standard glow and drop shadow effects to 3D text objects just as you would to 2D text objects. However, the results always appear in only two dimensions.

Add a glow effect to a 3D text object

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, select the activation checkbox to the left of the Glow heading (near the bottom of the Appearance pane).

   The activation checkbox is highlighted blue, and a default yellow glow is applied to the text object.

3. Double-click the Glow heading to display parameter controls, then adjust Color, Opacity, and other settings to customize the glow effect.
Note: Adding a Glow effect to a 3D text object forces the object to be rasterized. For details, see Text and rasterization.

Add a Drop Shadow effect to a 3D text object

1. In the Layers list, Timeline, or Canvas, select a 3D text object.

2. In the Appearance pane of the Text Inspector, select the activation checkbox to the left of the Drop Shadow heading (at the bottom of the Appearance pane).

3. Double-click the Drop Shadow heading to display parameter controls, then adjust Color, Opacity, and other settings to customize the drop shadow effect.
Substance: Plastic
Type: Shiny
Color Type: Color
Color:

Glow

Drop Shadow
- Color:
- Opacity: 75.0%
- Blur: 0
- Distance: 5.0
- Angle: 315.0°

Click to switch drop shadow on or off.
Drop shadow controls
About 3D text intersection and layer order

Use the following intersection and layer order guidelines when working with 3D text:

- 3D text intersects only with other 3D text.
- For 3D text layers in the same group to intersect, they must be contiguous in the Layers list (with no other layers separating the 3D text layers).
- For 3D text layers in different groups to intersect, the 3D text layers must be contiguous in the Layers list (with no other layers in either group separating the 3D text layers). Additionally, the groups must be set to 3D. For more information about converting 2D groups to 3D groups, see Create 3D intersection.
- 3D text uses only layer order: For 3D text to appear above other non-3D text layers, the 3D text must be positioned above the other layers in the Layers list.
For more information about layer order, see Create 3D intersection.

Certain operations, such as the application of some filters or selecting the Crop checkbox in the Properties Inspector, can
cause a group containing 3D text to be rasterized. For more information, see **Text and rasterization**.
After you create 2D or 3D text, you can apply dynamic animation effects using behaviors, keyframes, or a combination of both.

Although you can animate text using standard behavior types (Basic Motion, Parameter, or Simulation behaviors), two behavior categories in Motion are designed specifically for text:

- **Text Sequence behaviors** are preset behaviors that apply specific effects with no further customization necessary (although you can easily adjust them if you want to modify their effects). There are dozens of expressive presets to choose from, including Blur In, Frightened, Shock, Inflated Out, and Squish.

- **Text Animation behaviors** are highly customizable animation effects that allow you to create:
  - **Scrolls and crawls** for titles, credits, and lower thirds
  - **Animated text tracking**, which makes characters spread apart or compress together
• “Type-on” effects, which make characters pop into view sequentially)

• Powerful custom sequencing effects that animate color, outline, opacity, scale, and other attributes character by character

You apply a text behavior to a text object the same way you apply standard behaviors to any object in Motion. And after you apply and customize a text behavior, you can save it to the Library for future use.

Apply a text behavior

You apply text behaviors in the same manner as all other behaviors in Motion—via the Library or the Add Behavior pop-up menu in the toolbar.

Apply a text behavior from the Library

1. Create a text layer in your project.

   For more information, see Add text or Add 3D text.

2. In the Library, select the Behaviors category, then select the Text Animation or Text Sequence subcategory.
The Text Animation subcategory contains behaviors for creating scrolls and crawls, text tracking, type-on effects, and custom text animation effects. The Text Sequence subcategory contains ready-made text animation presets that create specific effects with little or no customization necessary.

3. Select a text behavior in the stack.
A preview of the animation plays in the preview area. The preview merely represents the default animation of the behavior, which can be modified later.

4. Do one of the following:
   - Drag the behavior to a text layer in the Canvas, Layers list, or Timeline.
   - Click the Apply button in the preview area.

The behavior is applied, and the Text HUD is replaced with the Text Behavior HUD (if the HUD is not visible, press F7).

**Note:** When you apply a behavior by dragging it from the Library, you can apply the behavior to only one text layer in your project at a time. If you need to apply a behavior to multiple text layers at the same time, use the Add Behavior pop-up menu, described in the next task.

---

**Apply a text behavior from the Add Behavior pop-up menu**

1. Select one or more text layers in the Layers list, Canvas, or Timeline.
2. In the toolbar, click the Add Behavior pop-up menu, then do one of the following:

- Choose Text Animation, then choose a behavior from the submenu.
- Choose Text-Basic, Text-Continuous, Text-Energetic, Text-Glow, Text-Highlighter, or Text-Subtle, then choose a preset behavior from the submenu.

The behavior is applied, and the Text HUD is replaced with the Text Behavior HUD (if the HUD is not visible, press F7).

Use preset text behaviors

About the preset text behaviors

Preset text sequence behaviors, found in the Text Sequence subcategory of behaviors in the Library, are preset versions of the Sequence Text behavior. The parameters in these preset behaviors are already animated (often with keyframes), requiring little or no customization on your part (although you can always modify them).

There are six classes of preset behaviors in the Text Sequence subcategory:

- Text-Basic: Simple animations with a start (text appears) and
• **Text-Simple**: Basic animations with a start and end, such as a fade-in or a blur-out.

• **Text-Continuous**: Animations without a start or end, such as text that wiggles continuously.

• **Text-Energetic**: Animations with a start (text appears) and end (text disappears) with a little more pizazz, such as text that bounces in or twirls out.

• **Text-Glow**: Animations with a start (text appears) and end (text disappears) that create glowing effects, such as a wisp in or a flare out.

• **Text-Highlighter**: Animations that are applied to the beginning of a text layer, such as a quick shiver or stretch.

• **Text-Subtle**: Animations with a start (text appears) and end (text disappears) that create soft, mellow effects, such as text that shimmers in or glows out.

After you apply a preset text behavior, you can leave it as is, or customize it to adjust the text effect or timing. Because these presets are all based on the highly customizable Sequence Text behavior, you can easily modify parameter values, add additional parameters, or remove parameters. For example, the Arrange In behavior automatically animates text Opacity, Scale, and Rotation values by default. However, you can add a parameter, such as Position, to the behavior.

The parameter controls in the Behaviors Inspector vary depending on the preset behavior you apply. Some preset behaviors are composed of multiple behaviors. For example, the Quiver preset behavior is made from a customized Sequence Text behavior and a Randomize parameter behavior.
For more information about the adjustable controls in preset text behaviors, see "Sequence Text behavior controls." For more information about Parameter behaviors, see "Parameter behaviors overview."

**Tip:** Because most preset text sequence behaviors are keyframed, it’s often helpful to see where the keyframes occur when customizing. In the Timeline, click the Show/Hide Keyframes button to display keyframes superimposed over the behavior’s timebar.

---

**Customize a preset text behavior**

After you apply a preset text behavior from the Text Sequence subcategory, you can modify its settings to suit your needs.

---

**Add a parameter to a preset text behavior**
1. In the Layers list or Timeline, select a preset text sequence behavior.

2. In the Parameter row of the Behaviors Inspector, click the Add pop-up menu, then choose a parameter.

   The parameter is added to the preset.

---

**Modify the speed of a preset text behavior**

When you add a preset text behavior, its bar in the Timeline is usually much shorter than that of the text layer it’s applied to. This is by design: most preset text animations apply a brief introductory effect to a text layer (a fade-in, for example).

You slow down or speed up the animation by changing the duration of the behavior’s bar in the Timeline.

1. In the Layers list or Timeline, select a preset text sequence behavior.

2. In the mini-Timeline or Timeline, do one of the following:
   - To slow the effect, drag the right end of the behavior bar right (to lengthen the effect) to the frame where you want
the animation to end.

Note: You can also move the playhead to the frame where you want to set the new Out point, then choose Mark > Mark Out (or press O).

- To speed up the effect, drag the right end of the behavior bar left (to shorten the behavior) to the frame where you want the animation to end.

Note: You can also move the playhead to the frame where you want to set the new Out point, then choose Mark > Mark Out (or press O).

Change the default glow color of a preset text behavior

If a preset text behavior contains a glow parameter, you can change the default glow color in two ways: via the Text Inspector or the Behaviors Inspector.

1. In the Layers list or Timeline, select the preset text behavior.
2. Do one of the following:

- In the Appearance pane of the Text Inspector, choose a color in the Color well of the Glow controls.

**Important:** Selecting the Glow checkbox results in an additive effect: The values defined in the Appearance pane are added to those in the text behavior. This may cause the look of the preset to change.

- In the Parameter row of the Behaviors Inspector, click the Add pop-up menu, then choose Glow > Color.

  The Color parameter is added to the Glow parameters in the behavior.

---

**Example: Modify the Flare In behavior**

In this section, the Flare In behavior (from the Text-Glow subcategory of preset text behaviors) is used to show how to modify a preset text behavior.

The following steps begin at the first frame of the text.

1. Select the text layer to be animated, then click the Add Behavior pop-up menu in the toolbar and choose Text-Glow > Flare In.

  At the first frame, the text is not visible because Face opacity and Glow opacity start at 0%, then move to 100%.
2. Press the Space bar to play the project and see the applied effect.

The text characters fade in from 0% to 100% percent opacity, and sharpen from a blur value of 10. A glow overlays the effect as the text appears.

3. In the Layers list, select the Flare In behavior.

The Behaviors Inspector opens, listing the specific text parameters used to create the animation (above the Add and Remove pop-up menus in the Parameter row).
4. In the Parameter row, click the Add pop-up menu, then choose Format > Rotation.

A Rotation parameter is added to the sequence (click the Format disclosure triangle to see the Rotation parameter).

5. Move the playhead to the first frame of the text, then click the Record button in the transport controls under the Canvas (or press A) to turn on keyframe recording.

6. In the Behaviors Inspector, set the Rotation dial to 90.

7. Press the Space bar to play the project and see the result.

Because the Rotation parameter has only a single keyframe,
the text remains static at 90 degrees.

8. Move the playhead to the frame where you want the rotation animation to end, and then in the Behaviors Inspector, set Rotation to 0.

Now that you’ve set a second keyframe value, the sequence is animated.

**Note:** You can edit the keyframes in the Keyframe Editor. For more information, see [Keyframing overview](#).

9. Return the playhead to frame 1 of the text and press the Space bar to play the project.

As the project plays, the text rotates from 90 degrees to 0 degrees.
You can change the color or other attributes of the text glow by using the Glow controls in the Appearance pane of the Text Inspector.

Create custom text sequence behaviors

Apply the Sequence Text behavior

You can build custom text sequence animations using the Sequence Text behavior (in the Text Animation category of behaviors in the Library). The Sequence Text behavior (not to be confused with the Text Sequence category of preset behaviors in the Library) lets you animate text attributes—scale, position, color, opacity, glow, and so on—in sequence, character by character. For example, you can create a sequence in which text characters fall vertically into place as they scale down, fade in, and rotate.

Because the Sequence Text behavior is not a preset, applying and activating it is a two-stage process:

1. **Stage 1:** Apply the Sequence Text behavior to a text layer in the Text Sequence category of preset behaviors in the Library.
Apply the Sequence Text behavior

- **Stage 1:** Apply the Sequence Text behavior to a text layer in your project.

- **Stage 2:** In the Behaviors Inspector, assign the parameters you want to animate, then adjust controls to set the animation’s direction, speed, number of loops, and other qualities. (Optionally, you can assign the Position, Rotation, and Scale parameters by dragging onscreen controls in the Canvas. See “Assign and activate Sequence Text parameters in the Canvas,” below.)

**Tip:** Using the Transform Glyph tool, you can modify individual text characters independently of the influence of the applied Sequence Text behavior. For more information, see Text glyphs overview.

---

**Apply the Sequence Text behavior**

- Select a text layer in your project, then click the Add Behavior pop-up menu in the toolbar and choose Text Animation > Sequence Text.

  The behavior is applied, and the first character of text is selected with the Adjust Item tool.
Important: You must add at least one parameter to the behavior before animation can occur. For details, see the next task.

Assign and activate Sequence Text parameters in the Inspector

After you apply the Sequence Text behavior to a text layer in your project (as described in the previous task), you must assign the parameters you want to animate.

1. In the Layers list or Timeline, select an applied Sequence Text behavior.

The Behaviors Inspector opens.

In the upper area of the Sequence Text controls are Add and Remove pop-up menus, used to select text parameters to be sequenced, or to remove parameters after they’re added. Under the pop-up menus are sequence controls, which include options for setting the direction and speed of the animation, whether the animation is applied per character, per word, per text object, and so on.
In this simple example, assign the Opacity, Scale, and Glow Scale parameters to the behavior.

2. In the Parameter row, click the Add pop-up menu, then choose Format > Opacity.
An Opacity slider is added in the Behaviors Inspector, in the Format area above the Add and Remove pop-up menus.

3. Set the Opacity slider to 0, then press the Space bar to play the project.

By default, the opacity sequences from the value set in the behavior (0%) to the original value of the text (100%). You can change this sequencing order in the Sequencing pop-up menu.

4. Click the Sequencing pop-up menu, then choose To.

Now, when you play the project from the beginning, the opacity fades to the value set in the behavior (0%) from the original value of the text (100%).

5. Click the Add pop-up menu, then choose Format > Scale.

The Scale slider is added to the Behaviors Inspector.

6. Click the Add pop-up menu again, then choose Glow > Scale.

The Glow Scale slider is added to the Behaviors Inspector.

7. Set the Scale slider to 250%, set the Glow Scale slider to 250%, then set the Spread slider (in the Controls section of the Behaviors Inspector) to 4.
The opacity sequences to the values defined in the behavior from the original values. The increased spread value softens the sequence between the characters.

**Note:** Although the style effects created in the Sequence Text behavior (Face, Outline, Glow, and Drop Shadow) are independent of parameters in the Appearance pane of the Text Inspector (Face, Outline, Glow, and Drop Shadow), changes made in the Appearance pane affect the sequenced text. For example, if you select the Glow checkbox in the Appearance pane after adding Glow to the Sequence Text behavior, the appearance of the glow may alter. This is because the Glow settings in the Appearance pane are additive to the sequence behavior (the glow may appear brighter or more blurred). In the following illustration, the glow is scaled and offset in the Appearance pane.
The above example covers only a portion of the options in the Sequence Text behavior. Using the behavior’s parameters, you can create a nearly endless variety of sequences. You can define the speed in which the sequence moves through the text, as well as whether the sequence moves through the text per character, word, or line. You can also change the direction of the sequence and define the number of times the sequence loops over its duration. Variance and randomization can also be added to values defined in the behavior. For more information on these controls, see Sequence Text behavior controls.

Assign and activate Sequence Text parameters in the Canvas

As an alternative to assigning parameters to the Sequence Text behavior in the Behaviors Inspector, you can assign three basic parameters (Position, Rotation, and Scale) by dragging onscreen controls in the Canvas.

1. With the Sequence Text behavior applied and the first character (glyph) selected (using the Adjust Item tool in the toolbar), do any of the following:
- **Sequence the position of the text:** Drag the character in the Canvas to a new position.

In the Behaviors Inspector, the Position parameter is added to the Format category (above the Add and Remove pop-up menus). The values in the Position parameter can be modified in the Behaviors Inspector (using the Position value sliders) as well as in the Canvas (by dragging the glyphs of the text object).

- **Sequence the rotation of the text:** Drag a rotation handle of a selected glyph in the Canvas. To display the rotation handles, click in the Canvas, then hold down the Command key. For more information on using onscreen
In this example, the text is rotated on its Y axis. In the Behaviors Inspector, the Rotation parameter is added to the Format category (above the Add and Remove pop-up menus).

- **Sequence the scale of the text:** Drag a scale handle of a selected glyph in the Canvas. (To scale the text uniformly, press Shift while dragging a scale handle in the Canvas.)

In the Behaviors Inspector, the Scale parameter is added to the Format category (above the Add and Remove pop-up menus).

2. Press the Space bar to play the project.
Note that in the Controls section of the Behaviors Inspector, the Sequencing pop-up menu is set to From, the default setting. As a result, upon playback, the text in your project moves *from* the value in the Position parameter *to* the original value (the position of the text before you dragged it in the Canvas).

For more information on Sequence Text parameters, see [Sequence Text behavior controls](#).

**Note:** When using the Sequence Text behavior, glyphs are selected with the Adjust Item tool rather than the Transform Glyph tool. For more information on the Transform Glyph tool, see [Text glyphs overview](#).

When you select a glyph with the Adjust Item tool, a section of the Timeline is highlighted, indicating when the selected glyph is affected by the sequence behavior.
Fine-tune an applied Sequence Text behavior

You can further customize an applied Sequence Text behavior, by softening transitions between characters and words or removing parameters. You can also adjust the appearance of the text independently of the Sequence Text behavior.

Remove a parameter from the Sequence Text behavior

- Select an applied Sequence Text behavior in the Layers list or Timeline, then, in the Parameter row of the Behaviors Inspector, click the Remove pop-up menu and choose a parameter.

  The chosen parameter is removed from the behavior.

Create a softer transition between each text character

If the transition between two characters in a sequence animation is too abrupt, control the amount of falloff by adjusting the Spread value.

- After assigning parameters to a Sequence Text behavior, drag the Spread slider (in the Behaviors Inspector) to the right to soften the changes between the text characters.
Modify a parameter without adding it to the animated sequence

If you want to modify the face, outline, glow, or drop shadow of text, but don’t want that modification to be animated, make the adjustment in the Appearance pane of the Text Inspector. Parameters modified in the Appearance pane do not affect an applied Sequence Text behavior. For example, by adding an outline to text via the Appearance pane, the text outline remains constant during the sequence animation.

1. Select a text object has an applied Sequence Text behavior, then open the Appearance pane in the Text Inspector.

2. Select the Outline activation checkbox.
   
   When selected the activation box is highlighted blue. Additionally, the Outline controls become available, and an outline is added to the selected text in the Canvas.

3. In the Appearance pane, adjust the Outline controls.
When you play back the project, the text is animated according to settings in the Sequence Text behavior, but the text outline remains constant, and does not sequence.

**Note:** Because parameters set in the Sequence Text behavior are independent of parameters set in the Appearance pane, you may see changes in the appearance of some attributes when you select parameter checkboxes in the Appearance pane. For example, if you create a sequence that animates text glow and then select the Glow checkbox in the Appearance pane of the Text Inspector, the effect is additive. The glow in the Appearance pane is added to the glow created in the Sequence Text behavior.

---

**Add keyframes to a Sequence Text behavior**

When From, To, Through, or Through Inverted are chosen from the Sequencing pop-up menu, the animation moves from one side of the text object to another, animating the text by character, word, or line. By choosing From Keyframes from the Sequencing pop-up menu, you can create a sequenced animation with specific timing. For example, you can create an uneven flicker effect by keyframing the opacity of the text, or move text characters in sequence to specific locations in the Canvas at certain points in time by keyframing the position of the text.

---

**Add keyframe animation to a Sequence Text behavior**
This example keyframes the Position parameter.

1. Select a text in your project, then click the Add Behavior pop-up menu in the toolbar and choose Text Animation > Sequence Text.

2. In the Behaviors Inspector, click the Sequencing pop-up menu, then choose From Keyframes.

3. Drag the playhead to the frame where you want to begin the animation, then click the Record button in the transport controls under the Canvas (or press A) to turn on keyframe recording.

When keyframe recording is enabled, the values in the Inspector for parameters that can be animated turn red.

**Note:** You can also animate parameters by manually adding an initial keyframe. After a keyframe is added to a parameter, any further adjustment to that parameter adds a keyframe at the current playhead position, independent of the Record button state. For more information, see [Keyframing overview](#).

4. Do one of the following:
   - In the Behaviors Inspector, click the Add pop-up menu, choose Format > Position, then use the Position value sliders to define the beginning (or ending) position of the text.
   - In the Canvas, drag the selected text character to its beginning (or ending) position.

A keyframe is added to the Position parameter.
5. Go to the next frame where you want to set a position keyframe, then do one of the following:

- In the Behaviors Inspector, change the Position value.
- In the Canvas, drag the selected text character to a new position.

A second position keyframe is created.

6. Repeat Step 5 until you add all the keyframes you need.

When you play the project (press the Space bar), the text characters move in sequence along the path defined by the keyframes.
Note: If you subsequently change the Sequencing parameter to another option (such as Through Inverted or To) and then change Sequencing back to From Keyframes, the keyframed animation path is retained.

Sequence the distortion of a 2D text appearance attribute

In addition to using the sliders and value sliders in the Inspector, you can use onscreen controls to sequence the Four Corner parameter, creating warp effects that manipulate the text Face (color fill), Outline, Glow, and Drop Shadow parameters of text. In the following simple example, the distortion of the text glow is sequenced.

Note: You cannot sequence the distortion of an appearance attribute for 3D text.

Sequence the warping of a text glow effect

1. Select a text layer in your project, then click the Add Behavior pop-up menu in the toolbar and choose Text Animation > Sequence Text.

2. In the Parameter row of the Behaviors Inspector, click the Add pop-up menu, then choose Glow > Four Corner.

In the Inspector, the Glow Four Corner parameter is added to the sequence above the Add and Remove pop-up menus.
The Four Corner parameter is used to spatially distort the text’s glow effect.

3. To activate onscreen handles, click the Attribute pop-up menu in the lower portion of the Behaviors Inspector, then choose Glow.

Onscreen handles appear.
4. Do one of the following:

- To distort the glow, drag a distort handle (any of the corner handles).

**Note:** Some characters may not appear to be affected when you drag in the Canvas. However, when you play the project, all characters are affected.

- To shear the glow, drag a shearing handle (any of the middle handles).
You can also drag the value sliders in the Four Corner parameter for Glow in the Behaviors Inspector. Click the Four Corner disclosure triangle to show the individual Bottom Left, Bottom Right, Top Right, and Top Left controls.

5. Press the Space bar to play the project.

The glow distortion is sequenced through the text, based on the settings in the Sequence Text behavior parameters.

Sequence Text behavior controls
The Sequence Text behavior has the following parameter controls in the Behaviors Inspector:

Parameter selection controls
- **Parameter (Add and Remove):** Two pop-up menus to add the text format and style parameters you want to animate in the sequence, or to remove them. After you use the Add pop-up menu to add a parameter to the sequence, that parameter’s
controls appear above the Add and Remove pop-up menu items. The Add pop-up menu items include:

- **Format**: Opens a submenu containing the following format parameters for sequencing: Position, Opacity, Scale, Rotation, Tracking, Baseline, Slant, and Character Offset. Except for Character Offset, these parameters are also found in the Format pane of the Text Inspector. (For more information on text format parameters, see Display the Format pane of the Text Inspector.)

Choose the Character Offset option to offset characters alphabetically or numerically. The amount of the offset is determined by the value set in the Character Offset slider. In the following illustrations, Character Offset and Position are sequenced. The Character Offset slider is set to 3. The words move in sequence from the character offset value to form the original words, “offset 123.”

Choosing Character Offset also activates the Character Set pop-up menu, where you can choose Preserve Case & Digits to ensure that offset characters respect the case and number of the original text. For example, with this option selected, an uppercase letter remains uppercase as other letters cycle through its position.

- **3D**: Opens a submenu containing the following 3D text-specific format parameters for sequencing: Extrusion
Depth, Front Edge Size, and Back Edge Size. These parameters are also found in the Appearance pane of the Text Inspector when the 3D activation checkbox is selected. For more information, see 3D Text controls.

- **Face**: Opens a submenu (available for 2D text) containing the following face parameters for sequencing: Color, Opacity, Blur, or Four Corner. For more information on text face parameters, see Face controls in the Appearance pane.

- **Outline**: Opens a submenu (available for 2D text) containing the following outline parameters for sequencing: Color, Opacity, Blur, Width, Layer Order, or Four Corner. For more information on text outline parameters, see Outline controls in the Appearance pane.

- **Glow**: Opens a submenu containing the following glow parameters for sequencing: Color, Opacity, Blur, Radius, Scale, Offset, Layer Order, or Four Corner. For more information on text glow parameters, see Glow controls in the Appearance pane.

  **Note**: The Glow parameter cannot be adjusted or sequenced with 3D text.

- **Drop Shadow**: Opens a submenu containing the following drop shadow parameters for sequencing: Color, Opacity, Blur, Scale, Distance, Angle, and Four Corner. For more information on text drop shadow parameters, see Drop Shadow controls in the Appearance pane.

  **Note**: The Drop Shadow parameter cannot be adjusted or sequenced with 3D text.

- **3D text material** (name varies depending on applied 3D Text controls, including Face controls, Outline controls, Glow controls, or Drop Shadow controls in the Appearance pane).
Sequencing controls

Adjust these controls to set how the sequencing occurs. Specify the direction, scope, and speed of the sequencing action, and what happens when the sequencing action reaches the end of your text object.

- **Sequencing**: A pop-up menu to set how the sequence animation moves through the text unit. (A text unit can be a character, word, line, or an entire text object, as set in the Animate pop-up menu, described below.) There are five items in the Sequencing pop-up menu:
  - **To**: Animation begins at the original parameter value and moves to the value set in the sequence behavior. For example, if the original opacity value is 100% and opacity is set to 0% in the Sequence Text parameters, the text unit begins completely opaque and becomes completely transparent.
  - **From**: Animation moves from the value set in the sequence behavior to the original parameter value. For example, if the original opacity value is 100% and opacity is set to 0% in the Sequence Text parameters, the text unit begins completely transparent and becomes completely opaque. This is the opposite of the To option in the Sequencing pop-up menu.
  - **Through**: The sequence goes through a full animation cycle.
Through:
The sequence goes through a full animation cycle starting at the original value of the parameter, moving to the value set in the sequence behavior, then returning to the original value of the parameter. For example, if the original opacity value is 100%, and opacity is set to 0% in the Sequence Text parameters, the text unit begins completely opaque, becomes transparent, and then becomes completely opaque again.

Through Inverted:
The sequence goes through an inverted animation cycle starting from the value set in the sequence behavior, moving to the original value, then returning to the value set in the sequence behavior. For example, if the original opacity value is 100% and opacity is set to 0% in the Sequence Text parameters, the text unit begins completely transparent, becomes opaque, and then becomes completely transparent. This is the opposite of the Through Sequencing option.

From Keyframes:
Lets you keyframe how the animation moves through the values set in the Sequence Text parameters. When From Keyframes is selected from the Sequencing pop-up menu, the Minimum and Maximum parameters in the Variance controls (see description below) are replaced with the Amount parameter, and the Fix pop-up menu appears. See Add keyframes to a Sequence Text behavior.

Animate: A pop-up menu to specify how animation is sequenced. There are six options:

- **Character:** Sequences the animation by single characters of text (including spaces).
- **Character (without spaces):** Like the Character setting,
sequences single characters of text, but does not treat spaces as characters (spaces are ignored).

- **Word**: Sequences the animation by word.
- **Line**: Sequences the animation by lines of text.
- **All**: Sequences the animation through the entire text object.
- **Custom**: Lets you customize the size of the sequenced text unit.

- **Start**: A slider (available when Animate is set to Custom) to define the starting point of the selection to be sequenced.
- **End**: A slider (available when Animate is set to Custom) to define the ending point of the selection to be sequenced.
- **Select**: Controls to set the range of characters affected by the animation defined in the Animate pop-up menu. Click the disclosure triangle to reveal the controls:
  - **Range**: A pop-up menu (used in combination with the Start Index and End Index parameters, described below) to specify the range of text sequenced by All (the default setting), Character, Character in Word, Character in Line, Word, Word in Line, or Line.
  - **Start Index**: A slider to set the beginning of the range for the sequence animation.

In a simple example, if Animate is set to Character for a multiline text object, the sequence moves through the characters one at a time, line by line. If the Range parameter is then set to Character in Line and Start Index set to 1, the first character of each line is not animated, but the remaining characters are animated (as long as the
End Index parameter is set to the number of characters in the longest line of text).

- **End Index**: A slider to set the end of the range for the sequence animation.

- **Invert**: A checkbox that, when selected, transposes the animation. In a simple example, the first character of each word in a line of text fades in. When Invert is selected, the first character of each word is fully visible, and the rest of the characters fade in.

- **Reverse**: A checkbox that, when selected, reverses the animation. In a simple example, the first character of each word in a line of text fades in. When Reverse is selected, the last character of each word fades in.

- **Spread**: A slider to control the amount of falloff at the beginning and end of the sequencing. To create a softer transition between each text unit, increase the Spread value. See [Fine-tune an applied Sequence Text behavior](#).

- **Direction**: A pop-up menu to set the direction of the sequencing.
  - **Forwards**: Sequences in the direction of the letters (typically left to right).
  - **Backwards**: Sequences in the reverse direction (typically right to left).
  - **Center to Ends**: Sequences from the center of the text outwards.
  - **Ends to Center**: Sequences from the outer edges of the text inwards.
  - **Random**: Randomizes the direction of the sequencing.
• Random Seed: Controls (available when Direction is set to Random) to change the current “randomness” (seed number) of the direction of the sequence. Type a new number in the text field or click the Generate button.

• Speed: A pop-up menu to set whether the rate of the sequence remains constant or changes. There are seven options:
  • Constant: The sequence animation moves from one end of the text to the other at a constant rate. The sequence moves in the direction specified in the Direction pop-up menu.
  • Ease In: The sequence animation begins slowly and increases to normal speed as it moves through the text.
  • Ease Out: The sequence animation begins at normal speed and slows toward the end of the text.
  • Ease Both: The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the duration of the text, then slows as it reaches the end of the text.
  • Accelerate: The rate of the sequence animation increases as it moves through the text.
  • Decelerate: The rate of the sequence animation decreases as it moves though the text.
  • Custom: Lets you keyframe how the selection (the animation) moves through the text.

• Custom Speed: A slider (available when Speed is set to Custom) to keyframe the completion of the sequencing by
defining the location of the text where the animation is in effect.

- **Loops**: A slider to set the number of times the animation sequences through the text over its duration.

- **Apply Speed**: A pop-up menu to control the speed of the sequencing over multiple loops. There are three options:
  - **Once Per Loop**: The setting chosen in the Speed pop-up menu is applied one time for each loop. For example, if Speed is set to Accelerate, the rate of the sequence animation increases as it moves through the text for every loop.
  
  - **Over Entire Duration**: The setting chosen in the Speed pop-up menu is applied one time for the length of the behavior. For example, if Speed is set to Accelerate, the rate of the sequence animation increases as it moves through the text over the entire duration of the behavior, regardless of the number of loops.
  
  - **Per Object**: The setting chosen in the Speed pop-up menu is applied one time for each object for every loop. For example, if Speed is set to Accelerate, the rate of the sequence animation increases as it moves through each text object for every loop.

- **Start Offset**: A slider to offset the start of the effect of the sequence behavior. By default, the sequence animation is in effect from the beginning of the behavior. For example, to start the sequencing 60 frames in from the start of the text object (or project), drag the Start Offset slider to 60 or enter 60 in the adjacent value slider. Using this slider to start the effect, rather than trimming the start of the behavior in the
Timeline, freezes the start of the effect (in this example) until frame 61. Trimming the start of the behavior resets the text to its original settings.

- **End Condition**: A pop-up menu to specify how the animation is applied to the end of the sequence animation. There are three options:
  - **Hold**: Completes the sequence animation cycle one time, then starts it over from the beginning (after the last text unit in the sequence completes its animation).
  - **Wrap**: Treats the sequence animation as a continuous loop so the spread wraps from the last text unit in the sequence to the first text unit.
  - **Ping-Pong**: Completes the sequence animation cycle forward, then completes the animation backward, then forward, and so on.

- **End Offset**: A slider to offset the end of the effect of the sequence behavior. By default, the sequence animation is in effect until the end of the behavior. For example, to stop the sequencing 60 frames from the end of the text object (or project), drag the End Offset slider to 60 or enter 60 in the adjacent value slider. Using this slider to stop the effect, rather than trimming the end of the behavior in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior resets the text to its original settings.

**Variance controls**

Adjust these controls to randomize the attributes assigned to
sequence through the text. For example, if you add variance to a scale sequence, the text scale is randomized rather than moving from the original Scale value to the Scale value defined in the sequence behavior. These sliders control the frequency of the randomness. When sequencing is set to To, From, Through, or Through Inverted, it’s useful to see how the Variance numbers affect the randomness. The following image shows a sequence animation in which the Y Position is offset. When a low variance value (frequency) is applied, the randomness is very smooth along the line of text—like the text is riding a very slow and smooth wave.

![Sequence animation with low variance](image1)

As the variance is increased, the randomness increases across the line of text. Because the text is riding on very short and frequent waves, the letters are offset in the Y axis with more randomness.

![Sequence animation with high variance](image2)
When From Keyframes is chosen from the Sequencing pop-up menu, the same principle applies, so a low variance value causes the text to offset from its animation with a smooth path, while a high variance causes more randomness.

**Note:** Because the Variance parameters are sensitive, low values are necessary for smooth animation results.

- **Variance:** A slider to fluctuate the values of the attributes assigned to sequence through the text. For example, if you add variance to an opacity sequence, the text opacity is randomized rather than moving strictly from the original Scale value to the Scale value defined in the sequence behavior.

- **Minimum:** A slider to define the lower boundary of the variance for the sequenced parameter value. For example, if you set Minimum to 25% for a sequence animating text scale, the minimum size that the text unit will scale to is 25% of the Scale value set in the behavior.

- **Maximum:** A slider to define the upper boundary of the variance for the sequenced parameter value. For example, if you set Maximum to 75% for a sequence animating text scale, the maximum size that the text unit scales to is 75% of the Scale value set in the behavior.

- **Amount:** A slider (available when From Keyframes is chosen from the Sequencing pop-up menu) to define the maximum amount that the animated parameter can deviate from its animation value. For example, the following image shows a custom animation of a glyph in the positive Y direction. When Amount is set to 50, the glyph deviates no more than 50 pixels to the left or right of the animation path. The bold red line shows the animation path, and the thinner red line displays the
randomized path.

- **Noisiness**: A slider to add an additional overlay of random variance. Higher Noisiness values result in more erratic variations in the affected parameter.

- **Seed**: Click the Generate button to create an initial random seed for creating randomness in the Variance parameters. To change the randomness results after you click Generate, click the button again or enter a value in the field.

- **Fix**: A pop-up menu (available when Sequencing is set to From Keyframes) to fix the values defined in the behavior to the start, end, or start and end of the behavior. There’s also an option to not fix the values. Variance must be greater than 0 for this parameter to have any effect. There are four menu options:
  - **Start Point**: When variance is applied, the values defined in the Sequence Text behavior (above the Add and Remove pop-up menus in the Behaviors Inspector) at the start and end of the behavior are fixed to the first frame of the behavior. In the following images, the text position is sequenced. Fix is set to Start Point.
• *End Point:* When variance is applied, the values defined in the Sequence Text behavior (above the Add and Remove pop-up menus) at the start and end of the behavior are fixed to the last frame of the behavior. In the following images, the text position is sequenced. Fix is set to End Point.

• *Both:* When variance is applied, the values defined in the Sequence Text behavior (above the Add and Remove pop-up menus) at the start and end of the behavior are fixed to the first and last frames of the behavior.

• *Neither:* When variance is applied, the values defined in the Sequence Text behavior (above the Add and Remove pop-up menus) at the start and end of the behavior are not fixed to the first or last frames of the behavior. In the following images, the text position is sequenced. Fix is set to Neither.
- **Attribute:** A pop-up menu to sequence the warping of attributes. There are five options:

  - **Transform Glyph:** Displays the glyph onscreen controls, allowing for the selection of characters of a text object for direct manipulation. For more information about sequencing using the glyph onscreen tools, see Add keyframes to a Sequence Text behavior.

  - **Face:** Displays onscreen controls that allow you to modify the shape, size, and position of the face (color fill) of text characters.

  - **Outline:** Displays onscreen controls that allow you to modify the shape, size, and position of the outline of text characters.

  - **Glow:** Displays onscreen controls that allow you to modify the shape, size, and position of the glow of text characters.

  - **Drop Shadow:** Displays onscreen controls that allow you to modify the shape, size, and position of the drop shadow of text characters.

  For more information about sequencing the warping of text attributes, see Sequence the distortion of a 2D text appearance attribute.

- **Position Type:** A pop-up menu to specify whether an attribute
is offset from the text uniformly or based on the size of text characters. There are two options:

- **Absolute:** When offsetting attributes, such as glows, shadows, and so on from text objects, choose Absolute to create an even offset regardless of the size of the text characters. In the following image, the yellow glow is uniformly offset from the white text because Absolute is chosen from the Position Type pop-up menu.

- **Relative:** When offsetting attributes, such as glows, shadows, and so on from text objects, choose Relative to create an offset based on the size of the text characters. In the following image, the yellow glow is offset from the white text based on the size of the text characters because Relative is chosen from the Position Type pop-up menu.
Create scrolling text

Use the Scroll Text behavior

The Scroll Text behavior (in the Text Animation category of behaviors in the Library) creates scrolling or crawling text, and is often used to create end credits in film and television production. However, Scroll Text is flexible and can be applied to other objects in a Motion project—shapes and images, for example—to create integrated credits, prologues, and so on.

You can apply the Scroll Text behavior to any kind of text in your project, including text imported from RTF or TXT files. When you apply the Scroll Text behavior, text scrolls vertically in the Canvas by default. However, you can set the Scroll Text behavior to scroll horizontally (a text crawl), as well.

Create a vertical scroll

1. Apply the Scroll Text behavior (from the Text Animation behavior category) to the text layer (or any object) you want to animate.

For more information, see Apply a text behavior.

Because vertical scrolling is the default option, the text shifts to below the Canvas for the beginning of the scroll. You can change the direction, position, and speed of the scroll in the Behavior Inspector or HUD.
2. Click the Play button below the Canvas (or press the Space Bar).

The text scrolls upward in the Canvas.

3. To edit the text, double-click the text in the Canvas.

The text stops scrolling, the ruler appears at the top edge of the text, and the scroll control becomes available at the right edge of the text. To continue playback, deselect the text by pressing Esc or by clicking in an empty area of the Layers list or the Timeline layers list. For more information on scroll controls, see Layout controls in the Layout pane.

4. To customize the scroll, adjust the parameters in the Behaviors Inspector.

For more information on Scroll Text behavior parameters, see Scroll Text controls.

Create a horizontal scroll

1. Apply the Scroll Text behavior (from the Text Animation behavior category) to the text (or any object) you want to animate.

   For more information, see Apply a text behavior.

2. In the Scroll Text HUD or Behaviors Inspector, click the Scroll Direction pop-up menu, then choose Horizontal.

   The text shifts off the Canvas to the right for the beginning of
the crawl, and is positioned in a single line, as the Layout Method parameter in the Layout pane of the Text Inspector switches to Crawl.

**Note:** When the Scroll Text behavior is applied to text, the Layout Method parameter is dimmed, indicating that you cannot manually change the layout method in the Layout pane. However, you can override this limitation by selecting the Allow Layout Override checkbox in the Behaviors Inspector. For more information, see [Scroll Text controls](#).

3. Click the Play button.

   The text crawls leftward in the Canvas.

4. To edit the text, double-click the text in the Canvas.

   The text stops scrolling, and the scroll control becomes available at the lower edge of the text. To continue playback, deselect the text by pressing Esc or clicking in an empty area of the Layers list or Timeline layers list. For more information on scroll controls, see [Layout controls in the Layout pane](#).

5. To customize the scroll, adjust the parameters in the Behaviors Inspector.

   For more information on Scroll Text behavior parameters, see [Scroll Text controls](#).

---

**Change the speed of the scroll in the Timeline**
In the Timeline, do one of the following:

- Trim the behavior by dragging the end of its bar to the left to speed up the scroll.
- Trim the behavior by dragging the end of its bar to the right to slow down the scroll.

For more information about adjusting behaviors in the Timeline, see Behavior timing overview.

Scroll Text controls

Use the parameter controls in the Behaviors Inspector to adjust the direction, rate, and position of the scroll:

- **Scroll Direction:** A pop-up menu to set the direction of the text scroll to Vertical or Horizontal.
- **Speed Control:** A pop-up menu to set the speed of the scroll or crawl. There are three options:
  - **Automatic:** The speed of the scroll is determined by the length of the behavior in the Timeline. In other words, the length of the behavior determines how long it takes the object to scroll or crawl across the Canvas. By default, the duration of an applied Scroll Text behavior is the same as the object or group to which it is applied.
  - **Fixed:** The speed of the scroll is based on the value in the Scroll Rate parameter (described below).
  - **Custom:** Specifies the start and end positions (defined as
offsets from the current position) of the scrolling object.

- **Scroll Rate Mult**: A slider (available when Speed Control is set to Automatic) to multiply the rate of the scroll. Amounts higher than those available in the slider can be entered in the value slider (the number field to the right of the slider).

- **Scroll Rate**: A slider (available when Speed Control is set to Fixed) to set the speed of the scroll in pixels per second.

- **Reduce Flicker**: A pop-up menu to modify the speed of the scroll to reduce flickering on interlaced or progressive displays. The menu options vary, depending on other parameter settings:
  
  - **None**: Available when Scroll Direction is set to Vertical, this option has no effect on the speed of the scroll.
  
  - **Progressive**: Available when Scroll Direction is set to Vertical, this option prevents flicker on a progressive display (such as an LCD television). The Progressive setting is not guaranteed to prevent flicker on an interlaced display (such as a CRT television).
  
  - **Interlaced**: Available when Scroll Direction is set to Vertical, this option prevents flicker on a progressive display (such as an LCD television) or on an interlaced display (such as a CRT television).

  **Note**: Because the minimum speed to prevent flicker on an interlaced display is 2 pixels per frame, and the minimum speed to prevent flicker on a progressive display is 1 pixel per frame, the Interlaced option may result in faster scroll rates.

- **No**: Available when Scroll Direction is set to Horizontal, this
option does not modify the scroll speed to reduce flickering on interlaced or progressive displays.

- Yes: Available when Scroll Direction is set to Horizontal, this option modifies the speed of the scroll to reduce flickering on interlaced or progressive displays.

- **Allow Layout Override**: A checkbox that, when selected, permits manual changes to the layout method (set in the Layout Method pop-up menu in the Layout pane of the Text Inspector). For example, when you apply the Scroll Text behavior RTF text and set Scroll Direction to Horizontal, the text is placed in a single line. If you select the Allow Layout Override checkbox, the text retains its paragraph form.

  **Note**: This parameter is available only when the Scroll Text behavior is applied to a text object.

- **Start Off-Screen**: A checkbox that, when selected, moves the text to an off-Canvas position for the start of the scroll.

---

### Create animated text tracking

#### Use the Text Tracking behavior

The Text Tracking behavior applies a rate of change to the Tracking parameter of the Format pane (in the Text Inspector). Tracking applies a uniform space between each character of text, resulting in an expansion effect, with text characters expanding apart.
Use the Text Tracking behavior

- Apply the Text Tracking behavior (from the Text Animation behavior category) to text in your project.

For more information, see Apply a text behavior.

When you play the project, characters spread out based on the rate set in the Rate parameter in the Behaviors Inspector or HUD.

Note: Like the Tracking parameter in the Format pane of the Text Inspector, the Text Tracking behavior respects the Alignment setting of the text. For example, to track from the center of the text outward, the Alignment of the text must be set to Center. This parameter is located in the Text HUD or the Layout pane of the Text Inspector.
Use Text Tracking controls to modify the rate and end offset of character tracking. The identical Text Tracking behavior parameters appear in the Text Tracking HUD and in the Behaviors Inspector. See Text Tracking controls.

Text Tracking controls

Use the Text Tracking parameter controls in the Behaviors Inspector or HUD to control the rate and end offset of the tracking animation:

- **Rate**: A slider to control the rate of the change in tracking values. The higher the rate, the greater the tracking values.

- **End Offset**: A slider to offset the end of the effect of the Tracking parameter. By default, text characters track to the end of the duration of text. For example, to stop tracking animation 60 frames from the end of the text object (or project), drag the End Offset slider to 60 or enter 60 in the value slider.

**Note**: Use the End Offset parameter to stop the effect of the tracking behavior before the end of the text object (or project) rather than changing the duration of the Tracking behavior in the mini-Timeline or Timeline. If you trim the end of the behavior, the text snaps back to its default tracking value at the end of the behavior.

Create a “type-on” effect

Use the Type On behavior
The Type On behavior creates a “type-on” or typewriter effect, with text appearing character by character.

Apply the Type On behavior

- Apply the Type On behavior (from the Text Animation behavior category) to text in your project.

For more information, see Apply a text behavior.

When you play the project, the text pops on character by character. To create a softer fade-in effect, select the Fade In checkbox in the Behaviors Inspector or HUD.

The Type On behavior is applied over the duration of the text object.

Increase the speed of the type on effect

1. In the Layers list or Timeline, select an applied Type On
The Type On behavior bar is selected in the mini-Timeline and Timeline.

2. Do one of the following:

   - In the Timeline or mini-Timeline, trim Type On behavior by dragging the right end of its bar toward the left, to the frame where you want the animation to end. As you drag, a tooltip displays the duration and delta (amount of change) of the behavior.

   - Drag the playhead to the frame where you want to set the new Out point, then choose Mark > Mark Out (or press O).

     By the time the playhead reaches the end of the new behavior duration bar, the type-on effect is complete.

**Note:** You can also slow the type-on effect by extending the behavior bar in the Timeline beyond the duration of the text object.

### Create a softer type-on text

1. In the Layers list or Timeline, select an applied Type On behavior.

2. In the Behaviors Inspector or HUD, select the Fade In checkbox.
Type On controls

The Type On behavior in the Behaviors Inspector or HUD contains a single control:

- **Fade In:** Select this checkbox to make each text character fade in rather than appearing with the default pop-in effect.

  **Note:** You can also create this type of animation using the Type On parameter group in the Layout pane of the Text Inspector. For more information, see [Layout controls in the Layout pane](#).

Animate individual text glyphs

The Transform Glyph tool lets you animate text characters independently of their text objects.

Animate text characters with the Transform Glyph tool

1. Select the text object that contains the glyphs to modify.

2. Click and hold the 2D tools in the toolbar, then choose the Transform Glyph tool from the pop-up menu.
Selecting the Transform Glyph tool activates glyph transform handles in the Canvas and adds additional controls to the Text HUD.

3. In the Text HUD, ensure that the Attribute pop-up menu is set to Transform Glyph.

The Transform Glyph option in the Attribute pop-up menu lets you modify and animate the position, rotation, and scale of text characters by dragging in the Canvas. You can choose other options from the Attribute pop-up menu to activate transform handles that spatially distort the Face, Outline, Glow, and Drop Shadow attributes of text characters.

4. Move the playhead to the frame where you want the animation to begin, then click the Record button in the transport controls under the Canvas (or press A) to enable keyframe recording.

5. In the Canvas, select and drag glyphs to their starting position in the animation sequence.
6. Move the playhead to the frame where you want the animation to end, then drag the glyphs in the Canvas to their ending positions.

An editable animation path is created for the keyframed glyphs. You can add and remove control points and change the shape of the path in the Canvas. For more information on working with animation paths, see Manipulate animation paths.

7. Move the playhead back to the start frame and press the Space bar to play the project.

The glyphs animate from their starting positions to their ending positions.

**Note:** The other options in the Attribute pop-up menu—Face,
Outline, Glow, and Drop Shadow—can be animated in the same manner as the Transform Glyph option.

SEE ALSO

Text glyphs overview
Spatially distort a glyph using onscreen controls

About animating basic text in 3D space

Although basic text has no inherent 3D parameters, you can move and rotate a text layer in 3D space. Simulation behaviors can also influence text characters to move out of their X and Y planes into Z space (depth). Additionally, text on a Spline path can be manipulated in 3D space.

When the Face Camera checkbox is selected (in the Text Layout pane), the text characters actively face the camera if the camera or text is rotated.

Tip: When working with 2D or 3D text in a 3D project, especially text that moves close to the camera, set the Render Quality in the View pop-up menu or the View pull-down menu to Best before exporting (choose View > Render Quality > Best). Use Normal when working in your project, because Best mode dramatically slows your project’s interactivity. You can also set the Render Quality on export using the pop-up menus in the Render pane of the Export window.
For more information about 3D effects in Motion, see 3D compositing overview. For more information about using true (extruded) 3D text, see 3D text overview.

---

**Make text interact with other objects using a Simulation behavior**

When text is a member of a 3D group, certain behaviors can be applied to pull text characters out of their X and Y planes.

1. In a project that contains text and at least one other object (such as a shape), select the nontext object.

2. In the Properties pane of the Inspector, adjust the Z position of the object so that the object and text are offset in Z space.

3. Apply the Orbit Around behavior (from the Simulation behavior category) to the text in your project.

4. Drag the object that is offset in Z from the Layers list to the Object well in the Behaviors Inspector.

   By default, the text orbits around the object (as a single object) in X and Y.

5. In the Behaviors Inspector, select Affect Subobjects, then click Z.

   When you play the project, the text characters circle about the target object in X, Y, and Z space.
When should you use keyframes to animate text?

As an alternative to animating with behaviors, you can animate most text parameters using keyframes. The text animation method you use (keyframing or behaviors) depends on your project, or more specifically, your timing needs:

- Use keyframes if you need an action to happen at a specific point in time in your project. For example, if you want text to be completely transparent at frame 1, become completely opaque at frame 60, become transparent again at frame 90, and opaque again at frame 120, use keyframing. Keyframes apply specific values to an object’s parameters at specific frames.

- Use behaviors if the timing of the animation doesn’t need to be precise. For example, if you want the text to be completely transparent at frame 1, become opaque over frames 60–90, and become transparent by frame 120, use the Fade In/Fade Out behavior. Behaviors generate a range of values that are applied to an object’s parameters.

You can combine keyframing and behaviors to animate any object in Motion. For example, if you keyframe text opacity, you can then apply the Tracking behavior to animate text tracking, or you can keyframe the Tracking parameter. However, if you keyframe the text Opacity parameter and then apply a Fade In/Fade Out
behavior to the text, unexpected results may occur. For more information, see About combining behaviors with keyframes.

About adding nontext behaviors to text

Even though text behaviors are typically the most convenient way to animate text, you can apply any other behavior to your text.

Nontext behaviors applied to text can affect the whole text object or its individual text characters, depending on the settings you choose. For example, when you apply the Spin behavior to a text phrase on a circular path, the entire phrase rotates around its anchor point. To rotate individual text characters, select the Affect Subobjects checkbox in the Behaviors Inspector.

Spin behavior applied to text on a path with Affect Subobjects turned on (the individual text characters spin)

Spin behavior applied to text on a path with Affect Subobjects turned off (the text layer as a whole spins)

Save a modified text behavior to
As with all modified behaviors, filters, generators, and so on, you can save a modified text behavior to the Library.

Save a modified behavior to the Library

1. If necessary for organizational purposes, rename an applied text behavior by double-clicking its name in the Layers list, typing a new name, then pressing Return.

2. In the Library, select the Behaviors subcategory where you want to store the behavior, such as the Text Sequence subcategory or Favorites category.

   The Library stack displays behaviors already in the selected subcategory.

3. From the Layers list or Timeline, drag the behavior into the Library stack, releasing the mouse button when the green add pointer (+) appears over the stack window.

   The behavior is saved to the Library in the behaviors subcategory you selected. A custom behavior is represented by a user icon in the lower-right corner of the behavior icon.

For more information, see Save custom objects to the Library and Manage Library folders and files.
Shapes, masks, and paint strokes overview

Shapes, masks, and paint strokes are vector-based layers that you create in Motion.

Shapes

*Shapes* are primarily used to create visual elements in a composition. You can use a single shape as a background or colored graphic in a composition, or you can create elaborate illustrations that combine many shapes. Shapes work like any other layer. But unlike an image or video clip that you import as a layer, a shape layer is created in Motion, either by adding a premade shape from the Library or by drawing a custom shape in the Canvas. There are two categories of custom shapes: *simple shapes* drawn as a rectangle or ellipse, and *complex shapes* drawn point by point as a Bezier or B-Spline shape. Each control point in a complex shape defines some sort of corner or curve, and the actual spline that makes up the shape connects these control points together like a connect-the-dots drawing.

To begin using shapes, see Simple shapes and masks overview
Masks

*Masks* are a special type of shape used to create regions of transparency in layers. Although shapes work as layers by themselves, masks must be assigned to an image layer to have an effect. For example, if you have a picture in which you want to isolate the foreground subject, you can create a mask to cut out the background. As with shapes, there are two categories of masks: simple masks drawn as a rectangle or ellipse, and complex masks drawn point by point in the Canvas as Bezier or B-Spline shapes.

To begin using masks, see [Simple shapes and masks overview](#) and [Complex shapes and masks overview](#). For more information about mask transparency, see [Masks and transparency overview](#).
Paint strokes

Like shapes, *paint strokes* are used to create visual elements in a composition. Paint strokes are drawn in the Canvas in a single, continuous movement. You can use a stylus and graphics tablet to draw paint strokes in a fluid fashion. Or you can use a mouse or Multi-Touch device to draw paint strokes.

To begin using paint strokes, see Paint strokes overview.

As with all objects in Motion, shapes, masks, and paint strokes can be edited or animated by keyframing their parameters or by applying behaviors. Additionally, the Shape Behaviors category contains behaviors designed specifically to animate shapes, including a behavior to sequence effects over the length of a paint stroke. For more information on using the Shape behaviors, see Shape behaviors overview.
Add simple shapes and masks

Simple shapes and masks overview

Use simple shapes and masks to quickly add a rectangular or elliptical form to your project. Simple shapes and masks are easily manipulated in the Canvas using onscreen controls that modify height, width, curvature, or roundness. Simple shapes and masks have no editable control points or individual splines.

You can add a simple shape or mask to a project in the following ways:

- Use the Rectangle tool or Circle tool to **draw a simple rectangular shape or elliptical shape** in the Canvas.
- Use the Rectangle Mask tool or Circle Mask tool to **draw a simple rectangular mask or elliptical mask** in the Canvas.

You can convert simple shapes or masks to complex shapes or masks with editable control points using the **Convert to Points** command.

SEE ALSO

Add shapes from the Library
Complex shapes and masks overview

Draw simple shapes

Use the Rectangle tool or the Circle tool to create simple shapes in the Canvas. Use the Line tool to draw straight lines in the
Draw a rectangle shape

1. Select the Rectangle tool in the toolbar (or press R).

   The Rectangle Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the color, outline, and roundness of the rectangle before you draw the shape, use the controls in the HUD.

   **Note:** You can also edit the rectangle color, outline, and roundness after the shape is drawn.

2. Drag in the Canvas until the resulting rectangle is the size you want, then release the mouse button.

   To draw a perfect square, press Shift while you drag. To draw the rectangle from its center, press Option while you drag.

3. After you create the shape, press Esc to exit shape-drawing mode and activate the Select/Transform tool.
The Shape HUD appears. (If the HUD is not displayed, press F7.)

Adjust the size, roundness, feather, or rotation of a rectangle shape

1. Do one of the following:
   - In the Canvas, double-click the rectangle shape.
   - In the Canvas, Layers list, or Timeline, select the rectangle shape, then click and hold the 2D transform tools pop-up menu and choose the Edit Rectangle tool.

   ![](image)

   Simple shape transform handles appear in the Canvas.

2. In the Canvas, do any of the following:
- **Adjust corner roundness**: Drag the roundness handle in the upper-left corner of the shape to smooth the corners of the rectangle.

- **Adjust size**: Drag a size handle (on the side of the shape) to adjust the height or width of the rectangle. To scale the shape uniformly, drag the inner edge of the shape.

  **Note:** You can also press the Shift key while adjusting the size handles to scale the shape uniformly.

- **Adjust softness**: Drag the shape’s outer edge away from the rectangle to feather outward, or toward the center of the circle to feather inward.

- **Adjust rotation**: Drag the rotation handle to rotate the shape.
Adjust position: Drag the center, or anywhere within the shape, to move the shape.

Draw a circle or ellipse shape

1. Click and hold the shape tools pop-up menu in the toolbar, then choose the Circle tool (or press C).

The Circle Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the color and outline of the circle before you draw the shape, use the controls in the HUD.

Note: You can also edit the circle color and outline after you draw the shape.

2. Drag in the Canvas until the resulting ellipse is the size you want, then release the mouse button.

To draw a perfectly symmetrical circle, press Shift while you drag. To draw the ellipse from its center, press Option while
you drag.

3. After you create the shape, press Esc to activate the Select/Transform tool.

   The Shape HUD appears. (If the HUD isn’t displayed, press F7.)

---

**Adjust the size, curvature, or feather of a circle shape**

1. Do one of the following:
   - In the Canvas, double-click the ellipse shape.
   - In the Layers list, Canvas, or Timeline, select the ellipse shape, then click and hold the 2D transform tools pop-up menu in the toolbar and choose the Edit Ellipse tool.

   Simple shape transform handles appear in the Canvas.
2. In the Canvas, do any of the following:

- **Adjust curvature**: Drag the curvature handle in the upper-left corner of the shape to add angular corners.

- **Adjust size**: Drag a radius handle (on the edge of the shape) to adjust the height or width of the ellipse or circle. To scale the shape uniformly, drag the inner edge of the shape.

  **Note**: You can also press the Shift key while adjusting the radius handles to scale the shape uniformly.

- **Adjust softness**: Drag the shape’s outer edge away from the shape to feather outward, or toward the center of the
shape to feather inward.

- **Adjust rotation**: Drag the rotation handle to rotate the shape.

- **Adjust position**: Drag, the center, or anywhere within the shape, to move the shape.

## Draw a line

1. Click and hold the shape tools pop-up menu in the toolbar, then choose the Line tool.

   ![Shape tools pop-up menu](image)

   The Line Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the color and width of the line before you draw it, use the controls in the HUD.

   ![Line Tool HUD](image)

   **Note**: You can also edit the line color and width after you draw the line.

2. Drag in the Canvas until the resulting line is the length you want, then release the mouse button.
Pressing Shift while dragging constrains the line to 45-degree angles.

3. After you create the shape, press Esc to activate the Select/Transform tool.

   The Shape HUD appears. (If the HUD is not displayed, press F7.)

---

**Change the start or end cap of a line**

1. Select a line shape in the Canvas, Layers list, or Timeline.

2. In the Style pane of the Shape Inspector, click the Start Cap or End Cap pop-up menu, then choose None, Square, Round, Bevel, or Arrow.

   When you choose Arrow, additional length and width sliders become available that allow you to further customize the arrow cap.

---

**SEE ALSO**

- Edit shape fill, outline, and feathering
- Complex shapes and masks overview
- Shape controls in the Inspector overview

---

Add shapes from the Library
The Shapes category in the Library contains pre-drawn shapes that you can add to a project. After you add a shape from the Library, you can edit the shape.

---

**Add a shape to a project from the Library**

1. In the Library, select the Shapes category.

2. Do one of the following:
   - Select a shape in the Library stack, then click Apply in the preview area.
   - Drag a shape from the Library stack into the Canvas, Layers list, or Timeline.

The shape is added to the project and can be modified. For information on editing shapes, see [Edit shape fill, outline, and feathering](#).

---

**Draw simple masks**

The Rectangle Mask and Circle Mask tools create simple masks, which create regions of transparency in layers.

---

**Create a rectangle mask**

1. Select the image layer you want to mask, then select the
Rectangle Mask tool in the toolbar (or press Option-R).

The Rectangle Mask Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the blend mode, softness, roundness, or spline color before the mask is drawn, use the controls in the HUD.

Note: You can also edit the mask parameters after you draw the mask.

2. Drag in the Canvas until the resulting rectangle is the size you want, then release the mouse button.

To draw a perfectly square mask, press Shift while you drag. To draw the rectangle mask from its center, press Option while you drag.

Adjust the size, roundness, feathering, or rotation of a rectangle mask

1. Do one of the following:
   - In the Canvas, double-click the mask
- In the Canvas, double-click the mask.
- In the Layers list, Canvas, or Timeline, select the mask, then click and hold the 2D transform tools pop-up menu in the toolbar and choose the Edit Rectangle tool.

Simple shape transform handles appear in the Canvas.

2. Do any of the following:
- **Adjust corner roundness**: Drag the roundness handle in the upper-left corner of the mask to smooth the corners of the rectangle.

- **Adjust size**: Drag a size handle (on the side of the mask shape) to adjust the height or width of the rectangle mask. To scale the mask uniformly, drag the inner edge of the mask.

  **Note**: You can also press the Shift key while adjusting the radius handles to scale the mask uniformly.

- **Adjust softness**: Drag the mask’s outer edge away from the rectangle to feather outward, or toward the center of the rectangle to feather inward.

- **Adjust rotation**: Drag the rotation handle to rotate the mask.
• **Adjust position:** Drag the center, or anywhere within the mask, to move the mask.

---

# Create a circle mask

1. Click and hold the mask shape tools pop-up menu in the toolbar, then choose the Circle Mask tool (or press Option-C).

![Circle Mask Tool HUD](image)

The Circle Mask Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the blend mode, softness, or spline color before you draw the mask, use the controls in the HUD.

![Circle Mask Tool Controls](image)

**Note:** You can also edit the mask parameters after you draw the mask.

2. Drag in the Canvas until the resulting ellipse is the size you want, then release the mouse button.
To draw a perfectly symmetrical circle, press Shift while you drag. To draw the ellipse from its center, press Option while you drag.

Adjust the size, curvature, or feather of a circle mask

1. Do one of the following:
   - In the Canvas, double-click the mask.
   - In the Layers list, Canvas, or Timeline, select the mask, then click and hold the 2D transform tools pop-up menu in the toolbar and choose the Edit Ellipse tool.

![Simple shape transform handles appear in the Canvas.](image)

2. In the Canvas, do any of the following:
- **Adjust curvature**: Drag the curvature handle in the upper-left corner of the mask to add angular corners.

- **Adjust size**: Drag a radius handle (on the edge of the mask shape) to adjust the height or width of the mask. To scale the mask uniformly, drag the inner edge of the mask.

  **Note**: You can also press the Shift key while adjusting the radius handles to scale the mask uniformly.

- **Adjust softness**: Drag the mask’s outer edge away from the mask to feather outward, or toward the center of the mask to feather inward.

- **Adjust rotation**: Drag the rotation handle to rotate the mask.

- **Adjust position**: Drag the center, or anywhere within the
Convert a simple shape or mask to editable control points

You can further refine the contours of a simple shape or mask by converting its outline to a complex shape (a spline with editable control points that allow you to adjust shape and curvature).

Convert a simple shape or mask

Do one of the following:

- Select a simple shape or mask (rectangle or circle), then choose Object > Convert to Points (or press Option-Command-B).

- In the Canvas, Control-click a simple shape or mask (rectangle or circle), then choose Convert to Points from the shortcut menu.

- Select a simple shape or mask (rectangle or circle), then click
the Convert to Points button in the Geometry pane of the Shape Inspector or in the Mask Inspector.

If you’ve animated the curvature, radius, or size parameters, a dialog appears asking you to confirm the conversion. The animation is not retained after the shape is converted.

**Note:** Animated feather values are retained when a simple shape or mask is converted.

![Convert to Points button](image)

Red control points appear on the shape or mask. For more information, see [Edit control points overview](#).

**Note:** The only way to convert the complex shape back to a simple shape is to use the Undo command (Command-Z).

---

**Edit control points on a line**

There’s no “simple” shape mode for a line shape, so you don’t need to convert the line to edit its control points.

- Double-click the line in the Canvas.

Red control points appear on both ends of the line. For more information, see [Edit control points overview](#).
Add complex shapes and masks

Complex shapes and masks overview

In Motion, you can draw complex shapes and masks using splines. Splines are vector-based curves that allow for complex, customized shapes. There are two spline-drawing methods:

- **Bezier splines**: Bezier splines are good for drawing shapes for illustration. The controls used to manipulate Bezier splines are similar to those found in many other drawing and compositing applications, so they may be familiar to you. Bezier controls lend themselves to the creation of precise, detailed shapes. Tangent handles adjust the curvature of the shape on either side of the control point, and this defines the surface of the shape.

- **B-Splines**: You can also use B-Splines to draw complex shapes. But unlike Bezier splines, B-Splines are manipulated using only points—there are no tangent handles. Furthermore, the points themselves do not lie on the surface of the shape. Instead, each B-Spline control point is offset from the shape’s
surface, “magnetically” pulling that section of the shape toward itself to create a curve. By combining the influence of multiple B-Spline points, you can create different curves. B-Splines are extremely smooth—by default, there are no sharp angles in B-Spline shapes, although you can create sharper curves, if necessary.

Because B-Spline controls are so simple, they’re easy to animate and manipulate. The tools you use for a specific task are largely a matter of personal preference.

You can add a Bezier and B-Spline shapes and masks to a project in the following ways:

- Use the Bezier tool or B-Spline tool to draw complex shapes with editable control points.
- Use the Bezier Mask tool, B-Spline Mask tool, or Freehand Mask tool to draw complex masks with editable control points.

You can use Bezier splines and B-Spline splines interchangeably for any task, and for either shapes or masks.
Complex masks use spline shapes that you can customize to create complex contours.

**Draw a Bezier shape or mask**

1. Select the Bezier tool in the toolbar (or press B).

![Bezier tool in toolbar](image)

**Note:** The Bezier Mask tool is located in the mask tools pop-up menu in the toolbar.

![Bezier Mask tool](image)

The Bezier Tool HUD (or Bezier Mask Tool HUD) appears. (If it doesn’t appear, press F7.) To change the parameters of the shape (or mask) before you draw it, use the controls in this HUD.

**Note:** You can also edit the shape parameters after you draw the mask.
2. Click in the Canvas to draw the first point.

3. To add points to further define the shape, do one of the following:
   - Click in the Canvas to make a linear corner point.
   - Drag in the Canvas to make a curved Bezier point, adjusting it to the shape you want.

Press Shift while making a curved point to constrain its tangents to 45-degree angles. Press Command–Equal Sign (=) to zoom in for a closer look and Command-Hyphen (−) to zoom out. You can scroll around by pressing the Space bar as you drag in the Canvas. If you have a Multi-Touch trackpad, it’s even easier: pinch open or closed to zoom in or out, and use a two-finger swipe to scroll around.
4. To finish the shape, do one of the following:

- Click the first point you drew to create a closed shape.

- Press C to close the shape, joining the first point you created to the last.

- Double-click anywhere in the Canvas to create the last point of an open shape.

- Press Return to create the last point of an open shape.

**Note:** Before a shape is closed, you can press Esc to cancel the entire operation, deleting the shape.

Immediately after finishing a shape, the Shape HUD appears and the Edit Points tool is selected, which lets you edit the shape you’ve just created.
Draw a B-Spline shape or mask

1. Click and hold the path shape tools pop-up menu in the toolbar, then choose the B-Spline tool).

**Note:** If the Bezier tool is selected, pressing B once selects the B-Spline tool. If another tool is selected, such as the Text tool, pressing B twice selects the B-Spline tool. The B-Spline Mask tool is located in the mask pop-up menu in the toolbar. The Bezier Mask tool is located in the mask tools pop-up menu in the toolbar.

The B-Spline Tool HUD (or B-Spline Mask Tool HUD) appears. (If it doesn’t appear, press F7.) To change the parameters of the shape (or mask) before it is drawn, use the controls in this HUD.
2. Click in the Canvas to draw the first point.

3. Continue clicking in the Canvas to draw additional points to define the shape you need.

**Tip:** While drawing a shape, you can move and adjust the control points you’ve created before finishing the shape. You can adjust any control point except the first one you created, because clicking the first point closes the shape. Press Shift while making a curved point to constrain its tangents to 45-degree angles.

As you create new B-Spline control points, keep the following in mind:

- The control points you draw influence the shape of the curve from a distance. They do not lie directly on the surface of the curve.

- To create more detailed curves, create more points. However, it’s best to use the fewest number of points necessary to create the amount of detail you need. Shapes with an excessive number of points can be difficult to edit later on.

- In many instances, it’s easier to create a loose group of control points first and then adjust them afterwards to create the precise curve you need in a later step.

4. When you’re ready to finish your shape, do one of the following:

   - Click the first point you drew to create a closed shape.
   - Press C to close the shape, joining the first point you
• Press Return to finish an open shape at the last point you made.

• Double-click anywhere in the Canvas to define the last point of an open shape.

**Note:** You can press Esc to cancel the entire operation and delete the shape.

Immediately after finishing a shape, the Shape HUD appears and the Edit Points tool is selected, which lets you edit the shape you’ve just created.

### Draw a freehand mask

Freehand masks create a mask shape in one movement, rather than in a point-by-point fashion (like a Bezier or B-Spline shape). For best results, use a stylus and tablet when drawing freehand masks.

1. Select the layer to mask, click and hold the mask tool pop-up menu in the toolbar, then choose the Freehand Mask tool.
The Freehand Mask Tool HUD appears. To change the parameters of the mask before you draw it, use the controls in this HUD.

2. Do any of the following:

- **Using a mouse**: Drag in the Canvas to draw a shape, finishing the shape at the starting point.

- **Using a tablet**: With a stylus, draw on the tablet, finishing the shape at the starting point.

A small circle appears when the pointer is over the starting point.

**Note**: If you don’t close the mask at its starting point, the mask is closed when you release the mouse button.
The mask is completed.

3. Edit your control points to fine-tune the mask.

SEE ALSO
- Edit control points overview
- Shape controls in the Inspector overview
- Masks and transparency overview
- Mask controls in the Inspector

Draw paint strokes

Paint strokes overview

The easiest way to draw a paint stroke is in one continuous movement, rather than one point at a time. Depending on the effect you want, you may achieve better results using a stylus and graphics tablet. Additionally, many styles and brushes in Motion take advantage of stylus pressure and speed.

There are two ways to create a paint stroke:
• Use the Paint Stroke tool to draw a freehand stroke in the Canvas.

• Convert an existing shape into a paint stroke.

Technically, paint strokes are outline-only shapes created using any shape tool. The outline is composed of *dabs*—vector or image parcels that combine to create the onscreen “stroke.” Dabs are analogous to the particles of a particle system but are arrayed along a spline.

Using the Sequence Paint behavior, you can sequence effects (such as opacity, rotation, and scale) over the length of a paint stroke. For more information on using the Shape behaviors, see *Shape behaviors overview*.

**Note:** The Paint Stroke feature is a design and graphics tool, not a retouching or rotoscoping tool.

---

### Create a paint stroke

Create paint strokes and preview the stroke attributes using controls in the HUD.

---

### Draw a freehand paint stroke

1. Select the Paint Stroke tool in the toolbar (or press P).
The Paint Stroke Tool HUD appears. (If it doesn’t appear, press F7.)

**Important:** Like the other drawing tool HUDs, the Paint Stroke Tool HUD is available only after you select the Paint Stroke tool, and before you create your stroke in the Canvas. The Paint Stroke Tool HUD lets you set the properties derived from the pressure and speed of the stylus *before* the drawing the stroke.

The default brush type (in the Shape Style parameter) is Basic Solid. You can change the brush type by defining a paint stroke style.

2. Define a paint stroke style in the HUD:
   a. Click the Shape Style preset pop-up menu, then choose an option.
b. Modify the Brush Color and Width settings.

If a preset is not used, a Basic Solid stroke is created. You can still apply a preset to the stroke using the Inspector after the stroke is drawn. Presets do not override the width or color of the stroke set in the HUD.

**Note:** The Pen Pressure and Pen Speed parameters are not available in the HUD when Shape Style is set to Solid Brush.

3. If you want to create a stroke that’s drawn over time, select the Write On checkbox.

Selecting the Write On checkbox applies a Write On behavior to the stroke. As with any other behavior, you can modify its parameters in the HUD or Inspector. For more information on using the Write On behavior, see Write On.

4. Draw your stroke in the Canvas, then press S or Esc to activate the Select/Transform tool.

The Paint Stroke Tool HUD is replaced with the Shape HUD, which contains basic parameters identical to those in all other shape HUDs. Consequently, after a stroke is drawn, you must use the Inspector to modify parameters unique to the paint brush and its dabs.

---

**Preview the paint stroke in the Paint Stroke Tool HUD**

The lower portion of the Paint Stroke Tool HUD contains a sketch area that displays a preview of a paint stroke effect. After you
select a style for your paint stroke, that style remains selected for subsequent paint strokes until you choose another shape style. You can select another style before you create a paint stroke in the HUD, or after you create a paint stroke in the Inspector.

**Note:** You cannot choose a shape style for a paint stroke that has yet to be created in the Shape Inspector.

1. Select the Paint Stroke tool in the toolbar.

2. Do one of the following:
   - Choose a brush from the Shape Style pop-up menu in the Paint Stroke Tool HUD, then draw a stroke in the sketch area to see a preview of the paint stroke.
   - Select the Write On checkbox, draw a stroke in the sketch area, then click the Play button to see a preview of the write-on stroke.
   - Apply a preset from the Shape Style pop-up menu to an existing stroke in the sketch area.

If the preset is an animated stroke, the stroke is...
automatically drawn in the sketch area. Press the Play button to see the stroke animation again.

**Change the style of an existing paint stroke**

1. Select an existing paint stroke in the Layers list or Timeline.

2. In the Shape HUD or the Style pane of the Shape Inspector, click the Shape Style pop-up menu, then choose a different option.

**“Particle-ize” a paint stroke**

You can animate the individual dabs in a paint stroke to create an exploding particle effect.

1. Select an existing paint stroke in the Layers list or Timeline.

2. In the Style pane of the Shape Inspector, choose Airbrush from the Brush Type pop-up menu (if it’s not already chosen).

3. In the Advanced pane, select the Dynamics checkbox, then play the project (press the Space bar).

   The dabs spread out in the Canvas.

4. To further refine the dab animation, adjust the Dynamics controls.

**Paint a stroke over time**
1. In the toolbar, select the Paint Stroke tool (or press P).

   The Paint Stroke Tool HUD appears. If the HUD does not appear, press F7 or D.

2. In the Tool HUD, select the Write On checkbox and any other desired stroke settings.

3. In the Canvas, create your stroke.

4. When you complete stroke, press Esc to exit the paint mode.

   The Paint Stroke Tool HUD is replaced with the Shape HUD. In the Layers list, a Write On Shape behavior is applied to the stroke. To modify the Write On parameters, select the behavior and use the HUD or the Behaviors Inspector.

   The faster you draw a stroke, the shorter the duration of the Write On behavior.

**Note:** If the Create Layers At option in Motion Project Preferences is set to Current Frame, the paint stroke is created at the current playhead position. If set to Start of Project, the stroke is created at frame 1. For more information about the Create Layers At option, see [If it’s your first import](#).

5. Play back your project.

   The stroke is “painted on” as the project plays.

6. To modify the speed at which the stroke is painted, adjust the duration of the behavior bar in the Timeline or mini-Timeline.
Create a write-on stroke using an existing shape

You can apply the Write On behavior to an existing shape to draw its outline over time. Because the Write On behavior only affects outlines, the Outline checkbox must be selected in the Style pane of the Shape Inspector.

Note: When you add a Write On behavior to an existing shape, the behavior spans the duration of the shape to which it’s applied.

1. Select the shape you want to use and select its Outline checkbox in the HUD or Style pane of the Shape Inspector.

   Note: You can leave the Fill checkbox selected, but only the outline is affected by the Write On behavior.

2. In the toolbar, click the Add Behavior pop-up menu, then choose Shape > Write On.
The Write On behavior appears in the Layers list. If the playhead is located at the start of the shape, the visual shape disappears and only the path is visible.

3. Play the project (press the Space bar).

The outline is drawn over the length of the behavior.

4. To adjust the speed at which the stroke is painted, adjust the duration of the behavior bar in the Timeline or mini-Timeline.

5. To adjust the properties of the stroke, use the Shape Inspector.

For more information, see Stroke pane.

---

**Convert shape outlines to paint strokes**

You can convert a shape outline into a paint stroke by modifying the brush type in the Inspector. After you assign a different brush type, paint stroke parameters become available. You can modify and animate the paint stroke’s brush parameters.

---

**Convert an existing shape into an editable paint stroke**

1. Select an existing shape in the Layers list, Canvas, or Timeline.
2. In the Shape HUD or Style pane of the Shape Inspector, select the Outline checkbox.

Modify any Outline parameter you want. In this example, the outline is widened and colored orange.

![Default circle shape with Outline checkbox deselected](image1)

![Circle shape with Outline checkbox selected](image2)

3. In the Style pane of the Shape Inspector, click the Brush Type pop-up menu, then choose Airbrush.

After you change the brush type to Airbrush (or Image), the following occurs:

- The shape fill options are disabled.

**Note:** The shape fill options are not available unless the Brush Type pop-up menu is set to Solid.

- The shape icon in the Layers list becomes a paint stroke icon.
The stroke softens because it’s using a soft brush type. You can modify the brush profile to vary opacity within the brush, or apply a custom opacity gradient to the brush profile in the Style pane of the Inspector.

- The Stroke pane becomes available in the Shape Inspector. Use the Stroke pane to set the Stroke Color Mode and Brush Scale parameters, and to adjust other options.

- The Advanced pane becomes available in the Shape Inspector. The Advanced pane contains a single group of Dynamics controls that allow the dabs of a paint stroke to be animated like particles. For more information on Dynamics, see Advanced pane.

4. Use the controls in the Style, Stroke, and Advanced panes of the Shape Inspector to modify or animate your paint stroke.

In the example below, the Additive Blend parameter is enabled in the Style pane. Additionally, the Color Over Stroke, Spacing Over Stroke, Width Over Stroke, Brush Scale, and Brush Scale Randomness parameters are modified in the Stroke pane.
SEE ALSO
Shape controls in the Inspector overview
Style pane
Stroke pane
Advanced pane

Use the Width Over Stroke onscreen controls

Typically the Width Over Stroke settings are controlled by a mini-curve editor in the Stroke pane of the Shape Inspector. However, you can also adjust Width Over Stroke values by dragging in the Canvas.

Note: The Width Over Stroke settings are only available when Brush Type is set to Airbrush or Image in the Style pane of the Shape Inspector.
Use the onscreen Width Over Stroke controls

1. In the Canvas, Control-click the paint stroke, then choose Stroke from the shortcut menu.

   Small control points (+) appear at along the red spline.

2. Click the control point that you want to adjust.

   Handles appear on either side of the control point.

3. To increase the width of the dabs, drag a handle away from the point; to decrease the width of the dabs, drag toward the point.

4. To change the position of a control, drag the control point to move it along the length of the stroke. (Points can be dragged over one another.)

5. To add width controls, Option-click the red spline.

   Additional points can only be added to shapes with control points.
6. To delete width controls, select the point and press Delete.

Paint Stroke tool controls in the HUD

The Paint Stroke Tool HUD appears when you select the Paint Stroke tool in the toolbar, before you draw a stroke. Use this HUD to specify stroke-drawing settings before you draw.

The Paint Stroke Tool HUD contains the following controls:

- **Brush Color:** Color controls that set the color of the brush. For more information on using these controls, see Basic color controls.

- **Width:** A slider that defines the width of the paint stroke.

- **Pen Pressure:** A pop-up menu that sets stroke properties derived from the pressure of your pen before creating the stroke. This parameter is not available for solid brush types. Only strokes drawn using a stylus and tablet will have recorded pressure variations. Choose from one of the
Nothing: Pen pressure is ignored.

Width: The harder the pen pressure, the wider the stroke. To adjust the width of the dabs after the stroke is created, use the width and brush scale controls in the Style and Stroke panes of the Shape Inspector.

Opacity: The harder the pen pressure, the more opaque the stroke. To adjust the opacity of the dabs after the stroke is created, use the opacity controls in the Style or Stroke pane of the Shape Inspector.

Spacing: The harder the pen pressure, the greater the spacing between stroke dabs. To adjust the spacing of the dabs after the stroke is created, use the spacing controls in the Style or Stroke pane of the Shape Inspector.

Angle: The harder the pen pressure, the greater the angle of the stroke dabs. To adjust the angle of the dabs after the stroke is created, use the angle controls in the Stroke pane of the Shape Inspector.

Jitter: The harder the pen pressure, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs, giving the dabs a particle-like appearance. To adjust the jitter of the dabs after the stroke is created, use the jitter controls in the Stroke pane of the Shape Inspector.

Note: You can affect multiple parameters to a single stroke so that, for example, pressure affects both opacity and spacing. Choose an option, such as Opacity, before the stroke is created. After you create the stroke, apply a pen shape behavior to the stroke and apply the action to another...
Pen Speed: A pop-up menu that sets the stroke’s width, opacity, spacing, angle, and jitter based on the speed recorded when drawing the stroke with the Paint Stroke tool. These settings can be applied to paint strokes created using a stylus and graphics tablet or a mouse. This parameter is not available for solid brush types. Choose from one of the following:

- Nothing: Pen speed is ignored.
- Width: The faster you move the pen, the more narrow the stroke; the slower you move the pen, the wider the stroke. To adjust the width of the dabs after the stroke is created, use the width and brush scale controls in the Style and Stroke panes of the Shape Inspector.
- Opacity: The faster you move the pen, the less opaque the stroke. To adjust the opacity of the dabs after the stroke is created, use the opacity controls in the Style or Stroke pane of the Shape Inspector.
- Spacing: The faster you move the pen, the greater the spacing between the dabs of the stroke. To adjust the spacing of the dabs after the stroke is created, use the spacing controls in the Style or Stroke pane of the Shape Inspector.
- Angle: The faster you move the pen, the greater the angle of the stroke dabs. To adjust the angle of the dabs after the stroke is created, use the angle controls in the Stroke pane of the Shape Inspector.
- Jitter: The faster you move the pen, the larger the amount
of jitter on the stroke. Jitter randomizes the position of the paint dabs so they appear more like particles. To adjust the jitter of the dabs after the stroke is created, use the jitter controls in the Stroke pane of the Shape Inspector.

- **Write On:** A checkbox that, when selected, allows a stroke to be “painted” on the Canvas over time. For more information, see Write On.

- **Smoothing:** A checkbox that, when selected, creates a smoother stroke with fewer control points. Paint strokes drawn with smoothing on are created as Bezier shapes. Paint strokes drawn with smoothing off are created as linear shapes.

- **Shape Style:** A pop-up menu that specifies a preset shape style (from the Library) to the selected shape. You can also save any custom shape style to the Library using this pop-up menu. Any stroke (shape) presets you have saved to the Library also appear in this list.

- **Sketch area:** An empty field where you can preview brush styles in combination with the current Paint Stroke Tool HUD settings.

**Edit shape control points**

**Edit control points overview**

Complex shapes, masks, and paint strokes are defined by Bezier splines and B-Splines, which are built with control points. The control points, which lie along the spline in connect-the-dot fashion, determine the shape of the spline.
You can modify a spline by adjusting its control points in the Canvas. This section covers how to:

- Display control points
- Select, deselect, and lock control points
- Add and delete control points
- Move control points to adjust a shape
- Edit Bezier control points
- Edit B-Spline control points
- Use dynamic guides and snapping to align controls points to other control points and to other objects

Display control points

There are several ways to display the control points of a complex shape to allow point-by-point editing in the Canvas.

Display a complex shape’s control points

Do one of the following:

- In the Layers list, Canvas, or Timeline, select a shape containing control points (a spline shape), then click and hold the 2D transform tools pop-up menu in the toolbar and choose the Edit Points tool.
Double-click a spline shape in the Canvas.

Control-click a spline shape in the Canvas, then choose Edit Points from the shortcut menu.

**Note:** Overlays must be enabled in the View menu (or the View pop-up menu above the Canvas) to see the control points and spline of a shape. In addition, if Handles or Lines are turned off in the View > Overlays submenu (or in the View pop-up menu), you cannot see a shape’s Bezier or B-Spline control points when editing.

After you display a shape’s control points, select control points to edit them. While editing the control points of a shape, you can select another shape and remain in control point-adjustment mode. This allows for quick modification of multiple shapes’ control points.
Select, deselect, and lock control points

The following tasks describe how to select and deselect control points in the Canvas.

For all of the following procedures, use the Edit Points tool in the 2D transform tools pop-up menu.

Select control points

Do one of the following:

- Click any control point.
- Drag a selection rectangle over multiple control points.
Shift-click unselected control points to add them to the selection.

Shift-drag a selection rectangle around unselected control points to add them to the selection.

**Note:** In Edit Points mode, when you place the pointer over a control point, an info window appears identifying the control point name. When dragging a control point, the info window displays the point’s name and coordinates. You can choose not to display this info by opening the General pane of the Motion Preferences window and deselecting Show Tooltips.

---

**Select every control point on a shape**

Choose Edit > Select All (or press Command-A).

---

**Deselect control points**

Do one of the following:

- Shift-click selected points.
Hold down the Shift key, drag a selection rectangle over selected points.

## Deselect every control point on a shape

Do one of the following:

- Click the Canvas anywhere outside the selected shape.
- Choose Edit > Deselect All (or press Shift-Command-A).

## Display an info window showing the control point number

By default, shape control points are numerically labeled in the order they were created in the Canvas.

- Click the View pop-up menu, enable Show Tool Info, then position the pointer over any control point in the Canvas.
An info window appears showing the numeric name of the control point ("Control Point 1," for example).

Note: Shape control points are also listed by number in the Geometry pane of the Shape Inspector.

Lock and unlock control points

You can lock control points in a shape to fix them in place and prevent accidental modification. A shape with locked points can still be moved.

- Control-click a control point, then choose Lock Point from the shortcut menu.

If the point was unlocked, it becomes locked. If the point was locked, Unlock Point appears in the shortcut menu, and the
point becomes unlocked.

Locked points appear gray with a black dot in the middle of the point.

Add and delete control points

If you didn’t create enough control points to make the complex shape you need, you can add more to the existing shape. You can also extend or close an open shape.

For all of the following procedures, use the Edit Points tool (in the 2D transform tools pop-up menu).
Add control points to a shape

Do one of the following:

- Option-click or double-click the edge of a shape to add a new control point.

**Note:** To add control points to a B-Spline shape, Option-click or double-click the B-Spline frame’s edge, rather than the edge of the shape itself.

- Control-click the edge of a shape, then choose Add Point from the shortcut menu.

Add control points to the end of an open shape
1. Option-click anywhere outside the shape to add control points to the end of the shape.

2. Click the first point in the shape to close it (or place the pointer over the first point, then press C).

   The closed shape is not filled.

---

**Close an open shape**

Do one of the following:

- Click the first point in the shape to close it (or press C).

  The closed shape is not filled.

- Control-click a control point, then choose Close Curve from the shortcut menu.

- Display the Geometry pane in the Shape Inspector, then select the Closed checkbox.

  You can reopen the shape by deselecting the Closed checkbox.

---

**Create an open shape from a closed shape**

Do one of the following:

- Control-click a point on the shape, then choose Open Curve from the shortcut menu.
The segment before the point (in a clockwise order) is removed from the shape. This action causes the selected point to become Control Point 1 and the remaining points to be renamed accordingly. If the originally closed shape was filled, the Fill checkbox remains selected. To disable the fill, deselect the Fill checkbox in the HUD or Style pane of the Shape Inspector.

Select the shape and deselect the Closed checkbox in the Geometry pane of the Shape Inspector.

**Note:** The spline before the first point drawn is removed. To change the start point (the first point drawn) of the shape, Control-click a point and choose Set Start Point from the shortcut menu.

---

## Delete control points from a shape

If a shape has more control points than are necessary, you can delete points from it to make it easier to edit. This can be helpful if you animate the shape later on.

Select points to delete, then do one of the following:

- Choose Edit > Delete.
- Control-click the selected points, then choose Delete Point from the shortcut menu.
- Press Delete.

The shape changes to adjust to the missing point. If you remove points from a closed shape, the shape remains
WARNING: If you delete a point from a shape that has a keyframed shape animation parameter in the Keyframe Editor, that control point is removed from the entire animation.

Move control points to adjust a shape

Because control points define the contours of a complex shape, you can move control points to change the shape.

For all of the following procedures, use the Edit Points tool in the 2D transform tools pop-up menu.
Tip: You can also modify multiple control points across different shapes simultaneously by selecting them all at once.

**Move control points**

- Select control points on the shape in the Canvas, then drag the points to a new position.

  As you drag selected control points, the rest of the shape stretches or curves to accommodate the change.
Press Command–Left Arrow, Command–Right Arrow, Command–Up Arrow, or Command–Down Arrow to nudge a point by one pixel (or Shift-Command to nudge by 10 pixels).

### Constrain the movement of selected control points

1. Select control points.

2. Press Shift while you drag a selected point horizontally, vertically, or diagonally.

**Important:** To rotate or scale control points, you must use the Transform Control Points command. See “Transform a group of control points,” below.

### Transform a group of control points

You can scale and rotate a group of points as if they were a single object by using the Transform Control Points command. The lines connecting the selected points to unselected points will move and
1. Drag a selection rectangle around the points you want to modify.

2. Choose Edit > Transform Control Points or press Shift-Command-T.

A bounding box appears around the selected points.

**Note:** The Transform Control Points command is available only when at least two points on the same spline are selected.

3. Drag bounding box handles to scale, rotate, offset the anchor point, and reposition the group of points as if they were a single object.

4. To release the selection, click anywhere outside the selection, or switch to a different tool.

---

### Move a shape edge

You can also select the line between two control points and drag the edge of the shape.

1. Click any edge of a shape object.

   The control points on either side of the line are selected.

2. Drag the line segment.
The distance between the two points remains constant, but the line can be moved freely. Press Shift to constrain the movement horizontally, vertically, or diagonally.

3. To release the selection, click anywhere outside the selection, or choose a different tool in the toolbar.

Edit Bezier control points

The methods used to adjust Bezier shapes are similar to those used by many other applications. Bezier control points are widely used to modify curves, and allow you to easily draw any shape you may need. Each point in a Bezier shape can be converted from a hard corner to a curve.

For all of the following procedures, use the Edit Points tool in the 2D transform tools pop-up menu.
Convert Bezier control points from corners to curves

Do one of the following:

- Command-click a curved point to turn it into a corner (Linear) point.

- Command-drag a corner point to turn it into a curved (Bezier) point, creating adjustable tangent handles.

- Control-click selected points, then choose Linear or Smooth from the shortcut menu to change the control point type.

Adjust a Bezier curve using a control point’s tangent handles
Curved Bezier control points have two tangent handles that you use to adjust the curvature of the shape on either side of the control point. These handles can be adjusted in various ways to create symmetrical and asymmetrical curves. By default, these tangent handles are locked to one another at an angle of 180 degrees, but you can override this restriction to adjust each tangent handle independently.

Do any of the following:

- Drag a tangent handle to adjust its length. By default, the opposing tangent is locked to 180 degrees, and adjusting the angle of one tangent handle adjusts the other. However, you can adjust the length of each tangent handle independently.

- Option-drag either tangent handle to break the relationship between opposing tangent handles. After this relationship is broken, adjustments to one tangent handle have no effect on the other, and you can rotate both tangent handles freely.
Control-click a tangle handle point, then choose Break Handle from the shortcut menu to break the relationship between opposing tangent handles.

Option-drag a broken tangent handle or Control-click a handle point and choose Link Handle from the shortcut menu to lock the angle of the tangent handles together again. The tangent handles now maintain their relationship when moved and rotated.

You can also press Option-Command and drag a handle point so the tangent handles maintain their broken relationship when moved and rotated.

Control-click a handle point and choose Align Handles from the shortcut menu to align the tangent handles to a 180-
degree angle.

Press Shift while you adjust a tangent handle to constrain its movement to 45-degree angles. To simultaneously modify the handles for more than one control point, Shift-select the points (on the same spline) and then adjust the tangent handles.

**Important:** If the Record button (in the transport controls under the Canvas) is enabled, curve adjustments are keyframed, creating animated shape changes. Additionally, if a keyframe has been added to the Control Points parameter in the Geometry pane of the Shape Inspector, curve adjustments are keyframed, regardless of the Record button state.

---

**Edit B-Spline control points**

Editing the position of control points in B-Spline shapes is similar to editing Bezier shapes. In fact, the steps for selecting, moving, adding, deleting, and locking control points are almost exactly the same. The main difference in editing both types of shapes lies in how you manipulate and adjust curves.

The simplest, and usually fastest, way to manipulate B-Spline curves is to move B-Spline points closer to or farther from one another. When B-Spline points are moved closer to one another, a sharper curve is created. B-Spline points that are farther from one another create shallower curves.
Each B-Spline control point tugs on a section of the shape, pulling it toward itself. As a result, you manipulate a shape’s curve by moving its control points in the direction you want to pull the shape. For example, notice how every control point creating the S curve below is offset in the direction of the curve it influences.

**Note:** You can show and hide the B-Spline frame lines that enclose B-Spline control points by choosing View > Overlays > Lines.

By default, B-Spline shapes have no corners. However, you can adjust the amount of curvature at each B-Spline control point to create sharper curves using fewer control points. (You can even create corners at a single point, if necessary.)

The easiest way to adjust B-Spline point curvature is by dragging
the control point while holding down the Command key. You can also switch among three preset degrees of curvature.

---

**Adjust B-Spline control point curvature**

1. Select a shape, then click and hold the 2D transform tools pop-up menu and choose the Edit Points tool.

2. In the Canvas, drag selected B-Spline control points while holding down the Command key to make their curves progressively sharper.

   A handle appears indicating the curvature adjustment you’re making.

3. Do any of the following:
   - Drag away from the point to make the curve progressively sharper.
• Drag toward the point to make the curve progressively looser.

![Very smooth B-Spline point](image1) ![Smooth B-Spline point](image2) ![Linear B-Spline point](image3)

**Note:** After the handle appears, you can modify the curve without the Command key.

• Command-click the handle to switch between three progressively sharper amounts of curvature.

Alternatively, you can Control-click a B-Spline point, then choose Very Smooth, Smooth, or Linear from the shortcut menu.

---

**Use dynamic guides and snapping**

The Canvas dynamic guides and control point snapping help you align selected points with other objects.

---

**Use control point snapping on a shape**

1. Click the View pop-up menu above the right side of the Canvas, and ensure that the Dynamic Guides item is checkmarked.
2. In the menu bar, choose View > Snap to ensure that snapping is turned on.

When active, a check mark appears next to the menu item.

3. Select the shape to edit, then click and hold the 2D transform tools pop-up menu in the toolbar and choose the Edit Points tool.
Note: In the Canvas, you can also Control-click a shape and choose Edit Points from the shortcut menu.

4. In the Canvas, drag a control point.

Yellow guides appear when the selected control point aligns with the edges or center of the original shape, the edges or center of other objects, or the center of the Canvas.

Turn off snapping while editing control
points

You can temporarily disable snapping to allow for subtle shape adjustments.

Do one of the following:

- Press N to turn off snapping. Press N again to turn snapping back on.
- As you begin to move the selected control point, hold down the Command key to turn off snapping as you drag the point.

Specify whether control points snap to the center, edges, or both the center and edges of an object

1. Choose Motion > Preferences (or press Command-comma).
2. In the Canvas pane, choose an option from the “Snap Objects At Their” pop-up menu.

Edit shape fill, outline, and feathering

After you draw a shape, you can adjust the fill, outline, and feathering to suit your needs. Because a line is really an outline, all
Outline parameters in the Inspector apply to a line.

For information on adjusting shape and mask splines and control points, see Edit control points overview.

## Edit a shape’s outline

1. Select a shape in the Layers list, Canvas, or Timeline, then open the Shape Inspector.

2. To manipulate the shape’s outline, do any of the following in the Style pane of the Shape Inspector:
   - **Turn a shape’s outline on or off**: Select or deselect the Outline activation checkbox. When selected, the checkbox turns blue.
   - **Change the color of the outline**: In the Outline controls select a different color from the Brush Color control.
   - **Change the width of the outline**: Drag the Width slider.

   **Note**: You can also use the Shape HUD to turn the outline on and off, and to change its color, roundness, and width.
   - **Change how the outline’s sharp corners are drawn**: Click the Joint pop-up menu, then choose an option.
   - **Change the shape of an outline’s start and end caps**: Click the Start Cap or End Cap pop-up menu, then choose an option.
   - **Change whether the outline appears over or under a shape’s fill**: Click the Order pop-up menu, then choose an
- *Change the outline from the default solid to an editable paint stroke:* Set Brush Type to Airbrush or Image. For more information, see Style pane.

3. To change the roundness of the outline, adjust the Roundness slider in the Geometry pane of the Shape Inspector (or in the Shape HUD).

### Edit a shape’s fill

1. Select a shape in the Layers list, Canvas, or Timeline.

2. In the Style pane of the Shape Inspector, do any of the following:
   - *Turn a shape’s fill on or off:* Select or deselect the Fill activation checkbox. When selected, the checkbox turns blue.
   - *Change a shape’s fill mode from a solid color to a gradient:* Click the Fill Mode pop-up menu, then choose Gradient.

     If the shape’s fill mode is set to a solid color, you can choose the color using the Fill Color control.

     If the shape’s fill mode is set to a gradient, you can choose a gradient from the Gradient preset pop-up menu, or click the Gradient parameter’s disclosure triangle to display the gradient editor and create your own custom gradient. For more information on using gradient editors, see Gradient editor controls.
Feather a shape

1. Select a shape in the Layers list, Canvas, or Timeline.

2. If the shape’s outline is visible, deselect the Outline activation checkbox in the Style pane of the Shape Inspector.

3. Do one of the following:
   - Adjust the Feather slider in the HUD or in the Style pane of the Shape Inspector.
     Positive values spread the feathering outward, while negative values feather the shape inward.

   - Drag the outer edge of a simple shape inward or outward
Drag the outer edge of a simple shape inward or outward in the Canvas.

**Note:** You can only feather shapes that have the outline turned off.

4. Optionally, you can also adjust the Falloff parameter in the Style pane of the Shape Inspector, which controls how steep the feathering is.

---

**SEE ALSO**

*Shape controls in the Inspector overview*

---

**Shape controls in the Inspector**

The Shape Inspector appears when you select a shape in the Canvas, Layers list, or Timeline. This Inspector comprises four panes:
The **Style pane** contains controls to modify the fill color, opacity, feathering, and outline of a shape. The Style pane also contains brush controls for a paint stroke or an outline.

The **Stroke pane** contains controls to set paint brush parameters, such as the spacing of the brush stoke dabs or the angle of the brush. The Stroke pane also contains gradient editor controls for the color stroke mode.

The **Advanced pane** contains controls to animate the dabs of a paint stroke like particles. The Advanced pane parameters control the life, speed, and spin of the animated dabs.

The **Geometry pane** contains controls that adjust the roundness or curvature of a shape, to close or open a shape, and to individually adjust the position of a shape’s control points using value sliders. The Convert To Points button is available when a simple shape is selected, allowing you to convert the simple shape to a Bezier shape with editable control points. You can also change the shape type (Linear, Bezier, or B-Spline).

---

**Style pane**

The Shape Inspector’s Style pane contains controls to modify the fill and outline of a shape, including changing the brush type for an outline or paint stroke. The parameters are grouped into two main categories of controls: Fill and Outline. The Style pane is available for all shapes and paint strokes.

**Shape Style pop-up-up menu**
Use this pop-up menu to apply a preset shape style (from the Shape Styles category in the Library) to the selected shape. In addition to the preset styles, any custom styles you’ve saved to the Library appear in this list.

## Fill controls

Adjust this group of parameters to set custom color, opacity, and feathering attributes of shape fills. An activation checkbox turns on or off the fill parameters for the selected shape. By default, this checkbox is selected (highlighted blue) for new closed shapes.

- **Fill Mode**: A pop-up menu that sets how a shape is filled. There are two options:
  - **Color**: Activates the Fill Color and Fill Opacity controls.
  - **Gradient**: Activates the Gradient editor and Gradient preset pop-up menu.

- **Fill Color**: Color controls (available when Fill Mode is set to Color) that let you pick a color fill for the shape. For more information on using color controls, see [Basic color controls](#).

- **Fill Opacity**: A slider (available when Fill Mode is set to Color) that adjusts the opacity of the fill (independently of the outline, if the Outline parameter is enabled).

- **Gradient preset pop-up menu (unlabeled)**: A pop-up menu (available when Fill Mode is set to Gradient) that applies a preset gradient (from the Gradients category in the Library) to the selected shape. In addition to the preset gradients, any custom gradients you’ve saved to the Library appear in this list.

  **Gradient editor**: A standard gradient editor (available when Fill Mode is set to Gradient) that lets you create custom gradients.
Gradient editor: A standard gradient editor (available when Fill Mode is set to Gradient) that sets custom color and opacity gradients. Click the disclosure triangle to the left to display all the gradient controls. For more information on using gradient editors, see Gradient editor controls. The controls for the Gradient editor are identical to the gradient controls for text, with one exception: The text gradient parameters include a dial to control the angle of the gradient. The shape gradient parameters, however, use Start and End point controls, available in the Inspector or via onscreen controls.

Feather: A slider that feathers (softens) the edges of a shape. Positive feathering values soften the edge of the shape from its edge outward. Negative feathering values soften the edge of a shape inward from the edge.

Note: You cannot feather an object when the Outline activation checkbox is selected.

Falloff: A slider that controls how “steep” the feathering is. Higher values result in feathering that’s pushed farther inward, so the edge of the feathering effect is more transparent. Lower values result in the “core” of the feathering effect being pushed farther outward, so the edge of the feathering effect is less transparent.

Note: You cannot adjust Falloff when the Outline activation checkbox is selected.

Outline controls

Use this group of parameters to set the outline attributes of a shape. An activation checkbox turns on or off the outline parameters for a selected shape. By default, this checkbox is
deselected for closed shapes and is selected for open shapes and paint strokes. When you select the Outline checkbox, the Brush Type, Brush Color, Brush Opacity, Width, First and Last Point Offsets, Order, and other controls become available.

- **Brush Type**: A pop-up menu that sets the kind of brush used to draw the outline. There are three options:

  - **Solid**: Creates a solid outline along the shape spline or paint stroke. This is the default setting.
  
  - **Airbrush**: Creates an outline made up of editable brush strokes referred to as *dabs*. You can set the dabs to be close together so the line appears solid, or you can space the dabs further apart. When Brush Type is set to Airbrush, the Stroke and Advanced panes become available in the Shape Inspector.
  
  - **Image**: Lets you use an image layer in your project as a dab source. When Brush Type is set to Image, the Stroke and Advanced panes become available in the Shape Inspector.

- **Brush Color**: Color controls that let you pick a color to use for the outline or paint dabs. These color controls are identical to the shape Fill Color controls (and all color controls throughout Motion).

**Note**: When Stroke Color Mode (in the Stroke pane) is set to
Color Over Stroke or Pick From Color Range, the Brush Color controls are not available.

- **Brush Opacity:** A slider that defines the opacity of the entire stroke, regardless of the Brush Type setting.

**Note:** When Stroke Color Mode (in the Stroke pane) is set to Color Over Stroke or Pick From Color Range, the Brush Color and Brush Opacity parameters are not available. When Stroke Color Mode (in the Stroke pane) is set to Use Brush Color, you can adjust the opacity, in the Stroke pane, to change over the course of the stroke. For more information on using the Opacity Over Stroke parameter, see Stroke pane.

The Brush Opacity control defines a different opacity value for a shape and its outline.

- **Brush Source:** An image well (available when Brush Type is set to Image) that lets you set an image layer in your project as the outline’s brush source. Drag an image, image sequence, QuickTime movie, text object, or shape from the Layers list into the Brush Source image well.

**Note:** When a movie or image sequence is the brush source, additional parameters appear in the Outline group of controls.
For more information, see Style pane movie controls.

- **Brush Profile**: A gradient editor (available when Brush Type is set to Airbrush) that sets varying levels of opacity within the brush. The brush profile uses the same opacity controls as a standard gradient editor. For more information, see Gradient editor controls. The default Brush Profile gradient creates a soft airbrush.

    ![Image of Brush Profile](image1.png)

    Modify the Brush Profile opacity gradient to create new brush looks.

    ![Image of Brush Profile](image2.png)

- **Width**: A slider that changes the width of a shape’s outline or width of a paint stroke’s dabs. On paint strokes, width adjustments alter the size of the dab while also maintaining the spacing between each dab.

    ![Image of Width](image3.png)

    **Note**: If you used the pressure parameters in the Paint Stroke Tool HUD to create variations in the stroke when the stroke was created, adjusting the Width parameter affects the width of the stroke uniformly.
- **Preserve Width**: A checkbox (available when Brush Type is set to Solid) that, when selected, maintains the defined width of the shape outline or paint stroke when the shape or stroke is scaled.

- **Joint**: A pop-up menu (available when Brush Type is set to Solid) that sets how hard corners on a shape’s outline are drawn. There are three options:
  - **Square**: All corners are squared off.
  - **Round**: All corners are rounded.
  - **Bevel**: All corners are cut at an angle.

- **Start Cap**: A pop-up menu (available when Brush Type is set to Solid) to choose the shape of an open outline’s start cap (the shape of the edge of an outline). There are five options:
  - **None**: The stroke ends at the control point.
  - **Square**: The cap is squared off.
  - **Round**: The cap is rounded.
  - **Bevel**: The cap is cut at an angle.
  - **Arrow**: The cap is a customizable arrow. When Arrow is selected from the Start Cap or End Cap pop-up menus, the Arrow Length and Arrow Width sliders appear.

- **End Cap**: A pop-up menu (available when Brush Type is set to Solid) to choose the shape of an outline’s end cap. There are five options:
  - **None**: The stroke ends at the control point.
  - **Square**: The cap is squared off.
  - **Round**: The cap is rounded.
- **Round:** The cap is rounded.
- **Bevel:** The cap is cut at an angle.
- **Arrow:** The cap is a customizable arrow. When Arrow is selected from the Start Cap or End Cap pop-up menus, the Arrow Length and Arrow Width sliders appear.
- **Spacing:** A slider (available when Brush Type is set to Airbrush or Image) that defines the space between dabs. A lower number creates a more solid line, and a higher number creates a greater distance between dabs.
- **Additive Blend:** A checkbox (available when Brush Type is set to Airbrush or Image) that composites all overlapping dabs together using the Additive blend mode. By default, dabs are composited together using the Normal blend mode. The Additive blend mode occurs in addition to whichever compositing method is already in use (the Blend Mode setting in the Properties Inspector).
- **Reverse Stacking:** A checkbox (available when Brush Type is set to Airbrush or Image) that inverts the order in which the dabs are stacked. To see the effect of this parameter, dabs must be overlapping.
- **First Point Offset:** A slider to offset and animate the start point of the outline. This is very useful for effects such as drawing a line across a map over time.
- **Last Point Offset:** A slider to offset and animate the end point of the outline.

You can manually animate the First Point Offset and Last Point Offset parameters in the Style pane of the Shape Inspector to achieve the same effect as the Write On behavior. (You can also use the Shape Write On behaviors to draw a stroke or
outline over time. For more information, see Write On.)

- **Order:** A pop-up menu that sets whether an outline is drawn over or under the shape fill color or gradient. The effect is more apparent with thicker outline widths. There are two menu options:
  - **Over Fill:** Outlines appear on top of the selected fill of the shape.
  - **Under Fill:** Outlines are obscured beneath the selected fill of the shape.

**Style pane movie controls**

Additional controls appear in the Shape Inspector’s Style pane when the Brush Source is a multi-frame object such as a QuickTime movie or image sequence:

- **Play Frames:** A checkbox that controls playback of Brush Source movie or image sequence. If the checkbox is selected, playback of the clip loops; if the checkbox is deselected, the paint dabs use the still frame specified by the Random Start Frame parameter or the Source Start Frame parameter (described below).

- **Random Start Frame:** A checkbox that introduces variation to image brush strokes when the Brush Source parameter contains a multiframe movie or image sequence. If the checkbox is selected, each dab uses a different random frame in the source clip. If the Play Frames checkbox is selected, dabs begin animating from this random frame. If the Play Frames checkbox is deselected, dabs do not animate, but display the random frame as a still frame. You can adjust
this pattern of randomness using the Random Seed button in the Stroke pane.

- **Source Start Frame**: A mini-curve editor (available when Random Start Frame is deselected) that defines the frame where playback of the source clip begins in the paint dabs. (See Work in the mini-curve editor.) The Source Start Frame default keyframe value is 0. You can change the start frame for all dabs, or you can create a curve so start frames vary over the length of the stroke (different dabs use different start frames). For example, if the first Source Start Frame value is 50, each dab begins playback at frame 50. If you create an animation curve that begins at 50 and ends at 250, each dab begins clip playback at a progressively later frame.

**Note**: The Play Frames checkbox must be selected for playback to occur. If Play Frames is deselected, you can display different still frames over the length of the stroke.

Click the Source Start Frame disclosure triangle to see the Stroke Length and Source Start Frame controls:

- **Source Start Frame Over Stroke**: A slider that adjusts the value of the selected keyframe in the mini-curve editor.

- **Stroke Length**: A slider that adjusts the value of the selected keyframe. Stroke Length is mapped horizontally on the mini-curve editor graph and provides a visual representation of the position of the changes in start frame value (keyframes) over the length of the stroke.

- **Hold Frames**: A slider that sets the number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

**Hold Frames Randomness**: A slider that varies the number of
Hold Frames Randomness: A slider that varies the number of frames to “hold.”

Stroke pane

The Stroke pane is not available until the Brush Type pop-up menu in the Shape Inspector’s Style pane is set to Airbrush or Image. The Stroke pane contains adjustable parameters specific to the paint stroke and brush, such as opacity, width, brush size, and so on.

Stroke controls

- Stroke Color Mode: A pop-up menu that specifies how color is applied to the stroke over its length. There are three options:
- **Use Brush Color**: Uses the color of the brush as defined by the Brush Color parameter in the Style pane. The stroke is a solid color over its length.

- **Color Over Stroke**: Dabs are tinted based on their position over the length of the paint stroke.

- **Pick From Color Range**: Dabs are tinted at random, with the range of possible colors defined by a gradient editor. A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used.

- **Opacity Over Stroke**: An opacity gradient editor (available when Stroke Color Mode is set to Use Brush Color) to change the opacity of dabs based on their location on the stroke. This gradient control is limited to grayscale values, which are used to represent varying levels of transparency. White represents solid dabs, progressively darker levels of gray represent decreasing opacity, and black represents complete transparency. A simple white-to-black gradient represents a stroke that is solid at its start, but fades out gradually over its length until finally vanishing at the end. For information on using gradient editors, see [Gradient editor controls](#).

- **Color Over Stroke**: A gradient editor (available when Stroke Color Mode is set to Color Over Stroke) to define the range of color in the stroke, beginning with the leftmost color in the gradient, and progressing through the range of colors until reaching the rightmost color at the end of the stroke. Gradual color changes do not appear in each dab, but only across the stroke as a whole. An opacity bar appears at the top of the gradient editor. For information on using gradient editors, see [Gradient editor controls](#).
• **Color Range**: A gradient editor (available when Stroke Color Mode is set to Pick From Color Range) to define a range of colors to randomly tint the stroke’s paint dabs. The direction of the gradient colors is not relevant (because this control merely defines the colors to be used in the random tinting). The Color Range parameter has the same controls as the Color Over Stroke parameter. For information on using gradient editors, see Gradient editor controls.

• **Color Repetitions**: A slider (available when the Stroke Color Mode is set to choose Color Over Stroke) that increases the number of times the gradient is repeated over the stroke.

• **Spacing Over Stroke**: A mini-curve editor that lets you customize the spacing of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs’ spacing over the length of the stroke, create a curve that varies the dabs’ spacing over the length of the stroke, and so on.

In the following illustrations, the default Spacing Over Stroke value of 100% in the mini-curve editor creates an even distribution of the dabs—based on the value set in the
Spacing parameter in the Style pane. For more information on using the mini-curve editor, see Work in the mini-curve editor.

In the following illustrations, the Spacing Over Stroke curve in the mini-curve editor is adjusted to use a greater value at the start of the stroke, and 100% at the end of the stroke. The dabs at the beginning of the stroke are spaced more widely apart and get closer at the end of the stroke.

Two additional controls in the mini-curve editor let you fine-tune the values of selected points in the curve:
- **Spacing Over Stroke**: A slider that adjusts the spacing between dabs at the selected keyframe. Increasing this parameter increases the spacing between each dab in the stroke.

- **Stroke Length**: A slider that determines where along the range of the dabs within the stroke the Spacing Over Stroke value (for the selected keyframe) is applied.

- **Fixed Brush Dabs**: A checkbox that, when selected, keeps the number and spacing of the dabs constant regardless of the changes in the stroke’s shape over time caused by behaviors or keyframe animation. The effect of this parameter is not visible when editing a paint stroke on a single frame.

- **Anchor Dabs To**: A pop-up menu (available when the Fixed Brush Dabs checkbox is deselected) that defines how dabs are added to or removed from a paint stroke when the length of the paint stroke is modified. There are two options:
  - **Start**: Adds dabs to or removes dabs from the start point of a paint stroke when the length of the paint stroke is modified. The first dab on the stroke remains fixed.
  - **Start and End**: Adds dabs to or removes dabs from the start and end points of a paint stroke when the length of the paint stroke is modified. The first and last dabs on the stroke remain fixed.

**Note**: Changing a shape’s control points or adjusting the Width or Spacing parameters (in the Style pane) or Spacing Over Stroke and Width Over Stroke parameters (in the Stroke pane) affects the dab spacing because larger dabs can be spaced further apart.

- **Width Over Stroke**: A mini-curve editor that lets you customize
the width of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs’ width over the length of the stroke, create a curve that varies the dabs’ width over the length of the stroke, and so on. The start value for the dab width is based on the value set in the Width parameter in the Style pane. For more information on using the mini-curve editor, see *Work in the mini-curve editor*.

Two additional controls in the mini-curve editor let you fine-tune the values of selected points in the curve:

- **Width Over Stroke**: A slider that adjusts the width of the dab at the selected keyframe.
- **Stroke Length**: A slider that determines where along the range of the dabs within the stroke the Width Over Stroke value (for the selected keyframe) is applied.

You can also adjust the Width Over Stroke parameter for a selected paint stroke in the Canvas. For more information, see *Use the Width Over Stroke onscreen controls*.

- **Brush Scale**: A slider that adjusts the size of the brush (the source of the dabs). Click the disclosure triangle to adjust the X and Y scale values independently. By default, Scale is set to 100%—the size of the dabs is equal to the size of the source brush. Unlike the width parameter in the Style pane, brush scale adjustments affect only the size of the dabs and don’t preserve the spacing between dabs.
- **Brush Scale Randomness**: A slider that defines an amount of variance in the scale of the stroke’s brush. A value of 0 results in no variance—all dabs in the stroke are the same size. A value greater than 0 introduces a variance. The scale for an individual dab is defined by the Scale parameter, plus or
minus a random value falling within the Brush Scale, Width Over Stroke, and Width (in the Style pane) parameters. Click the disclosure triangle to adjust the X and Y values independently.

- **Align Brush Angle**: A checkbox that, when selected, causes the stroke dabs to rotate to match the shape on which they are positioned.

- **Brush Angle**: A dial that specifies (in degrees) the rotation of the stroke dabs. Using the default dial or value slider modifies the Z angle. When the Local 3D checkbox (described below) is selected, additional Brush Angle Randomness controls become available. Click the disclosure triangle to expose X, Y, and Z rotation dials and the Animate pop-up menu.

- **Animate**: A pop-up menu (available when the Local 3D checkbox—described below—is selected) that lets you change the interpolation for animated 3D rotation channels. Click the Brush Angle disclosure triangle to display the Animate parameter. There are two menu options:
  - **Use Rotation**: Dabs rotate from their start rotation to their final rotation. Depending on the animation, the elements may rotate multiple times before reaching their final orientation (the last keyframed value). For
example, if the X, Y, and Z angle parameters are animated from 0 degrees to 180 degrees in a project, the elements rotate on all axes before reaching their final orientation.

- **Use Orientation**: Dabs rotate more smoothly and without multiple rotations. This option interpolates between the dabs’ start orientation (first keyframe) and their end orientation (second keyframe).

- **Angle Over Stroke**: A mini-curve editor that lets you customize the Z rotation (in degrees) of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs’ angle over the length of the stroke, a curve that varies the dabs’ angle over the length of the stroke, and so on. For more information on using the mini-curve editor, see [Work in the mini-curve editor](#).

Two additional controls in the mini-curve editor let you fine-tune the values of selected points in the curve:

- **Angle Over Stroke**: A dial that adjusts the angle of the dab at the selected keyframe.

- **Stroke Length**: A slider that determines where along the range of the dabs within the stroke the Angle Over Stroke value (for the selected keyframe) is applied.

- **Brush Angle Randomness**: A dial that defines an amount of variance in the rotation of the stroke dabs. A value of 0 results in no variance—all dabs have the same rotational value. A value greater than 0 introduces a variance. The angle for an individual dab is defined by the Brush Angle and Angle Over Stroke parameters, plus or minus a random value falling within the Brush Angle Randomness. Using the default dial modifies
the Z angle. To modify the rotation of the dabs in X, Y, and Z space, or to access the Animate parameter (available when the Local 3D checkbox is selected), click the disclosure triangle.

- **Animate**: A pop-up menu (available when the Local 3D checkbox—described below—is selected) that lets you change the interpolation for animated 3D rotation channels. Click the Brush Angle Randomness disclosure triangle to display the Animate parameter.

- **Use Rotation**: Dabs rotate from their start rotation to their final rotation. Depending on the animation, the elements may rotate multiple times before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, the elements rotate on all axes before reaching their final orientation.

- **Use Orientation**: Dabs rotate more smoothly and without multiple rotations. This option interpolates between the dabs’ start orientation (first keyframe) and their end orientation (second keyframe).

- **Local 3D**: A checkbox that lets you take advantage of the Motion 3D workspace. When the Local 3D checkbox is selected, the following become possible:
  - When the Face Camera checkbox (described below) is selected, paint dabs actively face the camera when the camera or stroke is rotated or animated.
  - When the Dab Depth Ordered checkbox (described below) is deselected, dab ordering remains consistent when the
paint stroke (or the camera) is rotated in X or Y space. When this checkbox is selected, the dabs jump in front of each other each time the stroke rotates 180 degrees. In other words, this checkbox draws the dabs in the stroke according to each dab’s actual 3D position in the project. Dabs that are closer to the camera appear closer; dabs that are farther from the camera appear more distant.

- When the Dynamics checkbox is selected in the Advanced pane, a paint stroke acts similarly to an emitter—the dabs become particles. When the Local 3D checkbox is selected, the dabs are animated in 3D space. When the Local 3D checkbox is deselected, the particles are animated in X and Y space only. For more information on Dynamics, see Advanced pane.

- When the Dynamics checkbox is selected in the Advanced pane, some applied Simulation behaviors will pull dabs out of their plane. For example, if a paint stroke has an applied Attracted To behavior (with the Affect Subobjects checkbox selected), and the target layer is in a different location in Z space, the dabs are pulled into Z space and move toward the target layer. The paint stroke must be a member of a 3D group for a behavior to pull dabs out of the X and Y planes. For information about 3D groups, see Create 3D intersection.

Use the following guidelines when working in 3D with paint strokes:

- Even in a 2D project, you can adjust a paint stroke’s general properties in 3D space. For example, you can modify the Z parameter (depth) using the Position, Scale, Rotation, and Anchor Point controls in the Properties
- Paint strokes do not receive reflections (controlled in the Properties Inspector) unless the Local 3D checkbox is deselected.

- Paint strokes do not cast shadows (controlled in the Properties Inspector) unless the Local 3D checkbox is deselected.

- Lighting does not effect paint strokes unless the Local 3D checkbox is deselected.

**Important:** Even if the Local 3D checkbox is selected, paint strokes do not intersect with the “global” 3D world. This means that paint strokes can exist in 3D space, but do not intersect with objects that exist inside their own group, or with objects in other groups. A 3D paint stroke is composited with the rest of the objects in the project based on layer order.

- **Face Camera:** A checkbox (available when the Local 3D checkbox is selected) that forces stroke dabs to actively face the camera if the camera is rotated or if the paint stroke is rotated or animated. When the Face Camera checkbox is deselected, the dabs face forward in the stroke and appear flat (unless the source layer or paint dabs are rotated in 3D space).

Because paint source dabs are 2D (flat) objects, dabs are not visible when you use the orthogonal reference camera views, such as Left, Right, and Top (unless the source layer or dabs are rotated in 3D space). This is because orthogonal views are at right angles (perpendicular) to the dabs. For more information on using cameras, see Add a camera.

- **Dab Depth Ordered:** A checkbox (available when the Local 3D checkbox is selected) that requires paint strokes to be rendered in the order of the layers they are on. This means that dabs from different layers can be ordered to appear in different depths, creating a more realistic 3D effect.
Dab Depth Ordered: A checkbox (available when the Local 3D checkbox is selected) that keeps paint dab ordering consistent when the paint stroke is rotated in X or Y space. When Dab Depth Ordered is deselected, the dabs jump in front of each other each time the stroke rotates 180 degrees.

- **Jitter**: A slider that lets you create a little chaos in your paint dabs. The higher the value, the more dispersed the dabs become (parallel to and perpendicular to the stroke’s control points). Jitter can be animated with keyframes so the dabs behave like particles. Click the disclosure triangle to display the individual X and Y sliders:
  - **X**: Moves the dabs parallel to the stroke’s curves at control points.
  - **Y**: Moves the dabs perpendicular to the stroke’s curves at control points.

- **Jitter Over Stroke**: A mini-curve editor that lets you customize the scatter of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs’ jitter over the length of the stroke, a curve that varies the dabs’ jitter over the length of the stroke, and so on. For more information on using the mini-curve editor, see [Work in the mini-curve editor](#).

Two additional controls in the mini-curve editor let you fine-tune the values of selected points in the curve:

- **Jitter Over Stroke**: A slider that adjusts the amount of dab movement along the X and Y axes at specific points along the curve. Click the disclosure triangle to reveal individual X and Y axis sliders, to customize the jitter effect. Drag the X slider to adjust keyframes that define the amount of dab movement parallel to the stroke’s curve at specific points...
along the stroke. Drag the Y slider to adjust keyframes that define the amount of dab movement perpendicular to the stroke’s curve at specific points along the stroke. Use the Jitter Over Stroke parameter to adjust the amount of dab movement in both directions at specific points along the curve (adjusts the purple and green curves simultaneously).

- **Stroke Length**: A slider that determines where along the range of the dabs within the stroke the Jitter Over Stroke value (for the selected keyframe) is applied.

- **Random Seed**: Controls that vary the Jitter, Brush Angle Randomness, and Brush Scale Randomness parameters (in the Stroke pane) and the Life, Speed, and Spin Randomness parameters (in the Advanced pane). If you don’t like the current random distribution of the dabs, you can change the seed number by typing a new number in the value field or clicking Generate. The Jitter value must be 1 or more for this parameter to have any effect.
The Advanced pane is not available until the Brush Type pop-up menu in the Shape Inspector’s Style pane is set to Airbrush or Image. The Advanced pane contains Dynamics controls that animate the dabs of a paint stroke like particles. Unlike particles, dabs are only “born” one time; but they can age and die like particles. When the Dynamics checkbox is deselected, dabs are immortal and are not animated.

**Note:** Although the Dynamics parameters are animated by default, you can customize the animation by keyframing or applying Parameter behaviors to the Dynamics parameters in the Advanced pane.

In addition to the Dynamics controls, the Advanced pane also contains controls for adjusting pen pressure and speed.

### Dynamics controls

Select the activation checkbox and adjust this group of parameters to animate paint stroke dabs in particle-like fashion. Click the Show button on the right side of the Dynamics row to reveal the Dynamics controls:

**Note:** When a Simulation behavior is applied to a paint stroke, the Affect Subobjects parameter appears in the Behaviors Inspector only when the Dynamics checkbox is selected (in the Advanced pane of the Shape Inspector) for the paint stroke.

- *Emission Angle*: A dial and value slider that set the direction in which the paint dabs travel. This parameter works in conjunction with the Emission Range parameter (described
- **Emission Range:** A dial and value slider that restrict the area in which the dabs travel, in the direction of the Emission Angle. Setting the Emission Range parameter to 0 degrees keeps dabs perpendicular to the paint stroke.

- **Life:** A slider that defines the duration of each dab, in seconds, controlling how long each dab lasts before disappearing—similar to how sparks disappear after flying away from a sparkler.

- **Life Randomness:** A slider and adjacent value slider that define an amount of variance in the life of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke share the same life span. A value greater than 0 introduces a variance defined by the Life parameter, plus or minus a random value falling within the Life Randomness value.

- **Speed:** A slider that defines initial speed, determining how quickly each dab flies away from the stroke.

- **Speed Randomness:** A slider that defines an amount of variance in the speed of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke move with the same speed. A value greater than 0 introduces a variance defined by the Speed parameter, plus or minus a predetermined random value falling within the Speed Randomness value.

- **Spin:** A dial that animates the dabs of a paint stroke by initially spinning each dab around its center. Adjustments to this control are in degrees per second.

- **Spin Randomness:** A dial that defines an amount of variance in the spin of the paint dabs.
Spin Randomness: A dial that defines an amount of variance in the spin of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke spin at the same rate. A value greater than 0 introduces a variance defined by the Spin parameter, plus or minus a random value falling within the Spin Randomness value.

Pen Pressure and Pen Speed controls

When you draw paint strokes with a connected Wacom stylus and tablet, or apply a shape style from the Shape Style pop-up menu to an existing paint stroke, two additional groups of controls appear in the Advanced pane:

- **Pen Pressure**: Controls that let you adjust the width, opacity, spacing, angle, or jitter of the paint stroke based on the pressure of your stylus on the tablet when the stroke was created. These controls are identical to the controls in the Apply Pen Pressure shape behavior. For more information, see [Apply Pen Pressure](#).

- **Pen Speed**: Controls that let you adjust the width, opacity, spacing, angle, or jitter of the paint stroke based on the speed of your stylus on the tablet when the stroke was created. These controls are identical to the controls in the Apply Pen Pressure shape behavior. For more information, see [Apply Pen Speed](#).

**Note**: Only strokes drawn using a stylus and tablet have recorded pressure variations. You can select how the pressure of the stylus affects the stroke in the Paint Tool HUD before you draw the stroke, or afterwards by activating this parameter in the Advanced pane.
Geometry pane

The Geometry pane of the Shape Inspector contains controls that allow you to change the shape type, to close or open a shape, and to individually adjust the position of a shape’s control points.

The Geometry pane controls are available for all shapes regardless of what is selected in the Brush Type pop-up menu in the Style pane. You can change a shape’s type at any time. Changing a shape’s type changes its form. For example, a single set of control points produces the following three shapes, depending on the selected Shape Type.

![Linear shape](image1.png) ![B-Spline shape](image2.png) ![Bezier shape](image3.png)

The Geometry pane contains the following adjustable controls:

**Basic Geometry controls**

- *Roundness*: A slider (available when a simple rectangle shape, Bezier shape, or B-Spline shape is selected) that adjusts the roundness of shape corners. Use this control to create rounded rectangles or to smooth the edges of any shape.

- *Curvature*: A slider (available when a simple circle shape is selected) that adjusts the degree of curvature of the circle. When set to 100%, the shape is elliptical. When set to 0%, the shape is rectangular.
- **Preserve Scale:** A checkbox (available when a simple rectangle shape, Bezier shape, or B-Spline shape is selected) that controls whether the Roundness setting is absolute or relative to the overall shape size. When this checkbox is selected, the roundness remains at the same approximate percentage of curvature as the object is scaled. When this checkbox is deselected, the curvature varies as the overall shape changes size.

- **Radius:** A slider (available when a simple circle shape is selected) that controls the width and height of the shape. Click the disclosure triangle to reveal individual X (width) and Y (height) sliders.

- **Size:** A slider (available when a simple rectangle shape is selected) that controls the scale of the shape. Click the disclosure triangle to reveal individual Width and Height sliders.

- **Shape Type:** A pop-up menu (available when a complex shape with control points is selected) that sets the type of control points used to define the shape. For example, if you originally created a Bezier shape, you can choose B-Spline from this menu to change each Bezier control point into a B-Spline control point. Changing the shape type does not move the control points, although the shape is changed, sometimes dramatically. There are three options:
  - **Linear:** All control points are joined by hard angles, and the resulting shape is a polygon. The control points of a Linear shape lie directly on its edges.
  - **Bezier:** Control points can be a mix of Bezier curves and hard angles, creating any sort of shape. The control points of a Bezier shape lie directly on its edge.
• **B-Spline:** Control points are all B-Spline points, with different degrees of curvature. B-Spline control points lie inside, outside, or on the edge of the shape, and are connected by the B-Spline frame.

• **Closed:** A checkbox (available when a complex shape with control points is selected) that, when selected, connects the first and last points of an open shape. If you select a closed shape in the Canvas, this checkbox is selected. Deselecting this checkbox disconnects the first and last points, converting the object into an open shape.

• **Convert To Points:** A button (available when a simple shape is selected) that, when clicked, converts a simple shape to a complex shape with editable control points. For more information, see Convert a simple shape or mask to editable control points.

---

**Control Points controls**

When a complex shape with control points is selected, this list becomes available, displaying the X and Y position parameters for the shape’s control points. The Control Points list also contains a single Animation menu (the downward arrow that appears when you move the pointer over the right side of the Control Points header row) that affects all the control points, letting you add keyframes, reset the shape’s animation, display the animation curve in the Keyframe Editor, and so on. For more information on using the Animation menu, see Animation menu.

---

**Shape behaviors**
Shape behaviors overview

Although you can animate shapes in your project by applying standard behaviors, a special category of behaviors is designed for use with shapes and their parameters.

There are nine Shape behaviors:

- **Apply Pen Pressure** maps stylus pressure to width, opacity, spacing, jitter, and other parameters when you draw a paint stroke with a Wacom tablet.

- **Apply Pen Speed** maps stylus speed to width, opacity, spacing, jitter, and other parameters when you draw a paint stroke with a Wacom tablet.

- **Apply Pen Tilt** maps stylus angle to width, opacity, spacing, jitter, and other parameters when you draw a paint stroke with a Wacom tablet.

- **Oscillate Shape** animates a shape by cycling its control points between two values.

- **Randomize Shape** animates a shape by applying a random offset to each control point.

- **Sequence Paint** animates the individual dabs of a paint stroke in sequence over time.

- **Track Points** pins the control points of a shape or mask to a moving clip or animated object.

- **Wriggle Shape** animates a shape with an effect similar to the Randomize Shape behavior, but more slowly.

- **Write On** draws a paint stroke or shape outline in the Canvas over time.
You **apply a Shape behavior** the same way you apply standard behaviors to any object in Motion. And after you apply a Shape behavior, you can modify its parameters in the Behaviors Inspector to create highly customized animations.

**Note:** For general information about animating with behaviors, see Behaviors overview.

## Apply a Shape behavior

Shape behaviors are applied like any other behavior in Motion.

Do one of the following:

- From the Behaviors section of the Library, drag a Shape behavior to a shape, mask, or paint stroke in the Canvas, Layers list, or Timeline.

- Select a shape, mask, or paint stroke in the Canvas, Layers list, or Timeline, then select a Shape behavior in the Library and click Apply in the preview area.

- Select a shape, mask, or paint stroke in the Canvas, Layers list, or Timeline, then click Add behavior pop-up menu in the toolbar and choose a behavior from the Shape category.

**Note:** When you apply a Shape behavior to a simple shape (a shape without control points), a dialog appears asking if you want to convert the shape to a complex shape with control points.
The Shape behavior is applied to the shape, mask, or paint stroke.

Apply Pen Pressure

When you use a Wacom stylus and tablet to create paint strokes with the Paint Stroke tool, the Apply Pen Pressure behavior controls width, opacity, spacing, angle, or jitter of the stroke based on the pressure of your stylus on the tablet.

**Note:** These parameters are identical to the Pen Pressure parameters in the Advanced pane of the Shape Inspector. You can choose to use the Advanced pane parameters or this shape behavior to apply the pressure data to the paint stroke. You can use a combination of Pen Pressure parameters in the Advanced pane and Apply Pen Pressure behaviors to affect more than one parameter (such as Opacity, Width, or Jitter) of the stroke using the same pressure data.

You can adjust the Apply Pen Pressure behavior using the following controls in the Behaviors Inspector:

- **Apply To:** A pop-up menu that sets how your paint stroke is affected by pen pressure. There are five options:
  - **Width:** Pen pressure affects the width of the stroke. The harder the pressure, the wider the stroke.
  - **Opacity:** Pen pressure affects the opacity of the stroke. The harder the pressure, the more opaque the stroke.
  - **Spacing:** The harder the pressure, the greater the spacing between stroke dabs.
- **Angle**: The harder the pressure, the greater the angle of the stroke dabs.

- **Jitter**: The harder the pressure, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs so they appear more like particles.

- **Min Pressure**: A slider that adjusts the minimum threshold of pressure sensitivity. Pressure values below the minimum value are remapped to 0. For Opacity and Width, those remapped values do not appear. For Spacing, Angle, and Jitter, the values are not modified. If the Min Pressure and Max Pressure (described below) parameters are plotted on a graph, Min Pressure represents the minimum value, or 0. The area of the graph between Min Pressure and Max Pressure is remapped to the output values.

- **Max Pressure**: A slider that adjusts the maximum threshold of pressure sensitivity. Pressure values above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, those values will have the greatest effect. If the Min Pressure and Max Pressures parameters are plotted on a graph, Max Pressure represents the maximum value, or 1. The area of the graph between Min Pressure and Max Pressure is remapped to the output values.

- **Scale**: A slider that sets the magnitude of the effect. The Scale slider defines the output range for the dabs based on the mapped values between minimum (0) and maximum (1) pressure, multiplied by the value defined in the slider (or adjacent value slider). This amount is then applied to the parameter (width, opacity, and so on) by multiplying (for width, opacity, spacing, and jitter) or adding (for angle). This control is independent of the Scale parameter in the Stroke pane of
the Shape Inspector.

- **Invert**: A checkbox that, when selected, inverts the attributes of the stroke created by the behavior. For example, if pen pressure is set to affect the opacity of the stroke, transparent areas of the stroke become more opaque and opaque areas become more transparent when the checkbox is selected.

**Apply Pen Speed**

When you use a Wacom stylus and tablet to create paint strokes with the Paint Stroke tool, the Apply Pen Speed behavior controls the width, opacity, spacing, angle, or jitter of the paint stroke based on the speed of your stylus on the tablet. (A paint stroke created using a mouse can also be affected by the Apply Pen Speed behavior.)

**Note**: In the Paint Stroke Tool HUD, you can select how the speed of the stylus affects the stroke before the stroke is created. Use the Pen Speed setting in the HUD in combination with a Pen Speed behavior to affect more than one parameter of the stroke (such as Opacity, Width, or Jitter) using the same pressure data. The Pen Speed parameter also appears in the Advanced pane of the Shape Inspector.

You can adjust the Apply Pen Speed behavior using the following controls in the Behaviors Inspector:

- **Apply To**: A pop-up menu that sets how your paint stroke is affected by pen speed. There are five options:
  - **Width**: The quicker you move the pen, the more narrow the stroke; the slower you move the pen, the wider the stroke.
• **Opacity:** The faster you move the pen, the less opaque the stroke.

• **Spacing:** The faster you move the pen, the greater the spacing between stroke dabs.

• **Angle:** The faster the movement of the pen, the greater the angle of the stroke dabs.

• **Jitter:** The faster the movement of the pen, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs so they appear more like particles.

• **Min Speed:** A slider that adjusts the minimum threshold of speed sensitivity. Speed values below the minimum value are remapped to 0. For Opacity and Width, those values do not appear. For Spacing, Angle, and Jitter, the values are not modified. If the Min Speed and Max Speed (described below) parameters are plotted on a graph, Min Speed represents the minimum value, or 0. The area of the graph between Min Speed and Max Speed is remapped to the output values.

• **Max Speed:** A slider that adjusts the maximum threshold of speed sensitivity. Speed values above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, those values will have the greatest effect. If the Min Speed and Max Speed parameters are plotted on a graph, Max Speed represents the maximum value, or 1. The area of the graph between Min Speed and Max Speed is remapped to the output values.

• **Scale:** A slider that determines the magnitude of the effect. The Scale slider defines the output range for the dabs based on the mapped values between minimum (0) and maximum (1)
speed, multiplied by the value defined in the slider (or adjacent value slider). This amount is then applied to the channel (width, opacity, and so on) by multiplying (for width, opacity, spacing, and jitter) or adding (for angle). This control is independent of the Scale parameter in the Stroke pane of the Shape Inspector.

- \textit{Invert}: A checkbox that, when selected, inverts the attributes of the stroke created by the behavior. For example, if pen speed is set to affect the width of the stroke, thin areas of the stroke become wide and wide areas become thin when the checkbox is selected.

\section*{Apply Pen Tilt}

When you use a Wacom stylus and tablet to create paint strokes with the Paint Stroke tool, the Apply Pen Tilt behavior controls the width, opacity, spacing, angle, or jitter of the paint stroke based on the tilt of the pen.

\textbf{Note:} You can use a combination of Apply Pen Tilt shape behaviors to affect more than one parameter (such as Opacity, Width, or Jitter) of the stroke using the same tilt data.

You can adjust the Apply Pen Tilt behavior using the following controls in the Behaviors Inspector:

- \textit{Apply To}: A pop-up menu that sets how your paint stroke is affected by the tilt of your pen as you draw. There are five options:
  - \textit{Width}: The tilt of the stylus affects the width of the stroke. The greater the tilt, the wider the stroke.
- **Opacity**: The tilt of the stylus affects the opacity of the stroke. The greater the tilt, the more opaque the stroke.

- **Spacing**: The greater the tilt of the stylus, the greater the spacing between stroke dabs.

- **Angle**: The greater the tilt of the stylus, the larger the value of the angle of the stroke.

- **Jitter**: The greater the tilt of the stylus, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs so they appear more like particles.

- **Calculate Tilt**: A pop-up menu that sets how the tilt of the stylus affects the stroke. Pen tilt is measured on two axes: X and Y. X represents the stylus tilting to the right and left (toward the right or left side of the tablet); Y represents the stylus tilting up and down (toward the top or bottom of the tablet). There are five menu options:
  - **Absolute**: Takes the maximum tilt from any axis.
  - **X Only**: Measures the tilt only on the X axis.
  - **Y Only**: Measures the tilt only on the Y axis.
  - **Axis**: Makes the Tilt Axis parameter (described below) available.
  - **Polar**: Uses the tilt of the stylus as if it were an angle. When viewed from above, the stylus points in a specific direction. That angle represents a polar value.

- **Tilt Axis**: A dial and value slider (available when Calculate Tilt is set to Axis) that defines the axis along which the tilt is measured.
- **Min Tilt:** Adjusts the minimum threshold of tilt sensitivity. Tilt values below the minimum value are remapped to 0. For Opacity and Width, those remapped values do not appear. For Spacing, Angle, and Jitter, the values are not modified. If the Min Tilt and Max Tilt parameters are plotted on a graph, Min Tilt represents the minimum value, or 0. The area of the graph between Min Tilt and Max Tilt is remapped to the output values.

- **Max Tilt:** A slider that adjusts the maximum threshold of tilt sensitivity. Tilt values above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, those values will have the greatest effect. If the Min Tilt and Max Tilt parameters are plotted on a graph, Max Tilt represents the maximum value, or 1. The area of the graph between Min Tilt and Max Tilt is remapped to the output values.

- **Scale:** A slider that determines the magnitude of the effect. The Scale slider defines the output range for the dabs based on the mapped values between minimum (0) and maximum (1) tilt, multiplied by the value defined in the slider (or adjacent value slider). This amount is then applied to the parameter (width, opacity, and so on) by multiplying (for width, opacity, spacing, and jitter) or adding (for angle). This control is independent of the Scale parameter in the Stroke pane of the Behaviors Inspector.

- **Invert:** A checkbox that, when selected, inverts the attributes of the stroke created by the behavior. For example, if pen tilt is set to affect the width of the stroke, thin areas of the stroke become wide and wide areas become thin when the checkbox is selected.
Oscillate Shape

The Oscillate Shape behavior animates a shape by cycling its control points between two values. You can customize how wide apart the high and low values are, as well as the number of oscillations per minute. This behavior is useful for creating fluid shape movements (think shape yoga) that would be time-consuming to keyframe.

When the Oscillate Shape behavior is applied to a shape, all control points of the shape are affected by default. When the behavior is selected in the Layers list, affected control points are highlighted in white on the blue shape behavior spline. To disable control points, click the control points. A disabled point appears blue.

**Note:** When the Oscillate behavior is applied to a simple shape (without control points), a dialog appears asking if you want to convert the shape.

You can adjust the Oscillate behavior using the following controls in the Behaviors Inspector:

- **Wave Shape:** A pop-up menu that sets the shape of the oscillation’s wave. The options are Sine (default), Square, Sawtooth, and Triangle. For more information on wave shapes, see Oscillate.

- **Phase:** A slider that adjusts the point of the specified oscillation where the behavior starts. Use this control to place multiple shapes with identical Oscillate behaviors out of phase with one another (so they don’t all look the same).

- **Amplitude:** A slider that adjusts the maximum values that the
control points oscillate between. The control point swings between the amplitude value, and the negative of the amplitude value. Higher values result in more extreme swings from the beginning to the ending of each oscillation.

- **Speed**: A slider that adjusts the speed at which the oscillation occurs, in oscillations per minute. Higher values result in faster oscillations.

- **Alternate Phase**: A checkbox that, when selected, offsets the motion of each control point by a phase of 180 degrees from its neighboring control point.

- **Oscillate Around**: A pop-up menu that sets whether the oscillation for each vertex is generated from a point or a perpendicular line. There are two options:
  - **Point Origin**: Each vertex’s oscillation is generated from a point. You can change the location of the point using the onscreen controls (dragging the small blue circle at the center of the shape) or using the X and Y Origin parameters in the Inspector.
  - **Line**: Each vertex’s oscillation is generated from a line. You can change the location of the line using the onscreen controls (dragging the ends of the blue dotted line) or using the Start and End coordinates in the Inspector.

**Randomize Shape**

The Randomize Shape behavior animates the control points of a shape by applying a random offset to each point of the shape.

When the Randomize Shape behavior is applied to a shape, all
control points of the shape are affected by default. When the behavior is selected, affected control points appear blue with white dots in the center of the point on the blue shape behavior spline. To disable control points, click the control points. A disabled point is a darker blue with a dark dot in the center of the point.

Note: When you apply the Randomize Shape behavior to a simple shape (without control points), a dialog appears asking if you want to convert the shape.

You can adjust the Randomize Shape behavior using the following controls in the Behaviors Inspector:

- **Amount:** A slider (available when Apply Mode—described below—is set to Add, Subtract, or Add and Subtract) that defines the maximum value the Randomize behavior will generate.

- **Multiplier:** A slider (available when Apply Mode—described below—is set to Multiply) that defines the maximum value the Randomize behavior will generate.

- **Apply To:** A pop-up menu that defines where on the shape the behavior is applied. There are three options:
  - **Points:** The control points of the shape are randomized,
The control points of the shape are randomized, changing their position over the duration of the behavior.

- **Tangents**: The control points’ tangent handles (rather than the control points themselves) of the shape are randomized. The control points stay in a fixed position while the curves between the points are animated.

- **Points and Tangents**: Both the control points and handles are animated.

- **Apply Mode**: A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. There are four options:
  - **Add**: Values generated by this behavior are added to other behaviors and keyframes that affect the same parameter.
  - **Subtract**: Values generated by this behavior are subtracted from other behaviors and keyframes that affect the same parameter.
  - **Multiply**: Values generated by this behavior are multiplied by other behaviors and keyframes that affect the same parameter.
  - **Add and Subtract**: Values generated by this behavior are added to and subtracted from other behaviors and keyframes that affect the same parameter.

- **Frequency**: A slider that lets you adjust the amount of random variation per second. Higher values generate faster variations, whereas lower values generate slower variations.

- **Noisiness**: A slider that adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected parameter.
• **Link**: A checkbox, available when you apply this behavior to a two-dimensional parameter (such as Distort) or three-dimensional parameter (such as Position or Rotation) that consists of X, Y, and/or Z values. Select this checkbox if you want the transformation applied to the X and Y vertices to be the same. For instance, a +10 change to X will result in an identical +10 change to Y.

• **Preserve Angle**: A checkbox that, when selected, causes the tangent handles become (or remain) flat, maintaining the continuity of the curves.

• **Random Seed**: A button to select a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

---

**Sequence Paint**

The Sequence Paint behavior animates the individual dabs of a paint stroke in sequence over time. This is the only way to animate the dabs individually—keyframing the stroke parameters or applying other behaviors affects all dabs in the stroke uniformly.

The Sequence Paint behavior is very similar to the Sequence Text and Sequence Replicator behaviors, which allow you to animate the Rotation, Color, Opacity, Scale, and Position parameters in sequence through the characters of a text layer or the elements of a replicator pattern. The Sequence Paint behavior adds Width to that list of parameters, allowing you to create sequenced animation through the dabs of a paint stroke.
For an example of using a sequence behavior, see Apply the Sequence Replicator behavior.

Before any sequencing animation can occur, you must add at least one parameter to the behavior in the Inspector, and then set a value for that parameter. Until a parameter is added, adjustments in the Inspector or HUD have no effect. You can add parameters to the Sequence Paint behavior and adjust the behavior using the following controls in the Behaviors Inspector:

- **Parameter**: Add and Remove pop-up menus that add and remove parameters to the sequence. After you add the parameter, additional controls appear in the Behaviors Inspector (above the Add and Remove pop-up menus). Adjust those controls to create a sequence animation based on the difference between the original value of the dabs and the modified value. There are six menu options:
  
  - **Rotation**: Specifies (in degrees) the rotation of the stroke dabs. You can rotate the dial or use the value slider. Click the disclosure triangle next to the Rotation parameter to reveal separate X, Y, and Z Rotation controls.
  
  - **Color**: Specifies a color to tint the stroke dabs. You can click the color well to choose a color, or open the disclosure triangle and use the Red, Green, and Blue sliders.
  
  - **Opacity**: Defines the opacity of the stroke dabs. Set a new
value using the slider.

- **Scale**: Defines the scale of the stroke dabs. Click the disclosure triangle next to the Scale parameter to reveal separate X Scaling and Y Scaling subparameters to scale the width and height of the dabs separately. By default, Scale is set to 100%—the size of the stroke dabs is equal to the original size defined in the stroke parameters.

- **Width**: Defines the width of the dabs. Unlike Scale, Width adjustments alter the size of the dab while also maintaining the spacing between each dab. Set a new value using the slider.

- **Position**: Defines the offset of the dabs from their original position. Click the disclosure triangle next to the Position parameter to reveal separate X, Y, and Z Position subparameters. For example, to create an animation in which the dabs move upward in the Y axis over the paint stroke, enter a positive value in the Y Position field.

- **Sequencing**: A pop-up menu that specifies how the sequence animation (the value change from the original parameter value to the value set in the Sequence Paint parameters) moves through the dabs of the stroke. The starting point for the sequence animation is based on the first control point of the paint stroke. (To change the start point of the shape, select the shape, click and hold the 2D transform tools pop-up menu in the toolbar and choose the Edit Points tool, then Control-click a control point in the Canvas and choose Set Start Point from the shortcut menu.) There are five Sequencing options:
  - **To**: The animation begins at the original value of the dabs and moves to the value set in the Sequence Paint behavior for that parameter. For example, if the original opacity
value of a stroke is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely opaque and become completely transparent.

- **From**: The animation moves *from* the value set in the Sequence Paint behavior to the original value of the stroke. For example, if the original opacity value of a stroke is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely transparent and become completely opaque. This is the opposite of the To Sequencing option.

- **Through**: The sequence goes *through* a full animation cycle starting at the original value of the stroke, moves to the value set in the Sequence Paint behavior, and then returns to the original value of the stroke. For example, if the original opacity value of a stroke dab is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely opaque, become transparent, and then become completely opaque again.

- **Through Inverted**: The sequence goes *through an inverted* animation cycle starting from the value set in the Sequence Paint behavior, moving to the original value of the stroke, and then returning to the value set in the Sequence Paint behavior. For example, if the original opacity value of a stroke is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely transparent, become opaque, and then become completely transparent. This is the opposite of the Through option.

- **From Keyframes**: Lets you keyframe how the animation moves through the values set in the Sequence Paint parameters over a stroke. Each dab undergoes the same
value sequence. When Custom is selected, added parameters must be animated to yield any effect.

- **Unit Size**: A pop-up menu that specifies whether the sequence animation is applied to the stroke as a whole, to its individual dabs, or to a custom range. There are three options:
  - **Dab**: Applies the sequence animation over each dab as its own entity. Dab is the default setting.
  - **All**: Applies the sequence animation to all stroke dabs simultaneously.
  - **Custom**: Lets you specify the percentage of dabs on the stroke affected by the sequence animation at once. Although you can create keyframes for the Custom option, it’s not required to affect the sequence. Use Custom to define an area of dabs affected by the sequence.

- **Start**: A slider (available when Unit Size is set to Custom) that sets the starting point for the dabs on the stroke affected by the animation.

- **End**: A slider (available when Unit Size is set to Custom) that sets the ending point for the dabs on the stroke affected by the animation.

- **Spread**: A slider that, when increased, creates a softer transition between dabs. (This parameter control is not available when Unit Size is set to All.)

- **Traversal**: A pop-up menu that sets the action of the sequence behavior to any of the following options:
  - **Constant Speed**: Moves the animation from the origin of the paint stroke through the end of the stroke at a constant speed.
- **Ease In:** The sequence animation begins slowly and increases to normal speed as it moves through the paint stroke.

- **Ease Out:** The sequence animation begins at normal speed and slows toward the end of the paint stroke.

- **Ease In/Out:** The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the stroke, and slows as it reaches the end of the paint stroke.

- **Accelerate:** The sequence animation increases in speed.

- **Decelerate:** The sequence animation decreases in speed.

- **Custom:** Lets you keyframe how the animation moves through the paint stroke.

- **Loops:** A slider that sets the number of times the animation sequences through the paint stroke over its duration.

**Note:** Loops is not available when Traversal is set to Custom.

- **Location:** A slider (available when Traversal is set to Custom) that defines the location of the stroke where the animation is in effect.

For more information on using the Custom Traversal option, see [Control sequence timing with keyframes](#).

- **End Condition:** A pop-up menu that determines how the sequence animation is repeated over the duration of the sequence behavior. This parameter has no effect for Loop values less than or equal to 1. The End Condition options are:

  - **Hold:** Completes the sequence animation cycle one time,
then starts it over again from the beginning (after the last dab in the sequence has completed its animation).

- **Wrap**: Treats the sequence animation as a continuous loop so the spread wraps from the last dab in the sequence to the first dab.

- **Ping Pong**: Completes the sequence animation cycle forward, then completes the animation backward, then forward, and so on.

---

**Track Points**

This behavior lets you track the control points of a shape or mask to a moving clip or animated object, or to apply existing tracking data to a shape or mask. For information on using the Track Points behavior, see [Track shapes, masks, and paint strokes](#).

---

**Wriggle Shape**

This behavior works similarly to the Randomize behavior, but with a slower effect.

When you apply the Wriggle Shape behavior to a shape, all control points of the shape are affected by default. When you select the behavior in the Layers list, affected control points are
highlighted in white on the blue shape behavior spline. To disable control points, click the control points. A disabled point appears blue.

**Note:** When you apply the Randomize Shape behavior to a simple shape (without control points), a dialog appears asking if you want to convert the shape.

You can adjust the Wriggle Shape behavior using the following controls in the Behaviors Inspector:

- **Amount** A slider (available when Apply Mode—described below—is set to Add, Subtract, or Add and Subtract) that defines the maximum value the Wriggle behavior generates.
- **Multiplier:** A slider (available when Apply Mode—described below—is set to Multiplier) that defines the maximum value the Wriggle behavior generates.
- **Apply To:** A pop-up menu that defines where on the shape the behavior is applied. There are three options:
  - **Points:** The control points of the shape are wriggled, changing their position over the duration of the behavior.
  - **Tangents:** The control points’ tangent handles (rather than the control points) are wriggled. The control points stay in a fixed position while the curves between the points are animated.
  - **Points and Tangents:** Both the control points and tangent handles are animated.
- **Apply Mode:** A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides
you with different ways of using a Wriggle behavior to modify a vertex’s preexisting values. There are four options:

- **Add:** Values generated by this behavior are added to other behaviors and keyframes that affect the same parameter.
- **Subtract:** Values generated by this behavior are subtracted from other behaviors and keyframes that affect the same parameter.
- **Multiply:** Values generated by this behavior are multiplied by other behaviors and keyframes that affect the same parameter.
- **Add and Subtract:** Values generated by this behavior are added to and subtracted from other behaviors and keyframes that affect the same parameter.

- **Frequency:** A slider that sets the amount of random variation per second. Higher values generate faster variations, whereas lower values generate slower variations.
- **Wriggle Offset:** A slider that offsets the sequence of random values when you want to apply the same Wriggle behavior to multiple shapes. By offsetting each shape’s version of the Wriggle behavior, you can prevent them from moving in sync.
- **Noisiness:** A slider that adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected vertices.
- **Link:** A checkbox available when you apply this behavior to a two-dimensional parameter (such as Distort) or three-dimensional parameter (such as Position or Rotation) that consists of X, Y, and/or Z values. Select this checkbox to keep the behavior’s effect on each value proportional.
- **Preserve Angle:** A checkbox that, when selected, causes the tangent handles to become (or remain) flat, maintaining the continuity of the curves.

- **Random Seed:** A button to pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

## Write On

The Write On behavior provides a quick way to draw a paint stroke or outline on the Canvas over time. Write On lets you create a handwritten text effect, build the ever-popular old-time serial travel map effect, create a hand-sketched alpha mask for a transition or reveal, and so on. The Write On behavior can be applied to a paint stroke created with the Paint Stroke tool or added to an existing shape.

You set the animation effect to draw, erase, draw and erase, draw in reverse, and so on, over time. When you apply Write On to a filled shape with an outline, only the outline of the shape is drawn.

You can adjust the Write On Shape behavior using the following controls in the Behaviors Inspector:

- **Shape Outline:** A pop-up menu that sets whether the stroke is drawn, erased, or drawn and erased. Choose one of the following menu items:
  - **Draw:** The stroke is drawn over the duration of the behavior.
  - **Erase:** The stroke is completely drawn at the beginning of
the behavior and is erased over the duration of the behavior.

- **Draw and Erase:** The stroke is drawn, then erased over the duration of the behavior.

- **Erase and Draw:** The stroke is completely drawn at the beginning of the behavior, is erased, then is drawn again.

- **Stroke Length:** A slider that defines the length as a percentage of the drawn or erased stroke. A value of 100% uses the entire length of the stroke, bounded by the First Point Offset and Last Point Offset parameters. If Stroke Length is set to 50%, when 50% of the stroke is drawn on, it begins to erase (from the beginning of the stroke) so only half of the length of the stroke is ever displayed over the duration of the behavior.

- **Stroke Offset:** A slider that offsets where the stroke begins on the shape. The value is expressed as a percentage of the total length of the shape from the start point defined on the shape.

- **Direction:** A pop-up menu that sets the direction in which the stroke is drawn. There are two options:
  - **Forward:** The stroke is drawn in a forward direction.
  - **Reverse:** The stroke is drawn in reverse.

- **Speed:** A pop-up menu that defines the stroke’s “draw-on” velocity from the first to the last point in the stroke. There are nine options:
  - **Constant:** The stroke is drawn at a steady speed from the first to the last point in the stroke.
  - **Ease In:** The drawing of the stroke starts at a slow speed, then reaches and maintains a steady speed through the
last point on the stroke.

- **Ease Out**: The drawing of the stroke starts at a steady speed, then slows down as it gradually decelerates to a stop at the last point of the stroke.

- **Ease Both**: The drawing of the stroke slowly accelerates from the first point on the stroke, and then slows down as it gradually decelerates to a stop at the last point of the stroke.

- **Accelerate**: The stroke is drawn with increasing speed.

- **Decelerate**: The stroke is drawn with decreasing speed.

- **Natural**: The speed at which the stroke is drawn along the path is determined by the shape of the path. For example, if the stroke is a U-shape curve, the stroke is drawn along more quickly as it moves toward the low point of the U, and more slowly as it moves up the edges.

- **Recorded**: This option appears only if there’s a recorded time over which the stroke was drawn. In other words, if a shape is converted to a paint stroke, this option does not appear. If the paint stroke is created with the Paint Stroke tool in the toolbar (using a stylus or mouse), this option does appear.

- **Custom**: Lets you draw the stroke along its path by setting keyframes for the stroke’s speed from 0 to 100%. In other words, you determine which portion of the stroke is drawn along its path in time.

- **Custom Speed**: A slider that becomes available when Speed is set to Custom. You can modify the Custom Speed velocity curve in the Keyframe Editor. For example, you can keyframe
custom values to draw a stroke forward to a specific percentage of its path, then backward, then forward, and so on before it reaches the end of the animation.

- **End Offset:** A slider that offsets the end of the behavior inward from the defined Out point and holds the last value. In other words, it offsets the visible paint stroke from the end of the path of the stroke.

## Keyframe shape control points

You can keyframe the control points of a shape. When you do so, the changes are recorded to the Shape Animation parameter, visible in the **Keyframe Editor**. Keyframes added to the animation parameter affect all the shape’s control points simultaneously.

![Keyframe Editor](image)

A series of corresponding keyframed shape changes

The process used to animate both masks and shapes is identical. To see an example of mask animation, see **Rotoscope a mask**’s...
Keyframe a shape’s control points

1. In the Layers list, Canvas, or Timeline, select a shape.

2. Click and hold the 2D transform tools pop-up menu in the toolbar, then choose the Edit Points tool.

The selected shape’s control points appear in the Canvas.
3. Click the Record button in the transport controls under the Canvas (or press A) to turn on keyframe recording.

4. Move the playhead to the frame where you want to change the shape, then make any necessary changes to the shape’s control points by dragging them in the Canvas or by adjusting the Control Points controls in the Geometry pane of the Shape Inspector.

In the Keyframe Editor (press Command-8 to open it), a keyframe appears for each adjustment you make at a new frame.
Note: Adjusting a shape while the playhead is on an existing keyframe adjusts the shape at that keyframe.

5. Continue advancing frames and making changes.

Every time you make a change to the shape at a new frame, you create a keyframe in that shape’s animation channel.

6. When you’re done animating the shape, click the Record button in the transport controls to turn off keyframe recording.

The animated shape object interpolates between each keyframed shape. If you don’t like how the interpolation is working, you can add more keyframes to force the control points to follow the path you want.

In the Keyframe Editor, you can also create, delete, and edit the timing of keyframes in the shape’s animation parameter. For simplicity, each change you make to a shape is recorded as a
single keyframe, no matter how many control points are edited. The shape’s animation parameter allows only keyframes set to linear interpolation. You cannot use any other form of keyframe interpolation.

Work with masks and transparency

Masks and transparency overview

Masks are a special type of shape used to create regions of transparency in layers. When you create a mask to define transparency in a layer, you’re drawing a shape to use as that layer’s alpha channel. (For more information about drawing shapes and masks, see Draw simple masks and Draw complex shapes and masks.) Because a layer’s alpha channel is a grayscale channel, masks are grayscale objects, where white defines solid areas, progressively darker levels of gray define decreasingly opaque areas, and black defines areas of complete transparency.

You can apply masks to layers that already have an alpha channel, to add to, subtract from, intersect, or replace the layer’s...
original alpha channel. You can also use another layer as an image mask to mask a layer. For more information, see Image masks overview.

This section describes how to:

- Mask a layer, then adjust the mask
- Mask layers in a 3D project
- Combine multiple masks to isolate complex contours
- Apply filters or behaviors to masks
- Use masks for rotoscope animation
- Make advanced adjustments to masks in the Mask Inspector
- Use an image to mask a layer

**Important:** When a mask is applied to a 2D group or a flattened 3D group, the group is rasterized. For more information, see Shapes and rasterization.

### Mask a layer

You can add a mask to any image layer in a Motion project. After you add the mask, you can make adjustments to fine-tune its effect.

### Add a mask to a layer

1. Select a layer in the Layers list or Canvas.
2. Click and hold the mask tools pop-up menu in the toolbar, then choose a mask tool (Rectangle Mask tool, Circle Mask tool, Freehand Mask tool, Bezier Mask tool, or B-Spline Mask tool).

Note: If you haven’t selected a layer, the mask tools are not available.

3. Do any of the following, based on the mask tool you chose in step 2:
   - *If you chose the Rectangle Mask tool or the Circle Mask tool:* Drag in the Canvas to create a simple rectangular or elliptical shape mask.
   - *If you chose the Freehand Mask tool:* Drag in the Canvas to draw a complex shape with Bezier control points. To close the mask shape, join the end of the shape outline to the target circle at the beginning of the outline. If you don’t reach the beginning of the outline, the mask shape is closed when you lift the stylus or release the mouse.
button.

- **If you chose the Bezier Mask tool or the B-Spline Mask tool:** Click in the Canvas to add control points to create a complex shape with Bezier or B-Spline control points. To close the mask shape, click the first point you made in the shape outline (or press C, or press Return, or double-click).

For more information about how to draw masks, see Draw simple masks and Draw complex shapes and masks.

The example below uses a Bezier Mask tool.

![Image of a fish with a mask drawn on it](image)

**Note:** Unlike standard shapes, masks are always closed.

After you finish drawing the mask, the following happens:

- In the Layers list, the mask object you created appears nested underneath the layer it’s applied to.
- In the Canvas, the region of the layer outside the shape becomes transparent, in effect cutting out the background of the layer. In the example below, the black area is the Canvas background showing through the transparent region of the fish layer.
Show or hide the effect of a mask

When a mask is attached to a layer, a mask icon appears in the Layers list and Timeline, to the right of the name of the layer.

- In the Layers list or Timeline, click the mask icon to turn the mask effect on or off.

View the alpha channel created by the mask in the Canvas

Masks apply an alpha channel (transparency) to a layer. You can view the alpha channel as a grayscale shape, isolating it for further modification.
Choose View > Channels > Alpha (or press Shift-A).

The alpha channel created by the mask is displayed in the Canvas. Choose View > Channels > Color (or press Shift-C) to return to color view.

---

**Feather the edges of a mask**

You can soften the edges of a mask (*feathering*) by a few pixels to make the masked object blend more seamlessly with a background. Feathering a mask by larger amounts creates progressively softer edges for various design purposes.

1. Select a mask in the Layers list.

2. Do one of the following:

   - In the Mask Inspector, drag the Feather slider to the right to feather the mask outward or to the left to feather the mask inward.

     ![Feathered in (color channel)](image1) ![Feathered in (alpha channel)](image2)

   - If the mask is a simple Rectangle Mask or Circle Mask, drag the outer edge of the mask inward or outward in the
When working in a 3D project, you might want to mask a layer that’s already angled in 3D space. You can immediately switch an angled object into a “work view” using the Isolate command. After you add a camera to a project, the Isolate option becomes available for any layer, group, or camera in the project. For more information about cameras, see Add a camera.

**Note:** You cannot manipulate masks in 3D space.

1. In a 3D project, select the layer to mask.

In this example, the center leopard image is the layer to be masked.
2. In the Layers list, click the Isolate button (to the right of the layer name) or choose Object > Isolate.

**Note:** A project must contain a camera before you can access the Isolate option. For more information about cameras, see Add a camera.

The layer is switched into “work view,” allowing you to mask the layer at its original orientation.
3. To return to your previous view (the view before you isolated the layer), click the Isolate button again.

**Note:** Clicking a camera’s Isolate button activates that camera’s view.

---

**Add a mask to a 3D group**

You can apply masks to the layers in a 3D group, but not the 3D group itself—unless you flatten the 3D group).

1. Select a 3D group in your project.
2. In the Group Inspector, select the Flatten checkbox.
3. Apply a mask to the group.

---

**About combining multiple masks**
Often you may find that it’s impossible to create the mask shape you need using only a single mask. For example, when masking an image that has a hole in it, you need at least two masks—one with its blend mode set to Add (to mask the overall object), and a second one with its blend mode set to Subtract (to cut the necessary hole in the middle of the image). In the following example, the only way to mask the space between the diver’s arms and legs is to create three overlapping masks, two with blend modes set to Subtract.

Multiple masks are also useful when you need to mask an image with complex contours or when you’re rotoscoping an object with multiple moving parts. For more information, see Rotoscope a mask’s shape.

Whatever the reason, you can easily combine multiple masks for any object by adjusting each mask’s Mask Blend Mode parameter in the Mask Inspector.
Each mask’s blend mode determines whether the mask adds to, subtracts from, or replaces a layer’s previously existing alpha channel. Additionally, blend modes affect how masks interact with one another. Ultimately, every mask applied to a layer combines according to the specified blend modes to create that layer’s final alpha channel.

Blend mode operations are also determined by the order of each mask in the Layers list, particularly with the Replace and Intersect blend modes. For example, a mask set to Intersect affects all masks nested underneath it in the Layers list, masking only the areas of the layer where the masks overlap one another. Similarly, a mask set to Replace mode effectively turns off any masks beneath it in the Layers list (including the image layer’s built-in alpha channel, if one exists).

For more information on mask blend modes, see Mask controls in the Inspector.

About applying filters or behaviors to masks
You can apply filters and behaviors to masks. Masks remain editable even after the application of a filter or mask.

Filters and masks
Applying a filter to a mask is an extremely powerful way to further manipulate the alpha channel created by a mask. For example, you can apply the Crystallize filter to a mask to add stylized,
When you apply a filter to a mask, it’s useful to bear in mind that a mask is just a grayscale image. In the example above, the Crystallize filter creates patterns in the grayscale mask image, which results in a rippled translucent pattern.

You apply a filter to a mask the same way you apply a filter to any other layer in your project. For more information, see Apply and remove filters.

Behaviors and masks
When you apply a behavior to a mask, the mask is animated like any other layer. However, because the mask affects only the transparency in a layer, and not the position, rotation, or scale of the layer, the result is similar to that of a “traveling matte,” where the mask moves in the layer it’s applied to, hiding and showing different areas of the image as it moves.

You apply a behavior to a mask the same way you apply a behavior to any other layer in your project. For more information, see Apply behaviors overview.

Use keyframes to rotoscope a mask

Rotoscope a mask’s shape

You can keyframe a mask’s control points to animate a changing shape over time. For example, you can animate a subtractive mask to change the shape of a hole in a foreground object, allowing other layers in the background to show through.

A more conventional use of animated masks is to rotoscope a foreground subject. Rotoscoping is the process of manually tracing a foreground subject to isolate it from the background. The result is similar to a blue screen or green screen effect. Why would you bother? In a wide variety of situations, keying is impractical or impossible if the shot wasn’t well planned. Even for shots where keying is possible, manual rotoscoping is often necessary to create garbage masks or holdout mattes to improve the effect. (For more information on creating garbage masks or holdout mattes using masks, see Crop unwanted background areas using a garbage mask and Restore part of a foreground image using a holdout mask.)
The following task demonstrates how to use a mask to isolate an object in a clip in order to apply separate effects to the isolated object and its background.

The process used to animate both masks and shapes is identical. To see an example of shape animation, see Keyframe shape control points. For more information on keyframing in general, see Keyframing overview.

Rotoscope a subject by animating a mask

1. Choose View > Resolution > Full to ensure that you’re viewing
Important: If the Canvas resolution is not set to full, the outlines of objects and images may shift slightly. As a result, masks created to trace a subject at less than full resolution may not be accurate.

2. Move to the first frame where the mask animation should begin, then draw a mask that accurately isolates the subject.

For details on how to draw a complex mask, see Draw complex shapes and masks.

3. When you’re finished drawing the first mask, click the Record button in the transport controls (or press A) to turn on keyframe recording.

4. Move to the first frame of the Timeline where you want to change the shape of the mask, then drag the mask’s control points in the Canvas.

Note: If the mask is deselected, you must select it in the Layers list so its control points become visible in the Canvas.
Make sure that the Show/Hide Masks button is selected in the Layers list so masks are visible.

5. Continue moving the playhead and dragging control points.

One imprecise rule of thumb is to move to the frame that’s halfway between any two keyframed mask shapes and make new adjustments. Continue keyframing shape changes at the halfway point between every two keyframes until the mask accurately follows the motion of the subject. For irregularly shaped objects or objects with complex motion, don’t be surprised if you need to add a large number of keyframes. Nobody ever said that rotoscoping was fast!

Every time you move the playhead to a new frame and make a change to the mask’s shape, a keyframe is created in that shape’s Shape Animation channel in the Keyframe Editor. If you move the playhead directly on top of a previously existing keyframe, you change the mask’s shape at that point without creating a keyframe.

6. When you’ve finished animating the mask, click the Record button again (or press A) to turn off keyframe recording.

Rotoscoping tips

Use the following guidelines when rotoscoping:

- Find the frame with the most detail showing in the subject you’re masking and use that as your starting frame. For example, if you’re masking someone walking, choose a frame where that person’s arms and legs are extended in mid-stride.
Doing so lets you specify how many control points to start with. Using as few control points to achieve the necessary level of detail in your mask simplifies the animation process.

- Use as few control points to achieve the necessary level of detail in your mask.

- Animated masks trigger the same motion blur as any other keyframed parameter in Motion. For example, if you animate a layer’s position so it moves really fast, the layer is blurred when you enable motion blur. If you animate a layer’s mask so it also moves fast, the edges of the mask are blurred as well. This is important because an animated mask’s blur should match any blur present in the foreground subject.

- When rotoscoping a moving subject, it’s a good idea to play the clip and examine its direction and speed to get a sense of how the mask must be animated. You may find it helpful to place markers indicating frames where the subject or camera stops, changes direction, or changes speed, because these are likely candidates for your first pass of keyframed mask changes. By noting these changes, you can attempt to reduce the amount of keyframing by making your first keyframed mask shape adjustments at these major changes in speed and direction. Because animated masks are interpolated to change from one keyframed shape to another, you can let Motion do some of your work for you.

- All mask animation is stored in the Shape Animation channel in the Keyframe Editor. You can create, delete, and edit the timing of a mask’s Shape Animation channel keyframes. For simplicity, each change you make to a mask is recorded as a single keyframe, no matter how many control points you edited. The Shape Animation channel allows only keyframes
set to Constant—you cannot use any other form of keyframe interpolation.

- It may not be necessary to rotoscope an entire subject with a single mask. Motion lets you apply multiple masks to a single object, so you can rotoscope different parts of a subject with separate masks. For more information, see About combining multiple masks.

- To pan the image in the Canvas while rotoscoping, press the Space bar. You can then pan in the Canvas without losing your mask selection or progress.

- Use the Track Points behavior to apply tracking data to a shape or mask. For more information, see Track shapes, masks, and paint strokes.

**Mask controls in the Inspector**

A selected mask’s parameters appear in the Mask Inspector. These controls allow you to adjust how the mask is drawn, how each mask operates upon an object, and how masks are combined with one another. The Mask Inspector also lets you fine-tune mask control point positions.

The Mask Inspector contains the following adjustable controls:

**Mask Controls**

- **Roundness**: A slider (available when a simple rectangle mask, Bezier mask, or B-Spline mask is selected) that adjusts the roundness of mask corners. Use this control to create
rounded rectangles or to smooth the edges of a mask.

- **Preserve Scale:** A checkbox (available when a simple rectangle mask, Bezier mask, or B-Spline mask is selected) that controls whether the Roundness setting is absolute or relative to the overall mask size. When the checkbox is selected, the roundness remains at the same approximate percentage of curvature as the object is scaled. When the checkbox is deselected, the curvature varies as the overall mask changes size.

- **Curvature:** A slider (available when a simple circle mask is selected) that adjusts the degree of curvature of the circle. When set to 100 percent, the mask is elliptical. When set to 0 percent, the mask is a rectangular.

- **Radius:** A slider (available when a simple circle mask is selected) that controls the width (X) and height (Y) of the mask. Click the disclosure triangle to reveal individual X (width) and Y (height) sliders.

- **Size:** A slider (available when a simple rectangle mask is selected) that controls the size of the mask. Click the disclosure triangle to reveal individual Width and Height sliders.

- **Shape Type:** A pop-up menu that sets the type of control points used to define the mask. For example, if you originally created a Bezier mask, you can choose B-Spline from this menu to change how the mask is drawn. Changing the shape type might dramatically change the mask’s form even though its control points remain fixed at their original coordinates. There are three options:
  - **Linear:** All of a mask’s control points are joined by hard
angles, and the resulting mask is a polygon. The control points of a Linear mask lie directly on its edge.

- **Bezier:** Control points can be a mix of Bezier curves and hard angles, creating any sort of mask. The control points of a Bezier mask lie directly on its edge.

- **B-Spline:** Control points are all B-Spline points, with different degrees of curvature. B-Spline control points lie outside the surface of the mask, but are connected by the B-Spline frame.

**Note:** You can hide the B-Spline frame by deselecting the Lines menu item in the View pop-up menu above the Canvas.

- **Mask Blend Mode:** A pop-up menu that determines how a mask interacts with the alpha channel of the layer to which it’s applied. When a layer has multiple masks, each mask can have a different Mask Blend Mode. When this happens, each mask adds to, or subtracts from, the layer’s alpha channel according to the selected mode. The final alpha channel is the combined result of all masks applied. There are four menu options:

  - **Add:** Removes all pixels from areas outside the mask shape. Each new mask adds more transparency, letting more of the underlying image show through. The Add blend mode (the default for new masks) is useful for adding back regions of an image that other masks are cutting out or when masking multiple areas that do not intersect in a single image. In the following example, both the rectangle and circle masks remove areas outside of the mask shapes, revealing the underlying black Canvas.
If the layer contains an alpha channel, a mask set to Add mode reveals only the masked section of the original alpha channel.

**Note:** To display the rest of a masked layer so you can trace it to create a second mask, turn off the first mask in the Layers list or Timeline. The outline of the first mask remains visible, even though it’s no longer affecting the layer’s transparency.

- **Subtract:** Removes all pixels from the area inside the mask shape, effectively punching a hole in the image. In the following example, the rectangle and circle masks punch a hole through the blue gradient object, revealing the underlying black Canvas.
• Replace: Completely replaces the image object’s alpha channel as well as any other masks that appear beneath the mask in the Layers list. In the following example, the circle mask overrides the rectangle mask, because the circle mask (set to Replace) appears above the rectangle mask in the Layers list. For more information, see About combining multiple masks.

• Intersect: Shows pixels only in regions where masks overlap. In the following example, only the overlapping areas of the rectangle and circle masks are visible.
In another example, if you import a TIFF file with an alpha channel and you want to cut out part of it without losing alpha information, you must use the Intersect blend mode. This is also true for layers with keying filters applied.

- **Invert Mask**: A checkbox that, when selected, reverses the mask—swapping its solid and transparent areas. This is useful if you need to switch the solid and transparent areas of an existing mask.

**Tip**: You can apply different filters and effects to the foreground and background of an image by first masking the foreground subject, duplicating the layer and its mask, then inverting the duplicate layer’s mask. Effects applied to the background can then be completely isolated from the foreground, or vice versa. You can adjust the opacity of a
mask in the Properties Inspector.

- **Feather**: A slider that feathers (softens) the edges of a mask. Positive feathering values soften the edge of the mask from its edge outward. Negative feathering values soften the edge of a mask inward from the edge. Feathering the edge of a mask can soften a harsh rotoscoping job, making the masked object blend more easily with the background.

- **Falloff**: A slider that controls how “steep” the feathering is. Higher values result in feathering that’s pushed farther inward, so the edge of the feathering effect is more transparent. Lower values result in the “core” of the feathering effect being pushed farther outward, so the edge of the feathering effect is less transparent.

- **Mask Color**: A pop-up menu that controls the color of the mask as displayed in the Canvas when it’s selected. This setting has no effect on the final output. Setting masks to different colors may aid you in identifying which mask is which.

- **Convert to Points**: A button (available when a simple mask is selected) that, when clicked, converts a simple mask to a complex mask with editable control points. For more information, see Convert a simple shape or mask to editable control points.

---

**Control Points controls**

When a complex mask with control points is selected, this list becomes available, displaying the X and Y position parameters for the mask’s control points. The Control Points list also contains a
single Animation menu (the downward arrow that appears when you move the pointer over the right side of the Control Points header row) that affects all the control points, letting you add keyframes, reset the shape’s animation, display the animation curve in the Keyframe Editor, and so on. For more information on using the Animation menu, see Animation menu.

Use Image masks

Image masks overview

Another way to create transparency in a layer is by using image masks. An image mask creates transparency in a layer by deriving an alpha channel from another layer, such as a shape, text, movie, or still image.

Note: You can use masks and image masks together.

The power of image masks is that they do not have to be drawn or animated.

Using image masks is easy. First you apply an image mask, and then you make adjustments in the Behaviors Inspector.

You can add filters to image masks to further manipulate the
transparency effect. You may be able to improve an image mask by using color correction filters such as Brightness, Contrast, and Gamma to manipulate the effect, enhancing or reducing detail to create the transparency you need. For more information, see About applying filters or behaviors to masks.

You can also apply behaviors to image masks to create animated transparency effects. For more information, see About applying filters or behaviors to masks.

Apply an image mask to a layer
Assigning an image mask is a two-part process. First, you create a blank image mask underneath a layer. Then you assign the image you want to use to create transparency.

Add an image mask to a layer

1. Select a layer to mask.

2. Choose Object > Add Image Mask (or press Shift-Command-M).

   The image mask appears underneath the layer in the Layers list and Timeline.
3. With the image mask selected, do one of the following:

- Open the Image Mask Inspector, then drag a layer to use as the mask from the Layers list to the Mask Source well.

- Open the HUD (if the HUD is not visible, press D or F7), then drag the layer to use as the mask from the Layers list into the Mask Source well.

**Important:** Click and drag in one movement to successfully drop a layer in an image well. If you select the layer to use as the source, then release the mouse button, you lose the selection.

In this example, text is used as the image mask.

4. In the Mask Inspector, click the Source Channel pop-up menu and choose the color channel (red, green, blue, alpha, and so on) you want to use to create transparency.
For more information about choosing a color channel, see “Select the image mask’s color channel,” below.

**Select the image mask’s color channel**

When you use a layer as an image mask, you can choose which of the layer’s color channels to apply to create transparency.

1. Apply an image mask and assign a mask source, as described in the previous task.

2. In the Image Mask Inspector, click the Source Channel pop-up menu, then choose a color channel (Red, Green, Blue, Alpha, or Luminance).

Because alpha channels are basically 8-bit grayscale images, you can use any single color channel as an image mask. Luminance lets you use the aggregate luminance from the red, green, and blue channels of an image to create transparency.

For more information about the Source Channel pop-up menu, see Image mask controls in the Inspector.
Image mask controls in the Inspector

After you add an image mask to a layer, the following parameters become available in the Image Mask Inspector:

- **Mask Source**: An image well to assign a layer (a shape, text, an image, a movie, particle emitter, numbered image sequence, and so on) to use to mask a layer.

- **Frame**: A slider (available when you use a movie or image sequence as the assigned image) that sets the start frame for playback.

- **Hold Frame**: A checkbox (available when you use a movie or an image sequence as the assigned image) that, when selected, freezes the frame specified in the Frame parameter. That frame is then used as the mask for the masked layer’s total duration.

- **Offset**: Value sliders that offset the X and Y values of the mask’s position, relative to the layer being masked, allowing you to change which part of the layer is masked.

- **Wrap Mode**: A pop-up menu that increases the area an image mask affects (if the image mask is smaller than the layer it’s assigned to). There are three options:
  - **None**: The object is used as is.
  - **Repeat**: The object is duplicated and tiled to fill up the full width and height of the image.
  - **Mirror**: The layer is duplicated, tiled, and reversed to fill the full width and height of the image. This may create a more seamless repetition for some images.

- **Source Channel**: A pop-up menu that sets which channel of
Source Channel: A pop-up menu that sets which channel of the assigned image is used to create the mask. There are five options:

- **Red**: Uses the red channel as a grayscale mask.
- **Green**: Uses the green channel as a grayscale mask.
- **Blue**: Uses the blue channel as a grayscale mask.
- **Alpha**: Uses the alpha channel from the mask layer.
- **Luminance**: Uses the aggregate luminance from the red, green, and blue channels as a grayscale mask.

**Mask Blend Mode**: A pop-up menu that determines how an image mask interacts with the alpha channel of the layer to which it’s applied. When a layer has multiple image masks, each mask can have a different Mask Blend mode. When this happens, each mask adds to, or subtracts from, the layer’s alpha channel according to the selected mode. The final alpha channel is the combined result of all image masks applied. These modes are identical to the Mask Blend Mode options available for shape masks. There are four menu options:

- **Add**: Adds the mask to the alpha channel (the default setting). This is useful for adding back regions of an image that other masks are cutting out.
- **Subtract**: Subtracts a mask from the alpha channel. This is useful for creating holes in the middle of layers, or for masking out additional regions of an image that are untouched by other masks.
- **Replace**: Replaces the layer’s original alpha channel, as well as any other masks applied to the same layer that appear underneath the current mask in the Layers list, with
the current mask. You can add masks above, set to whatever blending mode you like.

- **Intersect**: Masks out all regions of the layer that do not overlap the mask itself (but does not replace a layer’s original alpha channel). This includes other masks applied to the same layer that appear nested underneath the intersecting mask in the Layers list.

- **Invert Mask**: A checkbox that, when selected, reverses the mask—swapping its solid and transparent areas. This is useful if you need to switch the solid and transparent areas of an existing mask.

- **Stencil**: A checkbox that preserves the layer’s geometric transforms. If you’re creating a mask with transformed Scale, Position, Rotation, or other parameters, select this checkbox to use the modified layer.

- **Stretch**: A checkbox (available when Stencil is deselected) that stretches the mask to fit the boundaries of the image and centers the mask on the layer’s center point.

**Convert between shapes and masks**

Because masks and shapes are created in similar ways but perform different tasks, there are occasions where you may create a shape and later want to convert it into a mask, or vice versa. Different options are available when converting shapes to masks, depending on the type of object being masked. When you need to convert a shape to a mask, consider the following:
- When a shape is converted to a mask and applied to a scaled object, the resulting mask is scaled as well. This may lead to unexpected results. To prevent surprises, set the object to 100% scale or place the object in a new group and apply the mask to the group.

- Converting a shape that has been manipulated in 3D into a mask may produce unexpected results. For more information on working with masks in 3D projects, see Mask a layer.

- When a transformed (scaled, rotated, or anchor point-adjusted) shape is converted to a mask, the transforms are not maintained.

**Note:** Masks are not applicable to 3D paint strokes, 3D particle systems or replicators, 3D text, or unflattened 3D groups. To convert a shape to a mask on such an object, the item must be flattened.

### Convert a shape to a mask on an image

1. Use any of the shape tools to create a shape (or draw a paint stroke).

   **Note:** You can also add a preset shape from Shapes category in the Library.

2. In the Layers list, drag the shape object onto the layer to be masked.

   The shape is converted into a mask. If the layer to which the mask is applied is not centered in the Canvas, the position of
the mask is slightly offset. This is because the position of the converted mask is dependent upon the original position of the shape relative to the center of its parent group.

**Convert a shape to a mask on a group**

1. Use any of the shape tools to create a shape (or draw a paint stroke).

2. In the Layers list, drag the shape onto the group layer and pause, holding down the mouse button, then when the drop menu appears, choose Move Mask To Group.

**Convert a shape to a mask on the enclosing group**

1. Use any of the shape tools to create a shape (or draw a paint stroke).

2. In the Layers list, select the shape layer and do one of the following:
   - Drag the shape onto the group and pause, holding down the mouse button, then when the drop menu appears, choose Move Mask To Group.
   - Choose Object > Convert to Mask.

**Convert a shape to a mask on another**
1. Use any of the shape tools to create a shape (or draw a paint stroke).

2. In the Layers list, drag the shape object onto another shape object and pause, holding down the mouse button.

   A drop menu appears.

3. Choose Add Mask To Shape, then release the mouse button.

   The shape is converted into a mask on the other shape.

   **Note:** Spline masks are not applicable to 3D paint strokes. The Local 3D checkbox must be deselected for the paint stroke in the Stroke pane of the Shape Inspector for the drop menu to appear.

---

**Convert a shape to a mask on a particle emitter or replicator**

1. Use any of the shape tools to create a shape (or draw a paint stroke).

2. In the Layers list, drag the shape object onto an emitter or replicator and pause, holding down the mouse button.

   A drop menu appears.

3. Choose Add Mask To Emitter or Add Mask to Replicator, then
release the mouse button.

The shape is converted into a mask on the particle emitter or replicator.

**Note:** The 3D checkbox must be deselected in the Emitter or Replicator Inspector for the drop menu to appear.

---

**Convert a shape to a mask on basic text and 3D text**

1. In the Layers list, select the text layer to mask.

2. In the Layout pane of the Text Inspector, ensure the Flatten checkbox is selected.

3. Use any of the shape tools to create a shape (or draw a paint stroke).

4. In the Layers list, drag the shape object onto the text layer.

---

**Convert a mask to a shape**

- In the Layers list, select a mask and do one of the following:
  - Choose Object > Convert To Shape.
    
    The shape moves to the bottom of the group.
  - Drag the mask between two objects in the Layers list.
  - Drag the mask onto the group layer and pause, holding
down the mouse button; when the drop menu appears, choose Move Shape To Group.

About using filters and masks with shapes

Filters

You can apply filters to individual shapes or to a group that contains a number of shapes. You can use filters to stylize shapes far beyond the options available in the Shape Inspector. When you apply a filter to a shape, the shape remains editable. For more information, see Filters overview.

Important: After you apply a filter to a shape, you can no longer smoothly increase the size of that shape using the object’s transform controls. This is because filters change shapes from vector objects to bitmapped objects. As a result, they scale like other bitmapped objects, which display artifacts if they’re
Masks

Use the mask-drawing tools in the toolbar to create masks that punch holes inside shapes. You can also apply an image mask to a shape, using another layer in Motion to define areas of transparency. For more information on using masks and image masks, see Masks and transparency overview.

Important: Some operations, as well the application of some filters or a mask, cause a group to be rasterized. When a group is rasterized, it’s converted into a bitmap image. Because all shape layers (masks, shapes, and paint strokes) are contained in groups, this affects how shapes interact with other objects in your project. For more information, see Shapes and rasterization.

Copy shape styles

After modifying the fill or outline of a shape, you can apply that shape style to another shape in the project.
Apply a shape’s style to another shape

1. In the Layers list, drag the stylized shape object onto another shape object and pause, holding down the mouse button.

   A drop menu appears.

2. Choose Copy Style To Shape, then release the mouse button.

   The shape’s fill and outline are copied to the other shape.

SEE ALSO

Save custom shapes and shape styles to the Library

Save custom shapes and shape styles to the Library

After you create a shape or mask you like, you can save it as preset in the Shapes or Favorites category of the Library for future use. You can also save the style (fill, outline, feathering, and so on) of a shape.

**Note:** When you drag a custom mask from the Library into a project, the mask retains the position where it was saved (relative to the image or footage on which it is dropped).
Save a shape to the Library

1. Open the Library and select the Favorites, Favorites Menu, or Shapes category.

2. Drag the shape you want to save from the Layers list or Timeline into the stack at the bottom of the Library.

Shapes saved to the Favorites Menu category can be added to a project via the Favorites menu.

Save multiple shapes to the Library

1. Open the Library and select the Favorites, Favorites Menu, or Shapes category.

2. In the Layers list, select the shapes to save, drag them into the stack at the bottom of the Library, and continue holding down the mouse button.

3. When the drop menu appears, choose “All in one file” or “Multiple files.”

“All in one file” saves the shapes together, and they’re listed as one item in the Library. “Multiple files” saves the shapes as individual objects in the Library.

Note: When you drag shapes that were saved with the “All in one file” option to the Canvas, the shapes are dropped where you release the mouse button and are positioned according to their arrangement when originally saved to the Library. If you
use the Apply button in the preview area to add the shapes, the shapes are added at the center of the Canvas.

Save a shape style to the Library

1. With the shape selected, click the Shape Style pop-up menu in the Style pane of the Shape Inspector (or in the Shape HUD), then choose Save Shape Style.

2. Enter a name for the style in the Save Preset to Library dialog, then click Save (or press Return).

The custom style is saved to the Library in the All subcategory of the Shape Styles category. You can move the preset into an existing subcategory, or create your own folders to organize your custom styles.

When you select the saved style in the Library stack, a preview is displayed in the preview pane. The new preset now appears in the Shape Style pop-up menu in the Style pane of the Shape Inspector.
SEE ALSO

Copy shape styles
Save custom objects to the Library
Create graphics with generators

Generators overview

Add generators to a project to create instant graphical treatments such as colored backgrounds, bars, stripes, noise, or gradients. Some generators create animated patterns. However, most generators default to static, patterned images that you can animate using behaviors or keyframes.

After you add a generator to your project, you can adjust its settings or animate it in the Generator Inspector or HUD, or by using onscreen controls (handles in the Canvas).

There are two categories of generators in the Library:

- **Generators**: A collection of both static images, such as the Checkerboard generator, and animated images, such as the Clouds generator. Although static generators are not animated by default, you can keyframe their parameters to create an animated pattern. For a description of each generator and its
adjustable controls, see Image generators overview.

- *Text Generators:* A collection of animated text treatments, such as advancing timecode and number countdowns. For a description of each text generator and its adjustable controls, see Text generators overview.

As with all other image layers in a Motion project, generators can be moved, duplicated, set to different blend modes, used as the source for a particle or replicator cell, and so on.

## Add a generator

There are two ways to add generators: by dragging a generator from the Library to your project or by using the Add Generator pop-up menu in the toolbar. After you add a generator, it becomes a layer in the Layers list (and Timeline) and appears in the Canvas. The generator is set to the duration and size of your project by default. For example, if you’re working on an NTSC D1 project and you add a generator, the generator has a 720 x 486 (.90) pixel aspect ratio.

**Note:** The duration and start frame of the generator depends on the Project settings in Motion Preferences. For more information, see If it’s your first import.

---

**Add a generator by dragging from the Library**
1. In the Library, click the Generators category.

2. In the stack, click a generator.

   The generator preview appears in the preview area. If the generator is animated, such as Clouds, the animation plays in the preview area.

3. Do one of the following: Drag the generator to your project.
   - Drag the generator to the Canvas, Layers list, or Timeline.
   - Click the Apply button in the preview area.

   **Note:** Generators added to a project are not added to the Media list. The Media list includes only media files imported into Motion, such as image sequences, video files, Photoshop files, and audio files. For more information, see Display, sort, and search the Media list.

---

### Add a generator from the toolbar

- Click the Add Generator pop-up menu in the toolbar, then choose a generator.

There are two types of generators: standard image generators and text generators.
SEE ALSO
Modify or animate a generator
Controls common to all image generators
Image generators overview
Text generators overview

Customize a generator
Modify or animate a generator

You can modify an applied generator in the Inspector or HUD, or by using onscreen transform controls. You can animate generator parameters with keyframes or behaviors, and you can use a generator as the basis for a particle system. After you customize a generator, you can save it to the Library for future use.

While each generator is unique, there are a small set of controls that are shared between all generators. For more information, see Controls common to all image generators.

Modify a generator in the inspector

1. Select an applied generator.

   **Note:** For information on adding a generator to your project, see Add a generator.

2. In the Generator Inspector, adjust the parameter controls.

   For information on controls specific to each generator, see Image generators overview or Text generators overview.

Modify a generator using onscreen controls

As with any other image layer in Motion, you can make basic transform adjustments to an applied generator (modifying size, distorting, changing the anchor point, and so on) using onscreen transform handles. Changes to these basic transform parameters
are reflected in the Properties Inspector. Additionally, some generators have specific onscreen controls—usually to adjust the Center or Offset parameter—that you enable by selecting the Adjust Item tool in the toolbar. The Spiral Drawing generator has unique onscreen controls that simulate a stator (ring) and a rotor (gear) of a spiral-drawing tool. These changes are reflected in the Generator Inspector. For more information about the transform tools, see  Transform layer properties in the Canvas.

1. Select a generator in Layers list, Timeline, or Canvas.

2. In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Adjust Item tool.

   ![Adjust Item Tool](image)

**Note:** If the generator has no onscreen controls, the Adjust Item tool is not available.

In the center of the Canvas, the Center onscreen control or the Offset onscreen control appears (depending on the generator).
3. In the Canvas, drag the Center control or the Offset control to a new position.

The Offset or Center parameter is adjusted accordingly in the Generator Inspector.

**Tip:** Always adjust transform-related generator parameters (such as center and angle) using onscreen controls (or the controls in the Generator Inspector) rather than via the Properties Inspector; the equivalent controls in the Properties Inspector cause the generator to be resampled, resulting in a lower-quality output.

For more information about the Offset and Center parameters, see the controls descriptions for Image Generators.

---

**Animate a generator using keyframes**
Although most generators create static images, you can animate the parameters of a generator to create a moving texture over time.

1. In the Layers list, Canvas, or Timeline, select the generator you want to animate.

2. Move the playhead to the frame where you want the animation to begin, then press A to turn on keyframe animation recording.

3. In the Generator Inspector or using the onscreen controls (if available), adjust a generator parameter. A keyframe is added to the parameter.

4. Move the playhead to the frame where you want to create the next keyframe, then adjust the generator parameter again.

5. Play the project (press the Space bar).

The animated generator parameters create a moving, changing texture based on your keyframes. If you’re satisfied with the result, press A again to turn off keyframe recording.

**Note:** For more information on keyframing, see [Keyframing overview](#).

### Animate a generator using behaviors

As with all other objects in Motion, you can apply Basic Motion, Parameter, or Simulation behaviors to a generator. The following
example applies the Random parameter behavior to randomize the opacity of the Star generator, creating a flickering star.

1. Add the Star generator to your project and display the Generator Inspector.

2. In the Generator Inspector, move the pointer over the right side of the Spike Opacity parameter row.

   The Animation menu (a downward arrow) appears.

3. Click the Animation menu for the Spike Opacity parameter, then choose Add Parameter Behavior > Randomize.

The Randomize parameter behavior is applied to the Spike Opacity parameter, and the Behaviors Inspector is displayed so you can adjust the Randomize parameters.
4. In the Behaviors Inspector, drag the Amount slider to the right to increase the randomization effect.

5. In the transport controls (under the Canvas), click the Play button (or press the Space bar).

Because the Randomize parameter behavior is applied to the opacity of the star spikes, the star appears to flicker. When a Parameter behavior is applied to a parameter in a generator, a behavior icon (a gear) appears in the Generator Inspector in the row for the affected parameter. In this example, the behavior icon appears in the Spike Opacity parameter row.
6. To increase or decrease the effect of the flicker, adjust the Randomize parameters (in the Behaviors Inspector). To jump to the Randomize parameters from the Generator Inspector, control-click Spike Opacity parameter name, then choose Randomize from the shortcut menu.

For more information on using Parameter behaviors such as the Randomize behavior, see Randomize.

Use a generator as a particle cell source

As with other objects, generators can be used as a source for particle cells. The following example uses the Soft Gradient generator. To give your particle system more flexibility and reduce processing strain on your computer, scale the generator down in the Generator Inspector.

1. Add the Soft Gradient generator to your project.
2. In the HUD or Generator Inspector, reduce the Radius value. This example uses a Radius value of 40.

3. Reduce the Width and Height values. In the Canvas, the gradient and its bounding box are scaled down.
4. With the generator still selected, do one of the following:
   - Press E.
   - In the toolbar, click the Make Particles button.

After you add an emitter to the project, the new Emitter object is selected in the Layers list; a duplicate of the source object (the Soft Gradient generator) becomes an emitter cell for the new particle system; and the original source object (the Soft Gradient generator) is disabled.
In the Canvas, the emitter bounding box appears. You can transform the bounding box using the onscreen controls or controls in the Inspector. The particle appears in the Canvas in the same location as the original object. Although it appears as if the particle is selected, it is the bounding box for the emitter that is selected.

5. Press the Space bar to play the project.

Soft gradient particles are emitted.
You can change the particle color, emitter shape, scale, emission angle, birth rate, and so on in the Emitter Inspector or HUD. For more information on working with particles, see Particles overview.

Modified particles using the Soft Gradient generator as a particle cell source

Controls common to all image
generators

All image generators have common controls, located in the Generator Inspector. For lists of controls specific to each type of image generator, see Image generators overview.

The Generator Inspector contains the following controls for all image generators:

- **Reset**: A curved arrow button that restores the generator to its default settings.

- **Width**: A slider that sets the width of the generator, in pixels. Values range from 1 to the width of your project.

- **Height**: A slider that sets the height of the generator, in pixels. Values range from 1 to the height of your project.

- **Pixel Aspect Ratio**: A pop-up menu that sets the aspect ratio of the pixels drawn by the generator. Values can be selected from the following menu options: Square, NTSC D1/DV, NTSC D1/DV Anamorphic, PAL D1/DV, PAL D1/DV Anamorphic,
Anamorphic 2:1, D4/D16, D4/D16 Anamorphic, HD (960 x 720, 1440 x 1080), HD (1280 x 1080), or Custom. When you select a value other than Custom, the Pixel Aspect Ratio of that selection appears in a value field next to the pop-up menu. Enter values from 0 to 10000 in the value field. If the value does not correspond to a preset value (for example, 2 for Anamorphic 2:1), Custom appears in the pop-up menu.

**Important:** The Opacity parameter in the Generator HUD is identical to the Opacity control located in the Properties Inspector. This slider sets the transparency of the generator as a whole. Several generators contain a separate opacity control in the Generator Inspector, which is independent of the like-named control in the Properties Inspector.

**Image generators**

**Image generators overview**

Image generators quickly add animated or static graphics, such as stars, swirls, rays of color, or lens flares to a project. The image generator category is labeled *Generators* in the Library.

There are 28 image generators:

- **Caustics** creates an animated, simulated water surface.
- **Cellular** creates an animated pattern that looks like cells moving under a microscope.
- **Checkerboard** creates a static checkerboard pattern.
- **Clouds** creates an animated cloud pattern...
- Clouds creates an animated cloud pattern.
- **Color Solid** creates a single-colored object.
- **Concentric Polka Dots** creates a repeating pattern concentric circles, polygons, or stars.
- **Concentric Shapes** creates a repeating pattern of shapes.
- **Gradient** creates a basic gradient ready for customization.
- **Grid** creates a grid pattern made of two colored lines.
- **Japanese Pattern** creates a pattern of overlapping waves or congruent circles.
- **Lens Flare** superimposes a simulated lens flare effect.
- **Manga Lines** creates radial or linear Manga-style graphic lines.
- **Membrane** creates a sheer, animated sheet that flows gracefully in 3D space.
- **Noise** creates a random, colored static pattern.
- **One Color Ray** creates a ray pattern based on variations of a color.
- **Overlapping Circles** creates orbs of two different colors that overlay each other.
- **Radial Bars** creates bars of equal width that extend from a center point to the edge of the Canvas.
- **Soft Gradient** creates a soft-edged, radial gradient.
- **Spirals** creates a repeating circular spiral pattern.
- **Spiral Drawing** draws overlapping geometric curves like the Clouds pattern.
- **Spiral Drawing** draws overlapping geometric curves like the toy from your youth.
- **Star** creates a glowing star shape that contains an alpha channel.
- **Stripes** creates a default image with vertical bands of two alternating colors.
- **Sunburst** creates “beams” that radiate from a center point.
- **Truchet Tiles** creates a two-color pattern based on simple shapes in different orientations.

For a list of common parameter controls, see [Controls common to all image generators](#). For a description of each of the Image Generators and its specific controls, see the other topics in this section.

## Caustics

The Caustics generator creates an animated, simulated water surface. The size, speed, refraction, brightness, and color of the Caustics pattern can be modified and animated. You can use the Caustics generator to add light patterns to a project, or as the source object for an image map.
Adjust this generator using the controls in the Generator Inspector:

- **Size**: A slider that sets the size of the shapes and spaces in the pattern.
- **Speed**: A slider that sets the speed of movement of the light patterns.
- **Refraction**: A slider that sets the refraction of the light shapes.
- **Brightness**: A slider that sets the brightness of the light shapes.
- **Color**: Color controls that set the color of the light shapes. For more precise color selection, click the disclosure triangle to display Red, Green, and Blue sliders.

**Cellular**

The Cellular generator creates an animated pattern that looks like cells moving under a microscope. You can change the color, size, and speed of the cells.
Adjust this generator using the controls in the Generator Inspector:

- **Size**: A slider that sets the size of cells in the pattern. Values range from 3 to 64.
- **Speed**: A slider that sets the speed of movement of cells. Values range from 0 to 2.
- **Gradient**: Controls that set the color gradient used for cells. For information on using gradients, see Gradient editor controls.

**Checkerboard**

The Checkerboard generator creates a static checkerboard pattern. The contrast, color, size, and position of checkerboard squares can be edited and keyframed.
Adjust this generator using the controls in the Generator Inspector:

- **Checkerboard Type**: A pop-up menu that sets the shape of the pattern elements. There are four choices:
  - **Grid**: Creates checkerboard squares.
  - **Radial**: Creates a checkerboard set in a radial pattern.
  - **Shape**: Creates a checkerboard of two different shapes. The shapes choices include Square, Circle, Polygon, and Star.
  - **Triangular**: Creates a checkerboard of triangle shapes.
- **Center**: Value sliders that set the center of the generator. (You can also use the Adjust Item tool to adjust this parameter via onscreen controls. For more information, see [Modify or animate a generator](#).
- **Color 1**: Color controls that set the first color in the checkerboard. For more precise color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity sliders.
- **Color 2**: Color controls that set the second color in the checkerboard. For more precise color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity
- **Size**: A slider that sets the size of the squares in the checkerboard. Values range from 0 to 800.

- **Board Angle**: A dial that rotates the pattern.

- **Tile Height**: A slider (available when Checkerboard Type is set to Radial) that sets the height of the pattern elements.

- **Divisions**: A slider (available when Checkerboard Type is set to Radial) that sets the number of slices in the radial pattern.

- **Twirl**: A slider (available when Checkerboard Type is set to Radial) that sets the amount of twist in the radial pattern.

- **Checker shape**: A pop-up menu that sets the shape of the pattern elements to Square or Triangle.

- **Shape 1**: A pop-up menu (available when Checkerboard Type is set to Shape) that sets the first shape of the pattern to Square, Circle, Polygon, or Star.

- **Shape 2**: A pop-up menu (available when Checkerboard Type is set to Shape) that sets the second shape of the pattern to Square, Circle, Polygon, or Star.

- **Vertical Scale**: A slider (available when Checkerboard Type is set to Triangular) that sets the height of the triangles in the pattern.

- **Contrast**: A slider that sets the sharpness of the division between squares. Values range from 0 to 1.

- **Publish OSC**: A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and
Clouds

The Clouds generator creates an animated cloud pattern. You can modify or animate the color, scale, speed, and strength of the cloud layers.

Adjust this generator using the controls in the Generator Inspector:

- **Horizontal Scale**: A slider that simulates zooming into or out of the cloud pattern by horizontally scaling the generator. Larger numbers indicate a higher level of zoom.

- **Vertical Scale**: A slider that simulates zooming into or out of the cloud pattern by vertically scaling the generator. Larger numbers indicate a higher level of zoom.

- **Speed**: A slider that sets the speed of movement of the clouds. Values range from 0 to 2.

- **Gradient**: Controls that set the color gradient used for the clouds. For information on using gradients, see Use the
Method: A pop-up menu that sets the algorithm used to generate the clouds. Values can be set to Normal (default) or Turbulent.

Offset: Value sliders that set the coordinates of the center of the clouds. Coordinates are calculated from the center of your object, which is the coordinate origin. (You can also use the Adjust Item tool to adjust this parameter using onscreen controls. For more information, see Modify or animate a generator.)

1st Layer Strength, 2nd Layer Strength, 3rd Layer Strength, 4th Layer Strength: Sliders that set the strength of each of the four layers of clouds. Values range from 0 to 1.

Color Solid

The Color Solid generator creates a single-colored object. You can adjust the color of the solid, as well as keyframe the color to create an animated texture of changing colors.

Note: To create and animate a small, color-filled box or shape,
use the Shape tools to draw a vector-based shape rather than creating and masking a Color Solid generator. This is more efficient in terms of processor performance and workflow.

Adjust this generator using the controls in the Generator Inspector:

- **Color**: Color controls that set the color. For more precise color selection, click the disclosure triangle to display Red, Green, and Blue sliders.

**Concentric Polka Dots**

The Concentric Polka Dots generator creates a repeating pattern concentric circles, polygons, or stars.

Adjust this generator using the controls in the Generator Inspector:

- **Center**: A slider that sets the center of the generator pattern.
- **Dot Color**: Color controls that set the color of the polka dots.
- **Background Color**: Color controls that set the color behind the polka dots.
- **Ring Width**: A slider that defines the width of the concentric
Ring Width: A slider that defines the width of the concentric rings of dots.

- **Angle**: A dial that rotates the generator pattern.
- **Dot Radius**: A slider that sets the width of the polka dots.
- **Dot Spacing**: A slider that sets how far apart the dots are from each other.
- **Dot Shape**: A pop-up menu that sets the shape of the pattern elements. There are three choices:
  - **Circles**: Creates round polka dots.
  - **Polygons**: Creates polygons. When selected, the Number of Sides, Dot Rotation, and Align Dots parameters become available.
  - **Stars**: Creates stars. When selected, the Number of Points, Dot Rotation, Align Dots, and Star Radius parameters becomes available.
- **Contrast**: A slider that controls the transition between the dot and background colors. A value of 1 creates the highest contrast between the colors; lower values create less contrast, softening the shapes.
- **Publish OSC**: A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see [Final Cut Pro templates overview](#).

## Concentric Shapes

The Concentric Shapes generator creates a repeating pattern of
Adjust this generator using the controls in the Generator Inspector:

- **Shape**: A pop-up menu that sets the shape type. There are two choices:
  - **Circles**: Creates concentric circles.
  - **Polygons**: Creates concentric polygons with a minimum of three sides.

- **Number of Sides**: A slider (available when shape is set to Polygons) that determines the number of sides on the polygonal shape. A polygon must have at least three sides.

- **Rotation**: A dial (available when Shape is set to Polygons) that determines the orientation of the polygonal shapes.

- **Center**: Value sliders that set the center point of the generator in the Canvas. The left value slider represents X; the right value slider represents Y. To access individual X and Y controls, click the disclosure triangle.

- **Inner Cutoff**: A slider that defines a center stopping area for the generator. A value greater than 0 creates a hole in the
middle of the generator; the greater the value, the larger the hole. Objects composited below the generator in the project appear in the cutoff areas.

- **Outer Cutoff:** A slider that defines an outer stopping area for the generator. The lower the value, the more the outer edges of the generator are cut off. Objects composited below the generator in the project appear in the cutoff areas.

- **Color Type:** A pop-up menu that specifies color type. There are two choices:
  - **2 Color:** Creates two-color concentric shapes.
  - **Gradient:** Adds additional gradient parameters to the Inspector: the Gradient editor and Gradient Handling pop-up menu (described below). For more information on gradient editors, see [Gradient editor controls](#).

- **Color 1:** Color controls (available when Color Type is set to 2 Color) that set the first color in the generator. Using the default settings, this color appears in the center of the concentric shapes.

- **Color 2:** Color controls (available when Color Type is set to 2 Color) that set the second color in the generator.

- **Gradient Handling:** A pop-up menu (available when Color Type is set to Gradient) that specifies whether to clamp, repeat, or mirror the gradient in the areas beyond the end of the shape (determined by the Center parameter and the rightmost color tag in the gradient). There are three choices:
  - **Clamp to End Point:** Limits the gradient to its edge (as defined by the Center parameter and the rightmost color tag in the gradient).
- **Mirror:** Mirrors the gradient from its edge (as defined by the Center parameter and the rightmost color tag in the gradient).

- **Repeat:** Repeats the gradient from its edge (as defined by the Center parameter and the rightmost color tag in the gradient).

- **Width:** A slider that sets the width of the concentric shapes.

- **Contrast:** A slider (available when Color Type is set to 2 Color) that controls the transition between the two colors. A value of 1 creates the highest contrast between the colors; lower values create less contrast, softening the shapes.

- **Phase:** A slider that cycles through the colors or gradient.

**Tip:** Animate the Phase parameter to create a hypnotic effect.

- **Publish OSC:** A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see Final Cut Pro templates overview.

**Gradient**

The Gradient generator initially creates a linear gradient. You can change the gradient type from linear to radial, add and remove colors in the gradient, and change the gradient start and end points. You can save a modified gradient to the Gradient category in the Library and apply it to shapes, text objects, or particle cells. Additionally, gradient controls can be keyframed to create a
moving, color-changing gradient.

Adjust this generator using the controls in the Generator Inspector:

- **Gradient**: Controls that set the color gradient. For information on using gradients, see Gradient editor controls.

- **End Condition**: A pop-up menu (available when Radial is chosen from the Type pop-up menu in the Gradient editor) that specifies the end condition. (For more information on the Type pop-up menu, see Basic gradient controls.) The End Condition pop-up menu has two choices:
  - **Hold Last Tag**: Extends the last color defined in the gradient editor beyond the gradient (defined by the Start and End parameters) to the edge of the Canvas.
  - **Transparent Tag**: Ends the gradient at the location defined by the Start and End parameters. Because transparency is created, objects below the gradient in the project appear beyond the end of the gradient.
Grid

The Grid generator creates a grid pattern made of two colored lines. By default, they’re white lines on a black background. Using the controls in the Inspector, you can customize the colors and line widths of the grid, and add graph paper lines.

Adjust this generator using the controls in the Generator Inspector:

- **Offset**: Value sliders that set the coordinates of the center of the grid. Coordinates are calculated from the center of your object, which is the coordinate origin. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see [Modify or animate a generator](#).)
- **Line Color**: Color controls that set the color of grid lines.
- **BG Color**: Color controls that set the color of the grid background.
- **BG Opacity**: A slider that sets the opacity of the background. Values range from 0 to 1.
- **Feather**: A slider that sets the feathering or sharpness of grid lines. Values range from 0 to 1.
• **Line Width**: A slider that sets the width of grid lines.

• **Autofit**: A checkbox that, when selected, bounds grid background width and height values to ensure that there aren’t partial columns or rows at the edge of the grid.

• **BG Width**: A slider that sets the width of the background or space between lines.

• **BG Height**: A slider that sets the height of the background or space between lines.

• **Graph Paper Lines**: A checkbox that, when selected, adds a grid pattern on top of the existing grid. With this option selected, the Graph Line Color and Graph Line Frequency controls become available.

• **Graph Line Color**: Color controls (available when the Graph Paper Lines checkbox is selected) that set the color of the “graph paper” lines.

• **Graph Line Frequency**: A slider (available when the Graph Paper Lines checkbox is selected) that sets how frequently a grid line is also a graph line.

• **Publish OSC**: A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see [Final Cut Pro templates overview](#).

---

**Japanese Pattern**

The Japanese Pattern generator creates a pattern of overlapping waves or congruent circles.
Adjust this generator using the controls in the Generator Inspector:

- **Japanese Pattern**: A pop-up menu that selects the generator pattern. There are two choices:
  - **Seigaiha (Waves)**: Creates a pattern of radial gradients.
  - **Shippo**: Creates a pattern of overlapping circles that are divided into quarters.

- **Gradient Editor**: Controls (available when Japanese Pattern is set to Seigaiha [Waves]) that define the gradient fill of the overlapping circles. For more information, see Gradient editor controls.

- **Vertical Spacing**: A slider (available when Japanese Pattern is set to Seigaiha [Waves]) that sets the vertical distance between the overlapping circles.

- **Leaf Color**: Color controls (available when Japanese Pattern is set to Shippo) that set the color of the “leaves” in the pattern circles.

- **Radius**: A slider (available when Japanese Pattern is set to Shippo) that defines the width of leaves in the pattern. The larger the Radius value, the larger the leaves.

- **Contrast**: A slider (available when Japanese Pattern is set to Shippo) that adjusts the contrast between the leaves and the background.
- **Contrast**: A slider (available when Japanese Pattern is set to Shippo) that controls the transition between the colors of the shapes. A value of 1 creates the highest contrast between the colors; lower values create less contrast, softening the shapes.

- **Outside Shape**: A checkbox (available when Japanese Pattern is set to Shippo) that, when selected, creates a shape (in the color chosen in the Leaf Color parameter) outside of each circle. If you see no difference in the pattern when Outside Shape is selected, adjust the Radius value.

- **Inside Shape**: A checkbox (available when Japanese Pattern is set to Shippo) that, when selected, adds a square (in the color chosen in the Leaf Color parameter) to the center of each circle in the pattern.

- **Center**: A slider that sets the center of the generator pattern.

- **Background Color**: Color controls that set the background color of the generator.

- **Size**: A slider that sets the size of the overlapping circles.

- **Board Angle**: A dial that rotates the generator pattern.

---

**Lens Flare**

Lens flares result from a bright light source pointed right at a lens, refracting off multiple elements in the lens assembly of a camera. This generator adds a simulated lens flare.
Adjust this generator using the controls in the Generator Inspector:

- **Center**: Value sliders that set the position of the center of the lens flare. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see Modify or animate a generator.)
- **Size**: A slider that sets the radius of the ring of the lens flare.
- **Intensity**: A slider that sets the intensity of the lens flare. Values range from 0 to 4.
- **Falloff**: A slider that sets how fast the lens flare falls off. Values range from 0 to 10.
- **Color**: Color controls that pick the color of the lens flare. Click the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.
- **Outer Color**: Color controls that pick the outer color of the lens flare.
- **Ring Color**: Color controls that pick the color of the ring of the lens flare.
- **Streak Color**: Color controls that pick the color of the streaks.
- **Streak Color**: Color controls that pick the color of the streaks in the lens flare.
- **Streak Intensity**: A slider that sets the intensity of the streaks. Values range from 0 to 1.
- **Streak Count**: A slider that sets the number of streaks in the lens flare. Values range from 1 to 100.
- **Streak Noise Frequency**: A slider that sets the frequency of the noise in the streaks. Values range from 1 to 100.
- **Streak Noise Level**: A slider that sets the level of noise in the streaks of the lens flare. Values range from 0 to 20.
- **Ring Radius**: A slider that sets the radius of the ring of the lens flare. Values range from 0 to 1.
- **Ring Width**: A slider that sets the ring’s width. Values range from 0 to 1.
- **Glow Falloff**: A slicer that sets how fast the glow falls off of the lens flare. Values range from 0 to 20.
- **Streak Map**: An image well that displays a thumbnail of the map chosen for the streaks of the lens flare.
- **Publish OSC**: A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see [Final Cut Pro templates overview](#).

**Manga Lines**
The Manga Lines generator creates radial or linear Manga-style graphic lines.
Adjust this generator using the controls in the Generator Inspector:

- **Line Style**: A pop-up menu that selects the generator pattern. The choices include:
  - **Radial Inward**: Creates spoked lines that originate from the outer edges and extend toward the center of the generator.
  - **Radial Outward**: Creates spoked lines that originate from the center of the generator and extend outward.
  - **Linear One Side**: Creates lines that originate from one side of the generator.
  - **Linear Inward**: Creates lines that originate from two sides and extend toward the center of the generator.
  - **Linear Outward**: Creates lines that originate from the center of the generator and extend outward on two sides.

- **Center**: A slider (available when Line Style is set to Radial Inward or Radial Outward) that sets the center of the generator pattern.

- **Inner Radius**: A slider (available when Line Style is set to
Radial Inward or Radial Outward) that defines the inner boundary of the generator.

- **Outer Radius**: A slider (available when Line Style is set to Radial Inward or Radial Outward) that defines the outer boundary of the generator.

- **Angle**: A dial (available when Line Style is set to Radial Inward or Radial Outward) that rotates the radial lines.

- **Point 1**: Sliders (available when Line Style is set to Linear One Side, Linear Inward, or Linear Outward) that set the X and Y positions of the start of the lines.

- **Point 2**: Sliders (available when Line Style is set to Linear One Side, Linear Inward, or Linear Outward) that set the X and Y positions of the end of the lines.

- **Line Thickness**: A slider (available when Line Style is set to Linear One Side, Linear Inward, or Linear Outward) that defines the thickness of each line.

- **Color**: Color controls that set the color of the lines.

- **Background Color**: Color controls to set the color that appears behind the lines.

- **Contrast**: A slider that controls the transition between the line color and the background color. A value of 1 creates the highest contrast between the colors; lower values create less contrast, softening the lines.

- **Number of Lines**: A slider that sets the amount of lines in the generator.

- **Waviness**: A slider that warps the lines into waves. For more waves, adjust the Number of Waves parameter.
- **Number of Waves:** A slider that sets the number of waves when Waviness is set to any value other than 0. Higher values result in more waves.

- **Wave Offset:** A slider that defines the phase of the waves when Waviness is set to any value other than 0. (Animate this value to create interesting effects.)

- **Random Seed:** A slider that changes the random calculations to display the lines differently. Modifying this value over time yields a constantly changing pattern. The easiest way to see and use the Random Seed parameter is to add a Ramp behavior to it (in the Parameter behavior category), then ramp from a very small random seed value to a very large random seed value over time.

### Membrane

The Membrane generator creates a sheer, animated sheet that appears to move gracefully in 3D space. The speed, start and end points, offset, brightness, and color can be modified and animated. To expand the animation beyond the Canvas borders, increase the Width and Height parameters in the Inspector.

Adjust this generator using the controls in the Generator.
Inspector:

- **Speed**: A slider that sets the speed of movement of the sheet.
- **Start 1–4**: Sliders that set the starting point for the sheet wave. Experiment with these controls to find wave shapes.
- **End 1–4**: Sliders that set the ending point for the sheet wave. Experiment with these controls to find wave shapes.
- **Offset**: A slider that sets the coordinates of the center of the sheet. Coordinates are calculated from the center of your object, which is the coordinate origin.
- **Brightness**: A slider that sets the brightness of the sheet.
- **Color**: Color controls that pick the color of the membrane. Click the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.

**Noise**

The Noise generator creates a random, colored static pattern. To make animated noise, you can keyframe the Random Seed parameter in the HUD or Generator Inspector. When filters are applied to an animated Noise generator, you can create unique textures. In the second image below, the Stripes distortion filter is applied to an animated Noise generator to create a vibrant, electric light-type texture.
Adjust this generator using the controls in the Generator Inspector:

- **Random Seed:** A slider that sets a different noise value. Modifying this value over time yields a constantly changing noise pattern. The easiest way to see and use the Random Seed parameter is to add a Ramp behavior to it (in the Parameter behavior category), then ramp from a very small random seed value to a very large random seed value over time.

**One Color Ray**

The One Color Ray generator creates a ray pattern based on variations of a color. You can select the color, the degree of variance, the number of divisions represented, and the rotation of the pattern.
Adjust this generator using the controls in the Generator Inspector:

- **Color Space**: A pop-up menu that sets the color space. Generally, if you are working in NTSC, use YIQ. If you are working in PAL, use YUV.
- **Offset**: Value sliders that set the coordinates of the ray pattern’s center. Coordinates are calculated from the center of your object, which is the coordinate origin. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see Modify or animate a generator.)
- **Color**: Color controls that pick the base color.
- **Color Variance**: A slider that sets how much the colors differ from each other.
- **Divisions**: A slider that sets the number of divisions in the ray pattern.
- **Rotation**: A dial that sets the rotation of the whole pattern from the center point.
- **Sharpness**: A slider that defines the hardness of the edges of
the rays. Values range from .25 to 1.

- **Waviness**: A slider that warps the rays into waves. Values range from –10 to 10.

- **Frequency**: A slider that determines the number of waves in the rays when Waviness is set to any value other than 0.

- **Phase**: A slider that defines the offset of the waves from the start and end of the rays when Waviness is set to any value other than 0. (Animate this value to create interesting effects.)

- **Inner Cutoff**: A slider that defines a center stopping area for the generator. A value greater than 0 creates a hole in the middle of the generator; the greater the value, the larger the hole. Objects composited below the generator in the project appear in the cutoff areas.

- **Outer Cutoff**: A slider that defines an outer stopping area for the generator. The lower the value, the more the outer edges of the generator are cut off. Objects composited below the generator in the project appear in the cutoff areas.

- **Publish OSC**: A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see Final Cut Pro templates overview.

**Op Art 1**

There are three Op Art generators to help confuse your background-foreground senses. The Op Art generators create mathematically oriented patterns using a repetition of simple
shapes. Although some static patterns create a visual illusion of movement, you can keyframe Op Art parameters to create moving moiré patterns.

Adjust this generator using the controls in the Generator Inspector:

- **Line Thickness**: A slider that sets the thickness of the lines in the pattern.
- **Color 1**: Color controls that set the first color of the pattern. Click the disclosure triangle to display Red, Green, Blue, and Opacity sliders for more precise color selection.
- **Color 2**: Color controls that set the second color of the pattern. Click the disclosure triangle to display Red, Green, Blue, and Opacity sliders for more precise color selection.
- **Contrast**: A slider that sets how sharp or blurred the division is between the lines and the background.
- **Wavelength 1**: A slider that sets the frequency of the wave up and down.
- **Wavelength 2**: A slider that sets the frequency of the wave
• **Amplitude**: A slider that sets the amplitude of the waves.
• **Roundness**: A slider that sets the shape of the waves.

**Op Art 2**

This generator creates mathematically oriented patterns using a repetition of simple shapes. Although some static patterns create a visual illusion of movement, you can keyframe Op Art parameters to create moving moiré patterns.

Adjust this generator using the controls in the Generator Inspector:

• **Scale**: A slider that sets how close or far away the dots appear.
• **Angle**: A dial that sets the angle of the dot rows.
• **Dot Color**: Color controls that set the color of the dots.
• **Background Color**: Color controls that set the color of the
background. For more information on using the color controls, see Basic color controls.

- **Contrast**: A slider that sets how sharp or blurred the division is between the dots and the background.
- **Dot Size**: A slider that sets the dot size.
- **Compression**: A slider that sets how shallow or deep the fold in the imaginary paper appears.

### Op Art 3

This generator creates mathematically oriented patterns using a repetition of simple shapes. Although some static patterns create a visual illusion of movement, you can keyframe Op Art parameters to create moving moiré patterns.

![Default Op Art 3 generator](image1)

![Modified Op Art 3 generator (with Random Tile filter)](image2)

Adjust this generator using the controls in the Generator Inspector:

- **Line Thickness**: A slider that sets the thickness of the lines in the pattern.
- **Color 1**: Color controls that set the first color of the generator.
- Color 1: Color controls that set the first color of the generator.
- Color 2: Color controls that set the second color of the generator. For more information on using the color controls, see Basic color controls.
- Contrast: A slider that sets how sharp or blurred the division is between the lines and the background.
- Wavelength: A slider that sets the frequency of the wave.
- Amplitude: A slider that sets the height of the wave.
- Skew: A slider that sets rotation of the wave pattern.
- Roundness: A slider that sets the shape of the wave.

Overlapping Circles

The Overlapping Circles generator creates orbs of two different colors that overlay each other. You can use a third color for the background.

Adjust this generator using the controls in the Generator Inspector:
- Center: A slider that sets the center of the generator pattern.
- Color 1: Color controls that set the first color of the generator.
- **Color 2**: Color controls that set the second color of the generator. For more information on using the color controls, see Basic color controls.

- **Background Color**: Color controls that set the background color of the generator. If the background color is not visible, adjust the Circle Offset parameter.

- **Size**: A slider that adjusts the size of the circles.

- **Circle Offset**: A slider that adjusts the space between the circles.

- **Angle**: A dial that rotates the overlapping circles pattern.

- **Contrast**: A slider that sets how sharp or blurred the division is between the circles and the background.

---

**Radial Bars**

The Radial Bars generator creates bars of equal width that extend from a center point to the edge of the Canvas.

Adjust this generator using the controls in the Generator Inspector:

- **Center**: A slider that sets the center of the generator pattern.

---

![Default Radial Bars generator](image1.png) ![Modified Radial Bars generator](image2.png)
- **Center**: A slider that sets the center of the generator pattern.

- **Bar Color**: Color controls that set the color of the bars.

- **Background Color**: Color controls that set the background color of the generator.

- **Number of Bars**: A slider that sets the quantity of bars in the generator.

- **Bar Width**: A slider that defines the thickness of each bar.

- **Angle**: A dial that rotates the overlapping circles pattern.

- **Contrast**: A slider that sets how sharp or blurred the division is between the circles and the background.

- **Convergence**: A pop-up menu that sets how the bars meet in the center. The choices include:
  - **Modern**: Creates bars that appear to extend from one edge of the Canvas to the other, overlapping in the center.
  - **Classic**: Creates bars that appear to extend inward from the edges of the Canvas, meeting in the center with an offset overlap.
Soft Gradient

The Soft Gradient generator creates a soft-edged, radial gradient. The gradient contains an alpha channel, so you can place the generator over another image in the project. You can change and keyframe the color, size, and position of the Soft Gradient.

Adjust this generator using the controls in the Generator Inspector:

- **Center**: Value sliders that set the position of the center of the gradient. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see Modify or animate a generator.)
- **Color**: Color controls that set the color of the gradient. Click
the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.

- **Radius:** A slider that sets the radius of the gradient circle. Values range from 0 to 1000.
- **Publish OSC:** A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see [Final Cut Pro templates overview](#).

**Spirals**

This generator creates a repeating circular spiral pattern.

Adjust this generator using the controls in the Generator Inspector:

- **Type:** A pop-up menu that specifies whether a modern or classic spiral is created. There are two menu items:
  - **Modern (Linear):** Creates a modern spiral pattern, with the color swirls evenly spaced as they move toward the center of the spiral.
• **Classic (Exponential):** Creates a classic spiral pattern with color swirls becoming thinner as they move toward the center of the spiral.

• **Center:** Value sliders that set the center point of the generator in the Canvas. The left value slider represents X position; the right value slider represents Y position. To access individual X and Y controls, click the disclosure triangle. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see [Modify or animate a generator](#).)

• **Color Type:** A pop-up menu that specifies whether the spirals are two-color or a gradient fill.
  - **2 Color:** Creates two-color spirals. When 2 Color is selected from the Color Type pop-up menu, the Color 1, Color 2, and Contrast parameters become available.
  - **Gradient:** Lets you add colors to the spiral, creating soft
Let's you add colors to the spiral, creating soft transitions between colors. Spiral colors are determined by the Gradient editor. You can create a custom gradient or apply a preset gradient to the spirals. For more information on using gradient editors, see Move, duplicate, or change the interpolation of gradient tags.

- **Color 1:** Color controls (available when Color Type is set to 2 Color) that set the first color of the spiral.
- **Color 2:** Color controls (available when Color Type is set to 2 Color) that set the second color of the spiral.
- **Gradient:** Gradient controls (available when Color Type is set to Gradient) that allow you to pick a gradient from the Library.
- **Scale:** A slider (available when Type is set to Modern) that determines the size of the spiral arms.
- **Tightness:** A slider (available when Type is set to Classic) that determines the curl of the spiral. The lower the Tightness value, the looser the spiral.
- **Contrast:** A slider that controls the transition between the two colors. A value of 1 creates the highest contrast between colors; lower values create less contrast, softening the spiral. The Contrast parameter is not available when Gradient is chosen from the Color Type pop-up menu.
• **Rotation:** A dial that rotates the spiral around its center. (Animate the Rotation parameter to create a hypnotic effect.)

• **Publish OSC:** A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see [Final Cut Pro templates overview](#).

---

**Spiral Drawing**

Like a toy from our youth, the Spiral Drawing generator draws curves based on a “pen” that’s locked to a point on a gear (a rotor) that rolls within—or without—a larger ring (a stator). While the pattern draws, the ring remains in a fixed location, and the gear rolls along the inner edge or outer edge of the ring.

Adjust this generator using the controls in the Generator Inspector:

• **Auto Draw:** A checkbox that, when selected, creates an animated drawing. When Auto Draw is deselected, the drawing is static.

• **Auto Draw Style:** A pop-up menu that sets the style of the drawing instrument. There are two choices:
- **Pen**: Draws solid, even lines in the Canvas in a pattern defined by the generator controls.
- **Laser**: Simulates a laser in the Canvas in a pattern defined by the generator controls.

- **Draw Speed**: A slider that adjusts how quickly the drawing is created.
- **Cycle Start**: A slider that sets the beginning location of the drawing.
- **Center**: A slider that sets the center of the generator pattern.
- **Pen Color**: Color controls that set the color of the drawing.
- **Pen Width**: A slider that defines the thickness of the drawn lines (Pen or Laser).
- **Pen Blend Mode**: A pop-up menu that sets the blend mode of the generator to Normal or Add. This setting is a separate from the blend mode of the group. Setting the Pen Blend Mode to Add results in an additive effect (it’s added to the blend mode of the group).
- **Pen Location**: A slider that sets the position of the pen within the drawing gear. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see **Modify or animate a generator**.)
- **Line Smoothness**: A slider that defines how uniform the lines are. Lower the value to create more crimped, linear lines.
- **Ring Radius**: A slider that controls the size of the drawing. When Inside Ring is chosen from the Gear location pop-up menu, all drawing occurs inside the radius of the ring. When Outside Ring is chosen from the Gear location pop-up menu,
all drawing occurs outside the radius of the ring. (You can also use the Adjust Item tool to modify this parameter with onscreen controls.)

- **Ring Teeth**: A slider that controls the number of teeth on the outer drawing ring.
- **Gear Teeth**: A slider that controls the number of teeth on the inner gear. A lower Gear Teeth value results in a more complex drawing. (You can also use the Adjust Item tool to modify this parameter with onscreen controls.)
- **Gear Location**: A pop-up menu that sets whether the drawing occurs outside or inside the ring. There are two choices:
  - **Inside Ring**: All drawing occurs within the radius of the ring.
  - **Outside Ring**: All drawing occurs outside the radius of the ring.
- **Ring Rotation**: A dial that turns the ring (and the attached gear).
- **Gear Rotation**: A dial that turns the gear (and the attached pen point).

# Modify the Spiral Drawing using onscreen controls

You can use the Spiral Drawing onscreen controls to adjust the position of the drawing in the Canvas, the location of the pen within the gear, the size of the stator ring, and the number of teeth and rotation of the gear.
Adjust the Spiral Drawing using onscreen controls

1. In the Layers list, Canvas, Timeline, select an applied Spiral Drawing generator.

2. In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Adjust Item tool.

3. In the Canvas, do any of the following:
   - Drag the center onscreen control (or any blank area within the ring or gears) to reposition the drawing in the Canvas.
   - Drag the ring inward to decrease its radius or outward to increase its radius.
   - Drag the gear inward to decrease its teeth value or outward to increase its teeth value. This affects how closely the pattern is drawn to the center of the spiral.
Drag the white circle in the gear to adjust the location of the pen and the rotation of the gear.

For a complete description of the Spiral Drawing parameters, see Spiral Drawing.

Star

The Star generator creates a glowing star shape that contains an alpha channel. The scale, width, angle, epsilon (which fine-tunes the size of the star spikes), and opacity of the spikes can be modified and keyframed, as well as the position, color, and radius of the star.
Adjust this generator using the controls in the Generator Inspector:

- **Center**: Value sliders that set the position of the center of the star. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see Modify or animate a generator.)

- **Color**: Color controls that pick the color of the halo around the star. Click the disclosure triangle to display Red, Green, Blue, and Opacity sliders for more precise color selection.

- **Radius**: A slider that sets the radius of the circle at the center of the star. Values range from 0 to 300.

- **Spike Scale**: A slider that sets the size of the star spikes. Values range from 0 to 100.

- **Spike Angle**: A dial that sets the angles of the star spikes.

- **Spike Opacity**: A slider that sets the opacity of the star spikes. Values range from –8 to 0.

- **Spike Width**: A slider that sets the width of the star spikes. Values range from 0 to 50.

- **Epsilon**: A slider that fine-tunes the strength of the star spikes.
- **Epsilon**: A slider that fine-tunes the strength of the star spikes. Values range from –2 to 0.

- **Publish OSC**: A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see Final Cut Pro templates overview.

## Stripes

The Stripes generator creates a default image with vertical bands of two alternating colors. You can change and keyframe the position, colors, size, and contrast of the stripes. Animate the Center parameter to make the stripes move continuously across the screen.

Adjust this generator using the controls in the Generator Inspector:

- **Center**: Value sliders that set the position of the center of the stripe pattern. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information,
see Modify or animate a generator.)

- **Color 1:** Color controls that set the color of the first stripe. For more precise color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity sliders.

- **Color 2:** Color controls that set the color of the second stripe. For more precise color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity sliders.

- **Size:** A slider that sets the width of individual stripes.

- **Contrast:** A slider that sets the sharpness or blurriness of the edge between stripes. Values range from 0 to 1.

- **Publish OSC:** A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see [Final Cut Pro templates overview](#).

---

**Sunburst**

The Sunburst generator creates “beams” that radiate from a center point.
Adjust this generator using the controls in the Generator Inspector:

- **Center**: A slider that sets the center of the generator pattern.
- **Color**: Color controls that set the color of the sunburst.
- **Background Color**: Color controls that set the color (and opacity of that color) that appears behind the sunburst.
- **Number of Arms**: A slider that sets the number of spikes on the sunburst.
- **Radius**: A slider that defines the outer boundary of the sunburst’s spikes. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see Modify or animate a generator.)
- **Inner Radius**: A slider that defines the inner radius of the generator. A value of 1 results in no spikes; a value of .01 results in the sharpest spikes.
- **Angle**: A dial that rotates the sunburst.
- **Waviness**: A slider that warps the spikes into waves. For more waves, adjust the Number of Waves slider (described below).
- **Number of Waves**: A slider that sets the number of waves when Waviness is set to any value other than 0. Higher values result in more waves.
- **Wave Offset**: A slider that defines the phase of the waves when Waviness is set to any value other than 0. (Animate this value to create interesting effects.)
- **Contrast**: A slider that sets how sharp or blurred the division is between the circles and the background.
Truchet Tiles

The Truchet Tiles generator creates a two-color pattern based on simple shapes in different orientations, such as quarter-circles or white squares with black diagonal lines. You can also use an image layer to create a custom tile pattern.

Adjust this generator using the controls in the Generator Inspector:

- **Center**: A slider that sets the center of the generator pattern.
- **Size**: A slider that sets the scale of the tiles.
- **Shape**: A pop-up menu that sets shape of the tile pattern to Diagonal Lines, Arcs, Dots, Pipes, or Custom. When Shape is set to Custom, you can assign an image layer (shape, text, image, and so on) as the tile for the generator.
- **Color 1**: Color controls (available when Shape is set to Diagonal Lines, Arcs, Dots, or Pipes) that set the first color of the pattern. For more precise color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity sliders.
- **Color 2**: Color controls (available when Shape is set to Diagonal Lines, Arcs, Dots, or Pipes) that set the second color
of the pattern. For more precise color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity sliders.

- **Custom Tile Options:** An image well and group of checkboxes that become available when Shape is set to Custom. Drag an image layer into the Custom Tile Image well to create custom tiles. Select or deselect the checkboxes to flip or rotate the custom tiles. When the No Transform checkbox is selected, a random selection of tiles are not flipped or rotated.

- **Random Seed:** A slider that changes the random calculations to display the tiles differently. Modifying this value over time yields a constantly changing pattern. The easiest way to see and use the Random Seed parameter is to add a Ramp behavior to it (in the Parameter behavior category), then ramp from a very small random seed value to a very large random seed value over time.

- **Contrast:** A slider (available when Shape is set to Diagonal Lines, Arcs, Dots, or Pipes) that sets how sharp or blurred the division is between the tiles and the background.

**Two Color Ray**

The Two Color Ray generator creates a ray pattern alternating between two colors. You can select the colors, the number of divisions represented, and rotation of the pattern.
Adjust this generator using the controls in the Generator Inspector:

- **Offset**: Value sliders that set the coordinates of the center of the ray pattern. Coordinates are calculated from the center of the object, which is the coordinate origin. (You can also use the Adjust Item tool to modify this parameter with onscreen controls. For more information, see [Modify or animate a generator].)

- **Color 1**: Color controls that set the base color for the two-color ray.

- **Color 2**: Color controls that set the alternating color for the two-color ray.

- **Divisions**: A slider that sets the number of divisions in the ray pattern.

- **Rotation**: A dial that sets the rotation of the whole pattern from the center point.

- **Contrast**: A slider that sets the sharpness or softness of the division between rays.

- **Waviness**: A slider that makes the rays wavy. Positive or
negative values create waves in the rays. Values range from –10 to 10.

- **Frequency**: A slider that determines the number of waves in the rays when Waviness is set to a value other than 0.
- **Phase**: A slider that determines the offset of the waves from the start and end of the rays when Waviness is set to a value other than 0.
- **Inner Cutoff**: A slider that defines a center stopping area for the generator. A value greater than 0 creates a hole in the middle of the generator; the greater the value, the larger the hole. Objects composited below the generator in the project appear in the cutoff areas.
- **Outer Cutoff**: A slider that defines an outer stopping area for the generator. The lower the value, the more the outer edges of the generator are cut off. Objects composited below the generator in the project appear in the cutoff areas.
- **Publish OSC**: A checkbox that, when selected, ensures that if this generator is sent to Final Cut Pro X as part of a template, the onscreen controls are accessible in Final Cut Pro. For more information about publishing onscreen controls and other parameters, see [Final Cut Pro templates overview](https://www.apple.com/finalcutpro/).
countdown animations. The Inspector for each Text generator contains four panes: Format, Appearance, Layout, and Text Generator.

The first three panes (Format, Appearance, and Layout) control the font, size, color, outline, glow, drop shadow, and other standard text attributes. These panes are nearly identical to those in the Text Inspector for standard text layers, with two exceptions: The Text Generator Inspector has no Text editor (a field in which custom text can be typed) and no Editable in FCP checkbox. Additionally, the Text and Transform Glyph tools cannot be used to modify text in Text generators. For information on the Format, Appearance, and Layout panes, see Text Inspector overview.

There are four Text generators:

- **File** displays the contents of a text file, line by line.
- **Numbers** displays random numbers based on settings in the Inspector.
- **Time Date** displays the date and time based on settings in the Inspector.
- **Timecode** displays timecode based on the current project or the settings in the Inspector.

**File**

The File generator displays the contents of a text file. The appearance (font, weight, size, and so on) of the text in the source text file is ignored in favor of the settings in the Inspector. The text file must be in plain text (TXT) format.
In a File generator, each line of text appears onscreen, holds for a moment, and then disappears before the next line appears. You can control how the text appears using the controls in the Inspector. The duration of the generator bar in the Timeline determines how long it takes for all lines of text in the source file to reveal themselves.

Adjust this generator using the controls in the Generator Inspector:

- **Browse**: A button that opens a browser window where you can select the plain text (TXT) file to use as the text source.
- **Speed**: A pop-up menu that sets the behavior of the text as it appears and disappears onscreen. Choose any of several options:
  - **Constant**: The text appears and disappears at a steady speed from the first word or line to the last word or line in the text file.
  - **Ease In**: The text appears at a slow speed.
  - **Ease Out**: The text disappears at a slow speed.
  - **Ease Both**: The text appears and disappears at a slow speed.
  - **Accelerate**: The text appears and disappears with increasing speed.
  - **Decelerate**: The text appears and disappears with decreasing speed.
  - **Custom**: Defines the speed of appearance and disappearance of the text by setting keyframes for the text from 0 to 100 percent using the Custom Speed slider,
described below. In other words, you determine the rate of
the appearance and disappearance of the text over time.

- **Custom Speed:** A slider (available when Speed is set to
  Custom) that lets you keyframe the timing of the appearance
  or disappearance of the text. At 0 percent, none of the text
  has appeared; at 100 percent, the last of the text in the file is
  displayed (the last line or word).

- **Random:** A checkbox that, when selected, randomizes the
  order in which the lines of text appear.

- **Random Seed:** Controls that let you change the seed number
  (by typing a new number in the text field or clicking Generate).
  This changes the random calculations to display the text in a
  different order.

**Numbers**

The Numbers text generator displays random numbers based on
settings in the Inspector.

Adjust this generator using the controls in the Generator
Inspector:

- **Animate:** A checkbox that, when selected, enables animation
  of the numbers as the project plays. When deselected, a
  static number is displayed.

- **Start:** A slider that sets the beginning number for the
  generator. Slider values range from 0 to 100. For negative
  numbers or numbers greater than 100, use the value slider (to
  the right of the slider). Default values are based on the project.
  For example, when the Numbers generator is added to a
default project of 300 frames, the Start value is 1 and the End value is 300.

**Tip:** You can use the Link parameter behavior to set the numbers to show values of any parameter used in your project. In some cases, the number display may appear at a scaled rate. In other cases, the number display may be translated into another form (such as a percentage). For example, if you use the Link behavior to link to the value of a point light’s Falloff parameter, the number is scaled by a factor of .1 and the Intensity parameter is displayed as a percentage. You can scale and offset the value of the linked parameter using the Scale slider in the Behavior Inspector. To convert the number to a different format, use the Format pop-up menu in the Numbers generator. For more information about the Link behavior, see [Link](#).

- **End:** A slider that sets the ending number for the generator. Slider values range from 0 to 100. For negative numbers or numbers greater than 100, use the value slider (to the right of the slider). Default values are based on the project. For example, when the Numbers generator is added to a default project of 300 frames, the Start value is 0 and the End value is 300. If the End value is set to 200, a range of 0 to 200 is counted over the 300 frames.

- **Format:** A pop-up menu that specifies the format of displayed numbers. There are seven choices:
  - **Number:** Numbers are used in the generator.
  - **Currency:** Currency is used for the generator. The default is U.S. dollars. To change to another currency, choose an option in the Region pop-up menu.
  - **Percent:** Percentages are used for the generator.
- **Percent:** Percentages are used for the generator.
- **Scientific:** Scientific numbers are used for the generator.
- **Spell Out:** Numbers are spelled out in the generator.
- **Binary:** The binary numeral system is used for the generator. The binary system uses two symbols (0 and 1) to represent numeric values.
- **Hexadecimal:** Hexadecimal numerals are used for the generator. This system uses 16 symbols. The symbols 0 to 9 represent the numbers 0 to 9, and the letters A through F represent 10 to 15.

**Tip:** When using Hexadecimal or Binary formats, inputs of very large numbers are required to create change in every character in the generator. For example, if the default Start and End values of 1 and 300 are used (in a default project of 300 frames), only the last two or three digits appear animated in the Hexadecimal format.

If a number such as 4,294,967,296 is used, nearly all characters are animated.

- **Decimals:** A slider (available when Format is set to Number, Currency, Percent, Scientific, or Spell Out) that sets the number of decimal places.
- **Capitalize:** A checkbox (available only when Format is set to Spell Out) that, when selected, displays initial uppercase letters.

- **Minimum Digits:** A slider (available when Format is set to Number) that defines the minimum digits used in the generator. The default value is 1.

- **Thousands Separator:** A checkbox (available when Format is set to Number, Currency, or Percent) that displays a comma or other character to separate thousands (based on what is chosen in the Region pop-up menu).

- **Random:** A checkbox that, when selected, displays numbers randomly.

- **Random Seed:** Controls that change the Random Seed number if you don’t like the current random number count. Enter a new number in the text field or click Generate. This changes the random calculations to display different numbers.

- **Random Hold Frame:** A slider that specifies how long (in frames) each number is held onscreen. For example, If Random is selected and Random Hold Frame is set to 20, a number is displayed for 20 frames, then the next number is displayed and held for 20 frames, and so on.

- **Region:** Controls that change the numeric format to that of another geographical region. By default, the generator uses the current system’s region. Click the Current button to set the current system’s region as the region for the generator. Click the Region pop-up menu to select another region.

**Note:** The selected region is saved with the generator. If opened on another computer with a different regional setting, the generator retains the saved region.
The Time Date text generator displays the date and time based on settings in the Inspector. You can create a countdown or count-up animation by defining start and end values. You can also specify time units, as well as time and date format. The default date and time are based on the computer’s system clock at the time the generator is added to the project. This can be changed in the Inspector by manually entering a value or clicking the Set Current Time button.

Adjust this generator using the controls in the Generator Inspector:

- **Animate**: A checkbox that, when selected, enables animation of the time and date as the project plays. The animation, such as a countdown or count up, is based on the values set in the Start and End fields. When Animate is deselected, static information is displayed.

- **Start**: A field (available when the Animate checkbox is selected) that sets the start date and time for the generator. This parameter can be animated using keyframes.

- **End**: A field (available when the Animate checkbox is selected) that sets the end date and time for the generator. This parameter can be animated using keyframes.

- **Value**: A field that specifies the date and time displayed in the generator. Value is not available when the Animate checkbox is selected. This parameter can be animated using keyframes.

- **Set Current Time**: A button that loads the current time into the generator.

- **Time Units**: A pop-up menu that sets the units of time used in
- **Time Units:** A pop-up menu that sets the units of time used in the generator to Seconds, Minutes, Hours, Days, Months, or Years.

- **Time Format:** A pop-up menu that sets the time format used in the generator. Choose one of four options:
  - **None:** Displays no time in the generator. (The date appears in the generator if any option other than None is chosen from the Date Format pop-up menu.)
  - **Short:** Displays the time in hours and minutes.
  - **Medium:** Displays the time in hours, minutes, and seconds.
• Long: Displays the time in hours, minutes, seconds, and time zone.

• Date Format: A pop-up menu that sets the date format used in the generator. Choose one of five options:
  
  • None: Displays no date in the generator. (The time appears in the generator if any option other than None is chosen from the Time Format pop-up menu.)
  
  • Short: Displays the month, day, and year in all-numeral style.
  
  • Medium: Displays the month abbreviated to three letters without a period, the day, and the year.
  
  • Long: Displays the month spelled out completely, the day, and the year.
  
  • Full: Displays the day of the week and the month spelled
out completely, the day, and the year.

- **Region**: Controls that change the numeric format to that of another geographical region. By default, the generator uses the current system’s region. Click the Current button to set the current system’s region as the region for the generator. Click the Region pop-up menu to select another region.

- **Padding**: A checkbox that, when selected, adds a 0 in front of single-digit times or dates.

## Timecode

The Timecode text generator displays timecode based on the current project or the settings in the Inspector. You can specify a specific timecode value, an offset to the current timecode, the timecode format, and the timecode base. You can also customize the color of the text and the color and opacity of the background.

Adjust this generator using the controls in the Generator Inspector:

- **Current Timecode**: A checkbox that, when selected, loads the project’s current timecode as the value displayed in the generator.

- **Value**: A field (available when the Current Timecode checkbox is deselected) that sets the timecode value displayed. This parameter can be animated using keyframes.

- **Offset**: A field (available when the Current Timecode checkbox is selected) that specifies an offset value to the current timecode. This parameter can be animated using keyframes.

- **Format**: A pop-up menu that sets the timecode format. There
are three choices:

- **HMSF**: Timecode is displayed in hours, minutes, seconds, frames format.
- **HMS**: Timecode is displayed in hours, minutes, seconds format.
- **Frames**: Frame numbers are displayed.

**Timecode Base**: A pop-up menu that sets the timecode for the generator to the frame rate of the current project. Menu choices include 10, 15, 23.976, 24, 25, 29.97, 29.97 Drop, 30, 50, 59.94, 59.94 Drop, or 60.

- **Label**: A field that specifies a label. Text entered in the Label field is added as a prefix to the timecode displayed in the Canvas.

- **Background Color**: Color controls that set the background color for the timecode window. By default, the background color is black. Click the disclosure triangle to access Red, Green, Blue, and Opacity sliders.

### Save a modified generator to the Library

After you modify or animate the parameters of a generator, you can save the generator to the Library for future use. For organizational purposes, name objects that you save to the Library with a descriptive title.
Save a customized generator to the Library

1. In the Library, navigate to the Generators or Favorites category.

2. From the Layers list or Timeline, drag the generator into the Library stack, releasing the mouse button when the green add pointer (+) appears over the stack window.

   The behavior is saved to the Library in the behaviors subcategory you selected. A custom generator is represented by a user icon in the lower-right corner of the generator icon.

   **Note:** You can rename the behavior for organizational purposes.

   The modified generator is saved in the Generators category and appears organized alphabetically in the stack. Custom items saved in the Library are identified with a user badge in the lower-right corner of the icon.
For more information, see Save custom objects to the Library and Manage Library folders and files.
Add effects with filters

Filters overview

Filters are special effects used to modify the appearance of images and video clips in Motion. You can apply filters to create artistic effects (blurs, distortions, glows, stylized looks), to perform image corrections (color balancing, deinterlacing, sharpening), and to create sophisticated composting effects (green screen keying). For information on keying filters, see Keying overview.

Filter categories are organized alphabetically in the Library.

- You can **preview a filter** in the Library before you apply it.
- You can **apply a filter** by dragging it from the Library onto a Layer or group in the Layers list, Timeline, or Canvas, or by using the Add Filter pop-up menu in the toolbar.
- You can **adjust an applied filter** using controls in the Filters pane.
You can adjust an applied filter using controls in the Filters Inspector or HUD, or by dragging onscreen controls. (For a list of parameter controls in each filter, see Filter types overview.)

- You can animate filter parameters using keyframes or by applying behaviors.

### Browse and preview filters

Filters appear in the Filters category in the Library, organized into subcategories specific to their function (such as Color Correction, Blur, and Tiling). After you select a filter in the Library stack, a preview and brief description of the filter appears in the Library preview area.
Browse for a filter

1. In the Library sidebar, click the Filters category.

   A list of subcategories appears on the right side of the sidebar.

2. Click a filter subcategory.

   A list of filters in that subcategory appears in the Library stack.

3. Click a filter in the stack to select it.

   A preview and short description of the filter appear in the preview area at the top of the Library.

SEE ALSO

Apply and remove filters

Apply and remove filters

Filters are applied to image layers (still images, video clips, shapes, and so on) or groups in the Canvas, Layers list, or Timeline. An applied filter appears in the Layers list nested underneath its target layer or group. When applied to a group, a filter affects all layers inside the group.

Important: Some filters can cause a group to be rasterized.
When a group is rasterized, it’s converted into a bitmap image. In 2D groups, the application of any filter causes rasterization. In 3D groups, the application of specific filters causes rasterization. For more information on rasterization, see Filters and rasterization.

Apply a filter

Do one of the following:

- Drag a filter from the Library stack to a layer or group in the Layers list, Timeline, or Canvas.

- Select a layer or group in the Layers list, Timeline, or Canvas, then select a filter from the Library stack and click Apply in the preview area.

- Select a layer or group in the Layers list, Timeline, or Canvas, then click the Add Filter pop-up menu in the toolbar and choose a category and filter type.

The filter is applied to an image layer or to a group.

Note: Although you can apply a filter from the Library to another effects object in the Layers list (a behavior or another filter), the filter affects the parent image layer (or all layers in a group, if the filter was applied to a group), not the effects object.
Apply multiple filters to a layer

When you apply multiple filters to a layer, they have a cumulative effect. In the Layers list and Timeline, multiple filters appear nested under the layer or group they’re applied to.

Do one of the following:

- Select an image layer or group in the Layers list, Timeline, or Canvas; select multiple filters in the Library; then click Apply.

  **Tip:** Shift-click to select multiple contiguous filters. Command-click to select multiple noncontiguous filters.

- Select multiple filters in the Library, then drag them onto an image layer or group in the Layers list, Timeline, or Canvas.

The filters are applied to the image layer in the order they’re selected. For example, if you select Echo, Brightness, and Bevel, in that order, then apply them to a layer, their stacking order in the Layers list is Bevel above Brightness above Echo. The stacking order of filters determines the result of the composite effect.
In the Layers list or Timeline, select a filter that’s been applied to a layer or group, then do one of the following:

- Choose Edit > Delete (or press Delete).
- Choose Edit > Cut (or press Command-X).
- Control-click the filter and choose Cut or Delete from the shortcut menu.

The filter is removed from the project.

Remove a filter from the Filters Inspector

Select a filter in the Filters Inspector and do one of the following:

- Choose Edit > Delete (or press Delete).
- Choose Edit > Cut (or press Command-X).

Apply a filter to a cropped image

In Motion, cropping is always applied after a filter is applied. To apply a crop before a filter, do one of the following:

- Select an image or video clip in the Media list (in the Project pane), crop the image using the Crop sliders in the Media Inspector, then apply the filter to the layer in the Layers list.
- In the Layers list, select the cropped layer, choose Object >
Group (or press Shift-Command-G), then apply the filter to the layer.

For more information about cropping, see Crop a layer.

SEE ALSO
Adjust filters overview

Adjust filters

Adjust filters overview

After you apply a filter to a layer or group, the filter is represented in the following places in the Motion project window, allowing you to make adjustments:

- In the Filters Inspector, where you can turn the filter’s effect on or off, select and delete the filter, and adjust its parameters using sliders and other controls. See Adjust filters in the Inspector or HUD. For a list of parameter controls available for each filter type, see Filter types overview.
In the Canvas, where you can manipulate the filter’s onscreen controls (where available). See Adjust filters using onscreen controls.

In the Layers list and Timeline layers list, underneath the layer or group the filter was applied to, where you can select the filter, turn its effect on or off, reorder it, or lock it to prevent modification. See Layers list overview.

In the Timeline track area, as a purple bar underneath the blue bar of the layer or group it was applied to, where you can select the filter and modify its timing by slipping or trimming the bar. See Edit in the Timeline track area.

In the HUD, where you can adjust many filter parameters using sliders and other controls. See Adjust filters in the Inspector or HUD.

Adjust filters in the Inspector or HUD

The easiest way to modify an applied filter is to adjust its
parameter controls in the Filters Inspector or HUD.

---

**Adjust a filter in the Filters Inspector**

1. Select an applied filter in the Layers list or Timeline.

2. Open the Inspector, then click Filters.

   The Filters Inspector appears, showing parameter controls for the currently selected filter (and for any other filters applied to the parent layer or group).

3. Adjust the parameter controls to modify the filter.

   For a complete list of parameter controls in each filter, see [Filter types overview](#).

---

**Adjust a filter in the HUD**

1. Select a filter in the Layers list or Timeline.

2. Press F7 to open the HUD.

   The HUD appears, containing a subset of parameter controls for the currently selected filter. (To access all of a filter’s parameter controls, use the Filters Inspector.)

3. Adjust the parameter controls to modify the filter.

   For a complete list of parameter controls in each filter, see [Filter types overview](#).
Adjust filters using onscreen controls

Many filters have onscreen controls that let you manipulate parameters visually, by dragging in the Canvas.

Adjust a filter’s onscreen controls

1. Select an applied filter in the Layers list or Timeline.

2. In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Adjust Item tool.

Onscreen controls for the selected filter appear in the Canvas.
3. Drag the onscreen controls in the Canvas.

When you modify a filter parameter in the Canvas, the parameter values are updated in the Inspector, as well. For information about types of onscreen filter controls, see Types of onscreen controls.

**Note:** Many filter onscreen controls adjust multiple parameters. To modify one parameter at a time, use the Filters Inspector or HUD.

### Types of onscreen controls

Several onscreen controls are common to many filters. Other onscreen controls are unique to specific filters. The following list provides examples of the types of controls available. If you’re unsure of an onscreen control’s function, drag it in the Canvas while viewing the Filters Inspector to see which parameter value changes.

- **Center:** The most common filter onscreen control. Drag in the center of the circle to reposition the filter’s Center parameter (the center of the effect).
- **Amount**: An onscreen control with different representations, depending on the filter. In the Zoom Blur filter, drag the small circular handle (above the Center onscreen control) to adjust the Amount parameter.
In the Prism filter, drag the arrow handle inward or outward to adjust the Amount parameter. (Dragging the arrow in an arc adjusts the Angle parameter.)

- **Angle**: An onscreen control with different representations, depending on the filter. In the Page Curl Filter, drag the circular middle handle to adjust the Angle parameter. In the Kaleidotile filter, drag a corner handle to adjust the Angle parameter.
- *Rotate/Rotation/Twirl:* An onscreen control with different representations, depending on the filter. In the Page Curl Filter, drag the outer arrow handle to adjust the Rotation parameter. In the Scrape, Stripes, and Target filters, drag the small outer handle to adjust the Rotation parameter.
• **Radius/Thickness/Size/Falloff:** An onscreen control with different representations, depending on the filter. In the Disc Warp and Circle Blur filters, drag the large ring inward and outward to adjust the Radius parameter. In the Droplet and Ring Lens filters, drag the inner ring to adjust the Radius and Thickness parameters simultaneously. Drag in the area between the inner and outer rings to adjust the Radius parameter. Drag the outer ring to adjust the Thickness parameter.
In the Vignette filter, drag the inner ring to adjust the Size parameter, and drag the outer ring to adjust the Falloff parameter. Drag in the area between the inner and outer ring to adjust both parameters simultaneously.

- **Segment Angle/Offset Angle**: An onscreen control with multiple representations, depending on the filter. In the Kaleidoscope filter, drag the outer handle to adjust the Segment Angle parameter. Drag the middle handle (between the center and outer handle) to adjust the Offset Angle parameter.
Animate filter controls

Animate filter parameters using keyframes

Although several Motion filters are animated (Bad Film, Bad TV, and Overdrive, for example), most are not. However, it’s easy to create filter animations by using keyframes to change parameters over time.

Animate filter parameters using the Record button
1. Select an applied filter in the Layers list, Timeline, or Canvas.

2. Click the Record button (or press A) to enable keyframe recording.

3. Move the playhead to the frame where you want to add a keyframe.

4. In the Filters Inspector or HUD, change one or more parameters to a new value.

   A keyframe is added when you modify a parameter value.

5. Go to the next frame where you want a keyframe.

6. Repeat steps 4–5 until you finish.

7. Click the Record button again to turn off keyframe recording.

Click the Play button (or press the Space bar) to see the results.

---

**Animate filter parameters using the Record button and onscreen controls**

1. Select an applied filter in the Layers list, Timeline, or Canvas.

   If the filter has an onscreen control, the Adjust Item tool is selected and the onscreen controls appear in the Inspector.

2. Click the Record button (or press A) to enable recording.

3. Move the playhead to the frame where you want to add a
In the Canvas, drag the onscreen control.

A keyframe is added when you modify a parameter value using the onscreen control.

Go to the next frame where you want a keyframe.

Repeat steps 4–5 until you finish.

Click the Record button again to turn off keyframe recording.

Click the Play button (or press the Space bar) to see the results.

**Animate filter parameters using the Add Keyframe button or the Animation menu**

1. Select an applied filter in the Layers list, Timeline, or Canvas.

2. Move the playhead to the frame where you want to add a keyframe.

3. In the Filters Inspector, do one of the following:
   - Position the pointer over the right side of the row of the parameter to animate. When the Add Keyframe button (a plus sign in a gray diamond) appears, click it.
   - Position the pointer over the right side of the parameter row, click the downward arrow to open the Animation popup menu, then choose Add.
• Control-click the parameter name, then choose Add from the shortcut menu.

A keyframe is added at the current frame.

4. In the Inspector or HUD, or via the onscreen controls (if available), adjust the parameter value.

5. Go to the next frame where you want a keyframe.

6. Repeat steps 4–5 until you finish.

Click the Play button (or press the Space bar) to see the results.
For more detail on using the Animation menu to add keyframes, see Animation menu.

Animate filters using behaviors

Animating filter parameters is easy using Parameter behaviors, a special class of behaviors that animate a single parameter of an object. For example, if you have a layer with an applied Circle Blur filter, you can use a Parameter behavior to randomize the amount of blur applied to the object over time.

Animate a filter parameter using a Parameter behavior

1. In the Layers list, Timeline, or Canvas, select an applied filter.

2. In the Filters Inspector, do one of the following:
   - Place the pointer over the right side of a parameter row until the Animation pop-up menu appears (a downward arrow), then click the menu, choose Add Parameter Behavior, and choose a behavior from the submenu.
Control-click a parameter name, choose Add Parameter Behavior from the shortcut menu, then choose a behavior from the submenu.

A behavior icon (a gear) appears in the parameter row, and the Behaviors Inspector opens.

3. In the Behaviors Inspector, adjust the parameters of the newly applied Parameter behavior.

Click the Play button (or press the Space bar) to see the results.

SEE ALSO
Filter types overview

There are 11 filter types in Motion:

- **Blur filters** create design effects or simulate the real-world blurring that occurs due to the depth of field in photographed material.
- **Border filters** frame layers in a composition in various ways.
- **Color Correction filters** create design effects or fix a problem with contrast, color, gamma, or brightness.
- **Distortion filters** change the shape of layers—warping, twisting, and pulling them in different directions.
- **Glow filters** combine blur with brightness and color effects.
- **Keying filters** isolate a foreground image from a uniform background color (a green screen, for example) for special effects compositing.
- **Sharpen filters** sharpen images by creating a high-contrast overlay that emphasizes edges in the image.
- **Stylize filters** simulate different media, such as film, television, or print.
- **Tiling filters** create geometric patterns using shapes that are arranged into mosaics.
- **Time filters** manipulate video clips temporally.
- Time filters manipulate video clips temporally.
- Video filters are utilitarian in nature, and can help prepare a project for broadcast output.

For detailed information about each filter and its parameter controls, click the links in the list above.

### Blur filters

#### Blur filters overview

Use Blur filters to simulate the real-world blurring that occurs due to the depth of field in photographed material, or to create designed effects.

There are 12 Blur filters:

- **Channel Blur** gives you control over blurring each color channel of an object.
- **Circle Blur** creates a circular blur within an image.
- **Compound Blur** blurs an object using the specified channel of a designated map image.
- **Defocus** mimics the out-of-focus effect that occurs through a real-world camera lens.
- **Directional Blur** blurs an object along a specific angle, to create a blurred streaking effect.
- **Gaussian Blur** creates a soft blur effect.
- **Gradient Blur** creates a graduated blur between two points.
- **Prism** blurs and refracts the image as if seen through a prism.
- Prism blurs and refracts the image as if seen through a prism, creating a rainbow effect.
- **Radial Blur** creates a rotational blur centered on a point.
- **Soft Focus** duplicates and blurs an image.
- **Variable Blur** creates a tunnel focus effect with a blur applied inside or outside a circular region.
- **Zoom Blur** creates a blur that simulates a fast camera zoom-in to a point.

**Channel Blur**

Lets you apply a blur effect selectively to each color channel of a layer: red, green, blue, and alpha. Create custom glow effects that retain sharpness in selected channels while softening other channels.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the blur.
- **Blur Red**: Sets the blur to affect the red channel.
- **Blur Green**: Sets the blur to affect the green channel.
- **Blur Green:** Sets the blur to affect the green channel.
- **Blur Blue:** Sets the blur to affect the blue channel.
- **Blur Alpha:** Sets the blur to affect the alpha channel.
- **Horizontal:** Sets the percentage of maximum horizontal blur. This is a percentage of the Amount parameter.
- **Vertical:** Sets the percentage of maximum vertical blur.
- **Crop:** Sets whether the image is cropped beyond its original borders.
- **Mix:** Sets the percentage of the original image to be blended with the blurred image.

### Circle Blur

Creates a circular blur within an image. A center point sets the center of the blur effect, and a radius value sets the size of the affected region. You can also customize the amount of blur in the affected area.

Use Circle Blur to blur a limited area in an image. For more sophisticated control of the image region to be blurred, use the **Compound Blur filter**.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center:** Sets the position of the center of the blur effect. You can also drag the Center onscreen control in the Canvas.
- **Amount:** Sets the amount of the blur.
- **Radius:** Sets the radius of the circle defining the blurred area. You can also drag the onscreen controls in the Canvas.
- **Crop:** Sets whether the image is cropped beyond its original borders.
- **Mix:** Sets the percentage at which the original image is blended with the blurred image.
- **Publish OSC:** Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Compound Blur**

Blurs an object using the specified channel of a designated image used as a map image. Use a shape, text layer, still image, or movie file as the map image, then designate the red, green, blue, alpha, or luminance channel to create the shape of the blur.

**Tip:** Use this filter to blur specific sections of an image. For example, trace the subject of the image to blur with a Bezier or B-spline shape, then assign this shape as the Blur Map image. Use its Luminance or Alpha channel to define the blurred area, then disable the original shape layer in the Layers list to hide the source of the blur. For more information, see Edit shape fill, outline, and feathering.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the blur.
- **Blur Map**: An image well to set the map image. Drag a layer (an image, shape, text object, and so on) from the Layers list into the well.

**Note**: You can also apply or replace the blur map by dragging the source layer onto the filter in the Layers list.

- **Map Channel**: Sets the channel to be blurred: red, green, blue, alpha, or luminance.
- **Invert Map**: Sets whether the blur map is inverted.
- **Stretch Map**: Stretches (or compresses) the map image so it exactly overlaps the image the filter is applied to.
- **Horizontal**: Sets the percentage of maximum horizontal blur.
- **Vertical**: Sets the percentage of maximum vertical blur.
- **Mix**: Sets the percentage of the original image to be blended with the blurred image.

**Defocus**

Simulates the out-of-focus effect that occurs through a real-world
camera lens. The Defocus filter blurs an image while creating realistic lens artifacts that mimic the aperture shape in a camera in brighter areas of the image. You can customize the shape of the blur.

**Tip:** Use this filter when you’re trying to blur an image to match video or stills shot with a camera. For example, if you key a woman standing in front of a blue screen, and you intend to place a background image behind her to make it look like she’s standing in a valley with mountains in the background, use the Defocus filter instead of a Gaussian Blur filter to create a realistic depth-of-field effect for the mountains in the distance.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount:** Sets the radius of the defocus effect.
- **Gain:** Sets the amount of gain applied to the high-luminance areas.
- **Shape:** Sets the shape of the lens aperture to Circle or Polygon.
- **Sides:** Sets the number of sides of the lens aperture, if Shape is set to Polygon.
Sides: Sets the number of sides of the lens aperture, if Shape is set to Polygon.

- **Rotation**: Sets the angle of rotation of the polygonal lens aperture, if Shape is set to Polygon.

- **Aspect Ratio**: Sets the aspect ratio of the lens aperture.

- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the blurred image.

---

### Directional Blur

Blurs an object along a specific angle, to create a blurred streaking effect.

**Note:** The more filters you use in a project, the more you impact the performance of Motion.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the blur. You can also drag the arrow onscreen control in the Canvas to adjust the amount
Gaussian Blur

Creates a soft blur effect. The Gaussian blur is the softest blur effect you can apply and is a frequently used blur effect. By default, this filter affects the image uniformly, although you can control the amount of horizontal and vertical blur independently.

Gaussian Blur is relevant for most motion graphics tasks. You can animate it to create focus-control effects. However, to more accurately simulate camera focus, use the Defocus filter.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the blur.
- **Horizontal**: Sets the percentage of the Amount parameter applied in the horizontal direction.
- **Vertical**: Sets the percentage of the Amount parameter applied in the vertical direction.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended with the blurred image.

**Gradient Blur**

Creates a graduated blur between two points.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Point 1**: Sets the position of the start point of the gradient. You can also drag the Point 1 onscreen control (the lower-left point) in the Canvas.

- **Point 2**: Sets the position of the end point of the gradient. You can also drag the Point 2 onscreen control (the upper-right point) in the Canvas.

- **Amount**: Sets the radius of the blur.

- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the blurred image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).
Blurs and refracts the image as if seen through a prism, creating a rainbow effect.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the blur. Drag the arrow onscreen control in the Canvas inward and outward to adjust the amount (and angle) of the blur.

- **Angle**: Sets the angle of refraction. Drag the arrow onscreen control in the Canvas in an arc to adjust the angle of the blur.

- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the blurred and refracted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.
Creates a rotational blur centered on a point. The effect is similar to the motion blur you would see if an image were spinning quickly.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the radial blur. Drag the Center onscreen control in the Canvas to change the center position.

- **Angle**: Sets the angle of rotation of the blur.

- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the blurred image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.
Soft Focus

Creates an effect similar to duplicating an object, applying the Screen blend mode to composite the object against itself, then blurring an overlapping layer—within a single filter. The Strength parameter controls how much of the blurred image is added back to the original image.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the blur.
- **Strength**: Sets the amount of opacity of the blurred composite.
- **Horizontal**: Sets the percentage of the maximum horizontal blur.
- **Vertical**: Sets the percentage of the maximum vertical blur.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended with the blurred image.
Variable Blur

Creates a tunnel focus effect with a blur applied inside or outside a circular region. If the inner radius of the circle is larger than the outer radius of the circle, the blur is applied inside the circle.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the circle. Drag the center onscreen control in the Canvas to adjust the center position.
- **Amount**: Sets the percentage of the blur.
- **Inner Radius**: Sets the inner radius of the circle.
- **Outer Radius**: Sets the outer radius of the circle.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended with the blurred image.
- **Publish OSC**: Publishes the filter’s onscreen controls in
Zoom Blur

Creates a blur that simulates a fast camera zoom-in to a point.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Look**: Sets the type of blur operation. This pop-up menu has two options:
  - **Variable**: The blur increases toward the edges of the image. This option is faster when using high blur values.
  - **Uniform**: The blur is consistent from the center of the image outward.

- **Amount**: Sets the radius of the blur. Drag the small circle (above the Center onscreen control) in the Canvas to adjust the blur amount.

- **Swirl**: Sets the quantity and direction of the swirl. Positive and negative values affect the direction of the swirl.

- **Center**: Sets the position of the center of the blur. Drag the center to adjust its position.
Border filters

Border filters overview

Border filters allow you to frame layers in a composition in various ways.

There are three Border filters:

- **Bevel** creates a beveled border around the edges of an image.
- **Simple Border** creates a solid color border of variable width around the edges of an image.
- **Widescreen** “letterboxes” an object by horizontally masking its top and bottom.

Bevel
Creates a beveled border around the edges of an image by superimposing an angled frame over the original image. You can adjust the simulated direction of reflected light and the opacity of the bevel to vary the effect.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Light Angle**: Sets the angle at which the light hits the bevel.
- **Bevel Width**: Sets the width of the bevel as a percentage of the area of the layer.
- **Opacity**: Sets the opacity of the bevel, ranging from 0 (invisible) to 1.0 (opaque).
- **Light Color**: Picks the color of the light hitting the bevel border. Expand the color controls to adjust individual Red, Green, and Blue sliders, to more precisely select colors.
- **Mix**: Sets the percentage of the original image to be blended with the beveled image.

**Simple Border**
Creates a solid color border of variable width around the edges of an image.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Width**: Sets the thickness of the border.
- **Color**: Picks the color of the border. Expand the color controls to adjust individual Red, Green, and Blue sliders, to more precisely set the color of the border.
- **Border Placement**: Sets where the border is drawn on the image. This pop-up menu has three options:
  - **Inside**: Places the border along the inner edge of the image.
  - **Overlap**: Centers the border over the inner and outer edges of the image.
  - **Outside**: Draws the border along the outer edge of the image.
- **Mix**: Sets the percentage of the original image to be blended with the bordered image.
Widescreen

“Letterboxes” an object by masking it horizontally at the top and bottom to simulate different video and film aspect ratios. Because the image is masked, the layer beneath it in the composition (or the background color of the project) appears in the border space above and below the image. You can add a border to the masked image and customize the color and size of the border.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Aspect Ratio:** Sets the aspect ratio of the mask. Values include 1.66:1, 1.70:1, 1.78:1, 1.85:1, 2.35:1, 2.55:1, and 3.00:1.
- **Offset:** Sets the position of the mask relative to the Y center of the layer. Values range from –1.0 (the bottom of the layer) to 0 (the center of the layer) to 1.0 (the top of the layer).
- **Border Size:** Sets the thickness of the border.

**Note:** The border has no effect on the aspect ratio mask. The Border Size control merely adds a frame at the top and bottom edges of the filtered image.
• **Border Color:** Picks the color of the border. Color controls can be expanded with the disclosure triangle to include Red, Green, Blue, and Opacity sliders to more precisely select the color of the border.

• **Mix:** Sets the percentage of the original image to be blended with the letterboxed image.

## Color Correction filters

### Color Correction filters overview

The filters in the Color Correction category can be used in a number of ways. For example, you can set a mood by making an image sepia-colored. In addition, these filters can fix a problem with contrast, color, gamma, or brightness.

There are 17 Color Correction filters:

• **Brightness** boosts or lowers the uniform brightness of an image.

• **Channel Mixer** allows cross-mixing of red, green, blue, and alpha channels into one another.

• **Color Balance** adjusts the relative balance of all three color channels of an image, allowing two images to be color-matched, for example.

• **Color Reduce** reduces the full range of color in an image to two, three, or four colors.

• **Colorize** substitutes the blacks and whites in an image with colors you select.

• **Contrast** adjusts the difference between the lightest and darkest areas of the image.
- **Contrast** adjusts the difference between the lightest and darkest parts of an image.
- **Gamma** adjusts the relative distribution of brightness in the midtones of an image.
- **Gradient Colorize** uses each pixel’s color value to determine the application of a color value from a gradient.
- **Hue/Saturation** adjusts the hue, saturation, and value levels in an image.
- **Levels** remaps the white and black points of an image.
- **Negative** inverts color and brightness in an image.
- **OpenEXR Tone Map** applies tone mapping to an OpenEXR image.
- **Sepia** tints an image with a sepia tone.
- **Threshold** reduces all colors in an image to a duotone.
- **Tint** tints an image with a single color.
- **YIQ Adjust** allows color adjustment in YIQ color space.
- **YUV Adjust** allows color adjustment in YUV (Y’CbCr) color space.

### Brightness

Boosts or lowers the uniform brightness of an image by a specified amount.

Although this may seem to be the first filter to use for correcting for improper exposure in an image, Brightness boosts or lowers everything in an image at once. This means that raising the
brightness in an image raises brightness everywhere, including in the shadows. Consequently, a brightened image may look washed out.

However, this filter is useful for modifying the edges and effects of shapes, masks, particle systems, and generators.

A better filter for exposure correction is the **Gamma** filter.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Brightness**: Sets the multiplying brightness value applied to the image.
- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

**Channel Mixer**

Cross-mixes the red, green, blue, and alpha channels into one another. The Channel Mixer filter’s main parameters are divided into four sections—Red Output, Green Output, Blue Output, and Alpha Output—each of which manipulates an individual channel.
In each section, you can adjust the value of the relevant color channel added to or subtracted from the red, green, blue, and alpha channels.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Red - Red**: Sets the amount of input red added to the output red. The default value is 1.0, which leaves the red channel unmodified. As this value increases, the output value of red increases by the amount of input red multiplied by the value of Red - Red.

- **Red - Green**: Sets the amount of input green added to the output red. The default value is 0, which leaves the red channel unmodified. As this value increases, the output value of red increases by the amount of input green multiplied by the value of Red - Green.

- **Red - Blue**: Sets the amount of input blue added to the output red. The default value is 0, which leaves the red channel unmodified. As this value increases, the output value of red increases by the amount of input blue multiplied by the value of Red - Blue.

- **Red - Alpha**: Sets the amount of input alpha added to the red channel. The default value is 0, which leaves the red channel unmodified. As this value increases, the value of red increases by the amount of input alpha multiplied by the value of Red - Alpha.

- **Green - Red**: Sets the amount of input red added to the output green. The default value is 0, which leaves the green channel unmodified. As this value increases, the output value of green increases by the amount of input red multiplied by
the value of Green - Red.

- **Green - Green**: Sets the amount of input green added to the output green. The default value is 1.0, which leaves the green channel unmodified. As this value increases, the output value of green increases by the amount of input green multiplied by the value of Green - Green.

- **Green - Blue**: Sets the amount of input blue added to the output green. The default value is 0, which leaves the green channel unmodified. As this value increases, the output value of green increases by the amount of input blue multiplied by the value of Green - Blue.

- **Green - Alpha**: Sets the amount of input alpha added to the green channel. The default value is 0, which leaves the green channel unmodified. As this value increases, the value of green increases by the amount of input alpha multiplied by the value of Green - Alpha.

- **Blue - Red**: Sets the amount of input red added to the output blue. The default value is 0, which leaves the blue channel unmodified. As this value increases, the output value of blue increases by the amount of input red multiplied by the value of Blue - Red.

- **Blue - Green**: Sets the amount of input green added to the output blue. The default value is 0, which leaves the blue channel unmodified. As this value increases, the output value of blue increases by the amount of input green multiplied by the value of Blue - Green.

- **Blue - Blue**: Sets the amount of input blue added to the output blue. The default value is 1.0, which leaves the blue channel unmodified. As this value increases, the output value of blue
increases by the amount of input blue multiplied by the value of Blue - Blue.

- **Blue - Alpha**: Sets the amount of input alpha added to the blue channel. The default value is 0, which leaves the blue channel unmodified. As this value increases, the value of blue increases by the amount of input alpha multiplied by the value of Blue - Alpha.

- **Alpha - Red**: Sets the amount of input red added to the output alpha. The default value is 0, which leaves the alpha channel unmodified. As this value increases, the output value of pixels with nontransparent alpha increases by the amount of input red multiplied by the value of Alpha - Red.

- **Alpha - Green**: Sets the amount of input green added to the output alpha. The default value is 0, which leaves the alpha channel unmodified. As this value increases, the output value of pixels with nontransparent alpha increases by the amount of input green multiplied by the value of Alpha - Green.

- **Alpha - Blue**: Sets the amount of input blue added to the output alpha. The default value is 0, which leaves the alpha channel unmodified. As this value increases, the output value of pixels with nontransparent alpha increases by the amount of input blue multiplied by the value of Alpha - Blue.

- **Alpha - Alpha**: Sets the amount of input alpha added to the output alpha channel. The default value is 1.0, which leaves the alpha channel unmodified. As this value increases, more alpha is added to the pixels in the alpha channel. Values above 1 have no effect, unless the alpha is eroded by negative values in other alpha parameters.

- **Monochrome**: Sets the filter to monochrome mode. In
monochrome mode, all three color channels are affected by the Red controls.

- **Allow Mono > 1:** Allows monochromatic color channels to be set to values greater than 1. By default, this checkbox is selected. Color values are normally between 0 and 1, but can go over 1 or below 0 because the project’s bit depth is set to 16 bits per channel. If this checkbox is deselected, each Red color output control is linked. Moving any of them causes the others to adjust so the total value remains at 1.0. The filter must be in monochrome mode for this parameter to be active.

- **Include Alpha:** Sets whether to include the alpha channel in the mono calculation. The filter must be in monochrome mode for this parameter to be active.

- **Mix:** Sets the percentage of the original image to be blended with the color-corrected image.

**Color Balance**

Color balance refers to the relative strength of the red, green, and blue channels that constitute an image. For example, a blue-tinted image has a strong blue channel and weaker green and red channels.

For an example of using the Color Balance filter to match two composited layers, see Example: Use a filter to color-match two composited layers.
The Color Balance filter lets you adjust the relative balance of all three color channels of an image at once—for example, lowering the blue channel and raising the red and green channels to reduce blue tinting and yield an image that appears more orange and warm.

Color balance also relates to color temperature, which describes the quality of light in an image. For example, sunlight is generally more bluish than tungsten light, which is more orange. In professional film and video productions, white-balancing the camera before shooting usually ensures that whites in an image are neutral (with all three color channels balanced evenly). However, film stocks, optical filters, and digital white-balance settings can modify the tint of an image.

**Note:** The imbalanced color channels caused by a dominant
color temperature in the lighting of an image is often referred to as a color cast.

You can use the Color Balance filter to adjust the three color channels of an image to eliminate a color cast or introduce one. Here are some uses for the Color Balance filter:

- **Correct problems in lighting:** For example, you can rebalance an image that’s too orange to appear more neutral.

- **Match two images to one another:** For example, you can match the quality of light on an actor in a foreground green screen clip to the lighting in a background image.

- **Stylize the color of an image used in a creative composition:** For example, you can create a high-contrast, blue-tinted silhouette from the image of two actors dancing for a title sequence.

The Color Balance filter doesn’t just let you rebalance the overall strength of an image’s three color channels, it also lets you rebalance color specifically in three tonal zones of an image: shadows, midtones, and highlights. Three correspondingly named color controls let you make color balance adjustments in each zone of image tonality.

To make an adjustment to a zone, click the corresponding color well to open the Mac OS Colors window, then drag in the color
wheel. As you drag, the image updates. Dragging in a specific hue’s direction rebalances the image, tinting it with that hue. The farther toward the edge of the color wheel you drag, the more intensely you tint the image.

Tip: You can use any controls in the OS X Colors window to make color adjustments, including sliders, web-safe colors, and the magnifying glass picker. Further, you can save frequently used tints by dragging a color from the color bar at the top to an empty white swatch below. Clicking a filled swatch selects that color.

The adjustments to shadows, midtones, and highlights of an image overlap widely. For example, adjustments to shadows affect the darkest parts of the image the most, but the effect also influences midtones and lower highlights. This overlap ensures that adjustments you make blend seamlessly with the original colors of the image.

Note: Although you can make small contrast adjustments using the vertical lightness slider in the color wheel pane of the Colors window, it’s better to use a Contrast filter or a Levels filter to make
Adjustments to the overall lightness and darkness of an image.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Shadows**: Adjusts color channels in the darkest regions of the image. Click the color well to open the Colors window, then adjust the color balance of the darkest portion of the image. An eyedropper lets you sample any color in the Canvas to use for balancing the image. You can also click the disclosure triangle to reveal individual red, green, and blue channel sliders, with a numeric range from 0 (no color) to 0.5 (unaltered color) to 1.0 (maximum color).

- **Midtones**: Adjusts color channels in midtone regions of the image. Click the color well to open the Colors window, then adjust the color balance of the range of color falling between shadows and highlights. An eyedropper lets you sample any color in the Canvas to use for balancing the image. You can also click the disclosure triangle to reveal red, green, and blue channel sliders with a numeric range from 0 (no color) to 0.5 (unaltered color) to 1.0 (maximum color).

- **Highlights**: Adjusts color channels in the lightest regions of the image. Click the color well to open the Colors window, then adjust the color balance of the brightest portion of the image. An eyedropper lets you sample any color in the Canvas to use for balancing the image. You can also click the disclosure triangle to reveal red, green, and blue channel slider with a numeric range from 0 (no color) to 0.5 (unaltered color) to 1.0 (maximum color).

- **Boost**: Multiplies the values set in the Shadows, Midtones, and Highlights parameters. This is useful when using Color Balance
for exposure balancing, allowing you to “blow out” an image. A boost applied to strong colors may yield unexpected results.

- **Clip Color Values**: Turns clipping on and off. Clipping prevents color adjustments from forcing color values out of the allowable digital range. Clipping can prevent illegal signal levels in clips that are output to video. There are four menu options:
  - **None**: No clipping occurs.
  - **At White**: Any color channel exceeding the maximum value of 1 is clipped to 1.
  - **At Black**: Any color channel falling below the minimum value of 0 is clipped to 0.
  - **At Black and White**: All color channels are clipped to a minimum of 0 and a maximum of 1.
  - **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

**Color Reduce**

Reduces the full range of color in an image to two, three, or four colors that you select. Depending on the number of substitute colors you choose in the Reduce To parameter, this filter breaks down the full range of colors in the image into a color range for each Match Color parameter that’s available. The filter then substitutes the selected Replace With color for each interpreted range of color.

If two colors are selected, color information in the layer is reduced to the selected two colors; if three colors are selected, color
information is reduced to three colors; and so on.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Smoothness**: Sets the smoothness of the transitions between reduced areas. Values range from 0 (hard edges) to 1 (smooth blending).

- **Reduce To**: Selects the number of colors in the reduced layer. Choices are 4 Colors, 3 Colors, or 2 Colors.

- **Match Color 1**: Picks the color of the first selection color for reduction. The color controls can be expanded with the disclosure triangle to reveal Red, Green, and Blue sliders for more precise color selection.

- **Replace With**: Picks the color that’s substituted for the selection determined by Color 1.

- **Match Color 2**: Picks the color of the second selection color for reduction.

- **Replace With**: Picks the color that’s substituted for the selection determined by Color 2.

- **Match Color 3**: Picks the color of the third selection color for reduction.
**Match Color 3:** Picks the color of the third selection color for reduction. This parameter is used only if Reduce To is set to 3 Colors or 4 Colors.

**Replace With:** Picks the color that’s substituted for the selection determined by Color 3. This parameter is used only if Reduce To is set to 3 Colors or 4 Colors.

**Match Color 4:** Picks the color of the fourth selection color for reduction. This parameter is used only if Reduce To is set to 4 Colors.

**Replace With:** Picks the color that’s substituted for the selection determined by Color 4. This parameter is used only if Reduce To is set to 4 Colors.

**Mix:** Sets the percentage of the original image to be blended with the color-corrected image.

---

**Colorize**

Substitutes the blacks and whites in an image with colors you select. All other colors in the image are remapped to a duochrome range that falls between these two colors.

You can create interesting colorized negative effects by mapping a lighter color to the blacks and a darker color to the whites.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Remap Black To**: Sets the color that’s mapped to black. Click the disclosure triangle to reveal individual Red, Green, and Blue sliders to more precisely select the color.

- **Remap White To**: Sets the color that’s mapped to white. Click the disclosure triangle to reveal individual Red, Green, and Blue sliders to more precisely select the color.

- **Intensity**: Sets the strength of the colorization. Values range from 0 (no colorization) to 1.00.

- **Mix**: Sets the percentage at which the original image is blended with the color-corrected image.

**Contrast**

Adjusts the difference between the lightest and darkest parts of an image.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Contrast**: Sets the amount of contrast to be applied to the image.

- **Pivot**: Sets the point around which the contrast is adjusted. The point of contrast adjustment is the level that’s displayed if Contrast is set to 0.

- **Smooth Contrast**: Smooths the falloff on both the low and high ends of the contrast change.

- **Luminance Only**: Select this checkbox to protect the image from oversaturation when its contrast is increased.

- **Clip Color Values**: Turns clipping on and off. Clipping prevents color adjustments from forcing color values out of the allowable digital range. Clipping can prevent illegal signal levels in clips that are output to video. This pop-up menu has four options:
  - **None**: No clipping occurs.
  - **At White**: Any color channel exceeding the maximum value of 1 is clipped to 1.
  - **At Black**: Any color channel falling below the minimum...
- At Black: Any color channel falling below the minimum value of 0 is clipped to 0.
- At Black and White: All color channels are clipped to a minimum of 0 and a maximum of 1.
- Mix: Sets the percentage of the original image to be blended with the color-corrected image.

Gamma

Adjusts the relative distribution of brightness in the midtones of an image, without adjusting the white and black points. The perceived result is to brighten and darken the areas of medium brightness in an image, while leaving the highlights and shadows untouched. This avoids a washed-out effect.

This is one of the most useful filters for correcting poor exposure in images, and should almost always be used first before trying the Brightness filter.

Tip: When opening projects created in earlier versions of Motion, previous gamma adjustments may be lost. Use the Gamma filter to reproduce the effect.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Gamma**: Sets the gamma correction.
- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

**Gradient Colorize**

Uses each pixel’s color value to determine the application of a color value from a gradient.

![Original image](image1.png) ![Gradient Colorize filter applied (using Rainbow gradient)](image2.png)

Adjust this filter using the parameter controls in the Filters Inspector:

- **Gradient**: Selects a gradient preset to be applied to the image. You can also use this control also used to edit a custom gradient.

  For more information on using the Gradient editor, see [Change a gradient’s color and opacity](#).

- **Offset**: Sets an amount, in degrees, that the color wheel is
offset to determine color application. Values start at 0 degrees.

- **Repeats**: Sets the number of times the gradient repeats over the course of its range.

- **Repeat Method**: Sets the method by which the gradient is mapped when repeating. Values can be set to Mirror (default) or Wrap. This parameter affects the filter when Repeats is set to a number greater than 1.

- **Map Channel**: Sets the channel used to determine how the image is colorized. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

---

**Hue/Saturation**

Provides controls to adjust Hue, Saturation, and Value levels in an image. The Hue control is an angular representation of the color values in an image. By rotating the Hue angle, you uniformly remap the colors throughout an image, similar to the effect of turning the hue or phase knob of a broadcast monitor.

The Saturation slider controls the intensity of color in an image, with a high value resulting in vivid color, and a low value resulting in a grayscale image with no color at all. The Value slider adjusts the overall brightness or darkness of all colors in an image, including the blacks and whites in a desaturated image.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Hue**: Sets the angle of adjustment used to set the zero point of the color wheel.
- **Saturation**: Sets the color saturation of the layer, ranging from −1.0 (no color information) to 0.0 (unadjusted color) to 3.0.
- **Value**: Sets the intensity adjustment applied to the layer.
- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

**Levels**

Provides controls to remap the white and black points of an image, with a gamma control to adjust midtones, all at once. A histogram provides an analysis of the image to help you judge the adjustments to make.

A powerful option in this filter is the ability to make independent adjustments to the red, green, blue, and alpha channels of a layer.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Histogram:** Displays an analysis of the layer. By default, the RGB channels are selected. A pop-up menu can be used to select Red, Green, Blue, or Alpha channels for viewing.

Click the disclosure triangles to expose the RGB, Red, Green, Blue, and Opacity parameter groups. Click the group parameter disclosure triangles to display sliders:

- **Black In:** Sets the In point for black, below which values are considered black.
- **Black Out:** Sets the minimum brightness value that appears in the output. Other values are scaled between Black Out and White Out values.
- **White In:** Sets the In point for white, above which values are not output.
- **White Out:** Sets the maximum brightness value that appears in the output. Other values are scaled between Black Out and White Out values.
- **Gamma:** Sets the amount of gamma correction.
- **Mix:** Sets the percentage of the original image to be blended with the color-corrected image.

**Negative**

Inverts color and brightness in an image. This filter can be used to turn a scanned negative image into a positive.
Adjust this filter using the control in the Filters Inspector:

- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

**OpenEXR Tone Map**

Applies tone mapping to an OpenEXR image, reducing the dynamic range of the image so that it can be viewed on your monitor. The Exposure, Defog, Knee Low, and Knee High parameters allow you to control how the pixels in the high-dynamic range image are mapped to a lower dynamic range.

A recommended workflow is to apply the OpenEXR Tone Map filter to the *result* of your composite. In other words, apply the OpenEXR Tone Map filter after you’ve applied other filters to the OpenEXR image or blended the image with other images in your project.

**Note**: An OpenEXR file imported into Motion 5.0.2 or later is maintained as a high-dynamic range image and will appear brighter than in earlier versions of Motion (until you specifically alter the image). Prior to version 5.0.2, Motion forced tone mapping on imported OpenEXR images. In Motion 5.0.2 or later,
when you open an older project containing an OpenEXR image, an OpenEXR Tone Map filter is automatically applied to the image so that the project retains its original appearance.

To maintain the full dynamic range of an image being exported as an OpenEXR file, disable the OpenEXR Tone Map filter prior to exporting.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Exposure**: Lightens or darkens the displayed image, revealing more detail at the low end or high end of the image.
- **Defog**: Attempts to remove “fog” in an image. While recording, stray light in the camera may cause fogging of your image, creating unwanted light.
- **Knee Low**: Sets the low end of the white and middle gray values displayed in the image. Values between Knee Low and Knee High are compressed, allowing you to display a wider range of pixel values without clipping.
- **Knee High**: Sets the high end of the white and middle gray values displayed in the image.
- **Mix**: Sets the percentage of the original image to be blended with the modified image.

**Sepia**

Tints a layer with a sepia tone. The black and white points are remapped to dark and light sepia colors. You can adjust the tinting amount to achieve a subtle mix of the original and tinted colors, or a completely tinted image.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the amount of sepia tone applied to the image.
- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

**Threshold**

Reduces all colors in an image to a duotone, and optionally limits the range of midtones preserved in the image. The result is an extremely high-contrast image that defaults to black and white—but you can reduce the image to any two colors.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Threshold**: Sets the threshold of selection for color substitution. The threshold determines what is considered light and what is considered dark in the image.

- **Smoothness**: Sets the smoothness of transition between the substituted colors.

- **Dark Color**: Sets the color used to represent the dark interpreted areas of the image. Click the disclosure triangle to reveal individual Red, Green, and Blue sliders, for more precise color selection.

- **Light Color**: Sets the color used to represent the light-interpreted areas of the image. Click the disclosure triangle to reveal individual Red, Green, and Blue sliders, for more precise color selection.

- **Correct For Alpha**: Renders semitransparent pixels correctly. Enable this setting if the edges of the filtered image show artifacts.

- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.
Tint

Tints an image with a single color. Shadows and highlights are less affected, but all midrange colors in the image are gradually replaced with the tint color as the Intensity parameter is increased.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Color**: Picks the color used to tint the image. The color controls can be expanded with the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.

- **Intensity**: Sets the amount of tint applied to the image.

- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

YIQ Adjust

Allows color adjustment in YIQ color space. The YIQ color space definition was formerly used to describe an NTSC broadcast.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Y**: Sets the intensity of the Y color channel. (Y represents the luma component/grayscale information.)
- **I**: Sets the phase of the I color channel. (I represents the hue component/chroma information.)
- **Q**: Sets the phase of the Q color channel. (Q represents the saturation component/chroma information.)
- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.

**YUV Adjust**

Allows color adjustment in YUV ($Y' C_B C_R$) color space. The YUV color space definition is used to describe NTSC and PAL broadcast signals.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Y**: Sets the intensity of the Y color channel. (Y represents luma/brightness information.)
- **U**: Sets the phase of the U color channel. (U represents chroma/color information.)
- **V**: Sets the phase of the V color channel. (V represents chroma/color information.)
- **Mix**: Sets the percentage of the original image to be blended with the color-corrected image.
Mix: Sets the percentage of the original image to be blended with the color-corrected image.

Distortion filters

Distortion filters overview

Distortion filters are used to change the shape of layers—warping, twisting, and pulling them in different directions.

There are 27 Distortion filters:

- **Black Hole** distorts an image by causing part of it to disappear into the specified center point, bowing the top, bottom, and sides inward.
- **Bulge** distorts an image as if forced outward by something pushing from behind.
- **Bump Map** uses a source object to define a bump pattern that’s used to displace an image.
- **Disc Warp** stretches the object outward around a circular region.
- **Droplet** simulates the effect of a drop of liquid falling onto the surface of a pool.
- **Earthquake** creates an animated displacement effect on an object.
- **Fisheye** distorts an object as if it were seen through the view of a fisheye lens.
- **Flop** reverses an object horizontally, vertically, or in both directions.
- **Fun House** simulates the distortion caused by an imperfectly shaped mirror, similar to those in a carnival fun house.
- **Glass Block** cuts an object into a series of tiles, creating a duplicated pattern effect.
- **Glass Distortion** simulates the effect of the object being deformed as it shows through a piece of glass.
- **Insect Eye** maps a repeating hexagonal distortion pattern to an image, mimicking the POV of an insect.
- **Mirror** splits an object in half vertically and reverses the remaining half to create a reflection.
- **Page Curl** animates an object as if it is a page peeling away.
- **Poke** distorts an object by bowing the edges inward.
- **Polar** converts images from rectangular coordinates to polar coordinates, and vice versa.
- **Refraction** creates a glass-distortion effect on an image.
- **Ring Lens** creates a ring of distortion over the image, creating a donut-like bulge.
- **Ripple** creates animated ripples over the surface of an object.
- **Scrape** smears an image along an angle.
- **Sphere** simulates the effect of an image wrapped around a sphere.
- **Starburst** radiates solid-colored rays out from the center of your layer.
- **Stripes** turns an image into a series of vertical stripes.
- **Target** draws bands of concentric circles outward from the center.
- **Target** draws bands of concentric circles outward from the center point value.
- **Twirl** twirls an image like a fork twisting a plate of spaghetti.
- **Underwater** applies an animated distortion to an image, simulating a view through water.
- **Wave** distorts an image to simulate waves oscillating across it.

**Black Hole**

Distorts an image by causing part of it to disappear into the specified center point, and by bowing the top, bottom, and sides inward. As the value of the Amount parameter increases, the more the sides bow in, and the more of the image at the center point disappears into it. The **Poke** filter has a similar effect without removing part of the image.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the black hole. You can also drag the Center onscreen control in the Canvas.
- **Amount**: Sets the amount of force pulling on the layer. Default
values range from 0 (no gravity) to 3000 (the entire layer is pulled into the black hole).

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](https://FinalCutProXTemplatesOverview).

### Bulge

Distorts an image as if forced outward by something pushing from behind.

**Original image**  
**Bulge filter applied**

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the bulge. You can also drag the Center onscreen control in the Canvas.

- **Amount**: Sets the amount of the bulge.

- **Scale**: Sets the direction and scale of the bulge. Lower values make the image appear to bulge inwards; higher values make
the image appear to bulge outwards.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

### Bump Map

Uses a source object to define a bump pattern that can be used to deform an image, with parameters to control the amount of displacement. You can use any image, movie, or shape as the source object.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Map Image**: Displays a thumbnail of the map chosen. To add a map image or replace the current one, drag an object (image, shape, text, and so on) into the well.

- **Controls**: Sets the map controls to either of two settings:
Controls: Sets the map controls to either of two settings:

- **Direction and Amount**: Lets you offset the angle and amount of the map protrusion.

- **Horizontal and Vertical Scale**: Lets you offset the map by a single axis (X or Y).

- **Direction**: Sets the angle at which the bump map protrudes when the Controls pop-up menu is set to Direction and Amount.

- **Amount**: Sets how far the bump map protrudes when the Controls pop-up menu is set to Direction and Amount. Positive values push upward; negative values push downward.

- **Horizontal Scale**: Sets horizontal scaling of the map image when the Controls pop-up menu is set to Horizontal and Vertical Scale.

- **Vertical Scale**: Sets the vertical scaling of the map image when the Controls pop-up menu is set to Horizontal and Vertical Scale.

- **Repeat Edges**: Sets whether the edges of the object are repeated.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

**Disc Warp**

Stretches the image outward around a circular region. As the radius of the warping region increases, the image is warped outward with a greater amount of distortion. The color of the resulting disk is determined by the color value of the pixel where
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the disk. You can also drag the Center onscreen control.

- **Radius**: Sets the size of the disk. You can also drag the outer circle of the onscreen controls in the Canvas.

- **Crop**: Sets whether the filtered layer is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

**Droplet**

Simulates the effect of a drop of liquid falling onto the surface of a pool, with the image displaced by concentric ripples. This filter is
not automatically animated, but animating the Thickness parameter of this filter creates the effect of the ripples spreading out from the center.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the droplet effect. You can also drag the Center onscreen control in the Canvas.

- **Radius**: Sets the radius of the droplet effect. You can also drag the inner circle of the onscreen controls in the Canvas. Drag between the inner and outer circles to adjust the Radius and Thickness parameters simultaneously.

- **Thickness**: Sets the width of the rippling waves from the droplet. You can also drag the outer circle of the onscreen controls in the Canvas. Drag between the inner and outer circles to adjust the Thickness and Radius parameters simultaneously.

- **Height**: Sets the height of the droplet ripples.

- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

---

**Earthquake**

Creates an animated displacement effect on an image, adjusting its position as if shaken by an earthquake.

![Original image](#)  ![Earthquake filter applied (using three layers)](#)

Adjust this filter using the parameter controls in the Filters Inspector:

- **Twist**: Sets the amount the image is rotated as it is displaced.

- **Horizontal Shake**: Sets the maximum amount the image is displaced horizontally.

- **Vertical Shake**: Sets the maximum amount the image is displaced vertically.

- **Layers**: Sets the number of copies of the original image that are overlaid. Larger values create a motion-blurred effect.
- **Epicenter**: Sets the position of the center of the earthquake, around which the Twist occurs. You can also drag the center onscreen control in the Canvas.

- **Random Seed**: Sets the value of the random seed used to determine which frames are changed by the filter.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

---

**Fisheye**

Distorts an image as if it were seen through the view of a fisheye lens. The result is an extremely wide-angle warping effect also known as barrel distortion. Use the Fisheye filter with a negative Amount value as an imprecise way to correct for barrel distortion in images shot using a wide-angle lens.

![Original image](original.jpg)  ![Fisheye filter applied](fisheye.jpg)

Adjust this filter using the parameter controls in the Filters Inspector:

- **Radius**: Sets the radius of the fisheye lens effect.
• **Radius:** Sets the radius of the fisheye lens effect.

• **Amount:** Sets the amount and nature of the distortion. Lower values create concave distortion; higher values create convex distortion.

• **Center:** Sets the position of the center of the fisheye effect. Drag the Center onscreen control to adjust its value in the Canvas.

• **Mix:** Sets the percentage of the original image to be blended with the distorted image.

• **Publish OSC:** Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Flop**

Reverses an image horizontally, vertically, or in both directions.

Adjust this filter using the parameter controls in the Filters Inspector:

• **Flop:** Sets the direction in which the image is flopped (Horizontal, Vertical, or Both).
• *Mix:* Sets the percentage of the original image to be blended with the flopped image.

# Fun House

Simulates the distortion caused by an imperfectly shaped mirror, similar to those in a carnival fun house.

Adjust this filter using the parameter controls in the Filters Inspector:

- *Center:* Sets the position of the center of the fun house mirror. You can also drag the Center onscreen control in the Canvas.
- *Width:* Sets the width of the fun house mirror.
- *Amount:* Sets the amount of distortion of the fun house mirror.
- *Angle:* Sets the angle at which the fun house mirror is set.
- *Mix:* Sets the percentage of the original image to be blended with the distorted image.
- *Publish OSC:* Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.
Glass Block

Cuts an object into a series of tiles and offsets a portion of the image in each tile to create a duplicated pattern effect. The number of tiles and the amount that each tile is offset, can be customized.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the origin of the glass block effect. You can also drag the Center onscreen control in the Canvas.
- **Scale**: Sets the scale of the portions of the duplicated parts.
- **Angle**: Sets the angle of offset used to sample the duplicated parts.
- **Tile Size**: Sets the size of the glass blocks.
- **Mix**: Sets the percentage of the original image to be blended with the distorted image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.
Glass Distortion

Simulates an image being deformed as if through a pane of glass. An image well lets you assign an image, movie, or shape to use as the pattern in the glass. Other parameters let you control the scale and amount of distortion.

By default, Glass Distortion behaves as if there were a black image applied to the Distort Input well, which leaves the target layer unchanged.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the tiling of the glass distortion. You can also drag the Center onscreen control in the Canvas.

- **Distort Input**: Displays a thumbnail of the image map chosen.

- **Fit**: Sets the relative scale of the map image.

- **X Scale**: Sets the horizontal scale of the map image (when the Fit checkbox is deselected).

- **Y Scale**: Sets the vertical scale of the map image (when the Fit checkbox is deselected).
Y Scale: Sets the vertical scale of the map image (when the Fit checkbox is deselected).

- **Amount**: Sets the amount of offset.
- **Softness**: Sets how much blur is applied to the map image.
- **Mix**: Sets the percentage of the original image to be blended with the distorted image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

**Insect Eye**

Maps a repeating hexagonal distortion pattern to an image, mimicking the POV of an insect.

![Original image](image1.jpg) ![Insect Eye filter applied](image2.jpg)

Adjust this filter using the parameter controls in the Filters Inspector:

- **Size**: Sets the size of the hexagons, in pixels.
- **Refraction**: Sets the amount of distortion present in each hex.
- **Border Size**: Sets the width, in pixels, of the border of each hex.
- **Border Size**: Sets the width, in pixels, of the border of each hex.

- **Border Color**: Picks the color of the border of the hexagons. Use the disclosure triangle to display Red, Green, and Blue sliders, for more precise color selection.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

### Mirror

Splits an image in half vertically and reverses the remaining half to create a reflection. The center point and angle of the split can be customized. This filter is excellent for recreating the magic of 1980s music videos.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the mirror. You can also drag the Center onscreen control in the Canvas.

- **Angle**: Sets the angle of the mirror’s orientation.

- **Repeat Border Pixels**: Sets the edge pixels to repeat to fill in
Repeat Border Pixels: Sets the edge pixels to repeat to fill in the remainder of the shape when the Center and/or Angle parameters are offset from the center.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

---

**Page Curl**

Animates an image as if it’s a page peeling away from an upper corner of the Canvas.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Direction**: Sets the animation of the page curl to Open or Close.

- **Angle**: Defines the angle of the page turn. Alternatively, use the Angle onscreen control (the small circle between the center circle and arrow) with the Rotate control (the arrow) to...
set the direction of the page turn. For example, at an Angle value of 180 degrees, the page turn begins along the right edge of the image.

- **Rotation:** Defines the rotation of the page turn. Alternatively, use the Rotation onscreen control (the arrow) with the Angle control (the small circle between the center circle and arrow) to set the direction of the page turn. For example, when Angle is set to 180 degrees and Rotation is set to 130 degrees, the page turn begins along the upper-right corner of the image.

- **Radius:** Defines the size of the page curl. The larger the value, the more subtle the curl.

- **Fade Out:** Defines the image’s opacity over the page curl animation. When set to 1, the image remains opaque throughout the animation. When set to 100, the image is transparent by the end of the animation.

- **Shadow:** Controls the darkness of the shadow that appears beneath the curling portion of the image.

- **Highlight Color:** Defines a highlighted color on the back of the page.

- **Back Color:** Defines the color and opacity on the back of the page.

- **Animate:** Turns animation of the page-turn effect on and off.

- **Percent:** Defines the amount of curl in the static image when the Animate checkbox is deselected.

- **Mix:** Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC:** Publishes the filter’s onscreen controls in
Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Poke**

Distorts an image by bowing the top, bottom, and sides inward, and appears to push the image into the Canvas at the specified Center point. As the value of the Amount parameter increases, the more the sides bow in. The **Black Hole** filter has a similar effect but also removes part of the image at the center point.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the poke. You can also drag the Center onscreen control in the Canvas.
- **Radius**: Sets the radius of the poke effect. The higher the value, the smaller the image appears. Scale must be set to greater than 0 for the Radius parameter to have an effect.
- **Scale**: Sets the scale of the distortion.
- **Mix**: Sets the percentage of the original image to be blended with the distorted image.
Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

Polar

Converts images from rectangular coordinates to polar coordinates, and vice versa.

Tip: This filter works well with layers containing horizontal or vertical lines, such as the Stripes or Checkerboard generators. A similar effect can be created with any image by adding the Line Screen or other related filters.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the center point of the distortion from Polar to Rectangular or Rectangular to Polar. You can also drag the Center onscreen control in the Canvas.

- **Polar to Rect**: Applies a Polar-to-Rectangular distortion to the image. When this checkbox is deselected, a Rectangular-to-Polar distortion is applied.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.
Creates a glass-distortion effect on an image, with an optional height map.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Softness**: Sets the amount of softness applied to the refracted edges.
- **Refraction**: Sets the amount that the image is distorted.
- **Height Map**: Displays a thumbnail of the height map chosen. The height map is used to determine the edges along which the image is refracted.
- **Map Channel**: Sets the channel used to determine how the image is refracted. If a height map is present, the channel is selected from the height map; otherwise the channel is selected from the source object. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.
- **Mix**: Sets the percentage of the original image to be blended with the distorted image.
Ring Lens

 Creates a ring of distortion over the image, creating a donut-like bulge.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the lens. You can also drag the Center onscreen control in the Canvas.

- **Radius**: Sets the radius of the ring. Drag the inner circle of the onscreen controls to adjust the Radius value. Drag between the inner and outer circles to adjust the Radius and Thickness parameters simultaneously.

- **Thickness**: Sets the thickness of the ring as a percentage of the radius. Values range from 0 (no thickness) to 1.00 (no hole in the center of the ring lens). Drag the outer circle of the onscreen controls to adjust the Thickness value. Drag between the inner and outer circles to adjust the Thickness and Radius parameters simultaneously.

- **Refraction**: Sets the amount of refraction of the lens.

- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the
filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

### Ripple

Creates animated ripples over the surface of an image. This filter is automatically animated to create an undulating effect on the surface of the affected image. The amplitude can be adjusted to increase or decrease the rippling effect.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the origin of the effect. You can also drag the Center onscreen control in the Canvas.

- **Amplitude**: Sets the width of the waves.

- **Crop**: Sets whether the filtered image is sharply cropped at its edges. Is this the same as the previous bullet point? It might be worth clarifying.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

---

**Scrape**

Smears an image along an angle defined by the Rotation parameter. The Scrape effect starts at the center point, and continues to the edge of the layer.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the scrape. You can also drag the Center onscreen control in the Canvas.

- **Rotation**: Sets the angle of rotation of the scrape. You can also drag the outer handle of the onscreen control in the Canvas.
- **Amount:** Sets the ramping of the number of pixels spread across the range of the scrape. Values range from 0 (very gradual) to 200 (hard edge).

- **Mix:** Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC:** Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

---

**Sphere**

Simulates the effect of an image wrapped around a sphere. This filter can be used to turn an image of a map into an imprecise globe.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center:** Sets the position of the center of the sphere. You can also drag the Center onscreen control in the Canvas.

- **Radius:** Sets the radius of the sphere.

- **Crop:** Sets whether the filtered image is sharply cropped at its edges.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

### Starburst

Radiates solid-colored rays out from the center of an image. The colors are derived from pixel values around the selected center point, with the number of colors used determined by the Radius parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the starburst. You can also drag the Center onscreen control in the Canvas.

- **Radius**: Sets the radius of pixel sampling for ray color
determination.

- **Mix:** Sets the percentage at which the original image is blended with the distorted image.

- *Publish OSC:* Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

## Stripes

Turns an image into a series of vertical stripes. The angle of generated stripes can be changed using the Angle parameter. The stripe colors are derived from pixel values along a line through the center point at the angle specified by the Angle parameter. The distribution of colors is determined by the Offset parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center:** Sets the position of the center of the stripe effect. You can also drag the Center onscreen control in the Canvas.

- **Angle:** Sets the angle of the stripes. You can also drag the outer handle of the onscreen control in the Canvas.
• **Offset**: Sets the angle of pixel sampling used for sampling pixel color values.

• **Mix**: Sets the percentage of the original image to be blended with the striped image.

• **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

---

**Target**

Draws bands of concentric circles outward from the center point value. The target colors are derived from pixel values around the selected center point, with the distribution of colors determined by the Angle parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

• **Center**: Sets the position of the center of the target. You can also drag the Center onscreen control in the Canvas.

• **Angle**: Sets the angle of the line used to select pixels for the bands of circles in the target. You can also drag the outer
handle of the onscreen control in the Canvas.

- **Crop**: Sets whether the image is cropped beyond its original borders.

- **Mix**: Sets the percentage at which the original image is blended with the distorted image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

## Twirl

Twirls an image like a fork twisting a plate of spaghetti. The image appears to stretch from the sides to the center in a spiral. The amount of spiraling is determined by the Twirl parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the twirl. Larger values affect more of the image. Values range from 0 (none of the image is affected) to 1.00 (largest amount of the image is affected). You
can also drag the outer circle of the onscreen controls in the Canvas.

- **Twirl**: Sets the amount of twist. You can also drag the handle of the onscreen control in the Canvas.

- **Center**: Sets the position of the center of the twirl. You can also drag the Center onscreen control in the Canvas.

- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix**: Sets the percentage of the original image to be blended with the twirled image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

### Underwater
Applies an animated distortion to an image, simulating a view through water.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Size**: Sets the size of the ripples in the water. The smaller the number, the more ripples there are in the water simulation.
- **Speed**: Sets the speed at which the distortion is animated.
- **Refraction**: Sets the amount that the image is distorted.
- **Repeat Edges**: Sets whether the edges of the object are repeated.
- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

**Wave**

Distorts an image to simulate waves oscillating across it. The wave filter is not automatically animated, but you can animate the Offset parameter to create an undulating effect.

For information on animating parameters, see [Parameter behaviors overview](#).
Adjust this filter using the parameter controls in the Filters Inspector:

- **Amplitude**: Sets the amplitude of the waves.
- **Wavelength**: Sets the length of the waves.
- **Offset**: Sets the offset of the wave.
- **Vertical**: Sets whether the waves run vertically or horizontally.
- **Repeat Edges**: Sets whether the edges of the image are repeated.
- **Mix**: Sets the percentage of the original image to be blended with the distorted image.

### Glow filters

#### Glow filters overview

Glow filters combine blur with brightness and color effects. The results are automatically recomposited over the original image in various ways. Glows can be used to simulate film effects, as a method to render your footage more abstract, or as accents to make elements in a composition stand out.

There are nine Glow filters:

- **Aura** adds stylized light or dark halos around well-defined areas of an image.
- **Bloom** simulates the effect of extremely overexposed highlights on film.
- **Dazzle** adds glowing star-shaped accents to the highlights in
- **Glint** adds a bloom effect and rays of light to the brightest portions of an image.
- **Gloom** creates a muted, dark glow.
- **Glow** creates a basic glow effect.
- **Light Rays** creates light rays shining through an image from a specified point.
- **Outer Glow** creates glow around the outside of an image.
- **Overdrive** creates an animated glow by compositing numerous glowing tinted duplicates of the original image.

### Aura

Adds highly stylized light or dark halos around well-defined areas of an image. The resulting glow appears solarized, and the underlying image creates outlines that show through the glow effect.

[Original image](#) [Aura filter applied](#)

Adjust this filter using the parameter controls in the Filters Inspector:
- **Inner Radius**: Sets the amount the aura extends inward from its point of origin.
- **Outer Radius**: Sets the amount the aura extends outward from its point of origin.
- **Brightness**: Sets the brightness of the aura.
- **Clip to White**: Any color channel exceeding the maximum value of 1 is clipped to 1.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

**Bloom**

Simulates the effect of extremely overexposed highlights on film. Highlights above a specific threshold are blurred, brightened, and recomposited with the original. Unaffected regions of the image interact with the glow effect, but otherwise retain their detail.

Adjust this filter using the parameter controls in the Filters
Inspector:

- **Amount**: Sets the amount of the bloom.
- **Brightness**: Sets the brightness of the bloom.
- **Threshold**: Sets the luminance threshold at which the bloom starts.
- **Horizontal**: Sets the distance of horizontal bloom.
- **Vertical**: Sets the distance of vertical bloom.
- **Clip to White**: Any color channel exceeding the maximum value of 1 is clipped to 1.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

Dazzle

Adds glowing star-shaped accents to the highlights in an image. You can customize this filter to create effects ranging from subtle highlights to outrageous, colorful flashes of color.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the radius of the spikes from the glow.
- **Angle**: Sets the angle of rotation of the spikes.
- **Brightness**: Sets the amount of brightness of the glow.
- **Threshold**: Sets the luminance threshold of the glow.
- **Spike Count**: Sets the number of spikes coming off of glows.
- **Clip to White**: Any color channel exceeding the maximum value of 1 is clipped to 1.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

**Glint**

Adds a bloom effect and rays of light that are reflected at an angle to the brightest portions of an image. You can adjust the
Glint filter to create effects ranging from subtle glows to intense, multi-spiked flares of color. The Glint filter is especially useful with 3D text—it integrates beautifully with lights and changes based on the surface properties of the 3D text. Combine the Glint filter with lights for realistic-looking lighting and camera movements.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Exposure**: Lightens or darkens the glint highlights.
- **Tint**: Sets the strength of the color specified in the Tint Color parameter.
- **Tint Color**: Sets the color of the glint.
- **Glint Size**: Sets the size of the glint’s spikes.
- **Streaks**: Sets the number of spikes emanating from the glint.
- **Glint Softness**: Sets the amount of softness applied to the glint.
- **Glow Amount**: Sets the brightness multiplier of the glint.
- **Glint Angle**: Sets the angle of the glint streaks.
- **Intensity**: Controls the intensity of the glow effect; a high value brightens the light portions of an image.
- **Color Fringing:** Creates an effect similar to when a camera lens fails to focus colors to the same point. This is also known as *chromatic aberration*.

- **Crop:** Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

- **Mix:** Sets the percentage of the original image to be blended with the filtered image.

---

**Gloom**

Creates a muted, dark glow. The image is darkened, and areas of detail are evened out into larger regions of color. It’s spooky.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Radius:** Sets the radius of the gloom.

- **Amount:** Sets the amount of gloom. Values range from 0 (no gloom) to 2 (maximum gloominess).

- **Mix:** Sets the percentage of the original image to be blended with the filtered image.
Glow

Creates a basic glow effect. Glow is the most basic glow filter in this category, but can be customized to create many effects.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Radius**: Sets the radius of the glow.
- **Opacity**: Sets the opacity of the glow.
- **Threshold**: Sets the luminance threshold at which the glow begins.
- **Softness**: Sets the amount of softness applied to the glow.
- **Clip to White**: Any color channel exceeding the maximum value of 1 is clipped to 1.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

Light Rays

Uses a zoom blur rather than a Gaussian blur to distribute a glow. The resulting effect is that of light rays shining through an object from a specified point.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Amount**: Sets the amount of the light ray effect. Larger values extend the length of the rays.
- **Center**: Sets the position of the center point of the light source. You can also drag the center onscreen in the Canvas.
- **Glow**: Sets the brightness multiplier of the light rays.
- **Expansion**: Sets the distance the light rays extend outside the boundary of the layer.
- **Clip to White**: Any color channel exceeding the maximum value of 1 is clipped to 1.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Outer Glow**

Adds a glow to the alpha channel of an image. The result is a glow
around the outside of the image that leaves the interior unaffected.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Radius**: Sets the size of the glow.
- **Brightness**: Sets the brightness of the glow.
- **Inner Color**: Picks the inner color of the glow. Click the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.
- **Outer Color**: Picks the outer color of the glow.
- **Range**: Sets the gradient position between the glow colors.
- **Horizontal**: Sets the amount of horizontal glow.
- **Vertical**: Sets the amount of vertical glow.
- **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.
- **Mix**: Sets the percentage of the original image to be blended
Overdrive

Creates an animated glow effect by compositing numerous glowing tinted duplicates of the original image. Fine detail is lost, and the highlights of the image are emphasized. You can customize the inner glow and outer glow colors.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Intensity**: Sets the number of samples.
- **Size**: Sets the radius of the effect.
- **Rotation**: Sets the angle of rotation of the collected offsets.
- **Inner Glow**: Picks the color of the inner part of the glow. Click the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.
- **Outer Glow**: Picks the color of the outer part of the glow. Click the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.
- **Clip to White**: Any color channel exceeding the maximum...
• **Clip to White**: Any color channel exceeding the maximum value of 1 is clipped to 1.

• **Crop**: Sets whether the filtered image is sharply cropped at its original boundaries. When this checkbox is deselected, the filter affects the edges of the image.

• **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## Sharpen filters

### Sharpen filters overview

Sharpen filters sharpen images by creating a high contrast overlay that emphasizes edges in the image.

There are two Sharpen filters:

• **Sharpen** sharpens an image.

• **Unsharp Mask** creates an effect similar to Sharpen, but with more control over the amount of sharpening.

## Sharpen

Sharpened an image by enhancing the color contrast around edges in the image.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Intensity**: Sets the radius for the effect.
- **Amount**: Adjusts the contrast for the sharpening.
- **Mix**: Sets the percentage of the original image to be blended with the sharpened image.

**Unsharp Mask**

Creates an effect similar to Sharpen, but provides more options to refine and control the amount of sharpening applied to the image.

Adjust this filter using the parameter controls in the Filters Inspector:
- **Radius**: Sets the amount of the mask’s effect.
- **Amount**: Sets the amount of the multiplier used to sharpen the layer’s edges.
- **Threshold**: Sets the threshold of luminance difference to be considered as a high contrast range, between 0 and 1.
- **Horizontal**: Sets the horizontal width of the unsharp mask.
- **Vertical**: Sets the vertical scale of the unsharp mask.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## Stylize filters

### Stylize filters overview

Unlike distortion filters, which warp and deform an image, stylize filters simulate different media, such as film, television, or print, for example.

There are 25 Stylize filters:

- **Add Noise** adds noise to an image.
- **Bad Film** simulates old or damaged film or playback equipment.
- **Bad TV** simulates poor analog television reception.
- **Circle Screen** simulates an etched screening technique using a pattern of concentric circles.
- **Circles** adds elliptical facets to an image, giving it a mosaic-like appearance.
- **Color Emboss** gives the image the appearance of being stamped into the Canvas.
- **Crystallize** simulates the effect of viewing an image through a pane of glass with irregular facets.
- **Edges** creates an edge-detection effect.
- **Extrude** gives an object simulated depth.
- **Halftone** simulates the halftone screening method for print.
- **Hatched Screen** simulates a halftone pen-and-ink method of shading an image.
- **Highpass** stylizes the colors in an image to create a psychedelic display.
- **Indent** creates a shiny, bump-mapped effect, giving the appearance of depressed and flat areas.
- **Line Art** creates an effect similar to a line drawing on paper.
- **Line Screen** simulates an etched screening technique using a pattern of straight lines.
- **MinMax** erodes or dilates the light or dark areas of your image into soft, blocky regions.
- **Noise Dissolve** dissolves an object by adding a pattern of noise to it.
- **Pixellate** turns an image into a mosaic of blocks using colors taken from an object.
- **Posterize** reduces the number of colors in an image.
- **Relief** creates the appearance of a 3D height map.

**Slit Scan** creates an animated fly-through effect similar to...
• **Slit Scan** creates an animated fly-through effect similar to “stargate” images in science fiction films.

• **Slit Tunnel** creates an animated fly-through effect similar to “warp tunnel” images in science fiction films.

• **Texture Screen** uses a source layer to create a screen on an image.

• **Vignette** simulates the light fall-off and corner-blurring effect characteristic of images viewed through some camera lenses.

• **Wavy Screen** simulates an etched screening technique using a pattern of zigzagging lines.

---

**Add Noise**

Adds an overlay noise of the selected type to an image.

---

![Original image](image1.png) ![Add Noise filter applied](image2.png)

Adjust this filter using the parameter controls in the Filters Inspector:

• **Amount**: Sets the amount of noise added to the image.

• **Type**: Sets the type of noise added to the image. Values include Pink Noise (TV Static), White Noise (Uniform), Gaussian...
Noise (Film Grain), and Blue Noise, which reduces banding.

- **Monochrome**: Sets whether the added noise is monochrome or color.

- **Blend Mode**: Sets the blend mode used to add noise to the image. For blend mode descriptions, see How do blend modes work?.

- **Autoanimate**: Sets whether the noise is animated automatically.

- **Random Seed**: Sets the seed used to generate the position of the noise. This parameter is available only if Autoanimate is deselected.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

**Bad Film**

Simulates old or damaged film or playback equipment. This filter is animated.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Focus Amount**: Sets the amount of blur applied to the image. How do blend modes work?
- **Focus Amount**: Sets the amount of blur applied to the image, simulating a projector lens going in and out of focus.

- **Focus Variance**: Varies the amount defined in the Focus Amount parameter. For example, if Focus Amount is set to 3 and Focus Variance set to 1, the Focus Amount varies between 2 and 4.

- **Brightness Amount**: Simulates underexposed footage or an inconsistent projector bulb by lightening and darkening the image.

- **Brightness Variance**: Varies the amount defined in the Brightness Amount parameter. For example, if Brightness Amount is set to 2.5 and Brightness Variance set to 2, the Brightness Amount varies between .5 and 4.5.

- **Saturate Amount**: Adjusts the effect to simulate aged film stocks. Values below 0 lower the saturation, creating a faded film appearance. A value of –100 removes saturation to simulate black-and-white film. Values above 0 simulates oversaturation.

- **Saturate Variance**: Varies the amount defined in the Saturate Amount parameter. For example, if Saturate Amount is set to –20 and Saturate Variance set to 10, the Saturate Amount varies between –30 and –10.

- **Scratches**: Simulates scratches on film. The higher the value, the more scratches.

- **Scratch Color**: Sets the color of the film scratches. The color controls can be expanded with the disclosure triangle to include Red, Green, Blue, and Opacity sliders to more precisely select the color.

- **Hairs**: Simulates hairs on film. The higher the value, the more hairs.
- **Hairs**: Simulates hairs on film. The higher the value, the more hairs.

- **Dust**: Simulates dust or dirt on film. The higher the value, the more dirt.

**Tip**: Hair, dust, and scratches occur with random variance and may not appear on every frame. If you don’t see any effect while adjusting these sliders, play the clip and observe the effect over the duration of the shot.

- **Jitter Amount**: Simulates the look of a film projector that has a problem with its gate, reminding you of high school, if you are old. Increasing the amount of jitter increases the appearance of horizontal shake in the film.

- **Jitter Variance**: Varies the amount defined in the Jitter Amount parameter. For example, if Jitter Amount is set to .25 and Jitter Variance set to .05, the Jitter Amount varies between .2 and .3.

- **Grain**: Sets the amount of grain, allowing you to simulate different types of film stock.

- **Frequency of Change**: Defines how often (in frames) the values set in the parameters with variance are recalculated. For example, if Frequency of Change is set to 30, and Jitter Amount and Jitter Frequency are set to values greater than 0, the jitter parameters are recalculated every 30 frames, creating additional randomness.

- **Random Seed**: Lets you pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
Bad TV

Simulates poor analog television reception, adding attributes like exaggerated video field scan lines, static and roll.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Waviness**: Sets the amount of horizontal offset applied to video fields.

- **Roll**: Sets the amount of vertical offset applied to the image. The entire image is displayed, but the image is split along the roll line, with the otherwise missing part of the footage shown joined along the roll line.

- **Static**: Sets the amount of static added to the image.

- **Color Synch**: Sets the amount of horizontal RGB channel offset applied to the image.

- **Saturate**: Sets the amount of color saturation applied to the image. Negative values reduce saturation, positive values add saturation.

- **Scan Line Brightness**: Sets the brightness of the video field
scan lines added to the image.

- **Scan Line Percentage**: Sets the thickness of the video field scan lines added to the image.

- **Number of Scan Lines**: Sets the amount of scan lines added to the image.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## Circle Screen

Reduces an image to a high-contrast grayscale version of itself, then screens the result using a pattern of concentric circles, simulating an etched screening technique. The image is represented by varying thicknesses in the circular pattern.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the circle screen. You can also drag the Center onscreen control in the Canvas.

- **Scale**: Sets the scale of the circle screen.

- **Contrast**: Sets the contrast level.
- **Contrast**: Sets the contrast level.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

## Circles

Adds elliptical facets to an image, giving it a mosaic-like appearance. Each facet takes a color sample from the center of itself. Unlike other mosaic filters, the edges of the facets do not join, allowing parts of the untouched image to be visible between facets.

![Original image](#) ![Circles filter applied](#)

Adjust this filter using the parameter controls in the Filters Inspector:

- **Size**: Sets the size of the facets.
- **Falloff**: Sets the amount of alpha blending done at the edges of each facet.
- **Invert**: Sets whether the facets are elliptical or tiles with...
- **Elliptical Cut-outs**: Sets whether the facets are elliptical or tiles with elliptical cut-outs.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## Color Emboss

Traces high-contrast edges in the image with darker versions of the color in the image. This gives the layer the appearance of being stamped into the Canvas, while retaining the colors of the original image. The Direction and amount of Relief can be customized.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Direction**: Sets the angle of direction of the offset emboss.

- **Relief**: Sets the amount of the offset.

- **Crop**: Sets whether the image is cropped beyond its original borders.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
Crystallize

Simulates the effect of viewing an image through a pane of glass with irregular facets patterned into it. These mosaic-like facets give an image a crystallized appearance. This filter is automatically animated, and the facets appear to shift and turn according to the value in the Speed parameter. To prevent the facets from moving, set the Speed to 0 (zero).

Adjust this filter using the parameter controls in the Filters Inspector:

- **Size**: Sets the size of the facets.
- **Speed**: Sets the speed of the animation of the facets.
- **Smooth**: Sets whether facet colors are based on average values in the area they are replacing, or single samples taken from the center of the facet.
- **Feathering**: Sets the amount of feathering applied to the edges of facets.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
Edges

Creates an edge-detection effect by examining the luminance of an image to render high contrast borders between regions of brightness. These edges are then traced, and all other detail is replaced by black. The amount of eliminated detail depends on the value of the Intensity parameter. The colors of the resulting highlights are intensified variants of the colors from the original image.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Intensity**: Sets the intensity of the edges.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

Extrude

Gives an image simulated depth, by creating a front and back side, and then offsetting them and extruding the edges so they connect.
**Note:** Because this filter only simulates depth, an object with the Extrude filter applied does not interact with 3D aspects of Motion.

---

Adjust this filter using the parameter controls in the Filters Inspector:

- **Angle:** Sets the angle at which the image is extruded. Drag the onscreen control to adjust its value in the Canvas.
- **Distance:** Sets the distance the image is extruded. Drag the onscreen control to adjust its value in the Canvas.
- **Clipping:** Sets the distance at which the extrusion is clipped.
- **Back Size:** Sets the size of the simulated back of the image, as a proportion of its original size.
- **Face Brightness:** Sets a brightness level applied to the face of the image.
- **Front Brightness:** Sets a brightness level applied to the front of the image.
- **Back Brightness:** Sets a brightness level applied to the back of the image.
- **Extrude Style:** Selects the method used to extrude the sides
of the image. Shading or Gradient can be selected. With Shading selected, the color values of the pixels at the edges of the image are used along the extrusion. With Gradient selected, a gradient preset or custom gradient can be used.

- **Gradient**: Selects a gradient preset to be applied to the image. Can also be used to edit a custom gradient. The gradient is applied only if Extrude Style is set to Gradient.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

### Halftone

Reduces an image to a black and white version of itself, simulating the halftone screening method for print, in which the shadows and highlights of an image are recreated using patterns of small and large dots.

![Original Image](image1.png) ![Halftone Filter Applied](image2.png)

Adjust this filter using the parameter controls in the Filters Inspector:
- **Center**: Sets the position of the center of the halftone dots. You can also drag the center onscreen control in the Canvas.

- **Angle**: Sets the angle of the alignment of the dots.

- **Scale**: Sets the scale of the halftone dots.

- **Contrast**: Sets the amount of contrast between lightest and darkest dots.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

---

**Hatched Screen**

Reduces an image to a black and white version of itself, simulating a halftone pen-and-ink method of shading an image, in which the shadows and highlights of an image are recreated using hatched patterns of lines.

![Original image](image1.png) ![Hatched Screen filter applied](image2.png)
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the hatched screen. You can also drag the Center onscreen control in the Canvas.
- **Angle**: Sets the angle of the hatched screen.
- **Scale**: Sets the scale of the hatched screen.
- **Skew**: Sets the amount of skew of the hatched screen.
- **Stretch**: Sets the amount of stretch of the hatched screen.
- **Contrast**: Sets the relative amount of contrast between light and dark areas.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Highpass**

Emphasizes areas of detail in an image and stylizes the colors in the resulting image to create a mind-blowing psychedelic display.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Radius**: Sets the amount of variance of detail to consider. Values range from 0 (entire range of color) to 100 (only the most detailed portions).
- **Amount**: Sets the amount of emphasis.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

**Indent**

Creates a shiny, bump-mapped effect, giving the appearance of depressed and flat areas in the image.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Softness**: Sets the softness of the transition between flat and raised areas.
- **Brightness**: Sets the level of brightness of the image.
- **Ambient**: Sets the amount of ambient light hitting the image.
- **Highlight Brightness**: Sets the amount of brightness applied to highlights of the image.
- **Highlight Sharpness**: Sets the degree of sharpness applied to highlights of the image.
- **Light Rotation**: Sets the angle, in degrees, at which the ambient light hits the image.
- **Depth**: Sets the amount of depth between flat and raised areas.
- **Height Map**: Displays a thumbnail of the height map chosen. If present, the height map is used to determine the flat and raised areas of the layer.
- **Map Channel**: Sets the channel from the image used to
determine the flat and raised areas of the image. If a height map is present, the channel is selected from the height map. Otherwise, values include Luminance (default), Red, Green, Blue, or Alpha.

- **Stretch To Fit:** Sets whether the Height Map is stretched to fit the dimensions of the filtered layer.

- **Height Map X Scale:** Sets the scaling used to determine the width of the Height Map. This parameter becomes available when the Stretch To Fit checkbox is deselected.

- **Height Map Y Scale:** Sets the scaling used to determine the height of the Height Map. This parameter becomes available when the Stretch To Fit checkbox is deselected.

- **Height Map X Offset:** Sets the amount of offset used to position the Height Map horizontally. This parameter becomes available when the Stretch To Fit checkbox is deselected.

- **Height Map Y Offset:** Sets the amount of offset used to position the Height Map vertically. This parameter becomes available when the Stretch To Fit checkbox is deselected.

- **Mix:** Sets the percentage of the original image to be blended with the filtered image.

---

**Line Art**

Performs an edge detection of the high-contrast borders between regions of differing brightness in an image, tracing the edges and reducing other detail in the image to the color specified by the Paper Color parameter. The color of the resulting outline can also be customized. The effect is that of a line drawing on paper.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Threshold**: Sets the threshold of edge detection.
- **Smoothness**: Sets the level of smoothness of transition between the lines and the background.
- **Paper Color**: Sets the color of the paper. Click the disclosure triangle to reveal individual Red, Green, and Blue sliders to more precisely select the color.
- **Paper Opacity**: Sets the opacity of the paper.
- **Ink Color**: Sets the color of the ink used in the line drawing.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

**Line Screen**

Reduces an image to a high-contrast grayscale version of itself, then screens the image using a pattern of straight lines, simulating an etched screening technique. The image is represented by varying thicknesses in the pattern of the parallel lines.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the line screen. You can also drag the Center onscreen control in the Canvas.
- **Angle**: Sets the angle of the line screen.
- **Scale**: Sets the scale of the line screen.
- **Skew**: Sets the amount of skew of the line screen.
- **Stretch**: Sets the amount that the line screen is stretched.
- **Contrast**: Sets the relative amount of contrast between light and dark areas.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

### MinMax

Softly patterns an image by choosing a maximum or minimum
color value for pixels in the specified radius. The result erodes or dilates the light or dark areas of your layer into soft, blocky regions.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Mode**: Sets the mode of the effect. The following modes are available: Minimum and Maximum.

- **Radius**: Sets the radius of the effect.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

### Noise Dissolve

The Noise Dissolve filter dissolves an image by adding a pattern of noise to it. Raising the value of the Dissolve Amount parameter gradually eats away at more and more of the image. The alpha channel is set to zero within the noisy areas, so background images are revealed as the Dissolve Amount increases.
Adjust this filter using the parameter controls in the Filters Inspector:

- *Dissolve Amount*: Sets the percentage of pixels dissolved by noise.

- *Random Seed*: Sets a number to be used as a seed for noise placement.

- *Mix*: Sets the percentage of the original image to be blended with the filtered image.

**Pixellate**

Turns an image into a mosaic of blocks using colors taken from the image. You can increase or decrease the scale of the blocks.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the pixelation effect. You can also drag the Center onscreen control in the Canvas.
- **Scale**: Sets the scale of the pixelation.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

**Posterize**

Reduces the number of colors in an image to a set number per color channel, adjustable using the Levels parameter.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Levels**: Sets the number of levels of posterization.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

### Relief

Uses the color values of an image to calculate height vertices, creating the appearance of a 3D height map.

**Note**: Because this filter simulates depth, an object with the Relief filter applied does not interact with 3D aspects of Motion.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Front**: Sets the position of the center point of the front of the height map, determining the direction to which the height vertices are projected. Values are coordinates. Drag the inner or outer onscreen controls to adjust this value.

- **Front Size**: Sets the size of the front of the height map, as a proportion of its original size.

- **Back**: Sets the position of the center point of the back of the height map, determining the direction from which height vertices are projected. Values are coordinates. Drag the inner or outer onscreen controls to adjust this value.

- **Back Size**: Sets the size of the back of the height map, as a proportion of its original size.

- **Fuzziness**: Sets the amount of fuzziness applied to the height vertices. The higher the value, the softer the edges of the height vertices.

- **Height Map**: Displays a thumbnail of the height map chosen. If present, the height map is used to calculate height vertices.

- **Map Channel**: Sets the channel used to calculate height
Map Channel:
Sets the channel used to calculate height vertices. If a height map is present, the channel is selected from the height map, otherwise the channel is selected from the image. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

### Slit Scan

Creates an animated fly-through effect by simulating the slit scan process used to create “stargate” images in science fiction films.

![Original image](image1.jpg) ![Slit Scan filter applied](image2.jpg)

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the center of the slit. You can also drag the Center onscreen control in the Canvas.

- **Rotation**: Sets the angle of rotation of the slit.

- **Speed**: Sets the speed of the simulation.
- **Perspective**: Sets the angle of perspective on the layer.
- **Glow**: Sets the amount of the glow on the slit.
- **Glow Color**: Picks the color of the glow of the slit. Click the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.
- **Offset**: Sets the amount of offset between what is above and what is below the slit.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

### Slit Tunnel

Simulates a circular version of the slit scan process used to create “warp tunnel” images in science fiction films. This filter is automatically animated to create a fly-through effect.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center:** Sets the position of the center of the tunnel. You can also drag the Center onscreen control in the Canvas.
- **Rotation:** Sets the angle of rotation of the tunnel effect.
- **Speed:** Sets the speed of the simulation.
- **Perspective:** Sets the angle of perspective on the tunnel effect.
- **Glow:** Sets the amount of the glow at the end of the tunnel.
- **Glow Color:** Picks the color of the glow at the end of the tunnel. Click the disclosure triangle to display Red, Green, and Blue sliders for more precise color selection.
- **Mix:** Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC:** Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Texture Screen**

Uses a source object specified by the Map Image parameter to screen the target image. The source object can be any image, movie, or shape. By default, Texture Screen behaves as if there were a black image applied to the Map Image well, which makes the target appear desaturated and washed out.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Map Image**: Displays a thumbnail of the map chosen to generate the screen.
- **Center**: Sets the position of the center of the texture screen. You can also drag the Center onscreen control in the Canvas.
- **Angle**: Sets the angle at which the texture screen is placed.
- **Skew**: Sets the amount of skew applied to the map image.
- **Stretch**: Sets the amount of stretch applied to the map image.
- **Scale**: Sets the scale applied to the map image.
- **Contrast**: Sets the amount of contrast applied to the image by the screen.
- **Threshold**: Sets the threshold of brightness of the background image used to determine the brightness of the luminance map.
- **Noise Contrast**: Sets the amount of contrast added to the noise.
- **Noisiness**: Sets the amount of noise.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

---

**Vignette**

Simulates the light fall-off and corner-blurring effect characteristic of images viewed through some camera lenses.

![Original image](#) ![Vignette filter applied](#)

Adjust this filter using the parameter controls in the Filters Inspector:

- **Size**: Sets the size of the vignette. The larger the size, the more area of the object is affected by the vignette. You can also adjust this parameter in the Canvas, by dragging the inner ring of the onscreen control. Drag in the center of the inner and outer rings to adjust the Size and Falloff values simultaneously.

- **Falloff**: Sets the amount of feathering applied to the border of
the vignette. The higher the falloff, the softer the edge of the vignette. You can also adjust the Falloff parameter by dragging the outer ring of the onscreen control in the Canvas. Drag in the center of the inner and outer rings to adjust the Size and Falloff values simultaneously.

- **Center**: Sets the position of the center of the vignette. You can also drag the Center onscreen control in the Canvas.

- **Blur Amount**: Sets the amount of blur applied to the part of the image affected by the vignette.

- **Darken**: Sets the amount the affected part of image is darkened by the vignette.

- **Saturation**: Sets the amount of color saturation applied to the parts of the image affected by the vignette.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

### Wavy Screen

Reduces an image to a high-contrast grayscale version of itself, then screens the resulting image using a pattern of angled lines, simulating an etched screening technique. The image is represented by varying thicknesses in the pattern of the zigzagging lines.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Amplitude**: Sets the amplitude of the waves.
- **Wavelength**: Sets the wavelength.
- **Scale**: Sets the scale of the waves.
- **Contrast**: Sets the contrast of the screen.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

**Tiling filters**

**Tiling filters overview**

Tiling filters convert images, shapes, text, and other objects geometric patterns.

There are eight Tiling filters:

- **Kaleidoscope** simulates the effect of looking at an image through a kaleidoscope.
- **Kaleidotile** simulates looking through a kaleidoscope with...
- **Offset** treats an image as a tile, offsetting its origins but displaying the entire layer.
- **Parallelogram Tile** simulates looking through a kaleidoscope with facets made of parallelograms.
- **Perspective Tile** endlessly tiles an image, mapping it onto a grid.
- **Random Tile** tiles an image in an irregular pattern with circular panels.
- **Tile** tiles an image.
- **Triangle Tile** tiles an image with triangular shaped panels.

**Kaleidoscope**

Simulates the effect of looking at an image through a kaleidoscope. This filter isn’t automatically animated, but by animating the Offset Angle parameter you can simulate rotating kaleidoscope imagery.

Adjust this filter using the parameter controls in the Filters...
**Inspector:**

- **Center:** Sets the position of the center of the kaleidoscope. You can also drag the Center onscreen control in the Canvas.

- **Segment Angle:** Sets the angle at the tip of each triangular tile. You can also drag the outer handle of the onscreen control to adjust this value.

- **Offset Angle:** Sets the rotation of the whole kaleidoscope. Values range from 0 to 360. You can also drag the inner handle (between the center and outer handle) of the onscreen control to adjust this value.

- **Partial Segments:** Sets whether partial segments are used to complete the radius of the kaleidoscope. When Partial Segments is deselected, segments may be distorted to map them across the radius of the kaleidoscope with facets of equal size.

- **Mix:** Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC:** Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Kaleidotile**

Simulates looking through a kaleidoscope with rectangular facets. This filter is not automatically animated, but by animating the Angle parameter you can simulate rotating kaleidoscope imagery.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the origin of the kaleidotile effect. You can also drag in the center of the onscreen control (the box) in the Canvas.

- **Width**: Sets the width of the panels of the kaleidotile effect. You can also adjust the Width parameter by dragging the right or left center handle of the onscreen control in the Canvas. Drag a corner handle to adjust the Width and Height parameters simultaneously.

- **Height**: Sets the height of each panel. You can also drag the top or bottom center handle of the onscreen control to adjust this value. Drag a corner handle to adjust the Height and Width parameters simultaneously.

- **Angle**: Sets the angle of rotation of the panels. Drag a corner handle in an arc to adjust this value.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.
Offset

Treats an object as a tile, offsetting its horizontal and vertical origins but displaying the entire layer.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Horizontal Offset**: Sets the horizontal offset of the layer.
- **Vertical Offset**: Sets the vertical offset of the layer.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

Parallelogram Tile

Simulates looking through a kaleidoscope with facets made of parallelograms. This filter is not automatically animated, but by animating the Angle parameter you can simulate twisting kaleidoscope imagery.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the origin of the parallelogram tiles. You can also drag the Center onscreen control in the Canvas.
- **Angle**: Sets the angle of rotation of the panels.
- **Acute Angle**: Sets the acute angle at which the parallelogram sides meet.
- **Tile Size**: Sets the size of the panels.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Perspective Tile**

Endlessly tiles an image, mapping it onto a grid that can be positioned in simulated 3D space. Use Perspective Tile to create an endlessly repeating video wall stretching off into the distance.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Top Left**: Sets the position of the top-left corner of the grid.
- **Top Right**: Sets the position of the top-right corner of the grid.
- **Bottom Right**: Sets the position of the bottom-right corner of the grid.
- **Bottom Left**: Sets the position of the bottom-left corner of the grid.

**Note**: Drag the onscreen control handles to adjust the Top Left, Top Right, Bottom Right, and Bottom Left values.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

Random Tile

Tiles an image in an irregular pattern with circular panels.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the center point on the object where the tiles are generated. Values are coordinates. You can also drag the Center onscreen control in the Canvas.

- **Radius**: Sets the radius of each tile.

- **Feathering**: Sets the amount of feathering applied to the edges of each tile.

- **Seed**: Sets a number to be used as a seed for tile placement and stacking.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Tile**

Tiles an image. The number of tiles depends on the value of the Scale parameter.
Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the position of the origin of the tiles. You can also drag the Center onscreen control in the Canvas.
- **Skew**: Sets the amount of skew applied to tiles.
- **Scale**: Sets how much tiles are scaled.
- **Stretch**: Sets the amount tiles are stretched vertically.
- **Angle**: Sets the angle of rotation of tiles.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see Final Cut Pro templates overview.

**Triangle Tile**

Tiles an image with triangular shaped panels. The effect is similar to a kaleidoscope filter. This filter is not automatically animated,
but by animating the Angle parameter you can simulate a twisting kaleidoscope.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Center**: Sets the origin of the tile. You can also drag the Center onscreen control in the Canvas.
- **Angle**: Sets the angle of rotation of the triangles.
- **Tile Size**: Sets the size of the triangles.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
- **Publish OSC**: Publishes the filter’s onscreen controls in Final Cut Pro X. For more information on creating content for use in Final Cut Pro, see [Final Cut Pro templates overview](#).

**Time filters**

**Time filters overview**

Time filters manipulate layers temporally. Time filters are most
often used to modify moving footage.

There are five Time filters:

- **Echo** leaves a streaking trail behind the moving areas of an image.
- **Scrub** allows you to change the timing of the clip without moving it in the Timeline, via a virtual playhead.
- **Strobe** strobos the image, resulting in moving images that appear to skip frames as they play.
- **Trails** draws light or dark trails following a moving image.
- **WideTime** stretches the image’s motion out in time.

**Echo**

Creates a streaking trail behind the moving areas of an image.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Delay**: Sets the amount of delay between echoes. Values range from 0.1 to 1. A value of 0.1 is a zero frame echo, and a value of 1 represents a 60-frame echo.
- **Number**: Sets the number of echoes.
- **Decay**: Sets the amount of time it takes for an echo to decay.
- **Amount**: Sets the relative opacity of each echo.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.
Scrub

Moves a virtual playhead around a clip, allowing you to change the timing of the clip without moving it in the Timeline. Additionally, this filter lets you animate the offset parameter, often with interesting results. Try adding the Scrub filter to a video clip, then applying a Randomize parameter behavior to the “Frame offset” parameter, with the “Offset from” parameter set to Current Frame. Also, you can create a hold frame by setting Offset to First Frame, then adjusting “Frame offset” to find the frame you want.

**Important:** Scrub does not affect clip audio.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Frame offset:** Sets the offset of the virtual playhead.
- **Offset from:** Sets the position where the virtual playhead is offset. Values include First Frame or Current Frame.
- **Frame Blending:** Turns the blending between frames on and off.
- **Mix:** Sets the percentage of the original image to be blended with the filtered image.

Strobe

Strobes the image by holding frames for a set duration. As a result, moving images appear to skip frames as they play.

Adjust this filter using the parameter controls in the Filters Inspector:  

- **Strobe Rate:** Controls the number of frames played back per second.
- **Strobe Rate**: Controls the number of frames played back per second.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## Trails

Draws light or dark trails following an image’s movement. This filter is effective only with moving footage.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Duration**: Sets the duration of trails.
- **Echoes**: Sets the number of echoes trailing behind.
- **Decay**: Sets whether trails decay over time or disappear at the end of the duration.
- **Trail On**: Sets the value type that triggers trails. This pop-up menu can be set to Light or Dark.
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## WideTime

Holds frames before and after the current frame to stretch the image’s motion out in time.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Duration**: Sets the number of frames before and after the current frame.
- **Duration**: Sets the number of frames before and after the current frame that are blended.
- **Decay**: Sets the amount of time the added frames are held.
- **Amount**: Sets the amount of opacity of the delayed layer being overlaid. Values range from 0 (no reduction) to 1.0 (transparent).
- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## Video filters

### Video filters overview

Video filters are utilitarian in nature, and can help prepare a project for broadcast output.

There are two Video filters:

- **Broadcast Safe** limits the range of luminance or chrominance in an image to the broadcast legal limit.
- **Deinterlace** converts interlaced clips into noninterlaced clips.

## Broadcast Safe

Limits the range of luminance or chrominance in an image to the broadcast legal limit.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Video Type**: Sets the rule set to be used for filtering image
- **Video Type**: Sets the rule set to be used for filtering image data. Value can be NTSC or PAL.

- **Fix Method**: Sets the type of fix to be made to the image: Luminance or Reduce Saturation.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

## Deinterlace

Converts interlaced clips into noninterlaced clips using one of several possible methods.

**Tip**: In order to create a progressive scan clip when using the Deinterlace filter, ensure the Field Order pop-up menu in the Media Inspector is set to None.

Adjust this filter using the parameter controls in the Filters Inspector:

- **Dominant Field**: Sets the dominant field. There are two options: Upper or Lower.

- **Method**: Sets how the object is interlaced. This pop-up menu has three options:
  - **Duplicate**: The nondominant field is eliminated, and the data from the dominant field is duplicated to fill in the missing lines.
  - **Interpolate**: The nondominant field is eliminated, and a new field is created by averaging each pair of adjacent video lines to create new ones.
  - **Blend**: The nondominant field is eliminated, and new lines
are created by averaging the eliminated line with each pair of adjacent video lines.

- **Mix**: Sets the percentage of the original image to be blended with the filtered image.

---

**Publish filter parameters for use in Final Cut Pro X**

When you create effects templates in Motion for use in Final Cut Pro X, you can choose which parameter controls are available in the special effect, title, transition, or generator when it’s applied to a clip in Final Cut Pro. For example, if you create a Final Cut effect template using a Scrape filter, you might choose to export only the Rotation control to Final Cut Pro (and not the Amount or Mix sliders). In essence, you place limits on how the effect can be modified in Final Cut Pro by deciding which parameters to *publish*. You can also publish filter onscreen controls.

For more information on publishing Final Cut Pro X templates, see [Final Cut Pro templates overview](#).

---

**Publish filter parameters in a Final Cut template**

1. In an open Final Cut template project, select a filter.
2. In the Filters Inspector, do one of the following:
   - Click the Animation menu (the downward arrow that appears when you move the pointer over the right side of the parameter row), then choose Publish from the pop-up menu.
   - Control-click the parameter name, then choose Publish from the shortcut menu.

**Important:** Choosing Publish in the filter name row (the row containing the blue activation checkbox) publishes the filter’s activation checkbox—but not parameter controls for the filter (sliders, dials, and so on). Publishing a filter’s checkbox lets you turn on or off all published parameters simultaneously in Final Cut Pro X.

---

**Publish a filter’s onscreen controls**

1. In the open template project, select a filter.
2. In the Filters Inspector, select the Publish OSC checkbox.

**Review parameters set to be published in your template**

1. In the Layers list, click the Project object (at the top of the list).

2. In the Project Inspector, click Publishing.

   All parameters (for all object types) set to be published appear in the Publishing pane.

   **Note:** Published filter onscreen controls do not appear in the Publishing pane.

**Unpublish filter parameters in the Filters Inspector**

- In the Filters Inspector, do one of the following:
  - Click the Animation menu (the downward arrow that appears when you move the pointer over the right side of the parameter row), then choose Unpublish from the pop-up menu.
  - Control-click the parameter name, then choose Unpublish from the shortcut menu.

**Unpublish filter parameters in the Publishing**
1. In the Layers list, click the Project object.

2. In the Project Inspector, click Publishing, then do one of the following:
   - Click the Animation menu (the downward arrow that appears when you move the pointer over the right side of the parameter row), then choose Unpublish from the pop-up menu.
   - Control-click the parameter name, then choose Unpublish from the shortcut menu.

Example: Use a filter to color-match two composited layers

This example demonstrates how to use the Color Balance filter to match the color of a green-screened foreground image to a background plate. A green screen clip has been composited with a background layer using the Keyer filter. (For information about using the Keyer filter, see Keyer filter overview.) The background layer has already been modified with the Defocus and Contrast filters to appear moody and blurred (simulating a shallow depth of field).
Although the key is successful, the light illuminating the woman doesn’t quite match the light that illuminates the background.

You can fix this using the Color Balance filter.

Match a foreground subject to a background image using the Color Balance filter

1. Open the Library, click the Filters category, then click the Color Correction category to reveal the color correction filters in the stack.

2. Drag the Color Balance filter from the stack to the Layers list, onto the topmost layer of the composite (the keyed foreground layer).

Color Balance filter appears above of the Keyer filter in the Layers list.
3. In the Filters Inspector, click the Highlights color well in the Color Balance controls.

![Color Balance](image)

Highlights are often a good place to start when you need to match the color temperature of one image to another.

4. In the OS X Colors window, drag from the center of the color wheel toward orange, which is the predominant color of the background layer’s lighting in this example.

![Color Wheel](image)

As you drag in the color wheel, the color of highlights in the Canvas changes, with the color in the brightest highlights of the foreground image changing the most. Midtones are less affected, and shadows aren’t affected at all.
Stop adjusting when the color of the foreground layer’s highlights matches the color of similar highlights in the background.

**Tip:** You can also use the eyedropper tool in the Highlights color control to sample a highlight color in the background layer. (Click the eyedropper, then click a color in the background.) This can be a simpler adjustment, but it can also be tricky to sample the best color for a natural-looking match.

---

About using filters to manipulate alpha channels

There are filters you can use to manipulate or even replace a layer’s alpha channel. For example, the Keying filters create transparency by generating an alpha channel based on color or luminance values in that layer. Keying filters are usually used on layers that have no alpha channel information; these filters add a new alpha channel to the layers to which they’re applied. For more information on the use of the keying filters, see [Keying overview](#).
The process of improving a keying effect or of customizing an alpha channel created using shape or image masks may require the use of special filters. Although you can apply any filter to a shape or image mask to modify that mask’s effect, the filters described in this section modify a layer’s entire alpha channel, including the sum of all masks and other filters applied to that layer.

For example, if you’ve applied a keying filter, you can use the following filters to modify the resulting alpha channel even though no mask appears for that layer in the Layers list or Timeline.

- **Channel Blur**: This filter, found in the Blur category of the Filters library, lets you selectively blur the alpha channel. You can set the amount of horizontal and vertical blur independently.
Matte Magic: This filter, found in the Keying subcategory of the Filters library, lets you manipulate various qualities of an alpha channel, shrinking, feathering, and eroding the alpha channel to fine-tune it. For more information, see Matte Magic filter controls.

About filter performance

Filter performance considerations

In large projects with complex motion graphics, applying multiple filters can adversely affect your computer’s performance. To
ensure smooth playback, use the following suggestions to optimize your use of filters:

- When multiple layers are affected by a filter, place the targeted layers in a single group and apply the filter to the group (rather than applying the filter multiple times).
- When applying filters to very large 2D groups (such as a group containing a growing particle system), select the Fixed Resolution checkbox in the Group Inspector. When Fixed Resolution is enabled, layers in the group that expand beyond the edges of the Canvas are cropped, reducing the processing load on your computer. For more information, see Constrain group size.

Filters affect text, 2D groups, and 3D groups in different ways. For more information, see About 2D and 3D group properties.

### Third-party party effects and obsolete filters

Many third-party companies offer FxPlug filters and effects. If you install a third-party product, additional effects appear in the Filters list, usually in a separate, custom-named category.

If you open a project created in a previous version of Motion containing filters or media that are no longer available, an alert message appears listing the missing or obsolete items. For filter descriptions in earlier versions of Motion, see the user manual associated with that version of the application.

Save custom filters to the Library
After you add and edit a filter, you can save it as an effect preset in the Filters, Favorites, or Favorites Menu category in the Library, for future use.

---

**Save a filter to the Library**

1. Open the Library and select the Filters, Favorites, or Favorites Menu category.

2. Drag the filter you want to save from the Layers list into the stack at the bottom of the Library.

   The customized emitter is saved to the category you chose in the Library.

   **Tip:** For organizational purposes, create a folder of your own in the Favorites or Favorites Menu category to store custom filters.

---

**SEE ALSO**

- Save custom objects to the Library
- Move Motion projects, objects, or presets to another computer
Composite with color and luma keys

Keying overview

Keying is the process of isolating a foreground subject against a background area of uniform color or brightness to generate an alpha channel (a matte) based on the shape of the colored area. Keying is commonly performed on subjects photographed against a blue- or green-colored background, but keys can be based on any color (color or chroma keying), or on a specific range of brightness values (luma keying).

Color keying (also known as chroma keying) is commonly used on television to create the familiar effect of a newsreader or show host backed by a cavalcade of animated graphics. You can do the same thing in Motion using the Keyer filters.

Important: Keying to isolate a foreground subject is not always easy; learning how to use the parameters in each filter to best
effect takes time and patience. Most keys are “pulled” using more than one tool. Good compositing artists usually combine masked keyer filters, matte adjustment filters, spill suppression operations, and garbage or holdout masks to isolate a single subject. The Keyer filter in Motion combines many of these operations within a single set of parameters. In some instances, it may be necessary to apply different keyer settings to different areas of the subject, requiring the use of multiple keying filters and masks.

There are two types of keyer filters in Motion:

- Use the **Keyer filter** for blue screen or green screen keying, or for keying any range of color you choose.
- Use the **Luma Keyer** to generate mattes based on a sampled range of lightness in the image.

Two other filters provide standalone access to matte finishing operations:

- Use the **Matte Magic** filter to refine the edges of a matte.
- Use the **Spill Suppression** filter to manually correct matte problems created when the background color creates a reflection on the foreground subject.

**SEE ALSO**

- Crop unwanted background areas using a garbage mask
- Restore part of a foreground image using a holdout mask
- Apply multiple keys to a single subject

**Use the Keyer filter**
Keyer filter overview

The Keyer filter is intended for subjects shot in front of a blue screen or green screen. However, you can also use this filter to “pull” chroma keys from any range of color within a shot. The keyed portions of the image are rendered transparent, allowing background images to show through.

At its default settings, the Keyer filter attempts to work as automatically as possible. When you apply the Keyer filter to an object, Motion analyzes the visible frame in the Canvas to detect a dominant color such as a green or blue background. The dominant color becomes the initial sample that generates the tolerance, or core transparency, of the underlying key; this key is rendered as transparent in your composite. You can override the automatic initial color sampling to key any color, and you can refine your settings using the parameter controls in the Filters Inspector.

Pull a key with the Keyer filter

Getting started with the Keyer filter is easy. You apply a Keyer filter like any other filter in Motion—via the Library or the Add Filter pop-up menu in the toolbar. For information about applying filters, see Apply and remove filters.

After you apply the filter and create a basic key, you can fine-tune the default color sampling. (Alternatively, you can override the Keyer filter’s default sampling, then set the key colors manually.) If necessary, further refine the key using advanced color-selection controls and matte tools in the Filters Inspector.
Create a basic key

1. Import a background image into your project.

2. Import a foreground image or video clip of a subject positioned in front of a green screen or blue screen.

This example uses video footage of an actor standing in front of a green screen. Make sure the foreground layer (the actor and green screen) is above the background layer in the Layers list.

3. Move the playhead to a frame where the green screen is visible in the Canvas, then apply the Keyer filter to the foreground layer.

The Keyer filter analyzes the frame and guesses the color you’re trying to remove, based on the dominant color in the image (if blue or green). For best results, apply the filter to the frame with the greatest amount of the color to key.

If the automatic guess is incorrect (for example, if you want to key on red), you can manually set the color you want to key. See “Override automatic color sampling and set your own key colors,” below.

The background layer shows through as long as the View control in the Filters Inspector is set to Composite.
Note: If the clip you add a Keyer filter to is not visible in the Canvas, the initial key is pulled based on the first or last frame in which the subject appears, whichever is closest to the playhead.

4. If the automatic key is too aggressive (keying out soft details of the foreground subject that you want to preserve), open the Filters Inspector, then slowly drag the Strength slider left to reduce the tolerance (core transparency) of the matte until you’re satisfied with the amount of edge detail in the key.

Doing so allows areas of marginal transparency like hair, smoke, and reflections to show through. In general, it’s better to err on the side of a less aggressive key, using the parameters within the Matte Tools group to fine-tune the soft details you’re trying to preserve. For more information, see “Refine a key using Matte Tools.”
Tip: To see how the Chroma and Luma parameters are affected as you adjust the Strength slider, look at the Color Selection controls in the Filters Inspector. (Click the disclosure triangle beside the Color Selection parameter to see the controls.)

Override automatic color sampling and set your own key colors

Although the Keyer filter automatically samples your keying color, you can override that sampling and set the key colors manually. You might want to do this if you use a background screen color other than green or blue, or if the green screen or blue screen was unevenly lit.

1. Select an applied Keyer filter in the Layers list, then open the Filters Inspector or HUD.

2. Set the Strength slider to 0.

   Automatic color sampling is disabled, and the color screen background becomes visible in the Canvas.

3. In the Filters Inspector (or HUD), click to select the Sample
4. In the Canvas, drag a selection rectangle over an area of the screen color that you are attempting to key.

Most of the color screen should disappear and be replaced by the image in the layer underneath the foreground layer in the Layers list. You can add as many selection rectangles as necessary to sample areas of the color screen (for example, highlights or shadows on the color screen) to achieve a better result.
If the edges of the foreground subject are too sharp, use the Edges tool to soften the foreground edges. The Edges tool is also effective for fine-tuning semitransparent features such as smoke, glass reflections, and shadows.

5. In the Filters Inspector or HUD, click to select the Edges tool.

6. In the Canvas, drag over the edge of the foreground subject and, when an Edges control line appears, keep dragging so that one end point lies in the interior of the foreground subject and the other end point lies in the background.

7. In the Canvas, drag the center handle of the Edges control line to adjust the edge transparency of the keyed subject.

You can also set the View mode to Matte in the Filters Inspector, which helps you see the effect of using the Edges tool.

Tip: To see how the Edges control alters the outer softness
graph of the Chroma control and the bottom softness handles of the Luma controls, look at the Color Selection controls in the Filters Inspector as you make adjustments. (Click the disclosure triangle beside the Color Selection parameter to see the controls.)

Set your own key colors using keyboard shortcuts

When manually sampling colors to create a key, you can use keyboard shortcuts instead of clicking the Sample Color and Edge tools in the Inspector.

1. In the Layers list, select the Keyer filter to adjust.

2. Do one of the following:
   - To create a Sample Color selection rectangle, hold down the Shift key while dragging over the color you want to key in the Canvas.
   - To create an Edges sampling control, hold down the Command key while dragging to draw a line that crosses over the edge of the subject you’re keying in the Canvas.
   - To remove a Sample Color or an Edges control, Option-click anywhere in the sample control you want to delete, or click to select a sample control, then press the Delete key.

Refine a key using the Color Selection
1. With the Keyer filter selected in the Layers list, set the View mode in the Filters Inspector to Matte.

Matte mode lets you see how your adjustments affect the transparency of the image. The keyed image now appears in grayscale: white areas represent solid pixels in the final matte; black areas represent transparent pixels in the final matte; and varying levels of gray represent translucent pixels in the final matte (darker gray is more transparent; lighter gray is more opaque).

2. Click the disclosure triangle in the Color Selection row of the Filters Inspector to reveal additional controls.

3. Choose one of the two Graph views to select a mode for the adjustments you need:

   - **Scrub Boxes**: Remain in Scrub Boxes mode (the default) if you’re satisfied with the current key but want to adjust the edge softness of the resulting matte. In Scrub Boxes mode, you can adjust the outer graph of the Chroma control and the lower handles of the Luma control to increase or decrease the translucency of the edges of the matte.

   - **Manual**: Click Manual to make substantial alterations to tolerance (core transparency) and edge softness in the matte. In Manual mode, you can adjust the inner and outer
graphs of the Chroma control, as well as the upper and lower handles of the Luma control to alter all aspects of transparency in the matte. In Manual mode, you cannot alter the Strength parameter or add more Sample Color or Edges controls in the Canvas.

After you enter Manual mode, do not return to Scrub Boxes mode.

**Note:** For more information on keyframing the Color Selection controls, see About animated parameters in the Keyer filter.

4. Depending on the mode you selected in the previous step, adjust the controls to alter your matte:

- In Scrub Boxes mode, drag any side of the outer graph in the Chroma control to alter the range of hue and saturation contributing to the matte’s edge softness (transparency around the edges of the key).

  ![Chroma control](image)

  **Note:** In Scrub Boxes mode, you can also drag the two lower handles of the Luma control to alter the range of lightness and darkness contributing to the matte’s edge softness.

- In Manual mode, drag any side of the outer graph in the
In Manual mode, drag any side of the outer graph in the Chroma control to alter the range of hue and saturation contributing to the matte’s edge softness. Drag any side of the inner graph to alter the range of hue and saturation contributing to the matte’s tolerance (core softness). Drag in the center of the inner graph to rotate the graph to a new position in the color wheel.

**Note:** In Manual mode, you can also drag any of the four Luma control handles. The two upper Luma handles alter the range of lightness and darkness contributing to the matte’s tolerance (core transparency); the two lower handles alter the range of lightness and darkness contributing to matte’s edge softness.

In either mode, expanding the Chroma graph or Luma handle outward increases the regions of transparency in the keyed image. Dragging the side of a Chroma graph or a Luma handle inward diminishes the transparent regions in the keyed image. In the example below, the top image shows the holes in the matte that result from increasing edge softness using the outer graph of the Chroma control. The bottom image shows how reducing edge softness closes these holes.
5. If you haven’t adjusted the Luma control, drag the left or right lower handles to alter the softness of the luma component of the image.

Tip: In Manual mode, you can adjust the lower handles by dragging the bar connecting the top and bottom handles. To adjust all handles simultaneously, drag inside the curve in the graph.

6. Adjust the Chroma and Luma Rolloff sliders to subtly alter the falloff between the tolerance and softness of the key.
Refine a key using Matte Tools

1. With the Keyer filter selected in the Layers list, set the View mode in the Filters Inspector to Matte.

Matte mode lets you see how adjustments affect the transparency of the image. The keyed image appears in grayscale: white areas represent solid pixels in the final matte; black areas represent transparent pixels in the final matte; and varying levels of gray represent translucent pixels in the final matte (darker gray is more transparent; lighter gray is more opaque).

2. In the Filters Inspector, click the disclosure triangle of the Matte Tools row.

The row expands to reveal the Levels control, which adjusts the contrast of the matte. Also revealed are the Shrink/Expand slider, the Soften slider, and the Erode slider.

3. Use the Levels control to modify transparency and contrast in the matte.

A general rule for using the Levels control is to drag the center Bias handle left to decrease transparency in the matte or right to increase transparency in the matte. The Black slider on the left and the White slider on the right modify contrast in the
shadows and highlights of the matte.

The effects of Levels adjustments are best seen when View is set to Matte. In this view, the white area of the matte is the solid part, and the black area of the matte is the transparent part. Gray is translucent, with lighter grays creating progressively more transparency. With this in mind, here are some guidelines:

- Dragging the black bias handle right pushes gray areas to black, expanding areas of transparency within the matte.
- Dragging the center bias handle left pushes the grays in the matte towards white, widening solid areas of the key as semitransparent areas are made solid.
- Dragging the center bias handle right pushes the grays in the matte towards black, widening transparent areas of the key as semitransparent areas are made transparent.
- Dragging the white bias handle left pushes the grays in the matte towards white, expanding areas of solidity within the matte.

4. Drag the Shrink/Expand slider left to shrink the matte inwards, widening holes in the matte; drag the Shrink/Expand slider right to expand the matte outward, filling in holes in the matte.

![Original matte](image1)  ![Reducing Shrink/Expand](image2)  ![Increasing Shrink/Expand](image3)

5. Drag the Soften slider right to blur the matte overall, resulting
in softer edges throughout the matte.

6. Drag the Erode slider right to soften the matte from the edge inward, while preserving the original matte outlines as a translucent outer boundary.

Keyer filter controls

After you apply the Keyer filter to a video or image layer in your project, you can modify and refine the keying parameters in the Filters Inspector, which contains the following controls:
Refine Key tools

Use the Refine Key tools—Sample Color and Edges—to manually sample regions of an image to modify the tolerance (core transparency) of the generated key.

- **Sample Color**: A button that activates an onscreen control to select regions of the image to be turned transparent. Click the Sample Color tool, then drag a selection rectangle in the Canvas to define a range of color to key. After you create a selection rectangle, you can resize it to sample more or fewer shades of color, increasing or decreasing the range of background color used to create transparency. You can also add more selection rectangles to expand the range of color that is keyed, or add more selection rectangles at other frames of the clip to maintain transparency when lighting conditions change. (To add selection boxes, select the Keyer
filter in the Layers list, then hold down the Shift key while dragging in the Canvas.)

**Note:** Adding a Sample Color selection box to a frame adds to the sampled region that’s defined when you first apply this filter.

![Sample Color selection box](image)

When you sample regions in multiple frames, keyframes are added to interpolate the difference from one frame to the next. (Unlike standard keyframes, color-sampling keyframes are hidden in the Motion workspace by default.) The Jump to Sample buttons let you navigate between frames you’ve sampled, to make changes. For more information on keyframing the Keyer filter, see [About animated parameters in the Keyer filter](#).

- **Edges:** A button that activates an onscreen control to refine the transparency of marginal regions of the keyed subject, such as hair, reflections, smoke, or moving subjects with motion blur. Click the Edges tool, then drag in the Canvas to draw a line that crosses the boundary of the semitransparent region you want to adjust (with one point on the keyed foreground subject and the other point on the transparent background). Next, adjust the slider handle in the middle of this control line, outward to soften the matte, or inward to
harden it.

**Note:** To remove a Sample Color selection rectangle or Edges control line, select the rectangle or control line, then press Delete. Alternatively, Option-click inside the selection box or control line.

![Image of keying tool](image.png)

### Additional key controls

- **Strength:** A slider to adjust the tolerance (core transparency) of the Keyer filter’s automatic sampling. The default value is 100%. Reducing this value narrows the range of color sampled, resulting in less transparency in the keyed image. Increasing the Strength value expands the range of color sampled, resulting in more transparency in the keyed image. Use the Strength slider to retrieve areas of semitransparent detail such as hair, smoke, or reflections.

**Important:** Setting Strength to 0 bypasses the filter’s automatic sampling altogether, allowing you to manually sample a range of color using the Refine Key tools (described above).

- **Jump to Sample:** Left and right arrow buttons to navigate to
frames that have been manually sampled using the Sample Color and Edges tools. When the playhead is at a sampled frame, a numeric counter to the right of these buttons indicates your current position in the range of sampled frames (for example, “3 of 5”).

- **View**: Buttons to switch between three keying preview modes in the Canvas, useful for refining your key. The View setting affects what is rendered in your final output. For example, setting View to Matte lets you export a grayscale matte image that you can use as a luma channel matte in another application. There are three buttons:

  - **Composite**: A button that, when selected, displays the final composited image in the Canvas, with the keyed foreground object isolated against a transparent background, which lets layers underneath show through.
  
  - **Matte**: A button that, when selected, displays the grayscale matte, or alpha channel, generated by the keying operation. Viewing the alpha channel directly lets you evaluate the parts of the generated matte. Areas in the matte that appear white are visible in the final composite; areas that appear black are transparent; and areas with shades of gray are semitransparent (lighter grays being more solid). Viewing the alpha channel makes it easier to spot unwanted holes in the key, or areas of the key that aren’t transparent enough.
  
  - **Original**: A button that, when selected, displays the original,
unkeyed image in the Canvas. This view is useful to sample colors from the original image.

- **Fill Holes:** A slider to adjust solidity in regions of marginal transparency throughout a key. This control is useful when you’re satisfied with the edges of your keyed matte, but you have unwanted holes in the interior of the foreground subject that you can’t eliminate using the Strength parameter without ruining your edges. Higher slider values fill more holes in the solid areas of the keyed subject.

- **Edge Distance:** A slider to adjust how close to the edge of your keyed subject the effect of the Fill Holes parameter gets. Decreasing this parameter brings the solid, nontransparent area of the matte closer to the edge of the subject being keyed, sacrificing translucence at the edges in favor of filling unwanted holes at the edge of the keyed subject, or retrieving areas of semitransparent detail, such as hair, smoke, or reflections. Increasing this parameter value pushes the filled area of the matte farther to the interior of the subject, away from the edges, adding translucence to regions of the image that aren’t being keyed aggressively enough. Increasing this parameter too much may introduce regions of unwanted translucence in parts of the subject that should be solid.

- **Spill Level:** A slider to set how much spill suppression is applied to the keyed subject. *Spill suppression* is a color correction that neutralizes the green or blue colored light that often bounces off a green screen or blue screen background and tints the edges of a subject during a shoot. Consequently, it becomes more difficult to separate the foreground subject from the background during the keying process. Spill suppression is applied when you add the Keyer filter.
The color that is suppressed in the final image is based on the sampled portion of the image. The Spill Level slider controls how much spill suppression is applied to the keyed subject. For example, if the subject was shot in front of a green screen background, increasing the Spill Level value adds magenta to the foreground image, which neutralizes any unwanted green cast that your subject may be exhibiting. Spill suppression can be further customized using the controls in the Spill Suppression group, described later. Setting Spill to 0 turns off spill suppression.

- **Invert**: A checkbox that, when selected, inverts the generated matte, so that solid areas become transparent, and vice versa.

**Color Selection controls**

Click the disclosure triangle in the Color Selection row to reveal controls for adjusting the tolerance (core transparency) and softness (edge transparency) in the chroma and luma channels of the keyed region. Which controls are adjustable depends on the Graph mode (Scrub Boxes or Manual) you select in this group of controls.

These controls are meant to be used after you begin creating a
key using automatic sampling or the Sample Color and Edges tools. (However, you can skip those tools and create a key using the Color Selection controls in Manual mode.) The graphical Chroma and Luma controls in the Color Selection group provide a detailed way of refining the range of hue, saturation, and image lightness that define the keyed matte.

Before you adjust these controls, the graphs in the Chroma and Luma controls represent ranges of color and luma in the image that have been automatically and manually sampled (using the Refine Key tools and the Strength slider).

The Color Selection group contains the following controls:

- **Graph**: Two buttons to set how the adjustable graphs in the Chroma and Luma controls are used to fine-tune a key:
  - **Scrub Boxes**: When selected, this button limits the Chroma and Luma controls to adjusting softness (edge transparency) in the matte you’re creating. In Scrub Boxes mode, you cannot manually adjust tolerance (core
transparency), which is determined by the Keyer filter’s automatic sampling, plus any Sample Color selection boxes you’ve added in the Canvas. To increase matte tolerance, add more Sample Color selection boxes or adjust the Strength slider.

- **Manual:** When selected, this button allows Chroma and Luma controls to adjust the softness (edge transparency) and tolerance (core transparency) in the matte you’re creating. Make sure the Strength slider is set to a value greater than 0 before you switch into Manual mode, otherwise the Chroma and Luma controls are disabled. When you switch to Manual mode, the Refine Key tools and Strength slider become disabled, but samples you’ve made with those controls continue to contribute to the matte.

**Important:** After you switch to Manual mode, it’s inadvisable to switch back to Scrub Boxes mode. For best results, begin keying an image using the Sample Color and Edges tools in Scrub Boxes mode. Switch to Manual mode afterwards if you feel it’s necessary to refine your matte using the Chroma and Luma controls. However, after you switch to Manual mode, do not switch back to Scrub Boxes mode. If you do, you may experience unexpected combinations of additionally sampled and keyframed values that might be difficult to control.

- **Chroma:** Two graphic controls in the color wheel control to adjust the isolated range of hue and saturation that help define the keyed matte. The selected Graph mode governs which graphs in the color wheel are adjustable. The outer graph controls the **softness** (edge transparency) of the matte you’re creating, and can be adjusted in either Scrub Boxes or Manual mode. The inner graph controls **tolerance** (core
transparency), and is only adjustable when in Manual mode.

Drag any side of either graphic control to expand or contract the graph’s border, adding to or subtracting from the range of hue and saturation contributing to the key. In manual mode, you can also drag inside the tolerance graphic control to adjust its overall position in the color wheel.

To the left of the color wheel, a small graph displays the slope of *chroma rolloff*, the relative softness of matte edges in regions most affected by the Chroma control. Dragging the Chroma Rolloff slider (described below) modifies the shape of this slope.

It’s possible to zoom into and pan around the Chroma control to more precisely adjust the graphs:

- To zoom incrementally into the Chroma control, hold down the Z key and click the color wheel. To zoom out, hold down the Option and Z keys and click the color wheel. To smoothly zoom out, hold down the Z key and drag left in the color wheel. To smoothly zoom in, hold down the Z key and drag right in the color wheel. You can also hold down the Space bar and Command key (in that order), and drag left in the color wheel to zoom out or drag right to zoom in.

- To pan in the Chroma control, hold down the H key and drag in the color wheel. You can also hold down the Space bar and drag in the color wheel in the direction you want to move it.

- To reset the zoom and recenter the Chroma control, move the pointer over the Chroma control and press Shift-Z.

*Luma:* A grayscale gradient control with adjustable handles to modify the isolated range of the luma channel (the range of
lightness and darkness) that also helps define the keyed matte. The upper handles (which only appear in Manual mode) adjust the tolerance (core transparency) of the luma channel’s contribution to the key. The lower handles adjust the softness (edge transparency) of the luma channel’s contribution to the key.

The Graph mode governs which handles are adjustable. In Scrub Boxes mode, you can adjust only the lower softness handles. In addition to using the handles, you can drag the slope in the graph to adjust the softness.

In Manual mode, you can also adjust the upper tolerance handles, which modify core transparency within the luma channel of the matte. Dragging the slope in the graph adjusts the lower handles (the softness). To adjust all handles simultaneously, drag inside the curve in the gradient control.

By default, the slope of the left and right sides of the Luma graph has a slight “S” curve. You can modify the shape of the curve by adjusting the Luma Rolloff slider (described below).

**Note:** The luma softness handles may extend past the outer boundaries of the Luma control. This is due to the floating-point precision of the Keyer filter, and is an expected behavior.

- **Chroma Rolloff:** A slider to adjust the linearity of the chroma rolloff slope (displayed in the small graph to the left of the Chroma control). Chroma rolloff modifies the softness of the matte around the edges of regions that are affected most by the Chroma control. Lowering this value makes the slope of the graph more linear, which softens the edges of the matte. Raising this value makes the slope of the graph steeper, which sharpens the edges of the matte.
- **Luma Rolloff**: A slider to adjust the linearity of the luma rolloff slope (the ends of the bell-shaped luma curve displayed in the Luma control). Luma rolloff modifies the softness of the matte around the edges of regions that are affected most by the Luma control. Lowering this value makes the slope between the upper and lower handles in the Luma control more linear, which increases edge softness in the matte. Raising this value makes the slope steeper, sharpening the edges of the matte and making them more abrupt.

- **Fix Video**: Select this checkbox to apply subpixel smoothing to the chroma components of the image, reducing the jagged edges that result from keying compressed media using 4:2:0, 4:1:1, or 4:2:2 chroma subsampling. Although selected by default, this checkbox can be deselected if subpixel smoothing degrades the quality of your keys.

**Matte Tools controls**

Click the disclosure triangle in the Matte Tools row to reveal controls for post-processing the transparency matte generated by the previous sets of parameters. These parameters don’t alter the range of values sampled to create the keyed matte. Instead, they alter the matte generated by the Keyer filter’s basic and advanced controls (in the Color Selection parameter group), letting you shrink, expand, soften, or invert the matte to achieve a better composite.
The Matte Tools group contains the following controls:

- **Levels**: A grayscale gradient to alter the contrast of the keyed matte. Drag this control’s three handles to set the black point, white point, and bias (distribution of gray values between the black point and white point). Adjusting the contrast of a matte can be useful for manipulating translucent areas of the key to make them more solid (by lowering the white point) or more translucent (by raising the black point). Dragging the Bias handle (the gray tag under the gradient) right erodes translucent regions of the key, while dragging the Bias handle left makes translucent regions of the key more solid.

- **Black, White, Bias**: Click the disclosure triangle in the Levels row to reveal sliders for the Black, White, and Bias parameters. These sliders, which mirror the settings of the Levels handles described above, allow you to keyframe the three Levels parameters (via the Add Keyframe button to the right of each slider). Keyframing the Black, White, and Bias parameters may yield a better key, one that adapts to changing blue screen or green screen conditions.

- **Shrink/Expand**: A slider to manipulate the contrast of the matte to affect matte translucence and matte size simultaneously. Drag the slider left to make translucent regions more translucent while simultaneously shrinking the matte. Drag the slider right to make translucent regions more solid while simultaneously expanding the matte.
- **Soften:** A slider to blur the keyed matte, feathering the edges by a uniform amount.

- **Erode:** A slider that you can drag to the right to gradually increase transparency from the edge of the solid portion of the key inward.

**Spill Suppression controls**

Click the disclosure triangle in the Spill Suppression row to reveal controls for neutralizing a colored light that bounces off the blue screen or green screen and contaminates the isolated foreground subject. This fringing around the edge of the subject is called *spill*, and is difficult to eliminate because it’s part of the subject you’re trying to preserve.

The Spill Suppression controls work by letting you adjust the color correction that neutralizes unwanted color in the foreground subject. While the Spill Level slider (described above) controls how much suppression is applied, the controls in this group let you customize the quality of suppression being performed.

When first applied, the Keyer filter adds spill suppression to the video clip or image, based on the dominant color sampled to create the initial key. This automatic spill suppression desaturates the key color so fringing around the foreground subject appears gray (rather than blue or green). But if you reduce the Spill Level slider to 0, effectively turning off spill suppression, the gray fringing turns blue or green (the color of your background), proving that successful spill suppression is rendering the background a neutral gray.
The Spill Suppression group contains the following controls:

- **Spill Contrast**: A grayscale gradient to adjust the contrast of the color being suppressed, using Black point and White point handles (the tags under the gradient). Modifying spill contrast can reduce the gray fringing surrounding a foreground subject. The Black point handle (on the left side of the gradient control) lightens edge fringing that’s too dark for a successful composite. The White point handle (on the right side of the gradient control) darkens edge fringing that is too light. Depending on how much spill is neutralized by the Spill Level slider, these controls may have a greater or lesser effect on the subject.

- **Black, White**: Click the disclosure triangle in the Spill Contrast row to reveal sliders for the Black and White point parameters. These sliders, which mirror the settings of the Spill Contrast handles described above, allow you to keyframe the Black point and White point parameters (via the Add Keyframe button to the right of each slider).

- **Tint**: A slider to restore the natural color of the keyed foreground subject. Because the Spill Suppression controls eliminate blue or green spill by desaturating subtle blue or green fringing and reflection on the subject, the Tint slider lets you add hues to restore the natural color of the subject. Overdoing this parameter results in over-tinting the subject with the complementary color of the hue being suppressed—magenta if green, and orange if blue.
• **Saturation**: A slider to alter the range of hues introduced by the Tint slider (when the Tint slider is used at moderate levels).

## Light Wrap controls
Click the disclosure triangle in the Light Wrap row to reveal controls for blending color and lightness values from the background layer of your composite with the keyed foreground layer. Using these controls, you can simulate the interaction of environmental lighting with the keyed subject, making it appear as if background light wraps around the edges of a subject. In the following image on the right, with Light Wrap applied, environmental lighting from the orange sky background layer “wraps around” the edges of the candle and the right edge of the woman’s hair.

In Motion, the Light Wrap operation blends light and dark values from the background with the edges of the keyed foreground subject, and can be used to create color-mixing effects around the edges of the solid part of a key to better marry the background and foreground layers of your keyed composite.

Light Wrap is the last operation in the image-processing pipeline. In other words, the light-wrap effect is added after every other image operation is processed, including filters, lights and shading,
and other composited effects. As a result, Light Wrap accounts for any other visual effect that might alter the look of the object it is applied to, yielding the most desirable result.

**Important:** If the layer is set to the Light Wrap blend mode and you increase the Light Wrap parameter in the Keyer filter above 0, the Light Wrap parameters of the Keyer filter take precedence (and the Blend Mode is ignored). However, the Light Wrap blend mode in the Properties Inspector for a *group* overrides the Light Wrap parameters of any Keyer filters applied to layers in that group.

The Light Wrap group contains the following controls:

- **Amount:** A slider to control the overall light-wrap effect, setting how far into the foreground the light wrap extends.

- **Intensity:** A slider to adjust gamma levels to lighten or darken the interaction of wrapped edge values with the keyed foreground subject.

- **Opacity:** A slider to fade the light-wrap effect up or down.

- **Mode:** A pop-up menu to choose the compositing method that blends the sampled background values with the edges of the keyed subject. There are five options:
  - **Normal:** Evenly blends light and dark values from the background layer with the edges of the keyed foreground layer.
- **Lighten**: Compares overlapping pixels from the foreground and background layers, then preserves the lighter of the two. Good for creating a selective light-wrap effect.

- **Screen**: Superimposes lighter portions of the background layer over wrapped areas of the keyed foreground layer. Good for creating an aggressive light-wrap effect.

- **Overlay**: Combines the background layer with the wrapped areas of the keyed foreground layer so overlapping dark portions become darker, light portions become lighter, and colors become intensified.

- **Hard Light**: Similar to the Overlay composite mode, except that colors become muted.

**Mix slider**

A slider to set the percentage of the original image to be blended with the keyed image. 100% is the fully keyed image, while 0% is the original, unkeyed image.

**About animated parameters in the Keyer filter**

If necessary, you can animate the parameters of the Keyer filter to account for changes in the background screen you’re keying. For example, if there’s uneven lighting in the background, and the camera pans along with a moving subject as she walks from a bright part to a darker part of the colored background, you can animate the Keyer filter parameters to adjust to this change.
There are two ways of doing this. You can use the Refine Key controls (Sample Color and Edges) to sample background colors on multiple frames, or you can set manual keyframes using the Animation pop-up menu and keyframe controls found in the Filters Inspector.

- **Create keyframes using the Refine Key controls:** When you add a Sample Color box or Edges control to a clip you’re keying, keyframes corresponding to the Chroma and Luma controls (in the Color Selection group) are placed at that frame. This is the only way to keyframe tolerance while in Scrub Boxes mode, although you can manually keyframe the softness of the Chroma and Luma controls no matter what mode you’re in by using the Animation menu of the Filters Inspector. For more information about keyframe animation, see Animate parameters in the Inspector.

- **Create keyframes using the Color Selection controls in Manual mode:** In Manual mode, you can keyframe all aspects of the Chroma and Luma controls using the keyframe controls or Animation menu. Alternatively, you can use the Record button (in the transport controls under the Canvas) to keyframe changes to the Chroma and Luma controls. After you add the first keyframe to the Chroma or Luma parameters, additional keyframes are added at each frame where you make modifications. For more information about the Color Selection parameters, see Keyer filter controls and Pull a key with the Keyer filter.

After you’ve added at least one keyframe—by using the Refine Key tools or by manually keyframing—adjustments to the Chroma and Luma controls on other frames will generate more keyframes, whether the Record button is enabled or not.
Tip: To make an adjustment without adding keyframes, use the Jump to Sample buttons (in Scrub Boxes mode only), or the Next/Previous keyframe buttons to the right of the Chroma and Luma controls in the Filters Inspector (in Scrub Boxes or Manual modes) to navigate to a previously keyframed frame.

After you switch from Scrub Boxes mode to Manual mode, work in Manual mode from that point onward. Switching from Manual mode back to Scrub boxes mode can create unexpected combinations of additionally sampled and keyframed values that are difficult to control.

Note: Chroma and Luma control keyframes do not appear in the Keyframe Editor. They’re only visible using the keyframe controls at the right of each parameter in the Filters Inspector.

Use the Luma Keyer filter

Luma Keyer filter overview

The Luma Keyer filter pulls a key from an image or clip based on a selected range of image lightness. Although typically used to key out a white background behind a foreground subject, the Luma Keyer filter can also be used to generate creative effects by turning a narrow range of image brightness transparent. The Luma Keyer filter can also isolate rasterized logo and text graphics from a black or white background.

Luma keys are most effective when you’re keying a subject with a range of lightness different from the area you’re turning transparent. For example, if you’re keying a black background,
the foreground subject should not have deep shadows or dark areas that might get keyed with the background. Generally speaking, shadows and highlights in the image usually make this a difficult filter for pulling a perfect key.

You apply a Luma Keyer filter like any other filter in Motion—via the Library or the Add Filter pop-up menu in the toolbar. For more information about applying filters, see Apply and remove filters.

For a description of the Luma Keyer filter parameters, see Luma Keyer filter controls.

Luma Keyer filter controls

After you apply the Luma Keyer filter to a video or image layer in your project, you can refine the keying parameters in the Filters Inspector, which contains the following controls:

Basic controls

- **Luma**: A grayscale gradient control with handles to adjust tolerance and softness in the matte. When you first apply the
Luma Keyer filter to an image layer in Motion, the Luma control displays two handles: a Tolerance handle in the upper right, and a Softness handle in the lower left. Dragging the top handle to the left reveals a second tolerance handle. Together, these handles define the range of image lightness used to define the core transparency of the resulting matte. The range of lightness turned transparent is indicated by a checkerboard pattern behind the gradient. Two handles under the gradient define the softness, or edge transparency, of the key. (The second softness handle may not be visible until you drag the two tolerance handles left.) Dragging either of the lower softness handles farther out and away from the upper tolerance handles results in a key with softer edges. You can also drag the slope in the graph to adjust the softness handles.

- **Invert**: A checkbox that, when selected, inverts which area is transparent and which is opaque.

- **Luma Rolloff**: A slider to adjust the linearity of the falloff between the Luma control’s tolerance and softness handles. Modifying this parameter changes the softness of the matte around the edges in regions that are affected most by the Luma control. Decreasing the Luma Rolloff value makes the slope between the two handles of the Luma control more linear, which visibly increases edge softness. Increasing this value makes the slope between the handles of the Luma control steeper, sharpening the edges of the matte and making them more abrupt.

- **View**: A group of buttons to switch among three keying preview modes in the Canvas, useful for refining your key:
  - **Composite**: The leftmost button, when selected, displays
the final composited image in the Canvas, with the keyed foreground subject isolated against a transparent background, which lets layers underneath show through.

- **Matte:** The center button, when selected, displays the grayscale matte, or alpha channel, generated by the keying operation. Areas in the matte that appear white are visible in the final composite; areas that appear black are transparent; and areas with shades of gray are semitransparent (lighter grays being more solid, and darker grays being more translucent). Viewing the alpha channel makes it easier to spot unwanted holes in the key, or areas of the key that aren’t transparent enough.

- **Original:** The rightmost button, when selected, displays the original, unkeyed image in the Canvas.

### Matte Tools controls

Click the disclosure triangle in the Matte Tools row to reveal controls for post-processing the transparency matte generated by the previous sets of parameters. These parameters do not alter the range of values sampled to create the keyed matte. Instead, they alter the matte generated by the Luma and Luma Rolloff controls, letting you shrink, expand, soften, or invert the matte to achieve a better composite.

- **Fill Holes:** A slider to adjust solidity in regions of marginal transparency throughout a key. This parameter is useful when you’re satisfied with the edges of your keyed matte but have unwanted holes in the interior of the foreground subject that you can’t eliminate using the Strength parameter without ruining edges. Higher slider values fill more holes in the solid
- **Edge Distance**: A slider to adjust how close to the edge of your keyed subject the effect of the Fill Holes parameter gets. Reducing this parameter brings the solid, nontransparent area of the matte closer to the edge of the subject being keyed, sacrificing translucence at the edges in favor of filling unwanted holes at the edge of the keyed subject, or retrieving areas of semitransparent detail, such as hair, smoke, or reflections. Raising this parameter pushes the filled area of the matte farther to the interior of the subject, away from the edges, adding translucence to regions of the image that aren’t being keyed aggressively enough. Raising this parameter too much can introduce regions of unwanted translucence in parts of the subject that should be solid.

- **Levels**: A grayscale gradient control to alter the contrast of the keyed matte. Drag this control’s three handles that set the black point, white point, and bias (distribution of gray values between the black point and white point). Adjusting the contrast of a matte can be useful for manipulating translucent areas of the key to make them more solid (by lowering the white point) or more translucent (by raising the black point). Dragging the Bias handle right erodes translucent regions of the key, while dragging the Bias handle left makes translucent regions of the key more solid.

- **Black, White, Bias**: Click the disclosure triangle in the Levels row to reveal sliders for the Black, White, and Bias parameters. These sliders, which mirror the settings of the Levels handles described above, allow you to keyframe and apply Parameter behaviors to the three Levels parameters (via the Add Keyframe button to the right of each slider). Keyframing the Black, White, and Bias parameters may yield
a better key, one that adapts to changing blue screen or green screen conditions.

- **Shrink/Expand**: A slider to manipulate the contrast of the matte to affect matte translucence and matte size simultaneously. Drag the slider left to make translucent regions more translucent while simultaneously shrinking the matte. Drag the slider right to make translucent regions more solid while simultaneously expanding the matte.

- **Soften**: A slider to blur the keyed matte, feathering the edges by a uniform amount.

- **Erode**: A slider that you can drag to the right to increase edge transparency from the outer edge of the matte progressively farther into the interior of the keyed matte.

**Light Wrap controls**

Click the disclosure triangle in the Light Wrap row to reveal controls for blending color and lightness values from the background layer of your composite with the keyed foreground layer. Using these controls, you can simulate the interaction of environmental lighting with the keyed subject, making it appear as if background light wraps around the edges of a subject. In Motion, the Light Wrap operation blends light and dark values from the background with the edges of the keyed foreground subject, and can be used to create color-mixing effects around the edges of the solid part of a key to better marry the background and foreground layers of your keyed composite.

Light Wrap is the last operation in the image-processing pipeline. In other words, the light-wrap effect is added after every other
image operation is processed, including filters, lights and shading, and other composited effects. As a result, Light Wrap accounts for any visual effect that might alter the look of the object it is applied to, yielding the most desirable result.

**Important:** A separate Light Wrap option appears in the Blend Mode pop-up menu of the Properties Inspector for a selected layer or group in Motion. The Light Wrap blend mode in the Properties Inspector for a layer is ignored when you add a Keyer filter to that layer and set the Light Wrap Amount parameter to a value greater than 0. (The Light Wrap parameters of the Keyer filter take precedence.) However, if you set the Amount parameter of the Light Wrap group to 0, the Light Wrap blend mode becomes active again. Further, the Light Wrap blend mode in the Properties Inspector for a group overrides the Light Wrap parameters of any Keyer filters in that group.

- **Amount:** A slider to control the light-wrap effect, setting how far into the foreground the light wrap extends.
- **Intensity:** A slider to adjust gamma levels to lighten or darken the interaction of wrapped edge values with the keyed foreground subject.
- **Opacity:** A slider to fade the light-wrap effect up or down.
- **Mode:** A this pop-up menu to choose the compositing method to blend the sampled background values with the edges of the keyed subject. There are five options:
  - **Normal:** Evenly blends light and dark values from the background layer with the edges of the keyed foreground layer.
  - **Lighten:** Compares overlapping pixels from the foreground
and background layers, then preserves the lighter of the two. Good for creating a selective light-wrap effect.

- **Screen**: Superimposes lighter portions of the background layer over wrapped areas of the keyed foreground layer. Good for creating an aggressive light-wrap effect.

- **Overlay**: Combines the background layer with the wrapped areas of the keyed foreground layer so overlapping dark portions become darker, light portions become lighter, and colors become intensified.

- **Hard Light**: Acts like the Overlay composite mode, except that colors become muted.

### Additional controls

- **Preserve RGB**: A checkbox that, when selected, preserves smooth graphics and text. Some images may be rendered as if they have an alpha channel, even though they don’t. A good example is white text on a black background. Rasterized text in most images is anti-aliased properly, and further modification to the RGB channels by the Luma Keyer can degrade the quality of the edges. Selecting the Preserve RGB checkbox adds transparency to the image without modifying the RGB channels, leaving smoothly aliased text or graphics visually intact.

- **Mix**: A slider to set the percentage of the original image to be blended with the keyed image. 100% is the fully keyed image, while 0% is the original, unkeyed image.
Correct or refine an existing matte

Matte refinement overview
Keying is rarely a one-step process. Although adding a keying filter is the first step, there is usually additional work that must be done to create a good key that retains detail around the edge of your subject. You can use the mask tools and alpha channel filters to turn a decent key into a great one:

- **Create a garbage mask** to crop unwanted background objects in the shot that can’t be keyed, such as the edge of a blue screen stage, lighting rigs, or tape that appears in the background.
- **Create a holdout mask** to restore part of a foreground image that has been removed by the key.
- **Add a Matte Magic filter** to refine matte edges.
- **Add a Spill Suppression filter** to manually neutralize a key color.
- **Use multiple keys** to isolate difficult-to-key regions in your foreground subject.

**Important:** When using masks with keying, apply any masks after applying the keyer. Additionally, be sure to apply the masks to the same image layer as the keying filter itself.

Crop unwanted background areas using a garbage mask
After you apply a key, you may need to crop unwanted
background elements that can’t be keyed, such as the edge of a blue screen stage, lighting rigs, or tape that appears in the background. Using the Mask tool, you can create a garbage mask that removes unwanted elements.

You can also use a garbage mask to conceal parts of the background too difficult to key without the loss of foreground detail.

Create a garbage mask

- Select a keyed layer and use a mask-drawing tool to draw a mask around the foreground subject.

  **Note:** If the subject is moving, the garbage mask must be animated.

By default, the Mask Blend Mode is set to Add, and crops out everything outside the mask, while leaving the transparent areas in the mask alone. To crop out areas within masks, as shown in the following image, choose Subtract from the Mask.
Blend Mode pop-up menu.

For more information about creating masks, see Masks and transparency overview.

Restore part of a foreground image using a holdout mask

Sometimes, while pulling a key, you lose part of the image you’re trying to keep. This can happen when the color of the subject’s clothing is too close to the color of the background being keyed out, or when you need to use keying values that are too aggressive. In this example, small parts of the bird’s head and wings are getting removed with the key, rather than just the blue sky. If left uncorrected, the background image will show through the bird in these areas.
In these cases, you can duplicate the original layer, mask the part of the subject that’s being incorrectly keyed, and composite it over the keyed version to fill it back in.

**Note:** The Spill Suppressor filter can modify the color of the foreground subject as well. If you’re using the Spill Suppressor filter on the keyed layer, you may have to apply the same filter to the holdout mask layer to make sure the color matches. For more information on the Spill Suppressor filter, see [Spill Suppression filter controls](#).

---

### Create a holdout mask

1. Apply a Keyer filter to the foreground subject.
   
   For more information about using Motion’s Keyer filter, see [Keyer filter overview](#).

2. Duplicate the keyed layer.

3. On the newly duplicated layer (above the original layer in the Layers list or Timeline), delete the original keying filters.
If you’ve used a Spill Suppressor filter, don’t delete it, because it’s probably changing the color of the subject.

4. On the newly duplicated layer, use a mask-drawing tool to mask the area of the foreground that is incorrectly keyed. Make sure that the mask is entirely within the subject being keyed.

**Note:** If the subject is moving, the holdout mask must be animated.

5. If necessary, feather the edge of the mask you’ve just created, to make sure that it blends in with the object you initially keyed.

In the following image, a clean key is created within the mask by removing the “dirt” left by the original key.

6. As an optional step, you can nest the originally keyed layer and the holdout mask you just created inside a dedicated group so you can manipulate the entire subject as a single object.
Matte Magic filter controls

The Matte Magic filter lets you manipulate the edges of a matte by shrinking, feathering, and eroding them to improve difficult keys. The Keyer and Luma Keyer filters have much of the same functionality. Matte Magic is a refinement filter to let you manipulate mattes you create via other means. After you apply a Matte Magic filter, you can adjust its controls in the Filters Inspector:

- **Shrink**: A slider to manipulate the contrast of the matte in a way that renders translucent regions of the keyed matte more translucent while shrinking the matte.

- **Feather**: A slider to blur the keyed matte, softening the edges by a uniform amount.

- **Erode**: A slider that, when dragged to the right, increases transparency from the edge of the solid portion of the key inward.

- **Levels**: A grayscale gradient control to alter the contrast of any matte or alpha channel. Drag the three handles that set the black point, white point, and bias (distribution of gray values between the black point and white point). Adjusting the contrast of a matte can be useful for manipulating translucent areas of the key to make them more solid (by lowering the white point) or more translucent (by raising the black point). Dragging the Bias handle right erodes translucent regions of the key, while dragging the Bias handle left makes translucent regions of the key more solid.

- **Black, White, Bias**: Click the disclosure triangle in the Levels row to reveal sliders for the Black, White, and Bias parameters. These sliders, which mirror the settings of the
Levels handles described above, allow you to keyframe the three Levels parameters (via the Add Keyframe button to the right of each slider). Keyframing the Black, White, and Bias parameters may yield a better key, one that adapts to changing blue screen or green screen conditions.

- **Mix**: A slider to set the percentage of the original image to be blended with the filtered image. 100% is the filtered image, while 0% is the original, unfiltered image.

SEE ALSO

Spill Suppression filter controls

Spill Suppression filter controls

When you key an image that was shot against a blue screen or green screen, some color will have reflected from the screen to illuminate the edges, or even the interior, of the foreground subject. This unwanted coloration of the subject is called spill, and can be difficult to eliminate from the foreground subject you’re trying to preserve.

Unlike the spill suppression controls found in the Keyer filter, which automatically neutralize the color being keyed, the Spill Suppression filter lets you deal with this problem by manually choosing the color to be neutralized. After you apply a Spill Suppression filter, you can adjust its controls in the Filters Inspector:

- **Color**: A color control to sample the color to suppress. Click the color well and choose a hue from the Colors window, or use the eyedropper to sample a color in the Canvas.
• **Level:** A slider to adjust the amount of spill removal applied to the keyed image.

**Tip:** Green screen clips typically benefit from a lower spill-level setting than blue screen clips. Good starting points to try are 46% for green and 73% for blue, although you’ll need to customize these values for your composites.

• **Spill Contrast:** A grayscale gradient control to adjust the contrast of the color being suppressed, using Black point and White point handles (and corresponding sliders). Modifying spill contrast can reduce the gray fringing surrounding a foreground subject. The Black point handle (on the left side of the control) lightens edge fringing that’s too dark. The White point handle (on the right side of the control) darkens edge fringing that is too light. Depending on how much spill is neutralized by the Spill Level slider, these controls may have a greater or lesser effect on the subject.

• **Black, White:** Click the disclosure triangle in the Spill Contrast row to reveal sliders for the Black and White point parameters. These sliders, which mirror the settings of the Spill Contrast handles described above, allow you to keyframe the Black point and White point parameters (via the Add Keyframe button to the right of each slider).

• **Tint:** A slider to restore the natural color of the keyed foreground subject. Because Spill Suppression controls eliminate blue or green spill by desaturating subtle blue or green fringing and reflection on the subject, the Tint slider lets you add hues to restore the natural color of the subject. Overdoing this parameter results in over-tinting the subject with the complementary color of the hue being suppressed—magenta if green, and orange if blue.
Saturation: A slider to alter the range of hues introduced by the Tint slider (when the Tint slider is used at moderate levels).

Tip: The best order in which to use these controls is to adjust Tint before you adjust Saturation.

Mix: A slider to set the percentage of the original image to be blended with the filtered image. 100% is the filtered image, while 0% is the original, unfiltered image.

SEE ALSO
Matte Magic filter controls

Apply multiple keys to a single subject

In some instances, it may be difficult to key an entire subject with a single keying filter while retaining fine details. For example, uneven lighting or background color might mean that the best settings to key a subject’s hair may not work elsewhere. In such cases, you can use masks to isolate different parts of a subject, and then apply different keying settings to each area.

Segment a subject into separate keying zones

1. Create a group and place the layer you’re keying in the new group.

2. Duplicate the layer you’re keying until you have a separate duplicate for each part of the image you want to key
3. Use a mask tool to mask each part of the subject in the duplicate layers.

**Note:** For more about using the mask tool, see *Masks and transparency overview*.

Make sure the masks overlap, so there are no gaps in the foreground.

**Note:** If the foreground subject is moving, you might need to animate the overlapping masks.

4. Apply the relevant keying filter to the isolated parts of the subject, then adjust each filter’s settings.

Eventually, you may find you can achieve an optimal key for each part of the subject. Furthermore, with all duplicates nested in a single group, you can continue to manipulate the subject as a single object.
Motion tracking overview

Motion tracking is a method of recording the movement of an element (a shape or reference point in a movie clip) in the Canvas, then applying that recorded movement data to another element in the Canvas. For example, you can use motion tracking techniques to:

- “Pin” a post-production graphic to the side of a moving bus
- “Track” a blurry circle to a person’s face to preserve an innocent bystander’s anonymity
- Stabilize a ridiculously shaky camera to vastly improve a “found-footage” thriller
- “Replace” a daring stuntman’s head with the mug of a lazy leading actor

There are six tracking behaviors available in Motion. You apply a tracking behavior to an object in your project—typically a movie clip—to record and analyze its movement. The result of this analysis is a track—recorded movement data—that can be applied to any other object in the project, transferring the motion of a source object to a destination object.

SEE ALSO

How does motion tracking work?
What are the types of motion tracking behaviors?
How does motion tracking work?

The tracking behaviors in Motion analyze an area of pixels known as a reference pattern over a range of frames in a movie clip to “lock onto” the pattern as it moves across the Canvas. You specify the reference pattern to be analyzed and “tracked” by dragging one or more onscreen trackers (a red crosshair in a circle, shown below) to the area of the clip you want to analyze. Motion then analyzes the motion of the designated reference pattern for a specified duration of time. This duration is based on the length of the tracking behavior, the length of the defined play range, or the length of the clip.

![Tracker](image)

Ideally, the reference pattern should be a consistent, easily identifiable detail with high contrast. This makes the pattern easier to track.

During the analysis, the tracker advances to each subsequent frame, sampling many positions in the search region around the center point of the tracker. Some of those positions fit the designated reference pattern more closely than others; the tracker finds the position where the search region most closely matches the reference pattern (with subpixel accuracy). For every frame analyzed, the tracker assigns a correlation value by measuring how close the best match is.

In addition to searching for the reference pattern’s position, the tracker identifies how the pattern transforms (scales, rotates, or shears) from one frame to the next. Imagine you’re tracking a logo
on the shirt sleeve of a person walking past the camera. If the person turns slightly as he passes the camera, the reference pattern rotates. The tracker looks for the reference pattern and any shifts in that pattern’s scale or rotation.

As it analyzes motion in your project, Motion records the data, which you can then apply to any other object in your project.

The more trackers you use, the more spatial information you’ll record: One-point tracking records position data; two-point tracking and four-point tracking record position, rotation, and scale data (by comparing the relative change between the points); multiple-point tracking can record all the control points (vertices) on a shape.

Tracking in Motion is planar; in other words, tracking does not occur in Z space (depth). For example, when you analyze two features in a clip—and that clip is moving in 3D space—you record the changes in position, scale, or rotation over time in the clip, but not its actual 3D transformation.

Note: The Stabilize behavior (in the Motion Tracking category of behaviors) uses an advanced technology that analyzes the motion of the entire frame of a clip, without the use of trackers.

What are the types of motion tracking behaviors?

There are six tracking behaviors in Motion:
Analyze Motion

Generates and stores tracking information from a video clip, but does not apply that tracking data to other objects. However, other tracking behaviors can apply Analyze Motion tracking results to objects. The Analyze Motion behavior lets you add multiple trackers to a clip, to track multiple reference patterns at the same time. The Analyze Motion behavior is available in the Motion Tracking subcategory of behaviors. See Analyze the motion of a clip.

Match Move

Matches a foreground element to a background element so they appear locked together. Using Match Move, you can analyze one or more reference points in a video clip, then apply that tracking data to nearly any other object in your project, or you can apply tracking data supplied by another tracking behavior (such as Analyze Motion or Stabilize). You can also apply animation data created by keyframes or other behaviors (without having to analyze the motion of the animated source object). The Match Move behavior is available in the Motion Tracking subcategory of behaviors. See Match moving overview.

Stabilize

Removes unwanted motion in a video clip, such as camera jitter (horizontal movement, vertical movement, or both). Because the Stabilize behavior analyzes the entire frame of a clip, you don’t need to use onscreen trackers. Stabilize lets you smooth jittery clips while preserving the general motion of the camera, or lock
down video clips, stabilizing the camera as if it were on a tripod. The Stabilize behavior is available in the Motion Tracking subcategory of behaviors. See Stabilize a shaky clip.

**Unstabilize**

Applies the movement recorded by a Stabilize behavior to a clip or object (but does not perform its own tracking analysis). Use Unstabilize to match the camera shake in a movie clip to foreground elements added in post-production. The Unstabilize behavior is available in the Motion Tracking subcategory of behaviors. See Unstabilize a clip.

**Track Points**

Matches the control points of a shape, paint stroke, or mask to reference features on a video clip. For example, you can draw a mask around a car in a clip and then track the control points of the mask to the moving car, cutting the car out of the background. You can then apply effects to the isolated car, and the surrounding image is not affected. The Track Points behavior can analyze motion in a video clip, then apply that tracking data to points in a shape, or it can use existing tracking data recorded by the Analyze Motion, Match Move, or Stabilize tracking behaviors. The Track Points behavior is available in the Shape subcategory of behaviors. See Track shapes, masks, and paint strokes.

**Track**

Matches the position parameters of shapes, video clips, or filters
to a reference feature of a video clip. For example, you can match the Center parameter of a Circle Blur filter to a person’s face in a video clip. The Track parameter behavior can analyze motion in a video clip, then apply that tracking data to the position parameter of an object, or it can use existing tracking data recorded by another tracking behavior. The Track behavior is available in the Parameter subcategory of behaviors. See Track a filter’s position parameter.

Analyze the motion of a clip

The Analyze Motion behavior analyzes and stores tracking data from a clip. Analyze Motion data tracks are meant to be referenced by other tracking behaviors.

For a full description of Analyze Motion parameters, see Analyze Motion controls.

Note: Tracking in one pass rarely yields perfect results. For information on tracking methods and tips, see Basic strategies to improve tracking results.

Generate a tracking data using the Analyze Motion behavior

1. In the Layers list, Timeline, or Canvas, select the video clip to track, then click the Add Behavior pop-up menu in the tool bar and choose Motion Tracking > Analyze Motion.
Note: Alternatively, you can drag the Analyze Motion behavior from the Library onto the video clip in the Layers list, Timeline, or Canvas.

An onscreen tracker is added to the footage. By default, a single tracker appears at the center of the footage.

2. Play your background clip several times to determine a good reference point in the footage, then move the playhead to the frame where you want to start the track analysis.

3. In the Canvas, drag the tracker to the reference point you want to use.

Note: For more information on using the onscreen tracker, see Adjust onscreen trackers. For more information on selecting a tracking reference point, see Basic strategies to
4. To add more trackers, click the Add button in the Behaviors Inspector.

Each new tracker is added to the center of the footage.

The more trackers you use, the more spatial information you’ll record: One-point tracking records position data; two-point tracking and four-point tracking record position, rotation, and scale data (by comparing the relative change between the points); multiple-point tracking can record all the control points (vertices) on a shape.

5. Drag the additional trackers to the reference points you want to use.

**Note:** You can specify a portion of a clip to be analyzed. For more information, see Define a range of frames for analysis.

6. Click the Analyze button in the HUD or Behaviors Inspector.

When the tracking analysis begins, a progress window opens, and track points appear on a motion path in the Canvas. The track point at the current playhead position is emphasized.
The tracking keyframes contained in the behavior appear in the Keyframe Editor. (If the Keyframe Editor is not visible, click the Show/Hide Keyframe Editor button in the lower-left corner of the Motion project window.)

Because the Analyze Motion behavior is not applied to a source object or destination object, only the tracking keyframes appear in the Keyframe Editor. However, when you use a Match Move or Stabilize behavior, the tracking keyframes appear as well as the transform curves of the source object (for Stabilize) or destination object (for Match Move).

A confidence curve is also displayed in the Keyframe Editor. This curve provides a visual indication of the tracker’s accuracy relative to its parameter settings in the Inspector. The confidence curve is for reference only and is not used for editing purposes.
7. To stop a track analysis, click the Stop button in the progress window or press Esc.

**Tip:** If the tracker loses its reference pattern, do not click the Stop button. Allow the analysis to continue for a few seconds. When the tracker fails, the playhead jumps to the exact frame where the reference pattern was lost.

The analyzed track, contained in the Analyze Motion behavior, can now be loaded into other tracking behaviors. See Load existing tracking data into a tracking behavior.

---

**Match move an object to a background clip**

**Match moving overview**

The Match Move behavior analyzes the movement of a source object, then applies that movement data to a destination object. For example, using the Match Move behavior, you can lock a foreground graphic to the side of a moving bus, “pin” foreground video to a background TV screen, or mask a moving element for color-correction purposes.

To use a Match Move behavior, you need at least two objects in your project: a background or source object and a foreground or destination object. The source object provides movement data based on a tracking analysis of its video or its animation attributes (keyframes or behaviors applied to a shape, for example). The
movement from the source object is then applied to the destination object. The destination object can be a shape, text, a particle emitter, and so on. For step-by-step instructions, see Match move an object.

By default, the Match Move behavior applies a single tracker to analyze position data of a reference pattern (a small area of pixels) in a movie clip. However, you can optionally apply an additional tracker to analyze and record position, scale, and rotation (see About two-point tracking). Further, you can apply four trackers (a process known as corner pinning) to analyze and record position, scale, and rotation data of an object with four corners—a TV screen or billboard space on the side of a bus, for example (see Corner pin a foreground object).

For a full description of all adjustable Match Move parameters, see Match Move controls.

Match move an object

The Match Move behavior applies the movement data of a source object to a destination object.

To use a Match Move behavior, you need at least two objects in your project: a background or source object and a foreground or destination object. The source object provides movement data based on a tracking analysis of its video or its animation attributes (keyframes or behaviors applied to a shape, for example). The movement from the source object is then applied to the destination object. The destination object can be a shape, text, a particle emitter, and so on.
Match move a foreground object to a background clip

In this typical workflow, the Match Move behavior tracks an element of a background video clip and then applies the resulting track data to a foreground element. As a result, the foreground element matches the movement of the tracked element in the background clip.

1. Create a Motion project containing a video clip and a shape or image object.

   The video clip becomes the background element. The shape or image object serves as the foreground element.

2. Play the background clip several times to determine a good, clearly defined track analysis point.

   **Note:** The analysis of the Match Move behavior begins at the current playhead position. To define a tracking region, see Define a range of frames for analysis.

3. Select the foreground object, click the Add Behavior pop-up menu in the toolbar, then choose Motion Tracking > Match Move.

   **Important:** When applying the Match Move behavior to a group, make sure the footage being analyzed resides outside
of the group being tracked.

A single onscreen tracker (a red crosshair in a circle) is added to the Canvas. Because the default Match Move tracker records position data, it’s known as an anchor tracker. (In the Behaviors Inspector, you can deactivate this tracker by deselecting the Anchor checkbox.)

4. Determine if you need to activate additional trackers for two-point or four-point tracking.

- **Two-point tracking:** Analyzes and records position, rotation, and scale data using two trackers. To turn on two-point tracking, select the Rotation-Scale checkbox in the Behaviors Inspector (under the Anchor checkbox). When you do so, an additional tracker appears in the Canvas. For more information, see About two-point tracking.

- **Four-point tracking:** Analyzes and records position, rotation, and scale data using four trackers. Use this option to track the corners of a picture frame, television screen, or other rectangular element. To turn on four-point tracking, click the Type pop-up menu in the Behaviors Inspector, choose Four Corners, then proceed to Corner pin a foreground object.

5. Move the playhead to the frame where you want the track analysis to begin.

**Note:** You can specify a portion of a clip to be analyzed. For more information, see Define a range of frames for analysis.

6. In the Canvas, drag the tracker (or trackers) to the reference area (or areas) you want to track.
As you drag the tracker in the Canvas, the region around the tracker becomes magnified to help you find a suitable reference pattern.

7. Click the Analyze button in the HUD or Behaviors Inspector.

The behavior analyzes the movement of the reference pattern, and then matches the movement of the foreground object to it.

**Match move using animation data from keyframes or behaviors**

Because objects animated with keyframes or by behaviors already contain motion data, you can instantly apply that data to a destination object via the Match Move behavior (without having to perform a tracking analysis). The following simple example uses a magic wand image (made up of a rectangle shape) animated using the Spin behavior. The animation of the wand is applied to a particle emitter to create the illusion of sparkles flying off the tip of the spinning wand.

1. With the destination object selected, click the Add Behavior pop-up menu in the toolbar, then choose Motion Tracking >
Match Move.

In this example, a Match Move behavior is applied to a nonanimated particle emitter.

If the animated object is below the Match Move behavior in the Layers list, its animation data is automatically loaded into the Source well in the Inspector and HUD. If you don’t see the animated object in the Source well, drag the animated object from the Layers list into the Source well. In this example, the spinning Magic Wand Shape is the source animation.

2. In the Canvas, drag the destination object (the object to which you applied the Match Move behavior—in this case, the particle emitter) to the location you want.
In this example, the particle emitter is positioned at the tip of the wand. The motion path inherited from the source object appears in the Canvas, attached to the destination object.

As a result, the particle emitter and the wand now share the same animation path.

3. Play the project (press the Space bar).

The particles match the movement of the wand.

Reorder Match Move behaviors in the Layers list

When you add a Match Move behavior to a project, the closest active footage or animated object in the Layers list below the
behavior is automatically applied as the source animation. This source of animation appears in the Source well in the Behaviors Inspector. When you move Match Move behaviors in the Layers list, that data is reset. To retain the source animation data, rather than dragging to reorder layers, copy the Match Move behavior and paste it to another object.

1. Select the behavior to copy in the Layers list.
2. Choose Edit > Copy (Command-C).
3. Select the layer to apply the copied behavior to.

The copied behavior is applied to another object.

**Note:** You can also Option-drag the behavior in the Layers list to copy and paste it to a different object.

**About two-point tracking**

When you use two trackers in the Match Move behavior (two-point tracking), Motion analyzes and records not just the position parameter, but also the scale and rotation parameters. However, you can manually disable any of these parameters (in the Adjust row of the Behaviors Inspector) to achieve different effects.
In the following example, an oval shape (the foreground object) is match-moved to a video clip of picture frames (the background object) using two-point tracking. In the first three images below, only Position is enabled in the Adjust row of the Behaviors Inspector. As a result, although the camera pushes in toward the picture frames, the white elliptical shape does not change its scale or rotation based on the position of the two trackers.

In the next example, Position, Scale, and Rotation are enabled in the Adjust row of the Behaviors Inspector. Consequently, the white elliptical shape changes its position, scale, and rotation based on the position of the two trackers, matching the camera’s push toward the picture frames and preserving the illusion that the shape is physically attached to the picture frame.
Note: When using four-point tracking (corner pinning), scale and rotation are applied to the corner-pinned object. For more information, see Corner pin a foreground object.

SEE ALSO

Match Move controls

Corner pin a foreground object

For more control over tracking in a Match Move behavior, use the four-corner option, which lets you track four points on a background clip and apply the recorded motion to the four corners of a foreground object. There are two basic four-corner pinning workflows:

- After applying the Match Move behavior, use four-corner trackers to pin a foreground object to a background element: This workflow is useful when the pinned image is the same size as the background reference patterns to be tracked.

- Use onscreen controls to corner-pin a foreground object before applying the Match Move behavior: This method lets you position, resize, and rotate the foreground object to fit the background reference pattern.

Note: If the Match Move pinning methods described below fail to yield a successful track, try four-point tracking using the Analyze
Motion behavior as described in “Use the Analyze Motion behavior to track points,” below.

Use four-corner trackers to pin a foreground object to a background element

This workflow is ideal for a four-corner pin in which the transformed or pinned image is the same size as the background frame (or reference patterns) it’s being tracked to. In the following example, a foreground image is pinned to a background clip of a picture frame.

1. Drag the playhead to the frame where you want to start the track analysis, then apply a Match Move behavior to the foreground object.

   **Note:** If you’re corner-pining a 2D group, ensure that the Fixed Resolution checkbox is selected in the Group Inspector.

2. In the Behaviors Inspector, click the Type pop-up menu, then choose Four Corners.

   **Note:** If you’re corner-pining a 2D group, ensure that the Fixed Resolution checkbox is selected in the Group Inspector.
When you apply a Match Move behavior to a 3D group, the Four Corners option is not available. To corner-pin a 3D group, select the Flatten checkbox in the Group Inspector.

In the Canvas, a tracker appears at each corner of the foreground object’s bounding box. In the Inspector, the default track list (Anchor and Rotation-Scale), is replaced with the Top Left, Top Right, Bottom Right, and Bottom Left trackers.

3. In the Canvas, drag each tracker to a corner of the background element (in this example, the corners of the picture frame).

As you drag a tracker, a magnified inset appears to help you position each tracker.
4. Click the Analyze button in the HUD or Behaviors Inspector.

The foreground element is pinned to the background element; four motion paths show the transformation occurring at each corner.

To fine-tune the track (when the Type pop-up menu is set to Four Corners), you may need to make minor adjustments to the foreground element, such as modifying its scale or rotation. When you choose the Attach to Source option from the Transform pop-up menu in the Behaviors Inspector, you
cannot transform the tracked object. To transform the tracked object, choose Mimic Source from the Transform pop-up menu.

5. If necessary, make minor adjustments to the foreground element (such as modifying scale or rotation) by doing the following:

   a. Click the Transform pop-up menu in the Behaviors Inspector, then choose Mimic Source.

      The default option in the Transform pop-up menu (Attach to Source) does not permit transformations of the foreground element.

   b. Open the Properties Inspector and make any necessary adjustments to the foreground object using the Scale slider, Rotation dial, or other controls.

   For more information on the Mimic Source and Attach to Source transform options, see Match Move controls.

---

**Use onscreen controls to corner-pin a foreground object**

If you need to position, resize, or rotate the foreground object to fit the background reference pattern (an angled TV screen or picture frame, for example), use onscreen controls to adjust the foreground object before you apply the Match Move behavior.

1. Select the foreground object.
2. In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Distort tool.

3. Move the playhead to the frame where you want to start the track analysis.

   **Note:** You define a range of frames to be analyzed. For more information, see [Define a range of frames for analysis](#).

4. In the Canvas, drag each corner of the foreground object into the correct position.
You can fine-tune the corner positions by adjusting the Position, Rotation, Scale, and Four Corner controls in the Properties Inspector.

When you drag a corner in the Canvas, the Four Corner checkbox is selected in the Properties Inspector.

**Tip:** You can lower the opacity of the foreground object to better see the reference points on the background clip. You may also want to disable snapping so the image you are adjusting does not snap to the Canvas guidelines. To turn snapping on or off, choose View > Snap or press N.

5. Apply the Match Move behavior to the foreground object.

   In the Canvas, a tracker appears at each corner of the foreground object. In the Inspector, the default track list (Anchor and Rotation-Scale) is replaced with the Top Left, Top Right, Bottom Right, and Bottom Left trackers.

6. If necessary, drag each tracker in the Canvas to further fine-tune its position, watching the magnified view in the Tracker Preview area of the Inspector.
Important: To move the tracker positions independently of the foreground object, choose Mimic Source from the Transform pop-up menu in the Behaviors Inspector. When Attach to Source is chosen from the Transform pop-up menu, the foreground image is distorted when you drag the trackers in the Canvas.

7. Click the Analyze button in the HUD or Behaviors Inspector. The foreground object is pinned to the background element.

Note: If you adjust the Four Corner parameter for a layer and then apply a Match Move behavior, the Four Corner parameter is applied in the behavior. If you delete the behavior, the four corner settings for the layer remain. If you reset the Match Move behavior, the four corner settings are reset.

Use the Analyze Motion behavior to track points

If the Match Move pinning methods described above fail to yield a successful track, try four-point tracking using the Analyze Motion
behavior. In this workflow, the four-point tracking data collected from the Analyze Motion behavior is loaded into a Match Move behavior to corner-pin a foreground object.

1. Go to the frame where you want to start the track and apply an Analyze Motion behavior to the background element.

   By default, a single tracker appears in the Canvas.

2. Drag the tracker (Track 1) to a reference pattern in the top-left corner of the background element.

   **Note:** For four-point analysis, the trackers should be positioned in a clockwise order, starting in the upper-left corner. This ensures the proper alignment of your element when the transformation is applied.

3. In the Behaviors Inspector, click Add to add a second tracker, then drag the second tracker (Track 2) to a reference pattern in the top-right corner of the background element.

4. Add another tracker (Track 3) and drag it to a reference
pattern in the bottom-right corner of the background element.

5. Add another tracker (Track 4) and drag it to the reference pattern in the bottom-left corner of the background element.

6. Click the Analyze button in the HUD or Behaviors Inspector.

   The track is generated and its data is saved in the behavior.

7. Apply a Match Move behavior to the foreground element you want to corner-pin.

8. In the Match Move area of the Behaviors Inspector, click the Action pop-up menu (with the gear icon), then choose the Analyze Motion track.

   Doing so applies the Analyze Motion tracking data recorded in step 6 to the Match Move behavior.

9. In the Match Move area of the Behaviors Inspector, click the Type pop-up menu, then choose Four Corners.

   The four-point tracking data from the Analyze Motion behavior is applied to the foreground object.

**Note:** In a Match Move behavior with four-point tracking, trackers are placed in the correct order (clockwise from the top left) in the Canvas after you choose Four Corner from the Type pop-up menu in the Behaviors Inspector. You can reorder the trackers by clicking the Top Left, Top Right, Bottom Right, and Bottom Left pop-up menus, then choosing new ordering options.
Remove parallax from a 3D group

When you match move 3D groups that contain objects offset in Z space (depth), *parallax* is simulated. Parallax is the apparent shift of an object against a distant background caused by a shift in perspective, such as a change in camera position. You can disable this effect, if necessary, by doing the following:

- Select the Flatten checkbox for the tracked group in the Group Inspector.

The parallax effect is removed.

About combining animation and tracking data

When the destination object in a match move operation has no animation of its own, it precisely follows the motion of the source object. However, if the destination object is animated (has its own applied behaviors or keyframes), more complicated motion effects can be achieved by combining motion paths.
You can specify whether the animation of the destination object is ignored by or added to the Match Move behavior. You do this in the Match Move Behaviors Inspector, by choosing one of two options from the Transform pop-up menu: Attach to Source or Mimic Source.

- **Attach to Source:** Applies the movement of the source object to the destination object, but disables any animation inherent in the destination object. (However, you can reactivate the destination object’s own animation and deactivate the source object’s recorded track by turning off the Position, Scale, and Rotation buttons in the Adjust row of the Behaviors Inspector.)

- **Mimic Source:** Combines the motion paths of the source object and destination object’s own animation. In other words, the destination object maintains its own animation while at the same time mimicking the motion in the source object’s recorded track. When the Match Move behavior is set to Mimic Source, turning off the Position, Scale, and Rotation buttons deactivates the source object’s recorded track. For more information on Attach to Source and Mimic Source, see [Match Move controls](#).

### Stabilize a shaky clip

Use the Stabilize tracking behavior to smooth shaky motion in a movie or image sequence. For a full description of Stabilize parameters, see [Stabilize controls](#).

Using the Stabilize behavior, there are three ways to analyze a clip:
Use the default advanced motion analysis technique that evaluates the entire frame of a clip to extract movement data without using onscreen trackers.

Use onscreen trackers that analyze a reference pattern (a small group of pixels) in the Canvas. These are the same trackers used by the Match Move and Analyze Motion behaviors.

Use a combination of the advanced motion analysis and onscreen trackers.

**Important:** For information on using onscreen trackers with the Stabilize behavior, see Improve stabilization.

The Stabilize behavior is primarily useful for removing unwanted trembling from less-than-stable crane or jib arm moves, eliminating teetering from handheld walking shots, or reducing vibrations in automotive shots.

**Note:** Motion blur present in the image remains, even though the subject in the shot is smoothed or locked.

## Stabilize a clip using the Stabilize behavior

1. Apply a Stabilize behavior to the clip you want to stabilize.

**Note:** Unlike other behavior workflows, the Stabilize behavior’s automatic mode analyzes the entire clip from its first frame, rather than from the current playhead position. Additionally, onscreen track points are not created when using the default motion analysis in the Stabilize behavior.
2. In the Behaviors Inspector, set the options for the analysis:

   a. Click the Method pop-up menu, then choose one of the following options:
      
      - *Stabilize:* Locks down an image, removing problems such as camera shake. The resulting effect is similar to footage shot on a camera mounted to a stationary tripod.
      - *Smooth:* Eliminates camera jitter while maintaining the general motion of the camera.

   b. Click the Borders pop-up menu, then choose one of the following options:
      
      - *Normal:* Maintains the size of the stabilized footage. Resulting transformations made to the stabilized image may cause moving black borders to appear around the edges of the clip. A very shaky clip results in large black borders.
      - *Zoom:* Expands the clip to the full size of the Canvas, preventing black borders from appearing around the edges of the stabilized clip.
c. Click the Direction pop-up menu, then choose one of the following options:

- **Horizontal and Vertical**: Applies the stabilize transformation to the X and Y dimensions.
- **Horizontal**: Applies the stabilize transformation to the X dimension.
- **Vertical**: Applies the stabilize transformation to the Y dimension.

d. Enable or disable the Adjust buttons, as follows:

- **Position**: Enable this button to apply the analyzed position data to the clip. (The X and Y position changes in the footage are smoothed or stabilized.) To stabilize the X and Y position of the shot and leave scale or rotation changes intact, enable Position and disable
Scale and Rotation.

- **Scale**: Enable this button to apply any analyzed scale data to the clip. (Scale changes in the footage are smoothed or stabilized.) To stabilize or smooth changes in scale and leave position or rotation changes intact, enable Scale and disable Position and Rotation. (The Scale option is not related to the Zoom option in the Borders pop-up menu.)

- **Rotation**: Enable this button to apply analyzed rotation data to the clip. (Changes in the rotation of the footage are smoothed or stabilized.) To stabilize or smooth changes in rotation in the shot and leave position or scale changes intact, enable Rotation and disable Position and Scale.

For the smoothest result, enable all three Adjust buttons (Position, Scale, and Rotation).

**Note**: You can change the Method, Borders, Direction, and Adjust parameters before or after the clip is analyzed.

3. In the Behaviors Inspector or HUD, click the Analyze button.

**Note**: The clip is stabilized according to defined parameters. Unlike Motion trackers, the default Stabilize analysis does not create keyframes in the Keyframe Editor. However, the stabilized object’s transformation can be converted to keyframes. For more information, see Advanced strategies to improve tracking results. When trackers are added to and analyzed with the Stabilize behavior, keyframes are created.

For more information on correcting problems associated with
stabilization, see Improve stabilization.

Limit the area analyzed by the Stabilize behavior

When stabilizing a clip, you can define an area to be analyzed. During analysis, the area outside the region is ignored. Use this option for faster processing of a clip.

1. In the Layers list, select a Stabilize behavior.

2. In the Behaviors Inspector, then select the Track Region checkbox.

   A transparent red overlay representing the track region appears in the Canvas.

3. Do any of the following:
   
   - **Change the position of track region**: Drag in the region.
   
   - **Resize the track region**: Drag a handle on the bounding box of the region. The corner handles simultaneously resize width and height; the top and bottom center handles resize height; the left and right center handles resize width.
   
   - **Resize the track region from its center**: Press Option while dragging a handle.

   - **Change the angle of the track region**: Drag the rotation handle in the center of the track region.
4. After defining the track region, click the Analyze button in the Behaviors Inspector.

Because analysis takes place in the defined track region, the clip is analyzed more quickly.

---

**Unstabilize a clip**

Use the Unstabilize tracking behavior to reapply camera shake or movement into a finished clip.

The Unstabilize behavior’s sole function is to apply movement recorded by a Stabilize behavior, letting you match the camera movement from a background clip to foreground elements, or to unstabilize a stabilized clip.

**Note:** A project must include a Stabilize behavior with recorded motion data before you can use the Unstabilize behavior.
1. Select the object to unstabilize, click the Add Behavior pop-up menu in the toolbar, then choose Motion Tracking > Unstabilize.

   The behavior is added. If a Stabilize behavior (that has completed an analysis) is present in the project, the Stabilize data is applied to the Unstabilize behavior.

2. If you don’t want to use the automatically selected Stabilize behavior, do one of the following:
   - In the HUD or Behaviors Inspector, click the Action pop-up menu (with a gear icon), then choose a Stabilize behavior.
   - Drag an analyzed tracking behavior from the Layers list to the Source well in the HUD or Behaviors Inspector.

   The motion is applied to the destination object.

Define a range of frames for analysis

With the exception of the Stabilize behavior, the tracking behaviors begin their analysis at the current playhead position. The Stabilize behavior’s automatic analysis mode starts from the beginning of a clip (regardless of the playhead’s position). You can specify what portion of a clip is analyzed by setting In and Out points for the clip, or by trimming the tracking behavior in the...
You can also track a specific range of frames by adjusting the start and end points of the purple Analyze Motion bar in the Timeline or mini-Timeline.

**Change the In point of the tracking behavior**

Do one of the following:

- Position the playhead at the correct frame, select the clip, then choose Mark > Mark Play Range In (or press Option-Command-I).

- Adjust the start point of the purple tracking behavior bar in the Timeline or mini-Timeline

![Timeline screenshot](image)

Drag the In point to the right to delay the beginning of the tracking behavior’s analysis.

**Note:** If you adjust the length of the tracking behavior bar, make sure to set your tracking reference points within the range of the behavior.

**Change the Out point of the tracking behavior**
Change the Out point of the tracking behavior

Do one of the following:

- Position the playhead at the correct frame, select the clip, then choose Mark > Mark Play Range Out (or press Option-Command-O).

- Adjust the end point of the purple tracking behavior bar in the Timeline or mini-Timeline.

Note: If you adjust the length of the tracking behavior bar, make sure to set your tracking reference points within the range of the behavior.

Note: If you’re performing a reverse track analysis, set In and Out points for your track.

Load existing tracking data into a
tracking behavior

If you’ve already recorded tracking data (via the Analyze Motion behavior, for example), you can load that data into a Match Move, Stabilize, or Unstabilize behavior in your project. Likewise, if your project contains animation (via keyframes or an applied behavior), you can load that animation data into a tracking behavior. When you do so, motion data from one object is applied to another object in your project.

1. In the Layers list, select an object to receive tracking or animation data.

2. Click the Add Behavior pop-up menu in the toolbar, choose Motion Tracking, then choose Match Move, Stabilize, or Unstabilize.

The new tracking behavior is added to the Layers list, under the selected object. If your project already contains tracking data or animation data (from an Analyze Motion behavior or from keyframed animation, for example), that data is automatically applied to the new behavior (when the In the new behavior is below the object with tracking or animation data in the Layers list). And the source of the data appears in the Behaviors Inspector and HUD (in the Source well).

If the Source well is empty, you must manually apply tracking or animation data, as described in the next step.

3. To manually apply tracking data to the new behavior, do one of the following:
In the Behaviors Inspector or HUD, click the Action pop-up menu (with a gear), then choose a new source for tracking data.

From the Layers list, drag a tracking behavior, footage with tracking data, or animated object to the Source well in the HUD or Behaviors Inspector.

In the Layers list drag a tracking behavior, footage with tracking data, or animated object onto the new tracking behavior in the Layers list.

Tracking or animation data is applied to the new behavior, and the source of that data (a video clip or animated object) appears in the Source well in the Behaviors Inspector or HUD.

**Note:** To clear a Source well, drag the item away from the well and release the mouse button.

---

**Track shapes, masks, and paint strokes**

The Track Points behavior (located in the Shape Behaviors category) is designed for use with shapes, masks, and paint
Use the Track points behavior in the following ways:

- To track the control points of a shape or mask to a clip (for example, when rotoscoping)
- To apply tracking data from another tracking analysis to the control points of a shape or mask
- To apply the animation of an object to the control points of a shape or mask

The Track Points behavior does not work with simple shapes (made with the Rectangle, Circle, and Line tools) because they contain no control points. If you apply a Track Points behavior to a simple shape, a dialog appears asking if you want to convert the shape to apply the Shape behavior.

**Note:** To apply the analyzed movement of an object to a shape or mask as a whole (not to the shape’s control points), use the Match Move behavior.

For a full description of the Track Points parameters, see Track Points controls.

---

**Track a mask using the Track Points behavior**

In the following example, the Track Points behavior is applied to a loose mask of seven control points, isolating a car in a background clip.
1. With a background clip visible in the Canvas, use a mask tool to isolate part of the background clip.

For more information on working with masks, see Masks and transparency overview.

2. Select the mask object, then click the Add Behavior pop-up menu in the toolbar and choose Shape > Track Points.

The behavior is added to the mask object, and trackers appear for each control point on the shape. The trackers are arrayed in the same order that the shape was drawn: Control Point 1 is Track 1, Control Point 2 is Track 2, and so on.

3. Drag the trackers to fine-tune their position on the reference patterns of the background footage.

As you drag, a magnified inset view of the area around the tracker appears.
4. To disable a tracker, deselect its checkbox in the Behaviors Inspector.

**Note:** Control points without an associated tracker are not modified.

5. Click the Analyze button in the HUD or Behaviors Inspector.

The mask control points are tracked to the reference patterns in the background footage.

In this example, a mask is tracked to a moving car so the car can be isolated from the rest of the clip. The illustration on the left shows the original unmodified clip. In the illustration on the right, the tracked mask isolates the car, allowing separate effects to be applied to the car and its background even though they’re part of the same image. The mask protects the car from the effects of the heavy blur and desaturation.
As with all behaviors, you can drag or copy (by Option-dragging) a Track Points behavior to a new shape in the Layers list. When you apply the behavior to a new shape, the trackers are applied to the control points of the new shape. If the new shape has more control points than the originally tracked shape, only the original track points are applied. For example, if the originally tracked shape has three control points, and the new shape has five control points, trackers are applied to the first three control points of the new shape. If the new shape has fewer control points than the originally tracked shape, trackers are applied to the existing points on the new shape.

**Note:** Paint strokes usually have a large number of control points. Simplify a paint stroke by deleting or disabling control points before applying a Track Points behavior to the stroke. To track the stroke as a whole, rather than by its control points, use the Match Move behavior. For more information about paint strokes, see [Paint strokes overview](#).

---

**Apply the animation of one shape to the control points of another shape**

Applying the animation of one animated shape to another is an
easy way to create fun, complementary animations in which the objects appear to play with each other. For this workflow, your project must contain an object animated with keyframes or behaviors.

1. In a project that contains two shapes, animate one of the shapes using keyframes or a Basic Motion behavior.

   In this example, a simple line shape is animated with the Spin behavior.

   For more information about animating with keyframes, see Keyframing overview. For more information about Basic Motion behaviors, such as the Spin behavior see Spin.

2. Apply the Track Points behavior to a nonanimated shape.

   The Track Points behavior inherits the animation data of the animated object closest to it in the Layers list. (A thumbnail of the animated object appears in the Source well of the Track Points Behaviors Inspector.)

   In this example, the Track Points behavior is applied to a Bezier shape.
**Note:** To reference different animated object, drag that object to the Track Points behavior’s Source well in the Behaviors Inspector or to the behavior object in the Layers list.

3. In the Behaviors Inspector, click the Transform pop-up menu, then choose Attach to Source.

The spinning animation of the line is applied to the Bezier shape. The Bezier shape changes form because the vertex tangents match the transformation of the source animation.

4. To align the tangents to the transformation of the source object, select the Align Tangents checkbox in the Behaviors Inspector.

The spinning animation of the line is applied to the Bezier shape. The tangents remain aligned at their original angles along the shape.
**Note:** By default, the Transform pop-up menu is set to Mimic Source. For more information on the Transform pop-up menu, see Track Points controls.

---

**Track a filter’s position parameter**

The Track behavior (in the Parameter category of behaviors) lets you track a position parameter of an object. For example, you can track the center of a Light Rays filter to a moving light in a clip.

**Note:** This behavior applies only to filters with position parameters, such as Scrape, Ring Warp, Light Rays, Slit Tunnel, and so on.

For a full description of adjustable controls in the Track behavior, see Track controls.

---

**Track the parameter of a filter**

1. In the Canvas, position the center point of the filter over the reference pattern.
In this simple example, the center point of a circle blur is positioned over the license plate of a car.

2. In the Filters Inspector, Control-click the Center parameter, then choose Add Parameter Behavior > Track from the shortcut menu.

In the Canvas, the filter’s onscreen control is replaced with a tracker. The Behaviors Inspector becomes active, and the Track behavior parameters are displayed.

**Note:** In the Filters Inspector, a behavior icon (a gear) appears next to the Center parameter, indicating that it’s influenced by a behavior.

If necessary, adjust the tracker in the Canvas. If the reference pattern you want to track is offset from the center of the filter, use the Offset Track checkbox. For more information on using the Offset Track parameter, see Track obscured or off-frame points.

3. Click the Analyze button in the HUD or Behaviors Inspector.

The filter’s center is tracked to the clip. You can make changes to the filter parameters after the analysis is performed.
Adjust onscreen trackers

Many tracking behaviors use onscreen trackers (a crosshair in a circle, shown below) that you can position to analyze an area of pixels (a reference pattern).

The default onscreen tracker color is red. Depending on the color of your subject, you might need to change the color of the tracker to see the tracker in the Canvas.

When the tracking analysis begins, a progress window opens and track points appear in the Canvas, representing the post-analysis motion path (the path that looks like a string of pearls). The track point at the current playhead position is emphasized.

**Note:** Track points in the Canvas correspond to the tracking keyframes that appear in the Keyframe Editor.

You can adjust and customize onscreen trackers.

**Position the tracker**

1. Drag the tracker in the Canvas.
As you drag, a magnified inset shows the tracker’s position, and an info window displays the tracker coordinates. The magnified inset is a visual aid for positioning the tracker and does not represent a search region or reference pattern.

The magnified inset also appears as a Tracker Preview area in the Behaviors Inspector.

2. Fine-tune the tracker position by doing one of the following:
   - Drag in the Tracker Preview area.

   As you drag in the preview area, the tracker in the Canvas also updates.
If you use rotated footage, the rotation is not reflected in the Tracker Preview area in the Inspector. However, the rotation is reflected in the magnified visual aid in the Canvas.

- At the bottom of the Behaviors Inspector, click the track’s disclosure triangle, then use the Position controls to numerically adjust the tracker’s position.

**Note:** You can Option-drag in the Tracker Preview area to override the pattern search size. Option-drag left to reduce the size of the search pattern in the Canvas, and Option-drag right to increase the pattern search size. Alternatively, you can modify the search size using the Track Size slider in the track parameters.

---

**Move multiple trackers at the same time**

- Drag to select or Shift-select the trackers in the Canvas, then drag the selection to a new position.

A selected tracker appears yellow.

**Note:** Because you risk moving onscreen trackers when Shift-selecting, dragging to select may be a better option.

---

**Turn off onscreen trackers**

Do one of the following:

- Control-click a tracker in the Canvas, then choose Hide
Selected Tracker from the shortcut menu.

- In the Behaviors Inspector, deselect the relevant Track checkbox.

When a tracker is deselected, it’s not used in the analysis.

---

**Turn on onscreen trackers**

- In the Behaviors Inspector, select the relevant Track checkbox.

---

**Change the color of the onscreen tracker**

1. Select the tracker in the Canvas, then open the Behaviors Inspector.

2. Click the track’s disclosure triangle and use the Color controls to change the color of the tracker.

For more information, see [Basic color controls](#).
Guidelines for better tracking

Tracking guidelines overview

Selecting a good tracking reference pattern in a movie or image sequence is pivotal in achieving accurate motion-tracking results. However, tracking a single reference pattern with a single analysis pass rarely yields a perfect result. More often, a successful track combines automatic and manual tracking, experimenting with parameter settings, and resetting reference points at various locations in the clip. For more information, see Basic strategies to improve tracking results.

Additionally, a successful track may employ more advanced techniques, such as smoothing a track curve or converting tracking data to modifiable animation curves in the Keyframe Editor, or manually coaxing your tracking analysis. For more information, see Advanced strategies to improve tracking results.

Basic strategies to improve tracking results

Use the following basic techniques to improve your tracking results:

Find a good reference pattern

- Play the footage several times to locate a reference pattern...
that satisfies as many of the following rules as possible:

- Contains perpendicular edges, such as dots, intersections, and corners. Lines and straight boundaries should be avoided.
- Is a high-contrast pattern.
- Contains smooth or even changes in brightness or color. An example of an uneven color or brightness change is a sharp-edged shadow that passes over your reference pattern.
- Appears in every frame of the clip (does not move offscreen or become obscured by other objects).
- Is distinct from other patterns in the same neighborhood in the clip.

Manually modify track points

If you’re not satisfied with the location of a track point on a post-analysis motion path, you can drag an individual track point to adjust its position.

1. Position the playhead at the frame you want to modify.

   The track point at the playhead position is highlighted.

2. Do one of the following:
   - Drag the highlighted track point in the Canvas to adjust its position.
   - Drag in the Tracker Preview area in the Behaviors
For fine-tuning, you can zoom in and out of the clip using the Zoom tool. The zoom follows the pointer, so place the pointer on the track point in the Canvas and drag right to zoom in. Drag left to zoom out of the clip. To return to normal view, choose 100% from the Zoom Level pop-up menu (above the right side of the Canvas). If you have a Multi-Touch trackpad, pinch open or closed to zoom in or out, then scroll the zoomed view using two-finger swipes.

You can also adjust a tracking curve in the Keyframe Editor. For more information on using the Keyframe Editor, see Keyframing overview.

Delete bad keyframes in the Keyframe Editor

When an analysis is complete, you might need to retrack a portion of the clip. Rather than tracking over bad tracking keyframes, delete bad keyframes before retracking. If bad keyframes are not deleted, the tracking behavior may continue to use the old reference point.

1. Position the playhead at the frame where you want to retrack the reference pattern.

2. In the Keyframe Editor, drag to select the keyframes you want to delete.

If the Keyframe Editor is not visible, click the Show/Hide
3. Control-click in the Keyframe Editor, then choose Cut from the shortcut menu (or press Delete).

4. In the Canvas, drag the tracker to the reference point, then click Analyze.

New track keyframes are created.

**Tip:** When dealing with multiple problem trackers, you can turn off the trackers you’re not correcting to simplify your view in the Keyframe Editor. Additionally, when fine-tuning tracks in the Keyframe Editor, you can simplify what appears in the graph. The following image displays all curves for a simple four-corner pin.

To solo a curve, Option-click the parameter’s checkbox in the Keyframe Editor’s parameter list.
Delete bad track points in the Canvas

You can also delete bad track points in the Canvas, during or after analysis.

**Note:** Track points in the Canvas correspond to keyframes in the Keyframe Editor.

1. During analysis, press Esc to stop the tracking.
   
   If you’ve already completed the analysis, go to step 2.

2. In the toolbar, ensure that the Adjust Item tool is selected.

3. Ensure that a track point is active in the Canvas.
   
   You can to zoom into the Canvas to better see the active track points. The track point at the current playhead position appears larger than other track points.
Note: If you press Delete when a track point is not selected, the entire path is deleted.

4. Do one of the following:

- Press Delete to delete the track point at the current position of the playhead.

- Move the playhead to the frame where you want to begin deleting track points, and press Delete.

Each press of the Delete key removes one track point. Only active track points are deleted.

Tip: The direction in which track points are deleted is determined by the Reverse checkbox in the Behavior Inspector. When Reverse is deselected, each track point you delete moves the playhead toward the beginning of the clip. When Reverse is selected, each track point you delete moves the playhead toward the end of the clip.

Ask Motion for a hint

You can have Motion display suggested tracking points. You need at least one tracker in the Canvas to display suggested tracking reference points.
Press the Option key, place the pointer over a tracker in the Canvas, then hold down the mouse button.

The suggested reference points appear in the Canvas on the footage and in the magnified inset as small red crosshairs.

When you move a tracker toward a suggested point, the tracker snaps to the point. The suggested points are not necessarily ideal tracking reference points for the feature you want to track in the clip. Motion is merely picking locations in the current frame that meet the reference pattern criteria, such as an area of high contrast.

Remove interlacing (fields) from a clip before tracking
Select the footage in the Media list of the Project pane, then choose an option from the Field Order pop-up menu in the Media pane of the Inspector.

**Note:** Interlacing can be present in clips stabilized using the automatic analysis mode in the Stabilize behavior.

---

**Perform multiple stabilization analyses on a shaky clip**

If a clip is particularly shaky, it may be necessary to stabilize the clip more than once to remove camera movement not corrected in the first stabilization analysis.

- **Stabilize a clip, export the clip, import the clip, then stabilize the clip again.**

  For more information, see [Improve stabilization](#).

---

**Sharpen a clip’s reference area**

A sharp, high-contrast pattern can provide a good tracking reference area. You may be able to sharpen the reference pattern of a clip by applying any filter to a clip before tracking. The tracker analyzes the clip, but not the result of a filter applied to the clip.

1. Apply the **Sharpen filter** to the clip and adjust its parameters in the Filters Inspector.

2. **Export the clip**, reimport the clip into your project, then delete
3. Perform your tracking operation again.

Because the tracker analyzes the clip, not the result of a filter applied to the clip, the clip must be exported and reimported to your project.

Advanced strategies to improve tracking results

Use the following advanced techniques to improve your tracking results.

Smooth a track curve in the Keyframe Editor

You can smooth a track with the Keyframe Thinning function. Before smoothing the curve, you might want to copy the behavior (as a backup) to the Library or duplicate the behavior in the project. (For information on saving items to the Library, see Save custom objects to the Library.

In the following graph, there’s a keyframe at every frame, and the curve is quite jagged. The following example shows how you can simplify and smooth this curve.
1. In the parameter list of the Keyframe Editor, click in the fifth column of the keyframed parameter to open the Animation menu, then choose Reduce Keyframes.

The Reduce Keyframes dialog appears.

The Reduce Keyframes dialog applies a thinning algorithm to the keyframes for the parameter, reducing the number of keyframes while attempting to maintain a similar curve shape. The thinning algorithm can be adjusted in two ways. Increasing the Error Tolerance results in fewer keyframes. Increasing the Smoothing (frames) makes smoother curves between keyframe values.

This example uses 5, which means that 5 track points centered on the evaluated point are used to compute the current point’s new, smoothed value. This is a standard Gaussian (bell-curve-type) filter. In other words, if you leave the Smoothing value at 5, when the value of frame 12 is computed, frames 10, 11, 12, 13, and 14 are considered. If Smoothing is set to 3, the algorithm uses frames 11, 12, and 13. The larger the Smoothing value, the more points are
considered (and thus more calculations done) for every point in the curve.

2. Adjust the sliders to smooth the curve:
   
   - *Error Tolerance:* Drag right to reduce the number of keyframes used in the curve.
   
   - *Smoothing (frames):* Drag right to create smoother curves between keyframes.

   The Smoothing control modifies the curve by calculating, for each track point, the average of its neighboring track points, then applying that new value to the evaluated track point. The value set in the Smoothing slider specifies how many neighboring track points to average. In other words, if you leave the Smoothing value at 5, when the value of frame 12 is computed, frames 10, 11, 12, 13, and 14 are averaged; and if Smoothing is set to 3, frames 11, 12, and 13 are averaged. The larger the Smoothing value, the more points are considered (and thus more calculations done) for every point in the curve.

   As you adjust the sliders in the dialog, the curve is modified in the Keyframe Editor. There are now fewer keyframes on the curve, and the curve becomes smoother.

3. Click OK.
Apply an Average parameter behavior to a track curve

Another smoothing option is to apply the Average parameter behavior to a track curve in the Keyframe Editor. This behavior smooths the transition from one keyframe value to another. Averaged motion moves more fluidly.

- In the parameter list of the Keyframe Editor, control-click the name of the keyframed parameter, then choose Average from the shortcut menu.

The track is averaged, and its curve is simplified in the Keyframe Editor.

For more information on using the Average parameter behavior, see Average.

Convert motion tracks to keyframes

Tracking data recorded or referenced by the Match Move, Stabilize, or Unstabilize behavior can be “baked” into keyframes on the transformed object. The tracking keyframes are applied to the tracked object, and the behavior is deleted. You can then modify the animation curves in the Keyframe Editor.

Because the Analyze Motion behavior does not transform the image, analyzed tracks cannot be converted into keyframes. However, a Match Move or Stabilize behavior that references data from an Analyze Motion behavior can be converted into
keyframes.

1. Select the Match Move, Stabilize, or Unstabilize behavior to convert.

2. Choose Object > Convert to Keyframes (or press Command-K).

   A dialog appears confirming the conversion.

3. Click Convert.

   The behavior is converted into editable keyframes and the tracking behavior is deleted.

For more information on converting behaviors to keyframes, see Convert behaviors to keyframes. For more information on using the Keyframe Editor, see Keyframing overview.

---

**Define look-ahead frames**

When using the Analyze Motion behavior, you can direct a tracker where to look in a later frame for its reference pattern. This tool is ideal for the following types of clips:

- Clips that contain fast-moving features
- Clips with subjects moving in a relatively straight vector (with or without obstructions)
- Clips with swish pans (you may need to reset the “look-ahead” tracker at each panning change)

**Important:** If your track fails and you reposition your tracker, you
must also reset the look-ahead tracker in the Canvas to provide a new motion vector from the new reference point.

1. Apply an Analyze Motion behavior to a clip.

2. In the Canvas, position the tracker on a reference pattern.

   In the following image, the tracker is positioned on a reference pattern on the front bumper of the car.

![Tracker on car bumper](image)

3. In the Behaviors Inspector, adjust the Look Ahead Frames slider to specify how many frames you want the tracker to look ahead.

   **Note:** The maximum default for the Look Ahead Frames slider is 10 frames. However, you can enter a larger frame amount using the adjacent value slider.

4. While holding down the Command key, drag the tracker in the Canvas in the direction the reference pattern is moving in the clip.

   As you Command-drag the track point, a magnified inset displays the frame specified in the Look Ahead Frames parameter.
5. When the look-ahead tracker is positioned on the reference pattern, release the mouse button.

When you click the Analyze button, the new reference point is used as the tracking pattern.

**Note:** Look Ahead Frames can be used when tracking in reverse. When the Reverse checkbox is selected in the tracking behavior’s parameters and you use the Look Ahead Frames parameter, you’re looking at previous frames rather than future frames. The Reverse checkbox is only available for the Analyze Motion, Track (in the Parameter behaviors category), and Track Points (in the Shape behaviors category) behaviors.

---

**Manually coax a motion track using the Record button**

For challenging tracks, you can manually insert track position keyframes to help guide the tracker toward a reference pattern. For example, if you have footage with significant motion blur or objects that partially obscure the tracking pattern, you can manually create tracker position keyframes to help guide the tracker.
1. Apply a Motion Tracking behavior to the clip, then press A to enable keyframe recording.

2. In the Canvas, position the tracker at the reference point you want to track.

   A track position keyframe is created in the behavior (visible in the Keyframe Editor).

3. Navigate to the next frame where you want to create a keyframe.

   **Note:** You can press Shift–Right Arrow key to jump forward ten frames, or press Shift–Left Arrow key to jump backward ten frames.

4. In the Canvas, position the tracker at the reference point you want to track.

5. Repeat steps 3 and 4 until you’ve completed the track.

6. In the Behaviors Inspector, click the disclosure triangle for the track you’ve manually adjusted, then choose Use Existing Keyframes from the Fail Behavior pop-up menu.

7. Press A again to turn off keyframe recording.

8. Go to the first frame of the clip, then click the Analyze button in the behavior HUD or Inspector.

   **Important:** Even though keyframes are created, you must analyze the footage to obtain the tracking data.
Manually coax a motion track without enabling keyframe recording

1. Apply a Motion Tracking behavior to the clip.

2. In the Canvas, position the tracker at the reference point you want to track.

3. Choose Object > Add Position Keyframe.
   
   This command is available for the Analyze Motion, Match Move, Stabilize (when you use manual trackers), Track Points, and Track behaviors.

   **Note:** Keyframes cannot be created for automatically stabilized footage. Use the Track Region option for adjusting automatic stabilization, or convert the stabilized footage to keyframes. For more information on the Track Region parameter, see Stabilize a shaky clip. For more information on converting tracking data to keyframes, see “Convert tracks to keyframes” above.

4. Navigate to the next frame where you want to create a keyframe.

5. Repeat steps 2–4 until you’ve completed the track.

6. In the Behaviors Inspector, click the disclosure triangle for the track you’ve adjusted, then choose Use Existing Keyframes from the Fail Behavior pop-up menu.

7. Go to the first frame of the clip, then click the Analyze button in the Behaviors Inspector.
Note: You can also use the Tracker Preview in the Behaviors Inspector to reposition trackers in the Canvas.

Important: Even though keyframes are created, you must analyze the footage to obtain the tracking data.

---

**Edit the analysis data**

If none of the prior solutions helps, you can review the analysis data in the Keyframe Editor, then manually adjust or delete problem tracking point data.

Note: This technique is applicable only to trackers that you can adjust in the Canvas or Behaviors Inspector.

1. In the Layers list or Timeline, select an applied behavior.

2. In the Keyframe Editor, review the Confidence parameter for frames where the values are very low; if you see unusual spikes at the frames where the Confidence curve value is low, proceed to step 3.

3. Choose Object > Convert to Keyframes (or press Command-K).

   A dialog appears confirming the conversion.

4. Click Confirm.

   The behavior is converted into editable keyframes and the tracking behavior is deleted.
5. In the Layers list or Timeline, select the clip.

6. In the Keyframe Editor, modify or delete the points where the Confidence value is low.

For more information, see Add or delete keyframes or Modify keyframes.

Track perspective, scale, or rotational shifts

For images with significant change in size and angle, you can try a few different strategies.

Use a larger search area

- In the Behaviors Inspector, click the track’s disclosure triangle to display the Search Size parameter, then increase the value.

Lower the Fail Tolerance value

- In the Behaviors Inspector, click the track’s disclosure triangle to display the Fail Tolerance parameter, then decrease the value. With a lower Fail Tolerance value, the tracker is more likely to find a false match. With a higher value, the tracker is more strict in finding a match.
Begin the analysis at the clip’s midpoint

- Move the playhead to midpoint frame of the clip, and click Analyze in the Behaviors Inspector to track forward to the end frame of the clip; then return to the midpoint frame, click the Reverse checkbox in the Behaviors Inspector, and click Analyze to track backward to the beginning of the clip.

Track obscured or off-frame points

In addition to experimenting with tracker parameter settings, there’s a basic technique to correct track points that become obscured by moving offscreen or by an object passing in front of them.

The following sequence is a simple example of a candidate for offset tracking. As the car moves forward, it passes a tree that temporarily obstructs the reference pattern.

When the reference pattern becomes obscured, use the Offset Track checkbox to move the tracker, picking a new reference pattern in a different area from the original reference pattern. The offset between the original reference pattern and the new pattern is calculated to maintain continuity in the resulting track path.

In the following example, the track is obscured by a tree, so the
tracker is moved to a nearby reference pattern, and tracking continues until the original pattern reappears. Even though one region is examined, the points are saved in another region. The second tracking pattern should travel in the same direction as your original pattern.

---

**Offset (move) the onscreen tracker control to an unobstructed area of the image**

1. Go to the frame where you want to begin the offset track.

   When a track is lost during an analysis, Motion jumps back to the frame where the track failed. The bad track point is usually identified by an “x” in the Canvas.

   ![Image of car with track point highlighted]

2. Select the Offset Track checkbox in the HUD or Behaviors Inspector.

   ![Screenshot of HUD with Offset Track checkbox selected]

**Note:** The Offset Track parameter is available in the Analyze
Motion, Match Move, Stabilize, Track Points, and Track behaviors. Before the parameter becomes available in the Stabilize behavior, you must manually add a tracker using the Add button in the Inspector.

3. In the Canvas, drag the tracker (the crosshair in the circle) to a new, unobscured reference pattern.

4. Click Analyze to restart the motion analysis.

Motion continues to analyze the trajectory of the original track point, based on the movement of the new offset reference pattern.

**Tip:** When you use the Offset Track feature, make sure that the new reference pattern is as close to the original reference pattern as possible. Ideally, the offset reference pattern should share the same motion as the original reference pattern and appear on the same subject.

---

### About tracking retimed footage

When working in a project that combines tracking behaviors and retiming operations, use the following guidelines for more successful results:

- Because the Motion tracker analyzes in a project’s frame rate, ensure that the frame rate of the footage you plan to track matches the frame rate of your project. For example, to track 24 frames-per-second (fps) footage, your project’s frame rate should be 24 fps. When the tracking analysis is completed, retime the clip using the Retiming parameters in the Media list.
or by using the Retiming behaviors.

- Do not retime the footage before the tracking analysis.
- Do not retime the footage, perform a tracking analysis, then retime the footage again. This may adversely affect your tracking analysis.

**Note:** To track the motion of a clip after it’s retimed, export the retimed clip, then import it back into your project before you perform the tracking analysis.

**Improve stabilization**

The automatic motion analysis (analysis without trackers) used by the Stabilize behavior works best with real images. Artificial images, such as those with no texture, are not recommended for use with the Stabilize behavior’s automatic mode. Shots with very strong pans are also not recommended.

Use the following techniques to improve the results of footage stabilization:

**Add trackers to a portion of a stabilize operation**

If a stabilized clip has a bumpy section that’s not getting smoothed, you can add trackers to noncontiguous sections of a clip. Any stabilize data from the automatic motion analysis is overwritten by the portions of the clip analyzed using the onscreen
1. After the Stabilize motion analysis is complete, play the clip to determine the section you want to add trackers to.

2. Set an Out point for the tracker analysis by positioning the playhead at the frame where you want to stop the analysis, then choosing Mark > Mark Play Range Out.

3. Position the playhead at the frame where you want to start the tracker analysis, then do one of the following:
   - To analyze X and Y position changes in the footage, click the Add button in the Behaviors Inspector to add an Anchor tracker.
   - To analyze changes in X and Y position as well as rotation and scale in the footage, click the Add button in the Behaviors Inspector two times to add an Anchor tracker and a Rotation-Scale tracker.

4. Position the newly added tracker on the reference pattern you want to track in the Canvas, then click the Analyze button in the HUD or Inspector.

   The specified play range is tracked, creating track points in the Canvas and tracking keyframes in the Keyframe Editor.

   **Note:** When using this strategy to track multiple noncontiguous sections of the clip, use the same tracker to simplify the track and to avoid clutter in the Keyframe Editor.

   This strategy needs meaningful data—a large range of frames—to yield the best results.
**Modify smoothing parameters**

If you’re trying to smooth the motion in a clip, first try adjusting the smoothing parameters (without reanalyzing the clip).

- In the Behaviors Inspector, click the Method pop-up menu, choose Smooth, then adjust the Translation Smooth, Rotation Smooth, and Scale Smooth sliders.

**Reanalyze the clip at a higher-quality setting**

- Before analyzing a clip, open the Behaviors Inspector, click the Quality pop-up menu, then choose Better.

  Although the analysis may take longer at this setting, the quality will be higher.

**Remove black borders from stabilized clips**

When you use the Stabilize behavior, the resulting transformations that smooth or stabilize the shot cause moving black borders to appear around the edges of the image. Although this is necessary to achieve the desired effect, you probably don’t want these black borders to appear in the final shot.

Use the following methods to remove black borders.
Zoom the clip

You can zoom the clip using the Borders pop-up menu in the Behaviors Inspector. Be aware that zooming the clip may soften the image.

- In the Behaviors Inspector, choose Zoom from the Borders pop-up menu.

  The clip is expanded to the full size of the Canvas, preventing black borders from appearing around the edges.

Scale the stabilized clip

If you want to output the resulting clip at the same size as the original, the quickest fix is to scale the image after the Stabilize analysis. You’ll need to enlarge the image to the point where all instances of black borders fall outside the edges of the frame. Like the Zoom option (in the Borders pop-up menu), this method softens the image.

Note: This workflow is a manual version of zooming the clip using the Zoom option from the Borders pop-up menu.

1. Select the clip and open the Properties Inspector.

2. Adjust the Scale parameter so the borders no longer appear at the edges of the clip.

Distort the edges of the clip
You can experiment with filters to stretch the edges of the image to fill gaps. The following example uses the Scrape filter. (This solution is highly dependent on the type of image and may introduce other image artifacts that may not be acceptable.)

1. Select the group in which the stabilized clip resides.

![Left image: Clip with filter applied. Right image: Clip after adjusting Center and Rotation parameters.]

2. Apply a Scrape filter to the group, then adjust the Center and Rotation parameters.

The left image shows the clip when the filter is applied to the group. The right image shows the result of adjusting the Center and Rotation parameters: the black edge is stretched to the right side of the image.
About combining masks with tracking behaviors

When you add a mask to an object that has applied tracking data, the data is applied to the mask. In the following image, the foreground object is tracked to four points on the background clip, but still must be masked to fit into the picture frame.

By masking the image being tracked, you can include only the portion of the image you want to fit in the frame.

Although the mask is attached to the foreground image, you might need to animate changes in the mask’s position and scale to accommodate changes in the background clip over time.

**Note:** As an alternative to using masks, you can also crop an
object with applied tracking data using Crop controls in the Properties Inspector.

You can also track the control points of a mask to a clip or apply existing tracking data to the control points of a mask. For more information, see Track shapes, masks, and paint strokes.

# Tracking behavior controls

## Analyze Motion controls

The Analyze Motion behavior analyzes and stores tracking data from a video clip or image sequence, but does not transform the tracked footage. Analyze Motion data tracks are meant to be referenced by the Match Move, Stabilize, Track Parameter, and Track Shape behaviors. For more information, see Analyze the motion of a clip.

After you apply an Analyze Motion behavior to a clip, the Behaviors Inspector displays the following adjustable controls:

- **Movement**: Two controls used for the motion-tracking analysis.

- **Analyze**: A button to activate a motion-tracking analysis. When you click Analyze, a status window appears and displays the tracking progress. To stop the analysis, click the Stop button in the status window or press Esc.

  The start frame of the track analysis is based on the current playhead position, rather than the beginning of the behavior bar in the Timeline.

- **Reverse**: A checkbox that, when selected, reverses the Track shapes, masks, and paint strokes Analyze the motion of a clip.
• **Reverse:** A checkbox that, when selected, reverses the analysis direction, going from the playhead position to the first frame of the clip (or the first frame of the tracking behavior).

  **Note:** You must move the playhead to the frame where you want the reverse analysis to begin.

• **Tracker:** A button to add onscreen trackers to the Analyze Motion behavior. By default, one tracker is available. New trackers are added at the center of the Canvas.

• **Tracker Preview:** A preview providing a magnified view of the tracking reference area for a selected tracker. The preview updates as you adjust the position of the tracker in the Canvas. You can drag in the preview area to adjust the position of the tracker. When you do so, the image in the preview area moves around the red crosshair representing the tracker, and the tracker moves in the Canvas. You can also Option-drag left or right in the preview area to decrease or increase the size reference pattern to be analyzed in the Canvas. (Alternatively, you can adjust the Track Size slider, described below, to achieve the same result.)

• **Offset Track:** A checkbox that, when selected, lets you set a new tracker position when the original reference pattern becomes temporarily obstructed by an obstacle, or goes off the screen. Motion uses the tracker position to continue the same tracking path begun by the original reference pattern. For more information on offset tracking, see Track obscured or off-frame points.

• **Auto-Zoom:** A pop-up menu to choose a magnification level when positioning the tracker in the Canvas. You can zoom in on the Canvas when searching for an ideal tracking reference.
pattern. There are four choices: None, 2x, 4x, and 8x.

- **Auto-Zoom Mode**: A pop-up menu to set the display of the auto-zoomed tracker in the Canvas. There are three choices:
  - **Normal**: Displays a normal pattern.
  - **Contrast**: Displays the tracker pattern with contrast detection.
  - **Edge**: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the Canvas and does not appear in the Tracker Preview in the Behaviors Inspector.

**Note**: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.

- **Look Ahead Frames**: A slider and value slider to specify the number of future frames to be analyzed by the tracker. In other words, you can direct the tracker to look in a specific location for its reference point, which helps the tracker follow fast-moving objects. For more information about the Look Ahead Frames control, see [Advanced strategies to improve tracking results](#).

- **Track list**: A list displaying the trackers in the behavior (Track 1, Track 2, and so on). To disable a tracker, deselect its checkbox. To remove a tracker, click its adjacent Remove button. A tracker that is turned off is not analyzed. Click the disclosure triangle next to the track name to reveal additional subparameters:
  - **Position**: Value sliders displaying the X and Y positions of the tracker.
  - **Track Size**: A slider to set (in pixels) the pattern search size.
• **Track Size:** A slider to set (in pixels) the pattern search size for the tracker. As you adjust the tracker size, the Tracker Preview is updated to show the new pattern search size. However, there’s no visual change in the Canvas tracker. (In a traditional tracker, Track Size would be the pattern searched within the inner tracker box and the outer tracker box.)

Alternatively, you can adjust the Track Size parameter by Option-dragging left or right in the Tracker Preview area.

• **Search Size:** A slider to set search area size for the tracker. In Motion, you do not specify the size of a search area when setting up trackers in the Canvas. If your clip contains a lot of rapid movement, for example, you may have better results increasing the Search Size. For example, if Search Size is set to 150%, the tracker searches 50% further beyond the Track Size setting.

• **Fail Tolerance:** A slider to set the amount of tolerance for error, or confidence value, of the tracker. In other words, Fail Tolerance defines a threshold score at which the tracker determines it can match a reference feature. When the analysis yields a score above the Fail Tolerance value, the tracker accepts the match. When the score is below the value, the tracker rejects the match.

• **Fail Behavior:** A pop-up menu to specify what happens if the track confidence value falls below the Fail Tolerance amount. There are six menu options:
  - **Smart Retry:** The tracker attempts to find the reference pattern in a larger search area. If the pattern still cannot be found, the tracker switches to the Predict option (described below). Smart Retry is the default Fail
Behavior setting.

- **Stop**: The analysis stops when the tracker loses the reference pattern.

- **Predict**: The tracker predicts a new search area without creating keyframes until it finds a match for the reference pattern. This option is excellent for tracked elements that pass behind foreground elements.

- **Predict and Key**: If a failure is detected, the tracker predicts the location of the next track point (keyframe) based on a vector of the last two keyframes, and continues tracking in the new area.

- **Don’t Predict**: The tracker remains in its position and searches for subsequent matches as the clip’s frames progress. While searching for a match, the tracker does not create keyframes.

- **Use Existing Keyframes**: The tracker uses keyframes you have manually created as a guide. After manually adding keyframes, return to the start frame and start the tracking analysis. If the tracker has difficulty locating the reference pattern, the manually created tracking keyframes are referenced to guide the tracker.

- **Color**: A color control to set a new color for the onscreen tracker. The default tracker color is red. When a tracker is selected, its center point is yellow and the border of its magnified inset is the color set in the color well. To adjust individual color channels, including the tracker’s opacity, click the disclosure triangle. For more information about color controls, see Basic color controls.
Match Move controls

The Match Move behavior analyzes the movement of a source object, then applies that movement data to a destination object (a video clip, group, camera, shape, particle emitter, or other object in Motion).

Important: When you apply the Match Move behavior to a group, make sure the footage being analyzed resides outside of the destination group.

For information on using the Match Move behavior, see Match move an object.

To use Match Move (and access its parameter controls), your project must contain a foreground (destination) object and a background (source) object. After you apply a Match Move behavior to a destination object, the Behaviors Inspector displays the following adjustable controls:

- **Source**: A source well to set the source object supplying tracking data to the destination object. The source object can be another tracking behavior, an animated object, or a footage object. When you apply a Match Move behavior to a destination object, the nearest animated object, recorded track, or footage object beneath the behavior in the Layers list appears in this well. If a source object isn’t automatically assigned, drag one from the Layers list into this well. To clear the Source well, drag its thumbnail away from the well and release the mouse button.
When you drag any nonfootage object (such as a shape or mask) into the Source well, the trackers are no longer available in the Match Move behavior as there is no clip to analyze. Whatever animation is present in the shape or mask (via keyframes or behaviors) is applied.

**Note:** When you apply the Match Move behavior to a mask, the masked object is selected as the source.

- **Action pop-up menu:** A pop-up menu (with a gear icon) to manually assign tracking data (from other tracking behaviors in your project).

- **Movement:** Two controls used for the motion-tracking analysis:
  
  - **Analyze:** A button to activate a motion-tracking analysis. When you click Analyze, a status window appears and displays the tracking progress. To stop the analysis, click the Stop button in the status window or press Esc.

  The start frame of the track analysis is based on the current playhead position, rather than the beginning of the behavior bar in the Timeline.

  - **Reverse:** A checkbox that, when selected, reverses the analysis direction, going from the playhead position to the first frame of the clip (or the first frame of the tracking behavior).

    **Note:** You must move the playhead to the frame where you want the reverse analysis to begin.

- **Type:** A pop-up menu to set the type of motion tracking used in the analysis. There are two options:
  
  - **Transformation:** Enables one-point (position) tracking or
two-point (position, scale, rotation) tracking, transforming the destination object (the object to which the Match Move behavior is applied).

- **Four Corners**: Enables four-point tracking, corner-pinning the destination object (the object to which the Match Move behavior is applied). When Type is set to Four Corners, the Direction and Adjust parameters are no longer available.

**Important**: When you apply the Match Move behavior to a 3D group or a mask, the Four Corners option is not available. To corner-pin a 3D group, select the Flatten checkbox in the Group Inspector.

- **Direction**: A pop-up menu to specify the dimension in which the recorded movement is applied to the destination object: Horizontal and Vertical (X and Y), Horizontal (only X), or Vertical (only Y).

- **Transform**: A pop-up menu to set how the destination object (the object to which the Match Move behavior is applied) moves. There are two options:
  - **Attach to Source**: Anchors the foreground object to the recorded track or animation source. Use Attach to Source when the source object is scaling or rotating, and you want the destination object to “stick” to a spot on the source object. You can preserve preexisting animation in the destination object by using the Adjust buttons (Position, Scale, and Rotation), available when the Type pop-up menu (described above) is set to Transformation.

**Note**: Although the destination object is “attached” to the movement of the source object, the position of the destination object can be changed (offset from the source
In the following example, the Match Move behavior is applied to the red pill shape and uses the animated white arrow as the source object. The white arrow has an applied Spin behavior that causes it to spin in a clockwise direction. Additionally, the arrow’s anchor point is positioned at the bottom of the arrow (at the opposite end from the tip).

When the Transform pop-up menu is set Attach to Source, and you select the Position and Rotation buttons in the Adjust parameter row, the red shape is anchored to one spot on the arrow (the tip, in this example) and matches the clockwise movement of the arrow.

- **Mimic Source**: Allows the destination object to “mimic” the recorded track or animation source. You can preserve preexisting animation in the destination object by using the
Adjust buttons (Position, Scale, and Rotation), available when the Type pop-up menu (described above) is set to Transformation.

**Note:** Although the destination object is “attached” to the movement of the source object, the position of the destination object can be changed (offset from the source object). Additionally, the destination object can be scaled and rotated.

In the following images, the Transform pop-up menu is set to Mimic Source, and Position and Rotation are selected in the Adjust parameter row. The red shape is not locked to one spot on the white arrow. Instead, the red shape mirrors the arrow’s animation.

When Transform is set to Mimic Source, you can transform tracked footage in the Properties Inspector. For example, you can change the scale, position, or rotation of a corner-pinned clip. Also, when you corner-pin a clip and set the Type pop-up menu to Four Corners, Mimic Source lets you adjust the trackers without affecting the foreground image.

- **Adjust:** Three buttons to set the type of transformation applied to the destination object.
  - **Position:** A button that, when enabled, applies the position of the source (background) object to the destination (foreground) object, and activates the Anchor (position)
tracker (described below).

- **Scale**: A button that, when enabled, applies the scale of the source (background) object to the destination (foreground) object. The source track must include scale data for this parameter to have any effect. When Scale is enabled, the Rotation-Scale tracker (described below) is activated.

- **Rotation**: A button that, when enabled, applies the rotation of the source (background) object to the destination (foreground) object. The source track must include rotation data for this parameter to have any effect. When Rotation is enabled, the Rotation-Scale tracker (described below) is activated.

- **Tracker Preview**: A preview providing a magnified view of the tracking reference area for a selected tracker. The preview updates as you adjust the position of the tracker in the Canvas. You can drag in the preview area to adjust the position of the tracker. When you do so, the image moves in the preview area moves around the red crosshair representing the tracker, and the tracker moves in the Canvas. You can also Option-drag left or right in the preview area to decrease or increase the size reference pattern to be analyzed in the Canvas. (You can also adjust the Track Size slider, described below, to achieve the same result.)

- **Offset Track**: A checkbox that, when selected, lets you set a new tracker position when the original reference pattern becomes temporarily obstructed by an obstacle, or goes off the screen. Motion uses the tracker position to continue the same tracking path begun by the original reference pattern. For more information on offset tracking, see Track obscured or off-frame points.
• **Auto-Zoom**: A pop-up menu to choose a magnification level when positioning the tracker in the Canvas. You can zoom in on the Canvas when searching for an ideal tracking reference pattern. There are four choices: None, 2x, 4x, and 8x.

• **Auto-Zoom Mode**: A pop-up menu to set the display of the auto-zoomed tracker in the Canvas. There are three choices:
  - **Normal**: Displays a normal pattern.
  - **Contrast**: Displays the tracker pattern with contrast detection.
  - **Edge**: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the Canvas and does not appear in the Tracker Preview in the Behaviors Inspector.

**Note**: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.

• **Look Ahead Frames**: A slider and value slider to specify the number of future frames to be analyzed by the tracker. In other words, you can direct the tracker to look in a specific location for its reference point, which helps the tracker follow fast-moving objects. For more information about the Look Ahead Frames control, see Advanced strategies to improve tracking results.

• **Anchor/Rotation-Scale**: Checkboxes (available when the Type pop-up menu is set to Transformation) to enable or disable the Anchor and Rotation-Scale trackers. The Anchor tracker records position data. The Anchor tracker and Rotation-Scale tracker in combination record position, rotation, and scale data (by comparing the relative coordinate change between
Note: When the Source well (described above) contains tracking data from another behavior (such as Analyze Motion), these checkboxes become pop-up menus used to assign which trackers (from the source tracking data) will provide anchor (position) data to the destination object, and which will provide rotation-scale data. And because trackers are no longer needed in the Match Move behavior, onscreen trackers are removed from the Canvas.

Click the disclosure triangle next to the Anchor checkbox and Rotation-Scale checkbox to reveal additional subparameters:

- **Position**: Value sliders displaying the X and Y positions of the tracker.
- **Track Size**: A slider to set (in pixels) the pattern search size for the tracker. As you adjust the tracker size, the Tracker Preview is updated to show the new pattern search size. However, there’s no visual change in the Canvas tracker. (In a traditional tracker, Track Size would be the pattern searched within the inner tracker box and the outer tracker box.)

Alternatively, you can adjust the Track Size parameter by Option-dragging left or right in the Tracker Preview area.

- **Search Size**: A slider to set search area size for the tracker. In Motion, you do not specify the size of a search area when setting up trackers in the Canvas. If your clip contains a lot of rapid movement, for example, you may have better results increasing the Search Size. For example, if Search Size is set to 150%, the tracker searches 50% further beyond the Track Size setting.
• **Fail Tolerance:** A slider to set the amount of tolerance for error, or confidence value, of the tracker. In other words, Fail Tolerance defines a threshold score at which the tracker determines it can match a reference feature. When the analysis yields a score above the Fail Tolerance value, the tracker accepts the match. When the score is below the value, the tracker rejects the match.

• **Fail Behavior:** A pop-up menu to specify what happens if the track confidence value falls below the Fail Tolerance amount. There are six menu options:

  • *Smart Retry:* The tracker attempts to find the reference pattern in a larger search area. If the pattern still cannot be found, the tracker switches to the Predict option (described below). Smart Retry is the default Fail Behavior setting.

  • *Stop:* The analysis stops when the tracker loses the reference pattern.

  • *Predict:* The tracker predicts a new search area without creating keyframes until it finds a match for the reference pattern. This option is excellent for tracked elements that pass behind foreground elements.

  • *Predict and Key:* If a failure is detected, the tracker predicts the location of the next track point (keyframe) based on a vector of the last two keyframes, and continues tracking in the new area.

  • *Don’t Predict:* The tracker remains in its position and searches for subsequent matches as the clip’s frames progress. While searching for a match, the tracker does not create keyframes.
• Use Existing Keyframes: The tracker uses keyframes you have manually created as a guide. After manually adding keyframes, return to the start frame and start the tracking analysis. If the tracker has difficulty locating the reference pattern, the manually created tracking keyframes are referenced to guide the tracker.

• Color: A color control to set a new color for the onscreen tracker. The default tracker color is red. When a tracker is selected, its center point is yellow and the border of its magnified inset is the color set in the color well. To adjust individual color channels, including the tracker’s opacity, click the disclosure triangle. For more information about color controls, see Basic color controls.

• Top Left, Top Right, Bottom Right, Bottom Left (control groups): Controls (available when the Type pop-up menu is set to Four Corners and the Source well contains the footage being analyzed by the Match Move behavior) to adjust the Position, Track Size, Search Size, Fail Tolerance, Fail Behavior, and Color for each of the four-corner trackers individually.

• Top Left, Top Right, Bottom Right, Bottom Left (pop-up menus): Pop-up menus (available when the Type pop-up menu is set to Four Corners and the Source well contains tracking data from another behavior, such as Analyze Motion) to assign trackers from the source behavior to each of the four corners.

Stabilize controls
The Stabilize behavior uses a sophisticated motion analysis to
track every pixel from one frame to the next to smooth shaky motion in a video clip or image sequence. Unlike the Match Move and Analyze Motion behaviors, the Stabilize behavior does not use onscreen trackers to analyze motion. However, if the result of the analysis requires additional correction, you can manually add onscreen trackers to noncontiguous segments of the clip. For example, if an additional camera bump affects frames 350 to 380, you can add a tracker to analyze that portion of the clip. The data recorded from the analysis is added to the data recorded by default analysis to further smooth the clip.

In addition to considering horizontal, vertical, or horizontal movement in the clip, the Stabilize behavior looks at position, scale, and rotation. The Stabilize behavior can only be applied to footage objects in your project (QuickTime movies or image sequences).

For information on using the Stabilize behavior, see Stabilize a shaky clip.

After you apply a Stabilize behavior to a clip or image sequence, the Behaviors Inspector displays the following adjustable controls:

- **Source**: A source well to designate the source object supplying the tracking data used to stabilize the clip. By default, the clip you apply the Stabilize behavior to appears in this well, ready to be analyzed. However, you can manually drag a different source object into the well—another Stabilize behavior in your project or even a different footage object in your project. To clear a Source well, drag the thumbnail away from the well and release the mouse button.
- **Action pop-up menu:** A pop-up menu (with a gear icon) to manually assign tracking data (from other tracking behaviors in your project).

- **Movement-Analyze:** A button to activate a motion-tracking analysis. When you click Analyze, a status window appears and displays the tracking progress. To stop the analysis, click the Stop button in the status window or press Esc.

When using the Stabilize behavior (without trackers), the track begins at the start of the clip, rather than the current playhead position.

- **Quality:** A pop-up menu to define the level of detail in the motion analysis. There are two options:
  - **Faster:** Allows for a faster operation, but motion analysis is less detailed.
  - **Better:** Provides a more detailed analysis, but is slower. This is the recommended option when the clip contains rotation.

- **Track Region:** A checkbox that, when selected, lets you manually define an area in the frame to be analyzed. A red overlay appears in the Canvas. The area outside this overlay is ignored by the analysis. The track region’s onscreen controls are similar to a shape’s onscreen controls, allowing you to modify the size, shape, and position of the track region.

For more information on setting a track region, see [Stabilize a shaky clip](#).

- **Method:** A pop-up menu to define how the stabilization is applied to a shaky clip.
Method: A pop-up menu to define how the stabilization is applied to the clip. There are two options:

- **Stabilize**: Attempts to lock the motion of the principal subject in the shot to eliminate motion. As a result, the background appears to move around the subject being tracked.

- **Smooth**: Smooths the apparent motion of the camera, while allowing the general movement in the frame to proceed. Use this method to remove camera jitter.

- **Translation Smooth**: A slider (available when Method is set to Smooth) to smooth motion in the X and Y dimensions.

- **Rotation Smooth**: A slider (available when Method is set to Smooth) to smooth image rotation.

- **Scale Smooth**: A slider (available when Method is set to Smooth) to smooth an uneven zoom.

**Note**: Don’t set the Scale Smooth value above 0 unless you’re positive the clip is being zoomed.

- **Borders**: A pop-up menu to set how moving border artifacts are handled. When you stabilize a clip, the resulting transformations may cause moving black borders to appear around the edges of the clip. Stabilized clips containing extreme horizontal or vertical movement (due to excessive camera shake) may result in very large black borders. There are two Borders options:

  - **Normal**: Maintains the size of the stabilized footage. The moving black borders remain around the edges of the clip.

  - **Zoom**: Expands the clip to fill the Canvas. This prevents black borders from appearing around the edges, but
scales up the stabilized clip, which may degrade image quality.

**Tip:** You can also eliminate the black borders manually by adjusting the layer’s scale or Z position in the Properties pane of the Inspector.

- **Direction:** A pop-up menu to specify the dimensions in which the recorded movement are applied—Horizontal and Vertical (X and Y), Horizontal (only X), or Vertical (only Y).

- **Adjust:** Three buttons to set the type of transformation applied. Select any combination of the three:
  - **Position:** Stabilization is applied to the position of the analyzed image.
  - **Scale:** Stabilization is applied to the scale of the analyzed image.
  - **Rotation:** Stabilization is applied to the rotation of the analyzed image.

- **Tracker-Add:** A button to add trackers to the Stabilize behavior. By default, trackers are added at the center of the Canvas. You can add a maximum of two trackers to the Stabilize behavior. The first tracker you add is the Anchor tracker, used to analyze changes in X and Y position. The second tracker you add is the Rotation-Scale tracker, used to analyze changes in rotation and scale.

When you add trackers, the following occurs:

- The Track Region parameter is no longer available.
- The Reverse checkbox becomes available, allowing you to analyze a clip backwards from the playhead position (in
The Tracker Preview, Offset Track, Auto-Zoom, Auto-Zoom Mode, Look Ahead Frames, and track list controls become available. For more information about these controls, see **Match Move controls**.

**Note:** When another behavior is used as the source for the stabilization, you cannot add trackers to the Stabilize behavior.

### Unstabilize controls

The Unstabilize behavior applies movement data recorded in a Stabilize behavior, but does not perform its own tracking analysis. You can apply the Unstabilize behavior to many object types, including groups, cameras, shapes, particle emitters, and so on.

For information about using the Unstabilize behavior, see **Unstabilize a clip**.

After you apply an Unstabilize behavior to an object, the Behaviors Inspector displays the following adjustable controls:

- **Source:** A source well to designate the source object supplying the tracking data used to “unstabilize” (add motion to) the clip. The source object can be another Stabilize behavior. To clear a Source well, drag the item away from the well and release the mouse button.

- **Action pop-up menu:** A pop-up menu (with a gear icon) to...
Track Points controls

The Track Points behavior (available in the Shape subcategory of Behaviors in the Library) lets you link the control points of a shape or mask (including paint strokes) to reference features on a source clip. This behavior also lets you apply tracking data recorded by the Analyze Motion, Match Move, or Stabilize tracking behaviors to the control points of a shape or mask.

For information on using the Track Points behavior, see Track shapes, masks, and paint strokes.

After you apply a Track Points behavior to a shape or mask, the Behaviors Inspector displays the following adjustable controls:

- **Source**: A source well to specify the source object supplying tracking data. Drag a source object from the Layers list into the well. The source object can be another tracking behavior, an animated object, or a footage object. To clear a Source well, drag the thumbnail away from the well and release the mouse button.

- **Action pop-up menu**: A pop-up menu (with a gear icon) to manually assign tracking data (from other tracking behaviors in your project).

- **Transform**: A pop-up menu to set how the destination object track shapes, masks, and paint strokes.
A pop-up menu to set how the destination object moves. There are two options:

- **Attach to Source**: Anchors the foreground object to the recorded track or animation source. Use Attach to Source when the source object is scaling or rotating, and you want the destination object to “stick” to a specific spot on the source object. You can preserve preexisting animation in the destination object by using the Adjust buttons (Position, Scale, and Rotation), available when the Type pop-up menu is set to Transformation.

  **Note**: Although the destination object is “attached” to the movement of the source object, the destination object can be offset from the source object.

- **Mimic Source**: Allows the destination object to “mimic” the recorded track or animation source. You can preserve preexisting animation in the destination object by using the Adjust buttons (Position, Rotation, or Scale).

  **Note**: The destination object can be offset from the source object.

- **Align Tangents**: A checkbox that, when deselected, forces tangents to remain aligned at their original angles. When the checkbox is selected, the tangents match the transformation of the source animation, and the shape changes its form.

- **Movement**: Two controls (available when the Source well contains footage):
  - **Analyze**: A button to activate the motion-tracking analysis. When you click Analyze, a status window appears and displays the tracking progress. To stop the analysis, click the Stop button in the status window or press Esc. The
start of the track is based on the current playhead position, rather than the start of the behavior in the Timeline.

- **Reverse:** A checkbox that, when selected, reverses the analysis direction, going from the current playhead position to the first frame of the clip (or the first frame of the tracking behavior).

  **Note:** You must move the playhead to the frame where you want the reverse analysis to begin.

- **Tracker Preview:** A preview area (available when the Source well contains source footage) providing a magnified view of the tracking reference area for the selected tracker. The preview updates as you adjust the position of the tracker in the Canvas. You can drag in the preview area to adjust the position of the tracker. When you do so, the image moves around the red crosshair in the preview, and the tracker moves in the Canvas.

- **Offset Track:** A checkbox (available when the Source well contains source footage) that, when selected, lets you set a new tracker position when the original reference pattern becomes temporarily obstructed by an obstacle or goes off the screen. Motion uses the tracker position to continue the same tracking path begun by the original reference pattern. For more information on offset tracking, see Track obscured or off-frame points.

- **Auto-Zoom:** A pop-up menu to choose a magnification level when positioning the tracker in the Canvas. You can zoom in on the Canvas when searching for an ideal tracking reference pattern. There are four choices: None, 2x, 4x, and 8x.

- **Auto-Zoom Mode:** A pop-up menu to set the display of the track obscured or off-frame points.
Auto-Zoom Mode: A pop-up menu to set the display of the auto-zoomed tracker in the Canvas. There are three choices:

- **Normal**: Displays a normal pattern.
- **Contrast**: Displays the tracker pattern with contrast detection.
- **Edge**: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the Canvas and does not appear in the Tracker Preview in the Behaviors Inspector.

**Note**: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.

- **Look Ahead Frames**: A slider and value slider to specify the number of future frames to be analyzed by the tracker. In other words, you can direct the tracker to look in a specific location for its reference point, which helps the tracker follow fast-moving objects. For more information about the Look Ahead Frames control, see Advanced strategies to improve tracking results.

- **Track list**: A list displaying the trackers in the behavior (Track 1, Track 2, and so on). To disable a tracker, deselect its checkbox. To remove a tracker, click its adjacent Remove button. A tracker that is turned off is not analyzed.

**Note**: When the Source well (described above) contains tracking data from another behavior (such as Analyze Motion), these checkboxes become pop-up menus used to assign which trackers (from the source tracking data) will provide anchor (position) data to the destination object, and which will provide rotation-scale data. And because trackers are no longer needed in the Match Move behavior, onscreen trackers
are removed from the Canvas.

Click the disclosure triangle next to the track name to reveal additional subparameters:

- **Position:** Value sliders displaying the X and Y positions of the tracker.
- **Track Size:** A slider to set (in pixels) the pattern search size for the tracker. As you adjust the tracker size, the Tracker Preview is updated to show the new pattern search size. However, there’s no visual change in the Canvas tracker. (In a traditional tracker, Track Size would be the pattern searched within the inner tracker box and the outer tracker box.)

Alternatively, you can adjust the Track Size parameter by Option-dragging left or right in the Tracker Preview area.

- **Search Size:** A slider to set search area size for the tracker. In Motion, you do not specify the size of a search area when setting up trackers in the Canvas. If your clip contains a lot of rapid movement, for example, you may have better results increasing the Search Size. For example, if Search Size is set to 150%, the tracker searches 50% further beyond the Track Size setting.
- **Fail Tolerance:** A slider to set the amount of tolerance for error, or confidence value, of the tracker. In other words, Fail Tolerance defines a threshold score at which the tracker determines it can match a reference feature. When the analysis yields a score above the Fail Tolerance value, the tracker accepts the match. When the score is below the value, the tracker rejects the match.

- **Fail Behavior:** A pop-up menu to specify what happens if
Fail Behavior: A pop-up menu is specified when gamma is the track confidence value falls below the Fail Tolerance amount. There are six menu options:

- **Smart Retry:** The tracker attempts to find the reference pattern in a larger search area. If the pattern still cannot be found, the tracker switches to the Predict option (described below). Smart Retry is the default Fail Behavior setting.

- **Stop:** The analysis stops when the tracker loses the reference pattern.

- **Predict:** The tracker predicts a new search area without creating keyframes until it finds a match for the reference pattern. This option is excellent for tracked elements that pass behind foreground elements.

- **Predict and Key:** If a failure is detected, the tracker predicts the location of the next track point (keyframe) based on a vector of the last two keyframes, and continues tracking in the new area.

- **Don’t Predict:** The tracker remains in its position and searches for subsequent matches as the clip’s frames progress. While searching for a match, the tracker does not create keyframes.

- **Use Existing Keyframes:** The tracker uses keyframes you have manually created as a guide. After manually adding keyframes, return to the start frame and start the tracking analysis. If the tracker has difficulty locating the reference pattern, the manually created tracking keyframes are referenced to guide the tracker.

- **Color:** A color control to set a new color for the onscreen
tracker. The default tracker color is red. When a tracker is selected, its center point is yellow and the border of its magnified inset is the color set in the color well. To adjust individual color channels, including the tracker’s opacity, click the disclosure triangle. For more information about color controls, see Basic color controls.

Track controls

The Track parameter behavior (available in the Parameter subcategory of Behaviors in the Library) lets you track the position parameter of an object (such as a filter, shape, or particle emitter) to a reference feature of a clip, or to apply tracking data to the position parameter of an object.

For a description of the Tracker Preview, Offset Track, Auto-Zoom, Auto-Zoom Mode, Look Ahead Frames, and track list parameters, as well as tracker subparameters, see Analyze Motion controls. For information on using the Track parameter behavior, see Track a filter’s position parameter.

After you apply a Track behavior to an object in your project, the Behaviors Inspector displays the following adjustable controls:

- **Source**: A source well to specify the source object supplying tracking data. Drag a source object from the Layers list into the well. The source object can be another tracking behavior or a footage object. To clear a Source well, drag the thumbnail away from the well and release the mouse button.
**Note:** An animated object cannot be used as a source for the Track parameter behavior.

- **Action pop-up menu:** A pop-up menu (with a gear icon) to manually assign tracking data (from other tracking behaviors in your project).

- **Transform:** A pop-up menu to set how the destination object moves. There are two options:
  - **Attach to Source:** Anchors the foreground object to the recorded track or animation source. Use Attach to Source when the source object is scaling or rotating, and you want the destination object to “stick” to a specific spot on the source object. You can preserve preexisting animation in the destination object by using the Adjust buttons (Position, Scale, and Rotation), available when the Type pop-up menu is set to Transformation.
  
  **Note:** Although the destination object is “attached” to the movement of the source object, the destination object can be offset from the source object.

  - **Mimic Source:** Allows the destination object to “mimic” the recorded track or animation source. You can preserve preexisting animation in the destination object by using the Adjust buttons (Position, Rotation, or Scale).

  **Note:** The destination object can be offset from the source object.

- **Movement:** Two controls (available when the Source well contains footage):
  - **Analyze:** A button to activate the motion-tracking analysis. When you click Analyze, a status window appears and
displays the tracking progress. To stop the analysis, click the Stop button in the status window or press Esc. The start of the track is based on the current playhead position, rather than the start of the behavior in the Timeline.

- **Reverse:** A checkbox that, when selected, reverses the analysis direction, going from the current playhead position to the first frame of the clip (or the first frame of the tracking behavior).

  **Note:** You must move the playhead to the frame where you want the reverse analysis to begin.

- **Tracker Preview:** A preview area (available when the Source well contains source footage) providing a magnified view of the tracking reference area for the selected tracker. The preview updates as you adjust the position of the tracker in the Canvas. You can drag in the preview area to adjust the position of the tracker. When you do so, the image moves around the red crosshair in the preview, and the tracker moves in the Canvas.

- **Offset Track:** A checkbox (available when the Source well contains source footage) that, when selected, lets you set a new tracker position when the original reference pattern becomes temporarily obstructed by an obstacle or goes off the screen. Motion uses the tracker position to continue the same tracking path begun by the original reference pattern. For more information on offset tracking, see *Track obscured or off-frame points*.

- **Auto-Zoom:** A pop-up menu to choose a magnification level when positioning the tracker in the Canvas. You can zoom in on the Canvas when searching for an ideal tracking reference
pattern. There are four choices: None, 2x, 4x, and 8x.

- **Auto-Zoom Mode**: A pop-up menu to set the display of the auto-zoomed tracker in the Canvas. There are three choices:
  - **Normal**: Displays a normal pattern.
  - **Contrast**: Displays the tracker pattern with contrast detection.
  - **Edge**: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the Canvas and does not appear in the Tracker Preview in the Behaviors Inspector.

**Note**: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.

- **Look Ahead Frames**: A slider and value slider to specify the number of future frames to be analyzed by the tracker. In other words, you can direct the tracker to look in a specific location for its reference point, which helps the tracker follow fast-moving objects. For more information about the Look Ahead Frames control, see [Advanced strategies to improve tracking results](#).

- **Track list**: A list displaying the trackers in the behavior (Track 1, Track 2, and so on). To disable a tracker, deselect its checkbox. To remove a tracker, click its adjacent Remove button. A tracker that is turned off is not analyzed.

**Note**: When the Source well (described above) contains tracking data from another behavior (such as Analyze Motion), these checkboxes become pop-up menus used to assign which trackers (from the source tracking data) will provide anchor (position) data to the destination object, and which will
provide rotation-scale data. And because trackers are no longer needed in the Match Move behavior, onscreen trackers are removed from the Canvas.

Click the disclosure triangle next to the track name to reveal additional subparameters:

- **Position**: Value sliders displaying the X and Y positions of the tracker.

- **Track Size**: A slider to set (in pixels) the pattern search size for the tracker. As you adjust the tracker size, the Tracker Preview is updated to show the new pattern search size. However, there’s no visual change in the Canvas tracker. (In a traditional tracker, Track Size would be the pattern searched within the inner tracker box and the outer tracker box.)

  Alternatively, you can adjust the Track Size parameter by Option-dragging left or right in the Tracker Preview area.

- **Search Size**: A slider to set search area size for the tracker. In Motion, you do not specify the size of a search area when setting up trackers in the Canvas. If your clip contains a lot of rapid movement, for example, you may have better results increasing the Search Size. For example, if Search Size is set to 150%, the tracker searches 50% further beyond the Track Size setting.

- **Fail Tolerance**: A slider to set the amount of tolerance for error, or confidence value, of the tracker. In other words, Fail Tolerance defines a threshold score at which the tracker determines it can match a reference feature. When the analysis yields a score above the Fail Tolerance value, the tracker accepts the match. When the score is below
the value, the tracker rejects the match.

- **Fail Behavior**: A pop-up menu to specify what happens if the track confidence value falls below the Fail Tolerance amount. There are six menu options:
  
  - **Smart Retry**: The tracker attempts to find the reference pattern in a larger search area. If the pattern still cannot be found, the tracker switches to the Predict option (described below). Smart Retry is the default Fail Behavior setting.
  
  - **Stop**: The analysis stops when the tracker loses the reference pattern.
  
  - **Predict**: The tracker predicts a new search area without creating keyframes until it finds a match for the reference pattern. This option is excellent for tracked elements that pass behind foreground elements.
  
  - **Predict and Key**: If a failure is detected, the tracker predicts the location of the next track point (keyframe) based on a vector of the last two keyframes, and continues tracking in the new area.
  
  - **Don’t Predict**: The tracker remains in its position and searches for subsequent matches as the clip’s frames progress. While searching for a match, the tracker does not create keyframes.
  
  - **Use Existing Keyframes**: The tracker uses keyframes you’ve manually created as a guide. After manually adding keyframes, return to the start frame and start the tracking analysis. If the tracker has difficulty locating the reference pattern, the manually created tracking keyframes are referenced to guide the tracker.
• **Color:** A color control to set a new color for the onscreen tracker. The default tracker color is red. When a tracker is selected, its center point is yellow and the border of its magnified inset is the color set in the color well. To adjust individual color channels, including the tracker’s opacity, click the disclosure triangle. For more information about color controls, see **Basic color controls**.

• **Apply To:** A pop-up menu to assign the parameter affected by the Track behavior. Click the To pop-up menu, then choose a parameter. For example, if the Track parameter is applied to the X Position parameter of the tracked object, and you want to apply the tracking data to the X and Y Position parameters, click To, then choose > Properties > Transform > Position > X and Y.

## Save tracks to the Library

As with all behaviors in Motion, you can save tracking behaviors to the Library. However, a tracking behavior must reference the tracked source object. Therefore, it may make more sense to save the group that contains the tracking behavior, as well as the source footage, to the Library.

## Save a group to the Library

1. Open the Library and select the category where you want to save the group, such as the Favorites category.

2. From the Layers list or Timeline, drag the group that contains
the tracking behavior and its source (tracked) footage into the stack at the bottom of the Library.

The group is added to the Library category.

Save a behavior to the Library

1. Open the Library and select the Favorites, Favorites Menu, or Behaviors category.

2. From the Layers list, Timeline, or Inspector, drag the customized behavior you want to save into the stack at the bottom of the Library.

When you save a customized item to the Library, it is saved in the /Users/username/Library/Application Support/Motion/Library/ folder.

For more information on saving behaviors to the Library, see Save custom behaviors.
Audio overview

You can view the audio elements of your project in several places in the Motion workspace. You can import audio files and video files into Motion, then make adjustments to individual audio tracks or to the overall sound mix in your project. The workflow for adding and adjusting audio tracks in Motion is similar to the basic video workflow:

- **Add audio files** to your project.
- **Select and preview specific tracks.**
- **Adjust individual audio tracks** or adjust the Master track (the overall mix) in the Audio list.

- Adjust audio timing (playback speed, duration, and so on) in the...
Audio Timeline or in the Properties Inspector.

- Add effects such as fade-ins, crossfades, and pans using keyframes or using behaviors.
- Export audio with video, or export audio alone, in various formats.

View Audio files

The Audio list, located in the Project pane, displays audio tracks in your project, as well as the Master track, which controls your project’s overall audio mix. You can adjust the settings for each track using controls in the Audio list (see Adjust audio tracks).

You can view additional information about your audio files in the Audio Timeline, in the Keyframe Editor, in the Media list, and in the Audio Track Inspector.

Show the Audio list

Do one of the following:

- If the Project pane is visible, click the Audio tab at the top of the pane.
- Choose Window > Audio (or press Command-6).

For information about adjusting audio tracks in the Audio list, see Adjust audio tracks.
Sort the Audio list

- With the Audio list open, click the Search button at the bottom of the Project pane, then enter the name of a track in the Search field.

The Audio list shows the track (or tracks) that match your search term.

To stop filtering and return to the complete Audio list, click the Clear button at the right of the Search field.

Open the Audio Track Inspector

- Select an audio track in the Audio list or Audio Timeline, then click Audio Track in the Inspector.

Level, Pan, and Output Bus controls become available.

Show waveforms in the Audio Timeline

To see your audio tracks as waveforms laid out over time, open the Audio Timeline:

- Click the Show/Hide Audio Timeline button in the lower-right
The Audio Timeline opens (in the Timing pane), displaying a green bar containing the waveform of the file. (If the bar does not show a waveform, adjust the height of the tracks. For more information about adjusting Timeline tracks, see Customize the Timeline.)

Important: In a multichannel audio file, all audio channels in the file appear in the Audio Timeline.

Show waveforms in the Keyframe Editor

You can also view an audio track in the Keyframe Editor, to compare the waveforms of the track to keyframe placement in your project.

1. To open the Keyframe Editor, click the Show/Hide Keyframe Editor button in the lower-right corner of the Motion project window.
2. Choose an audio track from the waveform pop-up menu at the top-right side of the Keyframe Editor.

The waveform of the track appears in the Keyframe Editor, along with keyframes.

View individual tracks in the Keyframe Editor in a multitrack project

If there are multiple audio tracks in the project, by default only the waveform of the master track appears in the Keyframe Editor. Use the waveform pop-up menu to select a different track.

Choose a track name from the waveform pop-up menu at the
Show additional information about your project’s audio files

Do one of the following:

- In the Project pane, open the Media list.
- Select the audio file in the Media list, then open the Media Inspector.

The Media list in the Project pane and the Media Inspector display information about each audio file, including kind, duration, sample rate, format, file size, and other details.

Add audio files

You can add different kinds of audio files to a Motion project. Motion lets you preview files before adding them to your project. Motion supports audio in a variety of common file formats, sample rates, and bit depths. For a complete list, see Supported media formats.

Audio files added to a project are converted to a Motion-specific
internal format, allowing you to mix audio files with differing formats, sample rates, and bit depths in the same project.

**Note:** When you add an audio file, its start point in the Timeline is determined by the Create Layers At preference in the Project pane of Motion Preferences. To adjust this preference, see [If it’s your first import](#).

---

## Add an audio file to a project

Do one of the following:

- Drag an audio file from the File Browser or the Finder into the Layers list, Timeline, Canvas, Audio Timeline, or Audio list.

Each audio track is imported as an individual audio object in the Audio list.

**Important:** Audio tracks from files with more than two tracks of audio (such as 5.1 surround audio) are imported as individual audio objects.

The link icon for the object also appears in the Layers list, indicating that the object has a corresponding audio element.

The audio file is added to the project and appears in the Audio Timeline, Audio list, mini-Timeline, and Media list.
Note: To display the Audio Timeline, click the Show/Hide Audio Timeline button in the lower-right corner of the Motion workspace.

- In the Audio list, click the Add button (+), locate the audio file you want to add in the Import Files dialog, then click Import.

- With the Audio list active, choose File > Import (or press Command-I), locate the audio file you want to add in the Import Files dialog, then click Import.

- Control-click in the Audio list, choose Import Audio from the shortcut menu, locate the audio file you want to add in the Import Files dialog, then click Import.

The audio file is added to the project and appears in the Audio Timeline, Audio list, mini-Timeline, and Media list (but does not appear in the Layers list).

Add an audio file from iTunes

1. In the Library, select the Music category.

2. Select a playlist, then select a song in the file stack.

3. Do one of the following:
   - In the preview area, click Apply.
   - Drag the file to the Layers list, Canvas, Timeline, Audio.
Drag the file to the Layers list, Canvas, Timeline, Audio Timeline, or Audio list.

**Note:** Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes non-iTunes Plus music purchased from the iTunes Store.

The audio file is added to the project and appears in the Audio Timeline, Audio list, mini-Timeline, and Media list (but does not appear in the Layers list).

---

**Add an audio file to a project for later use**

You can also add an audio file to your project without having it appear in the composition. For example, you might want to archive an audio file for later use. You do this by dragging the file into the Media list.

1. Click Media in the Project pane to open the Media list.
2. Drag an audio file from the File Browser or the Finder into the Media list.

The audio file is added to the Media list, but not to the Audio Timeline or Audio list. If you later decide to add the file to the active composition, drag the audio layer from the Media list to the Canvas, Timeline, or Audio Timeline.

---

**Add only the audio from a QuickTime movie**

When you add a QuickTime movie to your project, the movie’s
video and audio tracks are both imported. If you don’t need the video, you can add only the audio track to your project.

- Drag a QuickTime movie file from the File Browser or the Finder to the Audio list of the Project pane.

The audio track from the movie is added to your project, without the video footage. The video footage is added to the Media list (but isn’t used in your composition).

---

**Add audio from a QuickTime movie**

You can import audio from QuickTime files containing dual stereo or multiple audio channels as a single stereo track or as individual tracks.

When you add a QuickTime movie file containing both video and audio, you can use its audio track independently of the video. When the file is unlinked from its source, a track can be individually enabled, disabled, or deleted. However, deleting a source QuickTime movie file from the Media list deletes all audio and video that originated from that file.

1. Choose File > Import (or press Command-I).

2. In the Import File dialog, select a QuickTime movie file.

3. Click the Audio pop-up menu at the bottom of the Import Files dialog, then choose an import option:
   - *Mix to Stereo*: Imports the movie file as a single stereo track.
   - *Import All Tracks*: Imports the movie file with a separate
• *Import All Tracks*: imports the movie file with a separate audio track for each channel.

4. Click Import.

If you chose Mix To Stereo, the file appears in the Audio list as a single audio track, and the video appears in the Canvas (and Layers list). The link icon in the Audio list (next to the lock icon) indicates that the audio object has a corresponding video element.

If you chose Import all Tracks, the file appears in the Audio list with an individual audio track for each channel in the file. The following image shows the Audio list after importing a stereo QuickTime movie file using the Import All Tracks option, with the resulting left and right tracks.

![Audio list with Import All Tracks option](image_url)

When you export a multichannel audio file from Motion, you can export all channels or mix them down into a single track. See *Select output channels*.

---

**Play back audio files**
Preview an audio file before adding it to a project

You can listen to, or preview, an audio file in the File Browser before adding it to a project.

- In the File Browser, select an audio file.

  If “Play items automatically on a single click” in the General pane of Motion Preferences is selected, the file begins to play. If the file does not play, move the pointer over the preview area and click the Play button on the image thumbnail. You can click the Play button again to pause playback or click the Mute button to mute or unmute the sound.

Play audio in your project

- Click the Play button in the transport controls under the Canvas.

  All audio tracks in the project that are turned on and not muted play back.
Scrub an audio track

You can scrub an audio track to hear the audio in your project as you move the playhead.

- Hold down the Option key while dragging the playhead right or left in the mini-Timeline or Audio Timeline.

  Pausing the drag while continuing to hold down the mouse button and Option key loops the five frames adjacent to the current frame.

Audio looping while scrubbing is turned on by default. You can turn off looping by choosing Motion > Preferences, clicking the Time icon, then deselecting the “Loop audio while scrubbing” checkbox.

Edit audio

Audio editing overview

There are multiple ways to edit audio in your project. You can:

- Adjust audio tracks using controls in the Audio list
- Cut, copy, paste, and delete audio tracks in the Audio list
- Slip, slide, and trim audio tracks in the Audio Timeline
- Use markers with audio to help synchronize visual and audio events
- Make advanced audio adjustments, controlling the Master
• Make advanced audio adjustments, **controlling the Master track**, setting output channels, keyframing level and pan effects, and syncing audio and video tracks

• **Retime audio** tracks in your project, speeding them up, slowing them down, or playing them at a different speed

---

## Adjust audio tracks

When you add an audio file to your project, Motion creates one or more audio tracks for the file. In the Audio list of the Project pane, you can turn audio tracks on and off, select tracks, mute and solo tracks, and control their volume and pan settings:

![Audio track controls](image)

**Important:** Changes you make to an audio track, such as renaming or trimming it, do not affect the source audio file.

---

## Adjust audio tracks

Do any of the following:

- **Select an audio track:** In the Audio list or Timeline, click in the row containing the audio track’s name and controls. Selected
tracks are highlighted. Shift-click to select multiple tracks.

- **Turn an audio track on or off**: In the Audio list or Timeline, click the activation checkbox on the left side of the audio track row. Deselecting an audio track’s checkbox removes it from the audio mix.

- **Rename a track**: In the Audio list or Timeline, double-click a track’s name, then enter a new name.

- **Adjust a track’s audio volume**: In the Audio list, the track’s HUD, or the Audio Track Inspector, drag the Level slider. You can also change the parameter numerically in the Audio Track Inspector using the value slider to the right of the Level slider.

- **Pan a track, changing its position**: In the Audio list, adjust the Pan dial, or, in the Audio Track Inspector or Audio Track HUD, drag the Pan slider.

- **Mute a track, temporarily silencing it during playback**: In the Audio list, click the Mute button (the speaker icon). Muted audio tracks remain silent during playback, but are still part of the mix when you export your project. You can also mute tracks in the Audio Timeline by Control-clicking a track, then choosing Mute from the shortcut menu.

- **Solo a track, temporarily muting all other tracks**: In the Audio list, click the Solo button (the headphones icon). Soloing an audio track mutes all other audio tracks during playback, soloing multiple audio tracks mutes all tracks not soloed during playback.

- **Unlink a track**: In the Audio list, click the link icon. Unlinked
audio can be moved independently of its accompanying video track in the Timeline. Click the link icon again to relink it to the same video track it was originally linked to. If you’ve offset its position in the Timeline, the offset is maintained when the audio track is linked again.

- **Lock a track, preventing it from being edited:** In the Audio list, click the lock icon. Click the lock icon again to unlock the track. When a track is locked, you cannot mute or solo the track, change its level or pan, move or trim it, or add keyframes. You can still play the track, and turn it on or off.

- **Specify an output channel:** In the Audio list, click the output channel pop-up menu, then choose an output channel for the audio track, such as Stereo, Left, Right, Center, and so on. You can also specify an output channel using the Output Bus pop-up menu in the Audio Track Inspector.

---

**Cut, copy, paste, and delete audio tracks**

You can cut, copy, and paste audio tracks in the Audio list. You can also duplicate tracks.

---

**Cut an audio track**

- In the Audio list, select an audio track, then do one of the following:
Copy an audio track

- In the Audio list, select an audio track, then do one of the following:
  - Choose Edit > Copy (or press Command-C).
  - Control-click the track, then choose Copy from the shortcut menu.

Paste an audio track

- In the Audio list, do one of the following:
  - Choose Edit > Paste (or press Command-V).
  - Control-click an empty area, then choose Paste from the shortcut menu.

Duplicate an audio track

- In the Audio list, select an audio track, then do one of the following:
  - Choose Edit > Duplicate (or press Command-D).
  - Control-click the track, then choose Duplicate from the shortcut menu.
The duplicate appears below the original file in the Audio list.

Delete an audio track

There are two ways to remove an audio track from your project.

- In the Audio list, do one of the following:
  - Select an audio track, then press Delete.
  - Control-click an audio track, then choose Delete from the shortcut menu.

The file is removed from the project.

If you try to delete an audio file with linked video, an alert dialog appears, warning that “One or more linked video objects will also be deleted. Are you sure you want to delete the audio? You can delete just the audio by first unlinking it from the video.”

Note: Deleting an audio track from the Audio list removes the associated file from the Media list if “Automatically manage unused media” is selected in the General pane of Motion Preferences.

Slip, slide, and trim audio tracks in the Audio Timeline
The Audio Timeline provides a view of audio elements over time. The audio tracks appear as green bars with the audio waveform superimposed on the bar, and can be edited like other objects in the Timeline. The Audio Timeline uses the same ruler, buttons, and other controls as the Timeline. For more information on the Timeline interface, see Timeline overview.

When you import an audio file, its start point is placed at the start of the project or at the current playhead position (depending on the setting of the Create Layers At parameter in Motion preferences—see If it’s your first import).

You can adjust audio tracks in the Timeline using standard nonlinear editing techniques:

- **Slide** an audio track in the Audio Timeline or mini-Timeline so the track starts playing at a different point in time.

- **Slip** a trimmed audio track in the Audio Timeline or mini-Timeline so a different range of media plays at the same location.

- **Trim** an audio track in the Audio Timeline or mini-Timeline to reduce track length or to have the media start or end at a specific point in time.

Each of these editing techniques is “nondestructive”—it does not alter the audio source file on your computer or external storage.
Show the Audio Timeline

Do one of the following:

- Choose Window > Audio Timeline (or press Command-9).
- Click the Show/Hide Audio Timeline button in the lower-right corner of the Motion workspace.

Slide an audio track

Slide an audio track to change its position in the Timeline.

Do one of the following:

- In the Audio Timeline, drag an audio track’s green bar left or right.
- Select an audio track in the Audio list, then in the mini-Timeline, drag the track’s green bar to the left or right.
Slip an audio track

Slip an audio track to change the range of playable media. When you slip an audio track, its In and Out points remain unchanged in the Timeline, but the playable portion of the audio file changes.

Do one of the following:

- In the Audio Timeline, holding down the Option key, drag left or right to slip the portion of the audio file.

  As you drag, the pointer becomes a slip pointer, a dimmed bar representing the full range of the audio clip appears over the green bar, and a tooltip appears, showing the In and Out points of the audio clip.

- In the Audio list, select a track, then, holding down the Option key, drag left or right over the green bar in the mini-Timeline.

  As you drag, the pointer becomes a slip pointer, a dimmed bar representing the full range of the audio clip appears over the green bar, and a tooltip appears, showing the In and Out points of the audio clip.
points of the audio clip.

Note: You can only slip media that has had its In or Out points trimmed, leaving unused audio available on either side or both sides of the green bar.

Trim an audio track visually

Trim an audio track to reduce track length or to have it start or end at a specific point in time.

- In the Audio Timeline, place the pointer over the beginning or end of a green bar until the trim pointer appears, then drag left or right.

  As you drag, a tooltip shows you the new In or Out point and the duration of the modified track.

- In the Audio list, select a track, place the pointer over the beginning or end of the green bar in the mini-Timeline until the trim pointer appears, then drag left or right.

  As you drag, a tooltip shows you the new In or Out point and the duration of the modified track.

Trim an audio track numerically
1. In the Audio list, select an audio track.

2. Open the Properties Inspector and show the Timing parameters.

3. Modify the In, Out, or Duration value sliders

As you adjust the value sliders, the green bars in the Audio Timeline and mini-Timeline are updated.

---

**Trim an audio track from the Mark menu**

In the Audio list, select an audio track, then do one of the following:

- In the Audio list, select an audio track, then do one of the following:
  
  - *Change the track’s start point:* Move the playhead to the frame you want, then choose Mark > Move Selected In Point.
  
  - *Change the track’s end point:* Move the playhead to the frame you want, then choose Mark > Move Selected Out Point.

---

**Use markers with audio**

When you add project markers to the Timeline, they’re visible in the ruler at the top of the Timing pane. You can use project
markers to designate “hit points” as you play the project, to jump to a specific point, or to highlight points to synchronize visual and audio events.

For information on adding and deleting markers, moving markers, editing marker information, and using markers, see Work with markers overview.

**Make advanced audio adjustments**

**Work with the Master track**

Each project has a Master audio track. The controls for the Master track are located at the bottom of the Audio list, below the individual audio tracks. Using the Master track’s controls, you can make changes that affect the final mixed output of all audio tracks. For example, you can lower the volume of all tracks at once, or pan all tracks to the left or right. In addition, you can turn the Master track on or off, or mute it.

You select the Master track by clicking its area at the bottom of the Audio list. When selected, the Master track area is highlighted.
Turn the Master track on or off

The Master track is turned on by default. When its activation checkbox is deselected, no sound is audible when you play the project, and no audio is included when you export your project. When the checkbox is selected, all audio tracks that are active are included in your export.

- Click the checkbox on the left side of the Master track; click the checkbox again to return the Master track to its previous state.

Set the master level of audio in your project

You can use the master Level slider to set the overall volume of audio in your project.

- Drag the master Level slider left or right.

The master Level slider multiplies the level setting for each track. For example, if you set a track’s level to 0.5 and you set the master level to 0.5, the combined level is 0.25 (one-fourth) of the original.

**Note:** If you raise an individual track’s level and the master level so the combined increase is greater than 2, you may cause audio distortion, or *clipping*.

At the right of the Master track controls is a pair of stereo level meters that display the combined level of all audible tracks. If either of the two red dots above the level meters (called
clipping indicators) lights up during playback, your master levels are too high, causing audio distortion, or clipping.

Reset the clipping indicators

Typically, when working with digital audio, audio engineers set the overall volume level as high as possible without causing clipping. If the clipping indicators light up above the master level meters, you need to find where clipping is occurring and lower the level to eliminate the cause of the clipping.

Play the project and observe where the clipping indicators light up. You can solo each audio track to determine which track is causing the clipping. After you determine which track is causing the clipping, you can lower that track’s overall level, or use keyframes to lower the track’s level at the specific point where clipping occurs. The clipping indicators are “sticky,” meaning that when they light up, they stay lit until you reset them or close the project. This helps remind you to find and eliminate the cause of the clipping before you export your project. As you work to eliminate clipping, reset the clipping indicators and play the project again to make sure clipping no longer occurs.

- To reset a clipping indicator, click a lit clipping indicator.

Set how sound is distributed in the stereo field

- Adjust the Pan dial to place the sound where you want it in the stereo field.
The Pan dial in the Master track works with the pan setting for each track. For example, if you pan a track to –100 (hard left) and you pan the master to 100 (hard right), the track is inaudible.

Select output channels

If you’re working with more than one audio track, you can adjust which tracks are assigned to which output channels, or you can create your own multichannel file from mono tracks.

**Important:** To export multichannel audio from Motion, you must first set the Master track output from Stereo to 5.1 Surround. You can then export up to six channels of mono audio. For more information, see Export audio only.

Set or change output channels

Do either of the following:

- To set the channel for a specific audio track: In the Audio list, click the output channel pop-up menu for the audio track.
To set the Master track output: In the Audio list, click the output channel pop-up menu in the Master track area, then choose 5.1 Surround or Stereo.

Animate audio level and pan settings

You can use keyframes to automate level and pan changes over time. Audio keyframes for level and pan changes are visible in the Audio Timeline and Keyframe Editor. You can adjust these keyframes (and their curves) to create fade-ins and fade-outs, to drop audio levels for voiceovers and other sound effects, and to eliminate clipping. (For general information about using keyframes and editing curves, see Keyframing overview.)

Add audio keyframes
Do the following:

1. Move the playhead to the frame where you want to record a keyframe.

2. Select an audio track in the Audio list or Audio Timeline, then do one of the following:
   - Click the Record button in the transport controls under the Canvas, open the Audio Track Inspector, then adjust the Level slider or Pan slider.
   - Open the Audio Track Inspector, adjust the Level slider or Pan slider, then click the Add Keyframe button to the right of the slider you adjusted.

   A keyframe is added at the current frame. To see the keyframe in the Audio Editor, click the Show Keyframes button in the upper-left corner of the Timing pane.

3. Move the playhead to a new frame.

4. In the Audio Track Inspector, drag the Level slider or Pan slider to set a different value.

   A keyframe is added at the current frame.

If you turned on keyframe recording in step 2 by clicking the Record button, click it again to turn off keyframe recording.

---

**Edit audio keyframes**

After you add Level or Pan keyframes, you can change their
values in the Audio Timeline or Keyframe Editor. In the Audio Timeline, keyframes appear in sequence along a flat line, showing their relative positions in time. In the Keyframe Editor, keyframes appear in a two-dimensional graph showing their positions in time (horizontally) and their parameter values (vertically).

Do any of the following:

- **Edit keyframes in the Audio Timeline**: Drag keyframes left or right to adjust their positions in time.

  If you added Level and Pan keyframes at the same frame, dragging the keyframe in the Audio Timeline adjusts all audio keyframes at that frame.

- **Edit keyframes in the Keyframe Editor**: Drag keyframes left or right to adjust their positions in time; drag keyframes up or down to change their Level or Pan values.

The Level and Pan parameters are adjusted via different numeric ranges:

- Level curves range from –96 to 6 with 0 equivalent to 0 dB (unity gain).
- Pan curves range from –100 to 100.

Because Level and Pan curves each use a different scale, it can be difficult to frame them at the same time in the Keyframe Editor.

### Delete an audio keyframe

Do one of the following:
In the Audio Timeline, select a Level or Pan keyframe, then press delete.

In the Audio Timeline, Option-click a Level or Pan keyframe, then choose Delete from the shortcut menu.

Crossfade audio tracks

To create a crossfade between two audio tracks in Motion, add keyframes to the level curve of each track at the same (or nearly the same) points where you want the crossfade to start and end.

1. Move the playhead to the frame where you want to start the crossfade.

2. In the Audio list or Audio Timeline, select an audio track, then do one of the following:
   - Click the Record button in the transport controls under the Canvas, open the Audio Track Inspector, then drag the Level slider to the left.
   - Open the Audio Track Inspector, drag the Level slider to the left, then click the Add Keyframe button (the gray diamond with a plus sign) to the right of the slider you adjusted.

A keyframe is added at the current frame. To see the keyframe in the Audio Editor, click the Show Keyframes button in the upper-right corner of the Timing pane.
3. Move the playhead to the point where you want the audio completely faded out, then do one of the following:

- If you added a keyframe in step 2 using the Record button method, set the Level slider to zero.
- If you added a keyframe in step 2 using the Add Keyframe button method, click the Add Keyframe button again, then set the Level slider to 0.

A keyframe is added at the current frame.

4. In the Audio list or Audio Timeline, select another audio track, then do one of the following:

- If you used the Record button method in previous steps, open the Audio Track Inspector, then adjust the Level slider to 0.
- If you used the Add Keyframe button method in previous steps, open the Audio Track Inspector, adjust the Level slider to 0, then click the Add Keyframe button to the right of the slider you adjusted.

A keyframe is added at the current frame.

5. Move the playhead to the point where you want the audio completely faded in, then do one of the following:

- If you used the Record button method in previous steps, set the Level slider to the level you want.
- If you used the Add Keyframe button method in previous step,
If you used the Add Keyframe button method in previous steps, click the Add Keyframe button again, then set the Level slider to 0.

A keyframe is added at the current frame.

If you used the Record button method in previous steps, click the Record button again to turn off keyframe recording.

Listen to the crossfade as you work. You may find that the best-sounding results are achieved by having the level curves for the two tracks be slightly asymmetrical. This is because the perceived loudness of different sounds with the same numerical value can be different.

Sync audio and video tracks

Motion lets you determine how to handle the playback of audio when audio tracks are not in sync with the video. You can skip video frames to resync with the audio, or pause audio playback to avoid skipping frames if the video is out of sync.
Set audio sync preferences

1. Choose Motion > Preferences, then open the Time pane.

2. In the Playback Control section, select one of the following:
   - *Skip video frames*: Video frames are dropped to enable an uninterrupted flow of audio, for as close to real-time playback as possible.
   - *Pause audio playback*: Audio playback pauses when video and audio are out of sync, then begins when audio catches up on the next loop. This enables an uninterrupted flow of video frames (at the expense of playback slowing down) to evaluate the look of your composition.

Retime audio

Motion lets you retime audio tracks in your project, to speed them up, slow them down, or play them at a different speed. There are several ways to retime audio tracks:

- Adjust the Timing controls in the Properties Inspector to modify an audio track’s playback speed, In and Out points, duration, and end condition (whether the track stops, loops, or “ping-pongs” back and forth).
- Adjust the green bar in the Audio Timeline to modify an audio track’s duration and playback speed, and to set whether or not the track loops.
Adjust an audio track’s timing parameters in the Properties Inspector

Each audio object in your project has timing parameters in the Properties Inspector.

1. Select an audio track in the Audio list or Audio Timeline.

2. Open the Properties Inspector, then click the Show button on the right side of the Timing row.

The Timing parameters appear.

Note: The Show button is hidden until you move the pointer over the right side of the Timing row.

3. Adjust the Timing parameters:
   - **Speed:** Drag in this value slider to set the speed of the audio track as a percentage. The default is 100%. Values lower than 100 play the audio track more slowly than its original speed, and also extend the Duration of the audio track. Values higher than 100 play the track faster than its original speed, and shorten its duration.
   - **In:** Click the left or right arrow (or enter a new value in the field) to change the In point of the audio track. Adjusting this parameter moves the audio track In point to the specified frame without affecting track duration.
   - **Out:** Click the left or right arrow (or enter a new value in the field) to change the Out point of the audio track. Adjusting this parameter moves the audio track Out point to the
specified frame without affecting track duration.

- **Duration:** Click the left or right arrow (or enter a new value in the field) to set the total duration of the audio track. Adjusting Duration also affects the Speed and the Out point.

- **End Condition:** Click the pop-up menu, then choose an option to set how playback continues when audio ends in the track. There are four options:
  - **None:** The audio track’s duration in your project is equal to the duration of its source media file (the default setting).
  - **Loop:** When the last frame of the audio track is reached, the track loops back to the first frame and plays again. This can cause a jump in the audio track’s apparent playback unless the track is designed to loop seamlessly. The End Duration value must be greater than 0 for this parameter to have any effect.
  - **Ping-Pong:** When the last frame of the audio track is reached, the next iteration of track playback is reversed. The End Duration value must be greater than 0 for this parameter to have any effect. (The Ping-Pong option is mainly for reference—the reversed section of the audio track sounds noisy, because Motion does not support true reverse playback.)
  - **Hold:** The audio stops at the loop point.

- **End Duration:** Drag the slider to set the number of frames by which the track is extended at the end of its duration. This control is available only when End Condition is set to a value other than None.
Change the audio track’s duration and playback speed in the Audio Timeline

Motion lets you change the timing of audio tracks in the Audio Timeline.

**Important:** To affect all channels of a multichannel audio file, select all tracks in the Audio list before making adjustments in the Audio Timeline.

1. In the Audio Timeline, position the pointer over the end of an audio track’s the green bar.

2. Do any of the following:
   - *Shorten track duration and increase playback speed:* Holding down the Option key, drag the end of the green bar to the left.
   - *Lengthen track duration and slow playback speed:* Holding down the Option key, drag the end of the green bar to the right.

As you drag, the retiming pointer appears, and a tooltip displays the track’s duration and speed.
Another way to extend an audio track’s duration is to loop it. You can easily loop a track by adjusting it in the Audio Timeline. When a looped audio track reaches its last frame, the audio starts playing from its first frame.

1. In the Audio Timeline, position the pointer close to the end of an audio track’s green bar.

2. Holding down the Option and Shift keys, drag the end of the green bar to the left.

As you drag, the loop pointer appears, and a tooltip displays the track’s In and Out points, duration, and loop duration.

The Audio Timeline displays looped tracks with barriers to indicate where loops begin and end. The first loop barrier in a track’s bar is interactive. Dragging the barrier left or right changes the point where the track loops.

Automate effects with audio behaviors
Audio behaviors overview

You can use audio behaviors to automate common audio effects such as pans and fades, as well as create sophisticated audio-driven animations.

There are three audio behaviors:

- **Audio Auto Pan** automates commonly used panning effects in an audio track.
- **Audio Fade In/Fade Out** automates the fading in and out an audio track. For a complete list of adjustable controls.
- **Audio (parameter behavior)** performs an analysis of an audio parameter (volume or bass, for example), then links changes in that property to any other object parameter in your project. For example, you can use the Audio parameter behavior to make a shape pulse to the bass of an audio track. For a complete list of adjustable controls, see Audio (parameter behavior).

The Audio Auto Pan behavior and Audio Fade In/Fade Out behavior are located in the Audio category of behaviors. You apply them like any other standard behavior: by dragging them from the Library to an object in the Layers list, or by using the Add Behavior pop-up menu in the toolbar. For more information, see Apply behaviors overview.

The Audio parameter behavior is located in the Parameter category of behaviors. For more information, see Apply the Audio parameter behavior.
Audio Auto Pan

The Audio Auto Pan behavior automates commonly used panning effects in an audio track. Adjust this behavior using the controls in the Behaviors Inspector:

- **Pan Position**: A slider that sets the position of the pan. If the Pan Position slider is set to 0, the sound is equally balanced between the left and right channels. With larger negative values of Pan Position, the sound increases in volume in the left channel and decreases in the right channel. With larger positive values of Pan Position, the sound increases in volume in the right channel and decreases in the left channel.

- **Depth**: A slider that sets how far the automatic pan occurs in the left and right channels. Values range from 0 to 100.

- **Direction**: A pop-up menu that sets the direction in which the pan moves over the behavior’s duration. Choose Left or Right to increase volume in one channel and decrease volume in the other channel over the behavior’s duration, giving the impression of a sound moving from one direction to another.

- **Volume**: A pop-up menu that sets how audio levels are affected during the pan. Choose from five options:
  - **Constant**: An animation curve that allows no change in volume.
  - **Ramp Up**: An animation curve that creates a constant increase in volume
  - **Ramp Down**: An animation curve that creates a constant decrease in volume
  - **Crescendo**: A logarithmic animation curve that creates a slowly accelerating increase in volume
• **Decrescendo**: A logarithmic animation curve that creates a slowly decelerating decrease in volume.

• **Gain**: A slider that sets the target gain used for volume. Values range from –96 dB to +6 dB.

• **Loops**: A slider that sets the number of times the auto pan effect repeats. Values range from 1 to 30.

• **Apply Volume**: A pop-up menu that sets how audio levels change when the Auto Pan effect repeats. Choose Once Per Loop or Over Entire Duration. If you choose Once Per Loop, the Auto Pan affects audio level changes each time a loop barrier is met. If you choose Over Entire Duration, the Auto Pan affects audio level changes over the duration of the track.

• **End Condition**: A pop-up menu that sets how the pan loops when the Auto Pan effect repeats. Choose Repeat or Ping Pong. This setting has an effect only if Loops is set to a value greater than 1.

• **Start Offset**: A slider that sets the number of frames from the beginning of the audio after which the audio effect starts.

• **End Offset**: A slider that sets the number of frames from the end of the audio before which the audio effect stops.

---

**Audio Fade In/Fade Out**

The Fade In/Fade Out behavior automates fading in and out an audio track. Adjust this behavior using the controls in the Behaviors Inspector:

• **Fade In Time**: A slider that sets the number of frames over which the audio fades in, from –96 dB to 0 dB. A duration of 0
frames leaves the beginning of the audio track unmodified.

- **Fade Out Time**: A slider that sets the number of frames over which the audio fades, out from 0 dB to –96 dB. A duration of 0 frames leaves the end of the audio track unmodified.

- **Start Offset**: A slider that sets the number of frames from the beginning of the audio track after which the volume animation starts. Adjust this parameter to make the behavior start after the beginning of the audio track.

- **End Offset**: A slider that sets the number of frames from the end of the audio before which the animation stops. Adjust this parameter to make the behavior end before the end of the audio track.

The Audio Fade In/Fade Out behavior has a custom graphical control in the HUD. Drag the beginning or end of the graph to modify the Fade In Time and Fade Out Time parameters:

![Audio Fade In/Fade Out HUD](image)

**Note**: The HUD control for the Audio Fade In/Fade Out HUD behavior is identical to that of the **Fade In/Fade Out** behavior (in the Basic Motion category of behaviors).
The Audio parameter behavior performs an analysis of a specific property of an audio track, then applies an animation curve to a parameter of another object in your project based on that analysis. You can apply the Audio parameter behavior to parameters of filters, replicators, shapes, particle systems, lights, text, and even other behaviors to make your visuals pulse in sync to the beat of a soundtrack.

Adjust this behavior using the controls in the Behaviors Inspector:

- **Source Audio**: A source well that sets the audio track from which to read audio data. Drag an audio clip or a video clip containing audio into the Source Audio well, or use the pop-up menu to choose a source for audio analysis.

  **Note**: For the Audio parameter behavior to have an effect on an object, audio must be present in the Audio Timeline at the position of the behavior.

- **Respond To**: A pop-up menu that sets the type of audio data analysis to perform. Choose Amplitude or Transients. If set to Amplitude, the behavior responds to peak values of a particular frequency. If set to Transients, the behavior responds to rapid changes in frequency.

- **Graph Range**: A pop-up menu that sets the initial range of frequency values to be analyzed by the behavior. There are four options: All Frequencies, Bass, Mid, or Treble. The option you choose affects the frequency range of the Low Frequency and High Frequency parameters (described below).

- **Audio Graph**: A graph displaying a visual representation of the Source Audio data analyzed by the behavior per frame.
Click the Play button beneath the Audio Graph to see the selected Source Audio data as it plays back live. If analysis underway, a progress bar appears in the Audio Graph area. The Output level meter shows the amount of audio data from this behavior being sent to the visual effect in Motion. (Output is controlled by the Scale slider, described below.)

Set Low Frequency, High Frequency, Floor, and Ceiling values by dragging the small tags along the bottom or right side of the graph. Alternatively, you can set these values numerically using the four sliders underneath the graph to isolate specific frequencies and values for analysis:

- **Low Frequency**: A slider that sets the low frequency threshold of audio analysis. Only audio frequencies above this value are analyzed. Values range from 1 Hz to 22,050 Hz.
- **High Frequency**: A slider that sets the high frequency threshold of audio analysis. Only audio frequencies below this value are analyzed. Values range from 1 Hz to 22,050 Hz.
- **Floor**: A slider that sets the minimum value of audio input, below which results are ignored. Values range from 0 to 1.
- **Ceiling**: A slider that sets the maximum value of audio input, above which results are ignored. Values range from 0 to 1.
- **Smoothness**: A slider (available when Respond To is set to Amplitude) that sets the window size to smooth the result curve. Any value other than 0 triggers a keyframe reduction with an error tolerance of 1%. Values range from 0 to 10.
Note: Depending on your audio file, Smoothness values greater than 7 may result in audio playing out of sync.

- **Sensitivity:** A slider (available when Respond To is set to Transients) that sets the sensitivity of the transient detection. Values range from 0% to 100%.

- **Channel:** A pop-up menu that sets the audio channel to analyze. Choose Mix/Mono, Left, or Right.

Note: With a multichannel audio file used as a source, you must select Mix/Mono for audio analysis to be performed properly.

- **Peaks:** A pop-up menu that sets how Motion generates peak curves in the Keyframe editor based on audio analysis data. Changing peak options affects how the Audio behavior is applied to its parent object. There are four menu options:
  - **Sharp:** Peaks are generated from the maximum amplitude of the audio channels you choose from the Channel parameter and the frequencies you set in the Graph Range. You can adjust which portion of the audio bandwidth is analyzed using the Graph Range pop-up menu and the sliders in the Audio Graph. When Respond To is set to Transients, two keyframes are added before and after each transient keyframe (attack and release), and the transient keyframes are interpolated as linear sharp peaks.
  
  - **Smooth:** Peak curves are generated from the average amplitude of the audio channels you choose from the Channel parameter and the frequencies you set in the Graph Range. You can adjust which portion of the audio bandwidth is analyzed using the Graph Range pop-up menu and the sliders in the Audio Graph. When Respond To is set to Transients, two keyframes are added before and after each transient keyframe (attack and release), and the transient keyframes are interpolated as linear smooth peaks.
menu and the sliders in the Audio Graph. When Respond To is set to Transients, two keyframes are added before and after each transient keyframe (attack and release), and the transient keyframes are interpolated as smooth curves.

- **Square**: When Respond To is set to Transients, this option appears. Two keyframes are added before and after each transient keyframe (attack and release), and the transient keyframes are constantly interpolated as square peaks.

- **Continuous**: When Respond To is set to Transients, this option appears. The transient values are interpolated with no additional processing and appear as is.

- **Attack**: A slider (available when Respond To is set to Transients) that modifies the animation curve to the amount of the offset in frames between the peak of the curve generated by the Audio behavior and the first frame of the curve. The number of frames that the curve takes to reach its peak value from its initial value is called the Attack.

- **Release**: A slider (available when Respond To is set to Transients) that modifies the animation curve to the amount of the offset in frames between the peak of the curve generated by the Audio behavior and the last frame of the curve. The number of frames that the curve takes to reach its final value from its peak is called the Release.

- **Apply Mode**: A pop-up menu that sets the method by which the audio analysis affects the curve. Choose Add, Subtract, Multiply, or Add and Subtract.

- **Delay**: A slider that sets a delay in frames to offset the resulting keyframes.
- **Scale**: A slider that sets the scale factor to affect the result of the audio analysis.

- **Apply To**: A parameter assignment pop-up menu that sets the object parameter to which the audio behavior is applied.

**SEE ALSO**

Apply the Audio parameter behavior

---

**Apply the Audio parameter behavior**

The Audio parameter behavior generates audio-driven animations in your projects by linking changes in an audio track to any other object parameter, including parameters of filters, replicators, particle systems, lights, text, and even other behaviors. Available in the Parameter category of behaviors in the Library (and via the Add Behavior pop-up menu in the toolbar), the Audio parameter behavior lets you make a particle system pulse to the beat of a bass line, text jitter to the treble of a vocal track, or a light strobe to the rhythm of a funky guitar riff.

For a list of all parameter controls in this behavior, see Audio (parameter behavior).

---

**Apply the Audio parameter behavior to an object parameter**

1. In the Layers list, Timeline, or Canvas, select an object.

2. In the Properties Inspector, do one of the following:
- Control-click a parameter name (Position or Rotation, for example), then choose Add Parameter Behavior > Audio from the shortcut menu.

- Click the Animation menu (the downward arrow that appears when you move the pointer over the right side of a parameter row) for the parameter you want to animate, then choose Add Parameter Behavior > Audio.

The Audio parameter behavior is applied to the chosen parameter of the selected object, but no source audio is yet applied.

3. In the Behaviors Inspector, click the To pop-up menu (in the Source Audio row), then choose a source audio track.

Play back the project to see how the Audio behavior affects the object.

4. To increase the intensity of the effect, drag the Scale slider (in the Behaviors Inspector) to the right.

5. Adjust the other parameters in the Behaviors Inspector as needed, particularly the Frequency parameters. For a complete list of parameter controls in this behavior, see Audio (parameter behavior).

---

**Apply the Audio parameter behavior via the Add Behavior pop-up menu**

1. In the Layers list, Timeline, or Canvas, select an object.
2. In the toolbar, click the Add Behavior pop-up menu, then choose Parameter > Audio.

The Audio parameter behavior is applied to the selected object. However, you still need to assign a parameter to be animated and apply source audio to drive the animation.

3. To assign a parameter to animate, click the To pop-up menu in the Apply To row (at the bottom of the Behaviors Inspector), then choose a parameter.

4. To apply source audio to drive the animated parameter, click the To pop-up menu in the Source Audio row (at the top of the Behaviors Inspector), then choose a source audio track.

Play back the project to see how the Audio behavior affects the object.

5. To increase the intensity of the effect, drag the Scale slider (in the Behaviors Inspector) to the right.

6. Adjust the other parameter controls in the Audio section of the Behaviors Inspector as needed, particularly the frequency sliders. For a complete list of parameter controls in this behavior, see Audio (parameter behavior).
Share Motion projects overview

When you’re ready to distribute your project, choose an export option from the Share menu to generate a rendered output file (or files).

Most Share menu options have a specific output target—such as an Apple device connected to iTunes, a Blu-ray disc, or a specific website. There are also options for exporting broadcast-quality or highly compressed QuickTime movies, image sequences, audio, and still images. You can customize the settings of each export method to suit your specific needs.

If you have Compressor installed (the professional transcoding application), you can further customize your output file or to spread the processing work across multiple computers, for faster rendering. For more information about Compressor, see the Compressor website.

Share to Apple devices

To export your project to an Apple device such as iPhone, iPad, or iPod, or to play your project on a home theater system using Apple TV, you must send the project to iTunes. You can use the default export settings or customize the settings to suit your needs.
Choose an Apple device format for sharing

1. Choose Share > Apple Devices.

2. In the Share window, click an Apple device shown at the top.

3. Select “Add to iTunes” if you want the shared file added to your iTunes library.

4. When the device you clicked appears at the center of the window, click Share.

The time it takes to export a project depends on the size of the movie and whether you render more than one movie size at once.

Customize an Apple device format for sharing

1. Choose Share > Apple Devices.

2. In the Share window, click an Apple device shown at the top.

   The Share window displays the basic details about the file (size and device compatibility).

   **Note:** Although the iPod option exports a file that’s compatible with all Apple devices, its resolution may not look good when you play it on an iPad or Apple TV.

3. Select “Add to iTunes” if you want the shared file added to
4. To specify additional options, click Show Details, then click Options.

5. In the Options pane, choose settings to fine-tune the rendered output:
   
   - **Sizes**: To export the file in multiple sizes, select additional devices in the Sizes area.
   
   - **Encode for**: Select “Higher quality” or “More compatibility.” Note the difference in file size and number of compatible devices listed.
   
   - **Title**: To change your project’s name in iTunes, enter a name in this field.
   
   - **Add to playlist**: To add your project to an iTunes playlist, choose a playlist.
   
   - **Compression**: Choose a render quality. “Faster encode (single pass)” sacrifices quality for faster processing.
   
   - **Duration**: If you set In and Out points in the Timeline, choose whether to export the entire sequence or the portion between the In and Out points.

6. To specify additional Motion-specific options, click Render.

   For more information, see [Render settings](#).

7. To see details about files to be output, click Summary.

8. When you’re satisfied with the settings, click Share.
The time it takes to output the project depends on the size of the movie, the number of movies being rendered, and the Render settings you selected.

If you selected the Add to iTunes option, iTunes opens (if it wasn’t open), and the new output media appears within.

Share to iMovie, GarageBand, and other Apple applications

You can open a finished Motion project in another Apple application by exporting the project as a QuickTime movie.

Share a Motion project to iMovie


2. In the Options pane of the Share window, choose your preferred export settings:
   - Export: Choose an export format.
   - Open with: Choose None.
   - Include: Choose whether to include video only or video and audio.
   - Duration: If you’ve set In and Out points in the Timeline, choose whether to export the entire sequence or the
portion between the In and Out points.

3. Click Next.

4. Enter a name and save location for the exported file, then click Save.

Motion renders and saves your movie, which can now be imported into an iMovie project using the File menu. For more information, see iMovie Help.

---

**Share a Motion project to the Media Browser**

When you export to your Movies folder, you can open the movie via the Media Browser in GarageBand, Pages, Keynote, and other Apple applications.

1. Follow steps 1–3 above.

2. Enter a name and set the save location for the exported file to /Users/username/Movies/, then click Save.

Motion renders and saves your movie to your Movies folder. You can now import the movie into applications such as GarageBand, Keynote, and Pages using the Media Browser button. For more information, see the particular application’s Help.

**Note:** You can import movies from any Finder folder into GarageBand, Keynote, or Pages, but movies not saved to your Movies folder will not appear in the Media Browser.
Create a DVD, Blu-ray disc, AVCHD disc, or disk image

You can burn your project to a standard-definition DVD or to a Blu-ray-compatible disc. There are two ways to create a Blu-ray-compatible disc:

- Use an external optical drive that supports Blu-ray disc burning to blue laser media.
- Use a standard DVD burner and standard red laser media to create an AVCHD disc with HD video content and menus. You can play AVCHD discs in Blu-ray players if they’re compatible with AVCHD discs.

You can also create a disk image (.img) file that you can copy to an external drive. You can take the disk image to a disc replication facility or burn it to DVD or Blu-ray disc media at a later time using Disk Utility.

Markers are added to the file on disc at 30-second intervals, making it possible to use the DVD or Blu-ray player’s remote to skip forward or backward 30 seconds each time you press the Next Chapter or Previous Chapter buttons. Each disc format has a maximum allowable number of disc markers:

- *Standard DVD*: 99
- *Standard Blu-ray*: 999
- *AVCHD*: 50
Note: If Compressor is installed on your computer, you can use the Send to Compressor option to open the project in Compressor, where you can add and name chapter markers using the Preview window. For more information, see Compressor Help.

---

**Burn a standard-definition DVD or create a standard-definition disk image file**

1. Choose Share > DVD.

2. In the Options pane of the Share window, choose your preferred export settings:
   - *Output device*: To burn a disc, choose an optical drive. To create a disk image (.img) file that you can copy to an external drive or burn to DVD media later, choose Hard Drive.
   - *Layers*: Choose whether to burn a single-layer or dual-layer disc.
     
     **Important:** Selecting “Dual-layer” when using a single-layer disc can result in an error during burning, depending on the project’s length.
   - *Disc template*: Choose an available template.
   - *Title*: Enter the name of the disc in the Title field. By default, the name of the disc is the project name.
   - *When disc loads*: Specify the DVD player’s action when the disc is inserted: Show Menu to have a main menu
appear; Play Movie to begin playing the movie immediately.

- **Background**: To add a background to DVD menus, click the Add button and choose a graphic (navigating to where you keep your graphics files on your computer or connected storage device). To choose a different background, click the Clear button, then click Add again.

- **Main Menu/Project**: Click Main Menu to see a preview of menus included with the selected template and background; click Project to see a preview of the movie.

3. To specify additional Motion-specific options, click Render.

   For more information, see [Render settings](#).

4. To see details about files to be output, click Summary.

5. In the Options pane, do one of the following:
   - *If you’re burning to a disc (instead of creating a disk image)*: Click the eject button at the right of the Output device pop-up menu, insert a blank disk into your disc-burning device, then click Burn.
   - *If you’re creating a disk image file*: Click Next, enter a name for the file, choose a save location, then click Save. (By default, Motion burns disk images as single-layer media, and adjusts the bit rate accordingly.)

---

**Burn a Blu-ray or AVCHD disc, or create a disk image Blu-ray file**
1. Choose Share > Blu-ray.

2. In the Options pane of the Share window, choose your preferred export settings:

   - **Output device**: To burn a disc, choose an optical drive (identified in the list by the type of output it supports: Blu-ray or AVCHD). To create a disk image (.img) file that you can copy to an external drive or burn to Blu-ray media later, choose Hard Drive.

   - **Layers**: Choose whether to burn a single-layer or dual-layer disc.

     **Important**: Selecting “Dual-layer” when using a single-layer disc can result in an error during burning, depending on the project’s length.

   - **Disc template**: Choose an available template.

   - **Title**: Enter the name of the disc in the Title field. By default, the name of the disc is the project name.

   - **When disc loads**: Specify the Blu-ray player’s action when the disc is inserted: Show Menu to have a main menu appear; Play Movie to begin playing the movie immediately.

   - **Include loop movie button**: Select this checkbox to add a Loop Movie button in the exported movie’s the playback menu. (This option is not available for all disc templates.)

   - **Background, Logo graphic, Title graphic**: To add a background, logo, or title to menus, click the Add buttons, then choose graphics (navigating to where you keep your graphics files on your computer or connected storage).
device). To choose a different graphic, click the Clear button (an “x” in a circle), then click Add again.

- **Main Menu/Project:** Click Main Menu to see a preview of menus included with the selected template and background; click Project to see a preview of the movie.

3. To specify additional Motion-specific options, click Render.

   For more information, see **Render settings**.

4. To see details about files to be output, click Summary.

5. In the Options pane, do one of the following:

   - **If you’re burning to a disc (instead of creating a disk image):** Click the eject button at the right of the Output device pop-up menu, insert a blank disk into your disc-burning device, then click Burn.

   - **If you’re creating a disk image file:** Click Next, enter a name for the file, choose a location, then click Save. (By default, the Share feature assumes single-layer media for disk images and adjusts the bit rate accordingly.)

   **Note:** Blu-ray and AVCHD menus are best suited for displays set to show 1080 lines of vertical resolution.

---

**Share to email**

You can create an email message in the OS X Mail app and include your movie as an attachment.
Share a project via email

1. In Motion, choose Share > Email.

2. In the Options pane of the Share window, choose your preferred export settings:
   - **Size:** Choose an export size.
   - **Compression:** Choose a render quality. “Faster encode (single pass)” sacrifices quality for faster processing.
   - **Duration:** If you set In and Out points in the Timeline, choose whether to export the entire sequence or the portion between the In and Out points.

3. To specify additional Motion-specific options, click Render.

   For more information, see [Render settings](#).

4. To see details about files to be output, including the attachment’s estimated file size, click Summary.

   **Important:** Many email services limit the file size for attachments. If the message exceeds the maximum size allowed by your email provider, the message size in the OS X Mail app appears in red, along with the allowed limit (if the Mail app can retrieve that information from the email provider).

5. Click Compose Message.

   After rendering is complete, the Mail app opens and an email is created with the Subject field filled in and the movie
Publish to video-sharing websites

You can share your Motion project by publishing it to popular movie-sharing websites including YouTube, Facebook, Vimeo, and CNN iReport. Before using the Share command, set up an account with any of these services you plan on using. Keep your account information handy, because you’ll need it to follow the procedures in this section.

Publish your project to YouTube

1. Choose Share > YouTube.

2. Do one of the following:

   - If you see your account name in the Account area, go to step 3 below.

   - If you don’t see your account name in the Account area, do one of the following:

     • If this is your first time publishing to YouTube via Motion: Click the Sign In button, and in the window that appears, enter your YouTube account email and password, click Sign In, then click Accept.

     (If you don’t have a YouTube account, go to https://accounts.google.com/ to create one.)
• If you have more than one YouTube account: Enter the YouTube email and password for your account, click Sign In, then click Accept.

• If you want to add another YouTube account: Enter your YouTube account email and password, then click Sign In. In the upper-right corner of the “Motion would like to” window, click the current account, then click “Add account.” Next, enter the YouTube account email and password for the additional account, then click Accept.

3. Enter the requested information:

   • Category: Choose a YouTube content category.
   
   • Make this movie private: Select this checkbox if you want to limit who can see your movie (only the contacts you specify on your online YouTube account page).
   
   • Title: Enter the movie name you want viewers to see.
   
   • Description: Enter information about your movie for viewers to read.
   
   • Tags: Enter keywords that viewers can use to find your movie.

   **Note:** All the above items are required.

4. Choose a movie size from the Size pop-up menu or, to have Motion choose the size based on your project’s media, select the “Set size automatically” checkbox.

5. Choose a rendering quality from the Compression pop-up menu—“Faster encode (single pass)” when you’re willing to sacrifice quality for faster processing, or “Better quality (multi-
6. If you’ve set In and Out points in the Timeline, use the Duration pop-up menu to choose whether to export the sequence or the portion between the In and Out points.

7. To specify additional Motion-specific options, click Render.

   For more information, see Render settings.

8. To see details about files to be output, click Summary.

9. Click Next, read the terms of service, then click Publish.

   Your project is rendered and uploaded to YouTube. The time it takes depends on how long your project takes to render, and on website traffic.

---

**Publish your project to Facebook**

1. Choose Share > Facebook.

2. If your account isn’t showing in the Account pop-up menu, do one of the following:

   - If this is your first time publishing to Facebook via Motion, click Add, then enter your account name. (If you don’t have a Facebook account, go to [http://www.facebook.com](http://www.facebook.com) to create one.)

   - If you have more than one Facebook account, choose one from the Account pop-up menu.
3. Enter the requested information:
   - **Password:** Enter your Facebook account password.
   - **Viewable by:** To determine the subset of people who can view your video, choose an item from this pop-up menu.
   - **Title:** Enter the movie name you want viewers to see.
   - **Description:** Enter information about your movie for viewers to read.

4. Choose a movie size from the Size pop-up menu or, to have Motion choose the size based on your project’s media, select “Set size automatically.”

5. Choose a rendering quality from the Compression pop-up menu—“Faster encode (single-pass)” when you’re willing to sacrifice quality for faster processing, or “Better quality (multi-pass).”

6. If you’ve set In and Out points in the Timeline, use the Duration pop-up menu to choose whether to export the sequence or the portion between the In and Out points.

7. To specify additional Motion-specific options, click Render.
   
   For more information, see [Render settings](#).

8. To see details about files to be output, click Summary.

9. Click Next, read the terms of service, then click Publish.

   Your project is rendered and uploaded to Facebook. The time it takes depends on how long your project takes to render and
Publish your project to Vimeo

1. Choose Share > Vimeo.

2. If your account isn’t showing in the Account pop-up menu, do one of the following:
   - If this is your first time publishing to Vimeo via Motion, click Add, then enter your account name. (If you don’t have a Vimeo account, go to http://www.vimeo.com to create one.)
   - If you have more than one Vimeo account, choose one from the Account pop-up menu.

3. Enter the requested information:
   - **Password**: Enter your Vimeo account password.
   - **Viewable by**: To determine the subset of people who can view your video, choose an item from this pop-up menu.
   - **Title**: Enter the movie name you want viewers to see.
   - **Description**: Enter information about your movie for viewers to read.
   - **Tags**: Enter keywords that viewers can use to search for and find your movie.

4. Choose a movie size from the Size pop-up menu or, to have Motion choose the size based on your project’s media, select “Set size automatically.”
5. Choose a rendering quality from the Compression pop-up menu—“Faster encode (single-pass)” when you’re willing to sacrifice quality for faster processing, or “Better quality (multi-pass).”

6. If you’ve set In and Out points in the Timeline, use the Duration pop-up menu to choose whether to export the sequence or the portion between the In and Out points.

7. To specify additional Motion-specific options, click Render.

   For more information, see [Render settings](http://www.ireport.com).

8. To see details about files to be output, click Summary.

9. Click Next, read the terms of service, then click Publish.

   Your project is rendered and uploaded to Vimeo. The time it takes depends on how long your project takes to render and on website traffic.

---

**Publish your project to CNN iReport**


2. Choose your account from the Account pop-up menu, or click Add to add an account.

   If you don’t have an account, go to the CNN iReport website (http://www.ireport.com) and create one.

3. Enter the requested information:

   Password: Enter your CNN iReport account password.
• **Password:** Enter your CNN iReport account password.

• **Subject:** Enter the movie name you want viewers to see.

• **Body:** Enter information about your movie for viewers to read.

• **Tags:** Enter keywords that viewers can use to search for and find your movie.

4. Choose a movie size from the Size pop-up menu, or to have Motion choose the size based on your project’s media, select “Set size automatically.”

5. Choose a rendering quality from the Compression pop-up menu—“Faster encode (single-pass)” when you’re willing to sacrifice quality for faster processing, or “Better quality (multi-pass).”

6. If you’ve set In and Out points in the Timeline, use the Duration pop-up menu to choose whether to export the sequence or the portion between the In and Out points.

7. To specify additional Motion-specific options, click Render.

   For more information, see [Render settings](#).

8. To see details about files to be output, click Summary.

9. Click Next, read the terms of service, then click Publish.

   Your project is rendered and uploaded to CNN iReport. The time it takes depends on how long your project takes to render and on website traffic.
Export a QuickTime movie

You can export your project as a QuickTime movie file via the Export Movie command in the Share menu. Use this option when you want to use the media in another application, copy it to an external storage device for a client to review, or publish it to an unsupported website. You can limit what’s exported from your project to objects you select using the Export Selection to Movie command. This technique is useful when you want to export background or foreground layers, but exclude other parts of the composition.

**Note:** When using the Export Movie or Export Selection to Movie commands, you can export only one project at a time. During export, the Share menu in other open projects is limited to one command—Send to Compressor. All other Share menu commands for those projects are dimmed and unavailable until the export completes. For more information, see Export using Compressor.

Export your project as a movie file


2. In the Options pane of the Share window, choose your preferred export settings:
   - **Export**: Choose an export format.
   - **Open with**: Choose a post-export action (Do Nothing, Open with QuickTime Player, or Open with Compressor). You
must have Compressor installed on your system for Open with Compressor to work.

- **Include**: Choose whether to include video only or video and audio.

- **Duration**: If you’ve set In and Out points in the Timeline, choose whether to export the entire sequence or the portion between the In and Out points.

3. To specify additional Motion-specific options, click Render.

   For more information, see [Render settings](#).

4. To see details about the file to be output, click Summary.

5. Click Next.

6. Enter a name and choose a save location for the exported file, then click Save.

Motion renders and saves your movie.

**Important**: The Export Movie command does not use background rendering, so you must wait until rendering is finished before you can continue to work in Motion.

---

**Export a selected object from your project as a movie file**

1. Select an object in the Layers list or Timeline, then choose Share > Export Selection to Movie (or press Option-Command-E).
2. In the Options pane of the Share window, choose your preferred export settings:
   - **Export**: Choose an export format.
   - **Open with**: Choose a post-export action (Do Nothing, Open with QuickTime Player, or Open with Compressor). You must have Compressor installed on your system for Open with Compressor to work.
   - **Include**: Choose whether to include video only or video and audio.
   - **Duration**: If you’ve set In and Out points in the Timeline, choose whether to export the entire sequence or the portion between the In and Out points.

3. To specify additional Motion-specific options, click Render. For more information, see [Render settings](#).

4. To see details about the file to be output, click Summary.

5. Click Next.

6. Enter a name and choose a save location for the exported file, then click Save.

Motion renders and saves the object you selected as a movie.

**Note:** The Export Selection to Movie command is not available when more than one object is selected.

**Important:** The Export Movie command does not use background rendering, so you must wait until rendering is
finished before you can continue to work in Motion.

Export audio only

You can export your project’s audio using the Export Audio command. You might want to do this to create a single audio file that contains a mix of all the project’s audio tracks.

Note: When you export your project, the audio is exported according to the current audio settings in the Export dialog. You can change the default exported audio sample rate via the Audio MIDI Setup application in OS X. To do so, quit Motion, then in the Finder, choose Go > Utilities and open the Audio MIDI Setup application. In the Output pane, specify a new sample rate. When you reopen Motion, the chosen sample rate appears in the Motion Export dialog.

Export your project’s audio by itself


2. Click the Export pop-up menu, then choose an audio format.

3. Select the “Open with [application]” checkbox to have the exported movie open in its default application.

The default application depends on the audio format you chose in step 2:

- AAC and MP3 files open in iTunes.
- AAC and MP3 files open in iTunes.
- AIFF, CAF, and WAVE files open in QuickTime.
- AC3 files open in Compressor (or in the application set by the Finder as the default application for AC3 files). For more information on the Finder, see Mac Help (in the Finder, choose Help > Mac Help).

4. If you’ve set In and Out points in the Timeline, click the Duration pop-up menu, then choose whether to export the sequence or the portion between the In and Out points.

5. To see details about files to be output, click Summary.

6. Click Next.

7. Enter a name for the audio file, choose a save location, then click Save.

Your audio file is rendered and saved.

**Note:** The number of audio files exported depends on the setting of the output channel pop-up menu in the Master track area at the bottom of the Audio list. If the menu is set to stereo, a single stereo file is output. If it is set to 5.2, six separate audio files are exported, corresponding to each surround track. For more information, see Select output channels.

---

Export a still image
You can save a single image file of any video frame in your project.

**Note:** When using the Save Current Frame command in the Share menu, you can export only one project at a time. During export, the Share menu in other open projects is limited to one command—Send to Compressor. All other Share menu commands for those projects are dimmed and unavailable until the export completes. For more information, see `Export using Compressor`.

---

**Share a still frame**

1. In your Motion project, move the playhead to the frame to be saved, then choose Share > Save Current Frame.

2. Click the Export pop-up menu, then choose an image format.

3. To specify additional Motion-specific options, click Render.

   For more information, see `Render settings`.

4. To see details about files to be output, click Summary.

5. Click Next.

6. Enter a name and choose a location for the saved file, then click Save.
Export an image sequence

You can export your project’s visuals as an image sequence—a set of sequentially numbered still-image files that are compatible with many professional finishing, compositing, and grading applications—using the Export Image Sequence command.

Export your project as an image sequence

1. Choose Share > Export Image Sequence.

2. Click the Export pop-up menu, then choose an image sequence file format.

3. To export frames from a project that uses nonsquare Pixel Aspect Ratio (such as NTSC or PAL) so the resulting files use square pixels, select “Scale image to preserve aspect ratio.”

4. If you’ve set In and Out points in the Timeline, click the Duration pop-up menu, then choose whether to export the sequence or the portion between the In and Out points.

5. To specify additional Motion-specific options, click Render.

   For more information, see Render settings.

6. To see details about files to be output, click Summary.

7. Click Next.

8. Enter a name for the image sequence, then choose where to
Important: This command creates a folder using the name you entered. The image sequence files are saved here.

9. Click Save.

Motion renders and saves an image sequence.

Export for HTTP Live Streaming

If you want to post a movie on a streaming website, you can export an HTTP live streaming playlist that’s linked to a group of movie segments (such as MPEG-4 files) compressed using different settings. When hosted using the related server software, the playlist dynamically chooses the best version for users’ various devices and Internet connection speeds.

Export your project for HTTP Live Streaming

1. Choose Share > Export for HTTP Live Streaming.

   Note: Your project must contain audio to use Export for HTTP Live Streaming.

2. In the Options pane of the Share window, choose your preferred export settings:
   
   - Versions to export: Select one or more network types on
which the movie will be streamed (Cellular, Wi-Fi, or Broadband). Select the “Include Read Me file” checkbox to include instructions for posting your project to your website in the export.

- **Segment length:** Choose how your video stream will be split into chunks that the web server can switch between while streaming to a device with varying network connection speeds. There are two options:
  - **10 seconds:** Allows the server to respond more quickly to changing connection speeds, at the expense of slightly larger files.
  - **30 seconds:** Allows for smaller, more efficient files when you do not expect the server to need to respond to rapidly changing connection speeds.
- **Duration:** If you’ve set In and Out points in the Timeline, choose whether to export the entire sequence or the portion between the In and Out points.

3. To specify additional Motion-specific options, click Render.

   For more information, see [Render settings](#).

4. To see details about files to be output, click Summary.

5. Click Next, and then enter a name and choose a save location for the exported file.

6. Click Save.

Motion renders and saves the exported segments into folders. If you selected “Include Read Me file” in step 2, an HTML file
containing information on how to post your project to your website is included in the export. If applicable, see your server administrator for more information.

Export using Compressor

Share menu options are configured to provide results that work well for common situations. However, at times you might need to customize the settings. Compressor, a professional transcoding application that works with Motion, gives you maximum control over media-conversion specifications and encoding workflows.

Important: To export using Compressor, you must have Compressor installed. Compressor must be purchased separately. For more information, see the Compressor website.

Here are some ways you can use Compressor:

- **If you have Compressor installed:** You can send your project to Compressor via the Share > Send to Compressor command, to take advantage of the options available in Compressor to customize your output.

- **If you have Compressor installed, or have copied Compressor settings to your computer:** You can apply Compressor settings (either the Apple-supplied setting or custom settings you create) in Motion via the Share > Export Using Compressor Settings command. Exporting a project in this manner lets you render your project using Compressor settings without opening your project in Compressor. Each Compressor setting you select results in an additional version of your project being
rendered. After you choose settings and click Save, your project is rendered in the background.

---

### Send a project to Compressor

1. Choose Share > Send to Compressor.

   Compressor opens, adding the project to the batch area.

2. Drag one or more settings from the Settings pane to your project in the batch area, then click Start Batch.

   For more information, see [Compressor Help](#).

---

### Export a project using Compressor settings


2. In the window that appears, select a setting from one of the folders.

   You can search for a specific setting, such as H.264 or 1080p, in the Search field that appears below the project preview.

3. If you’ve set In and Out points in the Timeline, click the Duration pop-up menu to choose whether to export the entire project or the play range (the portion between the In and Out points).

4. Select Open with Application to have the exported file
automatically open.

5. To see details about files to be output, click Summary.

6. Click Next.

7. Enter a file name, choose a save location for the output files, then click Save.

Your project begins rendering, as shown by a analysis indicator on the left side of the Motion toolbar.

Render settings

When sharing a Motion project, you can choose from different rendering options to balance image quality versus rendering time. These options, when available, are found in the Render pane of the Share window. (If you chose Share > Apple Devices and the Render pane is not visible, click Show Details.)
Basic rendering options

Use these options to choose the quality of your project’s output, as well as whether effects, such as motion blur and frame blending, appear in your project’s output.

- **Color**: A pop-up menu that sets whether to output Color channels (RGB only, with no transparency), Alpha channel only, or Color + Alpha (RGB with transparency).

  **Note**: Only some codecs support embedded alpha channels. If you’re outputting to a codec that doesn’t support alpha channels, no alpha channel is saved, regardless of the option you choose in this pop-up menu.

- **Premultiply Alpha**: A checkbox that, when selected, mixes (via multiplication) semitransparent pixels with the project’s background in the exported file (when the project’s
background color is black).

- **Render Quality**: A pop-up menu that sets a Render Quality to Best, Normal, Draft, or Custom. The Render Quality setting affects the image quality of specific effects, but not the image as a whole. Choosing a lower render quality reduces render times, while choosing a higher render quality improves the quality of output. For more information, see Custom Canvas view options.

- **Fields**: A pop-up menu that sets whether to render individual fields. Options include On (interlaced), Off (progressive), and “Use canvas setting.”

- **Motion Blur**: A pop-up menu that sets whether to apply motion blur to moving objects. The options are On, Off, or “Use canvas setting.”

- **Frame Blending**: A pop-up menu that sets whether to render frame blending to output smoother, higher-quality slow motion in your project. The options are On, Off, or “Use canvas setting.”

### 3D rendering options

Use these options to choose whether 3D effects, such as lighting, shadow, and reflections, appear in your 3D project’s output.

- **Camera**: A pop-up menu to choose the cameras to use to render your project, if your project uses 3D layers.

- **Lighting**: A pop-up menu that sets whether to render lighting effects. The options are On, Off, or “Use canvas setting.” Turning this option off reduces rendering time; however,
lighting effects do not appear in the output.

- **Shadows**: A pop-up menu to choose whether to render shadow effects. The options are On, Off, or “Use canvas setting.” Turning this option off reduces rendering time; however, shadow effects do not appear in the output.

- **Reflections**: A pop-up menu to choose whether to render reflection effects. The options are On, Off, “Use canvas setting.” Turning this option off reduces rendering times; however, reflection effects do not appear in the output.

- **Depth of Field**: A pop-up menu to choose whether to render depth of field effects. The options are On, Off, or “Use canvas setting.” Turning this option off reduces rendering times; however, depth of field effects will not appear in the output.

Display the background render list

You can render most Share operations in the background while you continue to work in Motion. To review or cancel projects in the render queue, display the Background Task List.

**Note**: Export Movie, Save Current Frame, and Export Selection to Movie render in the foreground.

Display the Background Task List

- Choose Window > Show Task List (or press F9).
- Click the analysis indicator (in the lower-left corner of the
The Background Task List window appears, displaying all background processes. Each task is labeled, has a progress bar, and displays text describing how far along the task is.

**Note:** Any current retiming (such as optical flow) analyses are also displayed in the Background Task List. Although you can reorder the priority of the retiming jobs, you cannot rearrange the priority of shared projects.

### Cancel the share

- Click the Cancel button next to the process you want to cancel.

### Share notifications
As you work in Motion, the OS X Notification Center provides a convenient way to receive alerts when your background share operations are complete (or have failed). These settings are controlled in OS X System Preferences.

Set Motion Share alerts in OS X System Preferences

1. Choose Apple menu > System Preferences.

2. In the Notifications pane of System Preferences, select Motion in the “In Notification Center” list, then set an alert style:

   - **Banners**: The share notifications appear on your screen and disappear after a while.

   - **Alerts**: The share notifications stay on your screen until you dismiss them.

   If the share fails, click “Details” in the alert to view a dialog displaying the error message.

   For more information, see Mac Help (in the Finder, choose Help > Mac Help).
Popular video codecs for file exchange

You can use video compressed with nearly any video codec in Motion. When you work on a project in Motion, it’s best to use high-quality codecs with a minimum of compression. Highly compressed video files, such as those compressed using the MPEG-4 or Sorenson codec, are likely to be unsuitable for creating high-quality work.

For purposes of media exchange between applications, not all codecs support alpha channels. Alpha channels define transparency in a clip, and are useful if you’re delivering an effects shot for use in someone else’s composition. If you’re required to export a composition using a codec with no alpha channel support, you must export the alpha channel as a separate grayscale media file.

**Note:** Motion processes color in the RGB color space. Any clips that were captured or recompressed using a $Y’C_BC_R$-aware codec, such as DV, the Apple ProRes family, or Uncompressed 8-bit 4:2:2, are converted to the RGB color space when used in a Motion project. Clips exported from Motion using a $Y’C_BC_R$ codec are converted back into the $Y’C_BC_R$ color space.

For a complete list of file formats supported by Motion, see
Apple ProRes

Apple ProRes codecs provide an unparalleled combination of multistream, real-time editing performance, impressive image quality, and reduced storage rates. Apple ProRes codecs take full advantage of multicore processing and feature fast, reduced-resolution decoding modes. All Apple ProRes codecs support any frame size (including SD, HD, 2K, and 4K) at full resolution. The data rates vary based on codec type, image content, frame size, and frame rate.

Apple ProRes includes the following formats:

- **Apple ProRes 4444 XQ**: The highest-quality version of Apple ProRes for 4:4:4:4 image sources (including alpha channels), with a very high data rate to preserve the detail in high-dynamic-range imagery generated by today’s highest-quality digital image sensors. Apple ProRes 4444 XQ preserves dynamic ranges several times greater than the dynamic range of Rec 709 imagery—even against the rigors of extreme visual effects processing, in which tone-scale blacks or highlights are stretched significantly. Like standard Apple ProRes 4444, this codec supports up to 12 bits per image channel and up to 16 bits for the alpha channel. Apple ProRes 4444 XQ features a target data rate of approximately 500 Mbps for 4:4:4 sources at 1920 x 1080 and 29.97 fps.

- **Apple ProRes 4444**: An extremely high-quality version of Apple ProRes for 4:4:4:4 image sources (including alpha channels). This codec features full-resolution, mastering-quality 4:4:4:4 RGBA color and visual fidelity that is
perceptually indistinguishable from the original material. Apple ProRes 4444 is a high-quality solution for storing and exchanging motion graphics and composites, with excellent multigeneration performance and a mathematically lossless alpha channel up to 16 bits. This codec features a remarkably low data rate compared to uncompressed 4:4:4 HD, with a target data rate of approximately 330 Mbps for 4:4:4 sources at 1920 x 1080 and 29.97 fps. It also offers direct encoding of, and decoding to, both RGB and Y’CBCR pixel formats.

- **Apple ProRes 422 HQ**: A higher-data-rate version of Apple ProRes 422 that preserves visual quality at the same high level as Apple ProRes 4444, but for 4:2:2 image sources. With widespread adoption across the video post-production industry, Apple ProRes 422 HQ offers visually lossless preservation of the highest-quality professional HD video that a single-link HD-SDI signal can carry. This codec supports full-width, 4:2:2 video sources at 10-bit pixel depths, while remaining visually lossless through many generations of decoding and reencoding. The target data rate of Apple ProRes 422 HQ is approximately 220 Mbps at 1920 x 1080 and 29.97 fps.

- **Apple ProRes 422**: A high-quality compressed codec offering nearly all the benefits of Apple ProRes 422 HQ, but at 66 percent of the data rate for even better multistream, real-time editing performance. The target data rate of Apple ProRes 422 is approximately 147 Mbps at 1920 x 1080 and 29.97 fps.

- **Apple ProRes 422 LT**: A more highly compressed codec than Apple ProRes 422, with roughly 70 percent of the data rate and 30 percent smaller file sizes. This codec is perfect for environments where storage capacity and data rate are at a premium. The target data rate of Apple ProRes 422 LT is...
approximately 102 Mbps at 1920 x 1080 and 29.97 fps.

- **Apple ProRes 422 Proxy:** An even more highly compressed codec than Apple ProRes 422 LT, intended for use in offline workflows that require low data rates but full-resolution video. The target data rate of Apple ProRes 422 Proxy is approximately 45 Mbps at 1920 x 1080 and 29.97 fps.

**Note:** Apple ProRes 4444 and Apple ProRes 4444 XQ are ideal for the exchange of motion graphics media because they are virtually lossless, and are the only Apple ProRes codecs that include alpha channel support to preserve transparency for later compositing.

### Uncompressed 8-bit and 10-bit 4:2:2 video

These resolution-independent codecs are appropriate for all standard-definition and high-definition Y’CBCR video formats. Video stored using these codecs undergoes no data compression, but some color resampling may occur depending on the source video format. Because compression usually results in video artifacts, using no compression guarantees the highest level of quality, so this codec is often used for video mastering when the absolute highest quality is required. This also results in large file sizes.

**Note:** Uncompressed 8-bit and 10-bit 4:2:2 movies do not support alpha channels.

**DVCPRO HD**
A high-definition video format used to capture video digitally from FireWire-enabled DVCPRO HD compatible decks. (Not to be confused with DVCPRO 25 or DVCPRO 50, which are both standard-definition formats.) This format supports a number of frame sizes and frame rates, including a 24p format that offers variable speed via a variable frame rate technology. DVCPRO HD uses 4:2:2 color sampling for high color fidelity, and has a fixed data rate of 12.5 MB/sec.

**Note:** DVCPRO HD movies do not support alpha channels.

**DVCPRO 50**

A standard-definition codec used to capture video digitally from FireWire-enabled, DVCPRO 50-compatible camcorders and decks. Although it’s similar to the DV codec because DVCPRO 50 is imported as YUV encoded video, it produces considerably higher quality video because it uses less compression. (DVCPRO 50 uses a 3:3:1 compression ratio, versus DV’s 5:1 compression ratio.) DVCPRO 50 also uses 4:2:2 color sampling for high color fidelity, as opposed to DV’s 4:1:1 color sample rate. DVCPRO 50 has a fixed data rate of 7 MB/sec.

**Note:** DVCPRO 50 movies do not support alpha channels.

**MXF**

MXF (Material eXchange Format) is an industry standard container format for video and audio. Similar to QuickTime files, a metadata wrapper describes the media within the MXF file. This information can include frame rate, frame size, creation date, and custom
data created by a camera operator, assistant, or archivist.

**Third-party codecs**

Numerous video-editing solutions use different codecs, some of which may be available for installation to encourage interoperability. For more information, contact the manufacturer of the editing system.

*Note:* Most third-party codecs cannot have alpha channels.

**Field order**

When a video display plays an interlaced video signal, each frame of video is split into two *fields*, each of which contains a set of alternating lines of horizontal resolution running across the screen. Standard-definition NTSC and PAL are both *interlaced* video formats, while some high-definition video formats, and all video displayed on a computer screen, are *progressive-scanned* video formats. With progressive scanning, these lines are drawn one at a time, from the top of the screen to the bottom.

When you record interlaced footage with a camcorder, each video frame is split into two fields, each containing half of the total lines of resolution in the frame. The first field is recorded, then the second, one after the other, so that both fields constitute one frame. When you play the video back, the monitor displays each recorded frame in succession, first drawing one field, then the other.

Field order refers to the order in which each pair of video fields is
recorded. Because video fields are recorded sequentially, it’s as if each 29.97 fps clip is really playing at 60 “frames” per second.

There are two options for field order:

- Upper (Field 2 is dominant, so the second field is drawn first.)
- Lower (Field 1 is dominant, so the first field is drawn first.)

Generally, Upper is used by 640 x 480 systems, while Lower is most common in professional 720 x 486 and DV 720 x 480 systems.

It’s important to render digital video with the field order required by your playback system. Because motion continues from one field to the next, it’s crucial that each field plays in the correct order.

**Note:** When creating line art or selecting a font to use in an interlaced broadcast video image, avoid creating horizontal single-pixel lines. Also avoid using fonts that are too thin. Because of the line-alternating nature of interlaced video, single-pixel lines flicker when the field in which they appear turns on and off. This results in a buzzing effect in your graphics, with the buzzing becoming more pronounced the closer the thin portions of graphics or texture in your image come to the horizontal axis. You can reduce this issue by adding a bit of blur or anti-aliasing to your image, but it’s best to avoid single-pixel lines when creating graphics for broadcast.

---

**Change footage field order**
Select the clip in the Media list of the Project pane, then choose an option from the Field Order pop-up menu in the Media pane of the Inspector.

---

Pixel aspect ratio

Pixel aspect ratio overview

Square versus nonsquare pixels

Pixel Aspect Ratio (PAR) is the ratio of the width of a pixel to its height. When you’re preparing to import graphics into Motion, be aware of the pixel aspect ratio you’re using and whether your project requires you to work with square or nonsquare pixels. Graphics created on a computer, whether scanned, painted, or rendered, will look distorted on a standard-definition video display unless you account for the different pixel aspect ratio.

- Use nonsquare pixels for standard-definition projects in NTSC or PAL.
- Use square pixels for full-raster high-definition projects, 4K projects, and multimedia video that will be played back only on computers.
- Use square pixels for graphics used in projects with decimated raster frame sizes, such as DVCPRO HD formats recorded with a squeezed 1280 x 1080 frame size, but which are later stretched during playback to 1920 x 1080. Raster decimation is a strategy for lowering the data rate of recorded
HD video; however, the final result is almost always mastered at the nearest corresponding full-raster resolution. By creating compositied graphics and animation at the full-raster resolution used for output, you’ll simplify your asset creation, and guarantee the highest quality.

To display nonsquare pixel video correctly in Motion, click the View pop-up menu above the Canvas, then choose Correct For Aspect Ratio.

**Note:** Because full-raster high-definition video and 4K video use only square pixels, their images always appear correctly when displayed on SD video displays.

**SEE ALSO**

Create graphics that look correct when output to video

Create graphics that look correct when output to video

1. In your graphics application, create a frame size that’s the square pixel equivalent of the video frame size you’re using.

   For example, if you’re working in DV-PAL with a nonsquare video frame size of 720 x 576, your graphic should have a square pixel frame size of 768 x 576. If you’re working in Broadcast HD 1080 with a square frame size of 1920 x 1080, your graphic should have a square pixel frame size of 1920 x
1080.

2. Create the graphic.

3. Do one of the following:
   - In your graphics application, rescale the graphic from the square frame size used to create it to the nonsquare equivalent used in Motion.
   - Save your image as is.

4. In your Motion project, select the object in the Media list of the Project pane, open the Media Inspector, then choose the correct aspect ratio from the Pixel Aspect Ratio pop-up menu.

Differences in color between computer graphics and video

The range of colors that can be displayed on a broadcast video monitor employing the Rec. 709 video standard for gamut and gamma is different than the range of color that can be displayed on your computer. For this reason, colors that appear bright and clean on a video display may seem duller when viewed on your computer.

Further, if you output media that exceeds the “broadcast-legal” range for video, some colors appear oversaturated, and may “clip” or “bleed” into other parts of the image. This distortion can be avoided by controlling the palette of colors you use in your graphics and animations. As you create the composite you’ll be
outputting to video, resist the temptation to use the brightest and most saturated shades of color available.

About high-resolution graphics

When you need to pan and zoom in or out of an image (such as a scanned map or photograph), use a high-resolution image. There won’t be any image degradation because you typically won’t need to zoom more than 100 percent. Scaling video and still images up to more than 100 percent creates artifacts: individual pixels become noticeable, causing a stair-stepping effect on high-contrast diagonal lines.

To scale an imported graphic to match the frame size of a sequence, use the following frame sizes:

<table>
<thead>
<tr>
<th>Frame size (pixels)</th>
<th>Type of video</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 x 1080</td>
<td>High definition, 16:9, square pixel</td>
</tr>
<tr>
<td>1280 x 720</td>
<td>High definition, 16:9, square pixel</td>
</tr>
<tr>
<td>720 x 486</td>
<td>Standard definition, 4:3, nonsquare pixel for NTSC</td>
</tr>
<tr>
<td>Resolution</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>720 x 480</td>
<td>Standard definition DV, 4:3, nonsquare pixel for NTSC</td>
</tr>
<tr>
<td>720 x 576</td>
<td>Standard definition, 4:3, nonsquare pixel for PAL</td>
</tr>
<tr>
<td>640 x 480</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>480 x 360</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>320 x 240</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>240 x 180</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>160 x 120</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
</tbody>
</table>
Graphics guidelines for HD projects

Creating graphics and still images for high-definition (HD) video projects follows the same process as for standard-definition video. Full-raster high-definition video formats use square pixels. You don’t have to worry about adjusting high-definition image dimensions before importing your graphics into Motion. To determine the image dimensions for your sequence, follow the guidelines below.

<table>
<thead>
<tr>
<th>Sequence preset</th>
<th>Still image dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i</td>
<td>1920 horizontal x 1080 vertical</td>
</tr>
<tr>
<td>720p</td>
<td>1280 horizontal x 720 vertical</td>
</tr>
</tbody>
</table>

Graphics guidelines for 2K and 4K projects

Graphics and animations intended for digital cinema or film distribution are often created at 2K or 4K resolution, depending on how a project is mastered. Both 2K and 4K resolutions are square-pixel, progressive-frame formats, typically with a frame rate of 24 fps. To determine the image dimensions for your sequence, follow the guidelines below.

<table>
<thead>
<tr>
<th>Sequence preset</th>
<th>Still image dimensions</th>
</tr>
</thead>
</table>


<table>
<thead>
<tr>
<th>Resolution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4K</td>
<td>4096 horizontal x 2160 vertical</td>
</tr>
<tr>
<td>2K</td>
<td>2048 horizontal x 1080 vertical</td>
</tr>
</tbody>
</table>
Work smarter overview

This chapter covers information and techniques that will help you work more efficiently in Motion, including how to:

- Customize Motion preferences
- Access all Motion menu commands
- Use keyboard shortcuts and create custom keyboard shortcuts
- Use tablet gestures
- Move projects, objects, or presets to another computer
- Use color and gradient controls
- Learn how rasterization impacts a project

Motion Preferences

Change preference settings

Motion Preferences let you customize your workspace, tailor the interface for different types of projects, and define the presets for new projects and exported finished movies.
Open Motion Preferences

1. Choose Motion > Preferences (or press Command-Comma).

The Preferences window opens.

2. Click a button at the top of the window to open a preferences pane:
   - **General preferences** affect what happens when you open Motion.
   - **Appearance preferences** control visual elements of the Motion interface.
   - **Project preferences** affect project and layer duration and other project options.
   - **Time preferences** affect how time is displayed, as well as playback and keyframing.
   - **Cache preferences** affect memory management and disk usage for projects.
   - **Canvas preferences** customize your Canvas view.
   - **3D preferences** customize various aspects of working in the Motion 3D workspace.
   - **Presets preferences** set a default project type to open whenever you create a new project.
   - **Gestures preferences** affect Wacom tablets, which can be used to control Motion.
After you’ve made changes to preferences, you can reset them to their original settings.

1. Choose Motion > Preferences (or press Command-Comma).
2. Hold down the Option and Command keys while opening the Motion app.
3. In the dialog that appears, click Delete Preferences.

Motion opens, and preferences are reset to the defaults.

General preferences

General preferences control basic settings in Motion.
Startup

- **At Startup**: A pop-up menu that sets one of two default behaviors when Motion is launched:
  - *Create New Project*: Opens a new empty project. If a default preset has not been chosen, the Project Browser appears at startup.
  - *Open Last Project*: Opens the saved project from the previous session.

Interface

- **Drop Menu Delay**: A slider that sets how long you must wait before the drop menu appears when dragging to the Timeline, Layers list, or Canvas. The drop menu provides additional choices for editing and importing objects into the project.
- **Show Tooltips**: A checkbox that, when selected, turns tooltips on and off across the application. Tooltips provide explanatory information such as names and basic usage techniques. They appear when you pause the pointer over tools and controls.

File Browser & Library

- **Display Folders**: A pop-up menu that sets how folders appear in the File Browser and Library. Menu items include the following:
  - *Alphabetically in List*: Lists folders alphabetically.
  - *Last in List*: Groups the folders together at the end of the list after all nonfolder items.
• **Photo Application**: A pop-up menu that sets the photo application, such as Photo Booth or Aperture, that appears in the Photos category of the Motion Library.

• **Show preview icons**: A checkbox that, when selected, turns preview icons on and off in the File Browser and Library. For example, when looking at replicators in the Library with the “Show preview icons” checkbox selected, thumbnails of the replicators are shown.

When the checkbox is deselected, the generic icon for each item type is displayed.

• **Play items automatically on a single click**: A checkbox that controls whether the preview area plays the contents of the item selected in the file stack.

---

**Media**

• **Automatically manage unused media**: A checkbox that, when selected, has Motion remove unused media from the Media list when you delete that media from the Canvas, Layers list, or Timeline. If you want to retain (in the Media list) a copy of media that’s no longer used in your project, deselect this checkbox.

---

**Appearance preferences**
Appearance preferences affect visual elements of the Motion interface.

**Timeline**

- **Timebar Display**: A pop-up menu that sets the Timeline display. There are three options:
  - **Name**: Displays bars in the Timeline track area by object name.
  - **Name Plus Thumbnail**: Displays bars in the Timeline track area by name and with a thumbnail image representing the first frame of the object. This setting is the default. Only layers (shapes, images, image sequences, text, and so on) display a thumbnail. Objects such as cameras, lights, and behaviors do not display a thumbnail.
  - **Filmstrip**: Displays bars in the Timeline as a continuous
strip of frames. The name text does not appear. Only layers (shapes, images, image sequences, text, and so on) display a continuous strip of frames. Objects such as cameras, lights, and behaviors do not display frames.

Canvas

- **Full View Opacity**: A slider that controls the opacity of the part of a layer that extends beyond the edge of the Canvas into the background. When set to 100%, the layer is transparent. When set to 0%, the layer is fully opaque. This setting takes effect when Show Full View Area is enabled in the View menu.

Thumbnail Preview

- **Background**: A pop-up menu that sets the background for thumbnail previews in the Layers list when layers are partially transparent (contain an alpha channel). There are two options:
  - **Checkerboard**: Displays a checkerboard pattern where transparent pixels appear.
  - **Color**: Displays a solid color where transparent pixels appear.
- **Background color control**: When Background is set to Color, this color control lets you select a new background color from the OS X Colors window or from the Motion pop-up color palette.

Status Bar
These controls set the information that’s displayed in the status bar (above the Canvas).

- **Dynamic Tool Info**: A checkbox that enables the display of transform information in the status bar when you actively adjust an object using the onscreen controls. When rotating an object in the Canvas, for example, the original rotation value and the current degree of change are displayed in the status bar.

- **Color**: A checkbox that enables display of pixel color value in the status bar when you move the pointer in the Canvas. Colors are displayed in the format chosen in the Display Color As pop-up menu (described below).

- **Coordinates**: A checkbox that enables display of the X and Y coordinates of the current pointer position.

- **Frame rate (only during playback)**: A checkbox that enables display of playback frame rate. Nothing is displayed unless the project is playing.

- **Display Color As**: A pop-up menu that sets the style of color data display (when the Color checkbox is selected). Menu items include the following:
  - **RGB**: Displays the red, green, blue, and alpha values of each pixel in ranges of 0–1, although super-white values can exceed the 0–1 value range.
  - **RGB (Percent)**: Displays the red, green, blue, and alpha values of each pixel in ranges (percentages) of 1–100.
  - **HSV**: Displays the color as hue, saturation, and value (brightness), where hue is a percentage from 1–360, and saturation and value are ranged from 1–100 degrees.
Project preferences

Project preferences affect project and layer duration and other project options.

Default Project Settings

These controls determine default values for new projects. These settings take effect in new projects created after you quit, then reopen Motion. To change the settings of an open project, use the Properties Inspector (press Command-J to open the Properties Inspector).

- **Project Duration**: A value field that sets the default duration for new projects. You can enter a number into the value field and choose Frames or Seconds from the pop-up menu.
• **Background Color:** A color control that sets the color of the background for any new projects created (but does not change the background color of the current project.)

**Note:** To render a new background color into your final output, you must choose Solid from the Background Color pop-up menu in the Properties Inspector (press Command-J to open it).

• **For New Documents:** Buttons that set what occurs when you create a project:
  
  • **Show Project Browser:** Sets the Project Browser to appear whenever you create a project.
  
  • **Use Project:** Sets a specific saved project to be opened whenever you create a project. When you select Use Project, the Choose button becomes available. Click Choose to specify the project to be opened. (If the project you want does not appear in the browser, click Open Other to locate the project in the Finder.) For more information on bypassing the Project Browser, see Bypass the Project Browser.

## Still Images & Layers

These settings control the default duration, placement, and size of still images and imported layers, as well as layers created in Motion, such as text, shapes, and masks.

• **Default Layer Duration:** Buttons that set the duration of still images, generators, and other layers that lack an inherent duration. There are two options:
  
  • **Use project duration:** Sets all layers to have the same duration.
- Use project duration: Sets all layers to have the same duration as the project.

- Use custom duration: Sets a custom layer duration, defined in the adjacent value field.

- Create Layers At: Buttons that set where new layers are placed in the Timeline. There are two options:
  
  - Current frame: Creates layers at the current playhead position.
  
  - Start of project: Creates layers at the first frame of the project.

- Large Stills: A pop-up menu that sets the size of imported files. There are two options:
  
  - Do Nothing: Imports the image at its original size.
  
  - Scale to Canvas Size: Imports and scales the image to fit the project size while maintaining the file’s aspect ratio.

**Note:** For more information on the differences between the Large Stills options, see Set the import size of large still images.

---

**Time preferences**

Time preferences set how time is displayed in the project, as well as for playback and keyframing options.
Time Display

These controls set how time is counted in the Motion toolbar’s timing display.

- **Display Time As**: A pop-up menu containing the following two items:
  - **Frames**: Shows incrementing frame numbers in the timing display.
  - **Timecode**: Shows eight-digit timecode numbers in the timing display.
- **Frame Numbering**: A pop-up menu that sets whether frame counts begin at 0 or 1.

Playback Control

- **Time View Updating**: A pop-up menu that sets how the
  - **Jump by pages**
- **If Audio Sync is Lost**: Options to handle audio sync issues:
  - **Skip video frames**
  - **Pause audio playback**
  - **Limit playback speed to project frame rate**
  - **Loop audio while scrubbing**
- **Keyframe Locking**: Options to control keyframe editing:
  - **Lock keyframes in time in Keyframe Editor**
  - **Allow sub-frame keyframing**
- **Time view Updating:** A pop-up menu that sets how the Timeline updates when you play a project. Menu items include:
  - *Don’t update:* Prevents the Timeline from advancing as you play. This setting improves performance.
  - *Jump by pages:* Sets the Timeline track area to jump forward when the playhead reaches the far right side of the Timeline.
  - *Scroll continuously:* Sets the Timeline to scroll behind a static playhead.

- **If Audio Sync Is Lost:** Buttons that set how Motion attempts to keep audio and video playback in sync if the project is too complex to play both audio and video smoothly. There are two options:
  - *Skip video frames:* Plays audio continuously but skips video frames to keep up.
  - *Pause audio playback:* Temporarily suspends audio playback when the project cannot play smoothly.

- **Limit playback speed to project frame rate:** A checkbox that, when selected, prevents the playback rate from exceeding the frame rate of the project. By default, Motion plays back your project as fast as possible based on the complexity of the effects and the processing power of your computer. When this checkbox is deselected, playback rate is limited only by your processor power; consequently, playback rate may exceed project frame rate.

- **Loop audio while scrubbing:** A checkbox that, when selected, sets the audio for the frames where you drag the playhead to
repeat. When this checkbox is deselected, the audio for those frames plays only once.

**Keyframing**

- *Lock keyframes in time in Keyframe Editor*: A checkbox that, when selected, sets the values of keyframes in the Keyframe Editor, but prevents you from moving the keyframes forward or back in time. This helps prevent changing your animation timing as you adjust parameter values.

- *Allow sub-frame keyframing*: A checkbox option that ensures smoother animations when recording during playback or when scaling a group of keyframes in the Keyframe Editor using the Transform Keyframes tool.

**Cache preferences**

Cache preferences affect memory management and disk usage for projects.
Memory & Cache

- **Project Cache**: A value field that specifies the percentage of your total system memory to use for the project cache. Enter a larger number to make more memory available to Motion to cache frames, to ensure consistently smooth playback.

Autosave

These settings control how frequently projects are saved, as well as the location of the saved files. Saved projects are time- and date-stamped. For more information about customizing autosave, see Save, autosave, and revert projects.

- **Use Autosave Vault**: A checkbox that, when selected, stores
autosaved projects to the location specified by the Autosave Vault Folder path. By default, the Autosave Vault folder is located in the Users/username/Movies/Motion Projects/ folder.

- **Save a copy every:** A value field that specifies how often, in minutes, a project is saved.
- **Keep at most:** A value field that specifies how many versions of the autosaved project to store in the vault.
- **Maximum of:** A value field that specifies the maximum number of autosaved projects to store in the vault.
- **Autosave Vault Folder:** A group of controls that let you set where the autosave files are kept. The Reset button sets the autosave location back to its default.

## Optical Flow Retiming

When you retime footage, Motion stores the retiming files on your computer. The settings in this section specify the storage location.

- **Save Retiming Files:** Two buttons that set the storage location of retimed footage:
  - **In folder with source media:** When enabled, this button tells Motion to save the retiming files in the same location as the source footage.
  - **In this folder:** When enabled, this button sets a custom storage location. Click Choose, then select a new location in the file dialog. By default, the Optical Flow folder is located in the /Users/username/Library/Caches/com.apple.motionapp/Retiming Cache Files/ folder.
- **Delete Retiming Cache:** A button that deletes any optical flow retiming files and resets any objects with optical flow to frame blending. An alert dialog appears asking if you want to remove all retiming files.

- **Reveal in Finder:** A button that, when clicked, shows the location of the retimed file folder in the Finder.

**Canvas preferences**

Canvas preferences customize your Canvas view. Changes made in this pane take immediate effect in your current project.

![Canvas preferences](image)

**Alignment**

These settings control the color and display of the optional grid, rulers, and guides that appear in the Canvas. Grids, guides, and rulers can be turned on and off in the View menu or in the View pop-up menu in the upper-right corner of the Canvas.

- **Grid Spacing:** A slider that sets the width for the grid in pixels.
- **Grid Color:** A color control that sets the color of the grid lines.
- **Guide Color:** A color control that sets the color of guides.
- **Dynamic Guide Color:** A color control that sets the color for dynamic guides.
- **Snap Objects At Their:** A pop-up menu that defines how objects are aligned with other objects when moved in the Canvas. There are three options:
  - **Center:** Aligns objects at their centers.
  - **Edges:** Aligns object at their edges.
  - **Center and Edges:** Aligns objects at their centers and edges.
- **Ruler Location:** A pop-up menu the sets the position of the ruler in the Canvas. There are four options:
  - Bottom Left
  - Top Left
  - Top Right
  - Bottom Right

**Zones**

These settings control safe zone sizes and colors. Safe zones are special guides to help you avoid placing images in areas of the screen that might not appear correctly on consumer television sets. Images that appear outside the action-safe region might be cut off. The area outside the title-safe region might have distortions that make text hard to read.
When producing output to be used for both television and film, it’s helpful to see the area of the TV frame that will be cut off when the clip is converted to film. The film zone settings allow you to display a guide that identifies the aspect ratio of the film gauge you are working in.

The safe zone and film zone guides can be turned on and off in the View menu, or in the View pop-up menu in the upper-right corner of the Canvas.

- **Action Safe Region**: A slider that sets the percentage of the Canvas where the action-safe guides appear. (Default is 90% of Canvas.)
- **Title Safe Region**: A slider that sets the percentage of the Canvas where the title-safe guides appear. (Default is 80% of Canvas.)
- **Safe Zone Color**: Controls that set the color of the safe zone guides.
- **Film Zone**: A pop-up menu that sets the guide size to match a standard aspect ratio. Entering a number into the value field to the right of the pop-up menu sets a custom aspect ratio.
There are five menu choices:

- Academy Flat 1.85:1
- Anamorphic Scope 2.35:1
- High Definition 16:9
- Academy Standard 4:3
- Custom

- **Film Zone Color**: Controls that set the color of the film zone guides.

**3D preferences**

The 3D preferences affect various aspects of working in the Motion 3D workspace.

**General 3D**

- **Display Inset View**: A pop-up menu that sets when the Inset
view (a temporary window that displays a camera view) appears in the Canvas. Inset View must be enabled in the View menu or View pop-up menu (in the upper-right corner of the Canvas) for the Inset view to appear. There are three menu items:

- **On Transform Change**: Sets the Inset view to appear when adjusting an object’s transform parameters, such as position, rotation, or scale.

- **On All Changes**: Sets the Inset view to appear when making adjustments specific to an object, such as adjusting the parameters of a replicator, in the HUD or Inspector.

- **Manually**: Sets the Inset view to be displayed all the time.

- **Inset View Size**: A slider that sets the size of the Inset view.

For more information, see [Inset view](#).

- **Default New Group Type**: A pop-up menu that specifies whether new groups are created in 2D or 3D mode. When set to Automatic, Motion determines the type of group that’s created based on the project. For example, when Automatic is selected and you are working in a 3D project, new groups are 3D. If you are working in a 2D project (no camera), new groups are 2D.

### 3D Grid

These controls let you modify settings for the grid that appears in the Motion 3D workspace.

- **3D Grid Spacing**: A slider that specifies the spacing between
grid lines, in pixels.

- **Primary Grid Color**: Controls that set the color of the main grid lines. The main grid lines appear slightly heavier than the secondary grid lines.

- **Secondary Grid Color**: Controls that set the color of the secondary grid lines (the lines that appear within the main grid lines).

### Presets preferences

Presets preferences let you select a default project preset, which determines the settings assigned when you create a project. You can change any of these settings while you work by selecting the Project object in the Layers list, then clicking Properties in the Inspector.

After you set default project preset this pane, all new projects opened from the Project Browser are created with this setting (unless you choose another option from the Preset pop-up menu in the Project Browser).
- **Project Preset list:** Displays the current list of presets. The checkbox to the left of each name identifies the default preset. The column on the right shows which presets are locked. Locked presets cannot be modified. You can duplicate a locked preset and edit the copy.

- **Default:** A column of checkboxes used to designate the default project setting used for new projects. Check a different box to select a new preset.

- **Summary box (not labeled):** To the right of the Project Preset list, the Summary box displays details of the selected preset.

- **Add Preset (+):** A button that displays the Project Preset Editor dialog used to create a preset.

- **Delete Preset (−):** A button that removes a preset selected in the Project Preset list above.

- **Duplicate:** A button that creates a duplicate of the preset selected in the Project Preset list above.

- **Edit:** A button that displays the Project Preset Editor, where you can modify preset settings.
The Project Preset Editor is where you make changes to a project preset. This window opens when you click the Add Preset button (+) or attempt to edit any of the existing presets in the Presets pane of the Motion Preferences window. For more information on how to create, edit, or delete project presets, see Create, edit, and delete project presets.

The Project Preset Editor contains the following settings:

- **Name**: An editable field containing the name for the preset.
- **Description**: A field containing descriptive text to identify the preset. You can enter your own descriptive text in this field.

**Note**: Locked presets cannot be edited. If you attempt to edit a locked preset, an alert dialog appears, a duplicate copy of the preset is made, and your edits are applied to the duplicate.
The new text will appear in the summary box in the Preset pane of Motion Preferences.

**Note:** In the lower-right corner of the Project Browser, only the resolution, field order, and aspect ratio appear—the descriptive text (or preset name) does not appear.

- *Width and Height:* Fields to set the frame size for the preset.
- *Pixel Aspect Ratio:* A pop-up menu that sets the pixel aspect ratio for the preset. This setting should match the type of media in your project.
- *Field Order:* A pop-up menu that sets the field order for your project. DV projects typically use the Lower First setting.
- *Frame Rate:* A pop-up menu that sets the frame rate for your preset.

### Gestures preferences

Gestures preferences affect Wacom graphics tablets, which can be used to control Motion.

![Gestures preferences](image)
You cannot turn on gestures in Motion unless you have a tablet attached to your computer and Handwriting Recognition turned on in the Ink preferences in OS X System Preferences. You can open Ink Preferences from the Gestures Preferences pane by clicking the Open Ink Preferences button.

For more information, see Tablet Gestures overview.

**Note:** Swipes, pinches and other multi-touch gestures performed on a Multi-Touch device are unaffected by any settings in the Gestures pane of Motion Preferences.

- **Gestures are:** Buttons that turn gestures on or off.
- **Open Ink Preferences:** A button that opens the Ink pane of OS X System Preferences.
- **Trigger:** A pop-up menu that sets which trigger method is used: Pen Button 1, Pen Button 2, or the Control key on your keyboard.
- **Allow gestures in the air:** A checkbox that, when selected, lets you trigger gestures without pressing the tip of the pen on the tablet. This option is available only when a pen button is set as the trigger to activate gestures.

**Motion menus**

**Motion menus overview**

The Motion menu bar provides access to many categories of commands in the application.
Many commands are *context-sensitive*—they change depending on the current state of the Motion application. For example, a menu item might appear dimmed when a command is not available due to the current state of the application or what is selected.

- The **Application (Motion) menu** contains general functions to control the application, modify preferences, and access the Apple website.
- The **File menu** contains functions and commands for saving and managing Motion files.
- The **Edit menu** contains familiar commands such as Undo, Cut, Copy, and Paste and also commands to select and delete objects, modify project properties, and more.
- The **Mark menu** contains commands to set In and Out points, add markers to the Timeline, navigate through your project, and control animation of effects.
- The **Object menu** contains commands for manipulating objects in Motion, including object placement in the layer hierarchy and physical alignment in the Canvas.
- The **Favorites menu** lets you apply saved custom content.
- The **View menu** contains commands for controlling the visual layout of the Canvas and Timeline.
- The **Share menu** contains commands for exporting your project.
- The **Window menu** contains controls to show and hide the panes in the Motion interface.
- The **Help menu** provides access to resources for learning
The Help menu provides access to resources for learning more about Motion.

**Note:** Many commands have shortcut keys that allow you to perform the same action from the keyboard. In this chapter, these shortcuts are listed in parentheses after the command description.

## Application (Motion) menu

The Motion menu contains general functions to control the application, modify preferences, and access the Apple website. It also provides access to system-level services.

- **About Motion:** Opens the About Motion window, which contains version, registration, and trademark information.
- **Preferences:** Opens Motion Preferences. See Change preference settings.
- **Commands:** Opens a submenu of the following items for customizing keyboard shortcuts:
  - **Customize:** Opens the Command Editor. See Search and customize keyboard shortcuts overview.
  - **Import:** Opens a dialog used to import a customized key command set.
  - **Export:** Opens a dialog used to export a customized key command set.
  - **Command Sets:** Lets you load a customized key command set.
  - **Final Cut Pro Set:** Sets the active keyboard to match the
default key command layout in Final Cut Pro X wherever possible. Select from English, Japanese, French, or German.

- **Standard Set:** Sets the active keyboard to the default key command layout. Choose English, Japanese, French, or German.

- **Provide Motion Feedback:** Opens a web page where you can send comments to Apple about Motion.

- **Download Additional Content:** Downloads additional Motion Library content such as templates, particle emitters, and replicators when your computer is connected to the Internet.

- **Services:** Provides access to commands that work across different applications. See Mac Help for more information about this submenu.

- **Hide Motion:** Hides all Motion windows. The application is still running in the background. You can bring it back to the front by clicking the Motion icon in the Dock. (Command-H)

- **Hide Others:** Hides windows from all applications other than Motion. (Option-Command-H)

- **Show All:** Shows all windows from all applications currently running.

- **Quit Motion:** Stops the application from running. You are prompted to save your open document. (Command-Q)

**File menu**
The File menu contains functions and commands for managing
Motion files.

- **New:** Opens either the Project Browser dialog or a new default Motion project (if you’ve already set a default project). (Command-N)
- **New From Project Browser:** Opens the Project Browser dialog. (Option-Command-N)
- **Open:** Opens a Finder dialog to choose a Motion project to open. (Command-O)
- **Open Recent:** Opens a submenu that lists the most recently opened files, giving you quick access to projects you’ve worked on recently.
- **Close:** Closes the current project. If the project has not been saved, Motion asks you to save the project before closing the window. (Command-W)
- **Save:** Stores the current state of the project to disk. (Command-S)
- **Save As:** Saves the current state of the project with a new name. (Shift-Command-S)
- **Publish Template:** Available when the current project is a standard Motion project, saves the current project as a Motion template or a Final Cut Generator template (for use in Final Cut Pro X). See Use templates overview and Create a generator template.
- **Revert to Saved:** Restores the selected project to the last saved state. Changes made after the last save are lost. Use caution; you cannot undo this operation.
- **Restore from Autosave:** Displays a dialog where you can...
• **Restore from Autosave:** Displays a dialog where you can choose a project previously saved to the Autosave Vault. See [Cache preferences](#).

• **Import:** Opens the Import Files dialog and lets you choose a file from disk to import into your project. (Command-I)

• **Import as Project:** Displays the Import File as Project dialog. A new project is created from the chosen file, using the file’s dimensions and duration. If multiple items are selected, they’re all placed in the same project. Additional options are available if an image sequence is selected. See [Open an existing project](#). (Shift-Command-I)

• **Reconnect Media:** Reestablishes a link to a file on disk when a layer in your project has been moved or modified.

• **Remove Unused Media:** Removes a media item from your project when the item is imported into the Media list but not into the project.

• **Remove Optical Flow Retiming:** Flushes the retiming information file when a media item has been processed for retiming. See [Retime media overview](#).

• **Page Setup:** Displays the standard system Page Setup dialog where you can set paper size and orientation for printing. (Shift-Command-P)

• **Print:** Displays the standard system Print dialog, where you can print the contents of the Canvas. (Command-P)

---

**Edit menu**

The Edit menu contains familiar commands such as Undo, Cut, Copy, and Paste and also contains commands to select and...
delete objects, modify project properties, and control the Motion spelling checker.

- **Undo**: Restores the project to the state prior to the action previously taken. This command is usually followed by the name of the last command performed (Undo Move or Undo Rotation Change, for example). If the menu item is dimmed, you cannot undo. (Command-Z)

- **Redo**: Performs the action that was previously undone. This command is usually followed by the name of the last command performed (Redo Move or Redo Rotation Change, for example). It’s only active if one or more actions have been undone. (Shift-Command-Z)

- **Cut**: Removes the selection and stores it on the Clipboard so it can be pasted later. (Command-X)

- **Copy**: Copies the selection and stores it on the Clipboard so it can be pasted later. (Command-C)

- **Paste**: Adds the current Clipboard selection to the project based on the current selection. This command is not available if nothing is on the Clipboard or if the contents of the Clipboard cannot be pasted to the current selection—for example, text cannot be pasted onto a keyframe. (Command-V)

- **Paste Special**: Gives you the choice to paste the contents of the Clipboard into the active Timeline by inserting (pushing existing objects out of the way) or exchanging or overwriting (replacing existing objects with the selected object). See Copy and paste objects in the Timeline. (Option-Command-V)

- **Duplicate**: Makes a copy of the current selection and immediately adds it to the project. (Command-D)
• **Delete**: Removes the current selected object, leaving a gap in the Timeline. (Delete)

• **Ripple Delete**: Removes the selected object and closes the gap in the Timeline. (Shift-Delete)

• **Insert Time**: Adds blank space into the Timeline. You can use Insert Time only after selecting a time region in the Timeline ruler. See Make changes to a region (range of frames).

• **Split**: Breaks an object into two objects, each on its own Timeline track. The split occurs at the current playhead position. If no object is selected, or the playhead is not positioned over a selected object, this menu item is dimmed.

• **Transform Control Points**: When multiple control points of a shape or mask are selected, choosing this command creates a transform box around the points. See Add and delete control points. (Shift-Command-T)

• **Select All**: Selects all objects in the project. (Command-A)

• **Deselect All**: Releases any objects selected in the project. (Shift-Command-A)

• **Project Properties**: Selects the Project object in the Layers list and opens the Properties Inspector. Use this pane to change the settings for the project. See Project properties overview. (Command-J)

• **Spelling and Grammar**: Opens a submenu of spell-checking controls that allow you to search through the selected text for spelling and grammatical errors. See Check spelling. Submenu items include the following:

  • **Show/Hide Spelling and Grammar**: Opens the system
Spelling and Grammar dialog. This command is active only when a body of text is selected (in the Layers list, Canvas, or Text editor). See Mac Help. (Command-Colon)

- **Check Document Now:** Turns on the spelling checker for the selected text in the Text editor (the text-entry area in the Format pane) in the Text Inspector. Mistyped or misspelled text is underlined in red. This command functions on text in the Text editor, but not in the Canvas. (Command-Semicolon)

- **Check Spelling While Typing:** Turns automatic spell checking on and off for text selected in the Text editor in the Format pane of the Text Inspector. When active, a checkmark appears next to the menu item. This command functions on text in the Text editor, but not in the Canvas.

- **Check Grammar With Spelling:** Turns automatic grammar checking on and off for text selected in the Text editor in the Format pane of the Text Inspector. When active, a checkmark appears next to the menu item. Text with potential grammatical errors is underlined in red. This command functions on text in the Text editor, but not in the Canvas.

- **Correct Spelling Automatically:** Corrects misspelled words that do not begin with a capital letter or that appear on a line of their own for text selected in the Text editor in the Format pane of the Text Inspector. This command functions only on text in the Text editor, not in the Canvas.

- **Find and Replace:** Opens the Find and Replace dialog, where you can locate and change a word (or any set of characters) that you’ve used in a Motion project. See Find and replace text in your project.
• **Start Dictation:** Enables and disables dictation. Dictation must be turned on in the Dictation & Speech pane of System Preferences. See Mac Help.

• **Special Characters:** Opens the OS X Characters Palette, which provides access to nontypical text characters like bullets, arrows, and currency icons. It can be used when typing in a text object in the Canvas, or when typing in the Text editor in the Text Inspector.

---

**Mark menu**

The Mark menu contains commands to set the beginning and end points of your objects, add markers to the Timeline, navigate through your project, and control animation of effects.

• **Mark In:** Sets the beginning frame of the play range to the current playhead position if no object is selected. If an object is selected, this command trims the In point for that object to the current playhead frame. (I)

• **Mark Out:** Sets the ending frame of the play range to the current playhead position if no object is selected. If an object is selected, this command trims the Out point for that object to the current playhead position. (O)

• **Move Selected In Point:** Moves the selected object or objects so the In point aligns with the current playhead position. (Shift-Left Bracket)

• **Move Selected Out Point:** Moves the selected object or objects so the Out point aligns with the current playhead position. (Shift-Right Bracket)

• **Markers:** Opens a submenu of commands for creating
Markers: Opens a submenu of commands for creating, modifying, and deleting markers. See Work with markers overview. The submenu includes the following commands:

- **Add Marker**: Adds a marker at the current playhead frame. If an object is selected, an object marker is added. If no object is selected, a project marker is added. (Press M or the Tilde key [~] to add an object marker; press Shift-M to add a project marker.)

- **Edit Marker**: Opens the Edit Marker dialog, where you can set a marker’s name, type (for project markers), color, duration, and comment. A marker must be selected for this menu item to be active. (Option-Command-M)

- **Delete Marker**: Removes the selected marker from the project.

- **Delete All Markers**: Removes all markers from the selected object. If no object is selected, this command deletes all project markers.

- **Mark Play Range In**: Sets the play range In point to the location of the playhead. (Option-Command-I)

- **Mark Play Range Out**: Sets the play range Out point to the location of the playhead. (Option-Command-O)

- **Reset Play Range**: Moves the play range In and Out points to the first and last frame of the project. (Option-X)

- **Play**: Starts playback of the project. (Space bar)

- **Loop Playback**: Turns looping on and off. When looping is enabled, playback repeats from the beginning of the play range after the end is reached. (Shift-L)

- **Record Animation**: Turns keyframe recording on and off. See Work with markers overview.
- **Record Animation:** Turns keyframe recording on and off. See Add keyframes.

- **Recording Options:** Opens the Recording Options dialog, where you can define user preferences for keyframe recording. See Simplify a keyframe-heavy curve.

- **Go to:** Opens a submenu of commands for navigating to a specific frame in a project. The submenu includes the following commands:
  - **Project Start:** Moves the playhead to the first frame of the project. (Home)
  - **Project End:** Moves the playhead to the last frame of the project. (End)
  - **Play Range Start:** Moves the playhead to the project In point. (Shift-Home)
  - **Play Range End:** Moves the playhead to the project Out point. (Shift-End)
  - **Previous Frame:** Moves the playhead backward by one frame. (Left Arrow)
  - **Next Frame:** Moves the playhead forward by one frame. (Right Arrow)
  - **10 Frames Back:** Moves the playhead backward ten frames. (Shift–Left Arrow)
  - **10 Frames Forward:** Moves the playhead forward ten frames. (Shift–Right Arrow)
  - **Previous Keyframe:** Moves the playhead to the previous keyframe in the project. (Option-K)
  - **Next Keyframe:** Moves the playhead to the next keyframe
in the project. (Shift-K)

- **Previous Marker**: Moves the playhead to the closest marker earlier in time. (Option–Command–Left Arrow)

- **Next Marker**: Moves the playhead to the closest marker later in time. (Option–Command–Right Arrow)

- **Selection In Point**: Moves the playhead to the first frame of the selected object. (Shift-I)

- **Selection Out Point**: Moves the playhead to the last frame of the selected object. (Shift-O)

- **RAM Preview**: Opens a submenu of commands to play back your project in real time, by temporarily storing the frames in a RAM buffer. See [Play back a project](#). The submenu includes the following commands:

  - **Play Range**: Renders the area between the project In and Out points and stores the frames in RAM. After the frames are stored, the region plays back at full speed. (Command-R)

  - **Selection**: Renders the range of time occupied by the selected objects and stores the frames in RAM. After the frames are stored, the region plays back at full speed. (Option-Command-R)

  - **All**: Renders the entire project and stores the frames in RAM. After the frames are stored, the region plays back at full speed. (Option-Shift-Command-R)

  - **Clear RAM Preview**: Clears the RAM cache.
Object menu

The Object menu contains commands for manipulating objects in Motion, including object placement in the layer hierarchy and physical alignment in the Canvas.

- **New Group**: Adds a new empty group to the project. (Shift-Command-N)

- **New Camera**: Adds a new scene camera to the project, and lets you specify whether to use 2D or 3D mode (if the project is not empty). (Option-Command-C)

- **New Light**: Adds a new light to the project, and lets you specify whether to use 2D or 3D mode (if the project is not empty). (Shift-Command-L)

- **New Light Setup**: Adds a preset lighting environment to the project, and lets you specify whether to use 2D or 3D mode (if the project is not empty).

- **New Drop Zone**: Adds a new drop zone to your project. Drop zones allow you to replace footage in a project by dropping clips onto the Canvas. See [Drop zones overview](#). (Shift-Command-D)

- **New Rig**: Adds a new rig to the project. Rigging lets you create complex animations that are easy to modify, by aggregating many separate parameters into a single control, such as a slider or pop-up menu. See [Rigging overview](#).

- **Bring to Front**: Moves the selected object to the top of the layers in a group. (Command–Right Brace)

- **Send to Back**: Moves the selected object to the bottom of the layers in a group. (Command–Left Brace)
- **Bring Forward:** Moves the selected object upward in the Layers list by one object. (Command–Right Bracket)

- **Send Backward:** Moves the selected object downward in the Layers list by one object. (Command–Left Bracket)

- **Alignment:** Opens a submenu of commands for aligning and distributing multiple objects in the Canvas. See Align layers in the Canvas. Submenu commands include the following:
  - **Align Left Edges:** Moves the selected objects so their left edges line up with the leftmost edge in the selection.
  - **Align Right Edges:** Moves the selected objects so their right edges line up with the rightmost edge in the selection.
  - **Align Top Edges:** Moves the selected objects so their top edges line up with the topmost edge in the selection.
  - **Align Bottom Edges:** Moves the selected objects so their bottom edges line up with the bottommost edge in the selection.
  - **Align Far Edges:** In 3D mode, aligns the farthest edges of each object along the Z (depth) axis.
  - **Align Near Edges:** In 3D mode, aligns the nearest edges of each object along the Z (depth) axis.
  - **Align Horizontal Centers:** Lines up the selected objects on their horizontal center points.
  - **Align Vertical Centers:** Lines up the selected objects on their vertical center points.
  - **Align Depth Centers:** Lines up the selected objects on their Z (depth) center points.
  - **Distribute Lefts:** Spreads the selected objects evenly...
Distribute Lefts: Spreads the selected objects evenly between the leftmost and rightmost objects based on their left edges.

- **Distribute Rights**: Spreads the selected objects evenly between the leftmost and rightmost objects based on their right edges.

- **Distribute Tops**: Spreads the selected objects evenly between the topmost and bottommost objects based on their top edges.

- **Distribute Bottoms**: Spreads the selected objects evenly between the topmost and bottommost objects based on their bottom edges.

- **Distribute Far**: Spreads the selected objects evenly between each object’s farthest point.

- **Distribute Near**: Spreads the selected layers evenly between each object’s nearest point.

- **Distribute Horizontal Centers**: Spreads the selected objects evenly between the leftmost and rightmost objects based on their horizontal center points.

- **Distribute Vertical Centers**: Spreads the selected objects evenly between the topmost and bottommost objects based on their vertical center points.

- **Distribute Depth Centers**: Spreads the selected objects evenly between the nearest and farthest objects, based on their Z (depth) center points.

- **Group**: Combines the selected objects into a group. (Shift-Command-G)

- **Ungroup**: Removes the grouping so you can manipulate the
objects individually. (Option-Command-G)

- **Active:** Sets whether an object is active. When an object is not active, it doesn’t appear in the Canvas and doesn’t appear in the final output. When the selected item is active, the menu item has a checkmark beside it. (Control-T)

- **Solo:** Hides all other objects in the project (but not the selected object). When the selected item is soloed, the menu item has a checkmark beside it. (Alternatively, you can Control-click an object in the Layers list and choose Solo from the shortcut menu.) You cannot solo a camera, light, or rig. (Control-S)

- **Isolate:** Displays the selected object in its original front-facing orientation if it has been rotated in 3D space. (Control-I)

- **Lock:** Prevents any changes from affecting the selected object. When the selected object is locked, the menu item has a checkmark beside it. (Control-L)

- **Unsolo:** Opens a submenu that lets you turn a soloed object back to its normal state. There are three choices: Video Only (Control-Shift-S), Audio Only, or Video and Audio. This menu item is available only when a soloed object is selected.

- **3D Group:** Changes the selected group to a 3D group. Deselecting the menu option changes the group back to a 2D group. (Control-D)

- **Blend Mode:** Opens a submenu for setting the blend mode of the selected layer. An object must be selected for blend mode options to be available. A layer can only have one blend mode set at a time. See [Types of blend modes](#).

- **Add Image Mask:** Adds a mask to the selected layer. (Shift-
• **Add Keyframe:** Adds a keyframe to the selected object, based on the last parameter adjusted. The name change is based on your last action (positioning an object, adjusting the scale handles, and so on). (Control-K)

• **Convert to Keyframes:** Converts all behaviors to keyframes on the parameters that the behaviors affect. This command is available only when the selected object or objects have behaviors applied. (Command-K)

• **Convert to Mask:** Converts a selected shape to a mask and applies the mask to the enclosing group. This command is available only when the selected object is a shape in a 2D group or a flattened 3D group. See *Convert between shapes and masks*.

• **Convert to Points:** Converts a selected shape to editable Bezier points. This command is available only when the selected object is a simple shape. (Option-Command-B)

• **Make Particles:** Uses the selected layer as a cell source for a new particle emitter. (E)

• **Replicate:** Replicates the selected layer. (L)

• **Make Clone Layer:** Creates a clone of the selected layer or group. See *Add and remove layers and groups*.

• **Reveal Source Media:** Opens the Media list and highlights the item that corresponds with the selected object. (Shift-F)

Favorites menu
The Favorites menu remains empty until you create your own favorite effects. After you’ve created favorites and stored them in the Favorites Menu folder in the Library, they appear in the Favorites menu, grouped by type. Use this menu to apply saved favorites to your project.

- **Show Favorites Menu Items:** Opens the Library and displays the Favorites Menu folder.

**View menu**

The View menu contains commands for controlling the Motion interface. Most of these items affect the Canvas, but some also apply to the Timeline and other areas of the interface.

- **Zoom In:** Zooms into the Canvas. (Command–Equal Sign)
- **Zoom Out:** Zooms out of the Canvas. (Command-Hyphen)
- **Zoom Level:** This submenu lets you set a specific zoom level, including a Fit in Window option. (Shift-Z)
- **Zoom Time View:** Opens a submenu of the following commands for zooming the contents of the Timeline:
  - **To Project:** Zooms your Timeline so the entire duration of the project fills the window.
  - **To Play Range:** Zooms your Timeline so the area between the project In and Out points fills the window.
- **Correct for Aspect Ratio:** Adjusts the display of the Canvas to simulate the nonsquare pixels that appear on a TV monitor.
- **Show Full View Area:** Turns on or off the display of layers that extend beyond the edges of the Canvas. Areas that extend
beyond the edges of the Canvas appear semitransparent. (Shift-V)

- **Use Drop Zones**: Turns drop zones on and off.

- **Save View Defaults**: Saves the current state of all overlay settings (rulers, safe zones, animation paths, 3D overlays, and so on) as the default state for new projects. See Custom Canvas view options.

- **3D View**: Opens a submenu of camera view options in a 3D project. This menu is identical to the Camera pop-up menu in the upper-left corner of the Canvas. See 3D compositing overview. The submenu contains the following options:
  
  - **Active Camera**: Shows the view from the active camera. Cameras added to your project appear in this list as Camera, Camera 1, Camera 2, and so on. (Control-A)
  
  - **Perspective**: Shows the perspective camera view.
  
  - **Front**: Shows the front camera view.
  
  - **Back**: Shows the back camera view (the view from the back of the scene).
  
  - **Left**: Shows the left camera view (the view from the left of the scene).
  
  - **Right**: Shows the right camera view (the view from the right of the scene).
  
  - **Top**: Shows the top camera view (the view from the top of the scene).
  
  - **Bottom**: Shows the bottom camera view (the view from the bottom of the scene).
  
- **Next Camera**: When the Canvas is active, this command
• **Next Camera:** When the Canvas is active, this command changes your view to the next scene camera based on camera order in the Layers list. (Control-C)

• **Select Active Camera:** Selects the “active” camera in the project—the topmost camera in the Layers list when there are multiple cameras existing at the same frame in time). (Control-Option-C)

• **Reset View:** Resets the camera view to its default orientation. (Control-R)

• **Fit Objects into View:** Reframes the current camera to fit the selected objects into the Canvas. (F)

• **Frame Object:** Frames the selected objects in the active view. If no objects are selected, Frame Object resets the reference camera to view all objects in the scene. See 3D view tools. (Shift-Command-F)

• **Focus on Object:** Used when a camera has depth of field turned on. Adjusts the camera’s Focus Offset to the selected object. See Depth of field overview. (Control-F)

• **Channels:** Opens a submenu of options to set which color and transparency channels are displayed in the Canvas. This menu is identical to the Channels pop-up menu above the Canvas. The submenu contains the following options:

  • **Color:** Shows the image just as it would appear on a video monitor. Visible layers appear in natural color and transparent areas reveal the background color as set in the Project Properties. This is black by default. (Shift-C)

  • **Transparent:** Shows the background area of the Canvas as transparent. A checkerboard pattern appears by default where no images block the background. (Shift-T)
- **Alpha Overlay**: Displays the image in normal color, but adds a red highlight over transparent areas of the image. (Option-Shift-T)

- **RGB Only**: Displays the normal mix of red, green, and blue channels but transparent areas (including semitransparent areas) are treated as opaque. (Option-Shift-C)

- **Red**: Sets the Canvas to display only the red channel as a range of black to white. (Shift-R)

- **Green**: Sets the Canvas to display only the green channel as a range of black to white. (Shift-G)

- **Blue**: Sets the Canvas to display only the blue channel as a range of black to white. (Shift-B)

- **Alpha**: Sets the Canvas to display the alpha (transparency) channel of the layers in the Canvas. (Shift-A)

- **Inverted Alpha**: Sets the Canvas to display an inverted view of the alpha (transparency) channel. (Option-Shift-A)

- **Toggle Current & Alpha**: Switches back and forth between viewing the current state and just the alpha channel. (V)

- **Overexposure**: Displays the overexposed areas of the composition. Luminosity values above 1.0 (out of gamut) are indicated by a red-and-white crosshatch pattern. Values above 2.0 (super-out of gamut) appear solid red. You can use the [Broadcast Safe filter](#) to limit the range of luminance or chrominance in an image to the broadcast legal limit. (Option-Shift-O)

- **Resolution**: Opens a submenu of options for playback quality and visual quality in the Canvas. Choosing a lower resolution option improves playback performance. The submenu
includes the following options:

- **Dynamic**: Reduces the quality of the image displayed in the Canvas during playback or scrubbing in the Timeline or mini-Timeline, allowing for faster feedback. Also reduces the quality of an image as it is actively modified in the Canvas. After playback or scrubbing is stopped or the modification is completed in the Canvas, the image quality is restored (based on the Quality and Resolution settings for the project).

- **Full (Shift-Q), Half, or Quarter**: Sets image quality. Each lower setting further degrades the image.

- **Quality**: Opens a submenu of display mode settings for objects in the Canvas, such as text and images:
  
  - **Draft**: Renders objects in the Canvas at a lower quality to allow optimal project interactivity. There’s no anti-aliasing.
  
  - **Normal**: Renders objects in the Canvas at a medium quality (the default setting). Shapes are anti-aliased, but 3D intersections are not.
  
  - **Best**: Renders objects in the Canvas at best quality, which includes higher-quality image resampling, anti-aliased intersections, and anti-aliased particle edges. This option slows down project interactivity.
  
  - **Custom**: Lets you set additional controls to customize render quality. Choosing Custom opens the Advanced Quality Options dialog. See [Advanced Quality settings](#).

**Tip**: When working in your project, work in Draft or Normal for better interactivity. When you’re ready to export your project, use Best or Custom.
• **Render Options:** Opens a submenu to enable or disable rendering settings that may impact playback speed. The submenu contains the following options: Lighting (Option-L), Shadows (Control-Option-S), Reflections (Control-Option-R), Depth of Field (Control-Option-D), Motion Blur (Option-M), Field Rendering (Option-F), Frame Blending (Control-Option-B).

• **Show Overlays:** Turns the display of all overlays on and off in the Canvas. This setting must be on to view any other overlay items (rulers, grids, guides, and so on). (Command-Slash)

• **Show Rulers:** Turns display of rulers in the Canvas on and off. (Shift-Command-R)

• **Overlays:** Opens a submenu to enable or disable various indicators, guides, and grids in the Canvas. The submenu contains the following options:
  
  • **Grid:** Turns the display of a grid on and off. You can customize the grid in the Canvas pane of Motion Preferences. (Command-Apostrophe)
  
  • **Guides:** Turns the display of guides on and off. (Command-Semicolon)
  
  • **Dynamic Guides:** Turns dynamic guides on and off. *Dynamic guides* are the lines that appear when you drag one item into alignment with another layer. Press N to turn snapping on or off. (Shift-Command-Semicolon)
  
  • **Safe Zones:** Turns the display of title-safe and action-safe guides on and off. You can customize the safe zones in the Canvas pane (Zones) of Motion Preferences. (Apostrophe)
  
  • **Film Zones:** Turns the display of film-based aspect ratio...
- Film Zones: Turns the display of film-based aspect ratio guides on and off. You can customize the film zones in the Canvas pane (Zones) of Motion Preferences. (Shift-Apostrophe)

- **Handles**: Turns the display of object handles in the Canvas on and off. The handles are the corner points that let you manipulate an object.

- **Lines**: Turns the display of object border lines on and off.

- **Animation Path**: Turns the display of keyframe animation paths—lines that show where an object moves in the Canvas—on and off.

- **Guides**: Opens a submenu of commands that control the guides in the Canvas:
  
  - **Lock Guides**: Causes all guides to be fixed in their current position to prevent you from accidentally moving a guide instead of moving an object. (Option-Command-Semicolon)
  
  - **Unlock Guides**: Releases guides to be manually manipulated.
  
  - **Clear Guides**: Removes all guides from the Canvas.
  
  - **Add Vertical Guide**: Adds a moveable, vertical guide to the center of the Canvas.
  
  - **Add Horizontal Guide**: Adds a moveable, horizontal guide to the center of the Canvas.

- **Snap**: Turns object snapping on and off in the Canvas and Timeline. Snapping aligns objects as you drag them. (N)

- **Show 3D Overlays**: Turns all 3D overlays on and off, including the 3D view tools, 3D compass, Inset view, 3D grid, and 3D
scene icons.

- **3D Overlays**: Opens a submenu of the following items that set the display of 3D overlays in the Canvas:
  - **3D View Tools**: Turns the Camera menu and 3D view tools on and off.
  - **Compass**: Turns the 3D compass on and off. The compass shows your current orientation in 3D space.
  - **Inset View**: Turns on *inset view*—a window in the lower-right corner of the Canvas that displays a perspective or active-camera view of your project as you move objects in 3D space, helping you stay oriented.
  - **3D Grid**: Turns the 3D grid on and off. The 3D grid helps you stay oriented while working in 3D space and can be used to guide the placement of objects in your project. (Shift-Command-Apostrophe)
  - **3D Scene Icons**: Turns all 3D scene icons, such as lights and cameras, on and off.

- **Layers Columns**: Opens a submenu to enable or disable the following controls in the Layers list of the Project pane:
  - **Preview**: Shows a thumbnail of the object. The group thumbnail represents the cumulative result of the composite up to that point in the project.
  - **Opacity**: Displays the current opacity (transparency) of the group or layer. You can adjust the slider to change the item’s opacity.
  - **Blend Mode**: Displays the current blend mode of the layer or group. Choose a new blend mode from the pop-up
- **Media Columns**: Opens a submenu of the following commands to turn on or off the display of technical information in the Media list of the Project pane:
  - **Preview**: Shows a thumbnail of the media file. The thumbnail for an audio file (with no associated image) appears as a speaker icon.
  - **Kind**: Identifies the type of media, including QuickTime movie, still image, QuickTime audio, or PDF. See Supported media formats.
  - **In Use**: Indicates whether a media item is being used in your project.
  - **Duration**: Displays the duration of the media in frames or timecode.
  - **Frame Size**: Displays the native size of the image in pixels. The numbers represent width and height. This column remains blank for audio-only files.
  - **Format**: Displays the format of the clip. This is also sometimes referred to as a codec.
  - **Depth**: Displays the number of colors (bit depth) of the file. Any item listed as Millions of Colors+ indicates that the media contains an alpha channel in addition to the RGB data.
  - **Video Rate**: Displays the frame rate of the media.
  - **Audio Rate**: Displays the sample rate in the audio track, measured in kilohertz (kHz).
  - **Audio Bit Depth**: Displays the bit depth of the audio file.
• **File Size**: Displays the overall file size of the media on disk.
• **File Created**: Displays the creation date of the media.
• **File Modified**: Displays the last date on which the media was modified.

• **Show/Hide Fonts**: Displays or hides the OS X Fonts window for selecting fonts and font attributes. (Command-T)

• **Show/Hide Colors**: Displays or hides the OS X Colors window for selecting colors. (Shift-Command-C)

---

**Share menu**

The Share menu contains commands for exporting your project. You can export high-quality movies and image sequences, send projects to the Media Browser for use in other Apple applications, or publish to popular sharing websites such as YouTube and Facebook. You can also create your own custom export settings. See [Share Motion projects overview](#).

• **Apple Devices**: Publishes your project to iTunes, allowing you to watch it on Apple TV, or to download it to iPad, iPhone, or iPod. See [Share to Apple devices](#).

• **DVD**: Lets you burn your project to a DVD or to a disk image. See [Create a DVD, Blu-ray disc, AVCHD disc, or disk image](#).

• **Blu-ray**: Lets you burn your project to a Blu-ray disc, an AVCHD disc, or a disk image. See [Create a DVD, Blu-ray disc, AVCHD disc, or disk image](#).

• **Email**: Opens your mail application and attaches your project as a rendered movie file. See [Share to email](#).

• **YouTube**: Publishes your project to YouTube. See [Publish to YouTube](#).
- **YouTube**: Publishes your project to YouTube. See Publish to video-sharing websites.
- **Facebook**: Publishes your project to Facebook. See Publish to video-sharing websites.
- **Vimeo**: Publishes your project to Vimeo. See Publish to video-sharing websites.
- **CNN iReport**: Publishes your project to CNN iReport. See Publish to video-sharing websites.
- **Export Movie**: Exports your project as a QuickTime movie to a Finder folder to use in other projects and applications or to distribute manually. See Export a QuickTime movie.
- **Export Selection to Movie**: Exports the current selection as a QuickTime movie to a Finder folder. See Export a QuickTime movie.
- **Export Audio**: Exports only the audio portion your project as an audio file to a Finder folder. See Export a QuickTime movie.
- **Save Current Frame**: Saves the frame currently visible in the Canvas as a still image file to a Finder folder. See Export a still image.
- **Export Image Sequence**: Exports your project as an image sequence to a Finder folder. See Export a QuickTime movie.
- **Export for HTTP Live Streaming**: Exports a QuickTime reference movie for web hosting. See Export for HTTP Live Streaming.
- **Send to Compressor**: Renders your project through Compressor, allowing you to further customize your export settings and output a single movie file to a Finder folder. See
Export using Compressor.

- **Export using Compressor Settings**: Renders your project using a predefined export setting (created in Compressor). See Export using Compressor.

Window menu

The Window menu contains controls to show and hide the panes in the Motion interface.

- **Minimize**: Shrinks the active window to the Dock—equivalent to clicking the Minimize button in the upper-left corner of the window. (Command-M)
- **Minimize All**: Shrinks the Motion project window and the viewer window (if you’re using a viewer window to preview an image or clip) to the Dock.
- **Zoom**: Resizes the active window to maximize desktop real estate, switching between full screen and the previously saved non-full screen state.
- **Show Inspector**: Opens a submenu of commands to open the four Inspectors: Properties (F1), Behaviors (F2), Filters (F3), and Object (F4).
- **Show/Hide Project Pane**: Turns the display of the Project pane on or off. (F5)
- **Show/Hide Timing Pane**: Turns the display of the Timing pane on or off. (F6)
- **Show/Hide HUD**: Turns the display of the HUD on or off. (F7)
- **Show/Hide Task List**: Displays the Background Task List
- **Show/Hide Task List**: Displays the Background Task List window. See Display the background render list. (F9)

- **Player Mode**: Expands the Canvas to fill your entire display. (F8)

- **Show Canvas on Second Display/Show Canvas in the Main Window**: Shows the Canvas and Project pane (Layers, Media, and Audio lists) on a second display, if you have two displays connected to your computer.

- **Show Timing Pane on Second Display/Show Timing Pane in the Main Window**: Shows the Timing pane (Timeline, Audio Timeline, and Keyframe Editor) on a second display, if you have two displays connected to your computer.

- **Revert to Original Layout**: Shows the Timing pane or Canvas in the main project window if the Timing pane or Canvas is displayed on a second monitor.

- **File Browser**: Displays the File Browser. (Command-1)

- **Library**: Displays the Library. (Command-2)

- **Inspector**: Displays the Inspector. (Command-3)

- **Layers**: Displays the Layers list in the Project pane. (Command-4)

- **Media**: Displays the Media list in the Project pane. (Command-5)

- **Audio**: Displays the Audio list in the Project pane. (Command-6)

- **Video Timeline**: Turns the display of the Timeline on or off. (Command-7)

- **Keyframe Editor**: Turns the display of the Keyframe Editor on or off.
- **Keyframe Editor**: Turns the display of the Keyframe Editor on or off. (Command-8)

- **Audio Timeline**: Turns the display of the Audio Timeline on or off. (Command-9)

- **Bring All to Front**: Moves the Motion window to the front if the main Motion window is behind windows of other applications.

- **Enter Full Screen**: Hides the menu bar and the Dock. (Control-Command-F)

- **Open Project/Untitled List**: Displays a list of open projects and any images that are open in a viewer window.

**Help menu**

The Help menu provides access to resources for learning more about Motion.

- **Motion 5 Help**: Opens Motion Help.

- **What’s New in Motion**: Opens the Welcome Screen and displays a list of the latest updates to Motion (based on the version installed on your computer).

- **Service and Support**: Opens a webpage that contains up-to-date technical support information about Motion.

**Keyboard shortcuts**

**Keyboard shortcuts overview**

Use keyboard shortcuts to streamline your work in Motion. The
tables in this section organize keyboard shortcuts by menu, component, and task. Some keyboard shortcuts are active only under special circumstances. Some of the keyboard shortcuts described in this section may conflict with system commands assigned to the OS X Finder.

This section lists all the keyboard shortcuts available in Motion, organized into the following categories:

- General interface commands
- Menu commands overview
- Audio list
- Tools overview
- Transport controls
- View options
- Miscellaneous
- HUD
- File Browser
- Inspector
- Keyframe Editor
- Layers
- Library
- Media list
- Timeline editing and navigating
- Keyframing commands
- Sign out of Motion account
Enable function keys on portable Macintosh computers

By default on OS X, the F1–F12 keys are assigned to Mission Control, hardware controls, such as brightness, audio volume, numlock, and so on. Therefore, you must press the Function (Fn) key with the F-key to invoke F-key commands in software applications.

You can change keyboard preferences so the F-keys work in the traditional manner, without pressing the Fn key. When this setting is activated, you can press the Fn key with the F-key to activate the hardware commands.

Enable traditional function keys

- In the Keyboard pane of the Keyboard preferences in System Preferences, select the “Use all F1, F2, etc. keys as standard function keys” checkbox. Uncheck the box to return to the default setting.
<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a project</td>
<td>Command-O</td>
</tr>
<tr>
<td>Create a project</td>
<td>Command-N</td>
</tr>
<tr>
<td>Create a project from the Project Browser</td>
<td>Option-Command-N</td>
</tr>
<tr>
<td>Open the project’s Properties Inspector</td>
<td>Command-J</td>
</tr>
<tr>
<td>Save a project</td>
<td>Command-S</td>
</tr>
<tr>
<td>Save a project as a new project</td>
<td>Shift-Command-S</td>
</tr>
<tr>
<td>Close a project or active window</td>
<td>Command-W</td>
</tr>
<tr>
<td>Task</td>
<td>Shortcut</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Import a file</td>
<td>Command-I</td>
</tr>
<tr>
<td>Import a file as a project</td>
<td>Shift-Command-I</td>
</tr>
<tr>
<td>Export movie</td>
<td>Command-E</td>
</tr>
<tr>
<td>Export a selection as a movie</td>
<td>Option-Command-E</td>
</tr>
<tr>
<td>Print the current view of the Canvas</td>
<td>Command-P</td>
</tr>
<tr>
<td>Undo the last change</td>
<td>Command-Z</td>
</tr>
<tr>
<td>Redo the last change</td>
<td>Shift-Command-Z</td>
</tr>
<tr>
<td>Cut the selection</td>
<td>Command-X</td>
</tr>
<tr>
<td>Copy the selection</td>
<td>Command-C</td>
</tr>
<tr>
<td>Paste the selection</td>
<td>Command-V</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Duplicate selection</td>
<td>Command-D</td>
</tr>
<tr>
<td>Select all items</td>
<td>Command-A</td>
</tr>
<tr>
<td>Deselect all items</td>
<td>Shift-Command-A</td>
</tr>
<tr>
<td>Delete the selection</td>
<td>Delete</td>
</tr>
<tr>
<td>Minimize the active window</td>
<td>Command-M</td>
</tr>
<tr>
<td>Open Motion Preferences</td>
<td>Command-Comma</td>
</tr>
<tr>
<td>Display Page Setup dialog</td>
<td>Shift-Command-P</td>
</tr>
<tr>
<td>Hide Motion</td>
<td>Command-H</td>
</tr>
<tr>
<td>Hide other open application files</td>
<td>Option-Command-H</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Quit Motion</td>
<td>Command-Q</td>
</tr>
<tr>
<td>Play/pause a project</td>
<td>Space bar</td>
</tr>
<tr>
<td>Turn on/off animation recording</td>
<td>A</td>
</tr>
<tr>
<td>Go to the start of a project</td>
<td>Home</td>
</tr>
<tr>
<td>Go to the end of a project</td>
<td>End</td>
</tr>
</tbody>
</table>

### Menu commands

### Menu commands overview

This section lists all the keyboard shortcuts for commands in the Motion menu bar, organized into the following categories:

- **Motion menu**
- **File menu**
- **Edit menu**
- **Mark menu**
- **Object menu**
Motion menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Motion Preferences</td>
<td>Command-Comma (,)</td>
</tr>
<tr>
<td>Hide Motion</td>
<td>Command-H</td>
</tr>
<tr>
<td>Hide other open application files</td>
<td>Option-Command-H</td>
</tr>
<tr>
<td>Quit Motion</td>
<td>Command-Q</td>
</tr>
</tbody>
</table>

File menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Create a project</td>
<td>Command-N</td>
</tr>
<tr>
<td>Create a project from the Project Browser</td>
<td>Option-Command-N</td>
</tr>
<tr>
<td>Open a project</td>
<td>Command-O</td>
</tr>
<tr>
<td>Close a project</td>
<td>Command-W</td>
</tr>
<tr>
<td>Save a project</td>
<td>Command-S</td>
</tr>
<tr>
<td>Save a project as a new project</td>
<td>Shift-Command-S</td>
</tr>
<tr>
<td>Import a file</td>
<td>Command-I</td>
</tr>
<tr>
<td>Import files as a project</td>
<td>Shift-Command-I</td>
</tr>
<tr>
<td>Print the current view of the Canvas</td>
<td>Command-P</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Close all open projects</td>
<td>Option-Command-W</td>
</tr>
<tr>
<td>Open the Page Setup window</td>
<td>Shift-Command-P</td>
</tr>
<tr>
<td>Print the current Canvas view</td>
<td>Command-P</td>
</tr>
<tr>
<td><strong>Edit menu</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td><strong>Shortcut</strong></td>
</tr>
<tr>
<td>Undo the last change</td>
<td>Command-Z</td>
</tr>
<tr>
<td>Redo the last change</td>
<td>Shift-Command-Z</td>
</tr>
<tr>
<td>Cut</td>
<td>Command-X</td>
</tr>
<tr>
<td>Copy</td>
<td>Command-C</td>
</tr>
<tr>
<td>Paste</td>
<td>Command-V</td>
</tr>
<tr>
<td>Action</td>
<td>Key Combination</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Paste special</td>
<td>Option-Command-V</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Command-D</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Perform a ripple delete</td>
<td>Shift-Delete</td>
</tr>
<tr>
<td>Transform control points</td>
<td>Shift-Command-T</td>
</tr>
<tr>
<td>Select all items</td>
<td>Command-A</td>
</tr>
<tr>
<td>Deselect all items</td>
<td>Shift-Command-A</td>
</tr>
<tr>
<td>Open the project’s Properties Inspector</td>
<td>Command-J</td>
</tr>
<tr>
<td>Find and replace</td>
<td>Command-F</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Open the Special Characters window</td>
<td>Option-Command-T</td>
</tr>
<tr>
<td>Mark menu</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>Mark In point</td>
<td>I</td>
</tr>
<tr>
<td>Mark Out point</td>
<td>O</td>
</tr>
<tr>
<td>Move the selected object’s In point to the location of the playhead</td>
<td>Shift–Left Brace ({})</td>
</tr>
<tr>
<td>Move the selected object’s Out point to the location of the playhead</td>
<td>Shift–Right Brace (}')</td>
</tr>
<tr>
<td>Add a project marker at the current frame</td>
<td>M</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Add a project marker at the current frame</td>
<td>Grave Accent (')</td>
</tr>
<tr>
<td>Open the Edit Marker dialog</td>
<td>Option-Command-M</td>
</tr>
<tr>
<td>Mark In point of play range</td>
<td>Option-Command-I</td>
</tr>
<tr>
<td>Mark Out point of play range</td>
<td>Option-Command-O</td>
</tr>
<tr>
<td>Reset play range</td>
<td>Option-X</td>
</tr>
<tr>
<td>Turn on Loop Playback</td>
<td>Shift-L</td>
</tr>
<tr>
<td>Turn animation recording on and off</td>
<td>A</td>
</tr>
<tr>
<td>Open the Recording Options window</td>
<td>Option-A</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Go to the start of a project</td>
<td>Home</td>
</tr>
<tr>
<td>Go to the end of a project</td>
<td>End</td>
</tr>
<tr>
<td>Go to the start of the play range</td>
<td>Shift-Home</td>
</tr>
<tr>
<td>Go to the end of the play range</td>
<td>Shift-End</td>
</tr>
<tr>
<td>Go to the previous frame</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Go to the next frame</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Go backward ten frames</td>
<td>Shift–Left Arrow</td>
</tr>
<tr>
<td>Go forward ten frames</td>
<td>Shift–Right Arrow</td>
</tr>
<tr>
<td>Go to the previous keyframe</td>
<td>Option-K</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcuts</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Go to the next keyframe</td>
<td>Shift-K</td>
</tr>
<tr>
<td>Go to the previous marker</td>
<td>Option–Command–Left Arrow</td>
</tr>
<tr>
<td>Go to the next marker</td>
<td>Option–Command–Right Arrow</td>
</tr>
<tr>
<td>Go to the selection In point</td>
<td>Shift-I</td>
</tr>
<tr>
<td>Go to the selection Out point</td>
<td>Shift-O</td>
</tr>
<tr>
<td>Perform a RAM preview of the play range area</td>
<td>Command-R</td>
</tr>
<tr>
<td>Perform a RAM preview of the current selection</td>
<td>Option-Command-R</td>
</tr>
<tr>
<td>Perform a RAM preview for the whole project</td>
<td>Option-Shift-Command-R</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Add an empty group to the project</td>
<td>Shift-Command-N</td>
</tr>
<tr>
<td>Add a camera to the project</td>
<td>Option-Command-C</td>
</tr>
<tr>
<td>Add a light to the project</td>
<td>Shift-Command-L</td>
</tr>
<tr>
<td>Add a drop zone to the project</td>
<td>Shift-Command-D</td>
</tr>
<tr>
<td>Add a rig to the project</td>
<td>Control-Command-R</td>
</tr>
<tr>
<td>Move the selected object to the top of the Layers list</td>
<td>Shift–Command–Right Bracket (])</td>
</tr>
<tr>
<td>Move the selected object</td>
<td>Shift–Command–Left</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Move the selected object to the bottom of the Layers list</td>
<td>Bracket (])</td>
</tr>
<tr>
<td>Move the selected object up the Layers list by one level</td>
<td>Command–Right Bracket (])</td>
</tr>
<tr>
<td>Move the selected object down the Layers list by one level</td>
<td>Command–Left Bracket (]</td>
</tr>
<tr>
<td>Group the selected objects into a new layer</td>
<td>Shift-Command-G</td>
</tr>
<tr>
<td>Ungroup a group of objects so you can manipulate the objects individually</td>
<td>Option-Command-G</td>
</tr>
<tr>
<td>Make an object active or deactivate an object</td>
<td>Control-T</td>
</tr>
<tr>
<td>For an audio track,</td>
<td>Control-S</td>
</tr>
<tr>
<td>Function</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Enable/disable the Solo button of the selected track; for an object, solo the object</td>
<td></td>
</tr>
<tr>
<td>Isolate the selected group or layer</td>
<td>Control-I</td>
</tr>
<tr>
<td>Lock/unlock an object</td>
<td>Control-L</td>
</tr>
<tr>
<td>Unsolo only the video portion of a file that contains video</td>
<td>Control-Shift-S</td>
</tr>
<tr>
<td>Convert a 2D group to 3D, or convert a 3D group to 2D</td>
<td>Control-D</td>
</tr>
<tr>
<td>Add an image mask to the selected object</td>
<td>Shift-Command-M</td>
</tr>
<tr>
<td>Add a keyframe (to the last modified parameter for the selected object)</td>
<td>Control-K</td>
</tr>
<tr>
<td>Task</td>
<td>Shortcut</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Convert the applied behaviors to keyframes</td>
<td>Command-K</td>
</tr>
<tr>
<td>Convert a simple shape to a complex shape (with editable control points)</td>
<td>Option-Command-B</td>
</tr>
<tr>
<td>Make the selected object the cell source for a particle emitter</td>
<td>E</td>
</tr>
<tr>
<td>Replicate the selected object</td>
<td>L</td>
</tr>
<tr>
<td>Clone the selected layer</td>
<td>K</td>
</tr>
<tr>
<td>Open the Media list and Inspector to display the source and properties of media objects</td>
<td>Shift-F</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Command–Equal Sign (=)</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Command–Minus Sign (‒)</td>
</tr>
<tr>
<td>Zoom to 100 percent</td>
<td>Option-Z</td>
</tr>
<tr>
<td>Zoom to fit in window</td>
<td>Shift-Z</td>
</tr>
<tr>
<td>Show Full View Area</td>
<td>Shift-V</td>
</tr>
<tr>
<td>Zoom Timeline in</td>
<td>Option–Command–Equal Sign (=)</td>
</tr>
<tr>
<td>Zoom Timeline out</td>
<td>Option–Command–Minus Sign (‒)</td>
</tr>
<tr>
<td>Zoom Timeline to project duration</td>
<td>Option-Command-0</td>
</tr>
<tr>
<td>Action Description</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Set 3D view to active camera</td>
<td>Control-A</td>
</tr>
<tr>
<td>Set 3D view to perspective camera</td>
<td>Control-P</td>
</tr>
<tr>
<td>Set 3D view to next camera</td>
<td>Control-C</td>
</tr>
<tr>
<td>Select the current active camera</td>
<td>Control-Option-C</td>
</tr>
<tr>
<td>Reset 3D camera view</td>
<td>Control-R</td>
</tr>
<tr>
<td>Fit the selected objects into view</td>
<td>F</td>
</tr>
<tr>
<td>Frame the selected object</td>
<td>Shift-Command-F</td>
</tr>
<tr>
<td>Focus on the selected object</td>
<td>Control-F</td>
</tr>
<tr>
<td>Function</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Show all color channels</td>
<td>Shift-C</td>
</tr>
<tr>
<td>Show the transparent channel</td>
<td>Shift-T</td>
</tr>
<tr>
<td>Show the alpha channel overlay</td>
<td>Option-Shift-T</td>
</tr>
<tr>
<td>Show the RGB channels only</td>
<td>Option-Shift-C</td>
</tr>
<tr>
<td>Show the red channel</td>
<td>Shift-R</td>
</tr>
<tr>
<td>Show the green channel</td>
<td>Shift-G</td>
</tr>
<tr>
<td>Show the blue channel</td>
<td>Shift-B</td>
</tr>
<tr>
<td>Show the alpha channel</td>
<td>Shift-A</td>
</tr>
<tr>
<td>Show the inverted alpha channel</td>
<td>Option-Shift-A</td>
</tr>
<tr>
<td>Feature</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Switch between the current channel and alpha channels</td>
<td>V</td>
</tr>
<tr>
<td>Show the Canvas at full resolution</td>
<td>Shift-Q</td>
</tr>
<tr>
<td>Enable/disable lighting in the Canvas</td>
<td>Option-L</td>
</tr>
<tr>
<td>Enable/disable shadows in the Canvas</td>
<td>Control-Option-S</td>
</tr>
<tr>
<td>Enable/disable reflections in the Canvas</td>
<td>Control-Option-R</td>
</tr>
<tr>
<td>Enable/disable depth of field in the Canvas</td>
<td>Control-Option-D</td>
</tr>
<tr>
<td>Enable/disable motion blur in the Canvas</td>
<td>Option-M</td>
</tr>
<tr>
<td>Feature</td>
<td>Hotkey</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Enable/disable field rendering in the Canvas</td>
<td>Option-F</td>
</tr>
<tr>
<td>Enable/disable frame blending in the Canvas</td>
<td>Control-Option-B</td>
</tr>
<tr>
<td>Show Overlays</td>
<td>Command-Slash (/)</td>
</tr>
<tr>
<td>Show the rulers</td>
<td>Shift-Command-R</td>
</tr>
<tr>
<td>Show/hide the grid</td>
<td>Command-Apostrophe (’)</td>
</tr>
<tr>
<td>Show/hide the guides</td>
<td>Command-Semicolon (;)</td>
</tr>
<tr>
<td>Show/hide the Dynamic Guides</td>
<td>Shift-Command-Semicolon (;)</td>
</tr>
<tr>
<td>Show/hide the Safe Zones</td>
<td>Apostrophe (’)</td>
</tr>
<tr>
<td>Show/hide the Film Zones</td>
<td>Shift-Quotation Mark (”’)</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Export movie</td>
<td>Command-E</td>
</tr>
</tbody>
</table>

**Share menu**
Export selection to movie | Option-Command-E

**Window menu**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize the active window</td>
<td>Command-M</td>
</tr>
<tr>
<td>Show the Properties Inspector</td>
<td>F1</td>
</tr>
<tr>
<td>Show the Behaviors Inspector</td>
<td>F2</td>
</tr>
<tr>
<td>Show the Filters Inspector</td>
<td>F3</td>
</tr>
<tr>
<td>Show the Object Inspector</td>
<td>F4</td>
</tr>
<tr>
<td>Show/hide the Project pane</td>
<td>F5</td>
</tr>
<tr>
<td>Feature</td>
<td>Hotkey</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Show/hide the Timing pane</td>
<td>F6</td>
</tr>
<tr>
<td>Show/hide the HUD</td>
<td>F7</td>
</tr>
<tr>
<td>Show/hide the Background Task list</td>
<td>F9</td>
</tr>
<tr>
<td>Enter/exit Player mode</td>
<td>F8</td>
</tr>
<tr>
<td>Show/hide the File Browser</td>
<td>Command-1</td>
</tr>
<tr>
<td>Show/hide the Library</td>
<td>Command-2</td>
</tr>
<tr>
<td>Show/hide the Inspector</td>
<td>Command-3</td>
</tr>
<tr>
<td>Show/hide the Layers list</td>
<td>Command-4</td>
</tr>
<tr>
<td>Show/hide the Media list</td>
<td>Command-5</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Show/hide the Audio list</td>
<td>Command-6</td>
</tr>
<tr>
<td>Show/hide the Video Timeline</td>
<td>Command-7</td>
</tr>
<tr>
<td>Show/hide the Keyframe Editor</td>
<td>Command-8</td>
</tr>
<tr>
<td>Show/hide the Audio Timeline</td>
<td>Command-9</td>
</tr>
<tr>
<td>Help menu</td>
<td></td>
</tr>
<tr>
<td>Open Motion Help</td>
<td>Shift–Command–Question Mark (?)</td>
</tr>
<tr>
<td>Audio list</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Show/hide the Audio list</td>
<td>Command-6</td>
</tr>
<tr>
<td>Make object active or inactive</td>
<td>Control-T</td>
</tr>
<tr>
<td>Lock/unlock an audio file</td>
<td>Control-L</td>
</tr>
<tr>
<td>Enable/disable the Solo button of a selected track</td>
<td>Control-S</td>
</tr>
<tr>
<td>Move up one level in the Audio list</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Move down one level in the Audio list</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Import</td>
<td>Command-I</td>
</tr>
</tbody>
</table>
Tools overview

This section lists all the keyboard shortcuts for tools in the Motion toolbar, organized into the following categories:

- Global transform commands
- Select/Transform tool
- Crop tool
- Edit Points tool
- Edit Ellipse and Edit Rectangle tools
- Pan and Zoom tools
- Rectangle and Circle tools
- Bezier Mask tool
- B-Spline Mask tool

Global transform commands

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate the current transform mode</td>
<td>S</td>
</tr>
<tr>
<td>Choose the Select/Transform tool</td>
<td>Shift-S</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Cycle through the transform modes (press repeatedly until the</td>
<td>Tab</td>
</tr>
<tr>
<td>transform mode you want is selected)</td>
<td></td>
</tr>
<tr>
<td>Constrain the movement of an object to the guidelines</td>
<td>Shift-drag the pointer</td>
</tr>
<tr>
<td>Override snapping while moving an object</td>
<td>Command-drag the object</td>
</tr>
<tr>
<td>Duplicate a selected object</td>
<td>Option-drag the object</td>
</tr>
</tbody>
</table>

**Select/Transform tool**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale an object proportionally</td>
<td>Shift-drag the object handle</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Scale an object from its center</td>
<td>Option-drag the object handle</td>
</tr>
<tr>
<td>Scale an object proportionally from its center</td>
<td>Option-Shift-drag the object handle</td>
</tr>
<tr>
<td>Snap the rotation of an object to 45-degree increments</td>
<td>Shift-drag the object rotation handle</td>
</tr>
<tr>
<td>Activate 3D transform tool</td>
<td>Q</td>
</tr>
</tbody>
</table>

**Crop tool**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crop an object proportionally</td>
<td>Shift-drag the object handle</td>
</tr>
<tr>
<td>Crop an object from its center</td>
<td>Option-drag the object handle</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Crop an object proportionally from its center</td>
<td>Option-Shift-drag the object handle</td>
</tr>
<tr>
<td>Pan a cropped object within the bounding box</td>
<td>Command-drag over the object</td>
</tr>
<tr>
<td>Move the bounding box around a cropped object</td>
<td>Option-Command-drag over the object</td>
</tr>
<tr>
<td><strong>Edit Points tool</strong></td>
<td></td>
</tr>
<tr>
<td>Add a point to a path</td>
<td>Double-click the path</td>
</tr>
<tr>
<td>Add a point to a path</td>
<td>Option-click the path</td>
</tr>
<tr>
<td>Convert a point to linear</td>
<td>Command-click the point</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Create a tangent on a control point</td>
<td>Command-drag the point</td>
</tr>
<tr>
<td>Scale a tangent proportionally</td>
<td>Command-drag the tangent handle</td>
</tr>
<tr>
<td>Adjust a B-Spline point bias</td>
<td>Command-drag a B-Spline point</td>
</tr>
<tr>
<td>Switch a B-Spline point bias</td>
<td>Command-click a B-Spline point</td>
</tr>
<tr>
<td>Break or relink a tangent handle</td>
<td>Option-drag a tangent handle</td>
</tr>
<tr>
<td>Constrain a tangent to 45 degrees and original value</td>
<td>Shift-drag a tangent handle</td>
</tr>
</tbody>
</table>

**Edit Ellipse and Edit Rectangle tools**
Convert a simple ellipse or rectangle shape to a complex shape (with editable control points)  
Option-Command-B

Convert a simple ellipse or rectangle mask to a complex mask (with editable control points)  
Option-Command-B

Pan and Zoom tools

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Pan tool</td>
<td>H</td>
</tr>
<tr>
<td>Select the Zoom tool</td>
<td>Z</td>
</tr>
<tr>
<td>Zoom out with the Zoom tool selected</td>
<td>Option-click in the Canvas</td>
</tr>
</tbody>
</table>

Rectangle and Circle tools
<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Rectangle Shape tool</td>
<td>R</td>
</tr>
<tr>
<td>Select the Circle Shape tool</td>
<td>C</td>
</tr>
<tr>
<td>Draw a shape proportionally</td>
<td>Shift-drag in the Canvas</td>
</tr>
<tr>
<td>Draw a shape from its center</td>
<td>Option-drag in the Canvas</td>
</tr>
<tr>
<td>Draw a shape proportionally from its center</td>
<td>Option-Shift-drag in the Canvas</td>
</tr>
<tr>
<td>Snap the rotation of an object to 45-degree increments</td>
<td>Shift-drag a rotation handle</td>
</tr>
</tbody>
</table>
# Bezier tool

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Bezier tool</td>
<td>B</td>
</tr>
<tr>
<td>Switch between the Bezier and B-spline tools</td>
<td>B</td>
</tr>
<tr>
<td>Close shape</td>
<td>C</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Command-click a path</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Double-click a path</td>
</tr>
<tr>
<td>Convert a point to linear</td>
<td>Command-click a point</td>
</tr>
<tr>
<td>Create tangents on a point</td>
<td>Command-drag a point</td>
</tr>
<tr>
<td>Scale a tangent handle proportionally</td>
<td>Command-drag a tangent handle</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Break or relink a tangent handle</td>
<td>Option-drag a tangent handle</td>
</tr>
<tr>
<td>Constrain a tangent to 45-degree increments and original value</td>
<td>Shift-drag a tangent handle</td>
</tr>
<tr>
<td>Cancel shape drawing and delete the open shape</td>
<td>Escape</td>
</tr>
<tr>
<td>Exit shape-drawing mode</td>
<td>Return</td>
</tr>
</tbody>
</table>

### B-Spline tool

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the B-Spline tool</td>
<td>B</td>
</tr>
<tr>
<td>Switch between the Bezier and B-Spline tools</td>
<td>B</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Close the shape</td>
<td>C</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Double-click a path</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Command-click a path</td>
</tr>
<tr>
<td>Adjust a B-Spline point bias</td>
<td>Command-drag a B-Spline point</td>
</tr>
<tr>
<td>Switch a B-Spline point bias</td>
<td>Command-click a B-Spline point</td>
</tr>
<tr>
<td>Cancel shape drawing and delete the open shape</td>
<td>Escape</td>
</tr>
<tr>
<td>Exit shape drawing mode</td>
<td>Return</td>
</tr>
</tbody>
</table>

**Paint Stroke tool**
Activate Paint Stroke tool | P
---|---
Adjust stroke width | Command-drag in the Canvas

## Text tool

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Text tool</td>
<td>T</td>
</tr>
<tr>
<td>Move the insertion point to the next character</td>
<td>Up Arrow, Down Arrow, Left Arrow, or Right Arrow</td>
</tr>
<tr>
<td>Move the insertion point to the next word</td>
<td>Option–Up Arrow, Down Arrow, Left Arrow, or Right Arrow</td>
</tr>
<tr>
<td>Move to the beginning of a line of text</td>
<td>Command–Left Arrow</td>
</tr>
<tr>
<td>Move to the end of a line</td>
<td>Command–Right Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Select characters from the insertion point</td>
<td>Shift–Up Arrow, Down Arrow, Left Arrow, or Right Arrow</td>
</tr>
<tr>
<td>Select words from the insertion point</td>
<td>Option–Shift–Up Arrow, Down Arrow, Left Arrow, or Right Arrow</td>
</tr>
<tr>
<td>Select a line of text from the insertion point</td>
<td>Shift–Command–Up Arrow, Down Arrow, Left Arrow, or Right Arrow</td>
</tr>
<tr>
<td>Increase kerning from the insertion point</td>
<td>Option–Command–Right Bracket (])</td>
</tr>
<tr>
<td>Decrease kerning from the insertion point</td>
<td>Option–Command–Left Bracket ([)</td>
</tr>
<tr>
<td>Select All</td>
<td>Command-A</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Select the Rectangle Mask tool</td>
<td>Option-R</td>
</tr>
<tr>
<td>Select the Circle Mask tool</td>
<td>Option-C</td>
</tr>
<tr>
<td>Select the Freehand Mask tool</td>
<td>Option-P</td>
</tr>
<tr>
<td>Draw a mask proportionally</td>
<td>Shift-drag in the Canvas</td>
</tr>
<tr>
<td>Draw a mask from its center</td>
<td>Option-drag in the Canvas</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Draw a mask proportionally from its center</td>
<td>Option-Shift-drag in the Canvas</td>
</tr>
<tr>
<td>Snap the rotation of a mask to 45-degree increments</td>
<td>Shift-drag a rotation handle</td>
</tr>
</tbody>
</table>

**Bezier Mask tool**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Bezier Mask tool</td>
<td>Option-B</td>
</tr>
<tr>
<td>Switch between the Bezier Mask and B-Spline Mask tools</td>
<td>Option-B</td>
</tr>
<tr>
<td>Close mask</td>
<td>C</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Double-click a path</td>
</tr>
<tr>
<td>Action</td>
<td>Command/Action</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Command-click a path</td>
</tr>
<tr>
<td>Convert a point to linear</td>
<td>Command-click a point</td>
</tr>
<tr>
<td>Create tangents on a point</td>
<td>Command-drag a point</td>
</tr>
<tr>
<td>Scale tangents proportionally</td>
<td>Command-drag a tangent handle</td>
</tr>
<tr>
<td>Break or relink a tangent handle</td>
<td>Option-drag a tangent handle</td>
</tr>
<tr>
<td>Constrain a tangent to 45 degrees and original value</td>
<td>Option-Shift-drag a tangent handle</td>
</tr>
<tr>
<td>Cancel shape drawing and delete the open shape</td>
<td>Escape</td>
</tr>
<tr>
<td>Exit shape-drawing mode</td>
<td>Return</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Select the B-Spline Mask tool</td>
<td>Option-B</td>
</tr>
<tr>
<td>Switch between the Bezier Mask and B-Spline Mask tools</td>
<td>Option-B</td>
</tr>
<tr>
<td>Close the mask</td>
<td>C</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Double-click a path</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Command-click a path</td>
</tr>
<tr>
<td>Adjust a B-Spline point bias</td>
<td>Command-drag a B-Spline point</td>
</tr>
<tr>
<td>Switch a B-Spline point bias</td>
<td>Command-click a B-Spline point</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Cancel shape drawing and delete the open shape</td>
<td>Escape</td>
</tr>
<tr>
<td>Exit shape-drawing mode</td>
<td>Return</td>
</tr>
<tr>
<td>Select the Bezier Mask tool</td>
<td>Option-B</td>
</tr>
<tr>
<td>Show/hide mask control points</td>
<td>Apostrophe ('')</td>
</tr>
</tbody>
</table>

### Transport controls

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play/pause a project</td>
<td>Space bar</td>
</tr>
<tr>
<td>Turn animation recording on or off</td>
<td>A</td>
</tr>
<tr>
<td>Enable/disable loop playback</td>
<td>Shift-L</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Go to the start of a project</td>
<td>Home</td>
</tr>
<tr>
<td>Go to the end of a project</td>
<td>End</td>
</tr>
<tr>
<td>Go to the start of the play range</td>
<td>Shift-Home</td>
</tr>
<tr>
<td>Go to the end of the play range</td>
<td>Shift-End</td>
</tr>
<tr>
<td>Go to the previous frame</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Go to the next frame</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Go backward ten frames</td>
<td>Shift-Left Arrow</td>
</tr>
<tr>
<td>Go forward ten frames</td>
<td>Shift-Right Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Command–Equal Sign (=)</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Command-Minus Sign (–)</td>
</tr>
<tr>
<td>Zoom out with the Zoom tool selected</td>
<td>Option-click the Canvas</td>
</tr>
<tr>
<td>Zoom to region</td>
<td>Command-drag in the Canvas</td>
</tr>
<tr>
<td>Zoom to 100 percent</td>
<td>Option-Z</td>
</tr>
<tr>
<td>Zoom to fit in the Canvas</td>
<td>Shift-Z</td>
</tr>
<tr>
<td>Show all color channels</td>
<td>Shift-C</td>
</tr>
<tr>
<td>Show the transparent channel</td>
<td>Shift-T</td>
</tr>
<tr>
<td>Feature</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Show the alpha channel overlay</td>
<td>Option-Shift-T</td>
</tr>
<tr>
<td>Show the RGB channels only</td>
<td>Option-Shift-C</td>
</tr>
<tr>
<td>Show the red channel</td>
<td>Shift-R</td>
</tr>
<tr>
<td>Show the green channel</td>
<td>Shift-G</td>
</tr>
<tr>
<td>Show the blue channel</td>
<td>Shift-B</td>
</tr>
<tr>
<td>Show the alpha channel</td>
<td>Shift-A</td>
</tr>
<tr>
<td>Show the inverted alpha channel</td>
<td>Option-Shift-A</td>
</tr>
<tr>
<td>Show the Canvas at full resolution</td>
<td>Shift-Q</td>
</tr>
<tr>
<td>Enable/disable field rendering in the Canvas</td>
<td>Option-F</td>
</tr>
<tr>
<td>Feature</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Enable/disable motion blur in the Canvas</td>
<td>Option-M</td>
</tr>
<tr>
<td>Show the rulers</td>
<td>Shift-Command-R</td>
</tr>
<tr>
<td>Lock the guides</td>
<td>Option-Command-Semicolon (;)</td>
</tr>
<tr>
<td>Show/hide the grid</td>
<td>Command-Apostrophe (’)</td>
</tr>
<tr>
<td>Show/hide the guides</td>
<td>Command-Semicolon (;)</td>
</tr>
<tr>
<td>Show/hide dynamic guides</td>
<td>Shift-Command-Semicolon (;)</td>
</tr>
<tr>
<td>Show/hide film zones</td>
<td>Shift-Quotation Mark (”’)</td>
</tr>
<tr>
<td>Show overlays</td>
<td>Command-Slash (/)</td>
</tr>
<tr>
<td>Switch between the</td>
<td>V</td>
</tr>
</tbody>
</table>
current channel and alpha channel

Show/hide safe zones

Enable/disable snapping to guides

Expose active layers

Expose all layers

Miscellaneous

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a particle emitter</td>
<td>E</td>
</tr>
<tr>
<td>Import an image mask to the selected object</td>
<td>Shift-Command-M</td>
</tr>
<tr>
<td>In the Keyer filter, reset the</td>
<td>Shift-Z</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Chroma zoom and center (when the pointer is over the Chroma control)</td>
<td></td>
</tr>
<tr>
<td>Select the next object above</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Select the next object below</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Nudge the selected objects one pixel</td>
<td>Command–Up Arrow, Command–Down Arrow, Command–Left Arrow, or Command–Right Arrow</td>
</tr>
<tr>
<td>Nudge the selected objects 10 pixels</td>
<td>Shift–Command–Up Arrow, Shift–Command–Down Arrow, Shift–Command–Left Arrow, or Shift–Command–Right Arrow</td>
</tr>
<tr>
<td>Add/Remove selected objects using the region</td>
<td>Shift-drag in the Canvas</td>
</tr>
</tbody>
</table>
Select multiple objects in a group or layer | Command-click an object or objects

Add to selection | Shift-click an object

---

**HUD**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/hide the HUD</td>
<td>F7</td>
</tr>
<tr>
<td>Cycle through the HUDs from top to bottom (when more than one effect is applied to an object)</td>
<td>D</td>
</tr>
<tr>
<td>Cycle through the HUDs from bottom to top (when more than one effect is applied to an object)</td>
<td>Shift-D</td>
</tr>
<tr>
<td>Function</td>
<td>Shortcut</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Show/hide File Browser</td>
<td>Command-1</td>
</tr>
<tr>
<td>Open project</td>
<td>Command-O</td>
</tr>
<tr>
<td>New project</td>
<td>Command-N</td>
</tr>
<tr>
<td>Show/hide Project pane</td>
<td>F5</td>
</tr>
<tr>
<td>Move up one item in the sidebar or file stack</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Move down one item in the sidebar or file stack</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Move left one item in the file stack</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Move right one item in the file stack</td>
<td>Right Arrow</td>
</tr>
</tbody>
</table>
Select first item in the file stack

Space

Move up one level in the folder hierarchy of the file stack

Command–Up Arrow

Inspector

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/hide the Inspector</td>
<td>Command-3</td>
</tr>
<tr>
<td>Increase a slider value by an increment of one</td>
<td>Up Arrow or Right Arrow</td>
</tr>
<tr>
<td>Decrease a slider value by an increment of one</td>
<td>Down Arrow or Left Arrow</td>
</tr>
<tr>
<td>Increase a slider value by Command–Up Arrow or</td>
<td></td>
</tr>
</tbody>
</table>

### Keyframe Editor

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/hide the Keyframe Editor</td>
<td>Command-8</td>
</tr>
<tr>
<td>Convert the applied behaviors to keyframes</td>
<td>Command-K</td>
</tr>
<tr>
<td>Fit visible curves</td>
<td>F</td>
</tr>
</tbody>
</table>

### Layers

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a group</td>
<td>Shift-Command-Command-N</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Bring the object to the top of the group</td>
<td>Command–Right Bracket (])</td>
</tr>
<tr>
<td>Send the object to the bottom of the group</td>
<td>Command–Left Bracket ([)</td>
</tr>
<tr>
<td>Bring the object up one level in the Layers list</td>
<td>Command–Right Bracket (])</td>
</tr>
<tr>
<td>Send the object down one level in the Layers list</td>
<td>Command–Left Bracket ([)</td>
</tr>
<tr>
<td>Place the selected objects in a new group</td>
<td>Shift-Command-G</td>
</tr>
<tr>
<td>Ungroup a group of objects so you can manipulate each object</td>
<td>Option-Command-G</td>
</tr>
<tr>
<td>Make the object active or deactivate the object</td>
<td>Control-T</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Enable/disable the Solo button of a selected track</td>
<td>Control-S</td>
</tr>
<tr>
<td>Isolate the selected group or layer</td>
<td>Control-I</td>
</tr>
<tr>
<td>Lock/unlock an object</td>
<td>Control-L</td>
</tr>
<tr>
<td>Move up one level in the Layers list</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Move down one level in the Layers list</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Expand a group in the Layers list</td>
<td>Option–Left Arrow</td>
</tr>
<tr>
<td>Collapse a group in the Layers list</td>
<td>Option–Right Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Add an image mask to the selected object</td>
<td>Shift-Command-M</td>
</tr>
<tr>
<td>Convert the applied behaviors to keyframes</td>
<td>Command-K</td>
</tr>
<tr>
<td>Open the Media list and Inspector to reveal the source and properties of media objects</td>
<td>Shift-F</td>
</tr>
<tr>
<td>Clone the selected layer</td>
<td>K</td>
</tr>
</tbody>
</table>

**Library**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/hide the Library</td>
<td>Command-2</td>
</tr>
<tr>
<td>Select the first item in the sidebar or file stack</td>
<td>Space bar</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Move up one item in the sidebar or file stack</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Move down one item in the sidebar or file stack</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Move left one item in the file stack</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Move right one item in the file stack</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Move up one level in the folder hierarchy of the file stack</td>
<td>Up Arrow</td>
</tr>
</tbody>
</table>

**Media list**
<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/hide the Media list</td>
<td>Command-5</td>
</tr>
<tr>
<td>Move up one level in the Media list</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Move down one level in the Media list</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Import</td>
<td>Command-I</td>
</tr>
<tr>
<td><strong>Timeline editing and navigating</strong></td>
<td></td>
</tr>
<tr>
<td>Nudge one frame forward</td>
<td>Command–Right Arrow</td>
</tr>
<tr>
<td>Nudge one frame backward</td>
<td>Command–Left Arrow</td>
</tr>
<tr>
<td>Nudge ten frames forward</td>
<td>Shift–Command–Right Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Nudge ten frames backward</td>
<td>Shift–Command–Left Arrow</td>
</tr>
<tr>
<td>Move the selected object to the In point</td>
<td>Shift–Left Brace ({)</td>
</tr>
<tr>
<td>Move the selected object to the Out point</td>
<td>Shift–Right Brace (})</td>
</tr>
<tr>
<td>Mark the In point of the play range</td>
<td>I</td>
</tr>
<tr>
<td>Mark the Out point of the play range</td>
<td>O</td>
</tr>
<tr>
<td>Reset the play range by moving the In and Out points to the first and last frames of the project</td>
<td>Option-X</td>
</tr>
<tr>
<td>Enable/disable loop playback</td>
<td>Shift-L</td>
</tr>
<tr>
<td>Action</td>
<td>Key Combination</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Open the Recording Options dialog</td>
<td>Option-A</td>
</tr>
<tr>
<td>Go to the start of play range</td>
<td>Shift-Home</td>
</tr>
<tr>
<td>Go to the end of play range</td>
<td>Shift-End</td>
</tr>
<tr>
<td>Go to the In point of the selected object</td>
<td>Shift-I</td>
</tr>
<tr>
<td>Go to the Out point of the selected object</td>
<td>Shift-O</td>
</tr>
<tr>
<td>Go to the previous frame</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Go to the next frame</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Go backward ten frames</td>
<td>Shift–Left Arrow</td>
</tr>
<tr>
<td>Go forward ten frames</td>
<td>Shift–Right Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Key Combination</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Go to the next marker</td>
<td>Option–Command–Left Arrow</td>
</tr>
<tr>
<td>Go to the previous marker</td>
<td>Option–Command–Right Arrow</td>
</tr>
<tr>
<td>Render a RAM Preview for the play range</td>
<td>Command-R</td>
</tr>
<tr>
<td>Render a RAM Preview for the selected object</td>
<td>Option-Command-R</td>
</tr>
<tr>
<td>Render a RAM Preview for the project</td>
<td>Option-Shift-Command-R</td>
</tr>
<tr>
<td>Mark an In point</td>
<td>I</td>
</tr>
<tr>
<td>Mark an Out point</td>
<td>O</td>
</tr>
<tr>
<td>Add a marker at the</td>
<td>M</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Add a marker at the current frame</td>
<td>Apostrophe (')</td>
</tr>
<tr>
<td>Open the Edit Marker dialog</td>
<td>Option-Command-M</td>
</tr>
<tr>
<td>Play/pause the project</td>
<td>Space bar</td>
</tr>
<tr>
<td>Turn on/off animation recording</td>
<td>A</td>
</tr>
<tr>
<td>Go to the start of project</td>
<td>Home</td>
</tr>
<tr>
<td>Go to the end of project</td>
<td>End</td>
</tr>
<tr>
<td>Convert the applied behaviors to keyframes</td>
<td>Command-K</td>
</tr>
<tr>
<td>Perform a ripple delete</td>
<td>Shift-Delete</td>
</tr>
</tbody>
</table>
### Keyframing commands

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a point to the path</td>
<td>Double-click a path</td>
</tr>
<tr>
<td>Add a point to the path</td>
<td>Option-click a path</td>
</tr>
<tr>
<td><strong>Create tangents on a point</strong></td>
<td>Command-drag a Bezier point</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td><strong>Convert a point to linear</strong></td>
<td>Command-click a Bezier point</td>
</tr>
<tr>
<td><strong>Adjust a B-Spline point bias</strong></td>
<td>Command-drag a B-Spline point</td>
</tr>
<tr>
<td><strong>Switch a B-Spline point bias</strong></td>
<td>Command-click a B-Spline point</td>
</tr>
<tr>
<td><strong>Scale tangents proportionally</strong></td>
<td>Command-drag a tangent handle</td>
</tr>
<tr>
<td><strong>Break or relink a tangent handle</strong></td>
<td>Option-drag a tangent handle</td>
</tr>
<tr>
<td><strong>Constrain a tangent to 45 degrees and original value</strong></td>
<td>Shift-drag a tangent handle</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Draw a shape proportionally with the Rectangle, Circle Shape, and Mask tools</td>
<td>Shift-drag in the Canvas</td>
</tr>
<tr>
<td>Draw a shape from its center with the Rectangle, Circle Shape, and Mask tools</td>
<td>Option-drag in the Canvas</td>
</tr>
<tr>
<td>Draw a shape proportionally from its center with the Rectangle, Circle Shape, and Mask tools</td>
<td>Option-Shift-drag in the Canvas</td>
</tr>
<tr>
<td>Cancel spline drawing and delete the open spline</td>
<td>Escape</td>
</tr>
<tr>
<td>Exit spline drawing mode and complete the existing</td>
<td>Return</td>
</tr>
<tr>
<td>spline drawing</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Add a point to the path</strong></td>
<td><strong>Double-click a path</strong></td>
</tr>
<tr>
<td><strong>Add a point to the path</strong></td>
<td><strong>Option-click a path</strong></td>
</tr>
<tr>
<td><strong>Convert a point to linear</strong></td>
<td><strong>Command-click a Bezier point</strong></td>
</tr>
<tr>
<td><strong>Create tangents on a point</strong></td>
<td><strong>Command-drag a Bezier point</strong></td>
</tr>
<tr>
<td><strong>Scale tangents proportionally</strong></td>
<td><strong>Command-drag a tangent handle</strong></td>
</tr>
<tr>
<td><strong>Adjust a B-Spline point bias</strong></td>
<td><strong>Command-drag a B-Spline point</strong></td>
</tr>
<tr>
<td><strong>Switch a B-Spline point bias</strong></td>
<td><strong>Command-click a B-Spline point</strong></td>
</tr>
<tr>
<td><strong>Break or relink a tangent</strong></td>
<td><strong>Option-drag a tangent</strong></td>
</tr>
</tbody>
</table>
Constrain a tangent to 45 degrees and original value
Shift-drag a tangent handle

Convert a simple shape to a complex shape (with editable control points)
Option-Command-B

3D commands

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the 3D transform tool</td>
<td>Q</td>
</tr>
<tr>
<td>Switch the 3D transform tool between position-only and universal</td>
<td>Comma (,)</td>
</tr>
<tr>
<td>Switch the 3D transform tool between rotate-only and universal</td>
<td>Period (.)</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Switch the 3D transform tool between scale-only and universal</td>
<td>Slash (/)</td>
</tr>
<tr>
<td>Set 3D View to Active Camera</td>
<td>Control-A</td>
</tr>
<tr>
<td>Set 3D View to Perspective</td>
<td>Control-P</td>
</tr>
<tr>
<td>Set 3D View to next camera</td>
<td>Control-C</td>
</tr>
<tr>
<td>Reset the 3D camera view</td>
<td>Control-R</td>
</tr>
<tr>
<td>Create a 3D Group of the selected objects</td>
<td>Control-D</td>
</tr>
<tr>
<td>Switch the 3D grid on and off</td>
<td>Shift-Command-Apostrophe (')</td>
</tr>
</tbody>
</table>
Search and customize keyboard shortcuts

Search and customize keyboard shortcuts overview

The Command Editor shows a visual representation of your keyboard, allowing you to:

- **Search for keyboard shortcuts and commands**
- **Customize keyboard shortcuts** to streamline the way you work
- **Import or export keyboard shortcuts** to use a command set from another application or to share a custom command set with other users

If you’re more familiar with keyboard commands from other applications, you can use the Command Editor to substitute those commands for Motion’s default set.

Display the Command Editor in Motion

- Choose Motion > Commands > Customize.

The Command Editor appears.
For description of the Command Editor controls and options, see Command Editor interface.

Command Editor interface

The upper half of the Command Editor displays a virtual keyboard. The lower half contains a Command List that sorts menu commands by group and offers a brief description of each command, along with its associated key combination, if any.

The virtual keyboard is color-coded to help you identify the type of command each key performs. For example, transport commands, such as Play (press the Space bar) and Record (press A), are light blue, while alignment commands are pink. The Command Groups
window on the left side of the Command List contains a clickable color key for reference.

Keys assigned to shortcuts are marked with a white dot, while unassigned keys have no additional markings. Several keys are shaded with a hatch pattern, indicating that they’re reserved for the OS X Finder.

The Command List displays several groupings of commands, organized by Motion menus as well as types of commands (Alignment, Tools, Transport, Go To, View, and Mark). Click a group to filter the Command list and display only the commands and keyboard shortcuts in that group.

The window to the right of the Command List shows additional
information about a selected key in the virtual keyboard (or a selected command in the Command List). When you select a key in the virtual keyboard, this window displays a list of all keyboard shortcuts associated with that key.

When you select a command in the Command List, this window displays a brief description of the command.

SEE ALSO
Identify a specific shortcut
Create your own keyboard shortcuts
Import and export command sets

Identify a specific shortcut
Although the Command Editor primarily used for creating new shortcuts (as described in Create your own keyboard shortcuts), the it can also be used to identify existing shortcuts.

---

**Choose a key command set**

By default, Motion uses the Standard Set of commands, with the language choice that you specified when you set up your computer.

Do one of the following:

- Choose Motion > Commands, then choose a set from the submenu.
- If the Command Editor is open, click the pop-up menu in the upper-left corner, then choose a command set.

After you choose the command set you want, the keyboard shortcuts in the set become active in Motion.

---

**Search for a keyboard shortcut**

Use the Search field in the upper-right corner of the Command Editor to locate a command or keyboard shortcut. You can search by command name, description, or keyboard shortcut.

- In the Command Editor, click in the Search field and enter a word that describes the keyboard shortcut you need.
The Command List immediately displays the search results, listing all commands and keyboard shortcuts related to the search term. You can narrow your search by choosing a category from the Search field pop-up menu. The menu items include All, Command, Description, and Key Equivalent.

**Note:** Do not use the Shift key to capitalize letters when typing in the Search field. The Search field recognizes the Shift key as a modifier key in a keyboard shortcut.

---

**Search for and highlight a shortcut on the virtual keyboard**

You can use the Search field with the virtual keyboard to highlight keyboard shortcuts.

1. Click the Keyboard Highlight button to the left of the Search field.

   The keyboard dims.

2. Click in the Search field and begin typing.

   Motion filters the Command List as you type and highlights the keys related to your search term.

   For example, in the image below, the search term “mark” returns keyboard shortcuts marker commands, and the command keys are highlighted in the virtual keyboard.

   **Note:** When you enable the Keyboard Highlight button, only command keys are highlighted. Modifier keys that may be part of
the keyboard shortcut (Command, Shift, Option, and Control) are not highlighted.

Filter by modifier keys

You can use the Modifier buttons (Command, Shift, Option, and Control) at the top of the Command Editor to see which keys work with the modifier keys.

1. Click one of the four modifier buttons at the top of the Command Editor (or click a modifier key on the virtual keyboard).
   Keys assigned to work with the selected modifier key appear marked with a dark gray dot.

2. If necessary, click another modifier button (or modifier key in the virtual keyboard) to create a combination.
   The virtual keyboard updates to show which keys are assigned to shortcuts that use those combined modifier keys.
Create your own keyboard shortcuts

Customizing shortcuts in the Command Editor is easy. Because the default Standard Set includes commands for which no shortcut is defined, you may want to apply a new shortcut to them. Because you cannot modify the Standard Set, you must duplicate that set and then customize the new duplicate set.

Duplicate the active command set

1. Choose Duplicate from the pop-up menu at the top of the Command Editor.

A dialog appears and prompts you to name the new set.

2. Enter a name in the dialog, then click OK.

The new duplicate set is saved and appears as an item at the bottom of the pop-up menu and the top-level Motion > Commands menu.

Add or modify a keyboard shortcut

Now that you have a duplicate set of assigned keyboard shortcuts, you can modify the key settings to create new or modified shortcuts.

1. Using the Search field of the Command Editor, find and select
the command you want to assign a keyboard shortcut to.

Alternatively, you can find the command by browsing through the Command List.

2. Using your physical keyboard, press the combination of keys you want to use for the command (for example, Option-Shift-T).

If the key combination is not assigned to a command, the virtual keyboard updates to show the new key assignment. A gray dot appears on a newly assigned key (or keys), and a color is applied if the command belongs to a color-coded command group.

If the key combination is already assigned to a command, Motion displays the current setting, and prompts you to confirm the change.

---

**Save a command set**

After you make changes to the command set, you can use the following method to save the changes.

- Click the Save button in the lower-right corner of the Command Editor.

If you close the Command Editor with unsaved changes, Motion prompts you to save the set.

---

**Delete a command set**
1. Make sure the set you want to delete is selected as the active set, then choose Delete from the pop-up menu at the top of the Command Editor.

A dialog appears.

2. Click Delete.

The set is removed, and the Standard Set becomes the active set of commands.

---

### Import and export command sets

After you save a command set, you can export it to create a backup or to share the set with another user. Exported sets are saved in a file that can be imported back into Motion later.

### Export a set of keyboard shortcuts

1. If necessary, use the pop-up menu to activate the command set you want to export, then do one of the following:
   - In the Command Editor, choose Export from the pop-up menu.
   - Choose Motion > Commands > Export. A Save As dialog appears.

2. Navigate to the location where you want to save the exported
set, then enter a name in the Save As field.

3. Click OK.

The file is saved in the location you chose, with the “.commandset” filename extension.

Import a set of shortcuts

1. Do one of the following:
   - In the Command Editor, click the pop-up menu in the upper-left corner, then choose Import.
   - Choose Motion > Commands > Import.
   
   An Open dialog appears.

2. Navigate to the location where you stored a command set file, select it, then click Open.

   The new command set is added to the Motion > Commands submenu in the menu bar and in the pop-up menu in the Command Editor. If you use a set with the same name, a dialog appears and asks you to rename the set.

Tablet Gestures

Tablet Gestures overview

If you use a Wacom tablet and pen, you can use gestures to
navigate in Motion and to perform tasks such as editing, copying, pasting, and so on. Gestures are continuous, uninterrupted patterns drawn in the Motion user interface (using your tablet).

The supported tablet for using gestures in Motion is the Wacom tablet family. Swipes, pinches, and other gestures performed on a Multi-Touch device (such as a trackpad or Magic Mouse) are unrelated to the gestures described in this section.

SEE ALSO

Enable gestures
Set Wacom tablet preferences
Use gestures overview

Enable gestures

You can change the default gesture input and trigger methods in Motion Preferences. When gestures are enabled, you can use a modifier key (the Control key) or a button on the pen to trigger gesturing. Before you can use gestures, Handwriting Recognition must be enabled in OS X Ink Preferences. You can open Ink Preferences from the Gestures pane of Motion Preferences.

Important: To use gestures, make sure that your Wacom tablet is connected to your Mac and that its current drivers are correctly installed. For more information, see your tablet’s documentation.

Set up Motion gesture preferences
1. In Motion, choose Motion > Preferences (or press Command-Comma).

2. Click Gestures.

The Gestures pane in Motion Preferences opens.

![Gestures pane in Motion Preferences](image)

**Important:** Gestures in Motion use the Inkwell technology in OS X. To use gestures, you must enable handwriting recognition in Motion Preferences. If you cannot turn gestures on at this point, or perform the following steps, follow the instructions in the following task, “Set up OS X Ink preferences,” then complete the following steps.

3. For “Gestures are,” ensure that On is selected.

4. To select a gesture input method, click the Trigger pop-up menu, then choose an option:
   - **Pen Button 1:** Choose this option to trigger gestures by pressing the first button (the button closest to the tip) on the pen.
   - **Pen Button 2:** Choose this option to trigger gestures by...
- **Pen Button 2**: Choose this option to trigger gestures by pressing the second button on the pen.

  **Note:** Pen buttons may conflict with the Wacom Tablet preferences. To customize pen settings for Motion, see [Set Wacom tablet preferences](#).

- **Modifier (Ctrl)**: Choose this option to trigger gestures by pressing Control.

  **Note:** Select the “Allow gestures in the air” checkbox to use gestures by swiping just above the tablet, without the tip of the pen touching the tablet. To use gestures in the air, you must set a pen button as the gesture trigger input method, as well as set pen button 1 to Disabled in the Pen pane of the Wacom Tablet application. For more information, see [Set Wacom tablet preferences](#).

---

**Set up OS X Ink preferences**

The Ink pane in the OS X System Preferences window contains additional settings that you should adjust to better facilitate using gestures in Motion.

**Note:** The Ink pane is accessible only if you have a tablet connected to your Mac.

1. In the Gestures pane of Motion Preferences, click Open Ink Preferences.

   The OS X System Preferences window appears, with the Ink pane active.
2. For “Handwriting recognition is,” select On.

By default, a “whoosh” sound is played when gestures are drawn. To disable the sound, click the Options button and deselect the “Play sound while writing” checkbox.

Set Wacom tablet preferences

In the Wacom Tablet pane of OS X System Preferences, you can create customized tool settings for an application. For example, you can disable the pen buttons for use in Motion but set button 1 to act as a right-click for another application.
Customize pen buttons for Motion

1. In the Wacom Tablet pane of OS X System Preferences, click the Add button (+) in the Application row.

2. In the Select Application dialog, do one of the following:
   - If the Motion app is open, select “Motion” from the Currently Open Applications list.
   - If the Motion app is not open, click the Browse button, navigate to and select the Motion app, click Open, then click OK.
     The Motion app now appears in the Selected Application field.

3. Click OK.
   The dialog closes, and Motion appears in the Application row of the System Preferences pane.

4. Click the Motion icon, then set your pen tool options.
   For more information, see your tablet’s documentation.

Use gestures

Use gestures overview
The following illustration shows the basic gesture anatomy. The dot represents the start of the gesture, and the arrow represents
the direction of your gesture. Draw the gesture on the tablet, with your pointer positioned over the Motion Canvas or Timeline.

![Gesture start position]

**Modifier keys**

Many gestures have additional functionality when used with a key on the keyboard. In the following tables, if a gesture has an entry in the Modifier keys column, it has additional functionality accessible via a keyboard shortcut. For example, if you have the Control key set as the gesture trigger, and you draw the play forward gesture, the project plays forward from the current time. If you press Control-Shift and draw the play forward gesture, the project plays from the start of the project.

**Scale of gestures**

There is no defined minimum or maximum scale for the gestural input. The tolerance is defined by the Inkwell technology. However, the size at which gestures are drawn may affect the result of the gesture. For example, when using the fit-to-fill zoom gesture and you draw a large circle, the zoom amount is small. If you draw a small circle, the zoom is large.

**Playback control**
<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advance one frame.</td>
<td>To advance in increments of 10 frames, press Shift.</td>
<td></td>
</tr>
<tr>
<td>Go back one frame.</td>
<td>To go back in increments of 10 frames, press Shift.</td>
<td></td>
</tr>
<tr>
<td>Play forward at normal speed.</td>
<td>To play from start, press Shift. To turn looping on or off, press Option.</td>
<td></td>
</tr>
<tr>
<td>Stop or pause playback.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**General navigation**
<table>
<thead>
<tr>
<th>Action</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in to the Canvas.</td>
<td>To zoom to the area within the gesture, press Shift. For example, if you draw a small gesture around an area, you get a large zoom. If you draw a large gesture, you get a small zoom.</td>
</tr>
<tr>
<td>Zoom out of the Canvas.</td>
<td>To position the zoom at the center of the gesture, press Option.</td>
</tr>
<tr>
<td>Select the Zoom tool.</td>
<td>To zoom in</td>
</tr>
</tbody>
</table>
and out of the Canvas, move the pen left or right. The zoom is centered on the area where the pointer is placed in the Canvas.

Select the Pan tool.

Set the Canvas to Home (100 percent).

Fit the Canvas in the window. To switch the Canvas display to player mode, press Shift.

Show or hide the Timing pane.
Show or hide the Project pane.

Show or hide the Inspector.

Show or hide the File Browser.

Show or hide the Library.

General commands

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Undo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Redo.</td>
<td></td>
</tr>
</tbody>
</table>
Delete the selected object.

Choose the Select/Transform tool.

Show and hide the HUD.

Copy.

Paste.

Note: The Paste command may be a bit tricky to master.

Timeline navigation and editing

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


Go to the start of the play range.

Go to the end of the play range.

Go to the start of the project.

Go to the end of the project.

Go to the start of the selected object.

Go to the end of the selected object.

Group.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Key</th>
<th>Action</th>
<th>Description</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ungroup.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set a local In point for the selected object.</td>
<td>To move the In point to the playhead position, press Shift.</td>
<td></td>
<td>Set a local Out point for the selected object.</td>
<td>To move the Out point to the playhead position, press Shift.</td>
<td></td>
</tr>
<tr>
<td>Bring the selected object forward in the stack.</td>
<td>To bring an object to the front of the stack, press Shift.</td>
<td></td>
<td>Send the selected object backward in the stack.</td>
<td>To send an object to the back of the stack, press</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
<td>Instructions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------</td>
<td>---------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Up Arrow" /></td>
<td>Add a project marker.</td>
<td>To edit a project marker, press Shift.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To clear a project marker, press Option.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Down Arrow" /></td>
<td>Add an object marker.</td>
<td>To edit an object marker, press Shift.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To clear an object marker, press Option.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Square Left" /></td>
<td>Set the start of the play range.</td>
<td>To clear the play range, press Option.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Square Right" /></td>
<td>Set the end of the play range.</td>
<td>To clear the end of the play range, press Option.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Move Motion projects, objects, or presets to another computer

You can move Motion project files, custom objects, or project presets to another computer that has Motion installed.

Copy a Motion project file to another computer

To move a Motion project file to another computer, you must also move all media that the project uses, including all QuickTime, still image, and audio files. In addition, any third-party Motion plug-ins or nonstandard fonts used in the project must be installed on the new computer, or they’ll be unavailable to your project.

Similarly, when you finish a project and want to archive it, it’s a good idea to archive the project file and all media, graphics, fonts, custom behaviors, filters, and third-party add-ons used in the project. If you need to restore the project for later revisions, you’ll have everything you need to get started quickly.

1. Save the project file using the Collect Media option as described in “Save a project and collect all project media into a folder” in Save, autosave, and revert projects.

2. Copy the folder containing the saved project file and all media
used in the project to another computer.

**Note:** If you move a project to another computer without selecting the Collect Media option, media can go offline (even if you’ve manually moved the media files). For more information on how to relink media files to your project, see [Reconnect offline media files](#).

---

**Copy a custom object to another computer**

Each customized object you drag to the Motion Library is saved as a separate file in the `/Users/username/Library/Application Support/Motion/Library/` folder on your computer. Although these saved custom objects appear in the OS X Finder with a `.molo` extension (“Motion Library object”), you cannot open them from the Finder.

You can, however, move saved objects to another computer that has Motion installed, then access them from the Motion Library. For more information about saving custom objects, see [Save custom objects to the Library](#).

1. In the OS X Finder, open your `/Users/username/Library/Application Support/Motion/Library/` folder.

   **Note:** If the Library folder is hidden in the OS X Finder, hold down the Option key, then choose Go > Library.

2. Copy a custom saved object file (with a `.molo` extension) to the `/Users/username/Library/Application Support/Motion/Library/` folder on another computer that has Motion installed.
Make sure that you also copy any imported graphics, images, or movie files used to create your custom material (such as a JPEG file used as the source for a particle emitter). After you open the project, relink to the source media files. For more information, see “Reconnect offline media via the Media Inspector” in Reconnect offline media files.

Copy a project preset to another computer

Each custom project preset you create (such as Broadcast HD 720) is saved as a separate file in your computer’s /Users/username/Library/Application Support/Motion/Presets/ folder. If you create custom presets that you rely on, you can move them to other computers that have Motion installed.

1. In the OS X Finder, open your custom preset files to that computer’s /Users/username/Library/Application Support/Motion/Presets/ folder.

   **Note:** If the Library folder is hidden in the OS X Finder, hold down the Option key, then choose Go > Library.

2. Copy a custom preset file (with a .preset extension) to that computer’s /Users/username/Library/Application Support/Motion/Presets/ folder.

For information on creating project presets, see Create, edit, and delete project presets.
Use color and gradient controls

User color and gradient controls overview

Use color controls to set the color of objects such as shapes, text, replicators, particles, and gradients. Use the gradient editor to select a preset gradient or to change gradient parameters, such as color, opacity, direction, and so on.

Color controls

Basic color controls

There are several basic color controls in Motion:

- **Color well**: A small color swatch that, when clicked, opens the OS X Colors window
- **Downward arrow**: A button beside the color well that opens the Motion pop-up color palette, an alternative to the OS X Colors window
- **Eyedropper**: A control used to pick a color in use in the Motion Canvas
- **Disclosure triangle**: A control that, when clicked, reveals advanced color controls
Change the color of an object using the basic Motion color controls

Do one of the following:

- Click the color well swatch, then pick a color from the OS X Colors window. For more information, see Colors window.

- Click the downward arrow or Control-click the color well, then pick a color from the Motion pop-up color palette. For more information, see Pop-up color palette.

- Click the eyedropper, then click an object of the desired color in the Canvas. For more information, see Eyedropper.

- Click the disclosure triangle on the left side of the color controls to expose individual Red, Green, Blue, and, when applicable, Opacity sliders. For more information, see Expanded color controls.

---

Pop-up color palette

Use the pop-up color palette to select a color from the spectrum of hues, saturation, and lightness. You can also select a grayscale value.
Pick a color in the pop-up color palette

- Control-click a color well or click the adjacent downward arrow, then do any of the following:
  - Click in the top area to select a color from the spectrum of hues, saturation, and lightness.

As you drag in either area, the pointer becomes an eyedropper, the column on the right displays the RGB and HLS values for the sampled colors, and two swatches above the RGB information display the current and sampled colors. As you sample in the spectrum, the selected object in the Canvas updates dynamically.

- Click in the bottom gradient to select a grayscale value.

Colors window
You can use the OS X Colors window in Motion, giving you access
to the familiar color pickers such as the Spectrum palette or the Crayons palette.

The Colors window has four sections: the icons at the top select picker interfaces; the large color swatch shows the current color; the middle section shows the active picker; and the row of boxes can be used to save swatches.

Show the Colors window

Do one of the following:

- Click a color well.
- Choose View > Show Colors.
- Press Shift-Command-C.
Pick a color in the Colors window

Do one of the following:

- Click a color in the color picker area.
- Click the magnifying glass, then click anywhere on the computer screen to choose a color.

**Note:** When you open the Colors window by clicking a Motion color well, the color you click in the Colors window loads into the well, and the selected object in the Canvas changes color. However, when you open the Colors window from the View menu (or by pressing Shift-Command-C), clicking a color in the Colors window does not load the color into the well or change the selected object. In this case, drag a color swatch from the Colors window to the color well. Similarly, if you leave the Colors window open and select another object in the Canvas, clicking in the Colors window does not change the newly selected object.

Save a color to the saved swatch area in the Colors window

1. Select a color in the picker or by using the magnifying glass.

2. Drag the color from the large swatch to a white square at the bottom of the Colors window.

Colors saved in this area remain accessible across applications and restarts.
Eyedropper

An eyedropper control beside the color well lets you pick a color in use in the Motion Canvas. By choosing from colors in your scene you ensure that elements remain in the same palette, creating a more cohesive and integrated design.

Pick a color using the eyedropper

1. In the Inspector, click the eyedropper for the color parameter you want to set.

   The pointer turns into an eyedropper.

2. Click a color in the Canvas.

   That color is assigned to the color well.

Expanded color controls

Sometimes you need precise numerical control over colors. You might also need to match two colors exactly or adjust a color channel independently.

Every set of color controls has a disclosure triangle, which, when clicked, reveals sliders for the Red, Green, and Blue color channels. You can choose or fine-tune a color by adjusting these sliders. Among other uses, these controls are handy when you need to keyframe each color channel differently.
Gradient controls

Gradient editor overview

Most attributes that can be filled with a color can also be filled with a gradient. Like color controls, gradient controls are a group of compound settings that can be expanded for more precise control.

You can apply a preset gradient style, create your own custom gradient style, and save gradient styles to the Library.

SEE ALSO

Gradient editor controls
Use the gradient preset pop-up menu

When the gradient editor is collapsed, you can select a preset gradient from the Gradient preset pop-up menu, located to the right of the gradient preview bar.

![Gradient preset pop-up menu]

Change the current gradient to a saved preset

- Click the Gradient preset pop-up menu and choose a gradient preset from the list.

  The new gradient is shown in the gradient bar and applied to the selected object in the Canvas.

Change a gradient’s color and opacity

The gradient editor is a flexible and powerful tool, allowing you to create custom styles.

Change the colors in a gradient

1. Click the Gradient disclosure triangle to show the gradient
2. To change the color of a color tag in the gradient editor, do one of the following:

- Double-click a color tag.

The Colors window appears. Use the Colors window to set a color for the tag.

- Click a color tag, click the disclosure triangle to the left of Color parameter name, then adjust the Red, Green, and Blue color channel sliders.

- Control-click a color tag to display the pop-up color palette. Drag the eyedropper in the palette to select a color. Drag in the lower palette to set the tag to a grayscale color.

- Click a color tag, then Control-click the color well to display the pop-up color palette.

- Click a color tag, click the eyedropper tool, then click a
Change the opacity in a gradient

1. Click an opacity tag.

   The Opacity slider is enabled.

2. Use the Opacity slider or adjacent value slider to change the level of transparency.

   The gradient transparency reflects the new opacity values.

   **Tip:** The lower the percentage of the opacity, the greater the transparency.

Add or remove a color tag

- Position the pointer in the lower gradient bar where you want to add the new color, then click.
A new color tag is added to the gradient.

**Note:** Although the color, opacity, and position of the tags of a gradient can be animated, the number of color tags and opacity tags cannot.

---

**Add an opacity tag to a gradient**

- Position the pointer in the opacity bar where you want to add the tag, then click.

  A new opacity tag is added to the gradient.

  Until the value is adjusted, the gradient opacity is 100%.

---

**Remove a color or opacity tag from the gradient**

- Drag the tag away from the gradient bar.

  The tag is removed.
Edit color and opacity direction and distribution

You can reverse the direction or evenly distribute the gradient color and opacity tags.

Reverse the gradient color or opacity direction

- Click the reverse tags icon next to the opacity or color bar.

The tags are reversed.

Evenly distribute the gradient color or opacity tags

- Click the distribute tags icon next to the opacity or color bar.
Change the direction of a shape’s gradient

1. With the shape selected and the Inspector open, click the Gradient disclosure triangle to show the gradient editor.

2. Use the Start and End value sliders to change the direction of the gradient.

Move, duplicate, or change the interpolation of gradient tags

There are many ways to manipulate tags in the gradient editor to create a custom gradient.

Move the position of a color tag or opacity tag

1. Click the color tag or opacity tag to move.

2. Do one of the following:
   - Drag the color tag left or right.
   - Use the Location slider (or adjacent value slider) to modify the position of the selected tag. A value of 100% is the rightmost position of the gradient, and a value of 0% is the leftmost position of the gradient.

Duplicate a color or opacity tag
- Option-drag the tag to a position.

**Change the transition midpoint between adjacent color or opacity tags**

- Drag the small triangle between adjacent color tags or opacity tags to change the point where one tag’s effect ends and the next tag’s effect begins. The closer the middle control is to a tag, the sharper the color or opacity transition.

![Middle control](image)

**Note:** The middle control does not appear for color or opacity tags set to Linear or Constant.

**Change the color or opacity tag interpolation**

- Click a tag, then choose Constant, Linear, or Continuous from the Interpolation pop-up menu.

**Save gradient presets**

As with shape styles, after you create a gradient, you can save it.
in the Library.

Save a gradient in the Library

1. Select the object with the gradient to save.

2. From the Gradient preset pop-up menu, choose Save Gradient.

3. In the Save Preset To Library dialog, enter the name of the gradient.

4. Click Save.

The custom gradient appears in the Gradients category in the Library. Custom presets can be identified in the Library by the small user badge that appears in the lower-right corner of the larger gradient icon. The gradient also appears in the Gradient preset pop-up menu.

Use onscreen gradient controls

Onscreen controls provide a more interactive way to edit a gradient’s attributes—color, location and value of color tags and opacity tags, and start and end points—in the Canvas. You can also use onscreen controls to add color tags and opacity tags, as well as change their interpolation.
Display the onscreen gradient controls

Do one of the following:

- In the Canvas, Control-click the object with the applied gradient, then choose Edit Gradient from the shortcut menu.
- In the toolbar, click and hold the 2D transform tools pop-up menu, then choose the Adjust Item tool.
The onscreen controls appear.

**Adjust the start and end gradient positions**

Do one of the following:

- In the Canvas, adjust the Start X and Y position of the gradient by dragging the top triangle (at the end of the gradient line).

- In the Canvas, adjust the End X and Y position of the gradient by dragging the bottom triangle (at the end of the gradient line).

**Change the location of gradient tags**

Do one of the following:

- To change the location of gradient colors, drag the color tags
along the gradient line in the Canvas.

- To change the location of the gradient opacity, drag the opacity tags along the gradient line in the Canvas.

---

### Add a color or opacity tag

Do one of the following:

- To add a color tag, double-click the gradient control line.

- Control-click the gradient control line where you want the tag, then choose Add Color Tag or Add Opacity Tag from the shortcut menu.

- Option-click the gradient control line where you want a color tag.

- Option-Shift-click the gradient control line at the location where you want the tag.

---

### Remove a color or opacity tag

- Drag the color tag or opacity tag away from the gradient line and release the mouse button.

---

### Change the color or opacity of a gradient tag
Control-click the tag, then drag the eyedropper in the pop-up color palette to select a color or opacity value. For Opacity, white represents more opaque values and black represents complete transparency. As you drag, the gradient is actively updated.

Adjust the gradient interpolation, direction, or distribution

Do any of the following:

- To change a tag’s interpolation, Control-click the gradient control line next to the tag, then choose Constant, Linear, or Continuous from the Color Interpolation submenu.

- To reverse the direction of the gradient, Control-click the gradient control line, then choose Reverse Color or Reverse Opacity from the shortcut menu.

- To evenly distribute the tags, Control-click the gradient control line, then choose Distribute Color from the shortcut menu to distribute color tags, or Distribute Opacity to distribute opacity tags.

Basic gradient controls

Most attributes that can be filled with a color can also be filled with a gradient. Like color controls, gradient controls are a group of compound settings that can be expanded for more precise control.
- **Gradient preview bar:** A horizontal bar that displays the currently selected gradient

- **Gradient preset pop-up menu:** An unlabeled pop-up menu to the right of the preview bar containing a list of gradient presets

- **Disclosure triangle:** A control that, when clicked, expands to show the gradient editor

### Gradient editor controls

Most attributes that can be filled with a color can also be filled with a gradient. Like color controls, gradient controls are a group of compound settings that can be expanded for more precise control. You can use these expanded controls to add keyframes and create animated gradient effects.

To customize or modify a gradient, click the disclosure triangle in the Gradient row of the Inspector to reveal the advanced gradient controls:

- **Gradient preset pop-up menu:** An unlabeled pop-up menu at the top of the gradient controls used to apply preset gradients or to save custom gradients.

- **Graphical controls:** Three horizontal bars that let you set and preview the opacity, color, and spread of a gradient.

  The narrow, white top bar (the *opacity bar*) controls opacity and transparency in the gradient. Adjust the spread of opacity across the gradient by dragging one of the small box-shaped...
opacity tags horizontally along the bar. Click in the opacity bar to add opacity tags, creating a gradient with varying levels of transparency. Delete an opacity tag by dragging it away from the color bar. Change the value of an opacity tag by selecting it and dragging the Opacity slider (described below).

Opacity tags have a value range of 0% (completely transparent) to 100% (completely opaque). Adjust the transition between two opacity tags by dragging the middle control—a small triangle between adjacent tags, available when Interpolation is set to Continuous (described below). By default, the opacity of a gradient applied to text is 100%.

The wide middle bar shows a preview of the current gradient.

The narrow bottom bar (the gradient bar) controls color in the gradient. Adjust the spread of color across the gradient by dragging one of the small box-shaped color tags horizontally along the bar. Click in the gradient bar to add more color tags. Delete a color tag by dragging it away from the gradient bar. Change the value of a color tag by selecting it and choosing a color from the color well below, or by double-clicking the tag and choosing a color from the Colors window. Adjust the transition between color tags by dragging the middle control—a small triangle between adjacent tags, available when Interpolation is set to Continuous (described below).

Selecting a color tag activates the Color and Location controls (described below). Selecting an opacity tag activates the Opacity slider (described below). Selecting a middle control activates the Middle slider (described below).

- **Color:** A color well and eyedropper that sets the hue of a selected color tag in the gradient bar. For more information about color wells, see Basic color controls.
• **Opacity**: A slider that sets the transparency of a selected opacity tag in the opacity bar. Values range from 0% (completely transparent) to 100% (completely opaque).

• **Interpolation**: A pop-up menu that sets the interpolation of a selected color tag or opacity tag. There are three options:
  
  • **Linear**: Creates a uniform distribution of opacity or color between the tags.

  • **Continuous**: Sets an adjustable rate of change between adjacent opacity or color tags. Adjust the rate of change by dragging a middle control in the opacity bar or gradient bar, or by dragging the Middle slider (described below).

  • **Constant**: Creates a constant color distribution from the color or opacity tag, moving from left to right in the gradient. For example, if the left color tag is set to Constant, the area of the gradient between that tag and the next one to the right is a single, solid color.

• **Middle**: A slider that duplicates the function of the middle controls in the opacity bar and gradient bar, adjusting the transition point between opacity tags or color tags. When you select a middle control, the Middle slider becomes available.

• **Location**: A slider that adjusts the location of a selected opacity tag or color tag.

• **Type**: A pop-up menu that lets you choose a linear or radial
gradient.

- **Start**: Value sliders that set the start position of the gradient in the selected object. This parameter affects the gradient as a whole—colors and opacity. Clicking the disclosure triangle stacks the X and Y value sliders vertically instead of horizontally.
  
  - **X**: Controls the X start position of the gradient.
  - **Y**: Controls the Y start position of the gradient.

- **End**: Value sliders that set the end position of the gradient in the selected object. This parameter affects the gradient as a whole—colors and opacity. Clicking the disclosure triangle stacks the X and Y value sliders vertically instead of horizontally.
  
  - **X**: Controls the X end position of the gradient.
  - **Y**: Controls the Y end position of the gradient.

**Note**: The Start and End parameters do not appear in text gradients.

- **Angle**: When the Type pop-up menu is set to Linear, this dial specifies the direction of a linear gradient. This parameter only appears for text gradients.
About rasterization

Groups and rasterization

Some operations, as well as the application of specific filters or a mask, cause a group to be *rasterized*. When a group is rasterized, it’s converted into a bitmap image. This affects how the rasterized group interacts with other objects in the project.

Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects in the group no longer interact with objects outside the group. When a 3D group is rasterized, the group as a whole can no longer intersect with objects outside the group. The rasterized 3D group is treated as a single object and uses layer order (in the Layers list), rather than depth order when composited in the project. (For more information on layer order versus depth order, see Create 3D intersection.)
When a group is rasterized, cameras and lights in the project still interact with objects in the rasterized group.

**Important:** Lighting in a flattened 3D group does not pass beyond the boundaries of that group, whether rasterized or not.

The following operations on a 2D group trigger the rasterization of that group:

- Making Blending changes (to the Opacity, Blend Mode, or Preserve Opacity parameters)
- Turning on the Drop Shadow parameter
- Turning on the Four Corner parameter
- Turning on the Crop parameter
- Applying any filter
- Adding a mask
- Adding a light (if the 2D group the light is added to is nested in a 3D group)

The following operations on a 3D group trigger the rasterization of that group:

- Making blending changes
- Applying specific filters
  
  For more information, see Filters and rasterization.
- Adding a light to a 3D project with the Flatten parameter enabled (in the Group Inspector)

When an operation triggers a rasterization on a group, the
A rasterization indicator (a small red box containing an “R”) appears next to the parameter in the Properties Inspector.

- A small outline surrounds the rasterized group in the Layers list and Timeline. This is called a *rasterization frame*.

Unlike vector graphics, rasterized 2D groups may lose quality when scaled if the Fixed Resolution checkbox is selected in the Group Inspector.

**Important:** 3D particle emitters, 3D replicators, and nonflattened text objects are treated as 3D groups for rasterization.

To learn more about how rasterization affects different types of objects, choose a topic in the Help table of contents (the sidebar to the left of this window).
Examples of rasterization

2D groups and rasterization

The following pair of figures show the effect of rasterization on the blend modes of 2D groups. In both images, the lone elephant layer, which is in the topmost group in the Layers list, overlaps a portion of the family of elephants layer, which resides in a separate 2D group in the Layers list. In both examples, the lone elephant layer has its Blend Mode parameter set to Vivid Light. In the nonrasterized left example, the lone elephant’s blend mode interacts with the pixels of the group underneath it (the family of elephants). However, in the right example, the topmost group is rasterized. Consequently, its Vivid Light blend mode no longer interacts with the pixels of the second group.

Important: If a group’s Blend Mode is set to Pass Through and the group’s layers have different Blend Modes applied, the layers are not rasterized.
3D groups and rasterization

The next pair of figures show the effect of rasterization on the intersection of 3D groups. In the left image, the nonrasterized example, two groups (Group A and Group B) containing rectangle shapes intersect in 3D space. In the right image, Group A is rasterized; consequently, Group A and Group B no longer intersect.

Text and rasterization

Rasterization affects how basic text and 3D text interact with other objects in your project.

Note: Sometimes, text is rasterized independently of the group in which it resides, and that rasterization affects how the text interacts with objects in its own group. For example, applying a Circle Blur filter to text that exists in 3D space (such as text on a path) causes the text to no longer intersect with other objects in the same group. The same operations that cause a 3D group to rasterize cause 3D text to rasterize. In some situations, selecting the Flatten checkbox in the Layout pane of the Text Inspector can...
minimize this effect.

The following example shows the nonrasterized 2D group (Group 1) containing text. The text interacts with the image beneath it in the layer stack because the text is set to the Soft Light blend mode. (Notice the texture in the words “big cats” created by the image beneath it.)

In the next example, the 2D group that contains the text is rasterized—triggered in this case by selecting the Crop checkbox in the group’s Properties Inspector. The text’s Soft Light blend mode no longer interacts with the object beneath it (the tiger image) in the layer stack. In the Layers list, a rasterization frame now appears around the Group 1 icon.
Tip: In the above case, moving the image into the group that contains the text eliminates the rasterization issue.

For more information on rasterization in 2D and 3D groups, see Groups and rasterization.

Shapes and rasterization

When a group becomes rasterized, all masks, shapes, and paint strokes in that group are affected and may no longer interact with other layers and groups as expected. Because paint strokes are rendered in a plane, they are always rasterized (independent of other objects in the same group). This affects how the dabs that comprise a paint stroke interact with objects in the same group.

Note: Because a paint stroke is always rasterized, no rasterization indicator appears around the paint stroke icon.

For more information on rasterization with 2D and 3D groups, see Groups and rasterization.
Particles, replicators, and rasterization

When a group becomes rasterized, particles and replicator elements in that group are affected and may no longer interact with other layers and groups as expected. Particles and replicators still interact in 3D with elements in the rasterized group.

The following examples demonstrate how rasterization affects particles in 2D groups. In the first image, a nonrasterized 2D group that contains a particle emitter is set to the Add blend mode. The particles interact with the group beneath the emitter in the Layers list (the group containing the reddish texture). The particles blend with the pixels of the underlying group.

In the next image, the group that contains the particle emitter is rasterized. The particle emitter’s Add blend mode no longer interacts with the group beneath it in the Layers list (made apparent by the dark ring around the edges of the particles).
A 3D particle emitter can be rasterized independently of the group in which it resides. Consequently, the resulting particles may not interact as expected with objects inside the same group. For example, applying a Circle Blur filter to a particle emitter causes the particles to no longer intersect with other objects in the same group. The same operations that cause a 3D group to rasterize cause a 3D particle emitter to rasterize. To minimize this effect, apply the filter to the emitter’s source object, or deselect the 3D checkbox in the Emitter Inspector.

When a group or a 3D particle emitter is rasterized, the group can no longer intersect with objects outside the group. In the following illustration on the left, the nonrasterized group that contains the particle emitter intersects with images from another group (when Render Particles is set to In Global 3D). In the illustration on the right, a Bloom filter applied to the star particles group has triggered a rasterization, so the emitter no longer intersects with images from another group.
**Note:** Unlike vector graphics, rasterized 2D groups may lose quality when scaled if the Fixed Resolution checkbox is selected in the Group Inspector.

In the following illustration on the left, the nonrasterized group that contains the replicator intersects with an image from another group. In the illustration on the right, a Gradient Blur filter applied to the replicator group has caused the replicator group to rasterize. As a result, the replicator no longer intersects with the image from another group.

For more information on rasterization with 2D and 3D groups, see Groups and rasterization.

**Filters and rasterization**
The application of some filters can cause a group to be rasterized. When a group is rasterized, it is converted into a bitmap image. In 2D groups, the application of any filter causes rasterization. In 3D groups, the application of specific filters causes rasterization. For more information on rasterization and 3D groups, see Groups and rasterization.

The following filters force rasterization of 3D groups:

**Blur filters**
- Circle Blur
- Compound Blur
- Defocus
- Gradient Blur
- Radial Blur
- Variable Blur
- Zoom Blur

**Border filters**
All Border filters force rasterization of 3D groups.

**Color Correction filters**
No color correction filters cause rasterization of 3D groups.
Distortion filters
All Distortion filters force rasterization of 3D groups.

Glow filters

- Gloom
- Light Rays
- Outer Glow
- Overdrive

Keying and Matting filters

- Keyer
- Luma Keyer
- Matte Magic

Sharpen filters
All Sharpen filters force rasterization of 3D groups.

Stylize filters

- Add Noise
- Bad Film
- Bad TV
- Circle Smeary
• Circle Screen
• Circles
• Color Emboss
• Crystallize
• Edges
• Extrude
• Halftone
• Hatched Screen
• Highpass
• Indent
• Line Art
• Line Screen
• MinMax
• Noise Dissolve
• Pixellate
• Relief
• Slit Scan
• Slit Tunnel
• Texture Screen
• Vignette
• Wavy Screen
**Tiling filters**
All Tiling filters force rasterization of 3D groups.

**Time filters**
All Time filters force rasterization of 3D groups.

**Video filters**
The Deinterlace filter forces rasterization of 3D groups.

**Shadows and rasterization**
Rasterized 3D objects do not cast shadows. If you perform an action that causes a group to be rasterized (such as modifying the group opacity or enabling the glow setting for a text object), and you still want that group to cast a shadow, you must flatten the group.

Flattened groups act as 2D layers and can cast and receive shadows as long as they are embedded in a 3D group. Text objects are flattened in the Layout pane of the Text Inspector, and 3D groups are flattened in the Group Inspector. Particle systems and replicators are flattened by deselecting the 3D checkbox in the Emitter Inspector or Replicator Inspector.
Rasterizing causes layers to be rendered in the stacking order shown in the Layers list. So even if the shadow-casting object is in front of the shadow-receiving object in the Canvas, rasterizing it may cause it to change position to reflect the relative order of the layers in the Layers list. You may need to rearrange the layer order in the Layers list to enable the rasterized, flattened object to cast a shadow.

For more information on working with Shadows, see Shadows overview.
Apple, the Apple logo, Apple TV, Finder, Final Cut, Final Cut Pro, FireWire, GarageBand, Geneva, Inkwell, iPad, iPhone, iPhoto, iPod, iTunes, iTunes Plus, Logic, Mac, Macintosh, Mac OS, MacBook, Pages, Pixlet, QuickTime, Spotlight, and TrueType are trademarks of Apple Inc., registered in the U.S. and other countries.

Mission Control and Multi-Touch are trademarks of Apple Inc.

iTunes Store is a service mark of Apple Inc., registered in the U.S. and other countries.

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Distiller, PostScript, and the PostScript logo are trademarks or registered trademarks of Adobe Systems Incorporated in the U.S. and/or other countries.

Helvetica is a registered trademark of Heidelberger Druckmaschinen AG, available from Linotype Library GmbH.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries.

The YouTube logo is a trademark of Google Inc.
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Other company and product names mentioned herein are trademarks of their respective companies. Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. Apple assumes no responsibility with regard to the performance or use of these products.